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Looking for the LightWave 2018 wiki?

Thank you for your LightWave purchase
NewTek LightWave 3D® is a complete 3D solution to model, render and animate. LightWave is used extensively in 
television and film production, video game development, print graphics and design, and LightWave artists have won 
more Emmy® Awards for visual effects and animation than any other CG artists. Plus, LightWave is designed to be used 
by a single artist, a small team, or a major facility, with seamless integration into diverse pipelines.

LightWave™ 2020 gives you the workflow and functionality you’ve heard about, along with new interactive tools for a 
real-time experience. You get the speed, flexibility and control you need to create quickly, easily and affordably.

LightWave 3D combines a state-of-the-art renderer with powerful, intuitive modeling and animation tools. Tools that 
may cost extra in other professional 3D applications are part of the product package, including 999 free cross-platform 
render nodes, support for Windows and Mac OS X operating systems, free technical support, and more. LightWave is 
enjoyed worldwide, as a complete 3D production solution for feature film and television visual effects, broadcast 
design, print graphics, visualization, game development, and Web. LightWave is responsible for more artists winning 
Emmy Awards than any other 3D application.

Major studios and post-production houses can spend years assembling custom pipelines. And it doesn’t end there, as 
these complex pipelines require large numbers of technical staff to maintain. While this may suit companies with 
hundreds of employees, the majority of studios around the world employ fewer than 40 employees. For them, 
extravagant, complex workflows are not just overkill; they pillage budgets and impose bottlenecks on both creativity 
and productivity.

LightWave fits seamlessly into large multi-software pipelines - with its powerful interchange tools including FBX, ZBrush 
GoZ, Collada, Unreal and Unity game engine support, and Autodesk Geometry Cache. Unlike other software packages, 
LightWave offers artists and studios a complete end-to-end solution right out of the box.

Robust polygonal and subdivision surface modeling.
Splendid PBR texturing tools, with powerful dedicated material shaders.
Powerful animation and rigging tools.
Eye-popping volumetric and dynamic effects systems.
A production proven, award-winning Global Illumination render engine - built in.

You decide what workflow or pipeline suits you best and LightWave puts all of the tools in your hands.

LightWave has been the choice of countless studios and artists for nearly 30 years. Chances are LightWave was used to 
create many of your favorite films, television programs, and games.

https://docs.lightwave3d.com/display/LW2018/LightWave+2018
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This wiki will help you learn the basics of 3D with LightWave - from installation and operation, to accessing and using 
the essential tools to model, animate and render. Once you’ve installed the software, please watch our tutorials, and 
the thousands more on sites like YouTube to learn the landscape. You should also join the online forums, where a 
passionate community of LightWave users from all over the world help each other to elevate their craft. Our 3D team 
also provides valuable tips and tricks for you to increase your knowledge and expertise, so visit our website often for 
the latest information at: www.lightwave3d.com.

Welcome to the NewTek family.

New to 2020
Installation
Getting Started with Layout
Getting Started with Modeler
Getting Started with Surfacing
Getting Started with Rendering
Reference
User Interface Conventions
Appendices
Notes

http://www.lightwave3d.com
https://docs.lightwave3d.com/display/LW2020/Notes
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New to 2020

Click here to expand Table of Contents...
Layout

Scene Editor Improvements
Rotation Order
Environment Lights
Node Editor Workflow Improvement
FBX interchange
OpenVDB
Instancing
OpenGL

Modeler
Local AC

Surfacing
New Hair materials for FiberFX
Improved SSS

Rendering
New Global Illumination methodology
Mobile NRC Monitoring
Tone Mapping

Engineering Updates

A lot has changed in LightWave. Here is a curated list with links to pages that describe the features:


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Layout

Scene Editor Improvements

Speed up your Scene Editor use with additions to Layout 2020.

Scene / Dope Editor improvements

Pages describing features new to LightWave 2020 have the label New and the badge 

Pages that have example content will have a download icon ( ) that you can click on to download 
associated content



https://docs.lightwave3d.com/label/new+2020
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Rotation Order

Rotation orders can now be changed in Layout.

Environment Lights
There is now a default Environment light in all new scenes.

Streamlining Environment systems

Node Editor Workflow Improvement
You can now use the middle mouse button to scroll around the node editor's interface. No keyboard modifiers needed

FBX interchange
Updates to LightWave FBX imports and exports mean that interchange with other applications is better than ever.

OpenVDB

Additional tools for OpenVDB mean that the rendering and animation of simulations of complex particle systems are 
made simpler.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=lkyyiozAmbE

https://www.youtube.com/watch?v=lkyyiozAmbE
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OpenVDB: New Tools

Instancing
New static Surface instance toggle speeds up surface instancing for Octane users.

Static instances

Offset Normal system for nodal instance placement

Offset Normal Instances

New instances are by default use Local instead of World Transformation Handling.

Rectangular Arrays can be aligned directly in the interface, without needing a node setup.

OpenGL
Updated OpenGL shaders mean your work is closer than ever to the final render in the viewport.
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LightWave 2019.1.4 OpenGL compared with LightWave 2020 OpenGL

Modeler

Local AC

Local Action Centers give new power to modeling.

Local Action Centering

Surfacing

New Hair materials for FiberFX
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Examples of Principled and AFC hair by Mauro Corveloni

Two new hair shaders give users the choice of how best to create the look of their hair.

New Principled Hair Material added to FiberFx
New AFC Hair shader for FiberFX

Improved SSS
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SSS Panther by Andrew Comb

Turtle showing SSS, and tone mapping, by Tim Laird

We have added Random walk multi-spectrum subsurface scattering to the Principled BDSF material. Technicalities 
aside, this means better SSS for your renders.

Random walk multi-spectrum SSS in the PBSDF material

Rendering

New Global Illumination methodology
LightWave has a revamped Brute Force GI engine and has added an Irradiance Cache engine. There's a new baking 
scheme, including a grid cache bake for scenes when you're not sure where the camera will go next.

New GI with primary and secondary bounce plug-ins
Grid-based Irradiance Cache generation

Mobile NRC Monitoring
Applications for iOS and Android mean that you can monitor the progress of your render not chained to your desk!

Mobile NRC monitoring
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Tone Mapping

Standard render, then rendered with the ACES Filmic tone map operator

Control the look of your rendered output.

Tone mapping

Engineering Updates
There are several changes under the hood to improve LightWave. These won't necessarily be of immediate interest to 
the regular user, but third-party developers should be interested in the new possibilities.

Engineering updates
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Offset Normal Instances

We have added another way to control instance placement and movement. It comes from a user request to be 
able to control instances that are not in the camera's field of view, to reduce the workload of having to calculate 
instances that would not be seen. We have added three new Vector outputs to the Instance Input node - Base X, Base Y, 
and Base Z. They can be used to dictate how instances will be placed based on a surface normal.

The ways these inputs work depend on the type of Instancer used, as follows:

Item (Pivot) - XYZ axis of the parent object
Point - XYZ of the surface point, Y is the surface normal
Polygon - XYZ of the surface point, Y is the surface normal
Particles - XYZ axis of the particle
Surface - XYZ of the surface point, Y is the surface normal
Rectangular Array - XYZ axis of the parent object
Radial Array - XYZ axis of the parent object
Motion Path - XYZ axis of the point on the path, Z points along the spline
Spline - XYZ axis of the point on the path, Z points along the spline

Example - Kooky Cube Eyeballs
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New Principled Hair Material added to FiberFx

Marianne using Principled Hair, courtesy of Mauro Corveloni

New to LightWave 2020 is a material called Principled Hair. It is a simplified shader based on the Principled 
BSDF limited settings. You will see that there are only five inputs compared to Hair's 19. Because hair can be considered 
a dielectric material, you will notice that is no diffuse control and that the Color doesn't just immediately make the hair 
assume the color you enter.

Color - (Default: 47 13 0) The color chosen to tint the hair strand. If you want to force the color chosen, set 
Roughness and Radial Roughness to 100 %
Cutical Tilt - (Default: 3.0 °) Moves the highlight up and down the hair - typical human hair has a tilt of 3-7°
Roughness - (Default: 25 %) The roughness along the length of the strand, the amount of scattering of light 
falling on the strand
Radial Roughness - (Default: 75 %) The roughness around the strand
Index of Refraction - (Default: 1.55) Controls how the glints are placed

The Principled Hair material is designed for Stroke-based Fiber FX hair
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You might find you need to heavily increase your refraction samples for Principled Hair to not appear noisy. 
Rather than increasing Refraction samples everywhere in the render, use the new Refraction sample override 
in the Shading Model tab of the Surface editor to only increase refraction sampling for your hair surface


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New AFC Hair shader for FiberFX

Pilkington the chimp, using AFC hair. Image courtesy Mauro Corveloni

 AFC stands for Artist-Friendly Controls. AFC Hair, like other hair materials, is also a dielectric material. The 
specular settings are divided into two sections. Primary is concerned with reflections of the front side of the stroke. The 
secondary specular is for the reflection bounced off the backside of the stroke, through what's called the cortex color 
inside the hair cylinder.

Primary Specular
Highlight Color - The color for the highlight for the stroke facing the camera

The AFC Hair material is designed for Stroke-based Fiber FX hair
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Highlight Intensity - How strong the highlight is
Highlight Width - For how far along the hair the highlight shows
Highlight Shift - The distance along the hair for the highlight

Secondary Specular
Secondary Highlight Color -The color for the highlight for the stroke facing away from the camera
Secondary Highlight Intensity - How strong the highlight is
Secondary Highlight Width - How far along the hair the highlight shows
Secondary Highlight Shift - The distance along the hair for the highlight

Transmission
Transmission Color - The color that transmits through the hair by reflection
Transmission Intensity - How much the Transmission Color affects the hair's visible color
Transmission Width - How far long the hair the transmission occurs
Transmission Shift - How the transmission slides along the hair
Transmission Azimuth Width - The distance "around" the hair transmission occurs

Glint
Glint Color - The color of the tertiary highlight
Glint Intensity - How intense the glint is
Glint Width - How far along the hair the glint occurs
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Random walk multi-spectrum SSS in the PBSDF material

In previous versions of LightWave, sub-surface scattering was created using diffuse lighting. New to LightWave 
2020 is the far superior Random Walk multi-spectrum SSS. The math is complex and can take longer to calculate, but 
the result is much better subsurface scattering. The settings in the Principled BSDF Material are similar to those in 
LightWave 2019 but the effect is far more controllable.

SSS used to have three control settings but now has four. Now, the Subsurface Scattering color input gives the 
scattering radius of the three colors not the base color of the subsurface scattering itself and uses Color as an input. To 
make a flesh tone, make the main Color a skin color and make Subsurface pinkish to scatter red more than green or 
blue.

It's perhaps easier to visualize the subsurface scattering radius if you change the Color Format in Options to 
Float rather than the default of Integer. Then you will see that 255 Red becomes 1.00. The three color values 
are multiplied by the Distance to calculate how deep inside a surface rays penetrate.


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Renders courtesy Andrew Comb. Mutant model by Luis Santos

Render courtesy Tim Laird, who says, "The node setup uses the component nodes. Two 
SSS nodes, one fully forward scattering (blue), and the other one fully backward 
scattering (orange). It then uses their respective SSS distance settings to mix the SSS. 
Then I added an iridescence fresnel with the GGX reflection, to give that look."

A comparison between 2019.1.5 and 2020:
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Note the Subsurface amount is much reduced in 2019.1.5 for a more accurate 
comparison with 2020
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The new Random Walk SSS is included in these new content scenes, kindly provided by ace LightWaver Tim 
Laird, for you to try. One of the main results of this new implementation is that subsurface colors converge on 
white in use but don't get there.

SSS Bleed Logo and SSS Milk (which will need a new HDR for the background. The one used in the 
render is not included)



https://docs.lightwave3d.com/download/attachments/8204146/SSS_Bleed.zip?api=v2&modificationDate=1587738293000&version=1
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New GI with primary and secondary bounce plug-ins
Click here to expand Table of Contents...

Introduction
Primary and Secondary Engines

Brute Force settings
Irradiance Cache Settings

Disk Caching
Cache Baking Considerations

Example

Introduction

The Monte Carlo radiosity engine has been removed in LightWave 2020, and scenes made in previous versions 
will be adapted on load. The two GI engines are now Brute Force and Irradiance Cache, an interpolated radiosity engine. 
Brute Force is, as its name suggests, an unbiased radiosity engine, and will have no blotchiness but may have noise if 
too few rays are used when rendering.

Irradiance Cache relies on caching to create noise-free, blotch-free renders. There are three sorts of cache - a scene 
cache, a frame cache, and a grid cache - each has their uses, described below.

Primary and Secondary Engines
LightWave now has two radiosity render engines. You can use whichever suits your scenes, but something to bear in 
mind is that the Secondary engine if used, is the one that will be calculated first. If you are using the Irradiance Cache 
engine and have no caches baked already, pressing F9 will pre-process a cache at render time. This cache is not 
permanent, so pressing F9 again will not use the cache from the previous render, and will instead pre-process again.

If you are using both engines, bake the secondary cache first, then primary. The primary cache will sample the scene 
again. If the rays cast hit a location that was already baked in the secondary cache the primary cache will use that 
result. If not, new samples will be generated. Once the primary cache is baked to your satisfaction, the secondary cache 
will no longer be evaluated (and can even be deleted if you are satisfied with your primary cache and need the disk 
space).

Brute Force settings

LightWave's unbiased Brute Force type is a new implementation based on Monte Carlo but decoupled from the 
Interpolated version of the engine. Using Brute Force on its own will result in long render times, but there will be no 
blotchiness, only noise if too few rays are used. There are only a few controls:

Intensity - (Default 100 %) You can dial up the radiosity, or reduce it to make its influence on the render more 
subtle





LightWave 2020  –  LightWave 2020

New to 2020 –  27

•

•

•

Caustics - (Default Off) Caustics are the flickers of light through a wine glass, or on the side of a swimming pool. 
They weigh heavily on render time, so only turn them on where necessary for the shot. If you have surfaces with 
SSS in your scene they will impact caustic rendering time even more

Images courtesy Olivier Michon using PBDSF SSS

Asymmetry 0.5 caustics OFF Asymmetry 0 caustics OFF Asymmetry -0.5 caustics OFF

Asymmetry 0.5 caustics ON Asymmetry 0 caustics ON Asymmetry -0.5 caustics ON

Affected by Volumetrics - (Default Off) Adds volumetrics into the radiosity solution, which can seriously impact 
render times
Rays - (Default 1) Rendering with a single ray will be fast, but it will also be noisy. The more rays you add, the less 
noisy your renders get, but you'd get rid of the noise faster if you use Secondary GI as well
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Irradiance Cache Settings

The settings start the same with Intensity, Caustics, Affected by Volumetrics and Rays (though the default for rays is 
512), then there's:

1. 1 ray BF (Brute 
Force), 6.5s

2. 100 rays BF, 97s 3. 300 rays BF, 289s 4. 1 ray BF + IC at defaults, 
41s

These F9 test renders are not big, but they allow me to quickly see what sort of radiosity I should throw at my 
scene. The first render (1) is just with the default 1 ray of Brute Force. It renders in 6.5 seconds, but it is too 
noisy, so I up the rays to 100 (2). That renders in 97s, but it's still too noisy. I set a render off with 300 rays (3), 
and not only does it take 289s, which is close to my time budget for a render this size, but I still have some 
noise. I choose to add secondary GI, using Irradiance Cache for my render (4), which takes 41s. It still has some 
noise, but I can live with it at that speed of render.

Even better, if I try an F9 render with Primary and Secondary both on Irradiance Cache (after having baked a 
cache), I get this in only 7.3s:



Irradiance Cache does work well in VPR, but if you haven't pre-baked a cache, it might be blotchier than you 
expect. A cache doesn't have to be baked for F9 renders since creating a cache in pre-processing will be done 
as part of rendering, but if you have the time to bake, then final renders, and re-renders, will be faster.


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Interpolation Accuracy - (Default 25 %) The lower the percentage, the smoother (less accurate) the result will 
be, but the more likely that light will leak. Higher percentages may leak to increased blotchiness necessitating 
increased samples and slower renders
Minimum Pixel Spacing - (Default 2.0) Minimum Pixel Spacing (or MinPS). This figure determines the minimum 
size, in screen space, of the sample taken for the radiosity. This setting is only available when the Screen 
Clamping option below is checked
Maximum Pixel Spacing - (Default 200.0) Maximum Pixel Spacing (or MaxPS). This figure determines the 
maximum size, in screen space, of the sample taken for the radiosity. This setting is only available when the 
Screen Clamping option below is checked

Minimum Size - (Default 50 mm). This is the sample size in LightWave world space. This setting is available when 
the Screen Clamping option below is unchecked. You could be rendering an image of a room at VGA size 
(640x480), but there will be a sample taken at every 50 mm even if such fine details won't be seen given the 
limited resolution
Distance Tolerance - (Default 50 mm). The first measure to see if another sample is called for is a straight linear 
distance measurement. Regardless of whether the MaxPS has been exceeded, this measurement determines 
that a new sample is required

You need to strike a balance with your min and max sizes for your sample areas. Too big a MinPS, and 
your contact shadows (where the feet of a table touch the floor, for instance) will be blurry and ill-
defined. Too small, and your renders will slow down unnecessarily. The same goes for your MaxPS. Try 
to keep proportions similar (if you are working on a whole building seen from a distance, both Min and 
Max can probably be large. If you are working on a desk render 1 might not be too small for MinPS, and 
your MaxPS might be 50)


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• Angular Tolerance - (Default 2.0 °). The angular tolerance is based on the normal of the sample. If two samples 
are taken within this tolerance, one will be rejected

In the example above, Sample 1 is a new sample added, and the camera is now looking for Sample 2. 
Normally, Sample 2 should not be taken at the location indicated because you can see that it lies within 
the MinPS we have set. However, it is also outside the Distance Tolerance set for this render and will be 
taken at this location after all.


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Screen Clamping - (Default on) Determines whether screen pixel size determines samples (MinPS and MaxPS), 
or physical size (Minimum Size)
Use Specular - (Default on. Will be ghosted if you don't have Use Cache checked) Determines whether or not to 
use specular samples in preprocessing for radiosity
Use Glossy - (Default on. Will be ghosted if you don't have Use Cache checked) Determines whether or not to use 
glossy samples in preprocessing for radiosity
Use SSS - (Default on. Will be ghosted if you don't have Use Cache checked) Determines whether or not to use 
SSS samples in preprocessing for radiosity
Resolution Multiplier -You can render the radiosity solution for your scene at a higher or lower resolution than 
the final image. Rendering at a lower resolution will speed up the radiosity portion of the render but will leave 
contact shadows less defined

The image above shows a simplified diagram of how Angular Tolerance works with a rendered sphere 
(stay with me...). Sample 1, in red, is a new sample added. Sample 2, in green, is not added because it 
comes within the Angular Tolerance set. The blue version of sample 2 is added, even though it is within 
the MinPS radius.


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Disk Caching
Bake the secondary cache first. Once satisfied that it has baked correctly for your scene, bake a primary cache 
(presuming you are using Irradiance Cache for both radiosity engines). Once the primary cache has baked, the 
secondary Irradiance Cache engine will no longer be evaluated.

Use Cache - Toggle for the disk cache. If secondary GI is engaged, the secondary cache should be baked before 
Primary GI cache
Cache Type - Two choices:

Frame - Useful for scenes with animated objects or light sources
Scene - Useful for scenes where there is only camera movement - an architectural visualization 
walkthrough, for instance

Cache File - The location on the disk where the cache file will be stored. Cache files are named with a .lwics 
extension for scene caches, and icfn.lwicf for frame caches where n is the frame number
Clear Cache - Destroys the cache file in the location set in the Cache File field
Scene Baking Frame Step - What frame interval between caches
Bake Grid - A Grid Bake walks a virtual 360 ° camera through the bounding box of your whole scene, taking 
samples at intervals set in the Grid Spacing field. Note that if you have the main body of your scene concentrated 
in one area, and some elements stored off to the side, Bake Grid only considers the whole bounding box for the 
scene and will thus spend time baking empty space
Grid Resolution - Size in pixels squared of the cache "images." There's little point baking a cache at a higher 
resolution than your final render, and you can often get away with baking a cache at a lower resolution though 
contact shadows might suffer
Grid Spacing - The bounding box for your entire scene is split into a grid, in all three dimensions, based on the 
resolution entered here
Bake Frame - Bake a single frame of a scene. Useful if there are troublesome radiosity artifacts without a cache
Bake Scene - Bake all the frames for a scene based on the Scene Baking Frame Step above. Normally, if you are 
baking a grid, the render times for each frame bake should accelerate as samples are added, and fewer and 
fewer new samples are needed

Cache Baking Considerations

If you have both engines engaged, and they are both Irradiance Cache, you should have a cache baked for each. 
Otherwise, there will be pre-processing when you render with F9 or F10
If you are baking a scene with only camera animation, a Cache Type of Scene will suffice; if you have any other 
animation (of lights or objects) you will want to use a Cache Type of Frame
Red dots are new samples taken when baking
Baking a scene will generally see baking times fall with each frame

Example
This simple scene is a rough guide to how baking works with this scene
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Setup Result Notes

1 VPR, no caches baked 82s Blotch
y

2 F9, Primary: IC, no caches 
baked

1x pre-process, 75.7s including 
21s pp

Too 
dark

3 F9, Primary: IC, Secondary: 
IC, no caches baked

2x Pre-process for every render, 
85.9s including 32s pp

Too 
slow

4 F9, Primary: IC, Secondary: 
IC, secondary cache scene 
baked

1x pre-process for every render, 
72.6s including 17s pp

Better

5 F9, Primary: IC, Secondary: 
IC, primary + secondary 
cache scene baked

no pre-process, 56s Best
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Setting up Global Illumination for a scene is often time-consuming, but will pay dividends in overall scene render time

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=lKK3Vy_s1Fw

http://youtube.com/watch?v=lKK3Vy_s1Fw
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Grid-based Irradiance Cache generation

Along with camera-based caching there is now the belt-and-braces grid-based cache. The grid-based cache 
divides your entire scene into blocks and creates a radiosity solution for each block with a 360° camera.

Bake Grid - If you don't know where your camera will be going in your scene yet, or you want a belt and braces 
approach that ensures that every eventuality will be covered, you can bake a grid cache. The grid cache sets a 
grid at the spacing set for the bounding box of your whole scene.
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The first image shows our test scene with a chair separated from the room we are 
trying to bake, the second shows the chair in the room. In this simplified diagram, 
every vertex in the blue bounding box represents where the 360° camera is taking 
samples (Grid Spacing), at the resolution chosen (Grid Resolution)


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When you check this option, two further suboptions become available:
Grid Resolution - By default, this is set to 1024. The resolution of the cache. A cache is not an image, nor 
a set of images, but the resolution here is similar to the resolution of an image. The higher the resolution 
the longer each grid will take to bake but the more detail it will contain
Grid Spacing - This is how frequently you will be taking snapshots for this cache, at the resolution 
specified above

The baking process shows this clearly - in the grid bake shown on the left there are 
large expanses of nothing. Notice also that there are 4,698 locations to bake, adding to 
the time needed for a render of the cache. In the image on the right, we have returned 
the chair to within the room we are trying to bake. Already we can see that there are 
only 132 locations to bake and there will also be very little checkerboard because there 
are only a few openings (the windows).

1.

2.

3.

If your grid is taking longer to bake than you expect, check several things:

That the resolution and spacing of the grid is appropriate to the scene (no point baking extreme detail 
when it won't be seen)
The grid encompasses the bounding box for the scene. As the example in the wiki shows, don't have 
elements outside the area you are concentrating on
That you are not baking the grid to a slow network location


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Mobile NRC monitoring
Click here to expand Table of Contents...

Introduction
Setting Up
Getting started with the app

Android
iOS
Direct
Hosted

Using the App

Introduction

New to LightWave 2020 is the ability to monitor network rendering on an Android device remotely. This allows 
you to fire off your render and keep an eye on how it's doing when away from the studio.

Setting Up
When you start LightWave 2020 NRC for the first time it will generate a unique identifier for use with the mobile app. 
This is the NRC Key in the new NRC preferences Monitoring tab:


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NRC Monitoring Prefs in Windows and macOS

Items on this tab are as follows:

NRC Key - Unique identifier for the NRC Controller generated on the first run
NRC Identifier - Human-readable name for the controller (optional). If none is set here or in the mobile app, the 
NRC key value will be used instead
Enable Monitoring - This needs to be checked for monitoring to work at all, and should be checked before you 
start rendering. Once checked, there are two further options:

Direct Access - The default access method for monitoring; this requires that you open an IP address and 
specific port in your Windows services.msc tool. This method allows viewing of rendered images

Server Port - The default port number is 4431
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Hosted - A more limited way of monitoring. Image viewing is not available with this method. Hosted links 
to an NT-hosted NoSQL server that keeps the log results of NRC. If you choose Hosted, further options 
appear:

Manually - Only when you request an update
Automatically - You can specify an interval between 5 and 60 seconds (default 10 seconds)

Getting started with the app

Android

The Google Play store has the application under the name NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

iOS

The App Store is where to go to get the iOS version of NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

Starting the app for Android or iOS for the first time presents a screen urging the user to create a server to monitor:
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As the message says, hitting the + icon at the bottom of the screen will open a new window where you can add an NRC 
Key - all that's necessary for the monitor to function. Adding an Identifier is optional, and in any case, your device will 
refer to the specific controller by its NRC key. If you enter an Identifier here, it will propagate to the Controller on your 
Windows or Mac desktop machine where you are running NRC; the same is true in the other direction.
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To add a controller, you need an NRC key first, which can be found in the NRC Controller preferences window > 
Monitoring tab. Copy this carefully onto the app and then proceed with your choice of Direct, or Hosted modes

Direct

You will need to enter an IP address along with the port number to be used. Until you have something that the NRC 
Monitor is happy with, you will see the following icon on the controller card:
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Once the connection is made, the bar will be removed:

Hosted

With Hosted mode, the NRC Monitor links to an NT-hosted NoSQL server that keeps the log results of NRC. The same 
iconography shows whether the connection has succeeded or not:

If your controller resolutely refuses to connect and you can't get rid of the bar even though you're sure you've 
done everything right, shut down the app and the NRC Controller and restart both. That usually unblocks 
them.


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Here there have been no tasks assigned to the renderfarm yet.

Using the App
Once you have your controller added, with no bar, it's time to start your scenes working. Both Direct and Hosted work 
the same way to begin with. Both have the same cards showing an overview of how many tasks have been assigned. 
You can tap on this card to see an overview of individual tasks:
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When a task is started, as shown left above, it will have no renders to show hence the line through the eye icon. Once renders 
are available the eye will be unbarred and can be clicked on to show previews of rendered images, right. Each buffer is 
treated as a separate task inside the scene.

With Hosted mode, the eyeball will always be barred because images cannot be previewed. In Direct mode, when the 
eyeball becomes unbarred you can click on the card to see thumbnails of all images rendered so far, and clicking on a 
thumbnail will display a full-scale image.

The three-dot menu on the right of each card will show the log for the task



LightWave 2020  –  LightWave 2020

New to 2020 –  48

NRC Log
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Tone mapping
Click here to expand Table of Contents...

Introduction
Examples
Tone Mapping
Uses

Introduction

A new Pixel Filter to enable control over how your rendering looks. Tone mapping is a way of taking the high 
dynamic range of a LightWave render and massaging the contents to display them to the best effect. As an example, 
imagine you take a picture indoors on a sunny day with a window in the background. Your camera will do one of two 
things. It will either think you are really interested in what's outside the window, despite you having taken the picture 
indoors and make everything indoors in the picture really dark to give you a nice view of the sky outside with all the 
little, fluffy clouds; or it will expose correctly for inside concentrating on your TV figurine collection, and the world 
outside will be reduced to a bright white square. When LightWave renders an image, it has both sets of data. Normally, 
we accept what LightWave gives us because we can steer it to what we want to see, but it has seen all. The trick is to 
combine that view of outside while maintaining the visibility of what is inside the room. Tone mapping can help with 
this task, and because it's a Pixel Filter, not an Image Filter, it can be used in VPR.

LightWave came with a Kitchen HDR image in the LightWave [6] days. It could be used for lighting a scene for global 
illumination back in GI's earliest days. It's a 360° photograph of the inside of a kitchen, and look in the background, 
there's a white window!





LightWave 2020  –  LightWave 2020

New to 2020 –  50

That window isn't just white, this is a high dynamic range image. Here's a close-up on that window exposing more for 
what's outside the kitchen. We can see the top of a building, and yes, fluffy clouds...

Examples

Here are some examples with the Hero scene from the supplied content:

Just a straight render with no Tonemapping Reinhard tone mapping. The difference is incredibly 
subtle between this and the straight render
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The ACES Filmic TMO applied with an exposure of 1.0. 
Notice the increased depth in the blacks and the overall 
"polish" of the image

ACES Filmic again, but with an Exposure of 2.0. A similar 
level of brightness to the straight render, but increased 
detail in dark areas

ACES Filmic with Exposure 4.0. It's probably best to 
render the background separately

ACES Filmic, Exposure 2.0. You can also play with Hue 
and Saturation. The Hero should definitely be rendered 
separately from the background here

Tone Mapping

Four types of Tone Map Operator (TMO):

Linear - This is the default LightWave render. You can control Exposure, Hue, Saturation, Brightness, and 
Contrast
Reinhard - The Reinhard method (just to be clear, because Max Luminance is controllable, this TMO is Extended 
Reinhard) is one of the simplest tone-mapping methods. It guarantees a solution that contains your brightness 
levels within the 255, 255, 255 range for LDR images, with no blowout. You can control Exposure, Max 
Luminance, Hue, Saturation, Brightness, and Contrast. Results can look grayish if you are working with brightly 
colored, highly saturated subjects
Filmic - The Filmic TMO is designed to replicate the look of film in the real world. It is based on John Hable's 
work. You control Cutoff, Max Luminance, Hue, Saturation, Brightness, and Contrast
ACES Filmic - The Academy Color Encoding System (or ACES) is a color image encoding system created by 
industry professionals with guidance from AMPAS (Academy of Motion Picture Arts and Sciences). It is rapidly 
becoming an industry standard. You can further control Exposure, Hue, Saturation, Brightness, and Contrast. 
ACES Filmic is much-praised for its film-like color response with rich blacks, and vibrant lighter tones

Some TMOs have the following settings:

Exposure - (Default 1.0) The Exposure control is a multiplier for your color channels
Max Luminance - (Default 1.0) Luminance is the value of light reflected off a surface. The Max Luminance setting 
allows further control for exaggeration or damping down of reflections
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Cutoff -  (Default 0.025) Values below this level are treated as black

All TMOs have the following settings:

Hue - (Default 0.0 °) Rotate the color wheel to tint your render
Saturation - (Default 100 %) Reduce or increase the amount of saturation in the render
Brightness - (Default 100 %) Reduce or increase the overall brightness of the rendered image
Contrast - (Default 0 %) Reduce or increase the overall contrast of the rendered image

Settings are maintained between TMOs where possible.

Uses

Tonemapping is a great way to get a quick look at how to push your images for the best look. It's ideal in that it can be 
used in VPR, but it does take a floating-point image and remap it into display space; your images will no longer be in 
high dynamic range. If you are using LightWave in a compositing workflow, you should definitely not use tone mapping 
in LightWave because it is inherently destructive for final renders. Tone mapping should occur in the compositing 
application.
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Local Action Centering

The Local Action Center allows you to select disparate edges or polygons in your model and act on them as 
one, locally. This means that you move, rotate or scale each selected edge or polygon at its local origin rather than a 
single origin for all the disparate elements. The Local Action Center works on multiple layers at a time.

Using the Move tool with a Local action center will end up with the same result as prior to their addition, but Rotation is 
a different story. The animation shows the Rotate tool (Y) being used on polygons on different layers, using different 
Action Centers:

The Transform tools are also greatly improved with this addition to the Action Centers. We show Stretch (H) with the 
different Action Centers, but Scale (Shift-H) is similar:



LightWave 2020  –  LightWave 2020

New to 2020 –  54

Local also works with Symmetry:
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Scene / Dope Editor improvements

 There have been improvements in how the Scene / Dope Editor works with selection.

In Options... > Items, there are three toggles:

Auto-apply selection to viewports - Defaults to on in 2020. When checked, items selected in the Scene Editor 
will also be selected in the viewport
Always highlight viewport selection - Adds a full-line highlight for the selection, rather than just the check.
Always show full viewport selection - With this checked, the Scene Editor will unfold hierarchies to show the 
selected item and refold them when an item higher in the hierarchy is selected. If the hierarchy has been 
deliberately unfolded by the user, the Scene Editor will not refold it with a new selection

Improvements to pixel-level scrolling, using glyphs rather than bitmapped images and proper button elements will all 
speed up use. The standard Scene Editor has no options panel, but will also benefit from the pixel-level scroll, and use 
of glyphs instead of bitmapped images.
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Streamlining Environment systems

Introduction

The Environment light, available in LightWave 2018 and 2019, has taken on added importance in LightWave 
2020. It is now part of the default scene when opening Layout, and complements the functionality found in the 
Backdrop tab of the Effects window in previous versions of LightWave. Now, you can have environments specific to 
environment lights, or a scene global environment put in place in the usual Backdrops tab in the Effects window. There 
is no longer a need to balance the sampling of the backdrop, as before. The icon for the environment light will remain 
even though its location or scale in a scene has no effect. Rotation will only have an effect if a Textured Environment has 
been installed, and that effect will be to rotate the environment rather than the light. The environment light's color and 
intensity are multipliers for the environment plugins used.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=_fkX_QROGXo

http://youtube.com/watch?v=_fkX_QROGXo
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OpenVDB: New Tools

Advecting OpenVDB particles with motion blur

New and exciting tools have been added to the LightWave 2020 OpenVDB roster. You now have the ability to 
bring in Partio particle objects from other software, split and merge your vdb objects for interesting possibilities.

Advect Points node — Advect particles by velocity grid
Analysis node — Grid creation Gradient, Curvature, Laplacian, Closest Point, Divergence, Curl, Magnitude, Normalize
Combine Math node — Combine grids using math operators
Level Set Morph — Morph between level set grids
Partio Node — Load Houdini .HClassic particle files
VectorGrid Split and Merge — Split and merge Vector grids for further experimentation
Visualize node — Grid viewer with options

The Esc key has been bound to more OpenVDB operations allowing easier cancellation of long operations.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=lkyyiozAmbE

Right now, using Package Scene with a scene with OpenVDB files will package the whole GridCache folder for 
the content. If you use a single content directory rather than a project-based one you may find that this 
packaged GridCache folder is enormous and contains far more files than it needs for the one scene. The 
Package Scene utility will be more intelligent about what it packages in a future release. For now, we thought 
it was better to package too much rather than not enough when you are transporting scenes.



https://www.youtube.com/watch?v=lkyyiozAmbE
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Advect Points node

This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for
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Analysis node

This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.
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Combine Math node

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
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A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background


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Level Set Morph

Introduction

You can morph between polygonal objects. It's not easy because you have to have the same point and poly 
count, and those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the 
power to do the same using OpenVDB, and as you can see from the rotating teapot/bunny, the results can be very 
impressive.

Use

In the scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be 
close. In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 

You will need to freeze subpatched objects as they are not seen by OpenVDB
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sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Surfaces

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. Double 
click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

The above node tree will synchronize your surface morphing at the same time as the geometry

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=_B6RLJG63yQ

http://youtube.com/watch?v=_B6RLJG63yQ
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Controls

The first four controls are graded in terms of rapidity and quality. Change up from the first only if it is posing you 
problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out
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Partio Node
Click here to expand Table of Contents...

Introduction
Node

Attributes list

Usage
From Particles
As Particles
LightWave Volumetrics

Introduction

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic format, 
just replace the file extension in Houdini.

Node

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

Target - If you are using a volumetric object with the particle system, make sure it is targeted here
Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed



You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.


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Attributes list

Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Usage

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following:

From Particles

Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, sometimes a little bigger. 
This makes sure the particle spans the voxel cube; smaller and you might not see the particle rasterized.

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself



There are example Partio scenes in the content in OpenVDB/Partio_Node

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Using the Partio node with a From Particles node

As Particles

You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the destination node 
and then just get particles that can be used for other purposes - such as with old-fashioned HyperVoxels.
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Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab

LightWave Volumetrics

You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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VectorGrid Split and Merge

New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states
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Visualize node

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform
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Engineering updates
LightWave 2020 has had a variety of improvements under the hood. Not all are fully actualized but will develop as time 
goes on. You can read about them here:

A generalized Meta-Data System
Attributes and Properties
Enhance the LWBaseFuncs global
Implement the Component handlers for the LWSDK
New Components window
Redesign the motion system (Arbitrary rotation orders)
SDK to full UNICODE
Unified management of simulation systems
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A generalized Meta-Data System

 LightWave 2020 contains the start of a generalized meta-data system. The intent is to attach data to almost 
anything in LightWave for third parties to access.

We now have attributes, components, and LWBaseFuncs. Attributes are the data storage, components are plugins 
containing attributes, and the LWBaseFuncs API provides access to these components.
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Attributes and Properties

 In multiple places, most notably the Object and Camera Properties windows, you will now see two buttons 
where there used to be one Properties button. The Properties button is still there but has had its name truncated to P. 
The new button, just labeled A, is for Attributes. Right now, the Attributes panel can just call the Properties panel, but 
the idea is that cameras, objects, and other scene items will be able to make use of attributes to communicate with 
other parts of the software. For now, general users should ignore the A button.
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Enhance the LWBaseFuncs global

The LWBaseFuncs global of the LWSDK has been revamped to allow any plugin to query more information 
about any other plugin, including: name, file path, reference count, attributes, owner, and more. Plugins can also be 
notified of various changes to other plugins. This global is essential to plugins wanting to use components to share data 
via attributes. Plugins will need to be written to address this new functionality but it will mean that plugins will be able 
to talk to each other in the future, rather than being completely isolated and unaware of each other as they are now.
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Implement the Component handlers for the LWSDK

Components are a new addition to the LWSDK and are accessible to the user via Layout's Components panel. 
Components are containers for data and functionality, very much like plugins themselves. In fact, each component is a 
plugin instance. These plugins differ from others in that they are supported in more areas of LightWave, including: 
viewports, images/clips, the scene, the Layout application itself, and more. Data sharing is facilitated by the 
LWBaseFuncs LWSDK global and attributes.
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New Components window

In Layout's Utilities tab, there's a window new to 2020. The Components window shows components for 
LightWave, the current scene, for items in the scene or surfaces, images, nodes, and Graph Editor Channels.

Components are a new addition to the LWSDK. They are containers for data and functionality, very much like plugins 
themselves.  Each component is a plugin instance. These plugins differ from others in that they are supported in more 
areas of LightWave, including viewports, images/clips, the scene, the Layout application itself, and more. The new 
LWBaseFuncs LWSDK global and attributes facilitate data sharing - the possibility of communication has now been put 
in place, but it needs third party programmers to take advantage
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Redesign the motion system (Arbitrary rotation orders)
Click here to expand Table of Contents...

Introduction
Usage

Introduction

LightWave's rotation orders have always been fixed to HPB - Heading, Pitch, Bank. This can cause a problem 
called Gimbal Lock where two of the three axes are on the same plane. As an example to demonstrate:


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Here we have a model of an arrow, pointing in the +Z direction

Once it is rotated 90° up in the Pitch we can see that the Heading and Bank axes are in the same plane.

LightWave 2020 introduces the possibility to change Rotation Order per item, and saved with the scene file. Some of 
the reasons you might want to change rotation order:

From experience with other applications you are more comfortable working with a different rotation order than 
LightWave's native HPB order
You are using motion data baked with a rotation order that isn't HPB
Interchange with applications which use a different rotation order than HPB
The thing you are animating has its rotations more naturally described with a different rotation order
Some gimbal lock situations can be avoided, as an example repeat the example above. Gimbal lock because H 
and B are on the same plane. Switch order to HBP, and no gimbal lock at a Pitch of -90 or +90 degrees (of course 
HBP does have gimbal lock, but on a different axis to HPB)

Rotation orders are not keyframed, so no you can't change them partway through an animation. You can 
change the rotation order at any point, so it isn't forever locked in stone if you change it. Changing the rotation 
order will not change the heading/pitch/bank rotation values. It will only change the order in which they are 
evaluated. So changing the rotation order will change the orientation of the item. Choose wisely before setting 
up the animation of the item.


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Usage

The rotation order for an item is set in the Motion Options window (M). Under the dropdown for SplineControl there is 
a new menu for different rotation orders giving their XYZ and LightWave-style (HPB) names, as follows:

XYZ / PHB - Maya standard?
YZX / HBP
ZXY / BPH - Unity standard?
YXZ / HPB - LightWave default
XZY / PBH
ZYX / BHP

The Numeric Adjustment Controls in the lower left corner will update to show the correct heading.
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The Rotation gizmo for the item has different sizes for the three circles, the largest or outer is the first to be evaluated. 
The colors for the rings are always the same too:

Red - Y / Heading
Green - X / Pitch
Blue - Z / Bank

If you use the Same As Motion controller on rotation, it will convert between rotation orders to maintain shared 
direction.

There is a small trap when using different rotation orders with bones.

Bones are aligned along the +Z axis. The bank angle is the rotation around the Z axis, and is used by bones for twisting. 
The heading and pitch are for aiming the bone. This works fine with HPB order, as the bone can be aimed anywhere 
with H and P, and then independently twisted with B.

But in some rotation orders this is impossible. Specifically, HBP and PBH. In those rotation orders, a non-zero bank 
angle actually makes it impossible to aim the Z axis in some directions.

(Exercise for the reader: create a null with HBP rotation order; set bank to 45 degrees; then try to make the Z axis point 
straight up or down using only H and P).



LightWave 2020  –  LightWave 2020

New to 2020 –  83

SDK to full UNICODE

The SDK has now been made fully Unicode-compliant. The LWSDK now supports Unicode character encoding 
in all non-ASCII contexts. Not only does this allow plugins to use the full range of Unicode glyphs, but it also avoids 
garbled text due to mismatched LightWave language choice and plugin language intent. Now, plugins will properly see 
things as:

(Image used because the MySQL database used for Confluence doesn't like 4-byte Unicode characters)

This also allows the user to use file paths across locales and computer platforms without concern for character 
limitations. LightWave's extensive legacy LWSDK support provides compatibility with prior-built plugins. Such plugins 
will still have the previous limitations.
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Unified management of simulation systems

A new window has been added for more unified management of simulation systems. Right now, only Bullet is 
included in the window, while other simulation systems are waiting to be added. There is SDK example code for how to 
include your simulation system in this window, and you can reorder simulations in this window to better deal with 
interactions between simulation systems.
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Installation

Installing LightWave - Windows — Installing LightWave on 64-bit Windows-based systems
Installing LightWave - Macintosh — Installing LightWave on 64-bit macOS systems
Installing LightWave - Render node — Installing LightWave as a render node for Windows and Mac systems
Licensing — How to get a new purchase of LightWave properly licensed
Using LightWave — A general guide to LightWave and documentation use
Feedback — LightWave 2019's Feedback Agent is a great tool to use when reporting issues or making feature requests

Conventions for using LightWave
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Installing LightWave - Windows
Click here to expand Table of Contents...

System Requirements
Hardware
Operating System
Graphics Card

Upgrading From a Prior Version
Software Installation

Installation Options
Legacy Plugins

Running the Program

System Requirements

Hardware

64-bit
Intel® Core™ 2 or better or AMD64 with SSE4 instruction set (Bulldozer onwards)
System RAM: 4 GB minimum

Operating System

Windows 7 64-bit or better

Graphics Card

NVIDIA® GeForce® 9 series or ATI Radeon HD 4000 series (minimum)
Minimum Screen Resolution: 1280 x 1024 pixels

Recommended Graphics card: GeForce 10 series or newer at 1920 x 1080 or better

Upgrading From a Prior Version
Those upgrading from an older version of LightWave 3D may have a USB hardware key (or parallel key on Windows 
systems), also known as a "dongle". LightWave no longer requires a hardware key, but you may still find one useful at 
times (as, for example, if you freelance at a firm with strict network policies).

Otherwise, the same installation instructions apply for an upgrade as for new users. The installation program will not 
delete any existing objects, scenes, or images on your system unless an existing item has the same name and is in the 
same directory as an item that LightWave 2019 installs. For this reason, you should install LightWave 2019 in a new 
directory.


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Software Installation
Download and install the most recent version of LightWave for which you have a license here: https://
www.lightwave3d.com/account/. If you don’t already have an account you can download the trial version found here: 
https://www.lightwave3d.com/try_lightwave/ and then create one.

Installation Options

After accepting the EULA, you will be asked what type of installation you wish to perform. Choose the Render node
entry if this installation is intended exclusively for rendering, rather than creating LightWave assets.

LightWave asks whether you wish to expand the Python runtime library. Users not interested in scripting can ignore this 
option. The file extensions option is checked by default and should be unchecked only if you are running multiple 
versions of LightWave. The Network Render Controller advanced options let you choose between an explicitly-launched 
Task Tray application or a Windows service at startup. The fourth question pertains to how your machine will be 
identified for network rendering.

Legacy Plugins

LightWave has a long and rich history and many plugins from that history. If you find yourself needing a legacy plugin 
for resurrecting an old project or similar, you will find a file called legacy.zip  in the support\plugins folder.

NewTek strongly recommends that you backup your system before you install LightWave 3D.

https://www.lightwave3d.com/account/
https://www.lightwave3d.com/account/
https://www.lightwave3d.com/try_lightwave/
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Running the Program
LightWave 3D is started the same way as any other program on the particular platform on which it’s installed. 
LightWave 3D has two major applications that work together: Layout and Modeler. Each program can be started 
independently; however, you may also access them by clicking the appropriate button on their respective interfaces.

It has been reported that occasionally, the necessary libraries for proper Python use do not get installed. If this 
is the case for you, installing the following two Microsoft visual c++ re-distributable modules required for 
pywin32 to work will resolve the problem:

http://www.microsoft.com/download/en/details.aspx?id=13523

https://www.microsoft.com/en-us/download/details.aspx?id=30679



In the installation are a pair of icons for troubleshooting firewall settings on Windows 10 systems. The two 
icons labeled Configure are for tech support use and should only be started at the request of NewTek 
technical support staff. The LightWave folder will no longer be inside the NewTek folder in the Start menu - it 
will still be installed wherever you put it. Look for "LightWave" directly.



http://www.microsoft.com/download/en/details.aspx?id=13523
https://www.microsoft.com/en-us/download/details.aspx?id=30679
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Installing LightWave - Macintosh
Click here to expand Table of Contents...

System Requirements
Hardware
Operating System
Graphics Card

Upgrading From a Prior Version
Software Installation

Installation Options
Legacy Plugins

Running the Program

System Requirements

Hardware

Intel processor

Operating System

Sierra 10.12 or better

Graphics Card

NVIDIA® GeForce® 9 series or AMD Radeon HD 4000 series (minimum)
Minimum Screen Resolution: 1280 x 1024 pixels

Recommended Graphics card: GeForce 10 series or newer at 1920 x 1080 or better

Upgrading From a Prior Version
Those upgrading from an older version of LightWave 3D may have a USB hardware key (or parallel key on Windows 
systems), also known as a "dongle". LightWave no longer requires a hardware key, but you may still find one useful at 
times (as, for example, if you freelance at a firm with strict network policies).

Otherwise, the same installation instructions apply for an upgrade as for new users. The installation program will not 
delete any existing objects, scenes, or images on your system unless an existing item has the same name and is in the 
same directory as an item that LightWave 2019 installs. For this reason, you should install LightWave 2019 in a new 
directory.



NewTek strongly recommends that you backup your system before you install LightWave 3D.
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Software Installation
Download and install the most recent version of LightWave for which you have a license here: https://
www.lightwave3d.com/account/. If you don’t already have an account you can download the trial version found here: 
https://www.lightwave3d.com/try_lightwave/ and then create one.

Installation Options

After accepting the EULA, you will be asked what type of installation you wish to perform. Choose the Render node
entry if this installation is intended exclusively for rendering, rather than creating LightWave assets.

LightWave asks whether you wish to install Python Site Packages, leave them checked unless you have a specific reason 
to not want them since they will be expected by third-party Python scripts. If you say no to configuring Advanced 
Options for the NRC Service, you will be asked to provide a name for network rendering for your machine. The advanced 
options for the Network Render Controller start with the choice between an explicitly-launched Dock application or a 
System Service (or daemon) that runs at startup. Next, you are asked how you'd like your diagnostics output, and the 
question after pertains to how your machine will be referred to for network rendering. Lastly, there is a question 
referring to UNC mapping for network drive use. After these questions are answered or ignored, the installation will 
commence.

Legacy Plugins

LightWave has a long and rich history and many plugins from that history. If you find yourself needing a legacy plugin 
for resurrecting an old project or similar, you will find a file called legacy.zip  in the support\plugins folder.

Running the Program
LightWave 3D is started the same way as any other program on the particular platform on which it’s installed. 
LightWave 3D has two major applications that work together - Layout and Modeler - the icons for which are located in 
the LightWave folder. Each program can be started independently; however, you may also access them by clicking the 
appropriate button on their respective interfaces.

A symbolic link to the LightWave configuration files will be created in the Documents folder to allow easy 
access for licensing and clearing configs.



https://www.lightwave3d.com/account/
https://www.lightwave3d.com/account/
https://www.lightwave3d.com/try_lightwave/
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3.

Mac Customization

OS X: Running Without the Hub

Layout and Modeler communicate with each other to keep assets and other data synchronized.  Normally, this is 
accomplished via the "Hub".  The Hub is an application (Hub.app) that passes messages and data between applications 
connected to it.  Normally, Layout and Modeler automatically ensure the Hub is started and attempt to communicate 
with it.

Some users may want to use this form automatic data exchange mechanism. They might want to work on different 
projects in each application, prefer to synchronize data manually (by saving and loading files), or avoid some local issue 
involving the Hub’s communication protocol.

In such cases, there are several ways to prevent the Hub from launching when Layout and Modeler or started.

Prevent the Hub from being found.  The Hub is an application called "Hub.app".  Renaming it to something 
different prevents it from being found by Layout and Modeler; and they will not be able to connect with it.
Start Layout and Modeler with command line arguments from Terminal.  Terminal is an application built-it to 
macOS that allows users access to the command line arguments that Layout and Modeler offer.  Terminal uses 
the keyboard to execute commands.  Some familiarity with the Terminal is required for this approach.
Create a "bash" script that, when double-clicked from Finder, will launch Layout or Modeler with the desired 
command line arguments.  Both TextEdit and Terminal are used in this procedure.

Create a Script for Starting Layout without the Hub

1. Launch /Applications/TextEdit by double-clicking its icon.

2. Enter the following text into the edit window.  Please note that it is important to have the ".app" extension included 
in the filename. The location of your LightWave installation may differ, so adjust as needed.

3. Make sure the format is set to plain text.  Use the menu "Format | Make Plain Text", if necessary.  

4. Save the text file to your desktop as "Launch Layout NoHub.app". Make sure to avoid using a ".txt" extension when 
saving.

This approach can be used for "Layout.app" and "Modeler.app".

For Modeler, just replace occurrences of "Layout" with "Modeler".


#!/bin/sh

open /Applications/NewTek/LightWave3D_2018.0.6/Layout.app --args -0


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5. Open a Terminal window using the /Applications/Utilities/Terminal application.

6. The script must be 'executable' so it will launch as a command when double-clicked with the mouse instead of 
opening as a text file. Make sure the current working path is the desktop (enter "cd ~/Desktop" if necessary) then enter 
this command.

7. Now, you can double-click the icon to launch Layout without the Hub.

chmod +x "Launch Layout NoHub.app"

Note that on some OS configurations, you may need to prefix the file name with "./", or, to avoid using quotes, 
the spaces in the file name need to be escaped (i.e., a "\" before them).

So, either this:

chmod +x "./Launch Layout NoHub.app"

or this:

chmod +x ./Launch\ Layout\ NoHub.app

may need to be used instead.


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OS X Special Menu
Click here to expand Table of Contents...

⌘ Mimics Control Modifier
⌘ 'help' Mimics 'insert'
⌘ Fn Mimics Fn
Opaque Popup Menus
Opaque Utility Windows
Scroll Wheel Mimics Option-Mouse
Allow OpenGL Stereo
Full Screen
Allow Hi-Res OpenGL

The Macintosh version of LightWave features a titlebar menu labeled Special which hosts a number of Mac-specific options.

⌘ Mimics Control Modifier

On by default. With this option on, the command key (⌘) can be used instead of the Ctrl key for Ctrl key shortcuts, like 
Ctrl-L for Limited Region. Be aware there can be a conflict when ⌘Fn Mimics Fn is also on for Ctrl-Fn key shortcuts, like 
Ctrl F5 for the Effects window.

⌘ 'help' Mimics 'insert'

On by default. The Insert key on a Windows keyboard pauses playback of a scene, but a Macintosh keyboard doesn't 
always have one. This entry enables the Macintosh Help key to replace the Insert key.


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⌘ Fn Mimics Fn

On by default. On some Macintoshes, hitting the Function key uses a system-wide utility like raising or lowering volume. 
Using this entry enables direct function key use for shortcuts, like F5 for the Surface Editor.

Opaque Popup Menus

On by default. When off, popup menus and dropdown lists have a slightly transparent feel.

Opaque Utility Windows

Off by default. When enabled LightWave panels that cover any portion of the main window will become semi-
transparent during mouse manipulations within the main window.  This helps with viewport manipulations without 
moving the obscuring panels.

Scroll Wheel Mimics Option-Mouse

Off by default. This allows a mouse bi-directional scroll wheel/ball to manipulate viewports as if holding the option key 
while click-dragging the mouse pointer.  This aids in viewport navigation.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=oCbU78I8CMA

https://www.youtube.com/watch?v=oCbU78I8CMA
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Allow OpenGL Stereo

Off by default. Some Macs have display adapters that are capable of Stereo OpenGL (quad buffers).  Enabling this 
feature on display adapters that do not support it can be risky, so this feature is disabled by default.  A restart of LW is 
required when changing this setting.

Full Screen

Off by default. When on, LightWave fills the screen completely including the menu bar. The mouse needs to be moved to 
the top of the screen to see menus.

Allow Hi-Res OpenGL

Although LightWave 2019 supports HiDPI monitors automatically now, this menu choice is still a valid one. If your 
graphics card is not powerful enough, leaving this menu item in its default Off state may result in a faster OpenGL 
display. Layout must be restarted after changing this setting.
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Installing LightWave - Render node

 

When you launch the installer for LightWave you are presented with the choice of how to install. In addition to the 
Typical and Custom (Windows-only) choices, LightWave 2019 includes a Render Node option. This installs just those 
files needed to configure the host system as LightWave render node. After installation, the render node runs 
automatically in the background, without any user interaction needed. The machine will then be ready to appear in the 
NRC list of available computers.
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IPv4 Discovery
By default, render node discovery relies on the popular Bonjour zero-configuration network technology. However, if you 
wish, you can opt to use IPv4 discovery instead. This will work automatically, but if your network requires the default 
port number of 29572 to be changed, this needs to be set up when installing. To do so, choose to configure advanced 
options for the Network Render Controller. There are several options to configure here, but if all you want is to change 
the port number, click Next three times to get to the following screen:

The screen after is the naming for the NRC Service Identifier.

For completely unattended access on PC, select to configure advanced options for NRC and set to Windows 
Service. On Mac, select System Service.



For completely unattended installation, perhaps necessary when installing on machines not present at the 
install location, you can run the installer from the command line with arguments to select the various options 
without running the GUI. Run the installer executable from the command line with the " --help" option to see 
all the values that can be specified.


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--help

--help Display the list of valid options

--version Display product information

--unattendedmodeui <unattendedmodeui> Unattended Mode UI

Default: none

Allowed: none minimal minimalWithDialogs

--optionfile <optionfile> Installation option file

Default:

--debuglevel <debuglevel> Debug information level of verbosity

Default: 2

Allowed: 0 1 2 3 4

--mode <mode> Installation mode

Default: qt

Allowed: qt win32 unattended

--debugtrace <debugtrace> Debug filename

Default:

--installer-language <installer-language> Language selection

Default: en

Allowed: sq ar es_AR az eu pt_BR bg ca hr cs da nl en et fi fr 
de el he hu id it ja kk ko lv lt no fa pl pt ro ru sr zh_CN sk sl es 
sv th zh_TW tr tk va vi cy

--prefix <prefix> Installation Directory

Default: ***unknown variable platform_install_directory***/
NewTek/LightWave_2019.0.0

--
expand_python_PySid
e

<expand_python_PySide
>

PySide 1.2.4

Default: 1
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--
expand_python_pywin
32

<expand_python_pywin
32>

pywin32 2.19

Default: 1

--
expand_python_WinPD
B

<expand_python_WinPD
B>

WinPDB 1.4.8

Default: 1

--
expand_python_MySQ
Ldb

<expand_python_MySQ
Ldb>

MySQLdb 1.2.5

Default: 1

--expand_python_Nose <expand_python_Nose> Nose 1.3.8

Default: 1

--
expand_python_NumP
y

<expand_python_NumP
y>

NumPy 1.9.2

Default: 1

--
expand_python_runti
me

<expand_python_runtim
e>

Expand Python Runtime

Default: 1

--register_lws <register_lws> LightWave Scene (.lws)

Default: 1

--register_lwo <register_lwo> LightWave Object (.lwo)

Default: 1

--register_extensions <register_extensions> Register File Extensions

Default: 1

--node_advanced <node_advanced> Would you like to configure advanced options for the 
Network Render Controller Service?

Default: 0

--node_operation_type <node_operation_type> Select the NRC Service operation type

Default: task_tray

Allowed: task_tray service
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--node_account_type <node_account_type> Select the NRC Service account

Default: user

Allowed: user network system

--nrc_account_name <nrc_account_name> Account Name*

Default: .\<username>

--nrc_account_pass <nrc_account_pass> Account Password*

Default:

--logoutput <logoutput> Output Destination

Default: console

Allowed: console file

--loglevel <loglevel> Logging Level

Default: warn

Allowed: info warn error

--logfilename <logfilename> Log file

Default:

--fallbackport <fallbackport> Base fallback port

Default: 29572

--nodeid <nodeid> Network Render Controller Service Identifier

Default: <Machine_Name> NRC Service

--Setup <Setup> Setup Type

Default: Typical

Allowed: Typical Screamernet Custom
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The command line sequence:

LightWave_2019.0.0_Win64_installer.exe --mode unattended --prefix <install 
location> --node_operation_type service --Setup Screamernet --node_account_type 
network --nrc_account_name "NT AUTHORITY\NetworkService" --nrc_account_pass 
unused

This code block installs LightWave silently in "Render Node" mode, and sets the NRC Service to automatically 
start the Windows service on boot.


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Licensing

This version of LightWave uses a software-driven licensing scheme, applicable to Windows 64-bit, and Macintosh OS X. 
This approach facilitates online purchase and prompt delivery, without any need for a physical shipment (although a 
hardware dongle can be purchased on request when so desired).

Although no longer required, those upgrading from older versions that required a hardware key can continue to use it if 
they wish (see note in the section Upgrading From a Prior Version). Note that commercial plugins that use the SDK* to 
reference a dongle will now work without one. Also as before, multiple LightWave instances can be run concurrently on 
the same machine.

New purchasers of LightWave can purchase a hardware dongle on request but it won’t be necessary, meaning that 
LightWave can become a completely digital product making purchasing licenses much simpler since no physical 
product will need to be shipped.

Purchasing and Activation
The www.lightwave3d.com website is open 24/7, 365 days a year, so you can you buy a new LightWave license or 
upgrade to the latest version at your convenience. LightWave is also available through your favorite reseller, if you 
prefer.

To check out pricing, visit the Store pages at www.lightwave3d.com; you don’t need to be logged in to do so. Click Buy 
Now to display the price, including sales tax, in your local currency. If you wish to make a purchase, enter your payment 
details and hit next. A confirmation page allows you to review the details and make any necessary edits, and then you 

https://www.lightwave3d.com
https://www.lightwave3d.com
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can hit next again. After a few moments to process your payment, you will be presented with download options for 
LightWave and the license.key file.

To apply the license.lwk, just launch either Layout or Modeler, drag the lwk file icon over the window, and drop it. 
Afterward, to restart LightWave to activate your license.

Note: If you lack Internet access, send a letter containing your address, LightWave serial number, your reseller’s details, 
and what sort of computer you will use LightWave on to:

NewTek
Attn: Customer Service
5131 Beckwith Blvd
San Antonio, TX 78249

FAQ
Will my dongle continue to work?
Dongles will continue to work and can continue to be used. If you are still running Windows XP you will have to keep 
using the dongle. Software licensing needs Vista or more recent.

Will my commercial plugins work if I don’t use my dongle?
Commercial plugins tied to a dongle should* work equally well with the software license. 

I usually have several Layouts open and a couple of Modelers. Will I still be able to do that with a software dongle?

Multiple LightWave instances can be run on a machine using the software lock. However an alert is shown if multiple 
instances using one license are run on different machines on a single network.

What happens if I run multiple copies of the same license on different machines on the network?
You will get a message that your dongle could not be found and then a message saying that the number of licenses 
owned has been exceeded. You can either buy additional licenses or close other copies.

I like the dongle. Will I still be able to buy new seats using it?

Yes, you can purchase a dongle if you wish. Please allow adequate time for your order to arrive (you may, of course, use 
the fully-featured trial edition before your order arrives,).

I would like to upgrade an older license of LightWave that I bought from someone to the latest version. Will I be able 
to?
Yes.  As long as you bought a full version with a dongle you can upgrade it. Purchasing an older version of LightWave 
without a dongle means that the owner is selling an upgrade, not a full version.

If I want to drop my LightWave on a USB key and take it to a job can I?
Yes, but you will continue to need to use your dongle. The software license only works when you install LightWave 
locally using the provided installer.

If you already have the trial version of LightWave (11.0.3 or more recent) installed, you only need to download 
the license.lwk file, and apply that to your Trial Edition for it to become a full license.


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* Commercial plugins getting the Lock ID using the SDK will normally work without changes. Plugins using their own 
scheme may need to be updated.
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Using LightWave
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LightWave 3D
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Typefaces
Keystroke Combinations

Mouse Operations
Symbols
Using the Wiki Documentation

LightWave 3D
LightWave 3D’s many features are presented in two distinct and specialized environments. In general, LightWave 
Modeler, or simply 'Modeler', is focused on 3D object creation, while LightWave Layout (or just 'Layout') is where you 
stage these objects, animate them, and render output.

Layout employs numerous control panels to group related tools and features. Toolbar buttons typically serve as 
shortcuts to frequently used items in these panels. For this reason, this manual explores Layout’s features panel by 
panel, then continues with a more workflow-based discussion.

In contrast, most Modeler tools are provided in Toolbars, hence their explanation is generally organized in toolbar 
order.

Typographic Conventions
The following conventions will be used throughout this manual.

Typefaces

ALL CAPS        Computer keys, directories, device names (e.g., ENTER, C:\LIGHTWAVE\OBJECTS, CTRL+P, etc.).



•

•

•

There are several further parts of LightWave that you may or may not be running:

The Hub - The Hub is a communications tool with a black-on-gray icon in your Windows taskbar or OSX 
Dock that liaises between Layout and Modeler. It runs by default and is responsible for passing 
modifications in objects - either geometry or surfacing - between Modeler and Layout, or vice versa
NRC Tasker - If you are using the machine you installed LightWave on as a render node, it is likely you 
will have a green icon representing NRC.
The QT32 Server - This will run whenever you save to a Quicktime animation file and has a purple icon. 
Apple never created a 64-bit version of the format, so this server acts as a "translator" from 64-bit 
LightWave to 32-bit Quicktime





LightWave 2020  –  LightWave 2020

Installation –  106

Keystroke Combinations

KEY1 + KEY2    Simultaneous keystrokes. Hold the first key and press the second key.

Mouse Operations

LMB           Left mouse button

MMB          Middle mouse button (if present)

RMB          Right mouse button

Selecting       Single-clicking an element with the LMB so that it becomes active or 
selected.

Deselecting   Single-clicking an element with the LMB so that it becomes inactive or 
unselected.

Activating       Selecting an option by clicking on its toggle button.

Deactivating Unselecting an option by clicking on its toggle button.

Clicking          Placing your mouse pointer over something and then pressing a mouse 
button. This nearly always means the LMB.

Right-clicking      Clicking an element with your RMB.

Double-clicking     Rapidly clicking an element twice.

Dragging         Selecting an element with your mouse pointer and continuing to hold 
the mouse button down as you move your mouse. This nearly always 
means with the LMB.

Symbols

The warning symbol will highlight a discussion that warns you about something. You should pay special 
attention to text marked with this symbol.



The Info symbol will give you some additional information about the section you're in.
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Using the Wiki Documentation
While first-time users may wish to start at the beginning and proceed through the entire manual, if you need to find 
something specific, the Wiki’s Search feature can save a lot of time.

The note symbol will highlight a discussion that is particularly noteworthy or interesting information that will 
not necessarily make you smarter with LightWave, but will allow you to amaze and amuse your friends with 
your inside knowledge of 3D industry trivia.


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Feedback

Feedback Agent
User feedback is the life blood of LightWave’s development. The Feedback Agent is provided so you can give the 3D 
Team the best possible information about issues you may encounter, or features you’d like to request. It can create a 
log when problems occur, and email it directly to NewTek’s bug reporting system.

To access the Feedback Agent, visit the Help menu in either Layout or Modeler. There you will see the following options:

Choose whichever is appropriate and you will be presented with the following window:

The first step is to fill your identity. We'll want to keep you updated for the progress for your report, so it's important 
you enter your details correctly here.
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Enter a real email address so we can keep you informed of progress with your bug or feature request

You can have the Feedback Agent remember your credentials to avoid having to enter them every time in a file with the 
rest of your configs on your machine. Once you have entered your name and email, Step 2 becomes available.

Step 2: Details is where you'll choose the category for your specific bug. 

If you don't see a category that specifically applies to your issue, pick the closest you can see and make sure the issue is 
well-described on the next tab. Note the steps completed. You won't be able to send your report until you have 
completed all seven steps.
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As the two fields say, add a descriptive report. The title field has a dropdown that shows the last five report titles you 
have used so that if you are making a series of reports you can speed up entering a title. The red outline disappears 
when you enter text.

Once you have entered details into both these fields you can move onto Step 4: Attachments.

Files can be pasted, dragged and dropped into this window or input using the Attach Files... button. You can remove 
selected files or clear them all with the other two buttons on the left side. There is a Take Screen Shot... button that 
allows you to grab a screenshot directly from within the Feedback Agent. The Agent window will minimize, there will be 
a two-second delay (that the user can change by typing in the Delay: field) and the cursor will change to a crosshair that 
can be drawn across the screen to capture an area. In the case of a multi-monitor setup, the mouse must be positioned 
on the target screen before the delay timer expires.

Once drawn, a field will appear to name the image and then the Feedback Agent window will reappear with the 
captured image.
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Then your image will appear in the list of attachments. Hovering over the list will show your grab.

There is also the option to do an Enhanced Capture. This presents handles to resize the grab and a handle in the center 
(with the extents of the grab) to move it around the screen.

The grab is completed by pressing the right mouse button.

Lastly on this page is the Privatize content (NDA) buttton. This will ensure that any content is stripped from any public-
facing version of the report and kept securely in our vaults.
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Once there is at least one attachment the Send... button will become available. Clicking it will send your report to 
NewTek. Once sent, the Feedback Agent closes.

The last tab Feedback Agent Settings is always available and consists of information for system admins. It is protected 
by first presenting a warning.

Although we've discussed Bug Reports here, the process is identical for Feature Requests but a grab is not essential.

Mac users will find a symlink for the configs folder (by default hidden) in the default Documents folder.
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LightWave’s Virtual World
As you likely know, the world is flat. Well, it is in most 3D applications anyway, as it relates to situating items in 3-
dimensional space. In the real world, you might use an item’s latitude, longitude, and elevation to describe its location. 
In LightWave's 3D domain, coordinates along X, Y and Z axes serve in a similar fashion.

By default, from the viewpoint of a user peering into the monitor, LightWave’s virtual ground plane extends left and 
right along the X axis from its midpoint, where X = 0. Positive X coordinates extend to the right of center, while negative 
values are to the left.

Similarly, from the midpoint (or 'Origin', where X, Y and Z coordinates all = 0), the ground plane extends rearward into 
the distance along the positive Z axis, and forward to the viewer (negative Z).

The Y axis is vertical, corresponding to elevation. Thus, relative to the Origin, where it intersects the ground plane at 
Y=0, elevation is expressed in positive (above) or negative (below) values.

Let’s consider an example: In the image below, we’ve loaded the Alien Emissary object supplied with the LW 2020 demo 
content. Notice that the object we loaded faces the positive Z direction, away from the viewer, and appears to be 
standing on the ground plane.


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Although not absolutely required, it’s standard practice to deliberately create 3D objects 
that load in this orientation and location. Of course, in most cases you will ultimately 
move them away from the Origin to create your composition or animation, but there are 
practical advantages to this convention.

World and Local Axes
Objects in a scene also have axes and, thus, an Origin, called the local Origin. When an object is first loaded, its local 
Origin is lined up with the world Origin. Moreover, its local axes are lined up with the world axes. However, once you 
move or rotate the object, this is no longer the case. LightWave provides functions that let you move and rotate items 
using global or local axes. Most of the time you’ll use World, but sometimes using Local will be invaluable.

To illustrate the difference, let’s imagine our alien is standing in the middle of a one-room house facing the front door. 
Her right arm is straight out and pointing to the right side of the house. Her left arm points to the left side of the house.
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Now, let’s say you turned her 90 degrees clockwise (to face the right side of the house.) If I told you to point her right 
arm towards the house’s right side (global axes), you’d move it straight out in front of her. However, if I told you to point 
her right arm to her right (local axes), she would point to the back of the house.

Commonly, you will modify objects – rotate, scale or stretch them – using their Local Coordinates (Origin and axes) 
while placing them in your 3D world using the World coordinate system.

Your Point of View
By default, Layout uses a single viewport. Later on in this section, you’ll learn how to use up to four simultaneous 
viewports. You can choose between several different points of view (POV) for each viewport using the View Type pop-up 
menu at each viewport’s top-left corner. Manipulating items in virtual 3D space on a 2D display (i.e., your monitor) can 
be difficult at times. Selecting a more suitable view often makes it much easier to perform a tricky operation.

It is sometimes easier to work in just two dimensions at a time. The options with the axis notations (e.g., Top (XZ)) are 
the "orthogonal" views, which let you move items in only two dimensions (horizontally or vertically), along the XY, XZ, 
or ZY axes. The (none) setting blanks out the viewport.

Note that there are two options for each axis set. This allows you to look in either direction along the perpendicular axis 
(e.g., Top (XZ) and Bottom (XZ). For these, Y is the perpendicular axis.)The Perspective view is a forced-perspective view. 
That is, it gives you a three-dimensional look at your scene.

The orthogonal and the Perspective views are dependent on each other. Changing the position of one will affect the 
other.
There are also pseudo-physical POVs. When setting up a light, you’ll often want to look through it to see exactly what it 
points at. In such a case, you’ll use the Light view to look through the current light. You’ll always want to see your scene 
from the Camera view at some point since that is the perspective used in your rendered images.
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Anatomy of a New Scene

Opening Layout, or starting a new scene, you are presented with the view above

A new scene in LightWave always contains three things:

A Camera
A Distant Light for directional lighting
An Environment Light for the background of the scene

You can delete one of the two lights, but a scene in LightWave always requires at least one light and a camera. This is 
the only moment in Layout where you can have nothing selected. By default, Layout is in Object mode at the start of a 
new scene but there are no objects present.
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User Interface Overview
LightWave’s Layout has been designed to provide the most efficient interface possible for your 3D animation work. 
Layout’s viewports provide visual feedback about the virtual world you are creating. By default, a single large viewport 
is displayed, but you can add more viewports showing different aspects of the project when that would be helpful. The 
display can be a highly detailed representation, or - depending on the scene’s complexity, your machine’s capabilities, 
and other factors - you can choose different modes. The modes range from bounding box stand-ins to wireframe 
representations of the scene, or perhaps textured or solid-shaded renditions. At the highest fidelity, you can use 
LightWave's render engine VPR to render an image directly in the viewport (as shown below).

1. Top Toolbar, 2. Layout Tabs, 3. Modeler Access, 4. Toolbar, 5. Workspace, 6. Numeric Adjustment Controls, 7. Grid 
Display, 8. Start Frame, 9. Timeline, 10. Tooltips, 11. Current Item, 12. Item Picker, 13. Edit Mode, 14. Properties, 15. 
Selection Info, 16. Keyframe Options, 17. End Frame, 18. Transport Controls, 19. Preview, 20. Undo/Redo, 21. Rate/Step, 
22. Viewport Menus



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  119

•
•
•
•
•
•
•
•
•

1. Top ToolBar

 
The Top Tool Bar buttons will appear no matter which Tab is selected and contains elements that are always required, 
such as File and Edit menus. You can completely hide (or unhide) the toolbar by pressing Alt +F2 (or choosing Edit > 
Display Options > Hide Toolbar On/Off).

2. Layout Tabs

 
The tabs located at the top of the interface will determine which tools appear in the Tool Bar. Generally, menu group 
names that are verbs contain commands based on the type of action they perform. Menu group names that are nouns 
contain commands based on the type of object they affect. The menu tab names are all intended to be read as verbs.

Items - Things to add to your scene, such as objects, lights or cameras
Modify - Animating scene items
Setup - Rigging and related tools
FX Tools - Simulation, Flocking, and Fiber FX
Render - Setting up, and starting scene or image renders
View - Tools for organizing viewports
Model - Creating quick geometry inside Layout
I/O - Working with other applications such as After Effects, ZBrush and others
Utilities - Plugins and scripting

Note also that when in VPR mode, there is an additional dropdown listing buffers to render.
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3. Modeler Access

 
This command will switch to your Modeler window if it is open or opens Modeler if you do not already have it open.

4. Toolbar

 
The buttons presented in this toolbar will depend on which menu tab you select along the top.
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5. Workspace

 
The Workspace consists of Viewports. By default, there is a single large viewport, but you can display multiple viewports 
if you desire (using the F3 and F4 keyboard shortcuts or visiting Options > Display). A viewport provides you with visual 
feedback about the virtual world you are creating.

Viewport Titlebar

 
You can change the View Type and Rendering Style of a viewport without going to the Display Options Panel by using 
the pop-up menus on the left side of each viewport titlebar. The third dropdown arrow gives more Viewport Options.

The buttons on the right side of a viewport affect centering, panning, rotating, zooming, and minimizing/maximizing 
your view.

6. Numeric Adjustment Controls

As we’ll see shortly, you can alter the position, orientation, and scale of items in your scene interactively; at times, 
though, you’ll need greater precision. Three number fields, labeled either X, Y, and Z, or H (Heading), P (Pitch), and B 
(Bank) according to the current edit mode, let you use direct entry to control the corresponding values.
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Constraining Modifications
Whether you are moving, rotating, or stretching an item, or moving its pivot point, Layout lets you independently 
deactivate any of the three components used for those settings. You deactivate the components by clicking on them on 
the information display in the lower-left corner of the screen. This protects the deactivated component(s) from 
changing as you move your mouse.

The Y channel won’t be affected when moving the currently-selected item

You can also confine changes by using any of the orthogonal views (i.e., Front, Top, and Side). In these views, you can 
generally make changes only along the display’s horizontal and vertical axes using your mouse.

7. Grid Display

 
The grid serves as a visual reference when you move items around, but it will never render in a final image (no matter 
how much you wish it to). The grid lines are darker every tenth square for visual reference. The Origin is located at the 
center of the grid.

You can find the current size of the grid squares in the information field at the very lower-left corner of the screen. The 
size of each grid square is adjustable, as is its overall size, on the Display Options Tab of the Preferences Panel (Edit > 
Display Options). Note that adjusting the size of the grid squares also affects the relative size of the representative 
camera and light icons within the scene.

8. Start Frame

 
This displays the first frame of the scene. It can be raised or lowered. This number remains in frames, even if you should 
set the timeline to be displayed in one of the other options (SMPTE, Film Key, Seconds) in the Options window. By 
default, it is set to 0. If you wish to offset the default Start Frame visit the Defaults tab in Preference.
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9. Timeline and Dope Track

The Timeline, located beneath the viewport area, hosts a Frame Slider that you can drag horizontally to change the 
current frame or shuttle through your scene. The input field left of the timeline is the scene’s first frame. The last frame 
is shown at right. Both first and last frames can be edited by simply typing a new value.

Another time-related feature, the Dope Track, appears just above the Timeline (if the Dope Track is not visible, make it 
visible by clicking the thick bar above the timeline; click again to close it). The Dope track plays a vital role in connection 
with animation. Until now, we’ve mostly discussed 3D space, but of course, animation involves a fourth dimension – 
time. Broadly speaking, animation involves changing an item’s position, orientation, or other properties over time.

The timing of the animation is governed by "Keyframes," or simply "Keys." Keys are fixed points in time where you have 
assigned specific values to the item’s properties. You might place a Sun object in your virtual sky at frame 1 and set a 
keyframe there, storing its X, Y, Z coordinates, and other properties at that point in time. Your sun will happily sit there 
all day long. But, if you advance the current frame to a later point in time, then move the sun some distance and set 
another keyframe, the Sun will now gradually move to this new position as the animation progresses.

We explain this here because, while the regular Timeline lets you see where keys exist, the Dope Track enables you to 
set, move, and define keys. In addition, it lets you add (passive) markers to help you navigate quickly in a scene, and 
also 'bake' ranges of keys to make your animation concrete.

10. Tooltip

 
This line of the interface shows information about tool actions or potential actions, and the render time for VPR as 
shown.

11. Current Item

The various items you can edit in LightWave all fall into one of four categories: Objects (including dynamics), Lights, 
Cameras, and Bones (which are contained within objects; choose the object first, then switch to Bone edit mode). You 
can only select one type of item to edit at a time; you cannot, for example, select a camera and an object together.
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There are several ways to designate which type of item with which you wish to work. You might simply click an item in a 
viewport to select it; the Current Item and Edit Mode will update accordingly. Or you can choose an Edit Mode button 
directly (13), then select the desired entry in the Current Item dropdown menu.

12. Item Picker

The Item Picker window allows you to select one or more objects quickly and to set up selection sets of objects for 
faster use.

13. Edit Mode

The Current Item dropdown menu only lists items in the same category as your current Edit Mode.
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As mentioned above you can only choose items from one of LightWave’s four groups at the same time. You can switch 
between the groups with these four buttons.

14. Properties

 
This button brings up a Properties window for the four item types. There’s a window for Objects, one for Bones and 
Lights and Cameras share a window.

15. Selection Info

 
The Selection Info displays how many items are selected.

16. Keyframe options

We discussed the role of keys (keyframes) earlier. The Create Key and Delete Key commands create or delete a key at 
the current frame (note that the button labels also show shortcut keystrokes, which will make your work much faster as 
you become familiar with them).

The Auto Key options just above can automate key creation, by automatically generating a key whenever you change an 
item’s animatable properties. The associated menu provides several alternative automation methods, discussed in 
detail later.

To automatically create or modify keys, you must activate the Auto Key option on the main interface. This is the global 
on/off switch for automatically creating keyframes. It works in conjunction with the Auto Key Create setting (General 
Options Tab of the Preferences Panel).

Use the Create Key and Delete Key commands to add and remove keyframes.
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17. End Frame

 
This displays the last frame of the scene. You can raise or lower the end frame. This number remains in frames, even if 
you should set the timeline to be displayed in one of the other options (SMPTE, Film Key, Seconds) in the Options 
window.

18. Transport Controls

 
Besides dragging the frame slider to navigate through your scene, you can also use the transport controls described 
here.

19. Preview

 
You can render a previsualization of your scene for when playback in Layout is not fast enough. A rendered preview will 
play at full speed regardless of how complicated your scene gets.

20. Undo/Redo

 
The Undo and Redo functions were completely overhauled in 2019. They will now not only reverse motion changes 
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(Move, Rotate, Size, or Stretch tool) that you have made but you can revert changes made in Dopetrack, the Scene 
Editors, the Graph Editor and server panes throughout LightWave. The Redo function will re-execute a sequence of 
actions that have been undone, beginning with the action most recently undone. You can set the number of undo levels 
that you wish to have available in the General Options tab of the Preferences Panel, discussed later, in the Edit Menu 
section. If there are no actions available to undo, the Undo button will be ghosted. The Redo button is ghosted if there 
are no actions available to redo.

If you are not using the Auto Key feature, you can quickly reset all aspects of a frame (i.e., position, rotation, etc.) if you 
haven’t created the key yet. Just press the Right cursor key and then the Left cursor key. This advances the current 
frame and then goes back to the original frame. The frame will return to the last keyframed state, or if the frame is not a 
keyframe, to its in-between state.

21. Rate/Step

 
This value sets the speed of playback. If you have the option Play at Exact Rate checked in Options, then this field will be 
labeled Rate. If not, it will be labeled Step. Rate is a percentage of real time, while Step is what frames will play - 1 
indicates every frame, 2 means every other frame, 3 indicates every third frame, and so on.

22. Viewport Menus
At the top left of all viewports in Layout, whether the single large viewport or the set of four, there are three or four 
dropdown menus.

View - This menu controls what you are looking at in the viewport. The choices are:
(none) - An empty viewport
Top (XZ) - This shows the scene from the top. Default keyboard shortcut Numpad 2
Bottom (XZ) - This shows the scene from the underside. Default keyboard shortcut with a second hit on 
Numpad 2
Back (XY) - Looking towards the front of the scene. Default keyboard shortcut Numpad 1
Front (XY) - The scene is shown looking from the front toward the back. Default keyboard shortcut with a 
second hit on Numpad 1
Right (ZY) - Scene is shown looking at the right side. Default keyboard shortcut Numpad 3
Left (XY) - Scene is shown looking at the left side. Default keyboard shortcut with a second hit on 
Numpad 3
Perspective - A rapidly-navigated view of the scene in perspective from any angle. Default keyboard 
shortcut Numpad 4
Light View - View through the current active light. A specific light can equally be chosen from the menu. 
Default keyboard shortcut numpad 5
Camera View - View through the currently active camera. A specific camera can be selected from the 
menu. Default keyboard shortcut Numpad 6
Schematic - presents a nodal view of scene make-up

Type - The type of OpenGL display:
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Bounding Box - Only shows the bounding boxes of scene objects
Vertices - Only the points of scene objects are shown
Wireframe - Scene objects are shown as wireframes
Front Face Wireframe - When the scene is heavy, showing only the front faces of objects can lighten the 
load
Shaded Solid - Polygons are solid but untextured. Only the basic color is shown
Textured Shaded Solid - The most realistic OpenGL mode. Some texturing will be visible
Textured Shaded Solid Wireframe - As above, but wireframes are visible too

VPR - The interactive renderer
Surface Preview - The view of an individual surface for editing

Render - An interactive view of the different render buffers. The full list is available here.
Options - Viewport options for OpenGL and VPR:
The items on the Viewport Options menu are as follows. Not all are available at the same time.

Bone Weight Shade - shows the selected bone’s influence range in any shaded viewport. The influence 
coloring is based on each bone’s color, which can be changed in the Scene Editor. A bright yellow is used 
for the currently selected bone. Note that the bone must be active to see this effect. This mode will 
override the normal texture display.
Bone X-Ray - By default Bone X-Ray is on to show bones inside geometry. Note that bones may still be 
invisible if the object surface is similarly colored/shaded. Change the bone colors using the Scene Editor, 
if this becomes a problem. If you wish to switch off Bone X-Ray you can uncheck the item in the Viewport 
Options menu.

DOF/MBlur Preview - Only available in Camera view mode. Gives a preview of scene motion blur and 
Depth of Field. The number of passes can be set at the bottom of Display Options.
Headlight - Provides an OpenGL-only, nondirectional light to illuminate dark scenes for easier work.

Center Current Item - For an object, the centering is based on its pivot point. This is not always the 
center of an object. If you deactivate this mode, either through the menu or the viewport icon, the 
existing POV position will remain until changed. As such, you can use this feature to establish a starting 
point if the need arises.

Set View Position, Rotation, Zoom... - Opens a requester for setting the viewport numerically.
Reset View Position, Rotation, Zoom - Resets to the default values when opening Layout.

Viewport Layout - Opens a sub-menu containing the 12 different view types. If a type with multiple 
viewports is chosen, each individual viewport will contain a viewport options menu. Choosing a different 
layout changes all the Layout viewports, not just the one in which you are choosing a new viewport 
layout. The layouts can also be chosen from the Options panel or by stepping through them with F3 and 
F4. 

Match Viewport Perspective - Only works in Camera or Light mode. Opens a sub-menu with four 
options:

Selected Camera
New Camera
Selected Light
New Light
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Store View - Stores the current Layout viewport orientation. Only one viewport can be stored if in a 
multi-viewport display. Stores the view in the scene file so the view will be available after a reload of the 
scene
Recall View - Retrieves the stored viewport orientation. This only works with the same viewport that was 
stored

OpenGL Wireframe - This and the OpenGL Overlay item below are only available when VPR is engaged. 
OpenGL Wireframe presents a wireframe over the rendered object.
OpenGL Overlay - This and the OpenGL Wireframe item below are only available when VPR is engaged. 
OpenGL Overlay presents a wireframe view of your scene elements, like lights, the grid and transform 
widgets, laid over the rendered view.
Show OpenGL UI - Shows or hides non-renderable interface elements.

When the viewport is showing VPR, two additional options become available:
Draft Mode - disabled by default, Draft mode applies a specific set of values
Mouse Refinement - On by default, this centers VPR refinement on the mouse position. This option can 
slow rendering slightly, if your scene is complex, try switching it off.
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Layout Tab - Items

This is the main tab you will use to Load, Add, Replace, Select and Delete items in your 
scene. Perhaps one of the first keyboard shortcuts to learn is + to load an object, and 
the second will be Ctrl N to add a Null. Other useful keyboard chortcuts include Alt-C to 
copy an object as an instance, and Shift-V to mirror an object.

Click here to expand Table of Contents...

Add

Null

(default keyboard shortcut Ctrl-N)

The Null Object

Null objects are special objects that can be used for many different purposes in LightWave Nulls can act as a target or 
parent item for lights or cameras, or perhaps a handle to help in manipulating a group of objects. They are often used 
with object/bone hierarchies to group major components and with Inverse Kinematics to act as goals for items to reach 
for.


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Example of a character using Null objects for Inverse Kinematics and Proxy Items.
Null objects appear in the Layout window as six-pointed stars or jacks; however, they never render in an image. Null 
objects, like the camera and lights, will appear to grow or shrink in relation to objects as the grid size is changed. They 
can be moved, rotated, scaled, and so on, just like any regular object.

You can change the appearance of a Null object by applying “Item Shape” in the Add Custom Object list, within 
the Object Properties panel.


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2.

3.

Null Objects with Item Shape Applied
To add a null object:

Select Items > Add Null (or hit Ctrl-N).
Enter the name you wish to use for the null object in the dialog that appears or accept the default name of 
“Null.”
If you would like to change the properties of the null click on Edit and the menu will expand.
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Shape - Determines the shape of the null. Standard is the default Star null
Axis - Determines the direction the null faces towards the positive axis
Filled - If this option is available and you select it, the item shape will be a solid color
Label - You can enter text which will be displayed in the viewports
Justification - If you enter text in the Label section, you can specify where on the null where to display that text
Draw Line To - Will draw a line from the null to the selected item
Selected Color - When the null is selected, this will be the color of the null
Unselected Color - When the null is not selected, this will be the color of the null
Text Color - If you have entered text, this will be the color of the text
Opacity - Determines the opacity of the null - whether it is transparent and see-through or solid

Null objects are created by LightWave on a scene-by-scene basis and are not real objects that can be saved to disk. They 
remain part of the scene file, however, and will reload with the scene.

Lights

Choose Items > Add > Lights and select the desired light type from the submenu. A dialog prompts you for a name when 
you add lights. Click OK to accept the default or type in the name you wish to use and click OK.

When there are multiple items of the same type with the same name, a numerical suffix is added automatically 
(e.g., Null (1), Null (2), etc.).


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Camera

You can add additional cameras by choosing Items > Add > Camera; however, only the Current Camera is used to render 
a scene. If you have more than one camera in the scene, use the Current Camera pop-up menu on the Camera 
Properties Panel (or Layout’s Current Item pop-up menu) to select the currently active camera. A dialog prompts you for 
a name when you add a Camera. Click OK to accept the default or type in the name you wish to use and click OK.

Convert Powergons

Powergons allow you to execute a short Layout command script, which is attached to selected polygons in Modeler. You 
can use this feature to quickly add, say, lights using polygons for positioning. Moreover, all of the lights properties can 
be defined as well.

Executing the Commands

Powergon commands that are attached in Modeler can be loaded into Layout. Then choose Items > Add > CVT 
Powergons. This executes any command scripts attached to the selected object.

Clone

This opens a submenu with four items:

Clone

(default keyboard shortcut Ctrl C)

See Lights for more information

See Camera for more information

For more information about Powergons see Add/Edit PGons
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1.

2.

If you want to duplicate an item that is already in your scene, you can just choose Items > Add > Clone > Clone. The new 
item will inherit all of the source items properties and motion. As such, this can be a real time saver.

Steps to cloning an item:

Select the item you would like to clone.

Choose Clone ( Items > Clone ) and input the number of clones you would like to create. Click OK.
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3. You should now have clones of your original object.

Clone Hierarchy

(default keyboard shortcut Shift Ctrl C)

If you want to duplicate an item and all of its children in a hierarchy that is already in your scene, you can just choose 
Items > Add > Clone > Clone Hierarchy. The new items will inherit all of the source items properties and motion. As such, 
this can be a real time saver.

The newly created Clone(s) will be located at the exact coordinates as the original so you will need to move 
them.


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Clone Instance

(default keyboard shortcut Alt-C)

This will create a null, with an Instancer, with an instance of the original object. The object in the scene will be called 
“<Original Object Name>_inst”. Very useful for placing instanced trees or cars in a scene for example.

Python Bake Instance

This will converted instanced geometry into real objects.. To use, select the original of the instanced objects and run 
this command.

The newly created Clone(s) will be located at the exact coordinates as the originals so you will need to move 
them.


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Mirror

(default keyboard shortcut Shift V)
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1.

2.

If you want to duplicate an item or group of items that are already in your scene, you can choose Items > Add > Mirror. 
This tool works in a very similar way to clone with one difference. Instead of duplicating the selected item(s) on top of 
themselves, Mirror gives you the option to mirror the selected items along the X, Y, or Z axis.

Steps for using Mirror in Layout:

Select the item or items you would like to duplicate.

Choose Mirror ( Items > Mirror ) and a dialog box will appear. Choose the Axis to Mirror on, you can choose an 
offset.
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3. Click OK.

Array

Array is a non-interactive tool that will create an array, rectangular or radial, of selected items.

Your original items and the mirrored ones will remain selected.
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Rectangular

The Total Counts at the top of the window represent the final object count in your array.
The Distances can be individually set as

Between - The distance between each member of the array
Multiply - the distance between the members of the array gets multiplied by the number from the original unit. 
That’s to say, the original item is item one, the second item in the array in a direction is item 2 and so on. The 
distances between arrayed items will be Item 2 at 4 m, item 3 at 6 m and so on.
Total - the arrayed item quantity will all fit in the distance entered.

Array cannot be undone, so the best way to use it is to save your scene and create the array. If it isn’t exactly as 
you’d like Revert Scene to Last Saved.


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Radial

Total Count - will be how many items are in the radial array.
Axis - will be around which axis the array will be created.
Rotation - Is how far in degrees you would like the radial array to go.
Clone Rotation - This can be set to either:

Normal - The cloned items are rotated so that they face “along” the line the are cloned on.
None - The clones maintain their original aspect.

Offset - This value gives an offset between clones based the Rotation Center values given.
Copy Center from - Allows you to use another scene item as the basis of your radial array. It is purely that item’s 
coordinates that are used. It is not otherwise implicated in the array.

Common

Random Position +/- - gives a random offset in the X,Y and Z dimensions to the positive and negative of the 
extent chosen to each item in the array.
Rotation +/- - gives a random rotation in the H, P and B dimensions to the positive and negative of the extent 
chosen to each item in the array.
Scale +/- - gives a random scale in the X, Y and Z dimensions to the positive and negative of the extent chosen to 
each item in the array.
Clone Hierarchy - For each item, its descendant(s) will also be copied.
Group Clones on Null - When the clones are created, they will all be parented to a null called Rectangular or 
Radial_Array_Group .

Replace

Rename

You can rename the current item, like cameras, bones, and lights, but not objects, using Items > Replace > Rename.

Replace

The commands found in the Items > Replace > Replace drop down menu let you replace the current object with another 
object, a layer from another object or a null object. You might use this feature to animate a very complex object by 
inserting a stand-in object with a low-polygon count and then replacing it when it is time to render.

Replacing a Multi-layer Object

When replacing a multi-layer object, select the first layer before replacing. The first layer will be replaced with the first 
layer from the new object file. Subsequent layers - belonging to the same original object - will be replaced if their layer 
numbers match those found in the new object file.

You can also use Items > Replace > Replace > With Layer to replace an object with a single layer from a multi-layered 
object. A dialog will appear to let you specify the layer.
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Layout Tab - Modify

This tab will allow you to Move, Rotate, Size and Stretch scene objects, although you 
probably won't need to switch to it for that, since rolling the mouse wheel switches 
between those options. You will want to switch to this tab to use tools like Move and 
Rotate Pivot. You can get more detailed information on all these tools at:

Motion Path Group
Arrange Group
Modify - General Group
Modify - Tools Group
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Motion Path Group

Click here to expand Table of Contents...
Move Path
Path Tool
Copy Motion
Paste Motion

Move Path

You can move an item’s entire motion path directly in a viewport using the Move Path tool (Modify > Translate > Move 
Path).

 


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Path Tool

(default keyboard shortcut Ctrl Y)

The Path Tool (Modify > Translate > Path Tool) will allow you to directly edit the current item’s motion path in a Layout 
viewport. To use, simply activate the Path tool and drag any of the current item’s keys. The perfect tool for tweaking an 
item’s motion path.

Green Handles on motion path represent each Keyframe.

The key will only move along the vertical and horizontal axes of the view, even in perspective.

Copy Motion

Copies the selected items motion path

Paste Motion

Replaces the motion path of an item with a copied one.

There is no undo for this action and no warning. Save before using it so that the scene can be reverted if the 
results are not what you expect.


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Arrange Group

Align and Distribute

Align and Distribute

Located on the Modify Tab > Arrange Group in Layout, these small but useful tools make aligning and spacing items 
equally in Layout easier. The Align tools work in much the same way as the Align to Last Point tools in Modeler, but for 
any Layout Scene items. To use them select the items you wish to align, then select the last item to which you want to 
align the other items. From the Align menu choose which axis (X/Y/Z) you wish to align against. Once clicked, all the 
items you selected will be aligned to the last item’s axis you picked.

To distribute, or equally space items, you don’t need to worry about the selection order, simply select the items you 
wish to equally space between each other, and choose the axis (X/Y/Z, or All Axis) you want to space the items along.

Please Note: Due to the way Generic Scripts operate in Layout, these tools will not contribute to any Undo. 
Make sure you save your scene if you are unsure whether you want to keep the changes, or you will lose the 
original positions of the items.


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Modify - General Group

Coordinate System

The Coordinate System setting (Modify > General > Coord System) affects the Move, Rotate, and Move Pivot Point tools.

World (default keyboard shortcut Shift F5)

World allows easy movement based on the world axes, even for items deep within a hierarchy that contain rotated 
parents.

Parent (default keyboard shortcut Shift F6)

Parent is for movement based on the axes of an item’s parent(s). If an item has no parent then this setting is equivalent 
to World.

Local (default keyboard shortcut Shift F7)

Local is for movement based on an item’s own axes (such as dollying a rotated camera along its view direction). For un-
rotated items it is equivalent to Parent. Local can be temporarily activated by holding Ctrl.

Example

Below, we have rotated a null and then parented a distant light to it. The Show Handles option, discussed later is also 
active for illustration purposes, as it is by default. The handles will line up with the movement axes that would be used if 
you dragged your mouse.

Local
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  Parent

World  
Note how with World, the handles line up with the lines on the grid. With Parent, the handles line up with the rotated 
(parented) null. Finally, with Local, the handles line up with the distant light’s rotation.

Avoiding Gimbal Lock

Gimbal lock normally occurs after you rotate an item 90 degrees on its pitch using the Parent coordinate system. Once 
this has occurred, rotating the object about either its heading or its bank axis gives you the same result-you have lost 
the ability to rotate about the object’s local heading. Gimbal lock is commonly a problem with bones in a hierarchy. By 
nature, bones have a starting position that is often rotated 90 degrees on their pitch, like bones in the arm of a human 
figure. You can avoid Gimbal lock by rotating using the Local coordinate system.

The Position and Rotation Coordinate System settings are independent. To change the system, select either 
the Move or Rotate tool first.
One thing to remember about Local and World rotation is that they are only for interactive manipulation. 
Internally, the Parent system is always used since it’s the only one that can encode absolute rotation values. 
This will affect how an item’s orientation is interpolated between two keyframes. As such, rotating the pivot 
point might still be useful in some situations.


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Reset

You can quickly reset position and rotation to their initial states by selecting the item, activating the channel you wish 
to reset (i.e., Move, Rotate, Size, and other tools), and then clicking Modify > Reset. You can reset individual channels 
without being in the mode by hitting Reset Position, Reset Rotation or Reset Scale and all channels with Reset All.

Reset is not an undo feature, although it can sometimes work similarly. Resetting restores the state for the selected 
channels to what it was when the item was first loaded or created.

If you plan to move a pivot point, you should reset the item’s position and rotation first.

If you have Position or Rotation axes deactivated, Reset will have no effect on those settings.
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Modify - Tools Group

Click here to expand Table of Contents...

IK Boost

(default keyboard shortcut Ctrl-B)

IK Booster (Modify > IK Boost Tool) is an animation system that can work independently from LightWave’s base Inverse 
Kinematics or it can be used  with LightWave’s base IK. With IK Booster applied to an object you can gain access to Bone 
Dynamics and IK Booster character tools.

Applying IK Booster

IK Booster can be applied to an object by adding it to the Custom Object list (Add Custom Object) in the Object 
Properties Panel.



Ryan Roye has kindly shared his excellent guide to IK Boost in our User-Created Tutorials section
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1.

 

You can also add IK Booster to an object using the IK Boost tool (Modify > IK Boost Tool).

Select the IK Boost tool and Right-Click on the object pivot point to bring up the option to Apply IK Booster.

 

When IK Booster has been applied to an object all the bones in the object and all of the object’s children will be set up 
with IK. Although IK Booster is ideal for character rigs, it can be a powerful tool for mechanical rigs as well.

Steps for applying IK Booster:

Load your object (s) into Layout and either create bones, or convert Skelegons to bones. In the case of a 
segmented object, make sure all parts are parented properly.
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2.

3.

Select the IK Boost tool (Modify > IK Boost Tool). Select the IK Boost tool and Right- Click on the object pivot 
point to bring up the option to Apply IK Booster. Select Apply IK Booster to activate IK Booster (IK Booster can 
also be applied in the Object Properties Panel as discussed above.)

Although there are some cases where Step 2 would be the last step before animating, in most cases you will 
want to apply further settings discussed below.
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Modes

KeyFrame Mode

IK Booster has several keyframe modes you can choose from the Keyframe Mode drop down menu. If the DopeTrack is 
active, the Keyframe Mode button will be located on the left side of the track.

If the DopeTrack in not active, the Keyframe Mode selection will be located on the left side of the IK Booster track. The 
IK Booster Track is located at the bottom of the viewport windows.

The Keyframe Mode selector on the IK Booster track doesn’t bring up a drop down menu, instead it toggles between the 
modes as you click on it with the LMB.

KeyFrame Modes

All Item - When this mode is selected, if you create a key on an item, it creates a key for that item and the entire 
hierarchy.
Parent - With Parent mode, if you create a key on an item, it creates a key for that item and every parent up that 
item’s chain.
Child - In Child mode, if you create a key on an item, it creates a key on that item and all of its children.
Parent + Child - In this mode, if you create a key on an item, it creates a key for that item and every parent up 
that item’s chain, and every child down the chain.
Current Item - With Current Item mode, if you create a key on an item, it only creates the key on that item.

IKB Menu

The IK Booster menu has several options to work with. If the DopeTrack is active, the IKB Menu will be located to the 
right of the DopeTrack.
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If the DopeTrack is not active, the IKB Menu will be located on the right side of the IK Booster track. The IK Booster Track 
is located at the bottom of the viewport windows.

IKB Menu Options

Bone Dynamics

This option enables and disables all bone dynamic functions for the object that IK Booster has been applied to.

Global fxIK

IK Booster provides a global IK on/off switch. When this option is active all hierarchies in the object will be solved with 
IK. When this option is not active only the current hierarchy will be solved with IK.

IK bind

IK Booster has the option to “fix” an item, which locks the position of the item’s controller. When IK Bind is active all 
fixed items will stay fixed. When it is not active, items that are fixed will ignore their “fix” setting and will no longer be 
locked to their position.
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Commands

Reset Rotation - This command will set the rotational values of the item(s) back to their original value.

re-BakeSpot-all - Any Bake Spot in the scene will be re-baked when this command is selected.

Motions

IK Booster has several motion options to help speed up animating and increase productivity.
Motion Copy - This function will copy the object’s entire motion to the clipboard.
Motion Rollback - This function will paste the last motion that was copied to the clipboard. This will remove any 
work that you have done since the time of copying the motion.
Motion Save - This function will save the entire motion data of the IK Booster object to a text file. This gives you 
the ability to re-use motions from your object on objects that share the same setup.
Motion Load - This function will load an IK Booster motion data file that was previously saved using the Motion 
Save command.

Options

This brings up the IK Booster Options Panel.

FxIk size - This setting determines the accuracy of the IK solving. The higher the number the less accurate the IK 
solving will be.
Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also 
works with Particle FX controllers. This becomes very handy when you are working on a complex scene and you 
want certain Wind emitters to only affect certain objects.

<default> Includes all groups.
<new group> Creates individual group. Can associate functions within a group.

The KeyFrame Mode selected will determine the items affected by Reset Rotation.

Any Bake Spot that was not previously baked will not be affected.
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Gravity - Setting for downward (-y) gravity. This option only applies to objects that have Bone Dynamics active.

Fix by Collision - This function will fix items that pass through a collision object. This option only applies to 
objects that have Bone Dynamics active.
Controller Size - Use this setting to change the size of the controller when it is unselected.

Controller Size: 50mm

Controller Size: 100mm

Size Mode - This setting determines the size of the controller when it is selected.
Size 1 - Smallest selected size.
Size 2 - Medium selected size.
Size 3 - Largest selected size.

Not Change - The selected controller size will be based on Controller Size. The controller size when selected and 
unselected will be the same.

  You can assign IKBoost settings to a group shared with Particle FX.

–9.8 in the Y is considered the value of earth gravity.  If you are simulating any terrestrial effect, make sure you 
use this value..


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IK Booster and the Dope Track

When the DopeTrack is active while in IK Booster mode, there are two different menus that can be used, the Right Click 
menu, and the Right Click and drag menu. You will also see the Keyframe Mode and IKB Menu buttons that are unique to 
IK Booster discussed earlier.

Right Click Menu

Right clicking on the dope track will bring up a menu with several functions described below.

Copy key from current - This function will copy a keyframe from the current frame (the frame the time slider is 
at), and paste the keyframe on the frame you right clicked on.
Make Key - This function will create a keyframe at the frame you have right clicked on. If you would like to create 
keyframes for a range of frames, use the Bake Keys function in the Right Click and Drag Menu.

Delete Key - This function will delete the Keyframe at the frame you have right clicked on. If you would like to 
delete a range of frames, use the Delete Keys function in the Right Click and Drag Menu.
Save Pose - This function will save an external file that contains the keyframe data of the IK Booster object for 
the frame you right clicked on.
Load Pose - This function will load a previously saved Pose file on the frame you right clicked on.

Right Click and Drag Menu

Right clicking and dragging to select a desired time range on the Dope Track will bring up a menu with several functions 
described below.

Bake Keys - This function will create keyframes for the selected time range

 
Left: Time Range Selected, Right: After Bake Keys
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Delete Keys - This function will delete keyframes in the selected time range.

 
Left: Time Range Selected, Right: After Delete Keys

Apply Keys

Apply keys is for making overall changes to densely keyframed animation. An example would be for correcting or 
making changes to an existing animation such as motion capture. All three "applies" use the first and last keyframe in a 
range as boundaries, and the keyframe that the slider is currently sitting on (Current Frame) as a control point.

Soft - In the case of “Soft Apply”, a Hermite spline is generated using these keyframes as points to smooth out 
the intervening keyframes. Default Hermite coefficients are used

Linear - “Linear Apply” uses the same keyframes, but simply “increments” the keyframe values between the 
control points.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  160

•

•
•

•

Flat - “Flat Apply” snaps all intervening keyframes to the value of the control keyframe (the one the slider resides 
on).

Record Motion

This function will record the motion of the selected controller at fixed distance intervals.

Right Click and drag to select the time range, select Record Motion, and set the options in the Record Motion Panel.

Record Interval - The set distance for each keyframe.
Record Key - Determines what items motion will be recorded using the various Keyframe Modes.

After you set the options for Record Motion, the IK Booster track will display red to show that you are recording. After 
you have moved the controller through the time range the track will return to the default mode.

Set Bakespot - This function will create a Bakespot in the select time range. A Bakespot is a time range in which 
you can bake keys into the desired time range so that they will remain for future operations.

Use the Bakespot Handles to adjust the time range for the bakespot at any time.

Bakespots have a right click drop down menu that gives you the following options:
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Bake Keys - This function will create keyframes for the selected bakespot.
Re-bake-All - Any Bake Spot that has been baked in the scene will be re-baked when this command is selected.
Remove Bakespot - Clears the bakespot from the track.

Dynamics Effect

This function will apply dynamic motion to a controller over the selected time range. When this function is selected the 
Dynamic Effect Preview Panel will appear.

The graph in the preview, displays the motion that will be applied to the controller.The line in the background 
represents one second intervals. This graph gives you a visual representation of the motion that will be applied.

Weight - Defines the weight of the controller. You can achieve heavy motions by increasing the Weight value, 
and you can create light motions by decreasing Weight.
Spring - Controls the springiness or stiffness of the controller. Reducing the Spring coefficient creates soft 
motions, while raising the Spring coefficient produces motions with a stronger repelling force. Setting the 
coefficient to an extremely large value creates stiff motions.
Resistance - Controls the amount of air resistance.

Once applied a keyframe will be placed on every frame in the selected time range.

Bind Motion

This function will bake keyframes for the entire time range based on the keyframe of the first frame in the range.

No calculations are needed when using this function.
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The example above shows bind motion in action. The Time range selected is from frame 36 to 49. When Bind Motion is 
selected every frame in the time range uses the data from Frame 35.

IK Booster Track

If the DopeTrack is not active while in IK Booster mode, the IK Booster Track becomes functional. The Keyframe Mode 
and IKB Menu buttons appear on the track as discussed earlier and all operations for IK Booster that were available on 
the Dope Track are available for the IK Booster Track.

IK Booster Track Time Ranges - The IK Booster track displays time ranges differently then the DopeTrack. The time 
range will be shaded as it is in the Dope Track, but only the first and last frame numbers will be displayed unlike the 
DopeTrack.

Time Range Keyframe Shifting - You can use the IK Booster Track to shift a selected area of keyframes. This function is 
unique to the IK Booster Track and can be very useful.
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IK Booster Frame Marker - Place a frame marker by left clicking on the IK Booster Track. The Frame Marker is the frame 
on the track that marks the frame that the time range ends or begins depending on which side of the marker you click 
and drag in.

Keyframe Origin - This marker shows the original location of the keyframes before any movement has taken place.

Keyframe Move Location - This marker shows where the Keyframe Origin is being moved to.

The Time Range will be shaded to display what area of time is being affected.

IK Booster Viewport Controllers

Once you have applied IK Booster to your object you have many options for displaying and working with the controllers 
that are created for each item. The controllers appear as circles while in Rotate mode and boxes while in Move mode.

To remove the frame marker, simply left click on it.

The items that are affected by Time Range Keyframe Shifting are determined by the Keyframe mode.
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Left clicking and dragging on the controller will allow you to move and rotate the controller freely. You can also left click 
and drag on individual channels to constrain the movement of the controller.

Rotate Mode:

Red - Heading Channel
Green - Pitch Channel
Blue - Bank Channel

Move Mode:

Red - X Channel
Green - Y Channel    
Blue - Z Channel

Controller Right Click Menu

Right clicking on the controller will bring up the controller menu.

Fix - This function will lock a controller in place. The controller will be displayed as a solid circle to indicate that 
it is fixed.
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Ankle Controllers are fixed

IK Stop - This function will make the selected controller the new base of the IK chain, and only controllers farther 
down the chain are affected by any IK operation.The controller will display a diamond shape to indicate that IK 
Stop is active.

A good example of using IK Stop is wagging the tail of a dog. Imagine a string of bones inside a solid dog object, 
extending down its tail. You want the tail to follow the dog as it moves about, but you do not want the dog’s 
body to wag as the tailbones are animated. You activate IK Stop for the bone at the base of the tail to accomplish 
this.

This function is similar to Unaffected by IK of Descendants.

The Shoulder Controller has IK Stop applied.

FK Control - This function will change the controller from Inverse Kinematics to Forward Kinematics (FK). 
Forward kinematics is the standard type of motion generated in LightWave when you rotate/move any parents 
in a chain. The position of the last controller in the chain is determined indirectly by the combination of all 
positions of any parent controller up (i.e., forward) through the chain. (For instance when you move your upper 
arm, your forearm and hand also move with it.)
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File Tools - The options listed below are file management tools for a controller.

Pose Save - This function will save an external file that contains the position of the selected controller for the 
frame you are currently on.
Pose Load - This function will load a previously saved Controller Pose file at the frame you right clicked on.
Motion Save - This function will save the entire motion data for the selected controller to a text file. This gives 
you the ability to re-use motions from the selected controller.
Motion Load - This function will load a controller’s motion data file that was previously saved using the Motion 
Save command.

Controller Options

The Options drop down menu has several functions to work with.

Move/Rotate - This function will toggle the control between Move and Rotate mode.

 
Left: Rotate, Right: Move
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Quaternion - This function will activate quaternion inverse kinematics solving for the selected controller. 
Quaternion IK will help any controller that suffers from gimbal lock and the controller will be displayed with a 
“Q” to indicate that Quaternion is active.

Set IK Target - This function will allow one controller to drive another controller’s motion. In other words, the 
currently selected controller drives the previously selected controller. The controller will be labeled with a “T” to 
indicate that Set IK Target has been applied. Choose Reset IK Target to remove the target setup from the 
controller.

Steps for setting an IK Target:

Select the controller that you want to animate.
Select the controller you want to drive the animation.
Select Set IK Target. The target is setup and ready to go. Use the Target controller to drive the controller 
in step a.

Setting Copy - This function will copy the settings from the previously selected controller. This can be a real time 
saver when setting up controllers on like items. One example would be setting up the left leg and copying the 
settings over to the right leg.
Dynamics Edit - This function will activate Dynamic Edit mode. Dynamic Edit mode allows you to set the dynamic 
properties for your controllers.

 Interesting side note: The quaternions are members of a non-commutative division algebra first invented by 
William Rowan Hamilton.


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To change the values for Weight, Resistance, Spring, and Viscosity, simply left click and drag on the control. Dragging 
left will decrease the value while dragging right will increase the value.

Weight - Defines the weight of the controller. You can achieve heavy motions by increasing the Weight value, and 
you can create light motions by decreasing Weight.
Resistance - Controls the amount of air resistance.
Spring - Controls the springiness or stiffness of the controller. Reducing the Spring coefficient creates soft 
motions, while raising Spring coefficient produces motions with a stronger repelling force. Setting the coefficient 
to an extremely large value creates stiff motions.
Viscosity - Controls the impact of a collision. A controller with a higher Viscosity value tends to keep its shape 
more. If a controller bounces, a higher Viscosity value will have less bounce motion because the Viscosity 
absorbs the bouncing force.

Size - This setting determines the area of influence the controllers have. The image below shows various sizes on 
the controllers that make up the head and torso area of this character.

On/Off - This function will determine whether a controller will be affected by dynamic calculation.
End Edit - This function will take you out of Dynamic Edit mode.
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Controller Edit

This function will activate Controller Edit mode. While in Controller Edit Mode you can freely move the controllers by 
left clicking and dragging them to a location.

 

Left: Before Edit, Right: After Edit

Controller Edit Mode has several options that can be used to customize your Controller settings. Right click to bring up 
the Controller Options menu.

Reset - This function will reset the controllers back to its default setup.
Float /Unfloat - This function toggles the controller between Float and Unfloat.

Bone Dynamics must be active for these settings to be calculated.
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Float - The controller moves along with the item.

 

UnFloat - The item moves but the controller is anchored.

 

Size Mode - This setting determines the size of the controller when it is selected.
Size 1 - Smallest selected size.
Size 2 - Medium selected size.
Size 3 - Largest selected size.

Not Change - The selected controller size will be based on Controller Size. The selected and unselected 
controller size will be the same.
End Edit - This command will exit Controller Edit mode.

Channel Menu

Right clicking on an individual channel will bring up the Channel menu. Each channel can be configured independently.
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Lock/ Unlock - This function will lock and unlock a channel. When it is locked, the number is surrounded with ().

The Controllers Heading Channel is Locked

Set/ Use Limit - This function will limit the channels value range. When a channel has a limit, the number is 
surrounded with <>.

The Controller’s Pitch channel has a limit

Edit Limit - This command brings up the Edit Limits Panel.

You can independently limit heading, pitch, and bank rotations between maximum and minimum values. You 
can prevent actions like bending a leg backwards at the knee (unless you’re animating a sports injury). To use 
the limiting feature, set the Min and Max values on the Edit Limits Panel.

Setting rotation limits can be particularly important when using inverse kinematics. When setting the Min/Max 
Limits, you will see a visual guide in the viewport that represents the limits.

By default the limits are –180 to 180. This is not ideal in most cases so you will want to edit the limits.
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Stiffness - Controls the springiness or stiffness of the limit. Reducing the Stiffness coefficient creates soft 
motions, while raising the Stiffness coefficient produces motions with a stronger repelling force. Setting the 
coefficient to an extremely large value creates stiff motions.
Copy and Paste - Use these commands to copy and paste settings between channels.
Reset Limit - This function sets the maximum and minimum settings of the limit to a present value. When Reset 
Limit is applied, you can edit the Maximun value by holding down the Ctrl key + left click and drag to the value 
that you want the limit to be set at.
Reset Value - This function will set the value of the channel to zero (0). This is very handy when you need to 
quickly set the channels value back to zero.
Add Link - This command will add a Booster Link to the selected channel. The reference controller will be the last 
controller selected.

Graph Edit

This command will launch the Graph Editor with the selected Channel active.

 The maximum value must be greater than the minimum.
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IK Booster Link

IK Booster Link can be used to link a channel from one controller to a channel in another controller. The Linked 
controller can be driven by the referenced control. This is very similar to how expressions can be used without writing 
any expressions.

Remove - This command will remove the Booster Link Modifier from the channel.
Change Shift - This function will adjust the motion of the linked controller at different times during the 
referenced controllers motion. To remove Change Shift from a channel, simply right click on the channel and 
choose Key Control.

Change Item - This function will change the reference controller to the last controller selected. This option can 
be changed in the IK Booster Modifier Panel under the Reference Item drop down menu as well.
Change ch - This command will allow you to change the channel that drives the selected controller. This option 
can be changed in the IK Booster Modifier Panel under the Reference Ch drop down menu as well.
Copy and Paste - These commands will copy and paste Booster Link settings.
Edit Graph - This command will launch the Graph Editor.
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IK Booster Link Modifier Options

Reference Item - This function will change the reference controller. The reference controller is what drives the 
linked controller.
Reference Ch - This command sets the channel of the Reference Item that drives the linked controller.
Shift Frames - Delays the linked motion by the number of frames specified. Entering “5” moves the frames -5, 
and -10 moves it +10.
Source Value - This function sets the percentage between the minimum and maximum value of the referenced 
channel that will be used.
Change Value - This function will change the value of the selected channel.

IKB Calculate

(default keyboard shortcut Ctrl X)

The IKB Calculate operation (Modify > IKB Calculate) is used to calculate IK Booster’s Bone Dynamics and generate 
keyframes based off those calculations. A keyframe will be created on every frame much like motion-capture data.

Move TCB

Another tool in the Modify menu will directly affect your motion path. At the bottom of the Modify list you will find Move 
TCB. This allows you to set the biases discussed in the Graph Editor section of the manual, but from Layout, rather than 
having to visit the Graph Editor itself. To use it, move to a keyframe, click on the Move TCB tool and you will notice that 
the lower left corner now displays T, C, B instead of the more familiar X, Y, Z or H, P, B.

IK Booster Link will abide by any limits that have been set on the channel that is driving the current controller.

Bone Dynamics need to be properly set up before this will work. Otherwise, clicking it causes an error.

The IKB Calculate button will also calculate dynamic objects as well. For more information about IK Booster 
and Bone Dynamics see the IK Booster section.


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You can enter figures in here for what you wish your TCB settings to be, or you can use the mouse:

LMB: Moving left and right alters the Tension
Ctrl+LMB: Moving left and right controls the Continuity
RMB: Moving left and right controls the Bias

Sliders

(default keyboard shortcut Ctrl D)

Sliders (Modify > Tools > Sliders) are slider gadgets that are displayed over viewports. An individual slider is tied to a 
specific animation channel. A slider will indicate the current value of a channel and also let you interactively adjust that 
channel value. Sliders are useful for all kinds of animations, especially character animations. A good example can be an 
animated hand, with multiple bone movements for multiple fingers.

To use sliders in a scene:

Add the Sliders custom object (Object Properties Panel) to any object.
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To display and interact with the sliders, choose Modify > Tools > Sliders. The sliders for the last current object (with the 
Sliders custom object) will be editable when the Sliders tool is active. Keep this in mind if you have more than one 
object with the Sliders custom object.

To configure your sliders:

Open the Sliders Custom Object settings dialog from the Object Properties Panel.

The left window (Channels List) will list all of the channels in the scene. To attach a slider to a channel, simply select the 
channel in the left window and double click or click the Add Channel button. Selected channels in the right window can 
be removed with the Remove Channel button.

The Range Min and Range Max settings define the interactive range of the slider. The underlying channel can go beyond 
these values, but the slider’s range of control and feedback will be limited to this range. If the underlying channel goes 
outside the range, the slider value will turn red.

Remember, as with all Layout tools, you’ll need to select another tool (Move, Rotate, etc.) to deactivate the 
Slider tool.


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1.

Clicking on the slider handle will immediately change the channel to the slider’s corresponding value.

The description Label will default to the channel name, but you may edit that if you desire. You can also set the color 
used for the slider with the Color preset pop-up menu or specific RGB values.Working with OpenGL Sliders:

There are three controls along the top. Drag the far-left one to move the slider group. The Envelope (E) button will 
display the Graph Editor with the associated channels in the curve bin. The right/left arrowhead (<>) button can be 
dragged to scale the size of the slider group. The arrowhead button on the right will minimise/maximise the slider 
display.

In the individual slider entries, the handle can be grabbed to slide to any value in the range set up and the arrows at the 
right end are to jump from keyframe to keyframe.

Spline Displacement

The Spline Displacement Tool (Modify >Tools > Spline Disp Ctrl) is a simple way to animate hoses, tentacles, etc. using a 
spline with control handles. This tool will create a spline the length of the object with a user specified amount of control 
points that can be used to deform an object.

To use Spline Displacement

Select the object that you would like to animate with Spline Displacement.

To simplify using sliders, use the Add Slider Bank generic plugin command (Not assigned to the interface by 
default). It will add a null object, apply the sliders custom object to it, and open the sliders interface, all in one 
step.



Spline Displacement is not a new tool. It used to be called SplineControl
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2. In the Object Properties window, Primitive tab, Modifier section, choose Spline Displacement from the Add 
Modifier Dropdown menu.
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3.

4.

5.

Double-click Spline Displacement to open its interface.

Choose how many Control Points you want (you can change this later, but doing so might lose any animation 
set). The slider will set a minimum of 5 and a maximum of 256, but a minimum of 3 can be typed if desired.
Use the Spline Displacement button (Modify > Spline Disp Ctrl) to activate and move the nodes around.
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Spline Displacement Options

Control Points - This field will determine the number of control handles that will be generated.

Use Object CPs - Uses nulls with the names given in Object Name Prefix placed in scene as control points for the 
spline displacement
Object Name Prefix - Prefix for naming nulls for spline displacement

Each control point will be numbered starting from 0. This number will appear in OpenGL.
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Object Axis - Defines the axis the control spline will be drawn on.
Auto Key Create - Similar to Layout’s standard Auto Key in that it will automatically create a keyframe as you 
move a control point. The only difference is that it will always create when on frame zero regardless of whether 
or not this option is active.
Create Key - When Auto Key Create is not active use this to create a keyframe.

Set Rest Shape - Use this to change the default rest position of the control points in relationship to the object.
Reset - This function works like undo, however instead of just undoing the last move it will reset all control 
points to their rest position.
Allow Stretch - When this option is activated the object is able to be stretched past its original scale.

  
Left: Allow Stretch OFF, Right: Allow Stretch ON

Spline Displacement can use other objects as controllers for the displacement. Here we look at moving 
our bar with null objects.
Example



Hitting Enter on the keyboard will not set a keyframe for a control point.
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• Scale by Weight Map - This option will use the Weight Map selected and only deform that area of the mesh.

Edit Tool

(default keyboard shortcut Ctrl E)

The Edit tool (Modify > Tools > Edit Tool) activates the ability to edit points on dynamic objects and particles. You will be 
able to visually see that you’re in Edit Mode in the viewport. All the points that make up the object will become 
highlighted and all the Edit tool functions will become active.

For more information about the Edit tools and some of its options, see the Dynamics and Particles sections.
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Layout Tab - Setup

Visit the Rigging tab for instruction on these tools.
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Layout Tab - FX Tools

The FX Tools tab contains easy-access buttons to set up Bullet dynamics, Fracturing, Flocking and FiberFX. Each 
is detailed in their respective sections:

Bullet Dynamics
Fracture
Flocking
FiberFX
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Layout Tab - Render

These tools are all explained in Rendering.
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Layout Tab - View

Navigation tools for Layout. Again, keyboard shortcuts mean you won't need to visit this tab often however, Add 
Viewport now allows additional floating viewports to be added to Layout.

Add Viewport
These viewports can be used for any of the normal viewport modes (Orthogonal, Perspective, Light, Camera, 
Schematic) and can be placed as desired.

Arrange
The Arrange dropdown on this tab is for arranging additional viewports. The choices are:

Row - Arranges additional viewports horizontally
Column - Arranges additional viewports vertically
Tile - Tiles additional viewports on top of each other
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Layout Tab - Model

Tools for creating temporary geometry for Layout. In the Create > Geometry dropdown, 
you will find:

Ground Plane

This will create a single plane object 10m x 10m by default. Segments can be added to 
create a subdivided plane suitable for converting to a SubPatch object. Combined with a 
displacement map this makes for an ideal simple water plane.

Cube



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  188

Cube will create a box for Layout. If you intend using Bullet with Layout-created objects, 
for testing, make a cube of 10m x 0.25m x 10m instead of using a Ground Plane for a floor. 
The pivot is only optionally centered on the bottom of the object.

Sphere

Sphere will create a ball-shaped object for Layout. There is the possibility to create a 
tessellated sphere, which is better for Bullet. Like Cube, the sphere created will have its 
pivot at the center of the object and only optionally have it at the base.
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Toroid

Toroid will create a torus-shaped object non-interactively.

Layout-created objects can be saved to disk for future retrieval either by 
checking the Save Object option in the creation panel, or by choosing File > Save 
> Save Current Object.


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Layout Tab - I/O

The I/O tab is fully described in the Interchange section.
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Layout Tab - Utilities

The Utilities tab is home to unsorted plugins (in the Additional dropdown) and Scripting tools with LightWave's 
native LScript and Python tools. This is also where you'll come to add new plugins and scripts:

Add Plugins Command
To add plugins, choose Utilities > Plugins > Add Plugins. Navigate to the location of the plugins you want to add. 
Select the plugins, hold the Shift key to select an entire range or hold Ctrl to select multiple non-contiguous 
files. In Layout, the Add Plugins Panel appears after you select the .p file(s).

The number of individual plugins found will appear in an informational dialog. The added plugins, their type 
and related .p filenames are then listed in the window.

To add additional plugins from the Add Plugins Panel

Click the Add Plugins button and select one or more .p plugin files from a directory.

Re-adding a plugin that is already added will not do any harm.

A single plugin file can have many functions, some internal and not directly accessible by you. Thus, 
when you add one, it may report back that it has added more than one plugin. This is normal.


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To add a directory of plugins

You can quickly add all of the plugins in a directory (including subdirectories) using the Scan Directory button. 
(It may take a few seconds to scan all of your plugin files. Be patient!)

Edit Plugins Command
(default keyboard shortcut Alt F11)

Use the Edit Plugins command to review and delete plugins that have been added. In Layout, choose Utilities> 
Plugins > Edit Plugins.

To delete a plugin command

You can delete a plugin command by selecting it and clicking the Delete button. (Other commands from the 
plugin will continue to exist.) Click Clear to delete all plugins listed. These operations have no effect on the 
actual files stored on your hard drives.

To rename a plugin command:You can rename a plugin command’s name by selecting it, clicking the Rename 
button and entering a new name.

You can access the Scan Directory feature from the Edit Plugins Panel .

You can also add plugins on this panel. The Add Plugins and Scan Directory buttons operate the same 
as they do for the Add Plugins Panel, discussed earlier.


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File Grouping Method

If desired, you can list the Plugin commands by their .p plugin filenames. Just select the File Grouping Method 
button at the bottom of the Edit Plugins Panel.
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User Preferences
Click here to expand Table of Contents...

Clearing Configs
If you are required to clear configs for any reason, the way to do it is to make sure LightWave is closed, including the 
Hub application (in your Windows taskbar or Macintosh dock). Then, navigate to:

Windows

<user>\.NewTek\LightWave\2019.0

and delete

Extension Cache-64
LW2019.0.3-64.CFG
LWEXT2019.0.3-64.CFG
LWHUB2019.0.3-64.CFG
LWM2019.0.3-64.CFG

Macintosh

 ~/Library/Application Support/NewTek/LightWave/2019.0/

and delete

Extension Cache
Extensions 2019.0.3
Hub 2019.0.3
Layout 2019.0.3
Modeler 2019.0.3

now when you launch anew, you can be sure everything in LightWave will be factory fresh.

Config Backup
When configs are changed now, a backup is created of existing settings before changes are enabled.

Edit Keyboard Shortcuts
(default keyboard shortcut Alt F9)



There may be plugin configs and color picker configs still to clear. If you wish to remove all traces completely, 
delete the 2019.0 folder but be warned you will have to license your LightWave again (you can retrieve your 
license key from your account at http://lightwave3d.com).



http://lightwave3d.com
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1.
2.

3.

Like the menus, keyboard shortcuts can be configured to suit your needs. To display the Configure Keys Panel, choose 
Edit > Edit Keyboard Shortcuts.

 
The window on the left contains a complete list of all assignable commands grouped by type. The right window shows the 
full list of all keystrokes and assigned commands, if applicable.

To assign a command to a key

Select a command in the left window.
Choose the target key in the right window. (You can hit the desired key or keystroke combo to select the key 
quickly.)
Clicking the Assign button will overwrite any existing assignment. Alternatively, you may drag the command to 
the right window.

We strongly suggest that you keep the default keyboard mapping assignments and make new shortcuts only 
to unmapped keys. (Most of the function keys are open.) Otherwise, technical support and using the 
documentation may become difficult.


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To unassign a command to a key

Select the target key in the right window.
Click the Unassign button.

Finding Assignments and Commands

If you have a command selected in the left window and click Find, the command, if any, on the right will become 
selected. Choosing a command in the right window and clicking Find will select the matching command in the left 
window.

Clicking Search allows you to type in a search phrase to find a command. Search is case-sensitive and will find the first 
instance when first run, and can be used iteratively to find additional instances by just hitting the button again, as it 
retains the string until you type in a new one.

Maintaining Key Mapping Sets

The Load and Save buttons let you retrieve and store key mapping sets that you develop. The Clear button clears out all 
assignments, so use with caution. Any available preset key mapping sets can be chosen from the Presets pop-up menu. 
The Window pop-up menu lets you select different menus to edit (e.g., Graph Editor), if available.

Edit Menu Layout
(default keyboard shortcut Alt F10)

LightWave menus are customizable. You can add, remove, group, and reorganize commands. Choose Edit > Edit Menu 
Layout to open the Configure Menus Panel.

Keyboard shortcuts can be assigned to only one command. Assigning a command that is already assigned to a 
different key will assign it to the new key, but remove it from the old one.



We strongly suggest that you keep the default menu organization intact. Otherwise, technical support and 
using the documentation may become involved. A better solution is to create a new menu tab and/or groups 
and place your frequently used tools in them.


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In the (left) Command window, a list of available commands will appear. These will be grouped by type.

In the (right) Menus window, several main sections have sub-items, which are indented to show the hierarchical 
relationships. Top Group contains the items that are always visible no matter which tab is selected. Main Menu items 
are the main tabs and related buttons for the main interface toolbar. Left, Middle, and Right Mouse Button Menu (when 
available) are the menus that appear when the Shift + Ctrl keys are held down along with the corresponding mouse 
button. There may be other menu sections defined.

In the Menus window, dots indicate commands while arrows indicate groups of commands/sub-groups beneath it. If 
the arrow points to the right, the group’s sub-menu items are collapsed and not visible. To reveal the sub-menu items 
for a collapsed group, just click on its right-facing arrow. To collapse an open group, click on its downward-facing 
arrow.

Finding Assignments and Commands

If you have a command selected in the left window and click Find, the command, if any, on the right will become 
selected. Selecting a command in the right window and clicking Find will choose the matching command in the left 
window.
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Clicking Search allows you to type in a search phrase to find a command. Search is case-sensitive and will find the first 
instance when first run, and can be used iteratively to find additional instances by just hitting the button again, as it 
retains the string until you type in a new one.

Menu Branches

Menu branches can be exported and imported allowing for rapid customization of several menu entries. To export a 
menu branch, right-click over the group you wish to export and choose Export Branch.

The file saved can be loaded into a different installation of LightWave using the same method - right-clicking the area in 
which you wish to import a menu branch and choose Import Branch.

New to LightWave 2019 is an additional command Import and Replace Branch.
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Maintaining Menu Layouts

The Load and Save buttons let you retrieve and store menu layouts that you develop. Any available preset menu layouts 
can be chosen from the Presets pop-up menu. The Window pop-up menu lets you select different menus to edit (e.g., 
Graph Editor), if available.

Edit Plugins Command
(default keyboard shortcut Alt F11)

Use the Edit Plugins command to review and delete plugins that have been added. In Modeler, choose Utilities> Plugins 
> Edit Plugins.

To delete a plugin command

You can delete a plugin command by selecting it and clicking the Delete button. (Other commands from the plugin will 
continue to exist.) Click Clear to delete all plugins listed. These operations do not affect the actual files stored on your 
hard drives.

To rename a plugin command: You can rename a plugin command’s name by selecting it, clicking the Rename button 
and entering a new name.

You can also add plugins on this panel. The Add Plugins and Scan Directory buttons operate the same as they 
do for the Add Plugins Panel, discussed earlier.


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File Grouping Method

If desired, you can list the Plugin commands by their .p plugin filenames. Just select the File Grouping Method button at 
the bottom of the Edit Plugins Panel.

Window Config Loader
This command is a quick way to launch a window configuration that was generated by the Window Configure tool.

Scene Metadata
If your pipeline dictates that you need to use a different path structure for use with other applications, it can be 
awkward when you need to bring scenes back into LightWave for further editing, needing to tell LightWave where a 
project's images are for instance because you have them under a different path. You can now save metadata to a scene 
file as comments if your workflow dictates that you vary from the standard LightWave content directory structure of 
Images, Objects, and Scenes.

When saving out a scene file, append the content directory information as comments to the very end of the scene file.

If Use Custom Paths is left unchecked, this should be a single comment like this:

// ContentDir: "X:/project/_library/assets/LW_Content"

If Use Custom Paths is checked in your LightWave options Paths tab, append all of the custom paths as comments to 
the end of the LWS file as well:

// ContentDir: X:/project/_library/assets/LW_Content
// ObjectsDir: X:/project/_library/assets/LW_Content/Objects
// ImagesDir: X:/project/_library/assets/LW_Content/Images

The full list of custom paths is as follows:

ContentDir "X:/project/"
ScenesDir "X:/project/Scenes"
ObjectsDir "X:/project/Objects"
SurfacesDir "X:/project/Surfaces"
ShadersDir "X:/project/Shaders"
ImagesDir "X:/project/Images"
PreviewsDir "X:/project/Previews"
MotionsDir "X:/project/Motions"
EnvelopesDir "X:/project/Envelopes"
AnimationsDir "X:/project/Animations"
NodesDir "X:/project/Nodes"
SoundsDir "X:/project/Sounds"
DynamicsDir "X:/project/Dynamics"
RigsDir "X:/project/Rigs"
LightsDir "X:/project/Lights"
RadiosityDir "X:/project/Radiosity"
ColorTablesDir "X:/project/ColorTables"
ImageCacheDir "X:/project/ImageCache"
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VertCacheDir "X:/project/VertCache"
BackupDir "X:/project/Backup"

Interface Color Customization
Customizing the Interface colors for Modeler and Layout is accessed through the Options panels in both applications - 
the Display tab in Layout and the Display Options Interface tab in Modeler. You will need to restart LightWave to see the 
changes you have made.

Configuration Files
For Macintosh OS X, the LightWave configuration files are stored in your ~/Library/Application Support/NewTek/2019.0
folder like so:

Extension Cache
Extensions 2019
Hub 2019
Layout 2019
Modeler 2019

For Windows 7 and onwards, the configuration files are kept in <USERNAME>\.NewTek\LightWave\2019.0. They are 
named:

Extension Cache-64
LW2019-64.CFG
LWEXT2019-64.CFG
LWHUB2019-64.CFG
LWM2019-64.CFG

Generally, you will not need to edit these files directly; however, you might need to remove these files if they get 
corrupted.

Startup Options
The following options are described for use in Windows. At the end of the list of Startup options, there is an Info box for 
Macintosh OS X.
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Editing a shortcut's target path can add functionality to how LightWave starts up. Here shown, -d for startup content 
assignment

-c for Configs

If you wish to redirect where LightWave stores the configs it creates away from the regular C:
\Users\<username>\.NewTek\LightWave\<version> folder, you can add -c to the end of your shortcut's 
targetline with the path chosen for the configs.

-d for Content

Layout has a -d option for designating a content directory to be used at startup. In Windows, it can be added as a 
startup option by editing the icon properties of the shortcut created for launching Layout and adding -d and the 
directory you wish to use, like so:

In Windows, shortcuts need to be edited for both the Modeler and Layout applications where appropriate for 
flags to take effect.


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-p for Plugins

The -p option is for creating a different location for plugin files - useful for instance when running multiple copies of 
LightWave over a network with a central store of plugins.

-0 for Command IPC

Using the -0 commandline flag will not run the Hub but use an Interprocess communications system. Layout and 
Modeler all notify each other when a mesh file has been saved to disc, and the applications that have that file open and 
have not applied modifications during the session will update from the new version on disc. For example, if both Layout 
and Modeler have “bob.lwo” open, Modeler has some edits applied to it, and Layout saves it transformed, Modeler will 
not automatically update from the disc.

If subsequently the object is saved out from Modeler, that will overwrite the changes made by Layout, and Layout will 
update from the save if no further changes were applied in Layout during the interim.

-i for Isolate

The ‘isolate’ flag (‘-i’) will completely disable all IPC mechanisms (Hub and CommandIPC), leaving the application 
isolated from all other product actions.

--frame-end-beep

Use this flag to play an existing sound file when a frame finishes rendering. The syntax is as follows:

--frame-end-beep={sound_file}

--anim-end-beep

Use this flag to play an existing sound file when a frame sequence finishes rendering. The syntax is as follows:

--anim-end-beep={sound_file}

--preview-end-beep

Use this flag to play an existing sound file when a preview finishes rendering. The syntax is as follows:

--preview-end-beep={sound_file}

Shortcuts should be made for Layout and Modeler, with the same flags applied in both. In all cases, there is no 
space following the flag for the path chosen. The example below is for redirecting configs:

C:\NewTek\LightWave_2019.0\bin\Layout.exe -cF:\Configs


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-f for Font

Use this flag to call a system font as the typeface to use for Layout or Modeler. The syntax is as follows:

-f{font_name@font_size}

Layout displayed with Stencil Std Bold at 10pt; Giddyup Std Regular at 12pt and Georgia at 9pt. The flags used were ...
\bin\Layout.exe -fStencilStd@10; -fgiddyupstd@12 and -fgeorgia@9 - none of these are recommended for an 
ergonomic work environment...

--command-port

The --command-port option enables an operating system-based communication mechanism that allows external 
processes to feed LightWave Command Sequence commands directly into the LightWave application.  This allows real-
time and continuous execution of CS commands within running LightWave programs.

The distributed LightWave product includes a Python package that works with both Python v2 and v3 that allows 
Python programs to utilize this mechanism.

When enabled, the command port number selected is displayed in the LightWave application's titlebar.  (e.g., "--
command-port=45454").

This mechanism does not function with Screamernet.

(the command-port mechanism is somewhat reminiscent of the Amiga AREXX system LightWave used to support.)

--dpiaware

Described below.

Use the filenames for the typefaces you wish to use rather than the display names, but the extension is not 
necessary - Stencil Std Bold should be written as stencilstd (you can leave off the .otf).


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-r

Lastly, a joke entry for bamboozling co-workers. Enter this as an option, and watch your colleague's face as they start 
LightWave...

HiDPI

LightWave 2019 presents a new way of working with LightWave on screens at a resolution great than 1920 x 
1080 here.

Layout Startup Command
If the LW2019-64.CFG configuration file contains a line beginning with “StartupCommand,” Layout will try to execute 
the rest of the line as a command after the main interface is first opened. The command can have arguments and it can 
refer to a generic plug-in or script.

Default Scene at Start
If you'd like Layout to start with the same scene setup every time it's easy to achieve but you need to use a single 
content directory to do so (if you see the "Would you like to change content directory?" message when you load scenes, 
this will probably not work for you out of the box). To create a default scene, simply set up something obviously 
different - change the light color to red.

Now use the Save menu option Save Scene as Default. In Layout Options (O) check Clear Scene To Default and finally 
restart LightWave. Now, when you start Layout, you will see that the default light color is red.

1.
2.

3.
4.

macOS Specifics

For macOS, the procedure for adding command line arguments is more involved. Here is how to make a 
launch shortcut icon using AppleScript:

Open the /Applications/Utility/Script Editor.app application
Choose to create a New Document.
Enter the following text:
do shell script "/Applications/NewTek/LightWave_2019/Layout.app/Contents/macOS/
Layout" 
(command line arguments should be added here, before the quote marks, for instance do shell 
script "/Applications/NewTek/LightWave3D_2019.1.2/Layout.app/Contents/MacOS/
Layout -i" will set the Isolate flag.
In the Script Editor, use the dropdown to save the document as an Application to your Desktop.
Double-click the resulting application icon.

To re-edit the resulting application, drag it to the dock "Script Editor" icon.


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To check this is working correctly, try loading a different scene. If you get a window like this:

You will need to do more work. Your LightWave content is almost certainly arranged like so:

Content:

   Project 1

        Objects

        Images

        Scenes

   Project 2

        Objects

        Images

        Scenes

etc.

For the default scene to work reliably, you have two choices. The first is for your content to structure to look like this:

Content:

    Objects

        Project 1

        Project 2

    Images

        Project 1

        Project 2

    Scenes

        Project 1

        Project 2

This is the same kind of organization (global) as the stock LightWave content if you have a look. Both this and the 
project-based way of managing content present their own problems - the first creates lots of file duplication, the second 
is difficult to separate out for sending to the farm, etc.

The second choice, if you want to keep the benefit of a default scene but are committed to the project-based content 
route, is to simply create a template content directory structure that you can always use, including a scene with your 
preferred settings. Copy this into place at the start of a project.
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Customizing Layout Viewport Navigation
The mouse directions used for viewport navigation can be customized by editing the WorldNavigation entry in the 
LW2019-64.CFG configuration file. It has four boolean values that correspond to panning via icon and Alt key, and 
rotation via icon and Alt key. Zero values mean that the viewpoint moves in the same direction as the mouse, and ones 
mean that the world appears to move with the mouse. For example, the default in LightWave 9 is 0 1 0 1. The old 5.6 
setting would be 1 1 0 0. See also Navigation Options.

Customizing Camera Presets
The camera resolution presets are stored in the LW2019-64.CFG configuration file using the keyword 
“ResolutionPreset.” Each preset includes a width and height, pixel aspect ratio, mask settings (left, top, width, and 
height), and a name that will appear in the pop-up menu. They can be modified, deleted, or added to. If no presets are 
found in the file, the original list is restored. See the configuration file for examples.

Customizing Image Savers for Output
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Full image saver list reduced by removing plugins (Alias.p, Aura_Exporter.p, BMP.p, CineonFP.p, DPX.p, DRLA.p, IFF.p, PCX.p, 
PICT.p, RLA.p, SUN.p, TGA.p, VPB.p and YUV.p plugins removed for this example)

The standard LightWave Image Saver list in the Output tab is long but can be reduced if certain file types are sure not to 
be needed. The plugins for this list can be found in the following locations, depending on operating system:

Windows: LightWave_2019.0\support\plugins\input-output
OSX: /Applications/NewTek/LightWave3D_2019.0/support/plugins/input-output

1.

2.

3.

There are caveats with doing this:

A backup of the plugins should be kept. Perhaps the easiest solution is to add the unwanted filetypes to 
the legacy.zip in the plugins directory;
While this reduces the Output list it also cancels the ability for LightWave to handle removed filetypes 
for loading;
Doing this might cause problems with some distributed rendering plugins.


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Options
Layout General Options
Layout Display Options
Layout OpenGL Options
Layout Defaults Options
Layout Paths Tab
Layout CS (Color Space) Tab
Layout OBJ Options
Navigation Options
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Layout General Options

Click here to expand Table of Contents...
Input Device
File Dialog and Color Picker Selection
The Visual Browser
Color Format
Popup Positioning
Automatically Creating Keyframes
Parent in Place
Left Mouse Button Item Select
Dbl. Click Bone Mode
Frame Slider Label
Frames Per Second
Frame 0 Time Code
Frames Per Foot
Fractional Frames
Show Keys in Slider
Play at Exact Rate
Measurement Unit System
Setting the Default Unit
Undo Levels
Save Options
Auto Save
Protect Legacy Scenes
Enable Master Autoload
FSPE
Autoscan Plugins
Clear Scene to Default
Threaded Mesh Evaluation
Thumbnail Review
Graph Editor Audio
Enable Image Caching

(default keyboard shortcut O)

Choose Edit > General Options to bring up the General Options Tab on the Preferences Panel.


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Input Device

The Input Device pop-up menu lets you select either a Mouse or Tablet as the primary input device. When you choose 
the input device, the default system drivers for the appropriate device are used.

File Dialog and Color Picker Selection

The File Dialog and Color Picker pop-up menus let you use custom LightWave dialogs for file loading/saving and picking 
colors. Selecting Default will use your standard system dialogs.

The Visual Browser

You can make the LightWave visual browser the default file dialog for Layout by choosing VB File Requester on the File 
Dialog pop-up menu. This appears on the Interface Tab of Modeler’s Display Options Panel (Edit > Display Options).

Color Format

The Color Format setting determines the scale used where the color selector appears next to the color swatch in Panels 
and Dialogs. Integer uses values 000 to 255, Float uses .00 to 1.00, and Percentage uses 0% to 100%.
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Popup Positioning

Center On Selected - This is the method where the selected item is always centered on the popup button. This 
can cause the menu to be partly truncated if it falls partly outside of the screen, which means that the user may 
have to scroll through the menu to get at the desired item.
Keep All On Screen - this is the method which ensures that the whole popup menu is always shown on screen. 
This may require the menu to be moved so that the selected item is no longer centered on the popup button.

Automatically Creating Keyframes

The Auto Key button on the lower part of the main interface turns the overall auto key mode on or off. When active, 
existing keys are automatically adjusted if an item is modified.

The pop-up menu on the General Options Tab has three settings:

Off - Off will modify only the settings of an existing keyframe for the current item.
All Modified Channels - All Modified Channels creates a keyframe, but for only the modified motion channel 
group (e.g., XYZ or HPB). So, for example, if you change only an item’s heading, a key is created only for the 
current item’s heading, pitch, and bank at the current frame.
All Motion Channels - All Motion Channels creates a keyframe for all motion channels.
Fixed - Keys will only be placed at the Auto Key Fixed Frame set below.

This feature can be a nice time-saver when compositing still images or initial keyframes, but can be a detriment when 
changing a feature like a position, as a test to see if you like it.

Parent in Place

When Parent in Place is active, an item will maintain a constant position, size, and orientation when it is parented or 
unparented.
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Left Mouse Button Item Select

When Left Mouse Button Item Select is active, you may click on an item with the LMB to select it in a viewport. (Those of 
you with three-button mouses can always use the MMB.) The reason to turn this item off is to prevent accidental 
selection of other items while trying to move, rotate or scale your current item.

Dbl. Click Bone Mode

With Double Click Bone Mode activated, bone mode is selected when a bone is double-clicked on.

Frame Slider Label

The Frame Slider Label pop-up menu lets you choose a type of measurement on the frame slider, which is the ruler-like 
control on the main interface.

You can select between Frame Number (the default), SMPTE Time Code (HH:MM:SS:FF, where HH is hours, MM is 
minutes, SS is seconds and FF is frames), Film Key Code, or Time in Seconds.

Frame

SMPTE
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Film Key Code

Time in Seconds

Frames Per Second

The Frames Per Second rate is specific to the calculation of texture velocities and other internal information that can be 
accessed by LightWave’s plugin architecture. If you had based a moving texture velocity so that it appeared to repeat 
every 30 frames, but your output was going to film (at the film rate of 24 frames per second), you would want to set this 
value to 24 so that the repeating nature of the pattern repeated properly. Change this frame rate if you are working on 
film or another medium that has a frame rate different than video (30 fps).

Frame 0 Time Code

Enter a starting SMPTE time code for frame 0 in this input field if it is other than 00:00:00:00. This can be important, even 
if you are not using SMPTE Time Code as your Frame Slider Label, but are using it in the Data Overlay setting on the 
Render Options Panel (Render > Render Options).

Frames Per Foot

When using Film Key Code, you can specify the Frames Per Foot.

Fractional Frames

When Fractional Frames is turned on, the frame slider can be placed at non-integer frame values, either by adjusting the 
frame slider, jumping to the previous or next key, or typing into the Go to Frame requester.

Show Keys in Slider

When Show Keys in Slider is active, a line will appear in the slider where a keyframe exists for the selected item(s).

Changing this value does not move keyframes. Keyframes are located based on time rather than frames so 
they’re always allowed to lie on fractional frames. If you want to move fractional keyframes to integral frame 
values, use the Snap Keys function in the DopeTrack.


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Play at Exact Rate

Play at Exact Rate causes forward and reverse playing of the scene to ignore the frame step and instead play in real-
time, waiting or skipping frames as needed. It has no effect on preview animation playback.

Measurement Unit System

LightWave supports several units of measurement. You can choose to work in different notations; however, you may 
input a value using a unit of measurement other than the default, and it will be converted on the fly. For example, you 
may be using meters, but if you type in “5 ft” LightWave converts it to 1.524 m. (Metric is basically the same as SI except 
that it also uses centimeters.) The Unit System setting determines what units of measurement Layout uses and 
displays. 

SI - SI is the International System of Units. (SI is the abbreviation of the French “Le Système International 
d’Unités.”) Unit measurements in Layout will now use a base system of meters. Grid sizes and distances can be 
measured in megameters, kilometers, meters, millimeters, micrometers, and nanometers.
Metric - Metric is the same as SI with the addition of centimeters.
English - The English system refers to measurements in miles, feet, and inches.

Setting the Default Unit

If a unit is not specified in an input field, the default is used. You can select the default unit using the Default Unit pop-
up menu.

Undo Levels

The number of available undos is determined by the Undo Levels setting found in the General Options Panel. You can 
set a specific number of levels by typing in a number in the Undo Levels entry field, or you can click to activate the 
Unlimited Undo option.

The Autokey Management option will delete the keyframe when an undo is performed.When Autokey Management is 
deactivated, the last action will be undone, but a keyframe will be left in place. Unlimited Undo will keep a history of all 
undoable actions from launch.

We strongly suggest that you use SI or Metric since that measurement type is generally assumed for exercises 
and tutorials.



We strongly suggest that you use the SI or Metric Unit System and meters as the default unit. Use other 
settings only for special situations. Both systems are based on 10, which will make your Modeling and 
animation life easier. The Default Unit of meters is assumed for exercises.


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Save Options

There are three different Save Options:

Disabled - When you clear scene, load a new scene or close Layout it happens immediately with no warning if 
things are unsaved.

Simple - This brings up the above message if you clear scene, load a new scene or close Layout without having 
saved first.

Advanced - The default option brings up a panel where you have control over what you wish to save, and how:

View Modified only - Shows only items that need saving
Scene File Version - 2018 is the current save format and default, but scenes can be saved as earlier versions to 
support people that don’t have the latest LightWave. Obviously these older scene formats won’t include features 
that were only introduced in later versions.
Save All Modified - Overrides the Save Mode column that indicates whether an item should be saved, saved 
under a new name or saved as an incremental version.
Save Mode - Defaults to Do Not Save , but this only applies if Save All Modified is unchecked. If is unchecked 
then the choice can be made individually for each scene item whether to Save , Save As , Incremental .
Save, Save and Clear, Clear and Cancel - These four options finalize the saving, or not, of a scene.
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Auto Save

You can set Layout to auto save objects and scenes to the current content directory in a folder named Backup. This 
folder will contain sub-folders for sorting dates and times. The times that can be set are 1 min, 5 min, 15 min, 30 min, 1 
hour. The auto save does not to save if there have been no changes made.

Protect Legacy Scenes

When this switch is checked (as by default), a warning will appear when loading a scene from a previous version of 
LightWave. There have been sweeping changes made to LightWave 2018 rendering it less compatible with legacy 
versions. Enabling this option will copy the scene to a new content directory of your choice before opening the new 
copy, preserving your content made with previous versions of LightWave.

Enable Master Autoload

This toggle will automatically load Master plugins when loading a scene. Normally it should be left checked, but studios 
with a specific Master plugins policy can disable it.

FSPE

A toggle has been added for FSPE (Full Scene Parameter Evaluation), which was previously a hidden feature. You can 
find it in the General Options panel in Layout. FSPE is a legacy plugin which was intended to take IK data into motion 
plugins.

Autoscan Plugins

If checked on, Autoscan Plugins scans the plugins folder and creates a file “ Extension Cache” with contains a list of all 
of your plugins. If you leave Autoscan Plugins off, you can fill the “LWEXTxxxx” configuration file by running Scan 
Directory.

Autoscanning is a process to look for plugins in specific locations for the current session. To speed up this process in 
subsequent sessions, the new extension cache file remembers the previous autoscanning and allows comparisons with 
the new session to see if these specific plugin locations have added or removed plugins from their folders. Plugins 
founds through this approach are tagged internally as ‘non-persistent’, since they may not be around the next session. 
Manual scanning of plugins (the Edit Plugins panel, either adding a single plugin or scanning a folder) makes the system 
aware of ‘persistent’ plugins, which are plugins you have specifically chosen to use regardless of any non-persistent 
(autoscanned) plugins. Knowledge of persistent plugins is kept in the usual “LWEXTxxxx” config. Persistent plugins 

Be warned that saving endless backups can rapidly fill a hard disk!

It is recommended to keep FSPE disabled. A continuous loop can be added if a child object is dependent on 
the motion of the parent object.



FSPE and Fixed Near Clip Distance are set back to the default settings upon Clear Scene or New Scene.
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supersede non-persistent plugins if they should ever conflict, thus giving the user more control of what plugins are 
used. It is recommended you have autoscan enabled and manually add plugins that are not in the pre-determined 
plugin locations. If you turn off autoscan, you are still able to manually add persistent plugins, but no non-persistent 
plugins will be available.

Clear Scene to Default

When this option is enabled, if a default scene exists in the Scenes directory of the current content path, it will be 
loaded into Layout whenever the user successfully performs a “Clear Scene”.

Threaded Mesh Evaluation

Threaded Mesh Evaluation will use however many cores you have and may help speed up mesh deformations..

The multithreading only happens in Layout for interactive work, not when rendering. Currently the following parts of 
the mesh evaluation have been multithreaded:

Morphing
Bone deformation
Motion (application of item move/rotate/scale to mesh)

Thumbnail Review

When this is checked and the Render Scene (F10) function is running, a series of thumbnails will appear in the Render 
Status Panel, showing the last several renders in the sequence..

Graph Editor Audio

This option enables the graphical representation of audio in the Graph Editor. Obviously you need some audio to show. 
Audio files can be added to Layout in the Scene/Dope Editor.

Layout recognizes a “default.lws” scene. If you save a scene named “default.lws” in the Scenes directory of 
your Content Directory, each time you open Layout it will open this scene.


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Enable Image Caching

This feature is intended to allow you to have an alternative to having all images active in RAM during the work session. If 
Image Cache is enabled, then the most-used images, or parts of images, are kept in RAM, and the least-used are stored 
in an on-disk image cache folder. This conserves memory and may even speed up rendering because the cache is stored 
as parts of images. If only a small area of a large image is needed for the render, this will be faster than fetching the 
whole image only to concentrate on a tiny part of it.

The feature is activated via toggle in the Preferences Panel > General Options tab. The user should ensure that their 
cache drive has sufficient space to accommodate caching by the nodes and is rapid enough for the read/write 
operations that will need to be performed.

When you first start the Image Cache, you will be asked to create a directory to store offline images. By default, a new 
folder called lwimagecache will be created in your User\Temp directory (%TEMP%\lwimagecache on Windows, ~/
Library/Caches/lwimagecache on Mac OS). The image cache will rapidly be filled with slices of the images in the 
loaded scene.

The image cache system is handling both those images that are present in the application that have not yet been saved 
and those that have a source file on disk. Exceptions are render buffers and LightWave image plugin-based loading - 
these images cannot be added to the cache until loading is complete. All cached images are saved in the internal 
working format for LightWave. This provides very quick handling for saving and for reloading. This also eliminates the 
need for repeating the time-costly processing steps that would be required for the source files from disk if they were to 
be simply loaded and cleared multiple times throughout the work session.

The image cache will flush when the feature is disabled or you quit LightWave.
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The Image Cache Maximum (or "RAM Limit for Images") entry is the total amount of RAM that you wish to allow for 
images, collectively, before caching to disk is engaged. The default setting is for systems with small RAM capacity. If you 
have more than four gigabytes of RAM, you will likely want to use higher settings. The maximum setting is one terabyte, 
but as a rough guide half of system RAM will give a good compromise between speed and usefulness.

On systems with large RAM capacity, you will gain some speed in image handling by turning the feature off; if you are 
using large images or a lot of images, this will, however, take up considerably more memory than when Image Cache is 
on.

Network rendering is complicated by this caching technique. Care needs to be taken to create a cache on 
individual nodes. To that end, choosing an appropriate directory on the originating machine is vital. The 
default location of %temp%\lwimagecache should be available to every Windows machine, but be careful if 
you choose a different location.


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Layout Display Options

Click here to expand Table of Contents...

Viewport Layout
Alert Level
Toolbar
Customize Interface Color
Grid Settings
Fixed Near Clip Distance
Dynamic Update
Bounding Box Threshold

(default keyboard shortcut D)
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The Display Options Tab on the Preferences Panel (Edit > Display Options) controls the settings for display options that 
are global in nature.
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Viewport Layout

You can display more than one viewport by changing the Viewport Layout pop-up menu. All of the normal viewport 
options can be set independently and all viewports will update simultaneously.

You can customize the relative sizes of multiple viewports by dragging the borders between them. Click the Save as Default 
button to use the selected Viewport Layout for future sessions. Otherwise, it will affect only the current session.

Undock Preview Window will make an undocked preview window when Make Preview is used. With Undock Preview 
Window active, Use Camera Resolution becomes an option. With Use Camera Resolution checked, the preview will use 
the resolution settings in the selected camera. Preview Scale Level is used for VPR previews and allows you to choose 
at what level to render previews. Every 32 pixels will be very rapid, but only clear in the largest strokes where Every 1 
Pixel will be slower to render and clearer. Antialiased will render each frame to the best VPR can before it moves to the 
next frame.

The display always uses OpenGL; it is not an option. Also, many of the display options are approximations and 
your actual rendered results may be different.


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Alert Level

The Alert Level setting controls how error, warning and informational messages are displayed. When set to High, these 
messages are displayed as dialog boxes, which you need to manually dismiss. The Medium level moves warning and 
information messages to an information line near the bottom of the interface and Low moves all messages.

Layout Information Line

Toolbar

The Left or Right settings determine on which side of the interface the Toolbar appears. (If you are left-handed, select 
Right.) If you are a keyboard shortcut expert, you can activate the Hide Toolbar option, which makes the Toolbar and 
Tabs invisible.

Customize Interface Color

Brings up a new window that allows you to choose the interface colors that suit you. There are three tabs, each with 
specific settings.

To redisplay the toolbar, press Alt F2 or open Display Options again.
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Grid Settings

Use the Grid Type pop-up menu to set the size of the overall grid or turn it off. Adjust the Grid Square Size to change the 
size of each square. Display Origin Only will display only the origin lines of the Grid. The Grid Antialiasing option will 
smooth out jaggies when active at the expense of a little processing time (should be imperceptible on modern systems).

LightWave must be completely closed (including the Hub) for the new settings to take effect from the following 
launching of LightWave.


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Fixed Near Clip Distance

The near clipping distance is the point at which surfaces disappear in your OpenGL display. Normally, the distance to 
the near clipping plane is set automatically to one-tenth of the grid size, multiplied by the camera zoom factor. You may 
change the base value by activating the Fixed Near Clip Distance option and entering a value in the input field.

If near clipping becomes a problem, you may find it easier to just adjust the grid size using the [ and ] keyboard 
shortcuts.

Dynamic Update

The Dynamic Update pop-up menu affects how the Layout window is updated with respect to changes on various 
panels. Interactive will continuously update the Layout window while changes are made. Delayed will update the 
Layout window when you release the mouse button. Off will update the window only when you close the panel.

Which setting you use will depend on many factors, like your processor speed, available processing resources, scene 
complexity, and so on. You may want to try Interactive and then back off to a lower setting, if updates become too 
sluggish.

Bounding Box Threshold

This value is an absolute limit for the number of points or polygons an object must have for it to automatically change 
to a bounding box during editing (move, rotate, size, etc.). For example, if the value is set to 5000, any object that has 
fewer than 5000 points or polygons will remain in solid or wireframe mode even as the object is manipulated. This can 
result in jerky movements depending on the speed of your computer and the quality of the video card. Any object with 
more points or polygons than the limit will automatically switch to bounding box mode so that the object can be 
manipulated smoothly. You should experiment and find a level that your computer can display at a decent rate and 
then leave that as your default.

Display - Camera View Tab
Display - Schematic View Tab

The near clipping distance only affects your OpenGL display and has no impact on your rendered images. 
There is also a far clipping distance that is always set to 10,000 times the near clipping distance. Normally you 
never see its effects unless you zoom out extremely far or have very distant objects, like stars.



The Bounding Box Threshold does not affect instances.
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• Display - Handles And Icons Tab
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Display - Camera View Tab

Camera View Background

LightWave lets you choose how you want the Layout interface background to appear when using the Camera view 
(only).

Blank - is the default choice and will show nothing but the normal blank gray background.
Backdrop Color - uses the color selected as the Backdrop Color on the Backdrop Tab of the Effects Panel ( Scene
> Effects > Backdrop ).

Background Image - lets you see the image set as the Background Image on the Compositing Tab of the Effects 
Panel (Window > Compositing Options) in the Camera view. You can use it to help you align objects that need to 
be positioned properly with respect to the background image. It will also show when you make preview 
animations using the Camera view.

This setting is independent of how the background will appear in a rendered image. That is, if the Backdrop 
Color is orange and there is a Background Image set, the viewport background will still appear orange if this 
option is set to Backdrop Color.


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• Preview - This requires you to have a preview animation loaded into memory of course. This can be one that was 
just generated or one that was loaded.

The preview animation will load starting at the upper-left corner of the Layout window. Make sure to use the same size 
interface as you did when you generated the preview for easy reference. It will also load beginning at frame 0 no matter 
what the frame was originally when the animation was created.

This feature is invaluable for creating moving composite shots and mattes. Using an image sequence composed of live 
footage as the background image, create a preview animation of that sequence with no objects or grid. Save the 
preview and load it in later when you need it. The preview animation will update much faster than using the original 
images as a background.

Composition Overlay

The Composition Overlay divides up the screen in a number of ways and is used to help with the aesthetics of a 
composition. Some of the overlays use the Golden Ratio (sometimes called the Golden Cut or Golden Proportion) which 
is represented by the Greek φ, or phi, which is a constant of about 1.6180339887. In mathematical terms, using a line as 
an example, the ratio of “a to b” is the same as the ratio of “a+b to a”, “a” and “b” being lengths on the line.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  232

•

•

•

Golden Sections - The camera view is divided by φ in both directions for X and Y directions.

Golden Triangle - The camera view is divided by φ using the sides of triangles for the ratio.

Harmonious Triangles - Similar to the rules for Golden Triangle, it draws from opposite sides.
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Rule of Thirds - Divides the screen into three equal parts in X and Y.

Spiral Sections - Using the rule of φ, the screen area is divided into a series of rectangles in the form of a spiral 
pattern.

Golden Spiral - Similar to Spiral Sections , the screen is divided by a curve using proportions of φ.
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Flip H - Rotates the Horizontal orientation 180 degrees.
Flip V - Rotates the Vertical orientation 180 degrees.
Rotate Compositional Overlay - Rotates the overlay by the specified amount.
Compositional Overlay Color - Select the desired color for the overlay.

Show Safe Areas

If your animation will be viewed on a television, be aware that viewers will not see the entire image. Select Show Safe 
Areas to toggle outlines in a Camera view that indicate the safe text (the inner border) and safe action areas (the outer 
border) for television. To allow for the display differences of different brands and designs of television sets, you should 
use this guide to ensure that text and action elements in your animations remain on screen when it is important that 
they be seen.

Alternate Aspect Overlay

The Alternate Aspect Overlay setting lets you overlay the borders of an alternate frame aspect ratio, within the normal 
frame in camera viewports. This information-only display mode can be used to simultaneously compose shots for both 
film and television, for example. The default alternate aspect ratio is 1.85.

OpenGL Fog

If you have the OpenGL Fog option active, you can see an approximation of your Fog settings from the Camera View as 
well.

These are reference guidelines and are not absolute positions.
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Show Field Chart

The Show Field Chart option turns on a crosshair chart similar to a 12-field chart as used in the film industry. It divides 
the camera view into quadrants, with each quadrant having 12 segments.

OpenGL Lens Flares

The OpenGL Lens Flares option lets you see lens flares right in a viewport while you use the Camera view. If you have the 
Lens Flares Options Panel open you can interactively make changes to the settings.

OpenGL Fog

Shows a representation of how Fog will look in the render. Like the other settings, only visible in the Camera Viewport.

Copy to Perspective

The Copy to Perspective option will use the appropriate settings in Camera Properties for the Perspective view.

DOF/MBlur Preview Passes

The DOF/MBlur Preview Passes setting sets the number of passes for Depth of Field and Motion Blur previews in the 
viewport.
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Display - Schematic View Tab

Several display options for the Schematic view appear on the Schematic View Tab.

Choose between Straight or Right Angle from the Link Style toggle.

Also, choose between Vertical or Horizontal from the Link Direction toggle.

If the Show Goal Links option is active, item links to goals are shown in dotted lines.
If the Drag Descendants option is active, moving a parent will move all its children as well.
If the Show Plugin Links option is active, motion dependencies from motion and channel modifier plugins are 
shown as dotted black lines.
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Display - Handles And Icons Tab

Handle, Camera, Light and Bone Icon sizes can now be changed and Bone sizes can also be changed individually in the 
Bone Properties Panel. Draw Bones Filled will draw filled in bones. Handle Wire Smoothing will set the amount of 
smoothing for handles in the viewport.

Draw Joint Rot. Tripod - displays the three arrows showing the axes for Joint-type bones only. This means you 
can see at a glace the orientation of your Joints without having to select them.
Render Thicker Gizmo Handles - Makes the handles for the various gizmos (Move, Rotate, Scale, etc.) bigger in 
the OpenGL window.
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Layout OpenGL Options

Click here to expand Table of Contents...

Display Characteristic Settings
Show Handles
Show IK Chains
Show Target Lines
Show SubPatch Cages
Show Fog Circles
Show Spline Targets
Overlay Color

Shaded Display Options
Max OpenGL Lights
OpenGL Textures
Faster Highlights
Pixel Blending
MipMap
Transparency

OpenGL Options Breakdown
Multi-Texturing
Reflections
Color Channel
Transparency Channel
Diffuse Channel
Luminosity Channel
Specularity Channel
NormalMap Channel

Shading Method
PBRGLSL Shaders
GLSLShaders
Geometry Acceleration
Transparency Sorting
VSync

Display Characteristic Settings
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The Show Motion Paths option toggles the visibility of the motion path and keyframes for the current active item in 
Layout.

A motion path looks like a line with small white (+) symbols at each keyframe. Motion paths are subdivided into smaller 
segments corresponding to the number of frames between keyframes. With Show Motion Paths active for an object that 
is stationary during an animation, the graph will display a single keyframe symbol only, indicating that this is its only 
keyframe position.

Motion Path for the Right Hand Bone

You have the ability to set the quantity of frames shown before the current frame and after it using the Motion Path 
Pre- and Post- fields. The setting defaults to 60 to match previous versions of LightWave. Other changes in this area of 
the GL tab of Preferences are:

Use Item Color - If checked, Motion Paths will be drawn using the item color (defaults to on).
Show Frame Markers - If checked, Motion Path Frame Markers will be drawn (defaults to on).
Show Keyframes - If checked, Motion Path Keyframes will be drawn (defaults to on).

Show Handles

The Show Handles option will display reference handles for the current item when you are moving, rotating, or 
stretching. These are based on the item’s local axes at its pivot point.

Be aware that Layout evaluates to whatever length the motion paths are, so the longer the paths are, the more 
they will impact performance.


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Show IK Chains

The Show IK Chains option will display a solid line for the IK chain and a dotted line for the direction of the item 
reaching for the goal object.

Show Target Lines

The Show Target Lines option turns on/off the line that connects between an item being targeted and the item 
targeting it.

Show SubPatch Cages

When using SubPatch objects, you may want to see the SubPatch cage. Activate Show SubPatch Cages, if this is the 
case.
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Show Fog Circles

When you want to see the extent of your fog’s Max Distance and Min Distance on the Volumetrics Tab of the Effects 
Panel (Scene > Effects > Volumetrics), activate the Show Fog Circles option and use one of the orthogonal views. You 
will see circles representing the two fog radiuses, a result of the minimum and maximum fog values. Just as the 
backdrop gradient sphere is centered about the camera, so is fog.

If you activate fog and the Show Fog Circles option, but do not see the indicator, check for the following factors:

Verify that Fog Type on the Volumetrics Tab of the Effects Panel is not set to Off.
Verify that you are using an orthogonal view.
Verify that you should be able to see the fog circles. Are you too close or too far from the camera for the circles to 
be visible? Use the grid as a guide. Also, is the Overlay color too similar to the object color? Try changing to a 
different display mode, or try changing the Overlay color (discussed below).
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Show Spline Targets

The controls in this section of the GL tab of the Options panel refer to the Spline Control tool.

Overlay Color

The color of the overlays for the field chart, limited region, fog circles, and so on, can be set to any of the standard 
wireframe colors using the Overlay Color pop-up menu. Setting the Default Overlay Color is saved in preferences. 
Setting the Overlay Color is not persistent.

Shaded Display Options

The following options affect the shaded OpenGL display characteristics.

Max OpenGL Lights

Enter the maximum number of light sources you want used in the OpenGL display. This lets you see their your lights’ 
effect right in the viewport in real-time. It is normally set at 8 since most graphics cards have this as a limit. Professional 
cards can sometime have more OpenGL lights. The number of OpenGL lights set does not affect renders.

OpenGL Textures

Activate to show image-mapped textures (not procedural) in the viewports. Use the Texture Size pop-up menu to select 
the pixel resolution (e.g., 1024 x 1024). Lower settings will update faster and use fewer system resources, but go all the 
way to 16384.
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Left: OpenGL Textures Off, Right: OpenGL Textures On 

Usually the first Color or Diffuse image map layer is shown in the Texture Mode viewports. Enable Show Texture Editor 
Layer to show the Texture Editor’s current layer instead, if applicable...

Reflection Mapping will only be visible when the surface Reflection value is greater than 50 percent.

Faster Highlights

The Faster Highlights option makes the display of (specular) highlights faster, but less accurate. Note that the difference 
may not always be visible and will vary depending on circumstances.

Pixel Blending

This OpenGL option will activate a smoothing display function.
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MipMap

Mipmapping is similar to what is used in today’s games to avoid graininess of textures in a distance or at a flat angle. 
Basically lower- res versions of the texture are generated in realtime and blended in. This feature is supported in 
hardware by most of today’s graphics cards. This feature also works if Mutitexturing is turned off. Please note however 
that due to the nature of this filtering method, low-resolution textures may appear a bit blurry.

Transparency

The OpenGL Transparency option activates a surface transparency feature in viewports. This lets you see through 
transparent surfaces in shaded viewports. (Of course, this is only an approximation of your actual rendered result.) This 
setting also controls Modeler’s display of transparent surfaces, if the Hub is running. Modeler will remember the last 
used setting, if you aren’t using the Hub.

OpenGL Options Breakdown

Multi-Texturing

Multi-texturing means multiple textures layers per polygon in OpenGL. Depending on the settings that you activate (see 
below), the following combinations of texture layers are possible:

Two color-layers with one diffuse-layer, one luminosity-layer and one reflection map (5 textures/
polygon).
One color-layer with one transparency-layer and one reflection map (3 textures/polygon).

Reflections

This OpenGL option lets you see the effects of image-mapped reflections (not ray-traced) in a Layout window.

Color Channel

For the display of textures in the Color Channel if Multi-texturing is on.

Transparency Channel

For the display of textures in the Transparency Channel if Multi-texturing is on.

Diffuse Channel

For the display of textures in the Diffuse Channel if Multi-texturing is on.

Luminosity Channel

For the display of textures in the Luminosity Channel if Multi-texturing is on.

Multitexturing is made to work with graphics-cards with at least two texture memory units.
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Specularity Channel

Shows image maps and texture for the Specularity channel.

NormalMap Channel

Shows applied Normal Maps.

Shading Method

In the Shading Method dropdown you have the choice between Multi-Texture, GLSL Shaders and PBRGLSL Shaders. We 
have detailed how Multi-texturing works just above.

PBRGLSL Shaders

Advanced GLSL shaders emulating the materials in the Software Renderer/VPR closely. Although shadows are not 
catered for, the fidelity of these shaders is much closer to VPR render equivalents. Cel shaded textures and reflections 
are also duplicated in OpenGL.

GLSLShaders

GLSL OpenGL Hardware Shading supports the OpenGL 2.0 hardware shader technology in video cards to provide very 
close approximations of render functions in the viewport displays. Light falloff, surface blending, gradients, and many 
procedurals can now be displayed in the OpenGL viewports in Layout when GLSL HW Shading is turned on.

New to 2019

The PBRGLSL shader is more demanding on hardware than GLSLShaders and lower-end GPUs may struggle.

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Geometry Acceleration

Determines how the graphics card displays OpenGL. Streaming renders the mesh immediately to screen, using the 
lowest amount of memory at the cost of speed. Buffered(VBO) will attempt to store the geometry in graphics card 
memory, allowing for the highest speed, at the cost of memory. In cases where the mesh or shading changes with every 
frame no caching is possible, a fallback to the Streaming method will result, for example with animated meshes and 
reflection maps. Smooth shaded geometry will benefit the most from the Buffered(VBO) mode. If the mesh is buffered in 
graphics card memory the performance you will get as much performance as your graphics card can give you.

Transparency Sorting

It’s usually fastest to leave this as it is, on SortbyObject. However, if you have a large quantity of surfaces with varying 
degrees of transparency, for accuracy you may prefer to choose SortbyPolygon. AlphaClipping is the fastest of the 
three methods but really is clipping. Anything less than 100% transparency shows as solid.

VSync

There are three options and again, leaving this setting to Always On should be the best choice in most cases. If your 
scene is extremely heavy setting it to Off or Only When Playing might give you a speed advantage when setting up the 
scene.

New to 2018

Two new channels have been added to the visibility options for Layout.  The Specularity Channel will show 
image maps and texture for the Specularity channel and NormalMap Channel will show applied Normal Maps. 
CGFX shading was removed in 2018, but these two perform many of the same functions and are more general.

OpenGL view with Normal map, Specularity and Depth of Field - this display is not VPR


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Layout Defaults Options

The Defaults Tab is concerned with default settings - including Scene Length, Frame Size and Camera settings.

The Default Start Frame and Default Initial Keyframe fields were new to LightWave 2018. Setting the Default Start 
Frame to a number other than the default 0 will begin the scene from that point in time, with the scene length 
measured from the new start point. If you have the scene start at something other than 0, consider also setting the 
Default Initial Keyframe field. The initial keyframe is made at 0 by default when you add or create a new Layout item, 
changing the start frame might mean the initial keyframes from new scene items are out of view.

Fixed Near Clip Dist. will create a clipping distance that is much closer for small objects at the expense of objects that 
are distant in a scene disappearing. The scene-level distance clipping setting on the Layout Display Options tab will 
allow you to set a nominal distance for clipping.

Default Edit Mode will allows you to specify which of the four edit modes (Objects, Bones, Lights, Cameras) to make 
active whenever the scene is initialized. This happens, for example, when the application starts, or when a scene is 
loaded.
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Layout Paths Tab

Here you can set default paths for LightWave to use, including network paths if you are using LightWave in a team with a 
centralized Content Directory. It also supports the use of non-standard content directory folders to better fit with other 
software in a pipeline if necessary. The Presets path has a cross at the end to clear any input path rather than needing 
to visit LightWave’s configs to clear.
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Auto-Detect

With Auto-Detect enabled, when you open a scene, Layout will attempt to automatically detect the paths for items in a 
scene.

Use Custom Paths

With custom paths enabled, you can specify a separate path for each category. This needs to be ticked before you can 
access each of the Scenes, Hierarchies, Objects, etc. buttons below.

Presets Location List

Clicking on this button in the Paths tab will open a fresh window with Preset location paths. New Locations can be 
added and chosen between and locations can be set as default or made read-only. This also makes possible a network-
wide presets system that can be carefully managed.

Image Cache

LightWave 2019's new Image Cache system path can be chosen here, but care needs to be taken especially with 
network rendering. See the Image Caching section on the Layout General Options page.

Content Directory

Please note that you should not add a custom path that is the same as the default paths (either Custom, This 
User, or Built-in) on installation. Presets will be using the same files and thus appear as duplicates.


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Content Directory

Content Directory

LightWave's content directory system is an essential part of how scenes are constructed in LightWave 3D. All content 
consists of a scene containing objects (either geometry-based or procedural), surfacing for said objects (again, image-
based or procedural) and all the animation, lighting, and other information necessary to recreate how a scene is 
intended to render final images - the end goal of creating a scene.

LightWave defaults to looking in certain directories under the Content Directory when you load scenes, objects, 
surfaces, images, envelopes, motions, previews, etc. This defaults to the user documents folder for the machine you 
installed the LightWave software into. The Content Directory is LightWave’s master directory; LightWave expects to find 
all of the appropriate subdirectories within this master directory.The Content Directory allows you to create a truly 
portable LightWave scene, including all object and image files and essentially acts as a pseudo root directory. By saving 
all your object and image files in subdirectories below the Content Directory, your LightWave scene and related files can 
be moved from drive to drive, from system to system, and even platform to platform, and still load properly.

Portability is important because LightWave scenes are often rendered on multiple machines or shared for education or 
fun.

Relative Links
When you save a scene, LightWave tries to save only a relative link to image and object files. So an object stored on your 
hard drive as C:\MyProjects\StretchPrincess\Objects\Jo.lwo where the Content Directory was C:
\MyProjects\StretchPrincess, would be saved in the scene file as only Objects\StretchPrincess.lwo.If you use objects or 
images outside of the Content Directory, those links are hard-coded (e.g., F:\Stretch\Princess\Jo.lwo). If you never 
move the scene and support files to another computer, the scene will load fine, but this isn’t the way you should do it.

Object File Links
Like scenes, objects can also have linked files. These are usually Image Maps used for surface textures. The Content 
Directory concept is also relevant here. Using image files below the Content Directory will avoid loading problems.

If you make any changes to object surfaces, you must save the object file - a step separate from saving a scene.

To set the Content Directory:
Open the General Options Tab of the Preferences Panel (Edit > General Options) and click the Content Directory button. 
A file browser will open and you can navigate to and select the folder you wish to use as your Content Directory.

You can also choose Set Content Directory from the Edit button, or choose from among the Content Directories that 
you’ve used lately by using Edit > Recent Content Directories, or by using the keyboard shortcut Alt + F12.

You can also change it in Modeler, on the General Options Panel. (If the Hub is active, Layout and Modeler will sync any 
changes to this setting.)

Ways to Use the Content Directory

If you use LightWave in a network environment, it is imperative that you use the Content Directory correctly.

If you load a scene where an object/image file cannot be found, a file dialog will appear, letting you manually 
locate the file. To prevent having to keep redirecting LightWave, save the scene once loaded and better use 
Package Scene to unite all elements into a content directory.



https://docs.lightwave3d.com/display/LW2018/Working+with+Files#WorkingwithFiles-PackageScene
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Here are a couple of different ways to use the Content Directory feature:

Use a separate directory as the Content Directory for every project. You’ll need to create subdirectories for 
Objects, Images, and Scenes beneath it. All files relevant to the project would be stored here. As you change 
from project to project, you must also change your Content Directory. (Note that your project could contain a 
multitude of scenes.)
Create subdirectories called MyProjects in the Objects, Images, and Scenes subdirectories that are created when 
you installed LightWave. (e.g., C:\ Lightwave\ Objects\ MyProjects, C:\ Lightwave\ Images\ MyProjects, etc.). 
Then, for each project, create identically named subdirectories in each of the MyProjects subdirectories and 
store your files accordingly.

Production Data Files
Subdirectories other than Images, Objects, and Scenes (e.g., Surfaces, Motions, etc.) are generally important only 
during the production stage. The information from these files is incorporated in the scene or object files and is not 
tracked independently. For example, when you apply that cromulent silver surface file to your spaceship’s skin, the 
settings are saved in the object file. The surface is not referred to again, unless you use it again.

In Layout’s File Menu, Package Scene can be used to collect a scene’s supporting files and ensure correct compliance 
with your content directory.

Be aware that LightWave will happily use either system, but that housekeeping is easier with the first option 
although file duplication might become a problem



https://docs.lightwave3d.com/display/LW2018/Package+Scene
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Layout CS (Color Space) Tab

Since LightWave 10, LightWave has been able to use Color Space information to give better results, above all with 
images used for texturing. Color space conversion is performed in four places in LightWave.

On loading, an image can be converted from its native color space format to linear.
When sent to the Image Viewer, an image can be converted from linear to another color space.
When saved from the Renderer, an image can be converted from linear to another color space.
When picked from the Color Picker, a color can be converted from and then to linear color space.

By default, LightWave is set not to do any conversion - the Linear setting, but to better suit work for the monitor, switch 
to sRGB. For better work for widescreen high-definition TV choose Rec709. These choices will help convert images that 
may already have color space definitions and keep their colors pure.

LightWave provides presets for sRGB and rec709 but a personalized mix can be set up with the dropdown choices for 
each of the different elements and saved as a preset for future use. You can also load in color space definitions to 
exactly match existing setups. A color table can be loaded by using Load Table from the pop-up. The color tables are 
stored in the project directory, in a directory called ColorTables.

The options are as follows:
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Convert Color Space to Linear

Picked Colors - Colors chosen from the LightWave or other color picker
Light Color - The color chosen for lights
Palette Files - Palettes loaded into LightWave
8-bit Files - 8-bit here refers to images that are 8 bits per channel such as JPGs, PNGs or TGAs, previously known 
as 24-bit or 32-bit. These benefit the most from color space conversion.
Float files - Images using floating point colors schemes don’t benefit from color space conversion, indeed it 
would cause severe banding and thus this should always be left on Linear
Alpha - Again, alpha images need to be preserved exactly as they are since the level of gray indicates distance. As 
such they don’t require or want color space conversion

Apply Color Space

Display Color Space - What Layout looks like. Normally, this should be left at sRGB unless you are working on a 
cinema screen or loom or something
Default Final Render- This is the color space for your renders. Again, if they are for the monitor choose sRGB
Default Buffer - These should be left as Linear
Embedded Alpha Channel - This should be left at Linear as for the conversion settings

Other Options

Auto Sense on Load - when you load a scene LightWave detects what CS setting were already in use and 
changes to them automatically when this option is activated
Color Correct OpenGL - to better match the colors of polygons and lights when not viewing in VPR or a render
Affect Color Picker - Best left checked since otherwise the colors you choose in the color picker won’t be those 
you get in the render
Convert 8-bit to Float - Converts 8-bit per channel files, otherwise known as 24-bit, to floating point files. This 
increases the memory overhead a lot for textured images. It will increase the fidelity of the results but is not 
always needed

For more information about Color Space and Linear workflow go here.
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Layout OBJ Options

The OBJ tab contains options for importing and exporting OBJ file objects.

OBJ One Layer - imports the object as a single layer
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OBJ One VMap - imports the object with a single vertex map
OBJ Pivot at Center - creates the pivot of the object at the center of the object
OBJ Write Normals - writes the normals associated with the object when saved
OBJ Merge Points - merges points sharing the same space
OBJ Reverse Ka & Kd - Reverses Ambient Occlusion and Diffuse channels
OBJ Double Sided - Creates double-sided geometry
OBJ Parts - Keeps LightWave Part Polygon tags
OBJ Foreground Layers - Only saves layers marked as foreground to OBJ
OBJ Continuous UV - UVs have shared points rather than duplicated

OBJ Smoothing Groups - Supports the new Smoothing Groups system
OBJ Remove Hidden - Polygons that are hidden will not be exported (Hiding layers does not have any effect)
OBJ Import Scale - sets the scale of an object when it is imported
OBJ Export Scale - sets the scale of the object when it is exported

Modeler can create vertex normal maps by exporting an object in OBJ format with smoothing groups 
unchecked here.


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Navigation Options

Click here to expand Table of Contents...
Introduction
Controls
Device Settings
Subjects and Styles
Presets

Introduction

The Preferences window for using 3D mice and other HID (Human Interface Device) controllers with LightWave 
can be found in Edit > Navigation Options. 2019.1 has added keyboard and mouse-based gaming methods in addition to 
specialized CAD equipment for use in Layout and Modeler.


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Controls

To enable the new navigation options, press X while in the main Layout or Modeler window. You will see a message 
appear at the top of the viewport or viewports indicating which Navigation mode is being used. In this new navigation 
mode, the traditional game keys of W, A, S, and D move in the X and Z directions with Shift speeding movement and 
Ctrl slowing it down. E and Q move in the Y-axis, while mouse movement controls rotation around Y and X axes. The 
vertical scroll wheel controls the field of view, while in Layout, the horizontal scroll wheel controls the scene playhead.

Device Settings

Below the Device Settings button is a dropdown list of devices to choose amongst. There will usually be at least Device 
0: Keyboard and Device 1: Mouse but you may have additional 3D pointers, etc. For the keyboard and mouse, clicking 
the Device Settings button will bring up one of two panels:

Keyboard and Mouse settings

Clicking the buttons in the keyboard settings window will permit changing the keys used for the actions described on 
the buttons, and the mouse settings cover mouse down and up functions and support up to two additional buttons.

Note a change in the Navigation Options panel compared to previous: the Name/Enable/Reverse/Sensitivity/
Scale settings columns are now per-device instead of global. Also, the System Panel button is now the Device 
Settings button, and one of the Enable Navigation buttons is now named Enable Device.


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Subjects and Styles

There are several Subjects and Styles:

View - Acts like using the Viewport navigation controls. If the view is a camera or light, you will be controlling the 
camera or light in the scene.

Grab - This attempts to emulate grabbing the world as you see it.
Orbit - This is similar to grab but using a point of interest in front of the viewer that it will rotate about.
Helicopter - This attempts to emulate flying a helicopter
Walk - similar to helicopter but with limits on the pitch and bank. It attempts to emulate walking.

Current Item - Moves and rotates the currently-selected object.

Grab - This emulates grabbing the item relative to what the viewer sees.
Helicopter - This emulates flying the item from the point of view of the item (as if the user were inside the item 
flying it like a helicopter).

By default, the vertical scroll wheel controls the field of view in both Modeler and Layout in the new navigation 
options. While it is easy to reset Modeler's default 500 just by opening the Modeler Display Options (D) and 
tapping in the Perspective Amount field, there is no such setting in Layout. It is suggested that you disable the 
vertical scroll wheel setting for the mouse in Device Settings in the Navigation Options... panel.

(If you have already scrolled the wheel before disabling this setting and want to recover your zoom manually 
without restarting Layout, exit the new navigation mode by hitting X. Select an item in Layout, hold down Ctrl
and Alt and move the LMB. In the X field at the lower left of Layout you will see a number. 4 is the normal field 
of view. If the number you have is greater than four, then hit X again and roll the scroll wheel backward. If less 
than four, X and scroll forwards. Check that you haven't overshot.

<4 scroll forward. >4 scroll back


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• Timeline - A mode that uses the Twist on a Space Explorer or equivalent to act like a jog/shuttle dial on a video 
control surface. Holding the Alt key while rotating the device’s puck will result in faster scanning through the 
timeline. The difference is more noticeable when the scene length is longer - a 120-frame scene is only barely 
noted, whereas the difference between normal scanning and Alt-scanning a 600-frame scene is pronounced. The 
changes for 2019.1 mean that this separate Subject is not as needed as a horizontal scroll wheel can move 
through the timeline while in the View or Current Item subjects.

Presets

You can create presets for settings to be able to quickly store and retrieve settings for different devices. References to a 
puck’s X, Y and Z axes consider the navigation device to be laying flat on a table and the x-axis being to the right, the y-
axis being upward, and the z-axis being forward away from the user. The Sensitivity and Scaling can be controlled for 
individual channels for your external control device. You can stop specific channels from being evaluated completely if 
you choose by unchecking the channel concerned, or reverse a channel’s direction.
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Working with Files
Click here to expand Table of Contents...

Recipe for a Scene
Object and Scene Files
Content Organization

Content Directory

Package Scene
Close/Save Window

Recipe for a Scene
LightWave animations (or still images) always start as a Scene - basically, a collection of objects, lights, cameras, and 
images - which can move and change over some specified length of time.

Creating a basic LightWave scene involves the following steps:

Adding items (e.g., objects and lights) to a scene
Setting the starting position for all items in the scene
Setting the length of the scene
Placing items in key positions at certain points in time
Previewing the motions of the items
Setting and testing render settings
Rendering the final animation

Usually, you work on one item at a time, the current item, and you need to tell LightWave which item it is. But before 
you learn how to do that, you need to know that Layout items are grouped into four different types: objects, bones, 
lights, and cameras. When you work on any item, the edit mode buttons along the bottom (i.e., Objects, Bones, Lights or 
Cameras) are set to the current item’s type.

Object and Scene Files
LightWave scenes can contain several things but normally they will consist of:

A camera
Lights
Objects

Cameras, Lights, motion paths particles and all sorts of other things are contained within files with the extension .lws. 
Objects, however, are contained separately in files with the extension .lwo. This means two things. The first is that a 
scene file can be ASCII text and can even be edited by hand. The second is that objects are stored separately, making 
them more easily replaceable and flexible. It does also mean that saving a scene isn't enough to save changes made to 
objects, such as surfacing.


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Content Organization
LightWave defaults to looking in certain directories under the Content Directory when you load scenes, objects, 
surfaces, images, envelopes, motions, previews, etc. By default, this is your user/documents folder. The Content 
Directory is LightWave’s master directory; LightWave expects to find all of the appropriate subdirectories within this 
master directory.The Content Directory allows you to create a truly portable LightWave scene, including all object and 
image files. It essentially acts as a pseudo root directory. By saving all your object and image files in subdirectories 
below the Content Directory, your LightWave scene and related files can be moved from drive to drive, from system to 
system, and even platform to platform, and still load properly.

Portability is important because LightWave scenes are often rendered on multiple machines or shared for education or 
fun.

Content Directory

Package Scene
Package Scene, found in the Save menu, gathers information from your scene and locates the items into the specified 
directory. You can choose to Package Files for transporting it to a different hard drive location, either locally or on 
another machine; Consolidate Files, which will bring any files that are currently not in your content directory into it; or 
Create a Zip Archive of your scene. This last is like Package Files but with the addition of archiving the content 
directory.

If you use LightWave in a network environment, it is imperative that you use the Content Directory correctly.
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Typing a path name works, just remember to hit Tab once you are finished typing

Package Scene is a Python script that will organize your scene content. It will also deal with .MDD, .BDD, and .PFX files, 
and works whether or not your content is actually in the current content structure. If a content element is currently 
loaded into your LightWave scene, Package Scene will find it.

Select the destination folder and if you want a new level under that for each subdirectory, type the name in the 
Subdirectory box. The paths will be updated after tabbing or pressing the Enter key.

Preserve Existing Structure - When checked, Package Scene will keep any specific content directory structure 
you are using, preserving subfolders and naming conventions
Copy Image Sequences - Image sequences can often get very big so are often defined outside the normal 
content directory structure. If you'd like to keep the scene package integral, you can check this option to bring a 
scene's image sequences into the content directory structure. The choice of using a named subfolder for 
sequences is yours
Copy UDIM Sequences - As above, but for UDIM image sequences.

VDB files and sequences are not copied with content directories
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Copy Radiosity Cache File - If a cache has been generated it makes sense to include it with the package so it 
doesn't need to be regenerated.
Reload Original Scene After Export - if you are using Package Scene to prepare files for sharing, it may be that 
you want to reload the original scene, if so check this option. If you want to make sure the Package has worked, 
you will probably want to use the packaged scene so leave this option unchecked.
Export for 2015 - Saves a version of the scene that can be loaded in LightWave 2015. The scene file version is 
converted to one 2015 can load and objects are saved in LWO2 format. Be aware that 2018 has many features 
that don't exist in 2015, from lighting to surfacing so further editing of the 2015 version of the scene will no doubt 
be needed.

After the interface in which you select the target directory for the export, the script:

Gets a list of all images and their paths.
Copies these images to the target directory.
Replaces all the images with their new location.
Changes the content directory to the target content directory.
Saves each object to the target location.
Saves the scene to a temp location.
Parses the scene file to find .MDD, .BDD, and .PFX references.
Finds and copies the dynamics files to their target location.
Rewrites the scene file, changing the respective dynamics paths, to the target location.
Loads the new scene file. This means at the end of operations, the user is now active in the newly exported and 
saved version of the scene, not the original scene from the original location.
If Reload Original Scene is checked, it will instead load the original scene.

Close/Save Window
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View Modified Only - shows only items that have had changes applied in the work session.
Scene File Version - will save the file in the version selected. The version 6.0 entry covers LightWave versions 6.0 
through 9.0.
Save All Modified - will save all changes made in a session.
Items - shows the items in a scene. Clicking on the arrow will expand or collapse the menu tree.
Modified - shows which items have been changed.
Save Mode - has different save options that are available by clicking in the Save Mode section.

Scene files: Do not Save, Save, Save As, Incremental
Object files: Do not Save, Save, Save As, Incremental

Files - is the file path where the items will be saved. Double clicking there will open a save options window.
Save - will save based on the options chosen above.
Save and Clear / Exit - will save based on the options above and then either clear the scene or exit Layout.
Clear / Exit - will clear the scene or exit without saving.
Cancel - will close this window without performing any of the above operations.
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Working with Viewports
Click here to expand Table of Contents...

Views
Types
Options
Changing Your Point of View

Move
Rotate
Zoom
Fullscreen Toggle

The Grid

By default, Layout has one large viewport that can be changed to show different things. Viewports have three dropdown 
menus.

View - What view the viewport is showing you. Examples include Perspective, Camera and Light;

Type - What render style is going to be used for the view. Examples include Bounding Box, Textured Shaded Solid and 
VPR;

Options - this menu has no title and contains a large variety of viewport tools including DoF/MBlur preview, Headlight 
and Match Viewport Perspective

You can split Layout's display into multiple viewports. The first option is to use the Viewport Layout choice in Display 
Options (D). The second is to use the F4 and F3 keyboard shortcuts to switch between the Viewport Layout choices 
sequentially.

You can also set the display mode used by the viewport using the Viewport Display Mode pop-up menu next to the View 
Type selector. This is much faster than using the Scene Editor Panel.


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Views

The three main views you will be spending your time in are Perspective, Camera and to a lesser extent Light (their 
keyboard shortcuts are numeric keypad 4, 6 and 5). The Orthographic views will be less used. It is worth noting however 
that the view names are based on "Looking towards...", so the Back view actually presents us with the head of the 
Rasper Cow pictured, and the Left view shows us the right flank of the creature.

The complete list of default views controlled by numeric keypad presses are as follows:

View Key

Back/Front 1

Top/Bottom 2

Right/Left 3

Perspective/Current Camera 4
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View Key

Current Light 5

Current Camera 6

Schematic 7

The second entry - Back/Front - indicates what happens if you press the shortcut a second time.

Types

Although little to no difference can be seen between Wireframe and Front Face Wireframe in the above image it helps to 
simplify the display of more complex objects. You can actually mix display levels, discussed in the Scene / Dope Editor
section.
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Options
The third menu presents some options for displaying viewports. In the examples for Types above, the Bone X-Ray
option is on. They are all discussed at Viewport Options.

Changing Your Point of View
With the View Control drag buttons located on the upper-right edge of a viewport, you can interactively alter the 
orthogonal and perspective POVs. The buttons are dimmed to indicate that they are not available when you use the 
Light or Camera views, where they have no effect since those are based on their respective item’s POV in the scene 
itself.

Center Continuously centers the viewport on the selected item. You may also activate the Center Current Item option on 
the pop-up menu next to the view selector.

 

For an object, the centering is based on its pivot point, which is discussed later. This is not always the center of an 
object. If you deactivate this mode, the existing POV position will remain until changed. As such, you can use this 
feature to establish a starting point if the need arises.

You can use the keyboard shortcuts A and Shift +A to Fit All and Fit Selected in any viewport. Fitting is based on pivot 
points rather than geometry.

Move

Orthogonal view: Moves your POV horizontally when you drag left or right and vertically when you drag up or 
down.
Keyboard shortcut: Alt

Perspective view: Moves your POV horizontally when you drag left or right and farther/closer when you drag up 
or down with the LMB . Moves your POV vertically when you drag up or down with the RMB.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  269

•

•

•

•

Keyboard shortcut: Shift + Alt 

Since you are changing your POV, the scene items will appear to move in the opposite direction of your mouse 
movements.

Rotate

Orthogonal views - not applicable.

Perspective view - Rotates your POV’s heading when you drag left or right and its pitch when you drag up or 
down with the LMB . Rotates your POV’s bank when you drag left or right with the RMB.
Keyboard shortcut: Alt 

Zoom

All views - Zooms in and out when you drag left and right. (You can also use the < and > keys.)
Keyboard shortcut: Ctrl + Alt or Alt+Scrollwheel

Fullscreen Toggle

The last icon in this group is a toggle to switch the associated viewport between fullscreen and back. 
Keyboard shortcut: Numpad 0

You can use the keyboard shortcut  G to center the area under the cursor.

Use the keyboard shortcut A to zoom the view out to where all items in the scene are visible.
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The Grid

It's grayed out here because Layout started fullscreen, as usual, and hasn't been put in a multiple viewport 
display yet so there's nothing to switch to.


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Viewport Options

The items on the Viewport Options menu are as follows. Not all are available at the same time.

Bone Weight Shade - shows the selected bone’s influence range in any shaded viewport. The influence coloring 
is based on each bone’s color, which can be changed in the Scene Editor. A bright yellow is used for the currently 
selected bone. Note that the bone must be active to see this effect. This mode will override the normal texture 
display.
Bone X-Ray - By default Bone X-Ray is on to show bones inside geometry. Note that bones may still be invisible if 
the object surface is similarly colored/shaded. Change the bone colors using the Scene Editor, if this becomes a 
problem. If you wish to switch off Bone X-Ray you can uncheck the item in the Viewport Options menu.

DOF/MBlur Preview - Only available in Camera view mode. Gives a preview of scene motion blur and Depth of 
Field. The number of passes can be set at the bottom of Display Options.
Headlight - Provides an OpenGL-only, nondirectional light to illuminate dark scenes for easier work.

Center Current Item - For an object, the centering is based on its pivot point. This is not always the center of an 
object. If you deactivate this mode, either through the menu or the viewport icon, the existing POV position will 
remain until changed. As such, you can use this feature to establish a starting point if the need arises.

Set View Position, Rotation, Zoom... - Opens a requester for setting the viewport numerically.
Reset View Position, Rotation, Zoom - Resets to the default values when opening Layout.
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Viewport Layout - Opens a sub-menu containing the 12 different view types. If a type with multiple viewports is 
chosen, each individual viewport will contain a viewport options menu. Choosing a different layout changes all 
the Layout viewports, not just the one in which you are choosing a new viewport layout. The layouts can also be 
chosen from the Options panel or by stepping through them with F3 and F4. 

Match Viewport Perspective - Only works in Camera or Light mode. Opens a sub-menu with four options:
Selected Camera
New Camera
Selected Light
New Light

Store View - Stores the current Layout viewport orientation. Only one viewport can be stored if in a multi-
viewport display. Stores the view in the scene file so the view will be available after a reload of the scene
Recall View - Retrieves the stored viewport orientation. This only works with the same viewport that was stored

OpenGL Wireframe - This and the OpenGL Overlay item below are only available when VPR is engaged. OpenGL 
Wireframe presents a wireframe over the rendered object.
OpenGL Overlay - This and the OpenGL Wireframe item below are only available when VPR is engaged. OpenGL 
Overlay presents a wireframe view of your scene elements, like lights, the grid and transform widgets, laid over 
the rendered view.
Show OpenGL UI - Shows or hides non-renderable interface elements.

When the viewport is showing VPR, two additional options become available:

Draft Mode - disabled by default, Draft mode applies a specific set of values
Mouse Refinement - On by default, this centers VPR refinement on the mouse position. This option can slow 
rendering slightly, if your scene is complex, try switching it off.
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The Grid

The Grid

A grid of squares, made up of an planar axis at 0,0,0, is visible in any of the orthogonal views, as well as the Perspective 
view. The grid serves as a visual reference when you move items around, but it will never render in a final image. The 
grid lines are darker every tenth square for visual reference. The Origin is located at the center of the grid.

 
You can find the current size of the grid squares in the information field at the very lower-left corner of the screen. The 
size of each grid square is adjustable as is its overall size on the Display Options Tab of the Preferences Panel (Edit > 
Display Options).

The Grid and Relative Camera/Light Sizes

The size of lights and cameras (that is, how they appear in the viewport) are relative to the size of the grid squares, with 
the exception of Area Lights and Linear Lights, which are independent of the grid square size. If you have very large grid 
squares, you will also have very large lights/camera compared to objects, and vice versa.

The Grid Square Size Effect on Positioning

The Grid Square Size (Display > Options: Display Options) also determines the incremental change as you drag your 
mouse. Thus, a smaller size lets you edit your object’s position with greater accuracy than using a larger one. If you find 
that you can’t edit an object with the accuracy required, try lowering the Grid Square Size. However, this will also affect 
the Orthogonal and Perspective view modes.

The size of the lights/cameras does not affect their functionality.
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Grid Square Size Auto-Adjustment

When you start creating a new scene, your Grid Square Size will automatically adjust itself upwards only, if necessary. 
This can be problematic when you use objects that differ significantly in relative size, like planets and spaceships. 
Objects may seem to disappear, when in reality they are just too small or too big to see in the viewport.

Once you manually set the Grid Square Size or save and reload a scene, the automatic sizing adjustment is deactivated. 
As such, you may want to load the smaller objects first and then manually change the Grid Square Size to the same 
value. Then, load the larger objects.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  275

•
•
•
•
•
•

•
•
•

Working with Items
Click here to expand Table of Contents...

Selecting Items
Manipulating Items
Item Properties
Scene Editor
Scene / Dope Editor
Instancing

Selecting Items

Manipulating Items

Item Properties
In LightWave there are four item types as shown at the bottom of the Layout interface - Objects, Bones, Lights, Cameras. 
They each have a dedicated Properties panel. The Bones Properties panel is a little more advanced, but you should 
familiarize yourself right away with:

Object Properties
Light Properties
Camera Properties

Scene Editor

Scene / Dope Editor

Instancing


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Selecting Items
Selecting Multiple Items
Selecting by Name
Deselecting Items
Item Selection: Bounding Box

There are several ways to select an item in Layout:

Click on the item in a viewport;
Click on the item’s name in the Scene Editor Panel (Scene Editor); or
Manually select the edit mode and then select the item from the Current Item pop-up menu. Note that you 
cannot select a locked item (a little lock icon appears next to name).
Use the Item Picker master plugin

You can select items in a viewport by clicking on any polygon edge rather than just on a pivot point.

You can use your Up and Down cursor keys to cycle through the Current Item list. All items, except objects, are 
highlighted in yellow when selected. When an object is selected, a dotted-yellow bounding box will appear around it.
You can select a bone by clicking near its midpoint, rather than its pivot point, making it possible to pick different bones 
that branch from the same point in a hierarchy.

Selecting Multiple Items

You can select multiple items of the same type, like all objects or all lights, and perform edits on them simultaneously.
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Holding the Shift (or Ctrl) key will allow you to select multiple items of the same type.

If the toolbar command is a state-type command and the selected items have mixed settings, the button will be shaded 
diagonally. Clicking the button will toggle the state of the current item and make all other selected items the same. 
Clicking again will toggle the state of all items.

Selecting by Name

Pressing the apostrophe ( ‘ ) key launches a special selector dialog. Simply type-in a few characters that uniquely 
identify the desired item and click OK. You can select any type of item.

Deselecting Items

In Layout, one item is always selected. It becomes deselected when you select a different object.

Item Selection: Bounding Box

A selection bounding box can be created by dragging your middle mouse button in any viewport.

Items whose points appear within the box will be selected, and if the Shift key is held down, the items will be added to 
the existing selected items, if they are the same type. If items of more than one type are within the box, preference is 
given to those items matching the current edit mode.

In addition to the viewports, this also works in other areas of the interface, such as the Graph Editor.

If your mouse has a scroll wheel, it should also function as a MMB when clicked.
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Manipulating Items
Moving
Rotating
Scaling
Readout

Moving

LightWave, like all other 3D packages, has handles to move, rotate and scale your items. Unlike most other 3D 
packages, you don't have to use them.

To move on the X and Z plane, you can click the left mouse button (LMB) anywhere in the viewport when an object is 
selected. When you hold down the LMB, the cursor is hidden to aid visibility of your scene.

To move in the Y-axis, use the right mouse button (RMB).
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Rotating

For rotation, a similar process. LMB is rotation on Heading and Pitch, RMB is rotation on Bank. If you wish your rotation 
to be on just the Heading or Pitch axis, it's still quickest to use the handles.

To move an object using local coordinates (in our case, the ship has been rotated on all axes), hold CTRL while 
dragging on the handles.


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Left: Using LMB to rotate on Heading and Pitch, Right: rotating on Bank using RMB

Scaling

Scaling can be either axis-independent or uniform. With uniform scaling, there is no handle, just the star of the pivot. As 
you might imagine, positioning the mouse anywhere in the scene and using the LMB or RMB has the same effect - your 
object is made bigger or smaller. With axis-independent, you will probably want to continue to use the handles for the 
accuracy they give. Again, LMB and RMB provide the same effect.
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Readout

In all cases, you can keep track of the changes you make at the lower left of the screen:

You can also lock off channels by clicking on the button highlighted in blue next to the channel. Doing so will limit 
changes to only the channels that are available. Equally, if you wish to be precise about changes, you can enter them 
numerically here. If you change the rotation order for an item in the Motion Options window, the order you choose 
shows in this corner readout.

New to 2018

Scale can have problems if an axis-independent scale operation has been performed on the object first. From 
2018, using Uniform Scaling with the RMB will keep proportions even if a non-uniform scale has occurred 
previously.


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Scene Editor
The Scene Editor (Scene Editor > Scene Editor) is the default choice for its speed of use, but there is also the new Scene / 
Dope Editor and NewTek suggests that you use the that over the standard. The Classic remains to help the transition for 
our customers who have a history with the Classic Scene Editor.

You can see a list of all of the items in your scene arranged hierarchically as well as all of the individual enveloped 
channels, perform global edits on keyframes, and change hierarchy. It also allows you to set the wireframe colors, 
change visibility modes, and even load a reference sound file.
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Basic Functions

The scene list is a standard LightWave list window. You can expand and collapse groups as well as subordinate items 
(e.g., child objects) by clicking the arrow icon that appears to the left of the item name.

The +/- sign icon will display or hide the individual channels for the item. Most of the time, these are the position, 
rotation, and scale channels; however, other enveloped channels can also be included, like light intensity.

The item type icon indicates the type of item and the color used when the item appears in wireframe. You can change 
this by right-clicking on the item name and selecting a color from the pop-up menu. When working with complex scenes 
with overlapping objects, it can be beneficial to use different colors for certain items in the scene.

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.


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Double-clicking an item’s name will bring up the related Properties Panel.

If you drag the right edge of the panel, you can shrink the size of the Scene Editor and hide the keys display. Use in this 
mode as a scene item picker!

The checkmark column activates or deactivates items. Deactivating an object is like setting its Object Dissolve (Object 
Properties) to 100%, and deactivating a light is like setting its Light Intensity (Light Properties) to 0%. For a bone, this 
toggles its Bone Active state (Bone Properties). This option has no effect on cameras.

The “eye” column is the visibility column. For objects, clicking on this icon will display a pop-up menu where you can 
select how the object is displayed. This can range from making the object hidden all the way up to showing it as a 
textured shaded solid.
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The Visibility setting can dramatically affect not only how an object is displayed, but also how fast the display is 
updated. Moving a 200,000-polygon 100-surface spacecraft around the screen using a textured display surely requires 
greater computing power than a wireframe six-sided bounding box. There are other reasons as well. Often, in a very 
complex scene, you may need to play with object visibility options in order to concentrate on certain aspects of the 
scene.

Most of the Visibility settings are self-explanatory. Front Face Wireframe will show only polygons that face the camera. 
The Textured Shaded Solid adds image-mapped surface textures.

For lights, cameras, and bones, you can make them visible or hidden by clicking in the visibility column.

You can override the Visibility setting to a certain extent by using the viewport’s Maximum Render Level pop-
up menu located on the top left edge of a viewport.
The Color and Visibility options affect only the appearance of items in the Layout view. They do not affect the 
final rendered image.


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Clicking in the “lock” column will toggle the locking function on for that item. Locked items cannot be selected in the 
viewports. The lock icon will also appear on the Current Item pop-up menu (on the main interface) next to the item’s 
name.

Pop-up Menu

When you right-click an item, it displays a pop-up menu. This menu can set the item’s wireframe color, clear the item, 
clone the item, rename the item, and open its Properties or Motion Panels.
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Keyframes

The colored bars to the right indicate the length of the keyframed channel. The bar starts at its first keyframe and ends 
at the last one. (Note that the ends may be past the end of the visible display area.) The plus signs indicate keyframes.

The line with the item’s name is the master channel and will show a composite of all of the keyframes in any of the 
underlying channels.

Adjusting Channels

You can move individual keyframes by dragging them with your mouse. The affected key is highlighted when you 
initially click on it. Dragging on the bar, off any key, will move the entire bar forward or backward in time.
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Key becomes highlighted as you drag one key

Move all keys for channel by dragging bar

There are square handles at the beginning and end of every bar. You can drag these to scale all of the keys in the bar.

Adjusting Hierarchy

You can drag item names up and down to change the order and hierarchy (i.e., parent/child relationships). As you drag, 
a yellow insert line will appear. You insert the item by releasing your mouse button at the line’s position. The line will 
cycle between different lengths as you drag; the different lengths indicate different levels of hierarchy. The relative 
length indicates the level the line becomes when you release the mouse button.

You can also drag keys on the master channel, which will affect only the appropriate underlying channels.

For more precise adjustments, use the Shift Keys and/or Scale Keys functions.
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Effects of Selections

You can select a contiguous range of (same type) items by holding the Shift key down as you select. Hold the Ctrl key 
down to select/unselect non-contiguous items.

You can then drag the entire selected range of items to a new hierarchical position. Most of the editing functions can be 
limited to selected items only. These items will also be highlighted in the viewports.

Adding Audio

You can sync your animation to sound: from the Audio pop-up menu, load a reference audio file (WAV format) that you 
can hear when you play the scene. A simple waveform is shown behind the time slider on the main interface. You can 

An item inserted between a parent and child will always become another child.
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scrub though the audio by dragging the timeline slider or preview the audio by selecting Play Audio. Use the Clear Audio 
option to clear the audio from the scene.

The Fixed Frequency option keeps the audio from changing pitch when you scrub the frame slider.

You can delay the start time of a loaded audio file by selecting Audio Start Time from the Audio pop-up menu. The value 
you enter into the dialog is the delay amount in seconds (e.g., if Frames Per Second, on the General Options Tab of the 
Preferences Panel, is set at 30, entering 1.0 starts your audio at frame 30).

Classic Scene Editor Buttons

Use the Favorites pop-up menu to create (or delete) selection sets for items that you want to access quickly. For 
example, if you always move the same five lights, you could multi-select them and make a favorite. Then, the next time 
you want to move them, you just select the favorites set you created and all five lights are selected automatically.

The Select pop-up menu lets you quickly select all items based on their type. To unselect a group of items, just click on 
any item. (One item is always selected.)

The Visibility pop-up menu will show/hide selected or all items.

The Colors pop-up menu will apply the selected color to all of the selected items. You can also set the default colors and 
apply them to the scene.

The Channels pop-up menu will expand/collapse selected or all items.

With Shift Keys you can Shift keyframes for all or just selected items forward or backward in time. The Low Frame and 
High Frame values set the range of frames to be affected. This function lets you fine-tune the animation without making 
individual changes for each item in the scene (a potentially tedious task). Enter a negative Shift Frames by value to shift 
backwards in time.

Some operations can affect frames outside the specified range. For example, shifting a range of frames in the middle of 
a motion path will cause keyframes after the range to shift so they are not overlapped by the newly shifted keyframes.

With Scale Keys you can extend or shorten either the duration of all or just selected items. The Low Frame and High 
Frame values set the range of frames to be affected. The result is that events occur either more slowly or more quickly, 
as they have been scaled to take place over a longer or shorter period of time. Scale Keys enables you to fine-tune the 
animation, allowing certain events or the entire animation to take place within a specified time frame so that you do 
not need to alter specific keyframes manually. The Scale Time by value represents the scaling factor with 1 being equal 
to 100 percent.
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Time-related elements of the scene other than motions and envelopes will not change with the use of either 
Shift Keys or Scale Keys. Therefore, image sequence loop lengths and texture motion will not be affected.


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Scene / Dope Editor
Click here to expand Table of Contents...

Introduction
Workspace
Scene Editor Options

General Options
Items Options
Properties Options
Dope Sheet Options
Scene Editor Audio Options
Scene Editor

Introduction

(default keyboard shortcut Ctrl F1)

The Scene Editor gives you the “big picture” of your scene. The Scene Editor is a data viewing and editing hub for many 
of the properties with Layout that pertain to items and surfaces. It does not intend to encompass all properties in 
Layout nor act as a complete replacement for those that it does support. But, it does intend to offer ease and speed 
when modifying data about multiple items or multiple surfaces. It also intends to allow users to have chosen data 
appear simultaneously within a single panel instead of having to jump around from panel to panel to make changes.

Not only are properties about items and surfaces presented, but also any channel data that is attached to these item 
types. “Items” refers to Layout Items that may consist of Objects, Bones, Cameras, or Lights. Surfaces refer to surfaces 
currently loaded within Layout. Since surfaces are always attached to Object Items, an object item must exist in Layout 
before a surface can exist.

The New Scene Editor is a user configurable scene overview tool. It is used to see everything that exists in a given scene, 
and can be used to edit most attributes of any item or groups of items in the scene, all from a single location. Multiple 
instances of it may be opened at any time, and each can be configured independently of the others. This would allow 
you to configure one Scene Editor specifically for settings that relate to a character in a scene, while another can be set 
up with options relating to the environment. A third may also be added that configured specifically to control lighting, 


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etc. Each Scene Editor stores its own set of configurations, so they’re “remembered” each time that particular scene is 
reloaded. Different configurations can be saved for different scenes. You have full control over how these can be set up.

Since all instances of the Scene Editor are displaying the same scene information, changes made in one will 
automatically be updated in all other instances, so all Scene Editors are displaying the current state of all the scene 
properties at all times.

To launch the new Scene Editor, click on the Scene Editor drop down menu and choose “New Instance”. You also have 
the option of choosing the Classic Scene Editor as well as multiple instances.

You can have multiple instances of the new Scene Editor open at once to allow multiple views of scene items. 
Shutting these windows does not remove the Scene Editors from the scene, merely closes their windows 
temporarily. If you wish to definitively shut down one or more Scene Editors, open the Master Plugins window (C
trl-Q), choose the Scene Editor instance you wish to close, hit the RMB and choose Remove.


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The Scene Editor has five main sections to it, each with a specific purpose. These areas are the Item List, Spread Sheet 
Property Panel, Dope Sheet Panel, Scene Playback Controls, and the Scene Editor Options.

Scene / Dope Editor - Item List
Scene / Dope Editor - Properties
Scene / Dope Editor - Dope Sheet
Scene / Dope Editor - Playback Controls

Workspace

A workspace is a collection of user specific settings that can be stored and recalled quickly. Settings include: panel 
width and height and location, view dimensions within the panel, Item view selection, filter options, display options, 
Property view bank and custom bank choices, dope sheet settings, etc. These Workspace settings are stored on a per 
user basis. A user-specific configuration file is used. The initial workspace data to use is built-in as a default workspace.
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The menu presented will show the existing workspaces available as well as options to save one, reset it, and remove 
one. Selecting a named workspace will transfer its settings to the current Workspace settings. Changes to the current 
workspace do not affect any stored workspaces unless that workspace is overwritten via the ‘Save current as…’ option.

Save current as… - Allows user to pick a name for the workspace. Using an existing workspace name will 
overwrite that workspace; otherwise, a new storage workspace is created.

Reset workspace - The current Workspace settings (not any of the storage Workspace settings) are reset to their 
built-in values.
Remove workspace… - A pop-up menu displays the existing workspaces, which can be removed. Choosing one 
results in losing that stored workspace; this has no affect on the settings of the current workspace.

Scene Editor Options

The Scene Editor options are categorized via the part of the GUI they affect: General, Items, Properties, and Dope Sheet. 
A separate panel is used to adjust these options, which are stored as part of the current workspace.
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General Options

Background color (odd rows) - click to change color of odd numbered rows.
Background color (even rows) - click to change color of even numbered rows.
Hierarchy indent (pixels) - (unsigned short) set to number of pixels used as a gap for each additional child depth 
when displaying hierarchical data like layout items.
Highlight color (RGB) - color of background for highlighted items.

Items Options

Default Object Color (RGB) - new objects are created in this color
Default Bone Color (RGB) - new bones are created in this color
Default Light Color (RGB) - new lights are created in this color
Default Camera Color (RGB) - new cameras are created in this color
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Auto-apply selection to viewports - This will select items in viewports as they are selected in the Scene Editor

Always highlight view port selection - Will highlight the scene editor selection with item chosen in 
the viewport. Will not open up hierarchies in which the item chosen may reside

Always show full view port selection - Will highlight items chosen in the viewport without overriding 
Scene Editor selection

Properties Options

Multiselect cells must have matching units - This is useful when selecting multiple channels and properties. 
When enabled, only those cells that share the same ‘storage’ units (e.g. length, angle, percentage) will be 
selectable. It may be useful to turn this off when you would like to select position, rotation, and/or scaling values 
simultaneously.
Limit color component values to 255 - When enabled, color values are limited to the 0-255 range. Some 
properties do interpret and benefit from color component values outside this range. (Light intensity for 
example)
View and edit color as HSV - This uses the Hue, Saturation, Value approach to displaying and editing colors 
within a cell.
Show cell selection order - When enabled, each cell will contain a small numeric indicator of what order that cell 
was selected. This can be useful when applying values that depend on the sequence of how the cells were 
selected in a multi-cell selection.
Open graph editor via ‘E’ button: (Boolean) - Normally, pressing on a cell’s ‘E’ button will add an envelope and 
then open that envelope (channel) in the Graph Editor. When this option is disabled, the Graph Editor will not be 
altered from its current state. When working with many cells at once, it may become cumbersome to have the 
Graph Editor open up when you only wanted to add the envelope.
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Dope Sheet Options

Show render first/last frame markers - When enabled, the gadgets for the Render Start Frame and Render Stop 
Frame are presented and can be moved with the mouse by clicking on them with the left mouse button.
Show Key ticks - This will allow the precise location of a key in time to be displayed.
Allow Group Selection - determines if groups of channels can be selected and manipulated when collapsed. If 
disabled, only channels can be manipulated and never groups of channels. If enabled, a group of channels can 
be manipulated by simply manipulating the group blocks (as long as the group item is not expanded). When 
expanded, only the desired channels will be manipulated even if the parent group is also highlighted.
Block period based on FPS value - Uses the current frames per second value in layout to determine the block 
period (or amount of time a block represents). When disabled, you can specify the custom time amount that a 
block should represent.

For example, an animation may be intended for 30FPS rendering, while the creation of the animation may 
depend on a music rhythm based on a tempo of 96. So, you could set the block period so that each block 
represents a 1/4 note or 1/8 note.
Block period - This is how much time each block in a dope sheet should represent. Normally this is one frame but 
may be larger or even fractions of a frame. This is currently measured in seconds per block and defaults to 
1/30th s/block.
Block width min. - This is the minimum pixel width that a block (that contains key frame data) should be.
Block width max. - This is the maximum pixel width that a block (that does not contain key frame data) should 
be.
Override block colors - This setting will use the Key block color and Group block color instead of the default 
block colors.
Key block color - Choose a color for blocks that represent a single data channel that contains one or more keys.
Group block color - Choose a color for blocks that represent multiple data channels in which at least one of the 
data channels contains one or more keys.

Scene Editor Audio Options

A Menu button is located at the bottom of the panel that controls some basic audio support features available in 
Layout.
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Play Audio - This will play a loaded audio waveform from start to finish.
Load Audio… - presents a file requester to get an audio file to be loaded. The audio waveform is loaded and can 
be seen in the main Layout window within the timeline. Not much detail about it is available however.
Audio Start Time… - This requests the scene time when the audio should start.
Audio Scrubbing -When checked, the loaded audio will play whenever the timeline is scrubbed. If it is 
unchecked, no audio will play. The loaded audio file will record with previews.
Fixed Frequency - This is a toggle option. When enabled, the audio will play at its intended sampled rate. If time 
scrubbing does not maintain real time playback rates, then gaps or skips in the audio may occur. When disabled, 
the pitch of the audio will vary as a result of the playback sample rate changing to accommodate the actual time 
scrubbing rate.
Clear Audio - clears out any audio currently loaded.

Scene Editor
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Scene / Dope Editor - Item List

Click here to expand Table of Contents...
Introduction
Items Tab

Display/Hide Channels
Expand/Collapse Groups
New Panel Hierarchies

Hierarchy Mode
Re-Parenting
Re-ordering
Adjusting Hierarchy
Item List Right Click Menu
Item Searching

Filter
Filter Option Panel: Items Tab
Filter Option Panel: Channels Tab

Scene Editor Selection Sets
Surface List View: Surfaces Tab

Surface List Display
Surface List Right Click Menu

Filter Option Panel: Surfaces Tab
Surface Filter Options Panel: Surfaces Tab
Surface Filter Options Panel: Channels Tab

Channels List View: Channels Tab

Introduction

The Item List allows selection of various ‘items’ to work with. These include Objects, Lights, Cameras, Bones, Channels, 
Channel Groups, and Surfaces. Because of the similarities between Objects, Lights, Cameras, and Bones, they have been 
grouped together to form the Item List view. Surfaces have widely different characteristics and form the Surface List 
view. Each of these may contain Channels and Channel Groups and these channels and channel groups form the 
Channel List.
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Items Tab

This view is used to view Objects, Lights, Cameras, Bones, and their associated channels, for modification within the 
Property and Dope Sheet views. It also allows manipulation of item hierarchies, names, existence, colors, lock states, 
selection status, channel selection, and more. The item view consists of an item list with each row representing a single 
item. Four columns extend throughout the list. These are Active, Visibility, Locked, and Name.

1 - Active, 2 - Visibility, 3 - Lock State, 4 - Channels
The Active column activates or deactivates items. Deactivating an object is like setting its Object Dissolve (Object 
Properties) to 100%, and deactivating a light is like setting its Light Intensity (Light Properties) to 0%. For a bone, this 
toggles its Bone Active state (Bone Properties).

The Visibility (eye) column determines how the item will be displayed. For objects, clicking on this icon will display a 
pop-up menu where you can select how the object is displayed. This can range from making the object hidden all the 
way up to showing it as a textured shaded solid. For Objects, the choices are Hidden, Bounding Box, Vertices, 
Wireframe, Front Face Wireframe, Shaded Solid, Textured Solid and Textured w/Wireframe. For Lights, Cameras, and 
Bones there is only an on/off state for visibility.

 

This only applies to Lights, Cameras, Objects, and Bones, not Channels, or Channel Groups.

You can override the Visibility setting to a certain extent by using the viewport’s Maximum Render Level pop-
up menu located on the top left edge of a viewport. The Color and Visibility options affect only the appearance 
of items in the Layout view. They do not affect the final rendered image.


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Clicking in the Lock State column will toggle the locking function on for that item. Locked items cannot be selected in 
the viewports. However, not all methods for manipulating items obey this flag.

The lock icon will also appear on the Current Item pop-up menu (on the main interface) next to the item’s name.

The Name column has more options than the other columns. It shows the item name, the type of item, item color. It 
also allows context menu options, hierarchy management, visibility (showing/hiding) of the hierarchy structure, 
channel visibility, shows and edits Layout item selection, and shows row selection.

Display/Hide Channels

The plus/minus sign icon will display or hide the individual channels for the item. Most of the time, these are the 
position, rotation, and scale channels; however, other enveloped channels can also be included, like light intensity.

Expand/Collapse Groups

The scene list is a standard LightWave list window. You can expand and collapse groups as well as subordinate items 
(e.g., child objects) by clicking the arrow icon that appears to the left of the item name.
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Item Type and Color
The item type icon indicates the type of item and the color used when the item appears in wireframe. You can change 
the color by clicking on the item and selecting a color from the pop-up menu. When working with complex scenes with 
overlapping objects, it can be beneficial to use different colors for certain items in the scene. Note also that objects are 
represented by cubes in this column, lights by light icons, cameras by camera icons and null objects by crosses.

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.


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Item Name
Simply displays the name of the item. Repeated clicks on this bar will change ordering and hierarchical levels.

Item Sorting
Clicking on each column heading can alter the order in which items in the item list are displayed. The columns are: 
Active, Visibility, Locked, and Name.

Clicking on the Active column will sort based on the active state of the item. Sorting toggles between increasing and 
decreasing active state. The Visibility and Locked columns sort the same way.

The Name column uses alphabetical sorting and applies to item names and channel names. However, lights and 
cameras are always separated from objects. Therefore, within each hierarchy level, all bones are presented before 
objects, which are presented before lights, which are presented before cameras. Channel hierarchies are always 
presented just below the item that owns them. Bone hierarchies are also always presented below the objects that own 
them and always after the object’s channel hierarchies.

There are really two hierarchies present here: one for items, and one for channels. They are managed separately and 
then incorporated into the final item list view. Item sorting may also support the ‘natural’ and ‘reverse natural’ order. 
This sorts an item’s ItemID.

The Active, Visibility, and Locked columns are always displayed on the left of the Name column so that they do not keep 
shifting position as the Scene Editor Panel resizes or the item view resizes.

The column heading of the Active column is an icon that looks like an ‘A’. If this column is used for sorting, an up or 
down arrow is displayed next to the column heading when increasing or decreasing sorting is used, respectively. When 
this column is not used for sorting, no such arrow appears.
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The column heading of the Visibility column is an icon that looks like an eye. If this column is used for sorting, an up or 
down arrow is displayed next to the column heading when increasing or decreasing sorting is used, respectively. When 
this column is not used for sorting, no such arrow appears.

The column heading of the Locked column is an icon that looks like a pad lock. If this column is used for sorting, an up 
or down arrow is displayed next to the column heading when increasing or decreasing sorting is used, respectively. Not 
locked is lower than locked.

The column heading of the Name column is the word ‘Name’. If this column is used for sorting, an up or down arrow is 
displayed next to the column heading when increasing or decreasing sorting is used, respectively. When this column is 
not used for sorting, no such arrow appears. In addition, the use of ‘natural’ sorting is supported, and is indicated with 
an arrow that also has a sort indicator of ‘ID’.

Active Item Indicator
When an item is selected (active) in Layout a check mark will appear to the right of the item’s name.

Hide Unselected Toggle
This option allows you to hide any item that is not selected in the Scene Editor list. Clicking the button again will unhide 
all items. This can be very handy when working on complex scenes that contain many items.

Hierarchy Mode

At the top of the item list view is the Hierarchy Mode button that toggles the display of items hierarchically. When 
enabled, the items parenting information will be used to indent child items to the right of their parents. In addition, the 
ability exists to manipulate the parenting information via the mouse within the item list.

This doesn’t affect the visibility in the viewport, it only affects the visibility in the item list.
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Ctrl-clicking on an arrow in the Scene Editor will unfold the complete hierarchy, then Alt-clicking on an item name will 
highlight it and its children recursively.

There are some rules that govern the hierarchical relationships:

Object Item - Can be child of Object Item, Light Item, Camera Item, (none)
Bone Item - Can be child of Bone Item, Object Item.
Light Item - Can be child of Object Item, Light Item, Camera Item, (none)
Camera Item - Can be child of Object Item, Light Item, Camera Item, (none)
Channel - Can be child of Object Item, Bone Item, Light Item, Camera Item, Channel Group
Channel Group - Can be child of Object Item, Bone Item, Light Item, Camera Item, Channel Group
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Re-Parenting

Once some items are highlighted, use the mouse to drag and drop them onto an existing object, bone, light, or camera 
item to change the parent of the highlighted items. The mouse ‘drop’ point can also be below the desired parent item at 
the same indentation level of that parent. Visual markers appear in both cases. The visual aids are brightest when all the 
highlighted items are appropriate for the reparent operation and darkest when none are appropriate. As an example, 
trying to reparent a bone from it’s owner object to another object is an inappropriate reparent operation. Reparenting 
can only be performed when the item view is in ‘hierarchy display mode’.

The above animation shows parenting the highlighted items to the PiranhaAlien body and then unparenting them.

Re-ordering

It is possible to change the internal storage sequence of lights, cameras, objects, and bones when a ‘Sequence’ sort 
modes is active. The sort modes are changed by mouse clicking on the item view’s item column. The mouse is used to 
drag and drop a highlighted selection between existing items. It is important to note that the sequence is implicitly 
defined as: all objects (for each object, all bones in that object) followed by all lights followed by all cameras. As such, it 
is not possible to reposition an object between two lights, for example. The horizontal mouse position is important in 
determining where to actually reorder items. A visual aid shows the desired insertion point, even if that insertion point 
is not valid for the highlighted items.
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The above image shows inserting the highlighted items between ‘Null (1)’ and ‘Null (4)’
Of important note is that the instance part of the name (the “(2)” in “Null (2)” for example) can change when saving and 
reloading the scene. This is because the instance value assignment is based on the item sequence at during certain item 
updates internal to Layout. Instance identification is not part of a scene reference to an item. To best ensure item name 
display consistency, each item name should be unique.

Adjusting Hierarchy

You can drag item names up and down to change the order and hierarchy (i.e., parent/child relationships). As you drag, 
a light green insert line will appear. You insert the item by releasing your mouse button at the line’s position. The line 
will cycle between different lengths as you drag; the different lengths indicate different levels of hierarchy. The relative 
length indicates the level the line becomes when you release the mouse button.

Holding down the LMB until the bar turns green shows that you are ready to adjust hierarchy. Here we changed the 
hierarchy of PiranhaAlien elements, finally unparenting all but the lower teeth and eyes.
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Item List Right Click Menu

Context menu options are available by RMB-clicking in the item view rows. The row context may change depending on 
what type of item is in that row. When combining the contexts of multiple highlighted rows, only the options available 
to all highlighted items will be available.

•
•
•
•

•
•
•

General Rules

Channels cannot be rearranged in either their hierarchy or top-down sequence.
When moving an item, it must not be an ancestor to any new parent.
An item cannot be moved to be a child of an item that it can have as a parent.
If multiple items are selected for rearrangement, the selected parents of any selected children will be 
used for rearrangement. The selected children will not be rearranged directly, but will follow their 
parent automatically.
Only the parenting/owner structure may be modified when any sort order display is used.
Sorting applies to each level of hierarchy individually.
Any child of a filtered item will also be filtered.


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Selection:
Select in viewports - applies current selection to Layout item selection.
Select all - This selects all displayed items (after filtering).
Select none - This unselects all displayed items.
Invert selection - This will make all (displayed) items switch their selection state.
Select channels - selects the displayed channels of selected items.
Unselect channels - unselects all channels belonging to currently selected items.
Select child items - selects the displayed child of the currently selected items.
Select child items (recursive) - select all displayed children of currently selected items as well as their 
descendants.
Unselect child items - unselects all displayed children of currently selected items.
Unselect child items (recursive) - unselects all displayed children of currently selected items. This differs from a 
non-recursive form by affecting the expand state of deeper child levels as well as the selected items.
Select similar - selects all displayed items that have a similar item type and name as the item right-clicked on.
Highlight view port selection - all items selected in the viewport will become selected in the Scene Editor.

Hierarchy:
Expand channels - This will show all channels for the selected items.
Expand channels (recursive) - this will progressively un-nest channel hierarchies.
Collapse channels - This will hide all channels for the selected items.
Expand child items - This will make the children for all selected items visible.
Expand child items (recursive) - This will make all descendants of the selected item as well as their descendants 
visible.
Collapse child items - This will hide the children of all selected items.
Collapse child items (recursive) - This will collapse all descendants of the selected items. This differs from a non-
recursive form by affecting the expand state of deeper child levels as well as the selected items.

Manipulate:
Motion property panel - opens the Motion Options Panel for the selected item.
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Item property panel - opens the Properties Panel for the selected item.
Edit Channels - opens the Graph Editor Panel with all the channels of the selected items ready to be edited.
Rename - Triggers a dialogue box to rename a single item. Renaming of multiple items at once is not supported.
Rename Layer - Rather than renaming the object’s root name you can choose just to rename individual layers. 
Renaming of multiple layers at once is not supported.

Add:
Add null object :- Activates the Null Object Name panel and adds a new null.
Add object :- Activates the Load Object panel.
Add object layer :- Activates the Load Object Layer panel.
Add (root|child) bone : adds a single bone to either an object item or as a child to an existing bone item. The 
context determines which.
Add camera :- allows adding a single camera to the scene.
Add area light :- Opens the Light Name panel and adds an ‘area’ type light to the scene.
Add distant light :- Opens the Light Name panel and adds a ‘distant’ type light to the scene.
Add dome light :- Opens the Light Name panel and adds a ‘dome’ type light to the scene.
Add linear light :- Opens the Light Name panel and adds a ‘linear’ type light to the scene.
Add photometric light :- Opens the Light Name panel and adds a ‘photometric’ type light to the scene.
Add point light :- Opens the Light Name panel and adds a ‘point’ type light to the scene.
Add spherical light :- Opens the Light Name panel and adds a ‘spherical’ type light to the scene.
Add spotlight :- Activates the Light Name panel and adds a ‘spotlight’ type light to the scene.
Clone :- allows cloning of any item or selection of items.
Clone hierarchy - clone a parent item with its children.

Clear:
Remove/Clear :- Removes the selected items from the scene.
Clear all objects :- Removes all objects from the scene.
Clear all lights :- Removes all lights from the scene.
Clear all cameras :- Removes all cameras from the scene.
Clear all bones :- Removes all bones from the scene.

Item Searching

The Find tool at the top of the item view list is an option to perform item name and channel name searches. Enter a 
simple search string (the case does not matter), press the Enter or Return key, and the search begins.

If a match is found, the item cursor is placed there and any list scrolling or item expanding necessary to view the 
matched item will be performed as well. It may also be useful to have the perspective camera (or a special camera) 
change to view that item.

That may be accomplished indirectly by selecting the found item while the object centring feature is enabled in layout, 
which puts the selected item into the perspective camera’s view. The search iterates through each list item (regardless 
of what type it is) starting with the current item list cursor location, progressing to the list end, wrapping around to the 
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list beginning, and winding up at the iteration starting point. The iteration is aborted once a string match is found. 
Filtered-out items do not get searched. If the search string used has more than one instance, all instances are selected.

Filter

At the top of item view is a Filter option drop down button. These options allow the ‘weeding out’ of unwanted items 
and channels.

The drop down menu has the following options:

Options… - This brings up a separate, but modeless, Options Panel used for selecting the filtering criteria for 
both items and channels. With the Options Panel previously used filtering criteria can be recalled easily as well. 
Making changes to the criteria can be viewed in the item list as the criteria changes.
Enable/Disable Item Filter (Boolean) - Toggle to affect if item filtering is used on Object, Light, Camera, and Bone 
items.
Enable/Disable Channel Filter (Boolean) - Toggle to affect if channel filtering is used on Channel items.

The Options Panel has a section for item criteria and a section for channel criteria. Checkboxes that enable/disable the 
filtering are duplicated here so that the dropdown toggles may be used in addition to these.

Filter Option Panel: Items Tab

For Items criteria, the following controls exist:

Enable Item Filtering (Boolean) - Toggle to affect if item filtering is used on Object, Light, Camera, and Bone 
items.
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Stored filters dropdown - choose any stored filter. Once selected, it is loaded. You only need save filter settings 
you wish to use over and over again.
Remove - this will remove the filter that is currently selected, if one exists.
Save - this will overwrite the current filter choice with the current settings. If no filter is currently selected, this 
button acts as a ‘ Save As… ’ button.
Save As… - click to save the current filter criteria to a filter name. The filter name is requested after clicking this 
button.
Contains - This determines how to use the item name string. Choices include: contains, equals, starts with, ends 
with, does not contain, does not equal, does not start with, does not end with.

Item name string field - Any string can be entered to be used to match against all Layout items (not just those 
currently in the item list).
Ignore Case - enable and disable case sensitive compares.
Include Object Items - enable to allow object items
Include Bones Items - enable to allow bone items
Include Lights Items - enable to allow light items
Include Camera Items - enable to allow camera items
Include Locked Items - enable to allow locked items
Include Unlocked Items - enable to allow unlocked items
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Filter Option Panel: Channels Tab

For channel criteria, the following controls exist:

Enable Channel Filtering (Boolean) - Toggle to affect if channel filtering is used on Channel items.
Stored filters dropdown - choose any stored filter. Once selected, it is loaded. You only need Save Filter settings 
you wish to use over and over again.
Remove - this will remove the filter that is currently selected, if one exists.
Save - this will overwrite the current filter choice with the current settings. If no filter is currently selected, this 
button acts as a ‘Save As…’ button.
Save As… - click to save the current filter criteria to a filter name. The filter name is requested after clicking this 
button.
Channel name string field - Any string can be entered to be used to match against all channels (allowed)
Contains - This determines how to use the channel name string. Choices include: contains, equals, starts with, 
ends with, does not contain, does not equal, does not start with, and does not end with.
Ignore case - This is used to enable case insensitive compares.
Include Position Channels - enable to allow position channels, which include ‘Position.X’, ‘Position.Y’, and 
‘Position.Z’
Include Rotation Channels - enable to allow orientation channels, which include ‘Rotation.H’, ‘Rotation.P’, 
‘Rotation.B’.
Include Scale Channels - enable to allow scaling channels, which include ‘Scale.X’, ‘Scale.Y’, ‘Scale.Z’.
Include Other Channels - enable to include any channels that are not the standard position, rotation, or scaling 
channels

Scene Editor Selection Sets
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The currently selected items, which may include objects, lights, cameras, bones, channels, and groups of channels, can 
be remembered for later use via a Selection Set. This simply allows the current selection to be saved and later recalled. 
Selecting Save Selection will bring up the Specify Selection Set Name Panel.

Once a name has been entered, click OK and the selection set will be added to the Sets drop down menu. Select the set 
name from the list when you would like to recall that selection. Select Remove Set to delete a selection set from the list.

Surface List View: Surfaces Tab

This view displays the names and ownership of surfaces currently loaded in Layout. Surfaces always belong to objects. 
Some of the same behaviours that apply to the Item List View will also apply here.

Surface List Display

Surfaces may be displayed ‘By object’ or ‘By surface’. Display By Object groups all surfaces belonging to a single object 
as children of that object. Display By Surface groups all objects that contain a surface with the exact same name as 
children of the surface.
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Either way, highlighting a surface will also select that surface in the Surface Editor window. The method of display is 
indicated within the column heading of the list as either ‘(By Object)’ or ‘(By Surface)’.

Surface items may also contain channels and groups of channels. For such surfaces, a channel expand icon will appear 
in that row and will operate as it does in the Item List View.

There is only one column in this list, the Name column. This column is sorted alphabetically by name, but can be 
reverse sorted as well by clicking on the column heading. A horizontal scroll bar located at the list bottom 
accommodates rows that are too wide to be fully seen.

Surface List Right Click Menu

RMB-click on a surface row presents context menu options.
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The options are the same as for:

Selection
Select all - This selects all displayed surfaces (after filtering).
Select none - This unselects all displayed surfaces.
Invert selection - This will make all (displayed) surfaces switch their selection state.
Select channels - selects the displayed channels of selected items.
Unselect channels - unselects all channels belonging to currently selected items.
Select children - selects all displayed children of currently selected surface groups.
Unselect children - unselects all displayed children of currently selected surface groups.
Select similar - selects all displayed surfaces that have a similar name as the item right-clicked on.

Hierarchy
Expand channels - This will show all channels for the selected surfaces.
Collapse channels - This will hide all channels for the selected surfaces.
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Expand items - This will make the children for all selected surfaces visible.
Collapse items - This will hide the children of all selected surfaces.

Manipulation
Surface property panel - opens the Surface Editor.
Edit in graph editor - opens the Graph Editor Panel with all the channels of the selected surfaces ready to be 
edited.

Filter Option Panel: Surfaces Tab

Surfaces and channels can be filtered much like they can for the Item List View. It is a way to prevent certain surface 
items from appearing in the list. The surface filtering is available via a drop down menu button at the top of the list:

Options… - opens a panel used to select surface item and surface channel filtering options. With the Options 
Panel previously used, filtering criteria can be recalled easily as well. Making changes to the criteria can be 
viewed in the item list as the criteria changes.
Enable/Disable Surfaces Filter - Toggles filtering of surface items
Enable/Disable Channels Filter - Toggles filtering of surface channels

The Options Panel has a section for surface criteria and a section for channel criteria. Checkboxes that enable/disable 
the filtering are duplicated here so that the dropdown toggles may be used in addition to these.

Surface Filter Options Panel: Surfaces Tab

For Surface criteria, the following controls exist:

Enable Surfaces Filtering - Toggles filtering of surface items.
Stored filters dropdown - choose any stored filter. Once selected, it is loaded.
Save - this will overwrite the current filter choice with the current settings. If no filter is currently selected, this 
button acts as a ‘Save As…’ button.
Save As - click to save the current filter criteria to a filter name. The filter name is requested after clicking this 
button.
Remove current filter button - click to remove the currently selected filter button. A confirmation requester is 
presented first.
Contains - This determines how to use the string. Choices include: contains, equals, starts with, ends with, does 
not contain, does not equal, does not start with, does not end with.
Name String Field - Any string can be entered to be used to match against all Layout surfaces (not just those 
currently in the item list).
Ignore Case - This is used to enable case insensitive compares.
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Surface Filter Options Panel: Channels Tab

For channel criteria, the following controls exist:

Enable Channels Filter - Toggles filtering of surface channels.
Stored filters dropdown - choose any stored filter. Once selected, it is loaded.
Save - this will overwrite the current filter choice with the current settings. If no filter is currently selected, this 
button acts as a ‘Save As…’ button.
Save As - click to save the current filter criteria to a filter name. The filter name is requested after clicking this 
button.
Remove current filter button - click to remove the currently selected filter button. A confirmation requester is 
presented first.
Channel name string field - Any string can be entered to be used to match against all channels (allowed).
Contains - This determines how to use the channel name string. Choices include: contains, equals, starts with, 
ends with, does not contain, does not equal, does not start with, does not end with.
Ignore Case - This is used to enable case insensitive compares.

Channels List View: Channels Tab

This view displays the names and ownership of channels used through the entire scene. This can include channels that 
are not normally visible by other means.

The operation of this list is similar to that of the other list views. See Item List and Surface List View 
documentation above for more info.


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Scene / Dope Editor - Properties

Click here to expand Table of Contents...
Spread Sheet Property Panel
Property Panel Banks
Bank Options Menu
Sizing Banks
Adding and Removing Banks
Property Panel Columns
Column Options Menu
Sizing Columns
Property Panel Cells
Cell Types
Unique Cell Type Adjust Properties:
Cell Options Menu
Selection Zone
Selection Zone Right Click Menu

Spread Sheet Property Panel

Often you want to edit certain properties of an item, and luckily, changing the values and properties of items is simple 
in Layout. But what if you need to change the properties for 20 objects? The Property Panel organizes these properties 
and lets you edit a wide range of values quickly and easily.

The Spread Sheet Property Panel consists of two sections, The Bank section and the Column section.


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Property Panel Banks

A collection of columns is called a Bank; and each bank can hold any number of columns. Some predefined banks exist 
that help to organize the vast multitude of properties available. Custom banks, which allow you to define which 
columns make up the bank, are also supported.

LightWave ships with a large collection of Bank Presets listed below:

  

  



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  323

  

  

 



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  324

•

•

•

Bank Options Menu

Right clicking on the Bank drop down menu will bring up the Bank Options Menu.

Add current cell selection to this bank’s cells - This will use any selected cell position and apply it to the other 
columns in that bank for that same row. Only cells of matching type as already selected cells will be selected.

Transfer current cell selection to this bank’s cells - this works like the ‘add current cell...’ except that transfer, 
clears out the current selection, so that the first type of cell encountered in the bank will be used.

Apply item selection to this bank’s cells - This looks at highlighted items on the left side and tries to select cells in 
the same rows as those items in all the columns of the bank.

However, only columns that are of similar types can have cells selected. For example, a check box type cell and a 
numeric type cell cannot be edited at the same time.
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Add this bank from selection - attempts to select all cells in the bank.

Remove this bank from selection - Deselects all cells in the bank

Rename bank - This will rename the current bank for this instance of bank existence.

Save as custom bank - once any arrangement of columns (including resizing) are made, this ‘custom’ bank can 
be named and saved for future use.

The cell types must match.
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• Delete custom bank - deletes the custom bank preset. It will not remove a bank instance based off that custom 
preset, just the preset so that it will not show up as a bank preset.

Sizing Banks

A bank can be resized using the right-most vertical line. In addition, using the upper portion of the vertical line (the part 
where the bank name row is) will proportionally size the columns in the bank, while it would normally just affect the last 
column.

Adding and Removing Banks

To add a bank, simply click the Add Bank button (+) located at the end of the bank name. To remove a bank, click the 
Remove Bank button (-) located under the Add Bank button.

Use the slider-bar at the bottom of the Property Cells to adjust which bank(s) are currently displayed in the viewing 
area.

Property Panel Columns

A Column consists of Cells. Each column in the Scene Editor is a property instance having a specific cell type. The 
Property cells contain the values for each of the properties, for all items. The values range from numerical values to file 
names, depending on which property you are editing. 

There are many column types available to choose from. Left click on the column header to select the Cell Type for that 
column.
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Column Options Menu

Right clicking on a Column drop down menu will bring up the Column Options Menu.

Add column after this one - This will create a new column to the right of the selected column.
Add current cell selection to this column’s cells - This will select the same cells that are currently selected in 
another column and apply that selection to the selected column.
Transfer current cell selection to this column’s cells - This will select the same cells that are currently selected in 
another column and apply that selection to the selected column. It will then remove the selected cells in the 
previous column.
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Apply item selection to this column’s cells - This will select the cells in the selected column based on the items 
selected.

Add this column to selection - This will select the cells that make up this column to add them to the selection.
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Remove this column from selection - This will unselect the cells from the selected column.

Remove this column - This will delete the selected column from the bank.
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Sizing Columns

Left click on the vertical dividers between columns to size a column.

Property Panel Cells

Each property has a cell and cell type depending on the type of data being manipulated. Each column in the Scene 
Editor is a property instance having a specific cell type. The rows are the items shown in the list view. Cells may be 
edited via a property editing panel, which allows greater manipulation flexibility when it comes to changing multiple 
cells at the same time.

Cell Types

Each cell type has its own unique Adjust Properties Panel, but they all share the Preview, Apply, and Revert options.

Preview - This option allows you to see updates to the Scene Editor in real time.

Apply - This will apply any changes made to the cell property.
Revert - This will undo the last change applied to a cell property.

Unique Cell Type Adjust Properties:

Toggle - Check Box

Check - This will activate the option.

This is a preview for the Scene Editor Only.
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Uncheck - This will deactivate the option.
Toggle - This will toggle between active and deactive.

Numeric - Subtypes of integer, percent, distance, angle, time, float.

Change Value To - Value that will be applied to the cell property.
Change Value Effect - Determines how the value will be applied.

The Replace edit mode lets you make absolute changes to the cell’s values. That is, when you apply the edit to the 
selected cells, the new value will replace the current values. For example, you select ten cells with various values in 
each cell, and in the Change Value To field you enter a value of 2.0. When the edit is Previewed or Applied, the cells will 
now all read 2.0.

The Add, Subtract, Multiply, and Divide functions are all relative editing modes. They adjust the cell’s values relative to 
their original values.

Use Step - This will add the Step value to the primary value incrementally according to the order in which the 
cells have been selected.
Step Effect - Determines how the Step Value will be applied.
List - Array of items like a drop down menu.

Change To - This will replace the cell property with the chosen option.
String - Strings used for item tag properties.

Mode - Determines how the string will be applied to the cell property.
String - The text or comment to be applied to the cell property.
Color - RGB color values where each component is 8 bits (not used for high dynamic lighting).
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Change Color To - RGB value that will be applied to the cell property.
Change Color Effect - Determines how the RGB value will be applied.

The Replace edit mode lets you make absolute changes to the cell’s values. That is, when you apply the edit to the 
selected cells, the new value will replace the current values. For example, you select ten cells with various values in 
each cell, and in the Change Value To field you enter a value of 2.0. When the edit is Previewed or Applied, the cells will 
now all read 2.0.

The Add, Subtract, Multiply, and Divide functions are all relative editing modes. They adjust the cell’s values relative to 
their original values.

Use Step - This will add the Step value to the primary value incrementally according to the order in which the 
cells have been selected
Step Effect - Determines how the Step Value will be applied.
Item - layout item that is used for parent item, target item, etc…

Change Item To - The item that will be applied to the cell property.
Enable Item Filter - For scenes with many items, use the filter option to limit your selection options.
Image - Images used for items like Projection image.

Change Image To - The image that will be applied to the cell property.
Enable Item Filter - For scenes with many images , use the filter option to limit your selection options.
Vertex Map - Vertex Maps used for items like Bone Weights.

Change Vertex Map To - The VMap that will be applied to the cell property.
Enable Item Filter - For scenes with many VMaps , use the filter option to limit your selection options.

Cell Options Menu

Right clicking on a cell brings up the Cell Options Menu.
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Toggle Selection - This will select and deselect the cell.

Select Panel - This panel gives you the ability to numerically select cells.

Deselect Panel - This panel gives you the ability to numerically deselect cells.

Jump to Editor - It is possible for a property cell to open a custom editor. The standard properties don’t use this 
function but it is possible for third party tools to add properties that do.
Deselect all - This will deselect all cells.
Reverse selection order - This function will reverse the selection order of the cells that are currently selected.

Ctrl + LMB will toggle selection as well.
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Other reorder options are Reorder selection (left to right increasing toward bottom), Reorder selection (right to 
left increasing toward bottom), Reorder selection (top to bottom increasing toward bottom), and Reorder 
selection (bottom to top increasing toward bottom).

Selection Zone

When a cell is available for multi-selection, it will be divided in two parts: on the left will be the Selection Zone and on 
the right is the Value Zone. Left clicking and dragging in the Selection Zone of a cell will add the cell to the selection set.

Shift-left clicking while selecting a cell will mark the corner of a selection box, expanding the selection box further out 
the more cells are selected. Control-left clicking will toggle on or off the selected cell. The cells are numbered in the 
order they are selected.
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Selection Zone Right Click Menu

Right clicking in the Selection Zone will bring up a new menu. This menu has options for changing the selection order. 
The Adjust Properties panel is also accessible from this menu. 

If you are using the stepping features in the “Adjust Properties” panel, order of selection will be important. 
Also, Adjust Properties is defaulted with Preview off to allow you to manipulate the values before seeing their 
effect on the cells. The Preview button will also be turned off after clicking the Apply button



String values cannot be added directly in the cell, but must be entered in the Adjust Properties Panel. 
You can hide the Scene Editor by hitting the Tab key.



If you have a Bank and Column selection that does not apply to the item type, the cell will not be selectable at 
all. The Bank and Column sections will now change the selected choice a different color instead of hiding it 
when the menu is activated.
If you have multiple cells selected and would like to only change a value for one, hold the Ctrl key while 
changing the value.


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Scene / Dope Editor - Dope Sheet

Introduction
Selecting Blocks
Manipulating Selections
Selection Right Click Menu
Sheet:
Time:
Selection:

Introduction

The Dope Sheet is a form of scratch sheet with which the animation of channel data (position, rotation, scale, etc.) can 
be manipulated without going into the details of what the exact channel values are. This gives an overview of the scene 
animation and is useful when the multiple items need to be viewed simultaneously so that their relative timing is 
correct. This view also allows easy manipulation of a large number of channels in one operation. It allows time 
offsetting and time scaling of channel data.

It can also accelerate the process of cutting out portions of motion or transferring motion from an item or channel to 
other items or channels. This view basically offers a method of manipulating key frame existence without worrying 
about the exact value of each key frame; one of Graph Editor’s purposes in Layout.

The Dope Sheet is a grid, or 2D array, in appearance. The horizontal dimension is time measured in blocks. Each block 
represents a range of time, which is user adjustable in the Options Panel. The horizontal block visible width has a pixel 
width, which can be adjusted to see more time blocks or fewer within the visible portion of the sheet.

The Dope Sheet does not modify key frame values.
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The vertical dimension is measured in rows. Each row represents a single channel of key frame data, a group of 
channels, or nothing. The height of each row is predetermined and matches the row height of the Item List View rows 
and Surface List View rows. Each channel that contains at least one key frame will have its appropriate block colored 
differently. Similarly, an item that contains one or more channels (i.e. a channel group, but may be any row that has 
channel children) with a colored block will have its own block colored, differently from the color of the channel block.

The range of time that the dope sheet will allow viewing of is determined by the preview first and last endpoints set 
within Layout. The scrollbar will then allow viewing within that frame range. There are numeric controls within the dope 
sheet at the bottom, which also allow setting the preview first and last frames. These endpoints are shared with the 
ones in Layout.

The scrollbar has sizing handles on both sides. These are used to adjust the block pixel width so that more or fewer 
blocks are visible at once. Minimum and maximum pixel widths exist as well.

At the top of the sheet is a timeline tick marker display showing what each block represents. A time code is displayed for 
each block for which there is room to display a time code.

There is a minimum pixel width of three pixels for each block.

The horizontal scrollbar has a size limit so that it does not get too small to grab hold of’.
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Selecting Blocks

Blocks may be selected by using the Left mouse to drag a selection box around the blocks of interest. The selection box 
starts in one corner of a block and ends in a corner of a block. The box will snap to the nearest block boundaries and will 
indicate a selection of contiguous time and contiguous rows.

The left edge of the dope sheet contains an empty area to show which rows (items) are selected in the dope sheet. Rows 
that contain some selected blocks appear differently. The top of the dope sheet shows which columns have selected 
blocks. The selection box itself is an outline of the selected blocks. The left and right edges of this box have thin vertical 
handles used for time scaling operations.

During selection, the box may extend beyond the visible portions of the sheet; this will cause the dope sheet to 
scroll hidden areas into view.


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Clicking the LMB in the left edge of the Dope Sheet will select the entire row for all columns. It is important to note that 
the dope sheet block selection is independent of an item list selection or surface list selection.

Clicking the LMB in the top of the dope sheet (where the time line tick marks are) will select the blocks in that column 
for all rows shown. This does not include hidden rows or filtered items.
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Clicking the LMB inside a single block will select that one block.

To add to an existing selection use the Shift + LMB.

Manipulating Selections

Once a selection box has been formed, the contents may be manipulated. If a channel group is manipulated, all 
channels contained within (that are not filtered out) are manipulated even if the group is not expanded. When a range 
of time is manipulated, only the keys originally selected will be manipulated, even if the selection box now has moved 
as a result of an operation.

LMB and drag is used to move the time offset of a selection. Time offsets are applied block by block. If finer time 
resolution is needed, using the control-key modifier while dragging allows the keys to move in time with smaller 
increments.

LMB and dragging the left or right Scale Handles will allow time scaling. Using the left edge will use the selection box 
end time as a scale reference time. Using the right edge will use the selection box start time as a scale reference time.

The control key can be held down while mouse left-clicking. Doing so will allow the precise location of a key in time to 
be manipulated instead of whole block manipulations. This can be done when creating the selection box, moving a 
selection, and scaling a selection.

A new selection always overwrites an existing selection.
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Holding the Shift key down while dragging, will ‘reacquire’ the keys to be manipulated. This means any key blocks that 
are currently highlighted AND inside the manipulation box

When you highlight some blocks and offset them so that now those original blocks are moved, only some keys may exist 
that are inside the highlighted blocks and the manipulation box. Hitting Shift while manipulating further will only affect 
those blocks that are both highlighted and inside that manipulation box.

Selection Right Click Menu

Clicking the RMB inside the selection box will popup a context menu:

Sheet:

Select all - select all blocks that the dope sheet will allow (all tracks all times within preview range)
Unselect all - unselect all blocks currently selected
View all - set the block pixel size such that the preview range can be seen in full.
Select Highlighted Tracks - This will move the manipulation box to the highlighted blocks.
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Time:

Set time here - set current time to the nearest frame to the current mouse position.

Selection:

Numeric offset… - present dialog to offset the current selection in time.

Numeric time scale… - present dialog to scale the current selection in time.

Erase - Delete all keys within original selection. No keys After the selection will be shifted.
Insert Gap - Make the selection box a blank gap. Shift left edge to be right of right edge
Delete - destroys all keys within selection regardless of originally selected keys and shifts all keys after the 
selection right edge to the left.
Cut - Stores keys from original selection into a temporary buffer. Those keys are deleted. The selection box 
remains. Key times are stored relative to the selection left edge time. The time range is also stored so that the 
right edge of the buffer is not determined by the last key.
Copy - Works like cut without deleting the original keys.
Paste Over - Only available if there are keys stored in the temporary buffer. Places keys into the selection box 
starting with the left edge as a reference point. The selection box remains. Keys will not be pasted beyond the 
right edge of the selection box. Tracks are processed top to bottom regardless of where the stored keys came 
from. Existing keys in the selection box are left alone. Keys with the same time value will be overwritten. When 
pasting, it is possible that the number of rows copied will differ from the number of rows pasted to. When copy 
row count is less than the past row count, the copied rows are applied row by row and will cycle around again 
when the end is reached. In other words a copy count of two rows paste count of five will result in source row 1 
being applied to target rows 1, 3, and 5; and source row 2 being applied to target rows 2 and 4. When the copy 
row count is greater than the paste row count, the excess copy rows will not be used.
Paste insert - like Paste Over except that all time from the left edge of the selection is moved forward in time in 
order to make room for the stored keys first. Then, the paste occurs ignoring the selection box left/right, but it 
does consider the top/bottom selection.
Edit in graph editor - opens the Graph Editor with the current selection box selected. This includes time range 
and tracks that may be selected.
Zoom - set the block pixel size such that the selection box time range occupies the visible portion of the sheet.
Quantize - This useful operation will make all keys move in time to the start of the block period they are 
contained within. This can help fix slight offset errors that may have crept in.
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Scene / Dope Editor - Playback Controls

Besides dragging the frame slider to navigate through your scene, you can also use the transport controls located in the 
lower right corner of the Scene Editor. You can also play your scene backward (left arrow) or forward (right arrow) from 
the current frame using the playback controls.

Keyboard Shortcuts

There are also some keyboard shortcuts that can be used for playback:

First frame - (Alt + Cursor Left)
Previous frame - (Cursor Left)
Previous keyframe - (Shift + Cursor Left)
Next frame - (Cursor Right)
Next keyframe - (Shift + Cursor Right)
Last frame - (Alt + Cursor Right)
Play Forward - (Page Up)
Play Backward - (Page Down)
Pause - (Insert)

Your playback speed will vary depending on the complexity of your scene, object display mode, system 
capabilities and so on. Reducing the size of your Layout window can dramatically increase playback speed.


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Instancing
Click here to expand Table of Contents...

About Instancing
Getting Started with Instancing
Instancing reference

About Instancing

Instancing allows vast duplication of objects in a scene with very little overhead. With instancing huge ‘virtual’ polygon 
counts can be achieved allowing the artist to populate their scenes with incredible detail, yet retain reasonable render 
times and memory usage.

While instances can be thought of as clones of the original source objects, they do not need to look identical. They can 
be randomly scaled, positioned, rotated and even surfaced entirely differently from the source, allowing for a huge 
variety of uses.

The Instancer Tab on Layout’s Object Properties panel is where the action happens. The selected object in the Object 
Properties panel will be the point source for the Instance Generator, once it has been added to the source object. 
Several instancing distribution methods are provided.

Instances can be displayed in OpenGL as normal objects, bounding boxes, as points, or not at all, as the user chooses 
and are fully supported in VPR.

Instances work with Classic, Dithered and Photoreal Motion Blur and Surfaces can be varied among the instances.


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You can directly enable and disable rendering of Instances in the Render Globals > Render tab.

Getting Started with Instancing

To get you going with Instancing, we’re going to make a very simple example purely using Layout that should whet your 
appetite for knowing more.

Start by visiting the Modeler Tools tab and use the Create > Cube and Create > Ground Plane buttons. You can leave the 
settings for these exactly as they are.
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Make sure the Ground Plane is selected and go into Object Properties by hitting P on your keyboard or the Properties
button at the bottom of the Layout interface.

Go to the Instancer tab and choose Instance Generator from the dropdown menu.
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Double click Instance Generator and from the Add Object dropdown choose New Cube Object. Congratulations you’ve 
made an Instance. Right now, its Type is Item Pivot and since the Ground Plane’s pivot is in the same place as the 
Cube’s, the instance you have created is in the same place.
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Let’s make things more interesting. Change the type to Surface and put in 1000 instances. They are all overlapping, so 
let’s shrink them down and position them more dynamically.
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In the Scale tab set the Min to 10 % and Max to 30 %. In the Offset tab just change Max Y to 2 m. In the Rotation tab set 
Max H to 45 °.

Now play. Use VPR to show your cubes rendered instead of those blue bounding boxes. Up the quantity of Instances - 
try a million or more!

See Randomly surfacing Instances for how to make your cubes multi-colored

Instancing reference
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Lights
Click here to expand Table of Contents...

Lighting Introduction
Video
Basic Light Attributes

Visible to Camera
Affect Volumetrics
Example - Creating a Volumetric Light
MIS Samples
Buffer Group
Normalize

Converting from 2015

Lighting Introduction
Along with objects and the camera, lights are a basic element in any LightWave Scene. In Layout, a Scene must always 
have at least one light. In fact, LightWave will not allow you to remove the last light source. If you really don’t need it, 
you can just turn its Light Intensity to zero or deactivate the light in the Scene Editor.
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Lights in LightWave come in various forms. Shown here are the standard lights at normal sizes for all but Spot, which has 
been enlarged, and Photometric that has no IES file loaded yet. Third-party lights can be added.

LightWave has several types of lights, and you can give them different names, colors, and attributes. Along with lens 
flares, volumetric and shadow casting options, you can control light with a high degree of precision. All of these features 
are found within the Lights tab of the Render Globals Panel.

Along with the several lights, LightWave also features radiosity and caustic light effects, which can add tremendous 
realism to your scenes.

LightWave lights don't have to act exactly like lights in the real world. For instance, you can choose not to see a 
LightWave light source, only its illuminating effect in the scene. This is actually a handy feature because unlike a movie 
set, you can place lights anywhere, including in front of the camera.

Video

Basic Light Attributes
Light Properties are to be found by selecting a light and hitting P or using the Properties button just to the right of the 
Current Item dropdown. This will bring up the Light Properties panel. This panel can vary quite a lot in size depending 
on what sort of light you’ve chosen, but they all have options at the top of the window in common.

Clear all Lights - Doesn’t need much explanation. Since LightWave always requires at least one light in the scene, 
a single Distant light, in its default position will replace all the lights in your scene. This action cannot be undone.
Lights in Scene - Just an info field that tells you how many lights you have in your scene.

•
•

•

•
•
•
•
•
•
•

Light power values are now listed in Lux (Lumen per meter squared)
The Dome light has been removed and the Distant light given an Angle value like it

The Environment light is used to add light from the backdrop for a scene. It is now in new scenes 
by default with a distant light
Area and NGon lights now only point in one direction and can act as portals
Lights can be visible to the camera
All lights except point are sampled
All lights can optionally affect volumetrics
Ambient Intensity has been removed
MIS set to 512 samples instead of 256
Distant light default angle set to 0.52 to better emulate the sun's soft shadows

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=_SjP11gFhwM

https://www.youtube.com/watch?v=_SjP11gFhwM
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Visible to Camera

A light with this option will be presented in the render as a visible light in the shape and size of its OpenGL 
representation. A light's size and shape can be altered in the Light Properties panel, or, in the case of Area and Linear 
lights, by using the Scale and Stretch tools in the viewport.

Affect Volumetrics

Lights can optionally affect volumetrics for creating volumetric lighting effects or affecting volumetric primitives from 
the outside.

Example - Creating a Volumetric Light

MIS Samples

Some lights perform Multiple Importance Sampling, a more accurate version of the Importance Sampling introduced in 
LightWave 2015 that is available through the Global Illumination tab in Render Properties. It is more accurate because it 
is directly sampling the environment image, whereas the GI version is one step removed sampling the GI result of the 
environment map.

Buffer Group

See the Light Groups page.

Though the Visible to Camera option may not be set in Light Properties, lights will still appear in reflections 
unlike earlier versions of LightWave.



Turning Cast Shadows on in the Shadows tab makes the light behave like an object casting a shadow created 
by other lights in the scene. Turning Cast Shadows on for a light is basically turning the light into a light 
blocker



Volumetrics require an Inv Distance ^2 falloff. In 2019, this is set by default, but if your light is not affecting 
volumetrics check this setting first.


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Normalize

There is a Normalize toggle in most Light Properties windows. Light intensity is now set in Lux, which is Lumen per 
meter squared. This means that as your lights change size so does their intensity. With Normalize off, a smaller light of a 
given intensity will give out less light, a bigger light more. With Normalize on, the intensity stays the same. It might 
appear to become dimmer in some cases but this is merely because the light output is being spread over a larger area.

The area of a Distant light will decrease as you reduce the angle in the panel, and thus its power diminishes if Normalize 
is not checked. 0° is a special value, and the Distant light will behave the same Normalized or not, with hard shadows.

Converting from 2015
Loading a scene from a previous version of LightWave will automatically convert scene lights to the correct values, but if 
you need to manually convert a 100 % light from the old percentage scale to Lux you can do so according to the 
following rules:

Area * 3.14
Distant * 3.14
Dome * 1.57 (converted to Distant light with the appropriate angle)
Linear * 3.14
NGon * 3.14
Photometric no changes, but see note
Point * 3.14
Spherical * 6.28
Spotlight * 3.14
3rd party lights * 3.14

Light Types
Ambient Light

Photometric has no changes because Photometric lights are based on the IES data they contain that should 
now be accurate, rather than needing tweaking



Pi (either half, full, or double) is approximately the same light output as previous LightWave versions' 100%



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  354

•
•
•

•
•
•
•
•

•
•
•
•
•
•
•
•

•
•
•

Area Light
Distant Light
Environment Light

Backdrop
SkyTracer 2
Image World
Physical Sky (Hosek-Wilkie)
Textured Environment

Linear Light
NGon Light
Photometric Light
Point Light
Primitive Light
Spherical Light
Spot Light
SunLight (Hosek-Wilkie)

Light Properties
Lens Flares
Luxigons
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Light Types
Click here to expand Table of Contents...

Saving Lights
Light Types
Falloff
Volumetrics

Saving Lights

Choose File > Save > Save Current Light to save the current light to a scene file. You save normal Light settings as well as 
Lens Flare and Volumetric Light settings. You can add the light to a scene by choosing File > Load > Load Items from 
Scene and selecting the previously saved light file - which is really just a scene file with only light information.

Light Types

LightWave has several types of lights, each with their own characteristics, features, and abilities. Once you add a light, 
you can change its type by changing the Light Type on the Light Properties Panel.


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The default selection of lights. More can be added by third parties.

Ambient Light
Area Light
Distant Light
Environment Light
Linear Light
NGon Light
Photometric Light
Point Light
Primitive Light
Spherical Light
Spot Light
SunLight (Hosek-Wilkie)

Falloff

Although the Lights Properties panel only has Off and Inverse Distance^2 as options, you can use the Node Editor to 
recreate legacy falloff styles using the Light Falloff node as shown.

Volumetrics

All lights (except Distant and Environment) can affect Volumetrics when Use Volumetric Scattering is on in Render 
Properties > Volumetrics and Affect Volumetrics is on in Light Properties.

All the lights we are about to present have had their picture taken using VPR in final mode with the light in the 
default position, orientation and settings. When settings are changed, the changes will be noted.


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Ambient Light

The Ambient light has been re-added to LightWave 2020.0.2 at the request of cel-shading artists. The light 
presents itself like a Point light in OpenGL, and, like a Point light, rotation doesn't matter. Unlike a point light, neither 
does position because an ambient light bathes the whole scene with a directionless illumination. Artists wanting a 
photorealistic render will probably never use this light but it can be useful if you wish to lighten shadows for a specific 
artistic effect.
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Area Light

If you could turn a four-point polygon into a light, you’d have an Area light. Light is sent out equally in all directions, 
except along the edges. This type of light might be used for flat light panels or as a portal light to bring GI samples inside 
a room.
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Unlike the Distant, Point, and Spotlight lists, you can size these lights, just as you would an object. Another distinction is 
that ray-traced shadows will have physically accurate edges that are sharpest near the object that is casting them and 
get softer further away. A smaller area light will result in sharper shadows than a large area light.

Normalize

There is a Normalize toggle in most Light Properties windows. Light intensity is now set in Lux, which is Lumen per 
meter squared. This means that as your lights change size so does their intensity. With Normalize off, a smaller light of a 
given intensity will give out less light, a bigger light more. With Normalize on, the intensity stays the same. It might 
appear to become dimmer in some cases but this is merely because the light output is being spread over a larger area.

The area of a Distant light will decrease as you reduce the angle in the panel, and thus its power diminishes if Normalize 
is not checked. 0° is a special value, and the Distant light will behave the same Normalized or not, with hard shadows.
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Portals

Area and NGon lights can be used as portals. Portal lights are guides placed in indoor scenes that help the 
renderer to concentrate environment lighting through openings like small windows.

The circle showing the ray source and box for the portal are purely for illustrative purposes. The light with the portal should 
be outside and larger than the opening

Portals work with the environment light and its plugins - Image World, Textured Environment, gradient backdrop or 
similar. While portals will add time to renders they also clear up noise and bring a lot of extra detail that you don't get 
using an environment light alone.

For copyright reasons, a gradient has replaced the HDR image for this scene. The effect is more 
interesting with a proper HDR image.



https://docs.lightwave3d.com/download/attachments/8201338/Light_Portals.zip?api=v2&modificationDate=1575626989000&version=1
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This scene is lit purely by the Environment light with an HDR image texture

The same scene, with an Area light with the Portal switch turned on. The increase in detail and color, and reduction in 
noise,  for the interior of the room is excellent considering the extra rendering time. The two scenes are available above to 
try for yourself.

The reason for turning Normalize off when using a portal light is that the color and intensity are coming from 
the backdrop environment rather than a localized light source. As such, the size of the portal has no bearing on 
the quality of light coming through the opening and so Normalize is turned off automatically when Portal is 
engaged. Normalize can be turned back on for artistic reasons.



If your scene has multiple lights, or large openings for light to come in from the environment, using a portal is 
not necessary - it can unnecessarily slow down rendering and even create additional noise. Equally, complex 
material networks will benefit from direct lighting rather than the additional computation necessary for 
portals. Finally, if you have several small openings on a wall, consider using a single portal that spans them all 
instead of multiple portals that can increase render setup time.


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Distant Light

A Distant light is somewhat like the light from the sun. Surfaces receive an infinite amount of parallel light rays traveling 
in the direction that the Distant light points to. Distant lights are handy when you want equal illumination on objects in 
a scene.

The Distant light replaces the Dome light from previous versions with its ability to set an angle. The default angle of 
5.2° will result in soft shadows, as though from sunlight, but the angle can be increased  or decreased for sharper 
shadows. Loading a scene from a previous version of LightWave with a Dome light will see it replaced with a Distant 
light. Settings will be preserved except mapping, since Distant doesn't currently support it.
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Distant light at 0°, 3° and 90° without normalization

Distant light at 0°, 3° and 90° with normalization

The Distant Light behaves a little differently from other LightWave lights, the icon representing it is purely so that it can 
be controlled by the user - only its rotation is relevant because, in essence, it is very powerful, very big and very far 
away, like our own sun. Because of this, you may place one Distant light in a scene pointing straight down and all 
objects in your scene are lit as if from above - in LightWave, the light can be a million meters or one meter above the 
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object. You will see the exact same results on the object. In most cases, you will need only one Distant light in a scene, 
although you can add more. Generally, you will get more realistic results using multiple types of lights.

Normalize

There is a Normalize toggle in most Light Properties windows. Light intensity is now set in Lux, which is Lumen per 
meter squared. This means that as your lights change size so does their intensity. With Normalize off, a smaller light of a 
given intensity will give out less light, a bigger light more. With Normalize on, the intensity stays the same. It might 
appear to become dimmer in some cases but this is merely because the light output is being spread over a larger area.

The area of a Distant light will decrease as you reduce the angle in the panel, and thus its power diminishes if Normalize 
is not checked. 0° is a special value, and the Distant light will behave the same Normalized or not, with hard shadows.

Volumetric Distance

The Volumetric Distance setting, added in LightWave 2019, is the distance the volumetric effect reaches from the ray.

Because LightWave, by default, places one Distant light aimed from the upper left to the lower right in a scene, 
you can simply load any object and immediately hit the Render (F9) button or go into VPR mode (without 
setting any key frames) to see what the object looks like.





LightWave 2020  –  LightWave 2020

Getting Started with Layout –  365

•
•

•
•
•

•
•

Environment Light

Click here to expand Table of Contents...
Introduction

Time Dependent

Usage
Light Intensity
Volumetric Distance

Troubleshooting
Environment Plugins


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1.
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Introduction

Although the Environment light has the word "light" in its name, it will not illuminate the scene by itself - the 
light color is used as a multiplier for the environment(s) that are 'loaded' into the light, or the Backdrop tab. Without 
any environments, either a blank list or existing ones unchecked, then the light color will be multiplying by zero, 
resulting in black.

There are now two locations for environment plugins for LightWave. Those contained in the Backdrops tab of the 
Effects window are called Global Backdrops, whereas the same plugins in the Environment Light window are local to 
that specific Environment light. To make use of the environment system, these things must be true:

An Environment needs to be present;
If you want to use an environment in the Backdrop tab of the Effects window, the Use Global toggle in the 
Environment Light panel must be checked. If the environment you want to use is added in the Environment 
Light, the toggle should be unchecked.

Clicking the RMB in the plugins area of an Environment light will add and remove environment plugins. Plugins can be 
reordered. Neither Position, Rotation nor Scale affect Environment lights

Time Dependent

Also new to 2020 is the Time Dependent toggle. This toggle ensures that the rebake of the environment will be 
up to date for each render frame. When the user knows they are not using envelopes, or anything else, that requires 
rebaking, they can disable it. The user may also want to disable it, even temporarily, if they are experiencing poor time-
slider interactivity.

Only one Environment light can be visible to the camera at a time
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Usage

If you only want to use an environment light in a scene, and don't have a background element (or have it switched off), 
either a single color, or a gradient, or an image; this is what you get:

As soon as you add a Backdrop in the Environment light, and turn off Use Global if it's on, but don't turn on Visible to 
Camera, you will get:

Adding an HDR image through Image World or Textured Environment will get you something quite beautiful:
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Light Intensity

Light Intensity acts as a multiplier for the background allowing for fine-tuning. Remember, if there are no environments, 
the color and intensity will be multiplied by zero giving black.

Multiple Environment lights can be used in a scene
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The same HDR, three different intensities

Volumetric Distance

The Volumetric Distance setting, added in LightWave 2019, is the distance the volumetric effect reaches from the ray.

Troubleshooting

Are you not seeing what you expect when rendering?

Symptom Diagnosis

All black render The only active light in the scene is an Environment light and it 
has no environment

Render is still black You have an environment light, and backdrop, check the Use 
Global toggle is in the right state for where the backdrop is

Render is good, but backdrop black Check you have Visible to Camera on in the Environment light, 
and Use Background Color off in Effects > Compositing
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Symptom Diagnosis

Render is good but HDR visible Either uncheck Visible to Camera in the Environment light or add 
Use Background Color in Effects > Compositing

Render is good but odd color cast Check the color of your environment light

Render is good but too bright/dark Check environment light color and intensity. Normally, they 
should be white and 1.0 lx respectively

Environment Plugins

Backdrop
SkyTracer 2
Image World
Physical Sky (Hosek-Wilkie)
Textured Environment
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Backdrop

Click here to expand Table of Contents...
Backdrop

Gradient Backdrops

Backdrop

(default keyboard shortcut Ctrl F5)

LightWave lets you change the colors of the backdrop behind all of the objects in a scene. The settings are on the 
Backdrop Tab of the Effects Panel (Top menu > Backdrop). You can elect to have a solid color using the Backdrop Color 
setting or a Gradient Backdrop. By default, the backdrop is solid black.

If you have any reflective surfaces, and you want the backdrop included in the reflection, set the Reflection options on 
the Surface Editor’s Environment Tab to one of the backdrop options.

Gradient Backdrops
LightWave’s Gradient Backdrop settings essentially provide a quick earth-like environment background. Note that no 
shadows can be cast on the backdrop since it isn’t there. Although you‘re unlikely to use it much for real-life imagery, it 
is great for faking a sky behind mountain objects, instructional animations, and logo animations. Use it when you need 
something to stick in the background.

There are two gradient areas. Think of it as a huge sphere cut into two halves. One half rests on top of the Y-axis plane, 
and the other half sits directly beneath it.




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The Sky Color begins all around the edge of the top half of the sphere and gradually turns into the Zenith Color moving 
towards the top. The Ground Color starts all around the edge of the bottom half of the sphere and progressively turns 
into the Nadir Color moving towards the bottom. Note that there is no gradual change of color between the Sky Color 
and Ground Color.

The camera is always positioned right in the center of the sphere. Thus, if you move the camera, the Gradient Backdrop
will always look the same. However, if you rotate the camera, you will see the various colors.

If you want the Gradient Backdrop to blend everywhere with no sharp color change, make the Sky Color and 
Ground Color the same.


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Left: Sky and Ground Squeeze both at 6.0, Right: Both at 20
The Sky Squeeze value determines how the Zenith and Sky colors are blended. The Ground Squeeze value determines 
how the Ground and Nadir colors are blended. The default value of 6.0 yields a nice spread between the various colors. 
A lower value will spread the change in colors over a greater area, and a higher value will compress the change.
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SkyTracer 2

Click here to expand Table of Contents...
SkyTracer2

The Atmosphere Panel
The Clouds Panel
The Texture Editor Panel
The Suns Panel
Sun Position
The Sky Baker Panel

SkyTracer2

The SkyTracer2 Environment was designed to create sophisticated atmospheric effects using real-world parameters. 
You can adjust the Atmospheric, Cloud, and Sun settings within the interface to create a variety of beautifully rendered 
sky images. These skies can be rendered (volumetrically or as a 2D effect) within an existing scene, or saved as image 
files to be composited or used as Texture Maps.The SkyTracer2 Environment was designed to create sophisticated 
atmospheric effects using real-world parameters. You can adjust the Atmospheric, Cloud, and Sun settings within the 
interface to create a variety of beautifully rendered sky images. These skies can be rendered (volumetrically or as a 2D 
effect) within an existing scene, or saved as image files to be composited or used as texture maps.

SkyTracer2 simulates light scattering and light absorption in the atmosphere. The settings for this simulation are real-
life parameters such as atmosphere thickness, cloud altitude, sun position and so on. Because SkyTracer2 uses 
volumetric lighting techniques, you can even get spectacular effects like the sun casting light rays through the clouds. 
You can adjust both the current Time and Location settings to accurately simulate the sun rising or setting, anywhere in 



SkyTracer 2 should no longer be used for new scenes if you would like accurate skies. The Physical Sky (Hosek-
Wilkie) Backdrop shader should now be used. SkyTracer 2 is merely provided for old scene use.


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this world or another.

Default SkyTracer2 settings

Several Presets
The interface is split into two sections: global controls are at the top of the panel and controls to adjust atmospheric 
effects are at the bottom of the panel.

The SkyBaker button brings up the SkyBaker Panel.
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The Dissolve setting adjusts the transparency of the SkyTracer2 effect and the Planet Radius adjusts the size of the 
planet, and thus the size of the atmosphere. The default value of 6.3Mm represents the size of the Earth.

The Atmosphere Panel

 

Think of the sky as a stack of two layers, Atmosphere and Haze. These layers have identical controls, but each can have 
different values for scattering, absorption, and density distribution.

Quality is the level of sampling performed along the camera’s viewing direction. Higher Quality levels give more 
accurate renders, however, this setting also affects rendering times. Therefore, the High setting should be reserved for 
very precise effects.

The Thickness setting controls the thickness of the atmosphere and haze layers. Thickness is measured in kilometers 
and meters respectively, with 100km and 1000m as default values.
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Left: Thickness 100%; Right, Thickness 50%
The Luminosity parameter adjusts the percentage of light that scatters within the layer. This scattering intensity is 
greatest in front of the sun and lower elsewhere.

 

Left: Luminosity 100%; Right, Luminosity 0%
Opacity measures the percentage of light absorbed within the layer. High values attenuate light, and objects disappear 
at the horizon. When you use opacity with haze, you can create pollution-like effects. However when you adjust the 
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opacity within the Atmosphere Panel, you can create strange, out-of-this world skies.

 

Left: Opacity 50%; Right, Opacity 200%
Fall Off modifies how density is distributed throughout the layer. Values higher than 100% decrease density rapidly with 
altitude, while a value of 0% has no decrease at all. Negative values in the Haze Falloff setting will invert the density 
distribution.

The Clouds Panel
No sky would be complete without some clouds! By controlling the clouds’ altitude, density, luminosity, opacity, and 
contrast parameters, SkyTracer2 can create an incredible range of cloud effects. The two layers in SkyTracer2, low and 
high-altitude clouds, have identical parameters; you can enable these layers separately for drastically different effects 
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or together for complex sky patterns.

 

Use the Enable Clouds switch to turn the two cloud layers on or off.

The Texture button opens the Texture Editor Panel, which is where you specify the type of cloud to render and adjust its 
coverage parameters. (see below)

Altitude sets the height in the sky where the cloud layer will start.

The Density setting controls how dense the cloud layer is. Think of this setting as adjusting the probability of rainfall for 
the area. A Density value of 10% means that the clouds are fairly devoid of water. This gives a much thinner cloud layer, 
which allows more light to travel through it. A value of 75% has a much thicker appearance, and shows a higher 
probability of rain.
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Left: Density 20%; Right: Density 200%
Luminosity controls the scattering intensity of light through the clouds. With high values, you create bright clouds. The 
light scattered from the cloud is attenuated by the Atmospheric and Haze settings.

 

Left: Luminosity 10%; Right: Luminosity 100%
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Opacity controls how much light is allowed through the layer. A setting of 100% renders a completely dark sky, while a 
value of 0% renders a much brighter sky.

 

Left: Opacity 10%; Right: Opacity 50%
The Contrast setting affects the coverage of the cloud layer. A value of 10% gives a constant sheet of clouds, with little 
variation within the layer. While the default value of 200% shows subtle variation within the cloud, it also reduces the 
cloud’s coverage.

 

Left: Contrast 100%; Right: Contrast 200%
Enable the Volumetric Rendering option to specify how SkyTracer2 will render the layer. When Volumetric Rendering is 
enabled, SkyTracer2 renders the clouds as a volume that has both density and mass. When Volumetric Rendering is 
disabled, SkyTracer2 renders the layer like an image projected on a piece of geometry in the sky. Disabling this effect 
will greatly reduce rendering time, but it will also generate a less convincing cloud layer.

If enabled, Volumetric Rendering also makes the cloud quality, height, shadow strength, and ambient light parameters 
available. These options do not apply to a cloud layer when you disable Volumetric Rendering.
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Activated, Deactivated
Textured Shadows activates the cloud layer’s self-shadowing option, which generates more accurate shadows within 
the layer, but increases rendering times. Textured Shadows is similar to HyperVoxel’s self-shadowing feature.

Like in reality, you can get an under-lit effect when the sun is very low on the horizon. In this case, the clouds are lit from 
beneath, creating spectacular red lighting effects. The effect is best accomplished by using volumetric clouds with 
textured shadows.

The Texture Editor Panel
SkyTracer2 uses a texture defined in LightWave’s Texture Editor to control the style, coverage, and placement of the 
cloud layers. Although you can use a Procedural, Image, or Gradient texture layer, the most common texture used will 
be the STClouds procedural texture. This procedural texture is specifically designed to work with SkyTracer2 and 
contains many of the settings needed to create realistic clouds.

Use the procedural preview window in Texture Editor to quickly see results when you adjust settings for cloud style and 
coverage. Simply adjust one of the procedural’s settings and watch how it affects the computed fractal.
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The Texture Value controls the strength of the cloud layer. The higher the percentage, the more cloud coverage 
in this layer.
The Small Scale and Big Scale values are two fractal scale parameters for the appearance of the clouds.
Lacunarity sets the turbulence within the cloud layer. A value of 1 renders the clouds nice and smooth, while a 
value of 5 or higher breaks up and distorts the cloud to give it a much more natural appearance.
The Octaves setting controls the amount of frequencies or detail your fractal receives. The higher the value, the 
more frequencies are used when rendering. This will create more details within the cloud, but it also causes 
longer rendering times.
Cloud Type lets you select from cloud styles. Cumulus clouds are big and puffy low-altitude clouds; Cirrus clouds 
are long and thin and are generally found at higher altitudes. You can even simulate the streaming effect that 
jets create when flying at high altitudes by selecting the Jet Trails Cloud Type.

SkyTracer2 applies textures to an imaginary cloud layer that is parallel to the XZ plane. Therefore when you apply 
textures with a planar projection, you should use the Y axis. You can create realistic cloud effects like attenuating the 
clouds in the distance using X and Z Falloff, or create pyramid-shaped clouds (as in Cumulus) by using a texture Falloff 
on the Y axis.

Instead of using a procedural approach, you can specify the clouds’ exact coverage by loading a fractal-like image on 
the Y axis. To get a convincing effect, you should use a smoothly repeating texture.

Use a gradient in any layer to modify the previous layer’s effect. The gradient Input Parameters are Heading (ray 
heading angle), Pitch (ray pitch angle), and Height. The height is the height inside the cloud layer.

The Suns Panel
SkyTracer2 uses one or two lights to render the clouds and atmospheric effects. You can use either your own lights or 
the SKT_Sun lights added by SkyTracer2. An added bonus: you can also set up these lights to render as either a sun or a 
moon flare.

The SkyTracer2 default texture has a Falloff setting already applied.

That is 0 in the bottom and 1 at the top.

By default only one Sun light is added.
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You can select which light(s) SkyTracer2 uses to calculate the appearance of the clouds in the Sun1 and Sun2 Light drop 
down list. The Type lets you choose to render the light as a sun or a moon. You can change the appearance of the sun or 
moon by adjusting the flare’s Size, Flare Intensity, Flare Boost, Streaks, and Color Shift values.

Sun Position
By pressing the Sun Position button, you access the Sun Spot Motion Modifier. You adjust the sun’s position by 
specifying the exact day and time for the light to be positioned.
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3.

Although you may never see it, the position of the SKT_Sun light rotates properly as time passes. To increase the speed 
of the animating sun, edit the Time Lapse field. To complete the time lapse effect, animate the cloud’s texture 
parameters.

The Sky Baker Panel
Once you create your sky, you can either render it on every frame along with your scene or Sky Baker can generate 
image files to map it onto geometry and fake the effect. Several reasons are listed below for why you would want to 
bake a sky:

You can see your sky in real-time using OpenGL.
The sky is saved as an image, so you can edit it with the Image Editor controls (e.g., hue, saturation, gamma, 
etc.).
The solution is already figured out, so the sky renders extremely fast.

The Sky Baker Panel lets you select the resolution of the images, their image type, mapping projection style and a file 
prefix name. The Antialiasing option activates and deactivates the Antialiasing pass when rendering the images.

The spherical projection has the advantage of being more compact and not distorted when compared to the 
cubic projection.


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By pressing the OK button Sky Baker will start to render all images. A progress bar shows you how much Sky Baker has 
completed. Once Sky Baker completes the job, you can choose to generate, position, and map the geometry needed to 
complete the effect.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  388

Image World

Use the Image World Environment to apply a lat/long style spherical map image as a spherical environment wrap; this is 
perfect for high dynamic range images. You can offset the heading and pitch of the image, as well as adjust its 
brightness.

Example of the style of image to use with Image World
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Physical Sky (Hosek-Wilkie)

Physical Sky is a Backdrop shader, with its elements rendered beyond the furthest extremities of the scene.  It is based 
on papers written by Lukas Hosek and Alexander Wilkie, the current best approximation of atmospheric light scattering. 
As can be expected from our everyday experience the atmosphere is thickest with the sun at the horizon, so, with 
default settings, more blue light is removed and the red is left, but these same settings allow for a wide range of 
different planetary atmospheres, real and imagined. This shader also allows multiple celestial bodies to be easily added 
and influence the atmosphere (Did someone say "binary star system"?)

Because SunSky is a backdrop shader, it means that although it can contribute to the lighting of a scene - using an 
environment light, say - you cannot interact with it. It's not possible to generate clouds using SkyTracer that will react 
accurately to it, but these things can be worked around using additional lights positioned in a similar position relative 
to the camera.
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New to 2019.1 is a softened horizon line and the possibility to color the "ground" portion of the 
backdrop.

To do so, add a Textured Environment, make sure it is above Physical Sky in the Environment list, and you can 
have something like this:


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Surface Albedo - Reflectance color from the planet. The default value of blue has been set because our planet is 
mostly water
Turbidity - The reduction in the transparency of air because of scattering of light by dust and smoke particles 
and water droplets. Increase the turbidity to make the atmosphere denser - hazier. Great for recreating LA 
sunsets
Scattering - The scattered color of the sky itself
Tint - Added for tinting skies. Leave white to use the sky color as normal, change the scattering color to multiply 
with the end result
Max Luminance - Function added for tone mapping the final result. This will tone down the brightness value of a 
star to better match the rest of the scene
Add/Rename/Remove Star - Add, rename or remove additional stars adding each to the bottom of the list. 
Because a backdrop is effectively flat, getting the stars in the right order for proper layering is done by dragging 
and dropping to reorder in the star list
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Item - Use an item's rotation to change the position of the sun in the scene. Because a sun is so far away, 
changing the position makes no sense. When using an item to control the sun's position, the following three 
options will be ghosted:
Pick Location - Opens the Location Picker window
Azimuth - The sun's position across the sky
Elevation - The sun's vertical position in the sky

Temperature - Similar to using the Kelvin scale in the color picker. The scale starts at 1000 and can go up and 
up, for instance, the temperature of Sirius is 25,200 K. The default value of 5,778 K is representative of the Earth's 
sun
Intensity - A value to choose for the overall intensity of your star in the sky. The default value of 5.0 has been 
chosen for the Earth's sun
Size - A value to choose for the overall size of your star in the sky. The default value of 5.0 has been chosen for 
the Earth's sun

The following three options are all linked - a low temperature implies a large size, a small size implies a 
high intensity and a high intensity implies a high temperature and vice versa. Care should be taken to 
balance



If you are linking your SunSky with a light (in the Item dropdown), you should set the SunSky light to 0 to 
disable the SunSky version and only use the light in the scene. Otherwise, you will have a doubling of lights, 
and more noise inherent.


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A small change to the Turbidity and Scattering color makes a dramatic difference
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Textured Environment

Use the Textured Environment environment to apply a texture as a spherical environment wrap; this is perfect for 360 
° high dynamic range images. Clicking the Texture button launches the standard Texture Editor giving you access to 
gradients, procedurals, and the use of images to create an endless variety of textures.

 
The texture is not stuck to the camera background, like a normal background image. Therefore, as you move the 
camera, you will pan over the environment.

Example of the type of image to use with Textured Environment

An interesting application would be to use a gradient and select the (camera) Heading or Pitch as the Input Parameter. 
This lets you vary a glorious sunset sky based on the rotation of the camera. You might also use this to add a nebula 
behind your starfield using a simple Turbulence or Fractal Noise procedural texture.
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There are several additional Gradient backdrops available using the Textured Environment plugin available on this tab. 
Select it and hit F8 to bring up the Presets window in which you will see several choices, including an updated oldskool 
Desert Chrome backdrop.
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Linear Light

If you could turn a two-point polygon into a light, you’d have something similar to a Linear light. Light is sent out 
equally in all directions, except at the ends. This type of light is great to use in objects like fluorescent strip lighting.
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The Linear light has been changed in intensity and orientation to give a better image

Ends

The Linear light has an Ends option. This toggle controls the visibility of the end caps. When turned off, the linear light is 
a hollow tube and emits light from both inner and outer surfaces.

Both lights are 3 m across and 200 mm long and visible to camera. The gold light has no Ends; blue light has Ends checked
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NGon Light

An NGon light behaves exactly like an Area Light, but you can choose how many sides you'd like it to have. Any quantity 
less than 3 will make the light circular in shape.
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Normalize

There is a Normalize toggle in most Light Properties windows. Light intensity is now set in Lux, which is Lumen per 
meter squared. This means that as your lights change size so does their intensity. With Normalize off, a smaller light of a 
given intensity will give out less light, a bigger light more. With Normalize on, the intensity stays the same. It might 
appear to become dimmer in some cases but this is merely because the light output is being spread over a larger area.

The area of a Distant light will decrease as you reduce the angle in the panel, and thus its power diminishes if Normalize 
is not checked. 0° is a special value, and the Distant light will behave the same Normalized or not, with hard shadows.

Portals

For copyright reasons, a gradient has replaced the HDR image for this scene. The effect is more 
interesting with a proper HDR image.



https://docs.lightwave3d.com/download/attachments/8201338/Light_Portals.zip?api=v2&modificationDate=1575626989000&version=1
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Area and NGon lights can be used as portals. Portal lights are guides placed in indoor scenes that help the 
renderer to concentrate environment lighting through openings like small windows.

The circle showing the ray source and box for the portal are purely for illustrative purposes. The light with the portal should 
be outside and larger than the opening

Portals work with the environment light and its plugins - Image World, Textured Environment, gradient backdrop or 
similar. While portals will add time to renders they also clear up noise and bring a lot of extra detail that you don't get 
using an environment light alone.
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This scene is lit purely by the Environment light with an HDR image texture

The same scene, with an Area light with the Portal switch turned on. The increase in detail and color, and reduction in 
noise,  for the interior of the room is excellent considering the extra rendering time. The two scenes are available above to 
try for yourself.

The reason for turning Normalize off when using a portal light is that the color and intensity are coming from 
the backdrop environment rather than a localized light source. As such, the size of the portal has no bearing on 
the quality of light coming through the opening and so Normalize is turned off automatically when Portal is 
engaged. Normalize can be turned back on for artistic reasons.



If your scene has multiple lights, or large openings for light to come in from the environment, using a portal is 
not necessary - it can unnecessarily slow down rendering and even create additional noise. Equally, complex 
material networks will benefit from direct lighting rather than the additional computation necessary for 
portals. Finally, if you have several small openings on a wall, consider using a single portal that spans them all 
instead of multiple portals that can increase render setup time.


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Photometric Light

Photometric lights are custom lights used to replicate real lights. The bottom section of the Light Properties panel 
allows you to load Photometric settings files in the IES format and control different aspects of the lights..
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An IES file has been loaded, the rotation has been changed. The Visible to Camera toggle is not available for IES lights. 
Use the Show in OpenGL toggle.

The intensity of a Photometric light is a percentage based on the data contained within the IES file. The value 
can be changed for artistic effect. The shadow size can also be changed by scaling the light.


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Photometric Info provides information about the loaded light.

The Thumbnail Angle, Zoom and Distance settings in the Light Properties affect only the Thumbnail Preview window 
and do not change the display in Open GL or in a render. Often you will find you need to radically increase the Intensity 
of a Photometric light to better match real-world lights.

Show in OpenGL will turn on/off the Photometric light for OpenGL display in the viewport. If this is unchecked, the 
light’s “web” will disappear and only the small pill-shaped icon will show.

A wide variety of IES lights are available online. A search for “IES Lights” in a search engine should bring up a 
list of different lighting manufacturers offering IES files for their catalog of lights.


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Point Light

A Point light sends light out from a central location equally in all directions. Light bulbs, distant camp fires, and fireflies 
are good examples for Point lights. In a way, a Point light is the opposite of a Distant light. It doesn’t matter how you 
rotate a Point light since it casts light in all directions, but it does matter where it is located.
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Primitive Light

The Primitive Light takes the form of the object you ascribe it to. The light has no representation in OpenGL until 
attached to an object, whereupon it assumes a bounding box representation the size and shape of the original object 
used.

The light can simply emanate from geometry or the Sample Surface option can be used to take into account the 
geometry's surfacing. If you use sampled surfaces, the light color and intensity act as a multiplier for the object's 
luminous intensity and color surfacing
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Mangalore warrior, resurfaced with PBSDF and a Primitive light collar

FFX Primitive light

When using FiberFX for Primitive lights, turning off Normalize is usually required

Roughly recreating luminous surfaces with spherical or area lights will be faster than using the primitive light
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Spherical Light

The spherical light emits light rays from the surface of a sphere. The default size is 100 mm, but you can edit the size in 
the Properties to make it smaller or bigger. At a size of 0 m a spherical light essentially becomes a point light.
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The position and size of the spherical light are important, but, like the point light, not its rotation. For the example 
shown, the size is 0m on the left and .8m on the right.
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Spot Light

Spotlights behave somewhat like their real world counterparts, sending light out in a specified direction and size. 
Spotlights are probably have the most uses of any light available to the LightWave animator. Flashlights, car headlights, 
and searchlights are all good examples of Spotlights.
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Spotlight size 0 and .5m

As you might have guessed, a Spotlight can project light onto objects using a cone of light. The size of the cone is 
determined by the Spotlight Cone Angle and Spot Soft Edge Angle values.

The Spotlight Cone Angle determines the width of the cone of light. It is equal to the angle from the edge of the 
Spotlight to an imaginary line projecting straight out from the middle of the light source. So a 30° Spotlight Cone Angle 
actually defines a 60° arc of light.

The Spot Soft Edge Angle determines the width of the falloff zone from the illuminated cone to the Spotlight edge. It is 
equal to the angle from the Spotlight edge to the line projecting straight out from the spotlight. Within this area, the 
spotlight slowly fades away to no light, thereby creating a soft edge.
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A Spot Soft Edge Angle of 0° creates a Spotlight with a hard edge, while a setting less than or equal to the Spotlight Cone 
Angle creates a soft-edged light.

Virtual Projector

Another cool feature of Spotlights lets you use the light to project an image onto an object, much like a movie projector. 
You select the image to project from the Projection Image pop-up menu.
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Spotlight Viewport Display

You can manipulate how Spotlights display in Layout. First, when you selected the Spotlight Cone Angle, it is 
represented by lines emanating from the light. If you interactively adjust the cone angle the shape of the lines will 
expand and contract.

If you use the Light View mode (on a Viewport’s Display mode menu or Numpad 5), you see a circle that represents the 
Spot Cone Angle. If you adjust the Spot Cone Angle in this view, the circle remains the same size. As such, it looks like 
you are zooming in/out.

The projected image will not conform to the circular shape of the cone angle. To do this, you could place a 
cookie-cutter object (e.g., a flat box with a round hole) in front of the spotlight or use a paint package to edit 
the image and fill the unwanted area with black.


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Spotlight moved to give better angle on skull
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SunLight (Hosek-Wilkie)

This light is based on papers written by Lukas Hosek and Alexander Wilkie, the current best approximation of 
atmospheric light scattering. As such, it is a Distant-type light whose position is irrelevant but whose rotation is all-
important. It can be used with the Sun Spot motion Modifier for accurate positioning around the Earth, given a specific 
location, time and date.

Surface Albedo - Reflectance color from the planet. The default value of blue has been set because our planet is 
mostly water
Turbidity - The reduction in the transparency of air because of scattering of light by dust and smoke particles 
and water droplets. Increase the turbidity to make the atmosphere denser - more hazy. Great for recreating LA 
sunsets
Scattering - The scattered color of the sky itself
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Max Luminance - Function added for tone mapping the final result. This will tone down the brightness value of a 
star to better match the rest of the scene
Temperature - The temperature in Kelvin of the sun's surface
Size - The default size of 5.0 is designed to replicate our sun
Samples - How many samples to use for this light
Volumetric Distance - the distance the volumetric effect reaches from the ray
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Light Properties
Click here to expand Table of Contents...

Light Color and Intensity
Node Editor

Input
Light Shader

Basic Tab settings
Light Display Size
To add a light
To Remove a Light
To Adjust a Light’s Properties

Shadows Tab
Shadow Type
Shadow Color

Objects Tab
Video

Light Color and Intensity

The Light Color setting on the Light Properties Panel modifies the color for the current light.

 

Distant and Area lights

Current Light - The currently selected light in Layout. Using the dropdown will present a list of scene lights. 
Lights can be renamed in the Current Light field
Light Type - Choose the type of light you wish to use. The options below this light choice might change 
depending on the light chosen
Light Color - What color your light shines with
Light Intensity - lets you set the brightness for the current light. This value is in Lux (Lumen^m2). The E button 
next to this value can change it over time
Intensity Falloff - All lights apart from Distant, Environment, and Photometric have falloff and it is set to Inv 
Distance^2 by default. It can be set to Off and the Node Editor just below can be used to create falloffs that 
would never be feasible in the real world.


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Light intensity is additive, so if multiple lights hit a surface, their intensities are added together. As such, too high a Light 
Intensity value tends to wash out a scene, particularly when you have multiple lights. Eventually, the rendered image 
becomes solid white when the values of light sources exceed a certain brightness.

Node Editor

The node editor in the Light Properties window has two nodes already present when you open it, as shown. They are:

Input

Provides Direction (Vector) and Distance (Scalar).

Light Shader

Luminaire Color - Colors the light when visible to the camera
Illumination Color - The color of the light emitted by the light item
Volumetric Color - The color of volumetric rays

All three can be hooked up with different elements or all use the same for complete control over the appearance and 
effect of a light

All lights have an intensity of 3.14 lx and an Intensity Falloff when added. The Distant, Environment and 
Photometric lights have no Falloff.


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Basic Tab settings

Not all settings below are on every light type:

Affect Diffuse - Deactivate to prevent a light from affecting the general color or brightness of a scene. This is 
particularly useful when you add lights to a scene for creating specular highlights. Often you want a light that 
creates a nice specular highlight on a surface, but you don’t want it to affect the rest of the lighting.

Affect Specular - Deactivate to prevent the light from creating specular highlights; the light still affects the color 
and brightness of the scene, however. This is very nice for adding lights in a scene to approximate the look of 
radiosity. A scene often needs a very high number of lights to give it the appropriate realism and warmth. 
However, adding too many lights can cause objects with a high Specularity setting to reveal the light’s presence 
with multiple hot spots. By disabling specularity for these lights you can overcome the problem.

Affect OpenGL - This option is for display purposes only. It will not change the effect a light has on a rendered 
image. With this option you can prevent the light from affecting Layout’s display, which uses OpenGL. This is 
important since the number of lights that can affect an OpenGL display is usually limited to 8 depending on the 
graphics card (if your card supports more, see the GL options tab of the Preferences Panel to increase your 
maximum).
Lens Flare - Engaging this toggle makes the Lens Flares options panel available.
Affect Volumetrics - This switch determines which, if any, scene lights affect volumetric effects. You need at 
least one for volumetrics to work.
Volumetric Samples - How many samples will be used for volumetric effects on a per-light basis.
Samples - The number of samples to use for the selected light.
Image - Applies an image to a light as a projector. With lights other than Spotlight, the image will tint the color of 
the light emanating. With a spotlight, the image will be recognizably projected.
Portal - This turns the light into a concentrator, rather than a light in its own right. It is used for filling openings, 
like windows, for directing outside light into the room.

Use powers of 2 for ANY sample setting.  LightWave does a better job with 2, 4, 8... 256, 512, 1024, etc.
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Light Display Size

Now that lights have a scale of their own, the old system of lights being displayed on the Layout screen in a size relative 
to the Grid no longer works. Lights retain their scale much like objects. Cameras do still scale with the grid. Also, the 
true light source is actually located at a center point within the visual representation of the light. For lights that can be 
resized (Linear, Spherical, Spot in the Properties panel; Area and NGon using the Size tool) the visual representation of 
the light indicates its size.

To add a light

Choose Items > Add > Lights and select the desired light type from the dropdown.

You can also select Light mode and use the Viewport Options menu Match Viewport Perspective item to move an 
existing light to look in the same direction as the Perspective view, or add a new light that does. The new light will be of 
the same type as the light that is active.

To Remove a Light

Select the light and choose Items > Delete > Clear Selected or Clear All Lights, or use the keyboard shortcut -.

To Adjust a Light’s Properties

Select the light and open its Properties Panel (P). If the panel is open, you can choose different lights to adjust using the 
Current Light pop-up menu.

A dialog prompts you for a name when you add lights. Click OK or hit Return if you wish to accept the default.
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Shadows Tab

In LightWave, the light goes through objects unless the light is set to generate shadows. So unless you use a light with 
Intensity Falloff, the light will continue on forever. By default, LightWave engages Intensity Falloff.

When a light generates shadows, it respects objects that block the beam, which keeps the light from continuing on its 
merry way. A shadow is created when you have a lighted area next to an unlighted or partially lighted area.
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With Shadows Inactive or RayTrace Shadows in the Render Properties > Render panel turned off

Say you have a scene containing a house with a fully-detailed interior. Without shadows, if you have a light emulating 
the sun, its light always affects the interior of the house, even if you position the light itself outside the house.

In order for an object to cast ray-traced shadows onto other objects, it must contain polygons that face the object 
receiving the shadow. In other words, the surface normal of a polygon must face the surface receiving the shadow. This 
is rarely a problem with solid objects, but if you cast shadows of flat planes, and do not see a shadow, make sure to use 
the Double Sided surfaces attribute or build the object with polygons facing both ways.

The Cast Shadows option on this tab allows a light to cast a shadow, whether Visible to Camera on the Basic tab is on 
or off.
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For this example, here are two lights - a Distant and an Ngon - with the distant light being strong. The Light Properties 
panel shown is for the lower, Ngon light

Shadow Type

You initially set lights to generate shadows via the Shadow Type  setting. By default, any light added to a scene has its 
Shadow Type set to Ray Trace. Ray tracing a light produces accurate shadows. Distant, Point, and Spotlights produce 
ray-traced shadows with hard edges unless they are sized above 0. Area, Linear, NGon, Photometric and Spherical lights 
produce ray-traced shadows with physically accurate shadow edges that are hard near the object casting them and 
softer further away. 

Shadow Color

A Shadow Color setting is available on the Light Properties Panel. If a shadow-casting light uses the default black color 
(0, 0, 0), it will have no direct effect on areas that are blocked by opaque objects. This matches the behavior of previous 
versions of LightWave (and the real world). Using colors lets you tint shadows without having to adjust ambient lighting.

The original light color dissolves into the shadow color as the amount of shadow increases from zero to 100%. To 
change the density of shadows without tinting them, set the Shadow Color to be the same as the Light Color (Light 
Properties) and then adjust the Shadow Color value (using the HSV colorspace controls).

Objects Tab

You can exclude any light or lights from the shading of any object. Simply click in the Exclude column to activate the 
exclusion.

Turning Cast Shadows on in the Shadows tab makes the light behave like an object casting a shadow created 
by other lights in the scene. Turning Cast Shadows on for a light is basically turning the light into a light 
blocker


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You can also exclude or include all lights in the objects properties panel or all objects in the lights properties panel or 
invert your selection by right-clicking on the Lights heading.
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Video

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=Cr1PC0iI3IE

https://www.youtube.com/watch?v=Cr1PC0iI3IE
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Lens Flares
Click here to expand Table of Contents...

Introduction
Lens Flare Options
Lens Flare Viewport Preview
Fade and Dissolve Options
Glow Options

Lens Streaks
Lens Reflections

Introduction

LightWave was the first professional 3D package to incorporate lens flares into its arsenal. Simply put, a lens flare is an 
artifact that appears in the lens elements of a camera when you aim it toward a source of light. It is by all definitions a 
defect-a limitation of the camera lens. However, by imitating this defect, you can add the realism of using an actual 
camera to LightWave animations.

You use lights to position lens flares since lights cause them. Lens flares are implemented as a light property. You can 
use any type of light; however, Linear and Area lights will generate only a single lens flare, as do the others. The light 
retains all of its normal lighting functions, but when it appears within a frame, a lens flare is generated.



While LightWave’s lens flares are easy to use and the effect is often very appealing, remember that lens flares 
are an artifact that most film and video directors try resolutely to avoid. Judicious use of lens flares can 
enhance your work, but overuse can quickly detract from it - qv JJ Abrams’ work.


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1.
2.

Understand that lens flares are an additive effect, which means they are added to a rendered image after LightWave 
calculates the scene’s appearance. Because of this, you can accidentally create too many flares, or flares so hot that 
they wash out other items in the scene. Of course, this may be a desired effect, such as when a large explosion takes 
place.

Since lens flares are an additive effect, they will not show up in an alpha channel saved image.

Moreover, since flares theoretically exist only in the lens of the camera, they will not show up in any reflections or 
refractions in an object’s surfaces.

Lens Flare Options

The central glow of a lens flare light source is white, while the glow around it is tinted by the light’s Light Color. Unlike 
real lens flares, LightWave gives you tremendous control over how your flares look. Additionally, since lens flares are 
used by LightWave animators for more than camera lens artifacts, there are some options that help the flares look more 
like real physical phenomena, like fire, glowing, and explosions.

To set up a lens flare:

Select the light.
Click Lights Properties Panel > Lens Flare to turn the option on for the selected light.

Make sure that Lens Flares is enabled on the Render tab in the Render Globals Panel or LightWave will not 
create lens flares.



You can add lens flares to the alpha channel of your render by adding the Flare2Alpha LScript to the Image 
Processing > Image Filters window.


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3. Click Lens Flare Options and set the options as desired.

 

Lens Flare Viewport Preview

You can see an approximation of your Lens Flare settings in any viewport using the Camera view. You must activate the 
OpenGL Lens Flare option on the Display Options Tab of the Preferences Panel (Edit > Display Options). Note that this is 
just an approximation of how the actual lens flare will appear and the actual rendered effect will likely be somewhat 
different.
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Fade and Dissolve Options

Flare Intensity sets the brightness of the lens flare. The default value is a good starting point.

Fade Off Screen - For when you want a lens flare light source to reduce its flare intensity automatically as the 
light source enters or exits at the edge of the screen. This simulates the properties of actual lens flares within a 
film camera. When this option is not active, the lens flare will remain constant as it moves off screen. ( On by 
Default )
Fade In Fog - For when you want a lens flare to automatically reduce its flare intensity as it is affected by the 
minimum and maximum distances set for fog on the Effects Panel’s Volumetrics Tab ( Windows > Volumetrics 
and Fog Options ). The further into the fog the lens flare is, the less bright it will be. Once past the maximum fog 
distance, the lens flare is completely dissolved by the fog. If Fade in Fog is not selected, the lens flare will remain 
bright no matter how far away it is. ( Off by Default )

Not all lens flare options can be seen in the preview, so you need to do test renders or use VPR in final mode.
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Fade Behind Objects - Select when you want a lens flare to reduce intensity automatically as the light moves behind 
other objects in the scene. This simulates the properties of actual lens flares within a film camera. Flares even 
change color when passing behind stained glass windows with the Fade Behind Objects option, which uses ray 
tracing to determine when lights are obscured by objects. If you do not select this option, flares will appear through 
objects. ( Off by Default )

 

Left: Normal Flare Settings, Right: Fade Behind Objects selected

Fade With Distance - Selecting this will automatically fade a lens flare as its distance from the camera increases. 
If you bring a flare closer to the camera, it grows brighter. ( Off by Default )

The Nominal Distance field, active only when Fade With Distance is selected, is the distance from the camera 
where the flare is at its input intensity. For instance, if your Flare Intensity is 100%, and your Nominal Distance is 
10 meters, moving the flare to a distance of 20 meters causes the intensity to drop to 50% (at twice the distance 
it drops to one-half the brightness). Conversely, at half the distance, 5 meters, it climbs to twice the intensity, 
200%.
Flare Dissolve - Enter a value to adjust the transparency of the lens flare effect. This option is handy when you 
wish to see large streaks of light coming from the lens flare but do not want a bright hot spot at the center of the 
flare. The higher the Flare Intensity, the larger the streaks (if selected), and the brighter the flare. Flare Dissolve 
values below 0% or above 100% are not useful, since the flare is either fully visible or fully invisible and cannot 
be more so.

Glow Options

The second section of the panel is devoted to Glow options.

Central Glow - is a glow of light at the center of the light source flare. This is the color of the light source. Red 
Outer Glow is a luminous, soft-edged red glow around the light source, available only when Central Glow is 
active. You may want this option off for deep undersea environments, where the color red is not visible. ( On by 
Default )
Glow Behind Objects - simulates a glow that surrounds a light source. This effect is different from that of a true 
lens flare, and should not be confused with that effect. A true lens flare is a phenomenon that occurs within the 
camera lens and thus appears to be in front of all objects in a scene. When the light source that causes the flare 
is obscured by objects between it and the camera lens, the flare fades or disappears depending on whether the 
light is partially or completely obscured (an effect that is handled by the Fade Behind Objects option). ( Off by 
Default )
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Glow Behind Objects is designed to simulate glows physically located at the light source rather than within the 
lens. These glows are caused by the illumination of a medium surrounding the light (such as murky water or 
foggy atmosphere) as opposed to true lens flares, which are caused by diffraction and reflections among the 
glass elements inside a lens assembly. Unlike true lens flares, glows, at a distance, can be partially visible even if 
the light source itself is obscured.

  

Left: Normal Flare Settings, Right: Glow Behind Objects selected

Central Ring - is a small ring of light, like a halo, surrounding the light source. The Ring Color option controls its 
color. The ring’s size is set by the Ring Size value, which defaults to 22%.

Anamorphic Distortion - causes the lens flare to stretch horizontally. This simulates the effect of the wider lens 
flares you see in motion pictures filmed in Panavision. The Distortion Factor acts as an aspect ratio control. The 
height of a flare is determined by its Intensity setting and proximity to the camera. The relative width of the flare 
is determined by the Distortion Factor.

The default value, 1.77, sets the flare’s width at 1.77 times the flare’s height. A default value of 3 causes the 
flare’s width to be three times wider than it is tall, and so forth. The higher the value, the more elongated the 
flare. To distort the flare vertically, enter a value less than 1. The lower the value, the taller the flare.

Use an enveloped Ring Size for shock waves or other similar anomalies.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  433

•

Lens Streaks

The Lens Flare panel divides in two at the bottom. The first is the Streaks tab.

Star Filter - this is a pop-up that lets you choose the number of points on the star-shaped streaks that emanate 
from the flare. The + n secondary options add in-between minor streaks. You can rotate the streaks with 
Rotation Angle . Positive values rotate the streaks clockwise as seen from the camera. Negative values rotate the 
streaks counterclockwise.
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Off Screen Streaks - allow lens flares that move off the visible screen area to continue to cast occasional streaks 
across the LightWave camera and into the scene.

Anamorphic Streaks - are elliptical horizontal blue streaks emanating from the lens flare light source. This 
simulates the effect of similar streaks seen in motion pictures filmed in Panavision.

The Random Streaks options adds dozens of tiny random streaks of light emanating from the light source. The 
intensity of these streaks is governed by the Streak Intensity, which is a percentage of the brightness of the lens 
flare. The higher the value, the brighter and larger the streaks. The default value of 3.0% produces streaks that 
closely match those found in film.

Streak Density - sets the number of random streaks. The number you enter is used as a rough approximation to 
determine the actual number of streaks, but your results will be close to the value entered. Higher values make 
for more streaks.
Streak Sharpness - determines how defined the random streak edges fall off and blend into the background. Low 
values blur the streaks together, making for softer, wider streaks. Higher values create very distinct streaks. The 
default value of 6.0 closely matches streak effects found in film.

You must activate Fade Off Screen to use Off Screen Streaks.
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Lens Reflections

The Lens Reflections option adds reflections of light in the LightWave camera, as if it were shooting the scene through a 
standard camera lens assembly. This effect emulates the multiple lens elements that make up a typical lens. Such flares 
commonly occur whenever you aim a camera at an intense light source.

If either the light source or the camera is moving, then the reflections will move across the screen also. This can be a 
dramatic effect.

The Polygonal Element Shape will change the shape of the reflections. The sided settings simulate lenses with n-blade 
irises. Since there’s just one iris per lens on a real camera, all polygonal reflections in a particular flare have the same 
shape. Settings are global for the scene, which means that different lights can’t have different patterns.

A very low Streak Sharpness value (like .0001) will blur the streaks into each other to create a glow-like effect.

To get the most visibility out of Lens Reflections, place the lens flare light near the side or corner of the 
camera’s view.


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Some of the available Shapes

You can modify the default Element Type, Element Position, Element Size, and Element Color for each of the sixteen 
reflection elements. To edit an element, first select it using the Current Reflection Element  pop-up menu. The elements 
are aligned in a straight line going through the center of the camera’s view through the light.

By default, the Elements 1 through 16 are aligned starting near the light, then through the center and on to the opposite 
side. However, each element’s position could be anywhere, if you want it to be. An Element Position of 0 is at the center 
of the screen, 1 at the light’s position and -1 on the opposite side. You can use values beyond 1 or -1 to move elements 
past those positions.

Element 15 (Yellow) Left: Position = -1, Middle: Position = 0, Right : Position = 1

An Element Size of 100% vertically fits the element to the camera resolution. It can be clipped or there can be space to 
the left and right, depending on the relative Camera Resolution Height setting.

The Element Type setting determines the shape and density characteristics of the reflection.

   

Circle- Bright Center, Even Center, Dim Center , Circular- Ring

     

A reflection using a Bright Center Element Type will not be the same size as the Even Center.
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Polygon- Bright Center, Even Center, Dim Center, Rainbow Ring

If you select a Polygon Element Type, you should also choose a shape other than Circular as the Polygonal 
Element Shape.
The viewport display will not show all lens reflection attributes.


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Luxigons
Luxigons are very similar to Powergons, but are specialized just to add lights and set certain light properties. To use, in 
Modeler select the desired polygons and choose Setup > Layout Tools > Add Luxigon. When the dialog appears, select 
the type of light you wish to add and set its properties.

Next, load the object into Layout and choose Items > Lights > Convert Powergons. After you click, the light type defined 
will be created, positioned at the center of the appropriate polygons, aligned with the polygon’s normal, and parented 
to the object.

You can clear Luxigons from selected polygons using the Setup > Clear Powergons command.
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Camera
Click here to expand Table of Contents...

Introduction
Multiple Cameras
Matching Perspective to Camera or Light View
Independent Viewport Cameras and Lights
CameraSelector
Perspective Match

Set Background Image
Numeric Panel
Example - Perspective Match

Camera Types
Camera Settings

Introduction

Image courtesy Kevin "Q" Quattro, Inhance Digital

The camera is the conduit for your imagination to a final image. When creating your render you need to decide what it 
will be used for, what its destination will be. Will it be an image for film or broadcast, print or computer screen?


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Whatever your image’s destination, there are two defining characteristics for it. One is how big it is, the other is the 
shape of the pixels that make it up.

You can make all these decisions in the Camera Properties window, which will appear when you pick a camera and hit 
the P button on your keyboard, or the Properties button on your LightWave screen.

Multiple Cameras
You can have as many cameras as you like in a scene. However, you can only render the current camera view. You add 
extra cameras into the scene by clicking on the Items > Add > Camera button, you can clone existing ones (with Ctrl-C) 
or you can use the Perspective view’s Viewport Options menu to Match Viewport Perspective to a selected or new 
Camera (or light) as shown below. If you have more than one camera in a scene, you can choose the camera you wish to 
be active, when in Camera mode, either in the Camera Properties Panel or the Current Item button under the main 
Layout window.

Matching Perspective to Camera or Light View
It’s often easy to set up what seems like a really good camera angle in the Perspective viewport and duplicating it in-
camera isn’t as simple. Layout can match your Camera or Light View to your Perspective Viewport. You need to have 
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your current Camera (or Light) selected at which new options become available in the third Viewport dropdown menu 
as shown:

You can choose to either copy the Perspective view’s orientation to the current camera (or light) or clone it and create a 
new one to which the Perspective view is copied.

To exactly match the Perspective viewport’s perspective, you should set the Camera’s Lens Focal Length to 30 
mm instead of the default 24.0 mm


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Independent Viewport Cameras and Lights

You can have multiple views from different cameras or lights, making setting up multiple viewpoints easier without 
needing to constantly switch between views. The above viewports show three different camera angles and a light view. 
When you switch between views you can always continue to use the current light or camera, or you can choose specific 
lights and cameras from a sub-menu.

CameraSelector
This Master plugin allows you to switch between different cameras in Layout. The current camera is still the one being 
rendered but this can be used to preview camera switches in-scene or in a Preview.

Hitting F9 will render the Camera marked as Current Item in Layout
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To access the CameraSelector, click on the Master Plugins button in the Utilities Tab. This will bring up a window with a 
drop down menu in which you can select CameraSelector. Double clicking on its entry in the Master Plugins list window 
will open the CameraSelector plugin’s window. To create a list of camera changes all you need do is to scrub through 
your scene selecting the camera you want for each shot. Simply click on the Add button in the CameraSelector window 
for each camera change you wish to take place. If you then start playing your scene, you will see that the camera 
switches at the time you stated. If you wish to remove a camera change, select the change you want to get rid of and hit 
delete in the CameraSelector window.

If you would like to see your scene play through just one camera view, you can turn off Camera Selector by clicking the 
Enable Dynamic Preview switch, during scene playback.

For CameraSelector to work its magic, it needs information not normally available to master plugins. This is why it 
automatically creates a null object called “SpecialTriggerNull” whose only purpose in life is to serve CameraSelector. If 
you wish to use a different object, you can select it on the Trigger drop down menu but, normally, there is no reason to 
do so.

Perspective Match
Perspective Match can be found on the Render tab of Layout. It enables the matching of the perspectives of a 
background image to Layout’s setup to make compositing still images containing real-world elements and computer 
graphics much simpler. In order to make use of it, you will need a digital photo that can be used as a background image, 
preferably with some obvious vertical, horizontal and depth lines that can be used for alignment.

Set Background Image

Although this is a separate tool and Perspective Match can be set up manually without it, Set Background Image 
automates things to a large extent. Choose the image you wish to use from those already loaded or load a new image.

Match Camera Frame Size to Image - Will match the pixel size of the image used.
Set Background Image Options - Will place the image chosen in the Effects > Compositing > Background Image 
field.

This script cannot pull data from the EXIF information in the picture. If you want to get the best possible 
match, then use the Real Lens camera and pull EXIF data that way, including lens focal length and Field of 
View. That said, Perspective Match does a very good job as it is.


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Numeric Panel

Perspective Match has a GUI panel which pops up with the n key (or whatever shortcut you have the Numeric command 
linked to). It has the following settings and options:

Lock - what value to lock to solve for the perspective amount

Zoom Factor - keeps zoom factor fixed, changes film size
Focal Length - changes zoom factor and film size, keeping focal length fixed
Frame Size - frame size remains fixed, changes zoom factor

Origin - when on, places a gizmo in the scene with which you indicate where the world origin should be. This 
moves the camera in X and Z.
Height - to solve for the camera Y position (in essence, scene scale)

(Fixed Height) - leaves the camera at its current height.
Height From Floor - adds a gizmo with which you can indicate the vertical height of something in the scene as 
measured from the floor (the XZ plane). Supply the height value in the provided widget.
On Floor - adds a gizmo with which you can indicate the length of something in the scene as measured on the 
floor.

So if you have a person in the scene with a known height, use “Height From Floor”, enter the person’s height, 
and set the gizmo from their feet to the top of their head. Note that the direction of this gizmo does matter: the 
flat end should be on the floor, the arrow at the other end.

On the other hand, if for example you have a ruler lying on the ground (or on a table, or whatever horizontal 
surface you want to place the XZ plane on), the use the “On Floor” option. Enter the length of the ruler, and place 
the gizmo along the ruler (which end goes where does not matter).

Swap XZ - swaps the X and Z indicators, because sometimes you change your mind what the X and Z directions 
should be in your scene. Effectively it spins the camera around by 90 degrees.
Reset - resets the gizmo positions to their default.
Solve More - runs the solver a few times every time you press the button, in case it hasn’t converged to a good 
solution completely yet.

Example - Perspective Match

If you use a huge image with Set Background Image you might need to add it to Effects > Compositing > 
Background Image yourself if the image isn’t made available to the script in time.


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Camera Settings
Click here to expand Table of Contents...

Resolution
Maximum Render Resolution
Constrain
Overscan
Aperture Height (Frame)
Frame Aspect Ratio

Camera Settings in a Viewport
Rendering a Limited Region
Memory Considerations

Anti-Aliasing
Shading Samples

Motion Effects
Rolling Shutter and Motion Blur Bias
Example - Rolling Shutter
Stereoscopic Rendering
Depth of Field (DOF)

Resolution

The Resolution drop down menu will present you with a series of pre-defined resolutions to choose from for your 
render. It will automatically set the Width, Height and Pixel Aspect ratio fields.


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Maximum Render Resolution

The maximum render resolution for 32-bit versions of LightWave was limited to 16,000 x 16,000 pixels. Machines 
running LightWave since v2018, only available as a 64-bit version, can render images up to 100,000 x 100,000 pixels 
given enough memory. Bear in mind that 100k x 100k is an extreme size. Just a blank image at this size requires around 

You can add your own presets to this list, but it requires you to delve into the LW2019.cfg file. If this thought 
doesn’t scare you, then we’ll proceed.

If you look in your LW2019.0-64.cfg (Layout 2019.0 on Mac) file you see that near the top there are several 
lines that look like this:

ResolutionPreset 1920 1080 1 HDTV (1920 x 1080)

The first two numbers are the size of the frame; the next one is the pixel aspect ratio. The last bit of text is the 
title of the preset that will appear in the drop down menu.

Feel free to make your own lines. For instance here’s one you may wish to add to get the ball rolling:

ResolutionPreset 2480 3508 1 A4 page (300dpi)

As you can tell from the title, this Resolution Preset gives you a full A4 page at 300dpi. The width and height 
fields can be set to anything between 16 and 100,000. Be aware that larger resolutions can make serious 
demands on the memory of your machine.

The Resolution Multiplier gives you a much more consistent way of quickly checking a scene rather than 
changing the width and height fields when you want a small test render. It takes into account the scaling of 
things such as particle, line, and edge thickness, as well as the glow radius.

If you have selected a resolution preset and you alter the width or height fields, it will override any preset and 
the menu will then show the word Custom. If you have already set a resolution multiplier, it will then operate 
on the Width and Height settings you have chosen.

The resolution multiplier does not scale an image after it has been rendered. Therefore, it can be used in a 
situation where the boss asks for an image about “two-thirds as large again.” Deciding which resolution to use 
on a project is largely down to its intended use. An image for broadcast can almost always use the appropriate 
PAL or NTSC resolution presets. An image for print will always vary depending on the size of the final image, 
whereas film is usually one or two size settings.

Both provide high-resolution images that can take a long time to render and a lot of memory. If, however, you 
are rendering an animation for display on a computer, you will often want to use a lower resolution for reasons 
such as the running speed of the final animation and its file size.



Print Assistant

If you are working with print a lot, you should use Print Camera. This gives you a range of standard 
page sizes, adds Bleed, sets DPI/PPI and gives you a preview of your page.


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149 GB of memory - 100k x 100k x (RGBA @ 4 bytes per channel = 16 bytes)/(1024 x 1024 x 1024) = 149 GB). Also, anything 
above 30,000 x 30,000 pixels won’t load into versions of Photoshop older than CS4.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  450

Constrain

Often you will want to increase the size of your render but keep the same picture aspect ratio. The Constrain check 
keeps the Width and Height values in same proportion, which ever you change. You can uncheck the Constrain gadget 
and recheck it to change the aspect ratio of your rendered image.

Overscan

You can set the overscan amount in pixels or in percent and the relations will be kept as you change.

  

The overscan amount will be added to each side and displayed in the viewport as a lighter overlay than the normal 
frame overlay. You cannot extend a Limited Region into an overscan area.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  451

Once you’ve been using a computer for a while you forget that pixels actually come in different shapes. Ones for NTSC 
TV are tall and thin; ones for PAL TV tend to be a bit fatter, while ones for print and HDTV are the same as those for 
computer screens – square as square can be.

The Pixel Aspect Ratio setting in LightWave is calculated by dividing the width of a pixel by its height. A pixel intended 
for print or a computer screen is square, as we said, so its aspect ratio is 1.0. Because NTSC pixels are taller than they 
are wide, the aspect ratio tends to be between 0.86 and 0.9. PAL ones, on the other hand, tend to vary between 1.01 and 
1.06. Values for widescreen displays are considerably wider in both NTSC and PAL.

Why worry about the pixel aspect ratio? After all a pixel is a pixel, right? Well yes, but if you look at a perfectly round ball 
that has a radius of 50 cm and you are using an NTSC resolution preset, the ball will look squashed on a computer 
monitor, whereas it will look perfectly round on your NTSC monitor. When selecting one of the resolution presets you 
will notice that the pixel aspect ratio changes along with the resolutions for width and height. As for things looking 
squashed or stretched on your computer monitor, I’m afraid it’s either something you’ll have to get used to, or you will 
need an output to a proper broadcast monitor to reassure yourself.

Aperture Height (Frame)

You can change the aperture height, or Frame, of your virtual camera in LightWave to match the optical characteristics 
of a real world camera, especially for film work. Changing this setting will only affect the Depth of Field effect and the 
lens focal length.

Frame Aspect Ratio

Before we move on, don’t confuse the pixel aspect ratio with the frame aspect ratio figure, often referred to simply as 
the aspect ratio. The way to work this out is to take the pixel width of a picture, divide it by the pixel height and multiply 
the result by the pixel aspect ratio. As an example, a standard VGA screen is 640 x 480. This equates to a frame aspect 
ratio of 1.333, which is the result of the following sum (640/480)*1 and converting it to a ratio. You will often see this 
figure quoted on the back of DVD cases to indicate the width of the display compared to its height (which indicates how 
much of your TV screen will be covered by black bars).

Camera Settings in a Viewport

When you use the camera view (numeric keypad 6), areas of the viewport that are outside the render area will be 
colored with the overlay color chosen in Display Options (D). You can have horizontal bars showing the exclusion or 

Aperture Height is always listed in inches, even if you are using a metric unit system.
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they can be vertical bars, depending on the frame aspect of the render you are making (in the image below 
demonstrating this we are using a monitor with a resolution of 1920x1080 and rendering an image at 1280x720).

Furthermore you will be able to show safe areas for overscan and underscan displays by turning on the Show Safe Areas 
switch in the Display Options (D). You will also have a grid displayed to allow you to better divide up the frame by 
selecting Show Field Chart.

If you are using a view other than the camera view, you will see the camera represented on-screen together with a 
pyramid showing its field of view. This pyramid is only shown when the camera is the selected item.
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Left Camera view, Right: Camera View with Safe Areas and Field Chart

Perspective view

If you are using an orthogonal projection and you have Show Fog Circles option switched on in the GL tab of 
Preferences (O), you will be able to see the area around the camera affected by fog. If you press Ctrl- P and choose a fog 
type from the Volumetrics tab while in a top view mode, for example, you will be able to see circles around the camera 
indicating a minimum and maximum fog radius around the camera.
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Top view, with Fog circles

Rendering a Limited Region

You can render a limited rectangular region of your scene if you only wish to test your work, rather than taking the time 
to render a full image. Limited Regions are also useful if you would like an accurate representation of your final frame in 
VPR, rather than the whole viewport. As an added benefit, it will speed up rendering, not having to render pixels that 
will not be in the final frame. Simply hit the L key and you will see that a dotted line will surround the renderable area of 
the frame. You can change the size and shape of this area by clicking and dragging the left mouse button on one of the 
dotted lines that surround the area.
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Above: What Layout looks like, Left: Render Limited Region Borders, Right: Render Limited Region No Borders
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Borders, no Borders

There are two different types of limited region that you can use, either with or without borders and you cycle through 
these choices by repeatedly hitting the L key or by choosing the drop down menu in the Render Globals window. The 
difference between a limited region with a border and one without it is the fact that a limited region with a border puts 
your limited region on a black page the size of a full render, whereas a limited region without borders will just render 
the shape you desire as the full image. The frame aspect ratio in Camera Properties will remain at the aspect ratio for a 
full frame, but all other options, such as antialiasing and Masks still apply.

The limited region with border allows you to “patch” only a segment of a frame, rather than having to re-render the 
whole frame for re-compositing. This can be a major time-saver.

Memory Considerations

Limited Region allocates only enough memory to render the horizontal limited region area. If you stitch parts of an 
image together, you can effectively render images that are much larger than those you could render one pass. This is 
especially useful for high-resolution print images or in low memory situations. However, note that some post-
processing filters require a full-sized image. In such cases, you may be able to apply those filters to the “stitched” image 
in an additional step. The way to do this is to take your final rendered image and save it to disk. Then clear your scene - 
or better yet, quit and restart LightWave – and load this image into an empty scene. Make it the camera backdrop and 
add whichever post-process filter you wish to use, and then render again. Since you aren’t rendering all the objects, 
textures, Image Maps, etc., the memory requirements will be a lot lower.

If aliasing (the stepping effect on diagonal lines seen when image resolution isn’t high enough) is the crime, then anti-
aliasing is the cure. Aliasing occurs because a pixel is rectangular in shape which means that there will always be a 
jagged effect with anything other than rectangular shapes. This effect can be reduced by working at high resolutions 
but cannot be removed. All image-processing programs, including LightWave, employ a device called anti-aliasing in 
order to reduce this stair-stepping effect. It compares the RGB values of two neighboring edge pixels and adds an 
average-valued pixel between them. This fools the eye into seeing a smooth line.

Anti-Aliasing

Overview of Controls

Shading Samples

To shade a pixel, LightWave needs to gather information about it. Shading samples define how many rays are fired to 
that pixel to determine its overall shading. Every pixel in the rendered image is hit by an initial ray fired from the 
camera; when a ‘hit’ occurs. If you have Shading Samples higher than 1, more rays are fired. The amount fired is set by 
the number of Shading Samples, so if you set it to 4, that many rays are fired. This process is repeated for each pixel if 
Minimum Samples is higher than 1, and is repeated as many times as set by the Maximum Samples in Camera 
Properties.

Lower numbers render faster at the expense of quality or noise in the image, the reverse is true for higher numbers.
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Motion Effects

Rolling Shutter and Motion Blur Bias

LightWave 11.5 added a rolling shutter to the Motion Effects settings for the camera. Working with footage that has 
been tracked in applications like Syntheyes can sync badly with CG-generated footage if the camera used is CMOS-
based (CCD-based cameras have no problem with rolling shutter). A rolling shutter offset helps with such issues and 
ensures that your tracked footage matches the CG you create in LightWave.

Subframes - controls the number of subframes used to create the motion blur streaks. For objects that are 
moving along curves, the more subframes, the smoother the streaks will appear. Motion is calculated as a series 
of linear steps currently. The default is 20 subframes to match previous versions. With the addition of multi-step 
deformation blur, calculating all the vertex positions 20 times a frame may be too slow for VPR. In addition, it is 
possible that users may need more than 20 subframes for animations with a great deal of motion.
 
Shutter Open - defines the time offset for the start of the render. If the Blur Length is set to 50%, a Shutter Open 
value of -25% will center the motion blur for each frame.

This is because a Blur Length of 50% is a half-frame’s worth of blur between the current frame and the next 
frame. A Shutter Open value of -25% would start the render a quarter-frame before the current frame. The 50% 
Blur Length would then carry the render past the current frame to end at a quarter-frame past the current frame, 
centering the motion blur.
Rolling Shutter - mimics the shearing distortion of a rolling shutter. Each horizontal line in the frame is 
progressively shifted forward in time, up to a maximum of a single frame’s worth on the bottom or top line. The 
positive or negative value of Shutter Skew determines whether the top or bottom get sheared forwards in time. 
At 100%, the bottom of the frame will show the positions of everything as they appear on the next frame. At 
-100%, the top of the frame shows the positions from the next frame.
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Example - Rolling Shutter

Stereoscopic Rendering

Depth of Field (DOF)
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Anti-Aliasing

On the Camera Properties panel, there are two main controls for anti-aliasing - Minimum Samples and Maximum 
Samples. If Adaptive Sampling is unchecked, Maximum Samples is ghosted and you only need to concentrate on the 
Minimum Samples value. When using only Minimum Samples, this is similar to the standard Anti-aliasing levels in 
previous versions of LightWave.

Minimum Samples

This value determines how many camera rays are generated per pixel. As the name suggests, this allows you to set how 
many samples are ALWAYS taken per pixel on the first pass of the image. When Adaptive Sampling is active, setting a 
higher minimum value will result in fewer Adaptive Sampling passes, because the image has already been through 
initial anti-aliasing. This does not always lead to faster renders; leave Minimum at 1 unless you are sure of what you are 
doing.

Maximum Samples

Available when Adaptive Sampling is on, this allows you to limit the number of samples LightWave will ever get to 
during the Adaptive Sampling process. Previously in LightWave, it was difficult to set a limit to this stage of the process, 
meaning that LightWave could keep on refining in the Adaptive Sampling stage, even when no more anti-aliasing was 
really needed, or visible. This can result in equivalent or improved quality at equal or faster render times than previous 
versions.

As with previous versions of LightWave, finding a good balance between render quality and speed is very scene 
dependent. You may need to experiment with the Maximum Samples and Adaptive Sampling Threshold on a smaller 
area of your scene using the Limited Region render.

You will probably need to massage your settings to get the best balance between speed and quality for your final image. 
Start by raising your Max Samples setting in Camera Properties to 16 and if you are using traditionally noisy lights or 
surfaces you might consider raising the Lighting and/or Shading Samples but slowly, perhaps to 2 or 3. Examples of 
noisy lights would any other than Point now since all other lights are sampled. Noisy surfaces would be things like 
blurred reflections or CarPaint - things that in previous versions would have had a Samples or Quality setting.

You should think of the Lighting/Shading Samples and Max Samples settings as being multipliers. For example, your 
Shading Samples are set to 8 and multiplied by the Max Samples setting in Camera Properties. If we imagine that you 
have set this to 16, then 16 x 8 would fire a maximum of 128 shading samples in total for every pixel of your image. If you 
also set your Light Samples to 8, you would have 128 shading samples and 128 light samples per pixel, and this starts to 
become quite heavy to render.
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Threshold

Threshold is the difference between the color values of neighboring pixels that triggers additional sampling. It is also 
used to see if additional sampling passes improve the pixel quality (variance) but that only is used when there is a high 
max adaptive samples. Only the final pixel color is used for the threshold. The additional buffer samplings are driven 
from the pixel color differences and the threshold.

Filter Radius

Filter radius is exactly that. It is the radius of the filter applied to each pixel sample. Each pixel sample is located 
somewhere inside the edges of a pixel (0-1 in x and y). The filter is a shape (for example a circle) that is used to blur the 
sample. This way a sample near the edge would affect both the pixel and one or more neighboring pixels. Typically you 
want a radius between 0 and 1 for the Filter Radius. Values larger than 1 are possible but are an inefficient way to blur 
your image - post-processing is far better. 0 means no filter at all.

Reconstruction Filters

The LightWave 3D renderer includes a full implementation of reconstruction filters. These filters determine how the 
rendering data is combined into a final image at a sub-pixel level in order to produce a final image. Reconstruction 
filters have been a subject of research over many years and the names of these filters are often derived from the 
research that led to their development. Reconstruction filters are not set on the Camera Properties panel, but rather per 
buffer in the Buffer tab of the Render Properties panel.

LightWave filters are outlined below:

Box

Adaptive Sampling is by necessity slower than straightforward anti-aliasing (AA) because LightWave needs to 
determine whether AA is necessary for any given pixel based on the Threshold and Filter Radius settings. It's 
there by default because it is more likely to give a good final result when in the testing phase, but should, 
ideally, be turned off for final sequence rendering.



Different buffers can have different filtering applied but beware of mixing different filters on buffers for the 
same render since it will be difficult and perhaps impossible to reconstruct a final image.


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This is the most common form of filtering, and the method that most traditional applications use to reconstruct an 
image from raw rendering samples. These samples are simply places in a pixel “box” and averaged. Although this 
technique is fast, it can exhibit significant artifacts on motion and when there is fine image detail. From a signal 
processing point of view, this is a very poor technique for reconstructing an image from the raw data that comprises it. 
This mode is very close to the traditional LightWave modes.

Circle

Based on Box, it uses a 6x6 matrix based on the Filter Radius size. Anything within the filter radius is given full 
importance. Anything outside is cut off.

Triangle

Based on a cone with filtering taking place on pixels in a 6x6 matrix.

Gaussian

Gaussian filter based image construction takes the samples that compose the image and builds the final pixel data by 
weighting their contributions based on a Gaussian kernel of approximately one pixel in size. This technique typically 
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performs quite well, although images tend to have a “soft” look. In practice this mode can be very valuable for video 
output where it can help hide some of the artifacts introduced by fielded or reduce bandwidth content.

Mitchell

Mitchell filtering is a technique that is now very popular and was suggested as an alternative to Lanczos filtering (see 
below). It does not suffer many of the ringing artifacts of Lanczos filtering and generally is a very good starting point for 
most situations.

LanczosSinc

Lanczos filtering is arguably the technique that yields the closest to the perfect results for image reconstruction. This 
technique is based on a windowed sinc function (a sinc function being the optimal infinite image reconstruction filter). 
Unfortunately in practice Lanczos image reconstruction tends to produce overly emphasized edges and “ringing” in 
high contrast areas of the image.

Additional Notes

Old scenes loaded into LightWave are not aware of the Minimum Samples and Maximum Samples settings, and 
therefore will be set to their defaults. This could mean that your old scene appears to render either slower or faster but 
noisy. You will need to adjust the values to suit your scene.

Due to changes in the way samples are generated, the Rays Per Evaluation and Secondary Bounce Rays in the Global 
Illumination panel are affected. This means in order to get similar results to previous versions of LightWave, you will 

Usage Tip

Box, Circle, Triangle and Gaussian may provide better results for moving images, whereas Mitchell and 
LanczosSinc may be more suited to stills due to their tendency to sharpen the image.


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need to increase these values, often doubling them. It won’t take any extra render time, but is needed to account for the 
differences in number of GI samples generated with the new system.

When the Use Gradient option is checked in the Global Illumination panel LightWave uses the old sampling method for 
Global Illumination only. When off then it uses the new sampling.

Anti-aliasing Using Edge Detection

By default, LightWave uses Adaptive Sampling (edge detection) to determine which areas of an image should be anti-
aliased. This focuses the anti-aliasing process primarily on the edges of objects. With Adaptive Sampling active, you can 
tell LightWave which areas to anti-alias by entering a sampling Threshold value. If the Adaptive Sampling option is 
inactive, LightWave will anti-alias the entire frame.

The adaptive sampling Threshold functions by comparing the brightness of two neighboring pixels. A value of 0 will 
anti-alias everything in the scene, but values between .0314 and .1255 work well in most situations - the higher the level, 
the fewer edges are detected and, thus, the lower the rendering time.

A value of 1 is the maximum brightness difference in a 24-bit color space; however, internally LightWave can work with 
pixels brighter than RGB 255, 255, 255. Since you might want anti-aliasing only when nearby pixels differ by more than 
1, the adaptive sampling Threshold can be set higher than 1. If you want to ensure that extra anti-aliasing is never 
performed, use a large Threshold value.
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Motion Effects

When using a camera to film fast-moving objects, these objects are often blurry. This is because they continue moving 
while the shutter of the camera is open. It is this feature that LightWave aims to replicate with Motion Blur.

Motion blur becomes essential when animating, especially for use with live action. It prevents the crisp quality that 
normally pervades computer-generated animation and helps an animation appear more fluid.

 

Use a camera view and see a preview of your depth of field and/or motion blur by choosing DOF/MBlur Preview from the 
Viewport Options menu.

LightWave’s motion blur system takes everything that can change over time into account. From shadows, to surfaces, 
from light intensities to object or camera movement. It accounts for curved motion and does not blur in a linear fashion, 
but rather following the path that the motion is taking.
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Motion Blur is now only a checkbox where there used to be a dropdown menu. The motion blur now proposed is 
Photoreal, first introduced in LightWave v9.2. Photoreal Motion Blur allows for multiple samples within each render 
pass.
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Left: a Particle explosion, Right: Rendered with Particle Blur 

Particle Blur - is for giving particles a motion blur effect. If it is not needed then keep it switched off for speed.
Blur Length - Blur Length sets the time that the simulated camera shutter will be open during a frame. 100% 
would mean that the shutter is open for the entire frame. 50% would mean that the shutter is open for half the 
frame and is a more typical setting. Increasing this value increases the length of the motion blur streaks. It is 
possible to enter values larger than 1.0 if you wish to capture more than one frame worth of action. The quality 
of the streaks is determined by the antialiasing settings.
Subframes - Each subframe will be anti-aliased with the settings described above. These subframes are blended 
together to produce the final image. This is the same way the the classic motion blur has worked in earlier 
versions of LightWave with the addition that each subframe can now be anti-aliased. If your scene contains 
object deformations, you should use multiple Subframe Passes when using Motion Blur . This will save you a lot 
of rendering time and produce more precise motion blur streaks.
Shutter Open - Lets you shift the time of the frame, up to one frame forward or backward, for the purpose of 
controlling whether the motion blur covers the first half of the frame, the last half, middle, etc., in order to match 
motion blur from other applications.
Shutter Efficiency - determines the amount of time, per frame, the shutter will be open. A value of 100% means 
the shutter is open 100% of the frame time, so the light exposure is equal for the entire frame. A value of 50% 
means the shutter does not open fully until midway of the frame, so the beginning and end of the light exposure 
are darker.
Rolling Shutter - Is for a Rolling Shutter effect detailed here.
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Motion Blur and its Alpha

Deformation Motion Blur

LightWave will perform motion blur on deformed objects (animated characters for instance) in both F9/F10 renders and 
final quality VPR.
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Stereoscopic Rendering

Stereoscopic rendering gives you the familiar two-image set seen from slightly different perspectives that can be 
combined in a variety of ways to produce a 3D image. Further explanation of stereoscopy is outside the remit of this 
manual, but there are plenty of resources on the web for people interested in this field. When rendering using the 
Stereoscopic Rendering function you will get two images for each frame of your animation suffixed with either an L or R 
for Left and Right eye images respectively.

When Stereoscopic camera always renders the Left Camera first then the Right Camera. So when using F9 it will render 
the left camera image, then it will then render the right camera image. When you have a RGB file format and path 
chosen it will save the sequence of Left and Right images into that folder.

Also, when you check on Apply Anaglyph Filter it will render the Left Camera Image and then composite that with the 
Right Camera image to create an Anaglyph Red / Blue image saved as the Right Camera Image. If rendering with the 
Anaglyph filter for best results you should use an image format without an alpha because the resulting final Anaglyph 
image is composed of both right and left camera so the alpha would cause the image to not display properly. If you 
need an alpha then you should render just straight Right and Left stereoscopic images (uncheck the Apply Anaglyph 
Filter) so that two separate images (Right and Left) will be generated with their proper alpha channels for compositing.

Use Apply Anaglyph Filter if you wish to make a 3D image viewed through red/blue glasses.
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Eye Separation - This field is set by default to 70 mm, the average distance between the centers of the pupils in a 
human adult. You can change this value to exaggerate the 3D effect.
Use Convergence Point - The Convergence Point is the point a specified distance away from the center of the 
camera that each eye focuses on. If it is checked off, the eyes will point directly forward. 

The original method of camera convergence is what is called Toe-in , which causes each camera eye to be 
rotated towards the convergence point. A setting of 0.0% for the Convergence Toe-in setting is equal to 100% for 
Off-Axis . 

LightWave supports all three of the major stereoscopic camera rig types used in live action and animation 
rendering and when Use Convergence Point is on, you can drag the Convergence point to where you want it in 
the viewport, or change the numeric values.

Stereo Tracked Eye - You can choose to center the tracking for the camera’s motions or bias it to the left or right 
eye.
When Use Convergence Point is enabled, the distance to the convergence point is always taken to be from the 
center eye.
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• Stereo OpenGL - Has three different modes. Off switches off the OpenGL display of stereoscopy for a less visually 
cluttered workflow, Anaglyph displays the OpenGL so that the 3D can be seen using anaglyph (red/Blue) glasses, 
and 3D Glasses that requires a 3D monitor, 3D-capable graphics card and accompanying 3D glasses.
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Depth of Field (DOF)

LightWave allows you to have a whole series of objects in a scene at differing distances from the camera and to render 
them all in perfect focus! The human visual system can’t even do that, and that’s the problem. For your images to look 
as realistic as possible, they need to use a feature of reality called Depth of Field. Fortunately, you can emulate this 
functionality inside LightWave.

Settings are found on the DOF tab at the bottom of Camera Properties and become active once the Depth of Field 
button is checked.
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Depth of Field refers to the area of acceptable sharpness in front of and behind the actual area in focus. When you 
enable Depth of Field you need to change two settings. The first setting, Focal Distance, refers to the distance from the 
camera to the object that you would like to be in focus.The second option is Lens F-Stop. Camera focus typically 
encompasses a range, from near to far, that we call “in focus”. Objects nearer than this, or farther than this, appear out 
of focus. The Lens F-Stop value determines the range of focus around the Focal Distance (the near and far distances 
from the camera in which objects still appear in focus).

If you are familiar with real world cameras, you know that the f-stop sets the diameter of the lens aperture. An f-stop of 
f/4 (which corresponds to a LightWave Lens F-Stop of 4) indicates an aperture diameter that is a quarter of the lens focal 
length (LightWave’s Lens Focal Length). Higher f-stop numbers refer to a smaller aperture, because the number is the 
denominator of a fraction. The aperture (f-stop) control on a real camera affects both the brightness and sharpness of 
an image. In the LightWave world, the Lens F-Stop works in the context of Depth of Field where it affects only sharpness.

The larger the Lens F-Stop value, the larger the depth of field, that is, the greater the distance between the near and far 
distances where objects appear in focus. Conversely, the smaller the Lens F-Stop, the smaller the range of focused 
area.In general, remember that the Depth of Field becomes progressively greater as the Lens F-Stop setting increases, 
the Focal Distance value increases and/or the Zoom Factor (and therefore the Lens Focal Length) setting becomes 
smaller.

When starting to experiment with Depth of Field, try using a short Focal Distance setting (shorter than the distance to 
the object you wish to be in focus) so that the depth of field is more pronounced. You can also look at the scene in an 
orthogonal viewport and be able to see a ring around the camera indicating the focal distance of your lens - the 
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distance at which things are in perfect focus. Don’t worry that the display will get confused if you are also showing fog 
circles in the viewport; the lines indicating the fog are visibly different to that of the focal distance.

The settings on this tab are as follows:

Focal Distance - This value is the distance at which the rays your camera “sees” are brought into focus. Without 
Depth of Field being engaged, everything in a scene is in focus all the time.
Lens F-Stop - This is the aperture setting that determines the strength of the Depth of Field effect. To create 
something exaggerated, use an F-Stop of less than 1.
Diaphragm Sides - The lens aperture is polygonal and this is here you can side how many sides the aperture has. 
A setting of less than 3 results in round lens reflections.
Diaphragm Rotation - How far off vertical the aperture is rotated.

The two diaphragm settings are for creating a so-called Bokeh Effect, where lens reflections appear in the final image.

A simple explosion of cubes with extreme depth of field. Diaphragm Sides has been set to 3 and Rotation to 23° to better 
show the Bokeh effect.

You can also set a null to be parented to the camera and linked to the focal distance envelope of the camera so that you 
can control the focal distance by moving the null. This way you can get an interactive distance tool to control the focal 
range. Here’s how you do it:

Add a null to your scene and parent it to your camera in the Motion Options window ( M ). In Layout, turn off the 
X and Y axes so that the null can only be moved along its Z-axis. Name this null “CameraFD”;
Go to the Object Properties window ( P ) and assign the Range Finder custom object to the null. You can turn on 
the link to camera if you wish;

Go to the Camera Properties window. Make sure that the Focal Distance is set to 0 m;Hit the Envelope button next to 
this field so that you can link the distance between the null and the camera to the focal distance used.

You can get an accurate measure of the distance between the camera and your selected object using the Ruler 
or Range Finder custom objects.


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Click on the Modifiers Tab in this window and use the Channel Follower Modifier. Double click on this in the list under 
the Add Modifier drop down menu to set up the Channel Follower Modifier;From the list of channels, choose the 
CameraFD.Position.Z channel, make sure that the time lag is set to 0, scale to 100% and start frame and end frame to 0 
and –1 respectively.

You can now key the position of the null and the camera’s focal range will be set to the distance between the null and 
the camera meaning that you can pinpoint a single object in a busy scene to be focused upon. The smaller the value for 
the Lens F-Stop, the smaller the range of focus.

Depth of Field/Motion Blur Viewport Mode

You can preview motion blur or depth of field in OpenGL using the preview option located in the third Viewport 
dropdown menu.

The number of preview passes is controlled in the Preferences Panel. You must use the Camera View to use the Motion 
Blur preview.

  

Number of motion blur passes - 3, 9 (the default) and 18.

The Display tab of the Preferences window is open and highlighted is the quantity of DOF/MBlur passes. You can have 
up to 35 presented in OpenGL.
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Camera Types
Click here to expand Table of Contents...

Zoom Factor
Perspective Camera
Advanced Camera
Orthographic Camera
Real Lens Camera

Camera and Lens Menus
Load Image
Limitations and cautions

Shift Camera
Surface Baking Camera

Surface Baking Example

VR Camera
Orientation Lock
Pole Merging

Zoom Factor

The zoom factor drop-down menu for each camera type allows you to set a zoom factor equivalent to a real-world 
camera lens. It has four different types of zoom factor for you to choose from, but LightWave defaults to a zoom factor 
of 3.2, equal to a 24 mm lens. LightWave users that are familiar with real-world camera equipment may find that using 
the Lens Focal Length type on the drop-down menu is the easiest to use. Those who are solely used to LightWave’s way 
of doing things may be more comfortable using the Zoom Factor type. You can also use the Horizontal and Vertical FOV 
(Field of View) settings. These set the degree of angle of view.


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Left:138 mm lens, Right: 8 mm lens

Smaller Zoom Factor or Lens Focal Length values will produce a wider angle lens effect while larger values give a 
narrow field of view, similar to a telephoto lens effect. You can create an envelope to achieve effects such as reverse 
zooms where you pull the camera away while concentrating the field of view. The envelope will be based on Zoom 
Factor regardless of which mode on the drop-down you choose to use.

To correctly match the Camera to the Perspective viewport when using Match Viewport Perspective, set the 
Lens Focal Length to 30 mm.


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Perspective Camera

The Perspective camera is LightWave's standard camera. It uses Unified Sampling and renders in packets.

Advanced Camera

The advanced camera is a multi-purpose camera. With the advanced camera, you can recreate real cameras and lenses. 
You can shift the lens distortion over time. Custom lenses can be created by using a mesh object
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Ray Start - This item defines the starting position for every Ray in the scene(world coordinate-based)
Item Position - this is used for pinhole type cameras (like the standard LW camera), which is a single point in 
space as a ray start position.
Item - the item in the scene to be used as a camera
Time Sweep - this can be used to control when in time to read the item position.
UV Position on a mesh - camera plane defined as a UV map on a mesh, I would probably recommend trying to 
stay within a semi-square plane as a starting point as you can get highly unpredictable results otherwise, the 
mesh itself can be animated in any manner(quite fun to play with)
Mesh - the mesh used for the camera plane.
UV Map - Select the UV map you want to use
Item XY - X and Y start position is taken from the Items coordinate system
Item - what item to use as ray start
Time Sweep - same as the item position Sweep function.
Custom - definable with XYZ using numerical input, envelopes or textures
Ray Direction - this defines where the rays should go once they leave the starting position, given in world 
coordinates.
Reverse - the direction of the ray is reversed.
Towards Item Position - Each ray goes through the origin of the item.
Towards UV Position on a mesh - Each ray goes through the matching UV coordinates on a mesh.
Mesh UV Polygon Normal - same as above but traverses the polygon normal instead of UV coordinates.
Mesh UV smooth normal - same as above but with normal smoothing.
Field of View - Behaves mostly like a perspective camera, aligning the rays to move along the Z-axis in the FOV 
defined by the settings. This has a couple of sub-modes you can play with as well:
Perspective - Standard perspective view with definable X and Y FOV
Orthographic - Planar projection mode, area rendered is defined by the size of the ray start item.
Cylinder - Y-axis is orthographic while the X-axis roams free; this is useful for making things like panoramas.
Spherical - Produces a similar effect as a fisheye lens. The vertical settings will be disabled. The horizontal value 
controls how many degrees the fisheye lens covers. Note that this mode affects both horizontal and vertical FoV. 
The field of view has a default value of 45.24.
Through item XY - rays set to go through item XY, dependant on ray start.
Custom - Definable with XYZ using numerical input, envelopes or textures.
Orientation Reference - Determines the orientation of the rays in relation to the selected item.

The depth direction settings are related to a z-depth map. Normally, Item Z Direction will be the most used, or 
Same as Ray for a spherical camera, but those shots can be achieved with the Perspective, Shift, or VR
cameras, respectively. The others are provided for experimentation and are provided as an ultimate method of 
achieving a shot if more normal methods fail.


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Standard Perspective Camera render
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Example of Time Sweep

 

Example of Spherical Camera (camera moved into the shoulder of the rasper cow)
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Example of Camera using UVMesh (view mapped to the UVs of the room)

Orthographic Camera

For the Orthographic Camera, the direction is the same for all rays, and the position is determined by the location of the 
corresponding pixel on the imaginary screen. Perspective of distance between objects is not possible when using the 
Orthographic camera. An example of using this camera is in top-down architectural renderings.

Real Lens Camera

The Real Lens Camera Setting in the Camera Properties Panel will simulate a physical camera lens. Several camera 
manufacturers are listed and act as filters - selecting a particular manufacturer will limit the models and lenses shown.

Camera and Lens Menus

The first filter (top-left) will select the manufacturer of the camera. The second (top-right) filter will select the camera 
body. The third (bottom-right) filter will select the lens type.

While it is possible to use the stereoscopic tools with the Orthographic camera, it is not recommended
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Irradiance falloff simulates the darkening towards the boundary of the image, much like a real camera. What is 
happening on a technical level is the brightness of a pixel is reduced as a function of the angle between the ray and the 
film plane.

The brightness is proportional to the cosine of the angle between the film plane normal and the ray direction, taken to 
some power given by the falloff value. So a falloff of 0 effectively disables it as the brightness will always be 1. Higher 
falloff values make the brightness drop off sharper and faster.

Load Image

The Real Lens camera can take its settings from the EXIF tags in an image or image sequence. The model selection 
dropdown in the Real Lens camera panel has an “(from image)” option. Selecting this opens a panel in which an image 
can be selected, and the settings to use from it picked.

There is also support for getting settings from image sequences. Image sequences should first be set up in the image 
editor. You can set the time in the sequence from which to get the settings. Some settings can be animated, which 
creates an envelope. Keyframes are set for all frames between the Scene Frame Start and End frame numbers 
(inclusive). If an image sequence is used, for each frame, it will use the settings from the image matching the frame 
according to the sequence’s settings.

Limitations and cautions

If Use Model is grayed out, even though make and model is shown, it’s because the Real Lens camera doesn’t 
recognize it.
There is no EXIF tag that says what lens is used. LightWave does put the lens info in the MakerNote for a rendered 
image, and it will use that if available. Otherwise, it will default to Standard.

If the first two filters are left at the default “All” selection, the Lens filter will show all lens types.
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Focal distance is only rarely stored in the appropriate EXIF tag. Some of the most popular digital camera makers 
keep the focal distance in a proprietary MakerNote (presumably to get you to use their crappy photo software), if 
at all. Again, LightWave rendered images do store the focal distance correctly (if rendered with DoF).
The focal length is the actual focal length, not converted to a 35mm film equivalent.
Exposure is mapped to blur length using the current scene FPS setting and causes photorealistic motion blur to 
be turned on.

Shift Camera

The Shift Camera is a tilt/shift type of camera capable of 2-point perspective views, popular for exterior renderings of 
building designs for architectural visualization. It works the same as the Perspective camera but removes the vertical 
perspective from the view. If part of the OpenGL preview is cut off, change the size of the grid with Fixed Near Clip 
turned off.

Vertical Shift - Shifts the camera along the vertical plane. The Use Cam Pitch checkbox gives the original 
perspective correction behavior.
Horizontal Shift - Shifts the camera along the horizontal plane.
Focus Item - An arbitrary focus plane can be selected from a dropdown menu of objects. This creates a focal 
plane from the XY plane of the selected item, allowing items at different distances to remain in focus.

The focus plane can be toggled on/off by checking Show Focal Plane.

The camera must be kept horizontal and not banked, as unexpected results may occur in a render.
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Surface Baking Camera

This camera considers each pixel as a UV coordinate, computing the position on a mesh polygon matching that UV 
coordinate, and shooting a ray at that position from close range. Unlike the Surface Baker shader it is multi-threaded, 
rendered by the raytracing renderer, it works with ScreamerNet, and works with VPR when not in Draft mode. 
Furthermore, as it produces a normal render, all the render buffers are available for saving.

The disadvantage is that only one mesh and UV map can be rendered at a time. However, you can set-up multiple 
cameras, each with its own mesh and map set, and render an animation that is set up to switch to a different camera 
each frame.

Mesh - This is the object that you want to bake.
UV Map - This is the map on that object that you want to use as the baker map.
Offset from Surface - This is the distance from the mesh surface at which to shoot the ray. Too large a value may 
mean that the ray encounters an intervening surface instead of the intended surface. Too small a value increases 
the possibility of floating-point errors causing the ray to slip through the mesh surface instead of hitting it or the 
ray direction to become erratic.
Direction Reference - Ray directions can be set to be equal to the polygon normal, the smoothed polygon 
normal, or in the direction towards the origin of the mesh. The ray will still hit the same spot on the mesh. The 
difference is in the direction in which the ray approaches that point.
UV Border - This is the ‘overdraw’ of the UV polygon boundaries. Using this setting, you can remove the visible 
seams in your UV projection.
Fit UV map to image - This control just determines how to fit the map to the rendered image size. Fit both width 
and height, or just width or height.
Flip UV Y - this inverts the map by flipping it around the “Y” axis.
Bake Surroundings - This allows you to flip the rays around, thereby baking the surroundings instead of the 
mesh. Use for baking a reflection map or environment map.
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Surface Baking Example

VR Camera

Interior Loft by Oscar Anchondo loaded into 2018 and rendered with a spherical VR camera but no other retouching

The VR camera is available in two types. Both types have a horizontal and vertical field of view whose frustums are 
visible in OpenGL, and the Cylindrical type can compute a vertical field of view automatically such that the aspect ratio 
is preserved (no stretching or squashing of the image). Straight ahead of the camera is the center of the view, and 
stereoscopic rendering is supported.

This camera is not displayable in OpenGL. Its effect is only visible through renders or VPR

https://docs.lightwave3d.com/display/LW2018/Example+-+Surface+Baking+Camera
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Orientation Lock

The Orientation Lock dropdown is to allow the animator to orient it naturally while working for previs but remove the 
pitch and bank components when rendering. Presents three options:

No Orientation Lock (Default) - Camera animation is possible in all three axes.
Keep Upright (Parent) - Camera animation in Pitch or Bank does not affect relative to the parent item's 
coordinates (the parent's +Y direction defines upright for the camera)
Keep Upright (World) - Camera animation in Pitch or Bank does not affect relative to world coordinates (the 
world +Y defines upright for the camera)

When the Orientation is locked to Parent or World, a new option Lock Heading becomes available to restrict the 
camera's Field of View to straight ahead (or whatever angle is chosen) at render time.

Pole Merging

The spherical VR Camera has the option for pole merging, to control distortion near the poles. There are three modes:

No Pole Merging - no pole merging takes place (default)
Pole Merging - simple pole merging with settings for how to handle the top and bottom poles
Use Nodal Pole - uses Nodal to set up more complex arbitrary pole merging

The simple pole merging option has the effect of reducing the eye separation to zero towards the poles. The settings 
control the falloff for each pole:

Off - no falloff, pole merging is disabled for that pole
Linear - linear falloff
Cosine - a smoother falloff following a cosine curve (default)

The Threshold Angle specifies the vertical angle towards the pole at which the falloff will start to be applied. The eye 
separation falls off from full at that angle, to zero at the pole. Note that the threshold angle is not signed.
The Power value raises the falloff to a power. Larger values cause a more rapid falloff.

Use Nodal Pole

The nodal setup allows for arbitrary control of eye separation and convergence distance as a function of horizontal and 
vertical ray angle.

Input Node
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Horizontal/Vertical Angle - Produces the horizontal and vertical angles of the ray (straight ahead is zero 
degrees; angles increase upwards and to the right; values are signed)
Convergence Distance - If used, this value is taken from the Stereoscopic Rendering settings
Eye Separation - If used, this value is taken from the Stereoscopic Rendering settings

VR Camera Output Node

Convergence Distance/Modulation - These work similarly to affect the convergence distance if Use 
Convergence Point is enabled in the stereoscopic rendering settings
Eye Separation - When connected, the Eye Separation input specifies a new eye separation to be used for the 
ray. If not connected it defaults to the eye separation specified in the stereoscopic rendering settings
Eye Separation Modulation - The Eye Separation Modulation interpolates between the eye separation from the 
stereoscopic rendering settings and the value provided to the Eye Separation input. If not connected, the Eye 
Separation input value is used. If connected, it linearly interpolates between the stereoscopic rendering setting 
eye separation (modulation value of 1), and the Eye Separation input (modulation value of 0)

When using the stereo render output, the VR Camera Export Image Filter should be used to define how renders 
are output.



Several new render presets have been included for use with the VR camera - VR HD, VR 2K, and VR 4K.

https://docs.lightwave3d.com/display/LW2018/Stereoscopic+Rendering
https://docs.lightwave3d.com/display/LW2018/Stereoscopic+Rendering
https://docs.lightwave3d.com/display/LW2018/Filter+List#FilterList-VRCameraExport
https://docs.lightwave3d.com/display/LW2018/Filter+List#FilterList-VRCameraExport
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Action! - Start Animating
Animation means giving life to something inanimate. When you open LightWave Layout you will be doing exactly that, 
whether just making a light flicker, rolling a ball, or full character animation. At animation's simplest, changing an 
object's position, rotation, and/or scale over time will be enough. As you gain confidence, you will learn about 
Parenting, Following, Kinematics, Simulation, and many other things you can achieve with LightWave.

Some definitions for you:

Parenting - Linking one item to another. Where the parent moves, rotates, or scales; the child will follow. There 
is a button labeled Parent in Place. If this is engaged, the child item will stay where it is. When switched off and 
the child has no keyframes of its own, the child will move to the same location as the parent.
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• Following - Using the Motion Modifier Follower you can have one item follow another, with a delay and various 
other user-definable options. 

If you select multiple objects in Layout and hit the E key, the objects selected will be parented to the 
last object selected.

The E key is pressed after each lasso selection to parent one null to the 
other selected


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Kinematics - Forward and Inverse Kinematics are ways to control character motion. There's too much for a 
simple illustration, visit Rigging.
Simulation - Likewise for simulation. Bullet Dynamics, Flocking and FX Dynamics are your first ports of call to 
learn more.
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Using the Timeline
Click here to expand Table of Contents...

Introduction
Viewport
DopeTrack
Graph Editor
Scene Editor
Scene / Dope Editor

Introduction

LightWave's timeline shows keyframes for the currently-selected item or items. You cannot edit keys on the timeline 
itself, they are purely informational. They show that the selected item has keyframes at a particular time in the scene. 
The key might not be in the tool you are currently using (Move, Rotate, Scale), but there is a key. To edit those keys 
there are several options.

Viewport

Make sure you are on the keyframe you wish to modify, and move, rotate or scale your item. The keyframe will record 
the changes you make as long as Auto Key is enabled (as shown in the image above). If Auto Key is not on, you must 
remember to update the keyframe manually with the Enter key before you change to a different keyframe, or your 
changes will be lost.

DopeTrack

You can open the DopeTrack section of the timeline by clicking on its top edge, like so:


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The DopeTrack is fully explained here.

Graph Editor

Open the Graph Editor from the menu or with the keyboard shortcut Alt F2. You have a timeline view of the keys you 
have set and can move them, change their pre- and post-behaviors and change their incoming curves.

Scene Editor

In the standard Scene Editor you can shift or scale all the keyframes for a specific scene item.
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Scene / Dope Editor

The Scene/Dope Editor allows more control of keyframes. You can modify only selected keys and can copy keys as 
shown at the end of the animation holding down the Alt key. An Undo is available by right-clicking in this scene editor.
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Working with Keyframes
Keyframes are how you note a change in LightWave. Want a light to turn on at a specific frame? Keyframe its intensity. 
Want to move your camera? Keyframe its motion. Want to set up a color change in a surface? Keyframe the color 
change. Keyframes are the essential way to tell LightWave how you want to work.Keyframes are everywhere in 
LightWave and you'll see them on your timeline that runs under the main viewport. You only see keyframes marked for 
the active element, be it Objects, Bones, Lights or Camera, otherwise the timeline would be very crowded. All elements 
have at least one keyframe at frame 0 that determines their initial position, rotation and scale.
Keyframes can be created in several ways:

Positioning, rotating or scaling something in Layout
Hitting Return
Adding keys in the Graph Editor in an Envelope

Keyframes can be moved in time with:

The Graph Editor
The DopeTrack

and lastly keys can be deleted using the:

Del key on a keyframe
RMB click on a key in the Dopetrack
and to remove a complete Envelope of keys, by Shift-clicking on an E icon.

To see the various ways you can add keyframes in Layout, read Animating - Creating Keyframes.
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If you have imported a motion capture file or brought in baked keyframe animation from another source, 
sometimes you can get an axis flip when items are close to positive and negative 180°. The image below shows 
a null rotating about the Heading axis. Just looking at it in Layout seems okay, but the Graph Editor reveals the 
jump:

The fix is to use a script added in 2019.1.3 called "Rotofix". You will need to select the item to be modified, then 
find the plugin. It's in the Utilities > Additional list but you can find it quickly by hitting Ctrl-Space and starting 
to type "Rotofix".

Here's the result:


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Motion Options
Click here to expand Table of Contents...

Motion Options Panel (default keyboard shortcut M)
IK and Modifiers Tab
Controllers and Motions Tab

Heading, Pitch and Bank Limits
Heading, Pitch and Bank Stiffness
Controller Types
Record Minimum/Maximum Joint Angles
Soft IK

Add Motion Modifier

Motion Options Panel (default keyboard shortcut M)

When an item in Layout is selected, clicking the Motion Options button opens a panel containing various controls for 
the selected item.


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• Parent Item - This dropdown menu allows you to parent the current item to any other item in the list excluding 
bones, which can only be parented to another bone belonging to the same object or to the object they belong to.
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Target Item - This brings up a list of items that will allow the currently selected item to target or point at.
Pole Item - Sets up a link to another item (often a null) that will be used as a Pole Vector. Pole Vectors are to the 
item’s Bank as Targets are to the Heading and Pitch.
Spline Control - Determines the Spline Control element that will be used for the selected item.

Rotation Order -  In 2020 there is a new dropdown for different rotation orders giving their XYZ and 
LightWave-style (HPB) names, as follows:

XYZ / PHB - Autodesk Maya standard
YZX / HBP
ZXY / BPH - Unity standard
YXZ / HPB - LightWave standard
XZY / PBH
ZYX / BHP

More information can be found here.

After all these controls, apart from Rotation Order, there is an X icon. This is used to rapidly de-reference the Parent, 
Target, Pole and/or Spline Control items without needing to go into the dropdown menu and selecting (none), although 
that option remains available.

If you select multiple objects in Layout and hit the E key, the objects selected will be parented to the 
last object selected.

The E key is pressed after each lasso selection to parent one null to the other selected


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IK and Modifiers Tab

Unaffected by IK of Descendents - This option is used to define the root of an IK chain. It acts as an anchor for IK 
based motions and stops the motion from passing back beyond that item.
Goal Object - This is an item which is usually the “handle” at the end of an IK chain. This handle serves the same 
function as a control rod on the end of a muppet’s arm or the strings on a puppet.
Objective Menu - This menu selects how the item uses the goal. The default is Go to Goal , which the familiar way 
of trying to get the item to be as close to the goal as possible. Point at Goal is similar to targeting in that it aims 
to make the items Z-axis point at the goal. YZ Plane through Goal the IK solver will attempt to get the YZ plane of 
the effector to go through the goal position. This menu is only available when a Goal Object is selected and in 
turn it makes the Goal Strength field available.

Goal Strength - This option is used to determine how much the end of the IK chain follows or is attracted to the 
goal object. This is particularly important when using multigoal IK chains. One goal for example could be used to 
control the placement of a leg/foot and another to determine the orientation of a knee joint. You would want the 
goal at the end of the leg to have a greater goal strength then the one at the knee. Sometimes this takes a little 
tuning to get right. With a character that is modelled to human scale, goal strengths from 30 -100 work well. 
Interestingly enough the smaller the character the larger the goal strength and the bigger the character the 
smaller the the goal strength needed.

Base on... - Four choices are presented:

Base on First Keyframe -
Base on Most Recent Keyframe -
Base on Current Time -
Base on Frame Number - Makes the field next to this dropdown available for adding a frame number, which can 
be enveloped

Chain - Activates the IK/FK blending options for the entire chain.

IK/FK Blending - Will blend the calculations for inverse kinematics and the keyframes for forward kinematics 
based on the percentage, with 100% being full FK.

Controllers and Motions Tab

The Controllers and Limits tab has been updated to include Position and Scale controls. The limits are based on the 
parent space and not world coordinates.

The World options for Rotation will use the world coordinates, rather than the local coordinates.The “Transform” Item 
option will select the item which influences the current item.

Interpolate uses the blend to interpolate between Same As Item value and channel value.Compensate removes the 
Same As Item value from the channel value to a degree specified by the blend.

Heading, Pitch and Bank Limits

We can determine a range within which a rotational channel of an item can rotate. This is useful to keep joints from 
hyperextending or keeping IK controlled joints from “popping”. It is also useful to keep items that are very closely 
spaced from rotating in and through each other.
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Heading, Pitch and Bank Stiffness

This setting allows you to set a stiffness or resistance on the rotational channels of an item. This works when the 
controller for a channel is set to IK. The Stiffness setting can help to determine which items in an IK chain will bend first 
or last. Higher values make a joint harder to bend and lower values easier to bend.
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Heading, Pitch and Bank Controllers
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Scale Controllers

Position Controllers

Controller Types

These contain seven options for controlling the rotation, position and rotation channels. Not all options are available 
for all channels.

Keyframe - This simply means that you can manually orient an item in that channel and keyframe its position at 
anytime.
Point at Target - This allows a particular rotational channel to target an item. Target Item in the main motion 
panel must be set to some item.
Align to Path - This allows the rotational channel of an item to align to its motion path. With the Align to Path 
Look Ahead controller under the IK and Modifiers Tab we can make this channel look ahead or anticipate a turn.
Inverse Kinematics -This allows IK to control this channel. If other channels are set to FK we can selectively 
determine which rotational channels are controlled via IK or FK.
Align to Velocity - The channels controlled by this option will have the same values as the corresponding 
channels of the set item. The stiffness value can be used to interpolate. The one for position has the option to 
use the world coordinates of the position item (instead of local). The calculations currently assume that X, Y, and 
Z are controlled, so the result may not be optimal if not all three position channels are “Same as Item” 
controlled.
Align to Pole - This option adjusts the angle of the item so it points towards the pole. It is similar to the target 
item, and typically used in combination with it.
Same as Item - The channels controlled by this option will have the same values as the corresponding channels 
of the set item. The stiffness value can be used to interpolate. The one for position has the option to use the 
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world coordinates of the position item (instead of local). The calculations currently assume that X, Y, and Z are 
controlled, so the result may not be optimal if not all three position channels are “Same as Item” controlled.

Record Minimum/Maximum Joint Angles

You can interactively set the rotational Min and Max values by rotating the item to the desired minimum direction and 
choosing Setup > Motions > Limits > Record Minimum Joint Angles (default keyboard shortcut: {). This will activate 
minimum limits for any rotational parameters (heading, pitch, or bank) that are currently active for the chosen item. 
Similarly, rotating the item to the desired maximum range limit and choosing Setup > Motions > Limits > Record 
Maximum Joint Angles (default keyboard shortcut: }) will automatically input the values into the maximum limits for the 
active rotational parameters.

Soft IK

 
Soft IK can be used with the Go To Goal objective. Its purpose is to smooth out the transition from a bent chain to a 
straightened out chain. It does this by changing the position of the goal that the chain uses, moving it closer to the 
chain root. Three types of Soft IK are available from the dropdown that each offer different ways of treating the 
transition. Experimentation is necessary to see which of Exponential, Linear and Clamp work best for your specific 
needs.

The threshold at which it starts to do this is set by the Max value. If the distance between the chain root and the goal is 
larger than that indicated, the soft IK will kick in smoothly.

There are three ways to specify what “the distance between the chain root and the goal” means:

Chain Chord - the Max value is given as a percentage of the straight-line distance between the chain root and the 
goal.
Chain Length - the Max value is given as a percentage of the distance between the chain root and the goal, as 
measured along the chain.
Given Lengths - the Max value is used as the distance.

Additionally, as well as a soft IK on stretching the chain, there is a soft IK on squashing the chain as well. If the distance 
between root and goal is less than a given minimum value, then it will start to push the goal away.

Full-time IK - When this option is off, IK is not calculated full-time. This means that animating the goal object will 
have no effect on the items with IK active. The goal object will affect the IK items while posing. The items that are 
part of the IK chain will have to be keyframed manually. In this mode the Goal object acts as an aid to pose the IK 
chain. When this option is turned on, as it is by default, IK is calculated full-time. 

This allows the goal object to be used to animate with full-time and the items in the IK chain do not need to be 
keyframed.

You should deactivate Heading, Pitch, and/or Bank to avoid setting limits for channels you don't wish to.
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Match Goal Orientation - As stated before the Goal object acts as a sort of handle or the control rod on the end of 
a muppet’s arm. By turning on match goal, the last bone in the IK chain will match its orientation to that of the 
goal objects. This allows things like a foot or hand to stay locked in place rather then pivot around the goal 
object.

Keep Goal Within Reach - It is possible for the goal object to move away from its IK chain once it exceeds the 
length of the chain. This is normal but can be disconcerting to some people. If this option is turned on, the goal 
object will always stay at the end of the IK chain.

Add Motion Modifier
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Add Motion Modifier

This panel allows additional plugins included with LightWave or available from third party sources to be activated. 
These plugins will allow motions to be controlled or modified in various ways. Next to each motion modifier in the list is 
a check box. This can be used to activate or deactivate the modifier next to it temporarily.

Click here to expand modifier list

Alembic Motion Controller
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Anchor
Camera Trigger
Cruise Control
CurveConstraint
Cyclist
Effector
Expression

Channel

Flocking - Item Motion
Follower
FX_CLink
FX_Link
FX_Motion

Mode Tab
Vector Tab

Gravity
Jolt!

Global Options
Effect
Using Preset Values
Applying Turbulence
Key Settings
Events Mode

LeadtheFollower
LScript
LScript/RT
master
Mimic
MM_MotionDriver
Motion Baker

New Key Mode

Nodal Motion Modifier
Dynamics Part Info

Oscillator
Parenter
QuaternionBooster
Sun Spot
Textured Motion
LeadtheFollower
Simple Constraints

Adding Constraints
Baking
Deleting Constraints
Simple Constraints vs. Parenter

Simple Affectors
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Alembic Motion Controller

 
For assets controlled through an Alembic file import.

Anchor

Anchor is a pre-calculated motion modifier for attaching one mesh object to another. The target object must have a UV 
map.

Camera Trigger

Camera Trigger is an internal plugin with no user-accessible functions. It can be called by tools such as Camera Selector.

Cruise Control

 
Will move item with constant speed. The direction of motion will be the direction at time 0. There must be at least two 
keys in the object motion, preferably linear.

CurveConstraint

CurveConstraint moves an item along a curve object, similar to a motion path. The curve object is selected on the Curve 
pop-up menu. (If there is more than one curve in the object, the first curve is used.)

Align - Will rotate the object so that it faces along the curve in the traditional “Z axis” manner.
Start Time/ End Time - These values determine how long the item takes to traverse the curve.
Curve Influence - The Curve Influence percentage blends the curve motion in or out.

CurveConstraint does not remain locked to the curve but adds the curve’s position to its own keyframed 
motion. To lock the item to the curve, parent the item to the curve, reset the item’s position then delete all its 
keyframes. You might use CurveConstraint to move an object along the same curve used to create the geometry 
(or create the curve from the geometry), just like you would with a roller coaster.
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Cyclist

Cyclist will associate the action of one item with a repeatable action (an animation cycle) of another item.

Channels are activated by clicking on the buttons that represent each channel at the top of the Cyclist Panel. All 
activated channels will have their values replaced by the animation-cycle values of that same channel, but at the time 
determined by the Cycle Controller. Channels that are not enabled will retain their normal value at the particular frame. 
For example, you can set up keyframes on wheels of a car, so they revolve continually, while parented to a car. Then, 
apply cyclist to the individual wheels, setting the car (or master parent) as the cycle controller. When the car moves, the 
wheels will turn.

Cycle Frames - Defines the frame range that contains the action that you want to be repeated (i.e., the 
animation cycle).
Cycle Controller - Controls the item based on the selected control parameter, defined on the pop-up menu just 
to the right. The control parameters can be an item’s position, rotation, scale, speed, or the distance it has 
traveled along its actual path length. The Forward Progress, Side Slip, and Climb parameters take into account 
the item’s orientation and tell how far the item has been moving forward (Z axis), to the right (X axis), or up (Y 
axis), respectively. Speed looks at the item’s velocity.
Controller Range - Defines how much change is required to equal one full animation cycle. The unit of measure 
for this parameter depends on the selected control parameter. For Position and other Distance settings, the unit 
of measure is in the LightWave Default Unit defined on the General Options Tab of the Preferences Panel. 
Rotation uses degrees and scale is a factor where 1 equals 100 percent. Speed is in default units per second.
End Behavior - Determines what happens after the first cycle completes.
World Coordinates - Select this button to use the Cycle Controller’s actual (world) coordinates, rather than its 
relative coordinates. These could be different if, for example, the object is parented to another object.
After IK - Although the motion of the item will always come from keyframes, the motion can be used to move an 
IK goal, if After IK is off.
Additive - this option is for use if you have more than one Cyclist added to an object. It adds Cyclist motions 
together rather than only taking the last one added.
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Effector

Effector causes effector objects to repel or attract the motion path of the affected object. The effector objects may be 
any objects you wish, but Null objects work best.

Effector Object(s) Prefix - Use this to set the prefix name. Any object that begins with this name will be an 
effector, allowing you to have more than one based simply on their names.
Solid Core Radius - Defines a spherical area, within which all objects are equally affected.
Falloff Distance - There is a gradual falloff of the effect between the Solid Core Radius and Falloff Distance. 
Objects outside the Falloff Distance are not affected at all.
Effector Shape - There are two choices, Point or Plane. If you choose Plane, you will need to specify the Axis. The 
Axis buttons will be grayed out if you choose Point.

Expression

This is a motion-modifier version of expressions, which can use the results of other motion modifiers, as well as IK. This 
is not possible with a channel modifier. 

The impact of the effector object is set and animated by keyframing its XYZ Size channels. Positive 
values repel, and negative values attract.


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Channel

You can select multiple channels from the pop-up menu and apply different settings for each (i.e., you don’t just pick 
one). They can all share scratch variables (A through Z), and the expressions can be aware of other components of the 
item’s motion. Thus, H can depend on Z, for example, without trying to reference the item’s object.

Flocking - Item Motion

 
This plugin gets automatically assigned when you have an item that is part of the flock.

Follower

Using the Follower item motion modifier is similar to parenting an object to another, except that you have control over 
which motion channels you wish to inherit. You can also modify and delay the inherited value. Moreover, the motion 
can be inherited from the camera, a light, a bone, or any object in the scene. Follower looks at the pivot point of the 
item to follow; therefore, certain objects that follow another should match pivots.
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Item To Follow - Use the pop-up menu to define the item whose motion you want to use. This item would be 
considered the leader.
World Coordinates - Activate this option to use the leader’s actual (world) coordinates, rather than its relative 
coordinates. These could be different if, for example, the object is parented to another object.
Time Delay - The number of seconds entered is added to the current time. A negative number can be used if 
desired.
Randomize - Is a maximum amount of time (in seconds) to be added to the delay. The actual amount will be 
between 0 and the Randomize value. This number may be negative or even larger than the Time Delay. (The 
latter would cause the item sometimes to anticipate the leader’s moves and lag at other times.) The overall 
delay amount for each item is fixed throughout the animation, so this is useful for basic flocking effects.

Path Delay - This parameter specifies a fixed following distance along the path of motion of the leader, which is 
helpful for keeping cars in a train following correctly through accelerations.

Align to Path - This option will align the follower object to its new path.
After IK - Allows you to apply Follower taking (or not taking) into account changes from IK.
Channel - Represents position, rotation and scale.
Source - Select a Source for any of the leader object’s motion channels you wish to use. Generally, the type of 
motion channels will match. That is, the follower object’s, say, X Position will be determined from the leader’s X 
Position. However, the settings can be different. For example, the follower object’s Bank Angle might be derived 
from the leader’s Z Position. Select none to disregard that channel.
Multiply By - You can scale the value applied to a channel by inputting a factor other than 1 in the 
corresponding field.
Add - The channel value may be offset by inputting a value other than 0 in the Add field.

The random number seed is taken from the object ID, which should be the same among ScreamerNet 
nodes and, thus, will cause items to have different delay amounts. The delay stays the same from frame 
to frame.


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FX_CLink

Used by FX Linker and cannot be directly addressed.

FX_Link

Particles - Choose particle group.
Rotation - This dropdown menu determines which rotation method the particle will have when emitted. The 
default value, none, has no rotation added.

Random - gives the item a random starting rotation.
Align to Path(h) and Align to Path(hp) will rotate the item according to the particle’s path.
Copy from Emitter - will use the original particle’s motion path.

Time shift - moves the start of the item’s sizing/rotation motion according to the settings in the drop-list. The 
None value doesn’t alter the timing of the item’s motion; it plays as it was initially keyframed. The Start Shift 
and End Shift options move the item’s motion to the beginning or end of the particle’s life. The Start Adjust 
(distance) and End Adjust (distance) settings will alter the frame rate of the motion according to the value in 
the Distance/Sec field. As the particle travels a certain distance, a percentage of the motion is animated.
The Pre and Post Behavior settings indicate what the item’s rotation/scaling state will be when the motion isn’t 
being animated. This represents the time before the particle is born and after it dies.

The Stay behavior will hold the first frame of the motion for the Pre Behavior and the last frame with the 
Post Behavior. The Original setting returns the object to its original state in either the beginning or end of 
the animation.
The Size Dissolve setting will dissolve the item in either the beginning or ending of the particles life. So in 
the Pre Behavior, while the particle is waiting to be generated, it’s not visible. Then for the Post Behavior, 
after the particle dies, it becomes invisible. 
Size effect applies the particle size to the object. The object’s normal layout size becomes a factor where 
0 = 0% and 1 = 100%. You can animate an overall size of particles using normal layout sizing functions.
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FX_Motion

Mode Tab

make key - Generates a key for every frame.
Group - Select an existing group or create a new one.
Mode - Three options possible:

After collision - Choose an action post collision: none, reverse, random, stop.
Start Frame - Choose what frame to start the effect.
Start by event - Use this option if you want to trigger the motion upon collision.

Weight - This option sets an arbitrary weighting value that will influence how factors like gravity affect the item.
Size - This option affects the outer boundary used for collision detection. It can also be used by volumetric 
plugins like HyperVoxels.
Resistance - This option adds an air resistance effect. Items will move slower as this value is increased.
Momentum - This option adds in a momentum or increased mass effect. Items will tend to resist being stopped 
or slowed down.
Rotation Resistance - This option has the same effect as Resistance except that it affects the items’ rotational 
channels.
z-Rotation by wind(deg/m) - This option rotates the item in its bank channel as it moves or is affected by the 
wind.
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Vector Tab

Initial Velocity - Sets the initial direction and force.
Velocity coordinates - Sets whether these settings use the item’s local axes or world coordinates.
Initial Rotation(deg/s) - Sets the items’ initial HPB rotation.
Random Rotation Start - randomizes the initial HPB rotation.
Update - Updates/refreshes the current seeings in the Layout viewport. This is good to do with a heavy scene.
Copy - Copies the current settings.
Paste - Pastes settings in the copy buffer over the current settings.

Gravity

Gravity simulates the effects of the Earth’s gravity on an item’s motion, making it fall naturally and even bounce with 
varying degrees of elasticity.



LightWave 2020  –  LightWave 2020

Getting Started with Layout –  518

•
•
•

•

•

Strength - This is the acceleration due to gravity in units of ‘g’, the Earth’s standard gravity.
Axis - The object’s position will be altered along the specified Axis.
Ground Level - Sets the height at which the object will meet the ground. This is measured in the Default Unit 
(General Options Tab of the Preferences Panel).
Elasticity - Describes the amount of energy lost on each bounce, which equates to the relative height of the 
bounces. Thus, 100% Elasticity is completely bouncy, and bounces forever, 0% doesn’t bounce at all.
Start Time/End Time - The Start Frame and End Frame parameters specify when the effect is applied.

Jolt!

Jolt! is an item motion modifier that simulates the chaotic and uncontrolled movements that occur when physical 
impacts have enough weight and velocity to cause jarring vibrations. For example, the collision of one celestial body 
striking another, the impact of a robot’s foot with the earth, the collision of a laser beam with a passing spaceship, and 
so on. All of these events are good candidates for Jolt!

The most natural results will occur if all the keyframed motion within the range of frames is a single linear 
path. In particular, the trajectory is determined by an object’s initial speed and direction of motion.
Your object must start in a positive position along the selected Axis.


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Jolt! also lets you specify vibration events using keyframes that indicate when a vibration will begin — and be at its 
most intense. You can also specify the duration of the vibration and its initial intensity. Intensities can be set based on 
the object’s position (X, Y, and Z axis) and its rotational values (heading, pitch, and bank). 

Global Options

Save Keys/Load Keys - Lets you save and restore Jolt! settings.

Jolt! does not provide the basic motion of an item, but rather modifies an existing motion. Jolt! does not 
modify existing motion except to radically deviate from it temporarily at specified intervals.


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Save Motion/Load Motion - These buttons save and load standard LightWave motion files based on the 
keyframed data. The Save Motion button is ghosted if no keyframes are set, and both buttons are ghosted when 
the Events Tab is selected.
Linear - Motion files saved with the Linear button active have their keyframes set to the (spline control) linear 
mode.
Intensity Ramp - Instructs Jolt! to track the movement of a LightWave item (i.e., Camera, light, object, or bone) 
and based upon its distance from the Jolt! object, increase or decrease the effect of the vibration proportionally.
Minimum Range - Is the radius in meters of Jolt!s effective range. LightWave items outside of this range will not 
create a visible effect. If you forget to set this value when you leave the Jolt! interface panel, you will be 
reminded and Jolt! will disable Intensity Ramp (with a minimum range of 0.0, it is ineffective anyway).
Shock Wave - With Shock Wave activated, vibration keyframes are adjusted internally to offset for the distance 
of the ramp object. The further away the ramp item is, the longer it will take for the vibration event to actually 
trigger, and the later it will trigger from its indicated start time. This option is useful if you use Jolt! on items in 
your scene other than the Camera. Items using Jolt! that are closer to the ramp item begin their vibration events 
sooner than items that are further away. With items positioned correctly, this option can produce a visible shock 
wave effect from the ramp item’s location.
World Coordinates - If you select an item that is part of a parental hierarchy, Jolt! alerts you and — if it isn’t 
selected already — suggests that you turn on the World Coordinates option. This option ensures that you get 
proper movement information from the child item.
NonLin2 - this button activates an alternate calculation for Jolt!’s motion calculations. It creates motions that 
are less harsh.
Keyframes mode - The Keyframes section houses the Jolt! key controls. When you want the jolting effect to 
occur on specific keyframes, you will adjust values in this section. (If you want the effect to occur based on the 
position, rotation, and/or scale of an item, this is done in the Events section. You can set values for both, but 
only the selected mode will be applied.) The Jolt Keys slider selects the current frame. The range of the slider 
will exactly coincide with the number of render frames that have been specified on LightWave’s Render Options 
Panel — not necessarily the same value that is used in the Preview settings. The << and >> buttons will jump to 
the previous or next keyframe, if any exist.

Clicking the Populate Key will take the settings for the current keyframe and copy them to every existing 
keyframe. In other words, it populates all keyframes with the current settings and saves you from the tedious 
task of copying and pasting settings, frame by frame.
Randomizing Keys - Randomizing (or jittering, if you prefer) provides a means of breaking up potentially 
monotonous key settings. Although Jolt! will internally randomize settings to some degree as it applies them to 
the item, unless you are using intensity ramping, the actual key values themselves will not be altered. By using 
the Randomize button, you can generate variances such that the motion of subsequent keys does not look so 
similar.
The randomizing process requires two or more keys in order to function. The settings of the first key are never 
altered (nor is there any reason to alter them because no other key will look exactly like them after the effect is 
applied). The degree of variance can be altered by using the Threshold control input field to the immediate right 
of the Randomize button. This control lets you specify, as a percentage, the maximum amount that each altered 
key will deviate from its current value.

Clicking the Create Key button makes a keyframe at the current frame. Use Delete Key to remove an 
existing keyframe. Note that the current frame must be a keyframe to do this.


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Effect

The Effects section at the bottom of the panel sets the actual jolting effect. Clicking Light, Medium, or Heavy will update 
a keyframe’s Position and Rotation values to reflect preset values for a light, medium, or heavy vibration. This feature 
can be used for starting points or final settings.

Clicking the Copy Key button will copy all of the Jolting Effect settings to an internal memory buffer. Clicking the Paste 
Key button will paste the settings into the fields currently visible. Note that this can affect either the Keyframe or Events 
Tab interchangeably.

Using Preset Values

You can alter preset values. If you press the D button to the immediate right of any of the presets, then you store the 
current settings for the key as the default values for that preset. These new default values will persist between sessions 
with LightWave 3D. (Jolt! stores its preset defaults in a file called JOLT.PRE. You can restore the built-in Jolt! preset 
values at anytime by deleting this file; however, it can be stored in various places depending on the system 
configuration. You will need to search your hard drive to find it.)

Applying Turbulence

Jolt! can apply turbulence to your item’s motion path in several ways. When you select Falloff, the turbulence applied 
will gradually decrease throughout the duration of the event. In other words, at the first frame of the event, the position 
and rotation values you have entered for the event will be at their strongest, while at the last frame of the event they 
will be at their weakest. If you do not select Falloff, then Jolt! applies the event values at their full strength at each 
frame throughout the event duration.

If you select Spring, Jolt! applies turbulence uniformly, and makes it appear as though your item is supported and 
buffered by springs. Without Spring, Jolt! applies turbulence more chaotically or randomly, which produces more of a 
true vibration effect.

Key Settings

A Duration value must be specified, in terms of the number of frames, within which Jolt! must complete the effect. 
Because you can specify the duration and location of vibration events, keyframe data may overlap. Jolt! handles this 

Please be aware that when you press any of these buttons, any existing Keyframe settings will be destroyed.
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situation by warning you about the overlap condition. The overlapping key will start before the preceding key ends. If a 
keyframe is deleted, Jolt! will recalculate all keys to ensure that any overlapped keys are corrected.

The Position controls let you define the maximum deviation on each of the three axes for the item at the current frame. 
These values are all specified in meters. The higher the number, the more dramatic the initial movement in that 
direction. A value of zero (0.0) in any position will prevent the item from deviating in that direction. The Rotation 
controls work similarly but set deviation values for heading, pitch, and bank (in degrees).

Events Mode

In the Events section, you can cause jolting based on the position, rotation, or scale of items. (If you want the effect to 
occur on specific keyframes, this is set on the Keyframes section. As noted earlier, you can set values for both, but only 
the selected mode will be applied.) The Watch pop-up menu gives you a list of all the items currently in your 
LightWave scene. You may select any available item from this list as the watched item, that is, the item that triggers the 
event. With the watched item selected, click on the Position, Rotation, and/or Scale button to activate the watched 
attributes. Click either the < (less than) or > (greater than) button next to the input field you wish to set. The Position 
and Scale fields correspond to X, Y, and Z, from top to bottom and the Rotation fields correspond to H, P, and B.

The << and >> buttons let you watch more than one item. To add another watched item, simply click the >> button. The 
informational display to the left will tell you what item is currently selected and how many there are in total (e.g., 01 of 
03). The << and >> buttons are also used to navigate through existing watched items. If you add a watched item by 
mistake, set Watch to (none). You also cannot add another watched item if the last existing item is set to (none).

Activate the Re-arm button if the item repeats its motion and you want it to trigger the event again. If Cascade is active, 
Jolt! will ignore the event (i.e., not evaluate it) until the event immediately preceding it has occurred at least once.

The Effects section at the bottom of the panel works as described for the Keyframes section (see Jolting Effect, above).

LeadtheFollower

An example LScript that you can pull apart to see how it works. It is a kind of reverse-Follower.

LScript

Allows you to add an LScript motion modifier to an item.

LScript/RT

Allows you to add a compiled LScript motion modifier to an item.
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master

Another demo LScript. This one serves for locking channels. There is no interface, you will need to edit the script so it 
does what you want.

Mimic

This Motion Modifier is new to LightWave 2019, and is added automatically when the FBX Interchange Bridge 
is used to import an FBX file using hierarchies for deformation. It can be manually added to a hierarchy to mimic an item 
in a completely different hierarchy, a bit like a streamlined "Same as Item" function. There is just one control, a 
dropdown of which scene item to mimic.

MM_MotionDriver

This plugin is for use with MotionMixer and is used automatically as necessary.

Motion Baker

Motion Baker will freeze the motion of an item into individual keys. Motion Baker takes into account not only IK, but 
also motion/channel modifiers, align to path, and so on. Dragging your frame slider or playing the scene starts the 
computation.

Mimic doesn't support shearing or off-axis scaling.
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New Key Mode

Extra Channels - Places the keys in a special AfterIK channel group - you might use these with expressions.
Use Existing - Will create normal keys for the selected position or rotation channels.

Overwrite Keys - Any existing key data will be overwritten. Note that the existing key data will include the effect 
of Motion Baker recorded on a previous pass.

Motion Baker’s position in a list of item motion modifiers does not matter unless another modifier has an 
AfterIK option and it is active.


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Nodal Motion Modifier

In the motion modifiers for a Layout item, there is a Nodal motion modifier that allows you to apply a nodal network’s 
vector output to your item’s Position, Rotation and Scale.

Dynamics Part Info

Oscillator

Oscillator applies damped harmonic oscillator motions (i.e., decreasing waves) to selected animation channels of an 
object’s motion. Examples of this effect are everywhere, from springs and guitar strings to a grandfather clock 
pendulum.
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Channel - Use the Channel pop-up menu to select an animation channel to be affected.
Enable - Activate the Enable button to turn on the selected channel. The oscillator value will replace the normal 
channel value. You may independently enable multiple channels and each channel may have its own 
independent group of settings.
Additive - Additive adds the oscillator value to the channel rather than replacing it. If this setting is active, a plus 
sign (+) will appear next to the channel name. If Additive is off, an asterisk (*) will appear next to each enabled 
channel name.
Cycle Time - Cycle Time is the period of the oscillation (i.e., wave), that is, the number of seconds between 
successive crests.
Wave Size - Refers to amplitude; the oscillator adds/subtracts this amount at its positive/negative crests.
Offset - The Offset value is also added to the oscillator value on each frame. Essentially, this sets the value of the 
horizontal axis that runs through the wave. By default, it is zero.
Phase - Phase sets where the wave crests with respect to the beginning of the cycle, it ranges from 0 to 360 
degrees. Essentially, the wave is shifted horizontally.
Damping - If Damping is applied, the crests will fall or grow over time, as is appropriate for harmonic oscillators. 
Damping units are a percent per cycle.
Start Frame/End Frame - The Start Frame and End Frame parameters specify when the oscillator is applied.
Copy/Paste - Copy and Paste use an internal clipboard to move Oscillator settings between channels or Layout 
items.

Parenter

An interactive way of dynamically parenting was added to LightWave 2015. With this Motion Modifier applied, a circular 
gizmo appears on the item Parenter is applied to that  you can drag in the Layout viewport to other items in the scene at 
the right time. The gizmo can be moved from item to item during the scene and applied to different items as needed. To 

The formula is: channel value = old value + size * sin( phase + 2*pi*time/cycle time ) * exp(-t*damping factor). 
Where the damping factor is a special number computed from the Damping percentage.


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cancel parenting you can right-click on the gizmo in the middle, but to allow parenting to move to a different item, drag 
the circle back to the host item.

QuaternionBooster

This plugin is for use with IKBooster and is used automatically as necessary. The plugin has no interface.

Sun Spot

Sun Spot is a motion modifier that will rotate an item, usually a Distant light or LightWave 2019's new 
SunLight, to match the sun’s angle at the specified date and time. New to 2019 is the Pick Location tool.
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Distance - The radial distance from the rotation center, at which the light is pointing.

Time Settings - Determine the starting angle. For example, the Hour field should be set from 1 to 24 and Day is 
the day of the selected Month.
Time Lapse - When Time Lapse is set to 0, there is no sun rotation. A value of 1, will make the sun rotate in real-
time, which is very slow (i.e., one second of animation equals one second of sun rotation in the real world). The 
rotation may be imperceptible in short animations. In such cases, you may want to leave it at 0 to minimize any 
impact on rendering time from moving lights.

Remember that the position of a Distant light is not that important since the light will always come 
from the direction it is pointing, even behind the Distant light’s position.



You can accelerate the movement by increasing Time Lapse. For example, 86400 (60 seconds * 60 
minutes * 24 hours) will cause one day’s rotation to occur in one second.


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Longitude/Latitude - Set the Longitude and Latitude for the part of the world your sun is (theoretically) shining 
on.
Time Zone - Time Zone is +/- Greenwich Mean Time (GMT). There are presets provided.

Pick Location - Opens the Location Picker window

Textured Motion

Textured Motion lets you apply the contour of texture to a motion. Thus, if you used the same exact texture for a 
Displacement Map (on a subdivided plane), you could automatically have the item move over it following the contour 
without much effort!

Offset - Lets you move the motion in the positive or negative direction along the selected Axis.
Scale - Acts as a multiplier for the motion. A value of 1 has no effect.
Axis - Determines the perpendicular mapping axis, as would be the case with an Image Map.
Texture - Opens the Surface Editor’s Texture Editor so you can set a texture to follow.

LeadtheFollower

To use:

Create a motion path for an object, and then parent one or more other objects to it.

Run LTF.LS for each of the child objects.

Use the Options button to bring up a requester where you can set the number of frames each object should be in 
relation to the parent object. (If the parent’s motion is set to Repeat, then the child object’s motions will repeat 
too.)

Simple Constraints

Use Simple Constraints (SimpleOrientConstraints, SimplePointConstraints, and SimpleScaleConstraints) to achieve 
“dynamic parenting” effects. You can independently inherit (world) position, rotation, and scale from other items in the 
scene and even use different items for different channels. These modifiers are “keyframe-aware” so you can have 

During night hours, the sun will stay at its lowest point at the end of its cycle and then pop to the 
starting point at the beginning of the next cycle. In other words, it will not revolve in a 360-degree circle.


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different settings at different times in your animation. You can also use Simple Constraints to set up your motion and 
then “bake” the motion into keys.

To use SimpleConstraints, open the Motion Properties Panel for the item you want to control and add one of the Simple 
Constraints motion modifiers. SimplePointConstraints is used for positional effects; SimpleOrientConstraints is used for 
rotational effects; and, SimpleScaleConstraints is used for scaling.

Adding Constraints

The window lists each constraint entry in the order it becomes effective. The number on the left indicates the frame.

To set up a “constraint,” first make sure the Layout current frame is where you want the constraint to start. Click the 
Add button to add a constraint entry to the list. A panel will appear where you adjust the settings for the entry.

There are three main rows of settings. Each row controls the XYZ position, XYZ scale, or HPB rotation, depending on 
which modifier you are using. Each channel has its own targeted scene item.

The Weight value determines how much the channel is “followed.” The default, 100%, will match the targeted channels 
exactly. You can use less than 100% or even more than 100%. Note that you can use the Envelope (E) button to animate 
the weighting.

SimpleConstraints uses the pivot points for the source and target for its computation, so keep this in mind if the effect 
isn’t turning out like you expect. Also, world space position, rotation, and/or scale are used, overriding the source’s 
parenting and keyframed data.

Select Null constraint if you want to disable and “bake” (see next section) the constraint at the current frame.

You may disable any channel by “clicking off” the XYZ or HPB button, making it unhighlighted. You can also set the 
selected item to none.

You can edit an existing entry by selecting it with your mouse and then clicking the Edit button.

Baking

To disable all constraints within a range of frames, but retain the constrained states, you can “bake” the constraint 
effect into actual keys. However, note that keys are only created where the targeted object has a key, not at every 
frame. Also, the keys’ Incoming Curve will be set to Stepped. This locks the state at each create key.

To bake the constraints, click the Bake Range button. In the panel that appears, set the sliders to define the range of 
frames you want to be baked. If you only want to bake the current frame, click Bake Current Frame to set the sliders to 
only the current frame. Click OK to execute the process. After baking, the constraints falling within the baked range will 
become disabled. Obviously, subsequent adjustments to targeted items will not affect baked motions.

If you click UnBake Selected, the selected constraint will be re-activated. Any keys created from baking will remain; 
however, remember that constraints will override them.

Deleting Constraints

To delete a constraint from the list, simply select it with your mouse and click the Delete button.

The scene item selected on the pop-up menus will default to the item currently selected in Layout just prior to 
clicking Add.


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Simple Constraints vs. Parenter

Simple Constraints are slightly faster than Parenter and allow you to control motion channels separately. In general, 
you should use Parenter, unless your item hierarchy is deep enough to cause performance issues.

Simple Affectors

The Simple Affector modifiers (SimpleOrientAffector, SimplePointAffector, and SimpleScaleAffector) are set up exactly 
like Simple Constraints, as described above. The difference is that the object retains its keyframe motion and is merely 
influenced by the target.
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Anchor

Anchor is a pre-calculated motion modifier for attaching one mesh object to another. The target object must have a UV 
map. Anchor places an item at a point on a mesh corresponding to coordinates in its UV map. The position cannot be 
animated over time, but there are several options. Add Anchor to the item you wish to place, not the item on which 
items will be placed.

After IK - run the Anchor plugin after any IK has taken place for the item being placed
Mesh - The mesh on which an item will be placed (the Anchor)
UV Map - The UV map from the mesh to be used for placement
Place on Mesh - Switch to place item on mesh or not. If this is unchecked the item remains unattached, but 
rotations will still be affected
Align with Mesh - The pivot is used to connect to the Anchor mesh. Alignment is done so that the item's X axis 
points in the direction of increasing U, Z axis in the increasing V direction
Undo Parent Scaling - When you use Anchor it is a good idea to parent the item that will be anchored to the item 
that is the Anchor, though not necessary. If you do, then Undo Parent Scaling becomes available. It works by 
keeping the scale of the anchored item constant despite the scaling of the anchor,
Image - The dropdown here is for selecting or loading an image. The image is used purely for the UV map display 
under these options to help pinpoint an area of the UV map more easily than just the polygons.

Under the options is a display of the UV map used with a cursor. Clicking LMB on this display will move the cursor and 
the attached object in the viewport. You can zoom into the display if needed for more precision but the display will not 
move with the cursor. You will need to  zoom out to show more of the map and zoom in again at the new area, if 
needed.

The Anchor plugin needs to do some precalculations. The AnchorChain master plugin controls when that happens. It 
applies to all Anchor plugins in the scene.
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There are options here too:

Calculate when saving - Performs a scene-wide calculation that is saved to the scene file
Calculate when rendering - Performs a fresh calculation when F9 or F10 are used. It's probably best to switch this 
option off when using distributed rendering
Calculate now - Force a calculation

Here is an example of Anchor in use. The cube is parented to a Null and it is to the Null we add Anchor. This allows the 
freedom to animate the cube in terms of rotation and distance from the Anchor object of the ball. Also shown is the 
Undo Parent Setting. At first it makes no difference because we haven't parented the Null to the Sphere.
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Parenter

Parenter

An interactive way of dynamically parenting was added to LightWave 2015. With this Motion Modifier applied, a circular 
gizmo appears on the item Parenter is applied to that  you can drag in the Layout viewport to other items in the scene at 
the right time. The gizmo can be moved from item to item during the scene and applied to different items as needed. To 
cancel parenting you can right-click on the gizmo in the middle, but to allow parenting to move to a different item, drag 
the circle back to the host item.
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Advanced Animation
Go to the Animation section of the Reference part of the documentation for more in-depth animation advice:

Simulation

Bullet Dynamics — LightWave's implementation of the Bullet dynamics library
OpenVDB — Industry standard volumetrics
Fracture — Create realistic breaks for your objects
Flocking — Simulate animal flocking behaviors
FX Dynamics — LightWave's original dynamics system
HyperVoxels — LightWave's original volumetric system

Animating

Rigging
Bone Properties
General Group
Add Group
Modify Group
Detail Group
Edit Group
Motions Group
Assignments

Animation
Translate Group
Rotate Group
Transform Group
DopeTrack
Keyframer

IK Boost
Spline Displacement
Motion Mixer
Ray Cast Geometry
Spline Control
Instancing reference
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Getting Started with Modeler

Click here to expand Table of Contents...
Introduction to Modeling

Components of a 3D Object
Modeling in 3D
Points, Polygons, and Edges

Next...
User Interface Conventions

Introduction to Modeling
LightWave Modeler lets you create objects from scratch or edit existing objects. Object Modeling is the design and 
creation of wireframe objects from a simple shape, like an apple, to a complex shape, like a finely-detailed sports car. In 
Layout, you are the interior designer moving furniture and putting up pictures. In Modeler, you are the furniture maker 
and the builder of the house.


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Components of a 3D Object
What makes up a 3D object? It has two traits: its physical shape and its visual appearance. The physical shape of an 
object comprises points joined by lines to form faces that we call polygons. The form that the polygons present to us 
makes up an object’s shape.
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The visual appearance of an object consists of color and texture qualities that connote realism to the eye, which are 
called surface attributes or material properties. When you enter a room and look at your chair you see a certain shape 
(that of a chair) and a certain surface (maybe wood or metal), so you think, “chair”. In LightWave 3D you have the tools 
to create simple or complex objects and define their surface qualities with great precision and detail.

Modeling in 3D
How would you make a mug? It depends; if you were a sculptor, you would mould a lump of clay. If you were a designer, 
you would draft it with paper and a mechanical pencil. If you were an artist, you would probably sketch it. But suppose 
you were using a computer. How would you make a mug? What tools would you use?
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You want to portray the mug with realistic color, depth, and shading. You need drawing tools, yes, but also power tools! 
With the computer, you can create the mug in a variety of ways. LightWave recreates drafting and workshop tools on 
screen so that people who are neither sculptors nor traditional artists can use them just as easily. In fact, LightWave’s 
tools do more than their real-life counterparts. There are several bonuses to computer design also. You can undo a 
mistake, something that is difficult to do in many of the arts. And there’s no mess to clean up.

Points, Polygons, and Edges
Generally, 3D Modeling is based on two simple elements: the point and the polygon. A point is a location in space, just 
as a point in a dot-to-dot coloring book represents a location on the page. Points are used as anchors to create 
polygons. Since points alone do not have height, width, or depth, they cannot be seen or rendered. However, you can 
load them into Layout and use points as invisible influences on other objects: as a center of rotation, or to play an 
invisible role of influence in an object hierarchy, for example. A third, in-between, mode is the edge mode. Edges are the 
lines which connect the individual points and form the outline of a polygon.

The process of creating 3D objects is a lot like drawing in dot-to-dot coloring books - of course, with 3D Modeling, the 
dots can also be placed in a third dimension (i.e., depth). Once placed, the dots can be connected with lines to form 
polygons. That collection of polygons, also referred to as an object, forms a recognizable shape that the computer can 
draw and animate. Polygons are usually three-sided triangles or four-sided quadrangles (although they can consist of 
more sides).
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You create or edit all objects using the same XYZ coordinate system used in Layout. The difference is that in Layout you 
are usually positioning an entire object, whereas in Modeler you are positioning the points that make up an object. 
Modeler also uses the XYZ coordinates 0, 0, 0 as the Origin.
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Left: Points that make up a head, Right: Polygons that make up the same head

The Origin is the default rotation center (called the pivot point) for objects in Layout. Keeping this in mind as 
you model your objects will make the objects load into Layout properly without having to move the pivot 
point.


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User Interface Conventions
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Introduction to Modeler

Introduction to Modeling
LightWave Modeler lets you create objects from scratch or edit existing objects. Object Modeling is the design and 
creation of wireframe objects from a simple shape, like an apple, to a complex shape, like a finely-detailed sports car. In 
Layout, you are the interior designer moving furniture and putting up pictures. In Modeler, you are the furniture maker 
and the builder of the house.

Components of a 3D Object

What makes up a 3D object? It has two traits: its physical shape and its visual appearance. The physical shape of an 
object comprises points joined by lines to form faces that we call polygons. The form that the polygons present to us 
makes up an object’s shape.
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The visual appearance of an object consists of color and texture qualities that connote realism to the eye, which are 
called surface attributes or material properties. When you enter a room and look at your chair you see a certain shape 
(that of a chair) and a certain surface (maybe wood or metal), so you think, “chair”. In LightWave 3D you have the tools 
to create simple or complex objects and define their surface qualities with great precision and detail.

Modeling in 3D

How would you make a mug? It depends; if you were a sculptor, you would mould a lump of clay. If you were a designer, 
you would draft it with paper and a mechanical pencil. If you were an artist, you would probably sketch it. But suppose 
you were using a computer. How would you make a mug? What tools would you use?



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  545

You want to portray the mug with realistic color, depth, and shading. You need drawing tools, yes, but also power tools! 
With the computer, you can create the mug in a variety of ways. LightWave recreates drafting and workshop tools on 
screen so that people who are neither sculptors nor traditional artists can use them just as easily. In fact, LightWave’s 
tools do more than their real-life counterparts. There are several bonuses to computer design also. You can undo a 
mistake, something that is difficult to do in many of the arts. And there’s no mess to clean up.

Points, Polygons, and Edges

Generally, 3D Modeling is based on two simple elements: the point and the polygon. A point is a location in space, just 
as a point in a dot-to-dot coloring book represents a location on the page. Points are used as anchors to create 
polygons. Since points alone do not have height, width, or depth, they cannot be seen or rendered. However, you can 
load them into Layout and use points as invisible influences on other objects: as a center of rotation, or to play an 
invisible role of influence in an object hierarchy, for example. A third, in-between, mode is the edge mode. Edges are the 
lines which connect the individual points and form the outline of a polygon.

The process of creating 3D objects is a lot like drawing in dot-to-dot coloring books - of course, with 3D Modeling, the 
dots can also be placed in a third dimension (i.e., depth). Once placed, the dots can be connected with lines to form 
polygons. That collection of polygons, also referred to as an object, forms a recognizable shape that the computer can 
draw and animate. Polygons are usually three-sided triangles or four-sided quadrangles (although they can consist of 
more sides).
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You create or edit all objects using the same XYZ coordinate system used in Layout. The difference is that in Layout you 
are usually positioning an entire object, whereas in Modeler you are positioning the points that make up an object. 
Modeler also uses the XYZ coordinates 0, 0, 0 as the Origin.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  547

 

Left: Points that make up a head, Right: Polygons that make up the same head

The Origin is the default rotation center (called the pivot point) for objects in Layout. Keeping this in mind as 
you model your objects will make the objects load into Layout properly without having to move the pivot 
point.


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1.

Editing Objects

Editing Objects

Generally, to build a 3D object, you create, combine, and modify simple shapes into more complex shapes. This is 
known as editing. The basic building blocks (i.e., primitives) include cubes, spheres, cylinders, and other shapes. Using 
tools not unlike those found in a wood or metal shop, you form a realistic representation of the envisioned object.

If you were building a desk, you would work from a sketch, a photograph, plans, or a small model of the desk you 
intended to build. This approach also works well for Modeling 3D objects. Having the actual shape or a representation 
of the object in front of you while you design is invaluable, and it will aid you in determining size, shape, angle, color, 
and more. Whenever possible, work from pictures or small-scale models. Picture books, magazines, blueprints, and 
visual dictionaries are useful companions to have nearby.

Selection Mode: Points, Edges and Polygons

The process of object editing involves manipulating points, edges and polygons. It will include selecting some portion 
of an existing object, choosing the operation to perform, adjusting any parameters for that operation, then carrying out 
the operation.

The concept of selecting is very important to Modeler. Selection is the act of specifying either the object itself, or a 
portion of it, that you intend to edit next. The most basic elements that you can modify include points, edges and 
polygons - the dots and multi-sided shapes that make up all objects. Any number of points, edges, polygons, or objects, 
in any combination, may be selected for a specific operation.

Point Selection

Points generally appear in two ways on-screen, selected and unselected. Selected points are highlighted, while 
unselected points remain small dots.

To select points:

Use Point Selection mode (Point button or Ctrl +G ). The Mode Selection buttons are located at the left of the 
screen under the top menu group.

Have a Plan!

Everything in a layer is considered selected when nothing is selected.

When selecting and unselecting, make sure that no Modeling tool is currently active. You can usually tell if a 
tool is active based on the mouse pointer. You can quickly deactivate any tool by pressing the Spacebar (or 
RETURN); however, if no tool was active, you will change the edit mode.


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1. Drag your LMB over points in an object and then release the mouse button to select those points. 

To add more points to a selection:

Hold the Shift key while you select with your LMB to add points to the existing selection or just click your MMB.

To lasso a group of points:

With the RMB , drag out a circle around points to select a group. As you might expect, you can add more points to a 
selection by holding the Shift key and dragging out a circle around the additional points you wish to select.

Once you have selected points and released the mouse button, you cannot select additional points in the 
same manner. You will need to hold down Shift to continue selecting or use the MMB.



If you know the number of points you want to select, check the information display above the Point (Selection 
mode) button. It shows you the number of selected items.


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1.

1.

To deselect points:

If selected points exist (and you have released the mouse button), dragging over them with your LMB will deselect 
them. You can also use the lasso by dragging with your RMB.

To deselect all points:

Click in any non-active (i.e., not a button) area on the toolbar to deselect all points. You can also use the Drop Current 
Tool command (/). Also, clicking on the number of selected points in the Selection Counter information display above 
the Point (Selection Mode) button will deselect all selected points.

There is an option in Modeler Display Options to double-click (off geometry, anywhere in the viewport) to drop the 
selection. The last selection can be restored by hitting the Drop/Restore Selection button or using the default keyboard 
shortcut of /.

Edge Selection

Edges generally appear in two ways on-screen, selected and deselected. A selected edge will appear highlighted with 
outlines in yellow (default). You will see that selecting edges is very similar to selecting points or polygons.

To select edges in a viewport:

Use Edge selection mode . The Mode Selection buttons are located at the left of the screen under the top menu 
group.

If you are using a viewport set to a non-shaded Rendering Style (Display Options), like wireframe, drag your LMB
over the edges and then release the mouse button.
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To add more edges to a selection:

Hold the Shift key while you select with LMB to add more edges to the existing selection or just click your MMB.

To lasso a group of edges:

With the RMB, drag out a circle around edges to select a group. Only the edges located completely within the outline are 
selected. Of course, you can add more edges to a selection by holding the Shift key and then drag out a new circle 
around the edges you wish to add to the selection.

To deselect edges:

If selected edges exist (and you have released the mouse button), dragging over them with your LMB will deselect them. 
You can also use the lasso by dragging with your RMB.

To deselect all edges:

Click in any non-active (i.e., not a button) area on the toolbar to unselect all edgess. You can also use the Drop Current 
Tool command (/). Also, clicking on the number of selected edges in the Selection Counter information display above 
the Point (Selection Mode) button will deselect all selected edges.

Once you have selected edges and released the mouse button, you cannot select additional edges in the same 
manner.


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1.

2.

There is an option in Modeler Display Options to double-click (off geometry, anywhere in the viewport) to drop the 
selection. The last selection can be restored by hitting the Drop/Restore Selection button or using the default keyboard 
shortcut of /.

Polygon Selection

Polygons generally appear in two ways on-screen, selected and deselected. A selected polygon will appear highlighted 
with outlines in yellow (default). You will see that selecting polygons is very similar to selecting points and edges.

To select polygons in a viewport:

Use Polygon selection mode (Ctrl+ H ). The Mode Selection buttons are located at the left of the screen under 
the top menu group.

If you are using a viewport set to a non-shaded Rendering Style (Display Options), like wireframe, drag your LMB
over the edge of polygons and then release the mouse button. This selects polygons that share that edge. With a 
shaded rendering style like Texture or Smooth Shade, you can click directly on the polygon’s face.

Edges are always part of a polygon. Cutting, or otherwise deleting or hiding, an edge will also remove the 
associated polygon.


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As polygons become selected, they will become highlighted and you will see a dotted line extending out of the face of 
the polygon and perpendicular to that polygon (The Normal display option must be active.). This dotted line is also 
referred to as the normal of the polygon or surface. The normal line indicates which side of a polygon has a face (the 
surface of the polygon you can see) or which direction the polygon is facing. In LightWave polygons by default have only 
one face. This means if you rotate a polygon the other side will not be visible because it is not double sided.

To add more polygons to a selection:

Hold the Shift key while you select with LMB to add more polygons to the existing selection or just click your MMB.To 
lasso a group of polygons:

With the RMB, drag out a circle around polygons to select a group. Only the polygons located completely within the 
outline are selected. Of course, you can add more polygons to a selection by holding the Shift key and then dragging 
out a new circle around the polygons you wish to add to the selection.

To deselect polygons:

If selected polygons exist (and you have released the mouse button), dragging over them with your LMB will deselect 
them. You can also use the lasso by dragging with your RMB.

To deselect all polygons:

Click in any non-active (i.e., not a button) area on the toolbar to unselect all polygons. You can also use the Drop 
Current Tool command (/). Also, clicking on the number of selected polygons in the Selection Counter information 
display above the Point (Selection Mode) button will deselect all selected polygons.

There is an option in Modeler Display Options to double-click (off geometry, anywhere in the viewport) to drop the 
selection. The last selection can be restored by hitting the Drop/Restore Selection button or using the default keyboard 
shortcut of /.

Selection with In-line Points/Polygons/Edges

If there are points/polygons/edges in-line (on top of each other) in a viewport using a non-shaded rendering style (i.e., 
Wireframe), you select all of the points/polygons/edges when you select with your mouse. However, shaded viewports 
respect polygons facing away from you and those obscured by other polygons. Thus, you can select by clicking on a 
polygon’s face without worrying about what’s behind or on the other side. You can change the Rendering Style from the 
pop-up menu on the viewport titlebar or on the Viewport Tab of the Display Options Panel.

Once you have selected polygons and released the mouse button, you cannot select additional polygons in the 
same manner.
If you know the number of polygons you want to select, check the information display above the Point 
Selection Mode button. It shows you the number of selected items.



Selecting a group of polygons and then deselecting the ones you don’t want is often the only way to select the 
ones you do want.


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1.
2.
3.

4.
5.
6.
7.
8.

Symmetrical Selection

When you select polygons/points/edges on the positive X axis and Symmetry mode (Symmetry button) is active, 
polygons/points/edges on the negative X axis are also selected (or deselected). Polygons/points/edges must be exactly 
opposite each other on the positive and negative sides of the X axis for this command to work properly.

Sel Entire Surface - Selects all the polygons making up the surfaces of the polygons that are currently selected.
Sel Entire Part - Selects all the polygons making up the parts of the polygons that are currently selected.
Select Path - Selects a shortest path (there can be multiple) between two elements. The selected elements can 
be of any type (vertex, edge, polygon).
Select Outline Points - Selects the outer points of a selected set of polygons.
Select Outline Edges - Selects the outer edges of a selected set of polygons.
Edge Selection
Loop Expand - Expands an edge selection along an edge loop.
Loop Contract - Shrinks an edge selection along an edge loop.

Symmetry also affects polygon editing.
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Viewports

Viewports

The largest part of the interface consists (by default) of four viewports. You can edit in any viewport and will be 
spending a lot of time in this area of the interface. The default four viewports starting in the top left and moving 
counter-clockwise are labeled Top, Back, Right, and Perspective.

The Top view is an overhead point of view looking down on the object. The Back view looks directly at the object from 
the rear. The Right view is positioned as if you stood to the object’s right. Perspective is a forced perspective view that 
you can rotate by holding the Alt key and dragging your mouse on it.

You can change the relative sizes of the windows by dragging any border between the viewports.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  556

 
As you grow familiar and gain experience with Modeler, you will find yourself switching back and forth among these 
viewports, changing their size, position, and function, and even changing the number, to get the best view from which 
to use a particular tool. You can adjust the screen to see as much or as little detail as you want, by using various options.

Save View Presets

You also have the option in Modeler of saving viewport presets. You can place the cursor over a particular viewport and 
use the Ctrl key in combination with any of the number keys on the numeric keypad to map that viewport or the whole 
window to that hotkey. For example, if you place your cursor over the perspective viewport and hit Ctrl numpad 9, you 
can assign that viewport to that hotkey. Each time you hit the numpad 9 key while holding the cursor over ANY 
viewport, it will change to your preset. This is a great way to easily switch viewports or even whole viewport setups 
instantly for different workflows.

Resetting Tools

Non-interactive areas (e.g., not a button) on the toolbar and bottom border (including the left-corner information 
display and grid size) act as a Reset button, much like you might use the ESC key on other applications. What happens 
when you click in a reset area depends on the current state of tools. For example, if you have points/polygons/edges 
selected and you are in the Point/Polygon/Edge Selection Mode, they become unselected.

You can Maximise a viewport by moving the cursor over it and pressing the Numeric 0 key on the keyboard.
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All built-in tools (i.e., primitive and modifying) maintain their state, if they are used, unselected, and then used again. 
The default state of the tool can be recovered by dropping (clicking in a reset area or choosing View/ Selection/ Drop 
Selection when a tool is selected, but inactive.) If the tool is active, the first drop deactivates the tool, keeping the 
current settings. The second drop would then reset to the default settings.
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Modeler File Menu

Starting a New Object

(default keyboard shortcut Shift N)

To start editing a new object from scratch, select File > New Object. A new object called Unnamed is created with empty 
layers.

Loading an Existing Object from Disk

(default keyboard shortcut Ctrl O)

Objects can be created, loaded into Layout, or loaded directly into Modeler.

 
To load an object into Modeler, select File > Load Object. The object becomes the current object and all of its layers are 
loaded.

Choose File > Load Object into Layer to load an object file into the currently selected layer. If the file contains multiple 
layers, they will all be loaded into the same layer.Choose File > Recent Files to reload an object that you had recently 
opened.Choose File  > Revert Current Object to put the current object in its last-saved state. Essentially, this is like 
closing and reloading the object.

Importing an Object

EPS

The EPSF_Loader command (File > Import > EPSF Loader) converts Illustrator (.ai) and encapsulated PostScript (.eps) 
files into two-dimensional LightWave objects, by converting bezier curves into tessellated polygons.

You may select multiple objects to load at once, by selecting more than one object at once in the file requester.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  559

•
•
•
•

The Curve Division Level option sets the desired level of detail.

      Curve Level - Rough, Standard, Fine, Super Fine

The Convert to pop-up menu sets the type of object that will be created.

Closed Polygons & Poly Lines - Will create a 2-point polygon chain and Polygons where vector lines are in the file.
Closed Polygons - Will create closed polygons where vector lines are in the file.
PolyLines (Line Polygons) - Will create a 2-point polygon chain where vector lines are in the file.
Spline Curves - Will create splines where vector lines are in the file.

The EPS file is defined by either typing the full path in the EPSF File input field or using the requester button to bring up 
a file requester.

Auto Axis Drill will attempt to automatically drill holes in faces, where appropriate. (e.g., the two holes in the number 8).

Auto Centering will center the resulting geometry.

If the EPS uses a gradient fill, you will need to convert it to a solid fill (e.g., using Illustrator) before using this 
loader.



If this option is not checked, the geometry will be created and you will have to manually create the hole.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  560

Pdbreaderv3

The Protein Data Bank (PDB) is an archive of experimentally determined three-dimensional structures of biological 
macromolecules, serving a global community of researchers, educators, and students. The archives contain atomic 
coordinates, bibliographic citations, primary and secondary structure information, as well as crystallographic structure 
factors and NMR experimental data.

This importer will read the PDB data and convert it to a LightWave Object.

More information about the PDB can be found here: http://www.rcsb.org/pdb

Due to the inherent differences between 2D structured drawings and 3D objects, there will usually be some 
amount of cleanup required.
This command has been tested with Illustrator files up to version 8.



http://www.rcsb.org/pdb
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•

•

•
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Vertex Loader

Use Vertex Loader in order to edit Weight Maps for bones that were created from scratch in Layout, or bones that were 
converted from Skelegons.

To use Vertex Loader, choose File > Import > Vertex Loader. First the Load Scene requester opens; select a scene file that 
has object(s) with bones. After you select a scene file, the following dialog box appears. There you select an object that 
you want to edit and click OK.

The selected object is automatically loaded into Modeler and displayed in Vertex Paint with its bones. If the object is 
already loaded, only the bones are loaded from the scene file. Weight Maps set on the Bone Properties Panel in Layout 
are used for each corresponding bone.

Saving Object FilesWhen you save an object, all layers are saved and preserved. You have several options which are all 
available from the File menu:

Save Object (default keyboard shortcut s ) - This option saves the current object using its filename. If the object 
has never been saved before, this is the same as using Save Object As.
Save Object As (default keyboard shortcut Ctrl s ) - This option opens a file dialog letting you name (or rename) 
the object before saving.
Save Layers As Object - Use this to save a foreground layer to its own object file. If multiple layers are selected, 
they will be saved in a single layer. Make sure you add the .lwo filename extension to your object name when 
saving.
Save All Objects - This option saves all files using their filenames. If any new objects haven’t been saved before, 
you are alerted and given the option of naming them.
Save Incremental (default keyboard shortcut Shift s ) - This option will give you the ability to save a version of an 
object by adding incremental numbers to the object’s name. This is handy when you want to save your object in 
various stages of the Modeling process.

Before launching Vertex Loader, please make sure Layout’s Content Directory setting matches Modeler’s.

An asterisk will appear next to the names (on the current pop-up menu) of objects that have been modified 
since their last save.


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Closing Object Files

Once you are finished with an object, you can close it by selecting Close Object from the Files pop-up menu. You can 
close all object files by selecting Close All Objects. If any objects are unsaved, you are alerted and given the option of 
saving them.

New to 2019, there is now a "Don't Save Any" option for closing objects to make closing multiple objects more 
rapid.

Sections

Save-Object-Section - You can use this to save a selected polygon as an object
Save-Object-Section-Cut - Saves the selected object section, and then cuts it from the object itself.
Save-Object-Section-Points - Use this plugin to save selected points of an object.
Save-Object-Section-Points-Cut - Saves the selected points, then cuts them from the object itself.

Exporting Objects

The File > Export menu has several options to export your LightWave object into different formats.

This plugin will allow you to save your object as an encapsulated postscript file (.eps). In the View pop-up menu, select 
which of your viewports you want to include in the file. The Texture UV View is especially useful for exporting UV 
projections to use as templates in a paint program. If you want to include the grid or points, activate Draw Grid or Draw 
Points.

Objects revert to their on-disk version in other Hub applications (e.g., Layout) when you close them or exit 
Modeler and do not save them first. This will cause you to lose unsaved attributes like surface changes.


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1.
2.
3.

4.

 
Enter the path and filename in the file input field or click the Export File button to bring up a file dialog. Define the size 
in inches of the resulting drawing using the W (width) and H (Height) field.

Export 3DS

Use this to Export to AutoDesk 3DS file format. An object can consist of no more than 65,535 polygons that must be 
triangulated for this format.

Export DXF

Use this to Export to DFX file format. DXF is the standard format for 3D objects and is used by most programs that 
support 3D content. DXF files can’t contain polygons with more than four points.

Export LightWave 5

Use this to Export to LightWave’s old Object file format. Anything after LightWave 5.7 uses current LWO file format.

Export OBJ

Use this to convert a LightWave object to Wavefront .obj file format specification. UV maps are not preserved in Export 
OBJ unless you follow these steps:

Load the object
Give it a UV texture map.;
Hit F5 and open the Surface Editor and hit the T next to the Color channel. In the Texture Editor, leave the 
texture type as Image Map, select UV as Projection and the UV map you created. You do not need to load an 
image;
Export as OBJ and then reload the object. You will see that the UV texture map is preserved, albeit renamed..

Path to Motion

Takes a spline from Modeler and makes it into a motion path for Layout.

Throw

Calculates trajectory and bounce on given item and inputs - output is a motion file for Layout.
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Quit

(default keyboard shortcut Shift Q)

Quit will shut down LightWave Modeler.
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Modeler Edit Menu

Basic Point, Edge, and Polygon Maintenance

Cut, Copy, Paste, Paste in Place, Delete

The basic steps to copy and paste points, edges, and polygons are essentially the same. First, you select the points, 
edges, or polygons. Then you either click the Copy button (Ctrl C) to copy the selection into the memory buffer, 
retaining the original, or click the Cut (Ctrl X) button to delete the selection. You can also use the Del key to run the 
Delete command; it is similar to Cut, but does not copy the data to memory for future pasting.

Once something is in the memory buffer, you can click the Paste in Place tool (Edit > Paste in Place) (Ctrl V) to paste the 
contents back into the layer. The memory buffer is not reset after pasting. Thus, you can paste the contents multiple 
times. The buffer contents change only when they are replaced by a subsequent cut or copy. For interactive pasting, use 
the Paste tool (Edit >Paste).

Undoing Operations

LightWave Modeler offers an undo function that lets you take back the last change you made while working on an 
object. The Undo button (Ctrl Z) is located in the Edit drop down menu. The number of undos is determined by the 
Undo Levels setting found in the General Options Panel. The maximum value is 128, but you can also be limited by your 
computer system RAM. However, minimally-configured systems should be able to go back several steps if necessary. 
Even power-users should find 10 undo levels sufficient.

Redo

It’s possible to go too far unintentionally and undo too many steps. To correct this error, click the Redo (Z) button 
located in the Edit drop down menu. As long as you have made no editing changes, you can redo all the way back to 
your last Modeling operation.The combination of Undo and Redo is a powerful tool, allowing you to step backward and 
forward through the evolution of a model. This is especially useful when you use some of the more advanced Modeling 
tools, and you may need to make a series of subtle changes to a model as you design it by undoing and redoing as 
needed until you achieve the desired shape.

Geometry cut (or copied) to the memory buffer loses its association with geometry it is cut away from, even 
when it is pasted back in.



If you undo back five steps, then use a new tool, you will no longer be able to redo those steps. Undo is like 
history that unfolds as you model. If you go back and change the model, then you have changed the course of 
history in a fundamental way. The structure of the model is now different, and redo will be unable to restore it.


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Configure Keys

Configure Menus

Syncmesh Tools

Edit Modeler Tools

This Options Panel gives you the ability to set new default settings on Cut, Divide, and Make Poly. Also, this is where you 
will need to set the settings for the three Quick Cut tools. By default the Quick Cut tools all have the same setting and 
you will need to define them in this panel.

Custom Preferences

You can use Edit > Import Preferences File and Edit > Export Preferences File to load and save, respectively, Preference 
settings. Use this feature to access special-purpose Preference settings you might set up. You can also use Edit > Revert
to Startup Preferences to go back to the settings that existed when you first started Modeler.

The Preference settings that exist when you shutdown Modeler will become the startup settings for your next 
session.


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General Options - See General Options Section below.Display Options - See Display Options Section, starting on the 
next page.Backdrop Options - Part of the Display Options.Recent Content Directories - The Content Directory is a central 
file path for loading objects, images, and scenes. Note that this setting is shared by all LightWave applications. This 
drop down menu will store recently used Content Directories to help gain access to past projects.

Modeler General Options

Modeler Display Options

Font Specification

You can specify the font to use for Modeler and Layout by launching with a commandline option. This was already 
available in LightWave v9 but only for Layout. Buttons will remain the same size for LightWave interfaces so this option 
should be used judiciously.

The possibilities are as follows:

-f &lt;fontname&gt;@&lt;pointsize&gt;

--font-app=&lt;fontname&gt;@&lt;pointsize&gt;

--font-edit =&lt;fontname&gt;@&lt;pointsize&gt;

Don’t forget to enclose font names with spaces in them in quotes as follows:

This will give this look to Modeler:
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Note that the Color channel text is missing and Luminosity , Diffuse and others are truncated.

If you want to create shortcut icons to launch Layout/Modeler follow the same methods as for redirecting configs and 
plugins.
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Modeler General Options

(default keyboard shortcut O)

You can access the General Options Panel by choosing Edit > General Options.

General Tab
OBJ Tab
Color Space Tab

General Tab

Content Directory - The Content Directory is a central file path for loading objects, images, and scenes. Note that 
this setting is shared by all LightWave applications.
Default Polygon Type - Some operations in Modeler create many polygons in one operation. As such, the 
computer must decide whether to generate triangles (three-point polygons) or quadrangles (four-point 
polygons), depending on the shape’s requirements.

To force the computer to use Triangles or Quadrangles, select either for the Polygon setting. Choose Automatic 
to let the computer create the most appropriate polygon type for each given operation.
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Flatness Limit - The Flatness Limit setting determines whether Modeler regards a polygon as planar or not. Note 
that a non-flat polygon considered planar according to this setting can still cause rendering errors. 

All polygons must have a surface name. When geometry is created, polygons are given the default surface name 
of Default. You can change the default name by changing the Surface field. This will affect only geometry created 
from that point on, however. Use the pop-up to the right of the field to select from existing surface names.

Curve Divisions  - The Curve Divisions setting determines how smoothly a curve (e.g., spline curves, text, etc.) 
should be interpolated. The finer the setting, the greater the number of polygons used, and the smoother the 
resulting curve division.
SubPatch Divisions - When a SubPatch object is frozen with the Freeze command ( Ctrl D), it is converted into a 
polygonal object. The Patch Division setting determines the level of detail used in the resulting object. The 
number entered in the Patch Division field must be 1 or greater and is restricted to whole numbers.

The number of polygons per SubPatch surface will be equal to the square of the Patch Division number. For 
example, if set to 4, each SubPatch surface will be converted into 16 polygons arranged in a 4 by 4 array. A 
setting of 2 would result in 4 polygons arranged in a 2 by 2 array. For Catmull-Clark patches, every level of 
Catmull-Clark subdivision quadruples the number of polygons.

The higher the setting, the higher the number of polygons used. Because of LightWave’s surface smoothing 
capabilities, you can often get away with a setting of 2 and sometimes even 1, which will keep the polygon count 
of your objects to a minimum.

Metaball Resolution - This setting determines the amount of detail used to display metaballs.
Symmetry Tolerance - Sets the amount matching elements can differ on opposite sides of the symmetry for 
symmetry to work.

Frames Per Second - Added to 2019 for nodeflows that have a time component, envelopes or nodes 
like Time.
Image Cache Maximum - If enabled, sets the amount of caching available for images in megabytes.

To create optimal objects, your goal is to keep the polygon count down. They will load and render faster than 
bloated objects, with no visible difference. As such, Quadrangles is the suggested setting for most cases. This 
lets you manually choose the areas that require triangles.



When you create a surface using the Change Surface dialog (Detail > Polygons > Surface), the option (Make 
Default) automatically sets the default surface name.



Setting this value too high with heavy-polygon SubPatch models can cause the performance of Modeler to 
degrade. If Modeler appears to be running sluggishly when working with SubPatch models, lower this value to 
help improve performance.


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2.
3.
4.
5.
6.
7.
8.
9.

10.
11.
12.
13.
14.

OBJ Tab

The OBJ tab contains options for importing and exporting OBJ file objects.

OBJ One Layer - imports the object as a single layer
OBJ One VMap - imports the object with a single vertex map
OBJ Pivot at Center - creates the pivot of the object at the center of the object
OBJ Write Normals - writes the normals associated with the object when saved
OBJ Merge Points - merges points sharing the same space
OBJ Reverse Ka & Kd - Reverses Ambient Occlusion and Diffuse channels
OBJ Double Sided - Creates double-sided geometry
OBJ Parts - Keeps LightWave Part Polygon tags
OBJ Foreground Layers - Only saves layers marked as foreground to OBJ
OBJ Continuous UV - UVs have shared points rather than duplicated
OBJ Smoothing Groups - Supports the new Smoothing Groups system
OBJ Remove Hidden - Polygons that are hidden will not be exported (Hiding layers does not have any effect)
OBJ Import Scale - sets the scale of an object when it is imported
OBJ Export Scale - sets the scale of the object when it is exported

https://docs.lightwave3d.com/display/LW2019/Smoothing+Groups
https://docs.lightwave3d.com/display/LW2019/View+Group
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2.
3.
4.

1.

Color Space Tab

Color space conversion is performed in four places in LightWave.

On loading, an image can be converted from its native color space format to linear.
When sent to the Image Viewer, an image can be converted from linear to another color space.
When saved from the renderer, an image can be converted from linear to another color space.
When picked from the Color Picker, a color can be converted from and then to linear color space.

The color space defaults are set up on the Layout Preferences panel.When an option is selected in the pop-up it 
becomes the current item for that selection.

Color tables are added to the selections, as if they were built-in.

A color table can be loaded by using Load Table from the pop-up. The color tablesare stored in the project directory, in 
a directory called Color Tables.

In the Image Editor, there is a check box, Treat as Alpha. This means use the alpha channel from the Preferences Default 
setting, not the alpha channel from the color space in the Image Editor. This is an override on the alpha color space 
selected in the Image Editor.

One can set the color correction for the Viewer files with palettes, 8-bit files, floating point files, alpha channel and the 
color picker from the preference default panel and the Modeler General Options panel.

When an image is loaded, if the file setting for that image is set to default, then an attempt is made to look at the 
metadata setting for that image. If the metadata settings have the color space the image was saved in, then it is used. 
For example, jpegs have metadata setting for sRGB and Adobe 1998 linear format.

The built-in color spaces are:

Linear, LightWave linear color space.
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1.
2.

sRGB, Standard RGB color space.
rec709, BT.709, HDTV
Cineon, Eastman Kodak Co.

The color lookup tables come in two formats:

LightWave color table format.
3D LUT format.

LightWave color table format is as follows:

Code:
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EGA
17, -0.5, 1.5
; Convert on load.
-0.5, -0.5, -0.5, -0.5
-0.375, -0.375, -0.375, -0.375
-0.25, -0.25, -0.25, -0.25
-0.125, -0.125, -0.125, -0.125
0.0, 0.0, 0.0, 0.0
0.125, 0.125, 0.125, 0.125
0.25, 0.25, 0.25, 0.25
0.375, 0.375, 0.375, 0.375
0.5, 0.5, 0.5, 0.5
0.625, 0.625, 0.625, 0.625
0.75, 0.75, 0.75, 0.75
0.875, 0.875, 0.875, 0.875
1.0, 1.0, 1.0, 1.0
1.125, 1.125, 1.125, 1.125
1.25, 1.25, 1.25, 1.25
1.375, 1.375, 1.375, 1.375
1.5, 1.5, 1.5, 1.5
; Convert on save.
-0.5, -0.5, -0.5, -0.5
-0.375, -0.375, -0.375, -0.375
-0.25, -0.25, -0.25, -0.25
-0.125, -0.125, -0.125, -0.125
0.0, 0.0, 0.0, 0.0
0.125, 0.125, 0.125, 0.125
0.25, 0.25, 0.25, 0.25
0.375, 0.375, 0.375, 0.375
0.5, 0.5, 0.5, 0.5
0.625, 0.625, 0.625, 0.625
0.75, 0.75, 0.75, 0.75
0.875, 0.875, 0.875, 0.875
1.0, 1.0, 1.0, 1.0
1.125, 1.125, 1.125, 1.125
1.25, 1.25, 1.25, 1.25
1.375, 1.375, 1.375, 1.375
1.5, 1.5, 1.5, 1.5 

Where:

EGA is the name of the color space that appears in the pop-up.

17 is the number of entries in the color table.

-0.5 is the lower range of the look-up table ( black ).

1.5 is the upper range of the look-up table ( white ).
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-0.5, -0.5, -0.5, -0.5 are the rgba values for the table entry.

Blank lines and lines beginning with comments, are skipped over.

3D LUT format tables are read in and a reverse lookup table is made. The name of the color space is the name of the file 
on the pop-up.

Auto Sense on Load detects the Color Space settings and uses those when a scene is loaded.

Color Correct OpenGL will color correct the OpenGL viewports.
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Modeler Display Options

(default keyboard shortcut D)

Modeler’s interface is highly configurable allowing to tailor it to your specific needs. You can change the arrangement of 
viewports as well as change the display characteristics for each viewport independently. Choose Edit  > Display Options 
 to bring up the Display Options Panel.

Layout Tab
GL Tab
Viewports Tab
Backdrop Tab
Interface Tab
Units Tab

Layout Tab

 
Layout options control the global arrangement of the viewports, the number of viewports and some other Global 
Display settings. Use the Presets pop-up menu to quickly set common layout configurations (Quad is the default 
setting). Selecting a Preset will affect the Layout setting, as well as settings on the Viewports Tab.
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If you want to set up your own custom layout, make a selection from the Layout pop-up menu. The icon to the left of the 
description will give you an idea of how the viewports will be arranged. Later, you will see that you have total control 
over what is in each viewport. In fact, each Layout option will remember the Viewport settings as they were the last time 
that Layout option was used.

Perspective Amount - The amount of perspective in the perspective view can be varied by changing the 
Perspective Amount slider on the Layout Tab. You can go from a very wide-angle to a flat nearly orthogonal view. 
The setting is global and affects all the perspective views the same way.
Background Color - Use the Background Color selector to change the color that appears in the background for 
viewports using a shaded display.
Default Sketch Color - Use the Default Sketch Color setting to change the color that the wireframe will appear in 
the various view modes. You can always change the Wireframe color on polygons using the Sketch Color tool 
located under the Detail Tab.
Selection Color Options - Use the Selection Color Palette for editing Point > Edge > Polygons when selected. 
Other options include changing the color for Normals and the color of active Tools.
Tool Color - Specifies the color for tool gizmos and Syncmesh tool text.
HUD Color - Specifies the color for the viewport surround when editing morphs.
HUD Opacity - Defines the strength of the color used for the HUD.
Fixed Normal Length - Change the length of the normal here.
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Show Options

The various Show Visibility options let you independently set what you want to see globally in your viewports.

Show Points - Points appear as small dots

 
Left: Show Points On, Right: Show Points Off

Show Surfaces - Surfaces are the polygon (or SubPatch) surfaces

 
Left: Show Surfaces On, Right: Show Surfaces Off

Show Cages - A cage is the outline that connects all of the control points when you edit a SubPatch object

 
Left: Show Cages On, Right: Show Cages Off
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Show Point Selection - When points are selected they appear highlighted if this option is selected

Show Guides - Guides are the dotted-lines that extend from the surface (patch vertex) to the control points on 
the cage (if visible) when you edit a SubPatch object

 
Left: Guides on, Right: Guides off

Show Normals - Normals are dotted lines that extend perpendicularly from selected (planar) polygons and 
indicate the direction a polygon is facing
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Show Origin - This option will show the 0 axis in the viewports. For the perspective view, only the X and Z axis 
are shown.

Show Grid - The grid is the background reference grid
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Show Polygon Selection - When polygons are selected they appear highlighted if this option is selected

Show Backdrop - A Backdrop is an image loaded for viewports on the Backdrop Tab. These images can be useful 
as Modeling reference

These visibility options can be overridden independently for each viewport on the Viewports Tab.
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• Show Edge Selection - When edges are selected they appear highlighted if this option is selected.

GL Tab

Texture Resolution determines the display resolution of images used. Lower settings will update faster and use fewer 
system resources.
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Texture Resolution - The Texture Resolution setting determines the resolution to use for displaying textures in 
viewports that have their Rendering Style set to Texture. Higher settings increase the detail of image textures 
displayed in viewports, but increase memory usage and display refreshing time.
Shading Method - Choose between MultiTexture shaders and GLSLShaders. Multi-texture shaders are simpler 
and intended for graphics cards that are less capable. GLSL is faster and shows more texture capabilities for 
modern cards.
Transparency Sorting - There are three options to choose from:

SortByObject -  sorting the objects by their distance from the camera - fast method
SortByPolygon - sorting polygons by their distance from the camera - slowest method
AlphaClipping - uses the alpha value of a texture in the transparency channel to determine transparency 
- fastest method

SortByObject is the default setting and will be the fastest in most cases.
Geometry Acceleration - Determines how the graphics card displays OpenGL. Streaming renders the mesh 
immediately to screen, using the lowest amount of memory at the cost of speed. Buffered(VBO) will attempt to 
store the geometry in graphics card memory, allowing for the highest speed, at the cost of memory. In cases 
where the mesh or shading changes with every frame no caching is possible, a fallback to the Streaming method 
will result, for example with animated meshes and reflection maps. Smooth shaded geometry will benefit the 
most from the Buffered(VBO) mode. If the mesh is buffered in graphics card memory the performance you will 
get as much performance as your graphics card can give you.
Pixel Blending - means texture filtering (mip-mapping)
Mipmapping - Mipmapping is similar to what is used in today’s games to avoid graininess of textures in a 
distance or at a flat angle. Basically lower- res versions of the texture are generated in realtime and blended in. 
This feature is supported in hardware by most of today’s graphics cards. Please note however that due to the 
nature of this filtering method, low-resolution textures may appear a bit blurry.
Reflections - Turns on reflection shading for Modeler
Transparency - Switches Transparency shading On/Off
Multitexture - Multiple texture layers per polygon in OpenGL
Frame Buffer Object - accelerates color correction (slightly)
Color Channel - De- /Activates the display of textures in the Color Channel if Multi-texturing is on
Diffuse Channel - De- /Activates the display of textures in the Diffuse Channel if Multi-texturing is on
Transparency Channel - De- /Activates the display of textures in the Transparency Channel if Multi-texturing is 
on
Luminosity Channel - De- /Activates the display of textures in the Luminosity Channel if Multi-texturing is on
Legacy OpenGL - uses pre-LightWave [8] geometry shading
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Viewports Tab

Viewport options let you change how objects are displayed in each viewport. To change the settings for a viewport, first 
select it using the Viewport buttons.

Use the Presets pop-up menu to quickly set the options on this tab for the selected viewport region. The selections are 
listed by view types, but will affect all of the settings on this tab.

The View Type pop-up menu determines the editing axes you want to use for the selected region.

For the Orthogonal settings, the names generally indicate the viewing perspective. Back (XY), for example, lets you edit 
along the X and Y axes. This means you are looking along the Z axis.

Since it is called Back, that means your perspective is from the back (i.e., negative side) of the Z axis, looking toward the 
positive side. UV Texture is entirely different - it is not used as a Modeling viewport but for adjusting UV texture maps.

There are four Display (group) commands assigned by default to certain keyboard shortcuts which affect the 
viewport beneath your mouse pointer. Shift F1 toggles the view between Back and Front, Shift F2 toggles 
between Top and Bottom, Shift F3 toggles between Right and Left, and Shift F4 toggles between Perspective 
and UV.


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Perspective

You may edit in a Perspective viewport, just as you would in any other, but you may also rotate your view perspective. 
This is Modeler’s virtual trackball, which enables you to rotate the object without affecting its orientation in the other 
three edit windows. It effectively provides you with three axes of rotation. While holding down the Alt key, you can 
perform these actions:

Rotate around the X axis (pitch) by dragging up or down directly across the verticle center of the viewport
Rotate around the Y axis (heading) by dragging left or right directly across the horizontal center of the viewport.
Rotate around the Z axis (bank) by dragging to the left or right around the perimeter

If the title bars are visible, you can drag the rotate drag button with your LMB to rotate. If you use the RMB, the viewport 
will rotate around its perpendicular axis. Holding the Ctrl key (or using your MMB) will cause rotations to snap to 15-
degree increments.

Rendering Style - The Rendering Style pop-up menu determines the style of display you want to use for the 
selected region:

Wireframe - Although the Wireframe is arguably the most limited display mode, it is the most commonly 
used Rendering Style because of its ease in viewing, selecting, and unselecting points and polygons.

Color Wireframe  - This is nearly the same as Wireframe, except the polygon edges are drawn using their 
Sketch color (Detail > Polygons > Sketch Color).

Imagine you are manipulating an imaginary ball with your mouse when you manipulate the Preview window.
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Hidden Line - Hidden Line shows an object’s Front Face polygons in wireframe view.

Sketch - Sketch shows an object in a combined wireframe and flat-shaded view. All polygon edges are 
drawn, but faces are also visible. This mode does not account for Surface settings, however. The polygon 
edges are always drawn in white and faces are grey. Background layers are visible.

You can change the polygon shading color in this mode by choosing Detail > Polygons > Sketch Color.
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Wireframe Shade - Wireframe Shade is a smooth-shaded mode that overlays the wireframe lines.

Flat Shade - In Flat Shade mode, the object is shown as a flat-shaded solid. This mode supports some 
Surface settings, but not smoothing.

Smooth Shade - Smooth Shade is a smooth-shaded mode that supports some Surface settings, such as 
Color, Diffusion, Specularity, Glossiness, Smoothing, and Double-sided.
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Weight Shade - Weight Shade provides visual feedback for editing Weight Maps.

Texture - Texture is similar to Smooth Shade, but it also shows images mapped to surfaces.

Textured Wire - Textured Wire is similar to Texture, but it also shows wireframes on the surfaces.

Upright Rotation - The Upright Rotation pop-up menu lets you rotate a viewport clockwise by 0, 90, 180, and 270 
degrees to accommodate imported objects from applications that may use other axes as up, or for exporting to 
them, for that matter.
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Titlebar Shortcuts

You can change the View Type and Rendering Style of a viewport without going to the Display Options Panel by using 
the pop-up menus on the title bar. Clicking on the left-most pop-up allows you to choose which View Type you want to 
be in and will then display it. The pop-up menu just to its right lets you choose the Rendering Style.

 
Note that if you have UV Texture selected as the View Type, the Rendering Style pop-up menu will instead list all loaded 
images. Select one to load it into the backdrop of that viewport.

Independent Options

The Independent options let you make certain viewport characteristics independent from other viewports. Changes to 
the selected characteristic do not affect it in other viewports and vice versa. For example, if a viewport uses 
Independent Zoom, zooming in it does not affect the zoom of other viewports. You must have your pointer over the 
viewport to affect an independent viewport. Independent Rotation is only applicable to perspective views. Normally, it 
is enabled. If you have multiple perspective views and this option disabled, they will move in unison when you rotate a 
view.

Independent Visibility

The lower portion of the panel contains the independent visibility options. You can individually select which visibility 
options are independent. To use them, you must also activate the Independent Visibility option. This option lets you 
quickly enable/disable this feature without losing the state of each setting.
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Backdrop Tab

On the Backdrop Tab, you can add full-color backdrop images that act as reference guides when you build objects. They 
let you model much like tracing a picture using tracing paper. To use backdrops, select the Viewport and the desired 
image from the Image pop-up menu.

From the Presets pop-up menu, you can save the settings for the selected Viewport to a file by choosing Save Current 
Backdrop. You can load this file later using Load Backdrop for any selected Viewport. You can also save the settings for 
all viewports by choosing Save All Backdrops. When this file is loaded later - using Load Backdrop - the individual 
Viewport settings are restored.

Use the Image drop down menu to select from the loaded images or choose (Load Image) to bypass the Image Editor 
and load a new image into Modeler and automatically select it for the current viewport.

Where possible, use square images.

If you are using a UV Texture viewport, you can choose a backdrop using any loaded image from what is 
normally the Rendering Style pop-up menu on the viewport’s title bar.



The backdrop images for the current default layout for each view configuration are cached as long as possible. 
Also, backdrops are not saved in config files or view presets.


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You can also adjust Brightness and Contrast. Use the sliders to adjust the settings. You can invert the colors by 
activating the Invert option. If you want to blend pixels for close-up work, activate the Pixel Blend option. Image 
Resolution determines the accuracy of the displayed image.

Aspect and Video images

The two Center and Size input fields are horizontal (top field) and vertical (lower field). Clicking Automatic Size will 
enter values that fit the defined image into an implied bounding box that surrounds visible geometry.

If you activate the Fixed Aspect Ratio option, you can enter a frame aspect ratio in the input field. Then, you only need 
to specify a horizontal size - the vertical size is computed automatically. If your images originated from video, you need 
to account for the pixel aspect ratio, since video pixels are not square like computer pixels. For example, a D1 NTSC 
image is 720 x 486 pixels; however, the frame aspect ratio is not 1.48 (720/486) as you might expect. The width of a D1 
NTSC pixel is 90 percent of the width, that is, a pixel aspect ratio of .9. As such, the true frame aspect ratio is 1.333 
(720/486*.9).

If you do not account for this difference, your models may appear slightly stretched when ultimately viewed on video. A 
way to fix this is to scale the object after the fact.

Colored background images sometimes make the wireframe hard to see (especially if the image has a bright 
white background). Setting the Contrast to its lowest value, and the Brightness to a little above the darkest 
value will produce a reasonable-looking backdrop that works well when Modeling.



The frame aspect ratio of a D1 PAL image is also 1.333 (720/576*1.067).
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Interface Tab

 
The Alert Level affects how error, warning and informational messages are displayed. The Toolbar Position setting 
determines if the main toolbar appears on the Left or Right side. Activate Hide Toolbar to make it hidden and maximize 
your screen real estate. Alt +F2 will hide (and more importantly, Unhide) the Toolbar as well.

Toolbar On/Toolbar Off

The Viewport Titles option turns the titlebars, which appear above each viewport, on or off.
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Toolbar On, Viewport Titles Off

Use the Input Device buttons to select the type of input device you are using.

You can optionally set Mouse Wheel Zoom to enable the use of the mouse scroll wheel to zoom in and out of a viewport. 
As with using the Ctrl Alt shortcut, the view will zoom based on your mouse pointer’s location.

The next option is for Double-click Deselect. This gives you the possibility to double-click on any empty space in the 
Modeler interface to deselect all selected Points, Edges or Polygons. You will still be able to use a single click in the 
normal deselect areas (under the menu buttons, on top of viewports, etc.) will this option is engaged.

The Fine Detail Cursor option, when active, makes your mouse pointer use the main crosshair pointer (Point mode) at 
all times instead of changing when the various tools and selection functions are used.

Fine Detail Cursor

The File Dialog pop-up menu lets you use custom LightWave dialogs for file loading/saving. Selecting Default will use 
your standard system dialog.

The custom File dialog provides many additional features not available with the standard system dialogs.
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The Visual Browser - You can make the LightWave visual browser the default file dialog for Layout and/or Modeler by 
choosing VBFileRequester on the File Dialog pop-up menu. This appears on the Interface Tab of Modeler’s Display 
Options Panel (Edit > Display Options).

 
The Color Picker pop-up menu lets you use custom LightWave dialogs for picking colors. By default it is set to the 
LightWave color picker shown below, but if you wish you can choose the system color picker here.

The Color Format setting determines the scale used where the color selector appears. Integer uses values 000 to 255, 
Float uses .00 to 1.00 and Percentage uses 0% to 100%.
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The Simple Wireframe Edges option turns off polygon offsetting for the sketch-like display modes. This may fix display 
problems on some video cards. The Simple Wireframe Points setting uses OpenGL’s own points for wireframe points 
and selected points at a user-specified size. These points can draw much faster than the standard points.

Units Tab

The Unit System determines the units of measurement that are used and displayed by the Modeler screen.

SI - is the International System of Units (SI is the abbreviation of the French “Le Système International d’Unités”). 
Unit measurements in Modeler will use a base system of meters. Grid sizes and distances can be measured in 
megameters, kilometers, meters, millimeters, micrometers, and nanometers.
Metric - The Metric System is the same as SI with the addition of centimeters.
English - The English System uses miles, feet, and inches.

If you input a value that uses a different unit of measurement than that of the default, LightWave will convert it on the 
fly. For example, you may be using meters, but typing in “5 ft” will convert to “1.524 m.”

Default Unit - Use the Default Unit pop-up menu to set an assumed measure when none is given for distance 
values.

We recommend you use the SI or Metric systems to model objects, since a system using base 10 is often much 
easier to use for purposes such as applying textures and adjusting object movement.


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Grid Units affects the zoom step amount but has no effect on the actual size of the object. You will likely find that 1 2.5 5 
and 1 2 5 are your most commonly used Grid Unit settings.

1 - The grid resizes in values that begin with 1, as in 10m, 1m, 100mm, 10mm, etc.
1 5 - The grid resizes in values that begin with 1 or 5, as in 1m, 500mm, 100mm, 50mm, 10mm, etc.
1 2.5 5 - The grid resizes in values that begin with 1, 25, or 5, as in 1m, 500mm, 250mm, 100mm, 50mm, etc.
1 2 5 - The grid resizes in values that begin with 1, 2, or 5, as in 1m, 500mm, 200mm, 100mm, 50mm, etc.
1 2   - The grid resizes in values that begin with 1 or 2, as in 1m, 200mm, 100mm, 20mm, 10mm, etc.

Grid Snap - The Grid Snap setting forces point creation and item movement to be limited to a specific increment.

None - None deactivates grid snap, so that items move freely and are not constrained by any grid intersections.
Standard - Standard sets the grid snap to one-tenth of the current grid size.
Fine - Fine makes the grid snap as small as possible for the current zoom level. This will be typically two to five 
times smaller than using Standard.
Fixed - Fixed lets you specify the increment of movement in the Snap Value input field. The grid will resize itself 
to use the value you specify.

Time Format - The Time Format setting allows you to set the display format for time values, like the Frame Slider 
Label option on Layout’s General Options Tab of the Preferences Panel. If the Hub is active, Layout and Modeler 
settings will be kept in sync.

If you use a metric Unit System, you should set the Default Unit to meters.
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Syncmesh Tools

In LightWave v11.5, Modeler gained new functionality and architectural changes that allowed increased interactivity for 
tools and more rapid tool development. 11.5 introduced several new tools for Modeler showing this system’s power and 
lays the groundwork for future first- and third-party modeling tool development. These tools are called Syncmesh and 
are differentiated from traditional Modeler tools by the presence of several new interface features.

All these new tools work on multiple layers and with Symmetry and share the same controls where appropriate:

Measure Amount - Clicking the button marked Measure Amount in one of the new tools’ Numeric window and 
the Numeric window will change to show a Line Start and Line End set of coordinates and you can pick a length 
using snapping to align with an object in the viewport, or even in a background layer.

Help text - Whichever viewport your mouse is over has the possibility of having a help text floating over it. This 
feature can be turned on or off in the Numeric panel and the state is remembered between tools.

Render Modes - A high-polygon mesh can slow Modeler’s performance, but the new Render Mode choice 
sidesteps the problem and offers more fluid viewport updates even for high resolution meshes. 

There are three choices of Render Mode:

Normal - Modeler’s standard speed of redraw.
Fast Preview - Fast Preview attempts to do everything that Modeler’s mesh system can do, only faster. The set of 
behaviors replicated in Fast Preview is not yet complete, but as new functions are added tools will automatically 
gain access to them.
Fast Deformation - The fast deformation mode bypasses dealing with smoothing angles and surfaces. For 
organic modeling where smoothing angle isn’t so important, you can get something on the order of a 3x or 4x 
speed boost compared to fast preview, which is fast already.
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Uniform Input Handling - Where appropriate, all new tools can use either two clicks to select either end of a line, 
or a click-drag motion. This makes manipulating the view of your object while using a tool possible. Shift 
constrains the line to the normal of the polygon you have initially clicked on.

Snapping - Snapping to various elements is available to all the new tools where appropriate. The snaps panel 
overlay in the viewport allows the user to enable or disable snapping to the following items.

Pre-selection highlighting - All of the new tools share pre-selection highlighting where it make sense. This makes 
it much easier to see whether your click will select a point, edge or polygon.

Nudging - Depending on the tool chosen you can nudge using buttons in the numeric panel, or the keyboard 
cursor keys for Up, Down, Left, Right and Page Up, Page Down keys for in and out. In the Numeric panel you can 
also change the Nudge amount.

The Syncmesh tools present in Modeler as of now are:

Create > Polygons > Line Pen
Modify > Translate > Align... > Align
Modify > Translate > Axis Translate
Modify > Translate > Tweak
Modify > Rotate > Axis Rotate
Modify > Transform > Heat Shrink
Modify > Transform > Axis Scale
Modify > Transform > Transform
Multiply > Extend > Chamfer
Multiply > Extend > Thicken
Multiply > Duplicate > Place Mesh
Multiply > Subdivide > Slice
Detail > Points > Straighten
Detail > Edges > Edit Edges
Selection > Polygons > Pick Surface
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Modeler Help Menu
The Help menu (located in the upper left-hand side of the interface) gives you easy access to documentation, NewTek’s 
website, and LightWave 3D’s about box.

Help - Choosing Help will launch LightWave’s documentation wiki (that you are currently reading). Use this to 
quickly search for information about a specific tool.
Submit a Bug Report / Submit a Feature Request - These two options  will launch LightWave's Feedback Agent.
About LightWave Modeler - Choosing About LightWave Modeler will display Modeler’s about box with 
information about the development team, as well as the Build number.
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Bottom Menu
Click here to expand Table of Contents...

Bottom Edge Menu
Info Display
Grid Info Field

Modes: Action Center Control
Numeric Panel
Drop Tool Command
Symmetry Mode

Symmetrical Editing
Symmetrical Selection

Surface: Change Surface
VMap Shortcut

Bottom Edge Menu

Info Display

Just above the grid display in the lower left-hand corner of Modeler is the Information Display. Most of the time this 
gives you feedback on the position of your mouse. However, depending on what you are doing, it can also display a 
variety of other information.Below are a few examples of what might be displayed with various tools:

Grid Info Field

A grid of squares - cleverly known as the grid - is visible in any of the orthogonal views, as well as the Perspective view. 
The grid serves as a visual reference when you move items around, but it will never render in a final image. The grid 
lines are darker every tenth square for visual reference. The Origin is located at the center of the grid.

 
You can find the current size of the grid squares in the Grid Information field at the very lower-left corner of the screen. 
Set the Unit System, Default Unit, and other options pertaining to the Grid in the Display Options Window.


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Modes: Action Center Control

Many Modeler tools (i.e., Rotate, Size, Stretch, Twist, Taper1, Taper2, Vortex, Pole1, and Pole2) can use different centers. 
This Action Center is located at the bottom of Modeler’s Interface.

Mouse (Shift   F5) - means to use the mouse position.
Selection (Shift  F8) - uses the center of a bounding box around what is currently selected.
Pivot (Shift F7) - uses the first active layer’s pivot point.
Origin (Shift F6) - means to use the very center of the universe: XYZ 0, 0, 0.

Numeric Panel

(default keyboard shortcut N)

The Numeric Panel is a multi-functional non-modal window. Its contents and abilities change depending on what tool is 
selected. When you create primitives, it lets you refine graphically set values. When you use modifying tools, it lets you 
change various settings that affect how the tool performs. The Numeric Panel is located at the bottom of Modeler’s 
Interface, or by just pressing the N key. It may be left open continuously.
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Use the Actions pop-up menu to Reset the fields to their default settings or to Activate the tool. (You can also press the 
N key to activate the tool.) Activating a tool turns on its interactive handles, if any, in the viewports. This can be for 
primitive shape, influence range, and so on. It will also activate the numeric fields, if they are ghosted.

Drop Tool Command

(default keyboard shortcut Return)

The Drop Tool command (Located at the bottom of the Modeler interface) will commit to the changes made with the 
currently selected tool and will deactivate the current tool.

Symmetry Mode

(default keyboard shortcut Shift Y)

Working in Symmetry Mode (Symmetry button, located along bottom edge) works on selection, as well as on editing. 
This mode will allow you to work on one half of your object and Symmetry will perform all edits and selection on the 
opposite side of the geometry.

You can also reset to defaults by clicking a reset area when a tool is selected, but not activated.
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Symmetrical Editing

Operations on the positive side of the X axis also inversely affect the negative side of the X axis. When this mode is 
active, your object is theoretically split in half at X=0.Generally, you should perform all of your edits on the positive side 
of the X axis when using Symmetry. Using the negative side may lead to unpredictable results.

 
If you get unpredictable results, make sure the negative-side geometry is exactly the mirror of the positive-side 
geometry with X=0 as the center point. If the negative-side geometry is the slightest bit off, it will not be affected. 
Generally speaking, this mode was meant to be used where the geometry to the left and the one to the right of X=0 
mirror each other. (However, all of the geometry does not need to be a mirror image, only the portion you want to work 
on symmetrically.)

Symmetrical Selection

When you select polygons/points on the positive X axis and Symmetry Mode (Symmetry button) is active, polygons/
points/edges on the negative X axis are also selected (or deselected).

Polygons/points/edges must be exactly opposite each other on the positive and negative sides of the X axis for this 
command to work properly.

The Fit Selected command (Shift A) respects symmetry. If both sides of an object are selected and Symmetry is 
active, then only one-half of the selection is used to compute the fit.



Symmetrical Modeling: Many of the Modeling tools will work in Symmetry mode. Most of the Modify menu 
tools work fine. Others such as bevel or smooth shift also work. Some tools such as Bandsaw do not work in 
Symmetry mode. In such a case you may have to use the tool on one side then use the Mirror tool to make sure 
the changes are done on both sides of the X Axis.


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Surface: Change Surface

(default keyboard shortcut Q)

The Change Surface command (Located at the Bottom of Modeler’s Interface) will bring up the Change Surface dialog to 
set the surface name and basic attributes for the selected polygons.

Name - This defines the surface name of the selected polygons. The Pop-Up menu will let you choose from 
existing surfaces.
Make Default - Selecting this option will assign this surface to any geometry created after the surface is made.
Set Initial Color - This option determines whether or not you can set basic attributes for your surface.
Color - Color is probably the most obvious surface parameter. It doesn’t take much experience to know that if we 
want something to look like a banana, we need to make it yellow, right? However, since you are dealing with a 
24-bit color palette and, thus, over 16 million colors, there are probably thousands of shades of yellow. 
Moreover, other settings, such as Roughness, can have a dramatic effect on the final rendered color.
Roughness - Roughness is the amount of light scattered by a surface, rather than returned directly to the 
camera. A high level scatters a lot of light, making the surface appears matte. A low level reflects most of the 
light, making the surface darker, but more polished.
Specular - Specularity is a more accurate way of saying reflection. It occurs on the surface of smooth or shiny 
objects. High Specular levels are commonly used on glass spheres, chrome bumpers, and so on. How the surface 
reflects tells the observer if the surface is dull, smooth, shiny, hard, or even metallic.
Smoothing - Smoothing causes objects to appear to have smoothly rounded surfaces even though the object is 
composed of flat-faced polygons. To do this, LightWave uses a technique known as phong shading. If the edges 
of two smooth-shaded polygons share vertices (points), they appear as one continuous, curved surface. The 
shared edge between them is no longer visible.

VMap Shortcut

VMaps can be created using the buttons in the lower-right corner of Modeler. These are simply shortcuts to the same 
options that can be found in the Vertex Maps Panel (Windows> Vertex Maps Panel). Choose a Vmap Mode to work in by 
clicking on one of the Vmap Mode buttons (W, T, M, C, S). Select which Vmap to edit from the Vmap drop down menu 
located next to the Modes buttons.
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W- Weight, T- Texture, M- Morph, C- Color, S- Selection Set. The + is to add a new vmap in the mode selected.

See Vertex Maps Panel for more detail.
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Smoothing Groups
Click here to expand Table of Contents...

Introduction
Should I Replace my Smoothing Method?

How Smoothing Groups Work
Smoothing Groups Options

Smoothing Info Window
Polygon Info Window
Statistics Window

Vertex Normal Maps

Introduction

Smoothing Groups (SG) is a concept that was introduced in 3d studio DOS to create areas of smoothing over polygon 
groups. It has become one of the standards for smoothing in the 3D industry, and LightWave now supports it. 
Smoothing Groups allow for a different kind of smoothing to our traditional surface-oriented vertex-based smoothing. 
Here is an example of why smoothing groups are useful. A client gives you a model of his excellent radio mast that he 
wants you to render. Here it is:

Yup that looks fine, you say to the client, but what are all the marks? The client replies that the polygons around the 
mast, marked with green, need to be smoothed. The ones marked with red need to be hard edges. Traditionally, a 
shape like this would be more laborious to model / surface in LightWave than it needs to be. An old-school way of doing 
it might be to break the model up and put it back together but not merge, you could use subpatch weight maps, extra 
poly flow to tighten curves, multiple surfaces with different smoothing angles and more, but it gets complex fast and 
worse if the model needs to be exported to a different package. Now, Smoothing Groups can make easy work of this 
challenging task.


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You can go through the rings, adding them to different smoothing groups, or you can just hit Auto Assign as shown 
below...

Should I Replace my Smoothing Method?

Smoothing Groups are now the third method of smoothing in LightWave and there is an order of precedence with the 
different methods. At the bottom of the list is LightWave-native smoothing, which is perfectly-suited for organic 
modeling. When dealing with hard surface modeling, objects will often be imported into LightWave with vertex normal 
maps (Modeler can only create vertex normal maps in version 2019 through exporting an object in OBJ format with 
smoothing groups unchecked in the OBJ Export options). At the top of the hierarchy is the new Smoothing Groups 
functionality, which supersedes both vertex normal mapping and LightWave's original smoothing.

How Smoothing Groups Work

Smoothing groups are a polygon tag indicating a group of polygons that should have shared (continuous) vertex 
normals. In this way, it is similar to the native LightWave method for smoothing, except where LightWave has one 
Smoothing option per polygon because there can only be one surface per polygon, you can have as many as 32 
smoothing groups for a single polygon using the SG method, with discontinuous polygons going in different smoothing 
groups. This means that a specific group can have several different non-adjacent polygons in it as shown below.
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Each ring will be in a specific group, and three groups are sufficient to create smoothing for this whole mast

Smoothing Groups Options

Smoothing Groups are managed in one of three places and not with the Smoothing Threshold in the Surface Editor at 
all. This does not need to be checked to make use of any smoothing groups you may have set.

The first is the Smoothing Info window, the second is the Polygon Info window, and thirdly, for selecting polygons in a 
smoothing group, you can use the Statistics window.

Smoothing Info Window

The Smoothing Info window, default keyboard shortcut U and found in Editors > More Windows, is the heart of SG 
workflow. With it, you can assign sg for polygons manually, or with Auto Assign based on the Angle field next to the 
button. This field will examine the angle between adjacent polygons and create smoothing groups accordingly. 
Selections are taken into account, but this button also adheres to the LightWave rule of "If nothing is selected, 
everything is selected." The groups are numbered from 1 to 32 and can be used in any order
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The contents of this window are:

Smoothing Groups 1-32 - The available smoothing groups. If you are in Set mode, clicking on one of these 
buttons will assign selected polygons to the named group. If the polygons selected cannot all be in the same 
group, shading errors will be apparent. The cure is to assign polygons with shading errors to a different 
smoothing group
Set / Select - These are the two modes for the window. In Set mode, clicking on an SG number will assign 
selected polygons to the number clicked. In Select mode, clicking on an SG number will select the polygons 
associated with the SG clicked. Holding down Shift while clicking a smoothing group that has been assigned will 
select all polygons on the object with the same SG number. Holding down Ctrl and clicking on a smoothing 
group number will select polygons that have been assigned to multiple smoothing groups including the one you 
Ctrl-clicked on
Unassign - Clicking this button will remove the smoothing groups assigned to selected polygons. A warning will 
be posted to prevent accidental SG removal
Invert - Inverts the polygon selection. If nothing is selected, clicking this button will ensure that all polygons in 
the object become selected
Draw IDs - This toggle enables the display of smoothing groups assigned to selected polygons
Connected- If you click on one or more polygons in your object, clicking this button will selected all polygons 
connected in the same smoothing group
Auto-Assign - Automatically assigns selected polygons to smoothing groups  based on the Angle field's contents
Vertex Normal Map - List of Vertex Normal maps on object that can be assigned to smoothing groups using the 
Auto-Assign button. Once assigned to smoothing groups, the vertex normal maps can be deleted.

You need to be in Polygon Mode for the Smoothing Info window to be active

Smoothing Groups are a new feature in LightWave 2019 and thus not available in LightWave 2018 or 
before. If your object might be used in a previous version of LightWave you will need to preserve the 
Vertex Normal map.


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Polygon Info Window

Hitting I in Modeler (or going to Editors > More Windows > Selection Info Open/Close) will bring up the Info window, 
and if you are in polygon mode, you will see additions to the readout of each polygon and a block of 32 numbers 
underneath. You can see what smoothing groups polygons are currently assigned to and can add new or remove groups 
by clicking
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Statistics Window

The Statistics window is opened with W (or going to Editors > More Windows > Statistics Open/Close) and has a new 
entry in Polygon mode at the end of the list. The Sm Gp group contains all the smoothing groups you have made for the 
current layer.

Vertex Normal Maps

Objects imported from other 3D software with smoothing groups assigned should come into LightWave already 
working. If you only have vertex normal maps assigned, smoothing groups can, and should, be substituted in Modeler. 
Vertex normal maps don't respect rotation. As an example, let's say you have an imported object, maybe a car, oriented 
vertically. If the car came from 3ds Max the vertical orientation is because in Max the Z axis is vertical, X and Y are the 
horizontal axes. If you rotate it to be correct for Modeler you would break the vertex normals.

The car on the left has just been imported. It has a vertex normal map. If we rotate it 180° around the Y axis, the shading 
is completely wrong

To replace Vertex Normal maps on an object, open the Smoothing Info window (U) and make sure the Vertex Normal 
map is selected then hit Auto-Assign. Once done, the vertex normal map can be deleted.
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Because they are not surface- but geometry-based, smoothing groups work well with deforming geometry in Layout.
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Modeler User Interface Overview
Click here to expand Table of Contents...

 

01 and 02. ToolBar
03. Modeler Tabs
04. Current Object
05. Layer Bank Selection
06. Layers
07. Layout Access
08. Workspace
09. Info Display
10. Grid Display
11. Selection Info
12. Progress Bar
13. Tool Tips
14. Edit Mode
15. Action Centers
16. Symmetry
17. SubD Type
18. Numeric Window
19. Set Surface
20. Drop Tool
21. Drop/Restore Selection
22. Undo / Redo
23. Vertex Maps

Modeler’s screen is divided into several areas. By default, the workspace of the screen consists of four viewports. 
Modeler displays four simultaneous points of view (Top, Back, Right, and a forced-perspective view), each looking at the 
same portion of the workspace from a different angle. These are not unlike Layout’s viewports. Changes made in one 
view are immediately updated in the others.
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01 and 02. ToolBar, 03. Modeler Tabs, 04. Current Object, 05. Layer Bank Selection 06. Layers,07. Layout Access, 08. 
Workspace, 09. Info Display, 10. Grid Display, 11. Selection Info, 12. Progress Bar, 13. Tool Tip, 14. Edit Mode, 15. Action 
Centers, 16. Symmetry, 17. SubD Type, 18. Numeric Window, 19. Change Surface, 20. Drop Tool, 21. Drop/Restore 
Selection, 22. Undo / Redo, 23. Vertex Maps

01 and 02. ToolBar
The toolbar sits at the side of the screen. The buttons presented will vary depending on which menu tab you select 
along the top. The Top Tool Bar buttons in section 1 will appear no matter which Tab is selected. You can completely 
hide (or unhide) the toolbar by pressing Alt +F2 (or choosing Edit > Display Options > Interface > Hide Toolbar On/Off).

Each area of Modeler’s Interface is fully customizable in the Configure Menus Panel (Alt + F10).

Hiding Panels

Since your screen can often get cluttered with open panels, you can quickly hide/show these floating windows 
by pressing Alt +F1.


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03. Modeler Tabs
The Tabs located at the top of the interface will determine which tools appear in the Toolbar. Each Toolbar is divided 
into menu groups. Generally, menu group names that are verbs contain commands based on the type of action they 
perform. Menu group names that are nouns contain commands based on the type of object they affect.

Create - Primitives, Points, Polygons, Curves and more.
Modify - Move, Rotate, Transform, and more.
Multiply - Expand on existing geometry. 
Detail - Tools to detail your object.
Construct - Reduce and combine points and polygons and much more. 
Map - All the tools you need to create and manage Vertex Maps.
UV - The tools specific to UV vertex maps.
Setup - Skelegons and other tools that can be used inside Layout. 
Selection - Tools related to selecting points, edges and polygons. 
Layers - Controlling an object’s layers and tools for managing layers. 
View - Display options and selection tools can be found here. 
I/O - Tools related to imported and exporting for Modeler. 
Utilities - 3rd-party tools or your own scripts. 

04. Current Object

Like files in your word processor, multiple object files can be loaded simultaneously. The Current Object pop-up button 
to the left of the layer buttons switches from object to object. Object names listed with an asterisk (*) have been 
changed and may need to be saved. Attempting to close the application triggers a request to save all changed objects. 
Ghosted objects are ones that have been loaded into Layout, but not into Modeler. Choosing a ghosted object from the 
pop-up menu will load it.
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Use the Current Object pop-up menu to select which object you are editing.

05. Layer Bank Selection
You can use the layer buttons in the top-right corner of the main interface to work with layers in banks of ten. LightWave 
gives you unlimited banks of ten which can be accessed here.

06. Layers
Every object can be a “MultiMesh”, that is, consist of an unlimited number of layers, similar to layers in many paint 
programs. The MultiMesh lets you work independently on specific parts of an object. During Modeling operations, you 
can set layers independently to be in the foreground or background, so you can work on a combination of layers as if 
they were in the same layer. Background layers can be used as a reference, but are often required when using certain 
Modeling tools.

07. Layout Access
This drop down menu gives you the following options:

Switch to Layout - switches to your Layout window if it is open or opens up Layout if you do not already have it 
open.
Synchronize Layout - Changes to objects in Modeler are reflected automatically in Layout when you select the 
Layout interface. You can force this synchronization by choosing this option.
Send Object to Layout - sends the current object to Layout. Actually, it sends a pointer to the current object’s 
file. As such, the object must be saved to your hard drive first.

08. Workspace
By default, the workspace of the screen consists of four viewports. Modeler displays four simultaneous points of view 
(Top, Back, Right, and a forced-perspective view), each looking at the same portion of the workspace from a different 
angle. These are not unlike Layout’s viewports. Changes made in one view are immediately updated in the others.

The crosshair at the center of the four viewports can be grabbed and moved where you want. If you have fewer than the 
normal four viewports, the borders between viewports can be used for resizing.

These options assume that you have the Hub running.
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Viewport Titlebar

You can change the View Type and Rendering Style of a viewport without going to the Display Options Panel by using 
the pop-up menus on the left side of each viewport titlebar.

The buttons on the right side affect panning, rotating, zooming, and minimizing/maximizing your view.

09. Info Display

Just above the grid display is an information display. Most of the time this gives you feedback on the position of your 
mouse. However, depending on what you are doing, it can also display a variety of other information.

10. Grid Display

In the bottom-left corner of the screen, you can see the grid size information display. As in Layout, this tells you how big 
each square is in the Modeler workspace.

11. Selection Info

See Working with Modeler Viewports for more info.
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Above the Edit Mode is the selection info display, which tells you how many points, edges or polygons you have 
selected.

12. Progress Bar
Displays tool processing.

13. Tool Tips
Displays helpful information for current tool.

14. Edit Mode

To the right of the grid display are four mode buttons. These are mutually exclusive buttons, so only one can be active 
at any one time. These determine when you are editing Points, Edges or Polygons using the Spacebar cycle. You can 
also select Volume mode from this section.

15. Action Centers

These tell you how any modification is going to be made to geometry - based on the position of your mouse pointer, 
based on the center of the selection, the pivot or the origin.

16. Symmetry

The Symmetry mode (Symmetry button, located along bottom edge) not only works on selection but also on editing. 
Operations on the positive side of the X axis also inversely affect the negative side of the X axis. When this mode is 
active, your object is theoretically split in half at X=0.
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17. SubD Type

Allows you to switch between two SubDivision modes, Subpatch and Catmull-Clark.

18. Numeric Window

You can enter numeric values for every tool in Modeler. Access it at the bottom of the interface.

19. Set Surface

Activates the Change Surface Panel to set the surface name and basic attributes for the selected polygons. See Surface 
Editor for more information.

20. Drop Tool

Finalizes your adjustments to geometry.
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21. Drop/Restore Selection

Deselects all selected geometry.

22. Undo / Redo

Button equivalents for the Ctrl -Z / Z operations.

23. Vertex Maps

VMaps can be created using the buttons in the lower-right corner of Modeler. In a way, you can think of Vmaps as 
“surfaces” for points. It's a way of tagging some information onto points that allow much more control of various 
Lightwave functions on a point level. The + button will create a new Vmap in the VMap type currently selected from this 
list:

W - Weight, T - UV Texture, M - Morph, C - Color, S - Selection Set.
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Top Tool Bar
These menus/buttons are always available, no matter which of the Tabs (Create, Modify, Multiply, etc.) you are in.

New - for starting a new object (default keyboard shortcut Shift-N)
Load Group - Tools concerned with loading objects or object layers
Save Group - Tools concerned with saving or exporting objects
Edit Group - Modeler Preferences and cut, copy, paste functions
Help - documentation, bug and feature request reporting and LightWave 
information
Surface Editor - For creating surfacing information for objects
Image Editor - For loading and editing images for use in surfacing or modeling
Layers Panel - A guide to the layers in your object(s)
Statistics Panel - The composition of your object
Vertex Map Panel - The vertex maps for your object
More Windows - Contains information windows and tools
Select - Selection tools
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Select

Click here to expand Table of Contents...

Select Loop
Next / Prev Loop
Ring
Select Connected
Expand Selection
Contract Selection
Select by Normal
Invert Selection
Invert Connected
Convert To
Switch Selection
Outline Points
Outline Edges
Open Edges
Same Surface
Same Part
Pick Surface
Select Surfaces
Select Nth Pattern
By Vertex Map Value
Drop/Rest Sel
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Select Loop

Next / Prev Loop

Ring

Select Connected

Expand Selection

Contract Selection

Select by Normal

Invert Selection

Invert Connected

Convert To

The Convert To commands take an existing point, edge or polygon selection and convert it to the format chosen.

Switch Selection

Is like Convert To, but without having to make a choice - a point selection becomes an edge selection becomes a 
polygon selection becomes a point selection.
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Outline Points

Takes a point selection and only leaves the points on the outside edge of the selection selected.
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Outline Edges

Takes a polygon selection and only leaves the outer line of edges selected.
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Open Edges

Looks for holes in manifold meshes and selects the edges surrounding them. Holes can be patched by converting the 
selection to points and hitting P, but in situations like the L-shaped hole, a single polygon will be created where perhaps 
three quads would be better.

Same Surface

With an initial polygon selection, using this tool will select any polygons belonging to the same surface(s).

Same Part

Similar to Same Surface above, Same Part takes an initial selection and expands to all polygons in the same Parts 
group(s).
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Pick Surface

Changes the pointer to show the current surface you are hovering over. Clicking the LMB will open the Surface Editor 
with the selected surface active.

Select Surfaces
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This window will let you select polygon groups belonging to one or more surfaces. You can match multiple surfaces to 
select the polygons belonging to them as the animation shows.

Select Nth Pattern

Opens a window permitting selection mathematically. The default setting will select every third polygon in a row, then 
jump to the next row.

By Vertex Map Value

Drop/Rest Sel

(default keyboard shortcut: /)

Is the same as the tool on the bottom and drop the current element selection.
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Statistics Panel

(Default Keyboard Shortcut: W)

Modeler's Statistics window is essential for good modeling. In the three modes - Points, Edges, Polygons - it shows a 
variety of vital information. In each category there is a + and a - at the left for selecting or deselecting items in that 
category. As an example it is possible to select all polygons belonging to a specific surface that are quads (four-point 
polygons), but not any with a Sketch Color of Magenta.

Points Mode

Total - The total number of points visible. This includes other foreground layers
0 Polygons - How many points are attached to no polygons
1/2/3/4 Polygons - How many points are attached to 1/2/3 and 4 polygons
>4 Polygons - How many points are attached to more than four polygons
(none) - This dropdown actually shows Selection Sets. A specific set can be chosen the list

Edges Mode

Total - The total number of edges visible. This includes other foreground layers
1 Polygons - The number of edges that are only attached to a single polygon
2 Polygons - The number of edges attached to two polygons (the most common case)
>2 Polygons - Edges attached to more than two polygons, quite rare

Polygon Mode

Total - The total number of polygons visible. This includes other foreground layers
Faces - Faces are normal polygons
Curves - The number of curves visible
Subpatches - Polygons converted to subdivision surfaces
CC Patches - Polygons converted to Catmull-Clark patches
Skelegons - The number of 2-point polygons converted to Modeler skelegons
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Metaballs - Single-point Polygons converted to metaballs
1 Vertex - Single vertex polygons
2 Vertices - Polygons with only two vertices. These and 1 point polys are important to have in the Statistics panel 
since almost always they should be removed
3 Vertices - Triangular polygons
4 Vertices - Polygons with four sides, also called quads
>4 Vertices - Polygons with more than four sides (and hence points)
Non-Planar - Polygons that are not flat within the Flatness Limit set in General Options
Surf: (none) - This dropdown list presents all surfaces present in the visible geometry
Part: (none) - This dropdown list presents any Parts that have been assigned to polygons
Col: (none) - This dropdown list presents the different Sketch Colors assigned to polygons to enable choosing 
that way
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Vertex Map Panel

Click here to expand Table of Contents...
VMap Selection
Vertex Maps Shortcuts

(default keyboard shortcut  F8)

You can display a non-modal window listing all Vertex Maps in the current object, grouped by type, by choosing 
Windows > Vertex Maps Panel.

In 2019.1, a filter field was added at the top of the panel to allow name filtering and even Regex use for tracking down a 
specific vertex map.

Right-clicking on a map will display a pop-up menu where you can select various maintenance operations. This menu is 
also available for the VMap selected in the list using the pop-up menu button (down arrowhead) in the upper-right 
corner. All operations can be applied to multiple vertex maps. Much like LightWave working exclusively with points or 
edges or polygons in Modeler, or Objects or Lights or Camera in Layout, you cannot delete multiple VMaps of different 
types at the same time, but deleting multiple UV maps, or Vertex Color maps or Weight maps is now possible.


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The pop-up menu also has options to show all Vertex Maps or to only show those that are in use in the current object, 
the default.

VMap Selection

There are two levels of selection. First, one main VMap, regardless of type, can be selected by clicking on its name in the 
window (or selecting it in the pop-up menu in the lower-right corner of the Modeler interface). Its name will become 
highlighted. This is used by various commands that work on any type of Vmap (e.g., Copy VMap and Delete VMap).

Generally, one VMap from each type (e.g., Weight and Morph) may be selected by clicking in the Sel column. A 
checkmark appears for these. (Note that the main selected VMap is always the selected VMap for its type.) This selection 
state is used by tools that only deal with certain VMaps, like the Airbrush tool.
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Changing the VMap selected in the pop-up menu on the (main) Modeler interface will change the main selected VMap 
and the VMap selected for its type. However, remember that not all VMap types (e.g., color VMaps) are accessible from 
this pop-up menu.
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Since LightWave 2015, you can select up to eight Weight Maps for display. They will be visible in Weight Shade Mode 
using different colors. You can rename or delete multiple selected maps (of one sort) at a time now as well.

Vertex Maps Shortcuts

VMaps can also be accessed using the buttons in the lower-right corner of Modeler. These are simply shortcuts to the 
same options that can be found in the Vertex Maps Panel. Choose a Vmap Mode to work in by clicking on one of the 
Vmap Mode buttons (W, T, M, C, S). Select which Vmap to edit from the Vmap drop down menu located next to the 
Modes buttons.

W- Weight, T- Texture, M- Morph, C- Color, S- Selection Set. The + is for adding a new map in the mode selected rather than 
going into the menu and choosing (new)
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Selection Info Panel

The Selection Info window works with Points, Edges and Polygons and offers various information about selected items.

Points

Information here is the specific Point number, how many polygons the point is attached to and the X, Y, and Z positions 
of the individual point.

Edges

Information here is the Edge number and how many polygons the edge is attached to and the positional information for 
the two vertices that make up the edge.
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Polygons

If the Selection window is opened in Polygon mode, the information shown is the internal polygon number, how many 
points make up the poly, how flat it is (polygons that are not flat enough risk rendering errors), the Surface name 
attached to the poly, the Part name (if any) and the OpenGL color used for display in Modeler. New to 2019 is Smoothing 
Groups information.

Common

In each mode, selecting an individual point, edge or polygon in the list will open a section at the bottom of the list 
where details can be edited. In this way new positions can be edited for points or edges and surface or part names can 
be re-assigned for polygons. The Info window is non-modal meaning that it can be left open while other points, edges or 
polygons are chosen and the Info window will fill with the chosen elements.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  638

The keyboard modifiers of Ctrl and Alt can be used in this display to keep it tidy. Ctrl clicking on an arrow in the 
list will open or close everything, while Alt clicking will open a specific selection and close another. The 
animation shows Ctrl-clicking first to open and close all entries, followed by clicking on a single entry, then Alt-
clicking on four others.


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More Windows

Contains small informational windows vital to Modeler use. The Statistics window (Default keyboard shortcut W) is 
decribed here and the Selection Info window (Default keyboard shortcut I) here. Smoothing Info is new to 2019 and 
decribed here.

The Hide Floating Windows (Default keyboard shortcut Alt F1) tool will temporarily hide or reveal windows covering 
Modeler's main display.

Hide Toolbar (Default keyboard shortcut Alt F2) maximizes Modeler viewport space by hiding the Tabs and Left side 
menu items.

http://Statistics+Panel
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Working with Modeler
Multi-Layer Object Standard
Multi-document Environment

Layout Communication
Layer Navigation

Layers Panel
Vertex Map Panel
Hide Floating Windows On/Off

Multi-Layer Object Standard
Every object can be a “MultiMesh,” that is, consist of an unlimited number of layers, similar to layers in many paint 
programs. The MultiMesh lets you work independently on specific parts of an object. During Modeling operations, you 
can set layers independently to be in the foreground or background, so you can work on a combination of layers as if 
they were in the same layer. Background layers can be used as a reference, but are often required when using certain 
Modeling tools such as boolean or cutting operations.

 
When you save an object, you save all layers with it. When you load an object, all of the individual layers remain intact; 
however, you may specify that certain layers be hidden when you use the object in Layout. You can thus save things like 
scratch objects - which you would not want rendered - in the same object file.

Multi-document Environment
Like files in an image editor, multiple object files can be loaded simultaneously. The Current Object pop-up button to 
the left of the layer buttons switches from object to object. Object names listed with an asterisk (*) have been changed 
and may need to be saved. Attempting to close the application triggers a request to save all changed objects. Ghosted 
objects are ones that have been loaded into Layout, but not into Modeler. Choosing a ghosted object from the pop-up 
menu will load it.

When loaded into Layout, individual layers of a MultiMesh are treated as individual objects.
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Layout Communication

If the Hub is running, a small pop-up menu button appears in the top-right corner of the interface, just to the right of the 
layer buttons.

Switch to Layout - switches to your Layout window if it is open or opens up Layout if you do not already have it 
open.
Synchronize Layout - Changes to objects in Modeler are reflected automatically in Layout when you select the 
Layout interface. You can force this synchronisation by choosing this option.
Send Object to Layout - sends the current object to Layout. Actually, it sends a pointer to the current object’s 
file. As such, the object must be saved to your hard drive first.

If you load an object in Layout only, its name is ghosted in the Current Object pop-up menu. Selecting a ghosted item 
will load it into Modeler and initiate the syncing process.

Layer Navigation

You can use the layer buttons in the top-right corner of the main interface to work with layers in banks of ten. You can 
apply most Modeling functions across multiple layers simultaneously by placing them in the foreground. You do this by 
clicking the top part of a layer button; all other layers are unselected, whether they are in the foreground or 
background. You can add foreground layers by holding the Shift key as you click. You can unselect a foreground layer 
by holding the Shift key as you click on a selected foreground layer button.

To place a layer in the background, click on the bottom part of a layer button. Selecting a background layer will 
unselect all other background layers. You can add background layers by holding the Shift key as you click. You can 
unselect a background layer by holding the Shift key as you click on a selected background layer button.
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You can change which bank of layers - ten layers per bank - are controlled by these buttons. Just click the < or > buttons. 
Bank 1 controls layers 1 through 10, bank 2 controls layers 11 through 20, and so on. The Bank Selection buttons are 
mapped to your PgUp and PgDn keys by default. The highest bank number is 99, but you can access higher layers using 
the Layer Browser Panel.

Layers Panel

Vertex Map Panel

Hide Floating Windows On/Off
Since your screen can often get cluttered with open panels, you can quickly hide/show these floating windows by 
pressing the Alt F1. This option can also be found under the Windows drop down menu.

You can quickly swap the state of foreground and background layers by pressing the apostrophe key (‘). 
If you notice a tool not working when multiple layers are selected, just select the one layer you need to work 
on and try the tool again.


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Modeler User Preferences
General Options

General Tab
OBJ Tab
Color Space Tab

Display Options
Layout Tab

Show Options

GL Tab
Viewports Tab

Perspective
Titlebar Shortcuts
Independent Options
Independent Visibility

Backdrop Tab
Aspect and Video images

Interface Tab
Units Tab

Modeler has two Options windows, General and Display. It also uses the same Keyboard Shortcut, Configure Menus  and 
Edit Plugins windows as Layout.

General Options
(default keyboard shortcut O)

You can access the General Options Panel by choosing Edit > General Options.
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General Tab

Content Directory - The Content Directory is a central file path for loading objects, images, and scenes. Note that 
this setting is shared by all LightWave applications.
Preset Shelf - The Edit Custom Locations button here opens the Custom Locations Editor. There you can add 
new locations where you've either already got presets or you'd like to create new ones. Flagging a location as 
the Default Save, means that things such as the Surface Editor, when it requests a new preset to be added. That 
preset will go to that Default location.
Default Polygon Type - Some operations in Modeler create many polygons in one operation. As such, the 
computer must decide whether to generate triangles (three-point polygons) or quadrangles (four-point 
polygons), depending on the shape’s requirements.

Flatness Limit - The Flatness Limit setting determines whether Modeler regards a polygon as planar or not. Note 
that a non-flat polygon considered planar according to this setting can still cause rendering errors. 

All polygons must have a surface name. When geometry is created, polygons are given the default surface name 

To force the computer to use Triangles or Quadrangles, select either for the Polygon setting. Choose 
Automatic to let the computer create the most appropriate polygon type for each given operation.



To create optimal objects, your goal is to keep the polygon count down. They will load and render 
faster than bloated objects, with no visible difference. As such, Quadrangles is the suggested setting for 
most cases. This lets you manually choose the areas that require triangles


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of Default. You can change the default name by changing the Surface field. This will affect only geometry created 
from that point on, however. Use the pop-up to the right of the field to select from existing surface names.

Curve Divisions  - The Curve Divisions setting determines how smoothly a curve (e.g., spline curves, text, etc.) 
should be interpolated. The finer the setting, the greater the number of polygons used, and the smoother the 
resulting curve division.
SubPatch Divisions - When a SubPatch object is frozen with the Freeze command ( Ctrl D), it is converted into a 
polygonal object. The Patch Division setting determines the level of detail used in the resulting object. The 
number entered in the Patch Division field must be 1 or greater and is restricted to whole numbers.

The number of polygons per SubPatch surface will be equal to the square of the Patch Division number. For 
example, if set to 4, each SubPatch surface will be converted into 16 polygons arranged in a 4 by 4 array. A 
setting of 2 would result in 4 polygons arranged in a 2 by 2 array. For Catmull-Clark patches, every level of 
Catmull-Clark subdivision quadruples the number of polygons.

The higher the setting, the higher the number of polygons used. Because of LightWave’s surface smoothing 
capabilities, you can often get away with a setting of 2 and sometimes even 1, which will keep the polygon count 
of your objects to a minimum.

Metaball Resolution - This setting determines the amount of detail used to display metaballs.
Symmetry Tolerance - Sets the amount matching elements can differ on opposite sides of the symmetry for 
symmetry to work.
Image Cache Maximum - If enabled, sets the amount of caching available for images in megabytes.

When you create a surface using the Change Surface dialog (Detail > Polygons > Surface), the option 
(Make Default) automatically sets the default surface name.



Setting this value too high with heavy-polygon SubPatch models can cause the performance of Modeler 
to degrade. If Modeler appears to be running sluggishly when working with SubPatch models, lower 
this value to help improve performance.


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10.
11.
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OBJ Tab

The OBJ tab contains options for importing and exporting OBJ file objects.

OBJ One Layer - imports the object as a single layer.
OBJ One VMap - imports the object with a single vertex map.
OBJ Pivot at Center - creates the pivot of the object at the center of the object.
OBJ Write Normals - writes the normals associated with the object when saved.
OBJ Merge Points - merges points sharing the same space.
OBJ Reverse Ka & Kd - Reverses Ambient Occlusion and Diffuse channels.
OBJ Double Sided - Creates double-sided geometry.
OBJ Parts - Keeps LightWave Part Polygon tags.
OBJ Foreground Layers - Only saves layers marked as foreground to OBJ.
OBJ Continuous UV - UVs have shared points rather than duplicated.
OBJ Import Scale - sets the scale of an object when it is imported.
OBJ Export Scale - sets the scale of the object when it is exported.
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Color Space Tab

Color space conversion is performed in four places in LightWave.

On loading, an image can be converted from its native color space format to linear.
When sent to the Image Viewer, an image can be converted from linear to another color space.
When saved from the renderer, an image can be converted from linear to another color space.
When picked from the Color Picker, a color can be converted from and then to linear color space.

The color space defaults are set up on the Layout Preferences panel.When an option is selected in the pop-up it 
becomes the current item for that selection.

Color tables are added to the selections, as if they were built-in.

A color table can be loaded by using Load Table from the pop-up. The color tablesare stored in the project directory, in 
a directory called Color Tables.

In the Image Editor, there is a check box, Treat as Alpha. This means use the alpha channel from the Preferences Default 
setting, not the alpha channel from the color space in the Image Editor. This is an override on the alpha color space 
selected in the Image Editor.

One can set the color correction for the Viewer files with palettes, 8-bit files, floating point files, alpha channel and the 
color picker from the preference default panel and the Modeler General Options panel.

When an image is loaded, if the file setting for that image is set to default, then an attempt is made to look at the 
metadata setting for that image. If the metadata settings have the color space the image was saved in, then it is used. 
For example, jpegs have metadata setting for sRGB and Adobe 1998 linear format.

The built-in color spaces are:
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1.
2.

Linear, LightWave linear color space.
sRGB, Standard RGB color space.
rec709, BT.709, HDTV
Cineon, Eastman Kodak Co.

The color lookup tables come in two formats:

LightWave color table format.
3D LUT format.

LightWave color table format is as follows:

Code:
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EGA
17, -0.5, 1.5
; Convert on load.
-0.5, -0.5, -0.5, -0.5
-0.375, -0.375, -0.375, -0.375
-0.25, -0.25, -0.25, -0.25
-0.125, -0.125, -0.125, -0.125
0.0, 0.0, 0.0, 0.0
0.125, 0.125, 0.125, 0.125
0.25, 0.25, 0.25, 0.25
0.375, 0.375, 0.375, 0.375
0.5, 0.5, 0.5, 0.5
0.625, 0.625, 0.625, 0.625
0.75, 0.75, 0.75, 0.75
0.875, 0.875, 0.875, 0.875
1.0, 1.0, 1.0, 1.0
1.125, 1.125, 1.125, 1.125
1.25, 1.25, 1.25, 1.25
1.375, 1.375, 1.375, 1.375
1.5, 1.5, 1.5, 1.5
; Convert on save.
-0.5, -0.5, -0.5, -0.5
-0.375, -0.375, -0.375, -0.375
-0.25, -0.25, -0.25, -0.25
-0.125, -0.125, -0.125, -0.125
0.0, 0.0, 0.0, 0.0
0.125, 0.125, 0.125, 0.125
0.25, 0.25, 0.25, 0.25
0.375, 0.375, 0.375, 0.375
0.5, 0.5, 0.5, 0.5
0.625, 0.625, 0.625, 0.625
0.75, 0.75, 0.75, 0.75
0.875, 0.875, 0.875, 0.875
1.0, 1.0, 1.0, 1.0
1.125, 1.125, 1.125, 1.125
1.25, 1.25, 1.25, 1.25
1.375, 1.375, 1.375, 1.375
1.5, 1.5, 1.5, 1.5 

Where:

EGA is the name of the color space that appears in the pop-up.
17 is the number of entries in the color table.
-0.5 is the lower range of the look-up table (black).
1.5 is the upper range of the look-up table (white).
-0.5, -0.5, -0.5, -0.5 are the rgba values for the table entry.
Blank lines and lines beginning with comments, are skipped over.
3D LUT format tables are read in and a reverse lookup table is made. The name of the color space is the name of 
the file on the pop-up.
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•
•
Auto Sense on Load detects the Color Space settings and uses those when a scene is loaded.
Color Correct OpenGL will color correct the OpenGL viewports.

Display Options
(default keyboard shortcut D)

Modeler’s interface is highly configurable allowing to tailor it to your specific needs. You can change the arrangement of 
viewports as well as change the display characteristics for each viewport independently. Choose Edit  > Display Options 
 to bring up the Display Options Panel.

Layout Tab

 
Layout options control the global arrangement of the viewports, the number of viewports and some other Global 
Display settings. Use the Presets pop-up menu to quickly set common layout configurations (Quad is the default 
setting). Selecting a Preset will affect the Layout setting, as well as settings on the Viewports Tab.

If you want to set up your own custom layout, make a selection from the Layout pop-up menu. The icon to the left of the 
description will give you an idea of how the viewports will be arranged. Later, you will see that you have total control 
over what is in each viewport. In fact, each Layout option will remember the Viewport settings as they were the last time 
that Layout option was used.
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Perspective Amount - The amount of perspective in the perspective view can be varied by changing the 
Perspective Amount slider on the Layout Tab. You can go from a very wide-angle to a flat nearly orthogonal view. 
The setting is global and affects all the perspective views the same way.
Background Color - Use the Background Color selector to change the color that appears in the background for 
viewports using a shaded display.
Default Sketch Color - Use the Default Sketch Color setting to change the color that the wireframe will appear in 
the various view modes. You can always change the Wireframe color on polygons using the Sketch Color tool 
located under the Detail Tab.
Selection Color Options - Use the Selection Color Palette for editing Point > Edge > Polygons when selected. 
Other options include changing the color for Normals and the color of active Tools.
Tool Color - Specifies the color for tool gizmos and Syncmesh tool text.
HUD Color - Specifies the color for the viewport surround when editing morphs.
HUD Opacity - Defines the strength of the color used for the HUD.
Fixed Normal Length - Change the length of the normal here.

Show Options

The various Show Visibility options let you independently set what you want to see globally in your viewports.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  652

•

•

•

Show Points - Points appear as small dots

  
Left: Show Points On, Right: Show Points Off

Show Surfaces - Surfaces are the polygon (or SubPatch) surfaces

  
Left: Show Surfaces On, Right: Show Surfaces Off

Show Cages - A cage is the outline that connects all of the control points when you edit a SubPatch object

  
Left: Show Cages On, Right: Show Cages Off
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Show Point Selection - When points are selected they appear highlighted if this option is selected

Show Guides - Guides are the dotted-lines that extend from the surface (patch vertex) to the control points on 
the cage (if visible) when you edit a SubPatch object

  
Left: Guides on, Right: Guides off
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Show Normals - Normals are dotted lines that extend perpendicularly from selected (planar) polygons and 
indicate the direction a polygon is facing

Show Origin - This option will show the 0 axis in the viewports. For the perspective view, only the X and Z axis are 
shown.
Show Grid - The grid is the background reference grid
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Show Polygon Selection - When polygons are selected they appear highlighted if this option is selected

Show Backdrop - A Backdrop is an image loaded for viewports on the Backdrop Tab. These images can be useful 
as Modeling reference

These visibility options can be overridden independently for each viewport on the Viewports Tab.
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• Show Edge Selection - When edges are selected they appear highlighted if this option is selected.

GL Tab
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Texture Resolution - The Texture Resolution setting determines the resolution to use for displaying textures in 
viewports that have their Rendering Style set to Texture. Higher settings increase the detail of image textures 
displayed in viewports, but increase memory usage and display refreshing time.
Shading Method - Choose between MultiTexture, GLSL and PBRGLSL Shaders. Multi-texture shaders are 
simpler and intended for graphics cards that are less capable. GLSL is faster and shows more texture capabilities 
for modern cards. PBRGLSL shaders are the most modern and will show more accurate detail on capable 
videocards.
Transparency Sorting - There are three options to choose from:

SortByObject -  sorting the objects by their distance from the camera - fast method
SortByPolygon - sorting polygons by their distance from the camera - slowest method
AlphaClipping - uses the alpha value of a texture in the transparency channel to determine transparency 
- fastest method

Geometry Acceleration - Determines how the graphics card displays OpenGL. Streaming renders the mesh 
immediately to screen, using the lowest amount of memory at the cost of speed. It also won't show normal 
maps. Buffered(VBO) will attempt to store the geometry in graphics card memory, allowing for the highest 
speed, at the cost of memory. In cases where the mesh or shading changes with every frame no caching is 
possible, a fallback to the Streaming method will result, for example with animated meshes and reflection maps. 
Smooth shaded geometry will benefit the most from the Buffered(VBO) mode. If the mesh is buffered in graphics 
card memory the performance you will get as much performance as your graphics card can give you.
Pixel Blending - Texture filtering
Mipmapping - Mipmapping is similar to what is used in today’s games to avoid graininess of textures in a 
distance or at a flat angle. Basically lower- res versions of the texture are generated in realtime and blended in. 
This feature is supported in hardware by most of today’s graphics cards. This feature also works if Mutitexturing 
is turned off. Please note however that due to the nature of this filtering method, low-resolution textures may 
appear a bit blurry.
Reflections - Switches reflections on and off. Only applies to image-based reflection maps.
Transparency - Switches transparency on and off.
Multitexture - Uses LightWave's original OpenGL drawing method. If your meshes are very heavy using this 
instead of GLSL is advised.
Frame Buffer Object - accelerates object drawing slightly.
Color Channel - De- /Activates the display of textures in the Color Channel if Multi-texturing is on.
Diffuse Channel - De- /Activates the display of textures in the Diffuse Channel if Multi-texturing is on.
Transparency Channel - De- /Activates the display of textures in the Transparency Channel if Multi-texturing is 
on.
Luminosity Channel - De- /Activates the display of textures in the Luminosity Channel if Multi-texturing is on.
Specularity Channel - Will show the specularity surface setting in PBRGLSL mode.
NormalMap Channel - Will show normal map in PBRGLSL mode
Legacy OpenGL - Uses the pre-LightWave [8] OpenGL drawing routines

SortByObject is the default setting and will be the fastest in most cases.
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Viewports Tab

Viewport options let you change how objects are displayed in each viewport. To change the settings for a viewport, first 
select it using the Viewport buttons.

Use the Presets pop-up menu to quickly set the options on this tab for the selected viewport region. The selections are 
listed by view types, but will affect all of the settings on this tab.

The View Type pop-up menu determines the editing axes you want to use for the selected region.

For the Orthogonal settings, the names generally indicate the viewing perspective. Back (XY), for example, lets you edit 
along the X and Y axes. This means you are looking along the Z axis.

Since it is called Back, that means your perspective is from the back (i.e., negative side) of the Z axis, looking toward the 
positive side. UV Texture is entirely different - it is not used as a Modeling viewport but for adjusting UV texture maps.

There are four Display (group) commands assigned by default to certain keyboard shortcuts which affect the 
viewport beneath your mouse pointer. Shift F1 toggles the view between Back and Front, Shift F2 toggles 
between Top and Bottom, Shift F3 toggles between Right and Left, and Shift F4 toggles between Perspective 
and UV.


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Perspective

You may edit in a Perspective viewport, just as you would in any other, but you may also rotate your view perspective. 
This is Modeler’s virtual trackball, which enables you to rotate the object without affecting its orientation in the other 
three edit windows. It effectively provides you with three axes of rotation. While holding down the Alt key, you can 
perform these actions:

Rotate around the X axis (pitch) by dragging up or down directly across the vertical center of the viewport
Rotate around the Y axis (heading) by dragging left or right directly across the horizontal center of the viewport.
Rotate around the Z axis (bank) by dragging to the left or right around the perimeter

If the title bars are visible, you can drag the rotate drag button with your LMB to rotate. If you use the RMB, the viewport 
will rotate around its perpendicular axis. Holding the Ctrl key (or using your MMB) will cause rotations to snap to 15-
degree increments.

Rendering Style - The Rendering Style pop-up menu determines the style of display you want to use for the 
selected region:

Wireframe - Although the Wireframe is arguably the most limited display mode, it is the most commonly 
used Rendering Style because of its ease in viewing, selecting, and unselecting points and polygons.

Imagine you are manipulating an imaginary ball with your mouse when you manipulate the Preview window.
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Color Wireframe  - This is nearly the same as Wireframe, except the polygon edges are drawn using their 
Sketch color (Detail > Polygons > Sketch Color).

Hidden Line - Hidden Line shows an object’s Front Face polygons in wireframe view.

Sketch - Sketch shows an object in a combined wireframe and flat-shaded view. All polygon edges are 
drawn, but faces are also visible. This mode does not account for Surface settings, however. The polygon 
edges are always drawn in white and faces are grey. Background layers are visible.

 
You can change the polygon shading color in this mode by choosing Detail > Polygons > Sketch Color.
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Wireframe Shade - Wireframe Shade is a smooth-shaded mode that overlays the wireframe lines.

Flat Shade - In Flat Shade mode, the object is shown as a flat-shaded solid. This mode supports some 
Surface settings, but not smoothing.

Smooth Shade - Smooth Shade is a smooth-shaded mode that supports some Surface settings, such as 
Color, Diffusion, Specularity, Glossiness, Smoothing, and Double-sided.
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Weight Shade - Weight Shade provides visual feedback for editing Weight Maps.

Texture - Texture is similar to Smooth Shade, but it also shows images mapped to surfaces.

Textured Wire - Textured Wire is similar to Texture, but it also shows wireframes on the surfaces.

Upright Rotation - The Upright Rotation pop-up menu lets you rotate a viewport clockwise by 0, 90, 180, and 270 
degrees to accommodate imported objects from applications that may use other axes as up, or for exporting to 
them, for that matter.

Titlebar Shortcuts

You can change the View Type and Rendering Style of a viewport without going to the Display Options Panel by using 
the pop-up menus on the title bar. Clicking on the left-most pop-up allows you to choose which View Type you want to 
be in and will then display it. The pop-up menu just to its right lets you choose the Rendering Style.
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Note that if you have UV Texture selected as the View Type, the Rendering Style pop-up menu will instead list all loaded 
images. Select one to load it into the backdrop of that viewport.

Independent Options

The Independent options let you make certain viewport characteristics independent from other viewports. Changes to 
the selected characteristic do not affect it in other viewports and vice versa. For example, if a viewport uses 
Independent Zoom, zooming in it does not affect the zoom of other viewports. You must have your pointer over the 
viewport to affect an independent viewport. Independent Rotation is only applicable to perspective views. Normally, it 
is enabled. If you have multiple perspective views and this option disabled, they will move in unison when you rotate a 
view.

Independent Visibility

The lower portion of the panel contains the independent visibility options. You can individually select which visibility 
options are independent. To use them, you must also activate the Independent Visibility option. This option lets you 
quickly enable/disable this feature without losing the state of each setting.

Backdrop Tab
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On the Backdrop Tab, you can add full-color backdrop images that act as reference guides when you build objects. They 
let you model much like tracing a picture using tracing paper. To use backdrops, select the Viewport and the desired 
image from the Image pop-up menu.

From the Presets pop-up menu, you can save the settings for the selected Viewport to a file by choosing Save Current 
Backdrop. You can load this file later using Load Backdrop for any selected Viewport. You can also save the settings for 
all viewports by choosing Save All Backdrops. When this file is loaded later - using Load Backdrop - the individual 
Viewport settings are restored.

Use the Image drop down menu to select from the loaded images or choose (Load Image) to bypass the Image Editor 
and load a new image into Modeler and automatically select it for the current viewport.

You can also adjust Brightness and Contrast. Use the sliders to adjust the settings. You can invert the colors by 
activating the Invert option. If you want to blend pixels for close-up work, activate the Pixel Blend option. Image 
Resolution determines the accuracy of the displayed image.

Aspect and Video images

The two Center and Size input fields are horizontal (top field) and vertical (lower field). Clicking Automatic Size will 
enter values that fit the defined image into an implied bounding box that surrounds visible geometry.

If you activate the Fixed Aspect Ratio option, you can enter a frame aspect ratio in the input field. Then, you only need 
to specify a horizontal size - the vertical size is computed automatically. If your images originated from video, you need 
to account for the pixel aspect ratio, since video pixels are not square like computer pixels. For example, a D1 NTSC 
image is 720 x 486 pixels; however, the frame aspect ratio is not 1.48 (720/486) as you might expect. The width of a D1 
NTSC pixel is 90 percent of the width, that is, a pixel aspect ratio of .9. As such, the true frame aspect ratio is 1.333 
(720/486*.9).

If you do not account for this difference, your models may appear slightly stretched when ultimately viewed on video. A 
way to fix this is to scale the object after the fact.

If you are using a UV Texture viewport, you can choose a backdrop using any loaded image from what is 
normally the Rendering Style pop-up menu on the viewport’s title bar.



The backdrop images for the current default layout for each view configuration are cached as long as possible. 
Also, backdrops are not saved in config files or view presets.



Colored background images sometimes make the wireframe hard to see (especially if the image has a bright 
white background). Setting the Contrast to its lowest value, and the Brightness to a little above the darkest 
value will produce a reasonable-looking backdrop that works well when Modeling.



The frame aspect ratio of a D1 PAL image is also 1.333 (720/576*1.067).
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Interface Tab

 
The Alert Level affects how error, warning and informational messages are displayed. The Toolbar Position setting 
determines if the main toolbar appears on the Left or Right side. Activate Hide Toolbar to make it hidden and maximize 
your screen real estate. Alt +F2 will hide (and more importantly, Unhide) the Toolbar as well.
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Toolbar On/Toolbar Off

The Viewport Titles option turns the titlebars, which appear above each viewport, on or off.

Toolbar On, Viewport Titles Off

Use the Input Device buttons to select the type of input device you are using.

New to LightWave 2015, you can optionally set Mouse Wheel Zoom to enable the use of the mouse scroll wheel to zoom 
in and out of a viewport. As with using the Ctrl Alt shortcut, the view will zoom based on your mouse pointer’s location.

The next option is for Double-click Deselect, also new to 2015. This gives you the possibility to double-click on any 
empty space in the Modeler interface to deselect all selected Points, Edges or Polygons. You will still be able to use a 
single click in the normal deselect areas (under the menu buttons, on top of viewports, etc.) will this option is engaged.

The Fine Detail Cursor option, when active, makes your mouse pointer use the main crosshair pointer at all times 
instead of changing when the various tools and selection functions are used.

The File Dialog pop-up menu lets you use custom LightWave dialogs for file loading/saving. Selecting Default will use 
your standard system dialog.
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The custom File dialog provides many additional features not available with the standard system dialogs.

The Visual Browser - You can make the LightWave visual browser the default file dialog for Layout and/or Modeler by 
choosing VBFileRequester on the File Dialog pop-up menu. This appears on the Interface Tab of Modeler’s Display 
Options Panel (Edit > Display Options).

 
The Color Picker pop-up menu lets you use custom LightWave dialogs for picking colors. By default it is set to the 
LightWave color picker shown below, but if you wish you can choose the system color picker here.
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The Color Format setting determines the scale used where the color selector appears. Integer uses values 000 to 255, 
Float uses .00 to 1.00 and Percentage uses 0% to 100%.

The Simple Wireframe Edges option turns off polygon offsetting for the sketch-like display modes. This may fix display 
problems on some video cards. The Simple Wireframe Points setting uses OpenGL’s own points for wireframe points 
and selected points at a user-specified size. These points can draw much faster than the standard points.
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Units Tab

The Unit System determines the units of measurement that are used and displayed by the Modeler screen.

SI - is the International System of Units (SI is the abbreviation of the French “Le Système International d’Unités”). 
Unit measurements in Modeler will use a base system of meters. Grid sizes and distances can be measured in 
megameters, kilometers, meters, millimeters, micrometers, and nanometers.
Metric - The Metric System is the same as SI with the addition of centimeters.
English - The English System uses miles, feet, and inches.

If you input a value that uses a different unit of measurement than that of the default, LightWave will convert it on the 
fly. For example, you may be using meters, but typing in “5 ft” will convert to “1.524 m.”

Default Unit - Use the Default Unit pop-up menu to set an assumed measure when none is given for distance 
values.

Grid Units affects the zoom step amount but has no effect on the actual size of the object. You will likely find that 
1 2.5 5 and 1 2 5 are your most commonly used Grid Unit settings.

We recommend you use the SI or Metric systems to model objects, since a system using base 10 is often much 
easier to use for purposes such as applying textures and adjusting object movement.



If you use a metric Unit System, you should set the Default Unit to meters.



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  670

a.
b.
c.

d.
e.

•

a.

b.
c.

d.

•

1 - The grid resizes in values that begin with 1, as in 10m, 1m, 100mm, 10mm, etc.
1 5 - The grid resizes in values that begin with 1 or 5, as in 1m, 500mm, 100mm, 50mm, 10mm, etc.
1 2.5 5 - The grid resizes in values that begin with 1, 25, or 5, as in 1m, 500mm, 250mm, 100mm, 50mm, 
etc.
1 2 5 - The grid resizes in values that begin with 1, 2, or 5, as in 1m, 500mm, 200mm, 100mm, 50mm, etc.
1 2   - The grid resizes in values that begin with 1 or 2, as in 1m, 200mm, 100mm, 20mm, 10mm, etc.

Grid Snap - The Grid Snap setting forces point creation and item movement to be limited to a specific 
increment.

None - None deactivates grid snap, so that items move freely and are not constrained by any grid 
intersections.
Standard - Standard sets the grid snap to one-tenth of the current grid size.
Fine - Fine makes the grid snap as small as possible for the current zoom level. This will be typically two 
to five times smaller than using Standard.
Fixed - Fixed lets you specify the increment of movement in the Snap Value input field. The grid will resize 
itself to use the value you specify.

Time Format - The Time Format setting allows you to set the display format for time values, like the Frame 
Slider Label option on Layout’s General Options Tab of the Preferences Panel. If the Hub is active, Layout and 
Modeler settings will be kept in sync.
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Working with Modeler Viewports
Click here to expand Table of Contents...

Views
Render Types
Changing your Point of View

Move
Rotate
Zoom
Fullscreen Toggle

The Grid


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By default, Modeler presents four viewports. Any of them can be made full-screen by 
tapping Numpad 0, or clicking the full screen icon at the top right of each viewport.

Views

The default views presented by Modeler are usually sufficient for general modeling tasks - Top, Back, Right and 
Perspective in anticlockwise order from the top left. However, the UV Texture view is very useful for modifying UV 
texture placement and as you'll see there are other default Modeler viewport layouts that might suit your workflow 
better (See Modeler User Preferences Layout Tab).

Layout View gives exactly the same view in Modeler as currently presented by Layout, including Perspective, Light and 
Camera views. This view cannot be moved in Modeler and Hub needs to be enabled for this to work. The view will show 
undeformed objects and in the case that there are multiple viewports in Layout, the Camera icon at the top right of the 
viewport will determine which view is visible in Modeler.

The UV viewport now has new display modes for making sure UV maps are correctly made. See Display styles.
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Render Types

We changed the Sketch Color for the body, tongue, teeth and eye or the Rasper Cow to show differences in different Render 
Types and also added a weight map.

Changing your Point of View
You can use the keyboard shortcuts A and Shift +A to Fit All and Fit Selected in any viewport. Fitting is based on the 
bounding box of your object(s) and works with multiple layers.

Move

Orthogonal view: Moves your POV horizontally when you drag left or right and vertically when you drag up or 
down.
Keyboard shortcut: Alt

Perspective view: Moves your POV horizontally when you drag left or right and farther/closer when you drag up 
or down with the LMB. Moves your POV vertically when you drag up or down with the RMB.
Keyboard shortcut: Shift + Alt 

You can use the keyboard shortcut  G to center the area under the cursor.
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Since you are changing your POV, the scene items will appear to move in the opposite direction of your mouse 
movements.

Rotate

Orthogonal views - not applicable.

Perspective view - Rotates your POV’s heading when you drag left or right and its pitch when you drag up or 
down with the LMB. Rotates your POV’s bank when you drag left or right with the RMB.
Keyboard shortcut: Alt 

Zoom

All views - Zooms in and out when you drag left and right. (You can also use the < and > keys.)
Keyboard shortcut: Ctrl + Alt or Alt+Scrollwheel

Fullscreen Toggle

The last icon in this group is a toggle to switch the associated viewport between fullscreen and back.
Keyboard shortcut: Numpad 0

The Grid
Modeler's grid constantly updates to provides an indication of current magnification. By default, each grid square is 500 
mm in size and as you zoom in or out this changes to keep the number of grid squares constant, but have a different 
value. The grid value can be seen at the lower left corner of the Modeler interface:

Use the keyboard shortcut A to zoom the view out so all objects in visible layers are completely onscreen. Use 
Shift + A to limit it to only objects in foreground layers.


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As you zoom in and out you'll notice the grid squares get smaller and larger until they change scale. This defined is 
defined in the Display Options > Units tab:

The default value is 1 2 5, but the range of choices is as follows:

1 - The grid resizes in values that begin with 1, as in 10m, 1m, 100mm, 10mm, etc.
1 5 - The grid resizes in values that begin with 1 or 5, as in 1m, 500mm, 100mm, 50mm, 10mm, etc.
1 2.5 5 - The grid resizes in values that begin with 1, 25, or 5, as in 1m, 500mm, 250mm, 100mm, 50mm, etc.
1 2 5 - The grid resizes in values that begin with 1, 2, or 5, as in 1m, 500mm, 200mm, 100mm, 50mm, etc.
1 2 - The grid resizes in values that begin with 1 or 2, as in 1m, 200mm, 100mm, 20mm, 10mm, etc.
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Working with Objects

Selecting

Manipulating

Layered Objects

For almost everything in Modeler, it's worth keeping in mind the mantra: "If nothing is selected, everything is 
selected"


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Selecting
Direct Selection

Extending Selections

Other Selection Methods
Selecting Layers

Foreground and Background Layers

Direct Selection

Modeler has three selection modes - Points, Edges and Polygons. They are exclusive, so you cannot mix a selection of 
points with polygons (although you can have both selected a tool will only operate in the mode you are currently in). 
You can select Points, Edges or Polygons by clicking and dragging with the LMB. 

There are several tools to aid selection in the Top Menu in Modeler covered here: Select.

Extending Selections

Once you let go of the LMB for your initial selection, to add further elements you either need to use the Shift key in 
conjunction with the LMB or the MMB to continue selecting further elements.

Other Selection Methods

The Statistics Panel window from the Top Tool Bar is essential for making more intricate selections such as "give me all 
polygons with more than four points" or "Give me polygons with the Surface 'Green' that are non-planar"

Selecting Layers

You can use the layer buttons in the top-right corner of the main interface to work with layers in banks of ten. You can 
apply most Modeling functions across multiple layers simultaneously by placing them in the foreground. You do this by 
clicking the top part of a layer button; all other layers are unselected, whether they are in the foreground or 
background. You can add foreground layers by holding the Shift key as you click. You can deselect a foreground layer 
by holding the Shift key as you click on a selected foreground layer button.

For almost everything in Modeler, it's worth keeping in mind the mantra: "If nothing is selected, everything is 
selected"


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To place a layer in the background, click on the bottom part of a layer button. Selecting a background layer will deselect 
all other background layers. You can add background layers by holding the Shift key as you click. You can deselect a 
background layer by holding the Shift key as you click on a selected background layer button.

Some tools require simultaneous foreground and background layer selections. Others can act on multiple layers at 
once to speed up workflow.

These layers can all be acted on at once

Foreground and Background Layers

Some tools (Boolean and Fracture for example) require both foreground and background layers to be available. Clicking 
the layer icons at the top will make the layered clicked a foreground layer. Clicking it in the lower half will make it a 
background layer. You cannot have a background layer without a foreground layer and clicking with the LMB will only 
select one foreground and background layer. If you wish more of either hold Shift when clicking LMB. That way you will 
be able to create the mix of foreground and background layers needed.

You can change which bank of layers - ten layers per bank - are controlled by these buttons. Just click the < or > buttons. 
Bank 1 controls layers 1 through 10, bank 2 controls layers 11 through 20, and so on. The Bank Selection buttons are 
mapped to your PgUp and PgDn keys by default. The highest bank number is 99, but you can access higher layers using 
the Layer Browser Panel.

You can quickly swap the state of foreground and background layers by pressing the apostrophe key (‘).

If you notice a tool not working when multiple layers are selected, just select the one layer you need to work 
on and try the tool again.


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Manipulating

The three main ways you have of manipulating geometry are Translation, Rotation and Transformation, but to model 
you need a lot more facilities including creation and deletion. Modeler is very freeform with regard to its elements. 
There are no constraints on what you do with them. You can build objects by laborious point-to-point construction, use 
spline cages, or construct organic models using subpatches and extending base polygons - the box method.

The first tab to visit for manipulation tools is the Modify tab, wherein you will find the above-mentioned Translate, 
Rotate and Transform tools. Then you have the Multiply tab, which contains tools to Extend, Duplicate and Subdivide 
your polygons. The Detail tab contains tools for concentrating on elements of your model, split into Point, Edge and 
Polygon sections; while the Construct tab is for reducing and combining model elements.

Fine Detail Manipulation

The Rotate and Scale/Stretch tools can further be controlled at much smaller scale by using the right mouse button (RM
B). This changes values at a much finer rate. Holding the Ctrl key will snap rotations in 15° increments. This works with 
move the left and right mouse buttons, but be aware that since the right button moves in finer increments it will take 
longer to get to the 15° amount to snap to. Holding Ctrl when Scaling or Stretching will still lock the changes to the axis 
you are mainly working on.

Using Ctrl, left and right mouse buttons to Stretch, then rotate 15° precisely on three axes

For almost everything in Modeler, it's worth keeping in mind the mantra: "If nothing is selected, everything is 
selected"


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Layered Objects
Pivot
Other Layers
Pros and Cons

Off-center pivots

A LightWave object can consist of many layers. In Layout, these layers become discrete objects when sent to Layout. 
This can have important and various consequences for organizing your modeling work.

Pivot

Once sent to Layout, an object is manipulated around its pivot point, rather than the individual points, edges or 
polygons. The pivot point is situated at the center of Modeler space, called the Origin. The Origin is shown in Modeler 
with thicker grid lines than normal and objects can be moved to the origin using the Center All... function (F2)

 

This sphere is away from the Origin in the Perspective view. This means that once the object is sent to Layout, its pivot 
point around which it will be moved, scaled and - most importantly for a ball - rotated will not be located at the center 
of the ball.

Other Layers

Once you have multiple layers in an Object it can be important to differentiate between them. Those other layers might 
just be tools used for cutting or measuring and thus do not need to appear in Layout. It may be that you have several 
elements that need to be animated separately (a door in the same layer as walls cannot open and close. It needs to be 
in its own layer to have its own pivot to do so), and once you do have several layers, how to keep track of them? A multi-
layered object will just be named "Object: Layer 1, Layer 2, Layer 3, etc." by default. The answer to both of these issues 
lies in the Layers Panel (F7).

Pros and Cons

It is certainly true that in certain instances, positioning elements where they should be in layers in Modeler can be seen 
as more simple, but there are two main problems. Taking a simple example:



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  681



LightWave 2020  –  LightWave 2020

Getting Started with Modeler –  682

This little house has the door, and even its handle, on separate layers so they can be animated opening and closing. 
That's good, but the chair has been positioned in the corner. When this object is sent to Layout there is no problem 
moving the chair around, however rotating is not so simple:

This is why it is important to do positioning and rotation in Layout and leave the chair (in this example) at 0, 0, 0.

The second problem is re-use of the chair model for use in a different house. If it is just a layer in another object, it won't 
be easy to find again. Better would be to leave the chair in a separate object, that way it can be easily reused in other 
scenes.
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Off-center pivots

There are times when you want to have the pivot off-center. In the example above, for the door hinges from its left side 
so you have two choices.

Move the door in Modeler so that that side of the door is at 0, 0, 0
Center the door, but move its pivot in Layout to put it in the right place as the following two examples show:
Example - Door Pivot 1
Example - Door Pivot 2
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Getting Started with Surfacing

Click here to expand Table of Contents...
Introduction
What is PBR?

Energy Conservation
Diffuse, Specularity and Roughness
Transmission, Scattering and Absorption
Fresnel
Non-realistic Surfaces?

Standard
Surface Editor
Image Editor
Node Editor

Hulk 3D Scan by 3DWP from Thingiverse

Introduction
We have had energy-conserving materials since LightWave v9.5 - with Dielectric, Conductor and others - but with the 
addition of physically-accurate lighting LightWave has had something called Physically-Based Rendering or PBR since 
the 2018 version. This means a large shift in how you will create your surfaces, and some new vocabulary to learn, but 
the benefit is that a) your surfaces will look much better and b) react to scene lighting in a far more consistent manner. 
Where once you might have needed to adjust your surfacing to better fit the lighting of your scene, with the new 
materials in LightWave your surfacing should work in all lighting conditions.


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What is PBR?
PBR, or Physically-Based Rendering, is a way of working in order to make sure that materials made in different 
applications are consistent with each other and also the environment they are used in.

Historically in LightWave we have only had one surface material that we could make any combination of reflective, 
transparent and colorful. Usually a surface with a mixture of all three looked bad so as time went on LightWave artists 
realized that a balance had to be struck between values of Diffuse, Transparency and Reflectivity. They all had to be 
juggled by hand and things like the Fresnel falloff of reflectivity and transparency that is so important to realistic 
surfacing had to be created with gradients. We are now freed from having to work this way.

In order to understand how PBR is going to benefit you as a LightWave artist it is important to at least have a passing 
knowledge of how materials work in the real world.

Energy Conservation
In all events (and Materials except Standard) the main guiding principle is the conservation of energy. That is to say, the 
amount of light reflected by a surface, or transmitted through it, never exceeds the amount falling on the surface. This is 
the reason there are no individual controls for some settings, like there are in Standard. For instance Dielectric doesn't 
have a Diffuse component.

Diffuse, Specularity and Roughness
Both Diffuse and Specularity are responses to illumination. Diffuse refers to the scattered reflection of light that gives us 
the color we perceive a surface to have, while Specularity refers to the sharp reflection of the same light. In LightWave 
Specularity used to refer only to the reflection of lights in shiny surfaces but now refers to reflection generally. How 
sharp the reflections are is controlled by the Roughness (or Glossiness in the case of the Standard material) with a low 
Roughness (or high Glossiness) providing tight detailed reflections while a rough, or non-glossy, surface will provide 
blurred or unrecognizable reflections. The same amount of light is reflected in both cases, but the roughness will 
determine how spread out that light is.

Transmission, Scattering and Absorption
Transmission refers to the transmission of light through a surface - transparency in LightWave's previous surfacing 
terms. Scattering is more complex and refers to light being scattered in a volumetric fashion inside a surface. LightWave 
used to do this with HyperVoxels and emulated it with subsurface scattering materials like Sigma or Skin. Absorption 
refers to the penetration of light inside a surface.

Fresnel
All surfaces have this falloff, first documented by Augustin-Jean Fresnel in the early 19th century, modulated by the 
roughness of the surface. It relates to how surfaces are more reflective at glancing angles than head-on. LightWave's 
new surfacing paradigm replicates this automatically with materials being 100 % reflective at a glancing angle. In all 
Materials other than Standard, there is no need to set complicated gradients to replicate physical properties.

https://en.wikipedia.org/wiki/Augustin-Jean_Fresnel
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Non-realistic Surfaces?
Although there is a greater preponderance for realistic surfacing with PBR it doesn't preclude artistic creativity. With 
materials like Principled BSDF non-photorealistic surfaces are still easily achievable while maintaining the benefits of a 
PBR workflow. If you really want to leave PBR behind you can still use Standard.

Standard
Standard is still LightWave's main surface material for imported assets for reasons of compatibility with existing assets. 
New models are textured with PBSDF as the default surface. Standard is as far away from PBR as possible and its use 
should be deprecated. Surfaces using Standard will be less predictable and harder to manage than those using modern 
materials like Principled BSDF. A full explanation of the limitations and a comparison of Standard with previous 
versions of LightWave can be found on its page.

Surface Editor

Image Editor

Node Editor
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Getting Started with the Node Editor

LightWave's Node Editor is not just for surfacing, it is increasingly indispensable for displacement, Volumetrics and 
Instancing among others. While some nodes available are only useful in certain contexts, the overall method of working 
with nodes is similar throughout and thus should be learned even if you have no interest in one particular aspect.

While the workflow seems complex to start with it is actually simpler and more consistent than working with layers in 
the Surface Editor and its consistency when it comes to Instancing or Displacement mean that once learned for 
Surfacing becomes easy to implement for other uses.

Node User Interface Overview
Node Editor Options
Input Nodes

Working with the Node Editor Viewport

Example - Adding an Image with Nodes
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Node User Interface Overview
GUI Anatomy
Menus and Hot Keys

GUI Anatomy

Let’s take a look at the graphical user interface (GUI) for the Node Editor. Use the numerical look-up call-outs to identify 
each element and read its description in the corresponding text below.

The title bar for our Node Editor window has been removed to make things clearer, but normally you will see that it 
contains the current surface name or the property if you are working with displacements, volumetric lights, motions or 
other node editor types.

Add Nodes - You can either use this menu to add nodes to your Workspace, or the list below (16). The menu is 
here in case you are in Node Flow (13) view where the nodes list is not available.
Edit Menu - Contained in this menu are all of the edit functions for working in the Node Editor GUI. From copying 
and pasting to importing and exporting the GUI manipulation tools you’ll be using most will be found in here. 
The specifics are detailed on page .

This menu is also available by right clicking on top of any node in the Workspace Area or listed in the Node Flow 
tab.
Undo - Click on this button or press Ctrl-Z, to undo the last Node Editor operation you performed.
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Redo - Click on this button or press Z, to redo the last undo operation you performed.
Purge - Click on the purge button to discard all of the undo history currently in memory for the node editor.

Tidy Nodes - Rearranges nodes to remove overlaps. Tidy Nodes will also collapse nodes that are not in 
use and arrange all unused nodes in a column to the left of the network.
Update - Click on the update button to force a manual refresh of any preview spheres displayed in the Node 
Editor panel.
Options - Clicking on the options button will display the option settings panel for the Node Editor.
Node Probe - this will show you the outputs of the nodes in your network. This value is evaluated without 
knowledge of any ray trace environment
Workspace Pan Gadget - Using the Pan Gadget (or widget) or by alt-dragging in the Workspace area, will allow 
you to scroll the Workspace area.
Workspace Zoom Gadget - Use this gadget to zoom in or out of the workspace area. This is useful when working 
with or constructing large networks and will allow you to quickly locate nodes and network segments that may 
be scrolled out of view.
Embedded Edit Panel Gadget - Use this gadget to pop open the embedded edit panel which can be used in place 
of floating edit panels when editing node properties. To edit node properties with the extension area closed 
simply double click on the node you want to edit.
Embedded Edit Panel Extension Area - With this area extended any selected node’s properties that has an edit 
panel can be edited in this embedded panel area.
Nodes or Flow - These two tabs either show the complete node list or the nodes currently in your network.
Search - Start typing the name of the node you are looking for and the list will reduce until your node is found. 
The dropdown icon to the right will allow you to make the search Case Sensitive, display results as a hierarchy or 
Flat and to Clear a search that has been made to reveal the full node list again (you can also just delete the 
search text).
Add Selected - If you know you are going to need a bunch of nodes for your network you can select them all 
using Ctrl and Shift modifiers and hit this button to add them all at once to your workspace.
Node List - In this area you will either find a list of all the nodes available, or those currently added to your 
Workspace area depending on the tab chosen at the top of the window (13).
Input - This node is permanently available and contains different outputs depending on what sort of Node Editor 
you are using. It contains outputs that are often needed.
Workspace - Use the workspace area to construct networks by adding nodes and connecting them together.
Selected - This is an example of a selected node.
Unselected - This is an example of an unselected node.
Surface Destination - This is the Surface Destination node. Making connections to this node from other nodes in 
the Workspace area define a surface’s properties.
Node Comment Entry Area - Add comments to any node by selecting the node and typing in the Comment Entry 
Area. Take care to press Enter when finished or your comments will not be saved with the node.

Menus and Hot Keys

The menus and hot keys described here apply only when the Node Editor window is active. To activate the Node Editor 
window if it is not active simply click anywhere on its interface. To display the Node Editor window if it is not displayed 

20, 21 and 22 together form what is called a Network. You can think of node networks as being very much like 
computer networks - with connections, input, output and the most important bit: results!


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simply click on the Edit Nodes button on the options panel you’re working with. Remember, the Node Editor lives in 
several places throughout the LightWave 3D application.

Edit - Pressing Enter or selecting Edit from the Edit menu, with any node selected and the embedded edit panel 
closed will open that nodes floating Edit Panel. In ancient times the Enter key was also referred to as the Return 
key.
Rename - Pressing the r key or selecting Rename from the Edit Menu with any one node selected will open a 
Rename Node requester that will allow you to rename the node. The name of a node appears in its title bar area.
Preview - Preview options are context sensitive. Depending upon what types of output the selected node offers, 
any of several preview options will be available. The preview option that is selected will determine what the 
preview sphere displays if the Disable Previews checkbox is unchecked in the Node Editor’s Options panel. The 
various possible types are:

Color - Color Channel
Alpha - Alpha Channel
Luma - Luminance Channel
Bump - Bump Direction in three colors
Result - Line Graph Display
Normal - Normal Direction in three colors

Copy - Pressing Ctrl-C or selecting Copy from the Edit Menu will copy any selected nodes into the copy buffer. If 
text is selected in the Note Comment Entry Area, numerical input areas or etc then the selected alphanumeric 
string will be copied into the copy buffer.
Cut - Pressing Ctrl-X or selecting Cut from the Edit Menu will cut any selected nodes into the copy buffer. If 
alphanumeric string data is selected in the Node Comment Entry Area, numerical input areas, or etc then the 
selected alphanumeric string will be cut into the copy buffer.
Paste - Pressing Ctrl-V or selecting Paste from the Edit menu, will paste any selected nodes into the Workspace 
area that are currently contained in the copy buffer. A separate copy buffer is simultaneously available for both 
nodes and for text so that you could for example, copy some text, copy a node, and then paste the text or the 
node in their attributed areas without losing the information in either of the two copy buffers.
Delete - Pressing the Del key or selecting Delete from the Edit menu, will delete any nodes or alphanumeric data 
that you may have selected. This delete operation only removes the item from the graphical user interface. No 
menu entries or disk based items will be affected. Delete operations do not place the deleted items into the copy 
buffer.
Select All - Pressing the A key or choosing Select All from the Edit menu, will select all the nodes currently in the 
Workspace area.
Clear Selection - With the Node Editor window active, pressing the D key or selecting Clear Selection from the 
Edit menu, will deselect any selected nodes in the Workspace area.
Invert Selection - Pressing the I key or choosing Invert Selection from the Edit menu, will invert the current 
selections. If no nodes are selected when I is pressed then all nodes will become selected.
Fit All - Pressing Shift-F or selecting Fit All from the Edit menu, will fit and center all of the nodes currently in the 
Workspace area. If all of the nodes cannot be displayed in the Workspace area at 100 percent zoom then the 
workspace area will be automatically zoomed out in order to fit all the nodes currently in the Workspace area.
Fit Selected - Pressing the F key or selecting Fit Selected from the Edit menu, will fit and center any node or 
nodes currently selected in the Workspace area. If all selected nodes cannot be displayed in the Workspace area 
at 100 percent zoom ratio then the Workspace area will automatically be zoomed out in order to fit all of the 
nodes currently selected into the Workspace area.
Disconnect Inputs - Selecting one or more nodes in the Workspace area and pressing Shift-D or selecting 
Disconnect Inputs from the Edit menu, will disconnect any inputs that are connected to the selected nodes. 
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Output connections from a selected node will not be disconnected. You can think of this as disconnecting all 
connections made to the left hand side of the node.
Expand - Pressing Shift-E or selecting Expand from the Edit menu, will expand any selected nodes that are 
currently collapsed.
Collapse - Pressing Shift-C or selecting Collapse from the Edit menu, will collapse any selected nodes that are 
currently expanded.
Export Selected - Choosing Export Selected from the Edit menu will open a Save file requester that will allow you 
to save the node or group of nodes you have selected as a .nodes file. A “.nodes” file is a structured text file 
containing the names of all the nodes you had selected when you saved the file, any comments that you had 
entered for each of the nodes selected, and any of the connections that existed between the selected nodes. It 
basically exports a complete snapshot of the nodes you had selected when you exported.

This is a very useful feature allowing you to create and maintain directory based libraries of various network 
segments or entire networks. “.node” files can be loaded and saved interchangeably between any of the three 
Node Editor windows for Displacements, Volumetric Lights, and Surfaces.

Import Nodes - Selecting Import Nodes from the edit menu will open a Load File requester allowing you to load 
any saved “.nodes” file. When imported the node group will appear in the dimensional center of the Node 
Editor’s Workspace area. Position offsets, connections, collapsed or expanded states and any node comments 
that existed when the nodes were exported will import back into your working environment.

This is an extremely useful feature allowing you to choose and load from maintained directory based libraries of 
various network segments or entire networks. “.node” files can be loaded and saved interchangeably between 
any of the three Node Editor windows for Displacements, Volumetric Lights, and Surfaces.

It is important to note that the Destination node will not be exported nor any of the connections that 
existed to the Destination node when the file was saved.



It is important to note that Destination node connections are not imported nor exported to or from a 
“.nodes” file.


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Node Editor Options

The Node Editor Options window offers several choices to customize how your Node Editor works. We'll cover them one 
by one:

Refresh Rate - Two choices, either Automatic or Manual. When set to Manual, refreshes have to be triggered by 
pressing the Update button in the main Node Editor interface
Disable Previews - Turn off the previews of procedural textures, images, gradients and other nodes offering a 
preview function
Line Type - Switches between Straight, Square and Spline to change the way the lines between nodes are 
drawn:

Snap to Grid - New to 2019, the Snap to Grid option will help to create neater nodal networks by snapping each 
node to the grid size set below
Grid Shade - The difference between the background color of the Node Editor and the grid lines displayed, 
default value 16. Setting this value to 0 will hide grid lines completely. This will not stop Snap to Grid from 
working
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• Grid Size - Defaults to 50, but change be set at the size you require between 10 and 400
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Input Nodes

Surface Input
Nodal Motion
Nodal Displacement
Instance Generator
Light
Flocking

The different Input nodes, where they can be found, what their outputs are.

Surface Input

When editing a surface, this node always appears in the Node Editor.
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Item ID (Integer) -  The LWItemID of the intersected primitive
Pixel X, Y (Integer) - The location of the pixel currently being rendered
Frame Width, Height (Integer) - The resolution of the image set in Camera 
Properties
Ray Position (Vector) - Origin of the ray that intersected this primitive (from the 
Camera, Reflection, Refraction, Shadow, etc.)
Ray Position dX, dY (Vector) - Ray origin differentials
Ray Direction (Vector) - The direction of the ray that intersected this primitive (from 
the Camera, Reflection, Refraction, Shadow, etc.)
Ray Direction dX, dY (Vector) - Ray direction differentials
Ray Weight (Color) The accumulated weight of the ray represented as a color
Ray Distance (Scalar) - The distance the ray traveled before intersecting the 
primitive
Shutter Time (Scalar) - The normalized shutter time (0...1)
Ray type (Integer) - Camera ray, Reflection ray, Refraction ray, Dissolve ray, Shadow 
ray and Occlusion ray. These can be fed into the Ray Type Switch node.
Ray Bounce (Integer) - The number of bounces the ray has taken to reach this 
intersection. Starts at 1
World Position (Vector) - The location of the intersection in world coordinates
World Position dX, dY (Vector) - The partial derivative of the world coordinate 
position in relation to X or Y coordinate of the pixel
World Position dU, dV (Vector) - The partial derivative of the world coordinate 
position in relation to the U or V coordinate of the pixel (for objects with automatic 
UV maps)
Perturbed Normal (Vector) - The interpolated normal perturbed by bump or 
normal mapping
Smooth Normal (Vector) - The interpolated normal
Geometric Normal (Vector) - The un-interpolated geometric normal
Normal dU, dV (Vector) - The partial derivatives of the normal along U and V 
coordinates
Barycentric Coordinates  (Vector) - The masses of each vertex on a triangle
Object Position  (Vector) - The location of the intersection in local coordinates
To Local, To World (Matrix) - Transformation matrices for the intersection
U, V (Scalar) - The U or V coordinate for the intersection, presuming the surface has 
UV coordinates
U and V dX, dY (Scalar) - The U and V partial derivatives along pixel X and Y
Primitive ID (Integer) - A Primitive can have an ID assigned that is different to the 
Item ID
Surface Side (Integer) - Determines if the intersection hit the front (0) or back (1) of 
the surface (2 double-sided back) (Example)
Polygon Index (Integer) - The numeric index for the polygon at the intersection
Mesh Element (Integer) - Outputs the element type needed for the Mesh Element 
Switch node

Nodal Motion

Accessed through Motion Options > Modifiers > Nodal Motion.
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Item Position (Vector) - Relating to the item driving the nodal motion
World Position (Vector) - Relating to World coordinates (Vector).
Frame (Integer) - The current frame number (Integer).
Time (Scalar) - The current time in the FPS set in Options (Scalar).
Item Rotation (Vector) - Uses the current Item rotation as an output (Vector).
Item Scale (Vector) - Uses the current Item scale as an output (Vector).

Nodal Displacement

Accessed through Object Properties > Primitive > Modify > Nodal Displacement.

Object Position (Vector) - Provides the undeformed vertex position
World Position (Vector) - Provides the deformed position in world coordinates
Normal (Vector) - The vertex normal
Current Position (Vector) - Provides the current deformed vertex position in object coordinates
Point Index (Integer) - Gives the point index of the vertex.

In addition, the Nodal Displacement destination node has the following options when double-clicked on:

A Mode setting to control if the value is used to displace (add) or set the vertex position.
Deformed Coordinates in texture nodes checkbox for object or world coordinates.

Instance Generator

Accessed through Instance Generator > Nodes > Edit Nodes.

ID Index (Integer) - The ID of each instance
Fixed Random (Scalar) - Gives a random output
Fixed Float (Scalar) - Gives an output relative to the quantity of instances used
Base Position (Vector) - The base position of the instance

Light

Accessed through Light Properties > Edit Nodes.

Direction (Vector) - The direction in which the light is pointing
Distance (Scalar) - A value that can be used for controlling color over distance

Flocking

Accessed through Flocking > Flock > Properties.

Position (Vector) - Final world position of the agent
Velocity (Vector) - Speed and direction of the agent
Bank Up Vector (Vector) - The direction of Up for the agents
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Working with the Node Editor Viewport
Keyboard Shortcuts
Navigation
Adding Nodes

Working with the Node Editor is similar to using a normal LightWave viewport but there are some differences.

Keyboard Shortcuts

Rename - R
Select All - A
Invert Selection - Shift I
Clear Selection - D
Fit All - Shift F
Fit Selected - F
Disconnect Inputs - Shift D
Collapse Node - Shift C
Expand Node - Shift E

Navigation

You can use the standard Alt key and mouse to pan the Node Editor window around, and Ctrl+Alt to change 
magnification

Adding Nodes

There are several ways of adding nodes to a network:
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 The most obvious way is to select from this list
This is a search field. Typing in here will update the node list live - to find the Principled BDSF material you only 
need to type "pr" before it is the only node available
The Add Node dropdown contains the complete list of nodes
Holding Ctrl and clicking the RMB will present a list of all nodes, like 3

For both 3 and 4, typing immediately filters the node list. It's not a find, meaning you will need to start to type 
the group name - c, right cursor, s will find the Scalar constant


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Getting Started with Rendering

Click here to expand Table of Contents...

VPR
Render Frame
Render Scene

Further Reading

LightWave's renderer is now more powerful than ever and you have unprecedented access to the inner workings of it 
with direct control of the AOV channels that make up a final image. AOV stands for Arbitrary Output Value and these 
channels are what make up a final image - with them you now have fine-grained control over how your image renders. 
AOVs are also called buffers.

For full reference, refer to the Rendering and Compositing section of this manual.

Rendering in LightWave takes place in three ways. First there is VPR.

VPR
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Switching to VPR with the menu and back to OpenGL with the keyboard shortcut
VPR is the Viewport Preview Render and will take over any viewport and replace the default OpenGL view with a 
rendered image interactively. You can quickly switch with the viewport display menu of the keyboard shortcut Ctrl F9.

Render Frame
Secondly, there is the single image offline render, accessed through Render > Render Frame or with the keyboard 
shortcut F9. This locks the current state of Layout and launches a Render Status window that shows ongoing progress 
with the render. You cannot use Layout while this happens, and you shouldn't modify your scene's objects in Modeler. 
The ones used for the render are locked in at the moment you start the render. Rendering a frame will create a final 
image, but will not automatically save it. It will be presented in the Image Viewer (or other render display you choose), 
and you can save it from there.

Render Scene

Once you have your scene finalized with all animation, lighting and camera set up, you should perform a Sequence 
Render with Render > Render Scene or with the keyboard shortcut F10. The Render Status will change slightly to show 
sequence render time remaining, rather than image time.

When you render the scene, you need to set up your render range (by default the render range will be from frame 1 to 
the end of the scene) and you can choose to render the range you need, or just arbitrary individual frames. See Render 
Properties - General for details.

You also need to set your output. F10 will go ahead and render the scene following the settings in Render Properties, so 
if you haven't set an image output, your computer will render and throw away the results of each frame.

At this point, if you have more than one computer at hand, it's a good idea to use them all for this final rendering stage. 
See Distributed Rendering - An Introduction.

Further Reading
Removing Noise workflow
Buffer List
Back to Beauty - Rendering for Compositing

Make sure you save your scene and all objects before you start a Scene Render!
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Removing Noise workflow
Click here to expand Table of Contents...

Flowchart Scene
Alpha Noise
Diffuse Indirect Noise
Specular Direct Noise
Diffuse Direct Noise
Shadow Noise
Specular Indirect Noise
Refraction Noise
Subsurface Scattering Noise
Still Noisy?
Go

Noise is an inevitable and unwanted result of rendering 3D images. Unless your scene is extremely simple it is likely that 
you will have some. LightWave's buffer view enables you to track down exactly where this noise is coming from before 
you launch your scene render.

 Updated for LightWave 2020. We're all familiar with upping the Antialiasing samples in order to create a 
noise-free scene, but some noise can't easily be reduced this way - at least, not in a timely fashion. Adding samples to 
the wrong areas to improve renders will make them slower and not improve the quality. Working through this checklist 
will show you better where to concentrate your efforts.

Flowchart Scene
This example scene is enclosed. Click on the box icon to retrieve it.

To exaggerate the effects of this workflow we have set our base values very low. Our scene has:

Depth of field with the F-Stop set to an unrealistic 0.8
Minimum and Maximum Samples at 1
Reflection Samples at 1
Refraction Samples at 1
Subsurface Scattering Samples at 1
Brute Force GI at 1 Ray
Light samples at 1

These all combine to give a render that looks like



https://docs.lightwave3d.com/download/attachments/8202908/Noise_Removal.zip?api=v2&modificationDate=1575985643000&version=1
https://docs.lightwave3d.com/download/attachments/8202908/Noise_Removal.zip?api=v2&modificationDate=1575985643000&version=1
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When trying to find the problem with this scene, we can check how the Alpha looks to see if it's purely an anti-aliasing 
problem.
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Alpha Noise

The Alpha shows us that the yellow logo on the left is noisy, the green one at the back is noisier still, and the gray one to 
the right is the noisiest. The yellow and green logos are subject to depth of field and the gray logo is moving fast and the 
noise is caused by motion blur (and possibly some DoF too). To correct both of these problems all that is needed is 
more Camera Samples for anti-aliasing, but we should start by taking the Depth of Field out of the equation. If the 
Alpha is the only problem with your scene you can Go! If not, carry on down the list, but be aware that those Camera 
samples are multipliers for the other sample settings so be prepared to juggle otherwise you will end with longer than 
necessary render times. If there's no motion blur or depth of field in your scene, look at the other buffers before you 
increase Antialiasing samples. You can probably get a clean render without increasing them.

It may seem odd that the transparent logo in the foreground seems to be cutting a hole in the alpha through 
the ground. What is actually happening here is that the refractions are bouncing off the inside of the logo and 
heading up. We have no environment for this scene, so those refraction rays are hitting nothing and just 
returning black. You can have a shim or an environment so this doesn't happen in your scene.


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Diffuse Indirect Noise

Indirect Diffuse noise is probably the most common challenge and we don't actually have that much, mainly because 
we don't have many purely diffuse objects in the scene. Nonetheless, you can actually see a bit in the curls of the red 
logo at front right and between the cubes just behind it. This noise is normally caused by too few Global Illumination 
samples. Increasing the number of Brute Force rays in the Global Illumination settings is the best thing to do. If your 
scene doesn't use radiosity, such noise can be cured with additional Camera samples. Was adjusting your Camera 
samples enough? Then go render. If not, try Specular Direct Noise.
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Specular Direct Noise

Specular noise is caused by a lack of light samples. In the blue ball we can see obvious lacks in lights reflected, 
particularly the Area light, which is very noisy. Usually, increasing the Light samples a little is enough to cure these 
problems, but it does depend on the size of the light - larger lights will require more samples. It can be confusing to spot 
the difference between Specular Direct and Specular Indirect noise. Direct is reflection of the lights themselves in your 
surface, while indirect is a reflection of other objects. Good to go? If not, go to the next one.
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Diffuse Direct Noise

Direct Diffuse noise is usually seen in the shadows of your objects. It can be cured with additional Light samples, but 
also see Shadow Noise. If this gives you a noise-free image, then you are ready to go. If not, and not Shadow Noise, carry 
on to Specular Indirect Noise.
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Shadow Noise

Shadow Noise is always a result of too few Light samples. There is little point adding light samples to all your lights, in 
the image above the light behind the yellow logo on the left needs additional samples but the other lights in the scene 
can probably be left as they are to keep render times as low as possible. Noise gone? Go render. If not, next.
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Specular Indirect Noise

Specular Indirect noise is caused by the reflection of objects in other objects and not the reflection of lights in objects, 
which is Specular Direct. You can check by setting the surface in which something is reflected to have a Roughness of 0. 
If the noise disappears you know there is a problem in Specular Indirect.

The Yellow logo appears clearly in the reflection when the ground surface Roughness is reduced to 0. The reflection is 
good, the noisiness is in the yellow logo itself.

To clear Specular Indirect noise. increase Reflection Samples in Render Properties > Render. Do you now have a noise-
free render? Go. If you don't, check Refraction Noise.
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Refraction Noise

Refraction noise is caused when transparent surfaces in your scene don't have enough refraction samples. It can be 
seen in the final render by noise and a lack of definition and more clearly looking directly at the Refraction AOV. It is 
cured by increasing the Refraction samples in Render Properties > Render. There is one more object in our scene 
causing problems, but if yours is good go render your scene. If you do have Subsurface scattering in your scene, check 
the next item.
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Subsurface Scattering Noise

The last noise offender in our scene is caused by Subsurface Scattering. There's no complicated solution. If your SSS is 
noisy, you need to increase Render Properties > Render > Subsurface Scattering Samples.

Still Noisy?

If you've been through this workflow and your render is still noisy, it will probably be down to one of these:

If there is something out of shot that is being reflected in your scene, check its sampling;
If you are using the Standard material, it is not energy conserving and so can knock values out of whack. 
Consider replacing it with an energy-conserving material like Conductor, Delta or Dielectric or Principled BSDF, if 
possible;
In this list, we have talked about geometric surfacing, but volumetrics in the scene can cause their own noise 
too. Increasing Volumetric Samples in lights affecting volumetrics will be the solution here.

Go

Go for final render! Make sure you save your scene and objects before you hit F10 and if sending the scene for a network 
render use Package Scene to prepare your files.
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Camera Samples 16
Reflection Samples 6
Refraction Samples 6
SSS Samples 9
Light Samples 4 for three (6 for the spherical behind the yellow logo and the large 
area light behind the camera)
Brute Force Rays 20

Gives us a satisfactorily clean render

•
•
•
•
•
•
•
•

As a shorthand, when looking to modify your sample settings check through this list:

Alpha → AA
Diffuse Indirect → GI Rays / AA
Spec Direct → Light Samples
Diffuse Direct → Light Samples
Shadow → Light Samples
Spec Indirect → Reflection Samples
Refraction → Refraction Samples
SSS → Subsurface samples



LightWave 2019 added two forms of noise reduction, for CPU and GPU. Both will reduce the noise in your 
renders but both rely on techniques, either manual or automatic, to blur noise without ruining the overall 
image. Using the steps listed above you will be able to reduce the noise in your renders with an understanding 
of what causes the noise in the first place. Postprocessing methods still have their place, especially for projects 
with a rapid turnaround, but getting familiar with the steps above will give you a better quality of render in a 
quantifiable way.


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Buffer List
Click here to expand Table of Contents...

Introduction
What Color Space Should my Buffers be in?
Data Buffers

Glossary
Direct
Indirect
Rho
Weight
"Clown Colors"

Compositing
Buffer Types

Introduction
LightWave renders are displayed once rendering has finished, and can be used as is but there is a lot more power if you 
use the buffers LightWave provides to create your images - you can save a lot of rerendering too.

What Color Space Should my Buffers be in?



Buffers.7z (51.7 MB) This archive contains the scene file used for most of the buffers shown on these 
pages



https://docs.lightwave3d.com/download/attachments/8202922/Buffers.7z?api=v2&modificationDate=1596702339000&version=1
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The Dragon here shouldn't have much color in the diffuse channel because the dragon is metal. Only areas where the 
verdigris shows through have diffuse color, and so, in Linear, the dragon is almost black.  Switching the Image Viewer 
display to sRGB gives us a better view of the diffuse component but such a view is only better for our eyes, not the 
compositing package.

When you first render an image broken down into its buffers for compositing, it can be unsettling to see how dark the 
resulting images can be. The simple answer is that the renders from LightWave should be saved as Linear, no color 
space manipulation at all, and then the compositing application will output a color-corrected sequence of images as 
the end result. At the same time, nothing prevents you from applying a color space to Image Viewer to better preview 
what that compositing end-result will be. Just don't save that color-corrected image for use in your pipeline.

Data Buffers

Some buffers purely represent data, Object ID and Surface ID are the only two right now. These will be presented in 
clown colors in Image Viewer but the saved image files will seem to be white. There are varying tones indicating discrete 
elements, but a normal screen can't show them.
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The Surface ID buffer as seen in Image Viewer (left) and the resulting TIFF file (right)

Glossary
There are a lot of buffers, but they break down into the following categories:

Direct

Buffers with "Direct" in their name show scene elements that are directly lit by scene lights. The Diffuse Direct is how 
the color of objects with roughness is seen. Specular Direct is the flash of light off a shiny metal of a car hood, for 
instance.

Indirect

Buffers that have Indirect in their name contain the elements of the scene that are lit by light that has bounced off other 
objects, or the environment. For the Diffuse buffer, this will mean the ambient color of an object in your scene or one 
that has received the bounce coloration in a radiosity render.

Rho

The Rho is the weight of reflection of light. In other words, the amount that shader will reflect back - the Specular Rho is 
how much specular reflection is calculated. This shader has a more complex explanation but is very powerful. An 
example would be to have a scene with copper spheres that your director decides should be gold. You can isolate the 
copper spheres in your scene using the material or id buffer, and divide the masked image by your Rho buffer. This 
removes their color. Now, take a copy of the Rho buffer that has been recolored to gold and multiply that with masked 
render. You now have gold spheres without having to rerender the whole scene. You could have tried to eyeball the 
change and isolate out the spheres to touch up their "paint job", but doing it with Rho buffer manipulation will be truly 
correct; for the colored lights in your scene, for other objects, for your director, and you.

Weight

Probably not a buffer type you'll use a lot, it's fairly specialized. Weight buffers are scalar and add up the contribution of 
a buffer type to a finished render. You might have one shiny penny in a scene with many dirty ones, so the Specular 
Weight buffer will highlight that shiny penny for you since it's the element with the most specularity in the scene it will 
be brighter than the other pennies. You can also use to alter the proportions of different buffers in a scene - upping the 
clearcoat in a new car scene, or changing the dermis and epidermis weights in a scene with lots of skin.

"Clown Colors"

Some buffers render in so-called clown colors in VPR, and also for display in Image Viewer. This is only for simplifying 
the concept
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Compositing
The Back to Beauty - Rendering for Compositing example will show you how to combine your buffers for the image you 
are trying to create.

Buffer Types
The Render Properties' Buffers tab shows available buffers organized into groups. They are:

Standard Buffers
These are buffers which the render engine itself makes available.

Extra Buffers
These are buffers which shading system elements, such as the Material nodes and Shading Models, provide.

Light Groups
This group contains any existing Light Buffer Groups. Each of the groups will contain its own set of the buffers which are 
known as "Direct" buffers, since this data can be broken out into a Light Buffer Group specific buffer.

Custom Buffers
Custom Buffers can be created to fulfill specific purposes, like breaking out surfaces of an object. They are stored with 
surfacing, so loading an object that has a Custom Buffer will add that buffer to the system.

Buffer Appearance
Buffers can have a large amount of data in them, represented by different colors. The means of displaying these colors 
depends on the format output.

The Compositing Buffer Export Image Filter has been moved to the LightWave Legacy plugin archive.
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Standard Buffers

These are buffers which the render engine itself makes available.

Final Render
Final output from F9 or F10. For some of the other buffers we have changed the material for the dragon or beads.

Buffers.7z (51.7 MB) This archive contains the scene file used for most of the buffers shown on these 
pages



Buffer types

The image column contains PNG images in these wiki pages because the wiki is not capable of showing an HDR 
image. Buffer Appearance explains the difference.



https://docs.lightwave3d.com/download/attachments/8202922/Buffers.7z?api=v2&modificationDate=1596702339000&version=1
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Alpha
A buffer that is black where there are no objects, or there are objects with a degree of transparency. A backdrop 
image does not contribute to the alpha channel. When there is no fog, the image will appear like our example. When 
there is fog, there will be no alpha as such because the fog will block the background
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Backdrop
The backdrop image, color or gradient for the scene
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Camera Tangent Space XYZ
The surface normals relative to the camera
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Coverage
The Coverage buffer is only for use with applications that support such buffers (compositing applications like Nuke 
or Fusion). It performs three separate tasks. The Red channel contains the information necessary for a compositing 
package to create a coverage buffer for the scene (an enhanced depth buffer). The Green channel contains a 
standard depth buffer, and the Blue channel is an Object ID buffer
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Depth
Black nearest the camera fading to white with distance. The LDR, or 8-bit, version is limited to only 255 possible 
steps
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Edges
A buffer containing just rendered edges. Shown here Intersection edges for the dragon and Silhouette edges for the 
spheres (with Other Edges for the green Sphere)
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Geometry

A grayscale buffer just containing the geometry in the scene
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Lens Flare
A buffer containing just the lens flare element from the render
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Motion
The Motion Vector Buffer outputs a color channel that shows object movement within the scene. This Buffer can be 
used by post-processing software to calculate a 2D motion blur effect. The advantage is that it is usually quicker to 
render compared to true 3D motion blur, but there are limitations for things like camera motion and transparency.
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Normals
The surface normals in world space
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Object ID
Objects are given different colors to separate them. For an HDR image output, this will look only like white in the 
Image Viewer, but there are different Red, Green, and Blue levels to indicate discrete objects
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Object Position
The position of each scene object in Local Space. This buffer records X, Y, and Z information rather than color
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Surface ID
Surfaces are given different colors to separate them. For an HDR image output, this will look only like white in the 
Image Viewer, but there are different Red, Green, and Blue levels to indicate discrete surfaces
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Texture Position
This buffer records X, Y, and Z information rather than color.

It appears differently in VPR (left) than Image Viewer (right) because with VPR values are 
multiplied to fall between 0-255, whereas Image Viewer can have negative values
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Transparency
Shows areas that are transparent to other objects or the background. See also Refraction
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UV
Shows the default UV. Other UV maps are indicated but not detailed. A layered object can only have one default UV 
map.

To demonstrate this, we have added two cubes with their own UV maps to the Ground plane 
object in the scene. The Ground Plane itself is set as the default UV , and the three spheres are 
discrete objects, so have default UVs each.
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World Position
This buffer records X, Y, and Z information rather than color.

It appears differently in VPR (left) than Image Viewer (right) because with VPR values are 
multiplied to fall between 0-255, whereas Image Viewer can have negative values

For this scene, the image from this buffer is not useful to show
dPdU/dPdV
The direction vectors for the U and V coordinate in world space. Some uses are texture filtering, anisotropy, and 
bump mapping. This buffer records X, Y. and Z information rather than color.
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Extra Buffers

These are buffers which shading system elements, such as the Material nodes and Shading Models, provide. 
Most buffers are available here in direct and indirect versions. The "direct" buffers contain data from direct illumination 
of the surface, meaning the light that came directly from a light source. As opposed to the indirect buffers which contain 
data from the indirect illumination, that being light that got to the surface via an indirect route such as light that has 
bounced off another object via radiosity. Some buffers only become available when the materials pertaining to them 
are used.

Carpaint Skin PBSDF

 

Carpaint, Skin and Principled BSDF have several entries in the Extra Buffer list below

Glossary

Direct

Indirect

Rho

Weight

Link to Back to Beauty

Show example using linear and srgb for compositing

clown colors

Buffers.7z (51.7 MB) This archive contains the scene file used for most of the buffers shown on these 
pages



https://docs.lightwave3d.com/download/attachments/8202922/Buffers.7z?api=v2&modificationDate=1596702339000&version=1
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Clearcoat Direct
Provided by the Carpaint and PBSDF material nodes, is the contribution of its Clearcoat element from direct 
illumination

For most of the extra buffers listed here, there are two additional buffers available, labeled as Rho and Weight, 
introduced in LightWave 2019. The Rho buffers include the surface's color and any fresnel effects.  Weight 
contains the value of the surface shader setting in this buffer as a percentage of its contribution to the render. 
A surface that was 100 % dielectric or metallic would have 0 diffuse weight because the diffuse component of 
the surface makes no contribution to the final render.

The Rho buffer is the BXDF reflection or transmission function that is being evaluated for each microfacet 
sample. They are intended for heavy compositing work and used to extract, for instance, the color from a 
specular buffer; by dividing the Rho by the specular direct and indirect to get the raw untinted reflection value.


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Clearcoat Indirect
Provided by the Carpaint and PBSDF material nodes, is the contribution of its Clearcoat element from indirect 
illumination
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Clearcoat Rho

The Clearcoat_rho buffer provides the amount of Clearcoat occurring based on the way in which Clearcoat changes 
with glancing angles, fall off, etc.
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Clearcoat Weight

This buffer shows the amount that the Clearcoat part of the scene's surfaces contributes to the overall render
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Dermis Direct
Available when the Skin node is used (the supplied material for the dragon has been replaced by the Skin node at 
default values)
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Dermis Indirect
Available when the Skin node is used (the supplied material for the dragon has been replaced by the Skin node at 
default values)
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Diffuse Direct
Provided by many material nodes, is the diffuse shading from direct illumination
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Diffuse Indirect
Provided by many material nodes, is the diffuse shading from indirect illumination. If you have no radiosity in your 
render, this buffer will not be available, because there is not indirect diffuse lighting.
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Diffuse Rho

xxx
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Diffuse Weight

xxx
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Epidermis Direct
Available when the Skin node is used
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Epidermis Indirect
Available when the Skin node is used

Fog
The diffuse color of objects with no other component
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Hypodermis Direct
Available when the Skin node is used
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Hypodermis Indirect
Available when the Skin node is used

Legacy Volumetric
Shows legacy HyperVoxels separately

The left image shows a final render with a surface HyperVoxel cloud, the second image shows the 
Legacy Volumetric buffer

Luminosity
Only shows elements that have luminosity

Raw RGB
The Diffuse color without additional surface components.
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Reflection
Only shows pure reflection. If PBSDF has zero roughness on reflection, it shows in the reflection buffer (as a scalar 
represented by changes to the alpha, whereas Standard appears as a color)

The dragon (PBSDF) is visible in this buffer in Image Viewer using the mouse to show the changing 
alpha, but not in a PNG. The ball is surfaced with Standard

Refraction
Only shows elements that have a refractive component.

For this buffer we changed the dragon to use the Dielectric material

Refraction Rho

xxx

Refraction Weight

xxx

SSS Direct
Provided by nodes with a SubSurface Scattering component, is the Subsurface Scattering contribution from direct 
illumination

SSS Indirect
Provided by nodes with a SubSurface Scattering component, is the Subsurface Scattering contribution from indirect 
illumination.

The green glow in this buffer is caused by the luminosity in the edges shown in the final render at 
the top of the list
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Shadow
Indicates scene shadows

Sheen Direct

Provided by nodes with a Sheen component, is the Sheen contribution from direct illumination

Sheen Indirect
Provided by nodes with a Sheen component, is the Sheen contribution from indirect illumination

Sheen Rho

xxx

Sheen Weight

xxx

Specular Direct
Provided by many material nodes, is the Specular contribution from direct illumination

Specular Indirect
Provided by many material nodes, is the Specular contribution from indirect illumination. Without glossy surfaces, 
this buffer will not be available

Specular Rho

The specular_rho buffer provides the amount of reflection occurring based on the way in which reflection changes 
with glancing angles, fall off, and so forth
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Specular Weight

xxx

Translucency Direct
Provided by Standard, is the Translucency contribution from direct illumination

Translucency Indirect
Provided by Standard, is the Translucency contribution from indirect illumination

Translucency Rho

xxx

Translucency Weight

xxx

Volumetric Direct
Provided by the Volumetric system, is the volumetric's contribution from direct illumination

Volumetric Emission
Provided by the Volumetric system, is the volumetric's emission of light into the scene

Volumetric Indirect
Provided by the Volumetric system, is the volumetric's contribution from indirect illumination

Volumetric Light

xxx
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Volumetric Transmittance

xxx
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Light Groups
Introduction
Creating a Light Group

Example - Light Group

This group contains any existing Light Buffer Groups. Each of the groups will contain its own set of the buffers which are 
known as "Direct" buffers, since this data can be broken out into a Light Buffer Group specific buffer.

Introduction

Light Groups are a way to ascertain and modify how certain lights contribute to a scene, In a scene with multiple lights, 
you can set as many groups as you like each containing one or more lights. Lights can belong to multiple light groups 
and each group outputs its own buffers. Those buffers are:

Diffuse_Direct
Specular_Direct
Translucency_Direct
Volumetric_Direct
Volumetric_Light

Any light in a group will have their contribution removed from the main buffers with the same names, and those lights 
not in a group will continue to contribute to the main buffers.

Creating a Light Group

Groups are created in the Render Properties Buffers panel in the Edit.. dropdown.

Once you have made a group you can rename it in the list and choose the options for the buffers it outputs.
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In this shot, we are in Final Render and can see the four spotlights projecting the LightWave logo onto the floor.

We have added the white and green lights to the Separation group and when we choose the Separation > Diffuse_Direct 
buffer we see only those lights:
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If we look at the normal Diffuse_Direct buffer we see the contribution of any lights that are not in a group:

This allows you to control the contribution of your lights after you render, as shown in the example below.

Example - Light Group
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Custom Buffers
Custom Buffers can be created to fulfill specific purposes, like breaking out surfaces of an object. They are stored with 
surfacing, so loading an object that has a Custom Buffer will add that buffer to the system. 

Adding a custom buffer will allow you to create buffers for specific purposes. If you need to split out objects for 
rendering separately, or group several elements together in a single buffer; if you want to create a buffer that doesn't 
exist in the standard buffers, then a custom buffer is what you need. To add a custom buffer, go to Render Properties > 
Buffers > Edit... > Create Custom Buffer. This will give you a field to name the buffer, which will then be presented in 
the list of possible buffers alphabetically. Clicking on Render Buffer will then make it available in your render (VPR or 
F9/F10).

Example - Custom Buffer

You will need to hook up the Custom Buffers you generate to every surface you need to appear in the custom 
buffer. It is not done on a scene basis.


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Buffer Appearance
For VPR
For HDR
For LDR

Buffers can have a large amount of data in them, represented by different colors. The means of displaying these colors 
depends on the format output. Here is an example scene, shown first in VPR.

Our scene, shown in Final Render VPR mode

We can change the buffer display mode by selecting from the Buffer menu at the top of the viewport. 
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Object ID, Surface ID and Depth buffers

For VPR

Things are always colorized in VPR to make it easier to visualize the data. Likewise, the depth buffer is normalized (see 
above if your depth buffer does not look right). When you are performing final renders, things change.

For HDR

Floating Point (FP) images (EXR, RAD, Cineon and so on) will use floating point numbers to separate scene elements. If 
you were to look at a rendered image with buffers in Photoshop or an image viewer capable of displaying a floating 
point image, but capable of no further processing, all you would see is white. There are different shades of white, but 
not in a human-visible way. Compositing programs don't care, they can see the differences very well and that's what is 
important.

Images will be colorized when viewed in LightWave's Image Viewer (and normalized for the Depth Buffer), but FP 
grayscale in other applications.

If your normalized depth buffer is only showing black or white for geometry, make sure the Depth Buffer 
options are set correctly for your scene. Visit Render Properties (Ctrl+F9) > Buffers > Depth and set the Options 
to an appropriate range for your scene.


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Holding down the LMB in the Image Viewer and moving over an image will show the ID number for the scene elements 
in this buffer

For LDR

LDR buffer images are always colorized. Additionally if you use TIFF or JPEG, the Blue RGB channel is used to contain 
the Surface and Object ID, which can be seen in Image Viewer (the lossy nature of JPEG compression means that item 
borders are not always clean). No other LDR format image contains the necessary metadata channels to enable this 
view of IDs, but all image formats work equally well outside LightWave. In Image Viewer, the RGB values will be shown 
on mouseover as they always have been.

Be aware that there is a limit of 255 Object or Surface IDs if you output LDR images. If your scene requires more 
of either (or both), you should use HDR output to avoid problems.


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Back to Beauty - Rendering for Compositing
Click here to expand Table of Contents...

Introduction
The Buffers
Volumetrics

Introduction
If you render straight out of LightWave - you hit F9 or F10 and take whatever you get - but for compositing work or more 
control over your renders and to speed them up (rendering depth of field adds time to a render, but rendering out a 
depth pass and using a compositing package to create a depth of field effect takes no additional time) using 
LightWave's buffers is the only way to go. The question always remains, "which buffers do I need" and the answer 
depends on your scene's content but for general use the following equation should see you right:

(Diffuse_(Direct and Indirect) + Specular_(Direct and Indirect) + Clearcoat(Direct and 
Indirect) + etc. + 
Refraction + Transparency + Luminosity + Fog) * Volumetric Transmittance
 + Volumetric_((Direct and Indirect))

All the following buffers should just be added together, and because adding is commutative the layer order does not 
matter. In Photoshop, the Blend Mode is called "Linear Dodge (Add)".

Remember, you only need the buffers you use, so if your scene has no Clearcoat, Fog or Volumetrics you do not 
need to include those buffers in your render


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The Buffers

Diffuse_Direct

plus
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Diffuse Indirect

plus
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Specular Direct

plus

Specular Indirect

plus
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Refraction

plus
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Clearcoat Direct

plus

Clearcoat Indirect

plus



LightWave 2020  –  LightWave 2020

Getting Started with Rendering –  767

SSS Direct

plus
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SSS Indirect

plus

Luminosity

Added together equal:
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Final Render

Volumetrics

When we say volumetrics in this sense we are referring to the new volumetrics that LightWave can now create, not 
volumetric lights or the HyperVoxels that came with LightWave 2015 and before. If you have Volumetric primitives or 
VDB files in your scene, you need to make sure that the Volumetric Transmittance buffer uses a Blend Mode of Multiply 
to combine it with the others for a render and that any other Volumetric buffers are added.

•
•

•

•

Images are PNGs here for demonstration purposes but should be EXRs or similar for full flexibility
If you are going to use PNG, you need to set your Depth Map distances correctly so that the range of 
steps is small enough to be contained by the 255 levels an 8-bit per channel image provides
You decide what buffers you need to use by the details you use in surfaces - if there's no SSS, you don't 
need that buffer and so on. Normally, the bare minimum is Diffuse (Direct and Indirect); Specular 
(Direct and Indirect); plus Refraction for transparent materials
Buffers can add a little extra time to a render because there will be more files to write out than a single 
image



Note that a Multiply blend mode must be used for Volumetric Transmittance
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Reference

In this section are gathered all the reference sections for the documentation. Come here when you're not sure how 
something works.

Layout
Modeler
Simulation
FiberFX
Animating
Surfacing
Rendering
Interchange
Scripting
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Layout

Layout is the LightWave application in which you will light, animate and surface the models you have created in 
Modeler. It is where you will render, either through VPR, using the F9 offline renderer, or using the LWSN distributed 
renderer.

Layout is the portion of LightWave in which you will create dynamic simulations and as many instances of objects as 
you'd like.

Object Properties
Scene Management
Previsualization
Import/Export
Master Plugins
Undo System
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Object Properties

LightWave's Object Properties panel contains a lot of information in a small space. The biggest change from versions 
previous to LightWave 2018 is the addition of a Primitive Type dropdown menu that considerably changes the types of 
objects Object Properties can deal with.



LightWave 2020  –  LightWave 2020

Reference –  773

•
•
•
•
•
•
•

If the surface changes, the object filename will be highlighted in yellow

Primitive Type
Render Tab
Appearance Tab
Lights Tab
GI tab
FX Tab
Instancer Tab
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Primitive Type

For the most part, your primitive type will be Mesh, but there are four other types selected from the Primitive Type 
Dropdown:

Primitive Type - Mesh
Primitive Type - Fiber
Primitive Type - Volumetric
Primitive Type - OpenVDB
Primitive Type - Shape
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Primitive Type - Fiber

While you can add FiberFX to a null with this Primitive Type, it is recommended you use the FiberFX window.
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Primitive Type - Mesh

When your Primitive Type is Mesh, then you have two further sub-tabs:

Geometry

Edges
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Mesh - Geometry

This tab shows the makeup of your mesh object. You can manage Object Replacement and use the brand new Modifier 
Stack.

When a mesh object has received revisions - in surfacing or geometry - the label for the object name will 
become yellow indicating that changes need to be saved.


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Object Replacement
Click here to expand Table of Contents...

Level-of-Detail Object Replacement
LScript and LScript/RT
Object List
Object Sequencer
OpenVDB Evaluator
Python
Python Frame Timer
Python Random Number

You can use plugins to replace objects during an animation.

Level-of-Detail Object Replacement
Adding Level-Of-Detail Object Replacement lets you replace the object with another object based on its distance from 
the camera. This can be a great time-saver for objects that are sometimes close to the camera and sometimes far, 
during your animation. There is no reason to waste rendering power on a gazillion-polygon battle cruiser that is too 
small to make out any of its details. If it’s far enough away, you might be able to get away with a simple box or sphere!


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From top to bottom, the entries must be in near-to-far order, so the furthest , as well as the shape of the geometry, is 
last. When the distance from the camera to the object is within each range, the corresponding object is loaded. The 
Base Object setting defaults to the object the plugin is added to; however, you can define a different one if you like.

LScript and LScript/RT
Loads a custom LScript to replace objects.

Object List
Object List replaces the current object with those listed in a text file. The file is defined using a file requester that 
appears when you click the Options button. Object List works much like Object Sequence, discussed later, but the 
object replacement list lets you use objects in different directories or even across a network. The file must be formatted 
as follows:
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#LW Object Replacement List
<replacement frame number>
<replacement object file>
<replacement frame number>
<replacement object file>
<replacement frame number>
<replacement object file>
<replacement frame number>

The replacement object information is defined in pairs of lines. The first line of the pair is the frame number at which the 
object is to be replaced. The second line of the pair is the filename of the replacement object, using a full path.

For example, to sequence through a series of box objects, this list would be used:

#LW Object Replacement List
0
c:\Newtek\Objects\terrihendrix.lwo
10
c:\Newtek\Objects\lloydmaines.lwo
20
c:\Newtek\Objects\willoryfarm.lwo
 

The sequence of objects does not need to be similar copies of the same thing. You can replace the cow with a chrome 
teapot if you want to.

The first paired lines must be the object you want at frame 0. LightWave will assume this even if you enter a different 
frame number. As such, if you used:

#LW Object Replacement List
35
c:\Newtek\Objects\box2.lwo
 

The Box2 object would still be loaded at frame 0.

Object Sequencer
Object Sequencer replaces an object with another one at a certain frame of the animation. This replacement is like 
choosing Items > Replace With Object File except that it happens during the animation. Object Sequence is to objects, 
what an image sequence is to images.

To perform an object replacement, you must have multiple objects with names that differ only by a three-digit number. 
For example, if you want to change between a series of box objects, you would name the first object box000.lwo. If you 
want that object replaced by a second object at frame 10, name the second object box010.lwo. This would be replaced 
by box027.lwo at frame 27, and so on. These objects don’t need to have anything in common except their names.

You must finish the object replacement list with a blank line otherwise the last object in the list will not load
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To use Object Sequencer, load the first object normally. Then, select Object Sequence as the Object Replacement 
plugin. All of the object files must be in the same subdirectory.

Object geometry is normally created in Modeler and object animation is accomplished in Layout. However, you can also 
animate object geometry, that is, change the relative positioning of points in an object and thus change its shape. A 
simple example of this is sending a ripple through a flag, which might be a simple segmented flat box. LightWave’s 
bones feature lets you bend and distort object geometry using an object skeleton. Often the bones are set up in a 
hierarchy using Inverse Kinematics (IK) to help animate a complex structure, but IK can just as easily be applied to a 
hierarchy of objects. Geometry can also be influenced by morphing.

To create such object sequences, you can use the Save Transformed Object command (File > Save > Save Trans Object) 
to save the stages of transformation for an animated object.

A sequence of objects created using Save Transformed Object to save the object in various stages of animation. Note 
that the location as well as the shape of the geometry is recorded.
OpenVDB Evaluator
This replaces the polygonal mesh of an object with an SDF - Signed Distance Field - or volumetric shape. This is a great 
way to remesh objects, dissolve them or create shaped fog volumes. OpenGL will show an iso-surface object, but a fog 
volume is best seen in VPR.
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Iso-Surface VDB of a LightWave logo changing Voxel Scale. The object goes from six polygons to 277,372.
Python
Load your Python object replacement script.

Python Frame Timer
Python Frame Timer will successively replace objects in your scene to make a timer coinciding with the scene Frames 
per Second setting.

To use this tool, first you need to set up one or more Nulls with the names:

hours_tens
hours_ones
minutes_tens
minutes_ones
seconds_tens
seconds_ones

These nulls will be replaced by objects that are named 0.lwo - 9.lwo as time passes in the scene. If you make those 
objects in the form of numeric digits you will have a seconds counter inside LightWave.

Python Random Number
An example script included with LightWave. Like Frame Timer, it uses a null object (name doesn't matter) to which you 
add this Object Replacement script. In the options set how often it changes and point the script to a directory 
containing objects named 0-9 and the number will change at every interval you set.
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OpenVDB Evaluator
Click here to expand Table of Contents...

Introduction
Common
Solid Volumes from Meshes and other Scene Items

Mesh To Volume
Shape To Volume
Fog To LevelSet
From Particles

Gaseous Volumes from Scene items
Gas Solver
To Fog Volume

Tools
Advect
Advect Points
Analysis
CSG
Combine
Filter
Level Set Morph
Noise
OpenVDB Info
Partio Node
Attributes list
Resample
Saver
Scatter
Solver
Vector Merge and Split
Velocity
Visualize

Using Fog in the OpenVDB Evaluator
Example - Volumetric Cheese


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Introduction

This feature gives the user the power to create volumes from meshes and meshes from volumes. Fog Volumes need an 
Iso above 0 in the OpenVDB destination node; Level Sets need an Iso at 0
In LightWave 2018, we added the possibility to load OpenVDB volumes and render the smoke or explosion, but we had 
no means of creating OpenVDB volumes. LightWave 2019 adds this missing capability, with the tools to convert mesh, 
primitive, or particle objects into VDB Fog Volumes or Level Sets - voxel-based solid objects.

Everything starts with the Object Replacement entry OpenVDB Evaluator. Creating a VDB volume, or even converting a 
VDB into a mesh, requires at least one null object using the OpenVDB Evaluator. OpenVDB files contain grids of data and 
LightWave adapts them to data the render engine can work with. With it, you can create volumetric objects that can 
deform or grow from smaller origins, or dissipate away.
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Once you have your target mesh and null to direct it to, open the node editor by clicking on the Properties 
button next to the OpenVDB Evaluator entry. The destination node

contains three entries. A scalar-based grid input, a purple Particle System input, and a vector-based velocity grid input. 
The scalar grid is the one you'll use most often for fixed shapes. If motion blur is enabled and there is a velocity grid, a 
deformer will be added to the object modifiers list allowing for subframe evaluation of the grid using the velocity input. 
The Particle System input is new to 2020, and transforms particle systems, whether originally OpenVDB-based or not, 
into OpenVDB volumes.

The OpenVDB Blur deformer cannot be interacted with by the user. It has no UI, cannot be added or deleted except 
automatically by Layout
Double-clicking on the destination node will open its settings window

Iso - The iso value is considered to be the zero crossing of the grid's field of values. This zero crossing is where 
polygons are constructed for LevelSet objects, Fog volumes require the Iso to be set above 0
Adaptive - Values above zero will consolidate small voxel size polygons into larger polygons as flatness allows
Invert - Fog volumes can be input, but due to the representational difference between them (unsigned ) and SDF 
(signed) volumes the polygons appear backward. This will flip the polygons for that case. Additionally, you will 
need to move the Iso surface above 0

Common
 OpenVDB nodes may have the following common settings:

Voxel Size - Size of the voxel grid in meters (LightWave supports uniform grids); the size of the voxel "blocks" 
that will make up your object
Inner Bandwidth - Inner Bandwidth for level set in voxels

Creating volumes from meshes relies on polys being tris or quads. NGons are not supported
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Outer Bandwidth - Outer Bandwidth for level set in voxels. For fog volumes, this defines the "softness" until 
maximum density is reached.
Fill Interior - Toggle for whether the volume will be solid when cut into or just a shell - like polygons are. Turning 
on Fill Interior with a Fog Volume will soften the outside of the fog
Coordinate System - How the voxel will be transformed. There are three choices

Local - No transform
World - Transform into world space
Parent - Use the parent item's space

Grid Name - the base name of savedgrid.vdb files. Files will be appended with the frame number and written 
with temperature, density, and velocity grids

Solid Volumes from Meshes and other Scene Items

Creating a volume this way requires a target mesh, primitive shape or Particle emitter that needs to be in the scene. It 
can be out of camera view, hidden from render and hidden in OpenGL and the Object Replacement will still work. To 
create a volume from this item requires adding a null and using the Object Replacement entry OpenVDB Evaluator. 
Clicking Properties for it will bring up a Node Editor window.

Mesh To Volume

Creating volumes from meshes relies on polygons being tris or quads. NGons are not supported
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In the OpenVDB nodes group, Mesh To Volume will be the node to convert your mesh objects into volumes. There are 
two choices for conversion, Fog Volume will convert a mesh into a volumetric fog, much like the image at the top of this 
page, but you need to use an OpenVDB primitive. The second option is Level Set, which creates a volumetric mesh 
object. The Voxel Size setting will determine the resolution of your volumetric object. For the Logo Rezzing Up
example, a Scalar Constant node was used with an envelope that went from the default 1 down to 0.0025 to create the 
increasing resolution of the volume.

Particle Radius is where you set the size of individual particles if you will be outputting a particle system from this 
node.

The new Attributes tab, added in 2020, is where you can transfer details like vertex maps or surfacing information from 
the original mesh to your OpenVDB object.

Surfaces will all be added. You cannot just choose one.
Shape To Volume
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Will create a volume from LightWave primitive objects.

Fog To LevelSet

Converts a Fog grid to a Level Set mesh object. A fog grid can be imported using the OpenVDB Info node. Double-
clicking the node brings up its window with Iso setting and Normalize toggle.

From Particles
New to 2020. There is now a Particle System output to send particles directly to the Editor Input. You can choose to 
represent particles as individual spheres or a trail (of connected spheres). When you select Trail, a Trail Resolution
setting becomes available. Higher values mean more trail particles and might be needed for high-velocity trails.

The Morphology tab includes elements that are found in the Filter node that can be applied directly, without needing a 
discrete Filter node.
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This node will create a volumetric object from a stream of particles created using the FX Emitter or the Scatter or Solver 
nodes here. You have the option to either create sphere shapes or a trail per particle derived from their position, radius, 
and velocity. Each trail is generated as CSG unions of sphere instances with a decreasing radius.

When you have a particle emitter being meshed, you cannot bring up the particle properties, as upon meshing 
(the OpenVDB Evaluator being an object replacement procedure), the PFX Emitter server pane will close. The 
only way to adjust particle properties, in this case, is by using the modal FX Browser panel.

The same is true for other server pane items - changing the subdivision level, for example - but in that case, the 
only workaround is to disable the VDB object in the Scene Editor by unchecking the render flag.



FX Emitter particles must have a Size, and that size must be output with the Output Size toggle. You don't 
need to Show Size; it just helps visually.


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Particle System - A dropdown for choosing the specific particle system you want to use. Using the Input ghosts 
this control
There are two tabs next:
Surface - Details how the particles look:

Particle Count - A readout of attached particle system particle count
Space - Choose whether your particles are situated in Local, Parent or World Space
Particle Type - Choice between Sphere and Trail. Sphere will create distinct bubbles whereas Trail will 
attempt to use particle velocity to create a trail of diminishing size. Each trail is generated as CSG unions 
of sphere instances with a decreasing radius
Trail Resolution - Only available when the Trail Particle Type is chosen. The default of 1.0 trails off 
"normally". Less than 1.0 means fewer trail particles and separation might be noticeable. More than 1.0 
means more trail particles are created. Higher trail speeds might need more particles to stay stream-like 
so separation doesn't show
Voxel Size - Size of the Voxel for the particles. Voxels sizes in a network should be the same, especially 
combining or collisions between VDB grids
Iso Surface - Iso sizes in a network can be different but the editor input node will create the final meshing

Morphology - Operators so additional nodes are not needed
Dilation - Dilate the grid along its normals making it bigger
Closing - Dilate the grid to close holes then erode closing openings
Smoothing - Gaussian smoothing

Gaseous Volumes from Scene items
Gas Solver

The direction of a trail is inverse to the direction of the Velocity vector, with a length of |V|. The radius at the 
head of the trail is given by the radius of the particle and the radius at the tail of the trail is Rmin voxel units 
which has a default value of 1.5 corresponding to the Nyquist frequency.


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Gas solver.  Use Stam's stable fluids method to advect density and temperatures. Both the density and the temperature 
affect the fluid’s velocity. Heavy smoke tends to fall downwards due to gravity while hot gases tend to rise due to 
buoyancy. We use a simple model to account for these effects by defining external forces that  are directly proportional 
to the density and the temperature.

buoyancy = (-densityscale * density * Vec3f(0, 1, 0)) + (temperaturescale * temperature 
* Vec3f(0, 1, 0));

External forces can be added on the Force Grid input. This input accounts for external forces like gravity, wind, 
turbulence and merely is added onto the end of the momentum equation.

Temperature Tab
Ambient Temperature - Ambient air temperature
Clamp Temperature - Clamps the temperature to the minimum value set below (otherwise the gas cools to the 
point where it falls like dry ice)
Min - The minimum temperature (in Celsius) for the gas to fall to
Normalize Temperature Grid - Outputs the temperature grid as a scale between 0 and 1, rather than, say, 60 
and 900
Fuel Temperature - Fuel temperature as it is emitted
Gas Density - Density of emitted smoke from the fuel grid
Fuel Velocity - Velocity of emitted smoke and heat from the fuel grid
Density Scale - Scale of the downward pull on dense smoke
Buoyancy Scale - Scale of the temperature gradient pulling smoke upward

http://physbam.stanford.edu/~fedkiw/papers/stanford2001-01.pdf
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Cooling Scale - Scales the cooling rate
Dissipation - The amount of density that falls off over each iteration so that the gas thins over time

Advection Tab
Spacial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spacial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Max Divergence Steps - Maximum number of iterations of the pressure solver
Advection Sub Steps - Substeps per integration step. The only reason to increase it above its default value of 
one is to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Curl Scale - Curl strength of the vorticity confinement

Domain Tab
Boundary - One of three choices:

Free Slip - Velocity is negated at the boundary axis
No Slip - Velocity is set to 0 at the boundary
Outflow - The grid is clipped at the boundary

The Min and Max domain fields are for setting the minimum and maximum extents (corners) of the simulation's 
domain.

Cache Tab
Cache Grids - Toggle for enabling the caching of grids to Cache Path folder. Once cached they can be loaded 
without simulation
Cache Name - Base name of saved grid . vdb files. Files will be appended with the frame number. Files will be 
written with temperature, density, and velocity grids
Grid Path - Path to save folder
Clear Cache - Clear all files in the cache folder
Behavior - A dropdown with three choices:

Manual - Cache control is completely up to the user
Warn - A message will warn "The cache is invalid, should it be cleared?"
Automatic - The cache is cleared automatically, when necessary

To Fog Volume

Converts an SDF grid (signed) to a fog volume (unsigned) with a filled interior. There are no options.

Tools
You can manipulate OpenVDB volumes with the following included tools.

Advect
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Advect a Signed SDF grid with a velocity grid. Requires a Velocity Grid vector to give movement and direction.

Spatial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spatial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Normalizing Steps - A number of renormalization passes can be performed between each substep to convert it 
back into a proper signed distance field. Prevents jerky motion but soften and slows the velocities
SubFrame Steps - Substeps per integration step. The only reason to increase it above its default value of one is 
to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Rebuild SDF - Toggle to rebuild and retrack the narrow band of the SDF

Advect Points
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This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for

Analysis
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This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.

CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes, and is the default option
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B
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The velocity of the input grids will be reconstructed and output.

Combine

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
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rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background


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Filter

  

This node adjusts the inner bandwidth of a volumetric signed distance field represented by a VDB volume
Filters the level set grid:

Filter Type:
Renormalize - Repair level sets represented by VDB volumes. Certain operations on a level set volume 
can cause the signed distances to its zero crossing to become invalid. This node iteratively adjusts voxel 
values to restore proper distance
Mean Value - This performs the equivalent of a simple box blur by taking the mean of the surrounding 
values
Median Value - This chooses the median of the surrounding values, good for homogenizing noisy data to 
avoid spikes
Mean Curvature - Finds the average curvature for a location and moves the surface along its normal to 
smooth out bumps
Laplacian Flow - Uses a local Laplacian value for movement along a normal
Dilate - Dilate the grid along its normals making it bigger
Erode - Erode the grid along its normals making it smaller
Close - Dilate the grid to close holes then erode closing openings
Open - Erode the grid then dilate to create openings
Track - the grid topology is updated by rebuilding the inner band so that it tracks the new iso interface
Gaussian - Gaussian smoothing
Resize - Change the width of the inner band of a VDB signed distance field

Accuracy - Increasingly complex algorithms for the accuracy of the integration
World - Performs the math for creating the levelset in World space, rather than Local
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Half Bandwidth - Level sets are normally symmetrical on the inner band. Half Bandwidth uses this fact to halve 
calculation times but at the cost of accuracy
Iterations - the maximum number of attempts to achieve a divergence-free pressure matrix
Voxel Offset - Offsets the iso surface from the actual value. For instance, using

Level Set Morph
You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

The above node tree will synchronize your surface morphing at the same time as the geometry

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out

Noise

Add the Bump output from an image or a 3D Texture to this node and pipe the output through.

OpenVDB Info
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The values for the Fuel channel of a VDB sequence
You can pipe a Level Set or Fog grid into this node and see the values contained within the file, but this node becomes 
more useful when you load a vdb file directly in the node. You can see info from whatever channels the vdb file contains.

Partio Node

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

Target - If you are using a volumetric object with the particle system, make sure it is targeted here

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.





LightWave 2020  –  LightWave 2020

Reference –  802

•
•
•

•
•
•
•

•

Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list
Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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Using the Partio node with a From Particles node

As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab
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You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Resample

Resample input grid to new voxelsize to output grid.

Interpolation - Different interpolators with increasing complexity
Rebuild SDF - Rebuilds and normalizes the narrow band of the level set
Prune - Removes values from the level set that are smaller than the Prune Tolerance set below

Saver

Pipe a grid into here and the frame or sequence is saved as VDB files upon clicking the Save button.

Save Type - a choice of Frame or Sequence. In both cases, a files or files will be saved using the File Name 
chosen appended with the frame number
Save Path - Choose a folder for the frame or sequence
File Name - The chosen prefix for the frame or sequence
Save - Immediately saves the frame or sequence. There is no visual confirmation apart from the playhead 
stepping through the scene in case of a sequence save

Scatter

To load files saved this way, use the OpenVDB Info node to choose the VDB file and its channel saved.
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Scatter creates particles on the input grid.  The particle system constructed belongs to the scatter target item. Particles 
can be scattered on or in both SDF and fog volumes.

Scatter Target - The input grid to scatter on
Scatter Mode - Dropdown to specify how the particles will be placed:

Point total - Absolute number of particles to be scattered
Point Density - Percentage of voxels in which to place a particle
Points Per Voxel - Number of particles to put in each voxel

Seed - Sets the random seed
Spread - Distance to randomly move from the voxel center

Depending on the scatter mode chosen:

Point Count - When Point Total is chosen (integer)
Density - When Point Density is picked (percentage)
Points Per Voxel - When Points per Voxel is chosen (scalar)

Multiply - Density multiplier
Animate - Reseed the random generator each frame
Fill Interior - Fill particles inside the sdf narrow band
Size Factor - The size of the particles created
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Creating bubbles inside a VDB toroid is simple with the Scatter node. The Filter node has been used here in Erode mode 
to ensure that the bubbles are created inside the toroid volume and not at the boundary.
Solver

A particle solver that uses a particle system to initialize a temporal PIC/FLIP feedback loop. Particles from the particle 
system are input as they are born. Then are advected by the integrator using the gravity over the frame substeps. PIC 
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(Particle In Cell) produces smoother motions, and FLIP (FLuid Implicit Particles) is splashier. The two methods can be 
combined.

The Navier-Stokes equations that the PIC/FLIP system uses do not dictate position but velocity. The vectors contained 
are not coordinates but velocities. PIC / FLIP is an advection equation, which is how the particles in these objects move 
within velocity fields.

Particles In Cells (PIC) works by evaluating particles as groups of particles in cells (like voxels)

FLIP stands for FLuid-Implicit Particles and uses a grid rather than particles. Grid-based methods were great for large 
ocean effects, but not fine detail close up visual effects work. Things can look globby and unrealistic at a small scale 
(thin fluids).

Inputs
Collision Grid - SDF grid to be used for collisions
Particle System input - Use a separate particle system

Outputs
Grid - Outputs an SDF grid
Particle System Out - Particle system output
Start Only - Only uses the first frame of the particle system
Voxel Size - Size of the gid voxels
Integrator - In short, the upper choices from this dropdown menu are faster but the lower choices are better 
quality
Subframe Steps - More steps per frame is more accurate but takes longer
PIC↔FLIP - Ratio of PIC velocities to FLIP velocities
Blobby - Check to treat the particles as spheres
Gravity - Downward pull in meters per second squared
Stickiness - Amount of velocity absorbed by contact with collision object
The next three checkmarks are to help visualize the grid:

Show Particles
Show Grid velocity
Show Collider grid

Vector Merge and Split

New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Solver is time-based so scrubbing the scene will break it, particularly going backward. Create previews to 
see a smooth animation if your scene is too heavy.


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The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states

Velocity

This node will construct a velocity grid for motion blur use.

Reference Grid - Use to populate the velocity grid on the active values
Velocity - Vector of velocity evaluated during grid building
Rebuild Velocity - Rebuild Velocity at each evaluation rather than creating a static field

You can use an envelope or a texture map to adjust the velocity grid over time for more control

Visualize

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
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Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform

Using Fog in the OpenVDB Evaluator
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On the left side of this screenshot we have a polygonal donut. In the middle we have a level set of the same donut and 
on the right we tried to do the same with fog but just get the pivot point.
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The solution is to change the Iso in the destination node, which needs to be a positive number - 0.01 will suffice. Our 
third donut looks very odd, as though the light is coming from the other side and as if it is standing up.

It was merely an optical illusion. The donut was actually inside out and clicking Invert restored normalcy.
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Donuts in all their forms: white - polygonal; red - Level Set volumetric; green - Fog Volume volumetric; blue - fog 
OpenVDB primitive
Example - Volumetric Cheese
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Modifier Stack

The Modifier stack replaces the rigidly defined and sometimes awkward system before LightWave 2018. Now, you can 
adjust the order of your modifiers simply by dragging them up and down the list. To edit a specific Deformer, double 
click on its entry. Deformers can also be switched on and off individually by clicking in the On column. At the start of the 
modifier list are the "standard" modifiers that are usually available by default:

Modifier - Morphing
Modifier - Bones
Modifier - Subdivision
Modifier - Nodal Displacement
Modifier - Surface Displacement
Modifier - Displacement Map
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In addition to the six built-in object modifiers there is a large selection of other modifiers listed here:

Add Object Modifier

If multiple objects are selected, the modifier stack will now show all selected objects. Holding Alt when 
clicking on an item in the modifier list will select similar items in all selected objects and they can all be moved 
in the list at the same time.

The circle indicates when Alt is being held down


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Add Object Modifier
Click here to expand Table of Contents...

Curve Conform
Deform Displacement Plugins

Deform: Bend
Deform: Pole
Deform: Shear
Deform: Taper
Deform: Twist
Deform: Vortex

Effector
Expression
FX_Hardlink
FX_Hardlink Properties
FX_MetaLink
FX Metalink Morph
HyperVoxels Particles
Inertia
Joint Morph Plus
Lazy Points
LScript and LScript/RT
MD Baker
MD Reader

Setting Options

MD_MetaPlug
Setting Options

MD_MetaPlug_Morph
Morph Mixer
NormalDisplacement
Python
Python Lazy Points
Relativity Morph
Serpent
Sock Monkey

Control Item Tab
Display Options
Batch Operations

MD Multi Baker
Spline Displacement

Curve Conform
Curve Conform uses a curve object to deform an object’s mesh. In order to determine what part of the curve applies to 
what part of the mesh, you must define an axis and a range of distances along that axis. The axis is the direction in the 
mesh, which will be transformed to lie along the curve. The Range Start and Range End values define where the 
beginning and end of the curve match up with the selected Axis.


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When Curve Conform is first added, it scans the mesh to compute a bounding box. The range and axis are set to match 
the longest side of this bounding box. The Auto-Range button can be used to rescan the mesh and set the range based 
on the bounds of the currently selected axis.

The curve object is set on the Curve pop-up. If there is more than one curve in the object, the first curve is used.

The Flip option reverses the influence direction of the curve. World Coordinates leaves the curve’s position fixed in 3D 
space, deforming only that part of the mesh that moves into its range.

Stretch alters the mapping of the range to the curve’s arc length (the length of the curve), so that the entire range 
exactly fits into the length of the curve. This can cause stretching or compression of the mesh along its axis.

When Align is enabled, the vertices are rotated, as well as translated, so the mesh’s “thickness” along the axis is 
preserved, like a bend operation. This mode maps the range directly to the curve, so the Flip option has the effect of 
flipping the mesh, but leaving the basic shape the same.The Curve Influence percentage blends the deformed shape 
with the original un-deformed shape

Show Curve (Custom Object) displays an object curve in Layout - normally curve objects are a modeling tool and cannot 
be seen in Layout. (If there is more than one curve in the object, the first curve is used.)

Deform Displacement Plugins
The Deform Displacement plugins let you deform objects much like Modeler’s Flex and Deform tools. Each needs two 
null objects to operate.

Deform: Bend
The Effect Base object defines the start of the bending point along the selected Axis. The Effect Handle object 
determines the direction of the bending.
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Deform: Pole
The Effect Center is the center of the effect and scaling it will distort the geometry. The Effect Corner defines the corner 
of the influenced area. Use the sliders to shape the influence area.

 

Nulls used in image are using Item Shape instead of the standard Null Shape.
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Deform: Shear
The setup for Deform: Shear is nearly the same as Deform: Bend. You can also control how the effect is applied from the 
base to the handle by using the two tension sliders. The top slider controls the beginning and the bottom one controls 
the end. Use the Preset pop-up to select from some common settings.

 

Deform: Taper
Deform: Taper works just like Deform: Shear, except that you size the handle instead of moving it.

 

Nulls used in image are using Item Shape instead of the standard Null Shape.

Nulls used in image are using Item Shape instead of the standard Null Shape.
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Deform: Twist
Deform: Twist works just like Deform: Shear, except that you rotate the handle instead of moving it. The center of the 
twisting is defined by the base object.

 

Deform: Vortex
The Effect Center is the center of the effect and rotating it around the selected Axis will distort the geometry. As such, if 
you select the X axis, you rotate the object’s pitch; for Y, you rotate heading; and for Z, you rotate bank. The Effect 
Corner defines the corner of the influenced area. Use the sliders to shape the influence area.

Nulls used in image are using Item Shape instead of the standard Null Shape.

Nulls used in image are using Item Shape instead of the standard Null Shape.
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Effector
Effector causes effector objects to repel or attract the points of the affected object. The effector objects may be any 
objects you wish, but Null objects work best.

The Effector Object(s) Prefix is a name prefix with the default of Effector, and any object that begins with this name will 
be an effector. This lets you have more than one effector based simply on their name.Solid Core Radius defines a 
spherical area, within which all points are equally affected. There is a gradual falloff of the effect between the Solid Core 
Radius and Falloff Distance. Points outside the Falloff Distance are not affected at all.

You can also choose the Effector Shape: it can be a Point or Plane. If it is a Plane, you need to specify the Axis. Plane can 
make an impenetrable plane that begins at the negative side of the axis based on the effector position (like keeping feet 
squashed against the floor). Falloff Distance and Solid Core Radius will have no effect.

The impact of the effector object is set and animated by keyframing its XYZ Size channels. Positive values repel and 
negative values attract.

Add Deform: Vortex three times using a different Axis setting on each to have full rotational influence. 
Nulls used in image are using Item Shape instead of the standard Null Shape.





LightWave 2020  –  LightWave 2020

Reference –  822

Expression
Expression is a sister plugin to the Expression channel modifier. You use it in the same way.

You can set independent expressions for the XYZ point displacements using the Channel pop-up menu.Some global 
options are available that are not on the channel modifier version. The After Bones option will cause the displacement 
to occur after bone displacement. With World Coordinates checked, the XYZ variables in the expression are in world 
space, not local space.

FX_Hardlink
FX_Hardlink is a very powerful tool that allows you to use the dynamic motion from one object and apply it to another. 
In most cases the dynamic object contains very few polygons (2-point polygons) while the “HardLink” object has a 
higher polygon count.

In the example below, Cloth Dynamics is applied to a 2-point polygon chain made up of (x4) 2-point polygons. It is the 
parent of a single layered object that is made up of four monkeys. When you use FX_Hardlink, the monkeys take on the 
motion of the 2-point polygon chain.

Hardlink keeps the geometry rigid and will displace it based on the Piece Mode setting.



LightWave 2020  –  LightWave 2020

Reference –  823

FX_Hardlink Properties

Under the Basic Tab you can choose what Piece Mode you would like to use. Polygon treats each segment as its own 
object. 1 Piece will make the entire object a solid and considers it one piece. Point Set will read selection sets that you 
could create in Modeler.

The Edit FX Tab allows you to change what pieces are linked to what nodes. This is handy if the tool doesn’t quite link 
what you thought it would on complex objects.

The HardLink Object must be parented to the Dynamic object in order for FX_Hardlink to work.
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FX_MetaLink
FX_Metalink is a very powerful tool that allows you to use the dynamic motion from one object and apply it to another. 
In most cases the dynamic object contains very few polygons (2-point polygons) while the “MetaLink” object has a 
higher polygon count.

In the example below, a 2-point polygon chain with Cloth dynamics applied to it is the parent of the Worm (MetaLink 
Object). The Work takes on the dynamic motion of the 2‑point polygon chain with zero calculation time.

 
The Smoothing option attempts to smooth the reshaping of the Metalink object. If unchecked, the reshaping can pass 
through the vertex of the cage object (dynamic Object).

You may run into problems if the Dynamic Object is too rough. Subdividing the Dynamic Object may help.

The MetaLink Object must be parented to the Dynamic object in order for FX_Metalink to work.
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FX Metalink Morph
FX_Metalink_Morph is a displacement plugin that enhances the functions of FX_Metalink. By itself, FX_Metalink cannot 
use normal morphing information because it ignores bones, Morph Mapping, and Displacement Maps. However, if you 
use FX_Metalink with FX_Metalink _Morph, you can use normal morphing data.

FX_Metalink _Morph has one pop-up menu called Morph Mode. Set this to One time morph to execute morphing only 
one time. This mode is appropriate when the morphing is from Morph Mapping. Use Every time morph to execute 
morphing for each displacement process. This mode is appropriate when the morphing varies, like the Displacement 
Map of waves. The Non morph setting simply disables this plugin.

HyperVoxels Particles
The HyperVoxels Particles Displacement plugin lets you set the base color for a HyperVoxels particle to the color of the 
Vertex Color Map, if one exists. You can also set the particle weight using a Weight Vmap.

Inertia
Inertia creates lazy points. It will delay the point positions in an object, and cause them to catch up over a period of 
time.

If you want to use other Displacement Maps and not have them be ignored by MetaLink also apply 
Metalink_Morph.



The FX_Metalink _Morph plugin can be added before or after FX_Metalink.

These options are only available when HyperVoxels have been applied to an object.
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Lag Rate (s/m) is the amount of delay (in seconds) for points that are one meter away from the pivot point of the object - 
points closer or farther will be adjusted accordingly. If you had the pivot point for the cow object at the tip of her nose 
and moved her forward, her nose would move with the pivot point; however, the rest of her would be delayed. If you set 
Lag Rate to 1, then the portion of the cow that is one meter from her nose would be one second behind.

Normally, the object’s movement triggers the effect; however, you can point at a different object instead by using 
Inertia Pivot Object. Then, the object doesn’t even need to move to get the effect. Inertia Pivot Object replaces the 
item’s pivot point, and becomes the center from which the inertia acts. Points farther away from this center have a 
larger delay in their animation - they are delayed by a time equal to the distance multiplied by the Lag Rate. Activating 
Local Pivot uses the pivot point’s local coordinates rather than world coordinates.

You can also specify a Weight Map. Zero weighting will result in no delay for those points. Using 100% is the same as not 
using a Weight Map on those points.

Joint Morph Plus
Joint Morph Plus drives an Endomorph based on the angle of a bone. This displacement function replaces the common, 
but cumbersome, use of Morph Mixer in combination with an expression or plugin to control the morph channel based 
on a bone angle. This would allow you to, say, bend an arm using bones, but also control a Morph Map that might bulge 
muscles.
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The first three entries define the object you are using the bones from, the bone and its axis that control the morphing. 
Usually the object will be (self) i.e. the object you are attaching to this plugin, but sometimes it makes sense to have the 
Endomorph controlled by another object’ s bones (e.g. if you have a high resolution object and a low resolution proxy).

The next two entries define what kind of morph is used if the control bone is below (Angle < Min) or above (Angle > Max) 
the defined range. If these options are set to (base), the base model (i.e. no morphing) will be used, otherwise the 
lowest (Min Morph) value or the highest (Max Morph) value will be used.

The next (up to five) values define the range of the morphs. Every entry (make sure to activate the checkboxes at the 
left) defines a morph at a given angle. The values can be in any order, but make sure that you also define the angle for 
the base model (usually this angle will be at zero degrees). If you define multiple morphs for one angle, only the first 
entry will be considered.

The percentage entry scales the morph, usually this entry will be set to 100%.

Rotate the control bone now and you will see the effect of the morphing. If the angle of the control bone matches 
exactly a defined position, the corresponding morph will be used, otherwise the plugin will interpolate between two 
morphs.

Lazy Points
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Lazy Points alters time for the points of an object it affects. When the Lazy Points Plugin is active for an object, the 
further an object’s points are from its center, the longer it takes them to move, rotate, size and stretch.

LScript and LScript/RT
These two items will allow you to apply an LScript.

MD Baker
MD Baker is a Displacement Map plugin that incorporates motion data from Layout into Motion Designer. MD Baker can 
handle motions, such as those of bones affected by Displacement Map plugins. The resulting data becomes an MDD or 
Geocache file to be used with the main Motion Designer plugin.

MDD Filename - This is the name the file will be saved as.
File Format - Determines the motion file type. You can choose from:

MDD - LightWave’s native Motion Designer format
GeoCache Single - creates a single GeoCache .mc file and its accompanying .xml file
GeoCache Multi - creates a separate GeoCache file for each frame of the scene. This is mainly necessary when 
Single .mc files become too large to be comfortably managed.
MC/MCX - When saving in a GeoCache format an option becomes available - to save in the new MC or MCX 
format.

Bake Mode - Sets what the motion data will record. Some file types only recognize data from specific mesh 
types.

Cage Only - The cage is the mesh before any subdivision is applied. Choosing this option will apply only motion 
data of the cage.
Subdivision Only - Subdivision occurs after the cage. Choosing this option will record only the subdivided mesh 
data.
Cage and Subdivision - This option will record both the cage and subdivided mesh data.

First Frame - Sets the first frame to start recording on.
Last Frame - Sets the last frame for recording.
Frame Rate - Sets the number of steps for recording. A setting of 1 will record the next frame, while a setting of 2 
will record every other frame.
Save OBJs - Checked on will save an OBJ file with the same name as the object.
Save LWOs - Checked on will save an LWO file with the motion file.

To use MD Baker:

When using MD_Baker with other Displacement Map plugins, be sure to add it after other displacements.
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3.
4.
5.
6.

7.
8.

•
•

•
•

•

Add MD Baker to the Deformations Tab of the Object Properties Panel for the object whose motion you wish to 
incorporate.
Double-click the added plugin to open its Options Panel.
Define the desired MDD filename and set the parameters. Click OK.
Click OK for the next dialog that appears.
Make a preview animation.
Open the MD Baker Options Panel again. This time a different version of the panel will appear. Click OK to save 
the MDD file data.
Remove MD Baker or deactivate it.
Load the file into MD Reader.

MD Reader

MD Reader is the Displacement Map plugin that applies motion data (MDD, vertcache or Alembic file) to an object in 
Layout. New to LightWave 2015 is support for MCX format vertex caches.

Setting Options
File Name - Use this to load the motion data file.
Information Line - This display shows the number of points in the cache, the number of frames cached and the 
time in seconds at the scene's frame rate.
Frame Offset - The default load time is at frame 0, you can use this setting to offset the load time.
Replay Speed - If you want the motion data to replay at a different speed, adjust this setting. 100% would be the 
same, 50% would be replay at half speed.
End Behavior - This setting determines what happens with the motion data once it has finished.

You can also bake multiple objects and read multiple MDD or GeoCache files using the MD Multi-Baker and 
MDD Multi-Loader tools on Layout’s I/O Tab.



MD_Reader is automatically added to the Target when you click the Activate button on the MD Property, 
Objects Tab. It is removed if Deactivate is clicked. As such, you will normally not need to add or adjust this 
plugin manually.


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Stop - The motion data will stop.
Loop - The motion data start at the beginning again once it has finished.
Comp - Composites the motion data, replacing the vertex positions between beginning and end, but leaving it 
untouched outside that.
PingPong - The motion data will reverse once it has reached the end, then go forward once it has reached the 
beginning again.

Apply Cache to - Choose between World or Object Space.
Match-By - Matches the MDD by the specified setting.

Point Order - Using this option, points must be in the same order on the object as the cache file. The advantage 
for using this Match-By option is lighter processing is necessary.
Coordinates - Matches the cache data with the object in Layout by the coordinates of each point in the object. 
The number of points in the cache and the new object do not need to match with this option.

Vertex Cache Units - Allows the MDD to scale the data brought in.
Up Vector - Offers a choice between Y-Up and Z-Up. LightWave is Y-Up.
Alembic Mesh - Used when you have loaded an Alembic file, this item shows the Alembic file name associated 
with the cache data. 

MD_MetaPlug
MD_MetaPlug is a Displacement Map plugin for extending MD_Plug and applying a MDD file to the object in Layout 
without restricting the shape or the number of points. This lets you create the animation, and lets you completely 
separate the object for animation and the object for rendering. For example, you might use this to add buttons on a 
dress after the MD calculation.

Setting Options
Specify the target MDD file in the MDD Filename field. The details include the number of MDD frames, recorded time, 
and the number of points on the plugin button. Verify the information.Specify the object used for the calculation of the 
MDD file as Cage Object. This object should be made up of triangles and quads. The smooth reshaping is executed 
based on the lattice by polygons.

In the ActionStart field, specify the time (in seconds) at which motions based on the MDD should start.

Use the EndBehavior pop-up menu to specify what happens at the end of the motion based on the MDD. Stop maintains 
the last state, Repeat repeats the motion, and Composite plays back the MDD file successively.

Key-Move is used to specify whether or not to displace the shape using the standard keyframe. Since the MDD already 
contains displacement information, setting Key-Move to ON can duplicate the displacement of shapes. As such, you will 
usually set this to OFF. However, this will also disable any movement in Layout.The Smoothing option attempts to 
smooth the reshaping. If unchecked, the reshaping will pass through the vertex of the Cage Object.

Activate Disable to turn the plugin off without losing your settings.

MD_MetaPlug_Morph

When using MD with other displacement plugins (which should be loaded after MD) be sure Key-Move is ON. 
Motion Designer ignores any plugins loaded above MD_Reader.



You may run into problems if the Cage Object is too rough. Subdividing the Cage Object may help.
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MD_MetaPlug_Morph is a displacement plugin that enhances the functions of MD_MetaPlug. By itself, MD_MetaPlug 
cannot use normal morphing information because it ignores bones, Morph Mapping, and Displacement Maps. However, 
if you use MD_Plug with MD_MetaPlug_Morph, you can use normal morphing data with Motion Designer.

The MD_MetaPlug_Morph plugin can be added before or after MD_Plug. Make sure MD_Plug’s Key-Move is set to OFF.

MD_MetaPlug_Morph has one pop-up menu called Morph Mode. Set this to One time morph to execute morphing only 
one time. This mode is appropriate when the morphing is from Morph Mapping. Use Every time morph to execute 
morphing for each displacement process. This mode is appropriate when the morphing varies, like the Displacement 
Map of waves. The Non morph setting simply disables this plugin.

Morph Mixer
Use the Morph Mixer Displacement plugin to animate using Endomorphs. You don’t really need to use the plugin now as 
a button to access MorphMixer has been added to the top of the Deform tab.

NormalDisplacement
NormalDisplacement can displace each vertex either along its normal or using Morph Maps. NormalDisplacement 
differs from regular displacement in that with regular displacement, the direction is fixed by you (or texture). With 
NormalDisplacement, the displacement is set by the geometry, an effect similar to using Smooth Shift in Modeler.

Using MD_Metaplug_Morph is CPU intensive, so be sure to select the appropriate Morph Mode.

See Morph Mixer Section, later in this chapter and starting on page , for more information.xxx

A vertex’s normal direction is the average of the polygon normals it is connected to.
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An image of normal displacement would be very helpful in describing the tool’s use.The Displacement Amplitude sets 
the amount of displacement. Displacement Direction lets you choose whether the direction of the displacement is 
along the vertex Normals or using Morph Maps. The Texture button brings up the Texture Editor, where you can add a 
texture (like in a regular displacement texture).

If you are displacing along Morph Maps, set the MorphMap pop-up menu to the target Morph Map.The Detail 
Attenuation option reduces the displacement in highly detailed areas, preventing the geometry from intersecting itself. 
This is accomplished by weighting each displacement by the neighboring polygons area, so vertices in small polygon 
areas are displaced less than in large polygon areas. You can adjust this weighting with the Attenuation Bias parameter. 
A bias of 0 percent will attenuate most polygons and 100 percent will affect only very small polygons.

The Cache Normals option causes the normals to be calculated only once. These results are used for later evaluations, 
making the evaluations much faster. This option is recommended for solid objects, but not for objects that are being 
deformed (e.g., with bones).

Remember that textures are three-dimensional and generally have different values for any point in 3D space (assuming 
your texture is something dynamic, like Turbulence). The value of the texture at each vertex acts as a multiplier against 
the Displacement Amplitude value. So if a texture was at 50 percent for a particular vertex and the Displacement 
Amplitude was 500mm, that vertex would be displaced 250mm (500mm x 50 percent). Each vertex would have its own 
evaluation.

Because each vertex gets its own texture value, when using Morph Maps, the amount of morphing is usually different for 
each vertex. If the texture is animated, you will see the amount of morphing change over time.

A cool trick would be to use a gradient texture with Distance to Camera or Distance to Object set as the Input 
Parameter. The gradient could just be a ramp from 100 percent to 0 percent. Then, you can cause a morph to occur 
based on the distance to the object or camera.

Python
Opens a file requester for a Python script to create displacement for your object.

If you are network rendering, “Cache Normals” will not work since the scene is unloaded and reloaded for each 
new frame. Instead of using “Cache Normals” for a solid object that does not change over time, freeze the 
deformed shape with the “Save Transformed” command, save it under a new name, and use the new object in 
place of the old. 
Play your scene while tweaking the settings to get real-time feedback.


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Python Lazy Points
A Python version of the Lazy Point script, included for learning and reference.

Relativity Morph
A Relativity Morph Expression module for the Relativity scripting system.

Serpent

Serpent is a displacement plugin that deforms an object so that it hugs its path. The object is expected to travel along 
some axis of alignment.

Alignment Axis sets the axis along which the object will be aligned. The Start Frame and End Frame parameters turn the 
deformation on and off at those frames, respectively.

Object deformation is usually not pretty when the object slides past the Start Frame and End Frame. To get around this 
glitch, give the object a nice straight lead-in, possibly with a linear keyframe. The length of this segment should be 
about the length the object extends past its center (0,0,0 in Modeler). Also, let the motion path and end frame extend 
beyond the end of your intended animation, or end with a nice straight segment along the Alignment Axis. Don’t make 
the bends in the curve too sharp relative to the thickness and subdivision level of the object.

Serpent is computationally intensive. Using the following steps will maximise your efforts:

Set up the motion path (i.e. keyframes) before applying the plugin to the object.
Apply the plugin to a low-polygon-count stand-in object and refine your Scene.
Use Items > Replace > Replace With Object File to replace the stand-in object with the finished version.
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1.

Sock Monkey
Sock Monkey is an animation plugin that uses scene items - typically null objects - to deform an object’s mesh. You can 
deform an object like it is a puppet.

Sock Monkey parallels bones in many respects. You may want to use it if it matches your animation style. One big 
difference, however, from using bones is that the control objects are external to the object.

Basic SockMonkey Setup:

Create an object in Modeler using selection sets or Weight Maps. These will define the regions of the mesh to be 
deformed (e.g., chest, upper arm, lower arm, hand, etc.). Using Weight Maps lets you vary the influence based on 
the vertex weighting.

Serpent does not work well with Align To Path controllers (Motion Options Panel) activated for the object.
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Load the object into Layout and add the SockMonkey displacement plug

Open the SockMonkey Options Panel. On the Relationship Setup Tab, set Vertex Group Types to the type you 

used in step 1
Click the Auto Setup Object button. Control items (objects) will be added to the scene and a relationship with 

each vertex group will be set up  
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(If you are using Weight Maps, select each group and activate the Use Weight Values option (Control Item Tab).)

To manually add a control item, select the selection set or Weight Map from the Vertex Group pop-up menu. Then, click 
the Auto-Add Control Item button. If the item already exists in the scene, select it from the Control Item pop-up menu 
and click the Add Relationship button.

Instead of using Auto-Add Control Item, which c=reates the control items, Auto Assoc. w/Existing will add relationships 
to existing scene items. Just make sure the scene items have the same name as the groups before running. In other 
words, if you have a Weight Map called Shoulder, you must have, say, a null object called Shoulder. Note that this 
operation will not position the scene items like Auto-Add Control Item does.

Control Item Tab

Control items don’t have to be null objects, although this is usually the case. They can be lights or even 
cameras.


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The settings on the Control Item Tab affect the selected group in the list. Use Rotation will cause the control item’s 
rotation to influence the group. When using Weight Maps, you’ll probably want to activate Use Weight Values so the 
weighting of vertices will affect influence.

Like bones, control items have rest positions that provide the starting point of their influence. To change a control 
item’s rest position, activate the Edit Rest Position option, move the item and then deactivate the option.

Display Options
Use the settings on the Display Options Tab to change how (or if) the group bounding box is displayed in viewports.

Use the Display Bounding Box option to toggle the bounding box on and off. Choose a Line Pattern for the bounding 
box.

 

Left to Right: Solid, Dotted

 

Left to Right: Dash, Dash-Dot
Choose a preset color from the Line Color drop down menu or pick a Custom Color for the bounding box.

Batch Operations
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Use Enable All Relationships and Disable All Relationships to activate or deactivate all of the group/control item 
relationships.

The Edit All Rest Positions option allows you to edit the rest position for all control items.

The Remove Relationship button removes the group/control item relationship for the selected group. You can also 
remove all relationships in one step using the Remove All Relationships.

MD Multi Baker
MD Multi Baker is similar to MD_Baker and can export multiple objects MDDs at once, see the File_Menu > Export section
on page PDF_LINK for more details.

Spline Displacement
The Spline Displacement tool (Modify > Spline Displacement) is a simple way to animate hoses, tentacles, etc. using a 
spline with control handles. It is fully documented here.
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Modifier - Morphing

Double clicking on the Morphing entry in the Modifier Stack will open a new section at the bottom of the panel with a 
Morph Target dropdown and options.

Morph Targets
Metamorphosing, or Morphing, causes a 3D metamorphosis from one object into the shape of another object. Morphing 
requires a minimum of two objects: a beginning object and a target object. 

To be able to morph successfully between objects, the number of points and their order must be identical.

When you enter a Morph Amount, the object will be transformed by that percentage into the Morph Target object. 
However, you will almost always animate the amount of morphing over time using a standard LightWave envelope to 
control the morphing of an object’s shape, surface colors, or both, during an animation.

Using Endomorph objects simplifies the process by keeping all target data within a single object file. This 
guarantees the same number of points and helps to maintain point order.


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The Morph Target is the destination object (the object that the current object will morph into). The target object itself 
can have its own target and you may create a chain of up to forty targets. (Any number of objects may be morphing 
within a scene.)

Morph Surfaces
You can cause the surface attributes (color, texture, etc.) of the first object in a morph chain to convert to the surface 
attributes of the second object. Even if additional objects are morphing, only the first and second objects may use 
Morph Surfaces.

Multiple Target/Single Envelope
To morph a single object through a chain of multiple targets using only one envelope, you can use the Multi Target/
Single Env option.The morph chain should be set so that object A has target B, object B has target C, object C has target 
D, and so on. Once that is set up a morph value from 0 to 100 morphs the A object into the B object. Morph values from 
101 to 200 will morph object A into object C. Values of 201 to 300 will morph to D, and so on.

If you use an envelope, the Morph Amount will have no effect on the result.

Multi Target/Single Env with surface morphing will reflect only a surface change during the first morph.
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Morph Mixer
Using LightWave’s Vertex Map feature, all of your morph targets can be wrapped up neatly into a single object, with 
point-offset information. This type of object is called an Endomorph and the targets are referred to as Morph Maps.

Another advantage of Endomorphs is that a morphed pose can be a mixture of multiple targets. With normal object 
morphing, discussed previously, you are limited to the morphed states between the beginning and target objects only.

What’s more, animating an Endomorph is simple because you just keyframe your poses using the Morph Mixer 
Displacement plugin.

Morph Mixer: Morph List
The Morph List will display all of the Endomorphs that have been created for the object. If no groups were created in 
Modeler they will all appear in one group. To have pre-defined groups use the group naming convention when creating 
your morphs.

Managing Groups
You can move a morph from one group to another by simply dragging it to the desired group.

Placing a (.) after the first part of the name creates a new group. It’s suggested that you name your morph 
using the group.pose format; like Eyes.Open or Mouth.Smile.
For more information about Endomorphs see the Endomorphs section at the end of the Map tab chapter in the 
Modeler part of the manual.


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Create a new group using the New Group button. This allows you to re-organize your morphs without having to return 
to modeler. Use the Rename Group button to give any of the morph groups a new name. You also have the option to 
remove groups with the Delete Group button.

Clicking the Graph Editor button in the Morph Mixer Panel will launch the Graph Editor with all the morphs channels in 
the channel list that appear in the Morph Slider area. The Reset Group button will set all the morph sliders in the Morph 
Slider Area back to 0%.

Morph Mixer Options

Deleting a group that contains morphs will place those morphs in the previos group in the list. Also, deleting a 
group doesn’t delete it from the object.


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Morph Mixer gives you the ability to save and load grouping information using the Save/Load Grouping Data 
commands. Use the Save/Load Endomorph Mix to reuse your morph animation data.

Morph Mixer has three View Modes to choose from. These modes will determine what morph sliders will appear in the 
Morph Slider Area.

Normal - Will display all the Morphs from the Current group.
Display all morphs as one group - Every morph in the object will be displayed and treated as one group.
Display Active Morphs Only - Only morphs that have been animated will be displayed.

Use the Set Slider Range setting to set the Low/High (min/max) values for all sliders.

Morph Slider Area
The Morph Slider Area is where you will do all your animating of the individual morphs.
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Individual Slider Banks

Morph Name - Name of morph for the Slider Bank.
Morph Slider - Slider used to interactively change the morph value.
Morph Value - Value of the current morph. You can manually enter in a value without using the slider.
Previous Keyframe - This button will skip to the previous keyframe in the animation.
KeyFrame - Displays Keyframe off and on.

Left click on “K” button creates key for the morph.
Left click on “K” button removes key if current frame has a keyframe for the morph.
Shift+ Left Click on “K” button keys all morphs in active group (respects view modes) at current value.
Shift+ Left Click on “K” button removes keys on all morphs in active group (respects view modes) if the current 
frame has a keyframe.
Ctrl+Left click on “K” button resets individual slider to zero and creates key.

Keyframes are always automatically created when the slider is adjusted.
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Next Keyframe - This button will skip to the next keyframe in the animation.
Envelope - This will launch the Graph Editor with the morph channel selected.
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Metamorphic
Click here to expand Table of Contents...

Introduction
Features:
Panel
Brush Mode

Brush Mode Tools

Brush Parameters
Undo and Redo
Animation

Introduction
Metamorphic is a multipurpose mesh sculpting and vertex map manipulation plug-in for LightWave 3D that works in 
LightWave’s Layout taking full advantage of the new capabilities of the modifier stack.



The Windows version of Metamorphic has the keyboard modifiers/shortcuts and graphics tablet support listed 
in the documentation. While Metamorphic is open, keyboard events will be captured and checked against the 
listed shortcuts. This means that typing in other applications might be affected.

Keyboard shortcuts and graphics tablet support have not been implemented in macOS

Object Properties blinking when you add Metamorphic is expected. Normally, adding a plugin drops it at the 
end of the list of modifiers, but Metamorphic has to be placed just before Subdivision so the Object Properties 
panel needs to be refreshed.


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Features:
Freeform animated sculpting
Built-in undo/redo system
Fully-multithreaded sculpting using all available CPU cores
Pen pressure support for brush size, strength and hardness (Windows only)
nodal brush texture support
Three modes of animation
Non-linear interpolation of sculpt animation keyframes
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Supports converting sculpt animation keyframes to Endomorphs
Predictive corrective morph sculpting that works after deformers with built-in driver/driven controller
Full Motion Blur support

Panel
The Metamorphic panel is organized into several different sections. At the top we have buttons to open this page in the 
Wiki and a General Options for Metamorphic:

View Vertex Selection - Shows the selection of vertices on the object
View Weight Value - Shows the numeric weight value of vertices when in the Weight Brush Mode
Hide Sel. While Sculpting - Hides the vertex selection while the LMB is held down for all Metamorphic modes 
and tools

Use Selection as Mask - When checked, this will restrict all Metamorphic operations to the selected area
Select/Weight Operations - This dropdown menu offers five global options for selection or weight maps:

Clear - Clears selection or weight map immediately (shortcut /)
Grow - The default option, increases selection or weight map area (shortcut })
Shrink - Reduces the quantity of selected vertices (shortcut {)
Connected - Selects any polygons connected with the initial selection. Selections are uniformly green 
and there is no Undo for this action. If you want to increase the strength of selection in areas, clicking Add 
to Selection is necessary (shortcut ])
Invert - Single click operation inverts the selected vertices (shortcut "0

Brush Mode
The middle section of the Metamorphic window is devoted to the Brush mode tools and parameters. There are seven 
choices here, six of which surround Layout's OpenGL window with a green line showing that Metamophic is active. The 
first of the seven, None (default keyboard shortcut - Space), removes the green outline. Here are the other six in order:

Brush Mode Tools
Metamorphic Select — Tools for vertex selection
Metamorphic Transform — Tools for displacing vertex selection
Metamorphic Sculpt — Tools for sculpting the mesh
Metamorphic Weight — Tools for creating weight maps in Layout
Metamorphic Normal — Tools for influencing normal maps
Metamorphic Color — Tools for creating vertex color maps in Layout

Brush Parameters
These are global options for controlling the brush for performing the operations contained within the six categories.

Symmetry on X - performs operations symmetrically across the X axis
Symmetry on Y - performs operations symmetrically across the Y axis
Global Brush - This selects all vertices for operations but respects Use Selection as Mask if enabled and there is a 
selection already extant. The direction of the effect is on each vertex normal. This setting is mainly useful for 
textures that you want to have a global effect or selection.
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Stroke Steps - Sets the distance between segments for strokes. Think of it as "How many steps will I need to 
take to get to the next segment". A lower number will result in a smoother sculpt. A higher number can result in 
separation into islands of sculpting
Stroke Coarseness - Changes the resolution of path interpolation. The value is based on a log(n) expression, so 
not much difference will be spotted in the middle of the range of values. It's at the extremes that changes will be 
fully evident.
The following three are toggles related to using a stylus and tablet. They only work on Windows for now:

Pen Pressure Radius - The default of 50 % can be changed by typing a new number, using the slider at 
the end of the field or by right-clicking in a Layout viewport and moving the mouse left or right
Pen Pressure Hardness - The default of 50 % can be changed by typing a new number, using the slider at 
the end of the field or by right-clicking in a Layout viewport and moving the mouse up or down. The 
hardness determines the width of the boundary region between 0 % and the full brush strength
Pen Pressure Strength -  Determines how fast clicking the LMB will result in a 100 % change to the 
vertices painted over.  The number is not clamped to 100 % and can be modified with CTRL-RMB left and 
right

Clamp Strength - This toggle will clamp the selection strength to 100 %
Negative Strength - Inverses the effect of painting with the LMB (Keyboard Modifier - Ctrl )

Smart Pick - Smart Pick supports sculpting of obscured polygons in wireframe modes. When on, on 
mouse button down picks the polygon with a vertex nearest the mouse for placing the brush, then, when 
dragging, tries to not move the brush position beyond the brush radius (hopefully keeping it on the intended 
surface)
Use Brush Nodes - Uses a nodal network to control the shape of the brush

Edit Brush Nodes - Only available when Use Brush Nodes is checked. Opens the Node Editor for editing 
the brush shape (Metamorphic Brush Nodes)
World Coords - Only available when Use Brush Nodes is checked. Uses world coordinates for the brush
Resolution - Only available when Use Brush Nodes is checked. Three choices for the nodal brush: Low, 
Medium and High. Obviously, the higher the detail, the slower the brush

Undo and Redo
There are unlimited undo and redo steps for Metamorphic in a separate undo system to the main LightWave one.

Undo - Undos previous Metamorphic operation (Keyboard Shortcut - Ctrl Z )
Redo - Redo previous Metamorphic operation (Keyboard Shortcut - Z)
Purge Undos - Clears memory of Metamorphic Undo steps
Purge Redos - Clears memory of Metamorphic Redo steps

Animation
Metamorphic has its own parallel keyframing system for operations so that they can be animated over time. Each sculpt 
key is a morph map and contains the relative offsets of each vertex.

Clear All Keys - Completely destroys all Sculpt Keys for an object. There is a warning beforehand, but no Undo
Create Key - While Sculpt keys are created automatically, new keys can also be created at the playhead position
Rename Key - Keys are automatically given names by Metamorphic, but these names can be overwritten with 
something more personalized
Create Key At... - Creates a sculptkey at the frame of your choice
Delete Key - Deletes an individual Metamorphic key. There is a warning before deletion but no Undo
Current Key - A dropdown list of the keys created in Metamorphic. You can click on an entry in this list to jump 
to the keyframe in the scene
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Animation Mode - A choice of three options:
Keyframes - The default mode of Single envelope/Multiple sculpts
Mixer - Non-linear morph mixer mode
Solo - Single sculpt edit mode

Sculpts To Morphs - Converts sculpts into morph maps. Keys can be cleared now, but the object should be 
saved otherwise the morphs will be lost
Edit Graph - Opens the Graph Editor with the Sculpt channel active
Driver Options - Opens a new window to choose a scene item to "drive" morph events, to control them

Driver - Scene item to use to drive Metamorphic
Clear Driver - Removes the driver
Get Layout Selected - Uses the currently-selected Layout item
+/- - Swaps the Minimum and Maximum Limits
Driver Channel - Choose the animation channel to use for driving Metamorphic operations
Clamp - Clamps within the set Minimum and Maximum Limits
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Metamorphic Select

Paint - Use the LMB to paint a selection of vertices. The RMB changes the size and hardness of your brush
Blur - Changes the values of the vertex selection so that there is a smoother incline between vertices that are 
just selected (green) to those that are hard selected (magenta)
Soft Selection - On by default, Soft Selection allows variation in just how much things are selected. With Soft 
Selection off, selection is purely a binary choice, there is no falloff
Add to Selection - (Keyboard modifier Shift) Off by default, with Add to Selection off, clicking over areas that are 
already selected will unselect them. With Add to Selection on, LMB painting will only ever increase the selection 
area



LightWave 2020  –  LightWave 2020

Reference –  852

•
•
•

Metamorphic Transform

Move - (Keyboard shortcut: T) Moves selected vertices in screen space
Rotate - (Keyboard shortcut: Y) Rotates selected vertices in screen space
Scale - (Keyboard shortcut: H) Scales selected vertices in screen space
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Metamorphic Sculpt
Click here to expand Table of Contents...

Introduction
Tools

Push/Pull P
Clay C
Flatten F
More/Less M
Smooth S or Shift
Smudge D
Restore R

Options

Introduction
The Sculpt tab is probably where you will spend most of your time in Metamorphic. This tab enables the user to 
dynamically alter the appearance of geometry with a set of tools that should be familiar to users of other sculpting 
software. It's best to use any of these sculpting tools with high-polygon meshes as the quality of the modification will 
strictly depend on the polygonal resolution of your mesh. The keyboard shortcut/modifier will be listed at the end of 
the Tool title.

Tools
Push/Pull P
The default tool. Push/Pull will raise peaks or create troughs (if you use Negative Strength on the Brush Parameters
tab) on your geometry. Other items on the Brush Parameters tab will directly influence your sculpts, such as Symmetry 
on X, Symmetry on Y, Stroke Steps, Stroke Coarseness, and perhaps most dramatically Use Brush Nodes.

Clay C
Clay will simulate adding extra material to your form, to the extent set by the Strength setting on the Brush Parameters 
tab. Additional material can be added on top of any already painted, but Clay will only put down so much material each 
time you paint.

Flatten F
Flattens the mesh based on the brush normal.

More/Less M
Exagerrates the mesh based on the brush normal. Using this tool in negative mode attenuates the sculpt.

Smooth S or Shift


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Averages vertex displacement with neighboring vertices to smooth out geometry.

Smudge D
Smudge is like a 3D drag on the geometry.

Restore R
Restore is a brush-based undo system. You are essentially painting back previous states of the geometry.

Options
Protect Open Edges - This pins open edges to protect them from sculpting operations
Zero Sculpt - Completely restores to zero any sculpts made on a keyframe returning the mesh to its original 
form
Record Stroke - Used for realtime animating. Use Record Stroke when you hit Play in Layout and want to create 
an animation of sculpting as Layout is playing
UV Map - Used to construct tangent coordinates
Relax Iterations - The number of smoothing iterations to use to calculate for Smoothing and Smudging

All the above tools respect Use Selection As Mask, if the toggle is on, and create keys for animation purposes



LightWave 2020  –  LightWave 2020

Reference –  855

•

•
•

•

Metamorphic Weight

The Current Tool dropdown contains four tools:

Add - Holding the LMB down in this mode will continue adding vertices to a weight map, or increase the strength 
of existing points within the weight map
Subtract - Has the opposite effect to Add as you might imagine
Blur - (Keyboard Modifier Shift) Blur softens a selection, bringing a gradient to soften a slope between points 
with not much weight and points with a lot
Clear - Is a soft deletion brush that removes vertices from a weight map.

None of the tools will have any effect if the Weight Map dropdown is not accessed first and either an existing weight 
map chosen, or a new one created.
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Metamorphic Normal

Metamorphic Normal mode gives you the tools to influence the normal map for an object. First you need a Normal map 
to apply edits to and you can choose a pre-existing Normal Map or create a new one in the Normal Map drop-down. 
Once done, make sure you choose the map in the Surface Editor's Vertex Map drop-down.

There are several tools:

Comb - The default tool, allows you to comb normals in screenspace to change their angle
Blur - (Keyboard Modifier  Shift ) Reduces sharp differences betwen adjacent normals
Recalc - Recalc takes account of any deformation to your Metamorphic object, whereas Restore will simply put 
the normals back to their undeformed state
Restore - Brush-based undo, paint to take normals back to their inital state
Bake Normals - Only works with polygonal meshes (rather than subpatch) and removes the need for a Vertex 
Normal Map
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Metamorphic Color

The tools are as follows:

Paint - The standard paint tool. LMB paints and RMB changes the size (side-side movement) and hardness (up-
and-down movement) of the brush
Erase - A paint tool that goes back to the current Background Color
Blur - (Keyboard Modifier Shift) Blurs between colors chosen
Clear - This tool paints back to the original background color created with the vertex map
Color Map - Dropdown permitting choosing an existing Vertex Color map, or creating one

Using the Color Brush Mode in Metamorphic requires not only a Vertex Map > Vertex Color node, but also for it 
to be connected appropriately in the node network for the surface of the object. Without this, no changes to 
the Color mode of Metamorphic will be visible.


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Modifier - Bones

Double-clicking on the Bones entry will open a fresh window:
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Bone Properties Panel
The Bone property panel gives you access to all the settings available for bones in LightWave Layout.

Bone properties can be accessed in two ways:

Select the Bones button at the bottom left corner of Layout and then click the Properties button located in the same 
corner.
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Alternatively use the keyboard shortcuts Shift B to switch to Bone mode and then P for Properties, or visit Object 
Properties > Modify and double-click the Bones modifier in the stack

Click here to expand Table of Contents...

Use Bones From Object
Clear All bones
Falloff type
Use Morphed Positions
Faster Bones
Current bone
Bone Active
Rest Position
Rest Rotation
Rest Length
Bone Weight Map
Use Weight Map Only
Weight Normalization
Strength
Multiply Strength by Rest Length
Limited Range
Bone Displacement/Parent Displacement
Joint Compensation
Joint Comp for Parent
Muscle Flexing / Parental Muscle Flexing
Muscle Bulge / Parental Muscle Bulge
Twist
Bone Icon Size

Use Bones From Object
This pop up menu allows you to choose a different object whose bones you would like to use to deform your current 
object.

Clear All bones
As the name suggests, this button will clear all bones from the current object.

Falloff type
Falloff Type uses a mathematical formula to set the falloff strength of a bone’s influence in the current object. An 
exponent is used (^2, ^4, ^8, ^16) to figure out how quickly the falloff will happen. The larger the number the quicker the 
influence of the bones will falloff.
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Inverse Distance, Inverse Distance ^2, Inverse Distance ^128
Use Morphed Positions
With this enabled, bone deformations will be applied after morphs. This option can adversely affect performance; 
normally it should be turned off.

Faster Bones
Each vertex will only be affected by the four closest bones in the object. This can increase performance in objects with 
more than four bones.

Current bone
Shows the currently selected bone. Multiple bone settings can be edited simultaneously.

Bone Active
When checked bone is on (active).

Rest Position
This sets the default base position of the bone, from which its influence is calculated. You can adjust this influence in 
several ways including distance falloffs, weight maps and so on, listed below. A bone, moved using the Move tool, can 
be reset to this default base position by selecting Modify > General > Reset.

Rest Rotation
This determines the orientation of a bone at the time it was rested. A bone, rotated with the Rotate tool, can be reset to 
this default base rotation, by selecting Modify > General > Reset.

Rest Length
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This determines the length of a bone at the time it was rested.

Bone Weight Map
Use this pop up menu to select a Weight Map to apply to the current bone. The influence a bone has on an object's 
points is now limited to within this weight map.

Use Weight Map Only
When this is toggled off, the bone's influence is limited to the weight map, but the Falloff, Ranges, Strength, Multiply 
Strength by Rest Length, etc.  all affect the bone's influence within that map area. You can, in fact, use the same weight 
map on multiple bones (for example assign all the bones in one leg the same weight map) and their influences will be 
mixed in the non-weight map way, but limited to the area of the weight map. This makes setup simpler for some 
characters.

When Use Weight Map Only is toggled on, the bone's influence is directly controlled by the weight map, and doesn't use 
other controls such as Strength, detailed below.

Weight Normalization
Use this option to obtain predictable results when using Weight Map Only.

This feature ensures that the total values of several Weight Maps applied to a vertex never exceed 100%. To calculate 
the amount of influence a bone will have on a particular point we have to know how many Weight Maps are assigned to 
bones and what their values are. For example, to calculate the amount of influence a bone will have on a vertex we have 
to know both the total number of Weight Maps on that point, and also their values. Assuming each Weight Map is 
assigned to a bone, we will conclude that the amount of influence a bone has on that point is derived as follows:

Point A has three weight maps assigned to it named Upp_Arm, Low_Arm and Elbow.

What is the amount of influence the Elbow bone will have on Point A ?

Point A = Elbow/(Upp_Arm + Elbow + Low_Arm)    

Strength
Strength acts as a multiplier on the influence of the bone. 100% means its influence is calculated as normal from its 
falloff, length etc. 0% will mean it has no influence, like deactivating it. 50% will halve its influence and 200% will double 
its influence. 

Multiply Strength by Rest Length
The Multiply Strength by Rest Length option (Bones Panel) causes a bone to multiply its Strength by its Rest Length to 
determine the influence of the bone. Bones with larger rest lengths will exert greater influence over other bones with 
equal Strength values, but smaller rest lengths.

Limited Range
When Limited Range (Bones Panel) is active, the Min value determines the sharp cutoff point of a bone’s influence. Any 
points within this range are 100 percent affected by movement or sizing of the bone. Any points outside of this range are 
affected to a smaller extent or not at all depending on whether they fall within the Max. In an orthogonal view, the Max 
setting is visible in the viewport.

A short bone will exert a spherical influence, while longer bones exert a more oblong influence.

Bone Displacement/Parent Displacement
These Texture panels allow you to distort your mesh in the bone's (or its parent's) X, Y and Z axes. The amount of the 
displacement is affected by the influence of the bone on the mesh, so where your bone affects the mesh 100% the 
displacement will be 100%, and where its influence is 0%, the displacement will be 0%. You can use images or 
procedurals, but gradients have some special inputs beside the usual ones (distance to pivot etc). These are detailed 
here.
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Joint Compensation
Sometimes bones used to create joints can cause pinching or unwanted bunching, much like a folded garden hose. 
Joint Compensation (Bones Panel) will remedy this effect by making the affected points tend to maintain the original 
volume inside the joint. The result is a more realistic-looking joint. You can modify the compensation amount to 
increase or decrease the effect.

Joint Comp for Parent
This option shears the points affected by the parent bone during the child bone’s rotation. This compensation also 
alleviates the pinching effect often caused by bones. At the same time the point shear occurs, the bone will also try to 
maintain the volume inside the joint.

Muscle Flexing / Parental Muscle Flexing
With Muscle Flexing, the points affected by the bone will flare out as the bone is rotated. Parental Muscle Flexing is more 
commonly used than Muscle Flexing. For example, when your forearm rotates your biceps flex. The forearm is the child 
and the bicep is the parent. It would not look natural for the forearm to bulge as it is rotated, but it looks perfectly 
natural when the biceps flex.

Muscle Bulge / Parental Muscle Bulge
These bulge the mesh outwards around the bone/parent bone depending on the angle of the bone (in the case of Z-
bones, this is only around the Pitch axis, but for Joints, this is all axes). It can use Textures to control the shape of this 
displacement like Bone Displacement/Parental Displacement, except this displacement occurs directly away from the 
bone, not limited to one particular axis. This has the same gradient options as the Bone Displacement/Parental 
Displacement, but again, these gradients affect the points in directions away from the bone, not just in one axis. For this 
reason, it will probably be the more used option than just the Bone Displacement/Parental Displacement textures. The 
effect simulates muscles bulging under the skin. The gradient inputs are discussed here.

Twist
The rotation axis most aligned with the bone at rest is used. For zero-length bones the bank axis is used. The amount of 
twist is the change in rotation of that axis between rest and current (limitation: local rotation values are used, so a twist 
of a bone is not inherited by child bones). There is a Twist toggle in the bone panel (default on), and an input which 
controls how curly it is (0% is no curl, 100% is curl by the amount of twist over the length of the bone).

Bone Icon Size
Changes the size of the bone icon in the OpenGL display. It does not affect how the bone influences the mesh or other 
bones.
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Muscle Bulge Gradient

The Gradient settings for muscles are listed here.

Weight Map
A weight map painted on the mesh can control how much points are affected by the bone's displacement.

Bend
The amount of displacement is controlled by the rotation of the bone. For example, this can be used with the Blending 
Mode Multiply to fade another bone displacement layer as the bone goes from 0 to 90 degrees.

Bulge Falloff
The gradient is controlled by the bone's falloff, so where the bulge is completely gone (at either end of the bone) the 
gradient input is 1. 
It's basically the inverse of Bulge, below.

Bulge
The gradient is dependent on the distance to the bone's center along its length. At either end the gradient's input is 0, at 
the bone's center it's 1.

Distance from Bone
The distance of the point affected from the bone drives the gradient.

X Distance from Bone/Y Distance from Bone
As above, but only using the X and Y distances to the point.
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Norm.Distance along Bone
The gradient's 0 point is taken as being at the bone's start, and the gradient's 1 point is taken as being at the bone's tip.

Angle from Inside
The angle from the Y-Z plane of the bone drives the gradient. Thus a gradient going from 1 at -180 to 0 at +180 will start 
out making the mesh fat at the back, then getting slimmer as you move around the bone, till you get no displacement at 
the other side of the back, leaving a crease where they meet. A gradient with 0 at -180/180/0 and 1 at -90 and +90 will 
bulge out the sides of the mesh around the bone. (Note that because a gradient here can only displace in X, Y or Z, you'll 
need to add two gradients to see 2 dimensional displacement)
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Modifier - Subdivision

SubPatch Display and Render Levels
SubPatch objects may be used in Layout as any other object. In Layout, the Object Properties Panel includes two 
settings that are important when you use SubPatch objects. The Display SubPatch Level and Render SubPatch Level 
settings determine the level of subdivision smoothing needed for display and rendering purposes, respectively. These 
values, generally, have an effect similar to Modeler’s Patch Divisions (General Options Panel) setting, discussed next.

The SubPatch levels may be set to zero. This is similar to a level of one, except that the patches are not continually 
remeshed, even if Subdivision Order is not set to First. In other words, a level of zero makes patches act like normal 
polygons, and this allows faster interaction.

Adaptive Pixel Subdivision (APS) is a system of subdividing an object. With APS an object can be subdivided per 
polygon, by a texture, or even by pixels. It works by computing the subpatch level for each polygon, and storing those 
levels in a VMap.

Additional Settings for Render Subpatch Level
Per Object - The classic method of having the same subdivision level for the entire mesh.
Per Polygon - Sets the Subdivision level per Cage Mesh polygon independently (commonly referred to as 
variable subdivision)
Pixels Per Polygon - Ties the amount of pixels of the output frame to the subdivision level of the cage polygons. 
For example, a setting of 4 means that a given polygon will have an area no larger than 4 pixels.
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Metaball Display and Render Levels
These are the resolutions for OpenGL and rendertime for Metaball objects.

When you make an item inactive in the Scene Editor, the mesh will still remain. in the scene. This is necessary 
for a number of reasons, plugins and other parts of LightWave may still need to reference the item. APS 
effectively gives the mesh a setting of 0 for a subdivision level. This is for both Catmull-Clark and subpatch 
subdivision.


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Modifier - Nodal Displacement

Double-clicking will open a Node Editor:

The Nodal Displacement destination node has a Mode setting to control if the value is used to displace (add) or set the 
vertex position. The Destination node icon will have a + or an = depending on which is chosen.
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It also has a setting to control if the Deformed Coordinates in texture nodes are in object coordinates or in world 
coordinates. Double click to access these options.

The Input node also has a Current Position output providing the current deformed vertex position in object coordinates 
(the existing Object Position is the undeformed position, and World Position is the deformed position in world 
coordinates). There is also a Point Index output giving the point index of the vertex.

The nodes for Nodal Deformers are described here.
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Modifier - Surface Displacement

Surface Displacement is a way to modify geometry using a map or procedural texture. It was available in previous 
versions of LightWave, but a lot harder to organize. Now, it's as simple as:

Make sure you have Subdivision first and then follow it with Surface Displacement. Here it's set to 500 mm and the 
Clamp restricts the height
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Modifier - Displacement Map

Double-clicking will open a Texture Editor window:

As in previous versions of LightWave you can use an image, a procedural or a gradient to drive displacement.
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Mesh - Edges

Edge/Outline/Line/Point Rendering
Edge Types

Edge Functionality
Example - Shadowing Options with Edges

Edge/Outline/Line/Point Rendering
All edge types work on instances. Nodal shaders can be used to adjust the taper, color and opacity of the edges. Lines 
and outlines can be tapered. Using a negative value for the thickness of any edge, line or outline causes them to be 
rendered in perspective. The negative thickness is used as a radius in meters. This shows in both rendering and 
interactive VPR.

When rendering edges that are not even a pixel wide, make sure to increase camera samples since the camera 
could "miss" edges if only one sample is used.


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Edges are a particular means of wireframe rendering. Unlike surface-based inking with high-contrast incidence-angle 
gradients (think of the computer-generated Galactus in the 1990’s SILVER SURFER cartoon), Edges can look as stable as 
any wireframe render. For models made of subpatches, this means that higher Render Subpatch Levels will deliver 
smoother ink lines, and lower Render SubPatch Levels will provide chunkier ink lines.

To render all possible Edges in a scene, make sure that Render Lines is enabled in Render Properties - Render.

To set the Edges for an individual object, select that Object and open up its Properties panel. Go to the Edges tab to see 
the Edge settings. To turn off Particle/Line Thickness rendering for just that object, set the value of Particle/Line 
Thickness to 0.0. The remaining Edge types use on/off checkboxes, and they will be turned off by default. These can be 
turned on individually by clicking on their names to activate their checkboxes.

Particle/Line Thickness - this value handles the thickness of one-point and two-point polygons. One-point 
polygons will render as Particles, and two-point polygons will render as Lines. With negative values, one-point 
polygons become raytraceable spheres, and two-point polygons become raytraceable tubes. Unlike the other 
Edges, the surfacing for Particles and Lines are controlled by the Surface Editor. For example, if you would like 
your one-point polygons to render with a blue color, go to the Surface Editor and set the Surface assigned to 
those one-point polygons to the color blue.

Edge Types
Silhouette Edges - these render along the edge shared by two polygons when the normal of one of those 
polygons faces the camera, and the normal of the other polygon faces away from the camera. The edges that 
qualify as Silhouette Edges will change with the angle of the model to the camera. This means that rotating the 
model, deforming the model or moving the camera will change the Silhouette Edges on each frame. An edge 
must be shared by two polygons to qualify as a Silhouette Edge - Silhouette Edges will never appear on a mesh 
that consists of a single polygon.

Unshared Edges - these appear on edges not shared by any other polygon. Unshared Edges, when checked, will 
always appear on a model that consists of a single polygon. For non-subpatch models, selecting an area of 
geometry and then applying a “Cut and Paste” operation will create an Unshared Edge at the border of the 
selection in your object. You might use this trick to get Edges to help you describe the panels in a spaceship, for 
example.

Sharp Creases - might also be called “UnSmoothed Edges”. Whether or not a given edge qualifies as a Sharp 
Crease depends on the Smoothing Angle of the surface to which that polygonal edge belongs. Lowering the 
Smoothing Angle of a surface will increase the number of Sharp Creases traced; increasing the Smoothing Angle 
will decrease the number of Sharp Crease edges. If the “Smoothing” option is left unchecked in the Surface 
Editor, most (if not all) of the polygon edges in your model will qualify as Sharp Creases. These edges could be 
good for sharp-edged machinery, buildings and rocky terrains. If the object is deforming (for example, an 

Silhouette Edges follow a similar rule to that followed in life drawing classes: a line represents the point 
where the surface of the subject matter turns away from the viewer.



Any overlapping points of a subpatch model will get “merged” into a shared edge in Layout for Render 
SubPatch levels higher than 0, so the “Cut and Paste” trick will only help you sharpen edges in your 
model - it will not give you an “Unshared Edge” in Layout. If you want the “Cut and Paste” trick to work 
on subpatch models, create an endomorph that separates the overlapping points. Layout will back off 
when it sees the endomorph, and it will not merge those points.


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animated ocean surfaced with a low Smoothing Angle), the smoothed/unsmoothed property of the edges can 
change from frame to frame, and the Sharp Creases will change with them.
Surface Borders - this type of Edge will appear at the edge shared by two polygons when those polygons have 
different surface names. The polygons can have the same texture parameters, but Surface Borders will not care. 
If the surface names differ, then the polygons will have an ink line render along their shared edge (unless the 
artist leaves Surface Borders unchecked).
Patch Borders - shows the borders of subpatches in VPR and F9 renders instead of the triangular polygons 
subpatches are made from.
Intersection Edges - shows where two objects interpenetrate without requiring a boolean operation. They work 
equally well with subpatch and polygonal objects; still or with animation.
Other Edges - any polygonal edge that does not qualify as a Silhouette Edge, Unshared Edge, Sharp Crease or 
Surface Border will fall into this group. Turn this on along with all of the other Edges for an old-fashioned 
Wireframe Render.
Surface Shaded - Allows Surface Editor shading of edges. See Mesh Element Switch.

Positive values will render in a fixed screen size defined in pixels. For example, a 1.0 pixel thickness will always draw an 
Edge of 1.0 pixels no matter how close or how far away the object is to the camera.

Negative values will render raytraceable spheres and tubes and define the thickness of the Edges in meters (3D space) 
instead of pixels (screen space). A value of -0.01 will always draw an Edge of 1cm (0.01 meters) in 3d space that will 
shrink/increase as the object changes its distance from the camera.

Using the Node Editor for Particles, Lines and Edges enables more control. These properties are offered for most Edge 
types:

Taper - the thickness of the particle, line or Edge. Suggestions:

Use the Alpha of a Turbulence texture to create a wobbly line.
Use an Incidence Angle gradient on Unshared Edges, Sharp Creases, or Surface Borders to taper those non-
Silhouette Edge types as the surface turns away from the camera.
Use a Weight Map to control the taper of Silhouette Edges. Use low values to taper the lines as they approach 
“corners” of the model. On a character’s face, those “corners” could be the tip of the nose, the bottom of the 
chin or the edge of the lip. These points would be where the artist’s brush or pencil lifted up from the paper at 
the end of a brush stroke or pencil stroke, so the lines should taper there.
Use a Distance to Camera gradient to shrink pixel-sized ink lines as the subject matter gets farther away from the 
camera.
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Color - the color of the Edge. Ideas:
Use a Gradient that controls the color of the Edges, so that the most brightly lit areas have the lightest 
color and the most shadowed areas use the darkest color. This approach to inking was used in the 2003 
animated feature, Wonderful Days (also known as Sky Blue).
Use a Weight map to mask off different sections of a model, then use those weight values to drive a Color 
gradient so that each section of the mesh has a different-colored ink line.

Opacity - the transparency of the Edge.

As mentioned above, Particle/Line surfacing properties are handled in the Surface Editor, so Color and Opacity are not 
available for “Lines.”

In the Edges tab, Edge Color offers a base color for Edges that can be overwritten by the Node Editor.

Edge Z Scale is a legacy property. We strongly recommend leaving it at its default value of 1.0.

Edge Functionality

Patch Borders used to show the subpatch basis of this model
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Example - Shadowing Options with Edges
An example that shows use of the Mesh Element Switch and Ray Type Switch nodes to control shaded edge shadows

Example

The cartoon mushroom rendered here makes use of intersection edges to produce the face and circle line work, 
avoiding the need to paint and map images to achieve the desired 2D look. To produce an illustration appearance 
to this character, no cel shading was used. The surface uses a diffuse of 0% and luminosity of 100%, with the 
surface colors being produced by a gradient controlled by a weight map set up for the bones in the character. The 
circles and the face geometry are two separate layers of geometry that intersect with the base character form. They 
share the same weight maps as the base layer and make use of the option to use the bones from the base layer. 
This enables them to deform along with any squash and stretch actions. The face is animated through a series of 
morph targets applied to the geometry producing the face edges. By utilizing intersection edges, any requirement 
to produce animated facial image maps that are carefully timed to match the performance are not needed. The 
performance is controlled by the animator. Silhouette edges are applied, and their taper value is animated through 
the node editor with a crumple procedural texture. This breaks up the thickness of the line work and creates a more 
organic appeal to the style.  
Mushy character and explanation courtesy Kevin Phillips

Kawai_shroom.7z

https://docs.lightwave3d.com/download/attachments/8198724/Kawai_shroom.7z?api=v2&modificationDate=1516011353000&version=1
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Primitive Type - OpenVDB

Click here to expand Table of Contents...
Introduction

Channels
Settings

Node Editor
Common
Solid Volumes from Meshes and other Scene Items

Mesh To Volume
Shape To Volume
Fog To LevelSet
From Particles

Gaseous Volumes from Scene items
Gas Solver
To Fog Volume

Tools
Advect
Advect Points
Analysis
CSG
Combine
Filter
Level Set Morph
Noise
OpenVDB Info
Partio Node
Attributes list
Resample
Saver
Scatter
Solver
Vector Merge and Split
Velocity
Visualize


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The eyeball icon offers an OpenGL preview of the VDB cloud

Introduction

OpenVDB primitives are the gaseous way of using OpenVDB files in LightWave. For volumetric solids, use the OpenVDB 
Evaluator in Object Properties. You can now create OpenVDB files directly in LightWave using ParticleFX or Flocking to 
develop the underlying movement needed for gaseous shapes.

Although there are three separate settings - for Emission, Scattering and Absorption - VDB files don't need to have all 
three active. Indeed, you don't have to use the same VDB file for each of the channels. You might have one for Emission, 
a separate one for Scattering and not use the Absorption channel at all.

Additionally, each channel can have different groups of data - density, fuel, heat, temperature, etc. - that represent the 
simulation. You can use one group for each channel.

Channels
Density - Determines how dense or sparse the data from the VDB is
Fuel - The source of the flames, explosion, etc. in your VDB file
Heat - Units of energy measured in Joules supplied by the fuel in your VDB
Temperature - The relative temperature of each voxel in the VDB file
Velocity X, Y, Z - The speed at which each voxel is traveling

Settings
Step Size - The resolution at which you wish to render your voxels. The default of 100 mm should be good for 
most uses, but if you want faster results and are not bothered by a lack of definition this value can be made 
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larger for a gain in rendering time. Likewise, if you want more detail, the Step Size can be reduced for more but 
at an increased render time cost.
Emission Channel - This channel is responsible for the color the VDB shines with, and is unaffected by the light 
shining on it.
Scattering Channel - Scattering is the color of the VDB when light shines ON it, so gray or white for smoke, etc. 
This is affected by lights, etc. Scattering light can penetrate inside a volume, losing strength as it goes in.
Absorption Channel - When light shines through the VDB, some of it is absorbed and doesn't come out again. 
You only see the color that's NOT absorbed, the color complementary to the one you chose.
Scale Values - The Emission, Scattering and Absorption channels all have Scale settings. While Scale is initially 
set at 1.0 by default, you can achieve a more dramatic effect by increasing the multiplier.
Sequence Options - becomes available once the channel is chosen and allows control over how many frames 
are used from the sequence.
Asymmetry - Asymmetry allows lighting your voxels from a different direction.
Interpolator - Applies a blur to the voxel, in Point mode you might see the cubes that are the basis for the 
voxels, in Bilinear and Quadratic they get smoothed out but take longer to render.

Node Editor

Opening the Node Editor for the OpenVDB Primitive offers a Destination node with Color and Scale inputs for the 
different channels, an Asymmetry input for deciding whether the cloud should be front- or back-facing and a Velocity 
Grid input for motion blur.

Click here to expand Table of Contents...

Common

 OpenVDB nodes may have the following common settings:

Voxel Size - Size of the voxel grid in meters (LightWave supports uniform grids); the size of the voxel "blocks" 
that will make up your object
Inner Bandwidth - Inner Bandwidth for level set in voxels
Outer Bandwidth - Outer Bandwidth for level set in voxels. For fog volumes, this defines the "softness" until 
maximum density is reached.


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Fill Interior - Toggle for whether the volume will be solid when cut into or just a shell - like polygons are. Turning 
on Fill Interior with a Fog Volume will soften the outside of the fog
Coordinate System - How the voxel will be transformed. There are three choices

Local - No transform
World - Transform into world space
Parent - Use the parent item's space

Grid Name - the base name of savedgrid.vdb files. Files will be appended with the frame number and written 
with temperature, density, and velocity grids

Solid Volumes from Meshes and other Scene Items

Creating a volume this way requires a target mesh, primitive shape or Particle emitter that needs to be in the scene. It 
can be out of camera view, hidden from render and hidden in OpenGL and the Object Replacement will still work. To 
create a volume from this item requires adding a null and using the Object Replacement entry OpenVDB Evaluator. 
Clicking Properties for it will bring up a Node Editor window.

Mesh To Volume

Creating volumes from meshes relies on polygons being tris or quads. NGons are not supported
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In the OpenVDB nodes group, Mesh To Volume will be the node to convert your mesh objects into volumes. There are 
two choices for conversion, Fog Volume will convert a mesh into a volumetric fog, much like the image at the top of this 
page, but you need to use an OpenVDB primitive. The second option is Level Set, which creates a volumetric mesh 
object. The Voxel Size setting will determine the resolution of your volumetric object. For the Logo Rezzing Up
example, a Scalar Constant node was used with an envelope that went from the default 1 down to 0.0025 to create the 
increasing resolution of the volume.

Particle Radius is where you set the size of individual particles if you will be outputting a particle system from this 
node.

The new Attributes tab, added in 2020, is where you can transfer details like vertex maps or surfacing information from 
the original mesh to your OpenVDB object.

Surfaces will all be added. You cannot just choose one.
Shape To Volume



LightWave 2020  –  LightWave 2020

Reference –  883

Will create a volume from LightWave primitive objects.

Fog To LevelSet

Converts a Fog grid to a Level Set mesh object. A fog grid can be imported using the OpenVDB Info node. Double-
clicking the node brings up its window with Iso setting and Normalize toggle.

From Particles
New to 2020. There is now a Particle System output to send particles directly to the Editor Input. You can choose to 
represent particles as individual spheres or a trail (of connected spheres). When you select Trail, a Trail Resolution
setting becomes available. Higher values mean more trail particles and might be needed for high-velocity trails.

The Morphology tab includes elements that are found in the Filter node that can be applied directly, without needing a 
discrete Filter node.
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This node will create a volumetric object from a stream of particles created using the FX Emitter or the Scatter or Solver 
nodes here. You have the option to either create sphere shapes or a trail per particle derived from their position, radius, 
and velocity. Each trail is generated as CSG unions of sphere instances with a decreasing radius.

When you have a particle emitter being meshed, you cannot bring up the particle properties, as upon meshing 
(the OpenVDB Evaluator being an object replacement procedure), the PFX Emitter server pane will close. The 
only way to adjust particle properties, in this case, is by using the modal FX Browser panel.

The same is true for other server pane items - changing the subdivision level, for example - but in that case, the 
only workaround is to disable the VDB object in the Scene Editor by unchecking the render flag.



FX Emitter particles must have a Size, and that size must be output with the Output Size toggle. You don't 
need to Show Size; it just helps visually.


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Particle System - A dropdown for choosing the specific particle system you want to use. Using the Input ghosts 
this control
There are two tabs next:
Surface - Details how the particles look:

Particle Count - A readout of attached particle system particle count
Space - Choose whether your particles are situated in Local, Parent or World Space
Particle Type - Choice between Sphere and Trail. Sphere will create distinct bubbles whereas Trail will 
attempt to use particle velocity to create a trail of diminishing size. Each trail is generated as CSG unions 
of sphere instances with a decreasing radius
Trail Resolution - Only available when the Trail Particle Type is chosen. The default of 1.0 trails off 
"normally". Less than 1.0 means fewer trail particles and separation might be noticeable. More than 1.0 
means more trail particles are created. Higher trail speeds might need more particles to stay stream-like 
so separation doesn't show
Voxel Size - Size of the Voxel for the particles. Voxels sizes in a network should be the same, especially 
combining or collisions between VDB grids
Iso Surface - Iso sizes in a network can be different but the editor input node will create the final meshing

Morphology - Operators so additional nodes are not needed
Dilation - Dilate the grid along its normals making it bigger
Closing - Dilate the grid to close holes then erode closing openings
Smoothing - Gaussian smoothing

Gaseous Volumes from Scene items

Gas Solver

The direction of a trail is inverse to the direction of the Velocity vector, with a length of |V|. The radius at the 
head of the trail is given by the radius of the particle and the radius at the tail of the trail is Rmin voxel units 
which has a default value of 1.5 corresponding to the Nyquist frequency.


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Gas solver.  Use Stam's stable fluids method to advect density and temperatures. Both the density and the temperature 
affect the fluid’s velocity. Heavy smoke tends to fall downwards due to gravity while hot gases tend to rise due to 
buoyancy. We use a simple model to account for these effects by defining external forces that  are directly proportional 
to the density and the temperature.

buoyancy = (-densityscale * density * Vec3f(0, 1, 0)) + (temperaturescale * temperature 
* Vec3f(0, 1, 0));

External forces can be added on the Force Grid input. This input accounts for external forces like gravity, wind, 
turbulence and merely is added onto the end of the momentum equation.

Temperature Tab
Ambient Temperature - Ambient air temperature
Clamp Temperature - Clamps the temperature to the minimum value set below (otherwise the gas cools to the 
point where it falls like dry ice)
Min - The minimum temperature (in Celsius) for the gas to fall to
Normalize Temperature Grid - Outputs the temperature grid as a scale between 0 and 1, rather than, say, 60 
and 900
Fuel Temperature - Fuel temperature as it is emitted
Gas Density - Density of emitted smoke from the fuel grid
Fuel Velocity - Velocity of emitted smoke and heat from the fuel grid
Density Scale - Scale of the downward pull on dense smoke
Buoyancy Scale - Scale of the temperature gradient pulling smoke upward

http://physbam.stanford.edu/~fedkiw/papers/stanford2001-01.pdf
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Cooling Scale - Scales the cooling rate
Dissipation - The amount of density that falls off over each iteration so that the gas thins over time

Advection Tab
Spacial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spacial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Max Divergence Steps - Maximum number of iterations of the pressure solver
Advection Sub Steps - Substeps per integration step. The only reason to increase it above its default value of 
one is to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Curl Scale - Curl strength of the vorticity confinement

Domain Tab
Boundary - One of three choices:

Free Slip - Velocity is negated at the boundary axis
No Slip - Velocity is set to 0 at the boundary
Outflow - The grid is clipped at the boundary

The Min and Max domain fields are for setting the minimum and maximum extents (corners) of the simulation's 
domain.

Cache Tab
Cache Grids - Toggle for enabling the caching of grids to Cache Path folder. Once cached they can be loaded 
without simulation
Cache Name - Base name of saved grid . vdb files. Files will be appended with the frame number. Files will be 
written with temperature, density, and velocity grids
Grid Path - Path to save folder
Clear Cache - Clear all files in the cache folder
Behavior - A dropdown with three choices:

Manual - Cache control is completely up to the user
Warn - A message will warn "The cache is invalid, should it be cleared?"
Automatic - The cache is cleared automatically, when necessary

To Fog Volume

Converts an SDF grid (signed) to a fog volume (unsigned) with a filled interior. There are no options.

Tools

You can manipulate OpenVDB volumes with the following included tools.

Advect
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Advect a Signed SDF grid with a velocity grid. Requires a Velocity Grid vector to give movement and direction.

Spatial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spatial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Normalizing Steps - A number of renormalization passes can be performed between each substep to convert it 
back into a proper signed distance field. Prevents jerky motion but soften and slows the velocities
SubFrame Steps - Substeps per integration step. The only reason to increase it above its default value of one is 
to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Rebuild SDF - Toggle to rebuild and retrack the narrow band of the SDF

Advect Points
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This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for

Analysis
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This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.

CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes, and is the default option
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B
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The velocity of the input grids will be reconstructed and output.

Combine

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
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rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background





LightWave 2020  –  LightWave 2020

Reference –  893

•
•

•

•

•

•
•
•
•
•
•
•
•

•
•

Filter

  

This node adjusts the inner bandwidth of a volumetric signed distance field represented by a VDB volume
Filters the level set grid:

Filter Type:
Renormalize - Repair level sets represented by VDB volumes. Certain operations on a level set volume 
can cause the signed distances to its zero crossing to become invalid. This node iteratively adjusts voxel 
values to restore proper distance
Mean Value - This performs the equivalent of a simple box blur by taking the mean of the surrounding 
values
Median Value - This chooses the median of the surrounding values, good for homogenizing noisy data to 
avoid spikes
Mean Curvature - Finds the average curvature for a location and moves the surface along its normal to 
smooth out bumps
Laplacian Flow - Uses a local Laplacian value for movement along a normal
Dilate - Dilate the grid along its normals making it bigger
Erode - Erode the grid along its normals making it smaller
Close - Dilate the grid to close holes then erode closing openings
Open - Erode the grid then dilate to create openings
Track - the grid topology is updated by rebuilding the inner band so that it tracks the new iso interface
Gaussian - Gaussian smoothing
Resize - Change the width of the inner band of a VDB signed distance field

Accuracy - Increasingly complex algorithms for the accuracy of the integration
World - Performs the math for creating the levelset in World space, rather than Local
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Half Bandwidth - Level sets are normally symmetrical on the inner band. Half Bandwidth uses this fact to halve 
calculation times but at the cost of accuracy
Iterations - the maximum number of attempts to achieve a divergence-free pressure matrix
Voxel Offset - Offsets the iso surface from the actual value. For instance, using

Level Set Morph
You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

The above node tree will synchronize your surface morphing at the same time as the geometry

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out

Noise

Add the Bump output from an image or a 3D Texture to this node and pipe the output through.

OpenVDB Info
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The values for the Fuel channel of a VDB sequence
You can pipe a Level Set or Fog grid into this node and see the values contained within the file, but this node becomes 
more useful when you load a vdb file directly in the node. You can see info from whatever channels the vdb file contains.

Partio Node

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

Target - If you are using a volumetric object with the particle system, make sure it is targeted here

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.





LightWave 2020  –  LightWave 2020

Reference –  897

•
•
•

•
•
•
•

•

Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list
Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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Using the Partio node with a From Particles node

As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab
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You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Resample

Resample input grid to new voxelsize to output grid.

Interpolation - Different interpolators with increasing complexity
Rebuild SDF - Rebuilds and normalizes the narrow band of the level set
Prune - Removes values from the level set that are smaller than the Prune Tolerance set below

Saver

Pipe a grid into here and the frame or sequence is saved as VDB files upon clicking the Save button.

Save Type - a choice of Frame or Sequence. In both cases, a files or files will be saved using the File Name 
chosen appended with the frame number
Save Path - Choose a folder for the frame or sequence
File Name - The chosen prefix for the frame or sequence
Save - Immediately saves the frame or sequence. There is no visual confirmation apart from the playhead 
stepping through the scene in case of a sequence save

Scatter

To load files saved this way, use the OpenVDB Info node to choose the VDB file and its channel saved.
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Scatter creates particles on the input grid.  The particle system constructed belongs to the scatter target item. Particles 
can be scattered on or in both SDF and fog volumes.

Scatter Target - The input grid to scatter on
Scatter Mode - Dropdown to specify how the particles will be placed:

Point total - Absolute number of particles to be scattered
Point Density - Percentage of voxels in which to place a particle
Points Per Voxel - Number of particles to put in each voxel

Seed - Sets the random seed
Spread - Distance to randomly move from the voxel center

Depending on the scatter mode chosen:

Point Count - When Point Total is chosen (integer)
Density - When Point Density is picked (percentage)
Points Per Voxel - When Points per Voxel is chosen (scalar)

Multiply - Density multiplier
Animate - Reseed the random generator each frame
Fill Interior - Fill particles inside the sdf narrow band
Size Factor - The size of the particles created
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Creating bubbles inside a VDB toroid is simple with the Scatter node. The Filter node has been used here in Erode mode 
to ensure that the bubbles are created inside the toroid volume and not at the boundary.
Solver

A particle solver that uses a particle system to initialize a temporal PIC/FLIP feedback loop. Particles from the particle 
system are input as they are born. Then are advected by the integrator using the gravity over the frame substeps. PIC 
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(Particle In Cell) produces smoother motions, and FLIP (FLuid Implicit Particles) is splashier. The two methods can be 
combined.

The Navier-Stokes equations that the PIC/FLIP system uses do not dictate position but velocity. The vectors contained 
are not coordinates but velocities. PIC / FLIP is an advection equation, which is how the particles in these objects move 
within velocity fields.

Particles In Cells (PIC) works by evaluating particles as groups of particles in cells (like voxels)

FLIP stands for FLuid-Implicit Particles and uses a grid rather than particles. Grid-based methods were great for large 
ocean effects, but not fine detail close up visual effects work. Things can look globby and unrealistic at a small scale 
(thin fluids).

Inputs
Collision Grid - SDF grid to be used for collisions
Particle System input - Use a separate particle system

Outputs
Grid - Outputs an SDF grid
Particle System Out - Particle system output
Start Only - Only uses the first frame of the particle system
Voxel Size - Size of the gid voxels
Integrator - In short, the upper choices from this dropdown menu are faster but the lower choices are better 
quality
Subframe Steps - More steps per frame is more accurate but takes longer
PIC↔FLIP - Ratio of PIC velocities to FLIP velocities
Blobby - Check to treat the particles as spheres
Gravity - Downward pull in meters per second squared
Stickiness - Amount of velocity absorbed by contact with collision object
The next three checkmarks are to help visualize the grid:

Show Particles
Show Grid velocity
Show Collider grid

Vector Merge and Split

New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Solver is time-based so scrubbing the scene will break it, particularly going backward. Create previews to 
see a smooth animation if your scene is too heavy.


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The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states

Velocity

This node will construct a velocity grid for motion blur use.

Reference Grid - Use to populate the velocity grid on the active values
Velocity - Vector of velocity evaluated during grid building
Rebuild Velocity - Rebuild Velocity at each evaluation rather than creating a static field

You can use an envelope or a texture map to adjust the velocity grid over time for more control

Visualize

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
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Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform
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Primitive Type - Shape

Creates a primitive shape at the size you choose. The choice of shapes is:

Sphere
Cube
Cylinder
Torus
Cone
Plane
Empty Volume

This shape can be textured like any other object, but only exists as a virtual object purely in Layout and saved in the 
scene file. It can even be used for Bullet.

Radius  - determines how large the object will be initially and acts as a multiplier for scale values applied to the 
null.
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Displacement Height - Controls how far out from the surface a displacement (set in the Node Editor Surface 
node).
Accuracy - Distance multiplier control to deal with primitive edge cases that need smaller marching steps.

Object UV

All Primitive shapes have an inherent UV map called Object UV. This can be used as a mapping source in Image nodes. 
The Image Sampler node doesn't need a Projection to use Object UV, loading the image and attaching it to the input 
you want on your shape is enough.

Shape Pros and Cons

Advantage Limitation

Don't consume memory like geometry
Resolution-independent
Can be surfaced
Can be used for Bullet Dynamics
Are saved in the scene file
Object UV

Only the simple preset shapes supplied (third parties can 
write others)
You can't add FiberFX to primitive shapes
Cannot be used for Instancing
Slower to render if displaced
Since they are based on nulls, most "Object-level" 
operations won't work (such as the Object ID buffer)

Example - Displacing Primitives

Example - Shape Dynamics
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Empty Volume

Click here to expand Table of Contents...
Introduction
Distance Tools

Capsule
Mobius
Shape CSG
SmoothMin

Additional Nodes

Introduction
Shape Primitives are ray traced using a distance estimation method (a smarter ray march). We have several built-in 
estimators - Sphere, Cube, Cylinder, Cone, Torus, Plane; and now Empty Volume. An empty volume can be used to 
create realtime booleans in Layout.
Inigo Quilez explains the principle here and suggests an empty volume providing the distance estimator through nodes. 
As Lightwave is rendering this shape, each surface point can be read using the input 'Object Position.' We translate that 
into its distance from the center of the volume using a Vector "Length Node" and then by adjusting this value with other 
things (i.e., maths, 3D procedural textures, etc.) we can then attach it to drive the 'displacement' value for the empty 
volume.

In LightWave, the functions are provided by adding a Null and setting it to Shape > Empty Volume. The displacement is 
performed by editing the resulting object's surface. The resulting object is called a Signed Distance Function or SDF.



http://iquilezles.org/www/articles/raymarchingdf/raymarchingdf.htm
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Distance functions drive the iso-surface boundary finding. A simple node showing the sphere primitive shape in an 
empty volume.

SDF Sphere.7z

To make use of the presets attached here, download to disk and in the Surface Editor go to the Preset... 
dropdown and choose Load from Disk... - this will replace your existing surface. Once loaded you can save the 
surface as your own preset. The Capsule preset will require that you supply nulls for End A and End B. Without 
them, it will just look like a stripy ball.



https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Sphere.7z?api=v2&modificationDate=1549356941000&version=1
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A rounded box derived from http://iquilezles.org/www/articles/distfunctions/distfunctions.htm 

SDF Rounded Box.7z
Distance Tools
Distance Tools menu heading contains nodes to create or modify distance functions.

Capsule

SDF Capsule Compound.7z
The capsule node relies on positional information based on the End A and End B inputs, or two items (nulls were made 
for the preset) to form each end of the capsule.

The capsule inputs determine:

Position - the location of the capsule shape. Usually the object itself, however, this can be driven by nodes
End A - One end of the capsule shape
End B - Opposite end of the capsule shape
Radius - the radius of the capsule shape

Setting both the end values to 0 will produce a spherical shape.

The attached surface preset available here relies on positional information for two items (nulls were made for this) to 
form each end of the capsule. The first input is taken from the Input node's World Position, and the Radius is based on a 
Scalar constant. The attached surface preset merely renames the inputs to make them easier to understand.

http://iquilezles.org/www/articles/distfunctions/distfunctions.htm
https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Rounded%20Box.7z?api=v2&modificationDate=1549357009000&version=1
https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Capsule%20Compound.7z?api=v2&modificationDate=1549357089000&version=1
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Mobius
A twisted set of a single ring. The inputs determine:

Radius - The overall size of the ring set
Cylinder Radius - The radius of the cylinder that is being twisted
Group Radius - How tightly packed the ring is
Order - How many apparent rings are being twisted together
Twist - The spiraling of each apparent ring
Coil - The spiraling of the total rings

Shape CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B

The two shapes must be built in the same Empty Volume for Shape CSG to work. At this time, the Capsule and 
Mobius preset nodes are the only two currently available to work with, but shapes created - such as the 
spheres above - can also use the Shape CSG node


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Using the Shape CSG node can create interesting effects. Here, a Scalar attached to a procedural texture controls the 
CSG effect
SmoothMin
Will blend between the Results from two SDF shapes with a user-definable radius.

Smooth Min adds three shapes using a blend
Additional Nodes

https://docs.lightwave3d.com/download/attachments/8198543/corruption.mp4?api=v2&modificationDate=1527600969000&version=1
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You can use a Vector Mod(ulo) for repetition. The initial Empty Volume radius determines how many shapes will fill it. 
The Vector Mod can be left at 1.0, 1.0, 1.0 and the Scalar will determine the size of the individual shapes

A grid of SDF spheres
A texture distortion of the above distance field.

Use a Vector Max when constructing unsigned shapes, with a per axis maximum.
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Primitive Type - Volumetric

When you choose Volumetric, a new set of options becomes available:

Source Item - Allow you to select a different item to act as host for the Volumetric Primitive. Normally, you 
would select the actual host item, but for certain circumstances including emitting from deforming meshes or 
examining texturing for a single particle rather than emitted cloud, you can select a different source object.

Example - Volumetric Primitive Emitter

Type - You can set Cube, Sphere or Cone here. The size of the type is based on a spherical bounding box so the 
Radius setting still stands.
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The null used for the Volumetric type is at the center of the sphere and cube, but at the point of the cone

Edit Nodes - For controlling the texture and shading of Volumetric Primitives.
Radius - Sets the overall size of the Volumetric Primitives.

The sphere is set at .5m, the cube at 1m, the cone at 1.5m

Step Size - The point at which a particle stops rendering when the camera is near (or in) it. This can be set higher 
for Volumetric Primitives that render faster or lower for when you want maximum detail, at the cost of longer 
render times.
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You will need to examine these images at full size. The leftmost has a 1 m Step Size and rendered in 103s. The 
middle image has a step size of 100 mm and rendered in 184s. The image on the right has a step size of 10 mm and 
rendered in 832s. There is actually little difference between the 100 mm and 10 mm images, mainly in the darker 
area at the right side of the cube

Viewport Preview - Turns on or off the OpenGL representation of the volume.
Emission - The amount and color of light emitted by the HyperVoxels. This can be set here, or with more 
possibility for customization in the Node Editor.
Emission Scale - A multiplier for the Emission value.
Scattering - What light is scattered by the volume. The color as it will appear is the complement in the color 
picker, so a green chosen as the scattering color will result in a purple tinge.

Scattering Scale - A multiplier for Scattering.
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Absorption - The color of light absorbed by the volume. The color of the volume is thus the complement of the 
absorption color chosen.

Absorption Scale - A multiplier for Absorption.
Asymmetry - For creating lighting effects where the light moves through the HyperVoxel in a different direction 
to its position in the scene.

 

Texture Mode - Presents three choices:
None - With None chosen, the only texturing options are what you have in the Node Editor above.
Non-Pyroclastic - Gives a cloudy form to the volume.
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Pyroclastic - The volume takes on the form of an explosion outwards from the null used for the object.

Texture - A scale from 0-1 determining how much or little of the texture applied will "shine through" in non- or 
Pyroclastic mode. 0 means the texture is fully  displayed, 1, not at all.
Texture Density - How dense the volume is. There is no ceiling on this value.
Texture Amplitude - How much the texture contributes to the final result. 0 is not at all and you will just see the 
form of Volumetric Primitive you chose, 1.0 is the size is completely determined by the texture you chose.

Video

Example - Volumetric planet and atmosphere

Note that a Volumetric Primitive is an object and thus blocks the alpha, unlike the fog in previous versions of 
LightWave



Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=71e0bWRRhyk

https://www.youtube.com/watch?v=71e0bWRRhyk
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Render Tab

Click here to expand Table of Contents...
Clip Map
Matte Object
Alpha Channel
Object Dissolve

Distance Dissolve

Unseen By Rays
Unseen By Camera
Unseen by Radiosity
Unaffected By Fog

Object Shadow Options
Shadow Offset


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Clip Map

The Clip Mapping function, located on the Rendering Tab of the Object Properties Panel and in the Surface Editor, offers 
a way to quickly alter an object. Basically, it allows you to cut away portions of an object using a texture. This is a great 
way of creating 2D pop-ups, as well as holes, tears, or grids in objects without having to model them.

Matte Object

The Matte Object option causes an object to be rendered in a single user-specified color (usually black or white) with no 
shading, overriding all of the object’s surfaces.

Alpha Channel

On the Matte Object section of the Render Tab panel there is also an Alpha Channel pop-up. You can choose from the 
following:

Use Surface Settings - uses the surface settings of the object to determine the object’s effect on the Alpha 
Channel
Constant Value - the object is black as far as the Alpha Channel is concerned. If this option is used the field 
below Alpha Value becomes available.

Object Dissolve

Entering a value for Object Dissolve on the Render Tab of the Object Properties Panel will cause LightWave to render the 
object in a semi-dissolved state. If you enter 100 percent, LightWave will not render it at all. Since the value supports 
envelopes, you can change the dissolve amount over time. For example, you may wish to slowly dissolve clouds in on a 
rainy day, or replace one object with another by dissolving them in and out in the same frame.

When an object is set as MATTE, it should take on the matte color where it is visible to the camera but it should 
not be seen by any other rays. In addition, the luminance channel should be 0 for the object’s pixels. The matte 
color is still affected by fog.


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Distance Dissolve

Activating Distance Dissolve lets you automatically dissolve the current object out after it has moved a certain distance 
from the camera. The Max Dist value determines the distance at which the object should be totally dissolved. The 
dissolve is gradual, thus the object will have some amount of dissolve any time it is between the camera and the Max 
Dist.

Unseen By Rays

Selecting Unseen by Rays for an object tells LightWave to ignore the object in its ray-tracing calculations when 
reflection and refraction are involved. This means that the object will not appear in the reflections or refraction of 
another object. It will, however, render normally in the scene. This is especially handy for objects that are front 
projection-mapped; you probably do not wish them to show up in the reflections within other objects. Unseen by Rays 
will not affect the shadow options of a given object.

Unseen By Camera

An alternative to making an object 100-percent dissolved is to activate Unseen by Camera. This makes the object 
invisible to the camera when you render; however, you will still be able to see it and work with it in the Layout window.

Although the camera won’t see these objects, lights will. You can use this option to cast fake shadows into your scene 
from off-screen objects, like window pane frames.

Underwater particles and moving stars often benefit from Distance Dissolve.
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Left: Normal Render, Right: Unseen Clay Sculpture

Unseen by Radiosity

You can choose objects to not be included in the global illumination solution for the scene.

Unaffected By Fog

Objects that have Unaffected by Fog selected will be excluded from the fog effect. Also, the fog Level setting, under the 
Unaffected by Fog option, will let you apply an amount less than or greater than normal. The default is 100%.
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Object Shadow Options

If a light has shadows enabled, any objects illuminated by it will generally cast shadows on themselves or onto other 
objects. However, you have complete control over this. LightWave lets you decide exactly which shadow options an 
object should employ. For example, you may wish for some objects not to cast shadows and others not to receive 
shadows. By default, all shadow options are on.

Judicious use of the Self Shadow, Cast Shadow, and Receive Shadow options for the objects in your scene can greatly 
speed up rendering times for lights.

Deactivate Self Shadow if you do not want or need an object to cast shadows on itself. An egg is a good example of an 
object that cannot cast shadows on itself. A tree on the other hand is a prime candidate for Self Shadow.

Self Shadow Inactive

Do not confuse Self Shadow with shading. An egg under a solitary light source may be shaded so that one side is darker, 
but this is shading and not casting a shadow on itself.

Deactivate Cast Shadow if you do not want an object to cast a shadow onto other objects. A spaceship orbiting a planet 
would be a good example of an object that usually should not cast a shadow.
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Cast Shadow and Self Shadow Options Inactive

Deactivate Receive Shadow if you do not wish an object to receive shadows from other objects. In the spaceship 
orbiting a planet scenario, perhaps a better option would be to turn off Receive Shadow for the planet as opposed to 
turning off Cast Shadow for the spaceship. You may want the spaceship to cast shadows onto nearby asteroids or other 
ships.

Shadow Offset

This defaults to 0. By entering a small amount (100 mm worked in internal testing) the origin of the shadow rays cast by 
the object will be offset along the smooth surface normal by the Shadow Offset distance. This will cause nearby 
polygons on irregular objects to not cast shadows on their neighbors if they are roughly co-planar with them. More 
distant polygons on the same object or polygons that are not co-planar will still cast shadows as usual. This feature can 
be used to get rid of flickering shadows on the surface of irregular objects such as asteroids.
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Appearance Tab

The Appearance tab replaces the Add Custom Object section in the Object Properties panel prior to 2018. Object 
Replacement is now achieved in the Primitive > Geometry sub-tab.

The list of Custom Objects is as follows:

Click here to expand Table of Contents...
Camera Mask

To use Camera Mask:

Depth of Field Display
Dynamics Constraint
Dynamics Force
Effector
Flock Director
Flock Generator
Frame Rate Meter
HyperVoxels Drawing (HV Custom Object)
IK Booster
Item Comment Display
Item Shape
Level-of-Detail Mesh Refinement
LScript and LScript/RT
Motion Capture Preview
Protractor
Python
Python Basic Barn
Range Finder
Ruler
ShowCurve
Sliders

To configure your sliders:


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1.

2.
3.

4.

SockMonkey
Speedometer
Visor

Interacting with a pane
Images and renders
The interface
Global settings
Pane settings
Example - Setting Up Visor

VRML97 Custom Object

Camera Mask

It is sometimes necessary to use a textured object for the background instead of using a Background Image (Effects 
Panel, Compositing Tab) for effects like casting shadows onto the background or when you want to move the 
background around. The Camera Mask custom object can be used to compute the exact Z distance needed to fill your 
camera view.

To use Camera Mask:

Model a flat Z-facing rectangle object with the proper aspect ratio. For example, 640 mm x 480 mm for a 4:3 
aspect ratio. Apply your surface texture.
Load the object into Layout and parent it to the camera.
Add the Camera Mask custom object plugin to the object. Enter the object’s size into its options dialog and then 
close it. You will then see a rectangle that represents the exact Z position where the object would fill the camera 
view. The numeric value of this magic distance is also displayed.

Now, adjust the Z position of the object. You will see a representation of the camera view extend from the object 
with your textured rectangle attached to the end. If you have a Camera Mask set on the Camera Properties Panel, 
it will be visible.
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Note that when the object is selected, the camera’s mask will appear as dotted lines. Otherwise, the mask will be 
the mask’s set color. (Note: You may see OpenGL display errors when the mask is solid.)
Adjust the object’s Z Position to the magic distance. The object will now fill the camera view.

 
You might also use a background plane with parts cut out, in conjunction with a Background Image, so you can 
position things between the plane and Background Image.A cross (+) also appears, which marks the camera’s 
Focal Distance setting from the Camera Properties Panel.

Depth of Field Display

The Depth of Field Display custom object is a handy tool for seeing your Focal Distance and Lens F-Stop Depth of Field 
settings found in the Camera Properties Panel. Anything that is located in the Focus shape will be in focus and anything 
outside of the Focus shape will be out of focus.

Steps for applying the DOF Display custom object:

Add a Null to your scene.
Parent the Null to the camera.
Activate Depth of Field in the Camera Properties Panel and adjust the Focal Distance and Lens F-Stop settings.
Add the Depth of Field Display Custom Object from the Add Custom Object drop down menu.

Use the numeric options to set the Circle of Confusion setting. This setting means the size of a point that is recognized 
as a single point. The smaller the value, the smaller the area will be in which objects are defined as ‘sharp’.
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Dynamics Constraint

Indicates a Bullet Constraint has been added to the object.

Dynamics Force

Indicates a Bullet Force  has been added to the object.

Effector

The Effector custom object can be used with the Effector Displacement plugin. This custom object is designed to give 
you better visual feedback of your effector in Layout. Note that it does not directly communicate with the related 
Displacement plugin, so all settings must be set manually.

It has two modes to match the shape of the effector: Point and Plane.
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When Effector Shape is set to Point, set the Solid Core Radius and Falloff Distance to match those settings on the 
Displacement plugin’s panel. The arrows and dotted-lines indicate the falloff area. The solid-line ball in the center is the 
solid core.

When Effector Shape is set to Plane, the effector will look like a four-sided plane. The Axis settings will become 
available, and you can then set them accordingly. The other settings have no effect in this mode.

Flock Director

Indicates that a Flocking Director has been added to the object.
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Flock Generator

Indicates that a Flocking Generator has been added to the object.

Frame Rate Meter

Adding Frame Rate Meter to a null object will display frames-per-second information when you play a scene or drag the 
frame slider.

HyperVoxels Drawing (HV Custom Object)

This custom object is automatically placed in the Add Custom Object list when HyperVoxels are applied to an object.

IK Booster

IK Booster is discussed in the IK Booster section on page PDF_LINK. One option of applying IK Booster is to do it here in 
the Add custom Objects list. The preferred way is to add it with the IK Boost tool (Modify > IK Boost).

Item Comment Display

If you add a comment to a scene item using the Python Add_Scene_Comments script this plugin will be activated 
automatically. If you wish to add a comment to a scene item manually using the Items Comments plugin (Utilities > 
Additional > Comments), you can add the Item Comment Display custom object plugin and see the comment in your 
viewports.
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The Item setting determines which scene item gets its comment displayed. It does not have to be the item you add the 
custom object plugin to. You also have control over the text Color, visibility (Alpha), and Justification.

Item Shape

Item Shape lets you specify the shape and look of your custom object. This is a great way to give each null in your scene 
a unique identity. When you create a null, clicking on the dropdown at the bottom of the window gives you access 
straight away to the Item Shape properties.

Shape - Choose the actual shape that will be displayed. Your choices are Standard (Standard Null), Box, Ball, 
Pyramid, Diamond, Tetra, Ring, Grid, and None.
Axis - Which axis the shape is facing. This is best represented with the Ring and Grid shape.
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Scale - Size of the shape.
Filled - This checkbox will determine whether the shape is displayed in wire or solid.
Label - Places a Label for the Item Shape.
Justification - Label Placement with the standard choices Left, Center, Right.
Draw Line To - Allows you to draw a dotted line to any item in the scene.
Selected Color - Color the item shape will be when it is selected.
Unselected Color - Color the item shape will be when it is not selected.
Text Color - Color of the Label text.
Opacity - Determines how opaque the item shape will appear.

Level-of-Detail Mesh Refinement

Adding the Level-Of-Detail Mesh Refinement custom object tool allows you to independently change the display and 
rendering resolution of SubPatch and Meta-primitives based on their distance from the camera. This can save you 
rendering time when those types of objects are sometimes close to the camera and sometimes far, during your 
animation.

 
From top to bottom, the entry groups must be in near-to-far order, so the furthest group is last. When the distance from 
the camera to the object is within each range, the corresponding Display/Render settings are used.
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A value of -1 disables that (display/render) parameter. It is like deactivating the Enable option for a group, but lets you 
control it differently for individual items in that group.

In your viewport, concentric rings are displayed around the object showing the defined distance ranges.



LightWave 2020  –  LightWave 2020

Reference –  934

LScript and LScript/RT

These two items will allow you to apply a Custom Object LScript.

Motion Capture Preview

This custom object plugin can be used to preview BioVision motion data. The preview is fast and accurate. Use it to 
determine if there were any errors in the motion conversion.

Simply add the MotionCapturePreview custom object to a null object on the Object Properties Panel. (If you run the 
MoCap_BVH_Setup generic Layout plugin, a null called “MotionCapturePreviewNull” will automatically be added to the 
scene with the custom object plugin already applied.)

Protractor

Protractor sets up a custom object you can use to measure angles. With the Shape setting you can make it a Full or Half 
circle. The Label option places numerical labels at set intervals. Use the Show Mark option to place a tick mark at a set 
angle. Use Show Range to highlight a set range.
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Python

Allows you to load a Python script.

Python Basic Barn

An example script to make a barn shape in Python. It doesn't render.

Range Finder

Adding Range Finder to an object will display the distance in meters from the selected item in the scene. The Draw Link 
option will draw a dotted line between the items.

 
Null objects work best. However, if you add this to a regular object, you may want to use the Bounding Box rendering 
level (selected on the viewport’s titlebar). Otherwise, the object’s surface may obscure the numeric display.

Ruler

Adding Ruler to a null object provides a measurement device. You can change the length of the ruler by stretching the 
object along the selected Axis. The units of measure can be 1/10 of a meter or feet/inches. The Draw Numbers option 
controls the display of the numbers.
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ShowCurve

ShowCurve displays an object curve in Layout - normally curve objects are a Modeling tool and cannot be seen in 
Layout. (If there is more than one curve in the object, the first curve is used.)

 
The color of the curve can be adjusted using the Curve Color setting on the Options Panel. The Draw Cage option, when 
active, displays the “cage” of the curve by connecting the vertices with dashed lines in a color of your choice. The Draw 
Points option, when active, adds arrowheads to each of the vertices to indicate the direction of the curve.

ShowCurve was designed to be used with the CurveConform displacement plugin.
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Sliders

 
Sliders (Modify > Sliders) are slider gadgets that are displayed over viewports. An individual slider is tied to a specific 
animation channel. A slider will indicate the current value of a channel and also let you interactively adjust that channel 
value.

To configure your sliders:

Open the Sliders custom object settings dialog from the Object Properties Panel.
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The left window (Channels List) will list all of the channels in the scene. To attach a slider to a channel, simply select the 
channel in the left window and click Add Channel. Selected channels in the right window can be removed with the 
Remove Channel button.

The Range Min and Range Max settings define the interactive range of the slider. The underlying channel can go beyond 
these values, but the slider’s range of control and feedback will be limited to this range. If the underlying channel goes 
outside of the range, the slider value will turn red. Clicking on the slider handle will immediately change the channel to 
the slider’s corresponding value.

The description Label will default to the channel name, but you may edit that if you desire. You can also set the color 
used for the slider with the Color preset pop-up menu or specific RGB values.

SockMonkey

The SockMonkey custom object plugin draws bounding boxes for links created in the main SockMonkey displacement 
plugin. However, if you use the Auto-add Control Item button on the main interface, this custom object plugin is 
automatically added to the created control item, so you don’t need to worry about adding this manually. If instead, you 
use the Add Relationship option - where you manually define the Control Item - you can add this custom object plugin 
to get the bounding box.

The Parent Object is the main SockMonkey object. The Pending Relationship is the related Vertex Group defined on the 
main interface. Once assigned, this dialog will no longer appear when you try to access the options. If not assigned to a 
link, adding this plugin does nothing.
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Speedometer

Adding Speedometer to a null object allows you to measure the speed of an item in meters per second. Choose the item 
whose speed you wish to measure with the Item pop-up menu. Activate the World Coords option to measure the actual 
speed based on world coordinates. (You’ll probably want to do this if the item is parented to moving item.)

The Max Speed setting determines the value when the pointer is pegged all the way to the right. Select Auto-Range to 
have the plugin determine the maximum. Note that the pointer can go past the maximum if the speed exceeds it.

Visor

 
Visor shows images and renders in a Layout viewport. The images and renders are organized in panes. A pane can show 
one or more images and/or renders, and there can be multiple panes in multiple viewports. Panes can be arbitrarily 
sized from taking up very little space, to a strip along the side of a viewport, to covering an entire viewport. Visor can be 
used to keep reference photos conveniently available in Layout without having to open yet another window. Visor can 
also be used to show the last few F9 renders in a viewport without the need to have the render window open.



LightWave 2020  –  LightWave 2020

Reference –  940

Interacting with a pane

A pane can be activated by clicking in it or by selecting the Null to which the Visor custom object is associated. Note that 
sometimes other items in the scene may interfere with clicking in the pane. Clicking near the corners usually works 
best.

If there are multiple panes, all the panes will at first become active. You can then click on the pane you want to work 
with by clicking in it again.

An active pane will show six gray handles. Four in the corners that can be dragged around to resize the pane, one on the 
border that is a slider if there are more image than can be shown in the pane and one in the center to move the pane. 
You’ll need to add some images with the Image Editor or by rendering in order for the slider to be useful.

The panes can be deactivated by selecting some item in the scene. Initially you may have to do this by changing the 
Current Item. Afterwards Visor will keep track and return you to the last tool used and the items last selected.

Images and renders

Panes can show both images present in the Image Editor, and any F9 renders. To have an image show up in a pane, 
simply load the image into the Image Editor.

To have renders appear in panes, the Render Display in the Render Options has to be set to the entry called 
Render2Image. This option is added by Visor and it adds renders to the Image Editor instead of renders appearing in the 
render display. From there they are picked up by the Visor panes.

References to images which are shown in a pane will be saved into the scene file, even if they aren’t used as part of the 
scene. However, this does NOT apply to renders. Renders will be lost if the scene is cleared (you can always access a 
render through the Image Editor and save any you want to keep from there). For renders, depending on how much 
space is available, Visor shows some helpful information about each render, for example:

[8] 05/05/15 01:28:12, 73s, 12f, (1280 x 720)

This reads as: this is the 8th render made, at the given date and time, took 73 seconds to render, it’s a render of frame 
number 12, and was rendered at a size of 1280 by 720 pixels.

Visor can be used without using Render2Image, but F9 renders won’t appear in the panes.
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The interface

 
The interface can be opened either by double clicking on the Visor custom object entry, or by double clicking on an 
active Visor pane.

As well as a button to add a new pane, there are also a set of global settings, and a bunch of settings for the currently 
active pane.

Global settings

Max number of renders - Each rendering takes up memory to keep around. The number of renders Visor keeps 
around is limited to the given number of most recent renders. If the maximum number of renders is reached, the 
oldest render is deleted. Note that this does not affect images, only renders. Default: 8
Double click time - This gives the maximum amount of time (in seconds)between clicks on a pane in order for it 
to be registered as a double click. Double clicks on an active pane open up the Visor interface. Default: 0.5

Pane settings

Remove pane - Clicking this button removes the currently active pane.
Viewport - Sets the index of the viewport in which the current active pane is placed. Viewports are numbered 
from zero up to a maximum of three. 0 means the first viewport, 1 the second, and so on. Which viewport is the 
first, second, and so on depends on the viewport layout. Negative viewport numbers indicate a viewport index 
relative from the last viewport. So -1 means that he pane will always appear in the last viewport, -2 means the 
second to last, and so on. Default: -1
Show - Selects if the currently active pane will show images only, renders only, or both types. Default: Images & 
Renders
Sort - Sets the sorting order between images and renders for the currently active pane. Default: Images first
Sort images by - Sets the sorting order of the images (if there are any) for the currently active pane. If Reverse is 
checked, the ordering of the images is reversed. Default: Name
Sort renders by - Sets the sorting order of the renders (if there are any) for the currently active pane. If Reverse is 
checked, the ordering of the renders is reversed. Default: Index, Reverse
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Background color - Gives the color used to fill the background of the currently active pane. If Background is 
checked, the background is drawn, otherwise it isn’t drawn. Default: 204 204 204, Background
Pane opacity - Sets the opacity with which the currently active pane is drawn. The pane opacity is only used if 
the pane is not active. When the pane is active, it will always be drawn completely opaque. Default: 100.0%

Example - Setting Up Visor

VRML97 Custom Object

The VRML97 custom object can be applied to an object to make its VRML attributes visible in Layout. It will display URLs, 
the Proximity-Sensor bounding box, LOD ranges, sound nodes, and links to alternate triggers.

You can send images rendered to the Image Viewer to Visor using the File > Frame Buffer > Auto-Send function.
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Lights Tab

Object Exclusions

You can exclude any set of lights, as well as radiosity and caustics, from the shading of any object. Simply click in the 
Exclude column to activate the exclusion.

If for some reason you need the excluded lights to continue to cast shadows, deactivate the Shadow Exclusion option. 
When this global setting is not activated, all lights will cast shadows even if they are excluded. You will need to add the 
Shadow Exclusion command (Lights command group) to a keyboard shortcut or menu to access it. Note that adding to 
a menu may be preferable so you can see its current state.

Use the drop down menu by right clicking to Select All, Clear All, and Invert Selection.
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GI tab

This tab provides the ability to be able to customize GI settings on a per-object basis. There are three choices:

Use Global - Uses the scene Global Illumination settings
Monte Carlo Brute Force - Only the quantity of brute force rays becomes available to adapt
Monte Carlo Interpolated - The normal interpolated settings become available to customize. Note that the flags 
for Use Bumps and Behind Test can not be optimized on a per-object basis
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FX Tab

Add FX

The FX Tab of the Object Properties Panel is where you can Add FX and manipulate the settings. Add FX choices:

Cloth - Cloth Dynamics
Soft - Soft Body Dynamics
Hard - Hard Body (Rigid Body) Dynamics
Emitter - Particle or Partigon Emitter
Wind - Wind controller.
Collision - Collision controller
Gravity - Gravity controller

This tab is for applying LightWave’s original FX dynamics system. Now that LightWave has a Bullet 
implementation available from the FX Tools tab in Layout, there is less need for this object-based dynamics 
system. It is still included for legacy use and the particle emitter, for which there is currently no Bullet 
replacement.



See FX Dynamics for all FX dynamics options.
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Instancer Tab

On this tab, clicking the Add Instancer dropdown menu provides you with three choices:

Add Instancer - See Instancing
Python - Opens a requester for a Python Instancing script
Python City Block - See Example - Python City Block
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Scene Management
Click here to expand Table of Contents...

Organizing your Scenes
File Menu Section
Editors Section

Scene / Dope Editor
Surface Editor
Presets
Image Editor
Graph Editor
Backdrop

Items Tab
Graph Editor
Scene / Dope Editor

Organizing your Scenes

Taking on a CG project can be a challenge, whether it is a simple scene with one object, one light, and one camera, or a 
complex scene with hundreds of objects, bones, surfaces, dynamics, and everything else in-between. Keeping it all 
organized is key to a successful project, and this section of the documentation is all about the tools you can apply to 
keep your scenes manageable.

Starting with the basics of loading and saving items in a scene, the chapter then progresses from management tools like 
the List Manager onto more complex tools such as the Scene Editor and Graph Editor.

File Menu Section

Layout’s File menu section contains common file management commands and tools.


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Editors Section

Scene / Dope Editor

Surface Editor

Presets

Image Editor

Graph Editor

Backdrop

Items Tab

The Items tab is where you will load or add objects, lights, and cameras to your scene. You will also find tools for 
replacing, renaming, selecting, and deleting scene items.

Graph Editor

LightWave's graph editor is a graphical way of manipulating scene items over time

Scene / Dope Editor

A full explanation of LightWave's Scene Editor and Classic Scene Editor
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File Menu Section

Layout’s File menu section, always located at the top-left or top-right of the Layout window, contains common file 
management commands and tools.

Layout Load Menu
Layout Save Menu
Layout Edit Menu
Layout Help Menu

Clear Scene

(default keyboard shortcut - Shift N)

Clear Scene - (File > Clear Scene) will remove all data from Layout and return Layout to its default setup. All unsaved 
data will be lost.

Quit

(default keyboard shortcut - Shift Q)

Leaves LightWave (but why would you want to?)
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Layout Load Menu

Click here to expand Table of Contents...
Load Scene...
Load Items From Scene

In Use

Load Multiple
Recent Scenes

Revert Scene to Last Saved

Set Content Directory...
Recent Content Directories
Load Object...
Load Object Layer...
Replace with Object...
Replace with Layer...
Load Motion File...
Import

Load Scene...

(default keyboard shortcut Ctrl O)

To load an existing scene: Choose File > Load > Load Scene... or use the keyboard shortcut Ctrl O and use the file dialog 
to navigate to the desired scene file. If the scene is not in your current content directory, you will be asked if you wish to 
change to the new scene’s content directory, do so. While the scene is loading, a progress dialog will appear. You may 
abort the load operation by clicking the Abort button; however, this may result in a partially loaded scene.

Load Items From Scene

Using Load From Scene (Items > Load From Scene) allows you to import existing lighting rigs, characters from other 
scenes, and many other things into a new one.

This can be extremely useful when working with complex scenes that have many items. Having the ability to set up a 
character in one scene and load the entire setup into a different scene is just one example of how useful Load From 
Scene can be.


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Loading objects from a scene is accomplished using File > Load > Load Items From Scene.... After you choose the scene, 
a panel will open up, and you will have the option to choose which items from the scene you would like to load. Double-
clicking on the root of an item type, for example, Lights, will enable/disable all items of that type. The object layer 
number will be listed when loading a multi-layered object.

Expand All and Collapse All will perform the respective function on the root of the item.
Select All selects all items and Select None deselects all items.
Clicking on Merge only Motion Envelopes will load only the motion envelopes for the selected items.
Selecting Load Meshes as Instances will add a null to the scene and add

In Use
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There are nearly 2,000 items in this kitchen scene. If just the spoons were needed for another scene, it would take a long 
time to pick through all 2,000, with no guarantee all the spoons would be chosen. That is why the Load from Scene 
panel includes a filter field at the top to allow the user to select items by filtering on a full or partial name.

Just entering part of the object name in the filter field at the top of this window will now limit the available items to load 
into the scene. No wildcards are necessary (* or ?) since they are implicit.
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Furthermore, at the bottom of this window, you can set a pattern for renaming non-geometry items loaded from 
another scene to prevent confusion with items already in the scene you are loading to. Non-geometry items include 
Lights, Cameras, and Nulls.

Regular expression support has been added to the Find/Replace fields. As with the Filter field, activate in the Find field 
with an @ prefix. When enabled, the Replace field may have substitutable parameters of the form <index>$ that 
correspond to each captured value in the regular expression (e.g., “Bob_$1_$2” would expect to match two captured 
text values from the expression “@^(.+)_pattern(\d+)_lino”).

Be aware that when the first child in the chain becomes the new parent of the remainder of the chain, some 
transformation issues may arise as that child is no longer bound by the parent’s transformations. These 
transformations will have to be cleaned up manually after the scene is loaded.

Load Multiple

Load Multiple enables easy loading of multiple objects or light setups. The window presents three options in a 
dropdown:

Load from Scene - As with the previous Load Items from Scene, but this method allows multiples of the items 
chosen to be loaded
Load Single Object - Opens a requester for loading an object. The quantity selected in the How Many? field will 
be loaded.
Load Light Scene - Loads a scene with a light set up ready. It will also load nulls for controls.

Recent Scenes

Gives a dropdown with the most recently-opened scenes.

Revert Scene to Last Saved
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1.

2.

This option will close the current scene and re-open it from the last saved version. Very handy as an ultimate undo.

Set Content Directory...

(default keyboard shortcut Alt F12)

Allows you to set a Content Directory when starting a new scene. When loading a scene, a change to the scene's content 
directory is proposed (and should normally be agreed to).

Recent Content Directories

Shows a short list of recent content directories used. Loading a recent scene will switch automatically to the content 
directory used.

Load Object...

(default keyboard shortcut Num +)

When you set up a new scene, you will need to load the appropriate objects into the scene. Use Load Object (File > Load 
> Load Object or the shortcut +) to add objects to your scene.

To load an object file into a scene:

If the object you wish to load is in your current content directory, then it will load with any accompanying 
images without a problem. If the object is from outside your content directory there are two main options. If the 
object has no accompanying images, then loading it from elsewhere won’t pose a problem anyway, but you 
should copy the object into your current content directory’s Objects folder. If it has accompanying images, these 
should go in the Images folder of the current content directory. You can perform all these steps by using Package 
Scene.
Select File > Load >  Load Object and use the file dialog to navigate to the desired object file. (Note: multiple 
objects may be loaded when more than one is selected in the file dialog.)

If the object contains multiple layers of geometry, each layer will be loaded as a separate editable item in Layout. An 
object is initially loaded so that its local Origin is at the global Origin and its local axes line up with the world axes.

Load Object Layer...

Choose File > Load >  Load Object Layer to load a specific layer from a multi-layer object. A dialog will appear allowing 
you to define which layer to load.

Replace with Object...

Selecting an object already in the scene makes this menu item available. It will replace the object selected with one 
chosen from a file requester with the same keyframes already assigned the scene object. This means that you can 
animate a low-polygon proxy object for speed and replace it with the high-polygon final object when ready to render.
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Replace with Layer...

As above, but for a single layer of an object.

Load Motion File...

Loads a motion cache file for an object. If you have baked a motion file in one of the formats supported (MDD, 
GeoCache, etc.) it can be loaded and applied to the currently selected object.

Import

A dropdown with Imports for:

Alembic Loader - Loads an Alembic scene file
FBX Import - Loads an FBX file. Can also be loaded with the standard Load Scene, or keyboard shortcut Ctrl O.
COLLADA Import - Loads a COLLADA file. Can also be loaded with the standard Load Scene, or keyboard 
shortcut Ctrl O.
MDD Multi-Loader - Loads cache files for multiple items. See the example.
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Layout Save Menu

Save

Save Scene...
(default keyboard shortcut S)

Saves the currently-loaded scene file.

Save Scene As...
(default keyboard shortcut Ctrl S)

Saves the currently-loaded scene with a new filename.

Save Scene Copy...
Saves the scene under a new name.

Save Scene Increment
(default keyboard shortcut Shift S)

Saves a version of the scene file. There is no requester and the scene filename is incremented with each increment - the 
first save will be scene_v001, then scene_v002 and so on.

Save Scene as Default
Saves the current scene as the default scene Layout will open with when started. If the Clear Scene to Default option is 
chosen in Preferences, this scene will be loaded.

Save All
(default keyboard shortcut Alt S)

Runs Save Scene and Save All Objects.

Save Current Object...
Saves the object selected in Layout.

Save Object Copy...
Saves the selected object with a new name.

Save Object Increment
Saves the selected object with an incremented name - object.lwo becomes object_v001.lwo and so on.

Save All Objects
Saves all scene objects.

Save Trans Object
Saves the currently selected object in its deformed state - if an object has changed in shape because of Stretching/
Scaling or using dynamics, etc. using Save Trans Object will save the object in that form. The new object is also saved 
relative to the origin.

Save Endomorph...

Saving the scene does not save the scene's objects. Any changes to Surfacing will not be saved with a Save 
Scene, only with an Object Save. Using Save All will perform a Save Scene followed by a Save All Objects.


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You can save the current “mix” of your morphs back into the endomorph by choosing File > Save >Save Endomorph. 
The morph will appear on a new “Miscellaneous” tab on MorphMixer. (Note that you may need to remove and then re-
add MorphMixer.) Don’t forget to save your object if you want to keep the new morph.

Save Current Light...
This will save a scene file containing the currently selected light and its properties.

Save Motion File...
Saves the current item's motion path as a file.

Package Scene
Export
Opens a submenu with:

Export COLLADA - Exports the scene as a DAE file.
Export FBX - Saves the current scene and objects, with their animation, in FBX format.

Export Alembic - Saves the current scene and objects, with their animation, in Alembic format.
MD Multi-Baker - Saves multiple MDD files.
Save 4.0/5.6/6.0/9.2/9.5 Scene... - Saves the scene in a format that can be understood by older versions of 
LightWave. Of course, items introduced in later versions will not be available, so exporting a v2018 scene with 
Instancing and Flocking will not contain those features if saved as a LightWave v 6.0 scene. A scene saved from 
2015 is a 9.5 scene.
Save LW2015 Object... - Saves the selected object in LWO2 format for use with previous versions of LightWave.
Export STL -Exports the currently selected object in STL format.
Export PLY - Exports the currently selected object in PLY format.
Export Scene as VRML97 - Exports the current scene in VRML97 format (mainly for color 3D printing).
Image List -This command will save a text file that contains a list of every image used in a scene and its location.
Example:
LightWave Image List
6769194: LW_Box_Front.tga E:\images\Endo_Sliders\LW_Box_Front.tga
6769195: LW_Box_Back.tga E:\images\Endo_Sliders\LW_Box_Back.tga
6769196: LW_Box_SideL.tga E:\images\Endo_Sliders\LW_Box_SideL.tga
6769197: LW_Box_SideR.tga E:\images\Endo_Sliders\LW_Box_SideR.tga

Clear Scene

Clear Scene - (File > Clear Scene) will remove all data from Layout and return Layout to its default setup. All unsaved 
data will be lost.

Load Commands

The important difference between loading an object directly versus loading from a scene lies in what is stored in an 
object file versus what is stored in a scene file. The object file contains only the object geometry and surface settings - 
what the object looks like in its most basic state. There is no movement information in an object file.

The FBX and Collada exporters do not export information associated with plug-ins, including plug-ins 
shipped with LightWave. In addition, image maps will get passed into the FBX only for Standard or 
Principled BSDF materials with images in a UV-mapped Color T slot or Image node. The Image Sampler 
node does not work for export.


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Movement information is saved in the scene file. However, this is not only movement in the normal sense, like moving 
an object from point A to point B, but also includes movement of the points in their positional relationship to each 
other.

Moving points can change the shape of an object, sometimes dramatically. However, generally, the number of points 
and polygons, as well as their relationship, remains the same.

Understanding object and scene files is fundamental to understanding LightWave.
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Layout Edit Menu

Undo/Redo

(Default keyboard shortcut Ctrl Z/Z)

Layout can undo and redo movement, rotation and scaling changes to the limit set in the General Options panel.

Edit Menu Layout...

(Default keyboard shortcut: Alt F10)

Edit Keyboard Shortcuts...

(Default keyboard shortcut: Alt F9)

Edit Plugins...

(Default keyboard shortcut: Alt F11)

General Options...

(Default keyboard shortcut: O)

Display Options...

(Default keyboard shortcut: D)

OpenGL Options...

Defaults Options...

Paths Options...

Color Space Options...

OBJ Options...

Navigation Options...

Schematic View Tools



LightWave 2020  –  LightWave 2020

Reference –  961

Schematic View Tools

This setting, found in Layout’s Edit menu, helps you organize the scene items when using the Schematic View.

You can set the Grid Size by typing an entry in the field or by using the sliders to the right of the entry field. Snap 
Selection to Grid will snap the selected items to the specified Grid Size. Snap Hierarchy to Grid is similar, but only works 
on the hierarchy from the selected root item. Snap All Items to Grid snaps everything.

If Move Parent is active, the parent will be repositioned along with the children. If inactive, only the children are moved.

The Tree View button will organize a hierarchy in a “tree” fashion. You must select the parent item before clicking the 
button.

The Skeleton View button will organize a hierarchy based on the positions of the items at frame 0, from the perspective 
set on the Projection pop-up menu. You must select the root item before clicking the button.
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Layout Help Menu

The Help menu (located in the upper left-hand side of the interface) gives you easy access to documentation, NewTek’s 
website, and LightWave 3D’s about box.

Web Based Help - Choosing Web Based Help will take you to this LightWave wiki (Default keyboard shortcut F1)
Submit a Bug Report / Submit a Feature Request - both of these entries will open the LightWave Feedback 
Agent

Enter License - Opens a window showing where a License.lwk file should be placed to license your copy of 
LightWave

About OpenGL... - Shows settings and capabilities for your video card

About LightWave 3D... - Choosing About LightWave 3D will display Layout's about box with information about 
the development team, as well as the Build number.

https://docs.lightwave3d.com/display/LW2019/Feedback
https://docs.lightwave3d.com/display/LW2019/Feedback
https://docs.lightwave3d.com/display/LW2019/Feedback
https://docs.lightwave3d.com/display/LW2019/Feedback
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• Check for Updates - Will check the LightWave3d.com website for updates to LightWave and present 
information:

https://lightwave3d.com
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Items Tab

Click here to expand Table of Contents...
Add

Null
Lights

Camera
Convert Powergons
Clone
Mirror
Array
Rectangular
Radial
Common

Replace
Rename
Replace

Add

Null

(default keyboard shortcut Ctrl-N)

The Null Object
Null objects are special objects that can be used for many different purposes in LightWave Nulls can act as a target or 
parent item for lights or cameras, or perhaps a handle to help in manipulating a group of objects. They are often used 
with object/bone hierarchies to group major components and with Inverse Kinematics to act as goals for items to reach 
for.


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Example of a character using Null objects for Inverse Kinematics and Proxy Items.
Null objects appear in the Layout window as six-pointed stars or jacks; however, they never render in an image. Null 
objects, like the camera and lights, will appear to grow or shrink in relation to objects as the grid size is changed. They 
can be moved, rotated, scaled, and so on, just like any regular object.

You can change the appearance of a Null object by applying “Item Shape” in the Add Custom Object list, within 
the Object Properties panel.


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3.

Null Objects with Item Shape Applied
To add a null object:

Select Items > Add Null (or hit Ctrl-N).
Enter the name you wish to use for the null object in the dialog that appears or accept the default name of 
“Null.”
If you would like to change the properties of the null click on Edit and the menu will expand.
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Shape - Determines the shape of the null. Standard is the default Star null
Axis - Determines the direction the null faces towards the positive axis
Filled - If this option is available and you select it, the item shape will be a solid color
Label - You can enter text which will be displayed in the viewports
Justification - If you enter text in the Label section, you can specify where on the null where to display that text
Draw Line To - Will draw a line from the null to the selected item
Selected Color - When the null is selected, this will be the color of the null
Unselected Color - When the null is not selected, this will be the color of the null
Text Color - If you have entered text, this will be the color of the text
Opacity - Determines the opacity of the null - whether it is transparent and see-through or solid

Null objects are created by LightWave on a scene-by-scene basis and are not real objects that can be saved to disk. They 
remain part of the scene file, however, and will reload with the scene.

Lights

Choose Items > Add > Lights and select the desired light type from the submenu. A dialog prompts you for a name when 
you add lights. Click OK to accept the default or type in the name you wish to use and click OK.

When there are multiple items of the same type with the same name, a numerical suffix is added automatically 
(e.g., Null (1), Null (2), etc.).


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Camera

You can add additional cameras by choosing Items > Add > Camera; however, only the Current Camera is used to render 
a scene. If you have more than one camera in the scene, use the Current Camera pop-up menu on the Camera 
Properties Panel (or Layout’s Current Item pop-up menu) to select the currently active camera. A dialog prompts you for 
a name when you add a Camera. Click OK to accept the default or type in the name you wish to use and click OK.

Convert Powergons

Powergons allow you to execute a short Layout command script, which is attached to selected polygons in Modeler. You 
can use this feature to quickly add, say, lights using polygons for positioning. Moreover, all of the lights properties can 
be defined as well.

Executing the Commands
Powergon commands that are attached in Modeler can be loaded into Layout. Then choose Items > Add > CVT 
Powergons. This executes any command scripts attached to the selected object.

Clone

This opens a submenu with four items:

Clone
(default keyboard shortcut Ctrl C)

If you want to duplicate an item that is already in your scene, you can just choose Items > Add > Clone > Clone. The new 
item will inherit all of the source items properties and motion. As such, this can be a real time saver.

Steps to cloning an item:

See Lights for more information

See Camera for more information

For more information about Powergons see Add/Edit PGons
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Select the item you would like to clone.

Choose Clone ( Items > Clone ) and input the number of clones you would like to create. Click OK.
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3. You should now have clones of your original object.

Clone Hierarchy
(default keyboard shortcut Shift Ctrl C)

If you want to duplicate an item and all of its children in a hierarchy that is already in your scene, you can just choose 
Items > Add > Clone > Clone Hierarchy. The new items will inherit all of the source items properties and motion. As such, 
this can be a real time saver.

The newly created Clone(s) will be located at the exact coordinates as the original so you will need to move 
them.


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Clone Instance
(default keyboard shortcut Alt-C)

This will create a null, with an Instancer, with an instance of the original object. The object in the scene will be called 
“<Original Object Name>_inst”. Very useful for placing instanced trees or cars in a scene for example.

Python Bake Instance
This will converted instanced geometry into real objects.. To use, select the original of the instanced objects and run 
this command.

The newly created Clone(s) will be located at the exact coordinates as the originals so you will need to move 
them.


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Mirror

(default keyboard shortcut Shift V)
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If you want to duplicate an item or group of items that are already in your scene, you can choose Items > Add > Mirror. 
This tool works in a very similar way to clone with one difference. Instead of duplicating the selected item(s) on top of 
themselves, Mirror gives you the option to mirror the selected items along the X, Y, or Z axis.

Steps for using Mirror in Layout:

Select the item or items you would like to duplicate.

Choose Mirror ( Items > Mirror ) and a dialog box will appear. Choose the Axis to Mirror on, you can choose an 
offset.
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3. Click OK.

Array

Array is a non-interactive tool that will create an array, rectangular or radial, of selected items.

Your original items and the mirrored ones will remain selected.
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Rectangular

The Total Counts at the top of the window represent the final object count in your array.
The Distances can be individually set as

Between - The distance between each member of the array
Multiply - the distance between the members of the array gets multiplied by the number from the original unit. 
That’s to say, the original item is item one, the second item in the array in a direction is item 2 and so on. The 
distances between arrayed items will be Item 2 at 4 m, item 3 at 6 m and so on.
Total - the arrayed item quantity will all fit in the distance entered.

Array cannot be undone, so the best way to use it is to save your scene and create the array. If it isn’t exactly as 
you’d like Revert Scene to Last Saved.


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Radial

Total Count - will be how many items are in the radial array.
Axis - will be around which axis the array will be created.
Rotation - Is how far in degrees you would like the radial array to go.
Clone Rotation - This can be set to either:

Normal - The cloned items are rotated so that they face “along” the line the are cloned on.
None - The clones maintain their original aspect.

Offset - This value gives an offset between clones based the Rotation Center values given.
Copy Center from - Allows you to use another scene item as the basis of your radial array. It is purely that item’s 
coordinates that are used. It is not otherwise implicated in the array.

Common

Random Position +/- - gives a random offset in the X,Y and Z dimensions to the positive and negative of the 
extent chosen to each item in the array.
Rotation +/- - gives a random rotation in the H, P and B dimensions to the positive and negative of the extent 
chosen to each item in the array.
Scale +/- - gives a random scale in the X, Y and Z dimensions to the positive and negative of the extent chosen to 
each item in the array.
Clone Hierarchy - For each item, its descendant(s) will also be copied.
Group Clones on Null - When the clones are created, they will all be parented to a null called Rectangular or 
Radial_Array_Group .

Replace

Rename

You can rename the current item, like cameras, bones, and lights, but not objects, using Items > Replace > Rename.

Replace

The commands found in the Items > Replace > Replace drop down menu let you replace the current object with another 
object, a layer from another object or a null object. You might use this feature to animate a very complex object by 
inserting a stand-in object with a low-polygon count and then replacing it when it is time to render.

Replacing a Multi-layer Object
When replacing a multi-layer object, select the first layer before replacing. The first layer will be replaced with the first 
layer from the new object file. Subsequent layers - belonging to the same original object - will be replaced if their layer 
numbers match those found in the new object file.

You can also use Items > Replace > Replace > With Layer to replace an object with a single layer from a multi-layered 
object. A dialog will appear to let you specify the layer.
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Graph Editor

Click here to expand Table of Contents...
Graph Editor Overview

Collapse buttons
Frame Range
The Time Slider
Panel Layout Adjustments
Using the Channel Bin
The Channels Pop-up

Editing Curves
Edit Mode Selection
To select curves for editing
To select/unselect keys for editing
To add keys to curves

Adding keys to curves
To delete keys from curves
Context Menu
To change key value/time
To scale selected keys
To roll a range of keys
To Zoom in and Out of the Graph Workspace
Copying Keys

Graph Editor: Adjusting the Curve Edit Window
Zooming and Panning

Graph Editor Toolbar

Graph Editor Overview

When you create keyframes for items, you specify a set of keys for the item’s animation channels (generally position, 
rotation, and scale, but also light intensity, etc.). The Graph Editor provides both a more global and more detailed way 
to alter the settings that govern an item’s animation channels. You have all of Layout’s keyframe editing capabilities, 
plus some others like dragging keyframes to different frames or graphically adjusting keyframe attributes. Use it to 
visually fine-tune or dramatically change an item’s animation characteristics.



The Graph Editor also controls all envelopes for options like light intensity, color, camera zoom, etc.
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Each Animation Channel is displayed on a two-dimensional graph. Time is constant along the bottom, and the Channel 
value or setting is equal to the vertical position. Because time is constant, you can visually judge things like where an 
item slows down or speeds up based on the slope of the curve. The Graph Editor is a great way to identify and fix those 
annoying hiccups, which can occur from time to time in what should be a smooth animation.

The Graph Editor has four major interface areas: the Channel (Curve) bin, the Curve Edit Window, the Curve/Expressions 
controls, and the Scene/Expressions list.

You can click the Collapse buttons to hide the left side and bottom areas of the panel to increase the screen real estate 
used by the Curve Edit window. When the left side is collapsed, the primary selected curve is shown in the information 
field.
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Collapse buttons

Collapse Trees Active
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Collapse Tabs Active

Collapse Trees and Tabs Active

Frame Range

If frames outside the range of frames in your scene (i.e., less than your first frame or greater than your last frame) are 
visible in the Curve Edit Window, those areas will be slightly darkened. There will also be a small handle at the very 
bottom of each border. You can drag these to interactively adjust your scene’s first and last frame.
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Start and Last Frame handles

The Time Slider

You can grab the time slider in the Curve Edit Window by its base and drag to change Layout’s current frame. The 
current frame is displayed below the slider handle.

Clicking at the bottom of the graph - where the frame slider handle would be - moves the frame slider to that frame.

Panel Layout Adjustments

You can drag the border between the Scene list and Channel Bin, and between the Channel Bin and Curve Edit Window 
to change the spacing between the two sides (if the Graph Editor is not at its minimum overall size).

Using the Channel Bin

When you first open the Graph Editor, the Channel Bin displays the appropriate curves for the currently selected item. 
The Channel Bin is merely a repository to show you which curves are available for display and edit. Deleting curves from 
this window will not affect your scene. This system makes it very simple to edit multiple curves from several different 
items.

To replace/add channels to the Channel Bin:

Locate the desired item in the Scene list.
Double-click on an individual channel or an item name (for all its channels). This will replace any existing 
channels in the bin. To add the channels to the Channel Bin hold the Shift key as you double click on an item or 
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its channels, or drag it into the bin. If you use the drag method, you can drag multiple channels/items into the 
bin by selecting multiple items in the Scene list (Shift key for range and Ctrl for non-contiguous selection).

To remove channels from the bin, select them and hit Shift D. Once you add channels to the bin, you can rearrange 
their order by dragging and dropping.

The Channels Pop-up

The Channels pop-up menu, above the Channel Bin, has a few functions. You may select Filter to filter out channels 
from the Channel Bin that do not match a pattern. The pattern is case sensitive. *.Position.* would remove any channel 
that wasn’t a Position channel. You could use *.Y to show only Y channels.

Choose Create Favorite Set… to manage curve sets. It lets you create sets of editable curves so that you can easily 
switch between different combinations of curves to manipulate during a session. To create a favorites entry:

Make sure the desired curves appear in the Channel Bin.
Select Create Favorite Set… from the Channels pop-up menu.
Enter an appropriate name in the input field that appears and click OK.

You can revert to any saved favorite set of curves by selecting it from the bottom of the Channels pop-up menu.

Choosing Replace Favorite Set… lets you replace an existing favorite set with the curves currently in the bin. Choosing 
Delete Favorite Set… lets you remove an existing favorite set from the Channels pop-up menu.

Editing Curves

With the Graph Editor, you can easily edit multiple curves simultaneously or use curves from different items as 
references. Since you can mix curves of different types in the bin, you can do interesting things like compare the curve 
of light intensity with the X position of an object - any curve in LightWave can be compared or edited together!
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You can interactively cut and paste key frames from one curve to another as well as simply replace an entire curve. This 
is also a good way to lock areas of curves together. By selecting multiple curves when you create keys the curves can be 
identical at those segments of the animation. If you put your cursor over a key you will see a data label pop up to inform 
you of that point’s Curve, Value, and Frame.

A Key’s Data Label

Edit Mode Selection

You can select from the edit modes by clicking one of the buttons beneath the Curve Edit window. From left to right, the 
mode buttons are Move, Add, Stretch, Roll, and Zoom. Pressing your Spacebar cycles you through the modes.

The information display, just to the right of the buttons, will display the name of the selected mode button, the shortcut 
key, and mouse operation information.
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To select curves for editing

Click on the channels in the Channel Bin to select their curves for editing. (Hold the Shift key for range and Ctrl for non-
contiguous selection). Selected curves will become highlighted, but unselected curves will still be visible as a reference. 
You can also Alt+RMB on a curve in the Curve Edit window to make it the (only) selected curve. Use Alt+Shift+RMB to 
add the curve to the current curve selection.

Your keyboard up and down arrow keys will cycle the selected key through the curves in the curve bin. Hold the Shift
key as you press the cursor keys to increase or decrease the curves selected.

When multiple curves are selected, one will be the “primary” selected curve, and its selection color will be a little 
brighter. Some commands, like Fit Values by Type, use the primary selected curve when more than one is selected.

To select/unselect keys for editing

In Move mode, select keys by clicking on them with your LMB. In any mode, except Roll, you can drag out a bounding 
box with your RMB. This will toggle the state of the bounded group of keys. To add to or subtract from a selection, hold 
the Shift key. To deselect all selected keys, just right click in the graph. To select all, Shift+double-click.

If only a single key is selected, you can use your keyboard left and right arrow keys to cycle the selection of keys along 
curves.

To add keys to curves

Select the channel curve(s).
Click the Add Mode button, or press the keyboard shortcut + .

Click on the graph at the desired frame (horizontal) and value (vertical) position. Before you release the mouse 
button, you can drag up and down to adjust the value. Hold the Ctrl key to adjust the frame.
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Adding keys to curves

You can double click on an existing active curve to add a key where you click while in Move mode. The cursor will have 
extra lines added to it when in a good position, as shown.

To delete keys from curves

Select the channel curve(s) and then the key(s).
Press the Delete key.

In the Add mode, you can delete keys with Ctrl + LMB.
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Context Menu

Right-clicking on a key in the Graph Editor and right-clicking a Color key
You can right-click on keys in a graph and see a context menu that presents several options:

Key Locked - toggle for locking a key. Only one key will be locked even if multiple are selected
Copy / Paste Key Value - Allows you to copy the values assigned to a key and paste them to a different key
Ease In/Out - Sets the Tension to 1.0 on all selected keys
Incoming Curve Type - Converts selected key to the curve type requested between TCB, Hermite, Bezier, Linear, 
and Stepped spline types. Does not work with multi-select
Open Color Picker - This entry only appears when you are editing a color graph. Changing the color applies to 
all three keys (RGB).
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To change key value/time

Select the key(s) and click the Move Mode button (or press the keyboard shortcut T).

Drag with your LMB to change the value. Hold the Ctrl key to change time.

To scale selected keys

Select the key(s) and click the Stretch Mode button, or use the keyboard shortcut H.

Place your mouse pointer at the position you want to use as the center of the scaling.
Drag using your LMB to scale value. Hold the Ctrl key to scale time.

To roll a range of keys

Select the Roll mode or use the shortcut Y.

Drag out the time range using your RMB.
Drag your LMB to roll the keys-as keys go past the end of the range, they reappear at the other end of the range.

To Zoom in and Out of the Graph Workspace

Select the Zoom tool

Drag your Left Mouse button and drag a bounding box in the area you want to magnify.

Right Click to Zoom out. You can also use the Magnifying Glass icon at the top right of the Graph Editor, or the 
normal keyboard shortcut of Ctrl+Alt+LMB to interactively zoom in and out (or the scroll wheel).



LightWave 2020  –  LightWave 2020

Reference –  989

1.
2.

3.

Copying Keys

You can copy keys using your mouse or keyboard.

To copy selected keys with a mouse:

Select the keys for editing. Any mode except Roll can be used. Drag using Ctrl + RMB .
When you copy a single curve, an insertion point marker (and paste time display) will appear as your pointer 
moves over the curve. Release the mouse button to insert. Move your pointer off the curve to abort the paste.
When you copy multiple curves, color-coded insertion marks will appear. With your mouse pointer not directly 
over a curve, release to paste. Selected keys may be on different curves, but they can be copied only onto the 
same curve.

See also the Copy Time Slice command (Keys > Copy Time Slice), page PDF_LINK

Graph Editor: Adjusting the Curve Edit Window

Like other LightWave viewports, you can pan around the graph by holding the Alt key as you drag around the Curve Edit 
Window. Alternatively, you can use the drag-window drag button in the upper-right corner. You can change the zoom by 
holding Ctrl+Alt while you drag or by dragging on the zoom-window drag button in the upper-right corner.

Zooming and Panning

The Zoom Box tool button is the right-most Mode button. Click it and you can drag out a box on the graph and zoom in 
on that area.

You can get a 2X zoom out by clicking your RMB with the Zoom Box tool selected. The zoom out will be centered at the 
point you click.

If you have a mouse wheel, scrolling it over the Curve Edit window will affect the zoom. Hold the Ctrl key to pan 
horizontally and use Ctrl+Alt to pan vertically.

Graph Editor Toolbar

Existing keys will be shifted over if you paste in more than one key (unless the Insert Overwrites Keys option is 
enabled).


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Graph Editor Toolbar

Click here to expand Table of Contents...
Toolbar Selection Menu
Toolbar Keys Menu
Toolbar Footprints Menu
Toolbar Autofit Menu
Toolbar Display Menu
Graph Editor Options
Undo
Cancel Changes
Channel Bin Pop-up Menu
Curve Edit Window Pop-up Menu
Key Pop-up Menu
Graph Editor - Editing Color Channels
Graph Editor: Curves Tab

Multiple Values
Pre and Post Behaviors

Incoming Curves
TCB Spline
Interactive TCB Adjustments
Hermite Spline
Bezier Spline
Linear
Stepped Transition
Dual-handled Control Points

Graph Editor: Expressions Tab
Graph Editor: Modifier Tab

Channel Motion Modifiers
AudioChannel
BoosterLink
ChannelFollower
Cycler
Expressions
FX_Clink
FX_Link
Dissolving an object based on particle life
Controlling a channel based on the number of particles
LScript and LScript/RT
MM (Motion Mixer) Channel Driver
NoisyChannel
Oscillator
Proximity
Python
Python Noisy Channel
RelChanneler


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SetDrivenKey
Textured Channel
Virtual Studio Trait

The Toolbar contains a slew of commands for the Graph Editor. Many of these are also available on the various Curve 
Bin and Curve Edit Window pop-up menus, described later.

Toolbar Selection Menu

The Selection menu contains commands that affect curves in the Curve Bin.

Add Layout Selected (default keyboard shortcut L) - This command will add the channels for the currently 
selected item(s) in Layout to the Channel Bin.
Get Layout Selected (default keyboard shortcut Shift G) - This command will replace the contents of the Channel 
Bin with the channels for the currently selected item(s) in Layout.
Clear Unselected Channels (default keyboard shortcut X) - This command will remove any unselected curves 
from the Channel Bin.
Clear Channel Bin (default keyboard shortcut Shift X) - This command will empty the Channel Bin.
Remove Channel from Bin (default keyboard shortcut Shift D) - This command will remove all selected curves 
from the Channel Bin.
Invert Channel Section (default keyboard shortcut I) - This command will invert the selection state of curves in 
the Channel Bin.
Select All Curves in Bin (default keyboard shortcut Ctrl Up) - This command selects all of the curves in the 
Channel Bin.
Reset Bin Selection (default keyboard shortcut Ctrl Down) - This command leaves only the first curve in the 
Channel Bin selected.
Filter Curves (default keyboard shortcut W) - Use this command to filter out channels from the Channel Bin that 
do not match a pattern. The pattern is case sensitive. *.Position.* would remove any channel that wasn’t a 
Position channel. You could use *.Y to show only Y channels.
Filter Position Channels (default keyboard shortcut !) - Use this to filter out everything but Position channels 
from the Channel Bin.
Filter Rotation Channels (default keyboard shortcut @) - Use this to filter out everything but Rotation channels 
from the Channel Bin.
Filter Scale Channels (default keyboard shortcut #) - Use this to filter out everything but Scale channels from the 
Channel Bin.

Toolbar Keys Menu

The Keys menu contains commands that manipulate the selection, creation, deletion, frame setting, and value of keys.

Create Key (default keyboard shortcut Return) - This allows you to create a key, Layout-style. A dialog will appear 
where you can enter the Frame and Value.
Delete Selected Keys (default keyboard shortcut Delete) - This command will delete any selected keys.
Lock Selected Keys (default keyboard shortcut Shift L) - This locks the selected keys so they are uneditable. 
Locked keys are grey.
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Unlock Selected Keys (default keyboard shortcut Shift K) - Unlocks selected keys.
Invert Selected Keys (default keyboard shortcut Shift I) - This flips the order of selected keys in time.
Snap Keys to Frames (default keyboard shortcut Q) - This command causes every selected key that falls on a 
fractional frame to snap to the nearest whole frame.
Set Key Values (default keyboard shortcut =) - This command will bring up a dialog where you can enter a new 
Value for the selected keys.
Bake Selected Curves (default keyboard shortcut B) - This “bakes” the state of selected curves by creating keys 
at every frame. Curves do not necessarily need to be affected by a Modifier, but their effects will be taken into 
account.
Copy Time Slice (default keyboard shortcut Ctrl C) - You can copy values of selected curves at the current frame 
(even if there are no existing source keys) and paste them elsewhere. This command will copy the values. These 
values may be pasted at any frame with Paste Time Slice, but only onto the same curve(s).
Copy Footprint Time Slice (default keyboard shortcut Ctrl X) - This works like Copy Time Slice, but uses the 
value(s) from the curve’s footprint instead of the actual curve. Use Paste Time Slice to paste.
Paste Time Slice (default keyboard shortcut Ctrl V) - Pastes in values copied with Copy Time Slice or Copy 
Footprint Time Slice at the current frame. Keys will be created (or modified, if they already exist) at the new 
frame with the new values.
Match Footprint Time Slice (default keyboard shortcut Ctrl B) - This creates a key on the curve that matches the 
footprint value at the current time. Essentially, it is the same as doing a Copy Footprint Time Slice operation and 
immediate paste.
Copy Selected Keys (default keyboard shortcut C) - This copies selected keys to a memory buffer. To paste the 
buffer, you must have your mouse pointer over a curve and use the Paste Keys command on the Curve Edit 
Window pop-up menu (Ctrl+Shift+LMB), discussed later.
Add to Key Bin (default keyboard shortcut K) - This creates a named set of keys that you can insert into a curve 
later. To paste the set, you must have your mouse pointer over a curve and use the Insert From Bin item on the 
Curve Edit Window pop-up menu (Ctrl+Shift+LMB), discussed later.
Numeric Move (default keyboard shortcut Shift T) - With this command, you can shift the selected keys. Frame 
Offset is the number of frames to use for the shift. Value Offset is a number to add to or subtract from the value 
for each keyframe.
Numeric Scale (default keyboard shortcut Shift H) - This command lets you scale the key times and values for 
selected keys. A Time Scale Factor of 1 means no change. A value of 2 would double the time, and .5 would halve 
it. The Time Scale Origin is the center of the scaling. Thus, if you place this at one selected key, the scaling will 
happen around it and not affect that particular key. This setting uses the units displayed on the graph. Value 
Scale Factor and Value Scale Origin work similarly, except they change the selected key values.
Roll Keys Left (default keyboard shortcut [) - Shifts the values of the selected keys to the left without affecting 
their time. This command works only with contiguously selected keys.
Roll Keys Right (default keyboard shortcut ]) - Shifts the values of the selected keys to the right without affecting 
their time. This command works only with contiguously selected keys.
Reduce Keys (default keyboard shortcut - ) - The Reduce functions let you remove consecutive keys that are 
within a certain threshold value of one another. The threshold is set by selecting Set Key Reduction Threshold.

There are two modes: Reduce Keys and Reduce Keys ( Recursive), whose default keyboard shortcut is _. As an 
example, assume consecutive keys A B C D E all have values within the threshold. Choosing Reduce Keys would 
remove keys leaving A C E. Selecting Reduce Keys again would leave A E, and a final Reduce Keys would leave 
only A. Reduce Keys (Recursive) would go directly from A B C D E to A in one step.

If you set the threshold to a negative number, Reduce Keys will eliminate every other key. Reduce Keys 
(Recursive) will remove all but the first key.
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Toolbar Footprints Menu

The Footprints feature lets you create an imprint of the current curve(s) to use as a reference and as a state you can 
revert back to.

Leave Footprint (default keyboard shortcut Shift F) - Creates the imprint that will be visible as a shade of the real 
curve’s color (once you make a change).
Pickup Footprint (default keyboard shortcut Shift R) - Erases the footprint for the current curve(s).
Backtrack Footprint (default keyboard shortcut Shift B) - Will restore the curve to its footprinted state.

Toolbar Autofit Menu

This group of commands affect the range of frames and values shown in the Curve Edit Window.

Autofit (default keyboard shortcut A) - You can automatically scale the graph display to show all of the selected 
curves with this command.
Autofit Selected (default keyboard shortcut Shift A) - You can automatically scale the graph display to show all 
of the selected keys with this command.
Autofit By Type (default keyboard shortcut Ctrl A) - Autofit By Type will scale the graph to fit the values for the 
primary selected curve’s type (i.e. position, rotation, scale, and so on).
Fit Values By Type (default keyboard shortcut Ctrl F) - This works like Autofit By Type, but only scales the graph 
vertically, retaining the current frame range.

Toolbar Display Menu

The Display menu contains commands that affect the graph display, as well as global options.

Numeric Limits (default keyboard shortcut Shift N) - This will display a small dialog. The Min Frame and Max 
Frame values set the range of frames you want to see on the graph. The Min Value determines the value of the 
bottom boundary of the graph and the Max Value sets the upper boundary.
Go To Frame (default keyboard shortcut F) - This action sets the current frame to the entered value. It also 
centers the Curve Edit Window around that frame.
Center Graph (default keyboard shortcut G) - Centers the graph on the current mouse position.
Reset Graph (default keyboard shortcut /) - This simply resets the graph to default frame and value ranges.
Edit Keyboard Shortcuts (default keyboard shortcut Alt F9) - This command will bring up the standard Configure 
Keys Panel. However, it will list shortcuts for the Graph Editor. (Note that the Window pop-up menu will be set to 
Graph Editor.) 
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Edit Menu Layout   (default keyboard shortcut Alt F10) - The Graph Editor has its own set of menus. These can be 
customized using the normal Configuring Menus Panel. (Note that you are editing the Graph Editor menus when 
Graph Editor is selected in the Window pop-up menu on the Configuring Menus Panel.)

Beneath the Main Menu group is the Graph Editor group. This is the group used for the Graph Editor’s toolbar. It 
can contain its own group for pull-down style menus. In the Popup Menu group are the commands that will 
appear when you press Ctrl+Shift+ LMB over the Curve Edit window.

Insert Overwrites Keys (default keyboard shortcut `) - Normally, when you paste in more than one key, existing 
keys may be shifted over. Enable this option to replace the paste range and not shift over keys.
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Filter Static Envelopes (default keyboard shortcut numpad 1) - This option will keep envelopes that have fewer 
than two keys from being displayed in the Channel Bin when selecting groups (both from the scene list, as well 
as from other Layout panels.)
Large Autosize Margins (default keyboard shortcut numpad 2) - This option will add an extra amount of outside 
space when you use autofit commands.
Allow Fractional Keyframes (default keyboard shortcut numpad 3) - This option keeps frame adjustments to 
whole numbers. This is linked to Layout’s Allow Fractional Current Frame setting (General Options Tab of the 
Preferences Panel).
Lazy Layout Update (default keyboard shortcut numpad 4) - When active, the Graph Editor will not update in 
Layout until after you release the mouse button. This can allow smoother adjustments in complex situations. 
When inactive, Layout will update as you make adjustments.
Track Layout Time (default keyboard shortcut numpad 5) - This option will scroll the Curve Edit window to keep 
the frame slider centerd. This is useful for watching the curves scroll by as Layout is playing.
Allow Passthrough Keys (default keyboard shortcut numpad 6) - This option lets you drag keys through each 
other in time. Normally, you stop at a neighboring key.
Lock Motion Keys in Time (default keyboard shortcut numpad 7) - This option causes keys to be created for all 
motion channels of the selected channel(s). Only Position, Rotation and Scale channels are affected. For 
example, Position.Y, Position.Z, Rotation.H, etc. would all be affected if Position.X was selected.)
Move No Keys Sel (default keyboard shortcut numpad 8) - By default, if no keys are selected, no editing will 
occur when using tools like Move or Stretch. Activate this option to change this so that all keys are considered 
selected when none are selected (like in Modeler).
Track Item Selections (default keyboard shortcut numpad 9) - This is a mode that will automatically bring the 
channels for the currently selected Layout item into the Graph Editor.
Fit Values when Selected (default keyboard shortcut numpad 0) - When this option is active, your view will 
automatically fit the values of the selected curve. This will not affect the visible range of frames, however.
Show Modifiers - Activate this to always make the modified curve (i.e., after the effects of motion Modifier 
plugins) visible as a dotted line.
Show Tangents - This command will activate or deactivate tangent handle display.
Center Speed Curves - Keeps the speed curves in the center of the Graph Editor display.
Antialias Curves - This command will activate or deactivate the feature that smooths the display of curves.

Show Key Info - This turns the pop-up display of key information off or on. This appears when your mouse 
pointer is directly over a key.
Hide Background Curves - Normally, non-selected curves in the Curve Bin are visible in the graph. This display 
option will toggle their visibility state.
Large Keyframe Points - Activate this option to increase the display size of keys.
Custom Point Color - This turns on the user-defined (unselected) point color. Selected points are always yellow.
Collapse/Show All (default keyboard shortcut F5) - This collapses or shows the Tabs and Trees areas of the 
Graph Editor.
Collapse/Show Tabs (default keyboard shortcut F6) - This is the same as clicking the Collapse Tabs button.
Collapse/Show Trees (default keyboard shortcut F7) - This is the same as clicking the Collapse Trees button.

Graph Editor Options

(default keyboard shortcut O)

If you are working with a lot of curves and keys, turning off the Antialias Curves and Show Tangents options 
can help speed up display refreshing.


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Most of the options on this panel can also be set from the Display menu and have been described previously. There are 
a few that can only be set here, however. On the General Tab, you can change the Default Incoming Curve. On the 
Display Tab, you can set the color used when the Custom Point Color option is active.
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Undo Last Action (default keyboard shortcut Ctrl Z). Use this command for a single level undo/redo of the last edit.

Cancel Changes

(default keyboard shortcut Shift U)

This command restores all envelopes to their state at the time the Graph Editor Panel was last activated (i.e., making it 
the top window).

Channel Bin Pop-up Menu

The Channel Bin has a pop-up menu that appears when you right-click a curve:

Replace… - Used to load a curve from a file
Save… - Saves a single curve to a file
Copy - Copies the curve under your mouse pointer when you open the menu to the curve memory buffer
Paste  - Pastes the curve stored in the memory buffer. Your mouse pointer must be over the curve you wish to 
replace before you open the menu
Remove from Bin - Removes the selected curve(s) from the Channel Bin
Footprints  - See Footprints
Show Velocity  - Adds a non-editable background curve representing the velocity of the selected curve. Velocity 
is defined as the time rate of change for a single curve including a vector. In other words, a velocity curve 
describes how much the value of the current single channel changed at that time

Also see the Footprints feature
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Show Speed  - Adds a non-editable background curve representing the speed of the current curve. Speed is 
defined as the magnitude of the velocity vector. This means the Speed curve represents the time rate of change 
of all three position, rotation, or scale curves
Show Modified - If the Show Modifiers option (Display menu) is active and your curve is being modified, from a 
modifier plugin for instance, this will let you see the actual modified motion curve
Append to Expression - This command will place the selected channel in the expression field. This is handy and 
will save you from having to type out channel names when creating expressions

Curve Edit Window Pop-up Menu

Another pop-up menu is available when you work in the Curve Edit Window. It appears when you Ctrl+Shift+LMB click 
over the graph. This gives you quick access to many commonly used commands.

Most of the commands have been discussed; however, some only appear on this menu because they require your 
mouse pointer to be directly over a curve.

Copy Selected Keys - This copies selected keys to a memory buffer
Paste Keys - Inserts the keys stored in a memory buffer with the Copy Selected Keys command- existing keys 
may be moved over if the buffer has multiple keys. Your mouse pointer must be over the pasting point on a curve 
before opening the menu (pointer will highlight)
Add to Key Bin - Creates named set of keys that you can insert into a curve later
Insert - Works like Paste Keys, but gets data from a specified key set
Options - Displays the Graph Editor Options Panel
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Key Pop-up Menu

Another contextual pop-up is available when you work in the Curve Edit Window. It appears when you right-click 
directly over a key - the operations affect that key only.

Key Locked - Locks/unlocks the key so it is uneditable; locked keys are gray when selected, black when not
Copy Key Value - Copies the key value to memory buffer
Paste Key Value - Pastes the value stored in memory to the key
Ease In/Out - Sets the Incoming Curve for the key to TCB Spline and sets the Tension to 1
Incoming Curves - Quickly change the Incoming Curve type for the key by selecting it from the list at the bottom 
of the menu

Graph Editor - Editing Color Channels

You can also animate color channels. If you add an envelope for, say, a surface color, you can edit the related RGB 
channels on the Graph Editor.

Clicking the Color Envelope Button in the Surface Editor

When a color channel is selected in the Channel Bin, a color bar will appear at the bottom of the graph. The bar shows 
you the color for the combined red, green, and blue values at any particular point in time-even if you don’t have all 
three color components in the bin.

Other customizable menus will appear when you Ctrl+Shift+RMB and Ctrl+Shift+MMB .
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You can use a color requester to set the key values by right-clicking on a key and selecting Open Color Picker. Note that 
the selected color will only set the color component for the selected channel(s). If other channels are selected, keys will 
be created as needed.

Graph Editor: Curves Tab

The Curves Tab in the Curve Controls area contains specific values for a selected key(s). The Frame field contains the 
frame number and the Value field holds the related value.

You can adjust any color channel beyond the normal maximum and minimum - creating a high dynamic range 
color. This may have no visible effect on the color bar, but could affect how the color is interpreted by other 
factors.


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Multiple Values

If you select multiple keys, input fields will show (mixed) if the keys have different settings. You can still edit the fields, 
which will change all selected keys to match the entered value. You can use this method to flatten a portion of a 
curve(s) or to match key times across multiple curves.

Pre and Post Behaviors

The Pre Behavior setting determines what happens before the first keyframe. The Post Behaviour determines what 
happens after the last keyframe. The available settings are:
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With Reset, the motion value is reset to zero.

With Constant, the values beyond the ends are constant, that is, equal to the first or last keyframe value.

With Repeat, the motion repeats from the first to last keyframe.
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With Oscillate, the motion is mirrored over and over.

With Offset Repeat, the motion repeats, but it is offset by the difference between the first and last keyframe values.
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With Linear, the curve receives a linear angle consistent with the angle at the start or end points.

Incoming Curves

The type of curve that precedes a key can be set using the Incoming Curve pop-up menu.

TCB Spline

TCB Spline (Tension, Continuity and Bias) curves have three controls that determine the shape of a curve as it passes 
through a key.
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Tension causes an object in motion to slow down, or move a little bit less in each frame, as it nears the keyframe, and to 
accelerate as it passes the keyframe (-1 = low tension, 0 = normal tension, 1 = high tension). Without Tension (i.e., value 
of 0), the object would pass through the keyframe position at a constant speed. Positive values slow an item through a 
keyframe (ease-in) while negative values speed it up (ease-out).

Tension –1

Tension 0
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Tension 1
A high Tension value (1.0) is often used at the end of a flying logo move in order to make the logo come to a gradual 
stop. High Tension at the beginning of this move would make the logo start slowly, while a negative value would make 
the logo start quickly.

Continuity accentuates a break or change in an object’s graph (-1 = sharp , 0 = normal , 1 = smooth). Negative Continuity 
gives a sharper transition in the spline path at a keyframe, while positive Continuity gives a broader transition 
(sometimes over-continuous) through a keyframe. Negative Continuity is usually used to replicate a sharp change in 
motion such as that of a falling ball striking a floor and quickly reversing direction.

If you right-click on a key, choosing Ease In/Out from the pop-up menu will set the Tension to 1 for all selected 
keys using TCB Spline.


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Continuity –1

Continuity 0
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Continuity 1
You would rarely want to use a positive continuity - this will cause an object to overcompensate as it passes through the 
keyframe and appear to stutter or roller coaster at the frame.

Bias determines whether an item’s spline path leans to one side of a keyframe or the other (-1 = more slack incoming, 0 
= equal slack, 1 = more slack outgoing). You accomplish this effect by moving the slack in the spline path to one side or 
the other of a keyframe. This serves to accentuate motion - the incoming motion by undershooting the keyframe and 
creating a feeling of anticipation, or the outgoing motion by overshooting the keyframe. For example, a racing car 
moving through a turn could use either a negative or a positive Bias setting to a) anticipate the turn with a negative 
Bias, or b) overshoot the turn with a positive Bias.

Negative Bias values place the slack before the keyframe while positive Bias values place it after the keyframe.
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Bias -1

Bias 0
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Bias 1

Interactive TCB Adjustments

You can interactively adjust TCB keys with your mouse. Simply press F1 for tension, F2 for continuity, or F3 for bias and 
then drag your mouse left to decrease or right to increase the value. You will see a small indicator in the lower-left 
corner of the graph.

This only works in the Move Edit Mode and for the first mouse drag. The tool stops when you release the mouse button.

Hermite Spline

If you use Hermite Spline, a tangent control handle will appear, emanating left from the key. This type of curve is an 
extension of the standard TCB Spline, but allows a wider range of results. Drag the handle (at the end) up or down to 
change the angle of the tangent and thus the shape of the curve.
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Bezier Spline

Splines using Bezier Spline operate like bezier curves do in many industry-standard paint and illustration packages. 
When you create a key, you must drag before releasing your mouse button to edit the handles. Otherwise, bezier keys 
have handles that coincide with the key. For an existing key, select it and then click-drag on it to pull out the handles.

 
Drag the handles to change the angle of the tangent and thus the shape of the curve. If you are curious, Bezier splines 
are indeed a variant of Hermite splines, and thus the results will be very similar.

Linear

Linear removes the gradual, smooth nature of a spline curve change and replaces it with more direct, sudden change. 
Linear affects the changes between the current keyframe to the previous keyframe only. By turning Linear on or off at 
different keyframes, graphs may contain both gradual and sudden changes.

Note that TCB Splines generally limit you to more realistic results.

Bezier curves were developed by Pierre Bézier for designing Renault automobile bodies.
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Stepped Transition

Stepped transition holds the preceding keyframe value and then abruptly jumps to the next keyframe value at that 
frame.

Dual-handled Control Points

When a Hermite or Bezier (incoming curve) key is followed by another key with the same incoming curve type, the 
(outgoing) tangent on the right side will affect the outgoing curve as well. Normally, the outgoing tangent will be unified 
with the incoming tangent. That is, they will operate as though there is only one tangent.

You can break the tangents, that is, make them operate separately by holding the Alt key and then dragging either side.

To reunite the tangents, just double-click on either control handle. The opposite side will line back up.

Graph Editor: Expressions Tab

Expressions are detailed here: Expressions
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Graph Editor: Modifier Tab

Channel Motion Modifiers

Channel motion modifiers are added on the Modifiers Tab of the Graph Editor. These modifiers control the motion at 
the channel level, as opposed to the (scene) item level, where motion is handled by item motion modifiers.

 
To use a channel motion modifier, select the target curve in the Graph Editor’s Channel Bin. Then select the modifier 
from the Add Modifier pop-up menu on the Modifier Tab. Once added, click on its name in the list to access its settings, 
if any. Channels with modifiers will have a small dot to the left of their names in the Channel Bin.

AudioChannel

The AudioChannel modifier modifies a curve based on an audio file.

 
Click the Name button to select the audio file you want to use. The Value Offset lets you move the entire motion up or 

Modifiers that do not have an explicit additive option are generally additive in nature.

Also see the MasterChannel Scene Master plugins. This lets you create custom user-defined channels.
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down. (The units are the ones used on the graph.) Waveform Scale is a multiplier. Thus, a value of 1 will have no effect. A 
value of 2 will double the values of the effect and .5 will halve it. Use the Start Time to enter a frame number when the 
audio should begin. The Filter Strength value will determine the sampling frequency used to convert the audio into a 
curve. A higher value will cause the curve to more closely follow the contours of the audio’s sound wave.

BoosterLink

IK Booster Link can be used to link a channel from one controller to a channel in another controller. The Linked 
controller can be driven by the referenced control. This is very similar to how expressions can be used without writing 
any expressions.

ChannelFollower

Using Channel Follower (aka Set Driven Key) is similar to parenting an object to another, except that you have control 
over which motion channels you wish to inherit. You can also modify and delay the inherited value. Moreover, the 
motion can be inherited from the camera, a light, a bone, or any object in the scene.

 
Select the channel you wish to follow from the Channels list window.
The amount of seconds entered into the Time Lag field is added to the current time. This number may be negative.

The value can be scaled by inputting a factor other than 100% in the corresponding Scale field.

The Start Frame and End Frame parameters specify when the modifier is applied.

Cycler

This is a channel-oriented version of the Cyclist item motion modifier.

See the IK Booster section for more information.
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Select the controlling channel in the Channels list window. The Controller Low Value and Controller High Value settings 
define how much change is required to equal one full animation cycle. The unit of measure for this parameter depends 
on the selected control channel.

Expressions

Expressions are an advanced LightWave 3D feature that uses mathematical formulas to modify the value of any 
animation channel. Expressions let you make the motion of scene items dependent on other item motions or factors in 
a scene. You could, for example, force an object to stay between two other objects, keep feet from going through the 
floor, or even control the entire posture of a character based on its feet! The possibilities are endless.

 
The Expressions Panel has four buttons: Copy, Paste, Load and Save. The Copy and Paste functions work on a per-
screen basis - if you type in your full expression, you may click on Copy, open another channel up, and then click on 
Paste and the entire expression is pasted in, including scratch variables. Click on Save if you create an expression that 
you want to use again in the future. You will then be able to load it into other channels at your convenience.

The A, B, C, and D fields are scratch variables for the expressions. Each of these can have an expression, which is 
evaluated before the main expression. This means that the main expression can use the variable A, B, C, and D for some 
other calculated value. The scratch variables are evaluated in alphabetical order, so B can use A, C can refer to A and B, 
and the D expression can contain A, B, and C.



LightWave 2020  –  LightWave 2020

Reference –  1017

1.
2.

3.

4.

5.

1.
2.

3.
4.

Scratch variables are useful both for breaking up massive expressions and for logically separating the functional 
elements of an expression. For example, driving a ball’s pitch based on its Z-distance can simulate rolling if the ball 
rotates once for every pi*diameter it moves. This expression (pitch = pi*Z/Diameter) fits on a line, but you need to 
include the model’s diameter. If you apply it to another ball, the expression must change. If you include the diameter in 
A, then changing the expression is more obvious; when you scale up the ball, A can be more complex.

FX_Clink

These channel and motion modifiers let children of a parent, which uses FX_Link, respect the parent’s ‘time shift’ 
setting. This modifier has no interface.

FX_Link

The FX_Link channel modifier has two functions. First, it can be used to dissolve out the object when the particles die.

Dissolving an object based on particle life

Open the Object Properties Panel for the object to be dissolved. (You’ll also need an existing emitter controller.)
On the Rendering Tab, click the Object Dissolve Envelope button. This adds a Dissolve channel for the object and 
opens the Graph Editor.
On the Modifiers Tab of the Graph Editor, add the FX_Link modifier. Open its Options Panel by double-clicking its 
name in the list after it has been added.
Set the mode to Particles dissolve and select the emitter from the Particles pop-up menu. Enter the particle 
number in the Node/numbers field; 0 is the first emitted.
Click OK. When that particle dies, the object will be dissolved to 100%.

FX_Link can also be used to vary a channel based on the number of particles at the emitter

Controlling a channel based on the number of particles

Open the Graph Editor and select the desired channel in the Curve bin.
On the Modifiers Tab of the Graph Editor, add the FX_Link modifier. Open its Options Panel by double-clicking its 
name in the list after it has been added.
Set the mode to Particles numbers and select the emitter from the Particles pop-up menu.
Click OK to close the panel and play your scene. The channel you selected will be changed based on the number 
of particles in that particular frame.You can scale the value by entering a number in the Node/numbers field. The 
number of particles will be divided by this value.

LScript and LScript/RT

These commands allow you to load a channel-oriented LScript.
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MM (Motion Mixer) Channel Driver

When an X Channel is added to a Motion Mixer Actor, this modifier is automatically added. Removing X Channels from 
an actor is achieved by either using the Remove Items entry in the Actor Menu, clearing the item from the scene, or 
manually removing the MM_ChannelDriver modifier on the Graph Editor.

NoisyChannel

This modifier randomizes a channel.

 
The Offset lets you move the entire motion up or down. (The units are the ones used on the graph.) The Scale parameter 
multiplies the noise amount added in to the channel, so a factor of 1 will have a noise effect, a factor of 0 will have no 
effect, 2 will double the effect, .5 would halve it, and so on. Speed is the rate of change of the noise, basically like a 
texture velocity. Phase shifts the effect in time.

The formula is:

channel value = old value + scale * fractal noise(phase + speed*time )

Oscillator

This is a channel-oriented version of the Oscillator item motion modifier. The channel is determined by which channel 
the modifier is added to in the Graph Editor. The effect is always additive.

For more information see Motion Mixer documentation
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Proximity

The Proximity plugin is implemented as a channel modifier plugin. It can be added as a channel modifier to any 
channel. This can be done either directly through the graph editor, or via an envelope for a parameter.

Source (item the plugin is applied to):- Proximity computes the distance between the position of a source item 
and one or more target items or meshes. This setting is used to set the source item.

When set to “(self)”, Proximity will use the item to which the channel being modified is attached. If the channel is 
not attached to an item, Proximity won’t do anything if the source is set to “(self)”.
Target :- Sets the target to which the distance from the source is measured. The target may be any item, with or 
without a mesh. If an item has a mesh, the shortest distance between the source position and the mesh will be 
computed. If an item does not have a mesh (such as a null, a camera, or a light) the position of the item’s origin is 
used.
Use ( How the channel will be effected) -

Target Only - The distance from the source to the target is used. If the target has a mesh, the distance to the 
nearest point on the mesh is computed, otherwise the distance from the source to the target origin is used.
Target and Decendants - Like “Target Only”, but any items parented to the target (and the items parented to 
those items, etc.) are considered as well. The nearest distance found for all items is used.
Target Leaves Only - Like “Target & Descendents”, but only the leaf items are used. The leaf items are those 
items in the tree which have no children.
Target Leaves as Line - Like “Target Leaves Only”, but the positions of leaf items with a common parent are 
considered as the vertices of a polyline. The shortest distance between the source position and the polyline is 
used.
Signed Distance :- When computing the distance from a source to a mesh, the distance can be either signed or 
unsigned. When signed distance is turned on, the distance will be negative if the source is below the surface of 
the mesh. Otherwise the distance will always be positive.

Distance Modfier :- remap the distance calculation

None :- The channel value is set equal to the computed distance.
Scale :- The distance is scaled by the given factor to give the channel value.
Remap :- Arbitrarily change the distance to a channel value. Typically this is used in combination with a gradient 
texture or an expression.

All the distance modifiers can be enveloped, textured, etc. for full control of the effect.

Sticky.rMeshDistance: Distance of the sticky item to the nearest point on a sticky surfaceDistance to mesh: Distance of 
the sticky item to the nearest point on a sticky surface
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Python

Will load a Python script, like the LScript modifier above.

Python Noisy Channel

Example Python code that you can play with for your own scripts, the source can be found in LightWave/Support/
plugins/scripts/Python/Layout/ChannelFilter.

RelChanneler

Open the Relativity Channeler Expression Module.

SetDrivenKey

Using SetDrivenKey (aka ChannelFollower) is similar to parenting an object to another, except you have control over 
which motion channels you wish to inherit. You can also modify and delay the inherited value. Moreover, the motion 
can be inherited from the camera, a light, a bone, or any object in the scene.

 
Select the channel you wish to follow in the Channels list window.
The amount of seconds entered into the Time Lag field is added to the current time. This number may be negative.

The value can be scaled by inputting a factor other than 100% in the corresponding Scale field.

The Start Frame and End Frame parameters specify when the modifier is applied.

Textured Channel

This is a channel-oriented version of the Texture Motion item motion modifier. It works exactly the same except that 
you apply it directly to the channel you wish to modify.

 
Since textures are three dimensional, particularly procedurals, use the Axis setting to use the X, Y or Z of the texture. 
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(Note: The differences between the Axis selection can be subtle.) You can also move the texture with the Offset setting 
and change the size of the texture using the Scale setting.

Virtual Studio Trait

This is a modifier to add to an object you wish to control inside Virtual Studio. See the Virtual Studio section starting 
page PDF_LINK for more details.
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View Tab

Viewports
Additional Viewports
View Layout
HW Shading
Grid

Viewports

Fit All - This will fit everything into any viewport that isn't Camera or Light. For fitting the active viewport instead 
of all viewports, use the keyboard shortcut A
Fit Selected - Fits the selected item or items into all Layout viewports. If you wish to only fit selected into the 
active viewport use the keyboard shortcut Shift A
Zoom - This gives a dropdown menu with

Zoom In
Zoom In 2x
Zoom Out
Zoom Out 2x

For zooming in and out of the center of the viewport.

View Mode - This dropdown menu offers a choice of viewports as an alternative to using the Viewport mode 
menu in each viewport. It also shows the keyboard shortcuts associated with each viewport. Using the menu will 
only change the top-left viewport if you have several.

Additional Viewports

Additional Viewports have their own page.

View Layout

Prev/Next Layout - Steps through the list of viewport arrangements seen in the Viewport Options menu.

The buttons in the dropdown menu only work if Layout is showing a single viewport. If you have multiple 
viewports you need to use the associated keyboard shortcuts.


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Save Layout - Saves the viewport arrangement as a default for the next time you start LightWave.

HW Shading

Use Multitexture / Use GLSL -Switches between Shading methods without changing the defaults set in 
Preferences.

Grid

Increase / Decrease Grid - Changes the grid size in a 1 2 5 manner - so 1 m becomes 2 m then 5 m, 10 m, 20 m, 50 
m and so on. The same is true in reverse with 1 m becoming 500 mm, 200 mm, 100 mm 50 mm and so on. The 
default keyboard shortcuts are [ and ].
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Additional Viewports

Additional Viewports are created in the View menu in Layout with Add Viewport. A maximum of 28 additional viewports 
can be created. Additional viewports can contain anything that Layout can see including the Schematic view and VPR.

Once you have added several, arranging them becomes important. The Arrange dropdown contains three choices:

Row - Arranges additional viewports in a row based on the selected viewport
Column - Arranges additional viewports in a column based on the selected viewport
Tile - Arranges viewports in a deck of windows

GIF showing the different arrangements. Unsorted, Column, Row and Tile
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Previsualization
Click here to expand Table of Contents...

Introduction
Creating a Preview Animation

To Create a Preview Animation:
Preview Options

Layout Transport Controls
Keyboard Shortcuts
Going to a Specific Frame
Playing the Scene

VPR (Viewport Preview Renderer)
Creating a VPR Preview
3D Display Virtual Studio

Introduction

There will be times, more often than not, when you will want to plan out your animations or review your progress as you 
are working without doing a full render. This is the role of previsualization, or previz.

Creating a Preview Animation

In addition to playing a scene using the transport controls, you can also create special preview animations. In most 
cases, these will give you a more accurate preview of your final animation.

To Create a Preview Animation:

If you are using multiple viewports, you will be asked which you wish to use. You can indicate the viewport for 
the preview by clicking the small camera icon that appears when you have multiple viewports.

Make sure the viewport’s Maximum Render Level is set as desired. If you would like a full-rendered preview, set 
the viewport to VPR (there are other options if you do so).
Select Make Preview from the Preview pop-up menu. A dialog will appear asking you for first and last frame 
settings, as well as Step. This initially defaults to the scene settings, but may be set independently. Click OK and 
the preview animation will be created.


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4. When the preview is complete, the Preview Playback Controls Panel will appear.

Here’s a rundown of the Preview Playback Controls:

01 Go to the end of playback, 02 Step, 03 Pause, 04 Play, 05 Multiplier, 06 Slider, 07 End Preview, 08 Playback rate

Preview Options

Also from the Preview pop-up menu, you can replay the preview currently in memory, free it from memory, and load/
save a preview animation file. Selecting Preview Options from the Preview pop-up menu will display a dialog.

You can press the Esc key to stop creating the preview animation. The animation will still be playable up to the 
point of termination.



To save time creating a preview animation for a complex scene, do the Texas Two Step: use a Step of 2 and 
playback using a frame rate one-half the desired rate.


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Here, you can select a compression level for preview animations, as well as select the format and codec used when you 
save them. Compressed previews use much less memory, thus you can have a lot more frames before virtual memory 
starts being used, which bogs down playback.

Compressed preview files are also smaller when saved to disk. You can also set whether or not to use virtual memory for 
preview animations.

Using the Make Preview Buffer option, you can choose to record the OpenGL back (offscreen) or front (on screen) 
display buffer. Other options may be available (e.g., Direct Draw). You may get better performance with different 
settings, depending on your video card.

When Virtual Memory is set to Disabled, LightWave attempts to use only RAM for storage and playback. (Your operating 
system can still ultimately swap the data to virtual memory, however.)Setting Screen Size to Stretch to Fit causes the 
image to fit the window, even if it is a different size than what was used when the preview was made.

Layout Transport Controls

You can use the transport controls to navigate through your scene.

You will want to install additional codecs, especially on Windows systems. The only codecs built into Windows 
tend to be very old. Consider XViD, QuickTime and Lagarith codecs.


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The controls are symmetrical forwards and backward. They are Go to Start, Go to Previous/Next Key, Frame Step and 
Play/Pause. The Rate/ Step field allows speed of playback control.

Keyboard Shortcuts

There are also some keyboard shortcuts that can be used:

Previous frame Left
Next frame Right
Previous keyframe Shift + Left
Next keyframe Shift + Right
Play Backwards Page Down
Pause Insert
Play Forwards Page Up

Going to a Specific Frame

If you press the F key, a dialog will appear. Enter the frame you want to go to.

Playing the Scene

You can also play your scene backward (left arrow) or forward (right arrow) from the current frame using the playback 
controls. The Step field, in the bottom-right corner, determines the frame increment. A setting of 1 will play all frames; 2 
will play every other frame, and so on.

VPR (Viewport Preview Renderer)

VPR is Layout’s native Interactive Render. Essentially, VPR is the LightWave renderer in a next gen interactive form. The 
VPR Interactive Renderer handles Radiosity, Ray-Tracing, Reflections, Refractions, and Transparencies - pretty much 
anything in short - to provide stunning LightWave renders as quickly as possible. VPR is activated in the Viewport 
Display menu by selecting VPR instead of one of the standard OpenGL view types. Once activated the viewport will 
begin rendering using the settings in the Render Globals panel. VPR will continually update when changes are made. 
VPR is explained in full starting page PDF_LINK.

Your playback speed will vary depending on the complexity of your scene, object display mode, system 
capabilities and so on. Reducing the size of your Layout window can dramatically increase playback speed.


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Creating a VPR Preview

While VPR is running, you can create previews just as with any other viewport display mode. You also have the choice of 
either making the preview in a viewport or as a separate window. To do so, visit the Display Options tab of the 
Preferences window (D) and check Undock Preview Win. You can also choose to use the Camera Resolution, but beware 
with this that your camera resolution isn’t bigger than your screen resolution (you can hit Esc to leave the window).

The last option is to set the Preview Scale Level. This setting applies whether you undock the Preview window or create 
a preview in a viewport and offers a dropdown with a choice of Antialiased at the top down to Every 32 pixels at the 
bottom. Obviously, the lower the resolution, the faster the preview will render. It’s up to you to determine what level of 
detail you require from your preview.
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With a Preview Scale Level of Antialiased, Every 4 pixels and Every 32 pixels.

3D Display
Virtual Studio
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3D Display

3D Display

 

LightWave 11.6 added a 3D viewing mode for people with the right hardware. If you have a 3D monitor or television and 
a graphics card capable of quad-buffering a display (for NVidia this means a Quadro graphics card but most AMD/ATI 
cards work), then you can see your scene in stereoscopic 3D. The display works both in OpenGL and VPR and supports 
both anaglyph and active or passive 3D (shutter glasses or RealD 3D glasses) depending on your hardware capabilities.

To enable the display 3D Plugin in a full-screen window.

Load a scene;
Pick Texture Shaded Solid / Texture Shaded Wireframe ( for color OpenGL );
In Camera Properties go to the Stereo tab and enable Stereoscopic Rendering ;
In the Stereo OpenGL dropdown pick 3D Glasses ;
Set your viewport to VPR and in VPR Options choose Add Display / 3DVisionPro ;
Edit Properties or double click 3DVisionPro ;
Check Full Screen if necessary for your graphics card

Esc closes the 3D display or you can click Toggle Window in the VPR options window.
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Virtual Studio

Click here to expand Table of Contents...
About Virtual Studio

Overview of Controls

The Device Manager
The Control Booth
The Studio

Studio Assets Submenu

Example: Car Shoot
3Dconnexion Example Setup
Virtual Studio Nodes
Move.me Example Setup

PlayStation3 Setup
LightWave Device Manager Setup

Virtual Camera Motion
Virtual Camera Zoom
Virtual Spotlight Motion
Virtual Spotlight Light Intensity
Virtual Spotlight Cone Angle

Glossary

About Virtual Studio

Virtual Production workflows are changing the face of CG and live action production, visualizations, and design. Most 
individuals and small to mid-sized studios assume that virtual production technology is out of reach but the truth is that 
this technology is scalable and very flexible. With LightWave and its Virtual Studio you can perform virtual location 
scouts of a 3D set, record handheld camera moves on a fully 3D LightWave scene, use game controllers like the PS3 
Move controllers to drive character animation, and control lights all in real time. In fact, any channel that can be 
animated in LightWave can be controlled with Virtual Studio. Clients love this type of interaction for meetings and 
virtual walk-throughs and it is easily within your reach with LightWave Virtual Studio.

LightWave’s development team are bridging the gap between real and virtual worlds. Our real world interface with 
LightWave has been fairly constant for years using a 2D screen output, a keyboard, and a mouse pointer with some 
buttons. These days, there are more real world devices we can tap into to allow real world humans to interact with 
LightWave. These include: motion tracking devices, 3D mice, gesturing, accelerometers, virtual buttons, wireless 
displays, joysticks, cameras and more. With Virtual Studio, LightWave can support many of the capabilities of a real 
studio, such as recording and adjusting live action, the key being ‘live’ action. Animators have always had the ability to 
adjust motion in an animation at a fundamental level (key frames) but producing the most realistic looking motion 
requires capturing real world data or simulating it procedurally. The purpose of LightWave’s Virtual Studio is to work 
with real world data by bridging the gap between LightWave and a real world studio.





LightWave 2020  –  LightWave 2020

Reference –  1034

Overview of Controls

Before we go into specifics, here is a presentation of the three principal windows Virtual Studio uses in Layout. These 
can all be found in the Virtual Studio tool group in the Top Menu section of Layout’s menus. The button beneath this 
group labeled Studio LIVE is a toggle that replicates the LIVE! button inside the Studio window for ease of access. This 
button creates a live-feedback evaluation of the scene (and its traits) that updates viewports to see the feedback. 
Without Live!, scene evaluations only occur when the scene time changes and in a few other situations, but not at a 
consistent frame rate like with Live! enabled.

The Device Manager

This assigns your connected device to be used for the Virtual Studio. You need to click the Enable column for the device 
type, this will be either a HID (Human Interface Device) compatible peripheral, the Intersense VCam or the PlayStation 3 
Move controller. If there are devices you don’t own, or are never likely to, you can remove them from display to make it 
tidier. Right click on the manager entries you wish to remove.
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If you plug in a device of the type you have removed, you will get the entry back in Device Manager.

Once you have enabled your specific device, you can click on the device’s name to see the readout of LightWave-
supported Tracks. In the case of PlayStation 3 Move.Me controllers you can adjust the gem hues at the top of each Move 
controller. The gem color settings in this panel are just used as a guide for Move.Me to change the gem colors (they 
won’t necessarily be exactly the same as on this panel) and colors that are too similar will not be allowed. The Console 
Sword button changes the onscreen appearance of the Move controller to the sword object assigned to the gem on the 
PS3.

The generic version of a HID device is purely the HID manager version. The generic device is limited in functionality, 
usually just to button presses; elements like accelerometers need to be specifically programmed. If you need to choose 
between devices always choose the non-generic version that has been specifically programmed for LightWave. Going 
further, you can remove them from view with the HID Manager Settings window.
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The Control Booth

This is where you set up behaviors using Layout commands to drive functionality for your device. The control booth is a 
way to control Layout similar to how one would assign keyboard shortcuts to do things that the user would normally 
use the GUI to do. These behaviors are not part of the scene. The control booth is a user interface tool. To know what 
commands are available go to the Utilities tab and click Save CMD List. The Space Explorer in this example has fifteen 
buttons in addition to the central controller and these can be assigned actions in the Control Booth. These settings are 
saved into a config file in your user directory: %USERPROFILE%\.NewTek\LightWave\2019\configs\ControlBooth.cfg on 
Windows systems, and under OS X: ~/Library/Application Support/NewTek/LightWave/2019/configs/ControlBooth.cfg

You can import or export collections of commands by clicking on the + symbol at the bottom left corner of the window.
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The Studio

This is where you will record your performances using the devices you set up in the Device Manager, using the behaviors 
you set up in the Control Booth — although the Virtual Studio can be driven without a third party peripheral. You can 
have an unlimited number of Performances recorded for a device to choose between for incorporation into your scene’s 
timeline.

Listed in this window are the traits that will be recorded with the Virtual Studio.

Name - the name of the item. Double clicking on the name will open the node graph showing the connections 
needed for setting it up. Alternatively you can single click on Edit... in the Nodes column.
Value - is the readout of the current output from the trait.
Nodes - Click on the entry in this column to edit a trait’s node network.
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Padlock - Allows the user to lock all the settings for the item (or group) so that no changes can be accidentally 
made without first clicking the padlock again.
A - For active. This determines whether the virtual studio will be looking at output from the trait.
Clapper board - The take number you are on. You can click on this number to change the take, or to add a new 
one.
Snowflake - Freeze. This icons stops all evaluation from the item.
Rec - This arms the device for recording. This is an individual record function so that you control which traits are 
to be recorded.
Play - This arms the specific channel for playback. Like record, it’s an individual function.

By default, when you bring a new trait into this window the Rec and Play columns are armed.

At the bottom of the window there are more functions:

‘+’ Clicking this button brings up a submenu:

New Empty Collection - Allows you to create a new group for assembling your traits.
New Collection Of Selection - If you have a series of traits selected in the Studio window, this will put them all in 
a new collection. Collections are renamed by double clicking on them.
New Take - This will set up a new take for the selected trait.

‘-’ Will bring up a submenu:

Remove Active Take of Selection - Removes the current take.
Reset Active Take of Selection - Zeroes out the take, but doesn’t remove it.
Remove All Takes of Selection - Deletes all takes from the selected Studio trait.
Remove Selected Collections - Removes the selected collections.

Active - A global button to evaluate Studio functions.
LIVE! - Live is the live-feedback evaluation of the scene (and its traits) that updates viewports to see the 
feedback. Without Live!, scene evaluations only occur when the scene time changes and in a few other 
situations, but not at a consistent frame rate like with Live! enabled.
FPS field - This requests a frames per second rate for the whole scene when used through the Virtual Studio. The 
following number is the actual reported FPS, useful for complex scenes that might not be able to play back at 
the requested rate.
Allow Rec - This is the Global record button. It allows the individual Rec settings.
Allow Play - This is the Global Playback button. It allows the individual Play settings.
Punch In/Out - used if you only want to use the Virtual Studio for a section of the scene. Left at 0 it will record the 
whole scene.
1-shot - this records the motion of your traits during a single playback of your scene, when it reaches the end of 
the timeline recording stops. This also works if you are playing back in reverse to reverse-record your traits at 
which point it will automatically stop when the timeline reaches the beginning of the timeline.
Performances - this opens a sub-menu related to storing multiple performances. Performances are useful for 
more complex setups where there are multiple scene assets being affected. A use case may be giving a director 
multiple options to choose from; but instead of being able to change just one take to accomplish that, it may 
require a lot of settings changes. The performance would encapsulate all the setting changes (to traits only) for 
quick switching. Another example could be a single ‘actor’ performing multiple roles in the scene: camera man, 
lighting, driving a car, effecting explosions where the car drives. A performance could be setup for each so that 
the real person can switch roles quickly and record or playback only the parts needed.
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Studio Assets Submenu

Rather than needing to use Load from Scene to bring in a camera or light from a scene where they have been set up, the 
user can simply choose the appropriate command from the menu to add a camera or spotlight. Examples have been 
put in this menu for PlayStation 3 Move.Me devices and 3Dconnexion Space Navigator, Explorer and Pilot Pro devices.

Users can add their own devices to this submenu by editing the Python scripts and providing an identically-named 
scene. Look in LightWave/Support/Plugins/Scripts/Python/Layout/Virtual Studio directory to see the examples. Once 
done, the new scripts need to be added using the Edit Plugins window or by restarting LightWave if you use Autoscan 
Plugins, and then the plugin needs to be added to the Assets menu using Edit Menus.
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 Example: Car Shoot

Note that to get VPR to resolve you need to turn off the LIVE! function so that the Virtual Studio isn’t constantly 
evaluating your 3D device.

The director wants to shoot a turntable of a new car and wants to direct you in the motions you will use. We’re using the 
Studio_Spyder scene from the content for this example. Use the Virtual Studio > Studio Assets menu to add a camera 
for the Space Explorer, Space Navigator or PlayStation 3 move.me system to the scene. If you wish to build your own 
node network to control the camera, individual nodes are explained starting on page PDF_LINK; the 3Dconnexion setup 
used for this example is explained starting on page PDF_LINK of the manual and a move.me node explanation can be 
found starting on page PDF_LINK

Once you have your new camera in the scene you will see that it is positioned badly so you need to give it a better 
starting position using your 3Dconnexion device, if it doesn’t move, make sure Live! is ticked in the Studio window or in 
the Top menu group of Layout. Now we can start.

Before anything else, make sure your Nav tab in Options is set to Device: (none)! You don’t want to make 
Layout use the same device for two different purposes.



A Space Explorer was used for the purposes of this scene. If you have a 3Dconnexion device not listed in the 
Studio Assets menu, you will need to double click on the trait item in the Studio window and open the Device 
node to associate your 3Dconnexion device with the node network.


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1.

2.

3.

4.

You need to make sure you have Active , Live! , Allow Rec and 1-shot all checked in the Studio window. Up on the 
trait for the Item Motion: Single you want the Rec and Play buttons checked too. You should be on Take 1. The 
scene only has 60 frames so it’s going to be quick, but that’s okay for this test. You need to be comfortable with 
using the 3Dconnexion device to control the camera smoothly and accurately and you can always change the 
playback rate of your scene if necessary.
When ready, press play on the scene and be ready to move your 3D mouse to capture the changes in position 
you want.
When the scene is done playing the Allow Rec button will switch off. Click the Allow Play button in the Studio 
window and play your scene back. You will see the motion you recorded. If you’re not happy with it, you can 
always hit the Allow Rec and 1-shot buttons again and redo the take. If however, you’d like to keep this take and 
try another, click in the Studio window in the clapperboard column. You will be presented with the possibility to 
choose between your takes or create a new one.

Your takes can be chosen between and played back on the timeline and when you are happy to render make 
sure the Studio Allow Play button is active for the take you want to render. All your takes are saved into your 
scene file.



LightWave 2020  –  LightWave 2020

Reference –  1042

All four takes were rendered and saved into a single scene.

3Dconnexion Example Setup

The node network for the 3Dconnexion example shown at the start of this section looks like this:
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2.

3.

4.

5.
6.

7.

8.

9.

10.
11.

This is how the individual nodes work:

This is our Device node. Here we are using a 3Dconnexion Space Explorer. If you are using a different model you 
will have different outputs, but the main ones devoted to movement are the same for all models - v for Position 
and w for Rotation.
This Multiply node allows you to scale the sensitivity of the movement controls of your 3Dconnexion puck. The 
settings are shown in the window above.
This Multiply node allows you to scale the sensitivity of the rotation controls of your 3Dconnexion puck. The 
settings are shown in the window below.
These three Vector Scalar nodes allow you to change the axis order to match the device’s rotation to the Euler 
angles LightWave uses (Heading/Pitch/Bank). Here Y goes to X, X goes to Y and Z is passed through.
The three Scalar outputs from 4 go into a Make Vector node.
The all-important Studio Trait node. This links a scene item (in this case VirtualStudioCam) with your node 
network and thus your device. The Position goes straight to the Add node in item 10 and the Rotation to item 7.
The HPBAdd node combines the two rotations of your controlling device and your scene item. The result is sent 
to the destination Trait node.
The HPBMatrix node converts heading/pitch/bank Euler angles to a 3x3 matrix output as right/up/forward 
vectors.
These outputs are taken, along with the original scaled output from the Device’s v output, and an inverse 
transform is applied. This is to make the right/up/forward vectors be relative to the Studio Trait node’s 
orientation (in order to better visualise this, imagine an arrow pointing northeast. What this node does is 
translate a forward push on the 3Dconnexion device’s puck into forward motion for the arrow, that is to say in a 
northeasterly direction, not just north).
The Studio Trait Position and transformed Device v are Added. The result is sent to the destination Trait node.
The destination Trait node.

Virtual Studio Nodes

In order to set up a virtual studio scene and be able to use peripherals such as the 3Dconnexion “mice” a series of nodes 
have been added to LightWave’s Node Editor. They are accessed by adding a Virtual Studio Trait motion modifier to 
your scene item like so:

and then double-clicking its entry in the Virtual Studio window.
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Item Info > Trait - A trait is a motion modifier added to a scene item making it visible to the Virtual Studio. Once you 
have added this modifier to your scene item, the scene item will become available in the Trait node in the node editor.

Item Info > Device - A device is the tool you are using to control the Virtual Studio, whether it be a 3Dconnexion 
peripheral like the Space Navigator or Explorer; a PlayStation 3 Move controller or an Intersense VCam. The outputs for 
a specific device will be appropriate to that device. The Space Navigator for notebooks here shown has just four outputs 
for movement, rotation and the two buttons present, whereas the Space Explorer has a total of 15 outputs representing 
the different buttons on the device.

When you add a device to your nodal network, you need to double click the node to present the following window 
where you will choose the device you wish to use.

If you set up a scene with a 3Dconnexion Space Explorer or similar with additional buttons and configured 
nodes relating to those buttons; then use a Space Navigator with no additional buttons the connections for the 
missing buttons will be lost if you save the scene. The nodes will still be there, but the connections will have to 
be remade when you reconnect a more fully-featured 3Dconnexion device.


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Math > Vector > HPBMatrix - convert Euler angles (heading/pitch/bank) to a 3x3 matrix output as right/up/forward 
vectors (each being a nodal vector type).

Math > Vector > MatrixHPB - convert a 3x3 matrix (specified as right/up/forward vectors) to a vector of Euler angles 
(heading/pitch/bank).

Math > Vector > Multiply Matrix 3x3 - multiply two 3x3 matrices. For rotation matrices, this has the effect of combining 
rotations. The output is another 3x3 matrix represented as right/up/forward vectors.

Math > Vector > Transpose Matrix 3x3 - a rotation represented as a 3x3 matrix can be transposed which has the effect of 
inverting it meaning the rotation is reversed.

Math > Vector > HPBAdd - combine two rotations represented as Euler angles and output the resulting rotation as Euler 
angles.

Move.me Example Setup

This is a PlayStation3 application that uses up to four PS3 Motion controllers and the PS3 Eye camera to track the 
position and rotation of each controller and sends that data across a network to client. That client, in this case, is the 
LightWave move.me device manager. Once accessible to the LightWave device manager, the data can be used to 
control your scene elements and user interface.
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2.

PlayStation3 Setup

You must have the necessary hardware and physically set it up. Please refer to your PS3 console for specific 
setup instructions such as linking the controllers to your system.

PlayStation3 console
PS3 Eye camera
PS3 Motion Controller (up to four; this example specifies two)
Network connectivity to a LightWave11 system

You must also acquire the PS3 move.me software application. This is available via the PlayStation Network Store 
(availability in certain markets may be limited).

Start the move.me application and get past its instructional splash screens. The screen should display what the 
camera is seeing, and the upper left corner of the screen will show the console’s IP address with a port of 7899. 
This is the server that LightWave11 will need to refer to shortly.

Repeat this next step for each PS3 Motion controller (also referred to as “gem”). At about three feet from the 
camera (PS3 Eye), point the Motion controller directly at and inline with the center of the camera lens, remain 
stationary, and press the Motion controller “Move” button (the largest top-side button). The gem will flash and 
finally settle-in on a color (Each gem will have a unique color.) You must be fairly still until the final color is 
visible; this is a calibration procedure. After the calibration, do not rotate the camera as that will disrupt the 
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orientation calibration. As the controller is moved, you will see a sword (or other avatar) represented on the 
screen. To disconnect the gem, press the ‘SELECT’ button on its left side. This does not power off the gem, it only 
disconnects it from motion tracking in the Move.me application. You may then repeat the calibration as needed. 
It is important to note that gems can only be connected or disconnected when no clients are connected to the 
Move.me application. After about 10 minutes of non-use, a gem may disconnect automatically (the gem color 
will go out). If any clients are connected at that time, they must be disconnected before the gem can be 
reconnected. This behavior may change in the future.

LightWave Device Manager Setup

The device manager in LightWave is the central place to decide what devices can participate with the studio and control 
booth features. The studio allows devices to affect your scene while the control booth allows devices to affect your user 
interface, which can also affect your scene. To be more clear, the studio feeds device data into your scene through its 
natural evaluation process similar to motion plugin evaluation, and the Control Booth interprets device data to issue 
Layout commands like those that can be entered by a user in the command input and command history panels.

Open the device manager panel. A table of existing managers is shown
Find the manager called “PS3 Move.me” and enable it.

Open the settings for it.
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5.
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Click on the “+” button to add an address entry. The default of “192.168.x.x:7899” should appear.

Look back at the console screen upper-left corner and change the IP address in the Move.me Manager settings to 
it. The address format is IP:port, so make sure there is a colon separating the IP address and the port value.
Enable the address entry. If all is well, the status should show “1”. It is important that the “PS3 Move.me” entry 
on the device manager panel is enabled before attempting to enable an address entry. You can now close this 
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settings panel. The 
“PS3 Move.me” manager should now have four devices (gems).
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7.

8.

7) A device must be enabled for its data to be received; so enable the devices of interest in the device manager 
panel. Highlight a device to see its data in the tracks table below and confirm its operation by watching the data 
change as you manipulate the gem.

At this point, the gem devices are available to studio and control booth.

More than one PS3 console may be connected simultaneously therefore allowing more than four gems in 
LightWave11.


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Scene SetupThe scene can be as simple or complex as you like. With up to four gems per PS3 console, you have a 
lot of options. This example sets up a virtual camera and a virtual spotlight as well as some control booth behaviors.

IMPORTANT! Windows firewall rules may be preventing the data stream even though the setup appears 
correct. A quick way to troubleshoot this is to disable the Windows firewall for the network connection that the 
console is on and re-check for track data changes. For a direct network connection between the LightWave11 
system and the PS3 console, there is less risk in disabling the firewall; but when the connection is also to the 
internet, special firewall rules may be necessary. The Mac platform does not have this issue.



The name of a device is its identity when used through LightWave and it should be unique from other devices. 
Because this name will change depending on how the hardware is setup and what hardware is available, it 
makes sense to rename devices to something you will use in your scenes and on your system. That way, a 
simple name change in the device manager will keep away the need to change all scene references to a device. 
Device names can be changed by double-clicking on its name. The device name and active state are 
remembered the next time you start Layout as well.



Take recording requires mapping device data to your scene elements; this is the purpose of studio traits. 
Control booth behaviors are not recorded in a take.


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5.

6.

Virtual Camera Motion

The virtual camera motion will be directly tied to the gem motion.

Create a scene camera and name it “virtual camera”.
Open the motion properties for it, and add the Virtual Studio Trait modifer. This will add a new trait to the 
Studio.

If the studio panel is not already open, you may open it in either of two ways: a) Open the properties for the 
plugin and click on the Studio button, b) choose the studio menu option (provided your menu configuration has 
it available).

Edit the node graph for this new trait. In the studio panel, locate the trait named ItemMotion:virtual camera and 
double-click its name or click Edit in the Nodes column. This opens a node graph with a target node representing 
the trait’s position, rotation, and scale.
Add a device node from the Item Info category to the node graph.

Open the properties for the device node, and set the manager and device to PS3 Move.me and PS3_Gem0
respectively.

If the devices are available in the device manager window, they can be selected via the drop-down gadgets in 
the panel. Otherwise, you may simply enter the names directly; however, no understanding of them will be 
available to complete the node graph. You may continue on with the node graph and make the final 
connections once the required devices are available. Once the node graph connections are made, they will be 
remembered when reloading your scene even if the devices are no longer available.


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Connect the device node XYZ and HPB to the trait Position and Rotation respectively;

In the Studio panel, enable the LIVE! button and make sure the value to its right is reasonable for your system 
(suggested 10 to 30). This value is a evaluation update rate. It determines how many times per second the scene 
is evaluated and redisplayed in the view ports. This allows you to see scene changes as a result of gem 
movement even though the scene time is not changing. Once this is done, you should now see the virtual 
camera moving in your scene as you move your gem.

The scale and orientation of gem motion may not be appropriate for your scene. Parenting the scene’s virtual 
camera to a null item is now useful by providing a more flexible reference for the gem data. Create a null item 
called “eye origin”.

The PS3 Eye must be able to see your gem’s colored orb to track its motion completely.
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Parent “virtual camera” to “eye origin”. The virtual camera will now move relative to “eye origin”. The “eye 
origin” item can be further parented to other items, even animated ones.

Virtual Camera Zoom

The gem virtual camera would not be very useful without the ability to control the zoom factor of your scene camera. 
We will create a channel trait for the camera zoom and applied the necessary node graph utilizing the gem trigger and 
move buttons.

Open the camera properties for the “virtual camera” scene camera.
Add an envelope to the zoom factor property (sometimes listed as lens focal length). This will open the graph 
editor.
Add the “Virtual Studio Trait” modifier to the new ZoomFactor channel. This will create a new studio trait called 
Channel:virtual camera.ZoomFactor . Due to internal technical reasons, this will also create another studio trait 
called Channel:virtual camera..LegacyZoomFactor .

We must adjust the node graph of the “.LegacyZoomFactor” trait only. Double-click its name to open its node 
graph. The target node has a single value called “Value”; this represents the trait’s value.

By default, the PS3 Eye is mapped to the scene’s origin and gem data is relative to this.
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5. Construct the following node graph. An explanation follows.

This zoom graph relies on the Motion controller’s ‘Move’ and ‘TPressure’ button data. The ‘Move’ track is a simple 
toggle where ‘1’ is pressed and ‘0’ is not pressed. The ‘TPressure’ track supplies values from 0 to 255 depending on how 
hard the user squeezes the ‘T’ trigger button. When you do not know what data values are possible for a track, look at 
the device manager panel in LightWave and highlight the device in question; the available data tracks and expected 
format will be displayed interactively.

The result of the graph will be this: zoom in when the ‘Move’ button is not pressed and zoom out when it is; the ‘T’ 
determines how quickly to zoom.

The logic node outputs a negative value when the ‘Move’ button is pressed having the effect of zooming out. The node 
output values act as a scaling to affect how fast the zoom will occur. This output is multiplied by the ‘TPressure’ value 
and sent to a “pow” node, which allows the zooming to appear more natural like that of a real camera zoom.
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The previous zoom factor trait value is needed to give the node graph something to modify, since it applies a relative 
amount to arrive at a final absolute trait value. The Studio Trait node allows us to specify which trait to use. We choose 
the same trait for which this is a node graph for.

The previous trait value is combined with the ‘pow’ effect and clamped to keep the resulting zoom factor within a 
reasonable range.

The above scalar affects how fast the zoom with occur. The value must be very close to 1.0.

This is a very basic zoom control. One enhancement is to add another logic node to allow multiple zooming speeds 
based on the amount the ‘T’ trigger button is squeezed. A gentle press to zoom very slowly and a hard press for 
maximum zoom speed.

Virtual Spotlight Motion

Similar to the virtual camera, the spotlight directly uses the gem motion.

Create a spotlight type light called “virtual spotlight”
Open its motion properties and add the “Virtual Studio Trait” modifier.
In the studio, open its node graph.
Create a device node set to the manager “PS3 Move.me” and device “PS3_Gem1”.
Connect the device node XYZ and HPB to the trait node position and rotation respectively.
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Virtual Spotlight Light Intensity

The gem can also be used to adjust the light intensity via additional buttons.

Open the light properties and add an envelope to “Light Intensity”
Attach the “Virtual Studio Trait” modifier to the channel in the graph editor.
In the studio, open the new trait’s node graph.
Construct the following node graph.

This node graph uses the gem ‘Triangle’ track to increase the light intensity while the ‘Square’ track decreases it.
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The light intensity is clamped between 10% and 98%.

Virtual Spotlight Cone Angle

Similar to the virtual camera zoom, the spotlight cone angle can use the trigger and mode buttons

Add a studio trait for the “Spotlight Cone Angle”. (Add “Virtual Studio Trait” to its channel)
Construct the following node graph, which is very similar to the virtual camera zoom factor node graph.

Glossary

Behavior - An assignment of a device track to a LightWave command setup via the Control Booth panel.

Cast - A collection of characters

Cast Performance - A combination of various chosen character performances.

Channel - A device’s data stream

Character - A collection of traits.
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Character Performance - A combination of various chosen takes for each trait in a character.

Character Preset - A definition of a character via its traits and connections to device channels and scene elements.

Character Track - The desired movement a character is expected to make as the scene progresses.

Collection - A container to better organize traits in the virtual studio and behaviors in the control booth.

Control - An interpretation of device channel data to cause an action. Controls can have child controls.

Control Booth - A feature that allows real world devices to issue commands in Layout.

Device - An data input/output container usually representing a real world physical control.

Device Manager - a manager of devices usually devoted to a specific method of communicating with them. The device 
manager panel accesses devices that are or have been available.

Device Track - A part of a device that provides or uses time-dependent data.

GEM - Motion controller used within the PS3 move.me application.

HID (Human Interface Device) - This is an industry standard to communicate with devices. The HID Manager supports 
this mechanism and provides access to devices that support it as well.

InterSense - An precise and range-limited motion tracking system.

LIVE - A 3D view port feedback mode that evaluates virtual studio traits many times per second without adjusting the 
current scene time.Performance - A particular arrangement of all traits such that they produce a desired result.

Preset - A collection of data used to remember settings applicable to specific aspects of the virtual studio. It’s purpose is 
to save the user time and grief while setting up their virtual studio.

Prop - A scene element that does not cause a response from a character, although, they can be manipulated by 
characters.

Device - A set of channels representing input. Typically, devices represent real world hardware.

Spike - A location marker for a prop or character.

Stage - A place to arrange the cast and props and define how the scene is to progress.

Studio Asset - A virtual studio setup that can be added as an asset to your existing scene.

Sword - An avatar used within the PS3 move.me application to represent a GEM.

Take - A recording of a trait value as it changes through scene time.

Trait - A scene asset that participates in the virtual studio.

Virtual Studio - A feature that allows real world devices control of scene assets.
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Import/Export
You may load foreign object and scene formats supported by LightWave directly into Layout or Modeler. To load an 
object in a foreign format into LightWave, you only need to use the normal Load Object menu entry. Complete 
explanations are found in the Interchange chapter of this manual starting page PDF_LINK. However, only Modeler can 
be used to save an object using a foreign object format. To do this in Modeler, choose File > Export and select one of the 
Export options.

Imported Object Formats

Format Supports

OBJ M, SA, T, UV

DXF M, SA

3DS M, SA, SSP, T, UV

DAE M, SA, T, UV

FBX M, SA, T, UV, Mrf

STL M

PLY M

M = Geometry mesh
Mrf = Morph
SA = Surface assignments (LW default properties)
SSP = Standard surface properties (color, glossy, etc.)
T = Texture maps (non-procedural)
UV = UV texture information

Before exporting to a foreign object format, save the object as a LightWave .LWO file first.
When appropriate, an options dialog may appear when you load or save a foreign object format file. Some trial and 
error may be needed to get acceptable results. OBJ settings are presented in the Options window, available when 
tapping o in Layout or Modeler.
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3DS import option dialog

3DS Export option dialog

Generally, you should merge points after loading a 3DS object.

Image and Animation Types

You can load and save various image and animation formats. What is available to you depends on the platform you are 
using, as well as the plug-ins you have active. Please check the NewTek Web site (www.newtek.com) for additional plug-
ins as they become available.

The Flexible Format, TIFF LogLuv, and Radiance image formats contain high dynamic range data (discussed below). In 
addition, they store the data with floating-point accuracy instead of using integers.

When a 32-bit format is selected for saved RGB images, the 8-bit Alpha image is stored along with the 24-bit RGB data. 
However, when you save alpha images directly, you save only the alpha image, even if the format is 32-bit.
The filename extension for Radiance images is .HDR. If you have any of these images using the .PIC extension, you 
should rename them.
Supported image formats include but are not limited to: PSD, Alias, BMP, Cineon FP, DPX, Flexible Image Format, IFF, 
JPEG, PCX, PICT, PNG, Radiance, RLA, RPF, SGI, Sun, TIFF, Targa, VBP, and YUV image formats.

Supported animation formats: AVI (any installed codec), QuickTime, QuickTime Stereo, Flexible Image Format, 
Storyboard, 4X Storyboard, Film Expand.

Supported Web 3D: QuickTimeVR, VRML and Shockwave for export.

http://www.newtek.com
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Images and Memory

Mipmapping is a process where a series of images with progressively lower resolutions are created from a base (full-
resolution) image. Each pre-processed image is a power of two smaller than the previous level. As textures move farther 
away from the camera, they obviously must be scaled down. However, because the mipmaps are pre-processed and 
loaded into memory, they can be used immediately for textures instead of continually shrinking down the base image; 
this saves rendering time, but requires more memory. Eight-bit grayscale and eight-bit index-color images remain in 
eight-bit form internally. For color images, their mipmaps, however, are 24-bit since they must include colors in 
between color palette entries. Floating-point images use 96 bits per pixel and have 96-bit mipmaps.

Here are some examples dealing with a 512 x 512 image in various formats, and how much memory is used for the base 
image and the first couple mipmaps:

512 x 512 eight-bit grayscale image:

Base image 262,144 bytes (512 x 512 x 1)
First mipmap 65,536 bytes (256 x 256 x 1)
Second mipmap 16,384 bytes (128 x 128 x 1)

Total 344,064 bytes

512 x 512 eight-bit color-mapped image:

Base image 262,144 bytes (512 x 512 x 1)
First mipmap 196,608 bytes (256 x 256 x 3)
Second mipmap 49,152 bytes (128 x 128 x 3)

Total 507,904 bytes

512 x 512 24-bit image:

Base image 786,432 bytes (512 x 512 x 3)
First mipmap 196,608 bytes (256 x 256 x 3)
Second mipmap 49,152 bytes (128 x 128 x 3)

Total 1,032,192 bytes

512 x 512 floating-point image

Base image 3,145,728 bytes (512 x 512 x 12)
First mipmap 786,432 bytes (256 x 256 x 12)
Second mipmap 196,608 bytes (128 x 128 x 12)

Total 4,128,768 bytes

High Dynamic Range Images (HDRI)

In computer graphics, color is displayed as a triplet value: red, green and blue. These values typically range from 0 to 
255. Those 256 steps of color represent eight bits and together all three channels make up a 24-bit image. This means 
the maximum amount of color or luminance variation an image is allowed is merely 256 steps.

See the discussion on radiosity for additional information on high dynamic range images.
In the real world, the human eye can perceive a much higher range of brightness and color values. Film can also react to 
a much wider range. Video cameras, however, are limited to a fixed range that fits closely to the same 256-step limit.
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When exposed to high dynamic range visuals, such as a sunset or a desert landscape, the lens of a camera will produce 
some level of artifacting. Some of those artifacts can be seen as blooming areas of brightness, color bleed, luminance 
spill, lens streaking, and many other visual cues that tell the viewer there is a very bright light source in the scene.

These very bright surfaces can also contribute to the overall lighting of a scene. For example, sunlight streaming into a 
room will bounce off the floor and add a subtle illumination to the walls and ceiling that would otherwise be left dark 
( this bouncing of light is known as radiosity). All of these effects can be seen in images captured by devices that do not 
support high dynamic ranges.

Because computer graphics applications were designed to output to devices that would not understand pixel values 
above RGB 255, 255, 255, most applications do not provide for any value to exceed these limits. LightWave, however, 
calculates all internal data without limits and with IEEE floating-point accuracy. This means that when LightWave points 
a light at a surface, while the final rendered pixel may reach only RGB 255, 255, 255 for pure white, internally that pixel 
may have reached ten times that amount. This may not seem significant at first glance - white is white after all - but, if 
we look at how LightWave utilizes that data, it becomes very exciting.

Import/Export

LightWave can utilise high dynamic range detail, as it is generated internally (e.g., in the case of a very bright light) or 
from data in image files. This can be imagery generated from a series of photographs taken at various exposures and 
composited (see Recovering High Dynamic Range Radiance Maps from Photographs by Paul E. Debevec and Jitendra 
Malik at ) or data rendered in LightWave saved in one of the high dynamic range formats.

Once these images are imported into the system, they can be used just like any other image in LightWave 3D (e.g., as a 
texture, background, etc.). During the rendering process LightWave will respect the extra data in the image to assist in 
secondary lighting and other calculations.

Imagine using a high dynamic range image as an environment wrap (e.g., using the Image World environment plug-in.), 
which also illuminates the scene. With the appropriate imagery you can illuminate a scene without any lights and the 
results will match the look and feel of the original photograph.
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Image by Darkside Animation

Once LightWave finishes rendering, you can export images with the same high dynamic range data. This lets you bring 
that data back into LightWave or into compositing applications that support such data. Using this extra data in the 
compositing process is very important as it can more accurately represent imagery as it would look if it were recorded 
directly to film. For example, compositing applications could use the extra dynamic range data to calculate the amount 
of diffuse bloom or color bleed from one pixel to the next.

Internal Compositing

Another area where high dynamic range imagery is supported is in LightWave’s own internal compositing through pixel 
and image filters. Any filter can be designed to take advantage of the high dynamic range data with floating-point 
accuracy. This way, high dynamic range data can be leveraged in the post-process phase with included filters and by 
third party additions.

Preview Compression Codec

The NTCodec.dll adds LightWave’s preview compression scheme into the Windows AVI codec. You just need to install it 
if you want to play/load compressed preview anims into other Windows applications/players. See the README.TXT file 
located in the NTCODEC directory for installation instructions.

The Hub

The Hub is essentially a message board that LightWave modules use to synchronize information. It contains entries like 
synced object filenames and configuration memory blocks. When the same object is loaded into both Layout and 
Modeler, changes made to the object are automatically synchronized. If the object appears in Layout, but not Modeler, 
you can quickly load it into Modeler by selecting it from the object pop-up menu - initially, the name will be ghosted.

If you have modified an object in Modeler (without saving) and then load the object file into Layout, the modified 
version will appear - since it is synced - not the data from the object file.
The Hub runs automatically when you run LightWave. Basically, it is a background process and you shouldn’t need to 
directly interact with it. However, you can bring up its interface by clicking its icon (when running).
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If you expand the Launch Processes menu, you should see applications that the HUB is aware of (e.g., Layout, Modeler). 
You can launch the application by double-clicking it. If you single-click (to select it) and then press the l key, you will 
also launch the application. If you press the Del key instead, you will delete the application from the launch list. (This 
has no effect on the program files on your hard drive.)

The Launch Processes menu will be empty initially. However, once you run Layout or Modeler, entries will be 
added.Under Windows, the Hub icon will appear in the System tray. You can right-click on it to access a small menu:

Open Open Hub window Close Close Hub window Launch Launch applications that the Hub knows about Properties Set 
options to quit the Hub after you exit LightWave Exit Close the Hub program

Properties

You can set the Automatic Shutdown to various time intervals, after which the Hub will shutdown when there is no 
activity. Note that even when Layout and Modeler are idle, there is still some minimal communication activity which will 
keep the Hub from shutting down.

When Layout or Modeler are running, you can set LightWave to auto-save objects and scenes in your Preferences dialog. 
On the General tab go down the near the bottom where you will see two dropdown menus, one for auto-saving Objects, 
the other for Scenes. In Modeler, you can just choose to auto-save Objects in the General Options panel.

If you would like to run Layout and/or Modeler independently, append -0 to the command (e.g., Lightwav.exe -0. That’s 
a zero, by the way.) You will have to load and save objects manually.

Command IPC

We have implemented an interprocess communications system, CommandIPC, into Layout and Modeler. When 
LightWave is started without Hub support (the -0 command line option), Layout and Modeler all notify each other when 
a mesh file has been saved to disc, and the applications that have that file open and have not applied modifications 
during the session will update from the new version on disc. For example, if both Layout and Modeler have “bob.lwo” 
open, Modeler has some edits applied to it, and Layout saves it transformed, Modeler will not automatically update 
from the disc.

If subsequently the object is saved out from Modeler, that will overwrite the changes made by Layout, and Layout will 
update from the save if no further changes were applied in Layout during the interim. LightWave CORE users should 
note that the IPC system is only active in the Windows and Mac builds, since LightWave HC code is not built for Linux.

The ‘isolate’ flag (‘-i’) will completely disable all IPC mechanisms (Hub and CommandIPC), leaving the application 
isolated from all other product actions.

Optimizing RAM Usage

If your computer is accessing virtual memory frequently during rendering, you may find a substantial increase in 
performance by installing more RAM on your machine or reducing the amount of RAM LightWave needs to store the 
render information.

One of the best ways to minimise the need for RAM is to reduce the color of the images used for texture mapping effects. 
Except for those used as a Surface Color, Texture Maps usually need to be only 256-level greyscale images.
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Master Plugins
Master Plugins are often parts of a plugin that are not useful for the user to interact with, behind the scenes 
components. Sometimes they are vital for working with scene-level actions. For instance, the Scene / Dope Editor is a 
Master plugin. Here is a list of all Master Plugins and their use:

AnchorChain - Component of the Anchor Object Motion Modifier plugin. Usually, you will not need to interact 
with the Master component, except if there is a problem with the calculations that Anchor needs to make.
AnimationTakes - Non-functional (for the moment)
Camera Selector / CameraSelector - Master Plugins for selecting a scene camera on a specific frame. There are 
two Master Plugins with similar names, Camera Selector and CameraSelector. Camera Selector has a slightly 
nicer interface but doesn't work with network rendering. CameraSelector works with network rendering, but 
doesn't have a Clear button. Both operate in exactly the same way - use the timeline to go to a specific frame, 
with a specific camera and click the Add button in the Camera Selector plugin chosen. If you wish to remove a 
Camera from the list, click Delete. Click Clear in Camera Selector (labeled as Universal Camera Selector in the 
Master Plugins window) to completely clear a list of cameras.
FiberFX - Master Plugin for FiberFX. It is this that opens the main FiberFX window for editing fibers.
Flock Master - Double-clicking on this Master Plugin will open the main window for Flocking.
FX_Master - Master plugin for FX dynamics, not user useful
gizmo_test - LScript test script to aid in third party script development
Item Picker - Presents a window that can contain a list of scene items to choose from, regardless of type (Object, 
Bone, Light, Camera). Useful if you have a few regularly picked items in a scene full of items all overlapping each 
other
LScript - Choose an LScript from a file requester
LScript Commander - The plugin that can also be called from the Utilities tab
LScript/RT - Choose a compiled LScript to run
lw_macrorecorder - This tool will monitor the stream of Command Sequence events that take place in Layout, 
and will generate a v2.0 Generic LScript file that will reproduce the sequence of commands, including their 
timings.
Master Channel - The Master Channel tool lets you create a user-defined channel, which will appear in the 
Scene list of the Graph Editor under the entry MC. You can keyframe the channel and use it as you would any 
channel. To create the master channel, add the plugin and enter a name into the Channel Name field of its 
options dialog. The Type setting determines the units of measure for the channel. You can add the plugin more 
than once to create multiple master channels.
Motion Mixer - The plugin for MotionMixer
ProxyPick - Allows for dummy objects to act as stand-ins for objects in a scene that are difficult to select 
normally, perhaps because they are obscured by other geometry or scene elements
Python - Loads a Python script
Python Command Port / Gizmo / Master / Ring / Shelf TxtrEd Test - Example Python scripts to aid in the 
development of your own
Render-Q -The master plugin for the render queue
Scene Editor -The Master plugin for the Scene / Dope Editor
SE Item Selector - Adds just the item selector from the Scene / Dope Editor
Unreal Bridge - The interface for the Unreal Bridge plugin was added in LightWave 2019
Window Configure - An experimental way of setting a workspace with Layout windows with set positions

https://docs.lightwave3d.com/display/LW2018/Anchor
https://docs.lightwave3d.com/display/LW2018/FiberFX
https://docs.lightwave3d.com/display/LW2018/Flocking
https://docs.lightwave3d.com/display/LW2018/Motion+Mixer
https://docs.lightwave3d.com/pages/viewpage.action?pageId=1861085
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Undo System
Click here to expand Table of Contents...

Introduction
Method
Systems Affected

Dopetrack
Scene Editor
Scene Editor / Dope Editor
Graph Editor
Server Pane

Preferences

Introduction

The Undo system in LightWave 2019 is undergoing revision and has had significant improvements in LightWave 2019 as 
part of a phased release to overhaul undo completely. In the lower-right hand corner of Layout, there is an updated 
Undo/Redo pair with a dropdown menu for each showing the operations possible. Several parts of Layout have been 
touched so that in addition to the geometry transforms that have long been possible to undo and redo; several other 
systems, including many in the Layout Modify menu, now have the same possibilities.

Method

Undo and Redo use the same keyboard shortcuts as before (Ctrl Z / Z), but now there is a menu attached to each of the 
buttons at the bottom-right of the default user interface. These menus list the changes that can be undone in order, 
with the most recent at the top and the oldest at the bottom of the menu. If you undo or redo a step at the bottom of 
the menu you will perform the same operation on all the steps above; there is no selective undo/redo.


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Systems Affected

Dopetrack

The Dopetrack timeline just above the scene timeline now has several undoable operations:

Moving a key or keys
Deleting a key or keys

Scene Editor

The classic scene editor shipped with LightWave since v5.5:

Changes to envelopes

Scene Editor / Dope Editor

The combined scene editor/spreadsheet offered in LightWave since v8:

Changes to envelopes

Graph Editor

More than one modification can be undone/redone now.

Server Pane

You might not know their technical name, but you've used them all the time you've created with LightWave. Server 
panes are where you add Object Modifiers or Image Filters, Pixel Filters or Motion Modifiers; Backdrop Environments 
and Legacy Volumetrics make use of them too.

A server pane

If you delete an entry you've added here, you can now undo and regain the plugin you removed - complete with all the 
settings you may have changed.
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Preferences

The Layout Options panel (O) has long had an Undo Levels entry. In the past, this entry merely referred to how many 
times you could change and undo geometry transformations, but now it includes changes to envelopes and other 
planned changes to the undo system.
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Modeler

Modeler is the LightWave application in which you will create the geometry for your scene. You can read our 
Introduction to Modeler here or just dive directly into a reference of Modeler command tabs:

Create
Modify
Multiply
Detail
Construct
Map
UV
Setup
Layers
Selection Tab
View
I/O
Utilities Tab
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Create

Introduction

The tools on the Create Tab allow you to make geometry. A wide range of tools is provided, including pre-made basic 
shapes known as primitives, drawing tools to create lines, curves and polygons, text, metaballs, and point creation 
tools that let you make points one at a time where you want them, or in groups at a time.

Tools and the Mouse Buttons

As will be shown in the examples for the primitive tools below, the LMB allows you to activate a tool by clicking on it, 
interactively adjust the geometry, and finally make the geometry by clicking again on the tool to drop it and complete 
the operation. Most (interactive) tools that create geometry (Box, Ball, Capsule, etc.) use the RMB to complete one 
operation with the tool - making new geometry, if applicable - and then begin a new operation with it, essentially 
dropping the tool and then reactivating it in a single step.

Creating in Perspective

You can create primitives in a perspective viewport in a similar way to how you would do it in a 2D viewport. You will 
see highlighted control points at the corners, sides, and center. You will also notice that you can see (fainter) hidden 
sides and control points. You can also drag any of the control points. Dragging a side control point will move the 
corresponding side along its perpendicular axis.
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Numeric Panels

For most tools there is also a Numeric panel available, which provides for precision when you need it, and which many 
find a quick and convenient way to control the various characteristics of the object they are creating. The contents of 
the numeric dialog will change as you select different tools. You may find it handy to just leave the numeric dialog open.

For example with the Box tool, the numeric panel offers two different ways to adjust the shape of your box, the Size and 
Range modes. Other options allow you to round off the edges of the box (Radius and Axis) or to make the edges sharp or 
smooth them (Sharp Edge).

Using the cursor Keys

The cursor keys let you quickly adjust settings for most primitives. For the Box tool, for example, they work as follows:

Right/Left cursor Up/Down cursor

Incr./decr. Horizontal Segments* Incr./decr. Vertical Segments*

*based on viewport beneath mouse pointer

Remember, you can rotate your view by holding the Alt key as you drag.
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Make UVs Option

The Make UVs option at the bottom of the various primitive Numeric Panels assigns some default UVs based on the 
geometry of the object. Note that a UV Texture Map must be currently selected or this option will be ghosted.

Primitives
Primitives - More
Text
Text - More
Points
Points - More
Polygons
Polygons - More
Curves
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Primitives

Box
Ball
Disc
Cone Tool
Capsule
Toroid
QuickBolt

Unit Primitives Group - This group creates primitives with no menus or settings. It will quickly create a 1 m-sized 
Box, Ball, Plane, Disc or Cone.
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1.

2.

Box

Box

(default keyboard shortcut Shift X)

The Box tool is located in the Create Menu Tab under the Primitives group. To create a box simply drag out a two-
dimensional shape in one of the viewports and then add depth to your object by expanding it in a different viewport. 
You’ll probably use the Box tool most often, because most objects are box-like in general form.

Creating a Box
Select the Box button located in the Create Menu Tab under the Primitives group.

Drag out the initial 2D shape in any viewport with your LMB . This activates the tool. 

Pressing the Ctrl key before you click and holding it while you drag will symmetrically constrain the shape. The 
dimensions of your outline are shown in the lower left corner.
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1. After you release the mouse button, you can adjust the shape by dragging any of the sides or corners. You can 
reposition it by dragging the center.
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Go to another viewport and drag to extend the shape into the third dimension. Release the mouse button.

You can continue to adjust the box’s size and position.

When you are satisfied, deselect the Box tool by clicking on it or choosing Make to turn your outline into an 
object. (Alternatively, you can select another tool.)

Numeric Panel Option: Box Tool
When you click on the Box tool to activate it, you can then bring up the numeric panel using the default keyboard 
shortcut N, or click on the Numeric button on the bottom toolbar of the Modeler window.

If you find you need to start over from scratch, just click in an inactive toolbar area or use undo.
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You have two different ways to adjust the shape of your box, the Size and Range modes. With the Size Tab selected, you 
can adjust the Width, Height, and Depth of your box dimensions. The Center XYZ settings set the position of the center 
of the box.

With the Range Tab selected, you can adjust the positions of two opposing corners of your box using the Low XYZ and 
High XYZ settings.
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You can round off the edges of the box by setting the Radius to a value greater than 0. Radius Segments allows you to 
specify how many sides are used to generate the smooth corners (larger segments obviously generate smoother ones). 
The Axis sets the direction of the radial polygon pattern used to round the edges. Use the Sharp Edge option to smooth 
or unsmooth the edges.

 

Left: Radius 176mm, Radius Segments 5, Right: Radius 176mm, Radius Segments 12

Modeling a box in Perspective view.

Using the cursor Keys
The cursor keys let you quickly adjust settings as follows:
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Right/Left cursor Up/Down cursor

Incr./decr. Horizontal Segments* Incr./decr. Vertical Segments*

*based on viewport beneath mouse pointer
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Ball

Ball

(default keyboard shortcut Shift O)

The Ball tool is located in the Create Menu Tab under the Primitives group. To create a ball simply drag out a two-
dimensional shape in one of the viewports and then add depth to your object by expanding it in a different viewport. 
The Ball tool is a great starting place for planets, eyeballs, disco globes and more.

Creating a Ball
Select the Ball button located in the Create Menu Tab under the Primitives group.

Drag out the initial 2D shape in any viewport with your LMB . This activates the tool. Pressing the Ctrl key before 
you click and holding it while you drag will symmetrically constrain the shape. The dimensions of your outline 
are shown in the lower left corner.
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2. After you release the mouse button, you can adjust the shape by dragging any of the sides or corners. You can 
reposition it by dragging the center.
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4.

1.

Go to another viewport and drag to extend the shape into the third dimension. Release the mouse button.

You can continue to adjust the ball’s size and position.

When you are satisfied, deselect the Ball tool by clicking on it or choosing Make to turn your outline into an 
object. (Alternatively, you can select another tool.)

There are two types of Ball, Globe and Tessellation. The make-up of a Globe is determined by the number of Sides and 
Segments. Tessellation balls are set using a Level parameter; these balls are created entirely of triangles and are, 
therefore, smoother looking.

If you find you need to start over from scratch, just click in an inactive toolbar area or use undo.
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Left: Globe, Right: Tessellation

Numeric Panel Option: Ball

Globe:

Axis - determines the major axis for the ball. This is also set when you click to first create the ball using the axis 
perpendicular to the (orthogonal) viewport.

Use a Tessellation ball if the camera will be close to the object and the surface is smooth.
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Sides - determines how many segments should be used around the ball.

Segments - sets how many vertical segments should be used. Three-sided polygons are always used at the top 
and bottom. Elsewhere, the polygons used are dependent on the Polygons setting on the General Options Panel 
( Modeler > Options > General Options ).

Tessellation: Sets the number of segments along the edges between the twelve polyhedral vertices. Higher settings will 
increase the complexity of the triangle matrix, taking longer to create and requiring more RAM.

Center - The XYZ coordinates of the center of the ball.

Radius - The radius of the ball along the X, Y, and Z axes.

Modeling a Tessellated Ball in perspective view.

Using the cursor Keys

Right/Left cursor Up/Down cursor

Incr./decr. Segments Incr./decr. Sides
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Disc

The Disc tool is located in the Create Menu Tab under the Primitives group. To create a disc, simply drag out a two-
dimensional shape in one of the viewports and then add depth to your object by expanding it in a different viewport. 
The Disc tool is a great starting place for soda cans, pipes and more.

Creating a Disc

To activate the tool, select the Disc button located in the Create Menu Tab under the Primitives group.

Drag out the initial 2D shape in any viewport with your LMB . Pressing the Ctrl key before you click and holding it 
while you drag will symmetrically constrain the shape. The dimensions of your outline are shown in the lower 
left corner.
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1. After you release the mouse button, you can adjust the shape by dragging any of the sides or corners. You can 
reposition it by dragging the center. At this point it will look similar to the Ball tool until you continue to the next 
step.
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Go to another viewport and drag to extend the shape into the third dimension. Release the mouse button.

You can continue to adjust the Disc’s size and position.

When you are satisfied, deselect the Disc tool by clicking on it or choose Make to turn your outline into an object 
(alternatively, you can select another tool).

If you find you need to start over from scratch, just click in an inactive toolbar area or use undo.
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Numeric Panel Option: Disc Tool

Axis - The primitive is aligned with this axis.

Sides - Sides determines how many segments should be used around the perimeter.
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Segments - Segments sets how many vertical segments should be used.

Bottom - Bottom is the starting point of the primitive along the selected Axis.

Top - Top is the ending point of the primitive along the selected Axis.

Center - Center refers to the coordinates for the center of the primitive.

Radii - Radii refers to the radius of the primitive along the axes.

Modeling a disc in perspective view.

Using the cursor Keys

The cursor keys let you quickly adjust settings as follows:

Right/Left cursor Up/Down cursor

Incr./decr. Horizontal Segments Incr./decr. Vertical Sides
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Cone Tool

The Cone tool is located in the Create Menu Tab under the Primitives group. To create a cone simply drag out a two-
dimensional disc shape in one of the viewports and then add depth to your object by expanding it in a different 
viewport. The Cone tool is a great starting place for an Indian teepee, snow cone, funnel and more.

Creating a Cone

Select the Cone button located in the Create menu tab under the Primitives group.

Drag out the initial 2D shape in any viewport with your LMB . This activates the tool. 

Pressing the Ctrl key before you click and holding it while you drag will symmetrically constrain the shape. The 
dimensions of your outline are shown in the lower left corner.

A cone with only four sides is a great way to quickly recreate the pyramids of Egypt!
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1. After you release the mouse button, you can adjust the shape by dragging any of the sides or corners. You can 
reposition it by dragging the center. At this point it will look similar to the Ball tool until you continue to the next 
step.
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2.

3.

1.

Go to another viewport and drag to extend the shape into the third dimension. Release the mouse button.

You can continue to adjust the Cone’s size and position.

When you are satisfied, deselect the Cone tool by clicking on it or choosing Make to turn your outline into an 
object (alternatively, you can select another tool.)

If you find you need to start over from scratch, just click in an inactive toolbar area or use undo.
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Numeric Panel Options: Cone Tool

Axis - The primitive is aligned with this axis.

Sides - Determines how many segments should be used around the perimeter.
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Segments - Sets how many vertical segments should be used.

Bottom - Bottom is the starting point of the primitive along the selected Axis.

Top - Top is the ending point of the primitive along the selected Axis.

Center - Refers to the coordinates for the center of the primitive.

Radii - Refers to the radius of the primitive (wide end for a cone) along the axes.

Modeling a Cone in Perspective view.

Using the cursor Keys

The cursor keys let you quickly adjust settings as follows:

Right/Left cursor Up/Down cursor

Incr./decr. Horizontal Segments Incr./decr. Vertical Sides
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Capsule

Another primitive tool is the Capsule tool (Create > Primitives > Capsule). This is used to create a cylindrical object with 
rounded, closed ends.

Creating a Capsule

Your initial click defines the perpendicular axis of the object. You can drag the center position handle to move the 
shape, and you can drag the outer bounding box edges to resize it.
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Numeric Panel Options: Capsule

The numeric settings are similar to those used for the standard primitive tools.



LightWave 2020  –  LightWave 2020

Reference –  1099

•

•

•

•

Axis - The primitive is aligned with this axis.

Center - Refers to the coordinates for the center of the primitive.

Length - Refers to how long the center of the object will be. Note: The ends are unaffected by this setting.

Radius - Refers to the radius of the primitive along the axes.
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Sides - Determines how many segments should be used around the perimeter.

Segments - Sets how many vertical segments should be used on the ends.

Divisions - Sets how many segments should be used on the center of the object.

Most tools allow numeric input. Thus, the contents of the numeric dialog will change as you select different 
tools. You may find it handy to just leave the numeric dialog open.


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Toroid

Toroid is an interactive way to create toroid shapes. It can be used in any viewport with use in the Perspective view 
creating a toroid about the Y axis. It is used by clicking and dragging in a viewport to pull out the main shape of the 
torus. Handles can then be used in the viewport to change the Main Radius, Section Radius, Start and End Angles 
interactively. The overall position of the radius can be changed by holding the central handle for the toroid.

You can switch to Lattice-like handles to further adjust the size of your toroid but be aware that any asymmetry is lost if 
you go back to the starting handle mode.
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The animation shows drawing out a Toroid then switching modes to further shape it. If you switch modes again any 
asymmetry is lost

The number of segments and sections can be changed with the usual Modeler cursor key shortcuts while in the 
tool.


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QuickBolt

Introduction

QuickBolt is a tool written by Peter Inkpen to quickly create accurately-dimensioned screws, nuts and bolts. The tool 
will refuse to work in any layer that already has geometry to avoid the possibility of corrupting existing geometry. This 
doesn't mean you need to start a completely fresh object to use QuickBolt, just a fresh layer is needed.

The QuickBolt panel is divided into two main regions: The top region which allows you to specify the general 
characteristics of the bolt or screw object and also allows you to save and load parameter value files, and the lower 
region which comprises five tabs labeled Presets, Thread, Thread Extras, Head and Nut where you define the detailed 
characteristics of the bolt or screw or nut.

The QuickBolt plugin will remember the last settings that you used to generate a screw/bolt/nut so that you can use 
them again, or use them as a baseline from which to produce a variant. If you want to quickly clear the previous 
settings, just click on the Reset To Defaults button at the top of the QuickBolt panel.

Example - QuickBolt QuickStart

QuickBolt Top Region
QuickBolt Presets
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QuickBolt Thread
QuickBolt Thread Extras
QuickBolt Head
QuickBolt Nut
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QuickBolt Top Region

The top region allows you to specify the general characteristics of the bolt or screw object, and to load and/or save 
parameter files.

The top panel fields are:

Reset To Defaults - Clicking on this button will reset all parameters to the default values.
Axis - The axis along which the bolt/screw/nut will be constructed.
Center X, Y, Z - The X, Y, Z co-ordinates of the center of the bolt/screw.
Number of sides - How many sides will comprise the thread barrel and other round components of the bolt/
screw (min 3, max 48, default 24 sides).
Load Parameters - Clicking on this button opens a standard file requester panel allowing you to load a 
previously saved parameter file.
Save Parameters - Clicking on this button opens a standard file requester panel allowing you to save a 
parameter file. Note that the parameters will be written to the file when the bolt or screw is generated.

The last two fields enable you to load and/or save files that record all the parameter settings for a given bolt or screw. 
This facility allows you to build up your own libraries of bolts and screws.



LightWave 2020  –  LightWave 2020

Reference –  1106

QuickBolt Presets

The Presets tab enables you to quickly select a common type of thread and QuickBolt will generate all the parameters 
automatically. Then all you need to do is select which components you require to be included in the final model and 
click on the OK button at the top of the QuickBolt panel.

Thread Type
A dropdown selection list with options of UN (Unified National), Metric, Whitworth, NPT (National Pipe Taper Thread), 
and NPS (National Pipe Standard Straight Thread). To create a preset, select the Thread Type and Coarse/Fine settings 
that you require.

Coarse/Fine
A selection list with options of Coarse and Fine. In combination with the Thread Type selector, it enables you to 
generate UNC, UNF, Metric Coarse, Metric Fine threads.

Thread Size
Next, click on the Thread Size and select the size from the list presented.
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Metric

Coarse

Metric

Fine

UN

Coarse

UN

Fine

Whitworth

Coarse

Whitworth

Fine

NPT NPS

Thread Fit Class
The Thread Fit Class may be changed from the default Standard fit to either Loose or Close for UN and Metric thread 
types. When you do so the Values Calculated For display will update accordingly.

HiLo Profile

1.

2.

3.

4.
5.

Note that:

The contents of this list changes to match the previous Thread Type and Coarse/Fine selections (see 
figure 3),
If you go back and change the Thread Type or Coarse/Fine settings the Thread Size will automatically 
reset to "select",
Metric Fine thread sizes are in the format of diameter#pitch (e.g. 3.0#0.5 represents a thread diameter 
of 3.0mm and a thread pitch of 0.5mm)
Currently the Coarse and Fine presets for NPT and NPS threads do not differ.
NPT threads are generated with a 1/16" per 1" taper over the whole length of the thread. NPS threads 
do not have this taper.


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You also have the option to choose to have a HiLo thread generated by selecting the HiLo Profile option. For more 
information on HiLo threads refer to the HiLo Thread Option page.
Values Calculated

Having chosen your Thread Type, Size and Coarse/Fine , the Values Calculated For display will now show the thread 
characteristics you have selected in a standard format.

Onwards
Having completed all your selections on the Presets tab you will find that the correct parameters will have been 
automatically filled in for you on the Thread, Thread Extras, Head, and Nut tabs. You should now go to these tabs to 
select further options (e.g. taper, shank, head, nut, etc.) prior to generating the object.

Note that selecting a thread using the Presets tab automatically enables the Thread tick-box on the Thread tab. 
Likewise, enabling the HiLo Profile on the Presets tab will also automatically enable this option on the Thread tab. The 
other tick-box options on the Thread, Thread Extras, Head, and Nut tabs are not automatically enabled and require 
you manually select what you want included in the object.

Like all the other QuickBolt tabs, the settings you select to generate a given bolt/screw/nut are remembered by 
QuickBolt, so that next time you run the plugin you save time by not having to select them again.

If you want to quickly clear all previous selections and reset values to default settings on all tabs, just click on 
the Reset To Defaults button at the top of the QuickBolt panel.


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QuickBolt Thread

If the Thread option is selected then a thread will be generated. If you want, you can just generate a thread on its own 
by leaving the tick boxes on the Thread Extras , Head and Nut tabs unchecked. The value input fields allow you to set up 
the basic parameters that define the shape of a thread.

In addition to a standard thread you can optionally create a HiLo Thread. You can also add a Taper to either a Standard 
or a HiLo thread.

The standard Thread parameters are:

Length - The overall length of the thread. A value of zero is illegal and will generate a warning message.
Pitch - The pitch of the thread (i.e. the distance between two adjacent crests of the thread). Values of zero and 
those greater than the thread length are illegal and will generate a warning message.
Major Diameter - The largest diameter of the thread. This is the distance between the axis of the thread and the 
crest of the thread measured perpendicular to the thread axis. Values of zero or those less than the Minor 
Diameter are illegal and will generate a warning message.
Minor Diameter - The smallest diameter of the thread. This is the distance between the axis of the thread and 
the root of the thread measured perpendicular to the thread axis. Values of zero or those greater than the Major 
Diameter are illegal and will generate a warning message.
Crest% - The width of the thread crest expressed as a percentage of the pitch. Values greater than 100%, or 
those that result in Crest%+Root% exceeding 100% are considered illegal and will generate a warning message.
Root% - The width of the thread root expressed as a percentage of the pitch. Values greater than 100%, or those 
that result in Crest%+Root% exceeding 100% are considered illegal and will generate a warning message.
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Direction - This pop-up allows you to specify the direction that the thread turns in. Options are either Left-
handed or Right-handed.

QuickBolt HiLo Thread Options
QuickBolt Taper
QuickBolt Create Profile

•

•

The Crest % and Root % values do not have to add up to 100%. However, if they do, then the walls of 
the thread will be at 90 degrees (e.g. with both Crest % and Root % set to 50% you'll end up with a 
thread resembling that of a car-jack).
Either or both Crest% and Root% can have zero values. This will produce a sharp crest and/or root to 
the thread.



If you are going to be doing a lot of work in either Imperial or Metric units then you can make life easier for 
yourself by changing the units in which Modeler displays numeric values of length/distance - open the Display 
Options panel (keyboard short cut D), click on the Units tab, then select the appropriate options.


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QuickBolt HiLo Thread Options

When this option is selected you will be able to generate a Hi-Lo thread and you will be able to adjust the parameters 
that define the shape of the Hi-Lo thread.

Note that in this instance the "Hi" component of the Hi-Lo thread is defined by the Standard thread parameters (i.e. 
Major Diameter, Crest %, and Root % are equivalent to Hi Major Diameter, Hi Crest %, and Hi Root %). The thread 
Length, Pitch and Direction values are common to both the "Hi" and the "Lo" components of the Hi-Lo thread.

The Lo Thread Parameters (see figures 1 and 2 below) are:

Lo Major Diameter - The diameter of the Lo part of the thread. This is the distance between the axis of the 
thread and the crest of the Lo thread measured perpendicular to the thread axis. Values of zero or those less 
than the Minor Diameter are illegal and will generate a warning message.
Lo Crest% - The width of the Lo thread crest expressed as a percentage of the pitch. Values greater than 50%, or 
those that result in Crest%+Root% exceeding 100% are considered illegal and will generate a warning message.
Lo Root% - The width of the Lo thread root expressed as a percentage of the pitch. Values greater than 50%, or 
those that result in Crest%+Root% exceeding 100% are considered illegal and will generate a warning message.
Hi/Lo Base Ratio - This allows you to specify the ratio between the base lengths of the Hi and Lo portions of the 
thread as measured along the Thread Minor Diameter (see Figure 2 below). A value of 0.5 means that the thread 
bases will be the same length. A value of 0.75 will produce a thread with the Hi Thread Base being 3 times that of 
the Lo Thread Base. Likewise, a value of 0.25 would mean that the Lo Thread Base would be 3 times that of the 
Hi Thread Base.
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QuickBolt Taper
When Taper Thread is selected you will be able to generate a taper to either a normal or a HiLo thread and you will be 
able to adjust the parameters that define the shape of the thread taper.

The parameters that enable you to change the Thread Taper are:

Taper Length - The length of the taper measured from the end of the thread. If the Taper Length exceeds the 
Thread Length a warning message will be generated.
Taper % - The value of the taper tip diameter expressed as a percentage of the thread diameter (range 0% to 
100%).

Taper Profile

Linear Concave Convex
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QuickBolt Create Profile
Create UN/ISO-Metric Profile
This button, located at the bottom of the Thread tab, enables you to quickly generate a non-standard thread size with a 
UN or ISO-Metric thread profile (i.e. a thread with a 60 degree internal angle between the sloping sides of the thread, 
and with the thread crest width half that of the root width). You need only specify the Length, Pitch, and Major Diameter
of the thread, and optionally specify if a HiLo thread is required (by ticking the HiLo Thread box). When you click on the 
Create UN/ISO-Metric Profile button the remaining thread parameters (e.g. Minor Diameter, Crest%, Root%) together 
with various parameters on the Thread Extras, Head and Nut tabs are automatically calculated ready for use. When 
you are happy with the values and the selections on the two other tabs, just click on the QuickBolt panel OK button to 
generate the object.



LightWave 2020  –  LightWave 2020

Reference –  1115

•
•

•
•

•
•

QuickBolt Thread Extras

Shank
Tip

The Thread Extras tab is where you select and define other items that can be added to the thread of the bolt or screw.

Shank
When this option is selected a Shank will be generated for the bolt or screw. A Shank is the smooth cylindrical region 
that lies between the head and the thread of the bolt or screw. A Shank may be generated in isolation.

The parameters that enable you to change the Shank are:

Diameter - The diameter of the shank. A value of zero is illegal and will generate a warning message.
Length - The overall length of the shank. A value of zero is illegal and will generate a warning message.

Note: To blend the Shank into the thread, the end of the Shank is tapered for a distance of 1.5 * "Thread Pitch" down to 
the Minor Diameter of the thread.

Tip
When this option is selected a tip will be generated for the bolt or screw. The tip is the smooth cylindrical region that 
protrudes beyond the end of the thread.

The parameters that enable you to change the Tip are:

Diameter - The diameter of the tip. A value of zero is illegal and will generate a warning message.
Length - The overall length of the tip. A value of zero is illegal and will generate a warning message.

1.

2.

The Shank can be selected independently and has no dependencies on any other components (i.e. 
should you wish to do so, you can just generate a shank). In contrast, the Tip can only be selected if the 
option to generate a thread has been selected (on the Thread tab).
Most of the values of the Thread Extras tab will be automatically generated if a thread was selected 
using the Presets tab, or if the Generate Symmetric Profile button was clicked on in the Thread tab.


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1.

2.

If the tip Diameter is set larger than the end of the threaded portion of the bolt or screw then a warning 
message will be displayed and the tip Diameter will be automatically limited to the diameter of the end 
of the thread. Typically, this might happen if you've decided to taper the thread and forgotten to 
reduce the tip Diameter correspondingly.
The tip Diameter may be set to a smaller value than the diameter of the end of the thread


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QuickBolt Head

Head
Drive Bit

The Head tab is where you select and define the head of the bolt or screw.

Head
If this option is ticked then the head of the bolt or screw will be generated. Note that you may, if you wish, just generate 
a head on its own - you are not required to have also selected a thread, shank, or nut. This is useful if you just want 
some bolt heads as components for a model you are creating.

The parameters are:

Type - This pop-up selection list allows you to select the type of head for the bolt or screw. The options are 
"Hex", "Square", "Round", "Dome", "Countersunk", "Oval" (i.e. like a Countersunk head, but with an oval upper 
surface), and "Hex Indented". See Figure 2 below for examples.
Diameter - The diameter of the head. A value of zero is illegal and will generate a warning message.
Depth - The overall depth of the head. A value of zero is illegal and will generate a warning message.
Chamfer - This drop-down list enables to to place a 25 degree chamfer on the top, bottom, or both surfaces of a 
hexagonal or square shaped head.
Base Finish - This pop-up selection list allows you to select the type of base which will be applied to the 
underside of the head. This option is only valid for hexagonal or square shaped heads with no bottom chamfer. 
The options are "Shoulder" (a high-tensile bolt style integral washer with outside diameter equal to the width 
across the flats of the head), "Washer" (an integral flat washer with outside diameter equal to 1.4 times the 
width across the flats of the head), and "Flange" (an integral washer with a rounded upper surface and with 
outside diameter equal to 1.4 times the width across the flats of the head). See Figure 3 below for examples.

1.

2.

The Head can be selected independently and has no dependencies on any other components (i.e. you 
can opt to just generate a head). In contrast, the Drive-Bit component can only be selected if the Head
component has been previously selected.
Most of the values of this tab will be automatically generated if a thread was selected using the Presets
tab, or if the Generate Symmetric Profile button was clicked on in the Thread tab.


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Note: 
1. When the "Dome" Head Type is selected, the curvature of the dome may be altered using the Depth parameter. For 
example, if the Depth is set to less than the half the Diameter, then a "Pan" shaped head can be generated.

2. The thickness of the Shoulder is fixed at 1.5875mm (0.0625") for thread major diameters greater than 12.7mm (0.5"), 
below this diameter the thickness is scaled to be 10% of the Depth of the head.

Head Type dropdown options Head Chamfer dropdown options Head Base Finish dropdown options

Head Types shown with a shank for illustration

Hex Square Round Dome Counter Sunk Oval Hex Indented

Base Finishes shown with a shank for illustration

Shoulder Washer Flange

Drive Bit
If this option is ticked then a drive bit recess will generated for the head of the bolt or screw. Note that this tick box will 
only be activated if you have also selected the option to make a head for the bolt or screw.

The parameters that enable you to change the Drive Bit are:

Type - This pop-up allows you to select the type of bit recess. The options are "Slotted", "Philips", 
"Allen","TORX" and "TORX Plus".
Width - The width of the bit recess. A value of zero is illegal and will generate a warning message.
Depth - The overall depth of the bit recess. A value of zero is illegal and will generate a warning message.
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Drive Bit Types applied to a Chamfered Hex Head for illustration

Slotted Philips Allen TORX TORX-Plus

Values have been changed from defaults to make better images
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QuickBolt Nut

When the Nut option is checked a nut will be generated. Note that the nut will be generated in the next free modeler 
layer to that of the thread.

Nut parameters are:

Type - This pop-up selection list allows you to select the shape of the nut. The options are "Hex" and "Square".
Diameter - The diameter of the nut. This is defined here as the line drawn through the center of the nut that 
connects two diametrically opposite corners. A value of less than 1.5 times the Thread Major Diameter is illegal 
and will generate a warning message.
Depth - The overall depth of the nut. Depth values of zero or greater than the Thread Length are considered 
illegal and will generate a warning message.

Chamfer Options

None Top Bottom Both

If you just want to generate a nut on its own, first select the thread characteristics (using either the Presets tab 
or by setting them manually on the Thread tab), then disable the option to generate a thread (uncheck 
Thread). Make sure you have the Nut checked, and then click on the QuickBolt OK button. A single nut will be 
generated in the first available Modeler layer.


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Primitives - More

Bubbles

The Bubbles tool (Create > Primitives > More > Bubbles) provides a quick and easy way to create bubbles, rocks, stylized 
clouds, and a variety of other interesting objects. This tool replaces each selected point in your foreground layer with a 
sphere.

To begin, create an assortment of points in the foreground layer. The Spray Points tool is particularly suited for this.

 
Once you are satisfied with the number and distribution of your points, select the Bubbles tool from the Create Tab in 
the Primitives section under More.

If no points are directly selected, the Bubbles tool will use every point in the foreground layer. Remember, 
more points mean longer calculation times.


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The options for creating the spheres are similar to those found in the Ball tool. Under Sphere Type, Globes are 
composed primarily of four-point polys (also known as quads) and can appear angular if they are created with a low 
number of sides or segments. Tessellated spheres are composed entirely of triangles and, using a comparable number 
of polys, will often yield smoother results.

If you choose Tessellated, the resolution of your bubbles will be determined by the Tessellation Level. Tessellation 
Level is similar to the Ball tool’s “Segments” setting, however, it is important to note that these settings are not 
identical. A Tessellation Level of 2 (which is the default) will produce significantly more polys than a Segment setting of 
2 with the Ball tool.

The default Tessellation Level should work for most bubbles. However, higher numbers (i.e. 4 or 6) can be used for 
extremely detailed objects. Though a setting of 6 will produce unwieldy individual bubbles with more than 100,000 
polygons each.

For Globes, the resolution of your bubbles will be determined by the number of sides and segments, which correspond 
to those in the Ball tool.

The Bubbles tool uses its own internal routines for varying the size of each bubble it creates, however you can 
determine the largest and smallest bubble size by adjusting the Maximum and Minimum Radius settings.

For the best results, use the Fit All command (a) to show every one of your source points. Then reference your Grid size 
before entering the Radius settings. If you enter a Maximum or Minimum radius that exceeds your Grid size, your 
bubbles will frequently overlap and produce undesirable results.

You name the surface for the bubble objects in the Bubble Surface field. The default is Bubble, although you can choose 
any name.

Once you are satisfied with your settings, click on the OK button. The position of each point will be recorded, after 
which the points will be deleted and bubble objects of varying size will be created in their place.

Tessellation Level has no effect when using Globe objects and Sides and Segments have no effect when using 
Tessellated objects.


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Platonic Solid Tool

The Platonic Solid tool is located in the Create Menu Tab under the Primitives group. This tool is very easy to use and 
can really speed up the modeling process. A platonic solid, as denoted by Euclid in the last proposition of his seminal 
mathematics textbook The Elements, is a polyhedron whose faces are all congruent regular polygons, and where the 
same number of faces meet at every vertex. The best known example is a cube (or hexahedron) whose faces are six 
congruent squares. Platonic solids are often used as a dice in role playing games, so if you want to make a D4, D6, D8, 
D12 and D20 easily, this is the tool for you!

The Shape pop-up menu on the Numeric Panel controls the shape of the object. It gives you seven primitive shapes to 
select from.

The Bubbles tool requires one undo for every bubble it generates, which means that running this tool on a 
large number of points may be impossible to fully undo. If you want to test different Sizes and Sphere settings, 
you should copy and paste your points to a new layer before running the Bubbles tool.
The Bubbles tool uses the points in the foreground layer, however polygons are ignored. As such, it is possible 
to achieve interesting results by running the Bubbles tool on one of your existing objects.


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The choices are:

Tetrahedron - the simplest of the platonic solids made with just four triangles.
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Cube - the best known of the platonic solids, otherwise known as a hexahedron.

Octahedron - an eight-sided object.

Cubeoctahedron - Although this panel is named the Platonic Solid tool, a Cubeoctahedron is not actually a 
platonic solid.
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Icosahedron - a 20-sided object made with triangles.

Dodecahedron - a 12-sided object made from pentagons.

Icosidodecahedron - This one isn’t a platonic solid either!

You can drag the center position handle to move the shape, and you can drag the outer bounding box edges to resize it. 
You can also use the numeric window to accomplish these options.

Wedge

The Wedge function (Create > Primitives > More > Wedge) will generate an annulus (like a flat donut).
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Axis - Axis is the axis perpendicular to the doughnut hole.
Sections - Refers to the number of radial sections to use for the object.
Height - Specifies the width of the object.
Inner Radius - Specifies the radius of the inner hole.
Outer Radius - Specifies the radius to the outside perimeter.
Start Angle - Start Angle is the starting angle around the selected Axis.
End Angle - End Angle is the ending angle around the selected Axis (360 for a complete doughnut).

Gear

The Gear function (Create > Primitives > Gear) creates a gear-shaped object. This tool is very similar to the Gears 
function (discussed next) but has fewer options.
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Teeth - Refers to the number of teeth in the gear.
Taper % - Sets the “pointiness” of the teeth. A higher setting creates sharper teeth.
Inner Radius - Refers to the distance from the center of the gear to the bottom of the teeth.
Outer Radius - Outer Radius is the distance to the outside edge of the teeth.
Thickness - Thickness is the width of the gear.
Axis - Axis is the perpendicular axis of the gear.
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Gears

True to its name, the Gears tool (Create > Primitives > More) quickly creates gear-shaped objects. Before describing the 
controls, let’s first take a look at what’s happening behind the scenes.Gear objects are composed of a disc shaped 
object with protrusions called “teeth.” Each tooth is made up of four points.

Two points comprise the base of each tooth, and two the top. Therefore, a gear with two teeth would be made up of 8 
points, a gear with four teeth would consist of 16 points, and so on.When you run the Gears tool, it first looks at the 
number of teeth you requested. It then multiplies the number of teeth by four (the number of points required for each 
tooth) and creates a disc using this total number of points.

The diameter of the disc is determined by you, and is called the “Inner Radius.”
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Here you can see that a disc with 24 points has been created. At four points per tooth, this will yield a gear with six 
teeth. An existing gear with six teeth can be seen in the background.Once the disc has been created, pairs of points are 
selected and moved outward. The position these points are moved towards is determined by you, and is called the 
“Outer Radius.”

Finally, the four points comprising each tooth are tapered by approximately 65%.
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Once the basic gear shape has been created, it is extruded to a Thickness specified by you.

To complete the gear, a hole is punched out of the center. This is accomplished by the creation of a disc whose 
diameter is exactly half the size of the Inner Radius. It is extruded, placed in the background, and used as a cutting 
template for a Boolean Subtract operation.
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This entire process happens internally, and is transparent to you. Now that we’ve looked at how gears are created, let’s 
take a look at the controls offered by this tool.

The first row of buttons determines the axis the base gear object will face once it has been created. It also determines 
the axis along which the gear object will be extruded using the Thickness setting (mentioned below).

The Number of Teeth enables you to set the number of teeth your gear will have. Note that at least three teeth are 
needed for a usable gear, and that entering 1 for the number of teeth will not result in a gear at all, as shown below.
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The Inner Radius determines the diameter of the gear’s base. This is the location from which each of the teeth will 
project outward.

The Outer Radius determines the length of the gear’s teeth. This is the location that the two points forming the top of 
each tooth will move towards. Note that it is possible to make the Outer Radius smaller than the Inner Radius. Doing 
this will still create a gear shape, although the teeth will appear to taper outward rather than inward.

 
The Thickness field determines the depth of the gear, which is the amount that the gear will be extruded. Note that the 
extrusion occurs along the Axis set by you at the top of the window.Under Gear Type, Angular is the default option, and 
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creates gears using the method described above. Smooth uses the Inner and Outer Radius to interpolate a smooth arc 
between the top and bottom of each tooth.

Bear in mind that smoothing is computationally intensive, and will take longer to calculate. Also, it will create an object 
with a higher number of points and polygons. Finally, the Center option determines the exact center for your gear, 
which can be useful for positioning gears that are offset precisely from one another. The three fields correspond to the 
X, Y, and Z axis respectively.
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Gemstone

You can quickly make a nice round-cut diamond with the Gemstone Tool (Create > Primitives > Gemstone Tool).

On the Numeric Panel you can control various aspects of your diamond. Center sets the center position and Radius the 
overall radius of the object.
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Higher Symmetry  values increase the number of polygons used on the crown and lower values decrease the number. 
The Crown, Girdle, Table and Pavillion settings control the size of those areas on the diamond. (See illustration below 
for reference.)

Make UVs

The Make UVs option at the bottom of the various primitive Numeric Panels assigns some default UVs based on the 
geometry of the object. Note that a UV Texture Map must be currently selected or this option will be ghosted.
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Make Air Polys

Make Air Polys will create duplicate polygons facing inside the Gemstone with the surface name of “Air”. This is a 
throwback to LightWave's original camera, no longer included. It should only be used for export to other engines that 
cannot deal with volume stacking.

SuperQuadric

Use the SuperQuadric tool (Create > Primitives > SuperQuadric) to create quadrics objects interactively. You can choose 
between two shapes: Ellipsoid (spherical) and Toroid (doughnut).

Toroid on the left, Ellipsoid on the right (with Top and Side Bulge set to 3)

Ellipsoid

You can use standard drag handles to manipulate the shape and position interactively.



LightWave 2020  –  LightWave 2020

Reference –  1139

1.
2.
3.

•

•
•
•
•

Interactively sizes the object by clicking and dragging here with the LMB .
Interactively Center the object by clicking and dragging here with the LMB .
Interactively sizes the Hole in the object by clicking and dragging here with the LMB .

The Numeric Panel provides more detailed control.

Axis - determines the major axis for the object. This is also set when you click to first create the ball using the axis 
perpendicular to the (orthogonal) viewport.
Sides - determines how many horizontal segments should be used around the Object.
Segments - sets how many vertical segments should be used.
Center - The XYZ coordinates of the center of the Object.
Size - Overall dimensions of the object.
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Hole Size - This option is only available for the Toroid Shape. This setting defines the inner radius of the toroid.
Top Bulge - This setting defines the vertical curvature of the geometry.
Side Bulge - This setting defines the horizontal curvature of the geometry.
A perfect circle - looking along the set Axis - can be made by setting the Side Bulge to 2. A value of about 5 yields 
a rounded square shape.

Make UVs

The Make UVs option at the bottom of the various primitive Numeric Panels assigns some default UVs based on the 
geometry of the object. Note that a UV Texture Map must be currently selected or this option will be ghosted.

Parametric Surface Object

The Parametric Surface Object function (Create > Primitives > ParametricObj) creates parametric surfaces based on the 
equations entered for X,Y, and Z in terms of UV coordinates. The function lets you create the object using Triangles, 
Rectangles, Curves, or just points (None).

Plot 2D

The Plot2D function (Create > Primitives > Plot2D) generates a two-dimensional surface in the XY plane consisting of 
Triangles, Rectangles, Curves, or points (None). The height (in the Z direction) is determined by the value of the 
expression in the Equation field at each division in the X and Y axes.

A quadric is a shape made of the squares of the coordinates, a generalization of a sphere, which is x2 + y2 + z2.
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In the fields labelled X Min, X Max, Y Min, and Y Max, enter the boundaries for the surface. In the XMesh and YMesh fields, 
enter the number of divisions along that axis.

Equilateral Triangle

Equilateral triangles are three-sided polygons whose sides are all equal in length. The Equilateral Triangle tool is found 
under Create > Primitives > More.
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Side Length determines the size for each of the triangle’s sides. The Axis buttons determine the direction along which 
the polygon’s normal will run, or simply, which way the triangle will be facing.

Using this technique, you can quickly and interactively create perfect triangles, diamonds, pentagons, hexagons, etc.

StarSphere

When you want to create a starfield with parallax, you can sprinkle some points around, convert them to polygons and 
give them surface names, but why bother? NewTek engineers have done all the hard work for you with StarSphere. This 
generates up to nine layers of single point polygons which all have different levels of magnitude allowing you to create 

You also can create an equilateral triangle using either the Ball or Disc tool. If you hold down the Ctrl key or 
use the middle mouse button to drag out a circle in one viewport, you will constrain the width and height, 
ensuring a perfect circle. Now click N to bring up the Numeric Panel and set Sides to 3.


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convincing starfield models quickly and easily.

The first parameters to set are how big you want the StarSphere to be and whether you want it spread over nine layers, 
or have it compressed down to one. The remaining settings are how many of each sort of star you wish to have in your 
StarSphere. Actual magnitude distributions are hard to come by and vary from location to location, so the default 
settings have been left at 100 stars of each magnitude, but it’s likely that you will have far fewer bright stars than faint 
ones, so your lower magnitude stars (Magnitude 2 - 6) should probably vastly outnumber your brighter stars (Magnitude 
-2, - 1).
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 Using the StarSphere Generator will create a new object.
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Text

The Text tools provide several ways to create 3D text objects, from a single word to multiple lines of text. A variety of 
controls over the look of the final text are provided, including beveling and extrusion depth, as well as how smooth the 
curved portions of letters will be.

OS Font Support in Modeler

 
As of 2015, Modeler supports any font your OS does. This means you can now use OTF fonts as well as Type 1 PS fonts 
and TTF. High ASCII characters can be input in the usual fashion in Windows by holding the Alt key and typing the three- 
or four-digit ASCII code on the Numeric keypad. Under OSX you need to refer to a chart for how to enter specific 
characters. On both, you can copy and paste existing characters from elsewhere into the Text Tool’s text entry field on 
the Numeric panel.

Manage Fonts
Text Tool
Logo
Multi Text
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Manage Fonts

(default keyboard shortcut F10)

Use the Font pop-up menu to select the font for your object. Clicking the Add Type-1 button brings up a file requester 
where you can load a PostScript font. If you have PostScript fonts, the files often have a .pfb filename extension. Click 
Remove Current Choice to remove the selected font from the font list. Remove All Manual Fonts will purge the entire 
list.

Import List brings up a file requester where you can load a previously saved font list file. This can be the Lwm.cfg file. 
Export List brings up a file requester for saving the current font list to a file. Note that the font list is automatically saved 
when you exit Modeler, so it is not mandatory that you save the list. Use this option to create custom file lists for special 
purposes.

LightWave will automatically populate its font list with any font available to your operating system including PostScript, 
TrueType and OpenType formats.

The clearing operations do not affect the actual files stored on your hard drive. Also fonts in the list utilise no 
RAM until used.


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Text Tool

(default keyboard shortcut Shift W)

The Text tool (Create > Text > Text) lets you interactively create type objects using any font available to your operating 
system including PostScript, TrueType and OpenType formats. Once you create them, these objects can be bevelled, 
extruded, drilled, and more.

When you first click in a viewport after selecting the Text tool (Create > Text > Text), the text insertion pointer appears. 
You can just start typing to create the Text template.
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The Text Insertion Pointer

You can use the Backspace or Delete keys to clear the last character typed. To clear the entire text line, press Shift + 
Backspace or Shift + Delete. If you need to use a Modeler keyboard shortcut, like the N key, while using the Text tool, 
first press the ESC key to exit the Text tool, then press the desired shortcut key.

Modifying the Template

The position of the text is referenced to the bottom left of the pointer. You can reposition the text in any viewport. 
Dragging the sizing handle up or down will scale the text larger or smaller. Dragging the kerning handle will adjust the 
amount of space between characters.Text will be aligned with reference to the vertical bar. Pressing the Tab key will 
cycle through the alignment options.

You can cycle through the font list using the Up and Down cursor keys or you can use the numeric requester. If you have 
already started a template, the font will change.

You must deselect the Text tool to actually create the object. This can be done by clicking on any other tool button, 
mode button, the Make button or hitting the Return key. The Text tool cannot be dropped with the / key (Drop tool) 
because it is interpreted as text input. Alternatively, clicking your RMB will create the object and also move the template 
to your mouse pointer position. You can quickly make unlimited copies of the text in this manner.

The number of points used to approximate curves in characters depends on the setting for Curve Division on the 
General Options Panel (Modeler > Edit > General Options).

If you realize you are creating your text in the wrong viewport, click in the grey empty area of the interface - the 
text you have created in the viewport will disappear, but you will notice that the Text tool button remains 
highlighted and active. Click in the correct viewport, and your text will reappear in that viewport.
The characters that are available within the selected font may be limited. You may or may not have all possible 
characters allowed by the font type depending on whether those characters were created in the font originally.


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The Text Numeric Panel

The related Numeric Panel provides interactive feedback and also lets you set options numerically. Axis is the 
perpendicular axis used in creating the text; however, it is usually set interactively by clicking the mouse in a view 
window. The Text input field lets you enter the text to generate into a 3D object.

From the Font pop-up menu, you can select any of the fonts defined in the previously discussed Fonts List.

Some fonts, when converted into 3D objects, have additional points near their corner vertices. When these polygons are 
beveled, these additional points can cause beveling inaccuracies. Use the default setting, Sharp, for the majority of your 
text generation, as this will avoid the creation of such points. The Buffered setting allows the additional points to be 
created.

The Alignment setting determines how the text is aligned around the text insertion pointer.

Center is the XYZ position of the insertion point; however, it is usually set interactively by clicking the mouse in a view 
window. The Scale value sets the general height of the text; however, the actual size may be less and will vary from font 
to font. Kern sets the spacing between fonts and depends on the font’s own characteristics. Negative numbers are 
allowed to bring characters closer together.

Characters with separate parts, such as i, é or ; will have an edge joining the parts making selecting the whole letter 
more easy. This edge won’t appear in renders unless you specifically want it to use Object Properties > Edge options in 
Layout.
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These lines might look odd in shaded OpenGL display modes, but there’s nothing wrong.

The Scale setting (Numeric Panel) cannot be set to zero or a negative number.
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Logo

The Logo tool (Create > Text > Logo) generates 3D text. Before using this utility, you must have at least one font loaded 
into Modeler.

The Logo Maker Panel is straightforward.

In the Logo Text field, you enter the word or phrase that you want extruded. Multiple lines of text are not supported. 
(Multiple lines of text can be created with the Make Text or Multi Text tools.) ASCII characters may be entered by 
pressing the Alt key and the four-digit ASCII code. ASCII characters may not display properly in the Logo Text field, 
however they will be properly generated in the final object.

The Logo tool will create your text object in Modeler’s Back Viewport and extrude it along the positive Z axis. The 
Extrusion Depth setting determines the size of the extrusion.

You choose the typeface in the Select Font popup list. Remember that only fonts that have been loaded with the Edit 
Fonts tool will be displayed in this menu.

If you use a Dingbat font with the Logo tool, you can quickly generate 3D arrows, starbursts, and other 
common design elements.


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Multi Text

The Multi Text tool (Create > Text > Multi Text) generates multiple lines of text and gives you control over size, kerning, 
and leading. In addition, it can load ASCII text files, making it a versatile text generation tool.

As with the other text tools, you must have at least one font loaded into Modeler before you can use this utility. Any font 
available to your operating system including PostScript, TrueType and OpenType formats is usable.

Clicking on Multi Text will bring up the text layout panel.

This window can be broken down into two sections. The top section contains text formatting options, while the bottom 
section contains text entry options. You begin by choosing your typeface from the Font pulldown menu. Remember that 
only fonts which have been loaded with the Edit Fonts utility will be displayed in this list.

The Alignment tool specifies the alignment for all the lines of text. The choices of Left, Center, and Right operate just 
like their counterparts in word processing programs.

The Axis buttons determine which direction the text object will face once it has been created.

The Corner buttons determine whether or not extra points will be created around the hard angles of the characters in 
your font. Many letters, like an M, have sharp angles. When you extrude these letters, you wind up with sharp edges, 
which look unrealistic when rendered because they lack the tiny bevels needed to catch the specular highlights. These 
bevels require extra points in the letter’s polygons; and by selecting Buffered Corners, the extra points needed to round 
and refine your polygon’s sharp edges are added.

The following picture shows the letter M generated with Sharp Corners.
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Notice that almost every corner forms an angle of 90-degrees or more. Now take a look at the same character generated 
with Buffered Corners:

Extra points have been created around the sharp corners. These points act as a buffer, allowing you to move or delete 
the points at the edges to create a bevelled shape (as in the example below).

Occasionally, when making a relatively large bevel with the Bevel tool, buffer points can cross over each other and 
produce render errors. If this is the case, try regenerating your text using Sharp Corners and using the Edge Bevel tool to 
compensate for any sharp edges.
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The Center input fields correspond to the X, Y, and Z coordinates, which determine both the left margin and base for the 
text object. More often than not, this can simply be left at its default, of 0, 0, 0 that used on a left-aligned text block, will 
produce an object which rests on the ground and is situated to the right of the origin. The image below uses center 
alignment.

The Scale setting determines the height of the font from its lowest point to its highest point. It’s important to note that 
the Scale setting does not measure the height of your font from the baseline up. Certain characters, such as the lower 
case p, q, and g, all fall below the baseline. And characters like f, h, and k rise higher than the more common a, s, and e. 
The Scale setting looks at the lowest and highest points in your typeface and scales the font so that the range between 
them matches your target size.

The Kerning setting determines the spacing between letters. Kerning is determined by “em” space and is measured in 
percentages, with 100% being equal to the width of the capital M in your chosen font. Negative values will bring your 
letters closer together. Positive values will spread your letters farther apart.

Line Pitch refers to the spacing between lines of text (also known as leading). A value equal to the Scale of your text will 
usually produce good results. Increasing this value will push the lines further apart. Decreasing this value will pull the 
lines closer together.

The Load Text and Save Text buttons enable you to import and export ASCII text files for use with the Multi Text tool. 
ASCII character codes are respected in these files, allowing you to utilise the extended character set of most fonts.

The Clear Text button will erase all text in the composition window, leaving you with a clean slate.The lower half of the 
Multi Text tool enables you to enter and compose blocks of text.



LightWave 2020  –  LightWave 2020

Reference –  1156

Text is entered one line at a time, and text lines can be entered in any order you desire. Before entering text, you must 
select the line onto which the text will be placed. The selected line will highlight as in the example above.

Once a line has been selected, text can be entered into the field at the bottom of the window. Pressing the Enter or Tab
key will place the text into the selected line.

To edit a line of text, simply select it with your mouse. The text from that line will appear in the entry field at the bottom 
of the window. Proceed to edit the text, then press Enter or Tab when you are finished.

To clear a single line of text, select it with your mouse, then delete the text from the entry field at the bottom of the 
window. Pressing Enter or Tab will accept your changes and wipe the line clean.When you are satisfied with your 
settings and text layout, press the OK button. A new text object will be generated. Should you find that a particular 
setting was incorrect (such as the Kerning or Line Pitch), simply delete your text object and run the Multi Text tool again. 
Multi Text retains the settings from its last use through the duration of your Modeling session. Note that once Modeler 
has been shut down, however, your Multi Text settings will be lost.
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Text - More

Text Layers

(Create > Text > More > Text Layers)

The Text Layers tool allows you to type letters, numbers, and other symbols and automatically have them beveled and 
extruded. Text Layers also has multiple layers and settings options.

Text Tab

Preview All - Checked, this previews all text. Unchecked, this previews only the first character.
2D - Checked, previews the text in 2D only.
Text -   This is where you enter all characters. You can even copy and paste from a text editor and all characters 
will be copied over until a carriage return is found.
Font - Select the font you want to use here.
Corners - Some fonts, when converted into 3D objects, have additional points near their corner vertices. When 
these polygons are beveled, these additional points can cause beveling inaccuracies. Use the default setting, 
Sharp, for the majority of your text generation, as this will avoid the creation of such points. The Buffered setting 
allows the additional points to be created, should you decide that you wish it.
Font Spacing - Increases/Decreases the amount of spacing between characters. Negative numbers will start 
spacing the letters in reverse.
Font Scaling - Increases/Decreases the size of the characters.
Extrude Extent - The amount the characters will be extruded.
Bevel Type :

Single - The bevel is made with only one segment
Round - The bevel is made with a convex edge
Corner Round - The bevel edge is rounded at the corner of the segment
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Hollow - The bevel edge is made with a concave edge
Corner Hollow - The bevel edge is inset with a Hollow edge
Bevel Shift - The distance the characters will be beveled out.
Bevel Inset - Affects the size of the bevel.
Bevel Segments - The number of segments created in the bevel.
Mirror - Mirrors the effects on the characters along the axis.
Disconnect Bevel Polygons - Unwelds the beveled edge from the rest of the model.

Surfaces Tab

Separate Surfaces - Checked, allows you to save a surface name for Face, Side, and Bevel. Unchecked, a single 
surface name will be given to all of the characters surfaces.
Face - The front and back surface of the characters
Side - The side surface of the characters
Bevel - The beveled edge of the character mesh

Layers/Export Tab

Determines how the characters are laid out in Layers for Modeler.

Layers : Per Letter, creates a new layer for each character. Per Word, creates a new layer for each word. Single, 
creates one layer for entire text.
Center All : Checked, will center all text at 0,0,0.
Pivot Positions : Determines the pivot point for each layer. Center will create the pivot point at the center of the 
text in each layer. Bottom Left will create the pivot point at the bottom left of the text.
Create Object : Create an object file for the text.
Object File : Determines the name and location of the object file.
Create Scene : Creates a scene file for the text.
Scene File : Determines the name and location of the scene file.
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Points

Points are the fundamental building block of 3D objects and have an XYZ location LightWave provides a variety of tools 
for point creation, ranging from one at a time with precision to mass creation of points with random locations.

Point
Add Center Point
Spray Points
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1.
2.

3.

4.

Point

(default keyboard shortcut +)

Point coordinates are the minimum information from which the geometry of an object can be calculated.

Remember a point needs to have X, Y, and Z coordinates. You can create points in real-time or by positioning first and 
then creating. As with every tool in Modeler you can choose to create a point with the Numeric Panel.

Creating Points

Choose ( Create > Points > Points ) from the menu or use the + key to activate the Point tool.
In any viewport, with your LMB drag the large crosshairs to the desired position (you can reposition in any 
viewport). The information display (bottom-left corner) will give you position feedback as you move your mouse.
Click the RMB to create the point. Be careful not to move your mouse pointer. Deselecting the Points tool will 
also create the point, if you don’t have a steady hand. Deselecting and then reselecting the Points button will 
create the point and keep you in the create point mode.
You can also position the point by dragging with your RMB . However, the points will all be created along the 
same plane (when you release the RMB ).
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1.
2.

Alternative Method to Create Points

Choose ( Create > Points > Points ) from the menu or use the + key to activate the Point tool.
Move the mouse to the location where you wish to create a point - the information display (bottom-left corner) 
will give you feedback as you move your mouse - and click the RMB to immediately create the point.

You can click down a point with the RMB and then, if you need to adjust the location, immediately click the LMB and 
move the point. Alternatively you can simply click the RMB to quickly lay down a string of points in succession and 
move them later using something like the Drag tool.

You can convert the point you’ve just made into a polygon by pressing P.
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Add Center Point

This tool adds a point to the bounding box center of a selection. It works across multiple layers, but will put the point on 
the first layer selected.
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Spray Points

Creating one or two points is not hard, but what happens when you need to create hundreds or even thousands of 
random points for objects such as stars, gasses or bubbles? Enter the Spray Points tool, (Create > Points: Spray Points), 
which works like a splatter gun to create a random assortment of single point polygons.

After selecting the tool, click in any viewport (including the perspective viewport!). A blue crosshair appears surrounded 
by a larger blue circle. The crosshair represents the center position of the Spray Points tool. The circle represents the 
radius within which points will be created.

The radius can be adjusted either numerically or interactively. To adjust the radius numerically, open the Numeric 
window (N).

Click in the field entitled Radius, type a new number and press Enter. (You can also use the slider to the right of the 
numeric field to make the radius larger or smaller).

To adjust the radius interactively, click the RMB in any viewport and drag. The radius circle will jump to the position of 
your mouse cursor. To make the radius smaller, drag your mouse towards the crosshair. To make the radius bigger, 
drag it away from the crosshair.
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To create points, drag your mouse while the LMB is held down. Simply clicking the LMB will not result in the permanent 
creation of new points. To see this in action, try clicking once, then moving your mouse to a new location and clicking 
again. You’ll notice that the points from your previous click disappeared and a new set of points was created under your 
mouse pointer. For the tool to generate permanent points, you must continue to hold down the LMB while dragging in a 
viewport.

The number of points created as you drag can be adjusted by the Rate setting on the Numeric Panel. A low rate setting 
will cause fewer points to be created as you move your mouse. A high rate setting will cause more points to be created.

The Spray Points tool doesn’t just create points, it creates single point polygons (also known as Particles), which means 
they can have Vertex Color Maps applied to them and will be visible in a render with those assigned characteristics. 
Points themselves can have vertex maps assigned to them regardless of whether they have polygons attached to them 
or not. In the case of color maps those cannot be seen unless the points are attached to polygons.

If you would like to use a Color Map with the Spray Points tool, simply click the Add Vertex Color checkbox and type a 
name for it into the Map field. If you have already created one or more Vertex Maps, you can use the drop down arrow to 
select one from the list.

Modeler will not display the Vertex Map in any of its viewport displays, however you can see the effect of the Color Map 
by running Vertex Paint from Modeler’s Map menu.
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Points - More

Random Points

Use the Random Points command (Create > Points > More > Random Points) to create a defined number of points 
distributed randomly.

You can choose between a Square or Sphere shape. Constant generally confines the points to the selected shape, while 
Falloff tapers off the point distribution along the perimeter.

Stipple

The Stipple tool (Create > Points > More) will cover the surface of your object with an even array of points. When used in 
conjunction with the Kill Polys tool (K), (Construct/Reduce/Remove/Remove Polygons), it is an effective way to 
generate uniform and predictable arrangements of points.To use the Stipple tool, place your geometry into the 
foreground layer. When you click the Stipple button, the Regular Surface Points Panel appears with fields for X, Y, and Z 
spacing for the points which the Stipple tool will create.
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The initial spacing values reflect the dimensions of your object and are a good place to start experimenting. (You can 
undo the results of the Stipple tool by hitting Ctrl Z twice.) If you lower the Spacing settings, you will generate more 
points and position them closer together. Increasing the Spacing settings will generate fewer points and position them 
further apart. As always, the smaller the spacing settings, the longer the processing time.
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Polygons

Polygons are multisided geometric shapes which are arranged so as to make a continuous surface for a 3D object. 
LightWave provides several tools for creating polygons, some of which use points you have already created, and some 
of which create the points as well as the resulting polygons.

Make Polygon
Pen
Line Pen
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Make Polygon

(default keyboard shortcut P)

The Make Polygon tool (Create > Polygons > Make Polygon) allows you to turn selected points into a polygon. Excluding 
the one and two-point specialty polygons, polygons should contain at least three points. You will likely find that your 
finished objects are constructed of a variety of polygons with different numbers of points.

To create a polygon from points:

In the Point Selection mode, create or select your points in a clockwise order. Then, click Create > Polygons: Make 
Polygon, or use the keyboard shortcut P.

Don’t get discouraged if making polygons seems very tedious. Not that it isn’t, but most of the time you’ll 
create your objects by starting with primitives. Usually, creating polygons from points is the exception rather 
than the rule.
You might hear artists talking about building objects point by point. This is the method they are referring to.



Once you create a polygon, you’ll want to view it in the Polygon Selection mode to see if its surface is facing 
the correct direction based on the normal. If you are using the back view for example, selecting points 
clockwise and making a polygon will create it with the face or normal of the polygon facing you. Counter-
clockwise selection of the points will create a polygon that faces away.


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Pen

The Pen tool (Create > Polygons > Pen) gives a quick way to create polygons on the fly, and creates the points as part of 
the process.

To create a polygon with the Pen tool:

Choose Create > Polygons > Pen and click in a viewport with your LMB. A polygon is created using points you define by 
clicking. If you drag with the mouse button, you can refine the point’s position before you create it, which happens 
when you release the mouse button. You do not need to click in the same viewport for each point. Once you have the 
polygon defined as you wish, you can finalize it by clicking the Pen tool off.

If you wish to create multiple polygons, then once you have completed a polygon, move the mouse cursor to where you 
wish to place the first point of a new polygon, click the RMB, then continue to build the new polygon using the LMB.

While the pen tool is active, you can click on and drag any point using the LMB to edit its position.
If you create a new point in your polygon by clicking to closely to an existing point, Modeler can think you are 
editing the existing point and not create the point. If this is the case, simply click at a location that is not close 
to an existing point, then drag the new point to its desired location.


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The Add Point button allows you to interactively add a point to your newly created polygon.

The point will be positioned at the same location as the last created point, so may not be obvious until you 
change its position either with the numeric panel, or by clicking on it and dragging with the LMB .
Once you create a polygon, you’ll want to view it in the Polygon Selection mode to see if its surface is facing 
the correct direction based on the normal, as discussed elsewhere. If you are using the Back view for example, 
creating points clockwise will make a polygon with its face or normal facing you. Counter-clockwise creation of 
the points will make a polygon that faces away.


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Line Pen

Create > Polygons > Line Pen - Line Pen is a polygonal sketching tool. If you use it to create interconnected lines, it will 
create a two-point poly chain, useful for hair guides and dynamics. If you connect lines to make closed shapes, Line Pen 
will create polygons. If you have existing polygons and draw additional lines attached to them, Line Pen will make those 
lines into polygons too.

Lines do not have to be sketched in a void. You can draw on existing polygons and holding Shift as you draw allows you 
to draw out from the normal of the polygon you are drawing on. Holding Ctrl will constrain the lines to an axis, in 
common with other Modeler tools.
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Polygons - More

Make 1-pt Polygons

Create Poly Chain

Edges 2 Poly

Metaballs
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Make 1-pt Polygons

Sometimes you will want to turn single points into polygons. This is necessary for objects like stars in a starfield, since 
you cannot assign surface attributes to a point, and points don’t appear in renders. Choose Create > Polygons > Points 
to Polys to turn selected points into single-point polygons (also known as Particles).
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Create Poly Chain

When you create points the normal process is to hit P to create a polygon. This causes problems if you actually want to 
make a chain of 2-point polys for fibers or similar. Create Poly Chain will not seek to create a closed polygon, but rather 
such a chain of 2-point polys.



LightWave 2020  –  LightWave 2020

Reference –  1175

Edges 2 Poly

(Create > Polygons > More > Edges2Poly) Creates a polygon based on the edges selected. Any necessary edges to 
complete a closed polygon will be added (for instance selecting three edges arranged in the form of a rectangle, the 
remaining edge will be added).
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1.
2.

1.

Metaballs

Metaballs is one of three Meta-primitives in LightWave. Meta-primitives are similar to HyperVoxels except that they are 
polygon-based, and their surface and interaction is more apparent and viewable in Modeler. In fact, Meta-primitives are 
a good place to start before you set up with HyperVoxels, because of their real-time feedback. All Meta-primitives will 
interact with each other if they are in the same layer, even though they are different types..

To draw a Metaball object:

Activate the Draw Metaballs tool. ( Create > Polygons > More > Metaballs )
Click in a Modeler viewport. Use any Rendering Style other than Wireframe and you will see the metaball

You can move the metaball by dragging its center handle. You can change its size by dragging the sizing handle 
that looks like an orbiting circle.
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2.

If you click anywhere else, another Metaball will be created.

If you move or increase a metaball so that its surface approaches the surface of another, they will adhere to each 
other, like the stuff in a lava lamp.
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1. Drop the Draw Metaballs tool (i.e., reselect it or press the space bar).

Converting to Metaballs

You can also convert points into plain Metaballs using the Make Metaballs command (Construct > Convert > Convert 
Metaballs).

Metaball Appearance

The amount of detail for displaying Meta-primitives is handled by the Metaball Resolution setting on Modeler’s General 
Options Panel (Modeler > Edit > General Options). The value represents the number of subdivisions (pixels per metaball 
on the screen). To get a smoother surface, increase the value. There is no limit.

You can also toggle the Meta-primitive mesh on/off by choosing Construct > Convert > Toggle Metamesh. You may want 
to do this if you have a lot of Meta-primitives and your display refresh is too slow. This is not just a display change and is 
similar to toggling off SubPatches. If you save a Meta-primitive with the mesh off, you will not be able to see the surface 
in Layout.

You can surface Meta-primitives as you would any object; however, you are allowed only one surface per layer.
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Animating Meta-primitives

You can animate Meta-primitives the same way you would animate any object. Of course, you won’t take advantage of 
their benefits unless you animate point positions. For this, you can use features like morph targets, bones, 
Displacement Maps, and so on. Note that only Meta-primitives in the same layer will interact with each other.

Editing Meta-primitives

Activate the Edit Metaballs tool (Construct > Convert > Edit Metaballs) to edit existing Meta-primitives. On the Numeric 
Panel, you can adjust the Radius and Influence.

Radius and Influence Settings

The Numeric Panel has Radius and Influence settings. Radius is simply the size of the Meta-primitive ball. Adjusting the 
Influence changes the interaction between balls. Setting a negative Influence will invert the primitive causing it to eat 
away neighbouring Meta-primitives instead of blending.

Deactivate the tool by dropping it, reselecting it, or hitting the space bar when you are done.

Meta Edges

Meta-Edges is one of three Meta-primitives in LightWave. To draw Meta-Edges:

Activate the Draw Meta-Edges tool. ( Create > Polygons > Metaedges )
Metaedges are essentially multi-point versions of plain Metaballs. Your initial clicking point establishes the first 
point. Hold the LMB down and drag out the second point. Other than there being two points, this tool works just 
like the Draw Metaballs tool.
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3. You can move each end of the Meta Edge object by dragging its center handle. You can change its size by 
dragging the sizing handle that looks like an orbiting circle.

If you click anywhere else, another Meta-Edges object will be created.
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4.

5.

If you move or increase meta-edges so that its surface approaches the surface of another, they will adhere to 
each other, like the stuff in a lava lamp.

Drop the Draw Meta-Edges tool (i.e., reselect it or press the Space bar) .

Converting to Meta-Edges
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Meta-edges can be created from two-point polygons or curves. Simply select the polygon/curve and choose Construct > 
Convert: Convert Metaedges.

The third type of MetaPrimitive is called a MetaFace. There is no tool to draw a MetaFace; it is created from 
existing geometry.


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1.
2.

Curves

Click here to expand Table of Contents...

Sketch Tool Bezier Plot 1D Spline Draw Spline Cage Make Curve
Creating from Points
To delete points from a curve:
Curve Direction
Using Control Points
Smoothing Two Overlapping Curves
Turning Curves into Polygons
Using Modeling Tools on Curves

In addition to making polygons from points, you can also create curves. Curves are a powerful Modeling tool and help 
you create smooth edges and flowing organic objects or object details. They are also used for some Modeling tools as a 
directional path.

You can create curves using a minimal number of points, yet achieve a smoothness that would take many times the 
number of points if you attempted to mimic the curve with a polygon. Moreover, with fewer points, it is easy to subtly or 
dramatically change the curve’s shape. However, by themselves, curves will never render in a finished image. They are a 
freeform Modeling tool used to create polygonal objects.

There are two types of curves: open and closed. An open curve has a beginning and an end - essentially a curving line. A 
closed curve has no beginning or end; it is a closed loop. A circle is a closed curve.

Sketch Tool
Bezier
Plot 1D
Spline Draw
Spline Cage
Make Curve

Creating from Points

You can also create curves from points in a similar manner to creating polygons.To create a curve:

Create a few points. Clicking with your RMB using the Points tool  ( Create > Points > Points ) will work.
Your points must be selected in the order you want the curve to flow. However, if you immediately go to - or 
were using - the Point Selection mode, the points should already be in the selected state. If not, select them in 
the desired order.
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3. To create an open curve from the points, click Create > Curves: Make Curve > Make Open Curve or press Ctrl P.

To create a closed curve from the points, click Create > Curves: Make Curve > Make Closed Curve.

You can modify the curve’s shape by simply moving the individual points. Notice how the curve flows smoothly through 
the interior points. It is easiest to see this as you drag points on either side of a point. If you need additional control, you 
can add additional points to an existing curve.

To add points to a curve: Select the spline or splines, activate the Add Points tool (Multiply > Subdivide > Add Points) 
and click anywhere along the curve.

To delete points from a curve:

Select the points and use the Cut command (Ctrl X) or the delete key.

Curve Direction

Curves also have a head and tail. This is important for certain Modeling operations. When the curve is selected in the 
Polygon Selection mode, the head is indicated by a small diamond; it is the first point you selected when creating the 
curve.
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You can flip the head and tail around by using the Flip command (Detail > Polygons > Flip or using the F keyboard 
shortcut).

Using Control Points

When using a curve as a Modeling tool, sometimes you need to adjust the curve to get it to “that perfect angle.” Because 
of the way that points control an open curve’s shape, it can be difficult to get the desired result at the ends of a curve. 
Fortunately, Modeler lets you have extra “control” points at each end, which affect the curve’s shape, but don’t actually 
become part of the curve’s Modeling characteristics.

To activate control points on a curve:
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1.

1.

If you have more than one curve, select your desired curve first using the Polygon Selection mode.

Choose Detail > Curves: Control Points > Begin Control Point to detach the first point from the curve. It is your 
starting control point. Dragging this point will change the shape of the curve at the new starting point.

Choose Detail > Curves > Control Points > End Control Point to detach the last point from the curve. It is your ending 
control point. Dragging it will change the shape of the curve at the new ending point.
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1.

1.

The Control Points commands will also toggle the control point state off, if selected again.

Smoothing Two Overlapping Curves

When two curves share the same end point, because of point merging or some other reason, the curve may not flow 
smoothly through that point. This can be particularly troubling when designing a complex spline cage. You could kill the 
curve (K), reselect the points and create a new curve, but there is an easier way.

To smooth curves sharing a common end point:

Select the two curves (Polygon Selection mode). 

Click Detail > Curves > Smooth . This smooths the joint as though the two curves were originally plotted as one 
continuous curve - even though they remain individual curves.

It is perfectly legal to have only a beginning or ending control point on a curve.
If you plan to use control points on a curve, you should add an extra point at the beginning and end of a curve 
for that purpose.



If you require a sharper corner anywhere on a curve, simply add an extra point close to the corner using 
Construct > Subdivide > Add Points.


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Turning Curves into Polygons

Since curves will never be seen by themselves, sometimes you need to turn them into polygons.

To convert a curve into a polygon, select the curve(s) and choose Construct > Convert > Freeze. Each independent curve 
will become a distinct polygon. An open curve will be closed (between its end points) before it is converted to a 
polygon.

Make sure that the point they share is in fact one point. (If not, merge or weld the points into one.)
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The number of points that Modeler will use to approximate the curve depends on the setting for Curve Division on the 
General Options Panel (Modeler > Edit > General Options).

Using Modeling Tools on Curves

Most of the standard Modeling tools will work on a curve as well. However, a curve is sometimes converted into a 
polygon before the tool is applied. This happens with the Extrude and Lathe tools (Multiply menu), for example.
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1.
2.

1.

Sketch Tool

The Sketch tool (Create > Curves > Sketch) is purely a two-dimensional Modeling tool. With it, you can draw polygons 
and curves in any viewport.

To sketch a polygon:

Choose Create > Curves: Sketch.
Open the Numeric Panel and select Face as the Type.

Drag out the desired shape. (It is not necessary to touch the beginning of the line with the end. The polygon is 
closed automatically.) 
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2.

1.
2.

When you release your mouse button, a polygon is created using the shape you sketched out. The polygon is 
always centered in the depth dimension of the viewport

Sketching Curves

You can use the Curve option on the Numeric Panel of the Sketch tool to create a spline curve instead of a polygon. The 
tool operates exactly as previously described, except an open spline curve is created instead of a polygon.

To sketch a curve:

Click Create > Curves > Sketch .
Open the Numeric Panel and select Curve as the Type.
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3. Drag out the desired shape. When you release your mouse button, a curve is created using the shape you 
sketched out. The curve is always written on a plane positioned at 0 of the viewport’s perpendicular axis

Creating open curves can be used in many Modeling operations. The image below is an example of taking the 
curve created above and using the Lathe tool to create a solid object. Instant Spray Can!
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1.
2.
3.

4.
5.

6.

7.

Bezier

The Bezier tool (Create > Curves > Bezier) allows you to create standard spline curves using tangent controls. If you’ve 
used any vector program you will feel right at home using the Bezier tool.

To use the Bezier tool:

Choose Create > Curves > Bezier .
Place your mouse pointer where you would like to begin your curve.
Click and hold your LMB - the beginning and ending of your first curve is created. Drag your mouse to where you 
want the curve to end and release the mouse button.
Successive clicks will create additional curves.
Drag the tangent handles (circles) to adjust the curve shape. Holding the Ctrl key while dragging will allow you 
to move both sides of the tangent simultaneously.
Click and drag with the LMB in the large circles that represent the curve control points to change the control 
point’s position.
Drop the tool by hitting the s pace bar.
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On the Numeric Panel, you can set the subdivision level (for smoother or less smooth curves), create a closed curve, and 
delete the last tangent point.

Open Curve

Closed Curve

Using the Bezier tool to generate a complex curve actually generates a normal Modeler spline curve between 
each control point. As such, you cannot re-edit the curves using the Bezier tool but, you can edit the control 
points created on the finished splines. To make the curves a single entity, select all the curves (you must be in 
Polygon selection mode to do this) and use the Detail> Merge Polygons tool (Shift Z ) to join all the curves 
together. (This is essential if the curve is to be used later on with Modelers Rail Bevel or Rail Clone tool).


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Plot 1D

The Plot1D tool, which is located in Create > Curves: Plot1D, generates either a curve consisting of two-point polygons 
or a spline curve. The curve is generated along the X axis, and its height is in the Z axis. Get your maths head on for this 
tool.

The height is determined by the value of the expression in the Equation field at each x. In the fields Min, Max, and 
Division, enter the x value for the start of the curve, the x value for the end of the curve, and the number of divisions of 
the curve.
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Spline Draw

The Spline Draw tool (Create > Curves > Spline Draw) is simply a tool for making spline curves. To use the tool, just click 
and move points. Clicking off the curve adds new points to the end.

Its Numeric Panel offers options for making control points, discussed later, and deleting the last point from the curve. 
Changing the Curve Points value will resample the curve into more segments. Note that resampling the curve can 
change its shape, particularly if the number is incremented gradually, as is the case with the mini-slider. If you want a 
more refined curve that accurately matches the one you have drawn, enter the new number directly into the field to 
avoid the intermediate curves.

Curve Points - Allows you to control how many control points are along a line. Changing the Curve Points value 
will resample the curve into more segments. Note that resampling the curve can change its shape, particularly if 
the number is incremented gradually, as is the case with the mini-slider. If you want a more refined curve that 
accurately matches the one you have drawn, enter the new number directly into the field to avoid the 
intermediate curves.
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End Control - Adds an extra node that will allow your spline to end on a curve or similar. When you end the tool 
you will see that there is an extra point that will move with your spline. Deleting this seemingly-unimportant 
stray point will also change the end of your spline.
Start Control - Adds an extra node that will allow your spline to end start a curve or similar. When you end the 
tool you will see that there is an extra point that will move with your spline. Deleting this seemingly-unimportant 
stray point will also change the end of your spline.
Closed Curve - Will close the spline into a closed shape.
Create UVs - When used as a FiberFX spline, this option will add a UV Map to the spline.
Delete Last - Deletes the last control point while in this tool.

Be aware that reducing this value will simplify your curve in a way that can't be undone except by 
redoing the whole operation


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Spline Cage

Create > Curves > Spline Cage creates a cylindrical spline cage (connected curves).

Axis - The primitive is aligned with this axis.
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Sections - Sets how many vertical segments should be used.

Sides - Determines how many segments should be used around the perimeter.

Bottom - Bottom is the starting point of the primitive along the selected Axis.
Top - Top is the ending point of the primitive along the selected Axis.
Radius - Refers to the radius of the primitive along the axes.
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Make Curve

To create an open curve from points, click Create > Curves: Make Curve > Make Open Curve or press Ctrl P.

To create a closed curve from the points, click Create > Curves: Make Curve > Make Closed Curve.

You can modify the curve’s shape by simply moving the individual points. Notice how the curve flows smoothly through 
the interior points. It is easiest to see this as you drag points on either side of a point. If you need additional control, you 
can add additional points to an existing curve.
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Modify

Introduction

The Modify Tab contains a variety of tools to make changes to existing geometry. These can be applied to individual 
selected points, edges, or polygons, portions of an object, or to an entire object. The available operations range from 
simple relocation of points or polygons to resizing the geometry in one or more dimensions, to complex deformations 
of the entire mesh.

Falloff Mode
Translate
Translate - More
Rotate
Rotate - More
Transform
Transform - More
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Falloff Mode

Several of the tools on the Modify tab have a Falloff pop-up menu on the lower half of the numeric panels. By changing 
the Falloff setting, you can effectively make the function of the Move tool have the same effects as using the Shear, 
Magnet, DragNet, and Drag tools, by just changing its Falloff setting. You might think of these tools as just shortcuts to a 
defined group of Modify settings. This type of selection via falloffs is also referred to as a Soft Selection.

We will be explaining the falloff tools here at the start of the chapter.

Falloff Types

Texture - The texture falloff is somewhat special. Clicking on the Texture button takes you to a standard 
LightWave Texture Editor window where you can choose an image, gradient, or procedural texture. This is then 
set as the falloff for the tool you are using.
None - None means no falloff. The Move tool is set to this by default.
Linear - Linear makes the effect fall off along a linear axis and operates like the tools Shear, Twist, Taper1, and 
Taper2.
Point - Point falloff works like the Drag tool.
Point Radial - Point Radial operates much like the DragNet tool.
Polygon - Polygon means falloff is immediate around a polygon, so you can move only a single polygon. It 
behaves like the drag tool but works on single polygons instead of points.
Radial - Radial means the effect will fall off in a radial pattern (in a cylindrical or spherical shape), so it is the 
default for Magnet, Vortex, Pole1, and Pole2.
Weight Map - Weight Map uses the selected Weight Map for the falloff. Unweighted points will not move at all, 
while heavily weighted points will move the most. Negatively weighted points will move inversely. This allows 
you to use an irregularly shaped falloff. This mode is particularly useful for creating facial endomorphs.

Falloff Mouse Controls

Falloffs are controlled with the right mouse button (RMB).

RMB on a handle to drag it.
RMB on nothing to start a new falloff.
RMB-Click on the handle to switch to Auto falloff mode.
Holding down Ctrl constrains the dragging of falloff handles to horizontal axes.
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Linear Settings

Shape

You can quickly select between various basic falloff directions using the Shape buttons. The Shape setting determines 
the Area of Influence. This is shown graphically in both the numeric panel and viewport windows. You can also use the 
Left and Right cursor keys to change the selected Shape.
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Tension Sliders

You can adjust how the effect falls off using the two sliders, which act like tension spline controls for the beginning 
(upper slider) and ending (lower slider).

Presets

You can quickly set up some common curves by selecting from the Preset pop-up menu. The graph on the numeric 
panel, as well as the outer edges of the axis tree (when using a fixed range) gives you a visual picture of the falloff. You 
can also use the Up and Down cursor keys to cycle through the Preset selection.

Range

The Range option determines where the Falloff’s center is located. By default, a linear falloff tool’s effect is 
automatically applied to the object (or selected items) 100 percent at one end and zero at the other, along the axis 
perpendicular to the editing viewport. This is indicated by the Range option at the bottom portion of the numeric panel, 
which has Automatic selected.

To use the tool in the Automatic mode via the numeric panel (by clicking the Apply button), select the perpendicular 
Axis. (If the axis has not been set either manually or by a previous mouse-based modify operation, the Axis setting is 
used to compute the falloff when you click Apply.)

Automatic - The center is set by clicking in the viewport.
Fixed - The center is set by entering in values in the numeric window.

Instead of using an Automatic Range, you can define a specific Fixed Range using an axis tree. This type of Range can be 
placed at any position and at any angle in 3D space. The effect tree looks like a pair of crossed wedges. The tool’s effect 
is applied along this tree with zero at its tip and 100 percent at its base (fat end) - portions of the object beyond the base 
are still affected 100 percent. The edges of the tree reflect the fall-off curve shape.

Using the Automatic Range is the simplest method. Thus, if possible, model your object along one of the three 
axes.


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To create a fixed range:

Select the desired linear falloff tool and drag out the axis tree with your RMB. (The Range option will be set to 
Fixed on the numeric panel.)

Reposition the ends by dragging them with your RMB .

To reset to Automatic Range:

To reset to Automatic Range, click your mouse pointer on an inactive interface area. Note this will also switch you back 
to the Automatic Range mode.

Moving an Object on an Arbitrary Axis

Let’s say you had an object that was not aligned nicely along the X, Y, or Z axis. If you wanted, you could define a fixed 
range and align the effect tree with the object. However, this can be a tedious process. A better alternative would be to 
use a Perspective viewport.

Remember, editing generally occurs along a viewport’s arbitrary horizontal and vertical axes. When using a Perspective 
viewport, this can be something other than directly along the X, Y, or Z axis. Thus, you can align your object so that it is 
perpendicular in the viewport and just use the Automatic Range.

Radial Settings:

This influence area falls off in a radial pattern (a sphere or cylinder). It is set independently of any selected polygons or 
points, but works in conjunction with them. That is, if points/polygons are selected, only those within the influence area 
are affected.

By default, the tool’s effect is automatically applied to the entire object (or selected items). This is indicated by the 
Range option, at the bottom portion of the numeric panel, which will have Automatic selected.

The XYZ positions of the starting and ending points are reflected in the numeric panel. You can edit these 
values, if necessary.


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1.

Setting the Falloff Shape

How the effect falls off is determined by the two sliders, which act like tension spline controls for the beginning/end 
(upper slider) and center (lower slider). You can quickly set up some common curves by selecting from the Preset pop-
up menu. The graph gives you a visual picture of the falloff.

Defining a Specific Range

Instead of using an Automatic Range, you can define a specific Fixed Range, which can be positioned and sized 
anywhere in 3D space.

To set the influence area:

Select the desired Radial falloff tool and drag out the influence area tree with your RMB . (The Range option will 
be set to Fixed on the numeric panel.) At this point, you have defined a cylindrical area that extends infinitely 
along an axis perpendicular to the viewport. Use the Ctrl key to constrain to a circle.



LightWave 2020  –  LightWave 2020

Reference –  1210

1. Resize the initial area as needed by dragging the outline edge handles with your RMB or reposition by dragging 
the center handle.
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2. To limit the depth of the area, drag out the outline in a different viewport. The amount of influence is strongest 
at the center and diminishes towards the edges. Polygons with all points outside of the area will not be affected.

To reset the influence area:

To reset the influence area, click your mouse pointer on an inactive interface area. Note this will also switch you back to 
the Automatic Range mode.

The Numeric Panel

The Radius X, Y, and Z values reflect the size and shape of the influence area. If you have defined a cylindrical (i.e., two-
dimensional) area, one axis will be 0. The Center X, Y, and Z values define the center of the area of influence.

Creating the radial falloff influence area is similar to creating a Box primitive, particularly in a perspective 
viewport.


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Texture added to Falloffs

Texture was added to the Falloff options in Modeler 2015 for the Move, Dragnet, Rotate, Scale, Shear and Twist tools. 
The texture can be chosen with a click on the Texture button (Image maps, Gradients and procedural textures including 
Nodes can all be used) and clicking on the Use Texture toggle will use the Texture falloff or revert to one of the standard 
Falloffs at the bottom of the window.
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•

Translate

The tools in the Translate group allow you to relocate all or part of the geometry, in some cases with varying level of 
effect across the geometry.

Move Tool

Drag

Snap Drag Tool

Tweak

Dragnet Tool

Magnet Tool

Shear Tool

Axis Translate

Align...

Align

Aligner Tool

Rest On Ground

Align to Plane

Center...

Center All...

Center X, Y, Z

Center Axis



LightWave 2020  –  LightWave 2020

Reference –  1214

1.
2.

Move Tool

(default keyboard shortcut T)

The Move tool (Modify > Move) is the basic tool used to reposition geometry. This tool is used often so it’s worth learning 
the shortcut key.

To move geometry:

Select your points or polygons.
Choose Modify > Move ( T ), click and drag your mouse in any view. The selected geometry will follow your 
movement.

Holding the Ctrl key before you click and drag will constrain the movement along one of the axes. It is also not 
necessary to place the cursor directly on the selected item. You can move from anywhere.



Move can use Falloff Modes to adjust how points, edges or polygons are moved.
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1.

2.
3.

Drag

(default keyboard shortcut Ctrl T)

To move points around without having to select them, select Move, then select other points, use the Drag tool.

To drag points:

To limit the edit to certain points, select them first. The Drag tool will not affect unselected points unless none 
are selected. Thus, if you have points in-line with each other in a viewport and don’t want to drag all of them, 
select the target points first. (Note that all of the selected points do not move as you drag, only the ones under 
your mouse pointer.)
Choose Modify > Drag to access the Drag tool.
Position your mouse pointer directly over a point, click and drag.

Drag using Linear falloff to drag out a nose

Drag can use Falloff Modes to adjust how points, edges or polygons are moved.
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Snap Drag Tool

(default keyboard shortcut Shift G)

The Snap Drag tool (Modify >Snap Drag Tool) allows points to be dragged and snapped to align with other points. When 
you drag a point with the Snap Drag tool, the point is snapped to the grid or to one of the non-moving points, if any.

If you set Drag Set to One Point on the numeric panel, only the single point will move. If you choose Connected Points, 
points that are connected to the point being dragged will also move. If you choose All Points, all points will move. As 
with other tools, you can use selection to limit which points are affected. Snap makes it easy to manipulate 
unconnected parts without having to make explicit selections.

 

With View Alignment, points will be snapped to approximately align with the other points along an axis perpendicular to 
the viewport, but not fully in three dimensions.

Although this tool works on individual points, selecting polygons and working in the Polygon Edit mode will 
limit its effect to points that share a vertex with the selected polygons.


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Tweak

Modify > Translate > Tweak - The Tweak tool allows you to interactively translate the points, edges and polygons that 
make up your object. You don’t need to be in a specific mode to use it. Points, Edges and Polygons can all be tweaked 
no matter which mode you are in. Clicking with the left mouse button will drag the elements, clicking with the right 
mouse button will extend new edges or polygons.
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Dragnet Tool

(default keyboard shortcut ;)

The DragNet tool (Modify > DragNet) combines the Drag and Magnet tools. While you might use it somewhat 
interchangeably with Magnet, they operate quite differently. Magnet’s radial falloff influence area works independently 
from the actual use of the tool. With DragNet, the spherical range is always centerd around the initial point of dragging. 
Moreover, you must actually drag a point, although other points in the influence area will also move.

The influence area is defined by the Radius around the initial pointer position. You can graphically set this by dragging 
out a circle with your RMB.

To use the DragNet tool:Select Modify > DragNet, click and drag a point. Other points in the influence area will also 
move, though not as much.

 

The information display tells you the Offset value, that is, how far you dragged the mouse. If you set the influence area 
interactively with the RMB, the information display shows the Radius value.

DragNet can use Falloff Modes to adjust how points, edges or polygons are moved.
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Magnet Tool

(default keyboard shortcut :)

The Magnet tool (Modify > Magnet) is a nifty tool for pushing in or pulling out sections of objects. The effect is smoothly 
applied, so it tends to create soft-edged bulges or dips in a surface. You might use the Magnet tool to create an egg 
shape from a sphere. (Simply enclose the upper hemisphere in the influence range, center the area near the top of the 
sphere, and drag upward with the LMB.) You can actually use the tool immediately as sort of a freeform deformation or 
you can create an area of influence.

 

To use the Magnet tool: 

Select Modify > Magnet and drag your LMB in a viewport. The initial pointer location defines the center of the move, 
although this may not be obvious if it is located outside of a defined range.

 

The information display will indicate the Offset amount for the affected axes, that is, the distance you have moved your 
mouse.
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The Offset X, Y, and Z values on the numeric panel will reflect the amount of movement along those axes for the tool’s 
last operation. You can edit the values and then click the Apply button to apply them, which you can do multiple times.

As shown, Magnet can use Falloff Modes to adjust how points, edges or polygons are moved.
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Shear Tool

(default keyboard shortcut [ )

Shearing is making an object slant to one side. A good example is italicized text. Think of Shear as Move with axial 
falloff. That is, the strength of the moving influence is not equal across the object, but gradually falls off along a selected 
axis.

Using Shear with a Radial falloff

To use the Shear tool:

Select Modify > Shear, click and drag your LMB in a viewport in the direction you want the slant.The information display 
tells you how much Offset you applied along two of the three axes, depending on the view you edit in. Hold the Ctrl key 
down while dragging to constrain the shear to your initial dragging axis.

The Offset X, Y, and Z values on the numeric panel will reflect the amount of movement along those axes for the tool’s 
last operation.

Shear can use Falloff Modes to adjust how points, edges or polygons are moved.
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Axis Translate

Modify > Translate > Axis Translate - Much like CAD tools, the “Axis...” tools work in a specific sequence. For Axis 
Translate, the sequence is that you pick where you want to move from to where you want to move to. There is no 
change in attitude for the object you have selected but you can use snapping again to provide more control.

  

Holding Shift and drawing up from the top yellow polygon allows you to move the blue box away from the yellow. As 
can be seen in the screenshots, neither box is aligned to an axis, but the blue box is moved along the yellow box’s 
normal. The third screenshot shows snapping to the vertices of the blue box. This will move it along its length.

The falloff modes for this tool are described in detail on the Modify page
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Align...

This submenu presents a variety of options. The To Point’s Last... align tools each perform a specific translation based 
on the last point selected and the axis chosen. When a group of points are selected and a To Point’s Last... align tool is 
used, all the selected points will align to the selected axis.

Align Points to Axis can perform multiple axis alignments at once.

Align Points to Axis (XYZ) will align any selected points to the specified axis. Multiple axes can be selected.

Align to aligns the points to the specified element. First will align the points to the first selected point. Last will align the 
points to the last selected point. World will align the selected points to the world axis.

Merge Points will perform a weld of any points sharing the same world space.



LightWave 2020  –  LightWave 2020

Reference –  1224

Align

Modify > Translate > Align... > Align - This tool requires two objects, one of which should be completely selected, and a 
click on two polygon normals. The Align tool will move and rotate selected geometry in such a way that the normal of 
the first click would face the normal of the second click.

To use the Align tool, first activate the tool. Click on a polygon of the selected geometry that you wish to align, then click 
on the polygon center that represents the target normal on the unselected geometry. All selected geometry will move 
so that the first normal shares the same root as the target normal, and this geometry will also rotate so that it faces the 
opposite direction of the target normal.

An example of Align usage: first click a polygon on the object to align, then click a polygon on an unselected target 
object. The selected object will move and rotate so that its clicked polygon center faces that of the clicked polygon 
center on the unselected box. Once aligned, a Transform gizmo permits further adjustment. Right clicking on a different 
polygon will move the gizmo to another location.

We want to align the front face of the selected red object with the top of the blue object. Both are on the same layer, 
neither is on any axis. First we click on the face of the red object we wish to align, next we click on the face of the blue 
object we wish that face to be aligned to and then the Transform gizmo appears for further modification
Choose Pivot

Note that if you click on the unselected geometry first and then the selected geometry Align will give 
unexpected results. Always click on the selected geometry first.


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When the Choose Pivot button in the Numeric window is chosen, a widget of options is presented. Not all of them make 
sense, or work, with Align (the Edge and Edge Center ones do not), but they are all presented as follows:
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•

•

•

•

Aligner Tool

Aligner will align geometry not only with axes, but also other geometry. The Mode setting determines what type of 
alignment you want.

Modes

World - The World mode will align geometry in the foreground to the X, Y and Z axes. The c setting will center on 
the axis. The minus (-) or plus (+) settings will place the geometry on the negative or positive side of the axis. Off 
disables that axis. So if you had a “floor” at Y = 0 and you wanted the object centerd, but resting on this floor, set 
the Z and X axes to c and the Y axis to +.
Foreground-> Background - In the F.G.->B.G. mode, the foreground is aligned to the background. 

This mode uses a bounding box around all of the geometry in the reference layer (the background). You can 
center or position on the negative or positive side of the reference. The -+ setting will align the right edge of the 
geometry with the right edge of the reference layer. The +- setting will align the left edge of the geometry with 
the right edge of the reference layer. You may also scale the geometry to the reference layer. Select the axis or 
axes to scale using the Scale Axis pop-up menu.

Background->Foreground - The B.G.->F.G. mode works just like F.G.->B.G., but uses the foreground as the 
reference for the background.

Absolute - The Absolute mode works like the World mode except you can numerically define where the center is. 
In other words, you can make it something other than 0, 0, 0.

Scale Axis - Gives the option to scale the geometry to the reference layer. Select the axis or axes in this pop-up menu. 
This option is only available with FG/BG modes.
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Rest On Ground

(default keyboard shortcut F3)

The Rest On Ground command (Modify > Rest On Ground) will move selected polygons so that they rest on a defined 
ground plane, that is, where X, Y, or Z equals 0.

 

Z Axis is unchecked here to make sure the legs stay in the same place

The Rest Axis is the axis perpendicular to the plane you want the object to rest on. You may also center the object on 
any of the axes.

The Sense option rests the object on the positive (+) side of the plane or the negative (-) side. The default setting would 
be ideal for, say, centering a vehicle around the Origin and placing it so it sits flat on the Y axis plane.
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Align to Plane

Modify > Translate > Align > Align to Plane/Restore Align - The scripts that were added in LightWave 11 to help with 
modeling off-axis - a kind of Construction Plane (cplane) analog - have been moved to the Modify tab since they are no 
longer as necessary with new tools available.

The Align to Plane tool creates a 2-point polygon in the first free background layer to store the rotation. This 
lets you save an object mid-way through an Align to Plane operation; quit Modeler; come back later and carry 
on. Modeler will know the exact transformation it needs to do to align the model back to its original state.


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Center...

This submenu contains tools to center geometry on one or more axes.



LightWave 2020  –  LightWave 2020

Reference –  1230

Center All...

(Default keyboard shortcut: F2)

Fires a command to center selected geometry at 0, 0, 0. Remember, if no geometry is selected it’s all selected.

New to 2018

Center All now respects Symmetry
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Center Axis

A tool that allows you to select to center on one or more axes and across multiple layers. The Respect Layers switch 
centers based on disconnected geometry in one layer being a whole for the purposes of centering rather than centring 
each object on the layer separately.
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Center X, Y, Z

Fires a command to center selected geometry on the selected axis.
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•
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•

Translate - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Move Plus
Before Move Plus
Move Plus LMB Move Plus RMB

Translate Plus Tool
Rove Tool
Point Normal Move
Untangle

Move Plus

The Move Plus tool (Modify > Translate > More > Move Plus) is a detailed version of the Move tool used to reposition 
geometry.

This tool is almost identical to LightWave’s interactive Move tool. However, it provides two additional features. When 
dragging your selection with the RMB, the selection will be translated along the local normals. When dragging with the 
right mouse button with Shift held down, the selection will be translated along the averaged normal.
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Before Move Plus

 

Move Plus LMB Move Plus RMB

Translate Plus Tool

Translate Plus is found in Modify > Translate > More and functions as a detailed Move, Rotate, and Scale tool. You can 
use a point’s normal, a segment, or a segment’s normal to define how to move, rotate, scale a selection. You can even 
just use global X, Y, or Z. Each of these operations can have a falloff.

Move Plus doesn’t replace the Move tool as it doesn’t have the Falloff settings that are found in the Move tool.
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Quick Preview Mode - The Quick Preview Mode will show a temporary blue outline of the translation and the 
action won’t take place until you have applied ( RMB ) the action. This is particularly handy when working with 
very heavy meshes.

Operation - This setting defines what will be performed on the object. Options are: Translate, Rotate, Scale on 
Axis, Scale to Point.

Axis - What axis will be used to determine how selection is “Operated” on. X, Y, and Z are just the default axes. 
The other options are Point Normal, Segment, and Segment Normal.
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Origin - Refers to where the Axis originates. By default it is placed at center of whatever the Axis is. There are 
times when it needs to be somewhere else. Generally, there won’t be a need to change this unless the operation 
is Scale on Axis. The options are Default, Point , or Segment.

When Point and Segment are selected, the object will display blue circles over each point. Select one point for Point 
mode and select two points for Segment mode.

Translate Origin - Enables moving of the Origin. For example, if Point Normal was the axis chosen, it will move 
the Origin along the normal.

Controls Tab - Whichever Operation is selected will be editable and the others will be grayed out. Generally, 
there is no need to use the controls because it is easier to click on the screen itself to move selections.

Falloff Tab - The options for falloff are Internal and None. Internal means that the falloff is only within the 
selection. Falloff settings can be edited by using the options at the bottom of the panel. 

Falloff Shape - Defaults to Linear , but there are also Bell , Curve Down , and Curve Up . The shape can be 
modified further by using Falloff Tightness.
Falloff Tightness - Determines whether points in falloff range will be closer to selection (or origin) or closer to 
their original position.
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Falloff Center - Same as the Origin settings except instead of Default it is a Selection .

Even though holding Ctrl or using the MMB will constrain movement, sometimes that is hard to do in perspective. Also, 
if moving selections with LightWave’s Move tool is slow (due to large poly count), this tool is handy because it moves in 
real time.

Rove Tool

The Rove tool (Modify >More > Rove) allows you to move and rotate with a single tool!

 

Position Rove Tool - Click and drag off the tool’s widget to place it where you want the action center to be.

Translation - To move an object, simply click and drag. Dragging on an axis constrains movement to that axis. 
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•

 

Rotation - Rotate the object about the center of the tool by clicking and dragging the rotation ring. The center of 
rotation can be repositioned by dragging the center of the tool.
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Point Normal Move

Point Normal Move is located under the Modify Tab and allows you to move points along their normals.

The yellow lines in the image above represent the normals for some of the points on the ball object. Using Point Normal 
Move would move each point along its normals.

You can move points along their normals on multiple foreground layers at once and the moves will be on the same layer 
as the original points.
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Mode:

Single Point - allows you to run it without selecting points first and then you can move any points you want 
without selecting them.
Selected Points - select the points you want to move, select Point Normal Move tool and then click and drag 
anywhere on the screen to move them in and out. 

Untangle

When a polygon is selected, this tool will make it circular. The more sides the polygon has, the closer to a perfect circle it 
will become.

The Rove tool only works in one Layer.
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Rotate

This group of tools is dedicated to rotating geometry.

Rotate Tool

Axis Rotate

Bend Tool

Twist Tool

Rotate - More
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Axis Rotate

Modify > Rotate > Axis Rotate - Much like CAD tools, the “Axis...” tools work in a specific sequence. For Axis Rotate, the 
sequence is to pick an end point for a line about which your selected polygons will rotate. Your second click denotes the 
other end of this line and then holding down the left mouse button will rotate the selected polygons about this axis. You 
can use snapping to snap the end points of your axis to vertices or the center of polygons on the layer. You can also pick 
the axis to rotate around from items on a Background layer. Alternatively, you can hold down the Shift key and click on 
a polygon to rotate about its normal.

  

We’re using the two objects from the previous example and we want to even them up. Use Axis Rotate and Shift click on 
the top blue polygon, now the box will be rotated about that polygon’s normal. To get the alignment right, use the 
Nudge controls in the Numeric Panel to perfect your rotation.
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Bend Tool

The Bend tool (Modify > Bend) is a combination of Rotate and Shear. It will move one side of an object and rotate it at 
the same time, causing the entire object to bend.
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To use the Bend tool:Select the tool and drag your LMB in the direction you want the bend to occur. The initial pointer 
location defines the center of the rotation. The trick is to use the Bend tool in the viewport that is perpendicular to the 
axis of the bend. Let’s say you have a tube whose main axis is along Y. Use the Bend tool from the top or bottom view. 
Also, experiment with the placement of the cursor relative to the object. Activating Bend when the cursor is centerd 
over the object has a different effect than activating Bend with the cursor located away from the object.

The information display tells you the Angle of bending, that is, the number of degrees you bent the object. Hold the Ctrl
key while dragging to constrain movement to increments of 15 degrees—this makes it much easier to bend along a 
single axis.

Angle - The Angle value on the numeric panel will reflect the degrees of rotation.
Shape - You can quickly select between two basic falloff directions using the Shape buttons. The Shape setting 
determines the Area of Influence. This is shown graphically in both the numeric panel and viewport windows. 
You can also use the Left and Right cursor keys to change the selected Shape.

 

Range

The Range option determines where the Falloff’s center is located. By default, a linear falloff tool’s effect is 
automatically applied to the object (or selected items), 100 percent at one end and zero at the other, along the axis 
perpendicular to the editing viewport. This is indicated by the Range option at the bottom portion of the numeric panel, 
which has Automatic selected.To use the tool in the Automatic Mode via the numeric panel (by clicking the Apply 
button), select the perpendicular Axis. (If the axis has not been set either manually or by a previous mouse-based 
modify operation, the Axis setting is used to compute the falloff when you click Apply.)
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Automatic - The center is set by clicking in the viewport.
Fixed - The center is set by entering in values in the numeric window.

Instead of using an Automatic Range, you can define a specific Fixed Range using an axis tree. This type of Range can be 
placed at any position and at any angle in 3D space. The effect tree looks like a pair of crossed wedges. The tool’s effect 
is applied along this tree with zero at its tip and 100 percent at its base (fat end) - portions of the object beyond the base 
are still affected 100 percent.

Using the Automatic Range is the simplest method. Thus, if possible, model your object along one of the three 
axes.


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Rotate Tool

(default keyboard shortcut Y )

Select Modify > Rotate, click and drag your LMB left for counter-clockwise rotation or right for clockwise rotation. The 
center of the effect is determined by the Action Center setting. Hold the Ctrl key down as you drag to rotate in 15-
degree increments. The information display (lower-left corner of the interface) will tell you the angle of rotation, that is, 
the number of degrees you have rotated.

Rotating an entire object in Modeler is very similar to as doing it in Layout, except that you rotate around the 
perpendicular axis of the viewport. Because of that, you will often have to use various viewports to rotate an object.

The Rotate Numeric Panel

The Angle defines the degree of rotation. The Axis setting defines the axis of rotation. When you click in a viewport, the 
axis is an imaginary line running perpendicular to the view you are editing in (i.e., coming straight out towards you). For 
the Back view, it would be the Z axis; in the Top view, it would be the Y axis; and in the Right view, it would be the X axis. 
If arbitrary axes were used, no Axis will be selected.

The Center XYZ values define the center of rotation coordinates.

In any viewport, pressing the R key (Rotate 90 Right) will rotate an object clockwise 90 degrees around a 
perpendicular axis located at the current mouse pointer location. You can also map the Rotate 90 Left 
command to a hot key as well.



Rotate can use Falloff Modes to adjust how points, edges or polygons are moved.
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Using the RMB (and Ctrl) for controlling motion will result in much finer rotation increments.
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Twist Tool

The Twist tool (Modify > Rotate > Twist) is similar to Shear, although the results are quite different. With Shear, the sides 
of the object are moved one way or the other. With Twist, one end of the object is rotated while the other remains 
stationary. Think of Twist as Rotate with axial falloff. That is, the strength of the rotational influence is not equal across 
the object, but gradually falls off along a selected axis. The twist occurs around the X, Y or Z axis, so you want to set the 
tool in a viewport perpendicular to the axis you want the twist to occur around.

To use the Twist tool:

Select the tool and drag your LMB left for counterclockwise twisting or right for clockwise. The center of the effect is 
determined by the Action Center setting.
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The information display tells you the Angle of twisting, that is, how many degrees you twisted. Hold the Ctrl key down 
while dragging to twist in increments of 15 degrees.

The Angle value on the numeric panel reflects the degrees of rotation. The Axis buttons relate to the rotational axis. If 
you use an arbitrary axis (i.e., twist in a perspective viewport), no Axis buttons are selected. The Center X, Y, and Z values 
indicate the center point of rotation, through which the axis runs.
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Rotate - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Dangle
Vortex Tool

Vortex Applied

Rotate to Axis
Rotate Any Axis

How to use Rotate Any Axis

Rotate HPB
Rotate About Normal
Rotate Abitrary Axis
Rotate to Ground
Rotate to Object
Rotate Morph

Dangle

Dangle will rotate a layer or selection relative to a rotation center. The Reference is what determines the axes used for 
rotation. Selection is a bounding box around the selected geometry, World is the Origin, and B.G. Layer is a bounding 
box around the background layer geometry.
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If Influence is set to Affect Layer, the rotation is applied to all of the geometry in the layer. With Affect Selection, only the 
selected geometry is rotated. Note that the rotation center can still be based on the Selection, even if you are using 
Affect Layer.

When the c setting is used for Axis, the rotation center is at the center of the Reference. Use the - or + options to move 
the rotation center to the negative or positive side of the bounding area, along the axis - these obviously have no effect 
if World is used.

When the bounding area is computed, an angle for the top “polygon” is measured based on its normal. If you use 
Absolute mode, it will change the rotation angle to be the exact amount entered. Relative will add the rotation to the 
geometry.

Enter the desired rotational values in the XYZ fields. These relate to the axis around which the rotation is performed.

To use the Distance function, select two points prior to running Dangle. The distance between those two points will be 
shown in the Distance field. Enter a new value and set Influence to Affect Selection. Click Ok. The two points will now be 
apart by the entered distance. Essentially, the points are scaled, using the rotation center defined by Dangle, until the 
points are at the defined distance. If you use Affect Layer, the entire layer will be scaled up proportionately. (If only one 
point is selected, the Origin is used as the other point.)

Vortex Tool

The Vortex tool (Modify > Vortex) will smoothly rotate a selected area of an object.
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To use the Vortex tool:

Select the tool and drag your LMB in a viewport. Dragging right will rotate the influence area clockwise, while dragging 
left will rotate counterclockwise. The center of the effect is determined by the Action Center setting, discussed 
previously.

You might use Vortex to create a swirl on an ice cream cone, a whirlpool in an ocean, or a cosmic whorl of stars.
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Select Range

Vortex Applied

The information display will tell you the amount of Angle of rotation.

The falloff modes for this tool are described in detail here.
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1.

Rotate to Axis

The Rotate to Axis tool requires an initial polygon selection on which to base rotations. The first set of axes is the axis to 
rotate the object around and the second set is the direction to which (or away from which) rotation should take place.

Rotation Center is a dropdown list similar to the rotation centers on the bottom toolbar. Layer pivot works with an 
object in a background layer. Restoring an object to orthogonals might require several uses of this tool, using different 
rotation or facing axes.

Rotate Any Axis

The Rotate Any Axis command (Modify > Rotate Any Axis) will rotate selected polygons around an arbitrary axis defined 
by a two-point polygon in the background layer.

How to use Rotate Any Axis

Create a 2-point polygon in a background layer that you would like to use to define the arbitrary axis you would 
like to rotate around.
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2. Switch layers so that your object is in the Foreground and the 2-point polygon is in the Background.



LightWave 2020  –  LightWave 2020

Reference –  1256

3. Select Rotate Any Axis from the Toolbar and enter a value.

Rotate HPB

The Rotate HPB command (Modify > Rotate HPB) lets you rotate the contents of a layer using heading, pitch, and bank 
values, as in Layout.

Rotate About Normal

The Rotate About Normal command (Modify > Rotate About Normal) will rotate selected polygons using the surface 
normal of the first selected polygon as the perpendicular axis of rotation.

Steps to Use Rotate About Normal:
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1.

2.

3.

Select the “Source” Polygon.

Select the Polygons that you would like to rotate.

Select Rotate About Normal and enter a value.



LightWave 2020  –  LightWave 2020

Reference –  1258

4.

1.

The Polygons selected in step 1 and step 2 will rotate around the polygon that you select in step 1.

Rotate Abitrary Axis

The Rotate Arbitrary Axis command (Modify > Rotate Arbitrary Axis) will rotate selected polygons around an arbitrary 
axis defined by a two-point polygon in the background layer.

To Use Rotate Arbitrary Axis follow these steps:

Create a 2-point polygon in a background layer that you would like to use to define the arbitrary axis you would 
like to rotate around.
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2.

3.

Switch layers so that your object is in the Foreground and the 2-point polygon is in the Background.

Select Rotate Arbitrary Axis from the Toolbar and enter a value.

Rotate to Ground

(default keyboard shortcut F4)
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1.

The Rotate To Ground command (Modify > Rotate-To-Ground) will rotate and move selected polygons to a defined 
ground plane based on the first polygon selected. The Rest Axis is the axis perpendicular to the plane you want the 
object to rest on. The Sense option rests the object on the positive (+) side of the plane or the negative (-) side.

 

Rotate to Object

The Rotate To Object command (Modify > Rotate To Object) will rotate in relation to a polygon. The first selected 
polygon defines the target orientation. The second and any other selected polygons will rotate and align to the first 
selected polygon.

Select Destination Polygon.



LightWave 2020  –  LightWave 2020

Reference –  1261

2.

3.

4.

Select Polygons to rotate.

Select Rotate To Object.

will rotate to Step 1’s selection.

Rotate Morph

Rotating the base of an Endomorph with the normal Rotate tool often does not add the proper amount of rotation to its 
morph targets. You may achieve better results with the Rotate Morph function (Modify > Rotate Morph).

You can select an Endomorph to rotate from the Vertex Map drop-down list, or selecting the Transform All 
Morphs option will apply the rotation to all Endomorphs in the object (which is often the preferred option in 
many cases where the base has been altered on an object containing many morphs)


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Transform

This group contains tools to change the size and scale of your objects along with other tools that don’t fit easily into the 
Translate or Rotate groups.

Stretch Tool

Size Tool

Transform Tool

Axis Scale

Taper Tool

Taper Constrain

Segment Scale

Heat Shrink

Spline Guide Tool

Jitter Command
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Axis Scale

Modify > Transform > Axis Scale - Much like CAD tools, the “Axis...” tools work in a specific sequence. For Axis Scale, the 
sequence is that you pick either the point you wish to scale uniformly about or draw a line that will be used as the origin 
of the scale as well as the dimension you wish to change the size of.

Clicking on Part Center allows you to scale the object about its own bounding box center. The second image shows the box 
nudged down in 10 percent increments to 50%, but if you just want to halve its height with the base resting where it is, use 
snapping to go from a vertex on the base to one at the top.

Example: Scaling Imported Objects

Often for a project we need to import objects from other 3D software and that can lead to scaling issues. We needed a 
22” LCD monitor for a scene, but bringing in this model has lead to a grid size of 50 m and a monitor over half a 
kilometer wide.

Using Axis Scale and measuring the diagonal of the screen gives a size of roughly 578 m. Entering a value of 22” in the 
Numeric panel and making sure the Uniform toggle is on will bring our whole monitor down to the correct size.
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1.

Heat Shrink

Modify > Transform > Heat Shrink - Conforms polygonal geometry to a background object by a desired amount. You can 
completely transform your foreground geometry to match the background object, or some way in-between. Our 
example shows the Mangalorian head surrounded by a level 6 tessellated sphere and Heat Shrink applied.

There are several controls for Heat Shrink as follows:

Amount - How much you want to apply the geometry of your object to the object covering it. In our example, how much 
the sphere adapts to the statue’s form. The Amount can go into the Negative allowing you expand a shape to fill a space 
rather than just shrinking to fit.Offset - How far away from the underlying object the foreground object is wrapped. 
Giving some Offset allows a lower polygon count object to better conform to a higher polygon underlying object.Mode - 
There are six options presented here:

X - Depending on the Sense chosen will start conforming the foreground to the background from the left, right or 
both sides. The Amount determines how much of the foreground conforms to the background object.
Y - Depending on the Sense chosen will start conforming the foreground to the background from the top, bottom 
or both sides. The Amount determines how much of the foreground conforms to the background object.
Z - Depending on the Sense chosen will start conforming the foreground to the background from the front, back 
or both sides. The Amount determines how much of the foreground conforms to the background object.
Normals - Pushes the points along the mesh normal until they hit something.
Sphere - Pushes the points toward or away from a central point until they hit something.
Closest Point - Each point looks for the closest point in the background and moves toward it. Sense has no effect 
with this mode.

Sense - The Sense options determine from which direction Heat Shrinks starts conforming:

+ - Heat Shrink starts from the Positive side of the axis.
- - Heat Shrink starts from the Negative side of the axis.
Both Sides - Heat Shrink starts from both sides of the axis.

Example: Protecting our Alien Emissary with Heat Shrink

Because we don’t want anyone to pierce our alien emissary’s secret identity when crime fighting we will create a mask 
for her with Heat Shrink so no-one will recognize her.

We’ve loaded the Alien Emissary model found in the LightWave content, but she’s too recognisable. Let’s use 
Heat Shrink to help with that.
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2.

3.

With the emissary in the background, we’ll make a simple eye mask for her. This is just a subdivided polygon 
with holes for her eyes.

Using Heat Shrink, we'll leave the defaults as is, but set Offset to 4 mm. Holding down LMB, we'll slide the 
mouse to the right to wrap the mask to the head. Once at 100 % here, we'll use the Thicken tool to give the mask 
some dimension. Finally, we'll convert to subpatch.
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4. Now she’s completely unrecognizable.
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Jitter Command

(default keyboard shortcut Shift J)

The Smooth command’s ugly sister is Jitter (Modify > Jitter). This command will add a roughness to the polygons of an 
object by randomly moving points within a certain radius of their current position. Jitter has several Type settings, each 
applying the effect in a different manner.

 

Uniform - Uniform performs a uniform jitter on every point within a rectangular region. A point may be shifted by 
as much as the value specified for the Radius parameter.

Gaussian - Gaussian results in a slightly less ragged jitter than the Uniform option, performing a normal 
distribution around the starting point’s location in an ellipsoid of the given Radius. A point may be shifted by as 
much as the value specified for the Radius parameter.

Normal - Normal uses the local surface normal and randomly moves points plus or minus within the specified 
Range along that surface normal.

Radial - Radial randomly distributes points inward or outward along a radial vector from a single point defined 
by the Center coordinates.

Range is the value used to set the range within which a point may move from its current location.

Scaling - Scaling is a variation of the Radial option. Points are jittered outward from a center point defined by the 
Center coordinates. Factor is the value used to set the range, as a percentage, within which a point may move 
from its current location.

A jitter value of 0 applies no jittering, meaning no change will occur. Values above or below 0 will affect the object.
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Segment Scale

Segment Scale (Modify > Transform > Segment Scale) allows you to select a group of points (in order) and scale them as 
one segment. This is a real time interactive tool that allows direct manipulation in any Modeler viewport.

You can scale points on multiple foreground layers at once and the scaling will take place on the same layer(s) as the 
original points.

Points on this sphere have been selected in an order that allows Segment Scale to move the points along an edge.

Scale

Enter the percentage you want the segment scaled or use the Slider button next to the Scale text box to increase or 
decrease the value.

Scale Type

Allows you to choose which points to move.

Centered - Will move both sides equally.
Side 1 Only - Will move side 1 only.
Side 2 Only - Will move side 2 only.

The LMB can be used in any Modeler viewport to manipulate the points directly.
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Selection Order

Segment Scale uses the point order of the selected points.

First -> Last - Loop Order.
First -> Second - Pairs

Examples:

Scale Type = Centered, Selection Order = First >Second. Before edit.

Scale Type = Centered, Selection Order = First->Second. After edit.
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Scale Type = Side 1 Only, Selection Order = First->Second. After edit.

Scale Type = Side 2 Only, Selection Order = First->Second. After edit.

Scale Type = Centered, Selection Order = First->Last. After edit.
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Scale Type = Side 1 Only, Selection Order = First->Last. After edit.

Scale Type = Side 2 Only, Selection Order = First->Last. After edit.
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Size Tool

(default keyboard shortcut Shift H)

The Size tool (Modify > Stretch > Size) allows you to scale an object uniformly along each axis, retaining its proportions.

To size an object:

Select the Size tool (Modify > Size) and, while holding down the LMB, drag your mouse right to increase or left decrease 
the size of the object. The center of the effect is determined by the Action Center setting, discussed previously. The 
information display will indicate the scaling factor you have applied.

The Size Numeric Panel

The Size Numeric Panel has only two basic settings: the Center XYZ values which define the coordinates for the center of 
sizing; and the size Factor, which defines amount of sizing, as a percent.
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The falloff modes for this tool are described in detail in Falloff Mode
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Lattice

Capture is shown with Symmetry active and multiple layers

The Lattice tool allows you to deform geometry. The bounding box that is made when you start the tool has 16 handles 
in each axis that can be grabbed and moved to adjust the geometry contained within. The handles work with symmetry 
and multiple handles can be selected at a time using the RMB to draw a selection box around. If you want to refine your 
selection, you can remove selected points holding the Ctrl key. Once a selection is made you need to click on one of the 
selected points to move your selection otherwise it will be lost.

Lattice works with Symmetry and multiple Layers.



LightWave 2020  –  LightWave 2020

Reference –  1276

Spline Guide Tool

Generally, the Spline Guide tool (Modify > Spline Guide) performs interactive deforming operations based on a guide 
curve. Clicking in the window creates the initial guide curve and center axis. Initially, the guide curve will be aligned 
along the longest distance of the selected geometry, extending from its minimum to maximum point. The center axis is 
centerd within the geometry.

 

Initially, the guide curve points have no effect on the geometry - like bones in their rest position. However, moving the 
points will vary the strength of the effect. Moving the center axis will change the influence of all the points on the curve.

What effect is applied is determined by the Operation setting on the numeric panel.

The Scale operation scales the geometry in the plane perpendicular to the axis around the center axis. Moving the guide 
points closer to the center shrinks the geometry, moving them farther away as it expands it.
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The Stretch operation scales the model in the plane perpendicular to the axis around the center like the Scale
operation, but uses different amounts of scaling in the plane (call it X-Y) depending on the X and Y distance of the guide 
points from their initial positions. Thus, the geometry can be expanded in one direction and reduced or left unchanged 
in the other.

The Twist operation rotates the geometry around the center axis. The Twist Angle parameter acts as an angle scaling 
factor.
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The Bend operation bends the model to conform to the curve.

The Weight Map operation works a little differently than the other operations in that it doesn’t deform the geometry, 
but affects the selected Weight Map instead. Essentially, it sets the values based on the reshaped curve. Move them 
closer to the center axis for negative weights, farther for positive.

If you activate Make Curve, a curve polygon will be created from the guide curve when you deselect the tool. Use this to 
save the guide curve shape. This curve can be placed in a background layer and loaded into the guide curve by clicking 
Get Background Curve.

Click Keep Edit to accept the current changes without resetting the curve. This is useful if you want a certain curve to be 
applied in subsequent operations.
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Changing the Curve Points value will resample the curve into more segments. Note that resampling the curve can 
change its shape, particularly if the number is incremented gradually, as is the case with the mini-slider. If you want a 
more refined curve that accurately matches the one you have drawn, enter the new number directly into the field to 
avoid the intermediate curves.
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Stretch Tool

(default keyboard shortcut H)

The Stretch tool (Modify > Stretch) is similar to the Size tool (discussed later), except that you can scale the object 
independently along each axis.

To stretch an object:

Select the Stretch tool (Modify > Stretch) and, using the LMB, drag your mouse right or left to increase or decrease the 
size along the horizontal axis. Moving up or down will increase or decrease the size along the vertical axis. The center of 
the effect is determined by the Action Center setting, discussed previously. The information display will tell you the 
scaling factor you have applied. Hold the Ctrl key while dragging to constrain movement along the initial dragging axis.

The Stretch Numeric Panel
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The Axis setting defines the axis of scale. When you click in a viewport, the axis is an imaginary line running 
perpendicular to the view you are editing in. The Horizontal Factor and the Vertical Factor represent the amount of 
scaling on those axes for the viewport. The Center XYZ values define the coordinates for the center of scaling.

The falloff modes for this tool are described in detail in Falloff Mode

Using the RMB (and Ctrl) for controlling motion will result in much finer stretch increments.
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Taper Constrain

The Taper Constrain tool (Modify > Transform > Taper Constrain) will resize an object at one end. You could use this tool 
to turn a box into a pyramid. Think of Taper Constrain as Size with axial falloff. That is, the strength of the sizing 
influence is not equal across the object, but gradually falls off along a selected axis.

To use the Taper Constrain tool:

Select Modify > Taper Constrain and drag your LMB left/right to apply the scaling. The center of the effect is determined 
by the Action Center setting, discussed previously.The information display indicates the Scale factor you applied.
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The Factor value on the numeric panel reflects the amount of scaling. The Center X, Y, and Z values indicate the center 
point of scaling.
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Taper Tool

The Taper tool (Modify> Taper) is very similar to the Taper Constrain tool. The difference is that it allows you to scale the 
affected end independently on the two axes. Basically, Taper is to Taper Constrain, what Scale is to Size. Think of Taper
as Stretch with axial falloff. That is, the strength of the moving influence is not equal across the object, but gradually 
falls off along a selected axis.
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To use the Taper tool:

Select Modify > Transform > Taper and drag your LMB left/right to apply the scaling horizontally. Drag your LMB down 
to apply it vertically. The center of the effect is determined by the Action Center setting, discussed previously.

The information display indicates the Scale factor you applied along the two affected axes. Hold the Ctrl key down 
while dragging to constrain the tapering to your initial dragging axis.
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The Horizontal Factor and Vertical Factor values on the numeric panel reflect the amount of scaling in those directions 
relative to the viewport used. The Axis buttons relate to the axis along which the effect occurs. If you use an arbitrary 
axis (i.e., taper in a perspective viewport), no Axis buttons are selected. The Center X, Y, and Z values indicate the center 
point of tapering, through which the axis runs.

The falloff modes for this tool are described in detail in Falloff Mode
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Transform Tool

Modify > Transform > Transform - A gizmo modeling tool that provides moving, rotating and scaling of your Point, Edge 
or Polygon selections or complete objects as needed using the new mesh system. Clicking the right mouse will 
reposition the gizmo to a new point, edge or polygon normal to enable better control. The gizmo itself is a LightWave 
object that can be edited to suit your needs and can be found in LightWave/support/gizmos.

The handles are colored to match their axes. The curves at the end of each arrow are for rotating, the arrows are for 
translation and the colored boxes are for scaling on a specific axis. The yellow circles are for translating on two axes and 
the white box at the center of the default gizmo is to scale on all axes.

Using Ctrl will adjust the position and rotation of the Transform gizmo so that you can rotate about a point not 
located on the object, for instance.


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Transform - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Set Scale
Fit to Background
Background Conform (BG Conform)
Absolute Size

Reference

Pole Evenly Tool
Pole Tool
Scale Morph Tool
Smooth Scaling
Center Scale
Center Stretch
Smooth
Quantize Tool
Wrap Sphere

Set Scale

You need to have at least two points selected to use this tool to provide a base measurement. With the two points 
selected, choose Set Scale and you will be presented with a measurement in the LW Measurement Distance field. You 
can choose the scale you would like your object to assume by tapping it in the Real World Distance field. There are 
controls on how to take the measurement (Measure along Axis: XYZ, X Only, Y Only, Z Only) and how to apply it with the 
Scale Center or Axis choices.
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1.

2.

Fit to Background

You need a foreground and background layer showing, then you can start this tool. The switches (Fit to Background X, Y 
and Z) can each be checked or unchecked and the foreground object will assume the same Bounding Box 
measurements on the axes you have chosen. The Move to Background Center option moves the foreground geometry 
to where the background geometry is sitting.

Background Conform (BG Conform)

The Background Conform function is available through the Legacy plugin Spherize.p. To install it and get the use of 
BGConform, Spherize and Squarize, use the Add Plugin command. To add it to your Modify tab, use the Edit Menu 
function( Alt F10). This function will take an object in the Foreground layer and fit it to an object in the Background 
layer.

Steps for using Background Conform:

Place the object that you want manipulated in the Foreground and the “effector” object in the Background.

Click on the Background Conform button and presto! Instant conform.
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Absolute Size

Absolute Size (Modify > Transform > More) allows you to scale geometry with great flexibility and precision. With the 
Values setting set to Independent, the object can be scaled independently on each axis. If Locked is used, the aspect of 
the geometry is maintained, meaning you only need to change one value and the others will change accordingly, to 
keep the proper relative proportions of the geometry.

Reference

The Reference setting determines a reference for the selected Action Center. Bounding Box uses a bounding box around 
all of the geometry. World uses the Origin. B.G. Layer uses a bounding box around geometry in the background. 
Absolute lets you numerically set the center position. The c setting will scale using the center of the reference. The 
minus (-) or plus (+) setting will scale using the negative or positive side of the reference.

Pole Evenly Tool

The Pole Evenly tool (Modify > Transform > More > Pole Evenly) scales an area of an object along the vertical and 
horizontal axes.

This is a handy tool for creating Morph Targets!
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To use the Pole Evenly tool:

Select Modify > Pole Evenly and drag your LMB in a viewport. The center of the effect is determined by the Action Center
setting, discussed previously.

The information display indicates the Scale factor you applied.
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The Factor value on the numeric panel reflects the amount of scaling. The Center X, Y, and Z values indicate the center 
point of scaling. You can edit the values and then click the Apply button to apply them, which you can do multiple 
times.

Pole Tool

The Pole tool (Modify > Stretch > Pole) is identical to Pole Evenly, except that you can scale an area independently on 
the two axes - dragging your LMB left/right to affect horizontally and up/down to affect vertically.

The information display indicates the Scale factor you applied along the two relevant axes.

The falloff modes for this tool are described on the Falloff Mode page.
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To use the Pole tool:

Select Modify > Pole and drag your LMB in a viewport. The center of the effect is determined by the Action Center 
setting, discussed previously.

The information display indicates the Scale factor you applied
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The Horizontal Factor and Vertical Factor values on the numeric panel reflect the amount of scaling in those directions 
in relation to the viewport used. The Axis buttons relate to the axis along which the effect occurs. If you use an arbitrary 
axis (i.e., use in a perspective viewport), no Axis buttons are selected. The Center X, Y, and Z values indicate the center 
point of scaling, through which the axis runs. You can edit the values and then click the Apply button to apply them, 
which you can do multiple times.

Scale Morph Tool

Scaling the base of an Endomorph with a normal sizing tool may not add the proper amount of scaling to its morph 
targets. You may get better results with the Scale Morph function (Modify > Scale Morph).

You can select an Endomorph to scale from the Vertex Map drop-down list, or selecting the Transform All 
Morphs option will apply the scale to all Endomorphs in the object (which is often the preferred option in many 
cases where the base has been altered on an object containing many morphs)


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Smooth Scaling

A variant of the Stretch tool is the Smooth Scale command (Modify > Smooth Scale). This command will scale selected 
polygons, but attempt to smooth things out as it scales. No new geometry is added, so the smoothing is done using 
existing points and polygons. The scaling is done based on the normals in the selected geometry.

The Offset value, editable on the numeric panel, is the exact amount that the object will increase in size overall; 
however, due to the smoothing effect, not all parts will increase this much. Negative numbers are also allowed, which 
reverse the effect.

 

Center Scale

Center scale is located under the Modify Tab and will scale a selection around its center point. Factor is the value 
(percentage) of the scale operation.

Smooth Scale is great for use on SubPatch objects. Use it on the stomach of a figure to give it a beer belly.
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Center Stretch

Center Stretch is located in the Modify Tab and will stretch a selection on the X, Y, or Z axis around the selections center. 
Factor is the value (percentage) of the stretch operation.

Smooth

(default keyboard shortcut Shift M)

Live Smooth is an interactive version of the Smooth command and works in the same way. It has replaced Smooth in 
the menu. Be careful about adding Strength numbers larger than 3 as they may cause feedback loops in the smoothing 
that actually result in spikes forming in your mesh. The same can happen with Strength values approaching 3 with high 
levels of Iteration.

For dense meshes, turn Realtime off and hit Update to see changes.

Quantize Tool

The Quantize command (Modify > Transform > More > Quantize) will snap points to specific coordinate spacing intervals 
(like a grid).
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This is very useful for snapping a non-planar polygon into a specific plane or flattening one side of an organic or curved 
object.

 

Wrap Sphere

The Wrap Sphere tool is located under the Modify Tab. Wrap Sphere will take the selected geometry (or all geometry) 
and deform it into a sphere. This is a great tool to use to create a Globe that unwraps into a flat map.
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Results will vary depending on which objects Wrap Sphere is applied to.
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Multiply

Introduction

These tools allow you to add to geometry using a variety of tools. Existing polygons can be used to create new detail in a 
model, including processes whereby one polygon can be turned into a complete 3D object, and objects can be 
multiplied in a variety of ways.

Extend
Extend - More
Duplicate
Duplicate - More
Subdivide
Subdivide - More
Destroy
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Extend

The Extend tools offer ways to use one or more existing polygons to create additional polygons and add depth and 
detail to objects or to create entire objects.

Bevel Tool
Chamfer
Rounder Tool
Extrude
Lathe Tool
Smooth Shift Tool
Smooth Scale
Multishift Tool
Thicken
Extender Plus
Rail Extrude Tool
Spline Bridge
Magic Bevel Tool
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1.

Bevel Tool

(default keyboard shortcut B)

The Bevel tool (Multiply > Extend > Bevel) is likely one of the most commonly used Modeling functions. Basically, it 
takes a polygon and extrudes it away from the original along the surface normal. It is similar to using the Extrude tool, 
but there will be no polygon at the position of the original polygon. When applied to multiple polygons, each polygon 
receives its own bevel - even on a double-sided polygon.

Steps for Beveling a Polygon:

Select the polygon(s) you would like to Bevel.
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2. Left-click and drag to create a bevel.

Dragging your pointer after activating the tool lets you graphically place the bevel. Deactivating Bevel or selecting 
another tool makes the bevel. Click on an open area of the interface to cancel the bevel before it is made or use Undo.

Dragging up/down lets you interactively change the Shift amount, the distance that the selected polygon will move 
along its surface normal. On the numeric panel, positive values make the bevel move in the same direction as the 
normal. Negative values make it move in the opposite direction.Dragging left/right lets you interactively change the 
Inset amount, the distance that the edges of the polygon will move in the same plane as the polygon. On the numeric 
panel, positive values move inward and negative values move outward.

Drag at an angle to simultaneously change Shift and Inset. Hold the Ctrl key to constrain to Shift or Inset, depending on 
which direction you drag initially.

If you select polygon(s), the top polygon will remain selected so you can perform bevel operations one after another. 
Click your RMB to accept the current bevel and begin a new bevel operation. You can also press the B key twice to make 
and start a new bevel. You can also bevel multiple polygons simultaneously!
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Other Numeric Options

The +/- fields on the numeric panel let you set randomization for the Inset and Shift values. The actual value applied will 
be varied by a random number between plus or minus the +/- value. For example, if Inset was 20 m and its +/- was 5 m, 
then the actual Inset would be between 15 and 25 meters. Generally, you want to use this feature only when beveling 
many polygons simultaneously.

Inner is the default Edges setting and bevels the polygon inward and forward along the surface normal. Outer will bevel 
outward and backward; however, the original polygon does not move and the new beveled edges extend away from the 
surface normal. This option reverses the mouse movement effects. In most cases, you use Inner.

By default, the surface name of the source polygon is used for the new geometry. If you select New Surface, you can 
enter a surface name (even an existing one) in the input field. You can change this setting anytime before accepting the 
bevel.

To avoid negative random values, make sure the +/-value is always less than or equal to the related Inset or 
Shift value.


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Beveling Tips

After performing a bevel, the selected polygon remains selected. To accentuate the beveled edge when the surface uses 
the Smoothing Surface option, perform a quick cut and paste to separate the selected (top) polygon from the added 
sides. This action precludes LightWave from smoothing over the beveled edge. You may also want to cut and paste the 
original polygon (before performing the bevel). Make sure you do not merge points after doing this!

Left: Polygons Not Separated, Right: Polygons Separated

If you use the same surface, which uses Smoothing, and the geometry goes from straight to curved, you may want to 
separate the polygons (with a cut-and-paste) at the transition point to get a clean edge.

The selected polygon retains its surface name; only the new edge polygons receive the defined name.
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Left: Polygons Not Separated, Right: Polygons Separated

If you wish for your bevel to become a smooth rounded edge that appears to blend into the object instead of the sharp 
defined edge you get with separating the polygons, add an extra bevel before, and after your bevel (a subtle shift and 
subtle inset). This will allow LightWave to correctly shade the bevel to appear the smoothly connect with the rest of the 
geometry.
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If you want to create an enclosed solid object when bevelling a 2D polygon, copy it to another layer first and choose 
Detail > Polygons: Flip. Go back to the original layer and perform the bevel normally. Then, paste the flipped polygon 
back into the original layer and choose Detail > Polygons: Merge Polys to merge points.

Cut and paste a polygon (like one side of a box) away from its host and bevel it a very small amount. Then, cut and paste 
the top polygon as well. This makes a nice clean edge that catches specular glints.

When you bevel polygons with sharp edges, you can often run into the problem of points being too close at the corners - 
very common when you bevel text characters. One solution is to delete unnecessary points near the corners prior to 
beveling. Don’t be scared to delete too many points; the change is usually so slight that no one will notice, particularly if 
the text is animated.

Another corner-fixing trick is to bevel out instead of in. This has the benefit of not requiring you to work on any points, 
but it affects the spacing between characters, if you are working with text. For this, use the Outer setting for Edges in the 
Bevel numeric panel.

Sometimes you also need to manually drag points on the new polygon away from the corner.
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Chamfer

(Default keyboard shortcut CTRL B)

Chamfering Points, Edges and Polygons. In previous versions of LightWave, Edge Beveling the central shape in one 
operation would not have been possible with the built-in tools.

Multiply > Extend > Chamfer - A simple, rapid tool which allows the user to bevel an object. Points, edges and polygons 
can be chamfered. Unlike a Bevel, which adds to your object’s volume, Chamfer maintains or reduces the volume of 
your object.

There are several controls in the Numeric window depending on what mode you are in when you choose to Chamfer 
(Point, Edge or Polygon). The first is the amount of chamfering with a Measure Amount button to enable you to measure 
an existing distance in the viewport. In Point mode, Edge Compensation will maintain the overall shape of your object 
while chamfering selected points.

In Edge mode, you have Subpatch-Friendly, which attempts to keep NGons out of the mesh so it can be successfully 
subpatched and Edge Compensation.

In Polygon mode, you have Subpatch-Friendly, Group Polygons - a toggle to either chamfer polygons as a group or 
individually, much like Bevel - and Edge Compensation. You can also toggle the Group Polygons mode by hitting ins on 
your keyboard.
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Rounder Tool

The Rounder tool (Multiply > Extend > Rounder) will bevel, smooth edges and generally round off geometry on a closed 
mesh in a variety of ways. It rounds based on point selection, bevels edges, smooths corner edges, has interactive 
controls, presets and more.

 

Selecting Edges

The edges you want to round are selected by selecting the edges or points at either end of the edge - illustrated below, 
or selecting the edge in Edge mode:

 
If no points are selected, as with other Modeler tools, Rounder will assume all the points have been selected (and hence 
round all edges/points).
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To only round three edges (of the four), add an extra point to the edge you don’t want rounding.

If the selected object is small in scale and Rounder is activated, the default values may make the object 
explode in size. If this happens, open the Numeric Panel and reduce the Inset Scale.



With the above method of edge selection it is NOT possible to select all but one edge of a polygon (eg. to round 
three edges of a square on one side of a cube). As shown on the left, if all four points are selected then the 
polygon is beveled.


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1.
2.
3.

Selecting Polygons

If no polygons are selected, Rounder will scan all the polygons of the object. If you are only rounding a few edges of an 
object containing a large number of polygons you can speed up the action of Rounder by selecting the polygons 
containing only the points/edges you are rounding.

Clean Geometry. An important part of not generating errors with Rounder is to ensure the geometry is clean:

Rounding edges must be shared by exactly two polygons.
Polygons containing rounded edges must be planar.
Make sure no isolated points or two-point polygons are selected

When selecting polygons make sure you select all the polygons adjacent to the edges/points you are rounding, 
otherwise Rounder will generate an error.


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•

The Rounder Numeric Window

Actions

Activate - you must either select Activate or click on a Modeler viewpoint before Rounder will actually round any 
edges.
Reset - select this to set all the controls on the panel back to their previous (ie. the last time Rounder was used) 
values.

Points/Edges

Select Points if you only want the points of your selected points to be rounded.
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Select Edges if you only want the edges defined by your selected points or edges to be rounded.
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Rounding polygons - This option sets the number of bevels that will be applied to the edge as illustrated below:

Inset Distance   - illustrated below:

Inset Presets - This is a popup list of preset inset distances (in the units chosen in Modeler’s Options panel). You 
can choose which list of presets to use on the Presets Tab.
Adjacent surfaces - This controls what surface is allocated to the newly created rounding polygons. If this is 
selected then Rounder will assign the surface to that of the original polygon adjacent to the selected edge as 
illustrated below:

The number of Rounding Polygons setting will appear in the viewport.
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If it is unchecked, then a new surface is assigned to the new polygons. The name of the new surface is given by 
the “New Surface” control.

New Surface - All newly created rounding polygons are assigned this surface.

Mesh Density - this determines the type of mesh on rounded points.

The central polygon on the point corner is adjacent to all the original polygons and hence its surface allocation 
is intrinsically ambiguous - it is assigned the surface the rounding algorithm first comes across.



If the Adjacent Surfaces checkbox is selected this option is not available.
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•

Low - this creates a mesh with a minimum number of polygons.

High - this creates a mesh on the corners with only quads.
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• Convexity - illustrated below.

Rounding points will cause them to be “indented” as shown below.
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• Project Inset - This button controls how Rounder projects the inset at edges. This is illustrated below:

When the projection is on, the width of the rounded edge is equal to the inset distance (0.5 m), but where the rounded 
edge intersects the side, the width is 1.1 m - which it must be to keep the rounded width constant along the edges. If the 
inset projection is off, then where the rounded edge intersects the side the width is set equal to the inset distance - this 
results in a tapering rounded edge. Why have this option? Well, there are situations where the choice of the 
intersections widths is ambiguous and Rounder has to “guess” what you want. It may not “guess” correctly and in that 
case it is better to force Rounder to not use projections, as is illustrated for the “wedge” below:
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Viewport Tool Tab

Activate Viewport tool — The Viewport tool allows you to drag the mouse in the viewport to interactively 
change either the inset distance or the number of rounding polygons by dragging either horizontally or 
vertically.
Inset mouse axis — This switch allows you to choose which axis controls the inset distance. If you want to drag 
horizontally to change the inset distance (and vertically for the number of rounding polygons), then choose 
Horizontal. Choose Vertical for the converse situation.
Inset scale — This controls the sensitivity of the mouse dragging when changing the inset distance.
Polygon step rate — This controls the sensitivity of the mouse dragging when changing the number of 
polygons.

Open GL Polygon Tab

OGL Polygons? These are additional polygons added to remove OGL display defects. The OGL polygons are in the same 
plane as the “flat” part polygons adjacent to the rounding polygons. Roughly speaking it stops the OGL renderer 
smoothing the edge into the bulk of the object and keeps the smoothing to the rounder part of the object.

Activate OGL polygons — Switch on or off the OGL polygons.
Inset percent — The size of the polygons is taken as a percentage of the inset distance.
Surface from — The surface name assigned to the OGL polygons can be:

Poly — the same as the original polygon (before rounding)
Edge — the same as that of the new rounding polygons (as determined by the main panel)
New — the name can be a new name as determined by the next control.

New Surface — The name of the new surface as chosen by the previous control.

Presets Tab

All the settings on the whole panel are now saved in a file, called RounderConfigs.txt, and reloaded when Modeler is 
launched. You can “Revert” to the settings in that file or you can revert to the Factory (ie in-built) settings.

You can assign up to three different inset preset files to the three “File” boxes. This allows quick switching between 
different sets of inset presets - or you can use the default (in-built) set.

More detail for the inset preset files:

1. You need to create inset preset files. You can create the file using a text editor with one number per line (with no 
units). Create as many files as you like (eg one for mm steps, one for m steps) etc.

2. Click on one of the Preset Inset File numbers (eg “File 1”), then click on the Change File button.

3. Then navigate to one of your inset preset files and select it.

4. All the inset presets are now loaded in and should appear in the inset preset pop-up.

5. Repeat (if desired) for the other two cases.

6. Now, each time you click on a Preset Inset File number, all the preset insets in the associated file are loaded.

Be aware that Rounder needs a closed mesh to work properly. While it may work on an unclosed mesh, 
Rounder is likely to crash.


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Preset Inset File - Select one of the four possible inset files to use with the Inset Presets pop-up menu on the 
main panel. File 1, File 2 and File 3 are the three presets files, while Def is the default built-in set of inset presets.

File 1 — The name of the File 1 inset preset file is displayed here.
File 2 — The name of the File 2 inset preset file is displayed here.
File 3 — The name of the File 3 inset preset file is displayed here.

Change file - This button enables you to navigate to a text file containing a list of inset presets. First select which 
of the three files, File 1, File 2 or File 3 in the Preset InsetFile row on controls, then click the Change File button 
and navigate to your preset inset file.
Revert Settings — Click on this button to change all the settings in the whole panel to those saved in the 
“RounderConfi gs.txt” file.

NOTE: All the settings of the entire panel are saved to the “RounderConfi gs.txt” file whenever you quit Modeler.
Factory Settings — Click this button to reset all the settings on the panel to the default built-in settings.
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Extrude

(default keyboard shortcut Shift E)

Use the Extrude tool (Multiply > Extend > Extrude) to give depth to a two-dimensional shape. You can extrude any two-
dimensional polygon or curve. The distance and angle from the initial dragging point sets the extrusion length and 
direction. As you continue to drag your mouse, you see the extrusion length and angle change accordingly.

The initial dragging point is not significant, only the distance and direction matter. In fact, when you release the mouse 
button, the axis will reposition itself starting at the object. You can further manipulate the axis by dragging its end in 
any viewport.

You can extrude polygons on multiple layers at once and the extrusions will be on the same layer as the original 
polygons.

When you are satisfied, simply click Multiply > Extend > Extrude again (or select another tool). To reset, click in a non-
active part of the interface or click Undo.

The numeric panel for Extrude defines the relative XYZ coordinates for the end of the axis in the Extent fields. You can 
change the number of Sides created on the panel, which can be useful for multi-segmented items like snakes, or objects 
you wish to bend or twist.

New to 2018

If you extrude a 2D shape, there is no longer a need to flip the polygons, if you are extruding on the side with the 
normal.
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Make UVs Option

The Make UVs option at the bottom of the numeric panel assigns some default UVs based on the geometry of the object. 
Note that a UV Texture Map must be currently selected or this option will be ghosted.

The Extrude tool treats the original polygon(s) as a cap on the end of the extruded shape. Therefore, to create 
an enclosed object, you should extrude backwards (ie. behind the original polygon(s)) for all the polygons to 
be facing outwards. Extruding forward in the direction of the polygons normal will create inverted polygons 
and your extrusion will appear to be inside-out. To correct this, simply select the affected polygons and then 
select Detail > Polygons> Flip.


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Lathe Tool

(default keyboard shortcut Shift L)

The Lathe tool (Multiply > Extend> Lathe) will sweep an object around an axis. Essentially, Lathe creates a cylindrical 
object with a profile of the original form. For example, if you lathe a circular-shaped polygon, you create a donut. You 
can sweep any two-dimensional object or curve. The classic use of this tool is to create a vase or bottle.

Dragging your mouse in a viewport determines the initial axis. The lathe axis has a cross hair at its center (the initial 
dragging point), which is used to drag the entire axis around. To change the angle, drag either end of the axis. You can 
also drag out the axis, which gives you more control over the effect, but the length of the axis does not in itself influence 
the impact of the tool.

You can Lathe polygons on multiple layers at once and the resulting shapes will be on the same layer as the original 
polygons or curves.
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When you are satisfied, deselect the tool or select a different one to execute the edit. To cancel, simply click in an open 
area on the interface or click Undo.

If you wish to change the number of sides in the lathed object (like the number of slices in a pie), you can use the Left 
and Right cursor keys. If you’d prefer to lathe less than a full 360 degrees, you can drag the handles as indicated in the 
following illustration. (Note: If the two handles are overlapped, you can still drag to separate them.)

Numeric Options for Lathe

You can also open the Lathe tool’s numeric requester to numerically change settings.

Polygons may end up flipped. To correct them, simply choose Detail > Polygons > Flip.
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The Start Angle and End Angle fields let you enter the degree of lathing, Sides sets the number of sides, and Offset will 
shift the shape along the lathe axis. The Center values define the center of rotation coordinates.

Make UVs Option

The Make UVs option at the bottom of the numeric panel assigns some default UVs based on the geometry of the object. 
Note that a UV Texture Map must be currently selected or this option will be ghosted.

To create a coiled spring: create a disc with, say, a one meter diameter. Select Lathe and place the axis about 
one meter to one side of the disc. Then, open the numeric requester and set the End Angle to 720 degrees (two 
full rotations), Sides to 48, and Offset to 2 m. 
If you plan on using a high level of subpatching on your lathed object, eight sides will usually suffice for most 
round subpatched objects.


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1.

1.

Smooth Shift Tool

(default keyboard shortcut Shift F)

The Smooth Shift tool (Multiply > Extend > Smooth Shift) is a beguiling tool that may not seem useful at first; however, 
you will find a variety of uses for it, like creating thin grooves in an object. Smooth Shift moves selected polygons along 
their smoothed vertex normals. The smoothed vertex normal is computed using the average of the normals for the 
polygons that share that vertex.

This tool is similar to Bevel; however, Bevel applies effects individually to each selected polygon, whereas Smooth Shift 
treats all selected polygons as a group.

Steps to Smooth Shift a group of polygons:

Select the geometry you would like to extend.

Choose Multiply > Smooth Shift and left click and drag.
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Polygons on a convex surface tend to expand since the normals at their vertices point slightly apart, while polygons on 
a concave surface tend to shrink. Polygons that are smoothed together stay together since they share normals at their 
shared vertices. Where polygons pull apart, either because their smoothed vertex normals diverge and exceed the Max 
Smoothing Angle or because some are selected and some are not, the gaps are filled with bands of new polygons.

The Offset is the distance of shifting along the vertex normal. Positive values make the shift occur in the same direction 
as the normal. Negative values make it shift in the opposite direction.

Using Bevel would have resulted in this:
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The smoothing method in Smooth Shift requires a cutoff angle. The Max Smoothing Angle on the numeric panel 
determines whether polygons will be smoothed over. Any two polygons with adjoining edges at angles greater than this 
value will be smoothed across.

Dragging your mouse horizontally will change the Offset amount on the numeric panel.The Scale setting, accessible 
from the numeric panel only, expands or shrinks the new geometry around the center of its bounding (box) area.

To achieve what amounts to a group-bevel - where the selected polygons are treated as one instead of 
individually - use Smooth Shift with an Offset of 0. Then, manually move the polygons (which will still be 
selected). Alternatively, try Multishift.





LightWave 2020  –  LightWave 2020

Reference –  1330

Smooth Scale

This tool brings up a requester for a single offset value. Selected polygons will be scaled by this amount about their 
combined normals.
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•

Multishift Tool

Multishift is an interactive tool similar to Smooth Shift, which allows you to inset and shift groups of polygons together. 
Unlike Smooth Shift, this tool lets you interactively inset the selected polygons by dragging the mouse left/right. 
Furthermore, the inset algorithm used can be chosen along with the shifting algorithm through the numeric panel.

Steps for using Multishift on selected geometry:

Select the geometry you would like to extend
On the Multiply > Extend Menu , choose Multishift.
Open the numeric panel, and toggle on Multishift Mode if it is not already activated.
Left-click and drag to move the selected polygons.
Right-click to create a new shift.

Unlike Smooth Shift, an average normal shifting algorithm is provided to shift groups of polygons along their average 
normals rather than along a local normal. Some users find that shifting along an average normal is often easier to 
control, as it doesn’t deflate/inflate the selection as it grows inward/outward.

Inset Amount - The movement of the polygons towards the inner selection. Several new algorithms have been 
introduced for greater flexibility.
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Shift Amount - The movement of the polygons outwards along the polygon normals.
Inset Scale - Controls the scale of inset during a single operation
Shift Scale - Controls the scale of shift during a single operation

Inset Menu

Inset: Contour - A general inset algorithm which is intended to maintain the natural outer contours of the 
selection.

Inset: Relaxed Contour - Works like Inset: Contour, with a different set of rules for sharp edges. Points on an edge 
with an acute angle, say about 15 degrees or less, when inset will begin to move closer together faster than 
those on an edge with a wider angle. Inset: Relaxed Contour will relax these tight angles, so the points will not 
move closer or overlap as quickly.

Inset: Hybrid - A combination of the Inset: Flat and Inset: Inner Edge algorithms. When the geometry is generally 
flat, meaning the normals do not vary much from polygon to polygon, it will use the rules for Inset: Flat. When 
the geometry is not flat it will use the rules for Inset: Inner Edge.
Inset: Flat - A 2D shape algorithm which uses rules for 2D methods for determining the direction of moving 
inwards and outwards. Works best with a group of flat polygons.

Inset: Inner Edge - The original algorithm for Multishift. Works best if used with quadrangles that are laid out in a 
grid-like fashion.

Inset: Regular Scale - This algorithm moves the new points toward the center of the selection.

Since the algorithm works by projecting on a 2D plane, Inset: Flat will likely fail and move points in the wrong 
direction if the geometry is not generally flat.
Flat is ideal for beveling flat shapes like text


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Shift Menu

Shift: Contour - Similar to the algorithm for Inset: Contour, the outward points along the normals are moved in a 
way that tries to preserve the original contours of the geometry.

Shift: Contour 2 - A slight variant of Shift: Contour, in the majority of cases should give the same result, but will in 
some cases give a better result and in others a worse result.

Shift: Average Poly Normal - A basic algorithm which shifts the group of selected polygons along the averaged 
normal of each polygon within the group.

Shift: Average Point Normal - A basic algorithm which averages the normals of all points making up the selected 
polygons and moves the newly created polygons along those normals.

Shift: Local Point Normal - Moves each point along its normal.

Shift: Point Normal - Moves each point along its normal, but also includes unselected polygons in the 
calculation.

Preserve UVs - Will create UV Maps for the newly created polygons. The new polygons are copied to the UV Map 
but not inset or shifted.
New Surface - Creates a new surface for the new polygons in a shift. You can create a new surface name or use a 
previously created surface.

Highlight All Steps - When checked, highlights each shift in a work session. Unchecked, only the current shift is 
highlighted.

Multishift Edit Controls

Current Shift Slider - Adjusts the current active shift when two or more shifts are available

Shift: Local Point Normal tends to be more useful in organic modeling. 
Unlike Shift: Point Normal, Shift: Local Point Normals will not include unselected polygons in the computation 
of each point normal.



None of the above algorithms are designed to work in all situations, although the contour algorithms are 
designed to be general-purpose and should work in most situations. Like any tool it is best to experiment and 
see which one works best for the situation.


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Next Shift - Selects the next shift
Prev Shift - Selects the previous shift

Insert Shift - Creates a new shift after the currently selected shift. The new shift will now be active and created 
halfway between the previous and next shift.

Delete Shift - Deletes the current shift, only if two or more shifts exist in the operation. After deletion the next 
shift is then selected as active.

Multishift Mode - When checked, Multishift Mode is activated and will record shifts and allow the user to edit and 
save the profile. A Right Mouse Click will insert a new shift to the operation, just like Insert Shift will do.

Save Options

Quick Restore - The profile for the last “Quick Store” operation is activated.
Quick Store - Stores the current active operation profile for use with “Quick Restore”.
Load Profile - Loads a saved profile
Save Profile - Saves the current active operation to a specific file

Right-clicking with Multishift Mode Off will only save the last shift when you choose Quick Save or Save Profile. 
Each Insert Shift, however, will be saved in the history of the current session.


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3.

Thicken

Multiply > Extend > Thicken - Gives single polygon thickness geometry added dimension interactively inwards or 
outwards. It can additionally create multiple segments for the offset polygons and create separate surfaces for both the 
thickened polygons and the interior of your thickened object. The Contour algorithm tends to work well for very 
orthogonal geometry or geometry without any deep ridges, but Normal is the fail-safe when Contour fails.

The copy of the Thickened geometry is called the New Surface, and the extrusion joining the copy of the geometry to 
the original is called the Side Surface. If you activate the checkboxes to Create New Surface and/or Create Side Surface, 
then you can assign new surface names to those Thicken-generated polygons. There are three ways to define the 
surface names assigned to the New Surface and the Side Surface:

Type the new name of the surfaces directly in the text entry field.
Left-click on the drop-down arrow next to each text entry field to choose from a list of existing surface names.
Click Choose New Surface and left-click on an existing polygon to use the surface name of that polygon.
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Extender Plus

(default keyboard shortcut E)

Extender Plus (Multiply > Extend > Extender Plus) clones selected points and creates new geometry connecting the 
original points and the clones. Essentially, Extender Plus is like using Smooth Shift with 0 Offset, except with points 
instead of polygons. Extender Plus is an updated version of Extender and works better in many areas.

Extender Plus works in both Point and Polygon modes.

Point Mode: Point Mode allows you to select an unordered group of points, automatically reordering the polygons it 
extends to face the proper normals. Furthermore, it detects when it should loop and when it shouldn’t, unlike Extender, 
which always loops.

 
Furthermore, it uses a simpler but more efficient algorithm of determining the normals of each edge’s connected 
polygon when creating each extended polygon as opposed to reordering the entire point selection as a whole. As a 
result, you don’t have to select the first two points in the proper clockwise order. The entire selection can be selected 
with a lasso without problems. The tool works particularly well with the Select Loop tool when used to select borders.

Poly Mode: In Poly Mode, Extender Plus performs a quick grouped polygon extrusion without providing an interactive 
interface. It can be a quick way to extrude while having an interactive transformation tool active such as Scale/Move 
tool as opposed to using Smooth Shift or Super Shift, dropping it, and then reactivating transformation tools.

Extender Plus works in Symmetry Mode as well as SubPatch Mode, unlike Extender.
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Rail Extrude Tool

The Rail Extrude command (Multiply > Extend > Rail Extrude) will extrude a point, polygon, or object along a curved 
path (single rail clone) or multiple paths (multiple rail clone). It is nearly identical to the Rail Clone command, discussed 
later. The difference is that Rail Extrude forms a continuous skin for the object instead of making individual copies of 
the object.

The curve(s) must be in the background layer and the polygons must be extruded in the foreground layer. The 
orientation and position of the foreground polygons will affect the result.

Generally, they should be at the very beginning of the curve and oriented perpendicular to it - as if the curve was a 
thread you were threading through the polygons.

 

The direction that the curve faces (which end is considered the beginning) will have bearing on both the shape and 
direction of the cloning. The direction affects the direction of the extruding. If you don’t get the results you expect, try 
flipping the curve’s starting point with Detail > Flip. If you are using multiple curves, they should generally run in the 
same direction.
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You can use Rail Extrude with multiple layers foreground layers and a single background layer containing the spline(s) 
and the extruded shapes will be on the same layer as the original polygons.

Single Curve

The Single dialog will appear when a single curve is in the Background layer.

Segments: the number of segments in the resulting object. Select Automatic to distribute a number of segments along 
the rail curve (based on the Curve Divisions setting on the General Options panel) according to the curve’s knot (point) 
spacing.

Select Uniform Lengths to distribute some number of segments (which you specify) evenly along the length of the entire 
curve. No matter what the knot spacing is, the segments will remain evenly spaced.

Select Uniform Knots to distribute some number of segments (which you specify) evenly between the knots that make 
up the curve. Whether the knots are close together or far apart, there will be the same number of segments between 
each.

Oriented determines the orientation of the polygon template as it follows the curved path. When active, it causes all 
segments to angle themselves automatically so that they are aligned with the rail curve as it turns. When inactive, it 
causes all segments to remain in the same orientation as the template so that they face exactly the same way.

If a UV Texture is selected, the Make UVs options are available. You can create the UV Map perpendicular to the U or V 
axis. You can have the U or V value assigned to a range from 0 to 1. Note that a UV Texture must be selected or this 
option will be ghosted.
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Multiple Curves

The Multiple dialog will appear when multiple curves are in the background.

In practice, one curve will act as the main cloning curve and the other(s) act as shaping curves. The effect of the shaping 
curves is determined by the distance from the main curve. However, you may change the effect by moving the polygons 
closer or farther away from any of the curves.

Segments is the number of segments in the resulting object. Select Automatic to distribute a number of segments along 
the rail curve, based on the Curve Divisions setting on the General Options panel. If you also select Knot, segments are 
distributed with regard to the curve’s knot (point) spacing. If you use Length, knot spacing is disregarded.
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To specify the number of segments, choose Uniform and enter the number in the input field. If Length is also active, the 
segments will remain evenly spaced no matter what the knot spacing is. If you use Knot instead, there will be the same 
number of segments between each knot, no matter how close together or far apart they are.Strength determines how 
strongly the rails vie for control of the point locations. You will not notice much of a difference unless you have Scaling
deselected. The higher the Strength value, the closer the object will hug the rails.

Oriented determines the orientation of the polygon template as it follows the curved path. When active, it causes all 
segments to angle themselves automatically so that they are aligned with the rail curve as it turns. When inactive, it 
causes all segments to remain in the same orientation as the template so that they face exactly the same way.

Scaling determines how segments along an axis are sized. If the rails in the background layer spread apart along any 
axis or axes, then the segments will automatically stretch along those axes as well. Turn Scaling on to scale segments 
equally, rather than along those specific axes only.

For example, with Scaling off, if you Rail Extrude a polygon along the Z axis using two rails that spread further apart in 
the X axis, the segment’s copies will be stretched on the X axis to maintain their relationship to the guide rails.
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Spline Bridge

Spline Bridge links polygons to create a bridging effect. As you can see the Numeric panel doesn't offer many options, 
but operation is simple. Select one or more contiguous polygons on each object you wish to bridge and start the tool. If 
you select multiple polygons and they are not contiguous - they don't touch, the tool will not work. By default Divisions 
is set to 1, but often you'll want to increase the number of divisions to better bridge gaps. Handles are available to 
direct the bridging and the First Twist and Second Twist options are there in case the bridging becomes twisted (this 
happens sometimes when polygon normals are not conducive to bridging and the point order has to be revised).
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Only a single group of one or more contiguous polygons on separate objects can be bridged. If non-contiguous 
polygons are selected on either separate object, Spline Bridge will start, but no bridging will be done.



The cursor keys can be used as shortcuts for this tool. Up and Down will increase and decrease Divisions, while 
Left and Right will do the same with Twists. When the cursor is nearer one end than the other, that is the end 
that will be twisted. Otherwise, the First Twist will be changed.





LightWave 2020  –  LightWave 2020

Reference –  1344

Magic Bevel Tool

The Magic Bevel tool (Multiply > Extend > More > Magic Bevel) lets you interactively drag out a bevel along an editable 
path with tremendous control over how the bevels are created.

You create the bevels by dragging any of the blue circle handles. All polygons will get a handle regardless of what is 
selected. The path will be drawn along the vertical and horizontal axes of the viewport, so use a Perspective viewport to 
bevel off-axis.

You can use Magic Bevel on polygons on multiple layers at once and the bevels will be on the same layer as the original 
polygons.

This tool works on polygons, SubPatches, one-point polygons, two-point polygons, and Metaballs.
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Operation:  

Magic Bevel offers the following operations:

Extrude - Extrude is selected by default and is the mode that initiates the bevel creation. Simply left click on one 
of the knots and drag out new geometry.

Edit Path - If you activate Edit Path, drag handles will appear at each bevel. You may drag them to change the 
positioning of each bevel.

 

Delete Knot - If you activate Delete Knot, you can interactively remove knots from the path. Simply Left-click on 
the knot you would like to remove.
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Delete Path - Activating Delete Path will give you the ability to remove an entire path. Left Click on the knot at 
the end of the path to remove it.

 

Uniform Spans - Applying Uniform Spans to a magic bevel path will evenly space each segment in the path.

 

Straight - Activating Straight and clicking on the end of a path will align the entire path on the polygons normal.

 
Move by Path - When Edit Path is active, you may also activate Move By Path. This option moves all of the bevel 
positions, from the current edit up to the end of the path, together at the same time.. When this is off, only the 
selected point moves.

Spline - The Spline option turns the path into a smooth spline path. This will change the bevel positions slightly.
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Uniform - The Uniform option causes the bevels to occur evenly along the path. You will notice that the bevels 
will no longer occur at each edit handle. This only works when using the Spline option.
Align to Path - The Align to Path option aligns the bevel polygons with the tangent of the path. When this is off, 
the angle of the bevels matches the starting polygon.

Symmetry:

Axis - Choose the X,Y, or Z axis to determine which axis symmetry to work from.
Sync Direction - Sync Direction allows you to decide in which direction the sync will occur.
Sync Symmetry - Pressing Sync Symmetry will update the geometry in the Sync Direction to match the other 
half.

 

Precision - The Precision value sets mouse sensitivity and determines how closely the bevels follow the path. 
When your mouse pointer moves this many pixels, a bevel is created. Higher values are less precise and result in 
longer segments.

Scale - The Scale value sets how much to size down (or up) each successive bevel.

Spin - This setting will determine by how many degrees each new bevel will rotate as it is created.
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UVs for Sides - The UVs for Sides option at the bottom of the numeric panel assigns some default UVs based on 
the geometry of the object. Note that a UV Texture Map must be currently selected or this option will be ghosted.

U Repeat - All geometry created will share the same U coordinates.
V Repeat - All geometry created will share the same V coordinates.
U Rotate - Adjusting U Rotate will shift the U coordinates of the map.

If you click your RMB after you create a bevel path, blue handles will appear on the new bevel geometry.
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1.

Extend - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Edge Bevel
Create Rows
Extender Tool
 Rail Bevel Tool
Router Tool
Motion Path Extrude

Make UVs Option

Seashell
Make UVs Option

Spikey Tool
Create Skin
Morph Polygons

Edge Bevel

Edge Bevel is a tool for rounding or splitting edges. It can be used in either point, edge or poly mode. In point or edge 
mode, the edges, or the edges that are defined by selected points, will be split (beveled). In poly mode, only the outer 
edge of the selection will be split.

Select Edge Bevel (Multiply > Extend > More > Edge Bevel) to Bevel selected polygons or edges (by point selection). The 
Bevel can be adjusted by scrubbing in the interface or by using the numeric window. Further adjustments can be made 
until the tool is dropped (space bar).

You can bevel edges on multiple layers at once and the bevels will be on the same layer as the original polygons.

Steps for beveling an edge:

Choose the edges you would like to bevel.
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2. Choose Multiply > Extend > More > Edge Bevel and adjust the Move setting.

Use the Preview Mode on slower machines to speed up interactivity. To use the tool in Preview Mode, make selection 
first and then choose Edge Bevel from the Multiply Tab. To adjust size of bevel, click and drag on screen. When it is at 
the desired position, right click and it will set it. The size of the bevel can still be adjusted more if needed or if finished, 
just drop the tool.

Create Rows

Creates a row of polygons based on the first row of selected points and the last selected point. The order of selected 
points on the first row does not affect the tool.

If only one point is selected, nothing will happen when the tool is run (it’s an Edge Bevel tool, not a Point Bevel 
tool) 
If all or no polygons are selected (in poly mode), the tool will do nothing because it bevels only the outer edge 
of the poly selection. If they are all selected, there is no outer edge.
If you want to round the edges on a cube that is higher resolution, select only the edges of the cube, not any of 
the points between edges.



Edge Bevel will give unpredictable results if the points selected have missing adjacent polygons.

Edges that are not in the outer edge category can also be split. Selecting any two or more points in a row will 
define an edge to be split. Therefore, on outer edges, the hard corners will become soft, on inner edges, the 
edges will be split but stay on their current plane.


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1.

The first row of points is selected then the last point. The first row determines the number of polygons created. The first 
and last point selected determine the edge of the first polygon. In step 3 the last point selected was at a different angle 
and so the "fin" was extruded at an angle. 4 shows multiple rows can be selected. Here, all points on the original grid 
were selected before the last point.

Extender Tool

This tool has been superseded by Extender Plus. The Extender command (Multiply > Extend > More > Extender) clones 
selected points and creates new geometry connecting the original points and the clones. Essentially, Extender is like 
using Smooth Shift with 0 Offset, except with points instead of polygons.

Steps for extending points (edges):

Select the points that make up the edge you would like to extend. Remember to select the points in order and 
counterclockwise.
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2. Choose Multiply > Extend > More > Extender , then move the selected points away from original points.

In Subpatch mode, newly created geometry will be in Polygonal mode. Extender Plus doesn’t have this 
limitation.


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 Rail Bevel Tool

Rail Bevel (Multiply > Extend > More > Rail Bevel) is a very fancy beveling tool that works in a similar manner to the 
normal Bevel tool. Dragging your mouse left/right adjusts the new bevel geometry’s distance from the original polygon. 
Dragging up/down adjusts the inset direction (towards or away from the polygon’s center). The Ctrl key constrains the 
change to a given degree of freedom - just like the normal Bevel tool.

The difference between Rail Bevel and Bevel is that Rail Bevel uses a profile from a background layer to generate several 
bevel operations in a single step.

The profile is a series of points you create. They can be unconnected, or part of a polygon or curve. The only important 
factor is point order, which is normally determined by their order of creation.The profile is treated as if it were oriented 
based on the polygon’s plane and extrudes along the direction of the polygon’s normal.

Steps for using Rail Bevel:

Selecting the points out of order may have unwanted results.

Left: Points selected in order, counter clockwise. Right: Same points selected randomly.



Each point in the profile is treated as a bevel. X=Inset, while Y=Length.
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1.

2.

Create some geometry in a layer that you plan on extending.

In a new layer create a curve with the profile you would like to use for your bevel. Your profile must be created in 
the Back/Front viewport to work.
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3.

4.

5.

Place the curve in the Background layer and your object in the Foreground layer. Select the geometry you would 

like to bevel.

Click and drag to create your bevel. Dragging your mouse left/right adjusts the new bevel geometry’s distance 
from the original polygon. Dragging up/down adjusts the inset direction.

Press the Enter key to confirm.

The placement of the curve has no effect on the final outcome. 
New geometry inherits VMap and face/curve properties of the original polygon.


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Rail Bevel works with multiple polygons selected.

If you have multiple profiles in different layers, you can apply them one after another by selecting them (one at 
a time) as the background layer while using Rail Bevel.


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Router Tool

The Router tool (Multiply > Extend > More > Router) will create custom beveled Edges. The numeric window will come 
up as soon as you select Router and will give you several options to work with.

Router has three bevel types to choose from: Round, Hollow, and Stair Step.

Round: This option will create a “convex” curve profile.Hollow: This option will create a “concave” curve profile.Stair 
Step: This option will cascade the newly created geometry.

Depth - Adjusting the Depth setting changes the Height of the newly created geometry.
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Edge Width - Edge Width controls the Inset of the bevel.

Steps: Adjusting the Steps setting will change the number of segments created

Bevel on Corner?: Choosing Yes (Default) will constrain the bevel curve to the Depth and Edge Width settings. 
Choosing No will use the Depth divided by the number of Steps to configure the curve along the edge

 

Motion Path Extrude

Motion Path Extrude (Multiply > Extend > More > Motion Path Extrude) will extrude geometry along a motion path saved 
out of Layout.

First - This option defines the first frame in the motion file that will be used. 
Last - This option defines the last frame in the motion file that will be used.  
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1.

2.

Step - This option determines how many segments will be used in the extrusion, by setting a sampling ratio 
relative to the number of frames of the motion path. The lower the number, the more segments.

Step Examples:

First Frame 1, Last Frame 60, Step 0.5 - 120 Segments

Step 1 - 60 Segments

Step 2 - 30 Segments

Step 3 - 20 Segments

Make UVs Option

The Make UVs option at the bottom of the numeric panel assigns some default UVs based on the geometry of the object. 
Note that a UV Texture Map must be currently selected or this option will be ghosted.

Steps to extrude along a motion path:

Create a motion path for an Item in Layout.

With the item still selected go to File/Save/Save motion file. Be sure the file has the .mot extension.
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3.

4.

Open the Modeler and create an object.

Select Motion Path Extrude ( Multiply > Extend > More > Motion Path Extrude ). Select the path saved above and 
change settings in the numeric window as needed. 
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Click OK.

Seashell

The Sea Shell tool (Multiply > Extend > More > Sea Shell) lets you interactively make seashell shapes. Essentially, this is 
like using the Lathe with a scaling factor on an object.

Open the numeric panel to set options.  

Axis - the perpendicular axis around which the shell is twisted. 
# of Loops - the number of times the source polygon is twisted fully.  
Sides per Loop - is the number of segments to use per loop.  
Shift per Loop - controls the vertical shifting of the loop.  
Scale per Loop - the scaling factor achieved after each loop.
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1.

2.

Make UVs Option

The Make UVs option at the bottom of the numeric panel assigns some default UVs based on the geometry of the object. 
Note that a UV Texture Map must be currently selected or this option will be ghosted.

Steps for using the Seashell tool:

Create a flat polygon that you would like to apply Seashell to.

Choose Multiply > Seashell and set the options to your liking.
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3.

1.

2.

3.

Press Enter on the keyboard.

Spikey Tool

The Spikey tool (Multiply > Extend > More > Spikey) subdivides the selected polygons and moves the center point out in 
the direction of the surface normal giving a spiked appearance. Simply select the tool and drag your mouse pointer in a 
viewport.

Steps for using Spikey:

Create an object that you would like to use Spikey on.

Choose Multiply > Spikey , and open the numeric window.

Left click and drag in the viewport or use the Spike Factor input field on the numeric window to adjust the 
spikes.
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4.

1.

2.

Press Enter to confirm the changes.

Create Skin

With the Create Skin command (Multiply > Extend > More > Create Skin), you can cover a series of polygons or curves 
with a polygon skin. The shapes do not need to have the same number of points in common. This is also called lofting.

Select the geometry to be skinned.

Choose Multiply > Extend > More > Create Skin.

Using Spikey with a Spike Factor of 0 is a good way to subdivide a polygon for deformation.

The polygons or curves must be selected (or created) in the order that you want them connected.
This operation can only operate with elements from the same layer.


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Create Skin works best when you use single-sided polygons for the framework. Double-sided polygons can result in 
strangely skinned objects.

If you skin using curves, the curves will remain in the Modeler workspace following the operation. However, they do not 
become part of the resulting skinned object.

Morph Polygons

The Morph Polygons command (Multiply > Extend > More > Morph Polygons) will create a number of connected 
intermediate polygons between two selected polygons or curves that have the same number of points. They will have 
an outer surface, as if you also used the Skin command on them.

Although Create Skin is similar to the Make Spline Patch command (Construct > Patch), which uses curves, the 
difference between the two commands is significant. The Make Spline Patch command tends to follow smooth 
contours, which maintains a rounded surface. Create Skin tends to connect curves with straight-line segments, 
which creates less smooth profiles.





LightWave 2020  –  LightWave 2020

Reference –  1366

1.

2.

3.

Select the two polygons/curves that you would like to skin.

Choose the Morph Polygons command ( Multiply > Extend > More > Morph Polygons ) and set the number of 
segments and click OK.

The result is
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If you morph using curves, the curves are treated as straight-edged polygons, and will morph in a linear fashion. The 
curves also remain in the Modeler workspace following the operation, although they will not be part of the morphed 
object.

The Number of Segments field defines the number of morphed steps you desire between the two selected polygons.

Morph Polygons works best when you use it between single-sided polygons. 
To get a twist effect, rotate the source or target polygon a little.



As with the Morphing function in Layout, the Morph Polygons command is dependent on point order. As such, 
you should create the source and target from the same polygon. You may need to flip some polygons after 
using this command.


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Duplicate

The Duplicate group contains tools dedicated to copying existing geometry.

Mirror Tool
Mirror XYZ Tools
Clone Tool
Rail Clone Tool
Array
Place Mesh
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Mirror Tool

(default keyboard shortcut Shift V)

Use the Mirror tool (Multiply > Duplicate > Mirror) to create an exact mirror image of an item. You can mirror the whole 
object, selected points, or selected polygons. Many objects you create will be symmetrical in nature. So it often makes 
sense to build only half of an object, create a mirror image, and join them together. At other times, your object may 
include certain parts that are identical, and an automated way to duplicate them is very helpful.

 

This interactive tool works using a mirroring fence. You drag out the fence with your mouse. This forms the main axis for 
the fence’s length. Once you release the mouse button you can reposition by simply clicking somewhere off the fence - 
you are essentially repositioning the initial drag point.

You can rotate the fence using the rotation handles. The swing rotation handle swings the fence like a gate around one 
end of the fence. The axis rotation handle rotates the fence around the axis along the length of the fence.The numeric 
panel defines the XYZ coordinates of the Center point (where the position handle is). The Axis, if any, is the axis 
perpendicular to the fence.
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If Free Rotation is inactive on the numeric panel, the default setting, you will only be able to draw and rotate the fence 
across planes aligned with an axis. If you hold the Ctrl key down, you will be able to use 15-degree increments. If Free 
Rotation is active, you are free to draw and rotate the fence at any angle.

If the Merge Points option is active, any overlapping points are merged automatically. Use this if you are mirroring two 
halves of an object together. When you are satisfied, simply click Multiply > Mirror again (or select another tool). To 
reset, click a non-active part of the interface or click Undo.

If adjusting the axis rotation handle only resizes the fence, try adjusting the handle in the perspective view.
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Mirror XYZ Tools

Mirrors the selected object along the zero value of the chosen axis.
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Clone Tool

(default keyboard shortcut C)

The Clone command (Multiply > Duplicate > Clone) creates copies of an item that you can spread out in an even layout 
or array. You can create a series of copies along an axis at specified increments. Clone duplicates a selected item one or 
more times using specific increments of distance, rotation, and scaling. You can create a spiral staircase out of a single 
step, or a wood screw out of a triangular polygon outline, for example.

 

Enter the number of copies of the selection to create in the Number of Clones fields.

The Offset fields determine the incremental distance between one clone and the next along the X, Y, and Z axes.

The Scale fields set the amount of incremental scaling for each copy.

The Rotation fields set the amount of incremental rotating.

The Center fields define the coordinates to use as the center point, around which the operation takes place.

The effect is progressive, so the change is applied to each clone based on the previous clone. So, for example, 
with scaling, the copies will get progressively larger or smaller.


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If you plan to clone with rotation, try to build your base object so that the rotation can happen around the 
Origin whenever possible.



To evenly space objects around an axis, take the number of total objects you want to end up with and divide it 
into 360 (you can even enter the sum into the input field.) This gives you the incremental rotation. Then set the 
Number of Clones to the total objects minus one.
Immediately after a Clone operation involving a template (i.e., 2D) polygon, you can use the lasso to encircle 
and select the entire group of newly cloned polygons. They are automatically selected in the order they were 
created. This means you can use the Create Skin command (Multiply > Create Skin) to place an outer surface 
around the new framework. After using Create Skin, the framework polygons are no longer needed (since they 
are inside the skin and will not render anyway). They are still selected, so you can delete them (except maybe 
the two ends), and leave only the skinned object remaining. This technique is useful when you create objects 
like a wood screw, where you no longer need the internal (unseen) polygons after you complete the outer 
surface.


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Rail Clone Tool

The Rail Clone command (Multiply > Duplicate > Rail Clone) works just like the Rail Extrude command, however, instead 
of resulting in an object with a smooth skin, it creates skinless segment clones along the background curve(s).

Rail Clone will create clone or clones of a point, polygon, or object along a curved path (single rail clone) or multiple 
paths (multiple rail clone). It is nearly identical to the Rail Extrude command. The difference is that Rail Clone creates 
individual copies of the object instead of forming a continuous skin for the object.

The curve(s) must be in the background layer and the polygons must be cloned in the foreground layer. The orientation 
and position of the foreground polygons will affect the result. Generally, they should be at the very beginning of the 
curve and oriented perpendicular to it - as if the curve was a thread you were threading through the polygons.

 

The direction that the curve faces (which end is considered the beginning) will have bearing on both the shape and 
direction of the cloning. If you don’t get the results you expect, try flipping the curve’s starting point with Detail > Flip. If 
you are using multiple curves, they should generally run in the same direction.
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Single Curve

The Rail Clone: Single dialog will appear when a single curve is in the background.

Segments is the number of clones in the resulting object. Select Automatic to distribute a number of clones along the 
rail curve (based on the Curve Divisions setting on the General Options Panel) according to the curve’s knot (point) 
spacing.

Select Uniform Lengths to distribute some number of clones (which you specify) evenly along the length of the entire 
curve. No matter what the knot spacing is, the clones will remain evenly spaced.

Select Uniform Knots to distribute some number of clones (which you specify) evenly between the knots that make up 
the curve. Whether the knots are close together or far apart, there will be the same number of segments between each.

Oriented determines the orientation of the polygon template as it follows the curved path. When active, it causes all 
clones to angle themselves automatically so that they are aligned with the rail curve as it turns. When inactive, it causes 
all clones to remain in the same orientation as the template so that they face exactly the same way.
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Multiple Curves

The Rail Clone: Multiple dialog will appear when multiple curves are in the background.

In practice, one curve will act as the main cloning curve and the other(s) act as shaping curves. The effect of the shaping 
curves is determined by the distance from the main curve. However, you may change the effect by moving the polygons 
closer or farther away from any of the curves.

Segments is the number of clones in the resulting object. Select Automatic to distribute a number of clones along the 
rail curve, based on the Curve Divisions setting on the General Options Panel. If you also select Knot, clones are 
distributed with regard to the curve’s knot (point) spacing. If you use Length, knot spacing is disregarded.
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To specify the number of clones, choose Uniform and enter the number in the input field. If Length is also active, the 
clones will remain evenly spaced no matter what the knot spacing is. If you use Knot instead, there will be the same 
number of clones between each knot, no matter how close together or far apart they are.

Strength determines how strongly the rails vie for control of the point locations. You will not notice much of a difference 
unless you have Scaling (below) deselected. The higher the Strength value, the closer the object will hug the rails.

Oriented determines the orientation of the polygon template as it follows the curved path. When active, it causes all 
segments to angle themselves automatically so that they are aligned with the rail curve as it turns. When inactive, it 
causes all clones to remain in the same orientation as the template so that they face exactly the same way.

Scaling determines how clones along an axis are sized. If the rails in the background layer spread apart along any axis or 
axes, then the clones will automatically stretch along those axes as well.

Turn Scaling on to scale clones equally, rather than along those specific axes only.

For example, with Scaling off, if you Rail Clone a polygon along the Z axis using two rails that spread further apart in the 
X axis, the clone’s copies will be stretched on the X axis to maintain their relationship to the guide rails.
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Array

Rectangular options
Radial options

 

Array duplicates an object into an array of your choosing. The array can be in one, two or three dimensions and is 
updated as you change values in the numeric panel. There are two modes, Rectangular and Radial.

Rectangular options

Count X, Y, Z - How many of your object you want in the array.
Offset X, Y, Z - The distance between array elements modulated by the Mode dropdown below each entry. All 
offsets are measured from the leftmost point for X; the lowest point for Y and the furthest forward point for Z.

Between - The distance between each array element
Total - The total distance for the offset of array elements
Multiply - The distance between array elements is multiplied at each increment of the array
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Random Position X, Y, Z - Randomizes the position of each array element up to the amount set, in both 
directions
Rotation X, Y, Z - Randomizes the rotation of each array element up to the amount set, in both directions
Scale - Randomizes the scale of each array element up to the amount set, in both directions

Radial options

Radial Count - How many objects are contained within the bounds of the Start and End angles. Array elements 
will be rotated to the circle
Start Angle - The beginning angle for the array. Negative numbers are possible. The default is 0°
End Angle - The end angle for the array. The default is 360° and while more cannot be achieved with the mini-
slider numbers can be typed in this field
Offset - Raises on the Axis each object in the array modulated by the mode dropdown below

Between - The distance between each array element
Total - The total distance for the offset of array elements
Multiply - The distance between array elements is multiplied at each increment of the array

Axis - The axis in which you wish to make your array
Radial Center - Offset the center of your Polar array. Changing the Radial Center of the Axis in which your array 
is made has no effect
Random Position X, Y, Z - Randomizes the position of each array element up to the amount set, in both 
directions
Rotation X, Y, Z - Randomizes the rotation of each array element up to the amount set, in both directions
Scale - Randomizes the scale of each array element up to the amount set, in both directions
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Place Mesh

Multiply > Duplicate > Place Mesh - Place Mesh is a tool to place background objects onto the foreground object’s 
polygons, aligned to their normals. It can work with a single background object or multiple, and placed meshes can be 
scaled or rotated as they are placed. If multiple background objects are used, they will be randomly chosen among.

The Ignore Placed Meshes toggle will not allow the placement of background meshes on anything other than the 
foreground object, avoiding placement of meshes on meshes on meshes, and the Use Smooth Normals toggle will 
place background meshes using a smooth normal setting to ensure better alignment with organic surfaces.

The Populate button creates a clone for each normal of a group of selected points or polygons, depending on the 
selection mode. Use Random Pitch, Random Heading and Random Scale to randomize these clones.

Naked points can also be clicked on and meshes applied to them and vertices in geometry will be snapped to. The snap 
behavior can be overridden by holding down Shift.

PlaceMesh cannot use layers from a different object as background layers. The solution is to temporarily copy 
the layers you require into the foreground object.


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1.

Duplicate - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Particle Clone
Clone to Layer
Motion Path Clone Tool
Symmetrize Tool
Point Clone Plus Tool
Radial Array
Helix Tool
Spin It Tool

Particle Clone

Particle Clone (Multiply > Duplicate > More > Particle Clone) will make a copy of the foreground object on each point 
that makes up the background object. It’s great for asteroids, bubbles, spikes, grass, etc.

Using Particle Clone:

Place the object that you would like to clone in the Foreground layer and the object that has the point 
information in the Background layer.
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2. Choose Multiply > Duplicate > More > Particle Clone , and sit back and enjoy the magic!

Clone to Layer

The Clone to Layer command (Multiply > Duplicate > More > Clone to Layer) creates copies of an item that you can 
spread out in an even layout or array. You can create a series of copies along an axis at specified increments. Clone to 
Layer duplicates a selected item one or more times using specific increments of distance, rotation, and scaling. You can 
create a spiral staircase out of a single step, or a wood screw out of a triangular polygon outline, for example.

 

If no object is in the Background layer, Particle Clone will clone the object in the Foreground layer using the 
points that make up that object.
Point Clone Plus (Multiply > Duplicate > More > Point Clone Plus) performs the same task but has options.


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This command is almost identical to the standard Clone (Multiply > Duplicate > Clone) command, but offers the ability 
to place your cloned geometry in multiple layers.

Clone to Layer Numeric Options:

Number of Clones - Enter the number of copies of the selection to create in the Number of Clones fields.
Clone Output - Choose between Current Layer and Multi- Layer.
Current Layer - This option will place the clones in the same layer as the original.
Multi-Layer - This option will place the clones in individual layers.

Select the Use Only Empty Layers option to skip over layers that contain data when clones are being created.

The Offset fields determine the incremental distance between one clone and the next along the X, Y, and Z axes.

The Scale fields set the amount of incremental scaling for each copy along the X, Y, and Z axes. The Rotation fields set 
the amount of incremental rotating around the Heading, Pitch, and Bank.

The Center Around option consists of Origin (0,0,0), the object’s center, and User Definable.

The Center fields define the coordinates to use as the center point, around which the operation takes place.

The effect is progressive, so the change is applied to each clone based on the previous clone. So, for example, 
with scaling, the copies will get progressively larger or smaller.



If you plan to clone with rotation, try to build your base object so that the rotation can happen around the 
Origin whenever possible.


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Motion Path Clone Tool

The Path Clone command (Multiply > Duplicate > More > Motion Path Clone) works just like the Path Extrude command, 
however, instead of resulting in an object with a smooth skin, it creates skinless segment clones along the motion path. 
Motion Path Clone will create clones of the selected geometry along the chosen motion path.

First: This option defines the first frame in the motion file that will be used. 
Last: This option defines the last frame in the motion file that will be used. 
Step: This option determines how many clones will be used in the extrusion per frame. The lower the number 
the more segments.

Step Examples:

First Frame 1, Last Frame 60

Step 0.5 - 120 clones

Step 1 - 60 clones

Step 2 - 30 clones

Step 3 - 20 clones

Steps to extrude along a motion path:

To evenly space objects around an axis, take the number of total objects you want to end up with and divide it 
into 360 (you can even enter the sum into the input field.) This gives you the incremental rotation. Then set the 
Number of Clones to the total objects minus one.


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4.

Create a motion path for an item in Layout.

With the item still selected go to File/Save/Save motion file. Be sure the file has the .mot extension.
Open the Modeler and create an object.

Select Motion Path Clone ( Multiply > Duplicate > More > Motion Path Clone). Select the path saved above and 
change settings in the numeric window as needed. 
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5. Click OK.

Symmetrize Tool

The Symmetrize command (Multiply > Duplicate > More > Symmetrize) clones an object n times with a rotation each 
time so that the result displays n-fold symmetry about the selected Axis. An object is said to have n-fold symmetry if it 
looks the same after being rotated 360/n degrees.

Point Clone Plus Tool

The Point Clone Plus command (Multiply > Duplicate > More > Point Clone Plus) will clone objects in the foreground to 
the locations of points in the background. You can randomize the rotation, scale, and centring independently for every 
axis between two values. Random Size will randomly change the overall scaling of objects. The XYZ Axis options specify 
whether the objects should be centered on the points or flush on one side or another. To specify static values, enter the 
same number in the Min and Max fields.

This command is great for cloning and placing, say, tree objects on a landscape or putting hair on a head.
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Radial Array

Radial Array (Multiply > Duplicate > More > Radial Array) creates an array of geometry around the Center position using 
the specified Axis. The Count setting sets the number in the final array.
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Helix Tool

The Helix Object function (Multiply > Duplicate > More > Helix) will create a helix (or double helix) based on a shape you 
have modeled. To use it, create your initial geometry and then call the Helix command.

The controls are as follows:

Number of Rotations - This is how many complete rotations of the spline forming your helix you will have.
Clones Per Rotation - There are two choices in the dropdown -

This is a non-interactive command so you will need to numerically input the settings.
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Uniform - The Numeric field below is ghosted and as many clones of your original geometry are made as 
necessary to ensure a continuous line of geometry along the spline with no gaps.
User Defined - The Numeric field becomes available for input. The number entered is how many clones of your 
geometry are used for each 360° section of the helix.

Helix Radius - The width from the center of the helix to the outside.
Helix Height - How tall the helix is.
Taper - This determines how the helix will change shape over its length. A negative number will result in a taper 
towards the top of the helix, while a positive number will taper towards the base.
Double Helix - This checkmark will create two similar helices twisting around each other, much like the famous 
example of DNA.
Oriented - This will orient your shape to best match the curve of the helix.
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Spin It Tool

The Spin it command (Multiply > Duplicate > More > Spin it) will create an array of geometry around the Origin using the 
specified Axis.

The Helix tool can need some clean-up once the operation has been made, including deleting extraneous 
clones made of the original geometry.

Double Helix and Oriented results in this shape, but the helices meet at the top and bottom, so it's best to 
remove those cubes.


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Subdivide

Add Points
Knife Tool
Slice
Connect
Subdivide Tool
Band Saw Pro Tool
Triple Tool
Cut Tool
Divide Tool
Fractalize Tool
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2.

Add Points

The Add Points operation (Multiply > Subdivide > Add Points) will give you the ability to manually increase the point 
count on a selected polygon. Sometimes you will need to add a point to a polygon and then move the point to change 
the shape of the polygon. You might also want to add multiple points so you can manually subdivide a polygon into 
smaller polygons.

To add a point to a polygon:

First, select the target polygon. If your selected edge is shared with another polygon, select that one as well. If 
you do not, the edge will split and the polygons will no longer be joined.

Choose Multiply > Add Points . Click the black plus sign at your desired insertion point along the edge.

Switch to the Point Selection mode and deselect any points before using Add Points. Adding points while there 
are already points selected will cause the added points to snap and weld to the selected points.


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Knife Tool

(default keyboard shortcut Shift K)

The Knife tool (Multiply > Subdivide > Knife) lets you interactively get results similar to the Drill function’s Slice option; 
however, it requires no background object. You simply drag out a slicing line in any viewport - nothing needs to be in a 
background layer. The line is infinite along the axis perpendicular to the view you initially drag in. This tool is perfect for 
adding segments to your geometry.

The other viewports will let you see the line from a different angle and a small dotted line will be visible that shows you 
the direction of the slice. After you have released the mouse button, you can drag the T-handles at the ends of the line 
(in any viewport) to reposition them or drag the center of the line to move the entire line. The tip of the dotted line can 
also be dragged to change the direction in increments of 90 degrees. This is an interactive tool so you will see the 
resulting new geometry as you position the line.

New to 2018

Knife now works in Symmetry.
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Like most tools, drop it or select another to make the geometry, or click your RMB to create the geometry without 
dropping the tool. Click on an open area of the interface to cancel the operation before it is made or use Undo.

The Knife tool’s numeric requester indicates the Start and End XYZ coordinates, defining the end points of the line. The 
Axis settings define a target point, relative to the base of the dotted direction line, that the line goes through.
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Slice

Multiply > Subdivide > Slice - A tool to split polygons. It highlights edges automatically and can be snapped to the center 
of an edge by holding down Ctrl.



LightWave 2020  –  LightWave 2020

Reference –  1398

1.
2.
3.

Connect

The Connect tool can connect two edges together, or divide one edge in two. Here’s an example:

Create a box and sit it on the ground (use F3 )
Select two of the vertical edges and hit L on the keyboard or Connect on the Multiply tab
With the resulting edge selected, hit L again. A new point will have been created at the center of the new edge.



LightWave 2020  –  LightWave 2020

Reference –  1399

Subdivide Tool

(default keyboard shortcut Shift D)

The Subdivide Polygons operation (Multiply > Subdivide > Subdivide) divides any selected polygons with three or four 
sides into smaller polygons. This makes an object appear smoother, but also makes the model more complex.

 

The Subdivide Polygons panel appears when you choose Multiply > Subdivide > Subdivide. This panel provides several 
commands that let you automatically increase the detail of existing polygons. To use this panel, you must select the 
target polygons first.

Randomizing Options

All Subdivide options let you enter a Fractal factor that will randomly jitter newly created points. The result is a 
subdivided object with its points randomly jittered. A factor of 0 will not jitter points and higher values will jitter points 
more.

You cannot use Subdivide Polygons on polygons with more than four sides.
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The jitter radius is a fraction of the edge length, times the Fractal factor. A factor of 1 will jitter the new points by at most 
50 percent of the length of the edge that they will subdivide. A factor of 0.1 is five percent jitter and a factor of 2 will 
move points 100 percent of the edge length. Points added to the center of four-point polygons are jittered a comparable 
amount, although the formula for them is more complicated.

 

0% Fractal
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50% Fractal

Faceted Subdivide

The Faceted option adds more segments to existing polygons, but doesn’t change the overall shape. Let’s say you made 
a box, but just wanted one side to have multiple segments. In this case you could use Faceted.
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Smooth Subdivide

Smooth will subdivide objects that have curved, smoothed, or rounded areas. Modeler assumes any two polygons are 
part of a smooth surface and will extrapolate where subdivided detail should be placed to maintain (even enhance) the 
curvature of the original form.

 

Faceted Subdivide works on triangles, when the Triple command is used.
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Smooth Subdivide

 

Faceted Subdivide

The value entered in the Max Smoothing Angle field is used to determine whether adjoining polygons should be 
smoothed or not. Adjacent polygons whose normals form an angle above this value will not be smoothly subdivided. 
The default is 89.5 degrees, so polygons at right angles or sharper will not be affected.

Metaform Subdivide

Metaform is another method of subdividing. The object will be smoothed dramatically, with the original object acting as 
a kind of bounding box template for a slightly smaller, more rounded form. Metaform is very useful for creating smooth 
organic-looking objects out of simple geometric structures.
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Metaform is an adaptive process, meaning that locations that contain greater detail (i.e., more points/polygons) will 
have more detail in the smoothing process. It is easy to create rounded forms with Metaform. Moreover, if you use 
Metaform on part of an object by selecting polygons, you can create specific areas of greater detail on an object without 
subdividing the entire object again and again.

Adjoining polygons with surface normal angles greater than the Max Smoothing Angle will not be subdivided in a 
smooth manner. The default angle is 179 degrees, so only polygons that are nearly parallel with each other are not 
affected.
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Metaform is often used one or more times on a box to create a rounded starting point for SubPatch cages. It is superior 
to using, say, a ball primitive, since all polygons are quads.
 

Smooth and Metaform can achieve similar results using the same maximum smoothing angle; however, 
Smooth will tend to smooth outward, and make a slightly larger object. Metaform, on the other hand, smooths 
inward, and makes a more compact object.


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Band Saw Pro Tool

Band Saw Pro (Multiply > Subdivide > Band Saw Pro) will slice through a contiguous band of four-point polygons (or 
patches). While the images below use a simple sphere, Band Saw Pro is capable of navigating a more complex object.

To use the Band Saw Pro tool, be sure you are in Polygon selection mode, then just click on an edge to select two 
polygons in the “band” that you wish to divide and activate the Band Saw Pro tool (Multiply > Subdivide > Band Saw 
Pro). The tool will select the band of polygons going either direction from the first two selected, and will indicate the 
slice(s). The selection band and the slice(s) will continue all the way around until the operation returns to the point of 
origin or encounters a non-four-point polygon. The tool’s Default setting is for a single a single slice right in the center. 
The Numeric panel options can be used to create multiple slices, with a variety of controls, and these can be saved as 
custom presets.

You can Bandsaw polygons on multiple layers at once and the cuts will be made on the same layer(s) as the original 
polygons.

Selecting polygons for a horizontal band. When activated, Band Saw Pro selects rest of band and indicates the slice.

Band Saw Pro defaults to the last preset used, even across sessions.
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When Bandsawing vertically, note that Band Saw Pro’s operation stops when it encounters a non-four-point polygon.

You can select just one polygon, and use the Numeric panel if you need to adjust the selected band. When you 
select more than one polygon, the first selected polygon controls the operation.





LightWave 2020  –  LightWave 2020

Reference –  1408

Band Saw Pro Numeric Options

Band Saw Pro Numeric Panel and Pop-ups

The Actions pop-up lets you Reset the tool or Activate it to make the slice.

The Preset pop-up lets you apply the default settings for the tool, or one of up to 10 custom settings. A custom setting 
can be created by selecting one of the Custom options on the Preset button, entering the settings for Enable Divide, 
Value to place the relative position of one or more slices, the Operation pop-up to add or change the location of slices, 
and, where needed, by applying Uniform, Mirror, or Reverse to set or fine-tune the final version of the slice(s). Press the 
space bar to accept the entries and execute the slice, and the settings will also be saved as the options for the Custom 
setting that was selected.
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The Direction option determines the direction of the band and the slice. With a quad, there are only two directions to 
proceed and these are described as Even or Odd. Auto is the default setting, wherein Bandsaw will pick the direction for 
you.

Enable Divide activates the slices that you have set up. However, you can also use Bandsaw to just select the band of 
polygons by not activating this option.

The Divide Window shows the slices that you have set up for the current operation. You can also make changes or 
additions in this window using the Operation pop-up, discussed next. When there are multiple slices shown in the 
window, the one shown is red is selected, and the ones show in blue are not selected.

The Operation pop-up lets you make changes and additions to the slices.

Add - allows you to create new slices by clicking with the LMB in the Divide Window .
Edit - allows you select a slice using the LMB and move it using the Value slider.
Delete -  allows you to select a slice using the LMB and remove it.

Value - lets you set the location of the selected slice by entering a value in the numeric field or by using the slider.
Uniform - equalizes the spacing between slices.
Mirror - will mirror the selected slice across the center.
Reverse -  inverts the order - handy if you placed the slice(s) on the wrong side.
Clear - will remove all slices and set it back to default.
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Triple Tool

(default keyboard shortcut Shift T)

The Triple command (Multiply > Subdivide > Triple) converts the selected polygon(s) into triangular polygons. For 
example, a square polygon becomes two triangular polygons. Triangles cannot by definition become non-planar; 
therefore, this tool is useful for objects you wish to animate using bones, or objects that will have Displacement Maps. 
Tripling non-planar polygons makes them planar.

Tripling does not change the general shape of the object/polygons. Also, once a polygon is a triangle, tripling it 
again has no effect.


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Cut Tool

(default keyboard shortcut Shift U)

The Cut command (Multiply > Subdivide > Cut) is a general-purpose, interactive cutting tool. The tool cuts from edge to 
edge. You can select edges using the point selection or a quicker yet less flexible method of selecting edges is to select a 
sequential set of polygons. The edges in between the polygons and the opposing edge of each end poly will be selected.

Cut is capable of cutting through polygons with any number of points. The ability to terminate cuts and form corner-
quads is still restricted, however, to 4-point polygons only. However, you can safely select n-point polygons even with 
those features turned on.

Choosing Multiply > Subdivide > Cut brings up the Cut panel.

You can Cut polygons on multiple layers at once and the cuts will be on the same layer as the original polygons.

The Maintain Quads in corners option will create the necessary geometry to maintain 4-point polygons in corner 
geometry.

 

Maintain quads in corners: On
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Maintain quads in corners: Off

The Square Corner Quads option will avoid creating 4-point triangle shapes in corners when the Maintain quads in 
corners is selected.

 

Left: Square Corner Quads: On, Right: Square Corner Quads: Off

The Terminate Cuts option will create extra geometry at the ends of the selection to avoid creating Ngons.

 

Left: Terminate Cuts: Off, Right: Terminate Cuts: On

When the Connect Divisions option is activated, Cut will split the polygons at the newly created points.
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Selection

 

Left: Connect Divisions: On, Right: Connect Divisions: Off

The Select Outer Edges option will define whether polygon edges outside the selection will be affected.

 

Left: Select Outer Edges: On, Right: Select Outer Edges: Off

When the Switch to Point Mode option is active the newly created points will automatically be selected after the 
operation.
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By default, there will be a single default slice right in the center. This is the positioning of the slice that will be made on 
the polygons.

The Value field will display the location of the selected slice. You can move it by selecting the Edit mode and dragging it 
with your mouse. You can also add more slices in the Add mode or remove them in the Delete mode.

Uniform equalizes the spacing between slices. Mirror will mirror the selected slice across the center Reverse inverts the 
order - handy if you placed the slice(s) on the wrong side. Clear will remove all slices and set it back to default.

Clicking the Continue button will apply the operation and close the Cut panel.

For faster, non-interactive versions of Cut see Quick Cut and Quick Saw



LightWave 2020  –  LightWave 2020

Reference –  1415

•

•

Divide Tool

The Divide command (Multiply > Subdivide > Divide) is very similar to the Add Points (Multiply > Subdivide > Add Points) 
command in that it will give you the ability to increase the point count on a selected polygon. The main difference 
between the two is that the points are automatically added in the center of the polygon’s edge when using Divide.

Sometimes you will need to add a point to a polygon and then move the point to change the shape of the polygon. You 
might also want to add multiple points so you can manually subdivide a polygon into smaller polygons.

The Divide command works in both Point and Polygon mode.

Point Mode - Divide will divide edges into two segments based on your point selection. Each pair of adjacent 
points you select will be treated as a selected edge to be divided. The tool will linearly search for adjacent point 
pairs - every possible linearly ordered pair it finds is used. This allows for the selection of adjacent edges without 
running the tool twice. However, it might take a little time to grow accustomed to the selection style, but it 
becomes natural over time.

 

Polygon Mode - the tool will divide edges between polygons. It’s a lot easier, quicker, and more straight forward 
this way than through point selections, but isn’t as flexible for doing multiple edges within the same poly. 
Additionally, the tool can divide the edge at the starting and ending polygons, provided that they are not 
adjacent. If they are adjacent, then a loop is formed and the shared edge between the first and last polygon will 
also be divided. The best way to see this is to experiment with the tool. 

 

Configuring Divide:

To configure the Divide settings, simply choose Edit > Edit Modeler Tools and select the Divide Tab.
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Fractalize Tool

The Fractalize command (Multiply > Subdivide > Fractalize) will subdivide geometry unevenly in a fractal pattern. Set 
the Subdivision Level (1-4) and amount of Fractal noise on the Fractalize panel. This is great for creating landscapes or 
rocks.
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Subdivide - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Click here to expand Table of Contents...
Split Polygons
Julienne
Julienne 2
Fast Triple Fan / Fast Triple Fan Traverse
Make Pole
Random Pricks Command
Quick Cut 1, 2, 3
Quick Saw

Split Polygons

(default keyboard shortcut Shift L)

Choosing Multiply > Subdivide > Split will divide a polygon into two smaller polygons using its existing points. If used on 
a curve, the curve will be split into two distinct curves.

Select a polygon and switch to the Point edit mode. Select two points that do not share any edges. Clicking Split will 
subdivide the polygon along a line between those two points.

Julienne

The Julienne command (Multiply > Subdivide > More > Julienne) slices an object into sections that are regularly spaced 
along a given axis. Julienne is very useful for subdividing objects that will be bent or used with a Displacement Map. Use 
the Division setting to determine how many slices you would like to make on the selected Axis.



In Point mode, the Bridge tool (Construct > Bridge) works identically to the Split Polygons command, except 
with one convenient modification: you don’t have to select the polygons you want to cut ahead of time.
When working with Splines, repeating the Split Polygons tool when there are multiple points selected will split 
the spline into smaller splines.


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Julienne 2

Julienne2 performs the same function as Julienne but it is geared towards a keyboard-centric workflow. First you are 
asked the axis and can merely hit x, y or z on the keyboard, then the number of slices.
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Fast Triple Fan / Fast Triple Fan Traverse

The Fast Triple Fan commands (Multiply > Subdivide > More) triple polygons, with new polygons sharing a common 
point in a fan shape.

Make Pole

The Make Pole command (Multiply > Subdivide > More > Make Pole) triangulates each poly you have selected with a 
pole at the center. Normally, poles are generally avoided in a model, but if you use the Make Pole tool with the Fix Poles 
tool (Detail > Fix Poles), they can be a convenient way to close open geometry without too many smoothing 
abnormalities. Furthermore, merging the triangles in an octagon can result in a nice set of quads.
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Random Pricks Command

The Random Pricks command (Multiply > Subdivide > More > Random Pricks) creates random surface points on 
polygons. Use this to add detail to an object where you will later kill all of its polygons.
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Quick Cut 1, 2, 3

Quick Cut (Multiply > Subdivide > More > Quick Cut) is simply a set of pre-configured Cut variants that allow you to cut 
quickly without going through a panel. They are designed to be used for commonly used cuts. They default to all having 
the same functionality - they need to be configured before the three start doing different things. To configure each 
Quick Cut, use the Quick Cut Config tool (Edit > Edit Modeler Tools) to configure each one to your preferences.

Quick Saw

The Quick Saw tools (Multiply > Subdivide > More > Quick Saw) are simply pre-configured variants of Cut (Multiply > 
Subdivide > Cut). Like the Quick Cut tools (Multiply > Subdivide > More > Quick Cut), these tools are quick in the sense 
that they do not require going through a panel interface to make cuts. Unlike the Quick Cut tools, these tools have hard-
coded customizations and cannot be customized for new functionality.

Quick Saw:

 

See the Multiply > Cut Tool for full details on QuickCut and QuickSaw.
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QS Double

 

QS Term

 

QS Double Term
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Destroy

Fracture in Modeler

This new Modeler tool (Multiply tab > Destroy > Fracture) breaks apart an object and makes the resulting segments into 
parts for use with dynamics. There are three algorithms implemented in the Fracture tool: Voronoi, an algorithmic way 
of breaking an object in a natural-looking fashion; Halves, a recursive split-in-half algorithm; and Matrix, a matrix-
cutting algorithm.

Many aspects of 3D work involve modeling properly for the intended use of the model. For example, many articles and 
discussions are available on how to model characters in order to be able to animate them properly. The flow of the 
polygons in the model is critical to getting the correct deformations to occur. There are similar discussions of modeling 
requirements for other purposes. For the current version of Fracture, you will get better results if you avoid geometry 
with long thin polygons, or with a disparity in the size of the polygons in the mesh - large polygons mixed with tiny ones.

Lastly, any object to be Fractured needs to be frozen, not sub-patched because Fracturing will destroy the polygon flow 
needed by subpatches.

Overview of Controls

Common Settings

Interior Surface - Entry field to set a name for the interior surfaces created in the fracture process.
Random Seed - Entry and minislider to adjust the random seed used for the fracturing process.
Preserve Original toggle - On keeps the unfractured original geometry in the layer it was created. Off does not 
preserve the original geometry. The undo system in Modeler will not always be able to recover the original 
geometry, so maintaining the original with this option can be useful if you need to retry the fracturing to get the 
results you prefer.
Create in - This offers the choice of either creating a completely new fractured object or creating a new layer for 
the existing object.
Part to Layers - LightWave will happily deal with the fractured object being in a single layer, but if you need to 
export to a different program that needs separate layers you can use this.

Explode Controls

The Explode morph map can be used as a “poor man” dynamics. Just animating the morph to explode a seemingly 
solid object and adding particles and HyperVoxels can often substitute for expensive dynamics simulations.

Explode Parts toggle - When checked this makes an exploded Morph map of the parts.
Explode Distance - Sets the maximum distance for the explosion. This controls how far to move each connected 
part away from the center of the object.
Explode Randomness - Specifies a percentage by which to vary the distance. For instance, if distance is 1 m and 
randomness is 50%, then the pieces will move away from the center anywhere between 0.5 m and 1 m.
Explode Morph - Name for the exploded morph map.

Cutting tools need to be fully closed meshes. For example, a cutting tool for Fracture cannot be a cone that 
you have chopped the top and bottom off of and distorted, so that you have an open mesh with a hole in the 
middle; you need a closed mesh, with no holes and preferably tripled.


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No Dynamics. The morph, some lens flare and particles are enough to make a good background explosion.

Fracturing Algorithms

Voronoi

Use - There are three choices:

Random Points - This will create randomly positioned Voronoi cells with which to break up your object based on 
the value set with the Cell Count field.
Background Layer Points - A set of points on a separate layer to the geometry you wish to fracture will be used 
for the basis of the Voronoi cells. The points need to be shown as a background layer, similar to Boolean 
operations. Points outside the geometry’s bounds will be clamped to the bounds for the cutting operation.
Background Layer Polys - This is something of a mix between Random and Background Layer Points. To use it, 
you need to create a closed 3D shape in a layer that you have as the BG layer for the object to be fractured, and 
the Cell Count field is available to fill that shape with the required number of cells used to fracture the original 
object.

Cell Count - This field is ghosted if you are using Point Selection since the number of cells is determined by the 
quantity of points you use.

Morph Maps can be examined using the M icon at the lower right of Modeler’s interface and the dropdown 
menu that goes with it. This way you can see the morphed object and the base fractured version.


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This image shows a Background Layer Points Voronoi fracture. Although the points are not within the bounding box of 
the mesh to be fractured they still have a pleasing effect.

Matrix

Detail - The detail factor controls how many pieces are created. The value entered is exponential (similar to 
subdivision surfaces) - 1 = 4 parts, 2 = 16, 3 = 64, etc.
Jitter Amount - Controls how much to jitter the source cutters. Higher values lead to more uneven results.
Jitter Iterations - Controls the number of times jitter is applied. This is similar to the iterations value in 
smoothing tools. Higher iterations with low values gives a different result to fewer iterations with high values. 
The former would move each point around more than the latter, which will move certain points more.

Background 3D shapes for cutting Voronoi Fractures in Background Layer Polys mode must be closed objects. 
It is best to triple them and make sure all normals are facing outwards.


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The three images show differing levels of Jitter and Iterations. 1 is no jitter, 2 is a Jitter amount of 50%, but an iteration 
count of 50, which is high and 3 is a jitter amount of 90% with only three iterations giving a far more jagged appearance.

Halves

Cutter - This determines the shape of the cutter used to fracture the objects.

Fractal Cube - Creates more organic results - like a rock being fractured.
Cube - Makes straight slices - very angular results.

Max Angle - This sets the maximum angle of rotation of the cutter as it is making slices. If you set it to 0, all slices 
will be axis-aligned and the results are very cube-like. With a high value, more sharp pieces that aren’t axis-
aligned are generated.
Unevenness - This chooses how uneven the splits are, by percentage. At 0%, everything is split down the middle. 
At higher values, the algorithm splits more off center. It’s a guide so where it cuts is still random, but with higher 
values the results will be more random.
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The three images above show: 1. Perfectly even cuts, no unevenness and no angle variation, 2. Changed unevenness to 
cuts that are not exactly halves, 3. Shows adding in an angle variation.
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Detail

Introduction

The Detail Tab contains a variety of tools for fine-tuning the points, polygons, edges and curves of your geometry.

Detail - Points
Detail - Edges
Detail - Edges - More
Detail - Polygons
Detail - Polygons - More
Detail - Curves
Parts
Measure
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Detail - Points

This group contains point-related tools.

Merge Points

Weld

Unweld

Weld Average

Set Value

Straighten

Swap Points



LightWave 2020  –  LightWave 2020

Reference –  1431

1.
2.

Merge Points

(default keyboard shortcut M)

Use the Merge Points command (Detail > Points > Merge Points) to remove points that occupy the same or very nearly 
the same space. Remember, if all of the points along a polygon’s edge are shared, LightWave’s surface smoothing can 
smooth over the two polygons.

Many circumstances exist where you may create unnecessary duplicate points, but here is a list of some common ones:

After you cut polygons to a separate layer and then paste them back.
After you use Boolean and Drill operations (including Fracture ), because the complex mathematics involved 
often generate extra points.

  Left: Before merging we can see the smooth ball has facets, one side of the subpatched cube is flat and there’s a seam 
down the middle of the bust. Merging points cures all these ills.

If the Keep 1-Point Polygons option is disabled, polygons are automatically deleted if they become single points (due to 
their vertices merging together). The default is for these polygons to be retained.The Merge Points command has two 
Range modes: Automatic and Fixed. These basically determine the criteria for when points should be considered 
mergeable.

Automatic merges the points that share the same space. For objects or portions of objects that you have cut from the 
main object with the intention of merging later (back into their original positions), use Automatic.

Fixed merges any points within the specified Distance of one another. When merged, one point will move to the location 
of another - Merge will not average the distance between points to create a new point midway between them. As such, 
the related polygon may be stretched as necessary.

To speed the operation, select the points you wish to merge before using this command. (It’s OK if you select 
more than you need.)
See also the Weld command, described next.


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2.

Weld

(default keyboard shortcut Ctrl W)

The Weld command (Detail > Points > Weld) is similar to the Merge Points command except that the selected points are 
welded to the last point selected.

Steps for Welding:

Select the points that you would like to weld. The last point selected is where the points will be welded to.

Select Detail > Points > Weld . The number of points welded will be shown in the info window at the bottom of 
Modeler.
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Weld Average

The Weld Points To Average command (Detail > Points > Weld Average) is similar to Weld, but averages the distance 
between points before welding. There is no source and target concept with selection.
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Unweld

(default keyboard shortcut Ctrl U)

The Unweld command (Detail > Points > Unweld) lets you create multiple copies of the selected points so that none are 
shared by two polygons at once-effectively reversing an executed Weld command.

Select point to be unwelded

Select Unweld from the menu or press Ctrl U. The points shown have been individually selected and moved 
using the Info window (keyboard shortcut I).
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Set Value

(default keyboard shortcut V)

The Set Value command (Detail > Points > Set Value) sets the X, Y, or Z position values for the selected points or 
polygons.

This is a great tool for aligning all of the points along a strict axis. You may find a need for this when you are trying to 
merge two halves of a mirrored object together and are having trouble merging all points along the mirroring axis.
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Straighten

Detail > Points > Straighten - This tool performs a function that can be achieved in many other ways, but its simplicity 
means it can be a very fast way of achieving its specific aims. It works by taking the first and last point of a selection and 
laying out all the points in-between in a straight line. It is ideal for straightening bone setups for Genoma for instance, 
where you don’t want misalignment between the points that make up the shoulder, elbow and wrist rig parts.
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Swap Points

Swap Points is a tool to use when you create a complex shape by drawing over a background image and then don’t 
select the points in exactly the right order. In our image on the left we are recreating some floorboards for a shot and 
selected the two points highlighted in the wrong order when making a polygon. Swap Points comes to the rescue for 
the second image.
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Detail - Edges

This group contains edge-related tools.

Edit Edges

Spin Edge

SplitRing

Border Slice Quad

Border Slice



LightWave 2020  –  LightWave 2020

Reference –  1439

•

•

Edit Edges

Edit Edges used to tighten a subd box

Edit Edges has been used to create an extra loop colored blue and individual edge segments have been moved up and 
down. The Edit Edges tool is still active and the vertical edge loop colored Orange shows the preselection highlighting with 
the circle in the center of the segment the mouse is over indicating where an additional horizontal edge loop will be 
inserted if the right mouse button is pressed.

Detail > Edges > Edit Edges - With Edit Edges you can slide edges, create edges or delete them:

Sliding Edges - Left clicking on an edge will select the whole edge loop. Moving the mouse left and right will slide 
the loop up and down in the case of a horizontal loop, or left and right in the case of a vertical loop. If you wish to 
only slide one segment of a loop, holding down Ctrl will slide only the segment you click on.
Creating Edges - When you select a loop you will notice a small circle in the center of the edge segment you click 
on. Right clicking the edge segment will create a new edge loop at this midway point - a vertical loop on a 
horizontal edge, a horizontal loop on a vertical edge.
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• Deleting Edges - Shift left-clicking on an edge will delete it.

The Numeric panel contains Percent and Distance fields. They are linked and show the distance an edge has slid. Either 
one can be modified, the other will update to the equivalent value and the edge loop will move.

The Normalize toggle slides the edges by a percentage of the gap on either side of the loop so all edges will reach their 
neighbors at the same time. If Normalize is off, edges get moved by an equal absolute amount, so some of the edges 
might hit their neighbors before others.

If you are having trouble with moving just a segment, rather than the whole loop, click on the loop before you 
hold down Ctrl and move the segment you wish to slide.


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Spin Edge

When an edge is selected, this tool will spin the edge and connect each end of the edge to the next adjacent point.
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SplitRing

When you have an edge selected, Split Ring will take the mid-point of the selected edge(s) and create a new edge loop 
around the mesh.
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Border Slice Quad

When you have edges selected, Border Slice Quad will create a new edge loop based on the selected edges. The new 
edges create new polygon quads around the loop.
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Border Slice

When you have edges selected, EdgeLoop will create a new edge loop based on the selected edges. The new edges 
create new polygons connected by the mid-point of the edges around the loop. Using this method can result in tri-
polygons and n-gons.
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Detail - Edges - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Add Edges
Steps to Add Edges:

ExtendEdges
EdgeWalk
Set CC Sharpness
Increase / Decrease Sharpness

Add Edges

Add Edges (Detail > Edges > Add Edges) is part of the Edge Tools toolkit that gives you the ability to interactively place 
new edges on your geometry.

Position - Each edge is assigned a marker located at the center of the edge (50%). Use the mini-slider next to the 
input field or interactively move the position of the marker in the viewport with the LMB . 
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1.

Distance From Start - This field will display the distance from the Start point of the selected edge to the marker 
on the edge. Distance From End - This field will display the distance from the End point of the selected edge to 
the marker on the edge.
Grid Snap - Checking this will activate Grid Snap. Using Grid Snap will limit movement of the marker based on 
the Ratio or Distance found under Grid Snap.
Grid Unit - Choose between Ratio and Distance to control Grid Snap.
Ratio - Grid Snap is set in percentage from 0% to 100%. Limit the movement in x% increments.
Distance - Grid Snap is set in Units . Limit the movement in n unit increments.
Stopper - Stopper sets up limits on marker movement.
Unit - Choose between Ratio and Distance to control Stopper settings.
Ratio - Marker Limits are set in percentage from 0% to 100%. Limit the movement in n% increments.
Distance - Marker Limits are set in Units . Limit the movement in x unit increments.
Release Current - This option will undo the last edge drawn.
Hide Markers - This option will hide the markers but will still allow edges to be created.
Realtime Update - When checked, this option will apply the edge to the geometry. When this option is off, it will 
not place the edge, but rather will place a preview of the edge. This can be very helpful with heavy geometry on 
slower machines.

Steps to Add Edges:

Left click from marker to marker to draw edges.
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2.

3.

Add the quantity you need. You can adjust the distances for the different connections as you go.

Press Enter on the keyboard to apply newly created edges.

ExtendEdges

ExtendEdges will extend the selected edges to a polygon you have selected, with the length of the edges matching the 
rotation of the selected polygon. If no polygon is selected, the edges will match the ground plane. The selection of the 
edges is important, see the following example.
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1.

2.

3.

In Polygon mode, the polygon of the plane is selected.

Switching to Edge mode, the edges on the side of the disc are selected. (Note that the edges along the top are 
not selected.) 

ExtendEdges is activated and the edges stretch to match the angle of the plane.
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4. After deselecting the plane polygon, ExtendEdges is activated again and the disc’s edges extend to the ground 
plane.

EdgeWalk

When two contiguous edges are selected, EdgeWalk will create a new polygon from the selected edges. EdgeWalk works 
best with edges that are at an angle with each other.
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01-04 Edges selected, then EdgeWalk activated multiple times. Note how it “walks” around corners.

Set CC Sharpness

Sets the sharpness value. For example, a value of 100% will create a sharp edge, while a value of 25% will result in a 
softer edge.
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Left: Value=0% Right: Value=100%

Increase / Decrease Sharpness

Increases or decreases the sharpness of an edge. This allows for harder or softer corners between two polygons.

The effect of the edge weighting is only visible when in weight shade mode or when CC subdivisions are turned 
on for the given polygons.


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Detail - Polygons

This group is for tools that work with polygons.

Merge Polys
Flip Polygons
Spin Quads
Unify Normals
Detail - Align
Mesh Repair
Set Face/Subpatch/CC
Sketch Color
Flatten
Reassign Surface
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Merge Polys

(default keyboard shortcut Shift Z)

Detail > Polygons > Merge Polygons joins two selected polygons that share at least one common edge. A common edge 
is one where two or more polygons share all of the points along that edge.

The Merge Polygons command also works on curves, if they share a common terminating point. It doesn’t matter if you 
use the start or end of the curve. They will be merged into one continuous curve.

Common problems are edges that don’t share all points. Try merging points first to eliminate overlapping points. After 
using this command, check for non-planar polygons, which often result. Another issue with both merging points or 
polygons is the presence of Morph maps. These will prevent merges.

Merge Polys can also be used for merging splines.
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Flip Polygons

(default keyboard shortcut F)

Often as you create polygons or use various tools with single-sided polygons, their surface normals will point in the 
wrong direction. Modeler provides some tools to help you solve that problem.

To flip polygons:

Simply select the polygon(s) and choose Detail > Polygons > Flip. This action reverses the direction of the surface 
normal for the selected polygons.
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Sometimes you may choose to have the polygons facing the other way (flipped). A room is a good example.

 

You should get in the habit of checking regularly for polygons facing the wrong direction as it is a common 
problem.



This command also reverses the direction of selected curves.
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Spin Quads

(default keyboard shortcut Ctrl K)

The Spin Quads command (Detail > Polygons > Spin Quads) can be applied to adjacent four-point polygons (i.e., quads) 
that share an edge. It merges the two polygons together and then splits them using a different set of opposing points, 
each time selected in a clockwise direction. If you apply Spin Quads three times, you’ll be right back where you started.

Spin Quads can be quite handy for fixing areas on a SubPatch object where a seam just doesn’t look right, as in the 
example below.
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Unify Normals

(Detail > Polygons > Unify Normals) When you have normals on the same mesh that are pointing in opposite directions 
(such as a flipped polygon), Unify Normals will point them in the same direction. Unify Normals will flip all polygons in 
the same direction as the first polygon that is found or selected.
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Detail - Align

Align Polygons (Detail > Polygons > Align) attempts to automatically make all polygons face the correct direction. After 
using, you may still need to use the Flip Polygons command (Detail > Polygons > Flip) before you are done.

To align polygons:

Select an area that includes the polygons needing to be flipped, as well as a large number of polygons facing the 
correct direction. Selecting polygons that share points and edges helps.

Choose Detail > Polygons > Align . Verify that the polygons were flipped as desired.
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Mesh Repair

When exporting as STL or PLY Mesh Repair gets automatically called to check on the quality of your mesh. It offers 
several fixes:

Clear Stray Points - if you have any points not attached to polygons in your model, they will be removed.
Clear One Point Polys - If you have any single point polygons in your model, they will be removed.
Clear Two Point Polys - Two-point polys can be very useful in LightWave for all manner of things, but they are no 
use for 3D printing.
Cap Holes - As previously stated, meshes for 3D printing need to be manifold - that’s to say with no holes. Cap 
holes gets rid of any holes in your mesh.
Triangulate Polys - Since our mesh doesn’t need to look pretty for animation, merely correct for printing, it is 
best to triangulate for complete compatibility.
Non-Manifold Edges - Edges that are non-manifold are ones that connect more than two polygons.

You can also call Mesh Repair manually since it’s not just useful for 3D printing but for your objects in general. If you 
have a reason for wanting to keep 2-point polys you can always uncheck that fix.

The edge of this box was selected and extended. The edge connecting the flap to the box becomes a non-manifold 
edge.
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Set Face/Subpatch/CC

These three commands change selected polygons into the type desired with no additional parameters. Useful when you 
have been flipping in and out of subpatch mode and left some polys unchanged.
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Sketch Color

When using the various Rendering Styles in a viewport, you can change the polygon shading color by choosing Detail > 
Polygons > Sketch Color.

We’ll start with our Alien Emissary figure in Texture mode to show the default view, this does not use the Sketch Color.

Texture - Doesn’t show Sketch Color. Selected polygons will be yellow as normal.
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Color Wireframe - The wireframes will be shown in the Sketch Color selected.

Hidden Line - The wireframes will be shown in the Sketch Color selected.
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Sketch - The polygons will be shown in the Sketch Color selected

Wireframe Shade - The wireframes will be shown in the Sketch Color selected
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Textured Wire - The wireframes will be shown in the Sketch Color selected

Texture - Doesn’t show Sketch Color. Selected polygons will be yellow as normal. Color Wireframe - The wireframes will 
be shown in the Sketch Color selected. Hidden Line - The wireframes will be shown in the Sketch Color selected. Sketch 
- The polygons will be shown in the Sketch Color selected Wireframe Shade - The wireframes will be shown in the 
Sketch Color selected Textured Wire - The wireframes will be shown in the Sketch Color selected

The default Sketch Color can be changed in the Display Options panel.
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Flatten

Flatten is a non-interactive tool that flattens selected polygons to a given axis or to the average of the polygons’ 
normals. It is designed to be used from the keyboard for speed though you can obviously still click the buttons.



LightWave 2020  –  LightWave 2020

Reference –  1467

•

•
•
•
•
•

•
•

•

Reassign Surface

Reassign Surface will take the surface assigned to an object in your scene, and apply it to a different object. This script 
will not perform magic - it won't invent UV coordinates for a surface without them, nor change the mapping on an 
image to make it work correctly. It will allow you to quickly select multiple surfaces based on wildcards and give them 
all the same surface.

Surface names can be typed or chosen from the dropdown list at the end of the Name field. If typed, pattern matching 
can be used to select multiple surfaces to replace them with a single surface.

The controls are as follows:

Find Surface Name(s) - A field to type a name or part of a name to act as a filter. You can also use the dropdown 
at the end to choose surface names from a list for the currently-loaded object
Search Rule - Four options for the first field:

Contains - The surface name contains the characters typed in the first field. The default option
Starts With - Assumes the characters typed will be at the start of the search
Ends With - Assumes the surface name ends with the characters typed
Exact - Only matches exactly what is in the first field

Case Sensitive - Matches case for the search field
Assign to Surface Name - Matches results from the first field and assigns them to the Surface named in the 
second field. A surface name can also be chosen from the dropdown
List All Surfaces in Surface Popups - If unchecked, will only show the surface names in active Layers. When 
checked will show all surfaces in object (but not other loaded objects)
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Detail - Polygons - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Fix Poles
Fix 3-5
Double Sided
Unify Polys
Normal Baker

Fix Poles

Fix Poles (Detail > Polygons > More > Fix Poles) is a simple tool which will take the poles you have selected (or all the 
poles that exist in your geometry if no points are selected) and will modify them to look better in subpatch mode by 
making cuts to form a tiny flat disc section at each pole, flattening and reducing the smoothing tension caused by the 
triangles all around it.
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Left: Before, Right: After

 

Left: Before, Right: After

Note that it doesn’t perform any miracles and some slight bumps and abnormalities may appear on the surface with 
curved poles. However, it certainly does make them look much better and more concealed most of the time, and will 
often obliterate such smoothing artifacts completely on poles which span across broad, flat regions. You can often 
apply the tool multiple times to the same pole to reduce the tension.

Fix 3-5

Fix 3-5 (Detail > Polygons > More > Fix 3-5) is a simple tool to turn each pair of polygons consisting of a triangle adjacent 
to a pentagon into quads which will generally work better with Subpatch mode. The tool works with your poly 
selection, and will repair any 3-5 polygons it detects in the selection.

If no polygons are selected, the tool will analyze all the polygons in your object.

Applying it twice on sphere poles looks best. Applying it too many times may cause the flatness of the discs 
created at the poles to become more pronounced.


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It is recommended that you always select the polygons you want to repair in a dense object, as the algorithm can take 
some time to search through all the polygons in a very dense model with high poly counts.

Double Sided

Sometimes you’ll actually want double-sided polygons, for example, when you need to go inside a hollow object. Most 
of the time, you can get away with simply using the Double-sided surface attribute on the Basic Tab of the Surface 
Editor. However, if you need to actually model the double-sided polygons, it is relatively simple. Just choose Detail > 
Polygons > More > Double Sided.
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It is also possible to make double-sided polygons manually using the following procedure:

Select the target polygons (even if it is the entire object).
Copy the selection.
Paste the selection.
Choose Detail > Polygons > Flip to flip the (still) selected polygons.
Choose Detail > Points > Merge Points to merge points.

Unify Polys

(default keyboard shortcut Shift I)

The Unify Polygons command (Detail > Polygons > More > Unify Polygons) converts selected polygons into a single 
polygon. The polygons must share the same points, such as double-sided polygons. It creates single-sided polygons 
with regard to the direction of their surface normals. However, unusual object shapes can occasionally fool its complex 
algorithms, resulting in single-sided polygons facing the incorrect direction. If this happens, you may need to use the 
Align Polygons or Flip Polygons commands to correct the resulting direction of the normals.

Normal Baker

Normal Baker (Map > Polygons > More... > Normal Baker) will store the (normalized) point normal for each vertex as 
three numbers into a VMAP called PNT_NORMALS. The values, starting with the first, represent the X, Y and Z directions 
of the vertex’s normal.
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Detail - Curves

These tools all act on curve elements in Modeler.

Smooth

Control Points
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Smooth

The Smooth command (Detail > Curves: Smooth) allows you to smooth two overlapping curves.

When two curves share the same end point, because of point merging or some other reason, the curve may not flow 
smoothly through that point. This can be particularly troubling when designing a complex spline cage. You could kill the 
curve (k), reselect the points and create a new curve, but there is an easier way.

To smooth curves sharing a common end point:

Select the two curves (Polygon Selection mode). 

Click Detail > Curves > Smooth. This smooths the joint as though the two curves were originally plotted as one 
continuous curve - even though they remain individual curves.

Make sure that the point they share is in fact one point. (If not, merge the points into one.)
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Control Points

Using Control Points

When using a curve as a Modeling tool, sometimes you need to adjust the curve to get it to “that perfect angle.” Because 
of the way points control an open curve’s shape, it can be difficult to get the desired result at the ends of a curve. 
Fortunately, Modeler lets you have extra “control” points at each end, which affect the curve shape, but don’t actually 
become part of the curve’s Modeling characteristics.

To activate control points on a curve:

If you have more than one curve, select your desired curve first using the Polygon Selection mode.

Choose Detail > Curves > Control Points > Begin Control Point to detach the first point from the curve. It is your 
starting control point. Dragging this point will change the shape of the curve at the new starting point.

Choose Detail > Control Points > End Control Point to detach the last point from the curve. It is your ending 
control point. Dragging it will change the shape of the curve at the new ending point.
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The control points commands will also toggle the control point state off, if selected again.

It is perfectly legal to have only a beginning or ending control point on a curve. 
If you plan to use control points on a curve, you should add an extra point at the beginning and end of a curve 
for that purpose.


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Create Part
Parts are the polygon version of point selection sets. (One distinction, however, is that a polygon can be 
assigned to only one part name, while a point can be a member of multiple selection sets.) You can quickly select 
a user-defined set of polygons by name as you would with surface names. This feature operates independently 
and in parallel with surface naming.
Surface to Parts
The Surfaces To Parts command (Selection > Selection Sets > Surfs to Parts) can convert surfaces to part names. 
The Part names are taken from the original Surface name.
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Create Part

Parts are the polygon version of point selection sets. (One distinction, however, is that a polygon can be assigned to 
only one part name, while a point can be a member of multiple selection sets.) You can quickly select a user-defined set 
of polygons by name as you would with surface names. This feature operates independently and in parallel with surface 
naming.

To name polygon parts:

Select a group of polygons

Click Detail > Selection Sets > Create Part. Enter the desired name in the Name field and click OK.

You can add to an existing part group by selecting the additional polygons and then selecting the group’s name from 
the pop-up menu.

To select parts:

In Polygon Selection Mode, choose the Statistics button at the bottom of the interface to open the Polygon 
Statistics Panel.
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Click on the pop-up menu triangle on the last line in the panel. (If it isn’t visible, drag the bottom of the panel 

down.) Select the desired part name
The selected part’s name will appear on the line. Click the plus sign (+) to select all of the polygons defined by 
the part.

Like surfaces, any one polygon can have only one part name. Therefore, if you create a new part that uses 
polygons from an existing part, those polygons will become associated with the new part only.


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Surface to Parts

The Surfaces To Parts command (Selection > Selection Sets > Surfs to Parts) can convert surfaces to part names. The 
Part names are taken from the original Surface name.
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Measure

The tools in this group are to measure polygons or volumes you have already created.

Measure Points

Angle Tool

Measure Tool

Calculate

Bounding Box Command

Point Center

Find Center

TriStrip ACTC
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Measure Points

You need to select more than one point to use this tool and once you have and clicked on the tool you will receive the 
information shown in the window that appears. You will get a Straight Distance measurement, which highlights the 
longest straight distance between two points by selecting them while the window is open (the original selection will 
return when you leave the window). You also get the maximum X, Y and Z distance between points.



LightWave 2020  –  LightWave 2020

Reference –  1482

1.

2.

3.

4.

Angle Tool

You will often need to estimate angles in the modeling process. Modeler provides what is best described as a virtual 
protractor. With it, you can measure the angle between any two points in any view.

To use the Angle Tool:

Choose Detail > Measure: Measure > Angle Tool.

Place your pointer at the vertex of the angle you wish to measure and drag the LMB out to form one side of the 
angle. A line will extend from the drag point.

Release the mouse button. You can reposition the end of the line by dragging it; however, you cannot move the 
starting position at this point.

Place your mouse pointer near the starting point (but not on top of it) and drag out the other side of the angle. 
The information display will now tell you the angle between the two lines.
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5. Once you release the mouse button, you can reposition the vertex or either end by dragging them. To reset, click 
in a non-active part of the interface.

If you place your mouse pointer on top of the starting point in step 4, the starting point will become the other 
end to the angle and you will drag out the first vertex instead of leaving it where it should be.


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Measure Tool

(default keyboard shortcut Ctrl E)

You will often need to estimate distances in the modeling process. The grid size can yield reasonably accurate figures, 
but if the two points are not aligned somewhat vertically or horizontally, estimating can be more difficult.

Fortunately, Modeler provides what is best described as a virtual tape measure. With it, you can measure the distance 
between any two points in any view.

To use the Measure Tool:

Choose Detail > Measure > Measure > Measure Tool and then drag between the two positions you want to measure. The 
information display in the bottom left corner will indicate the exact distance.

You can reposition either end by dragging it. To reset, click in a non-active part of the interface.
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Calculate

Calculate (Detail > Measure > Measure > Calculate) is a handy tool for quick calculation right in Modeler.

Click Calculate from the Detail Tab. Enter the Equation and the X,Y and Z values.

Press Enter on the keyboard to calculate. The answer will be presented in the Info area at the bottom of 
Modeler’s interface.
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Bounding Box Command

The Bounding Box command (Detail > Measure > Measure > Bounding Box) displays size and center position information 
for foreground layers.

Clicking OK will replace the layer(s) with a corresponding bounding box. Use this command to create stand-ins for 
complex objects, which can be replaced for the final rendered animation.

 



LightWave 2020  –  LightWave 2020

Reference –  1487

Point Center

The Point Center command (Detail > Measure > Measure > Point Center) will display the XYZ coordinates of the center of 
the object in the foreground layer in the Info bar.
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Find Center

The Find Center command (Detail > Measure > Measure > Find Center) works very much like the Point Center command 
but instead of displaying a requester with the center information, it will place a point in the center of a single polygon.
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TriStrip ACTC

The Tri Strip ACTC command (Detail> Tri Strip ACTC) will count the number of Tri-Strips in an object and will create a 
Vertex Color Map. ACTC makes triangle strips and fans out of independent indexed triangles. These triangle strips and 
fans can improve graphics card geometry performance approaching 3x, or a 200% improvement.

ACTC is an abbreviation for Applied Conjecture Triangle Consolidator, more information about this method can be 
found at: http://plunk.org/~grantham/public/actc/index.html.

Tri-Strip Example:
Tri-strips are a common method to compress mesh data in a lossless way. They define an order of consecutive triangles, 
with each pair of adjacent triangles sharing a common edge.

The Strip count will appear in the info bar under the viewports or a requester that will pop up when the command is 
applied. Clicking OK will add the Vertex Color Map.

NOTE: Your object must consist of 3-point polygons in order to perform this operation.

http://plunk.org/~grantham/public/actc/index.html
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Construct

Introduction

The Construct Tab contains a variety of tools for modifying geometry. These include ways to reduce the number of 
points and polygons in all or part of the geometry, and ways to shape the geometry by drilling holes or stenciling the 
mesh with new points and edges, or connecting meshes. Tools for patching splines, for converting metaballs and 
metaedges, for toggling SubPatch mode, and for freezing subdivision surfaces into a polygonal mesh are also located 
here.

Reduce
Reduce - More
Combine
Patches
Convert
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Reduce

The Reduce group contains tools for simplifying geometry and merging points, edges and polygons.

Reduce Points

Reduce Polygons

Reduce Polys + (Qemloss2)

Merge Triangles

Dissolve

Dissolve Loop

Weld Edges

Weld Ring

Remove
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Reduce Points

The Reduce Points command (Construct > Reduce > Reduce Points) traverses polygon edges and removes any points 
(from the polygons) that form an angle with adjacent points that is less than the Degrees setting.

 

This command is especially useful to reduce the number of points and polygons generated by extruding or beveling text 
objects.

 

Simply select a Point Reduction Threshold setting and the Degrees will be set automatically.

You can also enter your own Degrees setting. Activate Delete Points to delete the removed points.
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Reduce Polygons

The Reduce Polygons command (Construct > Reduce > Reduce Polygons) merges co-planar polygons with three or 
more vertices into a single polygon and can optionally remove any stray points resulting from the polygon removal.

 

Polygons are merged if the relative angle between two polygons is less than the Polygon Reduction setting, they share 
an edge, and have the same surface name.
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Reduce Polys + (Qemloss2)

The Reduce Polys + function (Construct > Reduce > Reduce Polys+) uses a surface simplification algorithm in an attempt 
to reduce the number of polygons in an object. The plugin lets you rapidly produce good quality approximations of 
excessively detailed polygonal models. Reduce Polys + is an excellent way to create low resolution stand-in objects for 
scene layout or for multi-resolution models. You can use the object replacement capability in Layout to substitute a low 
resolution object in place of an object with a high polygon count when it is far away from the camera.

1.6 M polygons get reduced to 159 K polygons gets reduced to 16 K polys

This plugin uses routines adapted from Michael Garland’s public domain QSlim Simplification Software. The algorithms 
used in this software are described in the papers written by Michael Garland and Paul S. Heckbert, Surface 
Simplification Using Quadric Error Metrics, SIGGRAPH 97, and Simplifying Surfaces with Color and Texture using 
Quadric Error Metrics, IEEE Visualization 98.

Introduction

Many 3D models contain a large number of polygons, especially algorithmically created models (such as those created 
by implicit surface construction techniques) and models created with 3D scanners and digitizers. Obviously, rendering 
3D scenes is much faster when the models contain a minimum number of polygons. Also with the current trend towards 

Always save your objects before you run Reduce Polys +!

UV maps are preserved when reducing the polygon count with Reduce Polys+. To maintain integrity, Polygon 
counts near edges tend to be largely unchanged in order to keep UV maps secure.


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sharing 3D worlds over the Internet, level of detail models (LOD) are becoming absolutely necessary for creating worlds 
in which you can browse and interact in a reasonable manner.

This tool provides polygon reduction on objects within Modeler. Only one parameter, the reduction Goal, must be set by 
you, the remaining default values should provide good reduction for many objects with a high polygon count. However, 
to get the best results, you must understand some of the basic concepts behind the algorithm.

Terminology

The simplification algorithm is based on contractions of vertex pairs. It supports two types of contractions: edge and 
non-edge contractions. An edge contraction occurs when the vertex pair shares an edge. This is the primary type of 
contraction that occurs during the reduction stage (in fact, non-edge contractions are turned off by the default 
parameters). The following figure shows an example of an edge contraction where vertex v1 and vertex v2 are joined to 
form a new vertex v3. Since v1 and v2 share an edge (highlighted below), one or more triangles will always be removed 
during this contraction. In this example, two triangles are eliminated from the mesh.

Edge Contraction

Non-edge contractions let the algorithm join unconnected areas of the object together. The next figure shows an 
example of a non-edge contraction (also called aggregation).

Non-Edge Contraction

In fact, there are two non-edge contractions taking place: v1 and v2 contract to form v5; v3 and v4 contract to form v6. 
Since by definition the vertices in the contraction pairs do not share an edge (there is no edge between v1 and v2, or the 
v3, v4 pair), there is no actual reduction in the polygon count of the object. However, since this feature joins previously 
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unconnected areas of the object together, the potential exists for future reductions. Many times this can also provide a 
better low resolution approximation of an object that has many disconnected regions.

As the algorithm proceeds through each iteration, an approximation of geometric error accumulates at each vertex of 
the object. If this geometric error is less than the user defined Maximum Error Tolerance, the vertex is marked as a 
viable candidate for another contraction.

Once the geometric error for a vertex becomes greater than the maximum threshold value, it will no longer be 
considered in any more contractions. During each iteration, the vertex pair with the smallest combined geometric error 
is chosen for the current contraction.

The algorithm proceeds until the simplified object is reduced to your targeted Goal (number of polygons) or until all the 
vertex errors have become greater than the Maximum Error Tolerance. These two parameters control how much 
reduction will take place, the remainder of the parameters control various aspects of the vertex contractions.

Two types of vertices receive special consideration by this plugin: surface border and boundary vertices. Parameters are 
provided for you to weigh the geometric error for these two special types of vertices:

A surface border vertex is a point that is shared by two or more surfaces.
An edge that exists in only one triangle is a boundary edge, and determines two endpoints that are called 
boundary vertices.

The Surface Border Weight and Boundary Preservation Weight parameters let you weigh the geometric error at these 
points. The higher the weight, the less likely the vertex will be replaced. Clever use of these parameters (along with 
some equally clever surfacing) can provide quite a bit of control over the contraction process. The Polygon Area 
Weighting parameter, causes every vertex’s geometric error to be weighted by the area of the polygons that contain the 
vertex. Once again causing larger values (triangles with larger areas) to be less likely to be removed.

To help preserve the shape of these shared borders, weighting of the surface border vertices, using Surface Border 
Weight, has been added to the algorithm to help restrict movement/replacement of those vertices.

Using Reduce Polys +

Make sure you have an object in the current foreground layer(s) of Modeler. You also need at least one empty layer, 
because the existing object remains unchanged, and the reduced object is placed in the first available empty layer. 
Choose Construct > Reduce > Reduce Polys + and you are presented with the following panel.
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Goal lets you set the final number of polygons you would like in the simplified object. You may enter either a desired 
polygon count (an integer such as 1000), or a percent based on the number of polygons found in the original object (a 
real number with a percent sign at the end, such as 65.2%). If you enter a percentage, it will simply calculate the 
polygon goal by multiplying that percentage by the total polygon count in the original object. So 100% will mean no 
reduction takes place, and 0% means the object will disappear completely.

The first major step that Reduce Polys + takes is to triple your polygons, which will increase the polygon count, if your 
model contains non-triangular polygons. A Goal of 100%, however, will reduce the number of polygons back to the 
original number, but now they will all be triangles. If that reduction doesn’t preserve your model’s shape well enough, 
don’t hesitate to try percentages over 100%, those models will still be smaller than the tripled original.

Maximum Error Tolerance sets the geometric error threshold. A large value (such as the default 1,000,000) almost 
guarantees that you will achieve the reduction goal in the previous parameter field. Smaller values may preserve the 
shape of the original object better, however you may not achieve the desired reduction goal entered above.

Surface Border Weight gives you some control over how often and far surface border vertices are relocated during the 
reduction process. A large value restricts the relocation of points that lie along surface borders, thereby preserving the 
shape of the border fairly well. Smaller values let the points move farther from their original location, possibly causing 
the border to change its shape. A value of 0 will not constrain the surface borders at all, and vertices along a border may 
not end up where you expect when the simplification is finished.

Boundary Preservation Weight allows you some control over how boundary vertices are relocated during the 
contraction process. A small value lets the boundary points move farther than larger values. A value of 0 will not 
constrain the boundary at all, and the object may not look at all like you expect when the simplification is finished.

If you end up with unexpected gaps between non-contiguous polygon surfaces, you can try to preserve those 
boundaries by increasing the Boundary Preservation Weight. However, you might get better results by merging the edge 
points together before running Reduce Polys +. You can always just cut and paste the polygons afterward, if the 
separation was essential.

Pair Selection Tolerance determines whether non-edge contractions are performed during the simplification process. If 
this value is 0, non-edge contractions are turned off, and only edge contractions will take place during the 
simplification. Any value greater than 0 will cause non-edge contractions to be possible during the reduction. If you 
enter a negative number, Reduce Polys + will automatically use 5% of the radius of the object’s bounding sphere. This is 
the value you should use if you want to start experimenting with this parameter.

Take care when changing this value to anything but 0! It is strongly recommended that you leave this at 0 for all 
complex models with lots of polygons. If you use this, first reduce the model to a fairly small polygon count with it 
turned off (=0), then reduce the reduction again with a carefully chosen Pair Selection Tolerance, or better yet, just use 
a negative number. It is a very memory-intensive operation.

Vertex Placement Policy is best left at Optimal. When a pair of vertices is contracted, the algorithm must decide where 
to locate the new vertex. The algorithm can use any one of the three final options listed in this selection of buttons. 
Optimal calculates the new placement based on the location with the least amount of geometric error. It doesn’t hurt to 
experiment with these options though.

Reduce Polys + ignores any polygon selections and works only on the entire object in the foreground layer, 
including any hidden polygons.



Other Parameter settings may cause the algorithm to fail to reach the reduction goal.
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Sometimes vertex pair contractions do not preserve the orientation of the faces in certain areas of the contraction, If 
Preserve Mesh Quality is changed to Yes, the normal of each neighbouring face is compared before and after the 
contraction. If the normal flips, the contraction is penalised greatly by making the geometric error for that contraction 
very large (so that contraction will probably never take place). In most cases, this will not be a problem, and the plugin 
will work faster if this parameter stays set to No. It’s not terribly slow, so it certainly doesn’t hurt to experiment with it.

If you change Polygon Area Weighting to Yes, the area of the triangle containing the vertex is used to weigh the 
geometric error. This will cause larger triangles to increase the geometric errors of its vertices, so it is less likely to be 
chosen for simplification.

The Reduce Polys + function displays a progress monitor while it creates the reduced object in the first available empty 
layer, following these steps: first, the object in the foreground layer(s) is copied to the first available empty layer, then 
all its polygons are converted to triangles using Modeler’s Triple command. Next, all vertices and polygons are 
converted into the necessary data structures needed for the simplification routines, and the copied object is 
subsequently removed. Once the simplification routine finishes, the reduced polygon object is placed in the previously 
empty layer.

For additional information, check out http://amber.rc.arizona.edu/lw/.

http://amber.rc.arizona.edu/lw/
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Merge Triangles

This tool will attempt to combine pairs of triangles to create quads - four-sided polygons. There is no interface.
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Dissolve

Similar to Merge Polys, but works on all elements. Selected edges then applying Dissolve will merge the polygons used 
by the selected edges. It cannot be used for deleting edges on the outside of polygons.

The first and second pictures show an internal edge being dissolved, but the outside edge in the third picture cannot be 
dissolved.
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Dissolve Loop

When you have an edge selected, Dissolve Loop will dissolve the edge loop the selected edges are part of, leaving a new 
set of polygons.
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Weld Edges

This tool will weld selected edges along their length, as though you had selected the two points that make the extremity 
of the edge and hit Weld Average (Ctrl Shift W). If you select one edge and use Select > Ring you can also replicate the 
next tool.
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Weld Ring

The Weld Ring tool takes the same single-edge selection as the previous tool, but welds the entire ring, as though you 
had selected one edge, used Select > Ring and used the previous tool.
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1.

Remove

This sub-menu contains three tools:

Remove

(default keyboard shortcut Del)

This will probably be one of your most-used tools. It deletes selected points, edges or polygons and in the normal 
Modeler paradigm, in Point or Polygon mode with nothing selected it will delete everything on a layer. Edge mode 
requires a selection.

Remove Vertices from Polygons

The Remove Points command (Construct > Remove > Remove Vertices From Polygons) disassociates the selected 
point(s) from the selected polygon, but does not delete the point. Non-selected polygons that used that point remain 
unchanged.

To remove a point from a polygon:

Select the polygon(s) containing the point to be removed (Polygon Selection mode).
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2.

3.

Select the points to be removed (Point Selection mode).

Choose Construct > Remove > Remove Vertices From Polygons. To actually delete the points, use the Cut 
function.

Remove Polygons

(default keyboard shortcut K)

Frequently, you want to use some of the points of an object (often primitives) in creating your objects. A good example 
is using part of a disc’s points to model a rounded corner. The way to do it is to use the Remove Polygons command (Co
nstruct > Remove > Remove Polygons).

To remove polygons but not points:
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1.

2.

Select the target polygons.

Choose Construct > Remove > Remove Polygons or press the K key.

An easy way to remember this keyboard shortcut is to think of it as “killing” (K) the polygons.



LightWave 2020  –  LightWave 2020

Reference –  1507

•
•

Reduce - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Collapse Polygons
BandGlue

Collapse Polygons

The Collapse Polygons command (Construct > Remove > More... > Collapse Polygons) replaces selected polygons with a 
single point at their average position. It is like moving all of the points for the selected polygons to their center and then 
merging the points.

 

BandGlue

The Bandglue command (Construct > Remove > Bandglue) merges a contiguous row of four-point polygons into one 
polygon. This is a great tool to use to clean up extra rows of geometry. Bandglue is the opposite of Bandsaw.

BandGlue respects Symmetry and can glue multiple polygon islands. The animation below shows both in action.
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You can Bandglue polygons on multiple layers at once and the joins will be made on the same layer(s) as the original 
polygons.

To use, first select a contiguous row of (two or more) polygons.

 

Then execute the command. Like Bandsaw, the operation continues all the way around the geometry until it returns to 
its point of origin, or hits a non-four-point polygon.
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•

Combine

This group contains Boolean tools and other means of joining geometry together.

Faster and Better Drills and Booleans

Complex Drill and Boolean operations require a lot of computing. Selecting the affected polygons in the foreground 
layer before using either command will greatly speed things up. This lets Modeler concentrate on only those polygons 
that need to be affected. Also, if your initial result is not satisfactory - particularly with complex objects - try it again 
after nudging one of the objects on an axis a little.

Boolean

Solid Drill

Drill Tools

Speed Boolean

Bridge

Connect
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Boolean

(default keyboard shortcut Shift B)

The Boolean command (Construct > Combine > Boolean) is similar in some respects to the Solid Drill command, 
discussed later. However, Boolean operations treat objects as solids with volume, instead of hollow 3D objects. They 
will merge, split, carve, and join objects in a variety of ways.

Like the drilling tools, you must have an object in the background layer. The major distinction of Boolean is that it treats 
the foreground object as a solid mass and thus creates inside surfaces along cut edges. There is also the Speed Boolean 
tool, described later, that can work on a single layer.

Our example geometry is this red box in the foreground layer and a green tube in the background layer.

With Boolean, some portion of the foreground and background objects must physically overlap in 3D space.

Union

Union joins the background layer with the foreground layer, taking the solid objects and combining them into a single 
object. Interior faces are removed and no new polygons or surfaces are created; therefore, all surfaces will retain their 
original names. To work properly, both objects must be closed 3D solids. You will need to merge points for the two 
objects to be truly in union.
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From the rendering perspective, you could get a similar result by just pasting both objects into one layer; however, 
Boolean results in the fewest polygons and smaller object files, which will use fewer system resources and render faster. 
There may be times, however, that due to the complexity of objects, Boolean will not produce acceptable results.

Intersect

Intersect takes solid objects and leaves behind whatever portion was common between them. It leaves behind only 
those portions of the background layer and foreground layer that were overlapping. (This corresponds to the portion 
that the Union operation discards.) No new polygons or surfaces are created; therefore all surfaces will retain their 
original names. To work properly, both objects must be closed 3D solids.

Subtract

Subtract removes the background drilling template object from the foreground object, leaving a copy of itself 
embedded there. Essentially, it carves the background layer out of the foreground layer, leaving new inside surfaces in 
its wake. New surfaces will take on the names of the surfaces that carved them. To work properly, both objects must be 
closed 3D solids.

The results of this operation will vary depending on whether the polygons being drilled consist of single-sided or 
double-sided polygons (see subsequent discussion).
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1.
2.

1.
2.

Add

Add joins the background layer with the foreground layer so that the overlapping shapes are fully combined as one. You 
can use combinations of 2D and 3D objects. This is different from simply saving two overlapping objects from two 
different layers, since the polygons that physically overlap are merged in a form of mutual drill operation. No new 
surfaces are created, although some polygons may be subdivided. Therefore all surfaces will retain their original names.

The result is similar to just cutting and pasting the tube object into the apple layer. The difference is that where surface 
polygons from the two objects intersect they are sliced by each other to form a common edge. All interior polygons and 
surface names are retained.

You can use more than two objects at a time, but it’s often better to work with a pair at a time. The math involved in 
Boolean operations is complex, and using multiple objects in a single operation is quite time-consuming.

To use the Boolean command:

Make the object that you are going to use as the cutter
Place the object to be cut in another layer and put the object from step 1 in the background.

Click Construct > Combine > Boolean (or use the keyboard shortcut Shift B ).
Select the type of Boolean Operation and click OK.

Single vs. Double-sided Polygons

Single-sided and double-sided polygons play a unique role in the Boolean Subtract operation. Imagine that you are a 
knife blade, slicing through a 3D sphere made of single-sided polygons. Every time you cut through a polygon layer, you 
pass from the outside of the sphere to the inside. If you passed through only one polygon, you are now inside the 3D 
sphere. Accordingly, a Boolean knife blade slicing through a one-sided sphere would leave solid halves.

Boolean commands such as Subtract will produce much better results if your objects contain plenty of 
geometry to begin with. If a boolean does not appear to produce favorable results, or generates an error when 
run, then consider increasing the amount of polygons with tools such as Multiply > Subdivide > Subdivide 
before performing the boolean operation.


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Now say there are two spheres made of single-sided polygons, one sphere being smaller than the other, with the 
smaller one inside the other (normals facing in). You pass through the first polygon - from air to solid - then through a 
second polygon - from solid back to air. You would now be inside a hollow core inside the inner sphere. A Boolean knife 
slicing through this sphere would leave a hollow core.

Now, if our two spheres were double-sided instead, Modeler would treat each sphere as if it were constructed with 
paper-thin walls (double-sided polygons are just back-to-back polygons). Remember, normally the sphere would be 
treated as a solid ball. Upon encountering a double-sided polygon, Modeler will think that it has passed through two 
polygons. In the paper-thin space between the front-facing and back-facing polygon, the Boolean knife blade sliced 
through air, then solid, then air again.

Boolean will usually not operate as expected if the foreground and background objects are both double-sided.
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Drill Tools

(default keyboard shortcuts: Drill Shift R)

There are two drill commands: Drill (Construct > Combine > Drill) and Solid Drill (Construct > Combine > Solid Drill). The 
difference is that with Drill you use a two-dimensional object as your drill bit. The bit extends infinitely along the drilling 
axis, so it has an imaginary third dimension. Think of it as looking straight down along the length of a drill bit. Forgetting 
the fact that you know it has length, it would look like a disc, right? With the Drill command, you just need a disc-shaped 
polygon and the length is assumed.

Solid Drill is essentially identical to Drill except - as you might have guessed - it uses an actual three-dimensional object 
as your drill bit.

When you use a drill in the real world, you must first place a drill bit in the drill. This same concept applies to Modeler. 
Modeler uses an item in the background layer as the drill bit that will cut the item in the foreground layer(s).

Both Drill tools have the same four options:

Core

The Core operation will include all polygons that reside inside the 3D space of the drill bit, plus portions of the polygons 
that straddle the borders.

If your drill bit is an open curve, Modeler will treat it as a closed curve with its endpoints joined.
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Tunnel

Tunnel is the opposite of Core. It creates a tunnel in your object. All polygons that reside outside the 3D space of the drill 
bit will be included, plus the trimmed polygons that straddle the borders.

Stencil

The Stencil option stencils the drill bit’s shape onto any intersecting polygons. It also names all of the polygons that fall 
within the bit’s shape. You can either enter a surface name in the field or select an existing name from the pop-up menu.
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1.
2.
3.

4.
5.
6.

This option is great for stenciling text or logos onto objects - an alternative to using surface color textures. To help draw 
attention to a stenciled area, you might wish to use the Bevel tool (Multiply >Bevel) or Smooth Shift tool (Multiply
>Smooth Shift) on the stencil.

Slice

Slice is the same as Stencil, except it does not rename any surfaces.

To drill an object:

Place the target object in a layer.
Place your bit object in another layer and put the target object in the background.
Position the bit object as desired. Use the viewport whose perpendicular axis (i.e., the axis you can’t affect) is the 
one you want to drill along. For example, if you wanted to drill along the Z axis, position the bit object in the 
Back type viewport.
Swap foreground and background layers using the apostrophe key ( ‘ ) shortcut.
Choose Construct > Drill .
Select the drilling Axis and the type of drilling Operation. Click OK.
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Solid Drill

(Default keyboard shortcut: Shift C)

The Solid Drill command (Construct > Combine > Solid Drill) will work just like the Drill command, but you have control 
over the effect along the drilling axis. There is no Axis option. It is unnecessary since you use a 3D object that has an 
actual, rather than implied, third dimension.

 

The objects in the foreground and background layers must physically overlap for the tool to work properly. 
They cannot be just lined up on an axis.
Both the drill bit and the item to be drilled must be closed solids. A hemisphere with one open side, or a hollow 
tube, would not qualify, but a closed hemisphere or a tube with sealed ends would.


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Speed Boolean

Speed Boolean works exactly like the Boolean command except that you work in one layer.

For Booleans to work properly in LightWave, you need fully connected, closed objects, and on two separate layers. What 
Speed Boolean does is take your polygon selection, expand it to Select Connected, then it Cuts the selected mesh, 
Pastes it on a free background layer and executes the desired Boolean operation, Deletes the background layer then 
switches back to foreground.

You can either select the Speed Boolean tool, or if you know which operation you are after just choose the appropriate 
SpBool operation and there will be no requester to slow you down.

 

Speed Boolean requires that you have both meshes in the same layer to function. You must also select at least 
one polygon on the mesh doing the Cut.


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Bridge

The Bridge Tool is located under Construct > Combine > Bridge.

Polygon Mode:

In Polygon Mode, the tool serves as a connect tool to form bridges/tunnels between polygons. Multiple polygons can be 
selected and bridged together, with or without matching border shapes/point counts.

 

It is recommended that the borders have point counts that are fairly close, otherwise the tool will perform heavy 
triangulation to bridge the polygons, which will often give undesired smoothing results without modifications. When 
bridging together polygons, the tool will automatically use a seam point, which will result in the minimal amount of 
twisting and turning of edges bridging the two polygons together. If the point counts don’t match, the seams are fitted 
at an angular tolerance level with triangles bridging the additional points on the border with the higher point count.

When in Point Mode the Bridge tool stores your poly selection, select all polys, run split polygons, then restore 
the previous selection. As such, the tool has the same problems with split polys when trying to do elaborate 
cuts - it’s recommended that you keep it simple and use the tool multiple times rather than try to make a very 
complicated series of cuts at once. This tool works well in combination with Divide.


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Combine - Connect

(default keyboard shortcut L)

Point Mode:

In Point Mode, the tool works identically to LightWave’s Split Poly tool, except with one convenient modification - you 
don’t have to select the polygons you want to cut ahead of time.

 

Edge Mode:

In Edge mode, selecting a single edge and hitting L, or this tool’s button in Construct > Combine > Connect will seem to 
do nothing but deselect the selected edge. However, if you then switch to point mode you will see a point has been 
added to the center of the edge you selected. If you select more then one edge and those edges are at an angle to end 
other, a new edge will be created joining all the selected edges. If you select edges that are on the same line, the result 
will be the same as if you had selected a single edge - new points will be placed in the center of each selected edge.

 

Single edge selected and result
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Multiple edges on the same line and result

 

Multiple edges selected and result

Polygon Mode:

In Polygon mode you cannot just select a single polygon, you must select several contiguous polys. Hitting L will add 
edges across the middle of the polygons in much the same way that Connect works in Edge mode.
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•

Patches

Tools for creating spline patches.

Patch

Auto Patch
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1.

2.

Patch

(default keyboard shortcut Ctrl F)

Modeler’s feature for Spline Patching lets you model with curves and then smoothly spread a mesh of polygons over 
them.

To use Spline Patching:

Make three or four curves that create one or more fully enclosed areas. Note that the curves must share end 
points, and that they must be “head to tail” meaning that the origin point of one curve is the same point as the 
end point of the preceding curve.

In the Polygon Selection mode, select the curves that surround the enclosed area. Do this in a clockwise or 
counterclockwise fashion. Remember which curve you selected first! It’s okay if you also select some polygons in 
addition to the curves, they will be ignored in the patching operation.
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3. Choose Construct > Patches > Patch . The fields for Perpendicular and Parallel refer to the number of polygons to 
put along the side that is perpendicular or parallel to the first curve you selected. Knots and Length let you 
choose to space your polygons equally according to the overall length or relative to the knots or points on the 
splines.
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4. Click OK . You should see a polygon mesh added to the area within the three curves you selected.

Sometimes a spline cage will be patched unexpectedly. There are some fixes you can try. All of the selected curves 
should flow in the same direction, based on their heads and tails. If they don’t, you can flip them and try the patch 
again. You can also try selecting the curves in the opposite direction.

Sometimes the resulting surface normals face the wrong way. Just select at least one polygon on that side. Choose 
Selection > Modify Selection > Connected (or hit ]) to select all of the connected polygons in the patch. Then, press the F
key to flip the polygons.

If there are not enough curves or they do not share points properly, an error message appears. If this happens, check 
the joining points carefully to make certain they are not merely overlapping. Choose either Detail > Points > Merge 
Points or Detail > Points > Weld to correct.

When patching a 3-sided spline patch, one corner will always contain a fan of triangles. The corner where these 
triangles will be created is determined by the connecting corner of the first and second spline selected.


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Auto Patch

The Auto Patch command (Construct > Patches > Auto Patch) automatically patches a spline cage. You can set the 
number of rows and columns of the patch between 1 and 20.

To space the polygons according to the length of the curve, select the Length Spacing checkbox.

To ensure success, try to have no more than four knots per curve.
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•

Convert

The Convert group is for switching between LightWave-native subpatches, Catmull-Clark patches or polygons, and for 
dealing with Meta-objects.

SubPatch

Freeze

Meta
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SubPatch

(default keyboard shortcut Tab)

Standard polygonal surfaces need many polygons to approximate a smooth surface. Even so, a smooth surface made 
up of polygons will eventually reveal its inherent sharp-edged nature, if it’s examined closely enough. Although you can 
create extremely polygon-heavy objects to attempt to compensate for this, it is often difficult to manipulate and 
manage them from the perspective of memory-consumption and editing.

A “SubPatch” - an abbreviation for subdivision patch - is a “bi-cubic patch”. The idea behind SubPatching is to 
repeatedly refine the control mesh until you achieve a smooth surface, called the “limit surface.” The SubPatch 
modeling mode is not unlike a real-time implementation of the Metaform (Multiply > Subdivide > Subdivide) command.
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You activate SubPatch mode by pressing the Tab key or choosing Construct > Convert > SubPatch. In most instances 
you want to affect the entire object, so no polygons are selected when you press the key. If polygons are selected, only 
those will have the SubPatch mode turned on. This can get confusing because the polygons become deselected. If you 
press the Tab key again, the SubPatch state of all polygons is reversed.

If you do this by accident, use the Statistics window to select/re-select just the SubPatch surfaces.
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To change the shape of the SubPatch object, you manipulate the shape of the polygonal cage (i.e., control mesh) using 
most of the standard Modeling tools, including Bevel, Smooth Shift, Metaform, and so on, or by just dragging points and 
polygons around. Don’t use tools that may create greater than four-point polygons, like Boolean.

You can select the SubPatch vertices by clicking either on the true (polygon cage) vertex location or the location of the 
vertex when mapped on the SubPatch surface.

 

When you use SubPatch, you often manipulate the polygons into what would normally be non-planar, degenerate, or 
cattiwompus polygons. Since the polygonal cage is merely a reference for the SubPatch object, this is perfectly 
acceptable.

If you end up editing a very complex cage, the display can become confusing. In such a case, the cage is often 
close in shape to the SubPatch surface. Thus, you may be able to edit the normal polygons and just flick the 
SubPatch mode on to check the results.


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Freeze

(default keyboard shortcut Ctrl D)

The Freeze command (Construct > Convert > Freeze) is used to convert curves, SubPatch objects and Meta-primitives 
into polygons.

 

To convert a curve into a polygon:

Select the curve(s) and choose Construct > Convert > Freeze. Each independent curve will become a distinct polygon. 
An open curve will be closed (between its end points) before it is converted to a polygon.

The number of points that Modeler will use to approximate the curve depends on the setting for Curve Division on the 
General Options panel (Modeler > Options > General Options or keyboard shortcut O).
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Meta

Click here to expand Table of Contents...

Convert Metaballs
Edit Metaballs
Convert Metaedges
Convert Metafaces
Toggle Metaballs

This sub-group is for meta-object tools.

Convert Metaballs

You can convert points into plain Metaballs using the Convert Metaballs command.

Edit Metaballs

Select the Metaball you wish to edit in Polygon mode and then activate the Edit Metaballs tool (Construct > Convert > 
Meta > Edit Metaballs). On the numeric panel, you can adjust the Radius and Influence with the numeric panel or 
interactively with the handles in the viewport.
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Convert Metaedges

Meta edges can be created from two-point polygons or curves. Simply select the polygon/curve and choose Construct > 
Convert > Meta > Convert Metaedges.

Convert Metafaces

There is no Draw Metafaces tool. They must be created from three- or four-point polygons or curves. Just select the 
polygon/curve and choose Construct > Convert > Meta > Convert Metafaces.

Toggle Metaballs

Like Toggle Subpatches, this turn on and off the display of Metaballs. Saving an object with Metaballs turned off will 
result in surfacing being unavailable.

Today, it’s simpler to leave your 2-point polys as lines and use the Object Properties > Edge tab to draw them 
with added thickness. Convert Metaedges is present for legacy purposes.



If you save a Meta-primitive with the mesh off, you will not be able to see the surface in Layout.
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Map

Click here to expand Table of Contents...
Introduction

What are Vertex Maps?

What are Per-polygon Maps?

Introduction

What are Vertex Maps?

As you might expect, every point in an object has independent position information. Points even have rotational 
information, although you normally don’t rotate individual points. A vertex map (VMap) is additional data that a user 
can add onto each point in an object. Any point in an object can have a unique entry (value) for a particular VMap or no 
entry at all. The VMap data is all stored in the object file.

Basically, VMaps are to points, what surfaces are to polygons. Like surfaces, you name your VMaps, which allows you to 
access them to perform certain operations. Some VMap types are designed for special built-in functions. For example, 
UV Maps hold texture placement information. Endomorphs hold offset information for point position. Weight maps are 
used more generally, like for bone influence; however, the SubPatch weight map is used specifically for control-point 
tension.

If a point has no entry for a particular VMap, the VMap is not assigned to that point - this map will have holes in it. Note 
that an assigned value of 0 is not the same as not having the VMap assigned to that point. However, some functions that 
use VMaps consider these two states to be equal - usually by necessity - essentially filling the holes with zeros.

VMaps are normally created using the buttons in the lower-right corner of Modeler.


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1.
2.

Once the map is created, you can set or edit the values in the map. Many LightWave commands, however, also have the 
ability to create VMaps.

VMaps are extra data and will increase your object’s file size. Thus, depending on the situation, you may be able to 
minimise the file size by judiciously assigning VMaps to points.

Because you can use vertex maps (VMaps) throughout LightWave, you should have a solid understanding of how they 
work. Here are some important basic points:

Weight maps have a general range of -100% to +100%.
Use the Selection Info command (Info button on the bottom taskbar, or press I ) to determine what VMaps and 
values are assigned to individual points.
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Internally, there is a single list of VMaps, which includes the maps from all the objects that are loaded. However, editing 
a map in one object will not affect other objects (using the same VMap name) because the data in the map is attached to 
the geometry of that object. There is no cross-talk between objects, except in the case of renaming. If you rename a 
VMap, all VMaps (for loaded objects) with the same name are renamed.

Generally, the only VMaps listed in the main VMap pop-up menu are those that contain actual data in the current object. 
Other VMaps are filtered out. Not all VMap pop-up menus will do this filtering, however, particularly those on plugins.

New VMaps are an exception to the above standard. Initially, they will appear in pop-up menus even if they contain no 
data. However, if you deselect a new VMap before using it, it will disappear from current VMap listings. It might save you 
some typing time, so Modeler still places the name in the pop-up menu that appears beside the naming field when you 
are creating a new VMap.

There can be one selected VMap of each general category (weight, UV texture, etc.), and they can be selected in different 
ways. The pop-up menu in the bottom-right corner of Modeler shows the current selection for the weight, UV texture, 
and morph categories, and can be used to change them. The VMap List window, discussed later, also shows the 
selected map in each category. Note that all new maps start out selected.
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What are Per-polygon Maps?

Per-polygon UV Mapping, or Poly Mapping, was introduced in LightWave 6.0b as a way to handle discontinuous UVs. 
(Without some kind of handling, they would cause the entire image map to appear backwards and squashed onto a 
single polygon at the map seam. Not a pretty sight.) They were superseded by the current UV Mapping tools found 
starting in LightWave 6.5, so unless you are working with a model that was mapped before that, there’s really no reason 
to use them; the new tools are much more elegant and flexible.

Unlike UV Maps, Poly Maps cannot be edited with the normal Modify tools used in the rest of Modeler, because they are 
not continuous. Instead, they are locked snapshots of some UV Mapping of a polygon. So any operation on a vertex 
must also specify which polygon’s view of that vertex is being edited.

You can select polygons that use per-poly UVs by choosing the VMap Poly Select command (Map > Poly Map > Select by 
Polygon Map).

General
General - More
Weight
Color
Poly Map
Morph
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General

Set Map Value

Airbrush

Clear Map

Edit Maps
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Set Map Value

Set Map Value (Map > General > Set Map Value). Clicking on this command opens a panel that allows you to directly 
specify a value for any of the Vertex Maps used in LightWave.

This value will be applied to all selected points. If no points are selected, this value will be applied to the entire map.

Vertex Map

The Vertex Map pop up menu allows you to choose the map you want to work with. The map selected will be the only 
map affected, regardless of what map is actually showing in your viewports.

Below that are various fields, which will be available or dimmed, depending on the map type you’ve chosen.

Weight Map

If you select a Weight Map, only one value will be available. Whatever value you type into the field will be applied to all 
selected points in the map, replacing any values you might already have assigned.

It’s entirely possible to assign values to maps you cannot see. In other words, if you don’t see anything 
happening, check to make sure you are looking at the correct map.


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Texture Map

If you select a Texture Map, two values will be available. The first is the U value, and the second is the V value. 0% for 
both values is the lower left corner, where the vertices meet on the UV Map Texture view. 100%, of course, is the upper 
right corner. All selected points will snap to the value chosen.

Morph Map

If you select a Morph Map, three values will be available. They correspond to the three axes (X,Y, and Z.) All selected 
points will be moved along a delta described by the numbers you enter. In other words, if you enter .3 in the middle (Y) 
field, all selected points will be moved 300 mm upwards from their Base values.



LightWave 2020  –  LightWave 2020

Reference –  1542

Color Map

If you select a Color Map, four values and three ranges will be available. The values are for Red, Green, Blue, and Alpha. 
The Ranges are General, Percent and Distance. It’s recommended that you don’t use the General field. The Percent is 
percent, of course. If you use Distance then 1m = 100%.

Don’t forget that if you don’t set the Alpha, in the fourth field, you won’t see the color on your map. (For full color, set it 
to 100%.) Using this tool with no points selected is a quick and easy way to make sure that all the points are in your 
Color Map. (Points with no assigned value are not the same as points with an assigned value of zero.)

Metaball

If you select a Metaball Map, one Value and three ranges will be available. The ranges are General, Percent, and 
Distance. They change the size of the Metaballs, and the distance at which they influence each other. Once again, any 
selected points, that is, Metaballs, will react to the numbers you enter in these fields.

This tool is not interactive; you won’t see your changes until you close the panel. All the fields in all categories revert to 
zero when the panel is closed.

Use this tool to assign all the points in your object to a Vertex Color Map if you are so inclined; but don’t use it 
to assign the colors. For that, it is much better to select the points, and then use the Point Color tool. It will give 
you a regular LightWave color requester. (But it will only work on selected points.)


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Airbrush

The Airbrush tool allows you to “paint” directly on your Vertex Maps. How it works depends on which kind of map you’re 
working with.

Choose the desired map from the Vertex Map drop down in the Numeric panel. All the maps available to the Airbrush 
will be listed here by name, with the type of map in brackets on the right.Whichever map you pick will be shown in any 
viewports capable of showing it, assuming it’s the same type of map chosen in the VMap Bar. (i.e. Weight Maps will be 
shown in viewports using the Weight Map Render Mode, Color Maps in Smooth Shade, Texture, and Textured Wire, etc.)

If you pick a different Weight or Color Map from the VMap Bar at the bottom of the screen while the Airbrush is open, 
that map will replace the one that’s showing, both in the viewports and the Airbrush Numeric panel, if it’s the same 
type.

The “same type” caveat is important. If you have a map of a different type showing in the Numeric panel and the VMap 
Bar, for instance, a Weight Map in the VMap Bar, and a Morph Map in the Numeric panel, any airbrush strokes will be 
applied to the map in the panel, in this case the Morph Map, and not to the one in the VMap Bar, even though that’s the 
one you will be looking at. So, if the airbrush seems to have no effect, check to make sure you are working on the right 
map.

Radius

The Radius determines the relative Falloff for the tool. You can adjust it interactively with the RMB, as you can with the 
Falloff values of most tools. In order to change anything, the radius must touch a point on your map; bear that in mind 
as you adjust it.
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Strength

The Strength determines the intensity of the effect. Small values are recommended; start with 10% and increase it if you 
need to.

This tool behaves like a real airbrush in some ways. If you move quickly, you’ll get less coverage than you would with a 
slow stroke, and going back over areas will increase coverage. However, unlike its real-world namesake, the tool must 
be moving in order to do anything. Don’t expect to get full coverage by holding it still over a point.

Also, remember that you are painting vertices, not polys. Running the Airbrush up and down the polys will have no 
effect unless the Airbrush radius touches a point. For best results, ignore the polys, and paint the points.
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You can select points or polys to limit the effect to the selected vertices only; however, because of the nature of Vertex 
Maps, you’ll find that the effect is blended with adjacent points or polys. Each point can only have one value; so as you 
can imagine, the more points you have, the more detailed your painting can be.

If you want a sharp edge between two polys, cut them, and paste them back in. Then either select the polys you wish to 
work with, or hide the others. In either case, since they are no longer sharing a point, there will be no blending. When 
you are finished, merge the points. They will keep their sharp edges.

Weight Value

To use the Airbrush with a Weight Map, it’s best to change one of the viewports to Weight Shade. (You don’t have to, 
unless you want to see what you’re doing; the tool will change the Weight value anyway.) Pick the Weight Map you want 
to work with from the list; it will automatically be shown in the viewports.
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Weight Shade display mode shows red on the right for positive weight maps and blue for negative weightmaps.

Type the value you want to apply in the Weight Value field. This value will replace the current one. In other words, if you 
are painting with 10% weight, you don’t have to worry about any of the vertices exceeding that value. You can also paint 
with 0%, to eliminate positive weight without worrying about negative weight.

If you hold down the Shift key, you’ll paint with the inverse value. In other words, if you’re painting with 30%, holding 
down the Shift key will enable you to paint with -30%. If you’re using -50%, it will give you +50%.

If you hold down the Ctrl key, the weight will go towards zero, whether it’s currently negative or positive. (In other 
words, it will go up if it’s negative, or down if it’s positive.)

You can push the values far beyond 100% and -100%, if you are so inclined.

Airbrush and Morph Maps

To use the Airbrush with a Morph Map, select the morph you want to paint on from the VMap Bar at the bottom of the 
screen. Select the morph you want to paint from in the Vertex Map menu in the Airbrush Numeric panel.
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Shape

Choose the percentage of the Shape that you want to apply from the Shape text field. You can change the current 
morph half way to another one, or change parts all the way, or just take 10% off the top. It’s very flexible.

You can also paint a morph onto the Base; but if you do, it will change all the relative morphs in your object. You are 
given a warning if you attempt it.

Airbrush and Color Maps

To use the Airbrush tool with a Color Map, choose the map you want to color from the drop down list. Make sure that it’s 
being used on a surface, and is visible, the Create Vertex Color Map requester asks which surface to apply it to. (Check 
the Advanced Tab of the Surface Editor for use.) The Airbrush will paint on maps that are not showing, so be careful. If 
you don’t see any effect, don’t assume that your settings are too weak.

Choose a color from the normal Color Requester. Be aware, though, that LightWave will apply the color over the base 
color of your object using the Multiply Blending Mode. If you are familiar with Photoshop, it’s very similar. Adding color 
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will always make the base color darker, never lighter. (If that’s a problem, simply start with a white base color, of 
course.) The colors you paint on the map itself will replace whatever colors are there, so it’s easy to lighten them.

Alpha

If you are using an Alpha Channel in your map, (enabled when you created it,) then you can also adjust the Alpha with 
the Airbrush. Do this by either changing the number in the Alpha text field, or by holding down the Ctrl key as you paint. 
You can increase the Alpha by using the Alpha text field; but it will also add color. (Which is just as well, really, since 
uncolored points with 100% Alpha are black.)
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Clear Map

(default keyboard shortcut _)

To clear a Vertex Map, select the map you want to clear from the VMap Bar, and click on the command. All values will be 
cleared, no matter which kind of map you chose. (Weight, Texture (UV), Endomorphs, Color Vertex Maps, or Selection 
Sets.)

To clear an entire map, make sure no points or polys are selected before you click.This differs from the Delete Map
command because it leaves the map. Only the information contained in the map is deleted, so you can immediately 
begin to put more information in, without having to create another map. If you don’t add information, the map will be 
deleted when you leave it. (Empty maps don’t persist in LightWave.)

To partially clear a map, select the points or polys that you would like to clear. Click the button, and the values for those 
points and polys will be gone.

This is extremely useful, as it allows you to correct your maps on a point-by-point basis.

Don’t use this function to clear a copy of a map to make symmetrical morphs, etc. Instead, just select the part 
you want to keep when you copy the map in the first place.


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Edit Maps

This sub-menu contains three commands for vertex map manipulation:

Copy Vertex Map

(Map > General > Edit Maps > Copy Vertex Map) To copy a Vertex Map, select the map you want to copy from the VMap 
Bar, and click on the command.

A dialog will appear that allows you to name the new Vertex Map. By default, it will have the name of the map you are 
copying, with a number appended to it. You can accept that name, or type in any name you like. (It is strongly suggested 
that you develop the habit of using meaningful names for your maps.)

Click OK, and the copy is made and selected, ready for you to work on.

All values will be copied, no matter which kind of map you chose. (Weight, Texture (UV), Endomorphs, Color Vertex 
Maps, or Selection Sets.)

To copy an entire map, make sure that no points or polys are selected before you click on the command.

To copy a partial map, select the points or polys that you would like to copy. Click the button, and only the values for 
those points and polys will be copied to the new map.

This is extremely useful, because it allows you to make perfect pairs of Endomorphs, Weight Maps, etc. by making a full 
map using symmetry, and then copying half of it to a new map.

For instance, you might make a symmetrical morph of your character closing both eyes. Call it “Eyes.close” Then copy 
the left eye only, use this button, and call the new Endomorph “Eyes.lWink” Instant flexible facial expressions!

Be aware that there’s no list here to choose from; you must do that in the VMap Bar.
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Delete Vertex Map

(Map > General > Edit Maps > Delete Vertex Map)To delete an entire Vertex Map, select the map you want to delete from 
the VMap Bar, and click on the command. (Weight, Texture (UV), Endomorphs, Color Vertex Maps, or Selection Sets may 
all be deleted with this command.)

The entire map will be deleted, whether any points and polys are selected or not. (If you wish to delete only some of the 
points or polys from your map, use the Clear Map command, instead.)This is different from the Clear Map command 
because it doesn’t simply empty your map. It completely deletes it, including its name.

Be aware that there’s no list here to choose from; you must do that in the VMap Bar.

Rename Vertex Map

(Map > General > Edit Maps > Rename Vertex Map)To rename a Vertex Map, select the map you want to rename from the 
VMap Bar, and click on the command. (Weight, Texture (UV), Endomorphs, Color Vertex Maps, or Selection Sets may all 
be renamed with this command.)

Simply type the desired name into the text field and click OK. Be aware that there’s no list here to choose from; you 
must do that in the VMap Bar.

This command will delete all maps that use the name of the map chosen in the VMap Bar from all open objects. 
For example, if you have a model with a morph you’re calling “Eyes.Blink,” and you decide that this particular 
character doesn’t need that morph, and you might as well delete it, be careful. As soon as you click, all the 
“Eyes.Blink” morphs will be deleted from all the characters that are open at the time, whether they are visible 
or not.


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Mirror VMaps

The Mirror VMaps tool can be used to copy selected VMaps from the +X or -X side of an object to the other side. The 
Mirror Axis Position can adjust for items that are not exactly on-axis, and the Tolerance value can be set for values that 
aren't purely symmetrical like faces, bodies, etc. The Make New VMap option creates a new VMap containing the copied 
data.

In this example, we copy the weight map from left ear to right. Then we undo and copy red to green in a new VMap. Even 
with the symmetry not being perfect, the result is good.

If there is already a selection when this tool is started, Mirror VMaps will be limited to the selection.

Note that we cannot copy green to red in this example because the green side has no weight map. If we had 
created a weight map for all points set to 0 %, then set the left ear to 100 % copying green to red would work.



You can use this tool to mirror vmaps selectively. With the VMap window open (F8), choose the maps that you 
wish to mirror. As is usual in Modeler, if nothing is selected, that means everything is selected.


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General - More

Cull Map
Deselect/Select
Clear Map

Normalize
Source VMap

Normal Baker

Cull Map

This command opens a dialog that allows you to select some or all of the points in a Vertex Map, and to automatically 
delete the ones that fall below a certain threshold.

To use it, choose the map you wish to cull from the drop down list. All types of Vertex Maps (Weight, Texture (UV), 
Endomorphs, Color Vertex Maps, or Selection Sets) from all open objects will be listed here.

Deselect/Select

Use the Deselect or Select buttons if you want to deselect or select the points in the map.

Clear Map

Enable Clear Map if you wish points to be automatically cleared from the map. If you enable it, no points will be selected 
or deselected; they will simply be cleared if they fall below the threshold.

Then type the number you desire for the Threshold into the Threshold Magnitude field, and hit Enter. (It’s important to 
do it this way if you are in the habit of using Return or Enter to move to the next field, because in this case it closes the 
dialog. If, on the other hand, you use the Tab key to move from field to field, go ahead and fill in the box in order, then 
click OK.)

Any points that fall below the threshold will be acted upon. (Deselected, Selected, or Cleared.)

The Threshold for most uses is between 2 and 0, although if you have pushed your weights, your numbers may 
be higher. 
To select only high threshold points, select all points, and choose Deselect to drop those below the desired 
threshold, leaving only the higher ones selected.


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Normalize

This command allows you to scale the values of your Vertex Maps. It works on the entire map, whether any points have 
been selected or not.

Source VMap

Choose the map you wish to scale from the drop down menu. All kinds of Vertex Maps are listed here, with the type of 
map in a code to the left.

Weight Maps are listed as WGHT .
Texture Maps are listed as TXUV .
Morph Maps are listed as MORF .
Color Maps are listed as RGBA or RGB (if they don’t include an Alpha Channel).
Selection Set Maps are listed as PICK .
Metaballs are listed as MBAL .

Minimum, Maximum - Select a Minimum and Maximum value for the map. The entire range will be scaled, not clipped, 
to fit between these two values.

Normal Baker

Normal Baker (Map > General > More > Normal Baker) will store the (normalized) point normal for each vertex as three 
numbers into a VMAP called pnt_normals. The values, starting with the first, represent the X, Y and Z directions of the 
vertex’s normal.

You’ll have similar results with all Vertex Maps.
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Weight

New Weight Map

Weights

Bone Weights

UV to Weight

SPW2Weight

Weight Blur
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New Weight Map

This command allows you to create a new Weight Map. It opens the Create Weight Map dialog, exactly like choosing W
and (new) from the VMap Bar at the bottom of the screen.

Name

To name your map, either type a name into the text field, or choose an existing name from the drop down list to the 
right. The list contains all the names of all the Weight Maps used during the current session, whether or not the objects 
remain open, and whether or not the maps have any points assigned to them.

It’s recommended that you choose a meaningful name, which will enable you to easily tell what the map is designed to 
do. This is especially true if you are working with other people; in fact, in those circumstances, there might be names 
that you are required to use, depending on the function of the map.

Initial Value

Choose an Initial Value by clicking in the box to enable it, and typing the value you desire into the text field, or using the 
spinners.

Choosing an Initial Value, even if it’s a value of zero, will place all the points into the map.

(Unassigned points are not the same as points with a value of zero, even though they might look the same in the 
viewport Weight Shade render.) This may or may not be desirable because every bit of information takes up memory.



LightWave 2020  –  LightWave 2020

Reference –  1557

Weights

This button allows you to edit existing Weight Maps by assigning weights to your points interactively.

It’s best used with one of your viewports set to Weight Render mode, and with the Numeric panel open. (These things 
will allow you to see what you are doing.)

Choose the Weight Map you want to edit from the VMap Bar at the bottom of the screen.

Place the tool on the point you wish to edit, and drag right to increase the weight, and left to decrease it. You can see 
the weight you are assigning in the Numeric panel, in the Change field.

You may also be able to see it in the Weight Shade viewport, or in the shape of the object, depending on the Weight Map 
you are using.

A weight of zero will have a grey-green color. Positive weight values will approach bright red. Negative values will 
approach bright blue.
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Change

The number in the Change field is a relative number, not an absolute. In other words, it tells you how much of a 
difference you’ve made in the weight, not what the weight is. This tool doesn’t work particularly well for assigning 
specific weights to selected points. For that, you should use the Set Map Value tool. The strength of this tool lies in its 
interactivity.

There’s nothing better to assign Subpatch Weights with, because you can see the results in real time as you work. 
Judicious use of the tool can save geometry, since you can sharpen edges with weights, instead of cuts.

Falloff

Like many other tools in Modeler, this one allows you to adjust the Falloff range.By default, the range is Point. In other 
words, the tool will only affect the point you are working with.

You can also assign other Falloff types:

None will assign the weight to all selected points/polys equally (or the entire model if none are selected.)
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Linear and Radial allow you to interactively set a range with your RMB, or to use a number of presets.
Polygon applies the weight equally to all the points of all the polys which share the point under your tool.
Point Radial allows you to set a falloff with the RMB that remains centered on the tool as you move it around. 
(Rather like the airbrush, but you drag to change the weight.)
Above the different types of falloff there is also the possibility to use a texture to guide how your weights falloff.
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Bone Weights

This tool creates Weight Maps for bones, based on the choices you make within its dialog box. The map will have the 
same name as the bone that it’s associated with. For example, if the bone is called Bone01, the map will be called 
Bone01 as well.

To use it, you must have both bone and geometry in foreground layers. Select the bone you wish to create a Weight Map 
for. (If no bones are selected, maps will be made for all foreground bones that don’t have one.)

Falloff

A dialog will open that allows you to choose the falloff algorithm for the bone. The various choices correspond to the 
Falloffs that you can use on bones when you aren’t using Weight Maps. But with this tool you can start there, and then 
modify the weight to suit your own needs. (You can also see what the Falloff is doing in any viewport set to Weight 
Shade, where positive weights are red, zero is grey-green, and negative weights are blue.)

Additive

If you enable Additive, the weight will be added to any existing value. So, if you have two bones with the same name, 
say both left and right arm bones called armbone.01, the effects from both would be shown on the same map.

Threshold Value

The Threshold Value is a capsule-shaped region around the bone. You can type the value into the text box, or use the 
mini-slider.

Use Threshold

The Threshold Value can be used in several ways. Off will simply ignore it.

Clip will take any weight outside the threshold and set it to zero, which can have the effect of giving fairly sharp edges to 
the Weight Map.

Subtract will subtract the weight at the threshold from all the weights in the map; so the weight inside the threshold 
progresses smoothly to zero, the weight at the threshold is zero, and weights beyond the threshold become negative.

Blend behaves like Subtract inside the threshold, but clips everything above the threshold, so all the weight beyond the 
threshold is zero.
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SPW2Weight

This command allows you to transfer the information in a SubPatch Weight Map to a new map.

To use it, click to open the dialog box. Choose the Subpatch Weight Map you wish to use from the drop down list (base, 
in most cases,) then type the name of the new (or existing) Weight Map into the Weight Map field. The new map will be 
created, and chosen in the VMap Bar.

If you used an existing map, the values in that map will be replaced with the values in the SubPatch Weight Map.
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Weight Blur

Weight Blur takes the current weight map and creates a gradient based on the upper and lower values.

 

Left: Top half of weight map set to 100%. Right: Weight map after Weight Blur is activated with five iterations.
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Color

New Color Map

ColorMap Adjust

Point Color

Textured Point

Vertex Paint
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New Color Map

This button allows you to create a new Color Map. It opens the Create Vertex Color Map dialog, exactly like choosing C
and (new) or the + from the VMap Bar at the bottom of the screen.

Choose a new name, whether or not to add an Alpha Channel, and which surface you want the map applied to.

Name

To name your map, either type a name into the text field or choose an existing name from the drop-down list to the 
right. The list contains all the names of all the Color Maps used during the current session, whether or not the objects 
remain open, and whether or not the maps have any points assigned to them.

Use Alpha

It’s recommended that you use an Alpha Channel in your texture unless you intend to completely color the object. If you 
don’t, you are likely to find that you have black artifacts around the edges when you use the Airbrush. This happens 
when a polygon has some points that are in the Color Map, and some that aren’t. (Points that are unassigned are not 
the same as points that are assigned a value of zero.) The Alpha Channel eliminates this, and allows better feathering, 
so the color you’re applying blends smoothly into the base color of the object.

In general, Alpha Channels allow you more flexibility, and are considered superior; but they do take up memory, and 
aren’t necessary if there aren’t any unassigned vertices.

Apply to surface

Choose which surface you would like the new Color Map applied to from the drop down list. All the surfaces in the 
current object will be there.

You don’t have to choose a surface; but if you don’t, the new map won’t be visible on anything. You will be able to 
assign values to it, and even color on it; but you won’t see it until it is applied to a surface. So be careful. You don’t want 
to waste time, or become frustrated because you think the airbrush isn’t working when the real problem is that you are 
painting on an invisible map!
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If you don’t choose a surface, you can always choose one later by opening the Node Editor, and choosing the node 
Vertex Map, picking the vertex map that you have created, and hooking it to the color input on your material.
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ColorMap Adjust

This tool allows you to adjust Vertex Color Maps that have already been created. By default it is shown in RGB mode, but 
can be switched to HSV. You can send edits to a different Vertex Color Map by changing the Output Color Map 
dropdown. The mouse pointer shown in the image indicates the handle for moving the HUD around.

Make Negative will give the complementary color for your map and the RGB (or HSB) sliders will return to 0.
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Point Color

This button allows you to assign a color to any selected points. To use it, select the points you would like to add the 
color to. (If no points are selected, this tool won’t do anything.)

Name

Type the name of the Vertex Color Map you would like to work on into the Name field, or choose it from the drop down 
list to the right. The list contains all the names of all the Color Maps used during the current session, whether or not the 
objects remain open, and whether or not the maps have any points assigned to them.

You can start a new map either by typing the new name into the field, or by choosing (new) from the list, and then 
typing a new name into the field. However, be aware that this map won’t be assigned to any surface, so you won’t be 
able to see the results of your choices until you assign it to one. (You’ll have to open the Surface Editor, and assign the 
map to a visible surface by selecting the surface, and then choosing this map from the Vertex Color Map list in the 
Advanced Tab).

So be careful. If you don’t see any change, don’t assume that the tool didn’t work. Check to make sure that the map has 
been assigned to a surface that’s visible in one of your viewports.

Use Alpha

Decide whether or not to use an Alpha Map with the selection.

If you are making a new map, it’s recommended that you do, unless you intend to completely color the object. Although 
the color will look fine, and blend nicely when using this tool, if you ever use the Airbrush on this map, you’ll have black 
artifacts around the edges where the color doesn’t feather properly.

If you are using an already existing, you must choose to use the Alpha if it has one, or not to use it if it doesn’t. The 
choice will not be disabled; but if you disable Use Alpha on an RGBA Map, or enable it on an RGB Map, Point Color will 
simply make a new map with the same name, and follow your choices. Since that map hasn’t been assigned to any 
surface, you won’t be able to see any results.

(But, you can see them if you go to the Surface Editor Advanced Tab, find the other map with the same name, and 
assign it to the surface).
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Color

Pick a color to put on all the points, using the normal LightWave Color Requester. Drag the numbers to choose an RGB 
color, or right-click to toggle to HSV and then drag, or click on the color swatch to open the Color Picker you have 
chosen to use.

Color Mode

In the Color Mode field, you can choose how this color will be applied to the points.

Replace

Replace removes any color currently there, and replaces it with this one.

Add

Adds the RGB value of the current color to the RGB value of the color already there, if any. This may result in RGB values 
higher than 255, of course, which gives you ultra-bright colors.

Blend

Adds the RGB values of both new and existing colors and averages them by dividing the result by two. The value won’t 
exceed 255, unless the existing color did.

Alpha

Finally, if you enabled Use Alpha, specify the amount of alpha you want to use.

(It’s important to enter the Alpha last if you are in the habit of using Return or Enter to move to the next field, because in 
this case it closes the dialog. If, on the other hand, you use the Tab key to move from field to field, go ahead and fill in 
the box in order, then click OK.)

Unlike most of the other Alpha fields, this one isn’t a percentage. That means that 1 is equivalent to 100%. So, 
if you want “normal” coverage, enter 1 in this field. (If you enter 100, you’ll really get 10000%, and your color 
will be far darker than you expect.) If you enter 0, which is the default, you won’t be able to see any color at all, 
because it will be totally masked. (You can see if it’s really there, though, by checking the Point Information (I). 
You can also change the alpha there, so you can see the color.)


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Textured Point

This button allows you to assign the luminosity values of a normal LightWave Texture (image, procedural, or gradient) 
to a Weight or Morph Map, or the Color values to a Color Map. Bear in mind, though, that the texture is assigned to 
points, not polys (hence the name) so, unless you have a very heavy mesh, you won’t get the detail you’d get by using 
the textures on a surface. Other than that, though, it works in a very similar way.

Offset

Offset will move a 3D texture through the surface.

Scale

Scale changes the scale on all three axes simultaneously.

Axis

Axis allows you to change the Projection Axis for the texture.

VMap Type

Choose the type of map you want to apply the texture to from the VMap Type drop down menu. The available choices 
are Weight Map, Morph Target, or Vertex Color.

VMap Name

Type the name of the Vertex Map you would like to work on into the Name field, or choose it from the drop down list to 
the right. The list contains all the names of all the maps of that type used during the current session, whether or not the 
objects remain open, and whether or not the maps have any points assigned to them.

You can also type a new name into the field to start a new map. In the case of a Color Map, you can choose (new) and 
then type one in; but be aware that, as always, you won’t be able to see it until it’s been assigned to a Surface. (To do 
that, you’ll need to open the Surface Editor, go to the Advanced Tab, and choose the map from the Vertex Color Map 
drop down.)

Weight Maps, Morph Maps, or existing Color Maps that have been assigned to a visible surface, will become selected in 
the VMap Bar, and will be visible in any viewports capable of showing them. (ie. Weight Maps will be shown in viewports 
using the Weight Map Render mode, Color Maps in Smooth Shade, Texture, and Textured Wire, etc.)

Click on the Texture button to open the familiar LightWave Texture panel. This works the same as it does everywhere 
else. You’ll find that the Gradient parameter choices are limited to Previous Layer, X, Y, Z, Distance to Center, and 
Weight Map; but other than that it’s what you are used to.
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As you work, you’ll be able to see the texture affecting the map in real time. Colors will change, weights will go from red 
to green, and morphs will distort as you watch.

Although you can change the orientation and scaling from within the Texture dialog, as you normally would, you can 
also change them in the Textured Point dialog (labeled Apply Texture)
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Vertex Paint

Overview

Vertex Paint is a Modeler plugin that lets you interactively “paint” a Vertex Color 
Map on objects and Weight Maps on Skelegons.

A Vertex Color Map is a LightWave feature that lets you assign colors to an 
object’s vertices (i.e., points). Vertex color maps are a basic LightWave feature so 
you can render their effect without using surface shader plugins. Although similar 
to Modeler’s Airbrush tool, Vertex Paint has its own independent interface for 
painting.

LightWave Skelegons let you define bones in Modeler. Weight Maps can provide 
additional deformation information. Vertex Paint provides a variety of features 
for you to set weights for Skelegons. You can see how the weight will deform the 
object in real-time while painting.

The Vertex Loader plugin can be used to load the bone information modified in 
Layout so that you can edit weights using Vertex Paint.

How to launch Vertex Paint

Vertex Paint consists of two plugins: Vertex Paint and Vertex Loader.

If you want to edit a Vertex Color Map or Weight Maps (for Skelegons):

First, load an object you want to edit into Modeler. Then, choose Map > Color > 
Vertex Paint. For Skelegon Weight Maps, your object must already have 

Overview
How to launch Vertex Paint
Saving the Data
Vertex Paint: User Interface
Changing the size of the 
main panel
Manipulating the 3D 
window
Rotating the view
Moving the view
Scaling the view
Perspective and 
Orthogonal view
Changing the view
Switching the display 
mode
B Button
T Button
Rotating a Bone
Moving a Bone
Scaling a Bone
Changing the Mode
Displaying a Morph Target
Vertex Paint: Showing / 
Hiding Polygons - 
Selecting / Deselecting 
Polygons
Select / Deselect Polygons 
Using Your Mouse
Show / Hide Polygons By 
Polygon
 Default Mouse Operations
Keyboard Shortcuts
Show / Hide Polygons By 
Surface
Vertex Paint: Light Setting

Setting the Light 
Source
Choosing Light
Light Type
Positioning the 
Light
Distant Light
Point Light
Spotlight
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Skelegons. The Skelegon names set by certain tools, such as Skelegon Tree, are 
used for each Skelegon’s Weight Map name.

If you want to edit weight maps using Layout bones:

Use Vertex Loader to load objects with bones that were created from scratch in 
Layout, or bones that were converted from Skelegons, in order to edit the Weight 
Maps in Vertex Paint.

To use Vertex Loader, choose File > Import > Vertex Loader. First the Load Scene 
requester opens; select a scene file that has object(s) with bones. After you select 
a scene file, the dialog box shown below appears. There you select an object that 
you want to edit and click OK.

The selected object is automatically loaded into Modeler and displayed in Vertex 
Paint with its bones. If the object is already loaded, only the bones are loaded 
from the scene file. Weight maps set on the Bone Properties panel in Layout are 
used for each corresponding bone.

If multiple skelegons share the same weight map name:

If a single weight map is shared by multiple Skelegons (or bones), Vertex Paint
displays the dialog box below. Generally, one weight map should correspond to 
only one bone in Vertex Paint.If you click Yes, Vertex Paint automatically uniquely 
renames the map so there is no longer a duplicate. If you click No, Vertex Paint 
makes an exception and allows a “shared” weight map.

Vertex Paint: Vertex Color 
Paint

Create Vertex Color 
Map
Rename Vertex 
Color Map
Delete Vertex Color 
Map
Vertex Color Map 
Type
Component vs. 
Blending Display
Vertex Color 
Painting
Selecting Operation 
Mode
Selecting 
Component
Selecting Paint 
Color
Painting Vertex 
Colors on Points
Painting Polygon 
Vertex Indices
Painting Vertex 
Color per Polygon
Painting 
Symmetrically 
along the X Axis
Customising the 
Color Palette
Gradient
Loading a Color 
Palette
Saving a Color 
Palette
Baking OpenGL 
Shading)
Reset to Surface 
Color
Adjusting Vertex
Adjusting 
Brightness and 
Contrast
Adjusting Balance
Adjusting Hue, 
Saturation and 
Value

Before launching Vertex Loader, make sure Layout’s Content Directory 
setting matches Modeler’s.


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Saving the Data

Changes made in Vertex Paint are not automatically updated in the Modeler 
object. To reflect the Vertex Paint changes, click the Save button or choose Save 
To Modeler from the Edit menu. (An asterisk (*) next to the object name means 
the object has additional information not yet updated.)

The following is what Vertex Paint updates:

Vertex Color - (RGB VMap, RGBA VMap)
Weight   - (WGHT VMap)
Morph - (MORF VMap, SPOT VMap)
Bone name - (BONE, PART PTag)
Bone Weight name - (BNWT PTag)

Vertex Paint: User Interface

Choose Map > Color > Vertex Paint to launch Vertex Paint. The interface appears 
below.

Vertex Paint: Bone Weight 
Paint

Choosing Bones
Disabling “Hide 
Unselected Bones” 
shows the bones
 Displaying Weight
Weight Value 
display mode
Weight Ratio 
display mode
Renaming Bones
Renaming Weight 
Maps
Copying Weight
Pasting Weight
Pasting Weight 
Symmetrically in X 
Axis
Pasting Weight 
Symmetrically 
Along an Arbitrary 
Axis
Axis
PositionSpecifies 
the origin position. 
If you selected the X 
Axis and then set 
Position to 1m, all 
of the points that 
meet the condition 
“X’ = -X + 2m” is 
looked up. 
OperationSpecifies 
how the weight will 
be pasted to the 
points. REP 
replaces the whole 
original weight 
value with the new 
value. OVR 
overwrites part of 
the original value 
only if the new 
value is bigger than 
the original ones.
Normalising 
Weights
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 Changing the size of the main panel

To change the size of the main panel, drag the mark at the bottom-right corner 
with LMB. The display will be jumbled while dragging, but once you release the 
mouse button, it will display properly.

Manipulating the 3D window

The large window on the right side of the panel is a 3D view where you can paint 
the vertex color of the loaded object or edit the weight value of bones. When you 
first run Vertex Paint, the 3D view displays the object you are going to edit. The 
3D view is changed in much the same way the Perspective view is in Modeler.

 Rotating the view

There are two ways to rotate the 3D view. One is to drag your LMB on the rotate 
button at the upper right of the panel. The other is to drag your LMB while 
pressing Alt key. Both ways rotate object in the direction you drag.

 Moving the view

There are two ways to move the 3D view. One is to drag your LMB on the pan 
button at the upper right of the panel. The other is to drag your LMB while 
pressing Shift key. Both ways move object in the direction you drag.

 Scaling the view

There are two ways to rotate the 3D view. One is to drag your LMB on the zoom 
button at the upper right of the panel. The other is to drag your LMB while 
pressing Alt and Ctrl keys. Moving your mouse cursor to the right magnifies the 
object, and moving to the left reduces the object.

Perspective and Orthogonal view

Vertex Paint supports both the perspective projection and the orthogonal 
projection to display objects in 3D space. To display the object in perspective 
projection, select Persp from the 3D view info pop-up menu. To display the object 
in orthogonal projection, select Ortho from the 3D view info pop-up menu. You 
might find that you can paint vertices easier with the Ortho mode. Changing the 
camera zoom factor

You can change the camera’s zoom factor when you are in the Persp mode. 
Dragging the mini-slider next to Fov at the top of the panel left or right, zoom 
factor changes. Increasing the value, the camera lens will be a telephoto lens, 
and decreasing the value, it will be more wide-angle.

Changing the view

Click the down-arrow popup at the top of the panel to change the 3D view 
display.

Trimming Weight
Painting Weight
Operation
Strength
Color Scale
Calculating Weight
Scaling Weight
 Viewing Weight 
Statistics
Setting Weight 
Value
Selecting/
Deselecting Points
The Current 
Editable Point
Setting Weight 
Value
Editing the Bank 
Rotation Axis of 
Skelegons
Vertex Paint: 
Creating a Morph 
Target

Vertex Paint: Misc
Import/Export 
Vertex Paint 1.0 file
Loading a Vertex 
Color file (.vcl) into 
Vertex Paint
Saving the Current 
Vertex Color Map to 
a .vcl File
 Preference Panel
BG Color
Wire Color
Checker Color
Vertex Alpha
Texture Resolution
Pixel Blending
Hide Unselected 
Bones
Enable Bone Colors
Mirror Epsilon
Weight Color Scale
Undo Levels
Command / 
Operation
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•Front View - displays the object from the front side.
Back View - displays the object from the back side.
Right View - displays the object from the right side.
Left View - displays the object from the left side.
Top View - displays the object from the top side.
Bottom View - displays the object from the bottom side.
Fit Mode - displays the object at the center of the display.
Fit Bone - displays the selected bone at the center of the display.

Switching the display mode

Vertex Paint can display objects using various display modes depending upon 
your needs. To change, use the pop-up menu at the upper left of the 3D view.

Points - Displays the points that make up the object. The vertex color is 
set for the point color. Light source is not used.
Wireframe - Displays the objects in wireframe. The vertex color is set for 
each vertex of the lines, if the color is different between the start and end 
point of the line, it displays a gradient color. Light source is not used.
Front Face - Displays only polygons with normals facing the camera in 
wireframe. Light source is not used.
Vertex Color - Displays the polygons in color, using the vertex color map 
currently selected. Light source is not used.
Wireframe Color   - Displays the polygons in color using the vertex color 
map currently selected, and also displays wireframe over it. Light source 
is not used.
Lighting Shade - Displays the objects using the light source set on the 
Light menu. The object’s surface information is used for the polygons’ 
color attributes. No vertex color shown.
Weight Value - Displays the weight value assigned to the currently 
selected bone in red gradient. If no bones exi st, it displays in grey.
Weight Ratio - Displays the weight ratio of the vertices for the selected 
bone. Stronger color means more weight. Each bone has its own unique 
color. color. If no bones exist, the object is displayed in grey.

 B Button

Clicking the B button on, switches to the “Blending display mode”. This is a 
blending display using the vertex color alpha in the Vertex Color and the 
Wireframe Color modes. This also enables the translucent display of the texture, 
using its alpha plane.

 T Button

Clicking the T button on, switches to the “Texture display mode”. This is a texture 
mapping display visible in the Vertex Color, Wireframe Color and Lighting Shade 
mode.

Frequently Asked 
Questions
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 Rotating a Bone

When the rotate button next to the bone VMap name on the Weight menu tab is 
showing, you can rotate the bones and see how the object deforms. Each ring 
means: Red=Heading (Y axis), Green=Pitch (X axis), and Blue=Bank (Z axis).

To rotate the bone, drag on the 3D window with LMB while pressing Ctrl key. The 
bone rotates as your mouse goes.

To rotate along only one axis, hold Ctrl and select the ring of the axis you want to 
rotate with LMB, then drag it. Selected ring is shown as a wide-band ring.

To reset the rotated bone at the default (Rest Position), with the Weight Tab 
selected, choose Reset the Bone from the Edit pop-up menu. To reset all the 
bones, choose Reset All Bones.

 Moving a Bone

When the move button next to the bone name on the Weight menu tab is 
showing, you can move the bones and see the deformation. A coordinate axis as 
shown below is displayed for the current bone. Each axis represents: Red=X axis, 
Green=Y axis, and Blue=Z axis.

Clicking the button next to the bone VMap name cycles it through its 
settings (rotate, scale, move).


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To move the bone, hold Ctrl and drag on the 3D window with LMB.

To move along only one axis, hold Ctrl and select the axis you want to move and 
then drag it. The selected axis is shown as a bold line.

 Scaling a Bone

When the zoom button next to the bone name on the Weight menu tab is 
showing, you can scale bones up or down. A coordinate axis as shown below is 
displayed for the current bone. Each axis represents: Red=X axis, Green=Y axis, 
and Blue=Z axis.

Clicking the button next to the bone VMap name cycles it through its 
settings (rotate, scale, move).



Clicking the button next to the bone VMap name cycles it through its 
settings (rotate, scale, move).


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To scale the bone up/down, hold Ctrl and drag on the 3D window with LMB. 
Dragging your mouse up/right scales up the bone, and dragging your mouse to 
down/left scales down the bone.To scale along only one axis, hold Ctrl and select 
the axis you want to scale with LMB then drag it. The selected axis is shown as a 
bold line.

Changing the Mode

Vertex Paint has four working (editing) modes. You can change those modes by 
clicking on the menu tabs at the center-left of the window. Note that the Edit 
pop-up menu will show the different menus depending on what mode you are in.

Color - Vertex color edit mode
Weight - Bone weight edit mode
Light - Light setting mode
Show - Polygons Show/Hide setting mode

Displaying a Morph Target

If the object contains EndoMorph targets, you can choose the displayed target on 
the Morph pop-up menu.
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Vertex Paint: Showing / Hiding Polygons - Selecting / Deselecting Polygons

Select / Deselect Polygons Using Your Mouse

When you are using the + Sel Mode, you can select polygons by dragging your 
LMB over them in the 3D view.

When you are using the - Sel Mode, you can deselect polygons by dragging your 
LMB over them in the 3D view. Dragging with your RMB deselects the polygon 
regardless of what selection mode you are in.

Hold the Ctrl and Shift keys as you drag your LMB to select/unselect using a 
bounding box. Hold the Ctrl and Shift keys as you drag your RMB to select/
unselect using a lasso. You can toggle the Sel Mode by pressing the Space key.
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Left: Bounding box selection. Right: Lasso selection

Show / Hide Polygons By Polygon

Vertex Paint can show/hide polygons either by polygon or by surface. Select By 
Polygon from the Select pop-up menu to manipulate by polygon. There are also 
some selection and hiding functions available in the Edit menu.

Show shows all polygons
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Select selects all polygons

Hide hides selected polygons

Hide UnSel hide unselected polygons

Sel All selects shown polygons

UnSel All unselects shown polygons

 Default Mouse Operations

The following table is a list of the mouse operations. You can customize the 
operation on the Preference panel (File > Preferences).

Operation Command Action

LMB ALT-SHIFT View Move Move the view

LMB ALT View Rotate Rotate the view

LMB CTRL-ALT View Zoom Scale the view

LMB View Tool Move Move the view (using the 
icon)

LMB View Tool Rotate Rotate the view (using the 
icon)

LMB View Tool Zoom Scale the view (using the 
icon)

LMB Color Paint Paint the vertex color (in 
Color mode)

RMB Color Radius Show size of the color paint 
brush (in Color mode)

LMB CTRL-SHIFT Color PickColor Select color from the 3D view 
(in Color mode)

LMB Color Palette Select color from the color 
palette (in Color mode)

LMB Weight Paint Paint bone weight (in Weight 
mode)



LightWave 2020  –  LightWave 2020

Reference –  1583

Operation Command Action

LMB CTRL Bone Navigate Rotate/Move/Scale the bone

LMB SHIFT Bone Select Select the bone

RMB Weight Radius Show size of the weight paint 
brush (in Weight mode)

LMB CTRL-SHIFT Weight Rectangle 
Select

Rectangle selection of the 
point (in Weight / Info mode)

RMB CTRL-SHIFT Weight Lasso Select Lasso selection of the point 
(in Weight / Info mode)

LMB Light Move Move the light source (in 
Light mode)

LMB Show Select Select the polygon (in Show 
mode)

RMB Show UnSel Deselect the polygon (in 
Show mode)

LMB CTRL-SHIFT Show Rect Select Rectangle selection of the 
polygon (in Show mode)

RMB CTRL-SHIFT Show Lasso Select Lasso selection of the 
polygon (in Show mode)

Keyboard Shortcuts

Key Action

A Display object at the center of the window

Shift-A Display current bone at the center of the window

, Zoom out

. Zoom in

Shift-F Display object in Front view

Shift-T Display object in Top view
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Key Action

Shift-S Display object in Right side view

F1 Points Display mode

F2 Wireframe Display mode

F3 Front Face Display mode

F4 Vertex Color Display mode

F5 Wireframe Color Display mode

F6 Lighting Shade Display mode

F7 Weight Value Display mode

F8 Weight Ratio Display mode

U Undo

Down Select next bone

Up Select previous bone

C Copy current bone weight

V Paste to current bone weight

Shift-V Paste to current bone weight symmetrically in X 
axis

X Clear current bone weight

+ Scale up current bone weight

- Scale down current bone weight

R Reset current bone rotation

Shift-R Reset all bone rotation

* Step forward

/ Step backward
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Key Action

T Bone move mode

Y Bone rotation mode

H Bone scale mode

- Hide current polygons

= Hide unselected polygons

| Invert Show/Hide polygons

SPACE Switch polygon select/deselect mode

Show / Hide Polygons By Surface

Select By Surface from the Select pop-up menu to manipulate by surface. You’ll 
also need to select a surface from the Surface pop-up menu.

Show shows polygons of selected surface

Select selects polygons of selected surface

Hide hides polygons of selected surface

Hide UnSel hide unselected polygons

Sel All selects shown polygons

UnSel All unselects shown polygons
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Vertex Paint: Light Setting

Setting the Light Source
Setting light sources on the Light tab determines the number of the lights, color 
properties, position, and other properties used in the “Lighting Shade” display 
mode. At the same time, it is used for the baking shading color with the Burn 
Lighting Colors command in the color mode. You can have up to eight different 
lights

Choosing Light
To choose light, select one from the Name pop-up menu or click the light icon in 
the 3D view with your LMB, if it’s visible.

Clicking on the checkbox next to the Name pop-up menu activates the light and 
affects the calculations of the light source on the scene. Click the checkbox off to 
deactivate the light source. Inactive light sources do not illuminate the scene.

Light Type
In Vertex Paint, you can use distant lights, point lights, and spotlights. You can 
also set the ambient color for the lights, which affects the entire scene. Below is a 
table of the parameters available for each light. These are used for OpenGL’s light
settings. For more information on the parameters, refer to “OpenGL 
Programming Guide”, published by Addison Wesley (ISBN: 0-321-17348-1).

  Distant Light Point Light Spotlight

Diffuse 4 4 4

Ambient 4 4 4

Specular 4 4 4

Position 4 4 4

Spotlight Position 7 7 4

Spotlight Angle 7 7 4

Constant 
Attenuation

7 4 4

Linear Attenuation 7 4 4

Quadratic 
Attenuation

7 4 4

Positioning the Light
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To move a light, click on the Position field on the Light tab and enter the 
coordinates in the dialog that appears. You can also just grab the light in the 3D 
view with your LMB and drag it to wherever you like.

Distant Light
Generally, a distant light is a light source which you only specify the light 
direction. In Vertex Paint, the direction of the distant light is measured as a vector 
from the light Position to the Origin. Moving the light position changes the vector 
direction.

Point Light
A Point light is a light source that has no direction and illuminates 
omnidirectionally (in 360 degrees). In Vertex Paint, the position of the point light 
is specified as the light Position.
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Spotlight
A Spotlight is a light source that has both position and direction information. In 
Vertex Paint, the position of the light is specified as the light Position and a 
coordinate where the spotlight “points” is defined by the Spotlight Position. The 
Spotlight Position is indicated by a red box so you can drag it in the 3D view. Also, 
the dotted lines coming out of the light represent the spotlight cone angle which 
can be changed by adjusting the Spotlight Angle setting.
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Vertex Paint: Vertex Color Paint

Create Vertex Color Map
To use Vertex Paint, you must define at least one vertex color map before you 
begin painting. Note that if an object mesh has more than one vertex color map, 
Vertex Paint uses the first map as the current map.

To create a new Color map, select the Color tab, then choose Edit > Create Vertex 
Color Map. Enter a unique map name and click OK

Rename Vertex Color Map
To rename a vertex color map, select the Color tab and the map, then choose Edit
> Rename Vertex Color Map.
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Enter the new name and click OK. Note that you still need to update the object by 
clicking the Save button next to the Object pop-up menu. 

Delete Vertex Color Map
To delete a vertex color map, select the Color tab and the map, then choose Edit
> Delete Vertex Color Map. The change is reflected when you click the Save 
button next to the Object pop-up menu. 

Vertex Color Map Type
There are two types of vertex color maps. RGBA means that the map includes the 
alpha information and RGB means that the map does not include the alpha 
information. In Vertex Paint, all the vertex color maps are treated as if they 
include the alpha. You can change the color map type by selecting the pop-up 
menu next to the Color Map option on the Color tab. The change is reflected 
when you click the Save button next to the Object pop-up menu.

Component vs. Blending Display
The Vertex Color and Wireframe Color display modes can blend the display of 
vertex color (RGB) and Vertex alpha data. Clicking the B button on changes 
display mode to “alpha-blended.” The Vertex Alpha option on the Preference 
panel determines how to blend the alpha.

If you set the Vertex Alpha option to Surface Color, information on the vertex 
color’s alpha is displayed as a blended percentage value of the vertex color and 
surface color - the same way LightWave handles vertex color alpha.

Color.Red = Vertex.Red * Vertex.Alpha + Surface.Red * (1.0 - 
Vertex.Alpha)Color.Green = Vertex.Green * Vertex.Alpha + Surface.Green * (1.0 - 
Vertex.Alpha)Color.Blue = Vertex.Blue * Vertex.Alpha + Surface.Blue * (1.0 - 
Vertex.Alpha)

If you set the Vertex Alpha option to Opacity, information on the vertex color’s 
alpha is displayed as an opacity value. If the alpha value is 1.0, the vertex color 
would be completely opaque. If the alpha value is 0.0, then the vertex color 
would be completely transparent.
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A component display mode using 
RGB painting. Only the vertex color 
is displayed.

A component display mode using Alpha 
painting mode. Only the Alpha 
luminosity is displayed.

A blended display mode choosing 
Surface Color for the Vertex Alpha 
option. Both vertex color and 
surface color is displayed.

A blended display mode choosing 
Opacity for the Vertex Alpha option. 
Vertices with an alpha value less than 
1.0 are semi-transparent.

Vertex Color Painting
Vertex Paint has three painting modes to paint the vertex color using a brush.

Color / Paint - Paint per point
Color / Index - Paint per vertex index of polygon
Color / Polygon - Paint per polygon

To begin painting, select a vertex color map on the Color Map pop-up menu or 
create a new vertex color map. Dragging your LMB on the 3D view paints points 
or polygons.

Selecting Operation Mode
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There are three operating modes that determine how paint is applied to existing 
vertex colors.

ADD - adds the value of the paint color to existing color.
SUB - subtracts the value of the paint color from existing color.
REP - replaces the value of existing color with the value of the paint color.
ERA - sets the value of existing color to 0.

Selecting Component
You have two components for painting vertex color: RGB and Alpha. To switch, 
click on the color component icon.

 RGB
 Alpha

 

Selecting Paint Color
There are two way to choose the paint color: the color slider bar and color 
palette.The color slider bar has RGB and HSV modes. You can switch modes 
depending on your needs. The current RGB color is shown on the swatch to the 
right of the eye dropper icon. The current Alpha is shown on the swatch to the 
right of the color swatch. Although Vertex Paint internally maintains color using 
floating values (i.e., 0.0 to 1.0), numerical color values are rounded to the nearest 
integral value from 0 to 255.

You can choose a color directly by dragging your LMB over the palette, a color is 
selected when you release your mouse button. To choose an Alpha value, use the 
slider instead of the palette. You can customise the palette, which is discussed 
later.

You can also pick any color displayed on the 3D view. Hold the Ctrl and Shift
keys, then click on the desired color in the 3D view. Another way to pick a color 
on the 3D view is to activate the eyedropper icon and drag on the 3D view with 
your LMB.
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You can use the default LightWave color picker to pick a color as well. Clicking on 
the color swatch with your LMB will launch it.

Painting Vertex Colors on Points

If you choose Color / Point for the Paint mode, you can paint vertex color on 
points, using three parameters: Brush Size, Front, and Strength.

Brush Size - Determines the size of your paint brush. You can visually see 
the brush size when you drag and paint on the 3D view with your LMB . To 
adjust your brush size, enter a value in the Brush Size input field. You can 
also adjust the size by dragging your RMB in the 3D view. Release your 
mouse button to accept the new size.

Front - Use this option when you do not want to paint points on the 
opposite side.

Brush Shape - You can paint with a round or square brush by clicking on 
the icon to the right of the Brush Size slider.

Strength - Strength allows you to paint as if you were using a soft brush. If 
Strength is set to 100%, all painted vertices get the same value. If Strength 
is set to 0%, the effect of the brush is 100% at its very center, but 0% at its 
edge. Areas of the brush between the center and edge use a proportionate 
value.
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Top: Strength=25%, Bottom:Strength=100%

Painting Polygon Vertex Indices

If you choose Color / Index for the Paint mode, you can paint the “vertex index” of 
polygons. The vertex index is a unique reference for each polygon vertex. 
Although a point may be shared by polygons, the vertex index is different. Just 
click inside the polygon nearest the vertex you want to affect. Brush Size, Front, 
and Strength settings are ignored.

Painting Vertex Color per Polygon
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If you choose Color / Polygon as the Paint mode, you can paint individual 
polygons a solid color.

Brush Size, Front and Strength settings are ignored. This essentially sets all of the 
polygon’s vertex indices to the same value.

Painting Symmetrically along the X Axis

Clicking the symmetry button at the top of the interface lets you to paint 
symmetrically along the X Axis. If you paint geometry on one side (left or right), all 
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the polygons and points symmetrical along the X axis is painted at the same time. 
This option can be used with any paint mode.

 

Customising the Color Palette
You can customise your color palette for Vertex Paint by choosing Edit > 
Customize Color Palette. There are four palettes available: 16, 64, 256, and 
Gradient, the default. Activating the Clear Colors option erases all existing palette 
information, resetting the colors to black (0,0,0).

Customized palette information is stored in the preference file. It maintains the 
information until another palette is loaded or the palette is reset.

Palette Size = 16

Palette Size = 64

Palette Size = 256

Gradient
To add a color to a swatch in a (non-gradient) palette, first select a swatch with 
your mouse. Then, adjust the current RGB color values. Finally, click the set 
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button below the palette. The RGB color will be added to the selected palette 
swatch.

Loading a Color Palette
To load a color palette, with the Color tab selected, choose Edit > Load Color 
Palette File. Then select a previously saved palette file. The following four 
formats are supported:8-bit BMP, 8-bit TARGA, Microsoft Palette® (.pal), and ACT 
color table (.act).

Saving a Color Palette
To save a color palette, with the Color tab selected, choose Edit > Save Color 
Palette File. The file is saved in Microsoft Palette® format (.pal).

Baking OpenGL Shading)
With Vertex Paint, you can “bake” OpenGL color information (including light 
source calculation) to a vertex color map. You can see the shading status to be 
baked using the Lighting Shade display mode. Adjust the light strength, location 
and other settings on the Light tab before baking.

To bake the colors, first create a vertex color map, then with the Color tab 
selected, choose Edit > Burn Shading Colors.

You have to set your view so that the entire object is visible in the 3D 
view. If not, the part outside the view will be omitted from the color 
calculations, or an error will occur.


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The Lighting Shade display mode. The light source is calculated.

The Wireframe Color display mode, displaying vertex color that was baked by the 
Burn Shading Colors command.

Reset to Surface Color
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Executing “Reset To Surface Colors” from the “Edit” menu resets vertex color to 
surface color.

Adjusting Vertex
Vertex Paint has several tools for adjusting vertex colors baked by Burn Shading 
Colors or the Shader Baker layout plugin. 

Adjusting Brightness and Contrast
With the Color tab selected, choosing Edit > Brightness/Contrast displays the 
following dialog box, where you can adjust brightness and contrast.

When you move the sliders, the change in brightness or contrast is previewd on 
the display in realtime. However, the change is not saved until you click the Apply 
button.

Adjusting Balance
With the Color tab selected, choosing Edit > Color Balance displays the following 
dialog box, where you can adjust each RGB component separately.

 

Adjusting Hue, Saturation and Value
With the Color tab selected, choosing Edit > Hue/Saturation displays the 
following dialog box, where you can adjust hue, saturation and value.
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1.

2.

3.

Vertex Paint: Bone Weight Paint

Choosing Bones
There are three ways to select the current bone, which becomes highlighted in 
yellow:

With the Weight tab selected, select the bone name from the Bone pop-up 
menu.
Press the Up or Down cursor key to choose the next or previous bone until 
you get the desired one.
Hold the Shift key and click the desired bone with your LMB directly in the 
3D view.

It may be difficult to choose a bone in the 3D view when it is inside the mesh. In 
such cases, disable Hide Unselected Bones on the Preferences panel. This shows 
the unselected bones outside the object so they are easily selected.

Disabling “Hide Unselected Bones” shows the bones
Also, you can work with bones easier when they are centered in the 3D view. To 
do this, just press the A key or select Fit Bone from the pop-up menu (small 
button with down arrowhead) along the top of the main interface.

 Displaying Weight
There are two display modes for bone weight: Weight Value and Weight Ratio.
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Weight Value display mode
Weight Value displays the value of the weight map that belongs to the current 
bone using a red gradient. Areas displayed in grey have no weight, or are just 
slightly weighted. This mode is useful when you are painting the weight. You can 
adjust the density of color using the Color Scale option on the Paint tab.

You can also set the default value for Color Scale with the Weight Color Scale 
setting on the Preference panel.
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Weight Ratio display mode
Weight Ratio is a mode that displays the ratio of bones’ influence on each point. 
Red, blue and green are preset for each bone; however, you can reset the colors 
using the color icon next to the Bone name pop-up menu.

“Bone Color” icon

 

Renaming Bones
To rename bones, choose Edit > Rename Bone with the Weight tab selected. A 
bone tree, like the one shown below appears. Select the bone you want to 
rename with your LMB and enter a name in the New Bone Name field. You can 
also rename the weight map name (New VMap Name field) at the same time.

The bones are displayed in a hierarchical order. Bone visible in the 3D view will be 
updated in real time. Also, the bone selected here becomes the current bone.
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Renaming Weight Maps
To rename a weight map, enter new name in VMap field. Don’t forget to save your 
changes.

You might see the following dialog box when you try to rename a VMap. This box 
appears when one weight VMap is already used (shared) by one or more other 
bones. If you click Yes, all of the VMap names used for the bones that refer to this 
VMap will be renamed. If you click No, only the VMap which the current bone 
refers to will be renamed - if no such VMap already exists, a new one will be 
created.
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This panel shows that three bones share one name “Bone01.” So if you click Yes, 
all three bones that referred to VMap “Bone01” will refer to newly renamed 
VMaps.

Copying Weight
You can copy a value of the weight map that belongs to the current bone to the 
Vertex Paint clipboard buffer. Press the C key or choose Edit > Copy. No message 
will be shown.

Pasting Weight
You can paste the copied weight value from the clipboard buffer to another 
bone’s weight map. Press the V key or choose Edit > Paste.

Pasting Weight Symmetrically in X Axis
You can paste the copied weight value from the clipboard buffer to another 
bone’s weight map along the X axis symmetrically. Press the V key or choose Edit
> Paste-X. The point located symmetrical along the X axis is found and weight 
map value is set.

You can specify the amount of “calculation error” when finding the symmetrical 
point with the Mirror Epsilon setting on the Preference panel.

Pasting Weight Symmetrically Along an Arbitrary Axis
You can paste the copied weight value from the clipboard buffer to another 
bone’s weight map symmetrically along an arbitrary axis. Choose Edit > Paste-
Axis to display the panel shown below. Select the desired Axis and offset Position. 
Then click OK.

Axis
Specifies the axis which the weight is to be pasted symmetrically. If you choose X, 
all of the points that meet the condition “X’ = -X” is looked up.

PositionSpecifies the origin position. If you selected the X Axis and then set 
Position to 1m, all of the points that meet the condition “X’ = -X + 2m” is looked 
up. OperationSpecifies how the weight will be pasted to the points. REP replaces 
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the whole original weight value with the new value. OVR overwrites part of the 
original value only if the new value is bigger than the original ones.
Using the OVR option allows you to paste the map symmetrically onto the same 
weight VMap. To do this, copy the weight and then paste it to the same weight 
VMap using the OVR option, you can create a weight map symmetrical to itself.

Normalising Weights
Sometimes you may get excessive weight values from using the BoneWeight 
Modeler command or just from painting in Vertex Paint. Weight values go beyond 
the normal range 0.0 to 1.0. Bone deformation can deform without “normalising” 
the weight because it is performed relatively, that is, using the percentage of the 
weight. However, in some cases (such as adjusting the weight by painting), you 
may want to normalize the weight to give you better control. Choose Edit > 
Normalize to normalize the weight values between 0.0 and 1.0, according to their 
percentages.

A weight map that is not normalised
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A weight map that is normalised

Trimming Weight
Bones inside “branching-type” geometry, like fingers, can be problematic when 
the weight map is created using a falloff calculation without any correction. Bone 
deformation will likely affect areas you wish to be independent. This is because 
the falloff calculation is performed referring to only the distance between a bone 
and a point.

The Edit > Trim Branch function solves the problem by allowing you to trim the 
weight for the current weight map. It first calculates the “primary bone” for each 
point (i.e., the bone closest to the point). If the bone is not a descendant of the 
current bone, the weight map value that the point holds is cleared. “A 
descendant” is a “bone route path” generated from one parent.

If you use this command where the bone route path branches, like at 
the base of a finger, it may not deform smoothly. As such, try to use this 
command where there is not bone branching. Also, trimming may not 
work well depending on the bone location. If you encounter this 
problem, try using the ERA or SUB painting operations to adjust the 
weight value.


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Before using Trim Branch. If you bend the finger using the highlighted bone, 
neighbouring fingers will also bend because they have bone weight.
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After using Trim Branch. Unnecessary weight for the points on neighbouring 
fingers have been erased. You can now bend the finger independently.
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Bones on the red line represent a descendant of the current bone, and bones on 
the blue line represents the other descendants.

Painting Weight
Select the Paint subtab on the Weight tab to “paint weight.” There are some 
adjustable parameters that will determine how the effect is applied. Dragging in 
the 3D view with your LMB paints the points under your mouse pointer.

The Brush Size and the Front settings are shared with the vertex color painting 
operations.
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Operation
Specify how the point weight is applied:

ADD - This mode adds the Value to the painted target weight. Note that 
the operation is only applied once while you press the mouse button, start 
dragging, and then release the button.
SUB - This mode subtracts the Value from the painted target weight. Note 
that the operation is only applied once while you press the mouse button, 
start dragging, and then release the button.
REP - This mode replaces the painted target weight with the Value.
ERA - This mode sets the painted target weight to 0.0.
OVR - This mode replaces the weight only if the Value setting is larger than 
the painted target weight value.
Value - This specifies the weight value that you are going to paint. A value 
of 100% is internally converted to 1.0 as a weight value. When you activate 
the picker button, you can refer to the weight value in the 3D view. 
Dragging your LMB refers to a weight value of the point that is closest to 
your mouse pointer.

Strength
Strength sets the point from the center of the brush where the paint falls off. If 
Strength is 100%, points inside the brush are all painted with a the full Value. If 
Strength is 0%, the center of the brush is painted with 100% of strength, and the 
value decreases relatively from from the center to the outer edge of the brush. If 
Strength is 50%, points within half the radius receive the full Value, then it falls 
off toward the edge of the brush.

Strength = 100%. All the point inside the brush is painted with the same value.
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Strength = 50%. Points inside half the radius are painted with 100% of the Value, 
then decreases relative to the distance from the center.

Strength = 0%. The paint strength decreases relative to the distance from the 
center of the brush.

Color Scale
This adjusts the strength of red gradient color in the Weight Value display mode. 
This is only a display setting, so changing this value does not affect the actual 
weight value.

Calculating Weight
To calculate weight using a falloff, select the Calc subtab on the Weight tab. 
Basically, this function works the same as the Modeler plugin Bone Weight. Note 
that any weight calculations will be normalized.
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Falloff specifies how the weight value is calculated. Linear sets the bone weight 
closest to the point to 1.0. Other weight is set to 0.0. Distance uses the inverse of 
the distance from point to bone as weight value. Other options (e.g., Distance ^ 
32) use the distance raised to a specific power. Higher powers cause a quicker 
falloff.

Calculate Weights executes the calculation based on the settings you have 
chosen.

Scaling Weight
To scale weight values, select the Scale subtab on the Weight tab.

The Scale setting specifies how the weight values are scaled.

Whole Scales all weight value uniformly

At Start 
Joint

Scales values using the bone’s starting point (the fat end) as 
the center
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At End 
Joint

Scales values using the bone’s ending point (the sharp end) as 
the center.

Click the + button to scale up the weight values using the value set in the input 
field next to the button. You can also scale it up by pressing the “+” key. Click the 
- button to scale down the weight value using the value set in the input field next 
to the button. You can also scale it down by pressing the “-” key.

 

Whole

Scales all weight value uniformly.

At Start Joint
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Scales values using the bone’s starting point (the fat end) as the center.

At End Joint

Scales values using the bone’s ending point (the sharp end) as the center.

Left: A weight map scaled up from the bone’s starting point. Right: A weight map 
scaled up from the bone’s ending point

Clamping WeightTo clamp the weight, select the Clamp subtab on the Weight
tab. When you deform single-mesh objects using bones, the more bones you 
have, the slower the calculation speed. By discarding the weight value for bones 
that have little influence, the calculation speed will be improved. This can be one 
of the most important factors in single-mesh realtime animations.

The N of Matrix setting corresponds to the number of bones that are sorted by 
their strength of influence. Let’s say you have a mesh with twenty bones. If you 
set N of Matrix to 5 and then press Clamp, up to the top five strongest weight 
values of the bones (for each bone) are retained. The other values (that is, values 
of the bones with weak influence) are set to 0.0.

 Viewing Weight Statistics
Use the Weight Statistics tab to select weighted points based on a value. These 
can be removed from the map to increase efficiency. To view weight statistics, 
select the Stat subtab on the Weight tab.

The Threshold setting specifies the threshold for selecting points. The buttons to 
the right of the input field represent the units. Value means the actual weight 
value. Ratio means a normalized range from 0.0 to 1.0.

Clicking the Select button will highlight in yellow the points which have a weight 
value less than the Threshold. To deselect, click the DeSelect button.
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The Select 0 Weight Points button detects zero-weighted points.The Discard 
Selected button removes the map from the selected points.

Setting Weight Value
To set the weight value for individual points, select the Info subtab on the Weight 
tab.

Selecting/Deselecting Points
By default, no points are selected. There are several ways to select points to edit.

To select all points - Click the Sel All button to select all points. Press the 
UnSel All button to deselect all points.
To use your mouse pointer - Drag your LMB in the 3D view to select points.
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To select using a bounding box - Hold the Ctrl and Shift keys and drag a 
bounding box with your LMB in the 3D view. Points included in this 
bounding box are selected when you release your mouse button.

To select using lasso - Hold the Ctrl and Shift keys and drag your RMB in 
the 3D view. Points within the lassoed area are selected when you release 
your mouse button.

You can use the Sel Mode setting to switch between Select ( + ) and 
Deselect ( - ) modes. You can also switch modes by hitting the Space key.

Clicking the UnSelect button deselects the current editable point (pink square). 

The Current Editable Point
Selected points are shown as a yellow point, and the current editable point is 
surrounded by a small pink square.
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The value of the current editable point is displayed in the Value field. You can 
change the weight value by dragging the slider or entering a value directly. You 
can cycling through all of the selected points, to change the current editable 
point, by clicking the Prev and Next buttons. The number of points selected and 
the (reference) number for the current editable point is displayed in the 
information display field at the bottom.

Setting Weight Value
To specify the weight value for all selected points, enter a number in the Value 
field and click the Set All button. 

Editing the Bank Rotation Axis of Skelegons
Skelegons generated in Modeler have vector information for the bank rotation 
axis that refers to the upward direction. This determines the bank rotation angle 
of the bone when converted in Layout. To adjust the bank rotation axis in Vertex 
Paint, activate the Bank Rotation Axis Edit option. (Note: Vertex Paint will reset all 
skelegons to their rest position before allowing you to edit the bank rotation.)
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Hold the Ctrl key and drag your LMB in the 3D view. A thick blue ring represents 
the bank rotation. The arrow represents the “upward direction” of the skelegon.

This editing option is only available for Modeler’s skelegons. You cannot use this 
option on the bones loaded by Vertex Loader.

If you want the bank rotation axis to align to a specified axis precisely, press the N
key. The bank rotation axis will correspond to the axis you chose.

Vertex Paint: Creating a Morph Target
To create a new morph target, choose (new) from the Morph pop-up menu on the 
main panel. A dialog will appear where you indicate the Name and Type of morph 
target.
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If you enter a new name when creating a morph target, geometry with bone 
deformation (from rotation, move, and scale) in the 3D view is created. Deformed 
geometry created using the preview animation function can also be used.

Vertex Paint: Misc

Import/Export Vertex Paint 1.0 file
The Import… and Export… items on the File menu can be used to import/export 
the Vertex Paint 1.0 format of the vertex color file (.vcl). (Vertex Paint 1.0 came 
with LightWave 5.6)

Loading a Vertex Color file (.vcl) into Vertex Paint
You must first load the LightWave 5.6 format LWO file into Modeler before loading 
the vertex color file (.vcl). Then start Vertex Paint. Create a new vertex color map 
by choosing Edit > Create Vertex Color Map and then choose File > Import…. 
Select a .vcl file associated with the loaded lwo file on the file dialog.

Saving the Current Vertex Color Map to a .vcl File
Select the vertex color map you want to save and choose File > Export…. Enter a 
name in the file dialog and click Save.

 Preference Panel
You can define some default setting on the Preferences panel (File > Preferences). 
Note that some changes will not take effect until the next time you launch Vertex 
Paint.
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BG Color
BG Color specifies the background color. Clicking on the color box with your LMB
displays the standard LightWave color picker. The change is applied when you 
close the Preferences panel. (Note: If your display does not update, try clicking in 
the 3D window.)

Wire Color
Wire Color specifies the wireframe line color. Clicking on the color box with your 
LMB displays the standard LightWave color picker. This setting affects the 
Wireframe Color, Weight Value,and Weight Ratio display modes. The change is 
applied when you close the Preferences panel. (Note: If your display does not 
update, try clicking in the 3D window.)

Checker Color
The two Checker Color boxes specifies the colors used for the checker pattern 
that makes up the background in the blending display mode. Clicking either of 
the color boxes displays the standard LightWave color picker.

Vertex Alpha
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Vertex Alpha determines how the vertex color’s alpha information is displayed in 
the Vertex Color and Wireframe Color display modes. If you select Surface Color, 
information on the vertex color’s alpha is treated as a value of blended 
percentage of vertex color and surface color. If you select Opacity, information on 
the vertex color’s alpha is displayed as a value of opacity.

Texture Resolution
Texture Resolution determines the texture resolution displayed in the Vertex 
Color, Wireframe Color and Lighting Shade display modes.

Pixel Blending
If Pixel Blending is active, both texture color and vertex color (or surface color) 
are displayed together. If Pixel Blending is inactive, texture color overrides the 
vertex color and Vertex Paint only displays texture color.

Hide Unselected Bones
Hide Unselected Bones specifies the display mode for unselected bones. If this 
option is active, unselected bones hide behind the objects. If this option is 
inactive, unselected bones are shown in front of the object so that you can grab 
and control them more easily.

Enable Bone Colors
If Enable Bone Colors is active, bone geometry is displayed using the Weight 
Ratio color.

Mirror Epsilon
Mirror Epsilon determines the accuracy used when Vertex Paint searches the axis-
symmetry point for the Symmetry mode, and the Paste-X and Paste-Axis options. 
The smaller value you set, the more precise the symmetry point are searched.

Weight Color Scale
Weight Color Scale determines the default value of the color scale used for the 
Weight Value display mode.

Undo Levels
Undo Levels specifies the maximum number of undos in the Color and the Weight 
display modes. Higher values require more memory.

Command / Operation
Select desired setting from those pop-up menu when you want to customise the 
default mouse operations. Assign each Operation setting to each Command 
setting.

Frequently Asked Questions
Q. Does Vertex Paint work with SubPatch objects? A. Yes. A SubPatch mesh is 
displayed as a polygon mesh. Vertex Paint can edit the required VMAP 
information. The original SubPatch information is maintained after it is modified.

Q. I cannot paint vertex colors. A. One or more vertex color maps are required to 
paint vertex colors. To create one, with the Color tab selected, choose Edit > 
Create Vertex Color Map.
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Q. An error “Unable to burn render colors.” occurs when I try to bake vertex 
colors. A. The Burn Shading Colors command uses OpenGL functions to acquire 
the color that is currently displayed. Therefore, Vertex Paint will not work 
properly if there is anything covering the 3D view or the object is outside the 3D 
view. Put the object inside the view and try again.

Q. I created a vertex color map but the vertex color is not displayed in Modeler. A. 
You have to assign the vertex color map to a surface. To do this, specify the map 
for the Vertex Color Map setting on the Surface Editor’s Advanced tab.

Q. Does Vertex Paint work with Layout in real time via the HUB? A. Clicking Vertex 
Paint’s Save button overwrites modified weight value and/or vertex color in 
Modeler. The changes should be reflected on the object in Layout after saving. 
(Note: Conversely, Vertex Paint does not acquire surface properties changed in 
Layout.)

Q. Can I utilise information such as vertex color for game development? A. You 
can access information, such as vertex color, by using the LightWave 8.0 plugin 
SDK. Other information, such as UV map and bone weight, can be acquired from 
both Modeler and Layout.You also can download Object Library 2 from DStorm to 
convert vertex color information stored in a LWO file. This could be used for 
something like in-house tool development.
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Poly Map

This subgroup contains Polygon texturing tools.

Adjust Polygon Map

This button will allow you to adjust your old Per-Polygon Maps, or to treat new UV Maps as if they were Poly Maps, and 
adjust them.

How do I use this tool?

Select the polygons that use the Poly Map, and click on the command to open a dialog, which lets you adjust them in 
several ways. It will also let you treat normal UV Maps as if they were Poly Maps, although it’s better to use the newer 
tools. To do that, select the polygons, and enter the map’s name in the Vertex Map field. (If you are editing real Poly 
Maps, leave that field blank.) This tool will not work on unselected polys.

Reverse Order and Shift Order adjust the connection between texture points and the polygon’s vertices. Checking 
Transform Texture will enable the Rotation Angle, Scale U and Scale V fields.

They all allow you to perform 2D transformations of the UV coordinates. The power of these operations is limited in 
comparison to the tools available for editing VMaps.

If you want to use those tools on your Poly Maps, simply use the Unweld command (Detail > Points > Unweld). This will 
put points on all the polys, and remove Per-polygon UV Mapping. At that point, you can use all the Modify tools, as you 
normally would. If your models are simple enough, you can Unweld selected points; if not, you can effectively unweld 
the entire model. Just be sure not to move anything in X,Y,Z space, and the Merge command (M) will put it all back 
together again when you’re finished mapping.

Clear Polygon Map

This button will clear the per-polygon UVs from their polygons. Just select them, and click. All the textures will simply 
vanish.

On the other hand, if you want to translate the old mapping into the new discontinuous UV Maps, then you’ll want to 
use the Poly Map to UVs button (Map > Texture > Poly Map to UVs), and do that instead.

How do I use this tool?

Just select the polygons you wish to clear, and click. No more maps.
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Lock UVs to Polygon

This button is used to assign the old per-polygon maps to the polygons. Unless you intend to use the older style maps, 
you really don’t need to use this.
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Morph

This group contains tools for manipulating LightWave’s endomorphs.

What is an Endomorph?

Sometimes, when you are changing the shape of your objects in Layout, you’ll find that the deformations you can get 
with bones just aren’t accurate enough. Fortunately, you can also force an object to change its shape into the shape of 
another object. This is called morphing. Morphing gives you total control, since you can manually place all the points 
exactly where you want them.

You can use morphing to help create character facial expressions, to make a flower bloom, to transform a boat into a 
car, and then into a rocket; anything you want to do, as long as both objects have the same point count and order.

The different states, or poses, of a morph are generally referred to as morph targets. They are made using morph maps, 
which are a form of Vertex Maps that define the different positions for the points. The original state of the object is 
known as the Base. The map is known as an Endomorph, and is incorporated right into the Object file, like any other 
VMap. If you copy and paste the object, all its morphs are copied and pasted right along with it.

When you make a morph, you can push and pull the points around, and place them anywhere you like. However, 
although it’s possible to add or subtract geometry within a morph, it’s strongly recommended that you refrain from 
doing so, and make all such modifications to the Base object instead. Otherwise, you can end up with incorrect point 
orders.

New Endomorph

Bkg to Morph

Apply Morph

Create Joint Morph
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New Endomorph

This command allows you to create a new Endomorph, or Morph Target.

How do I use this tool?

When you click on the command, a dialog box will open that’s not unlike the dialog you get when you click on W in the 
VMap Bar and choose (new) from the drop down menu.

Name

Enter a name for your new morph in the Name field, or choose an existing name from the drop down menu. The menu 
contains all the names of all the Morph Maps used during the current session, whether or not the objects remain open, 
and whether or not the maps have any points assigned to them.

It’s suggested that you name your morph using the group.pose format; like Eyes.Open or Mouth.Smile. That will cause 
the morph to appear on the same tab with all the other poses in that group when you use Morph Mixer in Layout.

Type

Choose the Type for the new morph. Relative targets record point displacement relative to the base object, so they are 
affected when the base object moves. Absolute targets are not affected by positional changes to the base object, 
although they do reflect changes to the number of points in the object.

Click OK to create the new Endomorph, and start to move the points around. (If you don’t, and you change the map 
shown in the VMap Bar, the new Endomorph will vanish. )
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Bkg to Morph

This command allows you to turn a background layer into a new Endomorph.

How do I use this tool?

Assuming that the background layer has the same number of points and point order as the foreground layer, you click 
the button to open the dialog.

Enter a name for your new morph in the EndoMorph Name field, or choose an existing name from the drop down menu. 
The menu contains all the names of all the Morph Maps used during the current session, whether or not the objects 
remain open, and whether or not the maps have any points assigned to them. If you choose the name of an existing 
morph for this object, the new one will replace the old one, which is similar to overwriting any other kind of file.

It’s suggested that you name your morph using the group.pose format; like Eyes.Open or Mouth.Smile. That will cause 
the morph to appear on the same tab with all the other poses in that group when you use Morph Mixer in Layout.

Tap Enter or click OK, and you’ll have another morph!

This tool is best used for changes made to the base geometry in other places; for instance, when you have saved an 
object with deformations using Save Transformed Object in Layout (File > Save > Save Transformed Object.). It can also 
be useful when you need to see the object while making the morph. Simply copy the object into a new layer, make the 
changes, then use this command to create the morph. (Don’t worry about any other morphs on the copy, they won’t 
affect the final outcome.)
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Apply Morph

This command allows you to add a specified percentage of a morph to any other morph target or to the Base object.

How do I use this tool?

Choose the morph target you would like to modify from the VMap Bar, or create a new one, and click the command. A 
dialog box will open.

Choose the morph you want to copy from the drop down list. The list contains all the names of all the Morph Maps used 
during the current session, whether or not the objects remain open, and whether or not the maps have any points 
assigned to them. (But you won’t get anything if you don’t choose a valid morph, of course.)

You can decide how much to blend the morph with the geometry that’s already there by entering a percentage in the 
Strength field.

Be aware that if you choose to apply a morph to the Base object, that displacement will appear in all the morphs 
associated with that base, including the one you used to change it.

You can also use this command to increase a morph by applying it to itself.
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Create Joint Morph

This tool moves the mesh as if you were rotating Skelegons, but without actually moving them at all. This allows you to 
easily make an Endomorph that you can use to smooth mesh deformation as you animate. (Morphing is another way to 
move your objects, by forcing them to conform to a different shape. The point placement for that shape is stored in a 
Vertex Map, called an Endomorph.)

This is something you will want to do after you already have your figure’s geometry, Skelegons and Weight Maps in 
place.

Begin by creating an Endomorph. You can either do this by using the M button in the VMap Bar and choosing (new), or 
by clicking on the Map > Endomorph: New Endomorph button. In either case, a dialog will appear that allows you to 
name the new morph. It’s recommended that you give it a name that will allow you to easily identify it in Layout. 
Something like LeftArm.M_90 is good; that will put the morph into the LeftArm group, and identify it as the morph that 
makes a bend of 90° look good.

Once you have the morph created, you’re ready to move the mesh. (It’s a good idea to open the Numeric Panel for the 
next steps.)

Click the CreateJointMorph command. If you have a Skelegon selected, you’ll see an active panel. If you don’t, then 
simply select a Skelegon.

You need to start in Before… Mode, so make sure that button is the one that’s highlighted.

Select the bone you want to work with from the Bone drop down menu, if it’s not already selected.

The Weight Map that is used by the bone will automatically show in the Weight Map field. (The field is for informational 
purposes only; you cannot change it.)
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When you do this, you will notice that cyan rotation handles have appeared at the joint. They are labelled H, P and B, for 
Heading, Pitch and Bank. (Heading is rotation around the Y axis, Pitch is rotation around the X axis, and Bank is rotation 
around the Z axis. These terms should be familiar to you from Layout.)

You can move the arm by dragging these handles, or you can enter the values you want directly into the Rotation 
Heading, Rotation Pitch, and Rotation Bank fields in the Numeric Panel.
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Adjust the joint by the desired amount and direction. For instance, in our example, bend the arm so the pitch is 90°. As 
you do, you will notice two things. First, there are the usual problems that occur in the elbow area . Secondly, although 
the mesh has moved, the Skelegon has not!

Drop the CreateJointMorph tool, either by tapping the spacebar, or simply getting the first of the Modify tools you plan 
to use for the Endomorph.

Go ahead and manipulate the mesh, reworking the area until the elbow looks more like a bent elbow, and less like a 
piece of folded foam rubber. (You can even make the bicep bulge, if you are so inclined.)
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When you are pleased with the results, click on CreateJointMorph again. Select the same bone, but this time, bend it by 
the same amount in the opposite direction. In our example, that would be a pitch of -90°. The arm will now be in the 
same orientation that it was when you started.

It’s often easier to select the points in the crease if you flip back and forth between the Base and the 
Endomorph. Any points you select in the base will remain selected in the Endomorph. (But move at least one 
point before you switch, or LightWave will think you didn’t want the morph, and it will vanish.) It’s probably a 
good idea to hide the Skelegons, so you don’t accidently move one of the points on them. (Select them in the 
Polygon Statistics and tap the - key to hide them.) You might want to hide everything else, too, except the arm 
you’re working on. When you are finished, show everything that’s been hidden by tapping the \ key.


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Click the After Edit button; you will probably see a bulge where you worked on the joint; but that’s alright. The Joint 
Morph is finished, and ready to take into Layout. Drop the tool, and save the object.
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UV
Click here to expand Table of Contents...

What are UV Maps?
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UVs and Projection
Discontinuous UVs
Unweld Command
Merge and Weld Commands
Free Move
Display Styles
UVs Outside the Box

UDIM
UDIM Workflow

What are UV Maps?

Sometimes, when mapping textures onto objects, you will find that the normal projection mapping just doesn’t work. 
This usually happens when the object is organic, or irregular in shape. For those occasions, there’s UV Mapping.

UV Mapping adds two extra coordinates to the points in your object; those on the U and V axis, running horizontally and 
vertically through a flat plane on which you can paint your texture. Since the coordinates are assigned to points, it’s 
essentially as if that painted texture was fixed to the surface of the object, with pins where all the points are. No matter 
how irregular your object is, or how it moves or flexes, those pins stay in place, and the texture stays right where you put 
it.

Technically, it’s not as accurate as projection mapping, because the texture is really only exact at those points, and 
merely interpolated everywhere else, but artistically, it works.

The trick is to make the map first. LightWave has the tools for that.

UV Texture Maps

Sometimes, standard image mapping tools (i.e., planar, cylindrical, and spherical mapping) may be somewhat limiting 
where the surface is irregular in shape. These techniques usually work well only where you can globally map the entire 
texture image using a linear interpolation along two axes. The object geometry essentially has no influence on how the 
texture is applied.

However, what if you could assign areas of a texture image to points on the surface, essentially tacking it down at key 
points? Well, you can with UV mapping in Modeler. Between the tacks, the image is stretched smoothly.The U and V 
refer to texture map coordinates and are really not much different than the XYZ coordinates you are familiar with. In 
fact, UV mapping is the process of setting up a relationship between the two dimensions of an image, U and V, with the 
three dimensions of an object surface, XYZ.


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UV Map on the LightWave 10 Creature Kit Mutant character by Luis Santos. Note the selected polygons in both views.

Once this relationship is set up, changing any parameter (i.e., U, V, X, Y, or Z) will also relatively change the appearance 
of the texture mapping. With UV mapping, the object provides additional information for texture mapping, which can be 
different for any given point on the surface. The texture is more or less stuck to points on the surface using a 
relationship that you define.

UVs and Projection

UVs have to come from somewhere. For existing polygonal models, the choices are limited to setting the UV coordinates 
for each point in the object manually, or applying some projection, which automatically generates the 2D texture 
coordinates from the given 3D point positions. In LightWave, you can create UVs by using projections, which also 
happen to be the same as the standard projections for texture mapping (i.e., planar, cylindrical, and spherical).

Usually, the projection for the UV map is not perfect for the model everywhere. The projected UV map must be tweaked 
- eyes and nostrils moved over the right parts of a face, or texture features matched to geometry features.

For illustration purposes, let’s say you had your texture image printed on a piece of very flexible rubber and wanted to 
fit it on a toy car made of wood. You could conform the rubber material to contours of the car by tacking it down with 
thumbtacks. That is more or less what UV mapping does. However, it is a little bit reversed: what you do is tack the UV 
points down onto the image.

Keep in mind that standard projection mapping is more accurate because it has some exact, continuous value 
over the entire surface. UV mapping, on the other hand, is technically accurate only at small sample points. 
The surface is interpolated for the large areas in between the sample points. Adjusting the sample points so 
that the interpolated areas look right is more exacting and the reason why UVs are thought to be more difficult 
to use.


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Discontinuous UVs

VMaps support discontinuous values across polygon boundaries, which are useful for UV texture coordinates, gradient 
weights, and other VMap-controlled surfacing parameters.

Discontinuous UVs are automatically used when appropriate with Modeler’s modeling tools.

Unweld Command

The Unweld command (Detail > Points > Unweld) creates multiple copies of the selected points so that none are shared 
by two polygons. Each polygon is given its own copy of the selected vertices, and VMap values for the polygon are made 
continuous over the new vertices. This tool is the key to being able to edit discontinuous UVs.

Merge and Weld Commands

When points are merged with the Merge Points (Construct > Reduce > MergePoints) or Weld Points (Detail > Points > 
Weld) command, any introduced discrepancies between VMap values are resolved with discontinuous UVs.

Merge points will no longer merge points that are at different locations in any of their morphs. This prevents distortions 
of the topology or discontinuities in the morph VMaps. It also provides a method to force seams in the mesh.

Free Move

When in UV Texture mode in the viewports and Free Move is active, selected polygons will separate into a new island 
when modified.
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Free Move on and off

Display Styles 

New to 2019 are the following UV viewport display styles that compare the polygon size of the object's geometry and 
adds them all together for the total area, plus each individual polygon, then does the same for the polygons in the uv 
map to have two values for each:

Wire -  The default display mode is the way the UV window has been displayed since it was available
Stretch - Shows the difference in edge lengths for the totals. Blue means the edge lengths are shorter in the UV 
map compared to the geometry, Orange means the edges in the UV map are longer than the source geometry. 
Edges that are dark blue are the same length

Scale - Shows the difference in polygon area between the UV map and the geometry. If the polygon is smaller in 
the UV map, then it is colored orange. If the polygon in the UV map is larger than the source geometry it is 
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colored blue. Polygons that are sized similarly in the UV map compared to the geometry are transparent.

Angle - The whiter the polygon in the UV window, the greater the difference between the angle the UV is showing 
compared to the geometry angle. The ideal for an optimum UV is to move its representation in the UV viewport 
to be transparent.

Overlap - When polygons in the UV map overlap, they are highlighted in the UV window with red.
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UVs Outside the Box

You may have noticed that UV coordinates can appear outside of the UV box. That is, have U or V values less than 0 or 
greater than 1. The texture is essentially tiled, so these points are still attached to some part of the texture. It is sort of 
like the old Asteroids video game where the ship moves off the edge, but appears on the opposite side.

The image shows a wall made in LWCAD with a UV map that only encompasses one polygon of the wall. The other polygons 
in the UV map are outside the 0,1 square and so repeat what is inside it.

It may help you understand the result by thinking of two rotation keys in Layout of, say, 0 and 720 degrees. From the 
viewer’s perspective, the orientations at those keyframes are the same; however, there is a (motion) path between the 
keys that LightWave interpolates. For UVs, there is a texture path. LightWave interpolates the texture between the UV 
coordinates.

Let’s say you had U coordinates at .9 and 1.3. Now although 1.3 and .3 would be at the exact same position on the 
texture, there would be a big difference in the interpolation path of .9 to 1.3 and .9 to .3. The latter would be backwards.

The calculations needed to show these different states of UV maps are quite expensive, so it's good to go back 
to the standard Wire to preserve Modeler stability when you are done


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UDIM

UDIM is a way of assigning multiple images to a single UV map, using a number to indicate blocks of UV space separated 
into ten columns of U before V increments. This makes parsing an image list used for texturing simple given that the 
images will have numbered filenames (1001, 1002, 1003... 1011, 1012, 1012...). It also simplifies the Image Editor with a 
single UDIM image in the list of images, rather than several numbered images. UDIM's major benefit is that it allows 
texture maps to be as detailed as necessary, with image maps at different resolutions for different areas of the object. 
As an example, in days gone by and with only one UV map, the map would need to be high resolution to get all the detail 
for important areas while less important ones got too much dedicated space. With UDIM, you can use high-resolution 
tiles for important details like facial features but consign things like the soles of feet to share a tile with other elements 
of lesser importance.
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In this example screenshot with a model exported from MakeHuman, we see the head and mouth get a UDIM tile, 
followed by the body and eye sockets. Next, the right and left hands, followed by the feet on a single tile. It's probably 
overkill, but each eye has its own tile, finishing up with both pupils on a single tile.

UDIM Workflow

UV Create
Make UVs
Set Default UVMap
ABF UV Unwrap
UV Spider
Texture Guide
Poly Map to UVs
UV to Weight
New Quad Poly Map

UV Select
Select UV Overlap
Select UV Island

UV Modify
Move UDIM
Transform UV
Rectangularize Grid
Flip UVs
Weld UV
Heal UV
UV Map Jitter
Set UV
Poly Norm UVs
UV Modify More...

UV Poly Tex Space
Turn Interactive
Rotate 90 Selection
Mirror Selection

UV Interpolation
UV|Texture
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UV Create

Make UVs
Set Default UVMap
ABF UV Unwrap
UV Spider
Texture Guide
Poly Map to UVs
UV to Weight
New Quad Poly Map
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Make UVs

This button will make a new UV map.

How do I use this tool?

When you click the Make UVs button, the above panel will open.You can also open the same panel when you select the 
T button in the VMaps bar at the bottom right of Modeler and then hit the + button or choose (new) from the dropdown 
menu.

Texture Name
Type the name you desire into the text field, or choose a name from the drop down list. The list contains all the names 
of all the UV Maps used during the current session, whether or not the objects remain open, and whether or not the 
maps have any points assigned to them.

Initial Value
You may start by assigning your map an Initial Value, which is based on the polygons that have been selected. If you do, 
several other fields become available. You may or may not want to do this, depending on how you are planning to build 
your map, and the shape of your object. If you do, Map Type will offer you four different kinds of maps to choose from. 
Three correspond to the standard projections you may already be familiar with of Planar, Cylindrical and Spherical; and 
Atlas. Atlas splits the map into islands of polygons that are not necessarily contiguous.

Map Type
There are four choices here:

Planar - Creates a flat UV map viewed down the axis chosen. Suitable for more faceted objects.
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Cylindrical - Creates a UV map around the axis chosen. Suitable for cylindrical objects like cans, trees, etc.
Spherical - Creates a UV map around the axis shown. Unlike cylindrical, this will create better-spaced pole areas.
Atlas - Creates a UV map splitting the geometry into islands. Ideal for rapid deployment of complicated objects.

Subpatch Interpolation
See UV/Texture.

Set as Default UV Map
This checkbox will set the specified UV map as the default. There can only be one and it is represented in the interface 
with a bullet by the name. The default UV map will be used in Layout for the Surface Input node's U, V and dU, dV 
outputs.

UDIM Tile #
If you are not using UDIM you can leave this at the default of 1001. Incrementing the number will change the position of 
the UV map you are creating.

Padding
If you are not using UDIM you can leave this at the default of 0.0. If you are, it is very important to leave a margin around 
each tile and it is recommendedto to Padding to at least 0.05.

Live Update
This toggle will keep updating the UV window as you work. It may slow down with complex models so it is not on by 
default.

Create
The Create button will activate with all the settings chosen but won't dismiss the window. Creating UV maps is often 
convoluted and you might need to create several different map types inside a single map



LightWave 2020  –  LightWave 2020

Reference –  1646

Set Default UVMap

This command has no user interface. It relies on the choice of UV Map chosen from either the Vertex Maps panel ( F8 ) 
or from the VMap dropdown in the lower right of the Modeler interface. Clicking the button will set the current active UV 
Map as the default UV map for the object. The default UV map is marked with a bullet point to the right of the UV map's 
name.

The spider UV map is the current default but changed to Texurewhen the Set Default UV Map button is clicked

If the current UV Map name is (none) then any default marker is removed.
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ABF UV Unwrap

UV > UV Create > ABF UV Unwrap - An Angle Based Flattening UV unwrapper with the ability to split geometry along 
selected edges for more complex objects. To use it, select a sequence of edges on your object and hit the button. There 
are no options.

A single edge segment was selected on the sphere and the right cursor key pressed to select the loop to the poles and 
then the ABF UV Unwrap button pressed. A UV map is created with the name Unwrap.

Known issue: Meshes with multiple open borders can cause the resulting UV Map to become unsymmetrical. 
To solve this temporarily cap holes prior to running ABF UV Unwrap.



Use Rectangularize Grid to square up your UV map



LightWave 2020  –  LightWave 2020

Reference –  1648

UV Spider

This command will crawl along a line of selected quads, no matter how much it twists and turns, and map it flat onto a 
specified section of UV space. Think Bandsaw, but mapping instead of cutting.

How do I use this tool?

This tool is really interesting. You can use it to unwrap any regular quad surface, even if you have twisted, turned, bent 
and vortexed it! But it does take some planning.

The tool works by crawling along a line of quads, and depositing them neatly onto a UV Map. But it only crawls along 
one line at a time. So, in order to unwrap an object, you have to select a couple of quads to get it started, just like you 
would with Bandsaw. However, it will put the first quad you select against the edge of the map. So, if you want a usable 
map, you have to start with the right quad, every time. In other words, if you’re unwrapping horizontally, you need to 
start with the next quad in the vertical row in order to get a good map. Now, if the piece has been twisted and turned, 
that’s not simple to do. (If it hasn’t, you don’t need this tool; there are easier ways to map straight things.)

You should begin by selecting a line of quads running perpendicular to the direction you plan to map. You can do that 
easily by selecting a couple of quads in the correct direction (vertically, in our example) and using Select > Select Loop, 
or using the keyboard shortcut Right Cursor. Once you have it, change the surface to something that will contrast 
nicely with the other surface. (Tap Q or click Surface at the bottom of the screen.) It’s only for mapping, and you can 
change it back later; but it will help you keep your place.

Then, select two quads horizontally in the bottom row of the area you want to map, and click the button.
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Vertex Map

Choose which UV Map to work on by typing the name into the Text field, or selecting it from the drop down list. The list 
contains all the names of all the UV Maps used during the current session, whether or not the objects remain open, and 
whether or not the maps have any points assigned to them. If you type a new name into the field, a new map will be 
created. If the map you pick (or create) isn’t chosen in the VMap Bar at the bottom of the screen, it will be when you 
click OK.

Select Edge

This option allows you to choose in which direction the Spider will run. Like similar tools in LightWave, if you’ve chosen 
two polys, Auto will give you the correct direction. Otherwise, you can choose Odd or Even by using the menu (but it's 
more predictable - and therefore faster - just to grab two polys.)

Direction

Choose the direction you want the UVs to run in. If you are mapping horizontal polys, choose the U direction. If you are 
mapping vertical polys, choose V.

U Start, U End

Choose the place on the map for the polys to be laid down. You can safely leave this at 0.0 to Start and 1.0 to End for the 
direction you are mapping. So, in our example, where we're mapping in U, we would leave U Start at 0.0, and U End at 
1.0.

V Start, V End

Use small increments in the other direction, so the polys will be laid down row by row. In our example, if we started with 
V Start at 0.0 and V End at 0.05, we’d get one row of polys, the width of the map, and one twentieth of its height. Click 
OK, and the row is made. Drop the polys.

Select the first two polys of the next row, and click the command again. The dialog box opens with the last settings 
intact, so you can see where you are. Simply change the V Start to .05, and the V End to .1, and make another row. 
Continue in that fashion, increasing both numbers by the same increment, until you have mapped the entire area.

When you are finished, you may notice two things. First, your map may be longer than the UV space. Second, there 
aren’t any points on it at all. That may be fine with you; in which case you’re done.

But, if you need to further manipulate the map, it’s easy to do. Just use the Unweld command (Detail > Points > 
Unweld). This will put points on all the polys, and allow you to use all the Modify tools, as you normally would. If your 
models are simple enough, you can Unweld selected points; if not, you can effectively Unweld the entire model. Just be 
sure not to move anything in X,Y,Z space, and the Merge command (M) will put it all back together again when you’re 
finished mapping.

(Don’t merge until you finish, though, so wait until you go though the next step.) Once you have points, you can use the 
Stretch tool (Modify > Transform > Stretch or H) to pull the polys down so they fit in the UV space, and your image won’t 
wrap.
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Texture Guide

This command allows you to interactively create a UV Map for selected polygons.

How do I use this tool?

To use this tool, make sure that one of your viewports is set to UV Texture, and select the polygons you would like to 
map. (If there are no selected polys, this tool will map all visible polygons.) If you would like to see the texture on your 
object while you make the UVs, you will need to assign an existing UV Map to that surface in the Surface Editor.

Click the command, and open the Numeric Panel, if it’s not already open. Click on the Actions button, and choose 
Activate from the drop down menu. The rest of the panel will light up, and the selected polys will be visible in the UV 
Texture viewport, if you are working with an existing map.

Click Make UVs at the bottom of the Numeric Panel, and either type a new name into the UV Map field to create a new 
map, or choose an existing map from the drop down menu. The list contains all the names of all the UV Maps used 
during the current session, whether or not the objects remain open, and whether or not the maps have any points 
assigned to them.

When you do, that map will become the active map in the VMap Bar at the bottom of the screen, and you’ll be able to 
see the UVs for the selected polys in the UV Texture window. The fun is about to start!

Choose the Surface you would like to make the UVs for. All the visible surfaces in the object will be listed.

Then choose your Mapping method. There are five to choose from.
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Planar

Planar is very similar to the Planar Mapping method you may already be familiar with. It projects the UVs onto the UV 
Map using a flat plane. When you choose it, you’ll see that plane represented as a orange rectangle in the viewports. You 
can choose the axis using the X, Y, Z buttons below the Mapping field. As you do, you will be able to see the results of the 
various orientations in the UV Texture viewport.

You can scale the map interactively by dragging the corners of the orange mapping rectangle, or by using the spinners 
or typing numbers into the fields in the Scale Tab. As you do, you will notice that, the larger the mapping rectangle, the 
smaller the map, and vice versa. This is because the object is occupying a smaller (or larger) percentage of the mapping 
rectangle. If you hold down the Ctrl key before you begin to drag, the scaling will be constrained to the last drag 
direction.

You can change the position of the plane by dragging the center cross, or by using the spinners or typing numbers into 
the fields in the Position Tab. Holding the Ctrl key will constrain the dragging to vertical only. Notice as you drag that 
when you drag right, the mapped object moves left in the UV Texture viewport, and vice versa. This is because it’s 
occupying the left (or right) side of the mapping rectangle.

You can rotate the mapping rectangle in the direction perpendicular to the rectangle by clicking and dragging on the 
dotted orange handles that extend from the center square. However, you can only interactively rotate on the axis 
perpendicular to the rectangle. If you want to rotate it in all three directions, you will have to use the numbers or 
spinners on the Rotate Tab. The tab uses Heading, Pitch, and Bank; controls that you should be familiar with from 
Layout.

Heading, of course, controls movement around the Y axis, Pitch around the X axis, and Bank around the Z axis. So, if you 
have chosen the Z axis for mapping, you can drag to change the Bank, but Heading and Pitch can only be changed in the 
Numeric Panel.

Notice, once again, that the object appears to move in the opposite direction to your movement when you drag, 
because you are changing the corner of the mapping rectangle that it occupies.
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Cylinder

Cylinder is the same as the Cylindrical Mapping mode you have seen in other places. It projects the vertices onto a 
cylinder, and then unwraps that flat onto the UV Map. The cylinder is visible as a simple orange wireframe cylinder in 
your viewports.

Choose the axis you would like to use as the length of the cylinder by clicking on the appropriate button (X, Y, or Z.) You 
can also choose the Width Wrap, which determines how far the polys will spread in the U direction on the map. You can 
adjust it to keep the polys proportional as you change the scale of the cylinder.

You can change the height of the cylinder by dragging on the top or bottom line. To change the other two directions, 
you must use the spinners or type the numbers into the fields in Scale Tab of the Numeric Panel. Once again, the larger 
the cylinder, the less space the polys take, and the smaller they appear on the map.

You can change the position of the cylinder by dragging the central orange cross. If you want to be more exact, you can 
use the fields in the Position Tab of the Numeric Panel.

Finally, you can rotate the cylinder; but only by using the fields in the Rotate Tab.

It’s interesting to note that each mapping method inherits the Scale, Position, and Rotation that are already present. 
So, if you wish to interactively rotate the cylinder, simply start with Planar Mapping, rotate the rectangle, and then 
switch. If you chose the correct directions, your rotation will be in place.

Spherical Mapping

Spherical Mapping, once again like Spherical Mapping in other parts of LightWave, projects all the points onto a sphere, 
and then unwraps it onto the flat surface of the map. The sphere is represented by a orange wireframe sphere in your 
viewports.



LightWave 2020  –  LightWave 2020

Reference –  1654

As always, choose the axis you wish to use as the poles of the sphere. You can also adjust both the Width Wrap and the 
Height Wrap, spreading the polys out in the U or V direction, to obtain the desired result.

You cannot interactively change the Scale or Rotation of the sphere; you have to do all of that using the tabs in the 
Numeric Panel. You can, however, change the position by dragging the center blue cross, and you can watch the UVs 
update in real time as you do so.

The regular caveats about size and direction which seem to be backwards apply again, of course, as does the note 
about the persistence of previous adjustments, as long as you haven’t closed the tool.

Cubic Mapping

Cubic Mapping corresponds to the Cubic Mapping you may know from the Surface Editor. The projection space is 
represented by a orange cube in your viewports.

You can scale the cube interactively by dragging on any of the corner handles, or you can use the spinners or type 
numbers into the fields in the Scale Tab for greater accuracy. You can position it by dragging the center orange square, 
as always, or by using the Position Tab. To rotate, though, you have to use the Rotate Tab, and type or spin. The usual 
caveats apply here, too.

Camera Mapping

Camera Mapping is an extremely flexible planar map that uses perspective. It’s represented by an orange pyramid in the 
viewports. You can think of the flat, rectangular part of the pyramid as the picture that will be used for the map, and the 
point as the camera lens.

You can scale the rectangle by dragging on its corners, or by using the Scale Tab of the Numeric Panel. You can change 
the position by dragging the center orange across in any viewport, or by using the Position Tab. You can change the 
rotation by dragging the point of the pyramid in any viewport or by using the Rotate Tab.
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You can change the perspective amount by moving the point towards or away from the object. This changes the Camera 
field of View. As is normal with cameras, the wider the field of view, the more perspective you have. (You can do a kind 
of fisheye UV Map, if you are so inclined.) The narrower the FOV, the less perspective.

All the usual caveats apply here, as well.

As you do all of this, no matter which Mapping type you are using, you may find that the UVs have moved out of the UV 
space. It’s not at all uncommon for them to do so. If you can’t find them, zoom out. (and if all else fails, close and reopen 
it, they will show up again)

When you are pleased with your results, tap the Return key or the Spacebar to drop the tool and make the UVs.

You will notice that there are no points in them anywhere; which means that you can’t perform any direct 
manipulations on them. They might be exactly what you want, in which case, you’re finished.But, if you would like to do 
more, it’s easy to turn this map into a normal one, with points. Just use the Unweld command (Detail > Points > 
Unweld). This will put points on all the polys, allowing you to use all the Modify tools, as you normally would. If your 
models are simple enough, you can Unweld selected points; if not, you can effectively Unweld the entire model. Just be 
sure not to move anything in X,Y,Z space, and the Merge command (M) will put it all back together again when you’re 
finished mapping.
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Poly Map to UVs

If you want to convert a Per-polygon Map to the more elegant and flexible Vertex UV Map, just select the polys you want 
to convert, and click this button.

How do I use this tool?

Vertex Map
Choose a map name. Either type one in, or choose one from the list.

If you have a viewport set to UV Texture, you’ll see the Poly Map polygons appear there. If you look, though, you’ll notice 
that there aren’t any points on them; so although you can now see them, you still can’t manipulate them.

To fix that, just use the Unweld command (Detail > Points > Unweld). This will put points on all the polys, allowing you 
to use all the Modify tools, as you normally would. If your models are simple enough, you can unweld selected points; if 
not, you can effectively unweld the entire model.

Just be sure not to move anything in X,Y,Z space, and the Merge command (M) will put it all back together again when 
you’re finished mapping.
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UV to Weight

This button allows you to create a Weight Map based on either the U or V value of a UV Map. (It does not allow you to use 
a grayscale map that you can color and apply the way you would apply a Texture UV Map. If that’s what you’re after, 
you’re looking for Textured Point).

To use it, create a UV Map that has the points arranged along either the U or V axis, the way that you would like the 
weights assigned.

Click on the tool to open the associated dialog.

UV Map

Choose the UV Map you have prepared from the UV Map drop down list, and type the name for the new Weight Map into 
the Weight Map text field (or choose it from the list, if you prefer to use an existing name. All Weight Maps used in this 
session will appear in the list, whether or not the object they are associated with remains open, and whether or not any 
points have been assigned to the map.)

Use

Choose whether you want to use the U axis or the V axis to create the map.

If you use the U axis, all the points on the left edge of the map will receive a value of 0%, the points on the right edge will 
receive a value of 100%, and the points in between will have values in between, of course.
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If you use the V axis, the points at the bottom are 0%, the points at the top are 100%, and those in-between are in 
between, of course.

Shift Value

This option adds the number entered to the 0 to 1 range. For example, if you entered a Shift Value of -1, the range would 
become -1 to 0, giving you a map that had weights from -100% to 0%. Entering a Shift Value of 1 would give you a range 
of 100% to 200%, and so on.

Scale Value

This option scales the values by the number entered. For example, if you entered a Scale Value of 200%, you would get a 
weight range from 0% to 200%. A Scale Value of -150% would give you a weight range of 0% to -150%, and so on.These 
values work together. So, for example, if you wanted a range between -100% and 100%, you would enter a Shift Value of 
-1, and a Scale Value of 200%.

Neither Shift nor Scale are either clipped or constrained.
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New Quad Poly Map

New Quad Polygon Map (UV > UV Create > New Quad Polygon Map) allows you to make a new Per-polygon Texture Map 
where each selected quad (four-sided poly) covers the entire map square.

How do I use this tool?

Select the quads you want to map. (It does nothing with unselected polys, and nothing with polys that aren’t quads.)

Vertex Map

Click the tool, and a dialog will open. If you want to make a discontinuous (normal) UV Map, then enter the name in the 
Vertex Map field, or choose an existing map name from the drop down list. The list contains all the names of all the UV 
Maps used during the current session, whether or not the objects remain open, and whether or not the maps have any 
points assigned to them.

If you want to make a Per-polygon Map, leave the Vertex Map field blank.

Image Orientation

Choose an Image Orientation, either 0, 90, 180, or 270 degrees.

Reverse Order

Click Reverse Order if you think the texture is going to be a mirror image. Click OK. Each corner of each quad will be 
assigned to one corner of the new Quad Map, so the entire picture will exist on each one. This works best for boxes and 
other simple shapes; but it can be very interesting on more complex objects.

If you have enabled the Texture Map in the Surface Editor, you’ll be able to see it. (If you haven’t, you’ll need to go and 
do that. To get a per-polygon texture to show up, choose an Image Texture, with UV Projection as normal. Choose any 
UV Map. It doesn’t even need to have any points assigned to it. Then choose (or load) your image. You’ll see it on the 
quads in Texture or Wireframe Texture viewports. To see a normal Vertex UV Texture, you have to choose the same UV 
Map that you named in the dialog, of course. In either case, if you are using more than one image layer in the Texture 
Layer Stack, only the one on the bottom will be visible in the viewports. So, if you want to see your UV Projection Image, 
make sure it’s on the bottom.

You might find that the orientation of the images isn’t what you’d hoped, or the picture is a mirror image of itself. If that 
happens, select the problem quads once more, and try again. Choose a different Orientation, if that’s the problem, or 
Reverse Order to fix the mirror image.

This is much easier to do if you adjust the ones that are causing problems singly, or in groups that have the same 
orientation, because the corners of the quads are assigned to the corners of the UV Map arbitrarily. So, if you leave them 
all selected, you may find that you are fixing some, while others are turning the wrong way again.
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UV Select

Select UV Overlap
Select UV Island
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Select UV Overlap

When you have multiple UV islands overlapping each other it can become very difficult to see what is happening with 
your model's mapping. This tool will select islands of polygons that are overlapping other islands so that they can be 
manually moved. The command can be fired while another tool is in use so you can be in the Move tool (T), hit Select 
UV Overlap and have a new selection ready to move.
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Select UV Island

Select one or more points or polygons in a part of a UV map, then choose Select UV Island to select the remaining points 
or polygons in just that UV Island.
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UV Modify

Move UDIM
Transform UV
Rectangularize Grid
Flip UVs
Weld UV
Heal UV
UV Map Jitter
Set UV
Poly Norm UVs
UV Modify More...
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Move UDIM

With this tool, you can drag UDIM tiles to a different location in the UDIM space. Select the tile you want to move, start 
Move UDIM and drag the chosen tile to its new home. Once there, you will get the choice of Moving or Swapping with 
the tile that is already there.

This animGIF shows that the tiles here are not connected in any way. The first go at Move UDIM saw the tile selected before 
Move UDIM was started. All works well. The second time, nothing was selected and tile 1001 was simply dragged to position 
1017. This creates a link back to the original position, and the render is incorrect
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Transform UV

This button allows you to adjust the UV values of selected polygons in several ways. If no polys are selected, it will act 
on all the visible polys in the current map.

How do I use this tool?

When you click the button, it will open a dialog which allows you to choose several ways to manipulate the UV values of 
selected points on your map. (If no points are selected, it will act on all of them.)

Offset

This option will move the points by the specified percentage of the UV space, in either the U (horizontal) or V (vertical) 
direction. Positive values will move them to the right, or up. Negative values will move to the left, or down.

Scale

This option will scale the points by the specified percentage, in either the U (horizontal) or V (vertical) direction. 100%, 
of course, is the current size. Larger numbers will increase the size, and smaller will decrease it. Unless you specify a 
different center, they will shrink or grow from 0,0, which is at the bottom left corner, where the black axis lines cross.

Rotation

This option will rotate the points around the center point. Positive values will move them clockwise, negative values will 
move them counter-clockwise. Unless you specify a different center, they will rotate around 0,0 or the bottom left 
corner, where the black axis lines cross.

Center

This option allows you to use a different center for the Scaling and Rotation, specified as a percentage of the UV space 
in either the U (horizontal) or V (vertical) direction. Positive values move the center to the right or up. Negative values 
move it to the left or down.

Of course, you can also use the normal Modify tools (Move, Drag, Snap, Scale, Stretch, Rotate, and so on) on UV Maps, 
with much the same results you would expect if you used them in a normal Modeler window. As long as you don’t use 
the Numeric Panel, nothing you do in the UV Window will affect the geometry of your model at all, since UV space is 
separate from X,Y,Z space.
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Be aware, though, that in order to do any of this successfully, you must be sure that you have unwelded all the seams on 
your model. If you don’t, any polys that aren’t showing a point will remain “stuck” to the map in that place, and will 
become severely stretched. (In the picture shown, you can see that there are points missing in the corners marked. 
There are also points missing all around the circumference of both circles. Whenever two polys share a point, only one 
will have it on the map, and it’s a problem if it’s on the edge)

This image shows the use of the Flip tool; but the same principle applies.

To fix it, undo, then select the points that are being shared (On the model, they’ll be on the poly next to the one without 
its point. If you select that poly on the map, it will light up on the model too, and you’ll be able to find which points to 
unweld easily.)

Go to Detail > Points > Unweld, and every poly will be given its own points.When all the edge polys are showing points, 
go ahead and manipulate them.
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Rectangularize Grid

Rectangularize Grid straightens UVs. Specifically, it squares up distorted UV maps making them easier to use 
with images. To take a simple example, using the Toroid tool in Modeler will create a great donut shape, but if you want 
to create a good texture map to get across the sprinkles and frosting while you can create maps using planar mapping 
and fudge the joins it is better to have the accuracy of a UV map. Until now though, a toroid created in Modeler with a 
UV map generated using the ABF Unwrap tool looks like this:

Hitting Rectangularize Grid will result in this:
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And judicious use of the Move and Stretch tools will give you this:

Finally, speedy use of an art package and some clip art will give this result:
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Mmm donuts...
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Flip UVs

These commands will flip polygons in UV space in order to reorient them (to fix images that are reversed when applied) 
There are three tools. The flirst is Flip UVs UI, which has been in Modeler for many versions.

How do I use this tool?

When you click the button, it will open a dialog which allows you to choose to flip the polys across the U (horizontal) 
axis, across the V (vertical) axis, or both. (Flipping both, of course, won’t fix mirror images in your render; but it might 
put the polys just where you want them.)Simply click to choose a direction, and then click OK. The polys will flip.

In order to do this successfully, you must be sure that you have unwelded all the seams on your model. If you don’t, any 
polys that aren’t showing a point will remain "stuck" to the map in that place, and will become severely stretched. (In 
the picture shown, you can see that there are points missing in the corners marked. There are also points missing all 
around the circumference of both circles. Whenever two polys share a point, only one will have it on the map, and it’s a 
problem if it’s on the edge)

To fix it, undo, then select the points that are being shared (On the model, they’ll be on the poly next to the one without 
its point. If you select that poly on the map, it will light up on the model too, and you’ll be able to find which points to 
unweld easily.)

Go to Detail > Points > Unweld, and every poly will be given its own points.When all the edge polys are showing points, 
go ahead and flip.
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Flip UVs UI

This will either flip on the U axis (horizontal in the UV map), the V axis (vertical in the map) or both at once.

Flip UV/U Selection

Designed to be ideal for mapping to keyboard shortcuts there are no options. This flips the selected polygons on the U 
axis with no requester.

Flip UV/V Selection

Designed to be ideal for mapping to keyboard shortcuts there are no options. This flips the selected polygons on the V 
axis with no requester.

It is likely you will need to unweld geometry before flipping. Once flipped, merging will restore a continuous 
mesh


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Weld UV

Weld UV will check that points are on top of each other and then will weld the points in place in the UV map.
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Heal UV

The Heal UV command will calculate the average of all VMap entries of a point and will set one continuous entry at that 
average position, deleting all discontinuous entries. Discontinuous vertices are marked in red, which gives immediate 
feedback if the commands are working correctly.
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UV Map Jitter

This button allows you to add a random UV value to all selected points. If no points are selected, it will act on all visible 
points.

How do I use this tool?

To use it, choose a map from the VMap Bar at the bottom of the screen (click T and choose from the drop down list.) 
Select the points you want to jitter, or leave them unselected if you want to jitter all the visible points. Click the button, 
and the dialog will open.

VMap

Choose the VMap you want to use from the drop down list. The list contains all the names of all the VMaps used during 
the current session, whether or not they are UV Maps, whether or not the objects remain open, and whether or not the 
maps have any points assigned to them. (But if you try to use anything but the UV Map selected in the VMap Bar, you’ll 
get an error message.)

Minimum/Maximum Jitter Amount

Set the Minimum and Maximum Jitter amount. But remember, when you do, that the entire map is only 1.0 big. So set 
tiny, tiny values unless you want the map to jitter right off the UV Square, and out into the wrap area. You can also use 
negative values, of course, to keep it more or less around the map, if you are so inclined.

Click OK, and you’ll see the jitter effect.
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Set UV

This button allows you to move selected points to a specific spot in either U or V space. If no points are selected, it will 
move all visible points. The effect is to line them all up.

How do I use this tool?

To use it, choose a map from the VMap Bar at the bottom of the screen (click T and choose from the drop down list.) 
Select the points you want to move, or leave them unselected if you want to move all the visible points. Click the 
button, and the dialog will open.

Since the points are going to be lining up, you need to move them perpendicular to the axis you want them to line up 
on. So, if you want a vertical line, you need to move them all to the same point on the U (horizontal) axis. If you want a 
horizontal line, you need to move them all to the same place on the V (vertical) axis. Choose the axis you prefer by 
clicking its name.

The spot on the axis is expressed as a percentage of the UV space. 0% is the lower left corner, where the two black axes 
lines meet. 100% is the top right corner.

So, if you want to move the points to line up one quarter of the way from the left, you’d enter U 25%. If you wanted 
them to line up two-thirds of the way to the top, you’d enter V 66%, and so on. It’s all relatively straightforward.
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Poly Norm UVs

This command will take all the selected polygons, and project them onto a UV Map according to their normals, so they 
will be mapped flat on the image. It’s one of the old Per-polygon tools; it’s similar to mapping in Atlas mode, except the 
polys wind up all piled on top of each other, without any points.

How do I use this tool?

Select all the polys you want to map, polygons that aren’t selected won’t be mapped, and click on the command. A 
dialog will open.

Vertex Map

Type the name of the map into the Vertex Map field, or choose a name from the drop down list. The list contains all the 
names of all the UV Maps used during the current session, whether or not the objects remain open, and whether or not 
the maps have any points assigned to them. If you type a new name into the field, a new map will be created, and 
chosen from the VMap Bar. If you use a name from the list, that map will also be automatically selected. If you don’t use 
any name, you’ll make a Poly Map.

Automatic Size

Click the checkbox if you want the polys to be automatically sized. If you do, they’ll be centerd in the UV space, and 
come close to filling it. If you don’t, they’ll probably be tiny, and in the lower left corner.

Click OK, and they’ll be made. You’ll notice that they don’t have any points, which means that you can’t manipulate 
them directly. Fortunately, that’s easy to fix. Just use the Unweld command (Detail > Points > Unweld). This will put 
points on all the polys, allowing you to use all the Modify tools, as you normally would. If your models are simple 
enough, you can unweld selected points; if not, you can effectively Unweld the entire model. Just be sure not to move 
anything in X,Y,Z space, and the Merge command (M) will put it all back together again when you’re finished mapping.
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UV Modify More...

Quad Spread UVs

This button takes the corners of a selected quad, and places them in UV space at the minimum and maximum values 
you specify.

How do I use this tool?
First, select a single quad.

Click the button, and it will open this dialog which allows you to pick the Maximum value in the U and V directions. 
Notice that there are no minimum values; the minimums are 0,0; the lower left corner of the UV Map, where the U and V 
axes meet.Whatever you pick for the Maximum U will be the right side of the quad. Whatever you pick for Maximum V 
will be the top. The left side and bottom will be against the axes, of course.

You will notice that, once the quad is spread, it will no longer have any points, which means that you cannot manipulate 
it with the normal Modeler Modify tools. Fortunately, that’s easy to fix.

Just use the Unweld command (Detail > Points > Unweld). This will put points on the poly, allowing you to use all the 
Modify tools, as you normally would. If your models are simple enough, you can Unweld selected points; if not you can 
effectively Unweld the entire model.

Just be sure not to move anything in X,Y,Z space, and the Merge command (M) will put it all back together again when 
you’re finished mapping.

Guess Viewport UV Image

(default keyboard shortcut Shift F9)

This command guesses what image should be used as the background in the Viewport set to UV Texture.

How do I use this tool?
Just set one of your viewports to UV Texture, and choose a Texture Map from the VMap Bar at the bottom of the screen. 
Click the button, or tap Shift F9 on your keyboard, and the image that’s used in the texture will automatically load as 
the Background Image in the viewport.

If you’re using more than one image in the surface that uses that UV Map, it will pick the one from the Color Channel, if 
there is one.

It’s just a quick, handy way of loading the Background Image. But be careful with it. If you’re using a Poly Map or a Color 
Vertex Map instead of an image, LightWave can grind to a halt while it tries to guess that.
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UV Poly Tex Space

Turn Interactive
Rotate 90 Selection
Mirror Selection
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Turn Interactive

 This tool will rotate individual UV polygons interactively. LMB click on a polygon will rotate in a clockwise direction, 
RMB click for anti-clockwise.
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Rotate 90 Selection

This tool uses a selection to determine what polygons in a UV map should be rotated. It won't work without a selection 
and the rotation is only counterclockwise. It might seem like unnecessary duplication of the previous tool in this group 
Turn Interactive, but if you need to rotate multiple tiles at once, that tool takes longer.
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Mirror Selection

Mirror Selection requires a polygon selection to work and simply mirrors each selected polygon about the U axis.



LightWave 2020  –  LightWave 2020

Reference –  1682

•
•
•
•
•
•
•

•

•

UV Interpolation

Click here to expand Table of Contents...
Interpolation Type
Subpatch Interpolation Mode
Linear Corners Interpolation Mode
Linear Edges Interpolation Mode
Across Discontinuous Edges Interpolation Mode
Axis
Settings

Usually Subpatch interpolation behaves differently on the outer edge of a mesh than inside a mesh. Since 
discontinuous edges are outer edges relative to a UV map or UV map island, but are inside edges relative to the mesh, it 
is not always possible for LightWave to automatically perform a correct Subpatch interpolation over discontinuous 
edges or over edges that are shared by multiple UV maps. For these types of situations, the following interpolation 
types have been offered to get the least distortion out of a UV map.

Interpolation Type

Linear - The UV map is interpolated linearly, most similar to the original mapping option and does not use any 
subpatching at all.

A UV map with two UV islands enclosed by a 3rd large UV island. Linear Interpolation Mode

The edges on the very left and right of this UV map are discontinuous, as are the edges along the two small 
islands in the centre. In this case the biggest problem is that some vertices are shared by all three UV islands. 
This makes many of the interpolation- methods fail. The situation would be even more severe, if each UV island 
was in its own UV map.


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Subpatch - All Edges are interpolated along the subpatch lines, as if the UV map was a subpatch mesh. (Note that 
the discontinuous edges do not line up.)

Subpatch Interpolation Mode

Linear Corners - Corner-Points that are along the outer edge of the UV map, but not the edge of the mesh, are 
interpolated linearly. Notice that it looks better than subpatch, but the discontinuous edges still do not meet up.
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Linear Corners Interpolation Mode

Linear Edge - Edges that are along the outer edge of the UV map, but not the edge of the mesh, are interpolated 
linearly. Discontinuous Edges now line up, but due to lack of cubic interpolation, some distortion may still occur.

Linear Edges Interpolation Mode

In this special case only the “Linear Edges” method would allow for well aligned discontinuous UV edges. However you 
would have to allow for some distortion along these edges.

Across discontinuous edges: Interpolation occurs along discontinuous edges. This method usually provides less 
distortion along discontinuous edges. A discontinuous edge can be considered a point that shares two separate 
polygons on a mesh, yet falls on the edge of the UV map so the two polygons are on opposite edges of the UV map. This 
option lines up the points so the two edges meet up. Please note that this option does not work across multiple UV 
maps.
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Across Discontinuous Edges Interpolation Mode

The Subpatch Interpolations can be further edited in the Assign UV Coordinates window and the Vertex Maps Panel.

Axis

Choose the axis you wish to align your UVs to: X, Y or Z.

Settings

In addition to choosing the axes, you can also decide whether to leave the Center and Size settings on Automatic, or to 
adjust them Manually. If you click on Manual, the Center and Size fields will become active. For most purposes, it’s 
recommended to simply leave them on Automatic. Once you have a UV Map and are ready to paint it, don’t make a 
screenshot, which will be of poor quality at best, and will need to be manipulated before you can use it. Instead, go to 
File > Export >Export Encapsulated Postscript, choose Texture UV from the View field, and make an .eps file, so you can 
have clean, high-resolution maps.

If heavy scaling is used or parts are rotated, Across Discontinuous Edges can produce errors. However, this 
solution is recommended first, since most of the time, the least distortion occurs at discontinuous edges.


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UV|Texture

Click here to expand Table of Contents...

What is UV Mapping?
What is Per-polygon Mapping?

Map Types
Planar
Cylindrical
Spherical
Atlas
Relative Gap Size
Segment by Surface, Segment by Part

What is UV Mapping?

Sometimes, when mapping textures onto objects, you will find that the normal projection mapping just doesn’t work. 
This usually happens when the object is organic, or irregular in shape. For those occasions, there’s UV Mapping!

UV Mapping adds two extra coordinates to the points in your object; those on the U and V axis, running horizontally and 
vertically through a flat plane on which you can paint your texture. Since the coordinates are assigned to points, it’s 
essentially as if that painted texture was fixed to the surface of the object, with pins where all the points are. No matter 
how irregular your object is, or how it moves or flexes, those pins stay in place, and the texture stays right where you put 
it.

Technically, it’s not as accurate as projection mapping, because the texture is really only exact at those points, and 
merely interpolated everywhere else. But it’s close enough!The trick is to make the map first. LightWave has many tools 
to help you do that.

What is Per-polygon Mapping?

Per-polygon UV Mapping, or Poly Mapping, was introduced in LightWave 6.0b as a way to handle discontinuous UVs. 
(Without some kind of handling, they would cause the entire image map to appear backwards and squashed onto a 
single polygon at the map seam. Not a pretty sight.) They were superseded by the current UV Mapping tools in 
LightWave 6.5, so unless you are working with a model that was mapped before that, there’s really no reason to use 
them; the new tools are much more elegant and flexible.

Unlike UV Maps, Poly Maps cannot be edited with the normal Modify tools used in the rest of Modeler, because they are 
not continuous. Instead, they are locked snapshots of some UV Mapping of a polygon. So any operation on a vertex 
must also specify which polygon’s view of that vertex is being edited.

You can select polygons that use per-poly UVs by choosing the Select by Polymap command (View > Selection > Maps > 
Select by Polygon Map).

Map Types

UV maps can be of several different types explained here, then choose the type of projection you wish to use from the 
Map Type list. They correspond to the standard projections you may already be familiar with.
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Planar

The first, Planar, simply looks at the object from one of the three axes (X, Y, or Z.) What you’ll get looks just like what you 
see in one of the Orthogonal viewports, but resized to fill the square of the UV space. If you choose X, you’ll get what you 
see in the Right or Left viewport. If you choose Y, you get what you would see in the Top viewport. If you choose Z, you’ll 
get what you see in the Front or Back viewport.

Cylindrical

The second, Cylindrical, gives you the same effect as you would get from a camera that rotated around the object, (sort 
of like having your teeth x-rayed) using the axis you chose as the center of the rotation. So, if you choose X, the camera 
will rotate around a pole going from left to right, and the top of the map will be the right side of the object. If you choose 
Y, the camera will rotate around an upright pole, and the top of the map will be the top of the object. If you choose Z, 
the camera will rotate around a pole going from close to far, and the top of the map will be the back of the object.

Spherical

The third, Spherical, behaves as if all the points are fastened to the inside of a sphere, and then the sphere is laid out 
flat. The poles of the sphere are on the axis you choose. So, if you pick X, the poles will be at the right and left, and the 
top of the map will be a few polys on the right side of your object. If you choose Y, the poles will be at the top and 
bottom, and the top of the map will be a few polys at the top of your object. If you choose Z, the poles will be close and 
far, and the top of the map will be a few polys on the back of your object.
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Atlas

The fourth Mapping method, Atlas, will call a slightly different dialog, because it has different tools. Atlas spreads the 
UVs out, so that none of the polygons overlap, and there is a minimum of distortion. This is good, if there’s no shading 
from poly to poly. It’s not so good if you need to shade smoothly over a number of polys, because it can be very difficult 
to paint on. You’ll have to decide according to your needs.

Relative Gap Size

Because polygons become separated in Atlas mapping, instead of choosing an axis (which would be meaningless), you 
can choose how much space should be left between groups of polys using Relative Gap Size.

Segment by Surface, Segment by Part

This option allows you to choose whether the polys should be separated by Surface or Part. (Segment by Surface, 
Segment by Part.) It’s recommended that you enable these, if you have a number of polys in a surface or part group that 
will be getting the same color, because it can make it easier to paint.
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However, there can be problem areas on a UV map that require special treatment. UV maps can have edges that are 
open in a map but closed on the mesh. A single edge on a mesh can be two edges on a map, or a discontinuous edge. 
These edges are usually along the UV unwrap seams.

This usually depends on the UV unwrapping method and the UV editing done, which means that each UV map is unique 
to every mesh. Discontinuous edges usually surround a so-called UV island.

A single UV map can contain multiple UV islands. These UV islands can be rotated and positioned freely in the UV space 
(by you, or using unwrapping methods like Atlas). A single island or even a single polygon can also be part of multiple 
UV maps (with different positions and orientations in each UV map).
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Setup

This tab contains tools for setting up characters for animating in Layout.

Skelegons
Skelegons - More
Layout Tools
Fiber FX
Genoma
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Skelegons

Skelegons are bones made in Modeler. They can't be used in Modeler but they are often easier to set up than using the 
single perspective viewport of Layout. Genoma uses skelegons to create ready-made rigs, but these tools can be used to 
add to Genoma rigs, or create rigging from scratch.

Create Skelegons
Edit Skelegons
Changing Skelegon Direction
Rotate Skelegons
Split Skelegon
Rename Skelegon
Skelegon Tree Panel
Selection
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Create Skelegons

One way to create a bone hierarchy is to use LightWave’s Skelegon feature in Modeler. Skelegons are a polygon type 
that can be added to your object in Modeler; they look like bones. You can create a complete skeletal structure out of 
polygons, hence the name Skelegons. Skelegons set up only placeholders for the bones. When you load an object with 
Skelegons into Layout, the Skelegons must first be converted to bones before you can use them for skeletal 
deformation.

There are several advantages to this system. First, you can use existing points in a character to create the Skelegons, if 
you wish, or you can draw your own Skelegons manually. Having this function as a Modeling tool makes the creation 
process much easier, as building a skeleton is inherently a Modeling task. Since the Skelegons are considered polygons, 
you can use any of the Modeling tools to create and modify the skeleton.

Another benefit is that the Skelegons are saved in the object file itself. This means that you no longer need to create a 
separate scene file to hold bone positions.One of the most beneficial features of this system is that when you modify the 
shape of the model, the bone structure can be modified at the same time, so you do not need to make secondary 
modifications to that skeleton.

Imagine that you build a character and spend a lot of time creating the bone structure. The client then decides he/she 
would rather have the character with shorter legs and really long arms.

Typically, the Modeling changes would be simple but recreating the skeletal system would be an arduous task at best. 
With Skelegons, the process becomes one simple step which only involves modifying the geometry.

With Skelegons, a series of base skeletons can also be stored and used as templates. The rubber band editing style of 
the Skelegons makes it very simple to modify an existing skeleton to fit all types of characters.

Genoma is a system for rigging using skelegons that has several presets for creating humanoid and animal rigs.
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Creating Skelegons

Like drawing bones in Layout, you can use the Create Skelegons tool to draw Skelegons directly into a Modeler layer. 
Just choose Setup > Skelegons > Create Skelegons, Left Click and drag your mouse. When you release the mouse button 
a Skelegon is created. With the tool still active, you can drag your mouse again to create yet another Skelegon attached 
to the first. Select the tool again to turn it off.

You can customize the Name used for each Skelegon, as well as the Weight Map name, on the Numeric Panel. When 
Digits is active on the Numeric Panel, bone names are incremented, like Bone01, Bone02, and so on. You can specify the 
initial number in the Start At field.

If the Part Tag option is active, the bone name will also be used as a Part name automatically. Click the Delete Last
button to delete the last Skelegon being created.

Remember that Skelegons are only placeholders for bones.
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The lower portion of the dialog combines the functions of the Bone Weights plugin (Map > Bone Weights). Activate Fill 
Weight Map to gain access to these functions. Remember that Weight Maps are part of geometry, not Skelegons. Thus, 
you need some geometry in the foreground to use this feature. The Weight Maps will be automatically created for the 
geometry.

Note that you can also activate the Fill Weight Map option after you have finished drawing your Skelegons or even 
toggle it on and off. This, however, must be done prior to making the Skelegons, by dropping or switching the tool.

Define the base Weight Map name in the Weight Map field. The maps will be named sequentially (e.g., Bone01, Bone02, 
and so on). The Falloff setting corresponds to the falloff that you can normally use on bones when you are not using 
Weight Maps.The resulting Weight Maps will give you a nice starting point for modifying bone influences.The Threshold 
Value is a distance from the bone that defines a capsule-shaped region.The Use Threshold pop-up has several settings. 
This will take the Weight value at the Threshold Value distance and either: ignore it (Off); set all weights outside the 
distance to 0 (Clip); subtract the threshold weight from all weights, so the weights go smoothly to 0 at the threshold, 
then start to become negative (Subtract); or subtract the Threshold Weight value as above, then clip the negative 
weights to 0 (Blend).

Bank Rotation Handle

When you edit Skelegons, a bank rotation handle will appear. The default angle for the handle is perpendicular to the 
viewport the Skelegon is first drawn in. Drag it to change the bank rotation to apply when it’s converted into a bone.
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Converting Skelegons to Bones

Skelegons cannot be used directly in Layout. They must be converted into bones first.

To convert Skelegons into bones:

In Layout, select the Skelegon object.

Choose ( Setup > Add > Cvt Skelegons ). This converts the Skelegons, which are only placeholders, into actual 
bones. Note that the bones are immediately ready for action. Rest positions are set automatically and bones are 
activated.

If your Skelegons were in a Modeler layer by themselves, you need to point the regular object to the newly 
created bones. Select the regular object and then open its Bone Panel. Select the Skelegon object in the Use 
Bones from Object pop-up menu.

If you want, you can simplify the process by cutting and pasting the Skelegons into the same layer as the 
object before saving. Then you can avoid the Use Bones from Object feature.


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Edit Skelegons

You can edit existing Skelegons (chains) by simply selecting the lowest Skelegon in the chain you wish to edit. Then, 
choose Setup > Skelegons > Edit Skelegons. You can also edit Skelegons along with an object’s normal polygons by 
selecting them at the same time.

If you want the Skelegons to use the same points as your object, copy the points you want to use as beginning and end 
points for the Skelegons to an empty layer. Use the Make Skelegons command. Then cut and paste the Skelegons into 
the normal object layer. Finally, merge points.
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Changing Skelegon Direction

The Flip command (Detail > Polygons > Flip or F) will flip the direction of selected Skelegons. (This command also flips 
the direction of a polygon’s normal.)
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Rotate Skelegons

Rotate Skelegons( Setup > Skelegons > Rotate Skelegons) allows you to quickly adjust the bank handles of Skelegons as 
well as preview rotational deformations. This includes the deformation of sub-patches. This is a great tool to test your 
Weight Maps and deformations in Modeler.

Using Rotate Skelegons

Load a model which contains Skelegons and make sure that both the Skelegons and the mesh are in the primary layer 
(the primary layer is the lowest numbered active foreground layer). Make sure that the Skelegons are not hidden, but it 
doesn’t matter whether any points or polygons are selected.

Now click on Rotate Skelegons and open up the Numeric Panel (N)

The first entry of the Numeric Panel is the Mode options. Normal will allow you to rotate the Skelegons as well as the 
mesh. Choosing the Skelegons Only option will move the Skelegons without moving the mesh.

The second entry is Bone. Bone is the Skelegon that is currently active. You can select other Skelegons by selecting from 
the drop down list or by clicking onto the small orange circles in the middle of each Skelegon.
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The third entry is Weight Map. Weight Map is the name of the Weight Map assigned to the Skelegon. The currently 
selected Skelegon has three lines with the letters H, P and B as well as a bigger circle attached to its stubby end. Holding 
the mouse down over one of the letters and dragging to the left or right rotates the Skelegon and its children and (if the 
associated Weight Maps contain non-zero values) deforms the mesh.

While you are in Normal Mode, you can have multiple Skelegons rotated around any axes. You can rotate the Skelegons 
also by changing the corresponding values in the Numeric Panel.

The Bank Handle (sometimes also the term Pitch Plane is used) determines how the rotational axes are aligned when 
the model is loaded into Layout and the pivot rotation for every bone is recorded. You can align the Bank Handle with 
the tool by holding the mouse down over the stubby end of the selected bone (inside the bigger circle) and dragging to 
the left or right.

The Heading and Pitch axes will circle around the bone, i.e. these axes are now aligned differently. The Bank Handle 
alignment will be shown in the Numeric Panel as well.
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If you click the button Reset Current Bone in the Numeric Panel, the Skelegon will be reset to its rest position (i.e. the 
position it had when the tool was activated). The value of the Bank Handle will be reset as well.

If you click Reset All Bones, all Skelegons will be reset. If you hit the Space bar or the Return key the rotational changes 
will be assigned to the mesh and the tool will be deactivated.

If you hit Modeler’s Undo button or click in an inactive toolbar area all Skelegons will be reset and the tool handles 
disappear, but the tool is still active. By simply clicking into one of Modeler’s viewports the handles will become visible 
again.
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Split Skelegon

You can split selected Skelegons in two using the Split Skelegon command (Setup > Skelegons > Split Skelegon).

You can apply this operation to more than one Skelegon at a time.
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Rename Skelegon

You can rename a Skelegon by selecting it in the viewport and then executing the Rename Skelegon command. (Setup > 
Skelegons > Rename Skelegon)
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Skelegon Tree Panel

If you open the modal Skelegon Tree Panel (Setup > Skelegons > Skelegon Tree), you can view the hierarchy of 
Skelegons. Skelegons will be automatically parented if, for example, Draw Skelegons is used.

The Weight Map column lists associated Weight Map names. Double-click in the Weight Map column to specify a Weight 
Map.
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You can also change the hierarchy by dragging and dropping individual Skelegons in the list.
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The same points will be used, but the connections will change to reflect the revised hierarchy.

You can rename a Skelegon by double-clicking its name in the list and entering the new name in the dialog that 
appears. The names you assign become bone names when the Skelegons are converted to bones in Layout.

You can also rename a Skelegon by selecting it in the viewport and then executing the Skelegon Rename command 
located under the Setup Tab.
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Selection

Two commands can help you select Skelegons: select Child Skelegon (Setup > Skelegons > Selection > Select Child 
Skelegon), which selects the child of the currently selected Skelegon, and select Parent Skelegon (Setup > Skelegons > 
Selection > Select Parent Skelegon), which selects the parent of the currently selected Skelegon. These commands are 
best set to a keyboard shortcut for optimum use. Press Alt F9 to open the Keyboard Shortcuts Editor.
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Skelegons - More

This group contain tools that are no longer so required, but could still prove useful in the right circumstances.

Skelegon Weight
Convert Skelegons

To use Convert Skelegons:

Mocap Skelegons

Skelegon Weight

Set Skelegon Weight command (Setup > Skelegons > More > Skelegon Weight) will set up the Skelegons association to 
map names. You still need to create and edit the weighting values as you would normally. The associated map names 
are automatically assigned to the bones and will appear as the Bone Weight Map setting on the Bones Panel. You can 
use the dropdown menu to choose an existing weight name.

Convert Skelegons

One way to create Skelegons is to create curves first. You can then convert the curves into Skelegons, which will be 
placed between the curve knots (points). With Convert Skelegons, (Setup > Skelegons > More > Convert Skelegons) you 
can even use points from the object to create the curves.

To use Convert Skelegons:

In an open Modeler layer, create points that will correspond to the bases and tips of the bones you want to 
eventually create. (You’ll probably want the object to be boned in the background for reference.)

The Skelegon Tree Panel will list map assignments.



LightWave 2020  –  LightWave 2020

Reference –  1708

2.

3.
4.

Select points, working from the (theoretical) base of the first child bone to the tip of the last bone in the chain. 
Then choose Create > Make Curve > Make Open Curve to create an open-ended curve with your points.

Repeat the previous step for all chains, if you have more than one. You can use the same point in multiple chains.
Choose Setup > Skelegons > More > Convert Skelegons to create the skelegon from the curves. You can edit the 
base/tip of the bones using standard modeling tools. The Skelegon bones will stay attached to each other.
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5.

If you desire, you can select and delete the curve afterward.

If you want, you can optionally cut and paste the Skelegons into the layer with the normal object geometry.

Mocap Skelegons

LightWave provides a couple of plugins to support the BioVision (BVH) motion capture file format. The 
MoCap_BVH_Setup generic Layout plugin reads a BioVision BVH file, creates bones, and applies the motion capture 
data to them.

MoCap Skelegons (Setup > Skelegons > More > Mocap Skelegons) is a Modeler plugin that creates Skelegons in Modeler 
that match the initial rest position of the Biovision BVH data.
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Use it to determine the correct scale, position, etc. for your object mesh. This object can then be used with the bones 
created using the MoCap_BVH_Setup generic plugin in Layout.

Bone Scale Factor - This option gives you control over the overall size of the Skelegons that will be created.
Bone Name Postfix - This option will put a number after each Bone name in Layout for scenes with multiple 
characters. This is a setting that only functions in Layout so there is no need to change it in Modeler.
Biovision BVH File - This field is where you will load the BVH Mocap file that will be read to create the Skelegons.

Steps to use Mocap Skelegons:

Click MoCap Skelegons (Setup > Skelegons > Mocap Skelegons).
Click OK. 
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3. Manipulate your model to match the Skelegons.

 

Your model is now ready to load into Layout!

Some models will need Weight Maps applied to assign geometry to each specific bone, and prevent distortion 
when using motion capture for animation.


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Layout Tools

These three tools are for creating Powergons - tags added to LightWave objects that can be used in Layout.

Luxigons (Setup > Layout Tools > Add Luxigon ) are like Powergons (discussed later), specialized just to add lights 
and set certain light properties. To use, in Modeler, select the desired polygons and choose Add Luxigon. When the 
dialog appears, select the type of light you wish to add and set its properties. In image 01 below you will see that the 
polygons of the dome are flipped inwards. Lights placed with Luxigons point in the direction of their polygon’s 
normal.

If you wish to use an existing light’s properties, set the default scene light’s properties and they can be used when 
you Convert Luxigons. Load the object into Layout and choose Utilities > Additional > Convert Luxigons. Select the 
existing light in the Clone Item pop-up menu if you wish to use the settings you have chosen. If you choose to Clone 
you will have set the Luxigon lights’ names from the name of the light you are cloning. Otherwise, enter the desired 
name of the new lights in the Light Name field. After you click OK, the defined lights will be created, positioned at 
the center of the appropriate polygons, aligned with the polygons’ normals, and parented to the object.

Add Luxigon Add/Edit Pgons Clear Powergons

You can clear Luxigons from selected polygons using the Setup >Layout Tools: Clear Powergons command.
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Before we discuss Powergons, it is important to understand Layout commands. If you have ever customized 
keyboard shortcuts or menus, you have touched on Layout’s underlying command structure. Nearly all of your 
actions in Layout are executed by sending discrete commands.

The commands listed in the keyboard shortcut and menu configuration panels only show the command name, but 
not any parameters the command might support. For example, the Render Options command causes the Render 
Option Panel to display. It obviously needs no additional information to execute. The Add Spotlight command, on 
the other hand, can take an optional argument that names the added light. Thus, executing “Add Spotlight 
CoolLight” would add a light named CoolLight.

You can get a much better idea of what we are talking about here by choosing Utilities > Commands: Cmd History (In 
Layout). This opens the Command History window. Leave it open and execute some operations in Layout. You will 
see commands whiz by as you click buttons and drag scene items. Here, you can see not only the command names, 
but also any parameters. You’ll also see some commands that are not listed in the keyboard shortcut and menu 
configuration panels, like Position and Rotation.

Add Luxigon Add/Edit Pgons Clear Powergons
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What are Powergons?

Powergons allow you to execute a short Layout command script, which is attached to selected polygons in Modeler. 
You can use this feature to quickly add, say, lights using polygons for positioning. Moreover, all of the light’s 
properties can be defined as well.

To Attach Commands

To attach a Powergon command script to polygons, first select the target polygons in Modeler.

Then choose Setup > Layout Tools > Add/Edit PGons. This brings up a dialog where you can enter the command 
script.

There are certain special “escape” characters you can use:

\a - Returns the area of the polygon.
\c - Returns the position of the polygon’s center in the form “x y z”.
\d - Returns the polygon’s normal vector as “nx ny nz”.
\i - Returns the item ID of the object containing the polygon.
\n  - Returns the polygon’s normal converted into heading, pitch and bank angles (bank is always 0) in the 
form “h p b”.
\r - Creates a line return to signify the end of the current command and the start of the next. Note that it is 
not needed at the very end of the last command.

Once the script is executed in Layout, you can clear the object if it is not needed otherwise. However, the 
Default command parents the lights to the object, so be careful since you don’t want to delete the children.


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The default command is “AddSpotlight LGON\rPosition \c\rRotation \n\r UpdateMotion\r 
ParentItem \i\rCreateKey 0”. This adds a spotlight named LGON, positions it at the center of the polygon, 
rotates it to match the polygon’s normal, parents the light to the object, and creates a keyframe at frame 0.

Once you click OK, the command script is attached to the selected polygons. (Technically, this action adds a PWRG 
type polygon tag to the polygons.)

To Clear Commands

To clear Powergon commands from polygons, simply select the polygons and choose Setup > Layout Tools > Clear 
Powergons. Activate the General Powergon option and click OK.

Executing the Commands

Once the Powergon commands are attached, load the object into Layout. Then choose Items> Cvt Powergons. This 
executes any command scripts attached to the selected object.

Clear Powergons (Setup > Layout Tools > Clear Powergons) will clear Powergon commands from polygons, simply 
select the polygons and choose Setup>Clear Powergons. Activate the General Powergon option and click OK. You 
can clear Luxigons from selected polygons using the Setup>Layout Tools > Clear Powergons command.

Add Luxigon

Add/Edit PGons

Clear Powergons

Add Luxigon Add/Edit Pgons Clear Powergons
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Add/Edit PGons

Before we discuss Powergons, it is important to understand Layout commands. If you have ever customized keyboard 
shortcuts or menus, you have touched on Layout’s underlying command structure. Nearly all of your actions in Layout 
are executed by sending discrete commands.

The commands listed in the keyboard shortcut and menu configuration panels only show the command name, but not 
any parameters the command might support. For example, the Render Options command causes the Render Option 
Panel to display. It obviously needs no additional information to execute. The Add Spotlight command, on the other 
hand, can take an optional argument that names the added light. Thus, executing “Add Spotlight CoolLight” would add 
a light named CoolLight.

You can get a much better idea of what we are talking about here by choosing Utilities > Commands: Cmd History (In 
Layout). This opens the Command History window. Leave it open and execute some operations in Layout. You will see 
commands whiz by as you click buttons and drag scene items. Here, you can see not only the command names, but also 
any parameters. You’ll also see some commands that are not listed in the keyboard shortcut and menu configuration 
panels, like Position and Rotation.

What are Powergons?

Powergons allow you to execute a short Layout command script, which is attached to selected polygons in Modeler. You 
can use this feature to quickly add, say, lights using polygons for positioning. Moreover, all of the light’s properties can 
be defined as well.

Once the script is executed in Layout, you can clear the object if it is not needed otherwise. However, the 
Default command parents the lights to the object, so be careful since you don’t want to delete the children.


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To Attach Commands

To attach a Powergon command script to polygons, first select the target polygons in Modeler.

Then choose Setup > Layout Tools > Add/Edit PGons. This brings up a dialog where you can enter the command script.

There are certain special “escape” characters you can use:

\a - Returns the area of the polygon.
\c - Returns the position of the polygon’s center in the form “x y z”.
\d - Returns the polygon’s normal vector as “nx ny nz”.
\i - Returns the item ID of the object containing the polygon.
\n  - Returns the polygon’s normal converted into heading, pitch and bank angles (bank is always 0) in the form 
“h p b”.
\r - Creates a line return to signify the end of the current command and the start of the next. Note that it is not 
needed at the very end of the last command.

The default command is “AddSpotlight LGON\rPosition \c\rRotation \n\r UpdateMotion\r ParentItem 
\i\rCreateKey 0”. This adds a spotlight named LGON, positions it at the center of the polygon, rotates it to match 
the polygon’s normal, parents the light to the object, and creates a keyframe at frame 0.

Once you click OK, the command script is attached to the selected polygons. (Technically, this action adds a PWRG type 
polygon tag to the polygons.)

To Clear Commands

To clear Powergon commands from polygons, simply select the polygons and choose Setup > Layout Tools > Clear 
Powergons. Activate the General Powergon option and click OK.
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Executing the Commands

Once the Powergon commands are attached, load the object into Layout. Then choose Items> Cvt Powergons. This 
executes any command scripts attached to the selected object.
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Add Luxigon

Luxigons (Setup > Layout Tools > Add Luxigon ) are like Powergons (discussed later), specialized just to add lights and 
set certain light properties. To use, in Modeler, select the desired polygons and choose Add Luxigon. When the dialog 
appears, select the type of light you wish to add and set its properties. In image 01 below you will see that the polygons 
of the dome are flipped inwards. Lights placed with Luxigons point in the direction of their polygon’s normal.

If you wish to use an existing light’s properties, set the default scene light’s properties and they can be used when you 
Convert Luxigons. Load the object into Layout and choose Utilities > Additional > Convert Luxigons. Select the existing 
light in the Clone Item pop-up menu if you wish to use the settings you have chosen. If you choose to Clone you will 
have set the Luxigon lights’ names from the name of the light you are cloning. Otherwise, enter the desired name of the 
new lights in the Light Name field. After you click OK, the defined lights will be created, positioned at the center of the 
appropriate polygons, aligned with the polygons’ normals, and parented to the object.

You can clear Luxigons from selected polygons using the Setup >Layout Tools: Clear Powergons command.
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Clear Powergons

Clear Powergons (Setup > Layout Tools > Clear Powergons) will clear Powergon commands from polygons, simply 
select the polygons and choose Setup>Clear Powergons. Activate the General Powergon option and click OK. You can 
clear Luxigons from selected polygons using the Setup>Layout Tools > Clear Powergons command.
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Fiber FX

Click here to expand Table of Contents...

FiberFX Strand Modeler
Global Controls
Fiber Tab
Guides Tab
Random Tab
Gravity Tab
Tools1 Tab
Tools2 Tab
Options Tab

Strand Tool
Strand Maker

FiberFX Strand Modeler

There are a number of tools available in LightWave 3D Modeler for FiberFX. These tools not only allow you to build 2-
point poly chain fiber guides for use with the FiberFX Pixel Filter plugin in Layout but the creation of full 3D fiber 
geometry, Vertex Bias maps for controlling fiber direction and auto-creation of UV maps for 3D fibers.

The Strand Modeler is the main part of FiberFX inside LightWave Modeler. When opened the Strand Modeler interface 
looks like this:

Viewport Hotkeys

The OpenGL viewport window supports many of the same hotkeys as LightWave 3D. Holding down the Alt key while 
dragging in the viewport rotates the view, Alt + Ctrl zooms and Alt + Shift pans the view.

The ‘a’ key auto fits and centers the object in view. The numerical keys 1 - 6 changes the viewport to show front, back, 
top, bottom, right and left views respectively.

Global Controls

Surface Selection & Controls
In the lower left-hand corner, you can select which surface on your model to grow your fibers on using the popup menu. 
You are not limited to just one surface, selecting a different surface name allows you to grow fibers with different 
settings on each surface in one fiber modeling session.

Once you have selected your surface, click the ‘Grow’ button, this will then add fibers to the selected surface using the 
current settings. Switching between surfaces allows you to edit the fibers parameters for that particular surface.

You can also click the ‘Hide’ button should you need to clean up the view while working on a particular part of your 
model.

This group is dedicated to Modeler tools for Layout’s FiberFX hair and fur system. For the Layout interface and 
controls see FiberFX


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FiberFX Strand Modeler showing fibers with different parameters grown on an object.

Load / Save
If you want to save your fiber editing session for later, you can save and load using these controls (you will need to save 
each surface setting if you have more than one). Note, any guides you’ve added will not be saved. To store guides you 
must click the ‘Okay’ button to complete the session. Fibers will be created along with the guides (each in different 
layers). To recall your session you must first load the settings, then load the guides using the ‘Add Guides’ popup menu 
found under the ‘Guides’ tab.

Fiber Tab

Fiber Distribution
There are two methods for distributing fibers over your models surface, ‘By Area’ and ‘1 Per Polygon’. Both of these 
methods also have a ‘Scaled’ option whereby the size of the underlying polygon is taken into consideration; you can 
adjust this compensation by adjusting the ‘Area Scale’ property. This gives a total of four actual distribution methods.

By Area - The number are fibers in the ‘Fiber Qty’ setting are scattered across the whole surface randomly. 
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Fiber Distribution ‘By Area‘

By Area Scaled - The number are fibers in the ‘Fiber Qty’ setting are scattered across the whole surface randomly 
but scales the length of the fibers according to the underlying polygon area size. This scaling can be adjusted by 
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the ‘Area Scale’ control.  
Fiber Distribution ‘By Area Scaled‘

Per Polygon - Places one fiber at the center of each polygon on your surface, this creates a very ordered 
appearance. If you use these fibers as guides in the ‘FiberFX Pixel Filter’ in LightWave 3D Layout, you can create 
many more ‘virtual’ fibers clustered about the center of these ‘guides’, giving the appearance of more fibers.
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Fiber Distribution ‘1 Per Polygon‘

Per Polygon Scaled - Places one fiber at the center of each polygon on your surface, but scales the length of the 
fibers according to the underlying polygon area size. This scaling can be adjusted by the ‘Area Scale’ control.
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Fiber Distribution ‘1 Per Polygon Scaled‘

Area Scale - This setting becomes available when the fiber distribution method is set to ‘By Area Scaled‘ or ‘1 Per 
Polygon Scaled‘. It adjusts the percentage of scaling from the largest to the smallest polygons.
Fiber Qty (Quantity) - Determines the number of fibers to be used in ‘By Area’ distribution mode.
Fiber Length - Set the length of the fibers. If ‘Area Scale’ is active, this would be the length of the polygons with 
the largest area. Length is measured from root to tip with the fiber in an absolutely straight position.

Effects such as Curl, Kink, and Gravity change the shape of the fiber and may cause the overall length to appear 
shorter.
Edge Qty (Quantity) - The number of edges on each fiber strand. The more edges the smoother the strand. If you 
render your fibers using the ‘FiberFX Pixel Filter’ in LightWave 3D Layout, fiber strands can be further subdivided 
by using the ‘Fiber Smooth’ setting. If required, you can cover an object with single point polygons by setting the 
‘Fiber Sides’ setting to 0. The maximum edges per fiber is 127.

   
Left - Edges: 1; Middle - Edges: 3; Right - Edges: 6.
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Fiber Sides - Fibers can more sides if you intend to use FiberFX for creating fully 3D ‘fibers’. 1 side will create 2-
point polygon strands which can be used as guide strands. 2 sides creates flat polygon ‘blades’, and any number 
above 2 will create full 3D fiber objects.

  

 
Sides 1: 2-point poly chains Sides 2: Flat 2D blades Sides 3+: Full 3D geometry

Fiber Radius - The setting controls the thickness of the fiber at the base. It only becomes available when the 
‘Fiber Sides’ setting is 1 or above.
Angle - Multi-sided fibers can be rotated around their axis using this control.
Taper % - Multi-sided fibers can be set to taper along their length, from root to tip. Higher percentages will 
create sharper pointier looking fibers. If set to a negative value, fibers can be made to have blunt flat tips. It only 
becomes available when the ‘Fiber Sides’ setting is 1 or above.

Guides Tab

Spline Type - Changes the spline calculation method for all splines (you can toggle between them).

‘Interpolating’ splines pass through each knot of the guide, whereas ‘Approximating’ splines act more like Bezier 
splines. ‘Interpolating’ splines can be bent tighter, ‘Approximating’ splines are smoother.
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Left: ‘Interpolating’ Splines; Right: ‘Approximating’ Splines

Add Guide
To place a guide on your model to control the fibers, click this button (or press the hotkey ‘g’) then select a polygon on 
your model that will serve as the placeholder for your guide. You can only place one guide per polygon.

To add many guides in one go, use the ‘Grow’ button to add fibers to your model and set the ‘Fiber Qty’ setting to the 
number of guides you require. Then click the ‘Okay’ button to commit your settings. Run the Strand Modeler again and 
use the ‘Add Guides’ popup menu selecting the layer that contains the fibers you just created. These will then load up as 
guides and not fibers. Or you can select ‘Current Fibers’ option which is a much quicker way of doing the same 
operation.

Scale (Guides) - Scales the length of the selected guides, this will also scale the length of any fibers they are 
controlling as a result.
Del Guide (Delete Guide) - To delete a guide hold down the Shift key and drag a box selection using your mouse 
over the guide you wish to delete (normal left mouse clicking doesn’t select a guide as this is how you move 
guide knots, not select them). You can continue to use this same method to select multiple guides. When a guide 
is selected the last knot will be highlighted white. You can now click the ‘Del Guide’ button to remove the 
selected guides.
Add Node (Guide Knot) - To add a new node (or knot) click this button, It will add a node / knot to ALL guides. 
Currently, all guides must have a uniform node / knot count.
Del Node (Guide Knot) - Clicking this button will delete the last node or knot from ALL guides.
Add Guides (Load Guides) - You can add or load guides in a number of ways using this popup menu. You can load 
guides previously saved on layers in your object. 2-point polygon fiber chains can also be loaded back in as 
guides, and not fibers.

Guides can be created from fibers currently growing on the surface. Note: guides created using this method take 
on the exact shape of your current fibers, so any styling done to them will be reflected in the shape of the guides.

You can also create guides based every polygon on the currently selected surface - guides will be created 
matching each polygons ‘normal’ vector. Or you can create guides based on every single point on the currently 
selected surface; again these will be created using the point normal vector.

Save Guides
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Saves the current guide set to the next available layer in Modeler.

Select Node (Knot)
This popup allows you to select either the First / Last node or knot on every guide (it selects all knots on every guide 
because any deletion of knots must be equal on all guides). You can also use Previous / Next to step through 
intermediate knots, or use the ‘None’ option to deselect.

Clear Guides
Clear all guides on the surface.

IK Guides
By default, when manipulating guides using the mouse, they use an IK (Inverse Kinematic) method of handling the 
guide chains which keeps all knots at an equal distance apart. If you wish to override this method, uncheck the ‘IK’ 
option. You will now be able to move knots anywhere you desire.

Interpolation
Guides have several ‘Interpolation’ methods available to them to further refine their area of influence on the fibers. 
Clicking the root knot on a guide changes its interpolation method (the color also changes to show which mode you’re 
in) and if applicable the radius of influence the interpolation has.
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Left: Sharp Wide; Right: Interpolate Wide
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Left: Radius Sharp; Right: Radius Sharp w/fx
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Left: Radius Interpolated; Right: Radius Interpolated w/fx
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Bundled

Radius - Sets the radius of influence for interpolation modes that support it.
Bundle % - The bundle percentage pulls all fibers in the radius of influence together forming a ponytail.
Bundle Bias - Sets how far along the fiber's length they start to bundle together. At 0% the bundling starts nearer 
the tip of the fibers, at 100% bundling starts nearer the root.

Random Tab

This tab contains controls for randomizing the appearance of the fibers to create a shaggier look.

Length - Randomizes the lengths of the fibers.
Jitter X - Randomizes the X axis direction the fiber as it leaves the object's surface.
Jitter Y - Randomizes the Y axis direction the fiber as it leaves the object's surface.
Jitter Z - Randomizes the Z axis direction the fiber as it leaves the object's surface.

Gravity Tab

Contains controls for simulating gravity affecting the fibers to create a more natural appearance.

Strength - The percentage of gravity affecting the fibers. Gravity bends the fibers in the direction of the arrow in 
the gravity direction control box.
Use Normals - Percentage of force pulling fibers into the direction of the surface normal. Useful for the creation 
of surface-hugging fibers instead of being pulled only in the direction of gravity.
Gravity Direction - The gadget allows you to change the direction you want the gravity force to be directed. To 
modify the click and drag the arrow using the mouse.
Reset - Reset the gravity direction arrow to point down.
Slope - Changes the force of the gravity effect according to the slope of the surface. Fibers on upward and 
horizontal facing surfaces receive more of the gravity strength, whereas fibers on downward and vertical 
surfaces receive less of the gravity force.

Tools1 Tab

Tools for fiber styling can be found on this tab.
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Curl % - Percentage of curl. Use in combination with curl turns to create various curl types. These require many 
edges for the smoothest effect.
Curl Turns - The quantity of curl revolutions. Set to 1 a curl would make a single 360 degree curl.
Randomize Curling - Randomize the phase of the curl start.
Kink - Sets the percentage of back and forth kinking like pleats or accordion fold.
Slope Shorten - Shorten the fibers according to the slope of the surface. At 100% the fibers facing down are 
scaled to 0 and fibers in between are scaled accordingly.
UV Bias - Set the directional bias to be applied over each polygon laying down according to the direction chosen. 
Think of this like a joystick at the North Pole. Setting UV Bias to have a specified direction lays all the fibers over 
into this direction. Handy for the creation of parts and the whorl at the top of the head.

Bias works by laying a fiber up or down against its underlying polygon. It can be used to create sleek lay-down 
types of hair. To illustrate, say you are doing a Wolfman. In the normal UV position, the hair part would be at the 
top of the head when contoured. All the hair would be flowing down over the face. If you changed the UV 
contouring setting appropriately, the same operation would produce the part at the nose. Then the hair will flow 
from the nose back across the face, more like animal fur.

Reset - Reset the UV bias and directional bias back to default.
Dir Bias - Use this to tip the “UV bias joystick” at the North Pole into a different orientation.

Tools2 Tab

Tools for fiber styling can be found on this tab.

Clip Object - Select another modeler layer as a clipper object to cut the hair that intersects it. The clipper object 
is shown in wireframe. For instance, you can use a box in another layer to clip hair into a flat top style. Imagine 
hair growing into a form and stopping where it intersects.
Clip Transformation - The clip object can be moved by selecting the transform and using the Ctrl key to 
manipulate it.
Reset - Resets the clip object back to the origin.
Hide - Hides the clip object.
Collision - Set the fiber collision with the surface. These are subject to effects and be aware that guides plus 
effects can drive fibers into the surface since by nature those are predetermined and subject to interpolation.

Guide knots themselves are subject to collisions and can be placed down on a surface.
Axis Mirror - Only available when using guides and is handy for creating a symmetrical hair part. Place the guides 
on one side and fibers on the other side to use them in a mirrored fashion.
Length VMap - Choose an existing weight map to alter the length according to the weight map values from 0 to 1.
Density VMap - Choose an existing weight map to alter the local fiber density according to the weight map values 
from 0 to 1.
Make UVs - UV coordinates are created for the fibers, 0 at the base and 1 at the tip. Useful for weighting animated 
fibers using clothFX.

Options Tab

Contains preferences for the FiberFX Strand Modeler.

Fiber Color - Sets the color of the fibers within the Interface. This does not affect the fiber's color when rendered.
Bkg Color (Background) - Sets the color of the viewport background within the Interface.
Grid - Draws an X-Z grid in the viewport.
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Reset Current Surface - Reset current surface to default settings, any styling will be lost. Guides will not be 
deleted.
Surface Offset - Push points off the polygon by set amount. Useful to offset single point polygons from the 
surface.
Knots Only - Show only the guide knots, turning off the spline drawing.
Ends Only - Show only the root and tip knots, hiding any knots in-between.
Fat Lines - Thickens up the fibers and guides within the interface to make them more visible.

Strand Tool

This is an interactive Modeler tool for adjusting fiber strands using IK after creating them in Strand Modeler. When 
launched the Strand Tool scans the selected layer and builds a list of fiber strands. A handle is drawn at the end of each 
strand and inverse kinematics is used to calculate the new position when moved.

Pressing the N key brings up the numeric panel allowing you to set the IK strength. The numeric panel also lets you 
toggle all knots to adjust interior knots in a strand.

The LMB is used for dragging your control points around and the RMB for scaling the distance between control points.

All knots - Show handles for all knots for dragging. When off only the end handle on a chain will be shown.
Fixed base - When off, the chain's base knot is not selectable for editing.
IK - Switch for inverse kinematic chain edit handling. With this on, chains will move in a sinuous fashion, with it 
off only the control point you are moving will be displaced.
Add knot - Add knot to end of chains.
Remove Knot - Removes the last knot on chains.
Weightmap - Create weightmap containing 0<>1 values, prompts for a name.
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Strand Maker

This Modeler tool allows you to create fiber strands using standard LightWave Modeler tools. When you run Strand 
Maker, it scans the polygons in the current layer then moves to a new layer and builds fiber strands based on the 
geometry.

You can also use LightWave Modeler's curve drawing tools like ‘Sketch’ and ‘Spline Draw’ to create fiber strands by hand 
or convert whole objects into fibers. Any objects with edge loops will create fibers that are continuous, whereas open-
ended curves will create strands exactly matching them.

Once these strands have been creating, you can use them back inside the Strand Modeler as fiber guides for further 
controlling your fibers.

In the quick example below, creating a ball object, delete half to create a hemisphere. Flattening it in the Y-Axis and 
finally converting the geometry to fibers using Strand Maker could be the beginnings of a spider's web.



LightWave 2020  –  LightWave 2020

Reference –  1737

Converting Existing Geometry to Fiber Strands Using the Strand Maker

This tool has no interface and is a one-click way to create two-point poly chains from polygons for use with 
FiberFX. Since FiberFX now works with curves directly, this tool is less needed.


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Genoma

Introduction

Genoma introduces a new way to rig your characters that is fast, flexible and intuitive. With its system of preset rigs and 
rig parts, people new to rigging can avoid the hours and even days it can take to get a usable result and users who are 
already expert riggers can benefit from the time saved by quickly creating the base rig to expand on and being able to 
save to the Genoma preset library for future use.

In contrast with traditional autorigging systems, Genoma is fully extensible. If the built-in biped isn’t enough for your 
multi-armed warrior priest, you can start with the basic biped and add all the extra arms you require. Genoma takes 
advantage of all of Modeler’s tools to shape and reshape the rig to suit your needs and has none of the limitations 
associated with Skelegons of old - such as orientation. Associating weight maps has been made easier and the controls 
for Genoma rigs in Layout make animation easier too.

Genoma is a system that embeds additional information into skelegons to allow them to be converted to more than just 
a set of FK-controlled bones in Layout. Rig information is stored in the object file and custom rigs can be created, 
modified and saved in the proper folder as Presets, so they can be recalled any time they are needed.

Genoma is designed to remove the need to deal with the complexity that rigging normally entails while permitting 
extension and exploration. For the first time, the user doesn’t need to delve into the bones of their creation. The aim 
with Genoma is to give the user the power to create intuitive controls for their characters and let Genoma worry about 
how to perform the actions requested of the rig.

In short, Genoma could be the starting point for an expert rigger who wishes to add more control to their rig and a 
destination for a user keen to animate without having to learn rigging first.

Genoma 1 and Genoma 2

Genoma is in two versions, one doesn’t replace the other. Genoma 1 is great for rapidly applying preset rigs to 
characters for quick animation, whereas Genoma 2 is more of a rigging development kit. It has considerably more 
power and can even handle changes to rigs that are already animated, but with great power comes more complexity 
and so Genoma 2 might be overkill for simple rigging, however once rigged and saved as a preset the Genoma 2 presets 
need no more expertise to use than Genoma 1 presets. Both will be described in the documentation of course and there 
will obviously be the possibility for overlap between both rigging systems.

Genoma 1

Genoma 2



LightWave 2020  –  LightWave 2020

Reference –  1739

•
•
•

•
•

•
•
•

•
•
•
•

Genoma 2

Genoma 2

The Genoma 2 RDK (Rigging Development Kit) is a system for advanced users who already know how to rig in 
LightWave, but want more control and speed for the whole range of rigging needs, from simple to complex.

New to Genoma 2 over the previous iteration are:

Full customization for any rig or rig part
No need for Connector Rig elements
Animation is now preserved when making changes.

Genoma Create
Genoma Edit

Genoma 2 Properties
Set...
Clear...

Genoma Tools
Add Prefix
Add Suffix
Indexed Rename

IKIF+ Rig
LightWave 2019 includes a new Genoma 2 rig used for Japanese TV animation, created by Koutarou SHISHIDO for IKIF+ 
Studio.

The components of Genoma 2 will be described in this documentation, but for full workflow you will need to 
watch the Genoma 2 workflow videos on lightwave3d.com if these descriptions don’t suffice.



1.

2.

3.

If you need to use more than one character in your scene and you want to use the Genoma2 biped presets 
(which uses Math Expressions) you'll need to follow the following steps:

Create your rig (the name of the mesh will be automatically used to give unique names to the math 
expressions).
Launch the included generic LScript that simply renames the proper controls using the object name as 
prefix.
Save the scene, since at that point the item names used in the expressions will be automatically 
updated.

Repeat the operations with another character using of course a different name for the mesh.

This is an operation you should perform once the rig is final.



http://lightwave3d.com
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Your geometry will need to have appropriate weight maps (head, arms, legs, etc.) for this rig to work
This rig is designed to be fluid and simple to use, with no need to have a clunky switch between IK and FK. The rig is also 
compatible with Motion Mixer. Several weight maps are already assigned to this rig by default.

To erase these, in Modeler:

Use the Statistics panel (W) to select all skelegons;
Use Setup > Genoma Edit/Set > Skelegon Weight Map;
In the panel that opens, delete the weight map name and click OK. This will delete all weight map associations 
for the skelegons.

To set your own weight maps to this Genoma 2 rig:

Select the skelegon(s) you wish to add weight maps to;
Setup > Genoma Edit/Set > Skelegon Weight Map.

The use of the similarly-named Set Skelegon Weight in Setup > Skelegons/More > Set Skelegon Weight is 
discouraged.





LightWave 2020  –  LightWave 2020

Reference –  1742

You can save over the supplied IKIF+ rig if you don't wish to have to repeat the weight map removal each time 
you use this rig. It would be more prudent if you just saved your own version of the rig to the same folder and 
then re-used it from that. To do so, save an object with only the modified rig in it to:

<Your LightWave installation>\support\genoma\rigs\Complex_Rigs\G2_Bipeds


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Genoma Create

Presets...
The Presets window is the same for Genoma 1 and Genoma 2 and presets are kept in separate Genoma 1 and Genoma 2 
folders.
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Genoma Edit

Genoma 2 Properties
Set...
Clear...
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1.
2.
3.

Genoma 2 Properties
Item tab
Shape Tab
Bone Tab
IK Tab
Pos/Rot/Sca Tabs
Expression Tab
Scripts Tab

To access the Genoma 2 Properties panel from a new launch of Modeler:

Make a skelegon;
Use Default Tags from the Set… dropdown menu on the Setup tab;
Now you will be able to use the Genoma Preferences

You will have access to eight different tabs.

The options in the upper and common part of the tabs allows the user to rename the current item, to assign a Parent, a 
Target, a Pole or a Spline control.

If Parent is set to CURRENT, the item will respect the current skelegon hierarchy defined in Modeler (skelegons merged 
vertices).Parent can also be set to MASTER if we want the item to be parented to the master null automatically 
generated by Genoma.

If we want no control to be assigned in Layout, we need to set the controller name (Target, Pole and/or Spline) to NONE 
(which is the default status).

Item tab

CURRENT, current, Current, MASTER, master, Master, NONE, none, None can all be used. Leaving the field 
blank will also set the controller name to NONE.


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Item Type - You can decide if the Genoma item will be a Bone, a Null or a Joint once the rig is created/updated in 
Layout.
Leave Modeler Shape Intact - When off, the Skelegon Shape will automatically be assigned when the Genoma 
Properties Panel is closed (according to the Item Type setting defined).

If we want to keep the current Skelegon shape (we can define the Skelegon shape using the SetAppearance tool) 
we need to set this option On.

Item Color - Sets a Layout item color.
Visible - Sets Layout item visibility on or off.
Locked - Sets Layout item lock state on or off.
Record Pivot Rotation - When checked, it make so the item initial rotation values will be set to 0,0,0 (Record 
Pivot Rotation will be used on the item).
Record Pivot Position - When checked, it sets the item current position as the Reset Position
Active Gizmo Channels - User can enable/disable animation gizmos for the item. This is something very 
important to do since items not working as animation controllers should have all Gizmo channels set to off. 
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Rotation only controllers should have HPB on and XYZ/SXSYSZ off.

Is it very important to activate the proper gizmos on the controller, since doing so Genoma2 will recognize them 
as such and correctly store the animation of any controller in the scene, so it can be applied again when Update 
Rig is used.

Shape Tab

From this tab is possible to define any ItemShape attribute, as long as the Genoma Item Type is set to “Null”.

Item Shape - Shape can be either Standard, Box, Ball, Pyramid, Diamond, Tetra, Ring, Grid, or None.

If Leave Modeler Shape Intact is set to off, then the Skelegon Shape will be updated to the selected shape.
Axis - Let the user define the itemshape axis.
Filled - Defines if the shape should be filled or not. Notice some shapes (like Ball) can’t be “filled”.
Xray - Defines if the item shape should be always visible, eben when “hidden” inside an object geometry.
Label - Defines a text label for the itemshape/control.
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Justification - Defines the text justification.
Draw Line To - Draws a graphic line between the current Genoma item and any other item specifying its name.
Selected Color - Defines the color of the Item while is selected.
Unselected Color - Defines the color of the Item while is not selected.
Text Color - Defines the color of the Text Label.

Bone Tab

From this tab is possible to set all the option normally found in the Layout Bone Panel.

The Weight map is assigned using the Set Skelegon Weight Map command.

Bone Active - Defines if a Bone should be set to Active (influencing mesh deformation) or not.
Maya Style Joints - Makes a Bone look like a Maya Joint (it only affects its shape).
Rest Length - Defines the Rest Length of a bone. When set to CURRENT (or current or Current) the rest length will 
match the one of the Skelegon.

Is it possible to specify a multiplier so the Rest Length will be set to the Current Skelegon Rest Length * 
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Multiplier.

For example if we want the Rest of the bone in Layout to be set to half the Rest of the Current Skelegon Rest 
Length, we’ll specify 0.5.

This also works as a multiplier for any ItemShape size.

Weight Map Only - Sets Weight Map Only on or off.
Weight Normalization - Sets Weight Normalization on or off.
Strength - Sets the Bone Strength.
Multiply By Rest Length - Sets Multiply By Rest Length on or off.
Limited Range - Sets Limited Range on or off.
Min/Max - Sets the Limited Range Min/Max limits.
Joint Compensation - Set Joint Compensation on or off.
Joint Compensation For Parent - Set Joint Compensation For Parent on or off.
Muscle Flexing - Set Muscle Flexing on or off.
Parental Muscle Flexing - Set Parental Muscle Flexing on or off.
Muscle Bulge - Set Muscle Bulge on or off.
Parental Muscle Bulge - Set Parental Muscle Bulgeon or off.
Twist - Set Twist on or off. Only available for Joints.

IK Tab
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This Tab presents the same IK options that can be found in Layout (IK and Modifiers).

Spline Fit - Sets the Spline Control Fit option.
Unaffected By IK - Sets Unaffected By IK option on or off.
Goal Object - Sets the IK Goal name.
Objective - Sets the Objective Type.
Initial IK State - Sets from which frame the IK should consider as initial state.
Frame - Sets the Frame for Initial IK State when Base On Frame is selected.
Chain - Defines the Chain option for IK/FK Blending.
IK/FK Blending - Defines the IKFK Blending value.
Goal Strength - Defines the Goal Strength for the IK.
Soft IK Options (NoSoft IK, Chain Chord) - Defines the Soft IK type, and Chain options.

Min/Max - Define min/max percentage for Soft IK.

Match Goal Orientation - Sets the Match Goal Orientation on or off.
Keep Goal in Reach - Sets the Keep Goal in Reach option on or off.
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• Full-TIme IK - Sets the Full-TIme IK option on or off.

Pos/Rot/Sca Tabs

These 3 tabs are the exact reproduction of Layout Controllers and Limits panel. If you need to know how these options 
work, refer to “Controllers and Limits Tab” on page PDF_LINK.

Expression Tab
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In Genoma2 we can create and assign Math Expressions to any Item’s channel.

All you need to do is to specify the expession name in the channel field you want to assign the Expression to.

First thing to do, is to create a Skelegon and use the Set Expression Tag command.

The Genoma Expression panel will open. Here it is possible to specify the Expression Name and the math expression.

After hitting ok, the panel will close and the Skelegon shape will change to a box with a E. That makes identifying 
expression skelegons easy.

To change the Expression name or the Math Expression, we can select the Expression Skelegon again and use Set 
Expression Tag.

When the expression will be created in Layout, the name of the current mesh will be added as a Prefix. That makes easy 
to have different characters sharing the same rig working correctly in the same scene.
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Scripts Tab

Among the most advanced features of Genoma2, the Scripts Tab lets the user request the execution of an LScript, a 
Python script, or a Custom Genoma2 function.

LScript and Python - LScript and Python Scripts should be added to LightWave as plugins. Then all is needed is 
to specify the name of the scripts.

If an item has the execution of a script (LScript or Python) assigned, the item will be selected and the script 
executed.

Of course this requires scripting skills from the user. In complex pipelines, especially for production demanding 
a lot of characters to be rigged, user scripts can really play a very important role speeding up the whole process.

NEVER USE SPACE IN THE EXPRESSION NAME. USE “_ “ INSTEAD.
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• Custom - Custom scripts are Genoma2 internal procedures that can be called for each item.User can specify only 
one Custom Script per item.
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Set...
A lot of these options are intended to be used to mass change Skelegons, rather than having to edit one Skelegon at a 
time in the Genoma Properties window.

Default Tags
The first entry on this dropdown is the command you will use to prepare skelegons for use with Genoma. You can also 
use this item to clear bones you have already set up with other options to bring them back to a default state. However, 
bone color and size will not be changed.

Expression Tag

This converts your Skelegon into a receptacle for an expression (and changes the Skelegon shape, as shown). Syntax for 
these expressions is explained starting on page PDF_LINK.

Position, Rotation, Scale, Target, Parent, Goal, Pole and Spline
These entries perform the same function as the tabs in the Genoma Properties window, but will be applied to however 
many Skelegons you have selected, rather than having to perform the changes on each bones individually in the 
Genoma Properties window.

Controller

All the entries in this list require explicit selection.
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This allows you to change controller settings for multiple bones at once. Select the Leave Unchanged entry to keep 
existing settings.

Skelegon Weight Map

Similar to Genoma 1, this allows you to assign weight maps to multiple bones at once.
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Clear...
This dropdown will clear all tags from selected Skelegons. It does not follow the normal Modeler rule of “Nothing 
selected, all selected”.

Clear looks like it can be undone in case of error, but it will result in unusable bones that need their tags re-
applied.


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Genoma Tools

Add Prefix

This creates a prefix for selected Genoma bones. Replace the word Prefix with the name of your chosen prefix. If 
you uncheck the Reassign Selected Only box, all Genoma bones on a layer will be renamed.
Add Suffix

This creates a suffix for selected Genoma bones. Replace the word Suffix with the name of your chosen suffix. If 
you uncheck the Reassign Selected Only box, all Genoma bones on a layer will be renamed.
Indexed Rename

When a Skelegon has been assigned Genoma 2 tags, you must use this function rather than the Normal Rename 
Skelegon tool.
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Add Prefix

This creates a prefix for selected Genoma bones. Replace the word Prefix with the name of your chosen prefix. If you 
uncheck the Reassign Selected Only box, all Genoma bones on a layer will be renamed.
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Add Suffix

This creates a suffix for selected Genoma bones. Replace the word Suffix with the name of your chosen suffix. If you 
uncheck the Reassign Selected Only box, all Genoma bones on a layer will be renamed.
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Indexed Rename

When a Skelegon has been assigned Genoma 2 tags, you must use this function rather than the Normal Rename 
Skelegon tool.
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Genoma 1

Genoma 1 Presets

Presets are the heart of Genoma. They can be added to so you can build up a library of reusable rig parts or even 
complete rigs to suit your needs. Opening the Genoma Presets window presents you with two main groups: Complex 
Rigs and Rig Parts. Complex Rigs are complete rig setups for bipeds, quadrupeds and insects. Rig Parts are where things 
get interesting since their Atomic structure allows you to mix and match elements to build your own rigs, or expand on 
those that already provided.

Atomic Element (SubRigs)

Unlike normal skelegons where every skelegon is an independent entity that can be detached or removed, Genoma 
subrigs can consist of multiple skelegons dependent on each other. Each one is required to correctly convert the subrig, 
and removing any skelegon in that subrig carries the risk of breaking the rig. As a result, while individual skelegons not 
used for Genoma are normally atomic elements, a Genoma atom can consist of multiple, inseparable skelegons.

Connectors

Connectors are special types of Genoma skelegon that serve as weld targets. They can be thought of as an input port to 
which things can be attached. Any time two or more subrigs are attached (welded) to one another, a connector must be 
used between them.

The two orange connectors in this picture of the wrist part of a rig should never be deleted. The four Magenta 
connectors can all be safely deleted to separate parts of a rig from each other.

Orange connectors should never be detached or removed.
Connectors added by the user are generally colored Magenta.

Use the Color Wireframe viewport display mode to be able to see the different colors of the Genoma items.

Root

If you want to start your rig from scratch, begin with a Root. This will be your character’s Center of Gravity (CoG). When 
converted in Layout, the root’s green box will be converted to provide a controller to enable you to position your 
character.
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Active and Passive Connectors

In Modeler there are two types of Connector that can be added to rigs. The Active button creates connectors that have a 
bone strength of 100% and will deform your mesh while the Passive button creates connectors with a bone strength of 
0%.

FK Controls

All controllers with the same number but a different suffix are identical in use, just with a different appearance to better 
suit different parts of your model.

Pitch Alignment and Control Size Elements

The Pitch Alignment Element and the Control Size Element. Their respective control points are selected.

The green arrow-shaped elements let the user define the Pitch direction of the bone once the rig is created in Layout.

Not every Subrig needs this kind of control. For example IK Chain alignment is automatically calculated by Genoma. 
Forward Kinematics subrigs with a Green element may need orientation by the user.

Some Subrigs present a Green box, that can be used to define the size of the controls that will be created in Layout by 
Genoma. When the Box is not present, it means that the size of any control for that SubRig will be automatically 
calculated.

Parenters

A Parenter is seen as a red line coming from a rig part. Here in the left image we can see the human_head_02 subrig and 
in the right a close up on the eye part of the rig showing the red line marking a Parenter. The single point at the end of 
the Parenter is selected for better visibility. To parent the eye control to another element on the rig, you just need to 
weld this point to the tip of another connector so that moving that connector will also control the eyes in this case. 
Parenters are available on other subrigs for a variety of different purposes.

Spines

There are several different spine rigs in this category, the only difference between them is the number of bones in each.
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Spline Control

In LightWave 11.6 a subrig Spline Control part was added to go with the Spline Control feature. It can be found in the 
Genoma Presets under Rig Parts/04_Spines. There are two versions.

Spline Control 01 - independent controls, no rotation apart from bank. Great for individually animating the 
controls, not so good if you wish to animated multiple controls at once, such as rolling up a tentacle for instance.
Spline Control 02 - The controls are in a hierarchy, with rotation controls in addition to the move controls 
present in the first version.

By default, both rig parts present four controls and 12 bones. By selecting just the Settings section of the subrig and 
choosing Rename Skelegons from the Setup tab you can adjust these numbers as you choose.

For animating along a spline you should select Spline_bone_1 and only change its Z position. You can also select all the 
bones in the spline and change them from Linear Distance to Fit to Spline in the Bones Motion Options panel if you’d 
rather have a spline-based object to animate.

Example: Animating a rollercoaster train

We’ve made a subdivided box and beveled the top to make a simple rollercoaster train. We added a Genoma 
SplineControl_1 subrig and sent the object to Layout, where we created the Genoma rig.
Stretching out the four control nodes, we use the Bank control (RMB) to tip some into the curves we have 
created.
Going to a frame at the end of the scene, selecting Spline_bone_1 and moving along the Z axis will animate the 
passage of the rollercoaster train along the spline.

Example: Animating an Octopus tentacle

Kept the same box, but removed the bevels and added tentacle suckers. Used the Genoma SplineControl_2 
subrig and elected the Settings part of the Genoma subrig and hit Rename Skelegon. Changed the quantity for 
controls from 4 to 6, and the number of bones from 12 to 24.
Sent to Layout and Created rig on the Setup tab in the Genoma section.
Selected all the Genoma Rotate controls and gave them a twist to curl our tentacle nicely.
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Arms, Legs and Hands

Arm_02 has a controller that can be sized and placed. Leg_Foot_01 is a bipedal leg suitable for a human character and 
Right_Hand_01 has one control for each finger. Using the Right mouse button will curl the fingers.

They are several choices for each of these elements.

Arms:

Arm_01 - The user cannot choose the size or position of the controls and the Pole Vector follows the IK 
Controller’s movement.
Arm_02 - The user can choose a size and placement of the controller and the Pole Vector is independent from IK 
Controller movement.
Arm_simple_01 - The simplest Genoma arm rig. No control sizing, no shoulder or wrist twist.
Arm_simple_02 - Like Arm_simple_01 but with its Pole Vector reacting to IK controller movement.

Legs:

Insect_Leg_01 - Simple insect leg subrig. The user cannot choose the size or position of the controls and the Pole 
Vector follows the IK Controller’s movement.
Insect_Leg_02 - Additional segment and Pitch Alignment and Control size are available. It also has an additional 
FK control.
Leg_Foot_01 - A humanoid leg with reverse foot.
Quadruped_leg_01 - Creates the hind leg of a quadruped animal.
Three_part_leg_01 - A generic three-segment IK element that can be used for many purposes.

Hands:

Finger_01 - An additional finger to add to a hand subrig or act as a horn or similar for your character. This finger 
has one control to curl or uncurl the finger. Finger_02 has a control per joint.
Left_hand_01 - Creates a five-fingered hand with one control per finger for curling and uncurling (using the right 
mouse button). There is a matching right hand.
Left_hand_02 - Creates a five-fingered hand with three controls per finger for curling and uncurling. There is a 
matching right hand.

Heads

There are two head rigs included in the Genoma Presets in 11.5. The first (human_head_01) has the green Pitch 
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Alignment and Control Size elements for several parts of the subrig. The second subrig (pictured) also has a Parenter for 
the eyes.

Muscles and Targets

This group contains muscles, targets and tendons. Muscles and Tendons are related so we’ll describe those first.

Muscles
There are two Muscle subrigs. Muscle_01 creates a single bone in Layout where Muscle_02 creates two bones. The effect 
they have is best shown by this simple example.

We have modeled a simple subdivided cylinder (01). To that we add a connector_01 to each end (02). Next we add 
Muscle_01, as can be seen it needs scaling up (03) . When scaled appropriately, weld the points shown to attach the 
connectors to the muscle (04). 05 and 06 show the muscle stretching and squashing the cylinder. As can be seen in 
image 04, there is a parenter that can drive the muscle through another are of the rig.

Tendons
Again there are two tendon subrigs, once with a single bone and one with two. The two-bone tendon makes even more 
sense than the two-bone muscle since it can have its two Parenters aligned to separate parts of the rig giving a nice 
twist to the tendon.

The steps for adding a Tendon to this cylinder are identical to the muscle placement, but the difference is that a tendon 
doesn’t have the bulge or stretch of a muscle as shown by images 05 and 06.

Target Controls

A variety of single eyeball or eyeball pair subrigs, with and without Parenters.

Overview

There are two short sections in the Setup menu in Modeler and Layout for Genoma. For Modeler there are three menu 
items:
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Genoma Presets - This opens a window with a set of premade rigs and rig parts to enable you to swiftly create your own 
customized rig. There are two buttons at the top of the window that are available if you open the Genoma Presets 
window with a connector already selected:

Align - This will align the new connector with your existing rig. If you untick it the Genoma Presets window will 
show you what you will get instead.
Merge Results - If you untick this option, the new subrig element you add from the Genoma Presets window will 
not be attache to your existing rig.

Connector Group - There are two commands in this group, Passive and Active. Both create connectors to extend your 
rig, but before you create a connector you need to select two points on your geometry - the base of one part of the rig 
with the top of another part. Clicking Active will now place a Genoma Connector between the two points you selected 
with a bone strength of 100%. Clicking Passive will create a connector not designed to affect the mesh that has a bone 
strength of 0%.

In Layout there are two commands for Genoma in the Setup tab..

Create Rig - This takes the rig you have created in Modeler and converts it into an IK/FK skeleton. Your OpenGL viewport 
should be switched to Bounding Box before you click this button.

Update Rig - If you realise that some deformation is ugly or you need more flexibility in a body part, you can edit your rig 
in Modeler and then update it here. Existing animation will be lost.
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Editing

In general any Modeler tool can be used to edit the Genoma Rigs. That makes adapting a pre-existing Genoma Preset to 
any character mesh fast and easy using tools that are familiar to the LightWave user such as Move, Rotate, Drag, Mirror 
and so on. It is possible to Copy and Paste Subrigs without problem. Select a subrig starting with the magenta 
connector to ensure that you are selecting the atomic elements that make up the subrig.

Creating Presets

Building your own Genoma presets is a simple operation. Build your rig as you need and save the object. Move the 
resulting LWO file into the LightWave/support/Genoma/rigs folder structure.

Some general rules that have to be followed:1) Never “break” a SubRig. None of its parts can be deleted or 
detached.2) Connectors attach different SubRigs. All SubRig elements have a Connector just for this.3) You can 
weld the tip of any Connector to the Base of any SubRig. Or the tip of any Connector to the base of a new 
Connector.4) You can attach more than one Connector to the tip of another Connector.5) You can attach more 
than one SubRig to the tip of any Connector, just use the Base of the SubRigs.6) You can tell the Base of any 
SubRig from its color (normally Blue).



To hide everything except your mesh in Layout, create a selection set of all the items in the scene apart from 
the mesh and then you can hide or show that selection set easily. Selection sets will stop working if you update 
your rig, so do not create a selection set until the rig is finished and you start animating.


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 Example: Rigging the Cube

Darkside Animation has provided a cute little character for this example. As you can see it won’t exactly fit one of the 
preset rigs - it has no spine or separate head and the limbs are somewhat outsized. The only solution is to build a new 
Genoma rig from scratch. To avoid that this tutorial spans 100 pages on its own you will need to pay careful attention to 
the images accompanying it.

The eyes and brows are using Endomorphs for their animation so we won’t be covering how to do those.

This character is provided in the content in both rigged and unrigged versions for you to play with.

Step 1: Starting the rig
We have the geometry in Layer 1 and we’ll rig on Layer 2. To begin any rig with Genoma you need a root to indicate the 
center of gravity (CoG) of your character. Add Genoma Presets > Rig Parts > 02_Roots > Root_01. Put it in the center of 
your cube as shown (01).

With the Root still selected, return to the Genoma Presets window and choose Genoma Presets > Rig Parts > 
01_connectors > connector_05. This will be welded to the end of your Root (02).
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The four arms of this quad connector are going to serve as “head”, “shoulders” and “pelvis”. We’re going to take a 
moment to shift all those components into place. To do so, make sure Symmetry is engaged and use Drag to pull the 
end of the right “shoulder” into place. The “pelvis” needs to be at the bottom of the cube between the legs and the 
“head” can be moved upwards a little (we aren’t going to use it in this example) (03).
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We also want the Root to be more easily accessible, so select the points shown and pull them out of the back of the 
character (04).
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To scale the green box, which will be the controller itself, just deselect the arrow point and pull to make the box bigger 
(05).

Step 2: The arms and hands
Switch to Polygon mode and select the magenta “shoulder” connectors. Now choose Genoma Presets > Rig Parts > 
05_arms > arm_02. This should bring in an arm on each shoulder (06).
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Now you need to switch between Point and Polygon modes and move and drag the parts of the arm rig into place so 
that it matches the geometry (07).
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When in Point mode get used to using the right mouse button lasso to select the general area you wish to work on since 
Genoma will have several parts that should all be moved/rotated together.

Switch back to Polygon mode, turn off Symmetry and select the connector that comes out of the right wrist. Choose 
Genoma Presets > Rig Parts > 07_hands > right_hand_01. This will weld a hand to the wrist but there are two problems 
with the preset hand for this character. The first is orientation, the second is two fingers too many. Re-orient the hand 
until it looks like (08).

Now we need to ditch two fingers so select the outer two down to their magenta connectors (09).
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Then you need to reshape the remaining fingers so they fit the geometry nicely (10).
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That’s fitted the right hand now. Because of the way Genoma works, all we need do is select the right hand up to the 
pink connector and mirror. Just weld the left-hand magenta connector to the end of the left arm and we’re good to go.

Step 3: The Legs and Feet
To add legs and feet to our character we add a connector to our “pelvis”. Select the “pelvis” connector and choose 
Genoma Presets > Rig Parts > 01_connectors > connector_02 (11).

Using Symmetry move the ends of the connectors into place over the middle of the legs and go to the Genoma Presets 
window again. This time, choose Genoma Presets > Rig Parts > 06_legs > leg_foot_01. The legs will come in horizontally, 
but make sure Symmetry is still on and rotate them into position. You will need to do some massaging to get the joints 
into position and fill out the foot (12).
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Step 4: Moving to Layout
The rig is now done and almost ready to send to Layout. There are a couple of steps to perform first in Modeler to make 
sure everything works. First weighting. Weight maps have already been created for the model, so assign the parts of the 
rig that make up each arm, each leg and each finger using the updated Set Skelegon Weight tool. You should then select 
the parts of the rig that are in the cube itself and assign them the ROOT weight map. Lastly, Genoma requires that your 
model only contains one layer and that the bones-to-be are in it with the geometry so cut the rig from the layer it’s on 
and paste it into the same layer as the geometry.

Now we send our object to Layout. Normally it is recommended to change the display mode to Bounding Box to speed 
up the conversion of a rig to bones, but because our sugar cube is very simple you can go ahead as it is. Go into the 
Setup tab and hit Create Rig in the Genoma section.

After a moment, during which messages about cyclic dependencies will appear that are nothing to worry about, you will 
get the following message:
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You can now test how your character deforms and moves. Use the controllers that appear on your character, don’t try 
to use individual bones. If you need to change something, revisit Modeler and make your changes. When you are 
satisfied return to Layout and use Update Rig. Any animation you have applied to the rig will be lost as the rig is remade, 
so deformation should be thoroughly checked before you start animating in earnest. Once the rig is to your satisfaction, 
a suggestion is to use the object picker to filter out everything that isn’t the model.
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•

•

•

Layers

Tools for managing your layers, moving them around, switching between them and more.

Layers Group

Pivot Group

Layer Utilities



LightWave 2020  –  LightWave 2020

Reference –  1780

Pivot Group

Pivot Point Tool

Generally, the pivot point is the positional focal point of the layer’s geometry when animated in Layout. By default, it is 
located at the Origin. Use the Pivot Point tool (Layers > Layers > Pivot) to move the pivot point. 

Once you have placed the Pivot in the new location for the object, press the Enter key. Your object’s pivot will be ready 
to go when you load it into Layout.

Center Pivot / Center Pivot Lyrs

Both tools works on multiple layers to center the pivot point to the geometry on the layer. The reason there are two 
tools is the Center Pivot will center on selections if there are any but is a script and so slower, while Center Pivot Layers 
is much faster, being compiled code, but ignores selections.

If a mesh is already in Layout, the tools in this group will intentionally not alter the existing pivot position in 
Layout. Otherwise any mesh edit would destroy your setup in Layout. To gain the pivot point edits made either 
delete and reload the object or use Layout Modify > General > Reset.


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•
•
•
•
•
•
•
•

•
•
•
•
•
•
•

Layer Utilities

Click here to expand Table of Contents...
Search Layers
Find on Layer
Connected to Lyrs
Cut Swap Paste
Copy Swap Paste
Copy Undo Paste
Flatten Sel Layers
Collapse Obj

These little tools are for swapping layers around and either splitting an object over several layers, or collapsing it down 
to fewer.

Search Layers

Allows setting of FG / BG layers from a searchable list.

Search field - finds layers with the characters typed
Select All - Selects all layers
Select None - Removes selection
Select Invert - Inverts any selections made. Selects all when no selection made
Set Foreground - the default choice. Sets layers as Fg layers when OK selected
Set Background - Sets selected layers as Bg layers when OK selected
Add to Selection - Will add to existing layer choices rather than overriding

Find on Layer

Finds which layers polys reside on by setting the FG layer of any selected polys.


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Connected to Lyrs

If you have multiple unconnected objects on a single layer, for ease of setup perhaps, but you want each to be on its 
own layer, this script will select a polygon, select connected polys, paste them to a new layer and come back and try 
again. The result is that the separate objects are now on separate layers.
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Cut Swap Paste

With a foreground and background layer selected, this tool cuts the object from the foreground layer, pastes it into the 
background layer and makes that layer the new foreground.

Copy Swap Paste

Similar to the previous command, but there are duplicates in both layers.

Copy Undo Paste

Similar to Copy Swap Paste, but leaves the foreground layer active, rather than swapping to the background.

Flatten Sel Layers

Choose Flatten Selected Layers to flatten multiple foreground layers into a single layer in one step. Essentially, this tool 
performs the reverse of Connected to Layers.

Collapse Obj

(default keyboard shortcut END) 

Object Collapser allows for several different ways to manipulate the Layers of an object or series of objects.

If Current Object is selected as the Collapse Mode, the current object will have all of its layers combined into the first 
layer of a new object. That layer will then be named after the object with a “_Collapsed’ assigned to the name.
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If All Loaded is selected as the Collapse Mode, all of the objects loaded into Modeler will be collapsed down to one-
layered objects and then combined into a single New Collapse Object. You can also set Object Collapser to From Dir, at 
which point all the objects in the given directory will be loaded and collapsed as for a All Loaded setting.

You can give the new object that will be created a name using the New Collapse Object name field. The New Collapse 
Object can be created in two different styles.

If Collapse to is set to Single Layer, the newly created Collapse Object will be a single layered object with all of the 
objects placed in that one layer.

If Collapse to is set to Multilayer, the newly created Collapse Object will be a multi-layered object with each object in 
Modeler placed in its own layer. Each layer of the new Collapse Object will be named after the object it represents.



LightWave 2020  –  LightWave 2020

Reference –  1785

Layers Group

Layers Panel

Layer Settings

Delete Layer

Insert Layer

Swap Layers

Next Layer

Prev Layer

Next / Prev Lyr Bank

Select All FG Layers

Select All BG Layers

Select FG Lyr Range

Select BG Lyr Range
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•
•
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•
•
•

Layers Panel

(default keyboard shortcut F7)

You can also use the Layers Browser window (Layers > Layers Panel) to do the following:

Access more than ten layers at a time
Set foreground/background state, even between objects
Navigate between objects
Name layers
Set layer visibility flag
Parent object layers

Layers panel has a pop-up menu that lets you switch between List and Hierarchy views.

The List view lists the layers. In the Hierarchy view, the layers of an object are shown in their parental relationship, and 
that can be altered by dragging and dropping layers. Layers cannot be moved between objects and all children at the 
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same level are shown in numeric order.When in Hierarchy view, the layer list shows layers with nothing in them leftmost 
in the list, and lists two more than are currently being used. This makes it match list mode behavior more closely.

The Alt+no. (1 through 0) keyboard shortcut will place a layer into the background. Note that if only one layer is active, 
it cannot be placed into the background.

All of the currently loaded objects will be listed. Click on the white triangle to expand or contract the layer listing for a 
particular object. Layers in the foreground will have a checkmark in the corresponding F column. Clicking in the F 
column for a different layer will place that layer by itself in the foreground. To add to the current selection, hold the 
Shift key as you click. The B column works similarly on background layers.

The Visibility flag can be toggled on/off for each layer by clicking in the column. A layer is invisible to Layout when the 
(Visibility flag) dot does not appear. You may want to use this on scratch layers and cutting objects used for booleans. 
This setting has no effect on Modeler.

Double-click on a layer name (unnamed by default) or choose Layers > Layers > Layer Settings to bring up the dialog to 
set the layer name and parent.

The Layers panel has received various updates in 2019.1, including making the List or Hierarchy choice more 
permanent between sessions, and making the rename window resizable.

A pair of empty layers are always listed after the last occupied layer.
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Freezing layers

Right-clicking on a layer will turn its icon cyan and will lock it as selected whatever other layers you click for foreground 
or background. If you move the layer the frozen checkmark will follow. To unfreeze a layer, right click it again.

Moving and Exchanging Layers

In List mode, if you select a layer and move it up or down there are two kinds of lines that indicate where you are. A line 
will show where the layer you have chosen will be inserted. If you have box around the layer it will be exchanged with 
the layer you have selected. The names of the layers will follow the layers. In Hierarchy mode, the line has no effect 
while the box will parent a layer.
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Layout Visibility

Click where the cursor is to highlight layers to send to Layout
Clicking in the empty square above the Eyeball column in the Layers panel will highlight all layers that will get sent to 
Layout (Reminder: Unchecking a layer in this column will not send it to Layout, useful for layers that are only intended 
as work layers rather than final geometry).

These actions for Layers have no undos.
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Layer Settings

You can edit a layer’s name and its parenting from this requester. It can also be presented by double clicking on a layer 
name in the Layers panel.

Naming layers is a great way to stay organized in Modeler and will be very important for Multi-layered objects 
in Layout. Each layer in Modeler opens as a separate object in Layout, so unique names will improve workflow.


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1.

2.

Delete Layer

(default keyboard shortcut Home)

Delete Layer (Layers > Layers > Delete Layer) deletes the selected layer and shifts the following layers up the layer list.

Steps for using Delete Layer:

Select Layer.

Choose Delete Layer. All layers are then shifted up the list.
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1.

2.

Insert Layer

(default keyboard shortcut INS)

Insert Layer (Layers > Layers > Insert Layer) inserts a layer in between two layers, shifting the layers down the layer list.

Steps to Insert Layer:

Select the layer above which you would like to have a new layer inserted.

Choose Insert Layer and the selected layer and all following layers will be shifted down.
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Swap Layers

(default keyboard shortcut ‘)

Choose Layers > Layers > Swap Layers to swap the foreground and background layers. This is a handy command to use 
with tools that require background objects like Boolean and Drill.

 

Left: Before Swap, Right: After Swap
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Next Layer

(default keyboard shortcut PgDn)

Advances all selected FG layers by one but keeps any BG layers you had selected (until a selected FG layer replaces a BG 
layer).

Pressing the Page Down and Page Up keys to change the layers

The Pg Up/Pg Dn keys were previously associated with the Layer Banks
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Prev Layer

(default keyboard shortcut PgUp)

Decreases all selected FG layers by one but keeps any BG layers you had selected (until a selected FG layer replaces a BG 
layer).

Pressing the Page Down and Page Up keys to change the layers

The Pg Up/Pg Dn keys were previously associated with the Layer Banks
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Next / Prev Lyr Bank

Choosing Layers > Layers > Next Lyr Bank or Prev Lyr Bank will change the bank of layers. The Bank Selection buttons 
are mapped to the PageUp and PageDn keys by default. The highest bank number is 99, but you can access higher 
layers using the Layer Browser Panel.
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Select All FG Layers

Selects all FG layers but keeps any BG layers you had selected.
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Select All BG Layers

Selects all BG layers but keeps any FG layers you had selected.
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Select FG Lyr Range

Fills foreground layers between two foreground layer selections.
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Select BG Lyr Range

Fills background layers between two background layer selections.
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1.

Selection Tab

Introduction

This tab contains tools to make sure your selections are as precise as you need them for modelling. You can select 
Points, Edges, Polygons, Volumes, Connected, Loops, Rings, Maps, Surfaces, Paths and more. The more frequently-used 
tools are actually in a Select dropdown menu in the top menu group. You will also find having the Statistics window (W) 
open a benefit while working.

Volume Selection Mode

(default keyboard shortcut Ctrl J)

You may select a portion of an object using a definable bounding box (i.e., a volume).

To use Volume Selection

Choose Volume from the list of selection modes at the bottom of the Modeler window. Draw out a box using 
multiple viewports to encapsulate what you wish to select. If one already exists, you can drag it around from the 
center or drag the edges and corners to re-size. You can reset the bounding box by clicking in an inactive part of 
the interface.

Polygons/points selected in this manner do not become highlighted.
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2. The initial state of the Volume Select is usually Exclude. This means that polygons touching the bounding box 
are excluded. Clicking the Volume button again will toggle to the Include state where polygons touching the 
bounding box are included in the selection. You can also judge the state by looking at the small text field right 
above the Points button.

Note the top edge of the bounding box. It's cutting through a row of polygons. If the Volume mode is set to Exclude, 
that row of polygons will be excluded from the selection

The selection is infinite along the axis perpendicular to the viewport you dragged the bounding box in if you don't size 
the box in all three dimensions. If you open the Volume Statistics Panel (Open/Close by using the Statistics button 
located at the bottom of the interface), you can also use the + and - buttons to formally select/unselect the listed 
points/polygons.
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The Stats window ( W ) is vital for using Volume selection mode. 01 shows a state after the volume box has been drawn 
out. 02 shows having clicked the + on Polygons Inside. If you switch to Poly mode you will see the selected polygons. 03 
shows having returned to Volume mode when there’s already a polygon selection and 04 shows having selected in 
Volume mode, but the Polygons Outside figure doesn’t agree with the polygon selection.

Lasso Volume Select

You can also lasso-select a volume by dragging your RMB in a viewport. A big difference between this and normal 
volume selection is that in a Perspective viewport, the lassoed area is perpendicular to the viewport. Moreover, the 
angle will be retained even when the viewport is subsequently rotated.



LightWave 2020  –  LightWave 2020

Reference –  1804

•
•
•
•
•
•
•

Modify Selection
Points Group
Edges Group
Polygons Group
Maps Group
Specialty Group
Selection Sets

If you are selecting from among many items within a cluttered space, it’s probably easier and quicker to use 
the Lasso tool for Polygon Selection Mode (i.e., RMB).


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•

•

•

•

•

•

•

•

•

•

•

•

Modify Selection

A series of tools that work in the three main selection modes.

Connected

Invert

Invert Connected

Expand

Contract

Select Loop

Select Next / Prev Loop

Select Outline

Select Ring

Selection Switch

Select Cycle

Drop Selection
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Connected

(default keyboard shortcut ])

The Select Connected command (Selection > Modify Selection > Connected) automatically selects all points or polygons 
that are connected to the currently highlighted points or polygons.

This is a powerful tool and one you should add to your memory banks. An object that is surrounded by others may not 
be easily selected using a volume, and may have several surface names (making name selection tedious).

Polygons that have overlapping points, but don’t share any of those points, will not be affected. Use the Merge 
Points command (Detail > Points > Merge Points) to make the edge shared.


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Invert

(default keyboard shortcut “)

To reverse the state of selected and unselected points or polygons, simply choose Invert Selection (Selection > Modify 
Selection > Invert).
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Invert Connected

(default keyboard shortcut ?)

The Select Invert Connected command (Selection > Modify Selection > Invert Connected) automatically selects all 
points or polygons that are connected to the currently highlighted points or polygons and deselects the current 
selection. Think of this command as a mix between Select Connected and Invert Selection.

 

This is a powerful tool and one you should add to your memory banks. An object that is surrounded by others may not 
be easily selected using a volume, and may have several surface names (making name selection tedious).
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Expand

(default keyboard shortcut })

The Expand command (View > Selection > Expand) is a single-step version of the Select Connected command. All 
points/polygons that are adjacent to selected elements are themselves selected.
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Contract

(default keyboard shortcut {)

The Contract command (Selection > Modify Selection > Contract) is the exact opposite of the Expand command, except 
that any elements that are adjacent to unselected elements are deselected.
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Select Loop

(default keyboard shortcut Right) 

Select Loop (Selection > Modify Selection > Select Loop) is a point loop-detecting tool that works in both Point, Edge 
and Polygon Selection Mode. Simply select two or more points or polygons and choose Select Loop. You only need to 
select one edge to show the loop needed. This tool will automatically select any edge loop which includes the current 
selection.

Point Mode

Edge Mode
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Polygon Mode
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Select Next / Prev Loop

(default keyboard shortcut Down / Up)

Once a loop has been selected you can change your selection, moving it to the next or previous loop using these 
buttons or cursor keys.

Select Next / Prev
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Select Outline

This button converts polygon selections into points selection or will convert a large point selection into just the outlying 
points, deselecting the inner points. Although it’s grouped with the Loop tools, you can convert any point or polygon 
selection into an outline point selection.

Select Outline
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Select Ring

(default keyboard shortcut Ctrl Right)

This tool has no effect in Polygon mode. You need to be in Point or Edge. Where a loop goes “in the direction of” your 
selection, a ring goes in the opposite direction.

Select Ring
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Selection Switch

Choose the Selection Switch command (Selection > Modify Selection > Sel Switch) to convert your selection between 
selection by retrieving all the points making up the selected polygons or convert your point selection to polygons by 
retrieving all the polygons enclosed by the selected points. Repeatedly pressing this button will exchange between 
points, edges and polygons.

Selection Switch
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Select Cycle

(default keyboard shortcut Space)

This is perhaps the first keyboard shortcut you’ll learn in Modeler. It switches between Point, Edge and Polygon 
selection modes and cycles around in that order (to get to Point mode from Edge mode, press Space twice).
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Drop Selection

(default keyboard shortcut /)

Choose Drop Selection (Selection > Modify Selection > Drop Selection) to deselect the currently selected points or 
polygons in the Active Mode.

This is a good keyboard shortcut to add to a mouse button if you have a mouse with more than three buttons.

You can also use Double-Click Deselect if enabled in Display Options > Interface
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Points Group

Point-related selection tools.

Sel Points

With an Edge or Poly selection active, clicking this button will transform the selection to a Point equivalent - a selected 
quad poly will become four points, a single selected edge will become two points.

Sel Outline Points

Performs the same function as Select > Convert To... > Points, but the Select function keeps the initial polygon selection 
where Sel Outline Points drops it.
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Edges Group

This group contains selection commands for edges.

Select Edges

Converts a point or polygon selection into the edges that make it. A selected polygon becomes four edges, two points 
become and edge.

Loop Contract / Expand

This pair of commands will take an edge selection and expand it until it locks as a loop. Until it’s a complete loop it can 
be expanded and contracted as desired.

Sel Edge Border

When polygons are selected, running EdgeBorder will select the outer edges of the selected polygons. This will deselect 
the polygons in the process but will add to any edges already selected.

 

Sel Open Edges

When activated, OpenEdges will select any edge on a polygon that does not have another polygon associated with that 
edge. On a closed object with holes -- perhaps generated in 3D scanning a real object, you can use this command, then 
use Sel Points and hit P to create polygons to close holes.
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•

•

•

•

•

•

•

Polygons Group

This group contains selection tools for polygons.

Sel Polygons

Sel Outline Edges

Select Entire Part

Select Entire Surf

Pick Surface

Select Surfaces

Select Polygons from Selection Set
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Sel Polygons

Converts a point or edge selection into polygon selections. Selecting a single edge will not select a polygon, you would 
need to select the four edges surrounding the quad to select it. Likewise the points at all corners of the polygon need to 
be selected.
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Sel Outline Edges

Changes a polygon selection into just the edges on the outside of the polygon selection.
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Select Entire Part

Based on a polygon selection, this tool will select a part that the initial selection is a member of.

Select Entire Part
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Select Entire Surf

Similar to the previous tool (Select Entire Part), this will select any polygons with the same surface name as the initial 
selection.

Select Entire Surface
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Pick Surface

This tool needs no initial selection. As you hover over your geometry it will show the surface names and clicking will 
bring up the Surface Editor with the chosen surface.
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Select Surfaces

Select Surfaces

This window will let you select polygon groups belonging to one or more surfaces. You can match multiple surfaces to 
select the polygons belonging to them as the animation shows.
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Select Polygons from Selection Set

Allows you to select polygons from a selection set, replacing the current selection if you use the command as is, if you 
use Keep Current Selection then the current selection is preserved and added to. The Exclusive option will only select 
polygons all of whose points are in the selection set.
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•

•

•

•

Maps Group

There are several VMap Selection commands that can be found in the Selection Tab under Maps.

Select by Map 

By Vertex Map Value

Select by Polygon Map

Select UV Seam
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Select by Map

The Select by Map command (Selection > Maps > Select by Map) selects or deselects points that have entries in the 
chosen Vertex Map.

Select by Map

You can convert this point selection into Polygons using Sel Switch, discussed before.
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By Vertex Map Value

This tool offers more precision over Select by Map. Not only can it select or deselect by map name, you can also base a 
selection on a range of weights. If you only want to select the points in a map that have a weight of between 40-60 %. To 
top it off, this tool will also make a polygon selection automatically.

Select by Map Influence
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Select by Polygon Map

You can select polygons using per-poly UVs by choosing the Select by Poly Map command (Selection > Maps > Select by 
Polygon Map).
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Select UV Seam

The Select UV Seam command (Selection > Maps > Select UV Seam) automatically selects polygons where the UV values 
span more than half the image - thus assuming that they are seam polygons. If you activate Patch with Poly Map, it will 
automatically turn these into per-polygon UVs.

Select UV Seam is limited, because it will not set UV values past 1.0 or less than 0. Thus, it is possible that some 
important portion of your image will get missed (e.g., you really needed a 1.2 U or V value).

The Select by Map command (Selection > Maps > Select by Map) selects or deselects points that have entries in the 
chosen Vertex Map.
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Specialty Group

Various selection tools.

Select by Normal

Select Path

Select Nth Pattern

Radial Select

Select Powergons
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Select by Normal

This tool is also available in the Select Menu in the Top Menu group. If you use this tool with no selection, you will be 
presented with a reduced range of options - the ones that need no selection. If however, you select one or more 
polygons on an object and then choose Select by Normal you will be presented with a window containing the following 
options:

Angle Tolerance - Polygons whose normals are at no more than this value in difference to your original selection 
will be selected.
Distance Tolerance - This will be ghosted unless you enable the following item.
Use Distance Threshold - This enables the above item where you can specify a maximum distance for Select by 
Normal to work.
Same Surface - Only selects polygons with the same surface.
Select Connected Only - Only selects polygons that are directly connected. If you unweld a group of polygons 
they won’t be selected.
Update - Shows the modifications you made to the selection.
Select by Axis - Will select polygons based on the axis chosen and the Angle Tolerance.
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1.
2.
3.
4.
5.

 

Selecting a single polygon on two, unconnected spheres.
Opening Select by Normal we can see that additional polys are already selected because of the default angle.
Increasing the Angle Tolerance selects more polygons.
Ticking Same Surface removes the polygons on the red surface.
Checking Use Distance will open the Distance field.
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Select Path

This tool will trace a path between two polygons on the same mesh. Start by selecting a pair of polygons:

Now choose Select Path. There is no interface.
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Select Nth Pattern

The n variable is the internal polygon number (which can be seen if you use the Info tool) and the offset variable is 
counted from that initial selection. If you select every 5th polygon in n this tool will get the first poly, the 6th, the 11th 
etc. If you have an offset of 1, it gets the second poly, the seventh, the twelfth, etc. The internal polygon number can be 
referenced from the Selection Info panel.
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Radial Select

The Radial Selection command (Selection > Specialty > Radial Select) will select points that fall within a defined radius 
of the origin, which is either defined in this panel or by selecting a point on your object. Points will be selected if they 
fall within the Inner radius and Outer radius.
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Select Powergons

The Select Powergon command (Selection > Select Powergons) will give you the ability to select Powergons and 
Luxigons in an object.
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1.

2.

Selection Sets

Selection Sets

Selection Sets (Selection > Selection Sets > Selection Sets) will save groups of points that can be reselected by a user-
defined name.

To create a point selection set:

Select a group of points.

Click Selection > Selection Sets > Selection Sets . Enter the desired name in the Name field and click OK.

You can also create and manage your Selection Sets in the VMap area of the interface.

A point can be a member of multiple sets.

You can add to an existing set by selecting the additional points and then selecting the set’s name from the 
pop-up menu.


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1.
2.

3.

1.

To select points in a selection set:

In Points Selection Mode, open the Point Statistics Panel located at the bottom of Modeler’s interface.
Click on the pop-up menu triangle on the last line in the panel. Select the desired selection set.

The selected set’s name will appear on the line. Click the plus sign (+) to select all of the points in the set.

To remove points from a selection set:

Select the points you wish to remove.
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2.

3.

Click Selection > Selection Sets > Selection Sets . Select the set from the pop-up menu.

Activate the Remove Points option and click OK.

You can delete the entire set reference by selecting it and then clicking the Delete button.

Neither deleting operation will delete the actual points, just their VMap.
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•

View
Tools for organizing viewports. Once you are proficient with Modeler you probably won't visit this tab very frequently 
since most of the tools within are easily driven by keyboard.

Viewports Group
View Group
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Viewports Group

Pan

You may pan a viewport by holding the Alt and Shift keys down and dragging a viewport. This feature is also activated 
with the Pan tool (View > Viewports > Pan). If the title bars are visible, you can drag the Move drag button to pan.

Each viewport is a window to a larger world. You can also pan the viewport beneath your mouse by using the cursor 
keys — one grid square for each press. Holding the Shift key will move the view four grid squares. Holding the Alt key 
will nudge by one-tenth of a grid square or the (Fixed) Snap Value amount on the Units Tab of the Display Options Panel
(Edit > Display Options), if that option is active. Alt + Shift will nudge ten times this amount.
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Pressing the G key will center your view around the mouse pointer. This is a very quick way to manoeuvre around. 
Remember this shortcut!

Magnify Tool

The Magnify tool (View > Viewports > Magnify) provides a way to interactively zoom in and out. This feature lets you 
smoothly zoom in or out of your pointer position by dragging your mouse left and right.

If the title bars are visible, you can drag the zoom drag button to zoom.

OpenGL Display Clipping

In some cases, if you zoom in too far, OpenGL will clip out points and polygons — essentially causing them to disappear. 
Unfortunately, this is a feature of OpenGL. (Actually, anything that is not in the exact center of the viewport gets clipped. 
If you center your viewport on an item, it continues to be visible.)

Zoom Tool

(default keyboard shortcut Ctrl Q)

One way to adjust magnification of a viewport is to use the Zoom tool (View > Viewports > Zoom).

It may help you to think of this as moving a window around as opposed to moving the object.

Other viewports will also change to stay in sync with the window you are changing (unless they are Center/
Zoom independent).


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You can drag out a rectangular box using the mouse and the view will automatically zoom in so that the rectangular box 
fills the view window.

Toggle Background Display

A new command for turning on/off the background image display.

Fit All

(default keyboard shortcut A)

Fit All Items in Views Items in Views - Automatic Pan and Zoom. This command will automatically fit objects into the 
viewport. To fit the object in all viewports, use the A key, a shortcut for View > Viewports > Fit All. You’ll often want to 
use this to center-up an object when it is first loaded.
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Fit All

The Fit One View command (Ctrl + A) will fit the object in the viewport under the mouse pointer into that viewport.

Fit Selected

(default keyboard shortcut Shift A)

Choose View > Viewports > Fit Selected (or Press Shift + A) to fit only the selected parts of an object into all viewports.

Other viewports will also change to stay in sync with the window you are changing (unless they are Center/
Zoom independent).


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Fit Selected

Zoom In/Zoom Out

(default keyboard shortcuts < , . >)

Modeler provides many ways to zoom in and out of your viewports. First, you can adjust viewport magnification by 
pressing the period key (.) to zoom in or the comma key (,) to zoom out. (These are shortcuts for View > Viewports > 
More > Zoom In / Zoom Out.) Holding the Shift key while pressing either key (i.e., the > and < keys, on a US keyboard) 
will double the zoom amount.

These tools are located under the View Tab in Modeler if you choose not to use the shortcut keys.

Single View

(default keyboard shortcut Numeric keypad 0)

Choose View > Viewports > Single View to toggle between single and multiple viewports.

Zooming in and out can also be achieved with the scroll wheel of your mouse if you activate the Interface > 
Mouse Wheel Zoom option in Display Options (D)


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Single View, 0 clicked while mouse over the Perspective viewport

The shortcut key for this function is 0 on the numeric keys. This shortcut allows you to choose the viewport 
you would like to have in single view. Do this by placing your cursor over the viewport you would like to use 
and press the 0 key on the numeric keypad.


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View Group

Hide Selected

(default keyboard shortcut - ) 

View > View > Hide Selected will hide selected polygons that you don’t want edited. This makes it easier to work on 
parts of a complex object without splitting it up between layers.

The polygons are still there, but any editing operations will not directly affect the hidden polygons unless they share 
points that are edited.

Hide Unselected

(default keyboard shortcut =) 

View > View > Hide Unselected will hide all unselected polygons. Select all of the polygons that you don’t want to hide 
and then Hide Unselected to hide all the unselected polygons and keep the selected ones visible.

Hide Invert

(default keyboard shortcut |) 

View > View > Hide Invert will swap the polygons presently visible with polygons that have had Hide Selected applied to 
them.

Unhide

(default keyboard shortcut \)

Selecting Unhide All (View > View > Unhide) will reveal all hidden geometry.

Although you cannot directly affect hidden polygons, you can affect them if you modify visible polygons that 
share points.



Although you cannot directly affect hidden polygons, you can affect them if you modify visible polygons that 
share points.


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I/O

Tools for importing and exporting objects.

Import Group
GoZ Interchange
Export Group

Layout

The two buttons in this group duplicate those found at the upper right corner of Modeler and can be assigned keyboard 
shortcuts.

Send to Layout - This button is only available once you have saved the object you are working on. Before then it 
is ghosted.
Sync with Layout - this button resends an object if changes have not automatically been noticed by Layout
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•

Import Group

Various objects formats (*.lwo; *.obj; *.dxf; *.3ds; *.dae; *.fbx; *.stl; *.ply) can be loaded into Modeler without needing to 
import them. This section is for those that can’t.

EPS

Vertex Loader

PDB Loader
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EPS

The Curve Division Level option sets the desired level of detail.

    Curve Level - Rough, Standard, Fine, Super Fine

The Convert to pop-up menu sets the type of object that will be created.

Closed Polygons & Poly Lines - Will create a 2-point polygon chain and Polygons where vector lines are in the file.
Closed Polygons - Will create closed polygons where vector lines are in the file.
PolyLines (Line Polygons) - Will create a 2-point polygon chain where vector lines are in the file.
Spline Curves - Will create splines where vector lines are in the file.

The EPS file is defined by either typing the full path in the EPSF File input field or using the requester button to bring up 
a file requester.

Auto Axis Drill will attempt to automatically drill holes in faces, where appropriate. (e.g., the two holes in the number 8).

Auto Centering will center the resulting geometry.

If the EPS uses a gradient fill, you will need to convert it to a solid fill (e.g., using Illustrator) before using this 
loader, and all fonts used need to be converted to outlines.



If this option is not checked, the geometry will be created and you will have to manually create the hole.

Due to the inherent differences between 2D structured drawings and 3D objects, there will usually be some 
amount of cleanup required.
This command has been tested with Illustrator files up to version 8.


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Vertex Loader

Use Vertex Loader in order to edit Weight Maps for bones that were created from scratch in Layout, or bones that were 
converted from Skelegons.

To use Vertex Loader, choose File > Import > Vertex Loader. First the Load Scene requester opens; select a scene file that 
has object(s) with bones. After you select a scene file, the following dialog box appears. There you select an object that 
you want to edit and click OK.

The selected object is automatically loaded into Modeler and displayed in Vertex Paint with its bones. If the object is 
already loaded, only the bones are loaded from the scene file. Weight Maps set on the Bone Properties Panel in Layout 
are used for each corresponding bone.

Before launching Vertex Loader, please make sure Layout’s Content Directory setting matches Modeler’s.
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PDB Loader

The Protein Data Bank (PDB) is an archive of experimentally determined three-dimensional structures of biological 
macromolecules, serving a global community of researchers, educators, and students. The archives contain atomic 
coordinates, bibliographic citations, primary and secondary structure information, as well as crystallographic structure 
factors and NMR experimental data.

Importing the Glutamate molecule

This importer will read the PDB data and convert it to a LightWave Object. More information about the PDB can be 
found here: http://www.rcsb.org/pdb.

Please note that the PDB Reader will import into the current foreground layer. Start a new object before using 
it if you don't want to overwrite existing data.



http://www.rcsb.org/pdb


LightWave 2020  –  LightWave 2020

Reference –  1858

•
•

•
•
•

•
•

•

GoZ Interchange

GoZ™
Setting Up GoZ™ for LightWave

LightWave support of GoZ by ZBrush
GoZ for Modeler
GoZ for Layout

Example: Using ZBrush to Edit Morph Maps
Example: Converting ZBrush Fibermeshes to FiberFX guides

Additional GoZ™ Notes

GoZ™

GoZ™ support is available in both Modeler and Layout. As with any data interchange there are certain ideal workflow 
practices to be aware of to achieve the best results. You should prepare geometry with tri and quad polygons only. 
ZBrush™ also expects one surface name and a single UV map on the object.

Our GoZ implementation is flexible enough to allow you to work in a variety of different ways.

You can begin your model in LightWave Modeler and send to ZBrush to create the UV map and paint your color texture 
map and generate your displacement and normal maps for the object. Then with a press of the GoZ button in ZBrush 
you can load the changed model back into Modeler and your shaders will be automatically applied to the object 
containing all color, displacement, and normal map information. Our LightWave Modeler GoZ implementation allows 
you to send an Endomorph on your object for further sculpting to ZBrush and back to Modeler. Imagine the facial 
targets and other effects you can create with this technique.

Alternatively, you could begin the model in ZBrush and use GoZ to send your sculpt to Modeler for more detail, then go 
back to ZBrush to continue sculpting. You could then send your final result directly to LightWave Layout, again with all 
the texture, displacement, and normal map shader information automatically set up. In Layout, even your bump 
displacement will be automatically set up on the object with the bump distance supplied by ZBrush to make it easier for 
you to get to the render quickly.

Setting Up GoZ™ for LightWave

For our purposes here we will assume you have already installed and are using ZBrush and now you would like to add 
LightWave to your sculpting pipeline.

For Windows users, normally the installation of LightWave sets up the necessary links with ZBrush, but just in case and 
also for OS X users, here are the steps to ensure communication between the packages:

LightWave support of GoZ by ZBrush

ZBrush “out of the box” doesn’t have built-in support of LightWave. LightWave itself supports GoZ. You, the end user, 
needs to copy a few files into the right location to activate this support inside of ZBrush.

There will be duplication of information as we detail GoZ for Modeler here, but also in the Layout manual
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•

•

•

LightWave GoZ support files are located here:

Windows: C:\Program Files\NewTek\LightWave2015\support\3rdparty_support\GoZOS X: ~Applications/
Lightwave2015/support/3rdparty_support/GoZ

With LightWave and ZBrush NOT RUNNING, Copy both the LightWaveLayout and LightWaveModeler directories 
from that folder to:

Windows: C:\Users\Public\Pixologic\GoZApps\ OS X: MacHD:/Users/Shared/Pixologic/GoZApps/
Now launch ZBrush and open Preferences and choose GoZ at the bottom.You will then find LightWave Layout
and LightWave Modeler

From there, you can have ZBrush find the install - or you can point it there yourself.

Load the model you wish to sculpt in either Layout or Modeler. In Modeler it is the current foreground layer (or the 
selected endomorph) that will be sent while in Layout it is the currently selected object. Now go to the I/O tab in either 
application and choose GoZ. The first time you do so there will be a slight pause as LightWave copies the necessary files 
to your ZBrush installation and then you will be in the ZBrush interface waiting to draw your object onscreen as a tool. 
Once done and modified to your satisfaction, pressing the GoZ button at the top right of ZBrush’s interface will send 
your object back to LightWave, now with the additional sculpting.

Here is an overview of what GoZ offers in both LightWave Modeler and Layout:

GoZ for Modeler

Geometry (tris and quad polys required)
Color Map
Displacement Map
Normal Map
Endomorphs
UV maps can be created in Modeler or ZBrush. ZBrush only supports one UV map per object.
The shader nodes are set up on the object but are not all present in Modeler. You need to open the object in 
Layout to access or edit all the nodes.
Sub Tools are separate objects and that is how you should think of them in Modeler, not additional layers.

GoZ for Layout

Geometry (tri and quad polys required)
Color Map
Displacement Map
Normal Map
Bump Displacement (with bump distance automatically supplied by ZBrush)
When you send your ZBrush Item with Color, Displacement, and Normal map to Layout nodes are automatically 
set up on the object and bump displacement in the object properties is activated.
There is a continuous update of texture maps as long as you are painting to actual texture maps in ZBrush and 
not just poly painting.
You can see your displacement and normal maps with VPR.

http://MacHD/Users/Shared/Pixologic/GoZApps/
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1.

Finally, note that if you change the geometry or polygon count in the middle of your process then vertex maps could be 
lost when exporting back to Modeler or Layout. This means you should get your geometry up to a certain level where it 
has enough points and polys to hold the sculpted detail when you “res up” in ZBrush. Do your sculpting and painting at 
that higher resolution level then when you hit GoZ in ZBrush to send back to LightWave the resolution automatically 
gets lowered back down to the base mesh. This is the typical workflow most often used with ZBrush and other 
applications.

Example: Using ZBrush to Edit Morph Maps

One of the most exciting uses for the new GoZ functionality is to sculpt morphs for your characters. The process is very 
simple and straightforward, but illustrating it should set minds at rest. We will use the Mangalore warrior head for this 
example, found in the LightWave content (characters\Mangalore).

We’ll add a morph map to our Mangalore head. We’ve called it Morph.Mouth_Open . Make sure it’s selected in 
your Morphs list and hit the GoZ button on the Modeler I/O tab.

If you select an endomorph in Modeler to send to ZBrush via GoZ, sculpt that endomorph and then send back 
to Layout instead of Modeler the base mesh will be overwritten. Always select the endomorph that you want to 
send and then make sure that same endomorph is selected on the object in Modeler before exporting back 
from ZBrush.


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2. ZBrush will load or open and you can draw your warrior onscreen. Use ZBrush’s Move Brush to spread the lips 
apart and hit the GoZ button in ZBrush.

The Mangalore head will reappear in Modeler and you’ll notice that you are still in the Morph.Mouth_open 
morph.
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3. Now you can create a new morph to sculpt. This time we are typing Morph.Frown . Once added, hit the GoZ 
button again.
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4.

1.

In ZBrush we brush in the frown for the model and send back. You can carry on adding new morphs and 
sculpting them like this.

Example: Converting ZBrush Fibermeshes to FiberFX guides

ZBrush v4R3 adds the ability to export the fibers supported by ZBrush into LightWave to be used as guides for 
LightWave’s own fiber solution FiberFX. To do this is very simple:

Start with a project inside ZBrush and comb the hair as you’d like it. Since the hair from ZBrush will only be 
guides for FiberFX you will not need a large amount of fibers.
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2.

Reduce the Preview Fiber Visibility down to a low figure. ZBrush will give you the total number of fibers that will 
be saved.

Save your guides out of ZBrush as an LWO file and load it into Modeler.
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3.

4.

The fibers need to be converted into guides for FiberFX using the StrandMaker tool on the Setup Tab, in the 
FiberFX group.

The new polychains will be created on a separate layer, so they need to be saved to a new object (you can 
replace the existing curves on Layer 1 and save over your original object if you prefer).
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5. Send this object to Layout and add FiberFX to it. Turn on Draw to see your newly-added fibers. You’ll see that the 
fibers aren’t exactly following your guides. This is because of the Random Length and Gravity settings. Set them 
both to 0%.
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6.

•

•

•

•

If you wish to increase the quantity of fur on your object, increase the number of fibers per guide using the Fiber 
Quantity setting in FiberFX.

Additional GoZ™ Notes

Surfaces and UV Maps - Don’t forget that ZBrush only expects one of each and will discard any others you have in 
your object. Make sure that if you have several of either you reduce them before sending to avoid losing your 
work.
Saving your objects - It is a good idea to save your sculpt as a ZBrush tool. In case of any problems or wanting to 
continue work started before, saving the LWO from Modeler alone will not keep your sculpting information.
Object assemblies - If you want to sculpt an object assembly as one piece in ZBrush, make sure the parts are 
separate objects (not just layers) and tick Import as SubTool in ZBrush GoZ Preferences.
Cache - to perform the task of shifting data between ZBrush and LightWave, ZBrush has a directory of 
intermediate files. These are normally kept in C:\Users\Public\Pixologic\GoZProjects\Default on a Windows 
system and /Users/Shared/Pixologic/GoZProjects/Default on a Mac. These temporary files are not automatically 
deleted and can take lots of room. If you see messages asking if you would like to use the object from disk, it is 
almost certainly because your ZBrush cache already has an object by the same name in it. You can clear this 
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•

directory safely (when no GoZ process is running). Alternatively in ZBrush GoZ preferences there is an option to 
clear cache files.
Layout or Modeler? - When you first start sending your object between LightWave and ZBrush, you will possibly 
begin using GoZ with Modeler to initially prepare your object for sculpting and texturing. Once you are happy 
with this first stage, you can tell ZBrush to start sending to Layout instead. To do this, can click the ‘R’ icon on 
the ZBrush interface near the GoZ button to change which application GoZ communicates with. In this case, 
change it over to use Layout rather than Modeler.
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Export Group

When you save an object, it will always be as LWO. If you wish to export a different format this group contains all.

OBJ

Export an object as OBJ. No limitations but surfacing doesn’t carry across though UV maps do. OBJs textured with 
image maps or numeric values in other packages will come in textured but Nodal or procedural textures will not 
translate in either direction. Autodesk’s Maya™ and Max™ reverse diffuse and ambient, so the default behavior of 
LightWave now is to Reverse Ka & Kd for OBJ export. If you find that textures are being transferred incorrectly, try 
switching this off on the OBJ tab of Options.
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FBX

Export an object as FBX.

If you have created a UV map you wish to export with an OBJ object, the UV map needs to be in use in texturing 
when you export or the UV map will be dropped. Simply adding a texture map to the Color channel and using 
the UV map will preserve it.



The FBX and Collada exporters do not export information associated with plug-ins, including plug-ins shipped 
with LightWave. In addition, image maps will get passed into the fbx only for Standard or Principled BSDF 
materials with images in a UV-mapped Color T slot or Image node. The Image Sampler node does not work for 
export.



The FBX and Collada exporters do not export information associated with plug-ins, including plug-ins shipped 
with LightWave. In addition, image maps will get passed into the FBX only for Standard or Principled BSDF 
materials with images in a UV-mapped Color T slot or Image node. The Image Sampler node does not work for 
export.


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•

Smoothing Groups - Converts LightWave normals into 3ds Max smoothing groups
Scale Scene - Scales the object being exported to better deal with non-real world units

COLLADA

Export an object as DAE. No limitations but surfacing doesn’t carry across though UV maps do.

EPS

Export an object as an EPS document. This will give you a Top, Side and Front flat wireframe view of your object along 
with UV map, if any.

3DS

Exports an object in the .3DS format. This has a maximum of 64k triangular polygons.

3D Printing Support

Full support for 3D printing formats and a tutorial.

Curve to Motion

Takes a spline from Modeler and makes it into a motion path for Layout.

Motion Throw

Calculates trajectory and bounce on given item and inputs - output is a motion file for Layout.

Unity 3D Mode switch

Both LightWave and Unity use "left-handed" coordinate systems but FBX is right-handed, which means 
LightWave has to convert to the right-handed coordinate system, and Unity has to convert from the FBX right-
handed coordinate system back to its left-handed system. The way to convert from left to right-handed 
coordinate systems is to invert one axis and change the sign of the rotations on the other axes. That means you 
have three choices: X, Y or Z. The typical choice is to do it along the Z axis, which LightWave does. Unity uses 
the X axis, which results in an apparent 180 degree rotation of the scene.

Another oddity on FBX import is the wrong rotation of Lights and Cameras, caused by Unity ignoring any pre-
rotation setting stored in the FBX file, so these need to be compensated as well, again only for Unity.

Using this switch means that when you go into Unity and look down the Z axis the imported FBX looks exactly 
the same as it does inside LightWave.


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•

3D Printing Support

LightWave has always been a good tool for 3D printing with its measurement system based on real-world quantities 
rather than the mysterious “units” used by some other software. This means that if you model the Empire State 
Building to scale in LightWave, it would print out at 1,454 ft (443.2 m) high - presuming you had a printer capable of such 
dimensions, the time to wait for the printout and the money to pay for all the material you’d need.

STL and PLY importers and exporters are included. For full-color 3D printing we support object-oriented VRML export.

Introduction to 3D printing with LightWave

STL Import/Export Format

PLY Import/Export Format

VRML Support
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Introduction to 3D printing with LightWave

Modeling for 3D printing is a new discipline for many with LightWave and requires a certain rigor. Models need to be 
watertight, otherwise known as manifold. This means that they are a solid continuous surface with no holes. You can’t 
use any of LightWave’s tricks, like subpatching or double-sided polygons, everything needs to be present in the model 
but equally you do not need to worry about polygon topology.

The first ring is manifold, there are no holes. The second is manifold too. The ring is hollow but the polygons are 
thickened. Our third ring is not acceptable as an object for 3D printing. Because LightWave’s polygons are single-sided, 
the inside of the ring counts as a big hole, even if it has been surfaced as double sided.
The next important factor is that there can be no intersecting polygons - that’s to say polygons that pierce others 
without being connected.
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The green fold on the left will print well. It has at least 2mm thickness and the fold in the center is contiguous. The red 
object on the right won’t. The two polygons share nothing and have no thickness.
Upresing
When you print a model with too few polygons, it can look faceted in print. If this isn’t the look you are going for, you 
can subpatch your object and then freeze it. However, this will reduce the size of finer details as they respond to the 
subpatching algorithm. A better way to reduce faceting can be achieved by using the Subdivide tool set to Smooth. 
Subdivide needed three iterations to get to an acceptable level of smoothness across this mesh, going from 7,380 
polygons to 472,320.



LightWave 2020  –  LightWave 2020

Reference –  1877

1.

Example: Preparing the Alien Emissary for 3D Printing
We wanted to test LightWave’s capabilities for 3D printing by sending our Alien Emissary model straight out of 
LightWave to Shapeways (http://www.shapeways.com/) 3D printing service for a full-color 3D print.

We started with the Alien Emissary from the LightWave 10 Content Directory. The scene file came complete with 
a character object, TIF texture maps, and a rig that could be used to pose the mesh (01). The mesh was 2.6 
meters tall. This is an appropriate height for an alien character, but too tall for a small statue meant to fit on a 
shelf. The model would have to be scaled at a later point (02).

http://www.shapeways.com/
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2.

 

A bust statue does not require arms or a lower body, so we chopped off the arms and all geometry below the 
lower torso (03). The mesh was not scaled at this point, because we wanted the option of posing the character 
with the existing rig.
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We also created an endomorph that could close the mouth and reduced the size and number of polygons in the 
mouth cavity to make it more suitable for a print (04-06).
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3.

 

A shell with no thickness cannot print (07). The arm holes needed patching. We patched the arm holes using 
Make Poly. Then used Bevel to give these n-gons a bit of an inset, then the Spikey Tool with a 0% Spike Factor to 
convert the n-gons into triangles. The results spackled over the arm holes nicely (08).
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Although the arm holes were now sealed, the alien was still a shell with no thickness. It had a large, open hole at 
the bottom.

 

One solution might have been to patch over this lower torso hole, sealing it off and fulfilling the “watertight” 
mesh requirements for 3D printing. However, a solid torso would have used a lot more material and cost a small 
fortune. In 3D printing, the less material used, the less costly the print. A hollow torso would not only make for a 
lighter statue, but also a cheaper print.

We used the Thicken tool to create an inner surface and a reasonably thick wall. Mindful that this alien would be 
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scaled down to about 25% of its original size for printing, we thickened the alien by 10mm. This way, when the 
alien was scaled down to a quarter of its size later, the wall thickness would not be too thin for printing (10). We 
also turned on the checkboxes for Create New Surface and Create Side Surface to make the new geometry easier 
to select and manipulate and gave the Thickened surface a different wireframe color. This made it easy to see 
intersections in the geometry, for example the eye and chin areas (11).
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4.

 

The interior sides of the eye socket, chin and mouth cavity geometry were simplified and smoothed out so that 
they would not intersect the outer geometry. The endomorph to close the mouth also needed some tweaking on 
the chin geometry (12-15).
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5.

 

The alien now had a watertight mesh that could be printed if scaled down to fit the printing bed. There was just 
one problem: gravity. This mesh had nothing to hold it upright after printing. At best, it could rest on its back if 
printed (16).
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It would need a pedestal. It would also need a structure inside it that could connect it to that pedestal. We built a 
structure by placing 2x2 subpatch cubes inside of the model and using Bridge to connect the sides of these 
cubes to the inner wall and to each other (17-20). This structure could later work with pedestal geometry to 
support the bust.
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6.

7.

We also created a weight map vmap called “Thickened” to mark the inner wall geometry with values of 100%. 
This weight map would be later used to invert the ZBrush displacement on the inside of the mesh (21).

Because the mesh matched that of the original alien, the original rig in Layout could have its mesh swapped out 
for the bust mesh. The alien could then be posed in Layout instead of Modeler. One advantage of posing in 
Layout is that many poses can be tried in one scene by keying different poses on different frames. (22-24) Morph 
Mixer was used to close the mouth.
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The final pose chosen was not too different from the original pose. The mouth was closed and the head raised 
slightly (25-26).
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8.

 

The original node network in the Displacement Node Editor was modified to invert the ZBrush displacement on 
the interior geometry. That way, if the displacement map made an indent on the outer wall, the same spot on 
the inner wall would be raised instead of similarly indented. This helped preserve the wall thickness (27-28).
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9.

 

When saving a subpatch object, Save Transformed respects the Subpatch Display Level . If the Subpatch Display 
Level is set to 0, Save Transformed will save out a subpatch model. If the Subpatch Display Level is set to 1 or 
higher, Save Transformed will save out a frozen, tripled mesh of polygons. The higher the Subpatch Display 
Level, the higher the number of polygons.

We set the Display Subpatch Level to 6, which meant that the bust (not including the pedestal or the eyes) would 
have 321,120 polygons when frozen. The more polygons used to describe details, the smoother the 3D print 
would be. We then used Save Transformed to save out a copy of the mesh in its posed, frozen position (29). A 
different filename was used for this copy so as not to overwrite the original subpatch object.
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Although the exported mesh contained the bust geometry, it did not include the eyes. We selected the eyes 
object, set the Display Subpatch Level to 3 and used Save Transformed to export a frozen copy of the eyes in the 
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10.

same posed position as the bust (30).

We now had two objects representing the posed and frozen geometry of the bust and eyes, respectively. These 
objects were brought into Modeler and placed into a single layer.

As spheres, the eyes did not need any special treatment. However, the bust needed one last inspection to make 
sure that its ZBrush displacement did not cause any intersection errors between the exterior of the skin and the 
interior of the skin. Making sure that the interior had a different wireframe color than the exterior of the 
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11.

geometry was about to pay off (31).

Spinning the model around revealed an intersection between the interior and exterior geometry of the head in 
the rear (32). This intersection had to be resolved to ensure a good quality print.
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12.

13.

 

Selecting the offending geometry and using a combination of Magnet and Dragnet to push the geometry back 
into the skull fixed the problem (33).
At this point, the bust had a pose and good geometry. Now it needed to be scaled to print size. Scale was used to 
bring this mesh down to 25% of its original size. It was now about 200 mm in height (34).

It could be printed, but it would not stand up on its own. This bust still needed a pedestal to support it after 
printing. Like the bust, the pedestal required high enough resolution not to appear faceted and a minimum 
thickness of 2 mm in order to be printable. It also required UV mapping for any texture maps.
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The pedestal was built to scale, using Lathe on a spline to create the shell of the pedestal (35) and mapping it 
with cylindrical UVs (36). We then used Thicken to give it a minimum wall thickness of 2 mm, and (as before) gave 
the Thickened surface a different wireframe color. Color Wireframe and Textured Wire display modes were used 
to detect any intersecting geometry, and the inner geometry was cleaned up by deleting unecessary loops with 
the Edit Edges tool.
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14.

 

A 3D printer can handle intersecting geometry up to a point. We took advantage of this and “attached” the 
pedestal with intersecting geometry. We lowered the bust onto the pedestal until the support structure within 
the bust intersected the top of the pedestal. There was no Boolean involved, just the intersection of two 
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15.

16.

separate meshes (37).

The bust now had a pedestal. It now needed to meet Shapeways standards. All polygons need to be planar for 
3D printing. The bust was already made up entirely of triangles. As a precaution, we tripled the mesh of the 
pedestal (38).
Shapeways accepts GIF, JPG and PNG files for texture maps. GIF images are restricted to 256 colors, while the 
lossy nature of JPG files can result in compression artifacts. We opted to convert all of the original color TIF 
image maps to PNG files and save the model using them instead of the TIFs. For the statue’s surfacing, all non-
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17.

18.

color maps were removed, since the 3D printer was only concerned with geometry and color data (39).

LightWave’s VRML exporter will export the first layer of the object, so we pasted the pedestal geometry, the bust 
and eye geometry into the first layer of the object. This was then exported as a *.wrl file using the VRML exporter.
Lastly, Shapeways expects a ZIP file that contains only the *.wrl and associated texture maps in PNG, JPG or GIF 
format. This ZIP file cannot contain any folder structure whatsoever. Only files can exist inside this ZIP file. 
Shapeways is also case-sensitive, so the texture maps should have the exact same capital and lower case letters 
as the original texture maps.
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The end result surveys our office
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For 3D printing there is no polygon budget and there are no tricks like smoothing or normal mapping. Your 
geometry needs to capture all the detail of your model; you are not going to use it for animating with.


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PLY Import/Export Format

PLY is Stanford University’s evolution of the STL format and doesn’t specifically require triangles. It can keep also 
additional data about an object, such as Vertex Normal maps, UV maps and Vertex Color maps.

Import
When you bring in a PLY file through the file requester or using drag and drop you will be presented with this Options 
window:

It is essentially the same as its STL counterpart only now you can choose to import the UVs, Vertex Colors and Vertex 
Normals with the object if you wish.

Export

As for STL with the Up Axis and Export Units, but Normals, Vertex Colors and UV Coordinates are only available if your 
object has them. For the File Type, if you choose Binary you have the option of Big or Little Endian encoding. Since most 
processors on the market today use Little Endian encoding you will probably be safest using it for your exports.
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•
•

•

STL Import/Export Format

STL is the grandaddy of 3D printing file formats and is in regular use today. It is the lowest common denominator that 
misses out on some of the bells and whistles of more recent formats but can be guaranteed to be understood by all 
software dealing with 3D printing.

Import
STL files can be dragged and dropped onto LightWave to load or they can be loaded using the Load Object file 
requester. When loading in either fashion you will be presented with an Options box like so:

Weld - welds the points of the mesh so that using Select Connected will select the whole mesh
Up Axis - For LightWave it’s Y, but bringing in an STL created with other software might have a different Up Axis. 
This merely rotates the object so it stands upright.
Import Units - Since STL objects have no inherent unit system, one needs to be determined from the number 
field and the dropdown next to it. If you are bringing in an STL made in LightWave, the default of 1 m is good.

Export
When you export in STL format, the first thing to consider is that the format only supports triangles. If your object has 
any polygons of a different number of sides you will see this message:

Any polygons in your object with more sides will be tripled. Polygons with fewer sides (1-point, 2-point) will be deleted. 
Once you have clicked OK you will get this options window:
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In it, you can choose whether your STL file will be saved in ASCII or Binary, what the Up Axis is and Unit Scale for the 
destination environment. There is also the Positive Quadrant setting, which moves the object into the +X, +Y, +Z space 
for printing software that prefers it.
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1.
2.
3.

4.

VRML Support

VRML .wrl files can be saved from Layout or Modeler. VRML is important, not so much for its use on the web these days, 
but for color 3D printing. It is the only format that supports image-mapped polygons right now. The advantage to being 
able to save a VRML object from Layout is that said object can be posed and deformed by modifiers like IK in LightWave 
allowing you to set your model up comfortably. LightWave cannot currently load VRML files.

For objects formats supporting UV maps, these are not preserved in Export unless you follow these steps:

Load the object
Give it a UV texture map.;
Hit F5 and open the Surface Editor and hit the T next to the Color channel. In the Texture Editor, leave the 
texture type as Image Map, select UV as Projection and the UV map you created. You do not need to load an 
image;
Export as the object format of your choice and then reload the object. You will see that the UV texture map is 
preserved, albeit renamed..

Please note that when exporting as STL, PLY or VRML only the current object layer is considered. None of these 
formats support multi-layered objects.


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Utilities Tab

Commands Group

LScript Group

Python Group

Plugins Group
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1.

2.

3.

4.

Commands Group

Edit Commands

User Commands are user-defined names that are associated with a particular tool/plugin. You can also provide 
arguments for the plugin. Once defined, they can be used as standard commands and assigned to a menu and/or key.

To add a user command:

Choose Utilities > Edit Commands . This will display the Edit User Commands dialog.

Enter the name you want to use. We suggest you also use the prefix cmd (e.g., cmdStretchPrOTON). This will 
keep all of your defined User Commands together when they appear in a list together with standard commands.

Select the command you want to use on the Action pop-up menu.

If the plugin requires arguments, enter them in the Argument field.

You can set up multiple User Commands using the same plugin with different arguments.



LightWave 2020  –  LightWave 2020

Reference –  1908

1.

2.

Click the Add button. Your command will appear on the User Command pop-up list, along with any other User 
Commands you have created.

Click Delete to delete the selected User Command. Selecting the Clear All button will delete all defined User 
Commands, but don’t click this unless you really mean it! There is no implicit undo for this. You will have to 
either re-add commands manually or use Edit > Preferences > Revert to Startup Preferences.

Click OK to close the dialog. The User Command will now appear in any command lists.

Maintaining User Command Sets

Although the User Commands are a part of the main preferences, the Load and Save buttons let you retrieve and store 
User Command Sets that you develop.

You can save a list of commands to a file by choosing Utilities > Save Cmd List. This file will list every action 
that is available as well as any arguments for the actions when applicable.



If you need to change the plugin associated with a User Command, you must delete it and then re-add it.
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1.

2.
3.

Edit Startup

You may define any tool/plugin (with arguments) to run automatically when you first run Modeler. Simply choose 
Utilities >Edit Startup and define the command and argument, if applicable.

Steps to Defining a Startup Command:

Choose Utilities > Edit Startup and select an action.

Click OK and close Modeler.
Launch Modeler and your action should take place.
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Save Cmd List

You can save a list of commands to a file by choosing Utilities > Commands > Save Cmd List. This file will list every 
action that is available as well as any arguments for the actions when applicable.

To remove a Startup Command, select (none) from the Action drop-down menu.
You can save a list of commands to a file by choosing Utilities > Save Cmd List. This file will list every action 
that is available as well as any arguments for the actions when applicable.



The un-compiled LScript file format is (*.ls).
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LScript Group

LScript

LScript is a high-level wrapper for the LightWave plugin Application Programming Interface (API). It encapsulates the 
complex underpinnings of the API away from the plug- in developer, allowing them to concentrate more fully on the 
task to be accomplished. LScript also provides added features not available in the plugin API, making plugin 
development faster.

Because LScript has its roots in the C language, the transition between scripting and native-language (binary) plugin 
development is eased a great deal. Scripts written in LScript can often be ported into C with far less effort. This makes it 
possible to use LScript as a rapid prototyping tool for plugin development.

Nearly all of the LightWave plugin architectures have scripting capabilities through LScript. LScripts can be installed in 
the same way plugins are. The LScripts then become commands that can be added to menus or assigned to keyboard 
shortcuts.

LScript also provides a run-time system, allowing scripts to be compiled into an encrypted binary form that prevents 
modification or reverse engineering. Facilities for timed or counted execution are also provided by the run-time system.

Most important, LScript is a virtual machine system. Scripts written on one platform should work directly and 
immediately on any other platform supported by LightWave. This differs from traditional plugin development in that 
each platform must have its own compiler, and each plugin must be compiled and maintained on that platform. 
LScripts are platform-independent.

LScript/RT (Run Time)

Executes a compiled LScript.

LSCompiler

This command will translate an un-compiled LScript to a Binary Compiled LScript.

The compiled LScript file format is (*.lsc).
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Execute Command

This command will allow an LScript command to be typed into the field and executed.
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Python Group

Open Console

Opens LightWave’s own Python console.

Python

This open a requester to load a Python script.
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Plugins Group

Add Plugins Command

(default keyboard shortcut F11)

To add plugins from Modeler, choose Utilities > Plugins > Add Plugins. Navigate to the location of the plugins you want 
to add. Select the plugins, hold the Shift key to select an entire range or hold Ctrl to select multiple non-contiguous 
files. In Modeler, the Add Plugins Panel appears after you select the .p file(s).

The number of individual plugins found will appear in an informational dialog. The added plugins, their type and 
related .p filenames are then listed in the window.

To add additional plugins from the Add Plugins Panel

Click the Add Plugins button and select one or more .p plugin files from a directory.

Re-adding a plugin that is already added will not do any harm.

A single plugin file can have many functions, some internal and not directly accessible by you. Thus, when you 
add one, it may report back that it has added more than one plugin. This is normal.


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To add a directory of plugins

You can quickly add all of the plugins in a directory (including subdirectories) using the Scan Directory button. (It may 
take a few seconds to scan all of your plugin files. Be patient!)

Edit Modeler Tools

This button duplicates the one in the Edit Menu at the top left of Modeler.

This Options Panel gives you the ability to set new default settings on Cut, Divide, and Make Poly. Also, this is where you 
will need to set the settings for the three Quick Cut tools. By default the Quick Cut tools all have the same setting and 
you will need to define them in this panel.

Additional

The Additional drop down menu (Utilities> Additional) will contain any tools added to Modeler that haven’t been 
assigned places in the menu.

Quantize UVs

This button divides the UV space into a grid of the specified size, and then snaps selected points to the closest 
intersection of the grid. If no points are selected, it will snap all visible points to those lines.

You can access the Scan Directory feature from the Edit Plugins Panel .
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How do I use this tool?

To use this tool, select the points you want to quantize, and click the button. (Once again, if you don’t select anything, 
all points will be quantized.) A dialog will open that allows you to specify the size of the Grid Snap, from 0.0 to 1.0. To 
find the number to enter, divide 1 by the number of squares you want in the grid. For instance, if you want 16 squares, 
you’d use 0.0625, If you want 5 squares, you’d use 0.2, and so on.

Enter the number for both the U (horizontal) and V (vertical) axis. If you don’t want any adjustment on one axis, just 
leave it at zero.

Then click OK. The points will snap to the closest grid intersection.

Absolute Measure

Script to find the length of a curve. If you only want to find the length of a segment, select the points making up the 
segment.
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Simulation

LightWave's dynamic simulation tools are split into six main areas:

Bullet Dynamics — LightWave's implementation of the Bullet dynamics library
OpenVDB — Industry standard volumetrics
Fracture — Create realistic breaks for your objects
Flocking — Simulate animal flocking behaviors
FX Dynamics — LightWave's original dynamics system
HyperVoxels — LightWave's original volumetric system
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Bullet Dynamics
Click here to expand Table of Contents...

About Bullet Dynamics
Example - Getting Started with Bullet
Overview of Controls

Bullet Group:
Dynamic Body:
Collision Body:
Constraints: 
Examples:

About Bullet Dynamics

LightWave 11 added Erwin Coumans’ open source, production-proven Bullet Physics Library to its dynamics tools. This 
feature is extremely simple to add to a scene, but its use is a little different from the HardFX plugin existing LightWave 
users are familiar with.





LightWave 2020  –  LightWave 2020

Reference –  1919

•
•

•
•

•

•

•

•

•

Example - Getting Started with Bullet

Overview of Controls

In the Layout FX Tools tab that hosts Bullet as well as other motion effects items Bullet’s properties are split into the 
following groups:

Bullet Group:

Enable Dynamics - This turns Bullet on and off globally for the scene.
Item Properties - This opens Bullet Properties on the Item tab. If any dynamic objects in Layout are selected 
when this is clicked, they will be selected in the Bullet panel.
World Properties - This opens the Bullet Properties on the World tab.
Remove Body - Removes selected objects from Bullet, so they are no longer part of any calculations. The Bullet 
settings for the objects will be lost.

Dynamic Body:

Rigid Body - The object will be subject to all the Hard Body settings that Bullet can offer, such as Gravity or 
Density, but will not break apart.
Parts Body - This is a great accompaniment for the Fracture tool. It keeps your object whole until there is a 
collision event.
Deforming Body - This adds a Soft Body matrix to your object. Your mesh will now be deformed following the 
rules you set for it.

Collision Body:

Static Body - This is the type to add for objects that will not move or be subject to other forces, but will react with 
other bodies. A floor is a good example of a static body.
Kinematic Body - Gives the selected object characteristics similar to Static, but it can be moved through 
keyframed animation, thus it is an object that is under user control. As with Static, it affects other dynamic items 
but cannot be affected by them.

•

•
•
•
•
•
•

•
•

In order to ensure dynamics calculations are free of problems, it is worth noting these guidelines:

Make your models not too small, or too large, as Bullet gives more predictable results when working 
with objects sized roughly between 0.4 - 10 m.
Any collision objects such as ground planes should not be infinitely thin but have some thickness.
Objects made of triangles and quads will generally behave better.
When using the built-in shapes within Bullet, have some Collision Margin set. 5mm is a good default.
Bullet doesn’t work with negative frame numbers.
Prepare your objects for dynamics, ensuring:
Models are ‘air-tight’, meaning all points are merged and there are no un-modeled holes in your mesh 
(missing polygons).
All single points and 2-point poly chains are removed.
Objects don’t have extremely long, thin polygons.


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By default, LightWave draws an overlay on dynamic objects in OpenGL to show that not only are they dynamic, but 
what type.

Constraints: 
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•
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•
•
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•
•

Point to Point - The Point to Point constraint, also known as ball-socket joint, limits the translation so that the 
local pivot points of two rigid bodies match in world space. A chain of rigid bodies can be connected using this 
constraint. No other controls than just attach A to B.
Hinge - The Hinge constraint, or joint, restricts two additional angular degrees of freedom, so the body can only 
rotate around one axis, the hinge axis. This can be useful to represent doors or wheels rotating around one axis. 
It contains Limits and Motors.
Slider - The Slider constraint allows the body to rotate around one axis and translate along this axis. It contains 
Limits and Motors.
Spring - The Spring constraint can create linear springs as shown; or angular springs, like the winding of a watch 
spring.
Cone Twist - The Cone Twist is a special point-to-point constraint that adds cone and twist axis limits. The x-axis 
serves as twist axis. It is useful when creating ragdolls, especially for limbs like the upper arm. It contains Limits 
and Motors.
Spring - The Spring constraint emulates real-world springs, both linear and rotational (like the winding of a 
clock). Contains Limits.
6 DoF - This generic constraint can emulate a variety of standard constraints, by configuring each of the six 
degrees of freedom (DoF). The first three DoF axes are linear axes, which represent the translation of rigid 
bodies, and the latter three axes represent angular motion. Each axis can be either locked, free or limited. Note 
that several combinations that include free and/or limited angular degrees of freedom are undefined. It contains 
Limits, Motors, and Springs.

Forces:

Forcefield, Vortex, Explosion - These three Bullet Dynamics types share similarities in their settings and effect. 
They are global to a scene and affect all other dynamic objects in the scene although falloffs can be created 
using gradients to isolate the effects to certain regions of 3D space. Note, textures for Force settings using World 
Coordinates won’t work correctly.

Bullet Item Properties Window
Bullet Constraints
Forcefield, Vortex and Explosion Properties
Bullet Cache, Hierarchies and Bones
Bullet and FiberFX

Examples:

Baking Simulations - Creating static animations from simulations
Further Examples - Other Bullet tutorials

You can simulate resistance on a hinge constraint by enabling the motor. Keep the target speed at 0 and 
increase the motor force. An initial try for a motor force would be about the mass of the object times the 
gravity. Think about how you would make something real also. You don’t have a door with only one hinge. 
That can cause twisting and even breaking the hinge. You can have multiple constraints between two objects. 
So for a door, you could put two hinges between the door and the wall. Or you could have the hinge constraint 
in the middle, with point-to-point constraints at the corners. The key is that the error due to the twisting is 
relatively small in the middle, but at the corners, it is a large positional error. So like in real life, add some 
supports at the corners to stop it from twisting apart.


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Bullet Item Properties Window

(Default keyboard shortcut: F7)

Inside this window, the first button at the top of the window is to Enable/Disable Dynamics globally in the scene. The 
same button is present on Layout’s FX Tools tab for ease of access. Next to it is a Reset button, use it when the 
simulation isn’t working as you’d expect. The Edit dropdown menu presents several options to add, deactivate and 
activate or remove selected or all items like so:
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You can also open the Preset shelf (F8 when the Bullet Dynamics window is active) or save presets for the selected 
dynamic item. Currently, the Bullet properties that can be saved within presets are:

Density
Friction
Bounciness
Linear and Angular Damping
Glue Strength
Breaking Angle
Breaking Distance
Merge Points
Mesh filter
Linear and angular stiffness
Shape retention
Damping, drag and lift coefficients
Volume scaling and conservation
Dynamic friction
Self collision
Solver iterations
For forces: field type, strength, density, axis, direction

In fact, it’s probably now easier to say which settings are not saved to presets and why. They are:

Enable/disable dynamics item
Shape
Activation and deactivation settings
Collision margin

In addition, neither the mass method nor the given mass are saved to presets currently. The intention is that presets 
save material properties, independent of the specific mesh used.

Next to the Edit menu is a button that allows the user to either show all of a scene’s items or only those that have some 
dynamic properties.
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Select and View Dropdowns

 

Choosing and viewing items in the Bullet Item Properties window.

Bullet Dynamics Properties

The other buttons in the window are divided into two tabs and a list. The list contains every dynamic item in the scene 
along with the type of dynamic body assigned and a checkmark for individually enabling or disabling the object.

Item Tab

Dynamic - This button replicates the functionality found in the list, for enabling or disabling an individual object. 
(You can also double-click an item in the list to activate/deactivate it from dynamics calculations, remember, 
when an item is disabled, the dynamics solution will need re-calculating).
Type - Shows a dropdown with the same dynamic type choices as presented in the Layout FX Tools tab - Rigid , 
Parts, Static, Kinematic, Deforming ; the constraints Point to Point , Hinge , Slider , Cone Twist and 6 DoF ; and 
the Forces Forcefield , Vortex and Explosion .
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Shape sub-Tab

Shape - The collision shape the object has for Bullet. This is a dropdown with five options - Box , Sphere , 
Capsule , Cylinder , Convex Pieces and Mesh . Convex Pieces approximates the mesh shape as a set of convex 
pieces. Convex pieces are faster to simulate than Mesh shapes, but take time to pre-process (the “Decomposing” 
passes you might see happen). Since Convex Pieces only approximates the shape you can lose some details that 
may or may not be important, unlike using Mesh which uses the shape exactly. The other four are simplified 
shapes to make calculation swifter.
Major Axis - Only available when using a predefined Shape, not Convex Pieces or Mesh , and usable mainly with 
the Capsule or Cylinder shapes. It defaults to Y since that is the axis most used for modelling objects that stand 
up, but if you are creating a dynamic pencil, for instance, you might choose X or Z, depending on the direction in 
which the pencil is lying.
Mesh Filter - This setting is only available with Kinematic objects and determines which parts of a mesh are 
subject to dynamic simulation. It is further detailed in the Kinematic section.
Collision Margin - Adds a margin to the collision shape. It makes the shapes a bit thicker and can prevent fast 
moving objects from tunneling through other objects.

Activation sub-Tab

Initial Activation - Sets whether the object starts off active (affected by forces such as gravity), or sleeping (not 
affected by forces until the first time the object is hit). When an object stops moving (or close enough), it will be 
put to sleep, unless it is set to the third option, Always Active . The fourth option, Activate on Last Key allows you 
to give an item some momentum before it is affected by Bullet dynamics and works based on the velocity of the 
motion keys you have assigned the item.

Two keyframes have been set for the ball at 0 and 3. When the last keyframe has passed, Bullet takes over using 
the velocity and vector set by the keyframes. The distance between the two keyed positions will give the velocity 
of the ball so setting a wider gap will make for a faster trajectory.
Deactivation Time (s) - This allows you to control when dynamic items are set to rest by Bullet. Measured in 
seconds, this value sets how long a dynamic item’s linear or rotational speed has to be under the threshold 
settings, before it is then put to sleep by Bullet. This helps control any jittering of items near the end of a 
simulation. Sleeping items will naturally be awoken if they are disturbed by any further collisions.

When using the built-in shapes, a Collision Margin greater than 0 is recommended (5 mm). It won’t 
offset your objects, but helps with calculation errors, this is especially true for smaller objects. When 
using any of the Mesh modes, the Collision Margin will offset your geometry, but can greatly reduce any 
calculation errors, so try setting to a low value, and only set to 0 mm if you really need to.


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Linear Speed Threshold - This allows you to set the maximum distance an item can travel per second to be 
considered by the Deactivation Time before it is stopped by Bullet.
Angular Speed Threshold - Same as Linear Speed, but for rotation. This sets the threshold rotation speed 
(degrees per second) which the item needs to be below to be considered by the Deactivation Time before it is 
stopped by Bullet.

Under the Shape and Activation sub-tabs are two further sub-tabs. Properties and Transform. Properties contains the 
individual properties of a specific Bullet Type (Rigid; Static; Vortex; 6 DoF, etc.), which are all detailed below for the 
specific Bullet types.

Transform sub-Tab

The controls here are for adjusting the predefined shape you have chosen for your collision - they are not available 
when Convex Pieces or Mesh is chosen as the Shape for your dynamic item.
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World Tab

The settings on this tab affect all of a scene’s Bullet simulations.

Gravity X/Y/Z - Although the default is set to an Earth standard gravitational acceleration of -9.8 m nothing 
prevents you from having your gravity point in any direction, or even varying it using Envelopes and Textures.
Dynamics Framerate (fps) - Set the frames per second for dynamics calculations. By default this is at 180 fps. 
Decreasing the value will result in faster calculation times at the expense of simulation accuracy (objects 
penetrating each other). Increasing will result in the opposite, more accurate simulation, but with slower 
calculation times.
Start Offset - Chooses when to start the beginning of the dynamic simulation. If using Frame Number , SMPTE 
Time Code or Film Key Code the number you input will be converted to the frame equivalent in that format. If 
using Seconds , there will be no conversion. For example, a value of 50 in this field translates to: 50; 00:00:02:02; 
3 +02 and 50.0 s respectively when using an FPS setting of 24 in Options.
Time Scale - By default this is set at 100%, however, using an Envelope you can slow down, speed up or even 
reverse dynamics time independent of the scene time to create ‘Bullet Time’ animations like those first 
popularized in the ‘Matrix’ films.
Draw Collision Shapes - There are three dropdown menus here - Draw Bodies , Draw Constraints and Draw 
Forcefields . Each of them has the following options:

None - No collision shapes are drawn for the scene.
All - the default; all collision shapes are drawn for the scene.
Selected - only the item(s) selected in Layout will have their collision shapes drawn.
Related - the items in the selected hierarchy have their collision shapes drawn.

Reset - If you ever see results in Bullet that seem strange to you, it could be the cache needs re-calculating from 
scratch. This button does just that, it clears and resets the cache Bullet is using when solving the dynamics, then 
rebuilds it when you scrub or play the timeline.

By default, all three Draw Collison Shapes settings are set to Related.
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Rigid, Static and Kinematic Properties

Mass Distribution - Determines how Bullet considers the mass of an object to be distributed. Two objects with 
different mass distributions can behave differently even if they have the same shape and weight the same. For 
example, a solid sphere can act differently than a hollow sphere. Bullet offers several distribution methods:

Solid - Mass is distributed through the object, it is solid.
Surface - The mass is distributed over the surface of the object, the object is hollow.
Vertices - The mass is concentrated at the vertices of the mesh of the object only.

Mass Specification - Determines how Bullet calculates the ‘heaviness’ of an item. Bullet can calculate an object’s 
‘weight’ based on mass, or density. Mass is the overall ‘weight’ regardless of what the object is made of or how 
big it is. For example: you can set a 1 m cube to be the same weight as a 10 m cube, and they will clearly be the 
same weight, whereas if you set the density of a 1 m and 10 m cube to 1 kg, the 1 m cube’s mass will be 1 kg/m 
cubed (1 m x 1 m x 1 m x 1 kg = 1 kg) and the 10 m cube would be 1,000 kg/m cubed (10 m x 10 m x 10 m x 1 kg = 
1,000 kg). Quite a difference in Bullet’s world! Bullet offers several calculation methods:

Mass (kg) - Only available when Mass Specification is set to Given Mass . For Parts mode, the amount is divided 
up accordingly to each part’s overall volume, so smaller pieces will be lighter than larger pieces, as expected.
Density (kg/unit) - Only available when Mass Specification is set to Density . The mass of the object is then 
calculated by multiplying the unit specified (kg) per the unit type set in either of the density modes. Therefore; 
kg x (Volume/Area/Number of Points).

Friction - The friction coefficient of the object. Makes objects slow down when in contact with other items.

Bounciness - Determines the level of rebound when objects collide with each other.

Linear Damping - Dampens the linear (translational) motion of the object to slow down its movement.

Angular Damping - Dampens the Angular (rotational) motion of the object to slow down its spinning.

Parts Properties

When Parts is chosen as the body type for an object, additional parameters become available:

Glue Strength - This determines how tightly bound parts are to each other. A low value will have them explode 
apart at first touch, a high value will keep them together.

Breaking Angle - The threshold angle up to which parts can twist/bend before the ‘bond’ (Glue Strength) 
between them breaks and the parts then separate.
Breaking Distance - The threshold distance up to which parts are allowed to move apart before the ‘bond’ (Glue 
Strength) between them breaks and the parts then separate.

In order for Friction to have an effect, colliding objects must each have a non-zero Friction value.

In order for Bounciness to have an effect, colliding objects must each have a non-zero Bounciness 
value.



Glue Strength with no Breaking Angle/Distance set is very dependent on the item’s scale and Mass 
Method used. Be aware that if your object’s weight/mass is too low, Glue Strength can appear to have 
little effect when set above 0%. Try increasing your object’s weight/mass until you see the effect.


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Merge Points toggle - When active, Merge Points will attempt to ensure that matching vertices on either side of a 
fracture have the same position, ensuring the mesh stays ‘air-tight’ while the parts are not broken.. This does 
have a cost in processing time and memory.

Example - Choreograph your destruction

Deforming Body Properties

When Deforming is chosen as the body type for an object, additional parameters become available:

Mesh Filter - This uses the chosen weight map in the geometry to determine what parts are dynamic. Any 
polygons with vertices in the chosen geometry with a non-zero value in the weight map will be considered as a 
deforming body, those with no weight map value are ignored by Bullet.
Shape Retention - This works in two ways. With Shape Lock set to None, it determines how little or much the 
mesh is deformed by Bullet. This mode is controlled completely by dynamics. If you set Shape Lock to one of the 
other options, your object will react in different ways, as noted below.
Shape Lock - works in conjunction with Shape Retention . It presents a dropdown with four choices:
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None - The shape’s translation and rotation are fully controlled by Bullet;
Translation - Translation responds to keyframing. Depending on the level of Shape Retention set Translation will 
still respond to the dynamic solution as well. Rotation is still completely controlled by Bullet;
Rotation - The opposite. Rotation can be keyframed but Bullet controls the translation;
Translation & Rotation - The mesh will follow the keyframed rotation and translation, but will be reacting to 
dynamics in relation to the motion.

Linear Stiffness - How resistant edges are to stretching or shrinking, or how stiff or stretchy the object is. The 
higher the value the more it will attempt to maintain the lengths of the edges.
Angular Stiffness - How resistant the object is to bending. The higher the value the more it will attempt to 
maintain the angles between edges.
Damping Coefficient - Dampens the motion of the vertices.
Volume Scaling - Scales the volume of the object, inflating or deflating it.
Volume Conservation - How well the object maintains the (scaled) volume. When set to 100 % it attempts to 
keep the volume of the object equal to the target volume; set to 0 % it doesn’t conserve the volume at all.
Friction - Defines the friction of the softbody. 0 % for frictionless (lots of sliding), 100 % for maximum friction (no 
sliding).
Solver Iterations - How many passes are done by the solver to solve the linear and angular stiffness constraints. 
Higher values take longer to calculate, but increase the simulation’s accuracy.
Self-Collision - Enable/disable detection of and response to the softbody colliding with itself.
Self-Collision Margin - The collision margin used for self-collision only, unlike the other collision margin which is 
used for collisions between different objects.

Example - Getting started with Deforming Bodies 

Example - Animating a chain with Bullet

Using a Deforming object for Collision

When using a character or anything else deformed by bones, morphs or displacement as a softbody collider, you need 
to transform the mesh itself (or part of it) into a Bullet Deforming body.

If you want to maintain the original shape of the deformed object, you need to set some parameters in the Bullet 
Softbodies panel:

Shape Retention must be set to 100%
Shape Lock must be set to Translation & Rotation
Both Linear and Angular Stiffness must be set to 0
Volume Conservation must be set to 0.

Make sure you set the Subdivision Order after Displacement or last for any Deforming Body subpatch objects 
or they will not work. Subdivision Order does not matter for polygonal objects.



Use simple kinematic shape objects parented to the bones of characters to create effective softbody colliders. 
Capsules are perfect for this.


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1.

Bullet Constraints

Click here to expand Table of Contents...
Example - First Constraint
General Constraint Rules
Point to Point

Example - Point-to-Point

Hinge
Example - Hinge

Slider
Example - Slider

Cone Twist
Example - Cone Twist

Spring
Example - Mars Rover
6 DoF

Example - 6DoF Camera Work  
Example - Non-Object Dynamics

We’ve given an overview of the different constraints for Bullet higher on this page. Now we will go into how to use them 
in a scene. The simplest way to add a constraint is to have two Bullet objects in your scene already, select them both 
and hit the Constraint you want in the FXTools tab, but there are many other ways to create the Constraints you want.

Example - First Constraint

We’ll start very simply. Create a standard Cube with the Modeler Tools tab. On the FX Tools tab, make this object 
a Static Body .


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2.

3.

 

Back to Modeler Tools and create a standard Sphere . Drop it on the Y so it’s below the Cube and move it a little 
to the side and back. On the FX Tools tab, make this object a Rigid Body .

 

Select your Cube , hold down Shift and select your Sphere again. On the FX Tools tab, click Point to Point in the 
Constraints.
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4.

 

Hit Play.

 

You can change the Point to Point Constraint for the other Constraints as you like. To do so, you need to visit the 
Constraint in the Bullet Item Properties window because if you just repeat the steps to make the first constraint you will 
merely add another, not replace it.
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General Constraint Rules

Before we detail each of the different Constraints and how to use them, there are some rules that apply to all of them.

The constraints in Bullet are designed to attach objects together, not to stand in for some invisible long wire. For 
a visible link, you will need to create geometry.
To create a Constraint between a Bullet item and another, select the “Head” first, then the acting object, then hit 
the constraint you wish to use. This will create a Null object, set to the constraint chosen, with the first and 
second objects selected as the two Bodies for the constraint. You can also have a single object selected and 
choose your constraint. Doing this will set the current object as the constraint and you will need to visit the 
Bullet Item Properties window to choose Attach Body 1 and Attach Body 2.
The “Head” of a Constraint will be based on a Null placed at the center of mass of the head object, whose 
position, rotation and scale can be changed, but not animated. Best to do this with Enable Bullet Dynamics 
deactivated.
All constraints are Breakable. For the specific Constraint, visit the Activation tab and set the Breaking Force. 
You can set an Envelope or Texture for the Breaking Force. As an explanation of how Breaking Force works think 
of a 1 kg weight hanging on a constraint in Earth gravity. This weight exerts a force of 1*9.8=9.8 on the constraint. 
So if the Breaking Force is set to 9, the constraint will break. If it is 10, it will not (at least not until some more 
force is introduced, for example through a collision).
All Constraints have an Enable Collision setting. When on, collision detection is enabled between the two bodies 
connected by the constraint. When two bodies connected by a constraint are set up so that they initially touch or 
intersect, instability can occur due to collision detection wanting to move the bodies apart, while the constraint 
tries to keep them together. In a bone rig, for example, it is typical to disable collision detection between 
connected bones for this reason, and to use rotation limits to stop a child bone from rotating too far into the 
parent bone.
All Constraints apart from Point to Point can have Limits set. Limits will be explained with each Constraint, but 
mean that you can control how far Hinges bend, for example.
Constraints apart from Point to Point and Spring can have Motors. Motors can act as brakes, slowing down a 
motion, or accelerators to give motion to things that are otherwise static. A Motor has two settings: Target 
Motor Speed and Motor Force.
The 6 DoF Constraint also has Linear and Rotational Springs. If you are using a Layout-created default 1 m 
Cube as a test object, try a spring stiffness of something on the order of 50,000 as a start (based on the mass of 
the object at 1,000 kg/unit) and adjust up and down to suit.
While Bullet is normally used only with objects, you can apply constraints to other scene items. Try making a 
chain of festive decoration lights, or restraining the camera to a dynamically-animated object.

To create a chain of items, select the head of the chain first, then select the rest of the chain in order and hit 
the constraint you wish to use. They will all be set up correctly in the Bullet window.


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Point to Point

  
The simplest of the constraints, also known as the ball socket joint. It is represented by a single line in OpenGL. The only 
option on the Attachment tab is Enable Collision. There is no damping.
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Example - Point-to-Point

Hinge

   
The Hinge only bends around one axis. As its name implies, it’s very useful for making hinges for doors etc.., but for the 
same reason that a door has two or more hinges, it makes sense to do the same in Bullet because otherwise torsion can 
cause problems. If you would like hinges that are stiffer, harder to move, use Motors. Keep the Target Motor Speed at 0° 
but increase the force until you achieve the stiffness you want. Bear in mind that you might want to increase the Force 
in a negative sense if your hinge bends in the opposite direction.
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Example - Hinge

Slider

   
The Slider constraint offers translation along a single axis. You can set limits for the distance of the slide and also for 
how much Body 2 swings around the axis of the slider. Again, you can use a Motor to slow downslope motion or move 
upslope.
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Example - Slider

Cone Twist

   
A Cone Twist constraint is a little like a Point to Point, only with more restrictions. There are Limits and Motors that can 
be used to better sculpt the motion you require.

Example - Cone Twist

 Spring

The Spring constraint can also be used within the 6DoF constraint, however that constraint is a bit complex if all you 
want it a simple linear or angular bounce. Spring follows the same rules we’ve already encountered with other 
constraints with regards to attaching bodies and enabling collision, but the main points of interaction are the Spring 
controls. By default, Linear Spring Stiffness is set to 10000 to give a satisfying result with default Modeler Tools dynamic 
objects. You can bring your spring to a halt using the Linear Spring Damping setting, but be aware that small values 
work best with this, larger values tend to look unrealistic.

To create an angular Spring it should be noted that the Spring is always around the axis of the constraint. If you wish to 
make a vertical spring you’ll need to create a horizontal constraint as shown in the metronome example in the content.
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 Example - Mars Rover

Load the Mars Rover scene from the content. This complex example shows how you can use Springs to recreate a 
suspension system on a six-wheeled vehicle that is driven completely dynamically.
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6 DoF

    
The most complex of Bullet constraints, this offers both directional and rotational possibilities that are set up in the 
same way as the separate Slider and Cone Twist constraints. In addition to the Limits and Motors found in almost all 
other constraints, there are also settings for Springs. To work well, a spring needs to counteract the mass of the object 
hanging off it as well as gravity.

Example - 6DoF Camera Work  

Example - Non-Object Dynamics
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Forcefield, Vortex and Explosion Properties

These three Bullet Dynamics types share similarities in their settings and effect. They are global to a scene and affect all 
other dynamic objects in the scene although falloffs can be created using gradients to isolate the effects to certain 
regions of 3D space. Note, textures for Force settings using World Coordinates won’t work correctly.

For each of the three types - Forcefield, Vortex and Explosion - the effect is chosen between one of three options:

Force - applies the type as a force. That means that lighter objects will accelerate faster. Similar to hitting 
something.
Acceleration - is like gravity. All objects accelerate at the same rate regardless of mass.
Velocity - is more like wind. Objects will have forces applied to them so that they reach a given velocity (even if 
that velocity is 0). Using Velocity opens up the Density property. Density is used to determine how quickly the 
objects match the velocity set. Set to 0 it will never match (like there is no air at all), while 1 means it will get to 
the target velocity pretty much immediately (like a stick in a fast-flowing stream of water).

The forces can be directed along the axis chosen and can be varied using Envelopes or Textures. In addition the 
Explosion Type has an extra Direction - Center. This marks the Explosion dynamic object as the centre of a radially 
expanding explosion. In the example shown below, the ball and cube are subjected to a forcefield to prevent them 
hitting the floor.
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Note that the gradient is applied to the floor rather than the falling objects. Forces are global, so the two rigid body 
objects falling toward the static floor object are the items that will be affected by the Forcefield. The strength of the 
field that is applied to a given rigid body is determined by evaluating the texture at the position of that rigid body. In 
this case, it would evaluate the gradient by determining the distance of the rigid body position from the gradient input 
object. The ball and cube thus fall toward the floor but are rebuffed the closer they get.

Example: Swirling Leaves

Thanks go to Greenlaw from Little Green Dog for sharing this scene. All the settings were arrived at through experiment 
and you should feel free to substitute your own.

You can animate the position, rotation and scale of a force-type Dynamic element over the course of a scene 
rather than using the axes to vary how your scene reacts to a Force.


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Bullet’s Forces are ideal for creating this kind of scene. It is easy to set up and reacts very naturally. For the example 
shown, we began with creating a solid floor and some columns to add interest and turbulence for the leaves. The leaves 
themselves are simple hexagons divided down their length for more of a shape:

The leaf is given a UV map to make it easier to texture and textured with a Color map the alpha of which is used for 
Transparency. The leaf is made double-sided to ensure that it remains visible and the Specular and Glossiness channels 
are textured to make the leaf more visually interesting. Lastly the leaf is duplicated using Point Clone Plus. Open the 
Multiply > Duplicate > More > Point Clone Plus panel and enter the desired parameters. For floating leaves, use full 
randomization for rotation; for ground cover, Randomize only the Heading the full 360 degrees and randomize the Pitch 
only slightly (maybe 10 degrees). Click OK.

In Layout, on the FX Tools tab, the floor and columns SquareBV object is made Static, the LeavesFloating object is 
added and made Parts and lastly three nulls are added to the scene and Vortex, Explosion, and Forcefield are applied.
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Let’s start with the simple. Our SquareBV object has Static applied, and the other settings are as follows:

Set the Shape to Convex Pieces and Collision Margin to 10 mm;
Mass Distribution should be Solid and Mass Specification set to Density with a Density of 1000 kg/unit;
Friction is set at 30 % and Bounciness reduced to 10 %.

Now we’ll deal with the LeavesFloating object:

Type is set to Parts so that each leaf is treated separately , Shape is Cylinder and Collision Margin to 10 mm;
Mass Distribution set to Surface and Mass Specification to Given Mass with a value of 0.001 kg;
Friction is set to 30 %, Bounciness 5 %, Linear and Angular Damping to 50 %;
Glue Strength is set to 0 % and none of the other settings in this section are engaged.

Lastly, we’ll change our three Force settings. The three forces are arranged in a column at the center of the scene with 
the following settings:

For the Forcefield layer, the size of the Fractal Noise texture is 2 m on all axes.
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The Explosion layer is the simplest. Set it to a low negative number so that it drags the leaves into the center rather than 
forcing them out.

The Vortex layer has a gradient on the Strength setting. It is set up like this:
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The values go from 0 to 0.1 and back to 0 over the 6 m range. With these settings you should have a fine swirl of leaves 
rushing around your courtyard. Add other objects or use a texture to create a more visually interesting Vortex.
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Bullet Cache, Hierarchies and Bones

Bullet Cache

As Bullet solves dynamic calculations, it stores the results in a cache so that animation playback can be fluid. The cache 
is automatically stored in the ‘Dynamics’ folder of the current Content Directory for the scene (this can be changed in 
the Options > Paths window, which can be accessed by pressing the o key). The cache file is named the same as the 
scene file, but has a .dynacache extension.

Bullet and Hierarchies

If you note that the motions of a parent object are not being updated in Bullet for a child object with Bullet applied, 
reset your dynamics cache on the World tab of Bullet Properties.

Bullet and Bones

You can parent a Bullet-controlled kinematic object to a bone and animate the bone using IK, targeting, etc. Bullet 
dynamics will read the motions.

To generate the full cache for a dynamics simulation, a quick way is to go to the end frame on the timeline, 
rather than pressing play. Either click on the last frame in the timeline, or bring up the Goto Frame window (F
key). Doing it this way means that although LightWave has to calculate the simulation for the whole scene in 
one go, it doesn’t have to display every frame update in the viewport, resulting in quicker calculation times.


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Bullet and FiberFX

To create hair and fur that is affected by Bullet, you should first set FiberFX Dynamic Gravity to Off and set Gravity to 0% 
so they do not interfere with Bullet’s calculations.

Fibers need to be polygonized by right-clicking on the item in your FiberFX window and choosing Polygonized Mixed.

This will create guides in geometry that are automatically weighted from end to tip with 0 % weight at the root and 100 
% weight at the tip. Make sure you save your fiber object after it has been polygonized.
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If you want the hair to deform but not the object it’s attached to, use a Mesh Filter in the Bullet window set to the fiber 
weight map that was created when you polygonized the hair. If you want it all to deform set the Mesh Filter to none. 

Bear in mind that if you don’t want the object to deform you will need to animate it to get the hair to flow. Bullet won’t 
react to the object at all because objects that have no weight map are ignored by Bullet and the hair will merely hang 
down unless you move the object around.

In Bullet set Mass Distribution to Vertices if you have a polychain-only object (or you are animating only the polychains 
of a mixed object).

Styles in FiberFX are morph maps that need to be activated in the scene by choosing Morph Mixer from the Object 
Properties window. Nothing needs to be done in Morph Mixer but by opening the window you are telling LightWave that 
it should remember you have a style on your fibers. Dynamics won’t work with styles though and when you use Morph 
Mixer it turns off the style. If you want to animated your FiberFX styles you can use Morph Mixer and Bullet will react to 
the changed style.

Speed up calculation of dynamics by turning off the display of fibers when calculating.

FiberFX requires multiple passes to work with LightWave’s photoreal motion blur. Since this adds a 
considerable overhead to rendering time you may prefer to motion blur as a post-process.


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OpenVDB

Click here to expand Table of Contents...
Introduction
OpenVDB Evaluator
Common
Solid Volumes from Meshes and other Scene Items

Mesh To Volume
Shape To Volume
Fog To LevelSet
From Particles

Gaseous Volumes from Scene items
Gas Solver
To Fog Volume

Tools
Advect
Advect Points
Analysis
CSG
Combine
Filter
Level Set Morph
Noise
OpenVDB Info
Partio Node
Attributes list
Resample
Saver
Scatter
Solver
Vector Merge and Split
Velocity
Visualize

OpenVDB Examples


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Introduction

Both gases and liquids are fluids. LightWave 2018 introduced us to the importation of existing OpenVDB simulations, 
Lightwave 2019 presented a robust framework based upon the industry-standard OpenVDB toolset, and LightWave 
2020 expands with new tools and workflows. This toolset was developed by DreamWorks Animation, primarily by Ken 
Museth, Peter Cucka, Mihai Aldén, and David Hill, for use in volumetric applications typically encountered in feature film 
and expands on this foundation providing backward compatibility with Lightwave’s existing particle simulation tools - 
ParticleFX and Flocking - while also introducing a new workflow for entirely VDB-based simulations.

In most cases, gases are handled by the OpenVDB Primitive type introduced in 2018 with a dedicated node editor. This 
provides fog-like raymarched volumetric rendering of thin particles such as smoke and fire.

Fluids, on the other hand, will mostly be generated as polygonal surfaces - called Iso Surfaces - using the OpenVDB 
Evaluator found in the Object Properties Object Replacement dropdown menu.

The key element in OpenVDB is the grid, more precisely "the efficient storage and manipulation of sparse volumetric 
data discretized on three-dimensional grids." Think of grids as an object’s bounding box that can be subdivided into 
smaller cells where something exists (such as a surface, points, particles…) while ignoring the empty cells, hence the 
"sparse" part of the description.

These cells are Voxels and act much like pixels in an image, but representing 3D volumetric shapes. The smaller the 
voxel size, the more detailed the object will be.

The beauty behind this system is that it entirely ignores empty cells decreasing memory and disk usage while making 
the rendering of volumes much faster.

http://www.dreamworksanimation.com/
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This new feature gives the user the power to create volumes from meshes and meshes from volumes

OpenVDB Evaluator

To create your own OpenVDB object, you need to start with a source object and a null with the OpenVDB Evaluator 
Object Replacement added. OpenVDB objects can be made from meshes, primitives and even other volumetrics.

Once you have your target mesh and null to direct it to, open the node editor by clicking on the Properties 
button next to the OpenVDB Evaluator entry. The destination node:

contains three entries. A scalar-based grid input, an OpenVDB-specific Particle System input, and a vector-based 
velocity grid input. The scalar grid is the one you'll use most often for fixed shapes. The new Particle System input gives 
you the ability to output a particle system from the OpenVDB Evaluator for further work downstream. If motion blur is 
enabled and there is a velocity grid, a deformer will be added to the object modifiers list allowing for subframe 
evaluation of the grid using the velocity input.
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The OpenVDB Blur deformer cannot be interacted with by the user. It has no UI, cannot be added or deleted except 
automatically by Layout

Double-clicking on the destination node will open its settings window

Iso - The iso value is considered to be the zero-crossing of the grid's field of values. This zero-crossing is where 
polygons are constructed
Adaptive - Values above zero will consolidate small voxel size polygons into larger polygons as flatness allows
Invert - Fog volumes can be input, but due to the representational difference between them (unsigned ) and SDF 
(signed) volumes, the polygons appear backward. Checking Invert will flip the polygons for that case. 
Additionally, you will need to move the Iso surface above 0
Points Only - Useful for outputting a particle system still as particles for use with other systems in Layout, like 
Flocking, Instancing, HyperVoxels, etc.
Static Mesh - Stops frame-based re-evaluation of a resulting OpenVDB mesh
RAM Cache - Caches the Grid input to RAM, up to the Max MB setting. If the cache exceeds this amount caching is 
released, starting with the frame furthest from the current frame
RAM Cache Max MB - The total RAM cache for the scene
RAM Cache Size - This field should show the current size of the RAM cache, and currently doesn't. The error will 
be corrected.

Common

 OpenVDB nodes may have the following common settings:

Voxel Size - Size of the voxel grid in meters (LightWave supports uniform grids); the size of the voxel "blocks" 
that will make up your object
Inner Bandwidth - Inner Bandwidth for level set in voxels
Outer Bandwidth - Outer Bandwidth for level set in voxels. For fog volumes, this defines the "softness" until 
maximum density is reached.
Fill Interior - Toggle for whether the volume will be solid when cut into or just a shell - like polygons are. Turning 
on Fill Interior with a Fog Volume will soften the outside of the fog
Coordinate System - How the voxel will be transformed. There are three choices

Local - No transform

Layout will provide you with a warning message if you create a vast number of voxels.
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World - Transform into world space
Parent - Use the parent item's space

Grid Name - the base name of savedgrid.vdb files. Files will be appended with the frame number and written 
with temperature, density, and velocity grids

Solid Volumes from Meshes and other Scene Items

Creating a volume this way requires a target mesh, primitive shape or Particle emitter that needs to be in the scene. It 
can be out of camera view, hidden from render and hidden in OpenGL and the Object Replacement will still work. To 
create a volume from this item requires adding a null and using the Object Replacement entry OpenVDB Evaluator. 
Clicking Properties for it will bring up a Node Editor window.

Mesh To Volume

Creating volumes from meshes relies on polygons being tris or quads. NGons are not supported
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In the OpenVDB nodes group, Mesh To Volume will be the node to convert your mesh objects into volumes. There are 
two choices for conversion, Fog Volume will convert a mesh into a volumetric fog, much like the image at the top of this 
page, but you need to use an OpenVDB primitive. The second option is Level Set, which creates a volumetric mesh 
object. The Voxel Size setting will determine the resolution of your volumetric object. For the Logo Rezzing Up
example, a Scalar Constant node was used with an envelope that went from the default 1 down to 0.0025 to create the 
increasing resolution of the volume.

Particle Radius is where you set the size of individual particles if you will be outputting a particle system from this 
node.

The new Attributes tab, added in 2020, is where you can transfer details like vertex maps or surfacing information from 
the original mesh to your OpenVDB object.

Surfaces will all be added. You cannot just choose one.

Shape To Volume
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Will create a volume from LightWave primitive objects.

Fog To LevelSet

Converts a Fog grid to a Level Set mesh object. A fog grid can be imported using the OpenVDB Info node. Double-
clicking the node brings up its window with Iso setting and Normalize toggle.

From Particles

New to 2020. There is now a Particle System output to send particles directly to the Editor Input. You can choose to 
represent particles as individual spheres or a trail (of connected spheres). When you select Trail, a Trail Resolution
setting becomes available. Higher values mean more trail particles and might be needed for high-velocity trails.

The Morphology tab includes elements that are found in the Filter node that can be applied directly, without needing a 
discrete Filter node.
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This node will create a volumetric object from a stream of particles created using the FX Emitter or the Scatter or Solver 
nodes here. You have the option to either create sphere shapes or a trail per particle derived from their position, radius, 
and velocity. Each trail is generated as CSG unions of sphere instances with a decreasing radius.

When you have a particle emitter being meshed, you cannot bring up the particle properties, as upon meshing 
(the OpenVDB Evaluator being an object replacement procedure), the PFX Emitter server pane will close. The 
only way to adjust particle properties, in this case, is by using the modal FX Browser panel.

The same is true for other server pane items - changing the subdivision level, for example - but in that case, the 
only workaround is to disable the VDB object in the Scene Editor by unchecking the render flag.



FX Emitter particles must have a Size, and that size must be output with the Output Size toggle. You don't 
need to Show Size; it just helps visually.


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Particle System - A dropdown for choosing the specific particle system you want to use. Using the Input ghosts 
this control
There are two tabs next:
Surface - Details how the particles look:

Particle Count - A readout of attached particle system particle count
Space - Choose whether your particles are situated in Local, Parent or World Space
Particle Type - Choice between Sphere and Trail. Sphere will create distinct bubbles whereas Trail will 
attempt to use particle velocity to create a trail of diminishing size. Each trail is generated as CSG unions 
of sphere instances with a decreasing radius
Trail Resolution - Only available when the Trail Particle Type is chosen. The default of 1.0 trails off 
"normally". Less than 1.0 means fewer trail particles and separation might be noticeable. More than 1.0 
means more trail particles are created. Higher trail speeds might need more particles to stay stream-like 
so separation doesn't show
Voxel Size - Size of the Voxel for the particles. Voxels sizes in a network should be the same, especially 
combining or collisions between VDB grids
Iso Surface - Iso sizes in a network can be different but the editor input node will create the final meshing

Morphology - Operators so additional nodes are not needed
Dilation - Dilate the grid along its normals making it bigger
Closing - Dilate the grid to close holes then erode closing openings
Smoothing - Gaussian smoothing

The direction of a trail is inverse to the direction of the Velocity vector, with a length of |V|. The radius at the 
head of the trail is given by the radius of the particle and the radius at the tail of the trail is Rmin voxel units 
which has a default value of 1.5 corresponding to the Nyquist frequency.


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Gaseous Volumes from Scene items

Gas Solver

Gas solver.  Use Stam's stable fluids method to advect density and temperatures. Both the density and the temperature 
affect the fluid’s velocity. Heavy smoke tends to fall downwards due to gravity while hot gases tend to rise due to 
buoyancy. We use a simple model to account for these effects by defining external forces that  are directly proportional 
to the density and the temperature.

buoyancy = (-densityscale * density * Vec3f(0, 1, 0)) + (temperaturescale * temperature 
* Vec3f(0, 1, 0));

External forces can be added on the Force Grid input. This input accounts for external forces like gravity, wind, 
turbulence and merely is added onto the end of the momentum equation.

Temperature Tab

Ambient Temperature - Ambient air temperature
Clamp Temperature - Clamps the temperature to the minimum value set below (otherwise the gas cools to the 
point where it falls like dry ice)
Min - The minimum temperature (in Celsius) for the gas to fall to
Normalize Temperature Grid - Outputs the temperature grid as a scale between 0 and 1, rather than, say, 60 
and 900

http://physbam.stanford.edu/~fedkiw/papers/stanford2001-01.pdf
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Fuel Temperature - Fuel temperature as it is emitted
Gas Density - Density of emitted smoke from the fuel grid
Fuel Velocity - Velocity of emitted smoke and heat from the fuel grid
Density Scale - Scale of the downward pull on dense smoke
Buoyancy Scale - Scale of the temperature gradient pulling smoke upward
Cooling Scale - Scales the cooling rate
Dissipation - The amount of density that falls off over each iteration so that the gas thins over time

Advection Tab

Spacial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spacial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Max Divergence Steps - Maximum number of iterations of the pressure solver
Advection Sub Steps - Substeps per integration step. The only reason to increase it above its default value of 
one is to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Curl Scale - Curl strength of the vorticity confinement

Domain Tab

Boundary - One of three choices:
Free Slip - Velocity is negated at the boundary axis
No Slip - Velocity is set to 0 at the boundary
Outflow - The grid is clipped at the boundary

The Min and Max domain fields are for setting the minimum and maximum extents (corners) of the simulation's 
domain.

Cache Tab

Cache Grids - Toggle for enabling the caching of grids to Cache Path folder. Once cached they can be loaded 
without simulation
Cache Name - Base name of saved grid . vdb files. Files will be appended with the frame number. Files will be 
written with temperature, density, and velocity grids
Grid Path - Path to save folder
Clear Cache - Clear all files in the cache folder
Behavior - A dropdown with three choices:

Manual - Cache control is completely up to the user
Warn - A message will warn "The cache is invalid, should it be cleared?"
Automatic - The cache is cleared automatically, when necessary
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To Fog Volume

Converts an SDF grid (signed) to a fog volume (unsigned) with a filled interior. There are no options.

Tools

You can manipulate OpenVDB volumes with the following included tools.

Advect

Advect a Signed SDF grid with a velocity grid. Requires a Velocity Grid vector to give movement and direction.

Spatial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spatial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Normalizing Steps - A number of renormalization passes can be performed between each substep to convert it 
back into a proper signed distance field. Prevents jerky motion but soften and slows the velocities
SubFrame Steps - Substeps per integration step. The only reason to increase it above its default value of one is 
to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Rebuild SDF - Toggle to rebuild and retrack the narrow band of the SDF
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Advect Points

This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for
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Analysis

This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.

CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes, and is the default option
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B
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The velocity of the input grids will be reconstructed and output.

Combine

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
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rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background


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Filter

  

This node adjusts the inner bandwidth of a volumetric signed distance field represented by a VDB volume

Filters the level set grid:

Filter Type:
Renormalize - Repair level sets represented by VDB volumes. Certain operations on a level set volume 
can cause the signed distances to its zero crossing to become invalid. This node iteratively adjusts voxel 
values to restore proper distance
Mean Value - This performs the equivalent of a simple box blur by taking the mean of the surrounding 
values
Median Value - This chooses the median of the surrounding values, good for homogenizing noisy data to 
avoid spikes
Mean Curvature - Finds the average curvature for a location and moves the surface along its normal to 
smooth out bumps
Laplacian Flow - Uses a local Laplacian value for movement along a normal
Dilate - Dilate the grid along its normals making it bigger
Erode - Erode the grid along its normals making it smaller
Close - Dilate the grid to close holes then erode closing openings
Open - Erode the grid then dilate to create openings
Track - the grid topology is updated by rebuilding the inner band so that it tracks the new iso interface
Gaussian - Gaussian smoothing
Resize - Change the width of the inner band of a VDB signed distance field

Accuracy - Increasingly complex algorithms for the accuracy of the integration
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World - Performs the math for creating the levelset in World space, rather than Local
Half Bandwidth - Level sets are normally symmetrical on the inner band. Half Bandwidth uses this fact to halve 
calculation times but at the cost of accuracy
Iterations - the maximum number of attempts to achieve a divergence-free pressure matrix
Voxel Offset - Offsets the iso surface from the actual value. For instance, using

Level Set Morph

You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The above node tree will synchronize your surface morphing at the same time as the geometry

The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out

Noise

Add the Bump output from an image or a 3D Texture to this node and pipe the output through.

OpenVDB Info
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The values for the Fuel channel of a VDB sequence

You can pipe a Level Set or Fog grid into this node and see the values contained within the file, but this node becomes 
more useful when you load a vdb file directly in the node. You can see info from whatever channels the vdb file contains.

Partio Node

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.
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Target - If you are using a volumetric object with the particle system, make sure it is targeted here
Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list

Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.



•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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Using the Partio node with a From Particles node

As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab
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You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Resample

Resample input grid to new voxelsize to output grid.

Interpolation - Different interpolators with increasing complexity
Rebuild SDF - Rebuilds and normalizes the narrow band of the level set
Prune - Removes values from the level set that are smaller than the Prune Tolerance set below

Saver

Pipe a grid into here and the frame or sequence is saved as VDB files upon clicking the Save button.

Save Type - a choice of Frame or Sequence. In both cases, a files or files will be saved using the File Name 
chosen appended with the frame number
Save Path - Choose a folder for the frame or sequence
File Name - The chosen prefix for the frame or sequence
Save - Immediately saves the frame or sequence. There is no visual confirmation apart from the playhead 
stepping through the scene in case of a sequence save

To load files saved this way, use the OpenVDB Info node to choose the VDB file and its channel saved.
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Scatter

Scatter creates particles on the input grid.  The particle system constructed belongs to the scatter target item. Particles 
can be scattered on or in both SDF and fog volumes.

Scatter Target - The input grid to scatter on
Scatter Mode - Dropdown to specify how the particles will be placed:

Point total - Absolute number of particles to be scattered
Point Density - Percentage of voxels in which to place a particle
Points Per Voxel - Number of particles to put in each voxel

Seed - Sets the random seed
Spread - Distance to randomly move from the voxel center

Depending on the scatter mode chosen:

Point Count - When Point Total is chosen (integer)
Density - When Point Density is picked (percentage)
Points Per Voxel - When Points per Voxel is chosen (scalar)

Multiply - Density multiplier
Animate - Reseed the random generator each frame
Fill Interior - Fill particles inside the sdf narrow band
Size Factor - The size of the particles created
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Creating bubbles inside a VDB toroid is simple with the Scatter node. The Filter node has been used here in Erode mode to 
ensure that the bubbles are created inside the toroid volume and not at the boundary.

Solver
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A particle solver that uses a particle system to initialize a temporal PIC/FLIP feedback loop. Particles from the particle 
system are input as they are born. Then are advected by the integrator using the gravity over the frame substeps. PIC 
(Particle In Cell) produces smoother motions, and FLIP (FLuid Implicit Particles) is splashier. The two methods can be 
combined.

The Navier-Stokes equations that the PIC/FLIP system uses do not dictate position but velocity. The vectors contained 
are not coordinates but velocities. PIC / FLIP is an advection equation, which is how the particles in these objects move 
within velocity fields.

Particles In Cells (PIC) works by evaluating particles as groups of particles in cells (like voxels)

FLIP stands for FLuid-Implicit Particles and uses a grid rather than particles. Grid-based methods were great for large 
ocean effects, but not fine detail close up visual effects work. Things can look globby and unrealistic at a small scale 
(thin fluids).

Inputs

Collision Grid - SDF grid to be used for collisions
Particle System input - Use a separate particle system

Outputs

Grid - Outputs an SDF grid
Particle System Out - Particle system output
Start Only - Only uses the first frame of the particle system
Voxel Size - Size of the gid voxels
Integrator - In short, the upper choices from this dropdown menu are faster but the lower choices are better 
quality
Subframe Steps - More steps per frame is more accurate but takes longer
PIC↔FLIP - Ratio of PIC velocities to FLIP velocities
Blobby - Check to treat the particles as spheres
Gravity - Downward pull in meters per second squared
Stickiness - Amount of velocity absorbed by contact with collision object
The next three checkmarks are to help visualize the grid:

Show Particles
Show Grid velocity
Show Collider grid

The Solver is time-based so scrubbing the scene will break it, particularly going backward. Create previews to 
see a smooth animation if your scene is too heavy.


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Vector Merge and Split

New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states

Velocity

This node will construct a velocity grid for motion blur use.

Reference Grid - Use to populate the velocity grid on the active values
Velocity - Vector of velocity evaluated during grid building
Rebuild Velocity - Rebuild Velocity at each evaluation rather than creating a static field

You can use an envelope or a texture map to adjust the velocity grid over time for more control
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Visualize

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform
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OpenVDB Examples

Example - First OpenVDB Liquid
Example - Logo rezzing up
Example - Volumetric Cheese
Example - Chocolate Sauce Donut Drape
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Fracture

Fracture in Modeler

This new Modeler tool (Multiply tab > Destroy > Fracture) breaks apart an object and makes the resulting segments into 
parts for use with dynamics. There are three algorithms implemented in the Fracture tool: Voronoi, an algorithmic way 
of breaking an object in a natural-looking fashion; Halves, a recursive split-in-half algorithm; and Matrix, a matrix-
cutting algorithm.

Many aspects of 3D work involve modeling properly for the intended use of the model. For example, many articles and 
discussions are available on how to model characters in order to be able to animate them properly. The flow of the 
polygons in the model is critical to getting the correct deformations to occur. There are similar discussions of modeling 
requirements for other purposes. For the current version of Fracture, you will get better results if you avoid geometry 
with long thin polygons, or with a disparity in the size of the polygons in the mesh - large polygons mixed with tiny ones.

Lastly, any object to be Fractured needs to be frozen, not sub-patched because Fracturing will destroy the polygon flow 
needed by subpatches.

Overview of Controls

Common Settings

Interior Surface - Entry field to set a name for the interior surfaces created in the fracture process.
Random Seed - Entry and minislider to adjust the random seed used for the fracturing process.
Preserve Original toggle - On keeps the unfractured original geometry in the layer it was created. Off does not 
preserve the original geometry. The undo system in Modeler will not always be able to recover the original 
geometry, so maintaining the original with this option can be useful if you need to retry the fracturing to get the 
results you prefer.
Create in - This offers the choice of either creating a completely new fractured object or creating a new layer for 
the existing object.
Part to Layers - LightWave will happily deal with the fractured object being in a single layer, but if you need to 
export to a different program that needs separate layers you can use this.

Explode Controls

The Explode morph map can be used as a “poor man” dynamics. Just animating the morph to explode a seemingly 
solid object and adding particles and HyperVoxels can often substitute for expensive dynamics simulations.

Explode Parts toggle - When checked this makes an exploded Morph map of the parts.
Explode Distance - Sets the maximum distance for the explosion. This controls how far to move each connected 
part away from the center of the object.

Cutting tools need to be fully closed meshes. For example, a cutting tool for Fracture cannot be a cone that 
you have chopped the top and bottom off of and distorted, so that you have an open mesh with a hole in the 
middle; you need a closed mesh, with no holes and preferably tripled.


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Explode Randomness - Specifies a percentage by which to vary the distance. For instance, if distance is 1 m and 
randomness is 50%, then the pieces will move away from the center anywhere between 0.5 m and 1 m.
Explode Morph - Name for the exploded morph map.

No Dynamics. The morph, some lens flare and particles are enough to make a good background explosion.

Fracturing Algorithms

Voronoi

Use - There are three choices:

Random Points - This will create randomly positioned Voronoi cells with which to break up your object based on 
the value set with the Cell Count field.
Background Layer Points - A set of points on a separate layer to the geometry you wish to fracture will be used 
for the basis of the Voronoi cells. The points need to be shown as a background layer, similar to Boolean 
operations. Points outside the geometry’s bounds will be clamped to the bounds for the cutting operation.
Background Layer Polys - This is something of a mix between Random and Background Layer Points. To use it, 
you need to create a closed 3D shape in a layer that you have as the BG layer for the object to be fractured, and 
the Cell Count field is available to fill that shape with the required number of cells used to fracture the original 
object.

Cell Count - This field is ghosted if you are using Point Selection since the number of cells is determined by the 
quantity of points you use.

Morph Maps can be examined using the M icon at the lower right of Modeler’s interface and the dropdown 
menu that goes with it. This way you can see the morphed object and the base fractured version.


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This image shows a Background Layer Points Voronoi fracture. Although the points are not within the bounding box of 
the mesh to be fractured they still have a pleasing effect.

Matrix

Detail - The detail factor controls how many pieces are created. The value entered is exponential (similar to 
subdivision surfaces) - 1 = 4 parts, 2 = 16, 3 = 64, etc.
Jitter Amount - Controls how much to jitter the source cutters. Higher values lead to more uneven results.
Jitter Iterations - Controls the number of times jitter is applied. This is similar to the iterations value in 
smoothing tools. Higher iterations with low values gives a different result to fewer iterations with high values. 
The former would move each point around more than the latter, which will move certain points more.

Background 3D shapes for cutting Voronoi Fractures in Background Layer Polys mode must be closed objects. 
It is best to triple them and make sure all normals are facing outwards.


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The three images show differing levels of Jitter and Iterations. 1 is no jitter, 2 is a Jitter amount of 50%, but an iteration 
count of 50, which is high and 3 is a jitter amount of 90% with only three iterations giving a far more jagged appearance.

Halves

Cutter - This determines the shape of the cutter used to fracture the objects.

Fractal Cube - Creates more organic results - like a rock being fractured.
Cube - Makes straight slices - very angular results.

Max Angle - This sets the maximum angle of rotation of the cutter as it is making slices. If you set it to 0, all slices 
will be axis-aligned and the results are very cube-like. With a high value, more sharp pieces that aren’t axis-
aligned are generated.
Unevenness - This chooses how uneven the splits are, by percentage. At 0%, everything is split down the middle. 
At higher values, the algorithm splits more off center. It’s a guide so where it cuts is still random, but with higher 
values the results will be more random.
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The three images above show: 1. Perfectly even cuts, no unevenness and no angle variation, 2. Changed unevenness to 
cuts that are not exactly halves, 3. Shows adding in an angle variation.
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Flocking
Click here to expand Table of Contents...

About Flocking
Using Flocking
Setting up a Simple Flock
Overview of Controls

Menus
Items List
Generator/Director Cache Settings
Director Properties

Path Example
Generator Properties

Flocking Nodally
Example: Chasing a Flock
Using Objects as Goals or Avoids

About Flocking

LightWave’s flocking system is based on 3D computer models of coordinated animal motion, things like flocks of birds, 
herds of animals or schools of fish. It can be used with LightWave’s instancing system or HyperVoxels.


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The flocking algorithm itself is based on just three principles in order to create this seemingly complex motion. These 
are Separation, which keeps your flock from getting overcrowded; Alignment, which keeps the flock all heading in 
roughly the same direction; and Cohesion, which is effectively the opposite of separation and keeps your flock bunched 
together.

Flocking can be seen in OpenGL and VPR. Instances and HyperVoxels controlled by Flocking can be motion blurred and 
use Depth of Field like other instances. Hypervoxels, like other volumetrics need the camera to be moving to be 
compatible with Photoreal Motion Blur (PRMB).

Using Flocking

In order to set up Flocking in LightWave you will need a flock and at least one director. This director can be a goal or 
something to avoid, meaning you can either lead or chase your flock. An effector can be as simple as a null object 
though you can attach a director to geometry - for instance, the leader of the pack or the nasty predator chasing the 
herd.

The director needs to move to excite the flock into movement of their own. Although an unmoving goal will draw the 
flock to it, it’s not very interesting behaviorally. It should also be stated that the behavior of the flock is completely 
deterministic, there is no fractal randomness here. A flock animated on one machine will work in exactly the same way 
on another, and more importantly will render the same too.

Setting up a Simple Flock

We’ll start with an empty scene of 200 frames to which you add Flocking from the Windows menu, or the FX 
Tools tab.

In the Flock Master window add a Generator . The defaults won’t give us a very interesting result, so change the 
following values:

Count X : 10.0 Count Y : 10.0 Count Z : 10.0 Size X : 4.0 Size Y : 4.0 Size Z : 4.0

This will give us a flock of 1,000 agents ready to fly.

Flocking doesn’t currently work with negative frames.

When using Flocking with network rendering (LWSN, for instance) you must bake your Flocking results.
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Add a Director - Goal to your scene and move it off in the distance. For this example ours is moved about 20 m in 
the Z. If you hit Calculate All Motions now and then Play on your timeline your agents will all head off to the goal, 
avoiding bumping into each other, but otherwise not interesting until they reach the goal, at which point they 
overshoot and try to reach it again, and again.
So we’ll give them something to avoid. Add a Director - Deflect and change its Deflect Core and Strength to 5.0 
and 3.0 respectively. Position it about halfway between your flock’s starting point and the goal. Hit Calculate All 
Motions again and you should get something like the image below:

To get the pretty colored trails for your flock, increase the Show Trails number. It represents the number of frames 
before and after the current one that will be shown.

Overview of Controls

Flocking is composed of several custom objects all controlled through a central Master Window as we saw in the first 
simple example. You can always control your flock and directors through the Object Properties > Geometry > Custom 
Object window and your settings will be duplicated in the Master Window. For simplicity, this documentation will only 
describe the presentation of the settings through the Master Window interface.

Make sure you hit the Calculate All Motions button each time you make changes to your flock or directors 
before you press Play on the timeline again.


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This window has three main sections. Across the top we have two dropdown menus and the Calculate All Motions 
button. Down the left we have a familiar listview of all the flocking elements in the scene. On the right, the settings for 
each individual element broken down into tabs.

Menus

Add New...

Generator - will create a Null-based flock generator.
Director - Goal - will create a Null-based director that your flock will gravitate towards.
Director - Avoid - will create a Null-based director that will repulse your flock directly away.
Director - Deflect - will create a Null-based director that will push your flock away tangentially.
Director - Arrive - will create a Null-based director with deceleration rules for your flock.
Director - Path - Will create a null-based director that will be the basis of a Path director. You will need to 
animate the null over the course of the scene for it to work.
From Scene Items

Generator - This allows you to add a Flocking generator custom object to an existing scene item.
Generator from Mesh Points - If you use this option it turns the points in the object into placement for your initial 
flock giving the opportunity to create initial flock shapes other than the default box or sphere.
Generator from Mesh Polys - As above but uses the mesh’s polygons to place the flock. In both cases, flocking 
rules apply so if the points or polygons are too closely spaced the flock will initially explode outwards.
Director - Goal, Arrive - Adds a Director custom object to an existing scene item.
Director - Avoid, Deflect - As above.
Director - Path - Will create a Director from a null that you have animated over the course of the scene..

Basic Setup - Creates a Generator and a Goal Director , both will be placed at the origin. This is simply a rapid 
way of adding flocking to a scene, since in most cases that is what you will do.
Predator-Prey - This will create a pair of flocks - one predator, one prey. The prey will have a Goal Director 
attached to it so that the predator flock will rush towards the prey flock. The predator flock has an Avoid Director 
attached so as it rushes toward the prey they scatter. You will want to adjust the base values

Edit...

Remove Selected, Remove All - Removes either the selected flocking generator or director, or removes them all 
at once.
Duplicate - An exclusive operation (copy operations outside the Flocking window do not affect what you have 
copied inside it) that allows you to duplicate Flocking elements .
Rename - Renames the selected item.

Multithread - A toggle to optionally multithread flocking calculations. Some calculations are actually quicker to 
calculate single-threaded, which is why this is left as an option.
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Full Evaluation - Forces deformations to be evaluated per frame, to make sure the agents react to the final 
deformed positions of the meshes. If you just use the regular Calculate button Flocking takes a best guess if you 
need full evaluation or not, since full evaluation is about ten times slower…
Calculate all motions - The most important button in the Flock Master window. Make sure you hit it every time 
before you hit play in the scene. Calculations should not take very long to accomplish, even with complex 
flocking motions.

Items List

The listview on the left contains the following fields:

A (checkmark)- Determines whether the element is active in the scene.
Class - Whether the item is a generator or director.
Type - What sort of generator or director the item is.
C - The display color in OpenGL
Scene item - the name of the item for the scene.

Generator/Director Cache Settings

Starting with the Cache tab since that is unique for all flock elements, this tab controls caching for the scene to make it 
less processor-intensive.

Use Cache toggle - Ticking this will lock the Properties tab completely, you will not be able to make new changes 
to the behavior of your flock or directors.
Cache filename - When Use Cache is on, this field is ghosted and serves only to be able to read the cache 
filename and location.
Load Cache - This button is available whether you are using a cache or not and allows you to load a different 
saved solution for your flock elements.
Save Cache - Available when Use Cache is not enabled, presents a file requester where you can choose where 
your cache will be saved.
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Director Properties

 
Directors are the Flocking elements that direct flocks. There are several choices to make when picking the type you 
want:

Goal - The flock will be drawn to this director in as direct a route as possible.
Arrive - As above, but there is a user-definable deceleration zone surrounding the director.
Avoid - The flock will flee this director in as direct a route as possible. If the Avoid director is large, the flock may 
stutter as it tries to find its way around.
Deflect - The flock will flee this director in a more tangential fashion giving a smoother result.
Path - The animation path for this Director will be used as a path for the flock to follow.
Plane - The flock will not cross an infinite plane. Multiple planes can be set up to provide a tunnel.

Goal and Avoid directors have the following options:

Range - Leaving this at 0 will affect the whole scene. If you have multiple directors in a scene you can give them 
fixed ranges and when entering the range of a second goal some will peel off to go to the new destination. The 
Range circle shown in the viewport is an indicator of the linear falloff for the attractive power of the goal with 
maximum at the central point and 0 at the circle edges.
Weight - For a Goal or Arrive Director this dictates how an agent will make a choice between two equidistant 
goals. A higher weight makes the director more attractive to the flock. For Avoid or Deflect Directors weight 
determines how repellent the directors are when there are multiple directors equidistant from the flock.
Strength - Directors all apply a change in speed to an agent. Strength is a multiplier of that change. For an Avoid 
or Deflect Director Strength determines how far out from the central point of the director the flock will be 
permitted to come. Set the Strength high enough and the flock won’t enter the sphere of influence at all.

Deflect directors add a further option:

Deflect Core - This is the inviolable core of a Deflect director. Flocks will try not to enter it.

Path directors add one additional option to Goal and Avoid directors:

Steps - Defines the “resolution” of the path.

Arrive directors add two different additional options to Goal and Avoid directors:

Arrival Radius - This determines the size of the arrival point for the Director.
Decelerate Radius - This determines at what distance flocks should start to decelerate for landing.

Plane directors have no options.
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 Path Example

The Motion Path option for a Director gives you a lot of direct control over your flock, with a little bit of chaos as some 
fall out of the path you give them. It creates a very natural-looking path-following animation. Here’s a quick guide how 
it works:

Set your scene to 600 frames and change your viewport to Top. Zoom out so you can see the whole width of the 
grid. Create a Null.
Give it a motion path over 300 frames. To simplify our starting example make sure the path doesn’t get too close 
to itself over its course.

In the Flocking Master window choose Add New... > From Scene Items > Director - Path .
Set the new path’s resolution. You want it to follow the null’s motion path quite closely. Here we have set 24 
steps.

Now Clone the Path null twice and change the two clones animation paths. The fact that the frames used for the 
paths is the same does not affect how the paths work in Flocking.
Add a Generator in the Flocking window. By default it comes in at the origin, which is great for our first path.

Hit Calculate All Motions in the Flocking window and you should see that your scene isn’t long enough for the 
flock to get to the ends of both paths, but the fact they separate into two groups is nice.
We have added a couple of Arrive directors to the end of the right path and a Goal to the end of the left path and 
made our flock massively larger. More paths could be added to further subdivide the flock and the goals are 
radius-limited to only capture flocks that fly nearby.

Generator Properties

There is a main section common to all Generator types that lists several important things.

OpenGL Color - Shows the color that will be chosen for the generator in OpenGL only. This has no bearing on 
rendered output.
Display Preview - The percentage of your flocks you wish to show in Layout. If you are creating very large flocking 
scenes you don’t need the slowdown of showing all the elements at once.
Visible Trail Frames - This shows a trail leading and following each flocking agent to the extent you request. 
Setting to 100 will show the path an agent will take both 100 frames in advance and 100 frames behind.
Show Details toggle - With this on you will see the collision circle around the agent and an arrow denoting its 
direction and orientation. With it off, each agent is represented by a dot.
Use Variance toggle - This toggle enables the Agent Variance tab explained below to be used otherwise it is 
grayed out.
Edit - This presents a dropdown with the following options:
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Copy - Takes a copy of the current agent settings
Paste - Pastes previously copied settings into this panel
Copy to Variant - Copies the current base settings to the Agent Variance tab to reset the values to the same.

Old Flight Mode - Provided for backwards compatibility with Flocking scenes set up in 11.0 - 11.0.3. Some users 
also prefer the flowing motion given to flocks by the initial algorithms, but they do not work well with Arrive 
directors, which were added later.

There are four tabs for Generator Properties as follows:

Generator

Start/End Frame - If you wish for your generator to begin animating your flock for the whole scene, leave these 
set to 0. If you wish a delayed takeoff set the Start value to a number greater than 0 and the flock will start to 
leave the generator at the time you choose. You will also need to change the End Frame for the time that the 
flock will have completely left the generator. Note that Sphere Generators will begin and end their movements 
randomly where Box generators are precisely ordered.
Generator Shape - This dropdown offers two choices for the starting shape of your flock Box and Sphere (a 
Sphere generator distributes flock members randomly, while a Box generates a specifically-ordered grid). If you 
have used Object Properties to attach a Flocking Generator to an object you are also given two further choices:

Mesh Points - There are two options. The Use Max toggle will set an agent at every vertex of the mesh, or you can 
use the Count field to determine how many you want to create.
Mesh Polygons - As above. The agents will be placed at the center of each polygon.

Count X/Y/Z - If you are using the Box or Sphere options, you can decide how many flocking agents you would 
like in your flock. For ground-based flocks use 1 in Y.
Size X/Y/Z - If you are using a Box generator this is the length of each side, if a Sphere, the radius in each axis.
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Agents All the following options can be enveloped and driven by Textures.

Particles use Agent Size - This toggle allows you to duplicate the size you set here for particles, to be rendered 
with HyperVoxels or other particle systems.
Agent Size - This is a hard sphere radius that agents cannot get closer than. Like marbles stacked in a jar they can 
touch but they don’t intersect, within the limits of the algorithm.
Range - This is the range at which the agents attempt to avoid colliding with any other agents. This isn’t a hard 
collision, it simply directs agents away from each other to maintain a gap between them. All entities in a flock 
such as birds or fish, will attempt to steer to avoid crowding their neighbours too closely and this is the setting 
that defines the closest distance at which they start reacting. This couples with the Avoid Collisions option 
detailed below.
Cohesion Range - This is the range at which the agents attempt to move towards each other to maintain 
formation. It can be considered the ‘stickiness’ of a group of agents, whether they stay in a big group or tend to 
splinter into small groups easily. This couples with the Cohesion setting detailed below.
Match Velocity Range - This is the range at which agents try to match the direction of travel with their 
neighbours. In all groups of traveling things there is a general motion, usually each agent moves mostly in the 
same direction as its neighbors. This couples with the Match Velocity setting detailed below.
Avoid Collisions - This is the strength of the agents desire to avoid getting too close to its neighbors. High values 
will make the agent move erratically, low values will produce much slower reactions.
Cohesion - This is the strength of the agents desire to maintain formation. Higher values would move agents 
quickly towards each other, low values would produce more flowing movements.
Match Velocity - This is the strength of an agent’s desire to match the velocity of its neighbors. Higher values will 
result in very uniform movement, like an army marching; low values will result in very localized motion.
Acceleration m/s2 - How fast the flock can achieve its maximum speed to chase Goal-type directors or flee Avoid-
types.
Min Speed m/s - If the flock’s speed is not at 0, this is the minimum speed it will move. Use more than 0 to 
simulate a flock of birds or school of fish.
Max Speed m/s - How fast the flock can travel.
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Turn Rate H/P/B - Agents move freely in any direction and try to orient themselves toward the direction of travel. 
This behaviour can be adjusted in the node editor, but the Turn Rate defines in what axes and how fast the 
agents can turn. Note these axes are relative to each agent. 0 values for any axis prevents rotation in that axis.

Agent Variance All the settings on this tab will be ghosted unless you toggle the Use Variance setting above. 
When you use it then the settings become available. The Variance tab initially uses the default values but you 
can specify a range for each option that is distributed randomly between the agents. For example, if the Max 
Speed on the Agent tab is 10 and on the Variant tab it is 20 and Use Variant is turned on, an agent’s Max Speed 
will be randomly fixed between 10 and 20. The Particles Use Agent Size toggle is common to both tabs, the state 
of the option is the same regaardless of what tab you’re on.

Takeoff

Initial Velocity m/s X/Y/Z - Assigns an initial direction for your flock to move in.
Use Normals - If you have assigned your flock to be generated by the vertices or polygons of an object, you can 
use their normals as a vector for initial velocity otherwise this control is disabled.
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Flocking Nodally

LightWave has nodes for more complex Flocking.

RayCast(Flocking) - This node is designed to be used with the Custom Object Ray Receiver in order to lock a flock 
to a surface. It has two inputs ( Ray Origin, Ray Direction ) and two outputs ( Distance, Intersect ). If you don’t 
specify a Ray Origin or Direction , this node assumes that you are trying to lock agents to a ground plane and so 
taking the Intersect output from RayCastNode(Flocking) into New Position on the AgentControl destination 
node will normally lock the agents to whichever object you have applied RayCastReceiver to (in Object 
Properties > Custom Object ) with no further modification needed.
AgentInfoNode - this node gives vector information on the Position , Velocity and Bank Up Vector of an agent. It 
is most useful for adding banking to a flock. To do so, make sure that the Turn Rate for your agents is set in the 
Agents tab of the Flocking window. You will need some Bank and perhaps Pitch as well if your flock’s motion is in 
all three dimensions. You can see that we have also added a VectorAdd node. The addition of a small value 
(0.3-0.6 is suggested) in the Y channel will bias the agent’s Bank rotation towards being upright. If you don’t add 
this node, the motion of a flock going round bends will be more chaotic with some agents perhaps rolling 
completely.

 Example: Chasing a Flock

This example shows both predator/prey behavior in Flocking and nodal control for flocks. We’ll start with a new 600-
frame scene and the new Predator-Prey entry on the Flocking Add New... menu.

The default entries need some tweaking to get a more predator and prey-like setup. There are never as many 
predators as there are prey, so we’ll move the Generator away from the Origin and reduce our attackers to only 
X: 2, Y: 1, Z: 2. Likewise we’ll increase our prey flock to X: 10, Y: 1, Z: 10. You’ll need to increase the box size to X: 5, 
Y: 1, Z: 5 too. Lastly, we’ll change the Range on the Avoid Director to 8.0 to give the flock a chance to get away.
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1. We’ll add a hilly terrain with a subdvided, subpatched 100m 2 plane. Go into Object Properties and use a 
Displacement map to displace the terrain as you see fit. We used a simple Turbulence procedural set to 15 x 15 m 
and raised some 8.5 m.



LightWave 2020  –  LightWave 2020

Reference –  1997

1. You need to tell Flocking that this terrain is your ground for the flock and their pursuers and you do that by 
adding a RayCaster to the terrain in Object Properties > Custom Object .
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Now, you need to tell Flocking to tell both your predator and prey to use the ground. Make sure Use Nodes is 
checked and go into the Node Editor from the Flocking Master window. Add a RayCastNode from the Additional
group and take its Intersect output into the New Position input on the Agent Control destination node. 
Remember to do this for both generators.

Hit Calculate All Motions in the Flocking window and watch your flock flee over the hills. Interestingly, once they 
reach the boundary of the terrain they “beam up” since the RayCastNode has no ground to put them on.

Using Objects as Goals or Avoids

Going into Object Properties on scene objects you can set any as Flocking items by visiting the Geometry tab and 
choosing Flock Director or Flock Generator. If you choose a Goal Director, Flocking will automatically deduce that you 
wish to use the polygons of your object as a goal, but you need to manually select Avoid Mesh if you wish for an object 
to become something to be avoided in your scene.
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FX Dynamics
Click here to expand Table of Contents...

Introduction
Adding Dynamics to your Scene and Objects

Items: Add: Dynamic Object

FX Browser
To add an FX controller:
To delete a controller:
To open a controller’s property panel:
The Start Button
The Save Button
Options Dialog
Real-time Display
Groups

Object Properties: Dynamics Tab
Add Dynamic
Dynamics List Window
Calculate

Introduction

LightWave has long had its own system of dynamics and they are presented here. They can sometimes interact with the 
more modern Bullet dynamics though they often require their own calculation or perhaps saving as MDD files. For most 
purposes, Bullet will provide better simulations and largely supersedes the original FX dynamics. There is no Bullet 
equivalent for LightWave’s own particle emitter, which means that you should be familiar with the Particle Emitter at 
the least.

Adding Dynamics to your Scene and Objects

Items: Add: Dynamic Object

One way to quickly add dynamic objects to your scene is to use the Add Dynamic Object drop down list (Items > Add 
Dynamic Obj). Choose between Collision, Wind, Gravity, and Particle from the drop down menu. You can add one or 
more of these controllers to your scene. Then, each can be set with its own Parameter settings to create just the effect 
you are looking for. A dialog prompts you for a name when you add a dynamic object. Click OK to accept the default or 
type in the name you wish to use and click OK.

Collision - The Collision controller lets you add an element for the particles and/or dynamic objects in the scene 
to bump into (does not work with Bullet dynamic objects).

Wind - The Wind controller lets you add wind to blow your particles and/or dynamic objects around (does not 
work with Bullet dynamic objects).

Gravity - Add a Gravity controller to add gravity-like effects to your particles and/or dynamic objects motions 
(not needed for Bullet dynamic objects).


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• Particle - The Particle Emitter controller is the controller and the source for particles. There are two emitter 
selections: HV Emitter, which adds a HyperVoxels Emitter to the scene, and Partigon Emitter, which adds an 
emitter of single point polygons (“partigons”) to the scene.

FX Browser

The FX Browser Panel is where you can add various controllers. From here, you can also open the property panels for 
the controllers that you add. To open this panel, choose Utilities > Additional > FX Browser.

To add an FX controller:

From the Add pop-up menu, choose the controller you wish to add, load, or apply.

For speedy access, try tapping Ctrl-Space in Layout and type "FX_"
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To delete a controller:

Select and clear, just as you would any other Layout item (Items > Clear Selected or - on the numeric keypad).

To open a controller’s property panel:

Choose the controller from the Item pop-up menu and click the Property button to open the Properties Panel for the 
selected controller.

The Start Button

Some effects require a “pre-calculation” before they can be previewed in your animations. These are instances where 
you have particles interacting or have post-deformed geometry. By activating the Start button, the FX will begin solving 
any simulations that are currently setup in the scene. The progress of the simulation is displayed in the output pane 
located at the bottom of the Particle FX Browser. A shortcut to this is on Layout’s toolbar at Modify > IKB Calculate.

The Save Button

Clicking the Save button saves all controller motions, using individual files, to your FX directory (defined on the Option 
dialog). These can be loaded using the Load Motion option on the Controllers Properties Panel.

Options Dialog

The Options dialog has some options that affect the manner in which LightWave computes controllers.

FX controllers can also be applied to an item in the Dynamics Tab of the Object Properties Panel.
When you add a controller from the FX Browser that is not one of the “Apply” options, a null object is added to 
the scene. Then, an FX custom object plugin is added (e.g., FX_Emitter, FX_Wind, etc.). Just check out the 
Dynamics Tab of the Object Properties Panel.



You can also display the Property Panel for the currently selected controller by choosing Utilities > 
FX_Property or by accessing the Dynamics Tab in the Object Properties Panel.
You can open multiple property windows, one per dynamic type, by holding Ctrl then changing the selection 
in the Item Select Menu.



Many scenes don’t need this step, but clicking Start won’t do any harm if you are unsure.
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The Background Job option activates multithreading. The update by Background Job option will update Layout when 
background tasks are complete. In most cases, you should leave these options in their default state of off.

The Resolution setting adjusts the parameter used when performing the physics simulations. The smaller the 
Resolution setting is, the more accurate the simulation will be. However, this also has a direct effect on the rendering 
times.

In this dialog you can also set the FX Directory. This is the default directory used when saving Controller settings.

Real-time Display

Just click the Play button in Layout and as you tweak the various controller parameters, you get real-time updates of 
how your changes affect the particles.

You can control how FX Controllers are updated using the UpdateMode pop-up menu.

Auto updates all emitters as parameters are modified. Use this for fast systems or in low-particle count simulations.If 
you have multiple emitters and are using the Select update, then only the emitter showing in the Select pop-up menu, if 
any, will be updated.

Adaptive dynamically scales the number of visible particles based on your CPU performance. This setting attempts to 
keep interactive performance at a useful level.

User turns off particle updating completely. You may force an update by either clicking the Start button on the Particle 
FX Browser, or the Update button on the File Tab of the Emitter Controller Panel. This setting is useful in situations with 
heavy particle counts.

Scenes with particles interacting or with post-deformed geometry require you to click the Start button first to 
pre-compute some motions. Clicking Start won’t do any harm if you are unsure.


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Groups

You can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also works with 
Particle FX controllers. This becomes very handy when you are working on a complex scene and you want certain Wind 
emitters to only affect certain objects.

<All Group> - Includes all groups.
<default> - Includes all items in scene.
<new group> - Create individual group. Can associate functions within a group.

Object Properties: Dynamics Tab

Figure 1: Dynamics Tab, Add Dynamic drop-down menu.

The Dynamics Tab of the Object Properties Panel is where you can add FX Dynamics and manipulate their settings.

Add Dynamic

The Add Dynamic dropdown menu lets you select Dynamics to apply to an object.Add Dynamic choices:

Cloth - ClothFX , applies Cloth Dynamics to a target object.
Soft - SoftFX , applies Soft Body Dynamics to a target object.
Hard - HardFX , applies Hard Body (Rigid Body) Dynamics to a target object.

You can associate particle FX’s functions by using groups. If multiple emitters are in the same group, you can 
associate settings. Also, if you do not want to associate, just by removing an emitter from the group, you can 
stop the association.


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Emitter - adds a ParticleFX Particle or Partigon Emitter to the scene. Note that if you wish to add a HyperVoxel 
emitter rather than a particle emitter, you should use the Item: Add: Dynamic Object: Particles menu option to 
add the HV Emitter.
Wind - adds a Wind controller to the scene, which can be placed, sized and oriented to affect a specific portion of 
the virtual stage.
Collision - adds a Collision controller to the scene, which can be placed, sized and oriented to affect a specific 
portion of the virtual stage.
Gravity - adds a Gravity controller to the scene, which can be placed, sized and oriented to affect a specific 
portion of the virtual stage.

Dynamics List Window

Once you have added a Dynamics type and selected it, you will see controls for that dynamics type presented under the 
list portion of the Object Properties window. In addition, above the listview, on the right hand side of the window there 
will be a Calculate button.

Calculate

Clicking on the Calculate button will perform the dynamics calculations for the scene. If the FX Browser is not open, 
please note that if you change focus to another application or attempt to move the Object properties panel, the 
viewports will stop tracking the dynamics progress and stop refreshing. Layout will appear to be locked up, but the 
calculations are continuing, and the interface will refresh again when they are complete. Having FX Browser (Utilities/
Plug-ins/Additional/FX Browser) open during calculations is therefore recommended to avoid the appearance of a 
lockup.

Cloth Dynamics
Soft Body Dynamics
Hard Body Dynamics
ParticleFX (Emitter)
Dynamics: Collision Controller
Dynamics: Gravity Controller
Dynamics: Wind Controller
Additional Dynamics Utilities
FX Linker
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Cloth Dynamics

Cloth Dynamics (ClothFX) have a variety of uses for supplying physical characteristics and natural movement simulation 
to thin, flexible materials.

Examples:

Clothing on a character such as a dress or shirt
Flag blowing in the wind
Curtains
Tablecloth or anything that needs to be draped over another object
Mud flaps on a truck
Hair

ClothFX Menu Tabs, Basic Tab menu

Cloth Dynamics are located in the Dynamics Tab of the Object Properties Panel. Choose Cloth from the Add Dynamic 
drop down list and then follow that by clicking on ClothFX in the Dynamics list window to open up the ClothFX options.
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“Sew” function in use

Basic Tab

Basic Tab menu

Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also 
works with ParticleFX controllers. This becomes very handy when you are working on a complex scene and you 
want certain Wind emitters to affect only certain objects.

Fix - The shape of polygons with “Fix” on remains intact and is not affected by the dynamics. In the image below, 
the ends of the cloth have been Fixed so that they stay in place while the rest of the geometry is pulled down by 
gravity.
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“Fix” applied to polygons indicated inside orange outlines – these stay in place, while gravity affects the rest of 
thecloth object.

Weight - defines the weight of the material. You can simulate the motions of a heavy material by increasing the 
Weight value, and you can simulate the motions of a light material by decreasing Weight.

The dress on the right hangs down more due to its weight and also will not flap as much.

Spring - controls the springiness or stiffness of the material. Reducing the Spring coefficient creates soft 
motions, while raising Spring produces motions with a stronger repelling force. Setting the coefficient to an 
extremely large value creates stiff motions.

Viscosity - controls the level of impact that a collision will have on the shape of an object. An object with higher 
Viscosity value tends to keep its shape more. If an object bounces, a higher Viscosity value will have less bounce 
motion because the Viscosity absorbs the bouncing force.

The pieces of cloth below are the same except for the Viscosity parameter. Here, a ball is moving up, pushing the 
piece of a cloth. The cloth with the higher Viscosity value tends to keep its shape more.



LightWave 2020  –  LightWave 2020

Reference –  2008

•

•

 
Effect of viscosity parameter on cloth. Left = lower viscosity, Right = higher viscosity

Resistance - This parameter is not a characteristic of the object itself, even though it can be set per object. 
Resistance controls the amount of resistance of the environmental medium in which the simulation is taking 
place. For example, this affects how quickly a cloth object moves through the virtual air in the scene by 
determining how “thick” the virtual air is. The default setting is 1.0; raising this number increases the resistance 
and lowering to a number between 1.0 and 0.0 decreases the resistance. This allows the simulation of a wide 
range of gaseous or even liquid media as the environment for the physical simulation. A negative number 
amplifies a collision of the cloth object. To simulate behavior within a normal atmosphere at sea level, a value 
of .14 would be appropriate. A value of 1.0 gives the medium a character close to that of molasses.

Sub-Structure - The surface of a pure, elastic body model has a high degree of freedom, which causes the object 
to easily distort. To prevent distortion, you can apply an auxiliary form, called a Sub-structure, to restrict the 
instability of the surface. This can improve your results with a two-dimensional object (i.e., one with no 
thickness) making it act as if it has some thickness. However, this reinforcement can require a high Sub-
Structure setting that can take longer to calculate.

When Sub-Structure is used on a square mesh, it creates something that looks like two triangular polygons 
placed on top of each other in opposite directions. The Sub-structure mitigates the tendencies to bend and to 
resist bending in certain directions. 

 
Substructure applied to the quadrangles of a mesh.

If you are coming to LightWave from Maya, the function that is most similar from that application is 
“Damping.”


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When the Sub-structure value is non-zero, the auxiliary form is applied. The higher the value, the more the form 
will have a tendency to keep its shape.

Hold-Structure - because a pure elastic body model simulates only the surface structure, it is limited to two-
dimensional motions, such as a bed sheet. In order to simulate elastic three-dimensional motions, such as a 
lump of gelatin, a Hold-structure needs to be used. This parameter causes a surface to tend to maintain its 
original shape, like gelatin does when it jiggles.

FX Button - Allows you to use a Vertex Map to control the value of an attribute (spring, viscosity, etc.) or a 
function (delay, wave size, compress bump).

 
FX Drop Down menu buttons

From the FX drop down menu the user can select a Vertex Map as well as change the base value.
Vertex Map – Will be displayed by name and type.

Example: “LeftArm/Weightmap”

Weight Map – The weight value of each point is defined in Modeler when you create a Weight Map. In Layout you 
cannot edit Vertex Map values. But the FX button allows you to add a modifier that, when combined with the 
original values of the Vertex Map, provides a way to adjust the values of the selected attribute/function without 
changing the original Vertex Map value.

Pointset – A pointset is created in Modeler. In Layout you cannot add or subtract points from a pointset. But the 
FX button allows you to add a modifier that, when combined with the pointset (value of 100%), provides a way to 
adjust values of the selected attribute/function.

Surface – Surfaces are created in Modeler. In Layout you cannot add or subtract points from a surface. But the FX 
button allows you to add a modifier that, when combined with the surface (value of 100%), provides a way to 
adjust values of the selected attribute/function.

UV – UV maps are created in Modeler. In Layout you cannot add or subtract points from a UV. But the FX button 
allows you to add a modifier that, when combined with the UVs value, provides a way to adjust values of the 
selected attribute/function.

The effect of Hold-structure is uniform throughout the surface, while with Sub-structure it is non-linear, which 
will often result in a more natural look. You can use a combination of both to achieve just the right result.



You can always check value information for points in the Point Info windows.
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Base – Selecting the <base = 0> option from the FX Drop Down menu will open a small requester that allows the 
user to edit the base value. Changing the base value changes the effective range. Example: Base=0% (0 – 100), 
Base=20% ( 20 – 100). The base value is 0% by default.

Collision Tab

Record Collision Points - When this is activated, ClothFX will record the time and location of a collision, which 
will trigger a particle emitter that has been set up and that is parented to the ClothFX object.

Fix By Event - This function will fix points that pass through a collision object that is set to “Event” mode.

Collision Detect - allows other objects to influence the motion of a dynamic object. This lets you create complex 
motions caused by obstacles in the path of the dynamic object. The simulation is performed by taking an object 
that collides (the collision object) with the elastic body model (dynamic object) into account in the calculation.

Exclusive Collision - When a collision object is selected from the list in this control parameter, it becomes the 
sole collision object. All other collision objects are excluded from the calculation.
Interaction - By Default you would want Interaction set to “All” so that all geometry will interact with each other. 
However you have the option of limiting the interaction by Vertex Maps.

Collision Offset - By default the collision offset is set to 0 so that the collision object will collide with the surface 
of the target object, allowing the target object to deform. Increasing the Collision Offset will result in the 
collision object deforming the target object at the distance specified in the Collision Offset field.

For those interested, the equation used to calculate the vertex point value is: Vp = Vmap * value+ (1- Vmap) * 
base. Another way to look at the equation is: Vp=(value-base)*Vmap+base.



Record CP works with ParticleFX and Nozzle=Parent collision, but you cannot use it with FX Collision and 
Parent Recorded CP (FX emitter>playback mode).


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Collision offset

You should understand that the collision is detected using a point on the target object (elastic body model) and a 
polygon of the collision object. As a result, a polygon of the target object can possibly penetrate the collision object—
usually an undesirable result. Use the Collision Offset setting to avoid undesired surface penetration.

Bound - adds a rebounding speed change at collision.

Friction - Like real-world friction, the Friction parameter makes the surface of the dynamic object less slippery. 
So, if you want the Dynamic object to tend to slip off the collision object, set Friction to 0. If you want it to stick 
more, increase the value.

The settings on the right image have a higher friction causing the cloth to stick to the collision object.

Fix Force - causes the dynamic object to stick to the surface and not slide around.

The image on the right has a higher Fix Force setting.

Self Collision - The Self Collision setting helps prevent a soft or cloth object’s mesh from passing through itself 
when the object is transformed during the simulation. Self Collision is calculated based on a point on the target 
object and a polygon on the collision object. If a surface has Self Collision and Collision Detection active, Self 
Collision is computed on the same surface.

Self Collision works in much the same way Collision Detection does, and there is no collision detection for polygon 
edges. As such, you may also want to adjust Collision Offset to avoid errant point penetrations.
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Connected - Connected is a Self-Collision option that derives its name from the Select Connected option in 
Modeler. When activated, a contiguous mesh within an object can self-collide. When deactivated, adjacent 
meshes within a single object can “self-collide” with each other, but any given mesh will not be able to collide 
with itself.

An example would be a character object that has been modeled with a complete body mesh and with clothing as 
additional meshes that are not part of the body mesh, such as a T-shirt. The T-shirt and the body of the character would 
be separate contiguous meshes - that is, in Modeler, selecting a few polygons on the T-shirt and hitting Select 
Connected will select all of the polygons of the T-shirt, but not select the polygons of the body. Selecting a few polygons 
on the body and hitting Select Connected will select all of the polygons of the body, but not the T-shirt.

In ClothFX, if Self-Collision is on but Connected is de-activated, the T-shirt can collide with the body, but not with itself. 
If Connected is activated, the T-shirt can collide with itself and with the body of the character. Deactivating Connected, 
then, can speed up a self-collision calculation at the cost of accuracy. Use only when separate meshes contained within 
a single object layer must collide against each other, but do not have to collide with themselves. Do not deactivate this 
option when dealing with curtains, windsocks, or any other situation where the material must self-collide with areas 
actually connected to itself.

Double Side - Collision is detected even if the motion is from behind the polygon.

Advanced Tab

Resistance Mode - Resistance mode tells the Resistance setting in Basic Tab how to react. With some amount of 
Resistance applied, you can see as you change Mode settings how the polygons will resist wind effects.

None - points move based on wind direction.
Polygon - points move based on wind direction + point normal.
Polygon (front) - points facing the wind move based on wind direction + point normal.
Polygon (back) - points facing away from wind move based on wind direction + point normal.

Mode Ratio - sets the amount of Resistance applied to specific effects set by Resistance Mode versus standard. 
75% sets 75% of the Resistance Mode and 25% of the standard resistance.

Compress Stress- controls the amount of compression a surface exhibits as a result of stress. A soft fabric like cotton 
can be made using a large Spring value and a low Compress Stress setting.

A stiffer fabric would use a higher Compress Stress setting. An example for use: you could easily make the apparent 
thickness of drapery vary with this setting.

Resistance Mode settings only apply to wind.
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Stretch Limit - To prevent a surface from stretching like rubber, lower the Stretch-limit below the default value of 
100%. This restricts the amount that the surface can be stretched. Setting Stretch Limit to 0% turns it off 
completely. For free-moving cloth like flags and curtains, one might set it as low as 1%. However, give clothing 
some “breathing room” in the Stretch Limit, and do not lower it below 10% for clothing items like sleeves, shirts, 
and pants. To reduce sagging in clothing, reduce the Polygon Size, not the Stretch Limit.

Polygon Size - Changes the surface to a specified size. For example, a value of 90% reduces the size of the surface 
to 90%. Use Polygon Size to reduce the looseness of a dress or to create frills.

Fiber effect - Allows you to set an axis for the traditional Fiber effect, basically making a certain axis “stronger” 
than the others. For example, setting Y as the axis makes the built-in folds of the dress (dress_fx002) stronger so 
the folds aren’t disregarded during calculation.

Relax Start - When this option is on, the ClothFX object starts out with no “Stress State”, meaning that the object 
is considered to be in its “true” or “base” state. Thus, if any displacements are applied to the object on the first 
frame of the calculation, the resulting form will be considered the “true” or “base” form of the object. This 
includes any Stretch/Size, bones, displacement maps, or morphs present on the first frame of the calculation. 
ClothFX will respect the size of each polygonal edge as the “true” length of each polygonal edge, and it will stick 
close to the distorted proportions of the object during the calculation.

When Relax Start is turned off, ClothFX considers the undistorted state of the object as it would be seen in Modeler to be 
the “true” or “base” state of the object. If the object is deformed by Stretch/Size, bones, displacement maps, or morphs 
on the first frame of the calculation, the object is considered to be “stressed” and will regain its “true” proportions 
during the calculation.

For example, take a sheet of polygons aligned with the XY plane and fix the uppermost row of points. If this object is 
stretched to a value of 4 on the Y axis, and Relax Start is turned ON, then the stretched version is accepted as the “true” 
version, and the calculation will be for a tall version of the object, without any great fuss. If Relax Start is turned OFF, 
then the unstretched version is regarded as the “true” form of the object. Because the object is stretched to four times 
its original size on the first frame of the calculation, the effect is as though the object begins by being stretched like a 
rubber band. As soon as you hit Calculate, the non-fixed points of this non-relaxed object will SNAP back into distances 
between themselves and their neighbors that more closely resemble the distances between them in the undistorted 
version of the object as would be seen in Modeler.

Compress Stress affects the strength of Spring and Substructure spring forces when they become compressed 
during the calculation. Suppose a polygonal edge, which represents a Spring force, is 1m in length, and the 
Spring strength is set to 1000 and the Compress Stress to 30%. If the material is stretched so that the edge 
becomes more than 1m in length, the Spring force will snap back with its full force of 1000. If the material is 
compressed so that the edge becomes less than 1m in length, the Spring force will push the points back with a 
force of only 300 (30% of 1000). The same Compress Stress percentage applies to Sub Structure forces when a 
Sub Structure spring is compressed below its original length.



Although you could also increase the Spring value to reduce stretching, increasing that value can make the 
behavior of the surface too complex and cause problems such as weird folds.


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Etc. Tab

Gravity(m/s^2) - Specify the direction and intensity of gravity along the world axes for this particular dynamic 
object. Note that when you set gravity in the Etc Tab for your dynamic object, it is not necessary to add a gravity 
controller separately. Conversely, if you add a gravity controller and set your gravity characteristics properly 
there, it will not be necessary to set gravity for the dynamic object on the Etc Tab. If you have a number of 
objects in the scene that you wish to have affected by gravity, then it might save effort to add a gravity controller 
and properly set it up and size it to affect all the necessary objects.

Resolution - Set the accuracy of calculation by how big the maximum error is.

When it approaches 0 the accuracy increases and errors will decrease, but calculation workload will also increase so it 
will take more time to calculate.

Timestamp Method was introduced to resolve an issue where ClothFX could get stuck doing very small timesteps in 
some cases. This would most often happen with meshes having vertices surrounded by tiny polygons. The default is 
“Velocity” which is the old method, and “Frequency” is the new method. “Frequency” does not always work, so if one 
doesn’t work try the other.

View Feedback - Set the feedback in Layout when controlling ClothFX. When the display is poor or the display 
speed is slow, you uncheck this.

Numeric Feedback - Set the numerical feedback in Layout when controlling ClothFX . When the display is poor or 
the display speed is slow, you uncheck this.
Presets - Similar to surface presets, ClothFX has 5 built in presets that give you a good place to start. Presets 
include: Cotton Thin, Cotton Thick, Silk, Rubber, Jelly.

The gravitational acceleration constant on earth is 9.81m/s^2. On planets with a less strong gravitational pull, 
(such as the moon) it is much lower, whereas on planets with a stronger pull (such as Jupiter) it is much higher. 
In LightWave’s coordinate system, you would set gravity by entering a negative value in the Y entry field; -9.81 
m for Earth-normal gravity.


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File Tab

Figure 18: File Tab

Load Motion - Loads a previously generated Motion file.

Clear Motion - Clears a loaded Motion file.

Save Motion - saves the generated motion to a file, which will be used subsequently to deform the object.

Load Limit- Loads a limited range of Frames. Example: If you have a MDD file with 2000 frames of data you can limit 
loading to just 100 frames to make it less memory and processor intensive.

Playback Mode

Normal - Plays back all Motion settings of the .mdd file.

Local - Plays back based on the local translations (move, rotate and scale) of the object. Allows a .mdd 
deformation on an object while respecting new motion applied to that object.

Distance Map - This adjusts the motion data to the movement of the object. When the speed is 100%, 1s (second) 
of motion data is used to move the object a distance of 1m.

Speed - When Playback Mode is set to Local or Distant the user is able to control the playback speed. One can 
also play the MDD file backwards from by setting Speed to –100% and inputting the frame-length of the MDD file 
into Shift Frames. For example, if the user recorded a 300-frame MDD file, he could play it backwards by setting 
the Playback Mode to Local, the Speed to –100% and the Shift Frames value to 300

Node Match - When Node Match is activated, the motion data can be played back on the object’s local position. 
Node Match allows one to play back MDD data recorded from an object with a different point count and order as 
long as the points share the exact same XYZ coordinates in Modeler. For example, suppose you had a castle 
model with a flag on top. One could run ClothFX on the whole castle, but this would result in a large MDD file for 
such a tiny detail, the flag. So, in Modeler, delete the castle polys and save the flag as a different object. Record 
the ClothFX calculations on the flag, and save the MDD file. Load the castle into Layout, apply ClothFX, load the 

After a motion file is saved, the name of the file will automatically be entered into the load field.
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MDD file calculated from the flag, set the playback to “Local” and activate Node Match. Node Match will remap 
the MDD data recorded from the flag-only object to the XYZ equivalents on the castle-with-flag geometry

Shift Frames - The user can shift the time the motion starts. Use Shift Frames if you need the motion to start on 
an earlier or later frame. By default, the number entered is regarded as a number of seconds to shift the .mdd 
file. If you prefer to use frames, enter the number of frames followed by the letter “f”; “-400f”, for example, to 
shift so that the motion in the .mdd file starts at frame -400.
Loop - The user has the option to loop the motion file in two ways.

Repeat - Plays the motion from start to finish and then repeats the motion from start to finish continually.

Oscillate -Plays the Motion from start to finish and then plays it from the end frame backwards to the start frame 
and then repeats the cycle. (Ping Pong motion)

Motion Size - Motion Size increases the distance relationship between points in a motion file.

Copy - Use the Copy button to copy the current settings between dynamic objects.

Paste - Use the Paste button to paste the current settings between dynamic objects.

Save - Saves all the settings contained in the ClothFX properties.

Load - Loads a saved Settings file. This is similar to using a Preset.

Scan Motion - Scans the motion of the object and applies the scanned results (.mdd file) to the object.

This means you don’t have to apply another plug-in to scan the motion (including bones, etc). It eliminates the steps of 
loading the motion file back in, and also enables you to quickly scan an object’s motion to allow for the use of EditFX on 
an object even if it’s not using dynamics.Info- Clicking the Info button brings up a window that gives you the version # of 
ClothFX and the MDD file information.

EditFX Tab

EditTool - Activates the ability to edit points. You will be able to visually see that you’re in Edit Mode in the 
viewport. All the points that make up the object will become highlighted and all the EditTool functions will 
become active.
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Sew function applied

Undo - The EditTool has its own undo. Click this button to undo the last edit that was made. You can only undo 
one edit.

EditNode - Specify the ID number of the point to be edited. If the EditTool is activated, you can select the target 
point from the Layout viewports by clicking on the point.

EditFrame - There are 4 modes to edit the Node’s (point) motion path.
All - will edit the entire Motion Path .
After - will edit the current frame and everything after it.

Before - will edit the current Frame and everything before it.

Current - will edit only the current Frame.

EditStart / EditEnd - Use the EditStart and EditEnd Fix options to set the range of frames that the user will be 
able to edit. All other frames will be fixed (locked).

EditSize - (Edit Range) This field changes the influence range.

Edit Falloff - This drop down is located to the left of EditSize. This will change the Falloff settings to either None, 
Soft, Linear, or Hard. As shown in Figure 19, by default the setting is Soft.

None - All vertices are influenced; in other words the whole mesh moves.

Linear - Deformation in the range of EditSize is attenuated linearly.

Soft - Deformation is attenuated smoothly in the range of EditSize.

Hard - Deformation occurs uniformly in the range of EditSize, and is not attenuated.

EditAxis - This sets the axis/axes in which the Node (point) can be edited. (All, X, Y, or Z)

EditMap - This option lets you limit the portion of the object that is editable by giving the user the option to edit 
by Vertex Maps.

You do not have to re-calculate when you move the path or keyframe data with EditAxis.
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SelectUpdate - When activated, you can re-calculate only the parts selected by EditNode. To re-calculate, click 
Calculate with SelectUpdate checked.

Command - The Command drop-down offers two commands for use during the editing process, Smooth and 
Makepath.

Smooth - Referring to the current frame, the movement of the parts that were selected by EditNode will be 
smoothed. When EditStart and EditEnd are not specified, the movement of the selected parts to the current 
position will be smoothed across all the frames. When EditStart and EditEnd are specified, it will make the 
position information smooth from the specified frames to the current frame.

Makepath -This command will create a Null object whose path is identical to the motion path of the selected 
part.

Sewing Tool - Enables Sewing Mode. Sewing Mode gives the user the ability to sew Nodes (points) together.

Sewing - This button is the third step in a three-step process of sewing Nodes together using the Sewing tool.

Steps to Sewing: “Left Click” on the first point and “Right Click” on the second point. Then click on the Sewing button.

Current Sew Object - Drop down list located to the right of the Sewing tool enables the user to choose which 
object is being sewn.

Link Node - Displays the Node that has been selected.

Event - This drop down menu determines whether the linked nodes will be Cut by an event or sewn by an event.

Cut by Event - When an Event object passes through the Nodes (points), they will break apart and become 
separated.

Sew by Event - When an Event object passes through the Nodes (points) they will be sewn together (Merged).
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Soft Body Dynamics

Soft Body Dynamics (SoftFX) are used to set physical behavior characteristics and to calculate physical simulations for 
an object that is intended to have an elastic nature through all or a portion of its volume. Generally a “soft body” 
maintains its volume, but the shape will vary based on motion and on forces being applied in the scene, including 
collision with other objects. Some examples:

Jello wiggling on a plate
The Pillsbury Dough Boy’s tummy jiggling as he jumps around
A flat tire flopping as the vehicle comes to a stop
A ball deforming as it bounces on a floor

SoftFX is located in the Dynamics Tab of the Object Properties Panel. Choose Soft from the Add Dynamic drop down list 
and then follow that by clicking on SoftFX in the dynamics list window to open up the SoftFX options.
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Input Tab

Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also 
works with ParticleFX controllers. This becomes very handy when you are working on a complex scene and you 
want certain Wind emitters to affect only certain objects.
Delay - Delays the deformation by a set amount of frames. Delay will not take effect until the Delay check box is 
selected for motion force, wind force, or wind force direction.
FX Button - Allows you to use a Vertex Map to control the value of an attribute (spring, viscosity, etc) or a function 
(delay, wave size, compress bump).

From the Effects drop down menu the user can select a Vertex Map as well as change the base value.

Vertex Map – Will be displayed by name and type. 

Example: LeftArm/Weightmap

Weightmap – The weight value of each point is defined in Modeler when you create a Weight Map. In Layout you 
cannot edit Vertex Map values. But the FX button allows you to add a modifier, that combined with the original 
values of the Vertex Map provides a way to adjust values of the selected attribute/function without changing the 
original Vertex Map value.
Pointset – A pointset is created in Modeler. In Layout you cannot add or subtract points from a pointset. But the 
FX button allows you to add a modifier, that combined with the pointset (value of 100%) provides a way to 
adjust values of the selected attribute/function.
Surface – Surfaces are created in Modeler. In Layout you cannot add or subtract points from a surface. But the FX 
button allows you to add a modifier, that combined with the surface (value of 100%) provides a way to adjust 
values of the selected attribute/function.
UV – UVs are created in Modeler. In Layout you cannot add or subtract points from a UV. But the FX button allows 
you to add a modifier, that combined with the UVs value provides a way to adjust values of the selected 
attribute/function.

Base – The base value is 0% by default. Changing the base value changes the effective range.

Example: Base=0% (0 – 100), Base=20% ( 20 – 100).

You can always check value information for points in the Point Info windows.

For those interested this is the equation used to calculate the vertex point value. Vp = Vmap * value+ (1- Vmap) 
* base.


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SoftFX has 3 inputs: Motion, Wind and Force.

Motion Force - Uses the Delay setting based on the motion of the object. The user has the ability to change the 
amplitude as well as apply an envelope.
Motion Force Delay check box - Activates the Delay setting for Motion Force.
Wind Force - Uses the Delay setting based on wind present in the scene. The user has the ability to change the 
amplitude as well as apply an envelope.
Wind Force Delay check box - Activates the Delay setting for Wind Force.
Force Direction - Forces the object to move along the axis selected (X, Y, or Z).
Force Direction Delay - Activates the Delay setting for Direction Force.
Force By Key - Only works when an envelope is applied. Takes the keyframes in the envelope and applies a force 
for every key.
Force - The value that Force Direction uses. The user has the ability to apply an envelope.

Operator Tab

Operator 1 and 2 Map – a deformation can be applied to nothing, everything or a particular Vertex Map.

Mode - How the Operator Map affects the objects deformation.
None – default (no change)
Square – Dampens the Operator Map so that the map is affecting the object deformation 0% at the start of the 
map to 100% at the end of the map.
Invert - Reverses the Operator Map’s original effect on the objects deformation.
Quad - Divides the map’s effect on deformation into 4 equal regions.
Inv Square – Reverse of “Square”. 100% at the start of the map and 0% at the end.
Inv Quad – Reverse of Quad.
Effect Size - increases the amplitude of the deformation.
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Left: Effectsize 50%; Right: Effectsize 200%

Wavecycle - number of cycles inside the deformation.

Left: Wavecycle 1.0; Right: Wavecycle 8.0

Wave Size(s) - the frequency of the deformation.

Left: Wavesize 0.1; Right: Wavesize 0.4

Op1 Motion/Op2 Wind- Limits the operator 1 map to the motion of the object and limits the Operator 2 Map to 
the wind. By activating these, the motion input affects the Operator 1 Map, and the wind input affects the 
Operator 2 Map.

Calculate Op2 Last - Applies operator 2 after everything in SoftFX has been calculated.
Operator Switch (blend operator) - if set to 50% it uses both Operator 1 and Operator 2 Map equally. If set to 0%, 
it uses 100% of Operator 1 Map. At 100%, it uses 100% of Operator 2 Map. You can also have a Texture Map which 
will control this blending.

Deform Tab
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Collision Detect - reflects the influence of other objects upon the motion of an object. This lets you create 
complex motions caused by obstacles. The simulation is performed by taking an object that collides (the 
collision object) with the elastic body model (dynamic object) into the calculation.
Exclusive Collision - Selecting an item from this list will exclude all other collision objects from the calculation.
Collision Size - Determines how the force of the collision is distributed across the SoftFX object.

Delays - Delays the reaction of the object returning to its original shape.
Fix By Event - This function will fix points that pass through a collision object that is set to “Event” mode.
Keep Root (keep original size) - object will keep its original size through SoftFX calculations. For example, you 
start with a 12” ruler. With Keep Root unchecked, this ruler might stretch to 14”. If Keep Root is checked it will 
maintain 12”.
Follow To - Uses these modes:
Path - Deforms the object along its motion path.
Wind – Deforms the object in the direction of the wind.
Gravity – deforms the object based on the gravity emitter.

Normal , Follow To Path

Path Shift - shrinks the root size (original size).
Ring - Ring does for a cylinder what Keep Root does for a straight line. You are limited to only 4 rings for 
calculation but can use Hard link or Meta link to apply it to objects with more then 4 rings.

Limit Size - Drop down menu- When activated:
Max Size -Will limit the size of the deformation by clipping it to the limit size.
Resize - Will limit the size of the deformation by shrinking it to the limit size.
Limit - Amplitude setting for the Limit.
Vector Limit - Constraining the movement to a particular axis, Normal, and object radius.

X - Becomes deformed only in the x direction.
Y - Becomes deformed only in the y direction.
Z - Becomes deformed only in the z direction.
X (local) - Becomes deformed only in the local x direction of object.

A Circle is one Ring. A Cylinder contains 2 Rings.
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Y (local) - Becomes deformed only in the local y direction of object.
Z (local) - Becomes deformed only in the local z direction of object.
XY - Becomes deformed only in the XY direction.
YZ - Becomes deformed only in the YZ direction.
ZX - Becomes deformed only in the ZX direction.
XY (local) - Becomes deformed only in the local XY direction of object.
YZ (local) - Becomes deformed only in the local YZ direction of object.
ZX (local) - Becomes deformed only in the local ZX direction of object.
Object radius - Becomes deformed only in the spherical direction, which centers pivot.
Normal vector - Becomes deformed only in the normal direction.
NV-Front - Becomes deformed only in the direction of normal grain side.
NV-Back - Becomes deformed only in the direction of normal reverse side.
Limit Ratio -percentage of the Vector Limit.

Bump Tab

Compress Bump - Applies bump (bulge) to polys that are under compression (push) and maintains the object’s 
volume.
FX Button - Allows you to use a Vertex Map to control the value of an attribute (spring, viscosity, etc) or a function 
(delay, wave size, compress bump),

From the Effects drop down menu the user can select a Vertex Map as well as change the base value.

Vertex Map – Will be displayed by name and type. 

Example: “LeftArm/Weightmap”

Weightmap – The weight value of each point is defined in Modeler when you create a Weight Map. In Layout, you 
cannot edit Vertex Map values. But the FX button allows you to add a modifier, that combined with the original 
values of the Vertex Map provides a way to adjust values of the selected attribute/function without changing the 
original Vertex Map value.
Pointset – A pointset is created in Modeler. In Layout, you cannot add or subtract points from a pointset. But the 
FX button allows you to add a modifier, that combined with the pointset (value of 100%) provides a way to 
adjust values of the selected attribute/function.
Surface – Surfaces are created in Modeler. In Layout you cannot add or subtract points from a surface. But the FX 
button allows you to add a modifier, that combined with the surface (value of 100%) provides a way to adjust 
values of the selected attribute/function.
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UV – UVs are created in Modeler. In Layout you cannot add or subtract points from a UVs. But the FX button 
allows you to add a modifier, that combined with the UVs value provides a way to adjust values of the selected 
attribute/function.

Base – The base value is 0% by default. Changing the base value changes the effective range. Example: Base=0% 
(0 – 100), Base=20% ( 20 – 100).

Negative Bump - Applies negative bump (dented) to polys under tension (pull).
Cycle Bump - Generates bump(s) across the Vertex Map selected. The higher the cycle the more bumps 
generated.
Cycle - Number of bumps generated by Cycle Bump.
Bump Offset - Allows you to create a bump/negative (bulge//dent) without any compressed polys.

Bump Limit - Limits the maximum effect of the bump value(s).
Make Wave By - Uses the Vertex Map information to create a rolling wave.
Wave Size - Amplitude of the wave created. At a higher value the total height of the wave increases.
Loop Cycle - Effects number of waves generated.
Loop Speed - Effects how fast the waves move across the object.

File Tab

Load Motion - Loads a previously generated motion file.
Clear Motion - Clears a loaded Motion file.
Save Motion - saves the generated motion to a file, which will be used subsequently to deform the object.

You can always check value information for points in the Point Info windows.

For those interested this is the equation used to calculate the vertex point value. Vp = Vmap * value+ (1- Vmap) 
* base.



there must be a compressed bump or negative bump value for Bump Offset to function.
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Shift Frames - Shifts the starting playback frame of SoftFX data. By default, the number entered is regarded as a 
number of seconds to shift the motion of the .mdd file. If you prefer to use frames, enter the number of frames 
followed by the letter “f”; “-400f”, for example, to shift so that the motion in the .mdd file starts at frame -400.

Playback Mode

Normal - Plays back setting all motion to .mdd file
Local - Plays back based on the local translations (move rotate and scale) of the object. Allows an .mdd 
deformation on an object while respecting new motion applied to that object.
Copy - Use the Copy button to copy the current settings between dynamic objects.
Paste - Use the Paste button to paste the current settings between dynamic objects.
Save - Saves all the settings contained in the SoftFX properties.
Load - Loads a saved settings file. Similar to using a Preset.
View Feedback - Set the feedback in Layout when controlling HardFX. When the display is poor or the display 
speed is slow, you uncheck this.
Numeric Feedback - Set the numerical feedback in Layout when controlling HardFX. When the display is poor or 
the display speed is slow, you uncheck this.

Animation Feedback

Info - Clicking the Info button brings up a window that gives you the version # of ClothFX and MDD file 
information.

EditFX Tab

Edit Tool - Activates the ability to edit points. You will be able to visually see that you’re in Edit Mode in the 
viewport. All the points that make up the object will become highlighted and all the Edit tool functions will 
become active.
Undo - The Edit tool has its own undo. Click this button to undo the last edit made. You can only undo one edit.
Edit Node - Specify the ID number of the point to be edited. If the Edit tool is activated, you can select from the 
Layout by clicking on the point.
Edit Frame - There are 4 modes to edit the Node’s (point) motion path.

All - will edit the entire Motion Path.
After - will edit the current frame and everything after it.
Before - will edit the current Frame and everything before it.
Current - will edit only the current Frame.

Edit Start/Edit End - Use the Edit Start and Edit End Fix options to lock off frames from being edited. This is the 
range of frames that the user will be able to edit. All other frames will be fixed (locked).
Edit Size - (Edit Range) This field changes the influence range.
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Edit Falloff - This drop down is located to the left of Edit Size. This will change the Falloff settings to either None, 
Soft, Linear, or Hard. By default the setting is Soft.

None - It has an influence on all apexes, in other words the whole mesh moves.
Linear - Deformation in the range of editSize is attenuated to linear.
Soft - Deformation is attenuated smoothly in the range of editSize.
Hard - Deformation occurs uniformly in the range of editSize, and is not attenuated.

Edit Axis - This limits the axis in which the Node (point) can be edited. (All, X, Y, or Z)
Edit Map - This option lets you limit the portion of the object that is editable by giving the user the option to edit 
by Vertex Maps.

Command

Smooth - Referring to the current frame, the movement of the parts that was selected by editNode will be 
smooth. When editStart and editEnd are not specified, the current position will be copied to all the frames. When 
editStart and editEnd are specified, it will make the position information smooth from the specified frame to the 
current frame.
Makepath - This command will create a Null object whose path is identical to the motion path of the selected 
part.



LightWave 2020  –  LightWave 2020

Reference –  2028

1.
2.
3.
4.
5.

Hard Body Dynamics

Hard Body Dynamics (also called Rigid Body Dynamics or Geostatic Simulation) are used to set the physical interactions 
and characteristics of bodies that are solid, or fixed in shape. Some examples:

Bowling Pins
Windowpane breaking
Objects exploding into pieces
Dominoes
Pinball machine

HardFX will easily create rigid body characteristics and behavior when applied to a goal object in a scene. You then need 
to set the Weight, Reflection, and Collision settings and calculate. The object that has an impact will rotate and move 
according to its shape and size. It will automatically calculate the result so that the outcome will be more realistic.

You do not have to create individual objects for the pieces that break into parts for calculation. If the points are 
connected as a continuous surface, or if it is a group, it will be determined as parts. Also, it is possible to create the 
events as a trigger.

One of the big features is the Edit tool which allows you to adjust the path of the objects by simply dragging the mouse, 
and to move, rotate, and smooth the motion itself. With this addition, you do not have to calculate every time you make 
some changes. As a result, you can easily create the movement that you wish.

HardFX is located in the Dynamics Tab of the Object Properties Panel. Choose Hard from the Add Dynamic drop down 
list and then click on HardFX in the list to open up the HardFX options.
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Basic Tab

You can set the basic settings like air resistance, weight, and size.

Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also 
works with ParticleFX controllers. This becomes very handy when you are working on a complex scene and you 
want certain Wind emitters to only affect certain objects. 

<default> Includes all groups.<new group> Creates an individual group and can associate functions within a 
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group.

Piece Mode - Setting for how HardFX will treat the object.

1piece - Make all polygons as one piece.
Parts - Make polygons that have common points as one piece.
1piece>parts (collision) - When it starts, it will be in 1 piece mode, but with Collision, it will change to parts 
mode.
1piece>parts (event) - When it starts, it will be in 1 piece mode, but with a Collision event, it will change to parts 
mode.

The event’s detection is made by each part’s pivot.

Adv. Resistance - Changes the calculation of the air resistance to an Advanced Mode. Usually, the value for air 
resistance is set only in Resistance; however, by turning Adv. Resistance on, it will include the object’s XYZ ratio. 
This helps create realistic physical movement like leaves falling.

Size - used to set the size of the object that will be used for collision. The size will be the percentage of each part.
Size Effect (weight) - Proportionate to each part’s weight to size. By turning it on, you can set weight 
proportional to the size (scale).
Weight - Sets the mass for each part. A higher value will increase the velocity from the items origin, while a lower 
value slows the velocity.
Size Effect (Resistance) - Controls the relationship of each part’s resistance to size. By turning it on, you set 
resistance proportional to size (scale).

Resistance - This one is not a characteristic of the object or part itself, even though it can be set per object, per 
group or per part. Resistance controls the amount of resistance of the environmental medium in which the 
simulation is taking place. For example, this affects how quickly an object or part moves through the virtual air 
in the scene. The default is 1.0; raising this number increases the resistance to the item’s movement and 
lowering to a number between 1.0 and 0.0 decreases the resistance. This allows the simulation of a wide range of 
gaseous or even liquid media as the environment for the physical simulation. To simulate behavior within a 
normal atmosphere at sea level, a value of .14 would be appropriate. A value of 1.0 gives the medium a character 
close to that of molasses. This can be used as a way to differentiate the behavior of differing parts or objects 
within a given scene.

You can associate with ParticleFX’s functions using group function. If it is in the same group, you can associate 
settings. Also, just by removing from the group, you can break the association.



If the value for the resistance is 0 or the ratio of each part is the same, even if you turn on Adv. resistance, you 
will not get any effect. In the case of a sphere (with same radius), since XYZ ratio are the same, you will not get 
any effect.



If the value for the resistance is 0 or the ratio of each part is the same, even if you turn on Size Effect 
(resistance), you will not get any effect.


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Fix

Sets a Fix each part’s pivot.

Free - Will not fix.
Spring Fix - Fixes with a spring, causing a back and forth motion.
Fix - Fixes.
Spring - When Spring Fix is selected, this represents the power of the Spring, which acts like a rubber band.
Spring Length - Setting for length when spring power is 0. Spring length is the length of the spring and with the 
length of spring offset of the pivot, it moves freely. Depending on the value of spring, spring length will vary.
Gravity - Setting for downward (-y) gravity.

Rotation Tab

The Rotation Tab will set the parameters for rotation.

Axis -Restricts rotation along the specified axis.

Free - Not restricted
x axis - Allows rotation only along the X axis.
y axis - Allows rotation only along the Y axis.
z axis - Allows rotation only along the Z axis.
xz axis - Allows rotation only along the X and Z axis.
xy axis - Allows rotation only along the X and Y axis.
yz axis - Allows rotation only along the Y and Z axis.

Impact Effect - Settings for the effect on rotation when there is an impact.

Roll - Creates rotation depending on the size and velocity.
Force - Creates rotation depending on the impact. This is useful for regular physical movement.
None - No effect to the rotation.
Stop - Stops the rotation.

If you are coming to LightWave from Maya, the function that is most similar from that application is 
“Damping.”


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Wind Effect - Setting for rotation from the effect of Wind.

None - Does not effect the rotation.
Accelerate - Strengthens the current rotation.
Roll - Creates perpendicular rotation to wind and moving direction.
Spin - The object will rotate around the axis that it is moving along..

Size Effect (torque) - Makes a ratio to each part’s torque to size. By turning it on, you can set torque proportional 
to the size.

Torque Min - Sets the minimum value for force for the rotational direction. By combining it with torque Max and 
giving a different torque to each part, you obtain a different rotation for each part.
Torque Max - Sets the maximum value for force for the rotational direction. By combining it with torque Min and 
giving a different torque to each part, you obtain a different rotation for each part.

Shift - Sets the direction of the pivot shift.

Random - Moves the pivot point in a random direction.
x shift - Moves the pivot point in the X direction.
y shift - Moves the pivot point in the Y direction.
z shift - Moves the pivot point in the Z direction.
object pivot - Sets the part’s pivot as the object’s pivot.
Pivot Shift - Moves the pivot of the rotation towards the direction set in shift. The amount is the percentage of 
the part’s size.

Collide - Restricts the movement of Resist (spin).

Free - Resist (spin) will always be on.
Collide - Resist (spin) will turn on only when a collision occurs.
Collide (axis) - Resist (spin) will turn on only when collision occurs and the axis is perpendicular to the collision 
surface.
Resist (spin) - Applies resistance to the rotational direction. This is useful when speed decreases by friction.

Swing - Fixes each part’s position. Useful when you want to create a jiggly movement.

Free - Will not fix the position.
Swing - Turns on swing for fixing the position.
Swing (wind) - Turns on swing and also adds wind to the jiggle.When you have roll or spin selected in wind effect, 
the effect of the wind will be invalidated.
Spring - Sets the restoring force when swing is on.

Switch By - Changes the setting by the specified trigger.

Changed group - When the group is changed in Collision, settings will change.
Event - When an event is given by Collision, settings will change.

If the Impact effect mode is roll, you cannot assign Y axis rotation to the Axis. Roll refers only to X and Z 
rotation.



The value for spring power is for each rotational direction.
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New Impact Effect - Changes the mode of impact effect when the trigger set in “switch by” is given.

Set Shift to Object Pivot to make the object’s pivot point the center of the axis,.

Collision Tab

Settings for collision.

Exclusive Collisio n- Selecting an item from this list will exclude all other collision objects from the calculation.
Collision By - Sets the detection method for collision.

Node - Detects the object’s vertex.
Box - Detects with a box vertex including the object.
Sphere - Detects the sphere set, in size, in Basic Tab.

From let to right: node, box, and sphere

Collision Node - When Collision By is set to Node, you can select the vertex of collision detection by using Vertex 
Maps.
Stop By Event - With Collision: Event , the movement will stop. It will move again with startByCollision or 
RestartByCollision . Event is determined by each part’s pivot.
StopByStabilizer - will attempt to stop a dynamic object from continually oscillating if the calculation reaches a 
set amount.

Supplement: By default, HardFX sets the axis of the calculated parts to the object’s pivot, unless it is changed 
by Shift or Pivot Shift.


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Start By Collision

Start By Collision -Usually, an animation starts from the start of the calculation, but when you select 
StartByCollision, the animation is made after the collision is determined.
Restart By Collision - The animation is made after the collision is determined. The difference with 
StartByCollision is that even if there is no collision, the animation is still created.

Break Distance - Sets the condition for Start By Collision’s collision factor. The calculation will not start if the 
distance is shorter than the specified distance.
Self Interaction - Sets the interaction within the same object.

None - No calculations made for interaction.
Sphere - Detects the sphere set, in size, in Basic Tab.
Box - Detects with a box vertex including the object.

Interaction - Sets the interaction between objects.

None - No calculations made for interaction.
Sphere - Detects the sphere set, in size, in Basic Tab.
Box - Detects with a box vertex including the object.

Bounce - Sets the power of the interaction. When the relative speed is kept at 100% after collision, the energy of 
the collision is not lost.

Force Tab

Applies settings for amount and behavior for the types of force that will be applied.

Force Mode -Sets the type of force that will occur.

Start - Force will occur at the beginning or when started by StartByCollision.
break(1piece>parts) - In Piece mode, when you select 1piece>parts, force will occur when it starts to break.
Event - Force will occur from FX_Collision’s event mode. The detection will be each parts’ pivot.
Initial Axis - Set the axis of the rotational power.
Random - Sets the axis to a random direction.
x - Sets axis to X direction.
y - Sets axis to Y direction.
z - Sets axis to Z direction.
Local Axis - When activated, specification for Velocity(m/s) is set to the object’s local axis.
Velocity(m/s) - Sets the velocity of the force along the specified axis.

StartByCollision is valid only with Collision. It will not work with two HardFX.
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Rotation (c/s) - Sets the rotational power by rotational speed (cycles/sec).

File Tab

Manages copy, paste, and HardFX’s motion data.

Load Motion - Loads a previously generated motion file.
Clear Motion - Clears a loaded Motion file.
Save Motion - Saves the generated motion to a file, which will be used subsequently to deform the object.
Playback Speed - This will set the percentage of the playback speed of HardFX data about to be played.
Shift Frames - Shifts the playback starting frame of HardFX data. By default, the number entered is regarded as a 
number of seconds to shift the motion of the .mdd file. If you prefer to use frames, enter the number of frames 
followed by the letter “f”; “-400f”, for example, to shift so that the motion in the .mdd file starts at frame -400.
Local - Plays back based on the local translations (move, rotate and scale) of the object. Allows an .mdd 
deformation on an object while respecting new motion applied to that object.
Copy - Copies the current settings between dynamic objects.
Paste - Pastes the current settings between dynamic objects
Save - Saves all the settings contained in the HardFX properties.
Load - Loads a saved settings file. Similar to using a Preset.
Resolution - Sets the accuracy of calculation by how big the maximum error is. When it approaches 0 the 
accuracy increases and errors will decrease, but the amount of calculation will also increase, resulting in longer 
processing times.
View Feedback - Sets the feedback in Layout when controlling HardFX. When the display is poor or the display 
speed is slow, uncheck this.
Numeric Feedback - Sets the numerical feedback in Layout when controlling HardFX. When the display is poor or 
the display speed is slow, uncheck this.
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EditFX Tab

Edit Tool - Activates the ability to edit Nodes. To edit, you will have to calculate HardFX, or load HardFX data.
Undo - The Edit tool has its own undo. Click this button to undo the last edit. You can only undo one edit.
Edit Node - Specify the number of the parts to be edited. If the Edit tool is activated, you can select from the 
Layout by clicking the parts.
Lock - Displays whether the parts specified by editNode are in Lock state or not. When parameters like size is 
changed by Value, it will be in Lock state. In this state, even if the size parameter is changed from the original, 
the Locked parameter will not change. To activate the size parameter, uncheck the Lock.
Edit Frame - Specify the frame(s) to be edited.

All - All frames will be editable.
After - Can edit frames before the count.
Before - Can edit after the count.
Current - Can edit only the current frame.

Edit Axis - Specify the direction to edit.

move(xyz) - Move the selected parts.
move(x) - Move the selected parts to X direction.
move(y) - Move the selected parts to Y direction.
move(z) - Move the selected parts to Z direction.
rotation(x) - Rotate the selected parts to X axis.
rotation(y) - Rotate the selected parts to Y axis.
rotation(z) - Rotate the selected parts to Z axis.
bend(x) - Rotate to X axis by making the center as the location data and rotation data from the selected parts.
bend(y) - Rotate to Y axis by making the center as the location data and rotation data from the selected parts.
bend(z) - Rotate to Z axis by making the center as the location data and rotation data from the selected parts.

Fix Edit Start - Activates EditStart. When activated, the current frame value is inputted in EditStart. When this is 
not specified, all the frames before the current frame will be edited. When you specify fix, you can get a smooth 
edit effect with EditStart’s frame, but when you press Ctrl key while dragging, you will get a linear edit effect.
Edit Start - Fixes the specified frame value and you can get a smooth edit effect between the current frames.
Fix Edit End - Activates EditEnd. When activated, current frame value is entered in EditEnd. When this is not 
specified, all the frames after the current frame will be edited. When you specify fix, you can get a smooth edit 
effect with EditEnd’s frame, but when you press Ctrl key while dragging, you will get a linear edit effect.
Edit End - It will fix the specified frame value and you can get a smooth edit effect between the current frames.
Value Type - Select the parts data to edit using value.

Size - Changes the size parameter for the parts selected in editNode.
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Weight - Changes the weight parameter for the parts selected in editNode.
Resistance - Changes the resistance parameter for the parts selected in editNode.
Torque - Changes the torque parameter for the parts selected in editNode.
pivot(x) - Changes the pivot’s X axis for the parts selected in editNode.
pivot(y) - Changes the pivot’s Y axis for the parts selected in editNode.
pivot(z) - Changes the pivot’s Z axis for the parts selected in editNode.
Value - Sets the value for selected item in Value type. When edited, Lock will be checked. In this state, even if the 
original parameter is changed, the Locked parameter will not change. To activate the size parameter, uncheck 
the Lock.

Selected Update - When activated, you can re-calculate only the parts selected by editNode. To re-calculate, 
activate Calculate with SelectUpdate checked. You do not have to re-calculate when you move the path or key 
frame data with editAxis

Command

Smooth -Referencing the current frame, the movement of the parts that was selected by editNode will be 
smooth. When editStart and editEnd are not specified, the current position will be copied to all the frames. When 
editStart and editEnd are specified, it will make the position information smooth from the specified frame to the 
current frame.
Make Path - This command will create a Null object whose path is identical to the motion path of the selected 
part.
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ParticleFX (Emitter)

With LightWave’s integrated particle system, ParticleFX, you can create scintillating effects like sparks, explosions, 
liquids, smoke, and much more. Because the system is integrated, there is no need for a secondary viewing interface or 
duplication of existing items like cameras. Everything is handled within the normal Layout interface, reducing the 
learning curve tremendously.

ParticleFX features several basic controllers: Emitters, Wind, Collision, and Gravity. You can add one or more of these 
controllers to your scene. Then, each can be set with its own parameter settings to create just the effect you are looking 
for.

Adding a Particle Emitter

If you wish to add a new Particle Emitter to your scene, choose Items > Dynamic Object > Particle. You can also add a 
particle emitter by choosing Emitter from the Add Dynamic drop-down menu on the Dynamic Tab in the Object 
Properties Panel.
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The main difference between adding an emitter from the Dynamic Objects drop-down menu is that you have the option 
of creating a Partigon Emitter by choosing it from the Emitter Type drop-down menu.

 
Partigons are a special object type for particles. Partigons provide a means for particle systems (like ParticleFX) to 
automatically generate single-point polygons as needed. You can apply surface attributes to single-point polygons and, 
thus, make them visible when they render.

Emitter Types

There are two emitter types: HV Emitter and Partigon Emitter. Either type automatically uses the FX_Emitter custom 
object plug-in to create the particles. The difference between the two selections is the type of object that each uses in 
Layout, which affects how they render.

HV Emitters

These use null objects that are invisible by themselves. To render particles from HVEmitters, you must add either new 
Volumetrics or legacy ones (in which case you need to engage Legacy HyperVoxels on the Volumetrics tab of Render 
Properties). If you use legacy HyperVoxels, in the HyperVoxels Panel, activate the HVEmitter object. If you use gradients 
with HyperVoxels parameters, special particle-related Input Parameters will be available.

Use the Particle2Partigon (Utilities > Additional > Particle2Partigon) function to convert a Particle Emitter into 
a Partigon Emitter.





LightWave 2020  –  LightWave 2020

Reference –  2040

Partigon Emitters

Partigon Emitters, on the other hand, use partigon objects - special objects designed specifically for use by particle 
systems. Essentially, they generate single-point polygons on the fly. Single-point polygons have a surface and you can 
use normal surfacing techniques. The surface will even be visible in shaded OpenGL viewports.

You can achieve many effects, like fireworks and sparks, by using Partigon Emitters alone (i.e., without HyperVoxels). 
You can save significant rendering time compared to HVEmitters, which require HyperVoxels for rendering.

Using an Object as an Emitter

You can use a LightWave object as an emitter by adding Emitter from the Add Dynamic drop-down menu on the 
Dynamic Tab in the Object Properties Panel. You must also use one of the object Nozzle settings discussed below under 
Emitter Controller.

Partigon Emitters can use HyperVoxels just like an HV Emitter can. If you do not wish to see the particles (e.g., 
when HyperVoxels are transparent), just deactivate the object on the Scene Editor. This will not affect the 
rendering of the Hypervoxels. Partigons are also subject to Edges > Particle/Line Thickness setting. Set this to 
0, if your voxels are being eaten by their edges.

Use of the Subdivision modifier is required for the correct function of Partigons.



The custom object bounding box will continue to appear.
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Generator Tab
Particle Tab
Motion Tab
Etc Tab
Rotation Tab
Interaction Tab
File Tab
EditFX Tab

To add Legacy HyperVoxels to an object (null or geometry), go to the Effects window, Legacy Volumetrics tab 
and add HyperVoxels. Double-click the HyperVoxels 3.0 entry and add the object you wish to have HyperVoxels 
on. 


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Generator Tab

Generator Tab

On the Generator Tab, you set parameters relating to the creation of the particles.

Group
When you work with multiple controllers, you may want to isolate specific groups. That is, perhaps you want Emitter (1) 
affected by Wind (1), but you want Emitter (2) to be affected only by Wind (2). This is easily accomplished by using 
groups.

The <default> group is a special global group that disregards independent groupings. Thus, if an emitter is set to a 
defined group (e.g., new_group), a wind controller set to <default> will still affect it.

<default> - Includes all groups.
<new group> - Creates an individual group. Can associate functions within a group.

Once you add a new group, it appears in the Group pop-up menu, where you can select it, as desired, to associate 
groups of controllers.

Birth Rate - The Birth rate works in conjunction with the Generate by setting. Essentially, it determines how 
many particles are born per the Generate by setting. The texture T option generates particles where the texture 
exists.
Generate by - Generate by has several possible settings. With the frame and sec options, every new frame or 
second, the number of particles set as the Birth rate are created.

When Generate by is set to speed, it creates the particles based on the speed of the emitter, caused by moving it. 

The Group feature works in conjunction with the Other Dynamic tools! Thus, if you add an emitter, a wind 
controller, and a soft body (Dynamic Object) element to the same group, they are all affected by the wind!
You can use the Group feature to disable a controller by simply setting it to a group not associated with an 
emitter.


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You need to keyframe some movement for the emitter to use this setting. The faster the movement, the faster 
the particles are created. The effect is similar to salt coming out of a saltshaker—the harder you shake it, the 
more salt comes out.

When Generate by is set to collision event, the particles are created when a collision event occurs. You need to 
use a collision controller whose Mode is set to event.

When Generate by is set to wind, particles are created if the wind speed exceeds the threshold1 setting (Motion 
Tab). (Threshold2 has no impact here.) The force of the wind has no effect on the birth rate. The windspeed 
setting is similar, but the birth rate is affected by the wind force. The greater the wind force, the greater the 
number of particles born.

Nozzle - The Nozzle setting determines the shape of the emitting source. With Box, particles are emitted from 
inside a box whose size is set below. With Sphere, particles are emitted from inside a sphere. With Cone, 
particles are emitted from inside a cone.

You can use geometry as an emitter, by adding the FX_Emitter custom object to any loaded object. This will allow 
you to use the Object-Vertices, Object-Normal, Object-Surface, and Object-Line nozzle types. When you use 
these nozzles, you can offset the center position by changing the Center Position values on the Etc. Tab.

 
When you use the Parent-Emitter, Parent-Emitter(end), Parent-Collision, and Child-Pivots nozzle types, they 
use one controller’s relationship to another in order to create multiple or cascading effects.

To use Parent-Emitter, you need to create two emitters and parent one to the other. Then, set the child’s Nozzle to 
Parent-Emitter. The parent’s particles will spawn particles, essentially becoming emitters themselves. Parent-
Emitter(end) is similar, but emits the particles after the parent’s particles die - perfect for exploding fireworks. 

For best results when using cone as the nozzle type, some Velocity and Vibration settings (none-zero) should 
be added in the Motion Tab.


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Parent-Collision doesn’t emit the particles until the parent particle has a collision. (Make sure you click Start to 
compute the motion.)

Child-Pivots aligns the emitter’s particles with the pivot point of child objects (i.e., objects parented to the 
emitter). The child objects must have the FX_Link motion modifier added. This allows you to use particle collision 
detection to move (e.g., break up) a group of objects.

Size Effect - The Size effect setting determines how keyframing a Size change for the emitter affects the 
particles.
Key Effect - The Key effect option causes particles to be created when a keyframe is encountered. The key 
setting differs from Key-Env, in that Key-Env creates them in a smoothed non-linear fashion. Set to none to turn 
this option off.
Generator Size - The XYZ Generator size fields set the default size of the emitter.
Particle limit - sets an overall limit for the number of particles that are emitted.
Start Frame - The Start frame field is normally an informational field that indicates the frame the particles will 
start being born. By default, this is the first frame setting in Layout. You can manually change this starting frame 
by checking the Fixed option and entering the desired frame in the Start frame field.

Usually, you use the object modes in conjunction with an Explosion value (Motion Tab).
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Particle Tab

On the Particle Tab, you set parameters that describe the created particles.

Particle weight - sets an arbitrary weighting value that will influence how properties like gravity affect the 
particles.
Particle size - affects the outer boundary used for collision detection. It can also be used by volumetric plug-ins 
like HyperVoxels.
Particle resistance - adds an air resistance effect. Particles will move slower as you increase this value.
Life time (frame) - sets the life of the particles in frames. Once a particle is born, it lasts only this long.If you 
activate Fixed Random, random calculations are constant, so they yield more predictable results. (Setting Life 
time to 0 means the particle will not die or age)
Fixed Random - Is for the generation of particles. In most cases this should be left on.
Show ID - By activating the Show Id option, each particle will display a number in the Layout viewport indicating 
the index number of the particle.
Show Size - The Show Size option draws a wireframe sphere around each particle representing the particle’s 
current size.
Output Size - If the Output Size is not checked, the size will always be 1.
Show Particles - The display of particles in OpenGL windows.

The plus(+) and minus(-) fields randomize the preceding field by adding or subtracting a value between 0 and 
the number entered. So if Particle weight was 1 and its randomize value was .1, the Particle weights would 
range from .9 to 1.1. A total particle value of zero or less will be zero.


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Motion Tab

On the Motion Tab, you set how the particles are placed into motion.

Velocity - Use the Velocity setting to scale the overall speed of the particles. A setting of 100% is normal. Lower 
values will slow down your particles and higher values will speed them up. The XYZ Vector settings determine 
the initial direction and speed of the particle motion. Other factors, like gravity, wind, and so on, will impact the 
result. You may override the Vector settings and point the particles to an object in the scene by selecting it in the 
Target pop-up menu.

If you want the Vector settings to relate to World coordinates instead of the emitter’s local coordinates, activate 
the World coordinates option.

Explosion (m/s) - The Explosion setting makes the particles move out from the center of the nozzle with an 
initial velocity equal to the value that you set.
Vibration(m/s) - randomizes the initial trajectory of each particle. You can achieve a fountain-like effect by 
reducing the size of your nozzle (e.g., XYZ=.1), adding some vector speed and increasing the Vibration value.
Vibration(min) - sets a minimum vibration amount.
The Threshold1 and Threshold2 values set up a vibration effect range. If a particle’s initial speed is under the 
Threshold1 value, no vibration will occur. If it exceeds the Threshold2 value, the vibration is applied. The 
vibration is phased in for speeds between Threshold1 and Threshold2. Use this for effects like water coming 
from a garden hose, where the water tends to fan out as more water comes out.

Threshold1 is also used when particles are generated by wind. When the wind speed exceeds the Threshold1 
value, particles are generated.
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Etc Tab

On the Etc Tab, you set miscellaneous parameters for the emitter.

Gravity (m/s^2) - In most cases, if you want gravity, you set the Gravity Y value to something like -1. However, 
you can set up inverse gravity by using positive values, and you can apply gravity on other axes.
Center Position XYZ - These values set the center for particle effects like Explosion (Motion Tab).
Position Blur - Sometimes you may not want the particles exploding from the center of the emitter. The Position 
blur value randomizes the initial particle position by using velocity. If you set this option to 0%, the particles are 
created side by side.
Parent Motion - Use the Parent motion setting to control how much of the emitter’s motion is applied to the 
particles. If it is set to 0, the particles are emitted the same no matter how the emitter may be moving.
Max Speed(m/s) - Setting the Max Speed (m/s) field regulates the top speed of the particle.
Loop Frame - The Loop Frame setting is used to repeat the particle generation and motion in the set number of 
frames. For example, if you enter a Loop Frame value of 30 frames, in a two second animation two particles will 
be generated with the same birth location and motion.
Record Step Frame - Records every nth step of playback to lighten cache files.
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Rotation Tab

The settings on this tab affect the rotation properties of each particle.

Rotation Dropdown:

None - No rotation will be calculated for the particles.
Align to Path - The particle will align to the rotation of the path it is traveling along.
Random Rotation&Scale - Will align, spin, and scale the particle randomly as it travels along the path and 
makes the Random Rotation&Scale button available.
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Interaction Tab

The settings on this tab affect the way particles from both the same and other emitters of the group interact with each 
other.

The Self Interaction dropdown determines how particles react to other particles of the same emitter. The Interaction 
drop-list determines how particles react to other particles from different emitters (within the same group). Options 
include having colliding particles push emitters, bounce off, drag, and crowd around each other.

Force - The Force setting adjusts the strength of the interaction effect.
Viscosity - Adjust the Viscosity setting to change the amount of resistance which particles receive when they 
interact with each other. This setting is useful when creating different types of liquid effects.
Detect Interaction - Turns on and off interaction detection.
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File Tab

The File Tab contains options for handling the clipboard and file commands.

You can save the particle motion of an emitter using the Save Motion button. The motion will take into account wind, 
gravity, and other options. It effectively freezes the particle motion; the particles will move just as they did when the 
motion was saved. Changing the Emitter settings, clearing/adding wind and gravity controllers, and so on, will have no 
impact.

Save motion is a great time-saver for network-rendered scenes or scenes that require heavy calculations for 
collisions. Once you’ve saved the motion, it doesn’t need to be calculated again. To use this feature, get your 
particles moving the way you want. Then make sure your scene plays back without any pauses - this means that 
ParticleFX has finished its calculations. Now, you can click the Save Motion button to save out the .pfx file. (If you 
look at the emitter’s Object Properties Panel, you’ll see the .pfx file referenced in the FX emitter custom object 
entry). Now save the scene and you’re done. Remember, you can even clear wind, collision, and gravity 
controllers without affecting particle motion.

When this feature is active, the Save Motion button will be ghosted. To clear a loaded motion, click Clear Motion. You 
can also load the motion file into another emitter using Load Motion.

Copy and Paste - these clipboard buttons allow you to copy the settings of a controller and apply them to 
another.
Save and Load - These buttons add custom saved ParticleFX controllers to your scene.
Playback Mode - works with the motion and determines how it will playback. 

Normal - indicates that it will playback normally, starting at frame zero.
Key - the motion will be started every time a keyframe is encountered for the emitter.
Parent Key is similar, but uses the parent item’s keyframes.

You can save time by advancing to the last frame, letting the frame refresh, then saving the PFX file.
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Parent Particles and Parent Particles (end) work like the identically named Nozzle options. Of course, 
the particles come from the motion file instead of Emitter settings. Make sure that the parent’s Particle 
size is set greater than 0.
Parent Recoded CP uses the Recode CP option on the Collision controller, which must be the parent of 
the emitter. Playback will occur when collisions are detected. Use this for effects like splashes in water 
from rain drops, where one emitter provides the rain and another emitter (with this option set) creates 
the splashes from the detected collisions with a ground plane.
Parent Particles (fix) - Once the parent particles are fixed in a collision then this motion is played back.

https://docs.lightwave3d.com/display/LW2019/Dynamics%3A+Collision+Controller
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EditFX Tab

The EditFX Tab contains options for real-time editing of your Particles.

Edit Tool - Activates the ability to edit each individual particle (Node).
Undo - The Edit tool has its own undo. Click this button to undo the last edit. You can only undo one edit.
Edit Node - Specify the number of particles to be edited. If the Edit tool is activated, you can select from the 
Layout by clicking the parts.
Edit Frame - Specify the frame(s) to be edited.

All - All frames will be editable.
After - Can edit frames before the count.
Before - Can edit after the count.
Current - Can edit only the current frame.

Edit Axis - Specify the direction to edit.

move(xyz) - Move the selected parts in any direction.
move(x) - Move the selected parts along the X direction.
move(y) - Move the selected parts along the Y direction.
move(z) - Move the selected parts along the Z direction.
rotation(x) - Rotate the selected parts along the X axis.
rotation(y) - Rotate the selected parts along the Y axis.
rotation(z) - Rotate the selected parts along the Z axis.
rotation(View Axis) - Rotate the selected parts.

Fix Edit Start - Activate editStart. When activated, current frame value is inputted in editStart. When this is not 
specified, all the frames before the current frame will be edited. When you specify fix, you can get a smooth edit 
effect with editStart’s frame, but when you press Ctrl key when dragging, you will get a linear edit effect.

Edit Start - It will fix the specified frame value and you can get a smooth edit effect between the current frames.
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Fix Edit End - Activate editEnd. When activated, current frame value is inputted in editEnd. When this is not 
specified, all the frames after the current frame will be edited. When you specify fix, you can get a smooth edit 
effect with editEnd’s frame, but when you press Ctrl key when dragging, you will get a linear edit effect.

Edit End - It will fix the specified frame value and you can get a smooth edit effect between the current frames.

Edit Size - (Edit Range) This field changes the influence range.

Command

Smooth -Referencing the current frame, the movement of the particle that was selected by editNode will be 
smooth. When editStart and editEnd are not specified, the current position will be copied to all the frames. When 
editStart and editEnd are specified, it will make the position information smooth from the specified frame to the 
current frame.
Make Path - This command will create a Null object whose path is identical to the motion path of the selected 
particle.
Delete - You can delete individual particles from the Emitter.
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Dynamics: Collision Controller

The Collision controller lets you add an element for the particles to bump into.

Collision controllers (FX Gravity) can be added in the Dynamics Tab of the Object Properties Panel or on the Items Tab in 
the Dynamic Objects drop down menu.

Mode Tab

Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This 
becomes very handy when you are working on a complex scene and you want certain Collision objects to only 
affect certain objects.

<default> Includes all groups.
<new group> Creates individual group. It can associate functions within a group.
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The Type setting controls the shape of the collision object. The Sphere, Box, and Plane options can be used for basic 
primitive collision shapes. The object, object-subdiv, and object-advanced settings are used when you use a LightWave 
object for collisions. Use the Infinite setting for an infinite-sized collision area. This is particularly useful with the Scatter 
and Attract modes. (Note that the Bound and Stick modes will continue to respect the Radius/Level setting.)

Use the Recode CP option to set up an event-like trigger to be read by a child emitter’s Playback Mode. As particles 
cross the collision plane created by the collision item, this event triggers the playback of a saved motion.

The InSide option causes the collision to occur inside the collision object.

Child Mesh will apply the current collision settings to a child object mesh, if one exists.

The Noshift option disables any offset the particles may generate in the collision process. This ensures that the particles 
will collide directly on the collision surface.

By activating the Change option, particles passing through the collision item can switch to a different group, to be 
affected by a different controller. The New Group defines which group the particles will switch to.The Mode setting 
determines what happens when a collision occurs. The Bounce option causes the collision to change the direction and 
velocity of the particles. With Stick, the particles simply adhere to the surface. Erase kills the particle upon contact. The 
event mode is used when the emitter has its Generate by option set to collision event: it creates particles at the time of 
collision. In Scatter mode, the collisions occur within the interior of the collision object and not at its surface. This 
causes the particles to scatter. The Attract mode causes the particles to be attracted to the center of the collision 
object.

You can associate with ParticleFX’s functions using group function. If it is in the same group, you can associate 
settings. Also, if you do not want to associate, you can disregard the association by removing from the group.


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Bounce



LightWave 2020  –  LightWave 2020

Reference –  2057

 
Stick
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Attract

The Radius/Level setting sets the size of the collision object based on this radius. If Type is set to Plane, this setting 
controls the level of the plane. If you are using a LightWave object, this setting controls the distance from the surface 
where the collision occurs.
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Left: Radius = 3m, Right: Radius = 0m

The Bounce/Bind power setting controls how particles bounce off the surface, when Mode is set to Bounce. The Stick 
mode controls the amount of attachment the particles have.
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Left: Bounce Mode, Bounce/Bind: 50%; Right: Bounce Mode, Bounce/Bind: 400%
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Left: Stick Mode, Bounce/Bind: 10%; Right: Stick Mode, Bounce/Bind: 90%

Friction power adds friction to the collision surface when you use the Stick mode, which slows the momentum of 
particles sliding over the surface.
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Left: Friction: 0; Right: Friction: 20

Fix power causes the particles to stick to the surface and not slide around.
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Left: Fix: 0; Right: Fix: 1.0

Increasing the Roughness setting roughens up the collision surface. Roughness changes particle motion after collisions, 
but it also depends on the Mode setting.
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Left: Roughness: 0; Right: Roughness: 200

If you reduce the Probability setting below 100%, you reduce the chance of a particle being treated as having collided 
with the collision object.
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Left: Probability: 100%; Right: Probability: 10%

Etc Tab

On the Etc. Tab, you can Copy, Paste, Load, and Save settings for the Collision controller.

Using an Object for Collisions

You can use a LightWave object as a Collision object by adding Collision from the Add Dynamic drop down menu in the 
Object Properties Panel, Dynamic Tab. You must set the Type to object on the object’s Collision Controller Panel. If you 
use a SubPatch object, you set the Type to object-subdiv to use the subdivided mesh instead of the base polygonal 
object. Use the object-advanced type to get even more accurate collision detection.
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Dynamics: Gravity Controller

A Gravity controller may be added to your scene to produce gravity-like effects on your particles and dynamic objects.

 
Gravity controllers (FX Gravity) can be added in the Dynamics Tab of the Object Properties Panel or on the Items Tab in 
the Dynamic Objects drop down menu.
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Size effect determines how scaling the Gravity controller in Layout affects the gravity. The Gravity option scales the 
gravity effect. Region scales the overall size of the effect area.

The Direction Gravity mode applies the gravity in a single direction using the Gravity XYZ values. The Point mode causes 
the center of the Gravity controller to attract/repel the particles. Negative values attract and positive values repel.
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Point Mode

The 2Pole Gravity mode creates two attraction points, one meter on either side of the center. It can create magnetic or 
electric field effects.

The Falloff Mode setting determines how the gravity’s effect tapers off at its region borders. Linear means the effect is 
linear throughout the controller’s region. The Inverse Distance setting uses a one divided by the radius of the controller 
region to taper off the gravity’s power from the center of the region. Off means no falloff. With this setting, the particles 
do not need to be within a controller region to be affected.

The Radius setting sets the radius of the controller region.The Power setting scales the overall force of the gravity.The 
Gravity XYZ settings determine the direction and force of your gravity when Gravity Mode is set to Direction. Normally, 
you’ll want to set Y to something like -1.Use the Copy, Paste, Load and Save options to re-use Gravity settings.

Cloth and Hard dynamics have Gravity settings as well.
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Dynamics: Wind Controller

The Wind controller lets you add wind to blow your particles and dynamic objects around. The Wind controller appears 
in a Layout viewport as a cloud of wind indicators—a bunch of short lines with pivot point dots at one end. The length of 
the lines indicates the force of the wind: the longer the line, the more powerful the wind. The angle of the line indicates 
the direction of the wind at the line’s location.

Wind controllers (FX Wind) can be added in the Dynamics Tab of the Object Properties Panel or on the Items Tab in the 
Dynamic Objects drop down menu.Mode TabOn the Mode Tab, you set the basic characteristics of the Wind controller.

The Wind mode setting determines the type of wind and how it changes over time. You can get a feel for what the 
setting does by looking at the wind indicators. There are a few special indicators, however. If you select Turbulence, you 
can set the size of the effect and direction using the Turbulence settings on the Vector Tab. If you select Direction as the 
Wind mode, you can use a Texture Map (Texture button on Vector Tab) to control the wind power and turbulence. 
Animate the texture to animate the wind. If you select rotation(y) or doughnut, use the Spiral setting at the bottom of 
the panel to adjust the intensity of the rotation. Sticky wind pushes items away. Vortex creates effects similar to a 
tornado or water spout.
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rotation (y)

doughnut

Animation Path is a bit different. It uses handles which can be used to control the path of the wind effect. The path can 
be controlled by the position and rotation of the handle.

The Blend mode sets how the wind blends with other overlapping winds. Add is additive. Max means the highest wind 
controls. With overwrite; the wind is replaced with itself. Heavy-wind disregards particle weight.

If winds have different Blend mode settings, obviously only one can control the blend. The priority order from highest to 
lowest is: overwrite, max, add, and heavy-wind. So, if Wind1 is set to add and Wind2 is set to max, the overlapping area 
will use max blend because it has the highest priority.The Size effect setting determines how scaling the Wind controller 
in Layout affects the wind. Setting it to Wind scales the wind power. Setting it to Region scales the overall size of the 
effect area.

The Falloff mode setting determines how the wind’s effect tapers off at its region borders, if at all. Linear means the 
wind is the same throughout its borders. The Inverse Distance setting tapers off the wind’s power from its center. The 

One way to add extra handles is to add a null and parent it to the wind controller. Or, you can clone one of the 
other handles.


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Distance setting makes the wind falloff towards its center. OFF means no falloff. With this setting, the particles do not 
need to be within a controller region to be affected.

The Radius setting sets the radius of the controller region.Use the Power setting to scale the overall force of the 
wind.The Spiral Amount setting is used for the rotation(y) or doughnut Wind modes.The Spiral Thickness setting 
controls the thickness of the doughnut wind.

Vector Tab

On the Vector Tab, you set the direction and force characteristics of the wind controller. The vectors are scaled per 
second.

The Wind XYZ settings determine the basic direction and force of your wind.

If you are using the Direction, Rotation, Cylinder-Explosion, or Hemisphere Wind mode, use the Envelope E button to 
animate the wind direction and force. To remove the envelope, Shift+ Click the E button.

If you are using the Direction Wind mode, use the Texture T button to add a 3D texture that affects wind direction and 
force. Note that the texture is added to the base Wind XYZ settings. To remove the texture, Shift + click the T button.

If you are using the Turbulence Wind mode, the Turbulence Vector sets the direction and power of wind turbulence. 
Turbulence size sets the wavelength of the turbulence.

Etc. Tab

On the Etc. Tab, you can Copy, Paste, Load, and Save settings for the wind controller.

Textures are three-dimensional. Thus, adding a texture adds it to all channels. Also, for envelopes, make sure 
you have the correct channel in the channel bin.


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Additional Dynamics Utilities

Deleting an FX controller

Select and clear, just as you would any other Layout item (Items > Clear Selected Item).

To open a controller’s property panel:

Choose the controller from the Item pop-up menu and click the Property button to open the Properties Panel for the 
selected controller.

The Start Button

Some effects require a “pre-calculation” before they can be previewed in your animations. These are instances where 
you have particles interacting or have post-deformed geometry. By activating the Start button, the FX will begin solving 
any simulations that are currently setup in the scene. The progress of the simulation is displayed in an output pane that 
opens at the bottom of the FX Browser when the Start button is activated. A shortcut to this is on Layout’s toolbar at 
Modify > IKB Calculate.

Dynamics Window during calculation

You can also display the Property Panel for the currently selected controller by choosing Utilities > 
FX_Property or by accessing the Dynamics Tab in the Object Properties Panel.



Many scenes don’t need this step, but clicking Start won’t do any harm if you are unsure.
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The Save Button

Clicking the Save button saves all controller motions, using individual files, to your FX directory (defined on the Option 
dialog). These can be loaded using the Load Motion option on the Controllers Properties Panel.

Options Dialog

The Options dialog has some options that affect the manner in which LightWave computes controllers.

The Background Job option activates multithreading. The update by Background Job option will update Layout when 
background tasks are complete. In most cases, you should leave these options in their default state of off.

The Resolution setting adjusts the parameter used when performing the physics simulations. The smaller the 
Resolution setting is, the more accurate the simulation will be. However, this also has a direct effect on the rendering 
times.

In this dialog you can also set the FX Directory. This is the default directory used when saving Controller settings.

Real-time Display

Just click the Play button in Layout and as you tweak the various controller parameters, you get real-time updates of 
how your changes affect the particles.

You can control how FX Controllers are updated using the UpdateMode pop-up menu.

Auto updates all emitters as parameters are modified. Use this for fast systems or in low-particle count simulations.

If you have multiple emitters and are using the Select update, then only the emitter showing in the Select pop-up menu, 
if any, will be updated.

: Scenes with particles interacting or with post-deformed geometry require you to click the Start button first to 
pre-compute some motions. Clicking Start won’t do any harm if you are unsure.


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Adaptive dynamically scales the number of visible particles based on your CPU performance. This setting attempts to 
keep interactive performance at a useful level.

User turns off particle updating completely. You may force an update by either clicking the Start button on the Particle 
FX Browser, or the Update button on the File Tab of the Emitter Controller Panel. This setting is useful in situations with 
heavy particle counts.

Groups

You can group Dynamic objects with a user-defined name to prevent unwanted interaction.

This also works with Particle FX controllers. This becomes very handy when you are working on a complex scene and 
you want certain Wind emitters to only affect certain objects.

<All Group> Includes all groups.<default> Includes all items in scene.<new group> Create individual group. Can 
associate functions within a group.

You can associate with particle FX’s functions using group function. If it is in the same group, you can associate 
settings. Also, if you do not want to associate, just by removing from the group, you can disregard the 
association.


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1.
2.
3.

4.
5.

6.
7.

FX Linker

FX Linker (Utilities > Additional > FX Linker) automates FX_Link setup on multiple particles. It basically clones the 
specified object and adds the FX_Linkmotion modifier using the settings you specify. This is a great tool for creating a 
flock of bats, or for creating a quick crowd simulation.

To use FX Linker:

Save your scene!
Load the target object.
If you plan to use the Size effect option, keyframe the size on this object. Also, make sure your particles have 
some amount of size (Emitter properties).
Choose Utilities > Additional > FX Linker and set the copy field to the number of instances you want to create.
The Random, Time Shift, Pre/Post Behavior, Distance/Sec, Size effect, and Make key options correspond to the 
same options on FX Link, see above. Check them if you want those options set.
If you are using Random or Size effect, you may set maximum and minimum values in the provided fields.
Click OK. Depending on how many copies you make, it may take a while before FX Linker finishes.

FX Property

You can display the Property Panel for the currently selected FX controller by choosing Utilities > Plug-ins > Additional > 
FX_Property .

Using FX Linker is a one-way shot. You can’t undo what it does after you click OK. Therefore, you should 
definitely save your scene before running this modifier.



Using FX_Linker is a one-way shot. You can’t undo what it does after you click OK. Therefore, you should 
definitely save your scene before running this modifier, or better, press shift + s to save a scene increment.


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FX_Hardlink

FX_Hardlink is a very powerful tool that allows you to use the dynamic motion from one object and apply it to another. 
In most cases the dynamic object contains very few polygons (2 point polygons) while the “HardLink” object has a 
higher polygon count.

In the example below, Cloth Dynamics is applied to a 2-point polygon chain made up of (x4) 2-point polygons. It is the 
parent of a single layered object that is made up of 4 monkeys. When you use FX_Hardlink, the monkeys take on the 
motion of the 2- point polygon chain.Hardlink keeps the geometry rigid and will displace it based on the Piece Mode 
setting.

FX_Hardlink Properties

You can also access the Controllers Property Panel by using the Dynamics Tab in the Object Properties Panel.

The HardLink Object must be parented to the Dynamic object in order for FX_Hardlink to work.
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Under the Basic Tab you can choose what Piece Mode you would like to use. Polygon treats each segment as its own 
object. 1 Piece will make the entire object a solid and considers it one piece. Point Set will read selection sets that you 
could create in Modeler.

The Edit FX Tab allows you to change what pieces are linked to what nodes. This is handy if the tool doesn’t quite link 
what you thought it would on complex objects.

FX_MetaLink

FX_Metalink is a very powerful tool that allows you to use the dynamic motion from one object and apply it to another. 
In most cases the dynamic object contains very few polygons (2 point polygons) while the “MetaLink” object has a 
higher polygon count.

In the example below, a 2 point polygon chain with Cloth dynamics applied to it is the Parent of the Worm (MetaLink 
Object). The Work takes on the dynamic motion of the 2-point polygon chain with zero calculation time.

You may run into problems if the Dynamic Object is too rough. Subdividing the Dynamic Object may help.

The MetaLink Object must be parented to the Dynamic object in order for FX_Metalink to work.
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The Smoothing option attempts to smooth the reshaping of the Metalink object. If unchecked, the reshaping can pass 
through the vertex of the Cage Object (dynamic Object).

FX Metalink Morph

FX_Metalink_Morph is a displacement plug-in that enhances the functions of FX_Metalink. By itself, FX_Metalink cannot 
use normal morphing information because it ignores bones, Morph Mapping, and Displacement Maps. However, if you 
use FX_Metalink with FX_Metalink _Morph, you can use normal morphing data.

FX_Metalink _Morph has one pop-up menu called Morph Mode. Set this to One time morph to execute morphing only 
one time. This mode is appropriate when the morphing is from Morph Mapping. Use Every time morph to execute 
morphing for each displacement process. This mode is appropriate when the morphing varies, like the Displacement 
Map of waves. The Non morph setting simply disables this plug-in.

ParticleFX DynamicLinker

Allows you to replace particles with other objects.

Particles --Choose the particle emitter to do the replacing.
Replace Object --Choose the object to replace the particles
Rotation --Give the item a rotation, once it is replaced
Time Shift --The amount of time to wait to replace the object

Size effect

time shift - Contains: start shift, end shift, start adjust (distance) and end adjust.
Lock Cloned Item --Locks the current item to be the same cloned item
Copy --The number of replacements to make

If you want to use other Displacement Maps and not have them be ignored by MetaLink also apply 
Metalink_Morph.



The FX_Metalink _Morph plug-in can be added before or after FX_Metalink.
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ParticleFX_Link

Particles

Choose the particle group.

Node

Rotation - The choices in rotation are: random, align to path (h) and align to path (hp).

Random will rotate the item starting from a random rotational position.align to path (h) Will align the item to a path 
using heading.align to path (hp) Will align the item to a path using heading and pitch.

Size effect

time shift - Contains: start shift, end shift, start adjust (distance) and end adjust.

Make Key

pre behavior - Contains: original, stay and size dissolve.
post behavior - Contains: original, stay and size dissolve.

distance/sec
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FX_Motion

Mode Tab

make key - Generates a key for every frame.
Group - Select an existing group or create a new one.

Mode

After collision - Choose an action post collision: none, reverse, random, stop.
Start Frame - Choose what frame to start the effect.
Start by event - Use this option if you want to trigger the motion upon collision.

Weight - This option sets an arbitrary weighting value that will influence how factors like gravity affect the item.
Size - This option affects the outer boundary used for collision detection. It can also be used by volumetric plug-
ins like HyperVoxels .
Resistance - This option adds an air resistance effect. Items will move slower as this value is increased.
Momentum - This option adds in a momentum or increased mass effect. Items will tend to resist being stopped 
or slowed down.
Rotation Resistance - This option has the same effect as Resistance except that it affects the items’ rotational 
channels.
z-Rotation by wind(deg/m) - This option rotates the item in its bank channel as it moves or is affected by the 
wind.
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Vector Tab

Initial Velocity - This option sets the initial direction and force.
Velocity coordinates - This option sets whether these settings use the item’s local axes or world coordinates.
Initial Rotation(deg/s) - This option sets the items’ initial HPB rotation.
Random rotation start - This option randomizes the initial HPB rotation.
Update - This option updates/refreshes the current settings in the Layout viewport. This is good to do with a 
heavy scene.
Copy - This option copies the current settings.
Paste - This option pastes the current settings.
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HyperVoxels
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Particle Weight Input Parameter

Introduction

With ordinary polygonal objects, realistic effects like liquids, smoke, clouds, and fire are difficult, if not impossible, to 
achieve without HyperVoxels. It simplifies the creation of volumetric rendering effects such as photo-realistic clouds, 
flames, explosions, dust, nebulae, contrails, fluids, smoke, ash, pyroclastics, gelatin, electro-microscopic images, rusted 
materials, detailed solid and rocky surfaces, and much, much more.

This type of HyperVoxel is a legacy from previous versions of LightWave. The new Volumetric Primitives are far 
more physically accurate and give great results that couldn't ever be achieved with this version of 
HyperVoxels. These legacy HyperVoxels still have a place since they are rapid to create and easily 
understandable thanks to years of practice.




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HyperVoxels have computed mass, as opposed to the modeled mass of normal LightWave objects. This opens the door 
to effects of greater complexity. You can now transform objects dynamically, like merging and slicing objects, without 
modeling multiple geometries. A common example of this is the action of the substance inside lava lamps.

HyperVoxels can be a surface, volume, or sprite. Surface HyperVoxels are similar to standard LightWave objects. They 
have a defined surface, but no interior. If you go inside such an object, there is nothing. Volume HyperVoxels, on the 
other hand, have computed volume. You would use this option to create effects like gases, flames, clouds, explosions, 
or even short hair or fur. Your camera can go inside these HyperVoxels and still see the texture. The Sprite Mode is a 
“slice” of a volume HyperVoxel. It renders more quickly, but lacks much of the volume mode’s 3D quality.The 
HyperVoxels volumetric filter is usually applied to a points-only object or a null object. The reason is that polygons may 
be visible after rendering and usually this is not desired. However, having polygons may make the object easier to see in 
Layout. In such cases, you can use the Unseen by Camera object property.

HyperVoxel textures are 3D algorithmic textures, unlike normal surface Bump Maps, which only appear to have depth. 
This means you can actually get very close to the surface and the textures will look three dimensional. HyperVoxels 
feature sub-pixel displacement, which results in surface details no matter how close you get. However, HyperVoxels get 
slower the closer into the them the camera is and for such uses LightWave's HyperVoxel Volumes are recommended.

You can determine the position of HyperVoxels by using a null object or an object’s points. Moving the object will move 
the HyperVoxel object. Changing the position of an object’s internal points will also change the look of a HyperVoxel 
object. HyperVoxels will appear around each point and their proximity to each other affects how the object appears on 
the whole.

A particle animation system is not required. You can achieve many spectacular effects using null objects or points 
animated by conventional means. However, HyperVoxels are unable to achieve realistic liquid effects.
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Image courtesy Christophe Desse

Here are some short exercises to jump-start you with HyperVoxels.

Example - Starting with HyperVoxels

This exercise gives you a quick hands-on feel for how to use HyperVoxels.

Example - HyperVoxel volumetrics

This exercise will give you a flavor of some of the volumetric features.

Example - Blending HyperVoxel Objects

This exercise shows how different HyperVoxel objects can interact with one another.

Sprite Texture Resolution

The Sprite Texture Resolution setting (on the main HyperVoxel Panel) is a Display setting and does not affect your 
rendered HyperVoxels. It allows you to set the quality of textures used on HyperVoxel particles in OpenGL in Layout.

HyperVoxel objects exist just as normal objects do. Thus, they cast shadows, are reflected, and so on. However, 
currently, plugins do not have access to all lighting information. As a result, HyperVoxels will continue to 
receive shadows, even if the Receive Shadows option on the Object Properties Panel is disabled.


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HyperVoxels Setting Management

Load/Save buttons allow you to retrieve and store HyperVoxels setting files. This can be used to create a library of 
attributes.

Use the Copy button to copy the settings for the selected HyperVoxel object to a memory buffer. These can be pasted to 
the currently selected HyperVoxel object using the Paste button.

Save will save the complete settings for a HyperVoxel, while Load will allow you to be selective about what you want 
from the file loaded.

Once you hit OK you will be presented with a further choice:

You can enable/disable HyperVoxels for an activated object by clicking in the checkmark column and you will not lose 
your settings. The Activate button will activate the selected object and set all settings to their defaults. The Deactivate
button places the object in an inactive default state. With Activate and Deactivate, you will lose any existing settings.

If the Show pop-up menu is set to All Objects, then all objects in the scene will be listed. HyperVoxels Only will list only 
HyperVoxel objects; however, this includes disabled HyperVoxel objects.

HyperVoxel types

Surface

The type you will most often use, these are HyperVoxels that appear to be solid objects, although they can blend with 
their neighbors.
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Sprites

The Sprite mode is a simplified two-dimensional slice (or slices) of a HyperVoxel, so it can quickly produce results to 
give you a fast sketch of the HyperVoxel’s rendered appearance. You might think of it as a slice of a Volume that has 
been mapped on a polygon that always faces the camera.You may want to use Sprite to accelerate the setup process for 
Surface or Volume modes. It’s even great for instances where you don’t need a full 3D volumetric effect, like a 
smokestack in the distance.

Although Sprites are two-dimensional in nature, you can still fly a camera through them. The sprite will begin to 
dissolve when the camera gets into it and eventually fully dissolve when the camera hits the slice.

Volume

Gaseous HyperVoxels. They can appear as wisps of vapor or clumps of foggy material.

Geometry Tab

Enter a specific radius for the individual particles in the Particle Size field. Click Automatic Sizing to compute an average 
size - this is a handy way to find a starting point. The average particle size is based on the shape of the entire object - 
HyperVoxels surfaces will not intersect at this setting.

Rendering time is related to how much the particles intersect each other - the more intersections you have, the longer 
the rendering time. For fastest rendering, always try to use the smallest number of particles and the smallest Particle 
Size that achieves acceptable results.

Size Variation sets the maximum percent that the particle size can vary. For example, a particle size of 1m with a 
variation of 100% can be as small as 1m and as large as 2m. Using a variation of 50% would yield particles ranging from 
1m to 1.5m in size. Use this setting to create random disturbances in the surface.

When you first activate an object, automatic sizing is performed for you.
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Stretching and Rotating HyperVoxels

You can stretch HyperVoxels on a selected axis or based on velocity (Stretch Direction). The amount of stretching is 
determined by the Stretch Amount setting, which may be animated. When using nulls, you may stretch HyperVoxels by 
animating normal Layout XYZ size values.

 

Left: Without Stretch Direction, Right With Stretch Direction

HyperVoxels also respect the rotation of the object. The Maintain Volume option on the HyperVoxel Panel Geometry Tab 
will cause the HyperVoxels to maintain their volume. This means that when they get squashed, they will maintain the 
same area.

Align to Path

Align to Path causes the HyperVoxels to rotate as they follow a path. This can be particularly important when using 
particles.

Blending HyperVoxels

Separate HyperVoxel items can interact with one another. You can individually set how the selected object interacts 
with other HyperVoxel objects. In order for HyperVoxels to interact:

All must belong to the same Blending Group.
All must have a Blending Mode selected.

Here, the two objects are shown separately:
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Left: Object 1, Right: Object 2

(none) means it will not interact with other HyperVoxel items.

No Blending

Additive will smoothly blend HyperVoxels.
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Object 1 Additive, Object 2 Additive

Negative will make the object push away portions of other HyperVoxel items that it comes in contact with - sort of like 
an animated boolean effect.

Object 1 Additive, Object 2 Negative

Effector is kind of a cross between Additive and Negative.
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Object 1 Additive, Object 2 Effector

A Blending Group is the group of HyperVoxel objects which you want to interact with each other. You can select an 
existing group or create a new one.

The Metaball blending method can be used with all HyperVoxel types. Rather than just retaining the two former preset 
choices (Metaballs 1 and Metaballs 2) the implementation was revised to allow for control of the algorithm via a 
percentage entry field and animation of the value using an envelope.

To enable, first check on the Blending toggle. The Blending Scale field now allows for control of the blending algorithm. 
The former Metaballs 1 option can be matched with a setting of 75%, and the Metaballs 2 option with a setting of 100%.

It is now possible to use any value, including values above 100%. This helps to provide quite a range of looks, including 
more fluid-like HyperVoxels setups. The setting can also be animated.
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Show Particles

The Show Particles option will display a bounding sphere in viewports.

The Blending Box will enable/disable the surface tension of HyperVoxels. Checked, Blending will result in the 
HyperVoxels connecting in close proximity. Unchecked, the HyperVoxels will not connect in close proximity.

With Blending off, you can create things like sand, gravel, and other loose particulate matter.

Shading Tab

Surface Mode

The parameters on the Shading Tab work just like their cousins on the Surface Editor.

The upper limit for particles has been removed. Although there is now no fixed upper limit, bear in mind that 
each particle can take 2.5 KB or more per second of animation at 30fps. Increasing the number of particles to 
more physical memory than you have available will result in LightWave crashing


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Self Shadows lets the HyperVoxel cast shadows on itself. (The HyperVoxel will cast shadows on other objects in the 
normal way.) Full Refraction forces rays to bounce each time a new refracting (i.e., transparent) surface is found. If this 
option is inactive, one refraction bounce is computed, which is enough most of the time. Full Refraction will, of course, 
increase render time, but will result in more sophisticated effects.

Volume Mode

The options on the Shading Tab are different for Volume HyperVoxels, which are gas- or cloud-type effects. Use Color, 
Luminosity, Opacity, and Density settings to change those parameters for the volumetric object.

You might try the (faster-rendering) corresponding bump textures on the Shading Tab without HyperTextures, 
if you don’t need the true surface details. Remember this: “Don’t get hyper if bumping will do” or “A bump in 
the night is not worth getting hyper over.”


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The Thickness setting, which defaults to 50%, lets you adjust the general heaviness of the volume. Higher Smoothing 
values yield less of a hard-edged look and volumes will appear more wispy.

Volume Mode Advanced

The various items on the Render Quality pop-up menu determine the level of detail HyperVoxels uses to render the 
volume. The default is Medium and should be adequate for most situations. Near Clip is the distance from the camera 
where the rendering starts. The default value is normally fine. A lower value will render finer details, but take longer to 
render. You might adjust this setting if the camera was inside a cloud. It really depends on the scale of the HyperVoxel 
objects and the scale of the details you want to see.

The Volumetric Shadows option creates shadows within the volume, which add detail and realism. However, it can 
increase render time significantly, especially when you are trying to simulate very dense clouds, like volcanic smoke. 
The Texture shadows option yields a very realistic shading of the hypertexture, but increases rendering time 
significantly. If you disable this option, you will miss all of the hypertexture shadow details.Use the Shadow Quality pop-
up menu to choose the render quality of the shadows. The Shadow Strength sets the darkness of the shadows.

The Illumination pop-up menu determines how the HyperVoxels volume is lighted. Self acts as if the light comes from 
the viewer. It can be useful to see more details on the object. With Constant, the scattering of light is constant, that is, 
the amount of light scattered at one point is proportional to the amount of light received at that point.

Rayleigh simulates a strong forward scattering of light within the volume. Light scatters in the direction of the light 
relative to the viewer, which means that illumination will be at its maximum when the light faces the viewer. This is 
perfect for back-lit clouds, smoke, and so on.

Beer uses the pattern’s sample density amount as the illumination value, dramatically reducing contrast between 
lighted areas. The setting uses the physical model for scattering of light inside a gas, and is a good setting for clouds. 
For a more “cartoony” look, try CelShade.

You can choose to have all lights affect the HyperVoxel with Use All Lights, or choose one or two specific lights.
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Ambient Color lets you specify the ambient light color of the volume. This setting works hand-in-hand with the Color 
setting on the Shader Tab.

Ambient Color is similar to ambient light in Layout, except that it applies only to the selected HyperVoxel object. 
Basically, the shading process is very similar to what happens with regular object surfaces.

Because of the way illumination is calculated inside volumetrics objects, Ambient Intensity can be higher than 100% 
without overexposing the image.

Try to avoid using these Light options, if you are ray tracing shadows. Ray-traced shadows on volumetrics is 
incredibly computationally intensive and will often result in unacceptable rendering times. A single pixel in 
volumetrics requires 20 or more samples and a shadow is ray traced for every sample. Try to fake lighting with 
Ambient Intensity and surface Luminosity or use Shadow Map Spotlights.


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Sprite Mode

The options on the Sprite Mode Basic Subtab are similar to the options available for the Volume mode. This makes sense 
since the Sprite mode is just a slice of a Volume mode HyperVoxel. 

Density on sprites is a multiplier for both Opacity and Luminosity. It is essentially the opposite of Dissolve.

With the Number of Slices setting, you can “thicken up” the effect by increasing the number of slices used for sprites 
from the default setting of 1. This allows you to get something a little closer to the Volume Mode while still retaining the 
speed of the Sprite Mode.
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Left: 1-Slice, Right: 3-Slice

You may choose to light the Sprite using all lights in your scene or up to two specific lights.Orient Slices to Ray orients 
the sprite’s coordinate system with the ray, rather than the default of aligning with the camera.

On the Clips Subtab, you can map an image directly onto a sprite using the Add Clip button. Any image available to the 
scene may be selected. Use the Image Editor to load an image not already available.

Clips are added to the HyperTexture. If you want to see only the clip, set the Texture option to (none) on the 
HyperTexture Tab.
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Some options on the Alpha pop-up menu let you cut away parts of the image you don’t want to use. If the image file 
includes an alpha channel, choose Embedded to use the alpha channel. Use Luminosity to leave brighter parts of the 
image. The Black mode will cut away black areas. The Threshold level lets you increase the range for what is considered 
black.

The Rotation setting sets a rotation speed for your clips. This is perfect for effects like billowing smoke and explosions. 
The higher the setting, the faster the rotation. Positive values make the clip rotate clockwise. Rotation always faces the 
camera.

If you do not want to use the color information in the image, uncheck Use Color. Then, only the greyscale information 
will be used. Antialiasing will yield better-looking edges, but it significantly increases render time and memory 
requirements.

When Solid is checked, the sprite is rendered as a solid object, preventing the normal additive result of overlapping 
sprites.

Sprite Clip Frame Offset

If you use HyperVoxels with particles, you can use multiple clips. The Frame Offset setting determines how you want to 
map an image sequence to a given particle. Particle Age starts the sequence for a particle at birth. Thus, the image will 
likely be different for particles at a given frame. Uniform will use the layout time as the time in the sequence. Thus, the 
image used is the same at each frame. When the bottom of the list is reached, it starts again from the top. Random will 
assign a random offset to each particle.

Frame Offset is an important control for sprite animations. It allows you to decide how to attach images to particles. 
Particle Age is probably the most useful. You can have literally hundreds of particles, each mapped with distinct image 
sequences. For example, you could have particles with independent water-splash image sequences, creating a complex 
and rich visual effect.
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HyperTexture Tab

The Texture pop-up menu determines what the texture will look like. The textures in this menu correspond to the 
identically named procedural textures, although not all of them will be available here.

The big difference is when you are using a Volume (Object Type) HyperVoxel. In this case, you can animate the texture 
effect.

In the Texture Effect pop-up menu you have several options. Turbulence makes the texture move towards the viewer. It 
is like animating a texture with the texture velocity parameter. Billowing animates the texture by rotating outward 
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along a velocity vector (à la Dante’s Peak). It is very good for explosions. Displace adds variations to the texture. The 
effect is best seen when the texture is moving. Dissolve gradually lowers density, making particles disintegrate.

Velocity Translate moves the texture in the direction of the particle velocity. Since each particle has a different velocity, 
this can result in a cool and complex texture motion. Dissolve & Expand might be used on explosions. It dissolves the 
effect as it expands. Some trial and error may be necessary to get the desired look.

The Effect Speed setting is the duration of the looping cycle. The value is equal to a percentage of Layout’s Default 
units, on the General Options Tab of the Preferences Panel, per frame.

Gradient Input Parameters

Special Input Parameters will be available for texture gradients on HyperVoxel parameters. Particle Age is simply the 
age of (Particle FX) particles, in frames. Particle Speed is the particle speed in default LightWave units (usually meters) 
per second. Use Time to change the setting over a range of frames.

The Particle Weight Input Parameter is used with regular objects that use HyperVoxels and requires them to have a 
Weight Map. The object must also have the HyperVoxels Particles Displacement plugin added. Set Particle Weight 
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1.

should be checked and the Weight Map selected.

For HyperTexture and Shading settings, gradient textures can use a distance to particle (along a specific axis) input 
parameter. This is the surface distance from the actual particle position along the selected axis.

Particle Weight Input Parameter

Create an object in Modeler.
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2.

3.
4.
5.
6.

7.

Create a Weight Map and add some random weighting to the points.

Load the object into Layout.
Choose Window > Volumetrics and Fog Options.
Open the HyperVoxels Panel and activate the object.
Open the object’s Properties Panel, add the HyperVoxels Particles Displacement plugin. Open its options, 
activate Set Particle Weight and choose the Weight Map.

On the HyperVoxels Panel, add a texture to the Particle Size and set the Layer Type to Gradient. Choose Particle 
Weight as the Input Parameter. Create some keys.
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FiberFX

FiberFX is LightWave’s native hair and fur system. Fibers using Solid Volume mode can be textured with nodes, and 
FiberFX contributes to alpha channels for all render modes.

FiberFX Window

The Information line will tell you how many fibers you have in your scene.

Activate - To add FiberFX to an object, select it in the list on the left and click the Activate button. Alternatively, you can 
double-click the entry in the list.

Deactivate - To remove FiberFX from an object click this button.

Edit - This brings up a menu with four options:
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Copy - Copies all FiberFX settings from an object.
Paste - Pastes all copied FiberFX settings.
Load - Loads saved settings.
Save - Saves settings.

In previous versions of FiberFX, there was an Edit Nodes button. In 2018, all surfacing is done in the Surface Editor with 
the Hair material and the FiberInfo node.

The listview to the left of the panel shows FiberFX-bearing surfaces to make it easier to see at a glance which surfaces 
have hair and which do not. The checkmarks indicate which surfaces have hair and the red checkmark shows that while 
FiberFX has been activated for an object, the surface has not been chosen. If an object has a single surface you won't 
see the red checkmark, it will automatically be white.

If you right click on an object you will be presented with a dropdown menu like so:

The options in this menu are as follows:

Clone - Creates a new instance of the object on which the parameters can be changed. As an example, you make 
a short white undercoat and the another layer of sparse long guard hairs over them.
Save as Default - Saves the current style as the default for FiberFX from now on.
Reset Default - Puts the default back to the medium-length brown hair style.
Polygonize - Creates a polygon mesh of your hair style. Choosing this option brings up the following interface:

 
Polygonize has the following parameters:

Sides - 1-sided is a single poly chain; 2-sided is flat with polys on each side; >2 is an extrusion of n sides.
Flatten - flattens the tube.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=YjdZvwHqUA0

https://www.youtube.com/watch?v=YjdZvwHqUA0
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Triangles - make triangles instead of quads.
Billboard - makes crossed polygons suitable for mapping.
Polygonize Mixed - Will use the guides on a surface object to make new mixed mesh object with guides attached 
to the mesh.

Save as CyWig - Saves your FiberFX as a CyHair wig.

There are four tabs in the FiberFX window, as follows:

FiberFX - Geometry
FiberFX - Styling
FiberFX - Bundle
FiberFX - Options

Polygonized Mixed generates two-point polygons. There are two ways to keep these two point polygons from 
showing up in the render. The artist can disable Render Lines in Render Properties > Render to prevent all two-
point polygons in the scene from rendering. Alternatively, the artist can set the Particle/Line Thickness of the 
object containing two-point polygons to 0.0. Particle/Line Thickness is found under the Edges Tab of Object 
Properties.



CyHair Support

Alie
n 
Iggy 
Pop

 
FiberFX supports the cyHair hair model data format from Cem Yuksel. This means you can style 
hair in a variety of packages and import your hair into LightWave for rendering, or inversely export 
from FiberFX for use in other packages. Load a cyHair wig in Modeler as any other file. Keep it as a 
separate object or put it on a different layer to the rest of your geometry. When sent to Layout, 
apply FiberFX to it.

If you have styled hair in FiberFX you wish to export as cyHair, right click on the hair in the FiberFX 
window and choose Save as cyHair Wig.



If you wish to clone objects with their corresponding FiberFX primitives make sure you use Clone Hierarchy.

http://www.cemyuksel.com/research/hairmeshes/
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FiberFX - Geometry

FiberFX has two styles of geometry tab. The one on the left will be seen when Fibers are grown on surfaces or objects, but if 
you use splines or poly chains you will see the style one the right

Max Fiber Density - Dictates how many fibers your surface will have. Max Fiber Density can either be expressed 
with a number or with a texture. It can also be animated over time using an envelope.
Relax - You can relax the fiber distribution across your object in a series of iterative steps that will gradually 
quantize placement making fibers more evenly spread. There are 40 levels of relaxation and each one marks an 
iteration, so setting it immediately to 40 will take some time to show results depending on the quantity of fibers 
to be processed. (Not available for Spline FiberFX)
Cluster - This will place additional copies of the guide fiber around the initial fiber to increase dynamic 
responsiveness.
Cluster Radius - The radius around the original guide fiber that is used for the placement of fiber copies.
Edit Guides - This allows you to style your hair and save the style as a Vertex Map with the object it is applied to. 
It is discussed in detail here.
Style - Apply a style created with Edit Guides.

Spline FFX specific:

Fiber Quantity - How many fibers follow the spline or poly chain.
Guide Radius - How far away from the spline fibers can spread. Important when the Fiber Quantity above is 
more than one.

https://docs.lightwave3d.com/display/LW2018/FiberFX+-+Options#FiberFX-Options-EditGuides
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Fiber Type - This setting gives you a dropdown menu with two choices. If you polygonize the fibers to make a model 
they maintain that alignment in the model as well:

Stroke - Will create a camera-facing 2D shape.

How smooth your spline fibers will be will depend on how many control points your spline has.

The spline on the left has 647 points, the spline on the right has only 16


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Solid - Will create a solid tube. It can be applied to any fiber guides. You can generate and style the fibers directly 
within FiberFX using the Edit Guides option, or you can use models set up with the FiberFX tools in Modeler 
(Fiber Modeler and  StrandMaker , both available on the  Setup tab in Modeler). Solid mode render fibers with 3D 
volume at render time, in much the same way that Layout treats 2-point poly chains when you assign a negative 
Particle/Line Thickness for an object.

End Caps - Presents a dropdown list with a choice between:

None - The ends of the Strokes or Solid fibers are squared off.
Cap Base - The base of each fiber is rounded.
Cap Tip - The tip of each fiber is rounded off. In Stroke mode, you might need to reduce the amount of tip 
transparency to see the effect, since the default 20% hides the rounding.
Cap Both - Both ends are rounded.

Fiber Width - Sets the thickness of fibers. Thinner fibers are more transparent and build up density more slowly, 
whereas thick fibers are less transparent and build up density faster. Model scale has an effect on fiber width, as does 
the distance to camera. Fibers further away are smaller in screen space and are more transparent.

The default value is based on human hair which has been measured at 0.017mm to 0.181mm with blond hair being the 
thinnest and black hair the thickest. 500 um is the median value.

Depending on the size of your object you may need to increase or decrease this value for a realistic effect. By default 
Solid fibers have an equal thickness across their length. To vary the thickness, click the T button and select the Gradient
Layer Type, then choose Fiber V as the Incoming Parameter and vary the thickness.

Edges - This is the geometric resolution of each fiber. Fibers are given two by default, but if you have long fibers you may 
need to increase edges in order to smooth the fiber and avoid awkward corners rather than bends. (Not available for 
Spline FiberFX)

 With strokes being camera-facing 2D shapes, their shadows are necessarily an approximation created by 
taking the central line of the fiber and expanding it, without taking the fiber's form into account. Mostly, this 
will be fine but if you require accurate shadows, use Solid instead.

Stroke fibers brought in from LightWave 2015 will need to be scaled by 0.0005.

https://docs.lightwave3d.com/display/LW2018/FiberFX+-+Options#FiberFX-Options-EditGuides
https://docs.lightwave3d.com/display/LW2018/Fiber+FX#FiberFX-FiberFXStrandModeler
https://docs.lightwave3d.com/display/LW2018/Fiber+FX#FiberFX-FiberFXStrandModeler
https://docs.lightwave3d.com/display/LW2018/Fiber+FX#FiberFX-StrandMaker
https://docs.lightwave3d.com/display/LW2018/Fiber+FX#FiberFX-StrandMaker
https://docs.lightwave3d.com/display/LW2018/Setup
https://docs.lightwave3d.com/display/LW2018/Setup
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Fiber Smooth - This is a subdivision technique for fibers at render time so that Edges can remain low and long fibers will 
still bend rather than corner. Since it happens at render time it has little impact on memory while working in Layout. By 
default Fiber Smooth is set at 2, which will subdivide each fiber four times. There are four levels of subdivision each of 
which doubles the previous level.

Gravity - FiberFX offers a simplified gravity. The default is set to 0 %, but 140 % approximates earth gravity on human 
hair if you wish to use it. 

Use Dot - This function uses the dot product of the gravity calculations to make the fibers act more like they are hugging 
the surface to which they are assigned. 

Dynamic Gravity - If you have applied gravity to your fibers, checking Dynamic Gravity will ensure the position of the 
fibers will be animated to always point in an appropriate direction for the movement of the object the fibers are 
assigned to.

Setting Fiber Smoothing higher than needed can impact render times. Try incremental settings until you hit 
the smoothing level you need, rather than maxing it out.


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•

FiberFX - Styling

Fiber kink - This setting is only available when Fiber Smooth is set to 1 or above. As fiber edges are subdivided, 
each newly created edge end point can be perturbed. This creates a kinked look to the fibers.
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•

   

 
Kink 20%, Kink 40%, Kink 60%, Kink 80%, Kink 100%

Splay - This setting controls how far away fibers are tipped from each other using the polygon center or guide 
fiber as the basis for splaying the fibers.

   

Because subdivision of fibers is performed just before the edges are drawn, they are not used in creation of the 
shadows, as these are created prior to subdivision. As a result, the ‘kinking’ effect will not be visible in 
shadows.


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Splay 20%, Splay 40%, Splay 60%, Splay 80%, Splay 100%

Stray - Random fibers can be shorter or longer giving a look where just a few strands of hair stand out from the 
rest, giving a more natural look.

Stray 40%, Stray 80%, Stray 120%, Stray 160%, Stray 200%

Swirl - Controls how much each fiber is twisted, based on a splay center based around the polygon center or the 
guide fiber.
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Swirl 20%, Swirl 40%, Swirl 60%, Swirl 80%, Swirl 100%

Random - Only available when Swirl is not zero, this randomizes the starting rotation of each fiber.

Swirl Turns - Gives the number of complete revolutions swirls make.
Tuft - Progressively shortens fibers further away from the center of the polygon or guide fiber.
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Tuft 20%, Tuft 40%, Tuft 60%, Tuft 80%, Tuft 100%

Clump - Gathers fibers together as though sticky or wet based on polygon center or guide fiber.

Clump 20%, Clump 40%, Clump 60%, Clump 80%, Clump 100%

Scale - Gives a length to fibers. Scale is based on the size of the object - 100 % long fibers on a mammoth built to 
scale will be a lot longer than similar 100 % fibers on a fly modeled to scale.
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Scale 20%, Scale 60%, Scale 120%, Scale 200%, Scale 400%

Random Length - Randomizes the length of all the hairs on a surface to give more variation. Distinct from Stray
because the randomization is applied to all fibers.
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Rand Length 20%, Rand Length 40%, Rand Length 60%, Rand Length 80%, Rand Length 100%

Part Angle - Defines an angle between adjacent guides that cause the fibers to follow the nearest guide and not 
interpolate. This causes “parts” in the hair style instead of interpolating. The Part Angle will by default be 
applied to all fibers on an object, but can be controlled as in the image below by using a gradient texture applied 
to a Weight Map or simply a Slope in this case. The Part Angle can be small and still have a large effect since it is 
based on an examination of the first segment on the guides and the dot product is used to determine if fibers 
should interpolate or follow the closest guide.

Bump - This effect perturbs the initial fiber direction by simulating a surface bump using the local gradient of the 
texture. Similar to the Bump Channel in LightWave’s Surface Editor. This effect needs a procedural texture or 
image in the texture channel to be visible.

Bump 50%, Bump 150%, Bump 300%, Bump 600%, Bump 1200%

Root Only - Only the root of the fiber is used to calculate the bump giving a different look to the fiber 
arrangement.
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Bump w/RO 50%, Bump w/RO 150%, Bump w/RO 300%, Bump w/RO 600%, Bump w/RO 1200%

Direction Bias - This setting becomes available when the object with fibers has a Bias Vertex Map created with 
Modeler’s FiberFX interface. It determines the ratio between the settings for the fibers in the window and those 
contained in the VMap concerning direction.
Bias VMap - Presents a dropdown from which you can choose a Bias Vertex Map.
Remap - Only available when you are using a Bias VMap. When using RGB colors you can’t specify a value of 
-255(-1). Using Remap, the value of 0 is remapped to -255(-1), 128(.5) is the new 0, and 255(1) remains the same.
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FiberFX - Bundle

The Bundle tab is only for a single polygon guide for fibers, any other object will ghost the settings on this tab. The 
polygon guide should consist of a chain of two-point polygons with at least four points along the chain. The quantity of 
fibers in the bundle is decided on the Geometry tab and then options are applied here. 

Bundle - This presents a dropdown with three options as follows:

None - Removes all bundles of fibers.
Twist - Creates a twist of fibers based on the Count field.
Braid - Creates a plait of fibers. You aren’t limited to a Count of three for this however setting the Count field to 
two will result in exactly the same result as using Twist .

Count - Determines how many bundles of fibers are going to be created.

Strength - Sets how tightly the Twist or Braid will be applied to the fibers. Higher values lead to an increase in turns 
involved for the full length of the fibers, which will always extend the full length of the guide.

Spread - The radius of the circle the braided or twisted fibers make. A gradient can be used to reduce the size of the 
circle as the fibers grow.

Twist - While Strength dictates how the bundles as a group are twisted, Twist twists each individual bundle in the count.
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FiberFX - Options

Scene Edge Limit - Sets the maximum number of fiber edges drawn in OpenGL. The higher the number, the more 
fibers will be visible at the expense of slower OpenGL responsiveness.
Use UV Map - If your mesh has a UV Map, you can use it, rather than texturing the hairs directly. As an example, 
you have a UV-mapped leopard model with an image for the fur. Using UV Map here will color your fibers 
according to that texture.

Edit Guides

FiberFX allows styling of fiber guides directly within the LightWave Layout OpenGL viewport using Edit Guides. The tools 
presented in this window are intuitive to use and allow more natural styling of fibers than using just the basic 
parameters found in the Geometry and Styling tabs of the main FiberFX window.

Fibers should be edited (using Edit Guides) in their undeformed state. Combing fibers must be done before any 
deformation is applied, and before they are parented, moved or rotated in space. Disabling Deformation, IK and Motion 
Controllers is a must.

To bring up the styling tools, click the Edit Guides button on the Geometry tab of the main FiberFX interface. Once 
clicked, the main FiberFX interface will be hidden, and you will be presented with a window asking you to name the 
style you are about to create. If you have already created a style and have it selected in the dropdown below the Edit 
Guides button, you will immediately enter Edit Guides where you can make changes. If you wish to create a new style, 
set your Style to None.
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When using the Edit Guides window individual fibers become hidden, and the guides that control them are shown 
instead, these are what you will be styling. It’s worth noting at this point that when you begin styling your guides the 
Edges setting in the Geometry tab locks, so either make sure you have edges set to what you want before styling or save 
a ‘before styling’ version of the scene to preserve the ability to edit edges. You can also set your style to None, and your 
Edges setting will unlock again, allowing you to recreate the style from scratch.

As soon as you click your left mouse button in an OpenGL viewport with this window open you will see two circles for 
your mouse pointer. The inner circle determines the strength of your brush, the outer the size. These values can be 
changed numerically in the Edit Guides window or using the right mouse button interactively in the viewport. RMB up/
down controls brush radius, while RMB left/right controls brush strength. This applies whichever of the three Brush 
Modes you choose to use.

The three brush modes are as follows:

Radius - This is an airbrush-like manipulation of the guides on your object.

Global - This affects all guides equally, your brush radius has no effect here, but the strength does.

Surface Hug - This works similarly to Radius mode but attempts to keep to the surface of your object.

There are four brush types as follows:

Push - This ‘combs’ the guides in the direction you drag the mouse over them. The amount it drags them depends on 
the strength of your brush.

Scale - You cannot interactively change the radius and strength of your brush when in this type since clicking on the left 
mouse button grows the hair inside the radius of the brush, right-clicking shrinks the same hairs.

Straighten - This will unbend your fibers the longer you leave your mouse button held down until they are back in their 
initial direction of the normal of the polygon they are on.

Single - A special-use type, this allows you to manipulate a single guide, for instance, to create a kiss curl on the 
forehead.

Brush Depth - Because styling is most often done in a Perspective viewport sometimes you don’t want to affect fibers 
that are seemingly within the brushes radius but are actually on the other side of the shape you are styling. Using Brush 
Depth will enable you to control just how deep into the screen the brush goes.
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Symmetry Axis - You can brush symmetrically on your object using these buttons, and a plane will appear bisecting your 
object perpendicular to the plane you choose. Also, a single circle shows the fibers you are affecting on the opposite 
side of the symmetry axis.

History - The Checkmark with On written on it is to enable or disable the keeping of a history of steps performed in the 
Edit Guides window and can be turned off to save memory. The history is only kept during the session using Edit Guides, 
not between sessions.

Revert - This reverts the style to what it was when you opened the Edit Guides window initially and functions regardless 
of the state of the History On/Off Checkmark.

Reset Default - This button takes the style back to its original, default state. Be warned that there is no undo for using 
this function.

Style settings

Style dropdown - Allows you to choose between the different styles applied to your fibers. 

New - Creates a new style based on the one you were previously editing.

Remove - Deletes the currently selected style from your fibers.
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When using Guides for FiberFX, make sure you turn Render Lines off, otherwise, the two-point polygons used 
for guides will render through the fibers.


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Animating

Click here to expand Table of Contents...
Keyframing
Navigating a Scene
Playing a Scene
Creating Keyframes
Creating and Modifying Keys Automatically

Auto Key: Off
Auto Key: Modified
Auto Key: All Channels
Auto Key: Existing
Auto Key: Fixed

Editing Motion Paths Directly in a Viewport
Move TCB
Deleting Keyframes
Delete Motion Key Plugin
Delete Mode
Threshold
Protection
Saving and Loading Motion Files
DopeTrack
BioVision Motion Capture Support

Motion Preview

Keyframer
Modify

Translate Group
Rotate Group
Transform Group

Coordinate System
World (default keyboard shortcut Shift F5)
Parent (default keyboard shortcut Shift F6)
Local (default keyboard shortcut Shift F7)


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1.

Example

Avoiding Gimbal Lock
Reset
Light Intensity
Sliders

To use sliders in a scene:
To configure your sliders:

Spline Displacement
To use Spline Displacement
Spline Displacement Options

Edit Tool
Example - Baking Simulations

Align and Distribute
Nodal Metalink

Now that you have reviewed cameras, lights and objects in the Layout section, it’s time to discuss animation.

Keyframing
The way to tell the computer where an object - be it camera, models or lights - is at any given point is to use keyframes. 
Keyframes fix an object’s location, rotation and scale for a given moment in time. Setting one at the start of your 
animation and one at the end means that LightWave will automatically interpolate between them for the duration of 
the animation. In fact it will create these in-between frames, called tweens, between every keyframe resulting in a fluid 
animation. To get you started, let’s create a piece of the easiest animation possible.

Start Layout and check to see if Auto Key: All Channels is enabled at the bottom of the interface window. Add a 
cube by clicking on the Modeler Tools > Create > Geometry > Cube button and accept the default entries by 
hitting the OK button. The cube will appear at 0, 0, 0. 
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2. Click in an empty part of the viewport and move the mouse. You will see the cube moves since it is the selected 
object. If you wish to restrict movement to an axis, hit Ctrl Z to undo your move and click and hold on the red 
arrow indicating the X axis. Drag the cube over to the left side of the screen.
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3.

4.

5.

Move the slider at the bottom of the Layout viewport to the end of the slider range - it will be at frame 120 by 
default. You can also do this by clicking on the rightmost button of the transport controls under the viewport.

Move the cube over to the right edge of the viewport, either by the X axis arrow or just freehand in the viewport. 
You will see two things. The first is that there’s a yellow line on frame 0 in the timeline under the Layout viewport 
(there’s also one under the slider at frame 120 now, but it won’t be as visible), the second is that there’s a gray 
dotted line marking some of the path that the cube is taking. If you were to count the dots when the cube is at 
frame 60 by hand, you would see that there were 120 dots - 60 in front, 60 behind, but just take our word for it. 
These mark frames along the way.

If you hit the play button just under the right-hand side of the Layout viewport you will now see your cube 
moving across the screen and starting again when the slider reaches the end of the timeline. Congratulations! 
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6.

7.

You’ve made an animation. It’s not exactly Disney caliber, but it is an animation.

To make it slightly more interesting, stop the playback by hitting the pause button. Move the timeline slider to 
the middle of the timeline.

Move the null up to the top of the viewport. You can do this by grabbing the green arrow pointing upwards from 
the null, or by using the right mouse button anywhere in the viewport. You will see the motion path change to 
match the new keyframe. Now when you press play again, you can see that LightWave has taken note of your 
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8.

9.

changes and made the appropriate in-between frames for the motion to proceed smoothly.

Stop playback by hitting the Pause button and go through your scene adding more keys as you go. Create a real 
roller-coaster ride for the Cube to take. 

When you want to check the null’s motion path, press play. When your viewport is in Perspective mode, if you 
use the navigation controls at the top right of the viewport, you can see how the animation looks from any angle. 
See something you don’t like? Press pause, move the timeline slider to the frame you want to change and move 
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10.

11.

the cube. 

All items in a LightWave scene can have independent keyframes - while your cube is getting sick on its roller-
coaster ride, you can have the light in the scene changing direction and the camera following it around to make 
it even more disoriented. Even better, just because you’ve keyframed an object’s heading, there’s nothing to say 
that you can’t keyframe its pitch and bank on different frames. 

Go back to our short tutorial and get everything - and I mean everything: cube, camera, light - moving. Don’t 
forget that in addition to the Move tool you used to reposition the null, you also have the Rotate tool (keyboard 
shortcut: Y ) and the Size and Stretch tools (keyboard shortcuts: Shift +H and H). You’ll find all these tools on the 
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Modify Tab or you can just roll the mousewheel. We’re not looking for great art, just trying to get you used to 
how things work.

Normally speaking, LightWave doesn’t work in seconds because motions tend to be too quick and seconds too coarse a 
measurement. It works in frames - there are 25 to a second in PAL and 30 frames to a second in the NTSC TV system, 
HDTV is more complicated, varying between 24 - 60 fps. For film work, there are 24 frames to a second. If you’ve left 
your time settings at standard they will be at 30 fps and you have created four seconds of animation.

Keep working on your simple animation until you start to feel the cube’s pain at being forced to ride the roller-coaster 
one more time… This is easy and you’ll be glad you’ve practiced before things start getting harder.

Navigating a Scene

Just under the Layout viewport (or viewports) is the frame slider that we’ve already used for our exciting null animation. 
Although its main action is obvious, you also have the ability to change the range shown and also to pan through this 
range easily. To scrub through the frames you can move the slider with the mouse or you can use the cursor keys.

Left and Right move you through the frames one at a time, and holding down the Shift key at the same time moves you 
to the previous or next keyframe. If you hold down the Alt key while you move the slider with the mouse you will pan 
the frame range – this means that you will keep the same number of frames on the slider, but the start and end points 
will change accordingly. If, for instance, you had a 500 frames long animation, the amount of action would cause the 
detail in the frame slider to be confused. But if you set the end frame to a 100, you can then pan through the other 400 
frames of your animation, so this 100 frames could show the range between 0-100, or 357-457, as you like.

You can also jump to a specific frame in your scene by hitting the F key on the keyboard, which will bring up a 
requester where you can enter a frame number.


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Playing a Scene

Under the transport controls for the scene, you will see two playback arrows and a Pause button, and under that a Step
counter. The playback arrows allow you to playback the scene in either direction while the step counter allows you to 
set how many of the scene’s frames you wish to see played back. Setting this counter to 1 will play every frame, setting 
it to 2 will play every other frame, and so on.

Creating Keyframes
As we’ve already learned, objects are always loaded at the Origin. This is the center of Layout’s grid: 0, 0, 0 and every 
new item will have a default keyframe for frame 0 here. If you never create another keyframe for an item, it will stay at 
this default location throughout the animation.

We used Autokey in the tutorial at the start of this section, but if we turn it off we will need to set keys by pressing the 
Return key twice. A window appeared but was dismissed by us hitting the return key the second time. Let’s go in for a 
closer look at this window.

Make sure your scene is not playing back before you move anything. If you have AutoKey on, you will end up 
with keyframes all through the animation.



Your playback speed will vary depending on the complexity of your scene, object display mode, system 
capabilities and so on. Reducing the size of your Layout window can dramatically increase playback speed.



If the Hub active, you can modify an object in Modeler even while your scene is being played back in Layout 
and the object will automatically update to reflect the changes you make.



Frame 0 is the default starting point, but you can create keys at frames less than 0, if you need to.
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By default the Create Key At field will contain the current frame. You can change the frame number to create the key - 
using the animation channel values for the current frame - at a different frame by entering a different frame number 
here. This is a good way to copy a keyframe. You can also re-pose your item and create a new key over an old one.

The For pop-up menu has several options. You can create keys for:

Selected Items - All items that are selected, which will always include the current item. Generally, this will be the one 
you use the most.

Current Item Only - Only the current item, even if others are selected.

Current Item and Descendants - The current item and any child items.

All Items - All items in the scene. Beware that this is not limited to just items of the same type. A key will be created 
using the current Animation Channel settings for all objects, bones, lights, and cameras.

The dialogs for creating motion keyframes for scene items have three rows of Toggle buttons. This lets you create 
animation channel keys independently. The Position, Rotation and Scale buttons allow a row to be turned on or off with 
one click. All channels are enabled by default and their state is remembered.

Creating and Modifying Keys Automatically

To automatically create or modify keys you must activate the Auto Key option on the main interface. This is the global 
on/off switch for automatically creating keyframes. It works in conjunction with the Auto Key Create setting (General 
Options Tab of the Preferences Panel).

Auto Key is a time-saving feature for advanced users and can be very useful for quickly roughing out a motion path; 
however, beginners may want to stick with creating keys manually.

Make sure you are always aware of the status of Auto Key and Auto Key Create. These options can result in an animation 
with extraneous keyframes.

The Auto Key function has been refined to allow quicker access to the various modes it can operate in. Previously this 
feature was hidden away in the Options panel, but is now located directly on the main interface in Layout. The Auto Key 
preference in the Options panel now only serves as a default startup preference.

An option also appears in the Auto Key popup menu called Auto Key: Existing. This mode was available before but was 
somewhat hidden; it has now been made much clearer which Auto Key mode you are in. The checkbox is now a visual 
indicator as to when Auto Key is active and when it’s completely off. Auto Key now has the following modes:

Keys created using the Create Motion Key dialog use the Graph Editor’s Default Incoming Curve type, 
discussed here. Generally, we suggest you use TCB Splines and not Bezier Splines. Bezier tangents are 
determined at the moment of creation and don’t automatically adjust as new keys are created. This can cause 
awkward movement through keys.


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Auto Key: Off

 
Automatic Keyframing is completely off, no new keyframes will be created or existing ones modified.

Auto Key: Modified

 
New keyframes will be created/modified, but only on the channels you edit. E.g. If you only move an item, keys will be 
created/modified only for the translation channels you change, but not for rotation or scale.

Auto Key: All Channels

 
New keyframes will be created/modified on ALL channels regardless of whether you only move, rotate or scale an item.

Auto Key: Existing

 
Only existing keyframes will be adjusted, no new keys will be ever be created, this is to allow tweaking of keys without 
fear of ever creating new ones. In previous versions of LightWave this mode was available when Auto Key Create Default
in Options was set to Off, but the Auto Key button in Layout was active. Now you just need to select this option.

Auto Key: Fixed

Keys will only be placed at the Auto Key Fixed Frame set in the field below the pop-up menu. Best used with static items 
that have no motion paths.

Editing Motion Paths Directly in a Viewport
You can also move an item’s motion path directly in a viewport using the Move Path tool (Modify > Motion Path > Move 
Path).

Note that the Autokey indicator at the bottom of Layout works in a similar manner to how the original Autokey 
on/off button did. For your Autokey preferences to be saved, you still need to visit the Options panel. This 
setting is not scene-specific.


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The Move Path tool allows you to shift your completed motion path for an item, keeping all the keys in the same places 
relatively. Let’s say you had a very complicated scene, it would be useful to be able to move to an empty portion, create 
the motion path for your object and then move it into place. With Move Path, that’s exactly what you can do.

Move TCB
Another tool in the Modify menu will directly affect your motion path. At the bottom of the Modify list you will find Move 
TCB. This allows you to set the biases discussed in the Graph Editor section of the manual, but from Layout, rather than 
having to visit the Graph Editor itself. To use it, move to a keyframe, click on the Move TCB tool and you will notice that 
the lower left corner now displays T, C, B instead of the more familiar X, Y, Z or H, P, B.

 
You can enter figures in here for what you wish your TCB settings to be, or you can use the mouse:

LMB: Moving left and right alters the Tension
Ctrl+LMB: Moving left and right controls the Continuity
RMB: Moving left and right controls the Bias

Deleting Keyframes
You delete keyframes in a similar way to how you create them.

 
To delete a keyframe:

Select the item. Normally, you will also go to the keyframe you wish to delete.

Click the Delete Key button at the bottom center of the Layout interface or press the Del key.
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The Delete Motion Key dialog will appear. It uses all of the same controls previously described for the Create 
Motion Key dialog.

Delete Motion Key Plugin

Use the TMP Motify Delete Motion Key generic plugin (Utilities > Additional > Motify) to delete keyframes, clear motions, 
delete ranges of keys, delete keys within a threshold, and more. Motify can be used to completely replace the built-in 
Delete Key dialog.

To use Motify:

Select the item(s) you want to delete keyframes from. Normally, you will also go to the keyframe you wish to 
delete.
Run Motify
Choose a Delete mode.
Enter a range of keys in the Delete Keys From and Through input fields.
Enter a Threshold.
Choose a For mode.
Enable or disable channels
Click OK.

The For pop-up menu determines which objects will have their keys deleted and has several options. You can delete 
keys for:

Selected Items - All items that are selected, which will always include the current item. Generally, this will be the 
option you use the most.
Selected Items and Descendants - The selected items and any child items.
Current Item Only - Only the current item, even if others are selected.
Current Item and Descendants - The current item and any child items.
All Items - All items in the scene. Beware that this is not limited to just items of the same type.

The Position, Rotation and Scale buttons allow a row to be turned on or off with one click. Only the selected channels 
will be processed. You can Shift click to invert a group’s selection state.

Many of the above steps are optional. For example, to simply delete a keyframe at the current time (using the 
previous For mode), run Motify and click OK.


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The All Other Channels button is a powerful feature, but can cause a lot of damage to your scene if used incorrectly. All 
non-motion channels will also be processed (the Position, Rotation and Scale buttons still determine if the motion 
channels are processed). This includes all envelopes applied to those items (like Camera Zoom Factor and Light 
Intensity), envelopes for applied plugins (such as Morph Mixer channels), and surface envelopes applied in the Surface 
Editor. Use this feature carefully, especially when deleting keys on multiple items at once.

The About button will open an informational dialog, including a list of keyboard shortcuts.

Delete Mode
The Delete Mode determines what is done to the item’s motion. The default mode, Delete Key, deletes the key at the 
frame entered in the Delete Keys field From field. Both integer and fractional keyframe values can be entered.

The Threshold field can be used to determine how close a keyframe has to be to the defined frame to be deleted. This is 
useful for deleting fractional keyframes when Fractional Frames is disabled on the General Options Tab of the 
Preferences Panel.

Delete Keys Within Range will delete all keyframes between and including the From and Through frames. The 
Threshold setting, in this case, will extend the range lower and higher - all keys within the range will be deleted.

Delete Keys Outside Range will delete all keyframes outside, but not including, the From and Through frames. 
Threshold is not used in this mode, as it only applies when the end frames are also deleted.

Delete Keys Before Range deletes all keyframes before, but not including, the From frame. Similarly, Delete Keys 
After Range deletes all keys after, but not including, the Through frame.

With Clear Motion , all existing keyframes will be deleted. This will only clear the channels marked at the bottom 
of the dialog.

If all keyframes become deleted in any of these modes, a new default keyframe is created at frame 0 with a position and 
rotation of 0.0 on all axes, and a scale of 1.0.

Threshold
Threshold determines how close a keyframe has to be to the From and Through frame numbers in order to be deleted. 
The default value of 0.0 means that the key must exactly match the frame numbers entered. A value of 0.1 means that 
any keyframe within 0.1 frames will be deleted. For example, if you are trying to delete keyframe 20 with a Threshold of 
0.1, all keys between 19.9 and 20.1 will be deleted. A value of 0.5 can be used to ensure that any fractional keys between 
the current frame and the next or previous frames are deleted without going into the domain of the next keyframe. The 
small pop-up menu to the right of the Threshold input field contains a number of reasonable presets values.

Protection
The Protection pop-up menu can be used to ensure that certain important keyframes are not deleted. This is especially 
useful when using the Delete Keys Outside Range or Clear Motion modes, where deleting all keyframes could ruin your 
scene or destroy your character’s bone setup and IK poses.

No Protection means that no keyframes will be protected from deletion. This allows you to delete any keyframe.
Protect Frame 0 will ensure that no keys at frame 0 are deleted. Similarly, Protect Neg & 0 will protect frame 0 
and all negative keyframes.
Protect First Key and Protect Last Key will keep you from deleting the first or last key in the channel, 
respectively.
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Saving and Loading Motion Files

To save the selected item’s motion path to a file, choose File > Save > Save Motion File. Use the filename extension .mot 
when saving a motion file. Mac users should note that this extension is not automatically added - you must type it as 
part of the file name and then save the file. To load a saved motion file and apply it to the selected item, choose File > 
Load > Load Motion File.

DopeTrack

BioVision Motion Capture Support
LightWave provides a couple of plugins to support the BioVision (BVH) motion capture file format. The 
MoCap_BVH_Setup generic Layout plugin (File > Import > MoCap_BVH_Setup) reads a BioVision BVH file, creates bones, 

Modeler’s Path Extrude and Path Clone commands use these files to execute their operations.
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and applies the motion capture data to them. For any use of Motion Capture files, you will need to have AutoKey (Shift 
F1) enabled.

Set Start Frame Offset to the frame you want the motion to begin.

Bone Scale Factor allows you to set a scale for your object from the start and may need some repeated experiments to 
get close to the scale of your object. Often BVH files come in at an extremely large scale. As a start, try a scale of 0.1.

The Bone Name Postfix is simply a number appended to the end of all of the bone names (e.g., LeftKnee_1).

After you run the plugin, replace the top null (in the created bone hierarchy) with the object to be animated. You could 
also use the Use Bones From Object feature on the Bones Properties Panel.If you need to change the initial resting 
position of bones, make sure you reset their rest positions (use the r key). You’ll probably need to adjust some of the 
individual bone properties after you run the plugin.

Applying motion capture to a LightWave object is an arduous process fraught with difficulties but yields good results.

MoCapSkelegons is a Modeler plugin that creates skelegons in Modeler that match the initial rest position of the 
Biovision BVH data. Use it to determine the correct scale, position, etc. for your object mesh. This object can then be 
used with the bones created using the MoCap_BVH_Setup generic plugin in Layout.

Motion Preview

There is also a custom object plugin that can be used to preview BioVision motion data. The preview is fast and 
accurate. Use it to determine if there were any errors in the motion conversion.Simply add the MotionCapturePreview 
custom object to a null object on the Object Properties Panel. (If you run the MoCap_BVH_Setup generic Layout plugin, 
a null called “MotionCapturePreviewNull” will automatically be added to the scene with the custom object plugin 
already applied.)

Keyframer

Modify
Now we shall examine the Modify tab:

Translate Group

Rotate Group

Transform Group

Coordinate System
The Coordinate System setting (Modify > General > Coord System) affects the Move, Rotate, and Move Pivot Point tools.
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World (default keyboard shortcut Shift F5)

World allows easy movement based on the world axes, even for items deep within a hierarchy that contain rotated 
parents.

Parent (default keyboard shortcut Shift F6)

Parent is for movement based on the axes of an item’s parent(s). If an item has no parent then this setting is equivalent 
to World.

Local (default keyboard shortcut Shift F7)

Local is for movement based on an item’s own axes (such as dollying a rotated camera along its view direction). For un-
rotated items it is equivalent to Parent. Local can be temporarily activated by holding Ctrl.

Example

Below, we have rotated a null and then parented a distant light to it. The Show Handles option, discussed later is also 
active for illustration purposes, as it is by default. The handles will line up with the movement axes that would be used if 
you dragged your mouse.



LightWave 2020  –  LightWave 2020

Reference –  2141

Local

  Parent

World  

Note how with World, the handles line up with the lines on the grid. With Parent, the handles line up with the rotated 
(parented) null. Finally, with Local, the handles line up with the distant light’s rotation.

Avoiding Gimbal Lock
Gimbal lock normally occurs after you rotate an item 90 degrees on its pitch using the Parent coordinate system. Once 
this has occurred, rotating the object about either its heading or its bank axis gives you the same result-you have lost 
the ability to rotate about the object’s local heading. Gimbal lock is commonly a problem with bones in a hierarchy. By 

The Position and Rotation Coordinate System settings are independent. To change the system, select either 
the Move or Rotate tool first.
One thing to remember about Local and World rotation is that they are only for interactive manipulation. 
Internally, the Parent system is always used since it’s the only one that can encode absolute rotation values. 
This will affect how an item’s orientation is interpolated between two keyframes. As such, rotating the pivot 
point might still be useful in some situations.


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nature, bones have a starting position that is often rotated 90 degrees on their pitch, like bones in the arm of a human 
figure. You can avoid Gimbal lock by rotating using the Local coordinate system.

Reset
You can quickly reset position and rotation to their initial states by selecting the item, activating the channel you wish 
to reset (i.e., Move, Rotate, Size, and other tools), and then clicking Modify > Reset. You can reset individual channels 
without being in the mode by hitting Reset Position, Reset Rotation or Reset Scale and all channels with Reset All.

Reset is not an undo feature, although it can sometimes work similarly. Resetting restores the state for the selected 
channels to what it was when the item was first loaded or created.

Light Intensity
(default keyboard shortcut Ctrl H)

Selecting a light, or several for that matter, and using this tool allows you to adjust light intensity interactively by 
holding down the LMB and moving the mouse left and right. Feedback is given down in the bottom left corner as usual. 
If you adjust more than one light at once, the feedback area reports how one is being adjusted, but all that are selected 
are adjusted equally. Make sure you multi-select with the Shift key rather than making a banding box.

Sliders
(default keyboard shortcut Ctrl D)

Sliders (Modify > Tools > Sliders) are slider gadgets that are displayed over viewports. An individual slider is tied to a 
specific animation channel. A slider will indicate the current value of a channel and also let you interactively adjust that 
channel value. Sliders are useful for all kinds of animations, especially character animations. A good example can be an 
animated hand, with multiple bone movements for multiple fingers.

If you plan to move a pivot point, you should reset the item’s position and rotation first.

If you have Position or Rotation axes deactivated, Reset will have no effect on those settings.
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To use sliders in a scene:

Add the Sliders custom object (Object Properties Panel) to any object.

To display and interact with the sliders, choose Modify > Tools > Sliders. The sliders for the last current object (with the 
Sliders custom object) will be editable when the Sliders tool is active. Keep this in mind if you have more than one 
object with the Sliders custom object.

Remember, as with all Layout tools, you’ll need to select another tool (Move, Rotate, etc.) to deactivate the 
Slider tool.


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To configure your sliders:

Open the Sliders Custom Object settings dialog from the Object Properties Panel.

The left window (Channels List) will list all of the channels in the scene. To attach a slider to a channel, simply select the 
channel in the left window and double click or click the Add Channel button. Selected channels in the right window can 
be removed with the Remove Channel button.

The Range Min and Range Max settings define the interactive range of the slider. The underlying channel can go beyond 
these values, but the slider’s range of control and feedback will be limited to this range. If the underlying channel goes 
outside the range, the slider value will turn red.

Clicking on the slider handle will immediately change the channel to the slider’s corresponding value.

The description Label will default to the channel name, but you may edit that if you desire. You can also set the color 
used for the slider with the Color preset pop-up menu or specific RGB values.Working with OpenGL Sliders:

There are three controls along the top. Drag the far-left one to move the slider group. The Envelope (E) button will 
display the Graph Editor with the associated channels in the curve bin. The right/left arrowhead (<>) button can be 
dragged to scale the size of the slider group. The arrowhead button on the right will minimise/maximise the slider 
display.

In the individual slider entries, the handle can be grabbed to slide to any value in the range set up and the arrows at the 
right end are to jump from keyframe to keyframe.

To simplify using sliders, use the Add Slider Bank generic plugin command (Not assigned to the interface by 
default). It will add a null object, apply the sliders custom object to it, and open the sliders interface, all in one 
step.


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Spline Displacement

The Spline Displacement Tool (Modify >Tools > Spline Disp Ctrl) is a simple way to animate hoses, tentacles, etc. using a 
spline with control handles. This tool will create a spline the length of the object with a user specified amount of control 
points that can be used to deform an object.

To use Spline Displacement

Select the object that you would like to animate with Spline Displacement.

In the Object Properties window, Primitive tab, Modifier section, choose Spline Displacement from the Add 
Modifier Dropdown menu.

Spline Displacement is not a new tool. It used to be called SplineControl
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3.

4.

5.

Double-click Spline Displacement to open its interface.

Choose how many Control Points you want (you can change this later, but doing so might lose any animation 
set). The slider will set a minimum of 5 and a maximum of 256, but a minimum of 3 can be typed if desired.
Use the Spline Displacement button (Modify > Spline Disp Ctrl) to activate and move the nodes around.
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Spline Displacement Options

Control Points - This field will determine the number of control handles that will be generated.

Use Object CPs - Uses nulls with the names given in Object Name Prefix placed in scene as control points for the 
spline displacement
Object Name Prefix - Prefix for naming nulls for spline displacement

Each control point will be numbered starting from 0. This number will appear in OpenGL.
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Object Axis - Defines the axis the control spline will be drawn on.
Auto Key Create - Similar to Layout’s standard Auto Key in that it will automatically create a keyframe as you 
move a control point. The only difference is that it will always create when on frame zero regardless of whether 
or not this option is active.
Create Key - When Auto Key Create is not active use this to create a keyframe.

Set Rest Shape - Use this to change the default rest position of the control points in relationship to the object.
Reset - This function works like undo, however instead of just undoing the last move it will reset all control 
points to their rest position.
Allow Stretch - When this option is activated the object is able to be stretched past its original scale.

Spline Displacement can use other objects as controllers for the displacement. Here we look at moving 
our bar with null objects.

Example



Hitting Enter on the keyboard will not set a keyframe for a control point.
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Left: Allow Stretch OFF, Right: Allow Stretch ON

Scale by Weight Map - This option will use the Weight Map selected and only deform that area of the mesh.

Edit Tool
(default keyboard shortcut Ctrl E)

The Edit tool (Modify > Tools > Edit Tool) activates the ability to edit points on dynamic objects and particles. You will be 
able to visually see that you’re in Edit Mode in the viewport. All the points that make up the object will become 
highlighted and all the Edit tool functions will become active.

MDD Multi-Loader

For more information about the Edit tools and some of its options, see the Dynamics and Particles sections.
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The MDD workflow is central to using LightWave in a multi-product pipeline, or to enforce consistency when network 
rendering. LightWave has long been able to save and load MDD files and this new window makes them much faster and 
easier to apply scene-wide. On the left side of the window are presented the objects in your scene with their point 
counts. The list on the right will hold the MDD files you load using the Add MDD file(s) or Scan Folder buttons. Once you 
have objects on the left and MDDs on the right you can either assign by hand, clicking on the object in the left list first, 
then the MDD; or you can use one of the automatic matching routines:

Names - Matches the MDD filename to the object name in Layout
Points - Matches the object pointcount with the MDD’s pointcount (MDDs with pointcounts different to the 
objects they are aplied to don’t give predictable results)
Points & Name - Will only match the MDD to the object if both Name and pointcount are identical (the most 
secure)
Points or Name - Tries to match pointcounts first, then name if the first attempt finds no matches

Following the Match By... options there are three other buttons.

Assign Random - this will randomly choose an MDD in the right list to assign to the objects on the left list.
Unassign - This removes the MDD assigned to the object. You can also click in a blank area in the MDD list
Unassign All - This gives a warning before removing all MDD assignments to the object list

All of the Name options respect the Name Match Tolerance percentage field under the left object name field. At its 
default 0% assigning MDDs is based on a strictly exact name match. Increasing this percentage will match more and 
more items to 100% where everything will be matched.

To the right of this field is Ignore Clone Suffix. This is checked by default since you often need to assigned MDDs to 
cloned objects. If you wish to control which MDDs get assigned to which of your cloned objects uncheck this button.

Once matched a tick will show by the object name in the left list. Clicking on an object with an MDD assigned will 
highlight the MDD it has been assigned in the right list. You can assign a different MDD by clicking on it in the right list 
and you can Remove MDDs by clicking the button with the same name, or Clear All MDDs by clicking the button to its 
right. This presents a warning before clearing the entire list of MDDs from the right list.
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Under the MDD list on the right side of the window are the same options you will find in the MD Reader you will have 
used previously in LightWave for going through each object in the scene one by one. There are Random Frame Offset 
and Random Replay Speed buttons with ranges beneath each to allow you to apply some randomisation automatically 
across MDDs rather than needing to each individually.

The last two buttons are:

Clear Existing MDDs - This clears MDDs already assigned to the objects in the left list before applying those you 
have chosen in this window
Reset MDD Settings - This button merely resets the MDD settings in the lower right half of the MDD Multi-Loader 
window back to their defaults if you have made changes you don’t like

When you hit OK, the MD Readers are applied to the objects as in previous versions of LightWave.

Example - Baking Simulations

Align and Distribute

Align and Distribute

Located on the Modify Tab > Arrange Group in Layout, these small but useful tools make aligning and spacing items 
equally in Layout easier. The Align tools work in much the same way as the Align to Last Point tools in Modeler, but for 
any Layout Scene items. To use them select the items you wish to align, then select the last item to which you want to 
align the other items. From the Align menu choose which axis (X/Y/Z) you wish to align against. Once clicked, all the 
items you selected will be aligned to the last item’s axis you picked.

To distribute, or equally space items, you don’t need to worry about the selection order, simply select the items you 
wish to equally space between each other, and choose the axis (X/Y/Z, or All Axis) you want to space the items along.

Please Note: Due to the way Generic Scripts operate in Layout, these tools will not contribute to any Undo. 
Make sure you save your scene if you are unsure whether you want to keep the changes, or you will lose the 
original positions of the items.


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Nodal Metalink

Users that have been LightWave artists for a long time will be familiar with the Metalink functionality for creating a 
simulation with a low polygon mesh and then using that simulation to drive the motions of a higher quality mesh. 
LightWave 11.5 introduced a nodal way of metalinking objects together. To use it, simply visit your high polygon mesh’s 
Object Properties window, the Deform tab and click Edit Nodes. Choose Displacement > Metalink and select the low 
polygon mesh you have used for the dynamics simulation.

LightWave's many tools for animation include not only the FK and IK sort, but also more procedural animation types, 
like Spline Control and Raycasting.

The Metalink node can’t handle a lowpoly SubPatch mesh that was used for dynamics simulation linked to a 
highpoly SubPatched or polygonal object unless the lowpoly SubPatched object is set to a Display level of 0, 
but this shouldn’t prove much of a limitation.


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Rigging
Bone Properties
General Group
Add Group
Modify Group
Detail Group
Edit Group
Motions Group
Assignments

Animation
Translate Group
Rotate Group
Transform Group
DopeTrack
Keyframer

IK Boost
Spline Displacement
Motion Mixer
Ray Cast Geometry
Spline Control
Instancing reference
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Rigging
Click here to expand Table of Contents...

Introduction
Genoma 2
Bone Properties
Setup Tab
IK Boost

Introduction

Part of preparing a scene is the rigging process. Rigging a character, or any other object, involves setting up a system of 
interactions, in many cases using bones and applying the rules and limitations to those bones. There is no one way to 
prepare a rig, so your rig may have different rules from someone else and still achieve the same goal.

A number of tools can be applied to a rig, including all of the tools in the Setup Tab. Additional functions are available in 
the Motion Options Panel, where you can apply Inverse Kinematics and other rules for motion, and IK Booster, which 
can be used to augment normal IK, as a separate IK system, and even have dynamics applied to your rig. You can also 
Export and Import your rig data for use in other models.

Genoma 2

LightWave 2015 introduced a completely revised version of Genoma, turning what was a relatively simple rigging tool 
into more of a rigging development kit. Since a lot of Genoma’s work is performed in Modeler, the main documentation 
for both Genoma 1 and Genoma 2 is in the Modeler section of the wiki: Genoma.

Bone Properties

Setup Tab

There are several groups of functions contained within the Setup Tab, as follows:

General Group
Add Group
Modify Group
Detail Group
Edit Group
Motions Group
Genoma
Assignments

IK Boost


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Bone Properties

Click here to expand Table of Contents...
Bones Section

Use Bones From Object
Clear All bones
Falloff type
Use Morphed Positions
Bone Type
Current Bone
Bone Active

Rest Section
Rest Position
Rest Rotation
Rest Length

Weight Map Section
Bone Weight Map
Use Weight Map Only
Weight Normalization
Strength
Multiply Strength by Rest Length

Limited Range
Compensation Section

Joint Compensation
Joint Comp for Parent
Muscle Flexing
Parental Muscle Flexing
Twist

Bone Icon Size

This panel gives you access to all the settings available for bones in LightWave Layout.


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Bone properties can be accessed in two ways:

Select the Bones button at the bottom left corner of Layout and then click the Properties button located in the same 
corner.

Press Shift B and then P.
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Bones Section

Use Bones From Object

This pop up menu allows you to choose a different object whose bone properties you would like to edit. When you first 
open the Bone Properties Panel, you only have access to the bones of the object that you had originally selected. This 
allows you to change to a different object without having to leave the Properties Panel.

Clear All bones

As the name suggests, this button will clear all bones from the current object.

Falloff type

Falloff Type uses a mathematical formula to set the falloff strength of a bone’s influence in the current object. An 
exponent is used (^2, ^4, ^8, ^16) to figure out how quickly the falloff will happen. The larger the number the quicker the 
influence of the bones will falloff.
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Left: Inverse Distance, Right: Inverse Distance ^2
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Inverse Distance ^128

Use Morphed Positions

With this enabled, bone deformations will be applied after morphs. This option can adversely affect performance; 
normally it should be turned off.

Bone Type

A dropdown with three choices:

Full Bones - LightWave legacy bone system
Faster Bones - Each vertex will only be affected by the bones with the four largest weights. This can increase 
performance in objects with more than four bones.
Limited Bones - Designed to be more inline with how bones are used with game engines, Limited Bones is more 
restricted than the other modes for simplicity and speed.
When active, the value in the new "Limited Bones Number" is used. Both Faster Bones mode and Limited Bones 
mode work by choosing bones with the highest weights, but where they differ is that Faster Bones picks from all 
bones with the four highest weights (which can be any number of bones if multiple bones have the same 
weights). Limited bones instead limits the number of bones to the "Limited Bones Number" value.
When Limited Bones mode is set for an object, it applies to all bones used for the object (unlike the other modes, 
which can be overridden by nulls in the skeleton).

"Use Morphed Positions" is (intentionally) not supported with Limited Bones.

Current Bone

Shows the currently selected bone.

Bone Active

When checked bone is on (active).
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Rest Section

Rest Position

This determines the position of a bone at the time it is rested. When a bone is rested in layout it has an effect on every 
vertex in the object. How much effect it has is called weighting (not to be confused with Weight Maps). How much a 
point is weighted towards a specific bone depends on several factors. The most important is distance from the bone 
and bone falloff.

Rest Rotation

This determines the orientation of a bone at the time it was rested.

Rest Length

This determines the length of a bone at the time it was rested.

Weight Map Section

Bone Weight Map

Use this dropdown menu to select a Weight Map to apply to the current bone. The influence a bone has on a point is 
now modified with the strength of the various Weight Maps on a given point.

Use Weight Map Only

Only uses values attained from an applied Weight Map to set bone influence. Since each vertex can have multiple 
Weight Maps, various bones can have a distinct influence on a vertex based on the strength of each Weight Map it is 
assigned to.

Note that if a point has only one Weight Map, the bone assigned to that weight will have 100% influence on that point 
no matter what the value of the Weight Map is.

In order for a bone to have partial control over a point, that point must have at least two Weight Maps assigned to it. If 
the total value of the combined Weight Maps exceeds 100%,unpredictable results can occur. The same goes when using 
negative weights. To insure predictable results in this mode, it is best to also check Weight Map Normalization.

Another thing to know is that in this mode all other bone functions cease to apply.

Weight Normalization

Use this option to obtain predictable results when using Weight Map Only.This feature ensures that the total values of 
several Weight Maps applied to a vertex never exceed 100%. To calculate the amount of influence a bone will have on a 
particular point we have to know how many Weight Maps are assigned to bones and what their values are. For example, 
to calculate the amount of influence a bone will have on a vertex we have to know both the total number of Weight 
Maps on that point, and also their values. Assuming each Weight Map is assigned to a bone, we will conclude that the 
amount of influence a bone has on that point is derived as follows:Point A has three weight maps assigned to it named 
Upp_Arm, Low_Arm and Elbow.What is the amount of influence the Elbow bone will have on Point A ?Point A = Elbow/
(Upp_Arm + Elbow + Low_Arm)
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Strength

Whenever two or more bones are present, Strength (Bones Panel) will determine the influence one bone has over 
another when ranges of influence intersect. If the option to limit the bones range is inactive, all points within the object 
are considered completely within the influence range of each bone.

Multiply Strength by Rest Length

The Multiply Strength by Rest Length option (Bones Panel) causes a bone to multiply its Strength by its Rest Length to 
determine the influence of the bone. Bones with larger rest lengths will exert greater influence over other bones with 
equal Strength values, but smaller rest lengths.

Limited Range

When Limited Range (Bones Panel) is active, the Min value determines the sharp cutoff point of a bone’s influence. Any 
points within this range are 100 percent affected by movement or sizing of the bone. Any points outside of this range are 
affected to a smaller extent or not at all depending on whether they fall within the Max. In an orthogonal view, the Max 
setting is visible in the viewport. A short bone will exert a spherical influence, while longer bones exert a more oblong 
influence.

Compensation Section

Joint Compensation

Sometimes bones used to create joints can cause pinching or unwanted bunching, much like a folded garden hose. 
Joint Compensation (Bones Panel) will remedy this effect by making the affected points tend to maintain the original 
volume inside the joint. The result is a more realistic-looking joint. You can modify the compensation amount to 
increase or decrease the effect.

Joint Comp for Parent

This option shears the points affected by the parent bone during the child bone’s rotation. This compensation also 
alleviates the pinching effect often caused by bones. At the same time the point shear occurs, the bone will also try to 
maintain the volume inside the joint.

Muscle Flexing

With this option the points affected by the bone will flare out as the bone is rotated. The effect simulates muscles 
bulging under the skin.

Parental Muscle Flexing

This option is generally more commonly used than Muscle Flexing. For example, when your forearm rotates your biceps 
flex. The forearm is the child and the bicep is the parent. It would not look natural for the forearm to bulge as it is 
rotated, but it looks perfectly natural when the biceps flex.

The following options only operate on the pitch channel and are all overlays on top of normal bone function.
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Twist

The rotation axis most aligned with the bone at rest is used. For zero-length bones the bank axis is used. The amount of 
twist is the change in rotation of that axis between rest and current (limitation: local rotation values are used, so a twist 
of a bone is not inherited by child bones). There is a Twist toggle in the bone panel (default on), and an input which 
controls how curly it is (0% is no curl, 100% is curl by the amount of twist over the length of the bone).

Bone Icon Size

Changes the size of the bone icon in the OpenGL display. It does not affect how the bone influences the mesh or other 
bones.
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General Group

Click here to expand Table of Contents...
Bone Edit Mode

Enter Bone Edit Mode
Exit Bone Edit Mode

Bones On/Off
Enable IK
Enable Deform

Bone Edit Mode

Bone Edit Mode allows you to edit your character rigs quickly and easily within the scene you are creating.

Enter Bone Edit Mode

(default keyboard shortcut Shift E)

Entering bone edit mode will do a number of things to help you work on character rigs in your scene.

When it is invoked it will turn off the visibility of all items in the scene except the object that you have selected and will 
take you to frame 0. All of the items that have been hidden will also be locked so there can be no accidental selection of 
another object. Enable IK will also be toggled off but can be turned back on when needed.



If you use the Scene Editor while in Bone Edit Mode make sure you only edit the character that you had 
selected in Bone Edit Mode.


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Before entering Bone Edit Mode.
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After entering Bone Edit Mode (note that a red border appears around the viewport).

The other character that shared the same origin has been hidden and locked.

Exit Bone Edit Mode

(default keyboard shortcut Shift D)

Exiting Bone Edit Mode will restore all visibility and locked items to their original state. You will have to move to the 
original frame manually.
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After exiting Bone Edit Mode.

The objects do not need to share an origin for Bone Edit Mode to work. Selecting any object in the scene and invoking 
Bone Edit Mode will work. But some of the Bone tools (Mirror Hierarchy) are easier to use if the character is worked on 
at X= 0, Z= 0.

Bones On/Off

Turns all bones on or off.

Enable IK

(default keyboard shortcut Shift F8)

When Enable IK (Setup > General > Enable IK) is active LightWave’s IK will be applied to all items with IK set up on them.

Moving the time slider from frame 0 will cause LightWave to exit Bone Edit Mode.

It is sometimes necessary to disable IK when editing a rig.
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Enable Deform

(Setup > General > Enable Deform) will toggle on or off LightWave’s ability to deform a mesh with bones.
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1.
2.
3.

Add Group

Click here to expand Table of Contents...
Bone
Child Bone
Draw Bones
Draw Child Bones
Convert Skelegons
Joints

Add Joint
Add Child Joint
Draw Joint

Bone

Setup > Add > Bone. A bone will be added with its base at the selected object’s local Origin, along its positive Z axis.

Child Bone

(default keyboard shortcut =)

Setup > Add > Child Bone. A bone will be added with its base at the tip of the selected bone, along its positive Z axis. The 
new bone will be a child of the original selected bone.

Draw Bones

Draw Bones will allow you to draw a bone in any orthogonal viewport (This will not work in Perspective). This bone will 
be parented to the object. Each successive bone added will also be parented to the object. If you need to add a child 
bone use Add Child Bone or Draw Child Bone.

To draw a bone in a viewport:

In any Layout orthogonal-view viewport, select the object, or existing bone if you are drawing a child bone.
Select Setup > Add > Draw Bones . (Since this is the initial bone, you can alternatively choose Draw Child Bones.)
Place your mousepointer where you want to place the base of the bone.
Drag your mouse to create the bone.

Draw Child Bones

(Setup > Add > Draw Child Bones) allows you to draw child bones from a parent.

To use Draw Child Bones:

Select a bone or object that you want to add a bone to.
Click Setup > Add > Draw Child Bones.
Use the LMB and draw out the bone to the length and in the direction you want.


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1.

2.

Convert Skelegons

One way to create Skelegons is to create curves first. You can then convert the curves into Skelegons, which will be 
placed between the curve knots (points). With Convert Skelegons, (Setup > Skelegons > Cvt Skelegons) you can even 
use points from the object to create the curves.

To use Convert Skelegons:

In an open Modeler layer, create points that will correspond to the bases and tips of the bones you want to 
eventually create. (You’ll probably want the object to be boned in the background for reference.)

Select points, working from the (theoretical) base of the first child bone to the tip of the last bone in the chain. 
Then choose Create > Make Curve > Make Open Curve to create an open-ended curve with your points.

If you want to continue adding bones just keep drawing more bones. The next bone will be added as a child to 
the previous bone. If you want to add a child to a different bone than the one that was just created you will 
have to select the bone first.


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3.

4.

Repeat the previous step for all chains, if you have more than one. You can use the same point in multiple chains.

Still in Modeler , choose Setup > Skelegons > Convert Skelegons to create the Skelegon from the curves. You can 
edit the base/tip of the bones using standard modelling tools. The Skelegon bones will stay attached to each 
other.

If you desire, you can select and delete the curve afterward.
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5. If you want, you can optionally cut and paste the Skelegons into the layer with the normal object geometry.

Joints

An alternative to LightWave’s default Bone type is also available, Joints. Joints are similar to the way that rigs are 
created in other 3D applications and offer some advantages over LightWave’s own bone system, particularly if you are 
in a multi-app pipeline.
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The older Bone type has been labeled Z-axis. You can change the bone type in the Bone Type drop-down menu in the 
Bone Properties Panel.

The easiest way to visually tell a Joint from a Z axis bone is the small circle where the bone types are connected. The 
small circle is actually the Joint, two connected joints are represented by a triangle pointing towards the child joint. 
Keep in mind that a single joint will be represented by only the circle portion as it does not have a child.

Deformation is entirely defined by the change in position of the joint. Currently, joint rotation has no effect whatsoever 
on deformation. Joint-based animation and deformation control allows for a “stretchy bones” effect with considerable 
control for the user. A more organic and natural motion effect for shoulder and neck movements can be achieved, for 
example, or a more exaggerated effect for cartoon-type characters. Even zero-length bones (e.g. isolated joints) can 
cause deformation (activate them and turn off Multiply Strength by Rest Length).

Add Joint

A bone will be added with its base at the selected object’s local Origin.

Add Child Joint

A bone will be added with its base at the tip of the selected bone, The new bone will be a child of the original selected 
bone.

Draw Joint

Draw Bones will allow you to draw a Joint in any orthogonal viewport (This will not work in Perspective). This bone will 
be parented to the object. Each successive bone added will also be parented to the object. If you need to add a child 
bone use Add Child Bone or Draw Child Bone.



LightWave 2020  –  LightWave 2020

Reference –  2174

•
•

•
•

•
•
•

•
•
•
•
•

Modify Group

Click here to expand Table of Contents...
Joint Move
Tip Move

Single Bone
Entire Contiguous Hierarchy

Bone Twist
Scale Hierarchy
Orientation

Align Pitch
Record Pivot Rotation
Record Bone Rest Position
Remove Pivot Position
Remove RPR

Joint Move

(default keyboard shortcut Ctrl J)

Joint Mover draws lines along each bone and puts a cross hair at the base of the child bone(s), which is usually 
coincident with the tip of the parent (but need not be).

In any view, you can then click the LMB and drag the cross hairs to the new location where the tip of the parent and base 
of the child should be, in effect, moving the joint location between two bones. After the mouse button is lifted, hit the 
space bar to actually change the bones. Using the RMB will constrain the bone to move along its length.

Attributes edited in LightWave will be the parent’s rest rotation and rest length, and the children’s rest rotation, rest 
position, and rest length.


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If you select the object and run Joint Mover, the tool will be drawn through the entire hierarchy.
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Here is a hierarchy with Joint Mover active. You can see the green cross hairs that are drawn at the joints and at the tip 
of the single bone at the end.

Using the LMB each one of the joints and the tip of the bone at the end has been moved (one at a time) to a new 
location.

After all the editing is done, hitting the space bar will exit Joint Mover and move all the bones to the new locations.

If you want to execute your edits but keep Joint Mover active just invoke Joint Mover again instead of hitting 
the space bar. This will move the bones and keep Joint Mover on.



These edits cannot be undone.
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A bone’s tip can be moved away from the base of its child by selecting the bone you want to edit and running Joint 
Mover. The tool will only be active in the selected bone which is not the case when the object is selected and the tool is 
drawn through the whole hierarchy.

This will allow you to move the tip of the bone away from its child’s base.
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After the tool is dropped (hit space bar), the bone is moved to its new position.
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If you have bones whose tips have been offset, Joint Mover can still be used to edit the joints’ position.

The tool will behave just as it does when the parent’s tip and its child’s base are touching.
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This is the result of that edit. The spacing is maintained even with the bones in their new position.
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If multiple child bones share a joint with the same parent you can move them by selecting the object and drawing Joint 
Mover through the entire hierarchy. Or you can choose the bones individually.
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Use the LMB and drag the common joint where you want it to be.
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Once the edit has been executed, the bones will be drawn in the new location still connected.
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You can choose what bones in a common joint you want to move. As long as the parent is selected, as many of its 
children as need be can be selected and moved.

Tip Move

(default keyboard shortcut Ctrl T)

Tip Move will allow you to move an entire hierarchy by moving the tip position of the hierarchy’s parent bone. Attributes 
edited in LightWave will be the bone’s rest rotation, rest position, and rest length.

Single Bone

If a single bone is selected, Tip Move draws a line along the bone and puts a cross hair at the tip of the bone. If there is a 
hierarchy with a child relationship to the selected bone a yellow line is drawn through the remaining bone but there will 
be no cross hair at the tips. Only the tip of the selected bone will be editable.
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If you use the LMB to move the selected bone’s tip, its hierarchy will move along with it. Even though the parent bone’s 
angle and size change the hierarchy, it will maintain its original configuration. If the RMB is used on the selected bone’s 
tip, it will expand along its own length.
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Once you get the selected bone’s tip where you want it you can hit the space bar and all the bones will be moved to the 
correct place. Or if you want to continue using the tool just select Tip Move again. All the bones will be moved and Tip 
Move will stay active.

Entire Contiguous Hierarchy

If the object itself is selected and Tip Move is activated. The tool will be drawn through the entire contiguous hierarchy.

In this mode every joint will be editable instead of just a single bone. But the same rules apply to the child/hierarchy of 
the tip that is being moved. Even though the parent bones’ angle and size change the hierarchy, it will maintain its 
original configuration. If the RMB is used on the selected bones’ tip, it will expand along its own length.

Once you get the selected bones’ tip where you want it, you can hit the space bar and all the bones will be moved to the 
correct place. If you want to continue using the tool just select Tip Move again. All the bones will be moved and Tip 
Move will stay active.

Bone Twist

(default keyboard shortcut Ctrl K) 
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Bone Twist allows you to change the bank rotation of a bone while leaving children of that bone unaffected. If no bones 
are selected, the tool will allow you to go bone to bone and adjust each bone’s bank. When invoked, this tool draws a 
circle around the base of the selected bone in blue, and draws representations of the three axes of the bone (in local 
coordinates). These drawn axes represent the right, up, and forward (x, y, and z) orientation vectors.

When the LMB is held down on the yellow cross and the mouse dragged right, the drawn axes rotate in a positive 
direction, when the mouse is dragged left, rotation is in the negative direction. Rotation is the similar to doing a Rotate 
operation in LightWave’s standard interface, and changing the bank angle by dragging the yellow cross in the blue 
circle.

However, the children of the selected bone will remain in place with Bone Twist. After the mouse button is lifted, hit the 
space bar to actually change the selected bone’s bank angle, or invoke the Bone Twist tool again to have the rotation of 
the bone occur with the tool remaining active.
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Selecting a bone and running Bone Twist will allow you to edit the bone selected and that bone only. Selecting the 
object containing the bones and running Bone Twist will allow you to edit all bones contained in the object. The reason 
for this is to give you the ability to isolate a bone that may be difficult to see when all bones have the tool active.
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Scale Hierarchy

Scale Hierarchy will allow you to scale a hierarchy up or down. This can help you when you import an existing hierarchy 
into a new mesh or if you are reusing pieces of your rig in another part of your object.

Select the object to scale the entire bone structure. If you want to only scale a section, select the parent bone of that 
particular hierarchy. You can also choose to scale targets and goals along with the bones.

Depending on the configuration of the hierarchy you may have to adjust the target and goal positions 
manually.


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Selecting the parent bone of a hierarchy will allow you to scale just that part if needed.

Use the LMB to make coarse changes and the RMB to make fine changes.

In this example the object has been selected so Scale Hierarchy will affect all the bones.



LightWave 2020  –  LightWave 2020

Reference –  2191

1.
2.

If you choose to scale targets and goals. Scale Hierarchy will attempt to move them along with the bones.

Orientation

Align Pitch

Twists the selected bone so that its pitch rotation axis is coplanar with that of its parent.

To use Align Pitch:

Select the child bone whose pitch you want to align with its parent.
Run Align Pitch located under Setup > Modify > Orientation > Align Pitch. Align Pitch will change the bone’s 
rotation and automatically move to the next child bone. This makes it easy to just step down a chain you want to 
align.

Record Pivot Rotation

(default keyboard shortcut Shift P)

(Setup > Modify > Orientation > Record Piv Rot) RPR is used to zero out the current items’ rotation at its current physical 
rotation. Basically it masks the real rotational values and allows LightWave to see H=0, P=0, B=0 after it is set. This can 
help avoid problems with Gimbal Lock.

Ensure that IK is disabled and that Bones are turned off. An easy way to do this is to use Bone Edit Mode. Setup 
> General > Bone Edit: Enter Bone Edit Mode.



This operation cannot be undone. Please save your work before executing the tool.
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Before RPR is applied in this example the bones heading (the red circle) is not aligned with its bone.
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After RPR is applied the bones heading (the red circle) is now aligned with the length of its bone.

Record Bone Rest Position

(default keyboard shortcut R)

Once a bone is placed and keyframed you must set its rest position and activate it. Usually, you will use the keyboard 
shortcut for the Record Bone Rest Position command, which is the lowercase R key. This does two things: records the 
rest position and activates the bone. From then on, any changes to the bone will deform the object.

When you use the Record Bone Rest Position command, LightWave sets the rest position by copying the bone’s current 
position and rotation values to the Rest Position and Rest Direction values (Bones Panel). This creates a point of 
reference, so that if you later move the bone (not the object), it can influence the object’s shape.

If you need to reset the rest position, you may want to deactivate the bone before reapplying the Record Bone Rest 
Position command. Alternatively, you could manually edit the Rest Position and Rest Direction values.

When adjusting a chain of bones individually you’ll need to keyframe each bone (or use Auto Key Create) 
before moving on to the next bone.



All of the Bone Edit tools (Joint Move, Tip Move, Bone Twist) will record the bone’s rest position automatically.
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Remove Pivot Position

Setup > Modify > Orientation > RemovePivotPos will remove Record Pivot Position from the entire rig. When invoked, a 
warning will be displayed. Press OK and RPP will be removed.

Remove RPR

Setup > Modify > Orientation > Remove RPR will remove Record Pivot Rotation from the entire rig. When invoked, a 
warning will be displayed. Press OK and RPR will be removed. The rotational values of the bones that had RPR applied 
will no longer read 0 degrees.
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Detail Group

Click here to expand Table of Contents...
Split Bone
Merge Bones
UnParent Bone

Split Bone

Split bone breaks the selected bone(s) using the interactive Split Bone widget. Clicking and dragging the widget will 
move it along the bone. Simply clicking will create the split.





LightWave 2020  –  LightWave 2020

Reference –  2196

Merge Bones

 

Merges two selected bones, if they have a parent/child relationship.
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The newly created bone will have its base located where the parent’s base was and its tip located where the child’s tip 
was.

The newly created bone’s name will be the original name of the parent.

UnParent Bone

(default keyboard shortcut Ctrl U)

(Setup > Detail > UnParent Bone) The selected bone’s relationship with its parent bone (if there is one) is severed, and it 
is parented to its object. After being “unparented”, the selected bone’s rest position is edited so that it remains in place, 
not moving, with respect to global coordinates.
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Edit Group

Click here to expand Table of Contents...
Copy Hierarchy

Example: Copying a Hierarchy

Mirror Hierarchy
Rename Hierarchy

Name Edit Method

Import RIG
Hierarchy will be parented to:
Browse Rig File:
Import Goals, ItemShapes, Targets
Name Edit Method

Export RIG
What’s Exported?
Root of Hierarchy to Export
Browse Export File:
Description of Rig to Export
Export Goals, ItemShapes, Targets.

Delete
Delete Hierarchy
Delete Bone

Copy Hierarchy

When invoked, the selected bone and all of its children are copied along with goals and targets if you choose. The 
copied hierarchy will appear next to the selected bone but slightly offset. The parent of the newly created copy will be 
the same as the copied bone’s parent.

Root of Hierarchy to Copy - Displays the selected bone that is the root of the hierarchy that you want to copy.


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•

•

1.

Copy Goals, Item Shapes, Targets - Select YES if you want any of these copied and NO if you only want the bones 
in the hierarchy copied.
Name Edit Method -

Add Prefix/Add Suffix - The user interface panel allows you to add a Prefix or Suffix. You can type in your own into 
the Prefix/Suffix to add to Bone Names text box. Or choose one from the Prefix/Suffix to add to Bone Names pop 
up menu.
Replace String - You also can choose to replace an existing text string in the original hierarchy with a new text 
string. Type the string you wish to replace into the Replace this String text box and the string you want to replace 
it with into the With this String text box.

Example: Copying a Hierarchy

Select the root bone of the hierarchy that you want to copy. Run Setup > Edit > Copy Hierarchy and select your 

options and set the Name Edit Method.
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2.

•

The copied hierarchy will be placed right below the original and parented to the same bone as the original.

Mirror Hierarchy

(default keyboard shortcut Ctrl W)

When invoked, the selected bone and all of its children are mirrored about a plane.

Root of the Hierarchy - This displays the selected bone whose hierarchy will be mirrored.
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•

•

•

Mirror Goals, Goal Item Shapes, Mirror Targets - Select YES if you want any of these mirrored along with the 
hierarchy and NO if you only want the bones in the hierarchy copied.
Center - Allows you to add an offset from the center.
Use Major Axis - Two choices are presented:

Use Coord Axis - You can choose this option to mirror across the X, Y or Z axis.

Other - This option will allow you to mirror using compound angles. Every unit you add to each axis adds to the 
angle of the resulting mirror
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•

•

Name Edit Method - Four choices:

Add Prefix/Add Suffix - The user interface panel allows you to add a Prefix or Suffix. You can type in your own into 
the Prefix/Suffix to add to Bone Names text box. Or choose one from the Add Prefix/Suffix to add to Bone Names 
pop up menu.
Replace String - You can also choose to replace an existing text string in the original hierarchy with a new text 
string. Type the string you wish to replace into the Replace this String text box and the string you want to replace 
it with into the With this String text box.
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• None - No user-defined rename.

Rename Hierarchy

When invoked, the selected bone’s hierarchy can be renamed. The options are Add Prefix, Add Suffix, or Replace String.
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•

Name Edit Method

Add Prefix/Add Suffix - The user interface panel allows you to add a Prefix or Suffix. You can type in your own into 
the Prefix/Suffix to add to Bone Names text box. Or choose one from the Prefix/Suffix to add to Bone Names pop 
up menu.
Replace String - You also can choose to replace an existing text string in the original hierarchy with a new text 
string. Type the string you wish to replace into the Replace this String text box and the string you want to replace 
it with into the With this String text box.

Import RIG

(default keyboard shortcut Shift I)

(Setup > Edit > Import RIG) Import RIG will read files saved in the RIG file format (See the RIG SDK for more information) 
and load them into LightWave.

Hierarchy will be parented to:

Displays the bone or item that the imported hierarchy will become a child of.

Browse Rig File:

This will open a file requester so you can navigate to the location of the RIG file that you want to import.

Import Goals, ItemShapes, Targets

Select YES if you want to import goals and targets along with the bones.
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•

1.

Name Edit Method

Add Prefix/AddSuffix - The user interface panel allows you to add a Prefix or Suffix. You can type in your own into 
the Prefix/Suffix to add to Bone Names text box. Or choose one from the Prefix/Suffix to add to Bone Names pop 
up menu.
Replace String - You can also choose to replace an existing text string in the original hierarchy with a new text 
string. Type the string you wish to replace into the Replace this String text box and the string you want to replace 
it with into the With this String text box. To use Import RIG to import a hierarchy:

Select the bone or object you wish to import to be parented to and run Setup > Edit > I mport RIG. 
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2.
3.
4.

5.

6.

Browse to the folder that contains the RIG file you want to use.
Select the import options.
Click OK.

The RIG information dialog will pop up. Press OK.

The arm has been imported along with IK and custom object and parented to the selected bone.

Just enable IK and it will work.

Export RIG

(default keyboard shortcut Shift J)

(Setup > Edit > Export RIG) With Export RIG (hierarchy) you can select a parent bone of a hierarchy or an object 
containing a hierarchy and export it for future use in another mesh. You can export goals, targets and keep the custom 
item’ shapes that may have been added.

What’s Exported?

Most settings applied to the hierarchy will be exported. IK settings and other properties will go along with the RIG file. 
See the note below for limitations.

The motion modifiers that make up many of the rigs used right now are not supported, but will be very soon. A new 
scheme to allow plugins to communicate and share their settings data will be added. The first to have this done is the 

There are limitations to what can be exported from the rig.
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1.

ItemShape plugin that allows you to customise the way Nulls and other objects are displayed. This allows the RIG file 
format to read the data directly from the plugin. As the other plugins add this feature, the RIG file format will be able to 
export and import ALL items and settings used in rigging a character.

Root of Hierarchy to Export

Displays the parent or root of the hierarchy to be exported.

Browse Export File:

This will open a file requester so you can choose a place to save your export.

Description of Rig to Export

Enter a useful description about the export so you will know what you have when you import this file back into 
LightWave.

Export Goals, ItemShapes, Targets.

Select YES if you want to export goals and targets along with the bones. To export a hierarchy from a selected bone:

Select the bone that is the parent of the hierarchy you wish to export.
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2. Run Setup > Edit > Export RIG and the dialog box will appear.
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3.

4.

•
•

•
•

Browse to the folder you wish to export to and choose the settings.

Click OK.

Delete

Delete Hierarchy

(Setup > Edit > Delete > Delete Hierarchy).

When invoked, the selected bone and all of its children and grandchildren, etc. are deleted, leaving all other bones in 
place.

Delete Bone

Delete Bone will delete the selected bone without causing the remaining bone to move.

Bone To Delete - Displays the name of the selected bone.
Parent Child Bones -

to Deleted’s Parent - Will parent the remaining bones (if there are any) to the deleted bone’s parent.
to Object - Will parent the remaining bones (if there are any) to the object.
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This operation cannot be undone.
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Motions Group

Motion Options

Record Minimum/Maximum Joint Angles

You can interactively set the rotational Min and Max values by rotating the item to the desired minimum direction and 
choosing Setup > Motions > Limits > Record Minimum Joint Angles (default keyboard shortcut: (). This will activate 
minimum limits for any rotational parameters (heading, pitch, or bank) that are currently active for the chosen item. 
Similarly, rotating the item to the desired maximum range limit and choosing Setup > Motions > Limits > Record 
Maximum Joint Angles (default keyboard shortcut: )) will automatically input the values into the maximum limits for the 
active rotational parameters.

You should deactivate Heading, Pitch, and/or Bank to avoid setting limits for channels you don't wish to.
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1.

2.

Assignments

Assignments allows you to quickly Target, Parent, Goal, Pole, Spline Control, Position, Rotation or Scale a number of 
items in your scene. It works by first choosing an item to be the recipient of the above actions, and then selecting other 
items you wish to perform the action. It’s perhaps easiest to demonstrate with a small example.

Add a null to a new scene. This is going to be our target, parent, etc. In Setup > Assignments hit Store Selected.

Select the light in our new scene and clone it nine times. Spread out the lights, perhaps using the Distribute tool. 
Click on the Assign... dropdown and choose an assignment, or you can use the Assign UI . Choose Target as our 
first example. All your lights should point at the null.
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3. Using Undo won’t help here if you clicked on something other than Target, but you can clear individual Assigns, 
or all in one go using the Clear... dropdown or Clear UI .
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Animation

Motion Options

Translate Group

Rotate Group

Transform Group

DopeTrack

Keyframer

Example - Baking Simulations



LightWave 2020  –  LightWave 2020

Reference –  2216

Translate Group

Move

(default keyboard shortcut T)

When you move an (unparented and unrotated) item in Layout, generally your mouse movements have the following 
effects:

Movement Move

Left/Right LMB Left/Right

Up/Down LMB Fwd/Back (3D*), Up/Dn (orthogonal)

Up/Down RMB Up/Down

*3D = Perspective, Light, and Camera views

You generally use a viewport’s arbitrary horizontal and vertical axes to adjust an item’s position (Move tool). As such, no 
matter how much you have rotated a Perspective view, dragging your mouse left or right will always move the item left 
or right on your display. Dragging your LMB left/right in the Right view would move an object along the Z axis. The same 
mouse movement in the Back view would move it along the X axis.

Local Axis Adjustments

Sometimes you may want to move an item using its local axes instead. You can do this by simply holding the Ctrl key as 
you drag. The movement will be along the object’s local axis, no matter what view you use (or how much you rotate the 
item).

For parented and rotated items, see also the subsequent discussion on Coordinate System.
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1.

Movement (Ctrl) Move

Left/Right LMB X axis

Up/Down LMB Z axis

Left/Right RMB Y axis

The pivot point is a point of reference used for all objects and does not correspond to any point used in an object’s 
geometry. The pivot point is the center of position, rotation, and scaling. By default, it is located at the object’s local 
Origin. The pivot point, a small yellow star, becomes visible when you select an object.

Pivot Point (Shown selected with handles)

Moving the Pivot Point

You can modify the pivot point from its default position in Layout or Modeler. Think of this as giving an offset amount 
from the object’s local Origin. When you move the pivot point, the object will appear to stay in the same position. On 
the face of it, this might seem confusing to you; if the pivot point is the point used to reference position, the object 
should move if the pivot point is moved. The reason the object doesn’t move is because LightWave automatically 
adjusts the object’s position by the same amount the pivot point is moved.To move the pivot point in Modeler:

Select View > Pivot to activate the Pivot Point tool and move the crosshairs to a new position in any viewport.

To move the pivot point in Layout:

Select the object.

Understanding pivot points is fundamental to understanding LightWave.

You cannot animate the pivot point.

This wiki has additional info about moving the pivot point in the Pivot Group section.
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1.

1.

Select Modify > Translate > Move Pivot.

Move the pivot point as you would any item in the Layout. (If you select the Move tool and look at the object’s 
Position settings, you will see that they have been changed to compensate for the movement in the pivot point - 
the object will not visibly move.)

Layout or Modeler

Setting the pivot point in Modeler saves its position in the object file. Setting it in Layout only saves the data in the 
scene file. As such, it is usually best to set your pivot point position in Modeler.

Why Move the Pivot Point?

You might be wondering why you might want to move the pivot point. Why not just model all objects so that the Origin 
is the desired center of rotation? Well, you certainly could do this and should probably try to do this as much as 
possible. However, there are often circumstances when multiple objects are just parts of a larger element. You want the 
individual parts to be positioned in their respective locations by default. But you may want to rotate them individually, 
around their own center point.

Let’s take puzzle pieces for example, where all of the pieces fly in to form the complete puzzle. If you modeled each 
piece centered around the Origin, it would be a real pain to move each piece perfectly into its final resting place. It 
would be much easier to load each piece by default at its resting position and then set arbitrary starting positions and 
rotations. To do the latter, you need to move the pivot points to the center of each piece. A robot is another good 
example. The arms, legs, feet, torso, etc., are all separate objects, each modeled in their natural resting position in 
Modeler. However, all parts must be rotatable around a unique axis. This is possible only by moving the pivot points of 
each object.

We strongly suggest that you leave an object at its default rotation and scale before you move its pivot point in 
Layout or you may get unpredictable results.


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Pivot Point moved so that rotation is at the Knee.

Move Path

You can move an item’s entire motion path directly in a viewport using the Move Path tool (Modify > Translate > Move 
Path).
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Path Tool

(default keyboard shortcut Ctrl Y)

The Path Tool (Modify > Translate > Path Tool) will allow you to directly edit the current item’s motion path, right in a 
Layout viewport. To use, simply activate the Path tool and drag any of the current item’s keys. The perfect tool for 
tweaking an item’s motion path.
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Green Handles on motion path represent each Keyframe.

Add to Position

You can numerically add to Position values by using Add to Position (Modify > Add to Position). It works like editing the 
Position input fields in the lower-left corner of Layout, but adds to the existing values instead of replacing them.

The key will only move along the vertical and horizontal axes of the view, even in perspective.
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Rotate Group

Rotate

(default keyboard shortcut Y)

When you adjust rotation, in contrast to adjusting position, the action is relative to the global axes around the item’s 
pivot point. By default, the pivot point is at the item’s local Origin.

Rotation uses a similar three-coordinate system: Heading, Pitch, and Bank. (These are rotations around each of the 
axes: Y, X, and Z, respectively.) You can think of heading as the movement in shaking your head “no.” Pitch is like the 
movement in shaking your head “yes.” Bank is like the movement of tilting your head left and right, saying “maybe”.

Heading, Pitch, Bank

When you rotate an item, your mouse movements have the following effects:

Movement Rotate

Left/Right LMB Heading Left/Right

Up/Down LMB Pitch Up/Down

Left/Right RMB Bank Up/Down

Rotate Pivot

Understanding pivot points is fundamental to understanding LightWave.
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The pivot point is a point of reference used for all objects and does not correspond to any point used in an object’s 
geometry. The pivot point is the center of position, rotation, and scaling. By default, it is located at the object’s local 
Origin. The pivot point, a small yellow star, becomes visible when you select an object.

Pivot Point (Shown selected with handles)  

Rotating the Pivot Point

You can rotate the pivot point, which sets a starting point for rotation that is different from the default rotation, which is 
in alignment with world coordinates.

If you have rotated an object and wish to transfer its current rotational state to the pivot rotation, choose Setup > 
Orientation > Record Pivot Rotation, which runs the Record Pivot Rotation command. Then you can start all over as far 
as rotating the item is concerned. It will add the rotations to any existing values for pivot rotation.

Add to Rotation

You can numerically add to Rotation values by using Add to Rotation (Modify > Rotate > Add to Rotation). It works like 
editing the input fields in the lower-left corner of Layout, but adds to the existing values instead of replacing them.

You cannot animate the pivot point.

Pivot rotation is most useful when used with bones. You may want to stick with normal item rotation for other 
rotational needs.



Unlike the Move Pivot tool, which changes the position values, when you use the Rotate Pivot tool, it does not 
compensate with changes to rotation values.


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Transform Group

Size

(default keyboard shortcut Shift H)

You can scale an object (but not Distant lights, Point lights, Spotlights or cameras) using the Size tool (Modify > 
Transform > Size). Size scales your object proportionately along all axes around its pivot point.

When you Size an object, it is scaled equally along all axes. Dragging left will make it smaller and dragging right will 
make it bigger.

Stretch

(default keyboard shortcut H)

You can Stretch an object (but not Distant lights, Point lights, Spotlights or cameras) using the Stretch function (Modify
> Transform > Stretch). Stretch lets you scale each axis of an object independently around its pivot point.

When you Stretch an object, your mouse movements affect the following axes:

Movement Stretch

Left/Right LMB X axis

Up/Down LMB Z axis

Left/Right RMB Y axis

Linear and Area Lights can be Scaled.

Linear and Area Lights can be stretched. Increased size for these types of lights also changes the softness of 
shadows.


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Squash

The Squash tool (Modify > Transform > Squash) is similar to the Stretch tool; however, when one of the scale channels is 
modified, the other two channels are automatically adjusted to preserve the object’s volume. Squash lets you scale 
each axis of an object independently around its pivot point.

 

Use the handles shown to perform a squash operation.

Add to Scale

You can numerically add to Scale values by using Add to Scale (Modify > Transform > Add to Scale). It works like editing 
the input fields in the lower-left corner of Layout, but adds to the existing values instead of replacing them.

Linear and Area Lights can be squashed.
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DopeTrack

Click here to expand Table of Contents...
DopeTrack
Baking

Soft Apply
Linear Apply
Flat Apply
DopeTrack Apply Zones

Snap Keys
Cut, Copy, Paste Keys
Add and Delete Keys

Channel-edit Mode

Multiselect Copy/Paste keys in DopeTrack

DopeTrack

Just above the time slider that shows all the frames in a LightWave scene there is a thick bar. Clicking on this seems to 
open a new time slider, it’s actually a tool called the DopeTrack, to help the workflow of animators.

The DopeTrack allows you to play with keys. Not only their position in time and the scene, but also to alter their 
properties. You can set up markers here to tell you when things should happen in the scene and bake ranges of keys to 
set your animation from frame to frame.

You’ll notice that when the DopeTrack is closed and your mouse pointer is over the thick bar, your mouse pointer will 
change from being a cross hair to an arrow pointing upwards. When DopeTrack is open and the mouse is over the thick 
bar, it will be a downwards-pointing arrow.

What’s the point of DopeTrack? Let’s say you have an animation and there’s a keyframe at frame 13 that you really want 
at frame 12. You could open the Graph Editor and move the keys there. If you have a lot of items in your scene, it may 
take a while to find the object you want to edit.

Let’s say you’ve moved this frame, but then your boss decides he wants an identical keyframe a bit later in the 
animation – say ten frames on. Then, being the indecisive management type he is, he wants to have those two 
keyframes moved along a bit in the animation. You could do this in the Graph Editor, but instead, you can just sit there 
nonchalantly, with a breezy “no problem, boss!”, and just use the DopeTrack…


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From left to right these animations show: Move a keyframe by first swiping over it with the LMB to highlight, then drag it to 
where you want. To delete one or more keys, select it/them and hit RMB and choose Delete Key. To copy a key or keys, 
select them, hit the RMB and choose Copy. Move the playhead to where you want to paste. The second method copies 
selected keys by holding down Alt and dragging the keys where you want them.

When you first open the DopeTrack it just looks like another timeline. The difference is that you can grab any keys on 
the DopeTrack and shift them about. Moreover you can grab a section of the timeline and any keyframes in that area 
will be selected. You will then be able to move all the selected keyframes at once. By default, the lines representing the 
keys are simple pale yellow lines, but if you click the right mouse button over the DopeTrack, a menu will pop-up where 
you can enter Channel Edit Mode, where the three channels that make up a keyframes X, Y and Z coordinates are 
represented by the red, green and blue lines. If you are in Rotate Mode the red, green and blue represent the Heading, 
Pitch and Bank channels. If you turn off some of the channels over on the left, you can then select just the channels you 
wish to move.If this were all DopeTrack could do, it would be enough, but there’s more. A right click on the DopeTrack 
itself will reveal a menu that gives even more options.
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Select All Keys - Selects all the keyframes visible on the timeline
Clear Selection - Deselects all selected keyframes
Add Marker - This adds a marker to your timeline that is visible no matter which item you have selected in the 
scene. You can also set a text that appears in the normal info window under the timeline. You can select this 
menu item, or you can hold down the Shift key and double click to set a marker. You can set a marker anywhere 
on the DopeTrack, regardless of the location of the timeline cursor.
Delete Marker - Position the timeline cursor on a marker and this option becomes available.
Clear All Markers - Clears all the Markers you have placed on the DopeTrack.
Set Marker Text… - Put your timeline cursor on a marker and it will become bright yellow and this menu item 
will become available. A marker is visible whichever item you select - it is based on the scene rather than an 
individual item. Whenever the time slider is on the frame where a marker is placed, and the DopeTrack is open, 
the marker will light up in bright yellow and the Marker text will appear in the status window. There is a limit of 
62 characters visible in this status window, although there is no limit on the quantity of characters you can put in 
the Set Marker Text… window.

Baking

If you right click and drag a selection on the DopeTrack this menu option will become available to you. Baking allows 
you to generate keyframes at every frame over the region you specify, to make sure of your animation or for export to 
another package.
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You can set a local or global bake zone. A local one bakes the current item and is shown in the same color as the 
keyframe markers on the DopeTrack, whereas a global bake zone will bake all items through those keyframes and is 
shown in blue. You can resize a bake zone by dragging the arrows at either end of it to make it shorter or longer, or 
move it in time by dragging on the line between them.

You can also hold down the Alt key and LMB drag on the time line and this will create a local bake zone immediately. 
There will be no need to even use the menu to set it.

Either way, when you have selected a zone to bake, the next thing is to know exactly what “baking” means. It means 
that you will create a keyframe at every frame in the zone you’ve selected. This sets in concrete your motion path, which 
can be useful if you have something precise to follow, or you need to export your motion to another application, like a 
game engine, for instance. Game engines don’t usually like IK, so by baking the motion your character goes through; 
you can replicate the effects of using inverse kinematics, without actually using it.

We now have our baked keys, let’s move onto the Apply sub-menus. All three Apply sub-menus use the first and last 
keyframe in a range as boundaries, and the keyframe that the slider is currently sitting on as a control point. The slider 
should be sitting inside the baked range.

If you have local bake zone(s) marked, but want to clear them, you can choose Clear Current Zone from the 
Baking sub-menu by right clicking on the DopeTrack again. Clear All Zones will remove both local and global 
zones.


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Baking a section of our animation. First a baking zone is set with Alt-LMB; then the zone is baked. We can still alter the 
shape of the baked animation by choosing an Apply method - Soft, Linear or Flat. The "Applys" are based on where the 
frame head is.

Now, here’s the scene with the various “Applies” applied. Remember the shape that results depends on the position of 
the frame slider. For demonstration purposes we will continue to leave ours on 42, even if the results could be more 
dramatic with it elsewhere. Also to be noted is that if you don’t like the results of a particular Apply, you can change it 
for one of the others with no penalty.

Soft Apply

In the case of Soft Apply, a Hermite spline using default Hermite co-efficients is generated using these three keyframes 
as points to smooth out the intervening keyframes. We baked the Y Channel.

However, you can’t go back to the previous unapplied state, so make sure you save your scene before you use 
Apply, then you can use File > Revert Scene to Last Saved


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Linear Apply

Linear Apply uses the same keyframes, but simply "increments" the keyframe values between the control points. We 
baked the Y Channel. Note the break in the slope of the baked keyframes. It is centered on where the playhead is.

Flat Apply

Snaps all intervening keyframes to the value of the control keyframe (the one the slider is currently on). We baked the Y 
Channel.
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DopeTrack Apply Zones

The Apply Zones in Dope Track use a CMY (Cyan , Magenta, Yellow) color scheme.

Local Zones are represented with Cyan. Global Zones are represented with Magenta. Proxy Zones, such as IK Booster , 
are represented in Yellow in this montage image (Normally you can only have the first two or the last one at a time).

Snap Keys

If you have received a scene that uses fractional frames, but you don’t want to use all or part of those keys, you can 
select the keys that are off-integer frame numbers that you wish to adjust, and use Snap Keys to quantise them to the 
nearest whole frame number.

Cut, Copy, Paste Keys

As you might expect, these allow you to move keys around the scene by cutting or copying them from where they are, 
and pasting them where you want them. If a group of keys are selected and you copy them, you will paste them starting 
at the time slider position.

To get rid of a set of baked keyframes, select them all by wiping over them using the left mouse button to 
select them all and then click the right mouse button to access the Delete Keys menu item - the Del key will 
bring up the Delete Keys window that will force you to delete the keys one by one.


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Add and Delete Keys

The Add function will create a keyframe in the DopeTrack where the mouse is at the time, so if you have an item at 
frame 10 in the scene and you Add key at frame 40, it will duplicate your object’s position from frame 10 at frame 40.

Channel-edit Mode

By default, the keyframe marks in DopeTrack are the same shade of yellow as the keyframes in the normal time slider. 
By switching to Channel-edit Mode you can choose individual channels by turning off the ones you do not wish to select 
in the bottom left-hand corner of the Layout window. When you switch back to Keyframe edit mode, any channels you 
have separated in time will become new keyframe lines in their own right.

Once you’ve shifted the channels separately, new keys appear in the normal timeline.

Turn off individual channels to move the remaining keys where you want them.

You can combine the keyboard and mouse to make DopeTrack even easier to use:

Alt LMB copies a keyframe
LMB doubleclick creates a keyframe
Shift LMB doubleclick creates a marker
Alt LMB Drag creates a local zone for baking

Multiselect Copy/Paste keys in DopeTrack

The Dopetrack clipboard was designed to contain channel information for only a single object. It has been re-factored 
to contain copied channel information for as many objects as are selected within the current edit mode. Clipboard data 
can be subsequently pasted on to multiple selected objects, as long as the clipboard data lasts (i.e., which ever is 
exhausted first: selected objects or clipboard data).

It should be noted that clipboard data is not cognizant of the edit mode that was active when it was stored. This means 
that, for example, data copied during a position edit can subsequently be pasted into the rotation channels of selected 
objects if the edit mode is changed, whether intentionally or not.
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Keyframer

Keyframer

Keyframer is essentially a collection of keyframing utilities. Its functions can be applied to currently selected items or 
defined by an external text file. You can even save and load frame and motion data.

To use Keyframer, choose Utilities > Plugins > Additional > Keyframer. The functions are divided into three different tabs 
on the panel: Standard, Transfer, and Other.

What is affected

When you choose certain functions, the Select Range and Objects Panel will appear. Here, you set which range of 
frames, scene items, and channels to affect. All operations only modify items listed in the Affected Channels and 
Affected Objects lists.

The Start and End values define the range of frames that will be affected.

Affected Channels

The Affected Channels list shows all of the channels that will be affected by operations. You may remove a channel by 
selecting it with your mouse and then clicking the Remove button.

If you click the Save button, you can save the list of Affected Channels into a text file. You should use the file extension 
“.lw_channels”. The file contains just a straight list of the channels, like:

Position.X
Position.Y
Position.Z
Rotation.H
Rotation.P
Rotation.B
Scale.X
Scale.Y
Scale.Z

You may replace the list of Affected Channels with the channels listed in a text file using the Load button.

Clicking the Default button returns the list of Affected Channels to the default ones.

Affected Objects

The Affected Objects list will default to the currently selected item(s) in Layout. You can list all scene items by clicking 
the All button.

If you click the Save button, you can save the list of Affected Objects into a text file. You should use the file extension 
“.lw_items”. It will be just a straight list of the scene items, like:

Null (1)
Null (2)
Light
Camera



LightWave 2020  –  LightWave 2020

Reference –  2238

You may replace the list of Affected Objects with the scene items listed in a text file using the Load button.

The Use selected objects only option, will cause the list to only show the item(s) currently selected in Layout.

The Include all subchildren option will cause all children of the listed items to be shown.If Use custom loaded is 
enabled, all of the items in the Affected Objects list will be affected. Otherwise the list is always dynamically determined 
by what is selected in Layout, what the children are, and so on.

Standard Tab

Choose Cycle (Bake) Keys - Keys within the range are copied and pasted after the End frame plus the Cycle Gap. The 
copy is repeated by the number times set with the Repeats slider.

Destroy Keys - Keys within the range are deleted.

Defractionalize - Fractional keys within the range are rounded to the nearest integer value.Create Random Keys - 
Creates new randomly spaced keyframes between the Start to End range. The animation curve “should” maintain its 
shape, if possible.

Random/Jitter Keys - This adds “noise” (i.e., jitter) to existing keyframes between the Start to End range.

MoveRotateScale - Modifies the position, rotation, and/or scale of items. If the Add method is used, the entered value is 
added to existing key values. If Multiply is used, the existing key values are multiplied by the entered value(be careful 
using 0!). The Overwrite method replaces existing key values with the entered values.



LightWave 2020  –  LightWave 2020

Reference –  2239

Transfer Tab

Node-to-Node Frame Copy - Copies the Position, Rotation, and/or Scale of the Source to the Target at the current 
frame. If the Use World co-ordinate Copy option is enabled, the target will take on the “world space” values of the 
source (i.e., not the local values). Note that you will still need to create a key with the copied values.

Node-to-Node Motion Copy - Copies the entire motion of the Source to the Target. (This is the same as saving and 
loading a motion file.) If All descendants is enabled, all descendants of both the Source and Target will be used and 
modified. If you are using All descendants, the Source and Target hierarchies should be identical or results will be 
unpredictable.

Load Single Frame data - Use this function to load the motion data saved with the Save Single Frame data function. 
Note that the position and rotation channels are loaded regardless of what appears in the Affected Channels list. Also, it 
will only affect the same item (when the data was saved)-that item must be in the Affected Objects list.

Save Single Frame data - This function will save all of the motion data for the Affected Objects at the current frame. 
Note that the position and rotation channels are saved regardless of what appears in the Affected Channels list. The file 
should be saved with the “.lw_frame” filename extension.

Load Clip data - Use this function to load the motion data saved with the Save Clip data function. Use the Start and End 
sliders to trim data. Regardless of the Start and End, the range is always copied in starting at frame 0. Note that the item 
must have the same name as the item used to save the data.

Save Clip data - This function will save all of the motion data for the Affected Objects for a defined range of frames. Note 
that all channels are saved regardless of what appears in the Affected Channels list. The files are saved to a directory 
you specify.

Only the data at actual keys within the range is saved. If the start of your range is not a key, the data for the next key (in 
time) is used. Keys retain their position in time even if you don’t save starting from frame 0.
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Other Tab

Dissolve - This function adds keys to the Object Dissolve channel (Object Properties, Render Tab). The object will be 
100% dissolved at the Start frame up until the End frame, where it becomes 0% dissolved.

UnDissolve - This function is the opposite of Dissolve, described above.Key All Morphs - Sets keys in every MorphMixer 
channel at the current frame for items with MorphMixer.

UnKey All Morphs - Deletes keys in every MorphMixer channel at the current frame for items with MorphMixer.Reset All 
Morphs - Sets key values to zero in every MorphMixer channel at the current frame for items with MorphMixer.
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IK Boost
Click here to expand Table of Contents...

IK Boost
Applying IK Booster

Steps for applying IK Booster:
Modes

KeyFrame Mode
KeyFrame Modes

IKB Menu
IKB Menu Options
Bone Dynamics
Global fxIK
IK bind
Commands
Motions
Options

IK Booster and the Dope Track
Right Click Menu
Right Click and Drag Menu
Apply Keys
Record Motion
Dynamics Effect
Bind Motion
IK Booster Track
IK Booster Viewport Controllers
Controller Right Click Menu
Controller Options
Controller Edit
Channel Menu
Graph Edit

IK Booster Link
IK Booster Link Modifier Options

IKB Calculate

IK Boost

(default keyboard shortcut Ctrl-B)



Ryan Roye has kindly shared his excellent guide to IK Boost in our User-Created Tutorials section
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IK Booster (Modify > IK Boost Tool) is an animation system that can work independently from LightWave’s base Inverse 
Kinematics or it can be used  with LightWave’s base IK. With IK Booster applied to an object you can gain access to Bone 
Dynamics and IK Booster character tools.

Applying IK Booster

IK Booster can be applied to an object by adding it to the Custom Object list (Add Custom Object) in the Object 
Properties Panel.

 

You can also add IK Booster to an object using the IK Boost tool (Modify > IK Boost Tool).

Select the IK Boost tool and Right-Click on the object pivot point to bring up the option to Apply IK Booster.
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1.

2.

 

When IK Booster has been applied to an object all the bones in the object and all of the object’s children will be set up 
with IK. Although IK Booster is ideal for character rigs, it can be a powerful tool for mechanical rigs as well.

Steps for applying IK Booster:

Load your object (s) into Layout and either create bones, or convert Skelegons to bones. In the case of a 
segmented object, make sure all parts are parented properly.

Select the IK Boost tool (Modify > IK Boost Tool). Select the IK Boost tool and Right- Click on the object pivot 
point to bring up the option to Apply IK Booster. Select Apply IK Booster to activate IK Booster (IK Booster can 
also be applied in the Object Properties Panel as discussed above.)
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3. Although there are some cases where Step 2 would be the last step before animating, in most cases you will 
want to apply further settings discussed below.

Modes

KeyFrame Mode

IK Booster has several keyframe modes you can choose from the Keyframe Mode drop down menu. If the DopeTrack is 
active, the Keyframe Mode button will be located on the left side of the track.

If the DopeTrack in not active, the Keyframe Mode selection will be located on the left side of the IK Booster track. The 
IK Booster Track is located at the bottom of the viewport windows.
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The Keyframe Mode selector on the IK Booster track doesn’t bring up a drop down menu, instead it toggles between the 
modes as you click on it with the LMB.

KeyFrame Modes

All Item - When this mode is selected, if you create a key on an item, it creates a key for that item and the entire 
hierarchy.
Parent - With Parent mode, if you create a key on an item, it creates a key for that item and every parent up that 
item’s chain.
Child - In Child mode, if you create a key on an item, it creates a key on that item and all of its children.
Parent + Child - In this mode, if you create a key on an item, it creates a key for that item and every parent up 
that item’s chain, and every child down the chain.
Current Item - With Current Item mode, if you create a key on an item, it only creates the key on that item.

IKB Menu

The IK Booster menu has several options to work with. If the DopeTrack is active, the IKB Menu will be located to the 
right of the DopeTrack.

If the DopeTrack is not active, the IKB Menu will be located on the right side of the IK Booster track. The IK Booster Track 
is located at the bottom of the viewport windows.
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IKB Menu Options

Bone Dynamics

This option enables and disables all bone dynamic functions for the object that IK Booster has been applied to.

Global fxIK

IK Booster provides a global IK on/off switch. When this option is active all hierarchies in the object will be solved with 
IK. When this option is not active only the current hierarchy will be solved with IK.

IK bind

IK Booster has the option to “fix” an item, which locks the position of the item’s controller. When IK Bind is active all 
fixed items will stay fixed. When it is not active, items that are fixed will ignore their “fix” setting and will no longer be 
locked to their position.

Commands

Reset Rotation - This command will set the rotational values of the item(s) back to their original value.

re-BakeSpot-all - Any Bake Spot in the scene will be re-baked when this command is selected.

Motions

IK Booster has several motion options to help speed up animating and increase productivity.
Motion Copy - This function will copy the object’s entire motion to the clipboard.
Motion Rollback - This function will paste the last motion that was copied to the clipboard. This will remove any 
work that you have done since the time of copying the motion.
Motion Save - This function will save the entire motion data of the IK Booster object to a text file. This gives you 
the ability to re-use motions from your object on objects that share the same setup.
Motion Load - This function will load an IK Booster motion data file that was previously saved using the Motion 
Save command.

The KeyFrame Mode selected will determine the items affected by Reset Rotation.

Any Bake Spot that was not previously baked will not be affected.
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Options

This brings up the IK Booster Options Panel.

FxIk size - This setting determines the accuracy of the IK solving. The higher the number the less accurate the IK 
solving will be.
Group - you can group Dynamic objects with a user-defined name to prevent unwanted interaction. This also 
works with Particle FX controllers. This becomes very handy when you are working on a complex scene and you 
want certain Wind emitters to only affect certain objects.

<default> Includes all groups.
<new group> Creates individual group. Can associate functions within a group.

Gravity - Setting for downward (-y) gravity. This option only applies to objects that have Bone Dynamics active.

Fix by Collision - This function will fix items that pass through a collision object. This option only applies to 
objects that have Bone Dynamics active.

  You can assign IKBoost settings to a group shared with Particle FX.

–9.8 in the Y is considered the value of earth gravity.  If you are simulating any terrestrial effect, make sure you 
use this value..


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Controller Size - Use this setting to change the size of the controller when it is unselected.

Controller Size: 50mm

Controller Size: 100mm

Size Mode - This setting determines the size of the controller when it is selected.
Size 1 - Smallest selected size.
Size 2 - Medium selected size.
Size 3 - Largest selected size.

Not Change - The selected controller size will be based on Controller Size. The controller size when selected and 
unselected will be the same.

IK Booster and the Dope Track

When the DopeTrack is active while in IK Booster mode, there are two different menus that can be used, the Right Click 
menu, and the Right Click and drag menu. You will also see the Keyframe Mode and IKB Menu buttons that are unique to 
IK Booster discussed earlier.
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Right Click Menu

Right clicking on the dope track will bring up a menu with several functions described below.

Copy key from current - This function will copy a keyframe from the current frame (the frame the time slider is 
at), and paste the keyframe on the frame you right clicked on.
Make Key - This function will create a keyframe at the frame you have right clicked on. If you would like to create 
keyframes for a range of frames, use the Bake Keys function in the Right Click and Drag Menu.

Delete Key - This function will delete the Keyframe at the frame you have right clicked on. If you would like to 
delete a range of frames, use the Delete Keys function in the Right Click and Drag Menu.
Save Pose - This function will save an external file that contains the keyframe data of the IK Booster object for 
the frame you right clicked on.
Load Pose - This function will load a previously saved Pose file on the frame you right clicked on.

Right Click and Drag Menu

Right clicking and dragging to select a desired time range on the Dope Track will bring up a menu with several functions 
described below.

Bake Keys - This function will create keyframes for the selected time range

 
Left: Time Range Selected, Right: After Bake Keys
Delete Keys - This function will delete keyframes in the selected time range.

 
Left: Time Range Selected, Right: After Delete Keys
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Apply Keys

Apply keys is for making overall changes to densely keyframed animation. An example would be for correcting or 
making changes to an existing animation such as motion capture. All three "applies" use the first and last keyframe in a 
range as boundaries, and the keyframe that the slider is currently sitting on (Current Frame) as a control point.

Soft - In the case of “Soft Apply”, a Hermite spline is generated using these keyframes as points to smooth out 
the intervening keyframes. Default Hermite coefficients are used

Linear - “Linear Apply” uses the same keyframes, but simply “increments” the keyframe values between the 
control points.

Flat - “Flat Apply” snaps all intervening keyframes to the value of the control keyframe (the one the slider resides 
on).

Record Motion

This function will record the motion of the selected controller at fixed distance intervals.
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Right Click and drag to select the time range, select Record Motion, and set the options in the Record Motion Panel.

Record Interval - The set distance for each keyframe.
Record Key - Determines what items motion will be recorded using the various Keyframe Modes.

After you set the options for Record Motion, the IK Booster track will display red to show that you are recording. After 
you have moved the controller through the time range the track will return to the default mode.

Set Bakespot - This function will create a Bakespot in the select time range. A Bakespot is a time range in which 
you can bake keys into the desired time range so that they will remain for future operations.

Use the Bakespot Handles to adjust the time range for the bakespot at any time.

Bakespots have a right click drop down menu that gives you the following options:

Bake Keys - This function will create keyframes for the selected bakespot.
Re-bake-All - Any Bake Spot that has been baked in the scene will be re-baked when this command is selected.
Remove Bakespot - Clears the bakespot from the track.

Dynamics Effect

This function will apply dynamic motion to a controller over the selected time range. When this function is selected the 
Dynamic Effect Preview Panel will appear.
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The graph in the preview, displays the motion that will be applied to the controller.The line in the background 
represents one second intervals. This graph gives you a visual representation of the motion that will be applied.

Weight - Defines the weight of the controller. You can achieve heavy motions by increasing the Weight value, 
and you can create light motions by decreasing Weight.
Spring - Controls the springiness or stiffness of the controller. Reducing the Spring coefficient creates soft 
motions, while raising the Spring coefficient produces motions with a stronger repelling force. Setting the 
coefficient to an extremely large value creates stiff motions.
Resistance - Controls the amount of air resistance.

Once applied a keyframe will be placed on every frame in the selected time range.

Bind Motion

This function will bake keyframes for the entire time range based on the keyframe of the first frame in the range.

No calculations are needed when using this function.
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The example above shows bind motion in action. The Time range selected is from frame 36 to 49. When Bind Motion is 
selected every frame in the time range uses the data from Frame 35.

IK Booster Track

If the DopeTrack is not active while in IK Booster mode, the IK Booster Track becomes functional. The Keyframe Mode 
and IKB Menu buttons appear on the track as discussed earlier and all operations for IK Booster that were available on 
the Dope Track are available for the IK Booster Track.

IK Booster Track Time Ranges - The IK Booster track displays time ranges differently then the DopeTrack. The time 
range will be shaded as it is in the Dope Track, but only the first and last frame numbers will be displayed unlike the 
DopeTrack.

Time Range Keyframe Shifting - You can use the IK Booster Track to shift a selected area of keyframes. This function is 
unique to the IK Booster Track and can be very useful.
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IK Booster Frame Marker - Place a frame marker by left clicking on the IK Booster Track. The Frame Marker is the frame 
on the track that marks the frame that the time range ends or begins depending on which side of the marker you click 
and drag in.

Keyframe Origin - This marker shows the original location of the keyframes before any movement has taken place.

Keyframe Move Location - This marker shows where the Keyframe Origin is being moved to.

The Time Range will be shaded to display what area of time is being affected.

IK Booster Viewport Controllers

Once you have applied IK Booster to your object you have many options for displaying and working with the controllers 
that are created for each item. The controllers appear as circles while in Rotate mode and boxes while in Move mode.

To remove the frame marker, simply left click on it.

The items that are affected by Time Range Keyframe Shifting are determined by the Keyframe mode.
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Left clicking and dragging on the controller will allow you to move and rotate the controller freely. You can also left click 
and drag on individual channels to constrain the movement of the controller.

Rotate Mode:

Red - Heading Channel
Green - Pitch Channel
Blue - Bank Channel

Move Mode:

Red - X Channel
Green - Y Channel    
Blue - Z Channel

Controller Right Click Menu

Right clicking on the controller will bring up the controller menu.

Fix - This function will lock a controller in place. The controller will be displayed as a solid circle to indicate that 
it is fixed.
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Ankle Controllers are fixed

IK Stop - This function will make the selected controller the new base of the IK chain, and only controllers farther 
down the chain are affected by any IK operation.The controller will display a diamond shape to indicate that IK 
Stop is active.

A good example of using IK Stop is wagging the tail of a dog. Imagine a string of bones inside a solid dog object, 
extending down its tail. You want the tail to follow the dog as it moves about, but you do not want the dog’s 
body to wag as the tailbones are animated. You activate IK Stop for the bone at the base of the tail to accomplish 
this.

This function is similar to Unaffected by IK of Descendants.

The Shoulder Controller has IK Stop applied.

FK Control - This function will change the controller from Inverse Kinematics to Forward Kinematics (FK). 
Forward kinematics is the standard type of motion generated in LightWave when you rotate/move any parents 
in a chain. The position of the last controller in the chain is determined indirectly by the combination of all 
positions of any parent controller up (i.e., forward) through the chain. (For instance when you move your upper 
arm, your forearm and hand also move with it.)
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File Tools - The options listed below are file management tools for a controller.

Pose Save - This function will save an external file that contains the position of the selected controller for the 
frame you are currently on.
Pose Load - This function will load a previously saved Controller Pose file at the frame you right clicked on.
Motion Save - This function will save the entire motion data for the selected controller to a text file. This gives 
you the ability to re-use motions from the selected controller.
Motion Load - This function will load a controller’s motion data file that was previously saved using the Motion 
Save command.

Controller Options

The Options drop down menu has several functions to work with.

Move/Rotate - This function will toggle the control between Move and Rotate mode.

 
Left: Rotate, Right: Move
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Quaternion - This function will activate quaternion inverse kinematics solving for the selected controller. 
Quaternion IK will help any controller that suffers from gimbal lock and the controller will be displayed with a 
“Q” to indicate that Quaternion is active.

Set IK Target - This function will allow one controller to drive another controller’s motion. In other words, the 
currently selected controller drives the previously selected controller. The controller will be labeled with a “T” to 
indicate that Set IK Target has been applied. Choose Reset IK Target to remove the target setup from the 
controller.

Steps for setting an IK Target:

Select the controller that you want to animate.
Select the controller you want to drive the animation.
Select Set IK Target. The target is setup and ready to go. Use the Target controller to drive the controller 
in step a.

Setting Copy - This function will copy the settings from the previously selected controller. This can be a real time 
saver when setting up controllers on like items. One example would be setting up the left leg and copying the 
settings over to the right leg.
Dynamics Edit - This function will activate Dynamic Edit mode. Dynamic Edit mode allows you to set the dynamic 
properties for your controllers.

 Interesting side note: The quaternions are members of a non-commutative division algebra first invented by 
William Rowan Hamilton.


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To change the values for Weight, Resistance, Spring, and Viscosity, simply left click and drag on the control. Dragging 
left will decrease the value while dragging right will increase the value.

Weight - Defines the weight of the controller. You can achieve heavy motions by increasing the Weight value, and 
you can create light motions by decreasing Weight.
Resistance - Controls the amount of air resistance.
Spring - Controls the springiness or stiffness of the controller. Reducing the Spring coefficient creates soft 
motions, while raising Spring coefficient produces motions with a stronger repelling force. Setting the coefficient 
to an extremely large value creates stiff motions.
Viscosity - Controls the impact of a collision. A controller with a higher Viscosity value tends to keep its shape 
more. If a controller bounces, a higher Viscosity value will have less bounce motion because the Viscosity 
absorbs the bouncing force.

Size - This setting determines the area of influence the controllers have. The image below shows various sizes on 
the controllers that make up the head and torso area of this character.

On/Off - This function will determine whether a controller will be affected by dynamic calculation.
End Edit - This function will take you out of Dynamic Edit mode.
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Controller Edit

This function will activate Controller Edit mode. While in Controller Edit Mode you can freely move the controllers by 
left clicking and dragging them to a location.

 

Left: Before Edit, Right: After Edit

Controller Edit Mode has several options that can be used to customize your Controller settings. Right click to bring up 
the Controller Options menu.

Reset - This function will reset the controllers back to its default setup.
Float /Unfloat - This function toggles the controller between Float and Unfloat.

Bone Dynamics must be active for these settings to be calculated.
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Float - The controller moves along with the item.

 

UnFloat - The item moves but the controller is anchored.

 

Size Mode - This setting determines the size of the controller when it is selected.
Size 1 - Smallest selected size.
Size 2 - Medium selected size.
Size 3 - Largest selected size.

Not Change - The selected controller size will be based on Controller Size. The selected and unselected 
controller size will be the same.
End Edit - This command will exit Controller Edit mode.

Channel Menu

Right clicking on an individual channel will bring up the Channel menu. Each channel can be configured independently.
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Lock/ Unlock - This function will lock and unlock a channel. When it is locked, the number is surrounded with ().

The Controllers Heading Channel is Locked

Set/ Use Limit - This function will limit the channels value range. When a channel has a limit, the number is 
surrounded with <>.

The Controller’s Pitch channel has a limit

Edit Limit - This command brings up the Edit Limits Panel.

You can independently limit heading, pitch, and bank rotations between maximum and minimum values. You 
can prevent actions like bending a leg backwards at the knee (unless you’re animating a sports injury). To use 
the limiting feature, set the Min and Max values on the Edit Limits Panel.

Setting rotation limits can be particularly important when using inverse kinematics. When setting the Min/Max 
Limits, you will see a visual guide in the viewport that represents the limits.

By default the limits are –180 to 180. This is not ideal in most cases so you will want to edit the limits.
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Stiffness - Controls the springiness or stiffness of the limit. Reducing the Stiffness coefficient creates soft 
motions, while raising the Stiffness coefficient produces motions with a stronger repelling force. Setting the 
coefficient to an extremely large value creates stiff motions.
Copy and Paste - Use these commands to copy and paste settings between channels.
Reset Limit - This function sets the maximum and minimum settings of the limit to a present value. When Reset 
Limit is applied, you can edit the Maximun value by holding down the Ctrl key + left click and drag to the value 
that you want the limit to be set at.
Reset Value - This function will set the value of the channel to zero (0). This is very handy when you need to 
quickly set the channels value back to zero.
Add Link - This command will add a Booster Link to the selected channel. The reference controller will be the last 
controller selected.

Graph Edit

This command will launch the Graph Editor with the selected Channel active.

 The maximum value must be greater than the minimum.
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IK Booster Link

IK Booster Link can be used to link a channel from one controller to a channel in another controller. The Linked 
controller can be driven by the referenced control. This is very similar to how expressions can be used without writing 
any expressions.

Remove - This command will remove the Booster Link Modifier from the channel.
Change Shift - This function will adjust the motion of the linked controller at different times during the 
referenced controllers motion. To remove Change Shift from a channel, simply right click on the channel and 
choose Key Control.

Change Item - This function will change the reference controller to the last controller selected. This option can 
be changed in the IK Booster Modifier Panel under the Reference Item drop down menu as well.
Change ch - This command will allow you to change the channel that drives the selected controller. This option 
can be changed in the IK Booster Modifier Panel under the Reference Ch drop down menu as well.
Copy and Paste - These commands will copy and paste Booster Link settings.
Edit Graph - This command will launch the Graph Editor.
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IK Booster Link Modifier Options

Reference Item - This function will change the reference controller. The reference controller is what drives the 
linked controller.
Reference Ch - This command sets the channel of the Reference Item that drives the linked controller.
Shift Frames - Delays the linked motion by the number of frames specified. Entering “5” moves the frames -5, 
and -10 moves it +10.
Source Value - This function sets the percentage between the minimum and maximum value of the referenced 
channel that will be used.
Change Value - This function will change the value of the selected channel.

IKB Calculate

(default keyboard shortcut Ctrl X)

The IKB Calculate operation (Modify > IKB Calculate) is used to calculate IK Booster’s Bone Dynamics and generate 
keyframes based off those calculations. A keyframe will be created on every frame much like motion-capture data.

IK Booster Link will abide by any limits that have been set on the channel that is driving the current controller.

Bone Dynamics need to be properly set up before this will work. Otherwise, clicking it causes an error.

The IKB Calculate button will also calculate dynamic objects as well. For more information about IK Booster 
and Bone Dynamics see the IK Booster section.





LightWave 2020  –  LightWave 2020

Reference –  2266

1.

2.

Spline Displacement

Spline Displacement

The Spline Displacement Tool (Modify >Tools > Spline Disp Ctrl) is a simple way to animate hoses, tentacles, etc. using a 
spline with control handles. This tool will create a spline the length of the object with a user specified amount of control 
points that can be used to deform an object.

To use Spline Displacement

Select the object that you would like to animate with Spline Displacement.

In the Object Properties window, Primitive tab, Modifier section, choose Spline Displacement from the Add 
Modifier Dropdown menu.

Spline Displacement is not a new tool. It used to be called SplineControl
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3.

4.

5.

Double-click Spline Displacement to open its interface.

Choose how many Control Points you want (you can change this later, but doing so might lose any animation 
set). The slider will set a minimum of 5 and a maximum of 256, but a minimum of 3 can be typed if desired.
Use the Spline Displacement button (Modify > Spline Disp Ctrl) to activate and move the nodes around.
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Spline Displacement Options

Control Points - This field will determine the number of control handles that will be generated.

Use Object CPs - Uses nulls with the names given in Object Name Prefix placed in scene as control points for the 
spline displacement
Object Name Prefix - Prefix for naming nulls for spline displacement

Each control point will be numbered starting from 0. This number will appear in OpenGL.
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Object Axis - Defines the axis the control spline will be drawn on.
Auto Key Create - Similar to Layout’s standard Auto Key in that it will automatically create a keyframe as you 
move a control point. The only difference is that it will always create when on frame zero regardless of whether 
or not this option is active.
Create Key - When Auto Key Create is not active use this to create a keyframe.

Set Rest Shape - Use this to change the default rest position of the control points in relationship to the object.
Reset - This function works like undo, however instead of just undoing the last move it will reset all control 
points to their rest position.
Allow Stretch - When this option is activated the object is able to be stretched past its original scale.

Spline Displacement can use other objects as controllers for the displacement. Here we look at moving 
our bar with null objects.

Example



Hitting Enter on the keyboard will not set a keyframe for a control point.
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Left: Allow Stretch OFF, Right: Allow Stretch ON

Scale by Weight Map - This option will use the Weight Map selected and only deform that area of the mesh.
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Motion Mixer
Click here to expand Table of Contents...

Steps for using Motion Mixer
Example - Simple Motion Mixer
Motion Properties
Pre and Post Behaviour Options
Weight Curve
Curve Translation
Motion Instancing
TimeWarp Curves
Relative XZ Custom Offset Type
Character Custom Offset Type
Example - Blending Motions with Transitions
Renaming or Replacing Items in Layout
The Track Area
Selection Menu
Actor Menu
Motion Menu
Actor Maps
Editing Motions
Baking Motion
The Channel Editor
Offset Editor
To set an offset:
To remove an offset:

More on X Channels
Key Commands
Additional Notes


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1.
2.

Motion Mixer was designed to bring the same concepts found in non-linear video editing to computer animation. You 
can store, re-use, and adjust motions for entire hierarchies. You can even mix motions together.

Motion Mixer’s “actors” define objects or groups of objects, while “motions” define their animations. The Timeline gives 
you the ability to move, trim and scale motions together. You can add “transitions” to control exactly how motions 
blend together. Creating incredibly complex animations from a library of relatively simple moves is fast and easy, 
bringing exciting possibilities to your LightWave animations. The best way to get comfortable with Motion Mixer is to 
play with a pre-made animation that will give you ideas for more.

Steps for using Motion Mixer

Load the ProtonJack_MM01 scene. You will see a rigged brown dog.
Choose Motion Mixer from the Windows dropdown menu or press the keyboard shortcut F2. The Motion Mixer 
Panel is broken down into four areas, Actors and Motions on the left, and the Timeline and Toolbar buttons on 
the right. Beneath the toolbar is the familiar frame display.
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3.

Beneath the frame display are the Motion Mixer tracks where motions and transitions are placed. There can be 
any number of tracks, each of which can hold any number of motions or transitions.

Press Play in Layout and watch the animation of Jack walking, looking around and running. You’ll notice that the 
movements correspond to the blocks on the timelines. Turn on and off the eyes on each timeline to isolate the 
motions.

Example - Simple Motion Mixer

Create your own Motion Mixer scene

Right-clicking on a motion will open a menu with various options:



LightWave 2020  –  LightWave 2020

Reference –  2275

•
•
•
•
•
•

Add Weight Curve - See Weight Curve
Add TimeWarp Curve - See TimeWarp Curve
Add Pre/Post-Behavior - See Pre and Post Behavior Options
Active - When the checkmark is removed, the motion isn't played
Remove - Removes motion
Properties - See Motion Properties

Motion Properties

A motion’s properties can be edited by right-clicking a motion in the Timeline. The motion can be renamed by simply 
editing the Motion Name field. The Scale field allows the motion’s scale to be modified numerically. Use Local Start 
Frame and Local End Frame to trim the ends of a motion without changing the original data.

A motion uses “behaviours” in the same way that LightWave uses them in the Graph Editor. After you click OK, you will 
see any behaviours added to the appropriate ends of the motion on the Timeline. You can change the length of a 
behaviour by dragging its end handle.

Pre and Post Behaviour Options
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You can add behaviours without going into the Motion Properties window. Right-clicking on the motion will offer Pre 
and Post Behaviours and once those are in place, right-clicking on them will present a menu where you can choose 
between the different options:

Reset - the motion value is reset to zero.
Constant - the values beyond the ends are equal to the first or last keyframe value.
Repeat - the motion repeats from the first to last keyframe.
Oscillate - the motion is mirrored over and over.
Offset Repeat - the motion repeats, but it is offset by the difference between the first and last keyframe values.
Lock - Normally, when you move a motion that has a behaviour, the behaviour will move along with the motion 
and retains its length. However, the Lock option “pins” the start or end frame of a behaviour to the Timeline. 
Dragging the motion will shorten or lengthen the behaviour. Eventually, it will push the behaviour once it has 
reached its minimum length.
Remove - the behaviour will be deleted/removed from the timeline.

Weight Curve

Motions can be assigned a Weight Curve that allow you to specify the influence a Motion has over time. These curves 
have the added benefit of allowing you to weight to any keyframed animation underlying the Motion in Layout. The 
weighting system works on a value of 1.0 indicating full influence and a weight value of 0.0 indicating no influence on 
the final animation. The difference with MotionMixer’s weights is that as the weight approaches 0.0, and if there’s 
underlying animation in Layout, then more of that underlying animation will be mixed into the final value:

Weight Value Motion Influence Layout Influence

1.0 100% 0%

0.75 75% 25%

0.5 50% 50%

0.25 25% 75%

0.0 0% 100%
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If a Motion has no Weight Curve attached then it’s treated as if it has a weight of 1.0. Weights can also be increased 
above 1.0. This is very useful for overlaying other Motions, the higher the weight value you apply the more influence that 
Motion will have over any others at that time (i.e., if you give a Motion a weight of 10.0, it will have ten times more 
influence over another Motion with a value of 1.0). When a Weight Curve has been applied, a small green bar is drawn 
under the Motion on the Timeline. Weight Curves can be added, disabled temporarily and opened in the Graph Editor 
either through the Motion Properties Panel or directly from the Timeline’s context menus (see below).

Curve Translation

Curves for Transitions, TimeWarps & Weights are moved and scaled to match their positions on the Timeline. This 
makes working with the curves far more intuitive; the frame indicator in the Graph Editor now shows the position on the 
curve at the current time.

Motion Instancing

Any number of instances of a Motion can be placed on a Track and each can have their own independent attributes (i.e., 
Item/Channel states, in/out points etc.)

To create an instance of a Motion, select the source Motion from the Motion Menu (this can also be a previously created 
instance) and click Add Motion.Freeing the “source” Motion also removes all instances.

TimeWarp Curves

These can be attached to any Motion (or instance) and allow you to vary the timing of the animation, you can speed up 
or slow down sections, go backwards or freeze time and continue. A small red bar is drawn under the Motion to signify 
that a TimeWarp curve is attached. These can also be temporarily disabled.

Controls to add/remove/disable TimeWarp curves are in the Motion Properties Panel and on the context menus.

Relative XZ Custom Offset Type

This is a hybrid of the normal Relative Offset and the Absolute Offset types. All channels are evaluated as relative offsets 
apart from the Y axis. This allows motions to be blended relatively but retain their Y heights (i.e., you don’t end up with a 
follow-on Motion under the floor or floating above the ground).

Character Custom Offset Type

As the name implies this offset type is specially designed for characters and makes it very simple to align Motions 
automatically. Say you have a Motion where a character turns a corner and ends up facing 90 degrees, you append a 
Motion of a walk in a straight line. MotionMixer can now rotate that Motion so that it continues in the direction that the 
last Motion ended on.

The Adjust Alignment control can be used to modify the calculated rotation value allowing you to fine tune the direction 
your character travels.

The Compensate for Start Angle checkbox allows you to compensate for a Motion that doesn’t travel along the positive 
Z axis. This is very handy for motion capture where motions are often not axis aligned (i.e., in situations where the 
performer runs diagonally to make the best use of the capture area, or probably more commonly, where people don’t 
create their forward motion along the positive Z axis).

To use the Character offset type set any items that control the characters movement (e.g., pelvis bone, IK Goals etc.) to 
CHAR in the Offset Editor (Custom Offset type).
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Example - Blending Motions with Transitions

Create new motions by blending existing ones

Renaming or Replacing Items in Layout

Renaming or replacing an item in Layout that belongs to an Actor will update the Actor and any motions. However, the 
channel names (as seen in the Graph Editor) will not be updated until the scene has been saved and reloaded. This does 
not affect the operation of Motion Mixer, but you should save and reload as soon as it is convenient.

The Track Area

Clicking on the eye icon with your LMB can deactivate each track. When a track has been deactivated, all motions and 
transitions on the track are also disabled. This is useful for isolating a motion on another track, so that it can be worked 
on without the effects of any transitions or blending.

The display can be scrolled horizontally by holding down the Alt key while dragging your LMB on an empty area of the 
display. Scrolling the display vertically can be achieved by using your Up and Down cursor keys.

You can add or remove Tracks by using the RMB on an existing track. Insert Track adds a new track to the Timeline at 
the end of the current list of tracks. Remove Track removes the currently selected track along with any motions on it. 
You can select a track by clicking on it.

Selection Menu

The Selection Menu can be used as shortcuts to select items in Layout.

Actor Menu

The Actor Menu pop-up menu provides methods for working with actors and the items defined within them.
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Add Items - Adds the currently selected items in Layout to the current actor.
Removes Items removes the items selected in Layout, from the current actor. Motion Mixer will no longer 
control these items. This does not clear the item from Layout, however. Clearing an item from your scene will 
also remove it from an Actor.
Scan X Channels - Use to to add Endomorph channels, if Morph Mixer is added to an item after that item has 
been added to an actor. Motion Mixer allows you to mix all of the animation channels belonging to an item. The 
non-transformation channels (i.e., any channel other than Position, Rotation, and Scale) are called “X Channels.” 
Other examples of X Channels are: a light’s RGB color and Intensity channels, a camera’s Zoom Factor, an 
object’s Dissolve channel, and so on.
Add External X Channels - Opens a panel from which can be chosen all scene X Channels.
Free Actor - removes the current actor from memory. All items contained in the actor are removed and all 
motions are freed.
Edit Actor Map - opens the Actor Map Panel.

Motion Menu

The Motion Menu provides methods for working with motions and the items defined within them.

Add Items - Adds the currently selected items in Layout to the current motion. Use this when you need items of 
different types in the same motion.
Remove Items - Removes the currently selected items in Layout from the current motion. Any animation data 
for these items will not be restored.
Load Motions - Loads a motion into the current actor. Motion files have an .hmot file extension and contain data 
for all the items in an animation. If the motion that’s being loaded contains animation data for items that are 
different from those in the current actor, the Motion Mapping Panel will be displayed.
Save Motion - Saves the current motion to disk.
Copy Motion - Creates a copy of the current motion. You will be prompted for a name, after which the motion 
will be added to the Motion List.
Rename Motion - Allows you to change the name of the current motion. This can also be done in the Motion 
Properties Panel.
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• Free Motion - Removes the current motion from memory, all channels are cleared and the motion is removed 
from the actor.

Actor Maps

The Actor Map informs Motion Mixer which channels in an item should be evaluated on playback and while “baking.” By 
default, all channels and all items are active.

Usually, an animation will not use all channels in all items. Having fewer channels active will improve playback 
performance in complex scenes and reduce the amount of keyframe data generated by the baking process. For 
example, in a character bone hierarchy, scaling is unlikely to be used, so these three channels can be deactivated for 
each item. Moreover, often only one item has any positional animation (e.g., the pelvis), so all the other items can have 
their position channels deactivated. Finally, some bones, like an elbow joint, only rotate around one axis, so the other 
two rotation axes can be deactivated.

To toggle the state of an item or channel, click in the column marked On. A check mark in this column indicates that the 
item or channel is active. A Padlock icon indicates that this item or channel is locked (i.e., inactive). This is a global 
setting and overrides any states set in the Channel Editor.

Editing Motions

The Edit Motion button on the toolbar places the currently selected motion back into Layout for editing. All other tracks 
and motions are disabled while this mode is active. Once the motion is in Layout, you can edit the animation as you 
would normally. When you’ve finished making changes, toggle the Edit Motion button off. This will bring up the Edit 
Motion dialog.

Actor Maps are saved and loaded in the LightWave scene file.
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Accept Changes to Motion updates the motion with the changes you made. Discard Changes to Motion does not update 
the motion.

Restore Channels restores any animation that was present in Layout before editing the motion. Keep Channels leaves 
the motion in Layout. This is handy for creating new animations based off an existing motion. Clear Channels clears all 
the channels in Layout associated with the motion’s items. Motions are placed back at the frame/time from where they 
were created and are reset to their original (100%) scale.

Baking Motion

The Bake Range button on the toolbar allows a range of frames to be recorded by evaluating the animation at a 
specified interval. This enables any combination of motions, transitions, and behaviors to be collapsed into a single 
motion that can be loaded back into Motion Mixer or just used in Layout.

The Start Frame, End Frame and Frame Step fields specify the range of frames that will be baked and the frequency of 
the evaluation. Note that Motion Mixer will always create a key on the first and last frames of the range.
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By enabling Create Motion, Motion Mixer will automatically create a new motion from the baked sequence and place it 
in the Motion List. The Motion Name field enables you to specify a name for this new motion. If this is disabled, the 
baked keyframes will be left in Layout, allowing you to perform further editing before creating a motion as described 
earlier.

The current Actor Map determines the items and channels that are baked. If an item or channel is locked, then no new 
keys will be made for it. This is an effective way of reducing the amount of new data created and optimizing the 
resulting motion.

The Channel Editor

The Channel Editor gives you complete control over which motions, items and channels contribute to your animation. 
Open it by clicking Channel Editor on the toolbar.

The panel contains three lists. The list on the left controls the states of the motions that are currently placed on the 
Timeline. Clicking in the left hand On column, toggles the state of each motion. In the center of the panel is the Items 
list. This shows all the items that are controlled by the motion selected in the Motion List. Any or all of these items can 
be enabled or disabled. The list on the right shows the state of the channels for the item currently selected in the Motion 
Items list. If a channel is marked with the [L] symbol, that channel has been locked by an Actor Map and cannot be 
altered here.

The Channel Editor can be used to combine two or more motions together. For example, say you have a character walk 
cycle and a waving animation and you’d like to combine them to create a walking waving animation. First, you’d 
position each motion on the Timeline so that they play at the same time.

Then, open the Channel Editor to edit the state of the items in each motion. In the walk cycle animation, you’d disable 
all the items for the upper body, leaving just the legs animating.

Often a Frame Step of 2 or 3 is accurate enough and much quicker to bake..

Currently, you will need to bake the entire animation sequence, if you intend to render the scene with 
ScreamerNet. Once this is done, remove the Motion Mixer plugin from the scene and save the scene using a 
different name.
Baking does not currently support X Channels.


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For the waving animation, you’d disable all the items relating to the character’s lower body, leaving just the upper body 
animating. Now, when you play back the animation, you’ll see the lower body animation from the walk cycle playing 
along with the upper body animation from the waving animation. The resulting animation can then be baked and saved 
for future use. Other animations could be layered on top of these, providing an easy way to add secondary motion to 
your work.

Offset Editor

By default, Motion Mixer uses an absolute offset when evaluating motions. This means that each motion is evaluated in 
isolation from any other motion on the Timeline. Alternatively, a motion may be offset from another motion. This is 
called a “relative offset.” If you want a motion to continue on from the point at which another motion has finished, you 
can use a relative offset.

To set an offset:

Select the motion on the Timeline that you’d like to set the offset for and click on the Offset Editor button on the 
toolbar.

Select the motion you want to create an offset from the Offset From pop-up menu and the type of offset from the 
Offset Type pop-up menu. Note that you cannot offset a motion from itself.

To remove an offset:

You can remove an offset from a motion either by setting Offset From to (none) or setting the Offset Type to Absolute.

More on X Channels

When you create an actor, or add items to an actor, Motion Mixer looks for any non-transform channels and assigns 
them automatically. If channels are added to an item after it has been added to an actor, Motion Mixer will detect the 
change and add them to the actor. The exception to this is Endomorphs. Endomorph channels will be added to an actor 
automatically only when Morph Mixer has been added before the item was added to the actor. If Morph Mixer is added 
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after that item has been added to an Actor, you must use Scan X Channels in the Actor Menu, which was mentioned 
earlier.

Removing X Channels from an actor is achieved by either using the Remove Items entry in the Actor Menu, clearing the 
item from the scene, or manually removing the MM_ChannelDriver modifier on the Graph Editor.

Custom Offset - when you add this to a Motion, you can choose, on a per item basis, whether to use Absolute or Relative 
offsets. This is very useful for animations containing translation. Just set the translation item(s) to Relative and the rest 
to Absolute. Changing the offset type is done by clicking on the column next to the item name in the Offset Editor list 
box, this will toggle between ABS and REL.

Key Commands

Shift+LMB Click: Add/remove Motions to/from the selection.
Shift+LMB Drag: Moves selected Motions on the Timeline. Drag anywhere other than on a Motion.
Ctrl+Drag: Moves the entire contents of active tracks. Disable a track if you don’t want to move its contents.
Ctrl+RMB Drag: Moves the contents of active tracks that have their start frames after the frame at which the drag 
operation is started.
Ctrl+MMB Drag: Same as Ctrl+RMB Drag, but affects only those Motions that have their end frames before the 
initial click frame.
Timeline can be zoomed by Alt+Ctrl+LMB dragging.The Timeline will pan vertically during a normal Alt+LMB
drag if the mouse is moved up or down more than the height of a track.

Additional Notes

Displacement/HyperVoxel Texture Layer Position, Rotation and Scale envelopes etc. can be used. General 
XChannel support has been improved.
MotionMixer creates a config file (in the same directory as the LightWave configs) to store settings between 
sessions. Colors for Motion & Behaviour bars and the Toolbar are specified here. Other colors will be affected by 
any changes made to the LightWave color scheme.
Scenes containing the same Actor can be imported using Load from Scene, this creates a duplicate 
Actor.Motions on the Timeline that have been made inactive through the Channel Editor cannot be selected or 
moved.
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Ray Cast Geometry

RayCast Node for Motion, Displacements and Instancing

The easiest way to think of the RayCast node is that it makes objects aware of their surroundings. Cars can stick to 
roads, lamps to desks, automatically. The node has the following settings:

In:

Ray Origin - origin of the ray
Ray Direction - direction the ray is traveling
Offset - Offsets the ray origin slightly backwards along the ray direction
Range - How far to look to decide if an intersection occurs

Out:

Distance - How far the ray traveled before hitting something
Intersect - World space point of intersection
Clipped Ray - Full length ray from Ray Origin along the Ray Direction until it hits geometry. If the ray hits nothing 
a zero length ray is generated
Hit Normal - Normal of the hit polygon in world space
Hit Smooth - Smoothed Normal hit
Inside - Checks to see if the ray cast intersects with an odd or even number of polygons and returns true (or 1) 
for an odd number of polygons, false for an even number (or 0). Used to see if the ray origin is inside closed 
geometry - Example.
Object - The item ID
Nearest Point Index - the nearest vertex of the found intersection
Polygon Index - The polygon number hit

Double-clicking on the node gets the following panel:
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Most of the time, the only thing that needs to be checked is the object that is being raycast onto. In our example below 
it would be the Ground Plane. More advanced options can be achieved using the other options in the panel or by 
connecting incoming nodes.

Getting Started
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To begin with we’ll use the simplest of examples. Create a new Ground Plane object using Modeler Tools > Create > 
Geometry > Ground Plane. Give it 10 subdivisions in X and Z. Once done, click Modeler Tools > Toggles > Toggle 
Subpatch to make it a subpatch object.

Select the Ground Plane and go into Object Properties with P. On the Primitive  > Geometry tab, double click 
Displacement Map. In the window that opens, change Layer Type to Procedural and hit Use Texture.

Now use Modeler Tools > Create > Geometry > Sphere to make a ball. In this example we just want to show the ball 
reacting to the terrain, not rolling. Check Center on Bottom to move the pivot point to the base of the sphere but accept 
all other defaults, and when the ball is presented move it up to Y = 1 m.
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Go to a Top view and animate the path the ball will take across your bumpy terrain and then switch back to Perspective 
view. If you press Play now the ball will float over the terrain.
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Let’s change that by going into the ball’s Motion Options by pressing M. Click on Add Modifier and choose Nodal Motion 
(01). Double click on the entry and a node editor will open showing two nodes, Input and Nodal Motion. We’re going to 
add a third: Ray Trace > Ray Cast Geometry (02).

The only things that need to be done with this new node are to double click it to set the Ray Cast Object(s) to be used, 
and to connect the Intersect output to the Nodal Motion’s Position input (03). Now press Play again.

Going Further

Perhaps the twisty turny path you have imbued the ball with is trying to avoid obstacles placed on the terrain. We 
thought the same so wanted to place some concrete pillars in the way of our plucky ball. We used the same RayCast 
node to position these pillars on the bumpy terrain.
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Use Modeler Tools > Create > Geometry > Cube to make a single pillar and give it a Height value of 3 m in Y. Don’t forget 
to move your pillar up in the Y so it is above the terrain. Copy the Nodal Motion modifier from the ball’s Motion Options 
and paste it into the pillar’s Motion Options. Now as you drag the pillar about you will see it is stuck to the terrain. Clone 
it a few times and dot them around the terrain for your ball to avoid.

Example - Inside RayCast

The Ray Cast Geometry node can be processor-intensive and your scene playback might stutter particularly if 
the Nodal Motion window is open or you are showing Motion Paths (GL tab in Options). If performance is still 
sluggish with these options disabled, make sure you bake the displacement to an object by using File > Save > 
Save Trans Object.


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Spline Control
How to Create the Spline
Getting Started with Spline Control
Going Further
Modeler Spline for Spline Control
How to View the Spline

How to Tweak the Spline
How to Activate/Deactivate Spline Control on a Per-Channel Basis
Open vs Closed Splines
The Z Position Represents the Distance Traveled Along the Spline
Item Chains
Animate the Nodes of the Spline to Animate an Item Chain

Curve to Spline
Export Spline
Example - Curve to Spline and Spline Instancing

LightWave can animate using a virtual spline. LightWave users familiar with the Animation Path Wind tool will feel 
instantly at home with the way that Spline Control is set up and users transitioning from other 3D software will 
appreciate the flexibility LightWave brings with its virtual splines.

How to Create the Spline

In order to use this tool, the user must create a virtual spline. This is not a new idea for LightWave, since Animation Path 
Wind used a virtual spline back in LightWave v9. To create a virtual spline, the user must parent two or more items to a 
parent item. These child items must also meet the following two conditions: they must be marked “active” with 
checkmarks in the Scene Editor, and they must have no children of their own. Then that parent item must be referenced 
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by the Spline Control setting of at least one other item in the scene. The parent item represents the container for the 
spline, and the child objects will represent the nodes for that spline.

Getting Started with Spline Control

Start with an empty scene.
Add a null object to the scene, and name it “Spline”.
Add two more null objects to the scene, and give them each the name, “node”.
Parent the two node null objects to the Spline null object.
Move node (1) 2 m further away on the Z axis, and node (2) 4 m. Select the Camera and use the keyboard 
shortcut M to open up its Motion panel.

Bones and Joints can serve as the child items that define the nodes of a virtual spline. Unlike Objects, Lights 
and Cameras, however, Bones and Joints default to “inactive” (unchecked in the Scene Editor) when first 
added to a scene. Because Spline Control ignores inactive items in a Spline Control Item’s hierarchy, Bones 
and Joints will not appear to work until they are activated in the Scene Editor. In addition, two or more of 
these active Bone/Joint items must have no children of their own in order for these items to count as the 
nodes of a virtual spline.



When the root of a hierarchy is presented as a Spline Item, Spline Control considers all of the items on that 
hierarchy that have no children of their own. This means that the user can parent items together in order to 
insert puppet controls between the nodes of the virtual spline and the Spline Item that forms the root of the 
hierarchy. An example of how Spline Control only considers “leaf-children” can be found in the “01_Learning” 
section of the example content.



To align the rotations of a virtual spline’s nodes to itself, change the Heading Controller, Pitch Controller and/
or Bank Controller to “Spline Control.” When no specific spline item is specified, the nodes will align their 
rotations to the spline that they themselves describe.


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Spline Control is near the Parent and Target settings. Change this Spline Control setting to Spline.

You have just created a virtual spline that can override the Position and Rotation channels of the Camera. A ribbon will 
be drawn through the two nodes to show you the path of the spline.

Now, select the second node and clone it twice.
Move these clones away from the original null object and from each other. You have just added two more control 
points to this spline.
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Select the Camera (which still refers to the “Spline” null as its Spline Control). While under the influence of Spline 
Control, the Z position of the Camera represents the distance traveled along the spline. In the lower-left-hand 
corner of Layout, enter XYZ values of 0 m, 0 m, 0 m for the Position data.
Scrub to frame 30, enter a Z value of 6 m for the Position data and make a keyframe. If you play from 0 you will 
see the Camera will travel 6 m along the spline. The values shown in the lower-left-hand corner will be the XYZ 
values applied by Spline Control. These are the same XYZ values that will be reported to tools that reference 
motion data, such as Same as Item.
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If the Camera banks unexpectedly, there are two ways to correct it. The first way: Select the Camera. Tap M to 
bring up the Motion Options panel. Go to the Controllers and Limits tab and go to the Rotation tab. Change Bank 
Controller from Spline Control to Keyframes.

The user can then keyframe the bank by hand. However, the alternate way is to try to correct the spline path itself:

Select each node (the child objects that define the nodes of the Spline) and rotate their Heading to align them 
with the path of the spline.
This can help reduce unexpected banking errors as the camera moves along the spline, but it may not be as 
reliable as disabling Spline Control for the Bank Controller.

 Going Further

Included with the LightWave content are a number of scenes that demonstrate very well what Spline Control can do, 
with helping text.

Modeler Spline for Spline Control

You can now use splines created in Modeler as Spline Control splines in Layout. Splines are created in Modeler by laying 
down points and using Ctrl-P to create a spline rather than P to create a polygon. Once saved and sent to Layout, they 

Note that you can also use Spline Control with Instancing for interesting animation possibilities. The process is 
described in the Instancing reference. Genoma also adds Spline Control features described here.


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can be used as a Spline Control spline simply by selecting the items to be on the spline and choosing the Modeler spline 
object as their control.

How to View the Spline

You have the choice of how you would like the spline displayed in the GL section of the Options panel. Here are the 
choices:

When the Spline is not selected and the Curve or Ribbon options are chosen it will be drawn in the object color for the 
Spline object. If the Spline is selected it will appear in the normal LightWave yellow as shown in 3 and 6.

There is an additional option, Show Spline Targets. This links a dotted line back from each node to the parent of the 
whole spline no matter how deep inside the hierarchy it is.

Show Spline Targets and Curve, Ribbon Selected options chosen (Spline is selected)

How to Tweak the Spline

Rotating the Heading and Bank of each node on the virtual spline will affect the bend and twist of the spline.

How to Activate/Deactivate Spline Control on a Per-Channel Basis

Spline Control affects Position and Rotation channels by default. However, these can be disabled on a per-channel basis 
by going to the Controllers and Limits tab of the Motion Options panel and changing Controller options in the Position/
Rotation tabs from Spline Control to Key Frames.

If your spline is complex, it can be laborious to create it in one go. If you need to create a spline in parts, 
selecting the parts and using Merge Polys (Shift-Z) will join the splines.


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Open vs Closed Splines

A spline is open by default. To create a closed-loop spline, select the spline item - that being referenced as the Spline 
Control of another item. Type m to access the Motion Options panel, and go to Controllers and Limits. Activate the 
Closed Spline checkbox to close the spline.

The Z Position Represents the Distance Traveled Along the Spline

Animate the Z Position of an item driven by Spline Control to push that item up or down the spline.

Item Chains

A chain of items refers to a hierarchy where each item is the child of the next item. An example of an item chain would 
be a linked chain of train cars, where the caboose is parented to a boxcar, which in turn is parented to the engine. 
Another example would be the bone chain that represents the spine of a snake or the spine of a Chinese dragon.

To apply Spline Control to an item chain, select all members of the item chain, type m to access the Motion Options
panel, and change the Spline Control item from (none) to the parent item representing the virtual spline. All items in the 
chain will conform to the spline. Animating the Z Position of the root item in the item chain will push/pull the entire 
item chain along the spline.

You do not have to apply Spline Control to an entire hierarchy. For a Chinese dragon, apply Spline Control only to the 
spine bones of the dragon and not to the leg and arm chains. That way you can use Spline Control to animate the spine 
of the dragon and other means (such as FK or IK) to animate the legs, arms, head and jaw of the dragon.

Animate the Nodes of the Spline to Animate an Item Chain

Animate the nodes of the spline to change the shape of the spline. This, in turn, will change the shape of the item chain 
that conforms to the spline.

Curve to Spline

Creating splines in Layout is fine when you are only using a few nulls to make your spline, but if you need hundreds to 
make a complicated path then creating them all with nulls in Layout could be a laborious process. A tool has been 
added to Layout to streamline the creation of such splines. To use it, create a curve in Modeler using whatever method 
you like (Add Points, then Make Open Curve on the Create tab; import an EPS using the Spline Curves option, etc.), save 
it and send it to Layout. In Layout, go to the Setup tab and in the Edit group use Curve to Spline. If you have multiple 
splines in your object you need to split them over several layers since Curve to Spline only works on the first spline in a 
layer. Rather than using nulls, the controls in the spline in Layout are created using bones (specifically Joints), which 
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has two advantages - the Layout object list isn’t filled with nulls needlessly, joints automatically have a pleasing 
“control” shape and can be sized in the viewport using the Options > Display > Handles & Icons settings.

Export Spline

Export Spline is a tool in Setup > Edit to convert Spline Control splines in Layout into Modeler curve objects. Simply 
select the head of a spline object and hit Export Spline and the entire spline will be saved as an LWO that can be further 
edited in Modeler, then reimported to Layout using Curve to Spline again. When reimporting like this, Curve to Spline 
will note that the spline has already been used and intelligently update node positions and quantities as needed rather 
than generating a new spline.

Example - Curve to Spline and Spline Instancing
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Instancing reference
Click here to expand Table of Contents...

Overview of Controls
Instance Generator Name
Add Object Popup Menu
Edit Popup Menu
Instanced Objects List
Generation Tab
Example - Curve to Spline and Spline Instancing
Options Tab
Weight Examples

Instance Transformation Options
Scale Tab
Stretch Tab
Offset Tab
Rotation Tab
Nodes Tab
Instance Generator Node

Hiding Instanced Objects
Example - Randomly surfacing Instances
Example - Monitor Screens
Example - Building a wall with Instances

There are several types of instancing for the user to choose from. Most of these provide additional dedicated controls 
when activated. In addition, each instance type can use the options found under the tabs at the bottom right of the 
panel to control the distribution and range limits of various attributes for instances. Nodes are available to allow for 
varying the surfaces among instances and controlling other attributes as well. First, we will list the types and their 
dedicated controls, then we will cover the controls in the tabs below.



The default Transformation Handling status for new instances is now Local instead of World

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Overview of Controls

Instance Generator Name

You can have multiple Instance Generators attached to an object. The text entry field found at the top left of the panel 
allows you to enter a name for the Instance Generator you’re editing. This is the name that will appear in the Instancer 
list on the Object Properties panel, so that you can tell multiple Instance Generators apart.

Add Object Popup Menu

This lists the objects in the scene, and allows the user to select the objects that will be instanced. When an item is 
selected, it then appears in the Instanced Objects List, just below the two dropdown menus.

Edit Popup Menu

Remove Selected - Removes the selected object from the Instanced Objects Window.
Remove All - Removes all objects from the Instanced Objects Window.
Replace Object - Pops up a list of the objects in the scene, and the user can pick one to replace the object 
currently selected in the Instanced Objects Window.
Add from Layout - Adds selected object or objects to the Instanced Objects Window.
Remove from Layout - Deletes selected object or objects from the Instanced Objects Window.
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Replace From Layout - Swaps one item selected in Layout for one item selected in the Instanced Objects 
Window.
Copy Settings - This copies all the transform settings (Scale, Stretch, Offset, Rotation, and Nodes) for the 
selected instance item now that all instance items in an Instancer can have different values.
Paste Settings - This pastes all the transform settings for an instanced object now that all instance items in an 
Instancer can have different values.

Instanced Objects List

Lists the instanced objects and provides controls for several basic attributes.

Active (Checkmark) - Controls whether an object will be instanced or not.
Instance Color - Selects the OpenGL color for instances of this object.
Visibility - Controls the display of the instances for this object in Layout.

None - Instances are hidden in the viewports (but they are still active)
Point - Instances are displayed as points.
Bounding Box - Instances are displayed as bounding boxes (default option).
Wireframe, Front Face Wireframe, Shaded Solid, Textured Shaded Solid - Displays the mesh of the instanced 
object. This could severely slow down your scene, use with caution.

Transformation Handling - Sets handling of transformations of the instances concerning the source object.

World - When world coordinates are used, the instances will respect any transformational changes made to the 
source item (default option).
Local - When local coordinates are used, the instances ignore any transformational changes made to the source 
item.
Parent - New to 2019, when instancing a PART OF a hierarchy, setting Parent mode ensures the hierarchy 
maintains the relative positions of its elements TO THE HIERARCHY'S PARENT. The root object for the transform 
can be set in the options tab.
Hierarchy (toggle) - Selects whether a hierarchy attached to the source item should also be instanced. By 
default, this toggle is not checked. When checked, the attached hierarchy is also instanced and inherits the 
transforms relative to the parent item.

Item - Name of the object(s) used as an instance source.
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Generation Tab

The controls in this tab are where you set the type of generation for instances. The types are:

Item (Pivot) - Creates an instance at the pivot point of the host object. A usual use case for this would be to use a 
null to create a clone of a scene item - what Clone Instance does.

Points - Creates instances at the points of the host object.

Max Points - Automatic way to set instances to match the number of points in the host object. This setting 
evaluates subdivision geometry, so you’ll always get the full number of instances regardless of display vs render 
subdivisions.
Instances - Set the number of instances to create.

Polygons - Creates instances at the polygons of the host object.

Max Polygons - Automatic way to set instances to match the number of polygons in the host object. This setting 
evaluates subdivision geometry, so you’ll always get the full number of instances regardless of display vs render 
subdivisions.
Instances - Set the number of instances to create.

Particles - Creates instances at the locations of particles (for use with particle emitters only).
Surface - Creates instances on all surfaces or a designated surface of the host object. The host surface must be 
quads or triangles, no n-gons.

Instances - Set the number of instances to create.
Surface Name - Select the surface(s) on which the instances will be placed.
Distribution:

Random - Places the instances randomly on the selected surface(s).
Uniform - Place instances at uniform distances on the selected surface(s).

Relax - (Active when Uniform is selected) You can relax the instance distribution across your object in a series of 
iterative steps that will gradually quantize placement making instances more evenly spread. There are 40 levels 
of relaxation and each one marks an iteration, so setting it immediately to 40 will take some time to show results 
depending on the number of instances to be processed. If the instances overlap, then either too many are being 
packed in or the scale is too high.

 Static - New to 2020 - setting Surface instances to static will stop evaluation at render time. This will 
mainly help with Octane, and other third-party renderers, having to spend significant time doing their own 
evaluation of each frame being rendered. Setting items to static will stop enveloped transforms from occurring 
during the rendering of the scene.

Rectangular Array - Creates instances in a 2D or 3D box-like array.

X, Y and Z Instances - Sets the number of instances to create in each Axis.
X, Y and Z Spacing - Set the spacing of the instances along each Axis.
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 X, Y, and Z Alignment - You can choose to align the array on the negative side (-), centered (0), or 
positive (+)

Radial Array - Creates instances in a 2D circular array on the selected axis around the pivot point of the host 
object.

Instances - Set the number of instances to create.
Axis - Set the axis for the array.
Radius - Set the radius of the array.
Start Angle - Set the starting angle of the array on the circle.
End Angle - Set the ending angle of the array on the circle.
Offset - Sets an offset distance perpendicular to the axis chosen between the instance at the start angle and the 
instance at the end angle. The instances between will be proportionally offset.

Motion Path - Creates instances along the motion path of the host object.

Giving a Null a motion path and then assigning it an Instance Generator allows this chain of Layout-created cubes to 
follow the Null’s motion path with a great deal of control.

Instances - Set the number of instances to create.
Separation - Time in seconds between each instance.
Time Offset - This slips the instances forward and backward along the motion path, and again is in seconds. If 
the value was 1 , then the instances would appear 1 second further along the motion path. Negative values slip 
the instances further back.
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Lock Motion to Time - This makes the instances move along with the motion object. You can use this in 
conjunction with Time Offset to make the instances move along with the object, but further ahead or behind in 
time.
Scale Motion Time - Scales the speed that time passes when Lock Motion to Time is on. For example, 0.5 would 
move the instances at half the speed of the motion object, while 2.0 would move them twice as fast.
Follow Motion Object - Instances are generated from the motion object forward in time, or backward; this 
control determines the behavior. If Follow Motion Object is on, the first instance is generated at the motion 
object’s position and the rest trail backward down the path. Otherwise the instances are generated ahead of the 
motion object with the final instance generated at the motion object’s position.
Separation Jitter - Jitters the Separation randomly so the instances are not uniformly distributed along the path. 
A value of 1 would jitter randomly from 0 to the separation value in either direction.
Offset Frequency - Setting is in seconds; randomly jitters the position of the instances as they move down the 
path, like a simple flocking behavior. The positions change every second of the value of Offset Frequency, so for 
a value of 2 the instances should change position every two seconds.

Use Local Offset - The offset values in the Offset tab can be either applied in world or local coordinates relative to 
the alignment of the instance on the path.
Scale Positions Only - If the motion object is scaled as it moves, the instances can be scaled along with it, or just 
their positions can be scaled, to make them spread out from the path or move towards it.

Spline - Creates instances along a Spline Control spline.

Instances - How many Instances you’d like to place along your spline.
Separation - How far apart you want the instances. The control is disabled if you choose the Distribute checkbox.
Distribute - This control spreads the instanced items evenly along the spline. It ghosts the Separation control 
when used.
Offset - You would use the Offset setting to create an offset from the start of the spline for your instances. If you 
set an Envelope for this setting, you can animation your instances moving along the spline
For Rotation, there are three Alignment options in the Rotation tab:

Spline - World - Uses world coordinates for item rotation
None - no rotation
Spline - Local - uses Spline coordinates for the rotation of the instanced mesh
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Example - Curve to Spline and Spline Instancing

Options Tab

Display Preview - For faster interaction when working with a large number of instances, set the percentage of 
instances to be visible in the viewport. This does not affect final rendering, but will make the UI, OpenGL and VPR 
more responsive by rendering with a lowered amount of instances.
Random Seed - This value is what instancing uses as a base to generate a random number. Changing this will 
vary any settings using ‘random’ values e.g. random scale. Every Instance Generator will have its own unique 
number, but if you wish different instance generators to use the same random state, you can set the same 
number here. Useful if you want items in more than one instance generator to be aligned.
Motion Blur Time Slices - This is a setting for rotations. Low numbers give a segmented look to objects moving in 
an arc, but the default setting of 10 should give a good look in most cases.
Root Object for Transform - Changing this value gives the user the ability to move the instancer up and down a 
scene hierarchy.

Above the transform settings are three controls:

Weight - The weight property can be used for limiting (turning off) the number of instances being shown, despite 
how many instances you have set. It does this by determining an approximate amount of probability of an item 
being shown , using the value you set. You can use a simple value, or the Texture Editor for more advanced 
weighting. This property can also be animated, so you can have instances appear/disappear over time.

Weight Examples

Imagine we have a scene with only one item being instanced across a plane, with the max number of instances set to 
100. At a 100% weight (or probability) it would clearly show all 100 instances. However, this setting can be used to limit 
the number of instances; if we set the weight 50%, you would only see approximately 50 instances, because they have a 
50% chance of being shown. If you count the number of instances in the 50% weight image above, you’ll notice there 

The weight is not the percentage of the maximum number of instances for each item, but is the approximate 
probability as a percentage of that item being shown. Note that this randomness is designed to work with 
large quantities of instances. If you are working with a small number of instances it would be wise to use a 
different method, such as Points or Polygons, if you expect fixed quantities of instances.


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are 53 instances and not 50 as you might expect. To explain why this is the case, we need to add another item into the 
mix.

Two items being instanced at 100% weight will result in 100 total instances, but with each item approximately equal in 
number (both have 100% probability of appearing, so they are approximately equal in number). If we set both items to 
50% weight, they now have 50% probability of being shown, however, we won’t see 100 instances as you might think, 
but 53 as before. This might not make sense at first, but the key word here is probability, so let’s try and explain.

The instancer has been set to have a maximum number of 100 instances. Let’s imagine that number as a list of 100 
‘instance slots’, that are ‘drawn’ in order from 1 to 100 (this is not how it works internally, but will help explain the 

concept).

To achieve a random distribution when we have more than one item to instance, that ‘list of instances’ also needs to be 
filled randomly, so as the instancer draws each ‘slot’ in order, we see the instances scattered in a random fashion rather 
than ordered in groups of each instance item.

 
However, creating a randomly ordered list of items to be instanced is not very efficient, especially when you have the 
potential to have thousands or even millions of instances. This is why the instancer does not work this way. Instead, it 
uses the probability of an instance being shown, or the weight value.

In reality, the instancer goes through the number of instances set, looking at the items in the instancer list and working 
out the probability to be shown for each item at that instance number. It determines this by a random percent value, if 
that value is less than the weight amount for the item, then the instance number it’s on is shown.

Due to this randomness, the probability that an instance will be visible can vary a little, which is why there are 53 
instances in this case and not exactly 50, but doing it this way is much faster than building and storing a pre-determined 
list of random numbers. That is why this method should not be used if instance numbers are low or exact numbers are 
required, since the variance for a small set will be larger proportionately than for a large set — 53 out of 100 is a lot more 
significant than 503 out of 1000 although both examples here have the same +/- 3 variance.

Time Scale - Allows any instanced hierarchies to be animated slower or faster than the original object hierarchy 
that was instanced.
Time Offset - Sets the animation offset (in seconds) of any instanced hierarchies from the original object 
hierarchy that was instanced.

Time Offset only works when the Instanced item is set to Parent and not World Coordinates.
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Instance Transformation Options

At the bottom of the Instance Generator panel are a set of tabs for controls that can be used with each type of 
instancing. These are Scale, Stretch, Offset, Rotation, Nodes.

Scale, Stretch, Offset and Nodes are identical for each type of instancing. Scale, Stretch, and Offset each provide two 
modes, Uniform and Random, for handling of the distribution of the attribute.

Scale Tab

Allows for varying the size of the instances. At the top of this tab are two functions that need additional explanation.

Scale by Polygon Area - This compares the size of the polygons that will be used to position instances with the 
size of the original object being instanced. It also controls the amount of influence the original object’s scaling 
has on the Neutral Scale Factor. For instance, if the actual area of the polygon is 0.1, then the instance will be 
scaled by 0.1, and so on
Neutral Scale Factor - This factors what size your instances will be for the polygon area they are being instanced 
on. Hence a Neutral Scale Factor of 2 will mean that two instances will fit inside the area of the polygon, the 
instances will be half size.
Use Deformed Size - If you use the Scale by Polygon Area setting above, you can have instance size changes as 
the host mesh deforms with this enabled

These settings function in conjunction with the other scaling and stretching options available to you, increasing the 
flexibility available.

Mode :

Uniform - All instances will be scaled at the same size.

Scale - Sets the size by percentage.

Random - Creates instances at varying scales based on the min/max settings.

Min - Smallest size for an instance, as a percentage.
Max - Largest size for an instance, as a percentage.

If you are using nodes to drive transformations in your instances, make sure you set the Scale / Stretch / Offset 
and / or Rotation tabs to Uniform.


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Stretch Tab

Allows for varying the proportions of the instances along each axis (X/Y/Z).Mode:

Uniform - All instances will have identical proportions.

Stretch X/Y/Z - Settings for the percentage of change to make in each axis.

Random - Creates instances at varying proportions based on the min/max settings.

Min X/Y/Z - Sets a minimum size in each axis.
Max X/Y/Z - Sets a maximum size in each axis.

Offset Tab

Allows for an offset from the initial position the instance was created.Modes :

Uniform - All instances are offset the same distance on each axis.

Offset X/Y/Z - Settings for the offset distance for each axis.

Random - Instances are offset at varying distances based on the min/max settings.

Min X/Y/Z - Sets the minimum value for the distance of the offset.
Max X/Y/Z - Sets the maximum value for the distance of the offset.
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Rotation Tab

Allows for controlling the rotations of the instances in a variety of ways. Some of these options will be determined by 
the type of instance generation used.

Alignment (Dependent on generation type):

Item (Pivot):

Item - Instances align with the host item.

Points:

Item - Instances align with the host item.
Normals - Each instance aligns with the normal of its associated point.

Polygons:

Item - Instances align with the host item.
Normals - Each instance aligns with the normal of its associated polygon.
Edge Aligned - Rotates an instance so its Z axis points at the center of the shortest edge of the polygon it’s 
generated on.

Particles:

Particles - Each instance aligns with its associated particle.

Surface:

Item - Instances align with the host item.
Normals - Each instance aligns with the normal of the surface at its location.

Rectangular Array:

Item - Instances align with the host item.

Radial Array:

Item - Instances align with the host item.
Rim - All instances are oriented to the pivot point of the host item.

Motion Path:

Be careful with aligning to Normal. If the polygons concerned rotate, the Instancer will need to 
determine where the normal should be and may not be consistent. Try Edge Aligned if you are having 
problems with Normal alignment,


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Motion Item - Instances align with the motion item.
Path - Instances align heading to the direction of travel along the path.

Mode :

Uniform - All instances have the same orientation.

Rotation H/P/B - Entry fields to set Heading, Pitch and Bank.

Random:

Min H/P/B - Set minimum rotations for Heading, Pitch and Bank.
Max H/P/B - Set maximum rotations for Heading, Pitch and Bank.

Target Item - Instances orient to the pivot point of a target item.

Target Item - Pick the target from the list of scene items, including lights and cameras.
Target Mode - Changes how targeting is calculated.

Look At - Instances all look at the pivot point of the target item.
Axis Aligned - Instances all align with an axis of the target item.
Axis X/Y/Z - Active when Axis Aligned is the target mode; selects the axis of the target object to align the instances 
with.

Nodes Tab

Access to the Node Editor for controlling the transformation and weighting of instances using nodes. Node flows can 
also be turned on/off without needing to delete or hook them.

Use Nodes - Toggle on/off.
Edit Nodes - Allows the user to access the Instance Generator Node and control instancing and attributes using a 
node flow.

Instance Generator Node

This works in conjunction with the settings in the transformation tabs on the panel, and allows node-based control of 
these items, as well as of the weighting of the instanced items. Any settings not controlled by nodes will use the panel 
settings, this allows you to mix node-based control with those on the main instance generator panel.Each of the inputs 
correspond to their equivalents in the main interface:
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The node transformation inputs are affected by whatever mode you have chosen in the main panel for the 
corresponding transformation. For example, if you had a node flow controlling Scale Min/Scale Max, but in the 
instance generator panel you have the Scale Mode set to Uniform then the node flow will not influence 
anything as you have chosen a different Scale Mode to that which the node flow is controlling.


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TimeScale and TimeOffset on the destination node now work in World, Local and Parent modes. The Input 
node now has a Fixed Float output.

This spits out a number from 0.0 to 1.0 , where 0 is the first instance and 1 is the last. 0.5 would be the instance 
halfway between, etc.

Imagine your instancer as a chain stretching from 0-1. You have instances picked out at 0, 0.4 and 0.8. If you 
increase the number of instances on your chain, you will make the "links" finer, but those positions will still be 
the same, even if the instance number (link) is increased.

Fixed Float is applied to Offset (which must be set to Uniform). As the number of instances changes, the 
"staircase" effect stays constant with more or fewer steps.



Changes have been made to Instancing in response to user requests for the ability to have the same object in 
an instance generator multiple times for different scale, offset, rotation, etc. This new functionality has made 
loading 2015 and newer instancing into earlier versions not possible.


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1.

For the animated abstract sphere above, we used a Turbulence procedural texture to drive the uniform Scale of our 
instanced cubes. We also set the Stretching to be Random and converted the same Alpha output from Turbulence into a 
Vector to drive the Stretch Max value to exaggerate the effect.

Hiding Instanced Objects

When you have used an object as an instance, it can be irritating to see it in OpenGL and renders still. You have several 
ways of removing it from view.

You can untick the Active entry in the Scene Editor. This removes it from VPR and renders, but not OpenGL.
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2.

3.

You can use the Scene Editor’s Maximum Render level to hide the original object.

You can set the Instances of this object to use a Local coordinate system, whereupon you can move the original 
object out of camera view or position it to swim against the tide, as here.
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Example - Randomly surfacing Instances

Example - Monitor Screens

Example - Building a wall with Instances
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Surfacing

This section of the documentation for LightWave 2020 will introduce you in more depth to techniques for surfacing. 
Starting with the simplicity and rapidity of LightWave’s Surface Editor, Image Editor and proceeding to an in-depth 
guide to all that is nodal, from the ease of the Material nodes to more complex networks of nodes performing surfacing 
tasks that would be impossible in the Surface Editor.

Image Editor
Node Editor
Color Spaces
Surface Editor
Preset Shelf
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Image Editor
Click here to expand Table of Contents...

Opening Image Editor
Image Editor Sorting and Filtering
Using the Image Editor
Source Tab

Image Type
Color Space
Alpha Channel
Interlace
Mipmapping
Dithering
Metadata
Sequence Settings

Editing Tab
Processing Tab

LightWave’s Image Editor is far more than a simple location to load up images or sequences of images to apply to your 
models. Of course, you can use it for that, but you can also edit the attributes for those images directly in the Image 
Editor without altering the original file, and you can set image sequence start and end frames within it.
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Opening Image Editor

Although you can hit F6 to call up the Image Editor any time you like, sometimes it’s nice to call it up with an image you 
are currently using, so that you can tweak for your particular needs. Any time that a window needs an image - 
particularly the Texture Editor - you will find an Edit Image button beneath the thumbnail of the image you’ve chosen.
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Image Editor Sorting and Filtering

The Image Editor has the ability to filter images from a list. This operation is live in the sense that as you type the 
filtering is carried out immediately. You can also choose to sort your image list in a variety of ways to best suit your 
needs (Alphabetical, Date, Type, Size, Bit Depth, etc.).
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You can Collapse and Expand the Image Editor so that it takes up less screen real estate when you don’t need it by 
clicking on the arrow that we’ve highlighted.

Using the Image Editor

To load a new image or animation, or image sequence, press the Load button. To replace an image you’ve loaded, 
perhaps in error, press the Replace button. The Clone button is a drop down, because it has two different abilities. The 
first - Instance - copies the image, but allows you to work on with different settings in the Editing and Processing Tabs, 
almost as though it were a new image. Any changes you make to the Instance will not be reflected in the original image, 
however changes you make to the Original image will be reflected in all instances. If you are using an animation or an 
image sequence, any instances will have the same in and out points.The second - Duplicate - can only be used on image 
sequences and simply copies the images. Each is treated as a completely separate sequence and changes made to the 
original sequence will not affect a duplicated sequence.
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To delete an image, image sequence or animation, simply select it in the list on the left-hand side of the window and hit 
the Del key on the keyboard. You can also do it by clicking the right mouse button over the image in the list that you 
wish to remove.

The image preview window acts as a reference for you to see the effects you are having on your pictures when using the 
editing or processing functions. All edits are carried out on this 24-bit preview so that they can be done as close to real-
time as possible, rather than working on the full image, scaling it down to the preview size and redisplaying it. Double 
clicking on the preview image will open the Image Viewer containing the image or frame with all processing and editing 
done. A large image and a great number of operations to perform on it may cause a delay in opening the Image Viewer.

The three buttons under the Information Panel give you options on how frequently you wish the preview image to 
update when a change is made. Auto updates the image when any change is finished and the mouse button released. 
Real updates the preview image in real-time, while you are making changes and Man means that any image changes are 
only performed manually, by clicking the left mouse button on the preview image.
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The Use Layout Time button and the slider underneath the preview image are intimately linked. If you are using an 
image sequence or an animation you can use this slider to scrub through it. Alternatively, click the Use Layout Time 
button and you can use Layout’s own timeline to scrub through your animation.

Source Tab

The Image Type pop-up menu displays the type for the currently selected image. Generally, this setting is auto-detected 
when you load the file. However, you can specify a single image in a sequence of images by leaving its Image Type to 
Still and when you load a frame in a sequence that you want to use, don’t forget to change the Image Type from Still to 
Sequence. Animation is used if you load an animation into the Image Editor and Reference is a clone of an image, as 
discussed above.

 

Image Type

The Image Type dropdown offers five choices:

Still - The default option used for all still images
Sequence - This option will be chosen automatically if you load a sequentially-numbered image from a folder 
with a sequence of such images. Layout will switch between images in a sequence based on the scene time
Animation - If an animation filetype is used, this choice will be taken
UDIM - A way of referring to images for UV mapping. See UDIM Workflow for more info
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Reference - An image that is cloned as an Instance will be assigned this choice
Memory - An image that only exists in memory without a file (this entry is not always visible). Visor creates 
images like these and the LightWave command IE_CreateImage does the same.

Color Space

You can normally leave these at Default for the images to take on their assign color space settings, but if you wish to 
specify directly choices are available on a per-image basis including the ability to load a color space table.

Alpha Channel

If you are using images with embedded Alpha Channels, like some TIFFs, TGAs and Photoshop format images, you may 
wish to disable the Alpha Channel, otherwise, you may get unwanted effects since LightWave’s OpenGL doesn’t take 
embedded Alpha Channels into account. If you only wish to use the Alpha element of a picture, for a Transparency Map 
for instance, use the Alpha Only setting.

Interlace

If you are using video grabs as still images, or a sequence, you may wish to use a field interlace. You have two choices, 
Even First or Odd First and which one you choose depends on your source material, but you will certainly know when 
you render if you’ve chosen the wrong one. If you are using images from almost any other source, you can leave 
Interlace to Off.

To be able to load a single image and tell LightWave that it is a sequence, you need to have a series of 
numbered files with the same filename. For instance, this is a valid sequence:

Ayslinn0001.flx, Ayslinn0002.flx, Ayslinn0003.flx and so on.

A sequence can be missing some individual frames, like so:

Ayslinn0001.flx, Ayslinn0002.flx, Ayslinn0007.flx, Ayslinn0008.flx

This sequence has frames 0003-0006 missing. When this is the case, LightWave will use the last frame it can to 
fill the gap. In other words, the sequence will be like so:

Ayslinn0001.flx, Ayslinn0002.flx, Ayslinn0002.flx, Ayslinn0002.flx, Ayslinn0002.flx, Ayslinn0002.flx, 
Ayslinn0007.flx, Ayslinn0008.flx


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Mipmapping

Mipmapping is an automated way of create image maps at varying resolutions optimized to suit the size of an object in 
a rendered image. In LightWave you can globally enable or disable mipmapping in Render Properties. Turning it on 
means that textures, especially ones with a lot of detail, will be better resized to suit the render. Turning it off usually 
means sharper texture images, but with an increased risk of “sizzling” during animation unless additional samples are 
used in Camera Properties.

Dithering

Applies a dither to images. Normally this is not necessary.

Metadata

Opens a window giving the metadata for the image, animation or sequence. If available, this will include EXIF data.

Sequence Settings

When you load a sequence of images, LightWave automatically tries to ascertain the way the sequence is numbered by 
comparing files.

Sequence Digits - You can override the number of digits used for a sequence if LightWave is getting confused.
Frame Rate - Frame Rate controls the incrementing of an image sequence with respect to the scene’s Frame Per 
Second setting on Layout’s General Options Tab of the Preferences Panel. So, if you set this to, say, 15 and your 
scene Frame Per Second is 30, the image sequence will increment every two frames.
First Frame and Last Frame - display which files (or frames for an animation file) are treated as an image 
sequence in LightWave. This is computed when you load an animation file or switch the Image Type pop-up 
menu to Sequence (after loading a single image from the sequence), but can be set manually. However, it’s best 
not to use these fields to trim your animation to fit your needs. Instead use the In and Out points discussed next.
Start Frame - determines on which frame in Layout your sequence will start. Use the In and Out sliders to 
determine how much of your animation you want to play back in Layout. The Pre Behavior and Post Behavior 
drop down menus determine what Layout should do when an animation is not as long as the frame count in 
your scene.

Editing Tab

You can independently adjust (and envelope) various image parameters for the selected image on the Editing Tab if you 
want the images altered before LightWave uses them.
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These image operations do not affect the actual file on your hard drive, only the image used inside LightWave itself. If 
you wish to save your changes to an image, double click on the preview to open the Image Viewer and save the 
transformed image there in the format of your choice.

Invert - Inverts colors in the image
Default - Resets values to default
HDR Filtering - Allows Gaussian or Bilinear filtering of HDR images

Processing Tab

Access this tab to add image-processing filters. You may use any of the non-post-processing filters in the filter list. Ones 
that can only be used in the rendering process will inform you of the fact. Image filters added here will not update the 
preview window interactively unless the Animate Filters option is activated.
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Filter List
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Filter List

Click here to expand Table of Contents...

Black & White
Exposer
Full Precision Blur
Full Precision Gamma
Glow
HDR Exposure
Lscript and LScript/RT
Negative
Python
Python Black & White
Python Negative
Sketch

Controls
Preview
Sketching
Sketch Power
Sketch Modifier
Sketch Color
Hue Modifier
Saturation Modifier
Luminance Modifier
Gradient Parameters
Sketch Channels

SpriteEdger
Textured Filter

To see procedurals in viewports:

Video Legalize
Virtual Darkroom

Basic Settings
Advanced Settings: Spectral Sensitivity Tab
Film, Paper, and MTF Curve Tabs

VR Camera Export
WaterMark

Black & White

Creates a Black and White version of your render. Double-clicking on the item in the list will bring up the Black and 
White panel where you can alter the gamma correction for the contrast levels.



LightWave 2020  –  LightWave 2020

Reference –  2329

 

 

Left: Black and White Image Filter Applied, Right: Normal Render

Exposer

This filter normalizes high dynamic range (HDR) images for using as Image Maps and HDR output for displaying in 
applications that are not HDR-savvy. The intensity mapping is non-linear, similar to the light response process in the 
human eye.

This filter processes the HDR output created by radiosity and renders into better-looking, brighter pictures. It does this 
without impacting the accuracy of the lighting simulation, which can happen if you add ambient light or crank up lights 
unrealistically. It is really an essential part of the camera simulation, for a perfect digital camera. (The Virtual Darkroom 
filter is similar, but more complex. It simulates the two-stage process of film response to light, and print emulsion 
response to projection through the film negative.)

Although you can add this filter on the Image Editor, it is of limited use there and more useful as an Image filter on the 
Processing Tab of the Effects Panel. This is mainly because most images you load are not HDR images, so pre-
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processing is not necessary and normal gamma should probably be used, if necessary. Moreover, if you do load an HDR 
image, it’s probably because you want the extra data. (Using the HDR Exposure filter will eliminate some, if not all, of 
the extra data.)The Input Dynamic Range is an informational display showing the High and Low pixel-intensity values 
encountered in the last processed image. Note that when the panel first appears, this information is not yet known.

If you do not want the filter applied to the Full Image, set the Exposure Apply pop-up menu to Foreground to apply it 
only to scene items or Background to affect only the background (i.e., where your alpha would be black).

The White Point is the input intensity considered to be the hottest white. Anything above this will be the same white in 
the output. This control is overridden by the Auto-Iris option, which sets the white point based on the actual input 
image data. Adjusting the white point is similar to cranking down an iris on a film camera to limit how bright parts blow 
out in a photograph.

The Black Point, expressed as a percentage of the nominal black point (1/255), is the darkest non-black pixel level in the 
input image that will be preserved. Anything darker will come out black. The Auto-Exposure option overrides Black 
Point by using the actual image data to determine a black point in the incoming data. Lowering the black point is 
similar to increasing the exposure time for a photograph.

Once these values are set, the filter translates the incoming image intensity - in a process very similar to gamma 
correction - so that the darker colors get more of the output range than the brighter colors. In other words, the filter 
changes the spacing of intensity levels so more levels are devoted to low intensity, darker details.

Full Precision Blur

This filter will soften an image by blurring it. Change the Size values to increase the amount of blur horizontally or 
vertically. The Strength settings determine the amount of the effect. You can also choose whether to affect the RGB 
(color) and/or alpha data.

You can use the Rendered Alpha (channel) or a Special Buffer as a mask using the Use Mask pop-up menu. If you want 
the mask computed prior to the blurring, check the Pre-Blur Mask option, otherwise the mask accounts for any blurring. 
To reverse the mask, check Invert Mask.

The Special Buffer setting on the Advanced Tab of the Surface Editor can have a value from 0 to 1, with 0 meaning no 
blur and 1 meaning full blur.
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Full Precision Gamma

Display devices have a non-linear relationship between pixel values and physical light intensity - they do not excite the 
display phosphors linearly. This non-linearity must be compensated for to correctly reproduce intensity. The Gamma 
Correction value is the exponent value in the correction formula and determines how to convert pixel values to light 
intensity. The default, 2.2, is a common value used on images bound for video, but is not necessarily the optimum 
value.

Glow

Glow will create a halo around surfaces based on their intensity. At the top of the panel there is a global intensity that 
can be enveloped and a Glow Radius setting that is also global. Intensities can be set and enveloped for individual 
surfaces in a scene and the result is multiplied over the final render. The alpha does not show the glow.

HDR Exposure

This filter normalizes high dynamic range (HDR) images for using as Image Maps and HDR output for displaying in 
applications that are not HDR-savvy. The intensity mapping is non-linear, similar to the light response process in the 
human eye.

This filter processes the HDR output created by radiosity renders into better-looking, brighter pictures. It does this 
without impacting the accuracy of the lighting simulation, which can happen if you add ambient light or crank up lights 
unrealistically. It is really an essential part of the camera simulation, for a perfect digital camera. (The Virtual Darkroom 
filter is similar, but more complex. It simulates the two-stage process of film response to light, and print emulsion 
response to projection through the film negative.)
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Although you can add this filter on the Image Editor, it is of limited use there and more useful as an Image filter on the 
Processing Tab of the Effects Panel. This is mainly because most images you load are not HDR images, so pre-
processing is not necessary and normal gamma should probably be used, if necessary. Moreover, if you do load an HDR 
image, it’s probably because you want the extra data. (Using the HDR Exposure filter will eliminate some, if not all, of 
the extra data.)

 
The Input Dynamic Range is an informational display showing the High and Low pixel-intensity values encountered in 
the last processed image. Note that when the panel first appears, this information is not yet known.

If you do not want the filter applied to the Full Image, set the Exposure Apply pop-up menu to Foreground to apply it 
only to scene items or Background to affect only the background (i.e., where your alpha would be black).

The White Point is the input intensity considered to be the hottest white. Anything above this will be the same white in 
the output. This control is overridden by the Auto-Iris option, which sets the white point based on the actual input 
image data. Adjusting the white point is similar to cranking down an iris on a film camera to limit how bright parts blow 
out in a photograph.

The Black Point, expressed as a percentage of the nominal black point (1/255), is the darkest non-black pixel level in the 
input image that will be preserved. Anything darker will come out black. The Auto-Exposure option overrides Black 
Point by using the actual image data to determine a black point in the incoming data. Lowering the black point is 
similar to increasing the exposure time for a photograph.

Once these values are set, the filter translates the incoming image intensity - in a process very similar to gamma 
correction - so that the darker colors get more of the output range than the brighter colors. In other words, the filter 
changes the spacing of intensity levels so more levels are devoted to low intensity, darker details.

Lscript and LScript/RT

Both allow you to run an LScript on a finished image.

Negative

Simply inverts the RGB values for the image.

Python

Applies a Python script to an image.
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Python Black & White

Python version of the Black and White script.

Python Negative

Python version of the Negative script.

Sketch

Controls

Open Preset Shelf & Add Preset: Sketch settings can be added to and taken from the presets shelf. When creating a 
preset, the thumbnail image is taken to be the preview image currently being shown (see below).

Preview

The preview image shows the effect of this Sketch plugin instance to the last image processed. The image will update as 
the Sketch settings are changed. Click on the preview image to force an update if needed.
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Sketching

Sets whether sketching is enabled or disabled. This does not affect the hue, saturation, and luminosity modifiers.

On - enable computation of sketch outlines
Off - disables computation of sketch outlines. This effectively sets the sketch value to 0.

Sketch Power

Larger numbers makes the edges sharper. Typical values are between 0.5 and 3.

Sketch Modifier

Modifies the “sketch” value. 0 means no edge here, 1 means a very strong edge.

None - leaves the value alone
Scale - scales the value by the given factor
Remap - arbitrarily change the sketch value, usually through an expression or texture

Sketch Color

The color to use for the sketch edges.

Hue Modifier

Changes the base colors of the image.

None - does nothing to the hue values
Rotate - moves the colors through the spectrum
Scale - scales the colors towards the start/end of the spectrum
Remap - arbitrarily change the hue values

Saturation Modifier

Changes the color saturation of the image.

None - does nothing to the saturation values
Steps - quantizes the saturation values in the given number of steps
Scale - scales the saturation values
Scale around mid - scales the saturation values around the mid point
Remap - arbitrarily change the saturation values

Luminance Modifier

Changes the color intensities of the image.

None - does nothing to the luminance values
Steps - quantizes the luminance values in the given number of steps
Scale - scales the luminance values
Scale around mid - scales the luminance values around the mid point

Because the preview image is usually much smaller than the actual image, the preview is only an 
approximation of the effect.


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Remap - arbitrarily change the luminance values, usually through an expression or texture

Gradient Parameters

For textures used as Sketch settings, a number of custom gradient parameters are available:

Sketch - the “sketch” value, between 0 (no edge here), and 1 (very strong edge here)
SketchDir - the direction of the sketch edge
Luminance - the luminance value at the current pixel
Hue - the hue value at the current pixel
Saturation - the saturation value at the current pixel

Sketch Channels

For envelopes and expressions used as Sketch settings, a number of custom channels are available in the Sketch group. 
Note that these channels are read-only (they are prefixed with an “r” as a reminder), and will only contain valid values 
during the evaluation of the Sketch plugin.

rSketch - the “sketch” value
rSketchDir - the sketch direction
rLuminance - the luminance value at the current pixel
rHue - the hue value at the current pixel
rSaturation - the saturation value at the current pixel

SpriteEdger

The Sprite Edger image filter “unmixes” anti-aliased object edges from the background. It can remove background color 
fringing if the object is not rendered over black. It can also clip the alpha channel to form a 1-bit (0 or 1) mask. It can 
even use this mask to clip the RGB imaged edges, setting the pixels to the background color if they are outside the 
mask.

Textured Filter

Use Textured Filter to add the selected texture to the image before use. You could use this filter to add, say, an 
animated Fractal Noise pattern to a simple black image. Since textures are three-dimensional, particularly procedurals, 
use the Axis setting to use the X, Y, or Z of the texture.

The differences between the Axis selection can be subtle.



LightWave 2020  –  LightWave 2020

Reference –  2336

1.

2.

3.

4.
5.
6.
7.

To see procedurals in viewports:

You can use Textured Filter to see procedural textures in your Layout viewport! Basically, you apply the procedural 
texture(s) to the image using Textured Filter and then map the image to the surface. Here’s how you do it:

Load an image into the Image Editor. It really doesn’t matter what image you use since it will be obscured by the 
textures.
On the Image Editor’s Processing Tab, add Textured Filter. Double-click it in the list window to access its options. 
Click the Texture button to access the Texture Editor.
Change the default initial Layer Type to Gradient. This provides the underlying color. You can leave it white or 
change it.
Add one or more procedural texture layers and set as you would normally.
Load your object and open the Surface Editor.
Click the Color attributes Texture button. Leave Layer Type set to Image Map on the Texture Editor that appears.
Set Projection as you would normally and select your image from the Image pop-up menu. The procedural will 
now appear in your viewport.

This operation requires a lot of computations and Layout may seem sluggish as it computes the texture.

If you use an image sequence instead of a still image, you can even see an animated texture! Note that if an animated 
texture is applied to a still image, it will not appear animated.

Video Legalize

The Video Legalize filter might be more appropriately named Hot Video, since it assumes that pure black, RGB 0, 0, 0, is 
mapped to the proper pedestal by the encoding device (e.g., 7.5 IRE for NTSC). The encoding device may not, however, 
correct hot pixels - that is, colors that exceed certain video specifications. This is where VideoLegalize steps in.

Pixel values are generally scaled into IRE units using the Black Point, White Point and Pedestal settings as follows: Level 
= Pedestal + (100 - Pedestal) * (pixel - Black) / (White - Black). White is always 100 IRE and PAL Black is 0 IRE. NTSC black 
is 7.5 IRE, thus for NTSC, the level would be computed: Level = 7.5 + 92.5 * (pixel - Black) / (White – Black).

The image preview window on the Image Editor will show the texture as well. Thus, you can double-click the 
window to bring up the Image Viewer, from which you can save this compiled image. This can then be image 
mapped back onto the surface without all of the calculations required with Texture Filter.


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Normally, an RGB level of 0.0 is black and 1.0 is white. If those are used for the Black Point and White Point settings, the 
NTSC level will be 7.5 + 92.5 * (pixel - 0.0) / (1.0 - 0.0) or just 7.5 + 92.5 * pixel. When the pixel is 1.0, the level is 100 IRE, 
and when the pixel is 0.0, the NTSC level is 7.5 IRE.

The settings default to NTSC encoding, but you may also select PAL from the Encoding pop-up menu. (Note that you 
also need to click the Default button after selecting a new Encoding item.) You may change the individual settings from 
their defaults, if desired.

The Correct pop-up menu determines how the image is corrected to fall within the specified limits.

Virtual Darkroom

The Virtual Darkroom filter simulates the photographic capture of images. It is based on A Model for Simulating the 
Photographic Development Process on Digital Images, by Joe Geigel and F. Kenton Musgrave in the SIGGRAPH ’97 
conference proceedings.

The actual computation is more complex than the above since other operations, like gamma correction, can 
happen.



It is highly recommended that you use Video Legalize (as a post-process image filter) if you plan to use your 
images for video.


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Global settings are the four controls located at the top. Output Type specifies whether the output image is Black and White 
(single-plane greyscale) or Color (three-plane RGB).

Basic Settings

Basic Settings control everything except for those settings on other tabs. Negative LUX is the illumination value for the 
negative pass - analogous to scene capture with a camera - which will affect overall brightness. Negative Time is the 
exposure time for negative pass, essentially the Exposure setting on the virtual camera. Positive LUX is the illumination 
value for the positive (printing) pass. Think of this as the brightness of the bulb in the enlarger or printing mechanism. 
Positive Time is the exposure time during the printing pass of virtual enlarger.Enable Scattering will activate the 
internal scattering effect. Negative Width and Negative Height are the width and height, respectively, in millimeters, of 
the virtual negative. These values are used in scattering and grain calculations. Enable Grain will activate the grain 
effect. Selwyn Granularity controls the intensity of the grain. Increasing this value increases grain, decreasing it will 
decrease grain.

Advanced Settings: Spectral Sensitivity Tab

If Output Type is set to Color, there will be six sets of RGB percentage controls. Each RGB trio specifies the percentage of 
the black and white output plane that is contributed by the input image plane named in the control. For example, the 
RGB trio in the upper-middle defines how the output from the negative passes on the spectral sensitivity module 
creates the green plane.If Output Type is set to Black & White, you specify what percentage of the red, green, and blue 
planes of the input image are used when they are combined into a single black and white image. This transition takes 
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place in the negative (first) pass. During the printing (second) pass, there is only a single input plane, so spectral 
sensitivity is not used.

Film, Paper, and MTF Curve Tabs

You can enter up to 21 pairs that define the characteristic curve of the film and paper, and the function for modulation 
transfer used for scattering calculations. For each pair, the first value represents log (exposure) and the second value 
represents the density. 
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For all Curve tab entries, points should be entered in order starting with Pt. 01. If Output Type is set to Color, curves 
must be set for each output plane by selecting the appropriate Red Plane, Green Plane, or Blue Plane sub-tab.

VR Camera Export

This Image Filter will take stereo renders (from any camera) and bundle them correctly for use in compositing 
applications or websites for a stereoscopic workflow. Its settings are as follows:

Destination - A choice of:
Image Viewer - Sends the left eye and right eye images to the LightWave Image Viewer along with an 
image composited in the fashion you choose in Stereo Type.
Image Files - Saves the left eye and right eye images in the format chosen, along with an image 
composited in the fashion you choose in Stereo Type.

Image Type - The still image format you wish to use for the Image Files setting
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File Output - The directory for outputting composited stereo renders
Stereo Type - Presents three choices:

Left Over Right - the left eye and right eye renders are stacked vertically
Left / Right - the renders are placed side-by-side
Anaglyph - Creates a single image to be viewed with red-blue glasses

Left over Right Left / Right Anaglyph

WaterMark

The WaterMark filter embosses an image in the lower-right quarter of your render. You can select any loaded image; 
however, grayscale images using a black background work best. The Light Angle field determines the direction of the 
implied light source.
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UDIM Workflow

UDIM is a way of assigning multiple images to a UV map, using a single number to indicate blocks of UV space separated 
into 10 columns of U before V is incremented. This makes parsing an image list used for texturing simple given that the 
images will have numbered filenames. It also simplifies the Image Editor with a single UDIM image in the list of images, 
rather than masses of numbered images.

A UDIM workflow is vital in other applications such as Mari and Substance, but even purely in LightWave can be 
extremely beneficial for a number of reasons. The first is that surfacing in LightWave only allows one UV map per texture 
meaning that you need to divide areas into multiple surfaces if you wish to use different UV maps or fit everything into 
one giant map that has the limitation of being bigger than it needs be for unimportant details and yet always too small 
for those details that really matter. Furthermore, if you do use multiple surfaces for the different UV maps, there will 
always come an area you wish to cross between two UVs and thus two surfaces. UDIM is a cure for these problems.

As an example, here is a VPR screenshot of 18 objects, all planes for simplicity, each UV-mapped.

They are all textured using what seems to be a single image in the Image Editor, but is in fact 16 separate PNG files. If we 
go into Modeler, we can see how the planes are arranged.
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In this GIF animation we show the UV space. Then we show plane_001 of our scene, which we can see fills the UV space. 
We show the UDIM image used and can see it extends far beyond the traditional UV space. Showing plane_008, then 
plane_000 shows where they sit on the UDIM image. Black tiles indicate missing images - either deliberately or because 
the image sequence has ended before the U reaches 10.

While this example is artificially simple to make it more comprehensible, the UDIM technique means that multiple 
images can be assigned space in UV coordinates for UV mapping to take place while simplifying the image count. This 
example also shows one UDIM array used with multiple objects, but it can also be used for a single object with multiple 
maps (many other 3D applications only allow one UV map per object).

Creating UDIM image sequences

UDIM sequences are images with numbering starting at 1001 counting upwards. You should not start at a higher 
number. If you miss numbers (1004, 1006, 1007, etc.) there will be a black tile where the number would be. Tiles are 
created horizontally from left to right. Once the tenth tile has been placed a new row starts. The UDIM sequence name 
will be the filename before the numbers. If you use a separator (an underscore, period or hyphen for instance) it will be 
kept as part of the UDIM sequence name. The images in a UDIM sequence do not all have to be the same size, this means 
that some tiles can be very detailed while others have less.

Traditionally in LightWave when polygons fall outside the 0-1 UV space there is a repeat of the texture. When 
using a UDIM workflow this is no longer true. To regain the normal behavior it suffices to use a non-UDIM 
image.


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Creating UDIM UV maps

In order to create the tiles needed for a UDIM UV map, when you create the UVs for your object, keep to the same UV 
Texture Name and select the tile number from the field near the bottom of the requester. As stated above UDIM tiles are 
ten to a row, like so:

Example - UDIM texturing the Sugarcube character

The padding field below ensures that you remain within a UV tile. UDIM maps are very sensitive to the 
boundaries of each tile so it is best to make sure you have some padding. 0.05 gives a five percent margin, 
which should be enough to ensure separation. If you aren't using UDIM, the padding can be ignored.


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Node Editor
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Material Advanced Inputs
Outputs
Edit Panel

Noise Type

Introduction

This chapter is divided into two sections. First an overview of the Graphical User Interface (GUI) and some of the 
conventions used when working with nodes in the Node Editor. In the second section we will discuss each node 
individually and in detail in reference guide format for easy look-up of any node’s function, purpose and the various 
inputs and outputs associated with each.

The node editor is an alternative and superior way of shading and texturing the geometry created in the modeling 
process. Node-based editing systems such as commonly found in many high end 3D computer graphic applications, 
have established themselves as an industry standard tool for shading and texturing. The Node Editor in LightWave 3D is 
superior to many others combining the ease of use associated with LightWave 3D with the power and flexibility required 
by high-end industry professionals. As we will see, it is easy enough for a beginner to begin shading and texturing 





LightWave 2020  –  LightWave 2020

Reference –  2347

•

•

•

objects within just a few minutes and powerful enough for advanced users to design their own custom shaders and 
textures either by constructing special purpose node networks in the user workspace area or by using the LightWave 3D 
SDK that is offered free from NewTek Inc.

The Node Editor currently exists in three different places throughout the LightWave 3D working environment. Each 
environmental instance of the Node Editor is identical in operation and technique except for one key aspect - the 
Destination node, sometimes also referred to as the Root node.

There is always only one destination node for any attribute (volumetric lighting, vertex deformation, or shading and 
texturing) that nodes are applied to. Here are the three locations and an example of what each of the Destination nodes 
look like.

Displacement Destination Node 

 
This will be the Destination node if the Node Editor is opened via the Edit Nodes button found in the Object 
Properties panel under the Deform tab (Accessed by pressing Shift-O, P).
Light Destination Node 

 
This Destination node will be present if the Node Editor is opened by clicking the Edit Nodes button located in 
the Volumetric Options panel contained in the Light Properties panel’s Basic tab (Accessed by pressing Shift-L, 
P).
Surface Destination Node 

 
This is the Destination node you will be using if you open the Node Editor by clicking on the Edit Node Graph 
button found in the Surface Editor panel F5.
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Input Node

If you wish to mix bumps for separate materials into the surface, do not add them to the materials but 
directly into the destination Surface node as shown:


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The Input Node is always present in a node editor, much like the Surface output node is in the Surface Editor’s Node 
Editor. It does not have to be used, but contains many frequently-required nodal inputs. There is an Input node in many 
of LightWave’s node editors, shown are Surface Editor, Nodal Motion, Nodal Texture, Nodal Displacement and Light 
Falloff. The Surface Editor Input node contains many new outputs:

Surface Input

When editing a surface, this node always appears in the Node Editor.



LightWave 2020  –  LightWave 2020

Reference –  2350

•
•
•

•

•
•

•
•
•

•
•

•

•
•

•

•

•
•
•

•
•
•
•

•
•

•

•
•

Item ID (Integer) -  The LWItemID of the intersected primitive
Pixel X, Y (Integer) - The location of the pixel currently being rendered
Frame Width, Height (Integer) - The resolution of the image set in Camera 
Properties
Ray Position (Vector) - Origin of the ray that intersected this primitive (from the 
Camera, Reflection, Refraction, Shadow, etc.)
Ray Position dX, dY (Vector) - Ray origin differentials
Ray Direction (Vector) - The direction of the ray that intersected this primitive (from 
the Camera, Reflection, Refraction, Shadow, etc.)
Ray Direction dX, dY (Vector) - Ray direction differentials
Ray Weight (Color) The accumulated weight of the ray represented as a color
Ray Distance (Scalar) - The distance the ray traveled before intersecting the 
primitive
Shutter Time (Scalar) - The normalized shutter time (0...1)
Ray type (Integer) - Camera ray, Reflection ray, Refraction ray, Dissolve ray, Shadow 
ray and Occlusion ray. These can be fed into the Ray Type Switch node.
Ray Bounce (Integer) - The number of bounces the ray has taken to reach this 
intersection. Starts at 1
World Position (Vector) - The location of the intersection in world coordinates
World Position dX, dY (Vector) - The partial derivative of the world coordinate 
position in relation to X or Y coordinate of the pixel
World Position dU, dV (Vector) - The partial derivative of the world coordinate 
position in relation to the U or V coordinate of the pixel (for objects with automatic 
UV maps)
Perturbed Normal (Vector) - The interpolated normal perturbed by bump or 
normal mapping
Smooth Normal (Vector) - The interpolated normal
Geometric Normal (Vector) - The un-interpolated geometric normal
Normal dU, dV (Vector) - The partial derivatives of the normal along U and V 
coordinates
Barycentric Coordinates  (Vector) - The masses of each vertex on a triangle
Object Position  (Vector) - The location of the intersection in local coordinates
To Local, To World (Matrix) - Transformation matrices for the intersection
U, V (Scalar) - The U or V coordinate for the intersection, presuming the surface has 
UV coordinates
U and V dX, dY (Scalar) - The U and V partial derivatives along pixel X and Y
Primitive ID (Integer) - A Primitive can have an ID assigned that is different to the 
Item ID
Surface Side (Integer) - Determines if the intersection hit the front (0) or back (1) of 
the surface (2 double-sided back) (Example)
Polygon Index (Integer) - The numeric index for the polygon at the intersection
Mesh Element (Integer) - Outputs the element type needed for the Mesh Element 
Switch node
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User Interface

The Node Editor has improvements for LightWave 2019. The most obvious is the grid behind the nodes, but there are 
also improvements to the way the user interface works.

Grid

The grid display is constant and by default set to a size of 20 pixels. The shading of the grid is based on a difference from 
the background color of the Node Editor. The default is a difference of 8, but values can go as far as -128 to 128. Positive 
values will have a grid color lighter than the background, while a negative value will darken the grid in comparison with 
the background color. A value of 0 in the Grid Shade field will effectively hide the grid. Even invisible, the grid can still be 
snapped to and the top left corner of a node will be used as the snapping point.
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Tidy Nodes

Rearranges nodes to remove overlaps. Tidy Nodes will also collapse nodes that are not in use and arrange all unused 
nodes in a column to the left of the network.

Keyboard Shortcuts

The LightWave standard of Ctrl+Alt will now zoom in and out of node networks to a minimum of 2 % and a maximum of 
100 %. The zoom is based around the center of the network, similar to Layout zoom.

If you select a node, you can now tap the , (comma) key to select all the nodes upstream of the selected node, or tap 
the . (period) key to select all the nodes downstream. Nodes selected in this way will have thicker connection lines 
drawn.

You can now pan around the Node Editor space just using the MMB. There's no need to use Alt-LMB 
anymore, though you can continue to do so.


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RMB Menu

 

Left: nothing selected Right: one node selected

Clicking the Right Mouse Button (RMB) in the Node Editor will present one of two menus depending on whether you 
have node(s) selected or not. There are new entries in both menus for 2019.

Example - Getting Started with Nodes

Connection Types

There are eight kinds of connections in the Node Editor. Each type (listed below) is color-coded for your convenience. 
Color type connections are red, Scalar types are green, Vector types are blue, Integer types are purple, Functions are 
yellow, Projections are white, Transforms are cyan and finally Materials are light gray. Usually, you will want to keep the 
connections limited to only similar types but the Node Editor is very flexible and allows dissimilar types to be 
connected. This can be used to your advantage if you apply logic while constructing your networks.
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1.

2.

3.

It’s useful and sometimes necessary to mind which types you are connecting when creating a network. There are a few 
rules of behavior that you may count on from the Node Editor and like all rules there are a few exception to mind as 
well. One very advantageous rule is that when connecting dissimilar types the output type will be automatically 
converted to the input type that you are connecting it to, in the most intelligent way possible. There are only three 
exceptions to this and they are -

The Normal and Bump input in the destination Surface node prefer the incoming type to be a Vector , but you 
can equally add a Color or even a Scalar .
Connecting another type of output to a Function input will not convert it to a function type. The connection will 
be made and some of the information from the non-function output may be used but the results will be 
unpredictable. Functions are the only type of connection that are actually bidirectional. This bi-directionality is 
transparent to the user but Function nodes receive information from the node they are modifying, alter the 
information in some way and then send the results back to the node they are connecting to. A good general rule 
of thumb to remember about function-type nodes is just to not intermix them with dissimilar types. Keep your 
Functions in the yellow and all will be mellow.
Material inputs and outputs can only be attached to Materials .

Here is a matrix of the automatic conversion between same and dissimilar connection types of node inputs and 
outputs. It is repeated at the end of this chapter for quick reference.

Here is a description of the kinds of connections found in the Node Editor and some more of the rules that apply to each 
one in greater detail.

To

Color

(Red)

To

Integer

(Magent
a)

To

Scalar

(Green
)

To

Vector

(Blue)

To

Functi
on

(Yello
w)

To 
Projec
tion

(Whit
e)

To

Materi
al

(Gray)

To 
Extent

(Dark 
Green)

To 
Volum

e

(Dark 
Gray)

To 
Matrix

(Cyan)

From

Color

(Red)

Color in 
RGB 

format 
unmodifi

ed

CCIR 601 
Luminan
ce values 

as 
Integer. 
Usually 0 
or 1 only

CCIR 
601Lu

minanc
e 

values 
as float

RGB 
values 
copied 

to vector 
compon

ents 
respectiv

ely

N/A N/A N/A N/A N/A N/A

From 
Integ
er

(Mag
enta)

Integer 
value is 
duplicat
ed to all 

3 RGB 
channels

Integer 
value 

unmodifi
ed.

Integer 
value 

unmodi
fied

Integer 
value 

copied 
to all 3 
vector 

compon
ents

N/A N/A N/A N/A N/A N/A
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From 
Scala
r

(Gree
n)

Scalar 
value 

copied 
to all 3 

RGB 
channels

Rounded 
to the 

nearest 
Integer 
value

Scalar 
values 

unmodi
fied.

Scalar 
value 

copied 
to all 3 
vector 

compon
ents

N/A N/A N/A N/A N/A N/A

From 
Vect
or

(Blue
)

Vector 
compon
ents are 
copied 
to RGB 

respectiv
ely

1st 
compon
ent ONLY 

is 
rounded 

to 
nearest 
Integer

1st 
compo

nent 
ONLY is 

used

Vector 
compon

ents 
unmodifi

ed

N/A N/A N/A N/A N/A N/A

From 
Func
tion

(Yell
ow)

N/A N/A N/A N/A Receiv
e, 

transfo
rm, 

return

N/A N/A N/A N/A N/A

From 
Proje
ction

(Whit
e)

N/A N/A N/A N/A N/A Projec
tion 

passe
d 

throug
h

N/A N/A N/A N/A

From 
Mate
rial

(Gray
)

N/A N/A N/A N/A N/A N/A Materi
al 

proper
ties 

passed

N/A N/A N/A

From 
Exte

nt

(Dark 
Gree
n)

N/A N/A N/A N/A N/A N/A N/A Extent 
values 
passed 
throug

h

N/A N/A
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From 
Volu
me

(Dark 
Gray)

N/A N/A N/A N/A N/A N/A N/A N/A Volum
e 
values 
passed 
throug
h

N/A

From 
Matri

x 
(Cya

n)

N/A N/A N/A N/A N/A N/A N/A N/A N/A Matrix 
values 
passed 
throug

h

Color Type Connections

Color outputs and inputs are designated by a red dot next to the connection name. Color is a composite type 
connection containing three channels of information.
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Input Output

Color inputs receive incoming color connections as three 
channels red (R), green (G), and blue (B) from other nodes 
in the network you are currently working with. Most of the 
time you’ll want to connect colors to colors unless you 
have a very specific task in mind and have read this 
documentation thoroughly fully understanding the 
consequences and conversions that take place when 
making connections between dissimilar connection types.

Connecting non-color output from other nodes to a Color 
input will automatically copy the incoming values to each 
color channel red, green, and blue. The color of the line 
connecting the two dissimilar types will change over the 
lines length from whatever color designates the output 
selected to red.

If the incoming connection is a vector type output then 
XYZ or HPB etc., will supply the values for the RGB 
respectively. This means that if the incoming vector type 
is a Position for example, then the X value of that vector 
will be used to define the red channel of the color. Y to 
green, and Z to blue and so on in a similar way for HPB if 
the vector being used is a rotation and so on.

The vast majority (almost all) of connections in the Node 
Editor are evaluated per spot therefore if the incoming 
color connection has a variance in the shader or texture 
values that is affecting the color channel (i.e. a pattern of 
some kind) then that varied color value will be supplied to 
the color input it is connecting to. Simply put, if you 
connect the color output of a red and green marble 
texture to a color input then that input will receive a red 
and green colored marble pattern - evaluated on a spot by 
spot basis.

Color outputs always supply three channel data 
evaluated per spot, in the format red, green, and blue 
(RGB) regardless of what other inputs are connected to 
the node or what other settings you may have set for 
your scene. Even if the incoming data for the node’s 
colors are scalar values and/or you have selected gray 
values via the color picker panel, the color output will 
still be outputting three channels of data.

Scalar Type Connections

Scalar outputs and inputs are designated by a green dot next to the connection name. In LightWave 3D’s Node Editor, a 
scalar is a floating point number or quantity usually characterized by a single value which doesn’t involve the concept 
of direction. The term scalar is used in contrast to entities that are “composites” of many values, like vector (XYZ, HPB, 
etc.), color (RGB), etc.

Some examples of scalar values are: 3.14159265, 13, 0.00001, -5.5, 2, and 69.666
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Input Output

Primarily, connections to a scalar input will be scalar 
outputs from other nodes in the network you’re working 
with. Most of the time you’ll want to connect scalars to 
scalars unless you have a very specific task in mind and have 
read this documentation thoroughly fully understanding the 
consequences and conversions that take place when making 
dissimilar connections.

Connecting non-scalar output values to a scalar input will 
automatically convert it to scalar type. The color of the line 
connecting the two dissimilar types will change over the 
lines length from whatever color designates the output 
selected to green.

If a component (vector or color) type output is being 
connected to the scalar input then one of several things may 
happen as follows:

If it is a color type output that is being connected to the 
scalar input then the CCIR 601 luminance values for that 
color are derived from the RGB values and used as the scalar 
input.

If it is a vector type output that is being connected to the 
scalar input then only the first component of the vector is 
used as the scalar value. For example if the vector being 
used is a position then only X will be supplied to the scalar 
input and Y and Z will be ignored. Likewise if the vector 
being used is a rotation then only the H (heading) will be 
used and the P (pitch) and B (bank) channels will be ignored.

Again however, these conversion processes are automatic 
and transparent to the user.

Scalar outputs from any given node will always 
supply scalar values regardless of what other inputs 
are connected to the node. Please see above for 
examples of scalar values.

Integer Type Connections

Integer outputs and inputs are designated by a purple dot next to the connection name.

Integers in the Node Editor can be used for many things but most often they are designated for the purpose of 
specifying predefined list member items such as any of the Blending modes described below in the next section on 
Blending Modes (see the Blending Modes table further down).

An integer is a non-floating point natural number. Some examples of integers are: 3, 13, 0, -5, 69 and 666.
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Input Output

Primarily connections to an integer input will be integer 
outputs from other nodes in the network you’re working with. 
Most of the time you’ll want to connect integers to integers 
unless you have a very specific task in mind and have read this 
documentation thoroughly thus fully understanding the 
consequences and conversions that take place when making 
dissimilar connections.

Connecting non-integer outputs to an integer input will 
automatically convert it to integer type using standard 
rounding. The color of the line connecting the two dissimilar 
types will change over the lines length from whatever color 
designates the output selected to purple.

If a component type output is being connected to the integer 
input then one of several things may happen as follows:

If it is a color type output that is being connected to the integer 
input then the CCIR 601 luminance values for that color are 
derived from the RGB values. Those luminance values are then 
rounded and used as the integer input. Since internal 
luminance values in the Node Editor are floating point values 
which most often range from 0.0 (black) to 1.0 (white) the 
rounding that takes place during this conversion would have 
the effect of reducing the luminance information to either a 
value of zero or one with no gray tones in between. Consider 
that the luminance value 0.5 (50% gray) when rounded to an 
integer value would become a value of 1 (white) and a gray tone 
just slightly below 50% gray (0.4) when rounded to an integer 
value would be 0 (black).

If it is a vector type output that is being connected to the 
integer input then only the first component of the vector is used 
after rounding it, as the integer value. For example if the vector 
being used is a rotation then only the rounded H (heading) 
value will be supplied as the integer input and P (pitch) and B 
(bank) will be ignored. Likewise if the vector being used is a 
scale or position then only the rounded X value will be used and 
the Y and Z channels will be ignored.

These conversion processes however, are automatic and 
transparent to the user.

Integer outputs from any given node will always 
supply integer values regardless of what other 
inputs are connected to the node. Please see 
above for examples of integer values.

Vector Type Connections

Vector inputs and outputs are designated by a blue dot next to the connection name.



LightWave 2020  –  LightWave 2020

Reference –  2360

Vectors are composite type values meaning they are comprised of more than one component or “channel”. Some 
examples of vectors in the Node Editor are Position, Scale, and Rotation. Notice that each one of these attributes 
contain more than one value. For example position is comprised of X, Y and Z. Scale is also comprised of X, Y, and Z and 
rotation is comprised of H, P and B - Heading, Pitch, and Bank respectively.
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Input Output

Generally, connections to vector type inputs will be vector type 
outputs from other nodes in the network you’re working with. 
Most of the time you’ll want to connect vectors to vectors unless 
you have a very specific task in mind and have read this 
documentation thoroughly thus fully understanding the 
consequences and conversions that take place when making 
dissimilar connections. You will never want to connect anything 
other than a vector type output to a vector type input that is 
labeled “Normal” next to the blue dot designation unless you 
know ahead of time why. The case for needing to make such kinds 
of connections to a Normal input is so rare that in fact the 
destination Surface node disallows non-vector connections to it’s 
Bump and Normal vector inputs. The general rule of thumb here is 
that all Normal inputs should only be receiving their data from 
other Normal type outputs. You may remember it by learning: 
“Normals in like only Normals out.” where the inverse of that 
phrase may not always be true.

Connecting non-vector output types to a vector input will 
automatically convert it to vector type with various limitations. 
The connection will be made except where noted, and the color of 
the line connecting the two dissimilar types will change over the 
lines length from whatever color designates the output selected, to 
blue.

Color type outputs are a kind of vector although undesignated as 
such and for good reason. It can be quite confusing to discuss 
colors as vectors. However there are times when the relationships 
are straightforward enough to be immediately useful.

When connecting a color output to a vector input each channel of 
the color output (R, G, and B) will be used to define the first, 
second, and third components of the vector respectively.

If a non-component type (scalar or integer) output is being 
connected to the vector input then the value of the scalar or 
integer is copied into all of the components of the vector that it is 
being connected to. For example connecting an Alpha output from 
any of the texture nodes to any of the texture nodes input 
connections labeled Scale would copy the Alpha value to all three 
of the components of the Scale vector. If for example, the Alpha 
value was 1.0 the recipient textures Scale value would be 1.0 for X, 
Y, and Z.

Once again these conversion processes are automatic and 
transparent to the user.

Vector outputs from any given node will 
always supply vector component values 
regardless of what other inputs are connected 
to the node.



LightWave 2020  –  LightWave 2020

Reference –  2362

Function Type Connections

Function type connections are special two-way connections. Functions offer a way of transforming a texture or shader 
value based on the functions’ graph.

Input Output

Function inputs should only be connected to from other 
Function type nodes in the network you are working 
with.

Always connect function to functions.

Connecting non-function outputs to Function inputs 
will make the connection and the color of the line 
connecting the two dissimilar types will change over 
the lines length from whatever color designates the 
output selected, to yellow. However the results of 
dissimilar connections with function nodes are not 
guaranteed to produce any predictable results.

When a function output is connected to a function input 
data (usually texture value data) from the node being 
connected to is sent to the connecting node where it is 
then transformed and sent back to the recipient node. 
The transformations that occur depend entirely upon 
the kind of Function node that is being used and the 
settings entered for its graph.

Function nodes specifically utilize the function 
connection to transform values of the nodes they are 
connecting to. Typically this will be shaders and textures 
and in these cases the shader or texture sends the shader 
or texture value to the connected function node. The 
connected function node then transforms these values 
based of the function graph, and returns the transformed 
values to the recipient node.

Function connections are specialized in this way allowing 
for bidirectional communication between nodes.

Once again, the output of a Function type connection 
should always be connected to the input of another 
Function type connection.

Material Type Connections

Material inputs and outputs are designated by a light gray dot next to the connection name.

Where previous connections were for input specific channels into other nodes, Materials are complete in themselves.

Input Output

Can only be connected to by other Material outputs Can only be connected to other Material inputs

Node Editor Probe

Item #8 in the initial guide to the Node Editor, this is a node probe that will show you the outputs of the nodes in your 
network.
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When enabled, you can hover the mouse cursor over any node’s output connections or preview area. If the preview area 
has a standard preview sphere, the hover location is displayed in the preview data type (color, scalar, vector, integer, 
etc.) When hovering over an output connection, the displayed data uses the data type of that connection; however, the 
value is evaluated without the knowledge of any ray trace environment. Therefore, the output connection evaluation is 
really only useful for those nodes that do not use preview spheres. The data display is shown in a floating popup that 
follows the mouse.

The data display will update a few times per second to account for live input from a Device node or if the user updates 
the preview spheres manually via the space bar. In other words, the mouse pointer can continue to hover over the same 
screen position and whatever happens to be beneath it will be displayed automatically.
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Blending Modes

Value Blending Mode

0 Normal

1 Additive

2 Subtractive

3 Multiply

4 Screen

5 Darken

6 Lighten

7 Difference

8 Negative

9 Color Dodge

10 Color Burn

11 Red

12 Green

13 Blue

All of the blending modes in the Node Editor are based on their Photoshop equivalents. Here is a description of each 
one not defined elsewhere in the LightWave 3D manual:

Darken

Darken looks at the foreground and background colors and chooses the darker one, whichever it is. Whichever is darker 
wins. Which of the two is used will vary across the image depending on which is darker at each spot as it is evaluated.

The preview sphere has traditionally been a gamma-corrected appearance of the actual evaluation. The probe 
will display the source data for the preview sphere, not the altered visual representation. The probe then 
shows the value of that output not the color-adjusted grayscale representation of that value.


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Lighten

Lighten is the reverse of darken. It evaluates the foreground and background colors and replaces the darker ones with 
the lighter ones.

Color Dodge

Color Dodge is a kind of inverted multiply mode. Dodging is a dark room technique commonly used by photographers 
and photo developers. This analog equivalent technique is achieved by holding a small piece of cut paper taped to the 
end of a thin wire or stick, in between the projected light and the photo paper causing some areas of the photograph to 
be underexposed. The same thing is going on here but the foreground pattern is being used as the dodge mask instead 
of a cut to shape piece of paper, to underexpose those areas. Remember that the more underexposed an area is the 
lighter it is and a completely unexposed sheet of photo paper is all white.

Color Burn

Color Burn is basically the same thing in reverse. Burning is also a darkroom technique where (in its simplest form) a 
large piece of paper with holes cut in the middle is held between the projected light and the photo paper after exposing 
the image initially on to the paper. This has the effect of overexposing or burning in some areas of the image. Again it is 
the background color values and patterns that are being used in place of that cut sheet of paper just mentioned, to burn 
in the image. Remember that the more overexposed an area is the darker it is and a completely overexposed sheet of 
photo paper is all black.

Red

Colors as seen on your monitor are comprised of three components red, green and blue. Each of these primary colors 
can be talked about or represented by considering them as separate channels. Usually to form any specific color these 
three channels are mixed additivly.

In these next three blending modes we are able to use each unique channel individually.

Selecting Red as the blending mode replaces the blue and green of the FG color channels with the blue and green 
channels contained in the BG Color. Only the foreground’s red channel will be considered but the green and blue 
channels will be taken from the background color only. If for example, your background color was 100% blue and your 
foreground color was 100% red - selecting Red as the blending mode would result in purple output.

Green

Selecting Green as the blending mode replaces the blue and red channels of the FG color with the blue and red channels 
from the BG Color. Only the foreground’s green channel will be considered but the red and blue channels will be taken 
from the background color only.

Blue

Selecting Blue as the blending mode replaces the red and green channels of the FG color with the red and green 
channels contained in the BG Color. Only the foreground’s blue channel will be considered but the red and green 
channels will be taken from the background color only.

Opacity

Opacity is the amount that each of these blending modes mentioned above, is applied. You can think of opacity as the 
strength of the blend effect.
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Invert

The Invert toggle button inverts the scalar Alpha values used to blend the two colors; background and foreground. 
Where applicable it will also invert the bump gradient so that not only are the background and foreground colors are 
swapped but the bump and alpha outputs as well are inserted.

About Using Nodes

All the nodes and textures included in LightWave 3D are multipurpose. Some textures are useful for things that you 
would not immediately recognize them as being useful for. For example, Bricks2D can be used to make strange-looking 
spider webs and a various assortment of other similar patterns.

It’s good practice to work with VPR (Ctrl -F9) active at all times while creating networks with the Node Editor. It is also 
very beneficial to have the Surface Presets shelf (F8) open during any surfacing work. VPR and the Presets shelf work 
together to offer the user a convenient interactive work history during the process of constructing texturing or shading 
Networks. Double clicking on the preview display area in the Surface Editor will add an entry in the Presets shelf with a 
scale version of that image as the icon for that preset.

Conversely, double-clicking on an icon in the Presets shelf will load and apply all of the surface settings saved when you 
double clicked on the Surface Editor preview display area.

Common Inputs and Outputs

Rather than repeating the same information all the time it makes more sense to only detail unique Inputs and Outputs 
and refer to a single place for the documentation of items shared between nodes. Herewith the Inputs and Outputs 
common to all nodes, starting with Inputs:

Inputs

Bg Color (Color) - Can receive colors and patterns from other nodes in the network. Users may also specify a 
background color using the controls found in the Edit Panel for this node.
Fg Color (Color) - Can receive colors and patterns from other nodes in the network. Users may also specify a 
foreground color using the controls found in the Edit Panel for this node.
Blending (Integer) - Specifies one of the blending types (0~13) found in the blending type list at the beginning of 
this chapter.

Can receive input from other nodes in the network or can be specified to by selecting a blending mode from the 
Blending pull-down menu in the Edit Panel for the node.

For general use specifying the blending mode by using the Blending pull-down menu in the Edit Panel will 
probably be the most desirable method of use. However, for larger networks where control of the blending 
modes of many texture nodes simultaneously is needed or when conditional blending is desired then using a 
node connection to control this value may be advantageous.

Opacity (Scalar) - Opacity is the amount that the selected blending mode is applied. You can think of opacity as 
the strength of the blend effect between the BG Color and the FG Color.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.
U Tiles (Integer) - Specifies the number of tiles in the U dimension.
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Can receive patterns and numerical inputs from other nodes in the network The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.
V Tiles (Integer) - Specifies the number of tiles in the V dimension .

Can receive patterns and numerical inputs from other nodes in the network The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.

Fractal Inputs

Small Scale (Scalar) - Like Lacunarity, Small Scale is a counterpart to the fractal dimension that describes the 
texture of a fractal. It has to do with the size distribution of the gaps between detail levels. The Small Scale value 
sets the amount of change in scale between successive levels of detail.

If you are seeing repeating patterns in the texture it might be a good idea to alter the Small Scale value for the 
texture.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify values for 
this attribute using the controls available in the Edit Panel for this node.
Contrast (Scalar) - Sets the contrast of the texture value gradient. Higher values produce less gradient 
information between texture value extremes and therefore less noise is produced. The lower values spread the 
gradient more evenly between the extremes of the texture values and thus allow for more overall noise in the 
final output from this node.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify the 
values for this attribute using the controls available in the Edit Panel for this node.
Frequencies (Scalar) - “Frequencies” as used in this node is really just another name for octaves as defined in 
some of the descriptions of fractal type textures within this document.

You can think of “Frequencies” as the number of levels of detail mentioned in the discussion just above for Small 
Scale. At one “Frequency”, only the basic pattern is used. At 2 “Frequencies” given a Small Scale value of 2, a one 
half scale pattern is overlaid on top of the basic pattern. And at three Frequencies, the overlays are one quarter 
scale over the one half scale over the basic and so on.

If Small Scale were 3 in this example, it would mean that each new iteration would be one third the scale of the 
previous layer.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify the 
values for this attribute using the controls available in the Edit Panel for this node.
Increment (Scalar) - Since this texture is a fractal or a fractalized noise pattern, it means that we can overlay 
smaller and smaller copies of the same pattern functions over previous layers in order to add detail. Technically, 
this is called Spectral Synthesis. These are not surface layers, but layers considered within the algorithm of the 
texture node itself.

Increment is the amplitude or intensity between successive levels of detail.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.
Lacunarity (Scalar) - Lacunarity is a counterpart to the fractal dimension that describes the texture of a fractal. It 
has to do with the size distribution of the holes. Roughly speaking, if a fractal has large gaps or holes, it has high 
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lacunarity; on the other hand, if a fractal is almost translationally invariant, it has low lacunarity. The lacunarity 
value sets the amount of change in scale between successive levels of detail.

If you’re seeing repeating patterns in the texture it might be a good idea to lower the lacunarity level of the 
texture.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.
Octaves (Scalar) - You can think of octaves as the number of levels of detail mentioned in the discussion just 
above for lacunarity. At one octave, only the basic pattern is used. At 2 octaves given a Lacunarity value of 2, a 
one half scale noise pattern is overlaid on top of the basic pattern. And at three octaves, the overlays are one 
quarter scale over the one half scale over the basic and so on.

If Lacunarity were 3 in this example, it would mean that each new layer would one third the scale of the previous 
layer.

Considering these three Increment, Lacunarity, and Octaves then if Lacunarity were set to 2, Increment were set 
to 0.5, and Octaves were 4, it would mean that each successive iteration for 4 iterations, was twice the frequency 
and half the amplitude.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.
Offset (Scalar) - Defines an offset into the texture value range where the minute details produced by the 
combined effects of Lacunarity, Increment, and the number of Octaves, begin to ramp sharply.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this 
parameter value using the controls available in the Edit Panel for this node.

Function Inputs

Frequency (Scalar) - The Frequency input controls the time taken to complete one function cycle. By increasing 
the frequency, the cycle period of the function is reduced. Likewise, decreasing the frequency means the 
function takes longer to complete one whole cycle. The mode (described below) determines the behavior of the 
function once it has completed a full cycle.
Amplitude (Scalar) - The Amplitude input controls the size of the function from peak to peak.
Phase (Scalar) - The Phase input allows the function waveform to be shifted in time. Increasing the phase shifts 
the function to the left, while decreasing it shifts the function to the right.
Mode (Constant, Repeat or Oscillate) - Three modes are available that determine how the function behaves after 
one complete cycle has been performed. The possible choices are:

Constant mode - in which the function remains as its last value when one cycle completes.
Repeat mode - in which the function restarts from the beginning when one cycle completes, giving a repeating 
oscillation based on a saw tooth waveform.
Oscillate mode - in which the function completes one cycle and then returns to its start point over the next cycle. 
This provides a repeating oscillation based on a triangular waveform.

Clamp Low (Scalar) - The Clamp Low input defines a point at which, if the function is less than, the output is 
clipped. In other words the output of the function can be no lower than this value.
Clamp High (Scalar) - The Clamp High input defines a point at which, if the function is greater then, the output is 
clipped. In other words the output of the function can be no higher than this value.
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Begin (Scalar) - The Begin input specifies the start of the step. That is, the position for the start point of the ramp 
up.
End (Scalar) - The End input specifies the finish of the step. That is, the position for the end point of the ramp up.

Material Inputs

Specular/Specularity (Scalar) - The term specular or specularity here refers to the optical property referred to in 
previous LightWave surface terms as reflection. The difference with standard Surface Editor Reflection where 
you can have as much as you like while also keeping the Diffuse level high, in a Material raising one will lower the 
other keeping the balance physically correct between the two.
Roughness (Scalar) - This value does nothing on its own. It is designed to be used with Reflection and Refraction 
Blur on the Advanced tab. Likewise, without some degree of Roughness , those settings do nothing except slow 
the render slightly.
Absorption (Scalar) - How quickly light passing inside an object is extinguished. A low value here with indicate 
greater transparency. Based on Beer’s law of absorption, to give a more realistic and non-linear result.
Refraction Index (Scalar) - This value is for the Index of Refraction of your material. Often used - 1.33 for water, 
1.5 for glass, 2.4 for diamond.
Dispersion (Scalar) - Controls the amount of light dispersion. Dispersion is a phenomenon that causes the 
separation of a wave into spectral components with different wavelengths, due to a dependence of the wave’s 
speed on its wavelength. This will cause the surface to render more slowly as it renders each spectral 
component separately (red, green and blue).

Dispersion as used in this shading model simulates real light dispersion. The higher the value the greater the 
amount of dispersion that will be simulated and applied.
Normal (Vector) - Specifies a vector direction for modifying the surface normal and only Tangent Normal maps 
should be used. This is surface normal direction information and affects the way the surface is shaded. Care 
should be taken when connecting to this input. Connecting dissimilar types or non directional vectors may cause 
the surface to shade wrongly.
Bump (Vector) - Specifies a vector direction for modifying the surface bump. This is surface normal direction 
information and affects the way the surface is shaded. Care should be taken when connecting to this input. 
Connecting dissimilar types or non directional vectors may cause the surface to shade wrongly.
Bump Height (Scalar) - Specifies the bump height or “amplitude” of the Bump directional vectors.
Bump Dropoff (Scalar) - How fast the visibility of the bump falls away.

Material Advanced Inputs

The Advanced tab contains controls common to all Materials namely Reflection and/or Refraction Blurring and 
environment settings similar to the standard Surface Editor’s Environment tab.

Reflection Blur - Controls the amount of blur of the surface reflections. Some amount of blur is required in order 
to have the Dispersion amount (when available) affect the surface.
Mode / Reflection Image Mode and Image are features exclusive to the Edit Panel. Please see the explanation for 
these items in the chapter that covers texturing with the Surface Editor.
Image Seam Angle - allows the user to rotate the seam line of a wrapped image around the Axis that has been 
selected for the projection method.
Interpolated - Switch between standard unified sampling and using a defined Sample and Blend Size to tailor 
your surface.

Outputs

Color (Color) - Outputs three channel color information in R, G, B format, evaluated on a per spot basis.
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Alpha (Scalar) - Outputs single channel alpha (grey) information evaluated on a per spot basis.
Luma (Scalar) - Outputs CCIR 601 luminance values derived from the RGB values contained in the image being 
used.
Bump (Vector) - Outputs component vector direction information the length of which are the product of the 
bump amplitude value.
Normal (Vector) - Outputs component vector direction information the length of which are the product of the 
bump amplitude value.

If used as an input to another normal type connection the destinations normal will be completely replaced with 
this information.

Nearly all Inputs can receive patterns and numerical inputs from other nodes in the network. The user may also specify 
this parameter value using the controls available in the Edit Panel for this node.

Edit Panel

Radiosity and Caustics check boxes are not offered as node connections in the Workspace area and are features 
exclusive to the Edit Panel of the node.When checked this shading model will evaluate shading information for the 
surface channel it is being applied including any Radiosity or Caustics computations as defined by those system 
attributes applied to the scene.

Unchecked, radiosity and/or caustics calculations will not be evaluated by this shading model as it is applied to the 
object surface being edited.

This can be used to omit both entire surfaces or per channel surface attributes from radiosity or caustics calculations 
thus offering more diversity in the rendered output as well as reducing the time needed to calculate these surfaces in 
scenes where either radiosity or caustics are used.

Noise Type

You can get a very good idea of what each Noise Type looks like in the fractal-based Node edit panel by following these 
few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

2D Textures
3D Textures
Additional
Constant
Displacement
Distance Tools
FiberFX Group
Flocking Group
Fresnel Functions
Functions
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Item Info
Layers Group Nodes
Material Components
Material Integrators
Material Tools
Materials
Math
OpenVDB group
Projections
RayTrace
Spot
Tools
Vertex Map
Volume Components
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2D Textures

Click here to expand Table of Contents...
Bricks2D

Edit Panel

CheckerBoard2D
Edit Panel

Grid2D
Unique Inputs
Edit Panel

Image
Edit Panel

Image Sampler
NormalMap

Unique Inputs
Edit Panel

NormalMapSampler
Edit Panel

Parquet2D
Unique Inputs
Edit Panel

Planks2D
Inputs
Edit Panel

Turbulence2D
Edit Panel

2D textures consist of images or procedurals that can be mapped to the object surface during the shading computation. 
An algorithm is used for “wrapping” the texture around the object’s surface so that the pattern curves and distorts 
realistically. The advantage of using 2D textures is that in using the projection methods available to them, the texture 
patterns can conform easily to basic geometrical shapes. Additionally, textures, in general, add apparent detail and so 
do not have to be modeled in geometry. An everyday use of a 2D texture might be to apply an image as a decal or label 
on a three-dimensional bottle or other object. 2D textures can also be used as transparency, reflection, refraction, 
normal, and displacement maps, etc.

Bricks2D

Bricks2D is a simple brick-like 2D texture useful for very many patterns and effects that one would not normally expect 
just by considering its name. From broken glass and strange spider webs to more in line with what its name implies; 
such as roughly shaped cobblestone roads and brick walls.



The Blending input on these nodes refers to Blending Modes.
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The Bricks2D texture has axial projection methods available such as spherical, cubic, planar, front, cylindrical, and UV.

Mortar Width (scalar) - Specifies the width of the mortar between the brick faces. Increasing this value will also 
reduce the face of the bricks in such a way that the pattern will repeat the number of U and V tiles within the 
defined scale of the texture correctly.
Mortar Sharp (scalar) - Defiance how steep the falloff angle is between the brick faces and the bottom trough of 
the mortar area.
Mortar Shift (scalar) - Mortar shift specifies the offset of the U directional mortar areas. When creating a standard 
red brick surface you can think of this value as determining the stagger amount of the bricks rows.

Edit Panel

Here the Mapping projection types and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

CheckerBoard2D

Procedurally generated checkerboard pattern with axial projection methods such as spherical, cubic, planar, front, 
cylindrical, and UV.
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Edit Panel

Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Grid2D

Procedurally generated grid pattern. This grid pattern can vary the thickness of the lines that form the grid as well as 
define a soft edge falloff from line to center in user-specified amounts. It has axial projection methods available such as 
spherical, cubic, planar, front, cylindrical, and UV.

Grid2D is also extremely useful for visualizing results from the output of other nodes and network segments.

Unique Inputs

Mortar Width (scalar) - Specifies the width of the mortar between the grid squares or “faces.” Increasing this 
value will also reduce the size of the face area of the grid in such a way that the pattern will repeat the number of 
U and V tiles within the defined scale of the texture correctly.
Mortar Sharp (scalar) - Defiance how steep the falloff angle is between the grid faces and the bottom trough of 
the mortar area.
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Edit Panel

 
Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Image

The description for this particular node could fill volumes and the use of images as applied to shading, texturing and 
lighting, has! This node is probably the single most useful and versatile node. The image node will allow you to load 
images with or without Alpha channels, map them directly onto polygons, and use various derived values from the 
image itself to control other nodes in the network.

The Image node has axial projection methods available such as spherical, cubic, planar, front, cylindrical, and UV.

It is worth mentioning here that while either images or procedurals by themselves can create stunning results, 
it is extremely advantageous to use procedurals and images together! You may find that when creating 
textures for photo-realistic or semi photo-realistic rendering, that procedurals can complement images and 
vice versa, in a way that far outweighs the use of either alone by themselves.


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Edit Panel

Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel.

Also please see the related sections elsewhere in this manual for descriptions of Pixel Blending, MipMap Quality, and 
MipMap Strength.
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The explanation of the Image Map Layer Type in the Texture Editor found elsewhere in this manual differ concerning 
tiling methods, only in that the labels describing the menus are different.

Invert Alpha inverts the alpha portions of the image so that the alpha region becomes solid and non-alpha becomes 
transparent.

Invert Color inverts the color of the image.

Width Tile in the Texture Editor is U Tiling in the Node Editors’ Image node.

Height Tile in the Texture Editor is V Tiling in the Node Editors’ Image node.

The behaviors described for Reset, Repeat, Mirror, and Edge are the same as described for the Texture Editor.

2019.1 brings separate color channel outputs to the Image node.

Image Sampler

An image node that allows more external control than the standard Image node. It uses the Projection nodes to 
determine how the image will be attached to the surface. A Projection node isn't needed for intrinsic Object UVs so the 
Image Sampler's Color output can be plugged straight into the Color Input on a primitive shape.

Invert Alpha inverts the alpha portions of the image so that the alpha region becomes solid and non-alpha becomes 
transparent.
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Invert Color inverts the color of the image.

2019.1 brings separate color channel outputs to the Image Sampler node.

Texturing the plane does not need a projection because the plane is a primitive with intrinsic UV map.

NormalMap

The normal map node allows you to load and utilize normal maps created from any of the various software packages 
that produce them such as ZBrush, Genetica Pro, or Marvin Landis’s free NormalMapCreate plugin for LightWave3D.

With descriptions of normal mapping technology being commonplace, we will highlight just a few of the main points 
you may want to consider when applying normal maps in LightWave3D. Namely what normals are in general, what 
happens when you apply a normal map, and a few of the differences between normal mapping and bump mapping.

It is easy to understand what normals are if we consider polygon normal or “geometric normals.” Polygon normals are 
just the direction in which a given polygon is facing - its facing or “normal” direction. Smoothed normals also consider 
smoothing interpolation. What’s happening when you apply a normal map is the replacement of that information with a 
set of directions contained in a map. The recorded directions are color encoded (RGB = the directions XYZ). This is 
different than standard bump mapping in that standard bump mapping does not replace the normal direction but 
rather modifies the existing directions. This is an important distinction because you’re replacing the direction the 
smooth shaded faces are facing when you apply a normal map, and the necessary cautions need to be taken to produce 
correct results.

Unique Inputs

Amplitude (scalar) - Specifies the normal height or “amplitude” of the Normal directional vectors.

Using Alpha or luminance (connecting Color) values from other textures in the network along with their 
respective bumps can have the effect of blending the bump textures.

Can receive patterns or numerical values from other nodes in the network. This value can additionally be 
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specified by user input by entering values into the Edit Panel of this node.

Since Bump Amplitude is a shading feature and not a displacement coordinate system value, it is specified as a 
percentage. Specifically, as a percentage of the texture value.

Edit Panel

Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node’s Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.
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Also please see the relative sections elsewhere in this manual for descriptions of Pixel Blending, MipMap Quality, and 
MipMap Strength.

NormalMapSampler

An image node that allows more external control than the standard Normal Map node. It uses the Projection nodes to 
determine how the normal map will be attached to the surface.

Edit Panel

Parquet2D

Parquetry is the inlay of wood, often of different colors, that is worked into a geometric pattern or mosaic and is used 
especially for floors. The Parquet2D procedural texture offers the ability to create these geometric patterns. While a very 
common use would be for floor designs, the Parquet2D texture like other procedural textures, affords a great deal of 
creativity limited only by the imagination of the user. Parquet2D has axial projection methods available such as 
Spherical, Cubic, Planar, Front, Cylindrical, and UV.

Unique Inputs

Tiles (integer) - This specifies the number of parallel planks or sections that each parquet tile is comprised. 

Values below one will be evaluated as one.

Mortar Width (scalar) - Specifies the width of the mortar (or gaps) between the parquet faces. Increasing this 
value will also reduce the size of the face area in such a way that the pattern will repeat the number of U and V 
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tiles within the defined scale of the texture correctly.

Mortar Sharp (scalar) - Defines how steep the falloff angle is between the parquet faces and the bottom trough of 
the mortar (or gap) area.

Edit Panel

 
Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Planks2D

The Planks2D procedural texture creates the gaps and faces of flush or staggered planks. Like Parquet2D, Bricks2D, 
Bricks3D, and other procedurals of this type a separate texture either procedural or image-based can be used where 
face and grout (mortar, gaps, etc.) materials are desired. Planks2D has axial projection methods available such as 
spherical, cubic, planar, front, cylindrical, and UV.
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Inputs

Mortar Width (scalar) - Specifies the width of the mortar (or gaps) between the plank faces. Increasing this value 
will also reduce the size of the face area in such a way that the pattern will repeat the number of U and V tiles 
correctly within the defined Scale of the texture.
Mortar Sharp (scalar) - Defines how steep the falloff angle is between the plank faces and the bottom trough of 
the mortar (or gap) area.
Stagger (scalar) - Stagger specifies the offset of the U directional gap (or “mortar”) areas. A value of 0% will cause 
all of the planks to line up flush on both ends, forming a straight row of planks.
Can receive patterns and numerical inputs from other nodes in the network. Additionally, user input values may 
be entered in the Edit Panel for the node.
Plank Length (scalar) - Specifies the length of the planks as a percentage to the overall size of the texture.

Edit Panel

 
Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.
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Turbulence2D

A multipurpose noise texture with axial projection methods such as spherical cubic planar front cylindrical and UV.

Edit Panel

 
Here the Mapping projection type and Axis are not offered as node connections in the Workspace area. Likewise, 
Reference Object, World Coordinates, and Automatic Sizing are features exclusive to this node's Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.
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3D Textures
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Unique Inputs
Edit Panel

Turbulence
Edit Panel

Turbulent Noise
Edit Panel

Underwater
Unique Inputs
Edit Panel

Veins
Unique Inputs
Edit Panel

Wood
Unique Inputs
Edit Panel

Wood 2
Unique Inputs
Edit Panel

fBm Noise
Edit Panel

Introduction

A 3D texture is computer generated via procedural algorithms with a set of parameters. The generated pattern follows 
logically inside the procedural volume and wherever polygonal surfaces exist in relation to that volume the procedural 
pattern information is applied. 3D textures can exist in world space coordinates or tied to an object’s center point when 
world coordinates is unchecked in the node’s Edit Panel. 3D textures avoid many of the difficulties attributed to the 
mapping of a bitmap around the surface of an irregular object. These textures have no edges and provide a continuous-
looking appearance.

Bricks

Bricks is a brick-like 3D texture useful in producing many patterns and effects. Modified, many elaborate variations 
divagating from conventionally recognizable brick patterns can be achieved.

Unique Inputs

Thickness (scalar) - Is the thickness of the mortar areas of the brick pattern. As the thickness value increases the 
size of the brick faces decrease within a given texture scale creating the appearance of smaller bricks spaced 
farther apart.

The Blending input on these nodes refers to Blending Modes.
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This value is in ratio to the texture scale. For example a value of 1.0 would produce a surface that was nothing 
but mortar with no visible brick faces. A value of zero would produce a surface of continuous brick faces with no 
mortar gaps and only hairline cracks that might be seen in very high precision stonework.
Edge Width (scalar) - Is the width of the beveled edges which create a rounded or beveled look to the four sides 
of the brick face.
This setting in ratio to the size of the brick face and is calculated as an offset along each side of each brick face.
For example a value of 0.5 would produce a pyramid shape that would occupy the entire face area of each and 
every brick because 0.5 or halfway in from each edge of the brick is the entire brick face.

Edit Panel

 
Axis is not offered as a node connection in the Workspace area. Likewise Reference Object, World Coordinates and 
Automatic Sizing our features exclusive to this nodes Edit Panel. Please see the explanation for these items in the 
chapter that covers texturing with the Surface Editor.

Checkerboard

Procedurally generated checkerboard pattern.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this node's Edit Panel.

Crackle

Cellular type texture good for amphibian type skin, scabs, rocks, gravel, asphalt, and etc.

Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this node's Edit Pane. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.
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Crumple

A cellular type texture good for a wide variety of uses including oceans, windy lake surfaces, to various types of rock, 
certain types of window glass, and etc.

Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Crust

A cellular type texture that produces intersecting circular patterns and provides controls for transition gradients 
between the circular foreground and background colors.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Dots

Procedurally generated three dimensional grid of ball-like texture elements.

Unique Inputs

Diameter (scalar): - The Diameter value specified as a percentage, controls the “width” or diameter of the ball 
shapes that produce a circular look where an object surface intersects with the texture. 

Since the sphere-like texture elements are aligned and spaced on a cubic grid by default it is entirely possible to 
apply this texture to a box or flat surface and see no results at all. What’s happening in this circumstance is that 
the balls are aligning on either side of the polygon surface. The surface plane essentially is passing through a 
part of the texture that contains no variant values - the space between the balls - and thus no visual results are 
produced. 

In this situation, increasing the Diameter parameter to between 120% and 150% will allow you to see the results 
of the texture in VPR in order to interactively Position the texture at the optimal offset values.

Can receive patterns and numerical inputs from other nodes in the network. The user may also specify this value 
as a percentage using the controls available in the Edit Panel for this node.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

A simple offset Litho effect made by piping an image’s Luma into the Diameter value of Dots giving a halftone effect. The 
Scale value of Dots needs to be reduced and the Fg and Bg Colors should be reversed.
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FBM

A fractional Brownian motion (FBM) fractal texture. The results of several scientific studies have shown that many real 
world natural textures have the same kind of spectra as produced by FBM making it a natural choice for various kinds of 
naturally occurring textures and patterns.

Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Flakes

Flakes is a procedurally-generated texture that simulates chips of glass or plastic.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Grid

Procedurally generated grid pattern. This grid pattern can vary the thickness of the lines that form the grid and has the 
ability to define a soft edge falloff from line to center in user specified amounts.

Width (scalar) - Defines the width of the grid square faces. If you think of this texture in terms of a tile pattern the 
width parameter defines the size of the tile plates in ratio to the mortar areas or grid lines.

A value of 100 % would be all title plates (squares) and a value of 0% would be all mortar areas (grid lines) in a 
mutually exclusive manner.
Contrast (scalar) - Controls the contrast amount between the foreground and background. Essentially this acts 
as a cubic bland or falloff between the background (grid squares) and the foreground (grid lines).

Values near 100% will produce very sharp transitions between grid squares and grid lines. Values near 0% will 
produce very soft linear gradient transitions between grid squares and grid lines.
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Edit Panel

Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

HeteroTerrain

An experimental prototype texture developed by Dr. Forest Kenton “Ken” Musgrave, Hetero Terrain is a fractal type 
texture that controls the amount of details added by successive overlays (called fractalizing) according to an “Offset” 
value. Edit Panel
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Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this node’s Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of the LightWave 3D manual for these related features, you can get 
a very good idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

Honeycomb

A procedurally generated hexagonal honeycomb pattern. The Honeycomb texture node can be applied on an axial basis 
X, Y, or Z.

Unique Inputs

Thickness (scalar) - Defines the thickness of the lines that form the hexagonal honeycomb pattern. This is in ratio 
to the size of the inner hexagons formed by the pattern. This means that increasing the thickness of the lines (Fg 
Color) will decrease the size of the inner hexagons (Bg Color). 
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Values approaching or above 0.25 will begin to distort the hexagonal shapes. Values between 1.0 and 2.0 will 
produce a staggered square grid pattern. A value of 2.0 or higher will cover the surface 100 percent solid in the 
foreground color with absolutely no pattern.
Edge Width (scalar) - Is the gradient falloff size of the pattern lines (foreground) into the hexagonal inner shapes. 
Increasing this value will have the apparent effect of decreasing the size of the inner hexagonal shapes. 

The recommended value range for this parameter is 0.0 to 0.5. Higher or lower values may produce unexpected 
results. Values above 1.0 are not meaningful.

Edit Panel

 
Axis is not offered as a node connection in the Workspace area. Likewise Reference Object, World Coordinates and 
Automatic Sizing our features exclusive to this nodes Edit Panel. please see the explanation for these items in the 
chapter that covers texturing with the Surface Editor.

Hybrid-MultiFractal

An experimental fractal prototype texture developed by Dr. Forest Kenton “Ken” Musgrave, Hybrid Multifractal attempts 
to control the amount of details according to the slope of the underlying overlays. Hybrid Multifractal is conventionally 
used to generate terrains with smooth valley areas and rough peaked mountains. With high Lacunarity values, it tends 
to produce embedded plateaus.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this nodes Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of this manual for these related features, you can get a very good 
idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

Marble

A texture that produces a three dimensional grid of columns of marbly vein-like patterns. The Marble texture can be 
applied on an axial basis X, Y, or Z.

Unique Inputs

Vein Spacing (scalar) - Defines the number and size of the veins within the given Scale value. 
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For example, given a uniform scale of 1m a Vein Spacing value of 1.0 would produce one vein per meter. A vein 
spacing value of 0.5 would produce two veins per meter, 0.25 four veins and so on.
Distortion (scalar) - Controls the amount of distortion or noise that is applied to the veins. This property is in 
direct correlation with Noise Scale.
Noise Scale (scalar) - Controls the scale of the noise that is applied to the vein columns. This property is in direct 
correlation with the Distortion value.
Contrast (scalar) - Sets the contrast of the texture value gradient. Higher values produce less gradient 
information between texture value extremes and therefore less noise is produced. The lower values spread the 
gradient more evenly between the extremes of the texture values and thus allow for more overall noise in the 
final output from this node.
Frequencies (scalar) - “Frequencies” as used in this node is really just another name for octaves as defined in 
some of the descriptions of the fractal type textures within this document.

You can think of “Frequencies” as the number of levels of detail. At one “Frequency”, only the basic pattern is 
used.

Edit Panel

Axis are not offered as node connections in the Workspace area. Likewise Reference Object, World Coordinates and 
Automatic Sizing are features exclusive to this nodes Edit Panel. Please see the explanation for these items in the 
chapter that covers texturing with the Surface Editor.
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MultiFractal

A multipurpose fractal type texture node.

Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this nodes Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of this manual for these related features, you can get a very good 
idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

Procedural

This node, new to 2019, is a direct way to address the procedural textures in LightWave rather than using a Color Layer 
node or the 2D or 3D Procedural nodes. This node directly accesses the code used for the original layered 
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implementation of the nodes and gives access to procedurals in third party collections not otherwise accessible other 
than in Color Layer nodes where you don't have the ability to manipulate the procedural with a Function input or 
change its Pos/Rot/Scale with another node input. If you wanted to get both a color and a bump map, you'd need two 
different Layer nodes, one for the color and one for the bump. Additionally, we have procedurals that don't have an 
equivalent 2D/3D node, and most of the nodes that have the same names in the 2D / 3D Procedurals don't match in 
appearance with these original procedurals.

Edit Panel

The specific procedural, native or 3rd party, can be chosen from the dropdown at the top of the window and if the 
procedural has specific options they can be accessed through the Options button below. The procedural node has 
Color, Alpha, Value and Bump outputs.

Ridged MultiFractal

An experimental fractal prototype texture developed by Dr. Forest Kenton “Ken” Musgrave, Ridged Multifractal is one of 
the best Fractal texture patterns to produce mountains, and mountainous terrain. It introduces highly detailed peaks 
and ridges often in similar shapes as naturally occurring mountain ranges. Control over the sharpness of the ridges can 
be achieved by adjusting the Threshold value. The Noise Types used are fairly critical in determining how mountainous 
the terrain should or should not be.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this nodes Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of this manual for these related features, you can get a very good 
idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

Ripples

A procedural texture that produces a three dimensional ripple pattern.

Unique Inputs

Wave Sources (scalar) - Defines the number of wave sources that interact with each other in order to create the 
overall Ripple texture effect. 
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Each wave source is a spherical ripple pattern. When a flat object surface for example, passes through the center 
of a wave source it appears very much alike to the effect one sees by throwing a stone into a body of very still 
water.
Wavelength (scalar) - Defines the wave length of the wave sources. This is the length or distance between the 
waves as measured peak to peak. This value is in ratio to the texture scale value meaning that if the texture scale 
was set to 1m for X, Y, and Z then a wavelength value of 1 would produce waves from each source exactly 1m 
apart. With the same scale if the wavelength value were set to 0.25 the results would be four waves per meter 
from each source as defined by the Wave Sources parameter.
Wave Speed (scalar) - Defines the speed of the wave in terms of distance from peak to peak per frame. For 
example given a Wave Length of 0.25 if the desired cycle point was at 60 frames into the animation the Wave 
Speed value would be 0.004166666667. This is the resulting number from dividing 0.25 by 60 (0.25/60).

Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Turbulence

The general purpose fractalized noise texture, Turbulence is good for various aspects of naturally occurring phenomena 
such as fire, water, wind, smoke, clouds, or adding dirt, grime, and age to otherwise clean it computer graphic looking 
surfaces.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Turbulent Noise

A multipurpose turbulent noise texture good for a wide variety of applications.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this nodes Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of this manual for these related features, you can get a very good 
idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.

Underwater

A procedural texture that produces double interlocking rebel patterns per wave source in order to approximate wavy 
water refraction patterns.

Unique Inputs

Wave Sources (scalar) - Defines the number of wave sources that interact with each other in order to create the 
overall Ripple texture effect. 

Each wave source is a spherical double ripple pattern. When a flat object surface for example, passes through 
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the center of a wave source it appears very much alike to the effect one sees by throwing a stone into a body of 
very still water.
Wavelength (scalar) - Defines the wave length of the wave sources. This is the length or distance between the 
double wave pattern. This value is in ratio to the texture scale value meaning that if the texture scale was set to 
1m for X, Y, and Z then a wavelength value of 1 would produce waves from each source exactly 0.5m apart. The 
reason we arrive at the value of 0.5 is because as mentioned this is a double wave pattern - meaning two 
concentric waves.
Wave Speed (scalar) - Defines the speed of the waves in terms of distance from peak to peak per frame. For 
example given a wave length of 0.25 if the desired cycle point was at 60 frames into the animation the Wave 
Speed value would be 0.004166666667. This is the resulting number from dividing 0.25 by 60 (0.25/60).
Band Sharpness (scalar) - Controls the sharpness of the gradient between wave peaks and valleys.

Edit Panel

Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Veins

A three dimensional cellular type texture that produces vein-like texture patterns.

Unique Inputs

Width (scalar) - Controls the width in percentage, of the veins. Smaller values produce narrower sharper veins.
Contrast (scalar) - Defines the amount of contrast in percentage values, between the vein areas and the spaces 
in between the veins.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

Wood

A three dimensional procedural texture that produces wood like ring patterns. This texture is not intended to produce a 
“photo-real” wood texture by itself alone but rather supply the user with the basic framework of a wood texture 
allowing users the freedom to add the kind of grain patterns and other details needed to produce the desired results.

Wood offers the ability to scale the transition gradient ramp of the rings.

Unique Inputs

Frequencies (scalar) - Defines the number of noise frequencies (0~31) used to affect the basic ring pattern. Each 
frequency introduces compound affecting noise patterns.
Turbulence (scalar) - Defines the amount of influence each frequency will have on the basic ring pattern. This 
setting is in ratio of to texture Scale value.
Ring Spacing (scalar) - Defines the spacing value between rings in terms of layout units usually meters. As 
opposed to some other seemingly similar textures the Wood texture Scale value has no affect on ring spacing.
Ring Sharpness (scalar) - Controls the position of the end of the gradient ramp from the foreground color or ring 
start, to the background color also offset from the ring start edge. 

You can think of each concentric ring as having a highly defined leading edge or “start” position and the Ring 
Sharpness as defining the thickness of each ring where the thickness is always a gradient from the foreground to 
the background color. 

Higher values produce narrower rings while lower values produce wider rings. A value of about 4 will produce a 
gradient ramp length that ends in about the middle of the ring before the affecting Turbulence is applied.
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Edit Panel

Axis are not offered as node connections in the Workspace area. Likewise Reference Object, World Coordinates and 
Automatic Sizing our features exclusive to this nodes Edit Panel. please see the explanation for these items in the 
chapter that covers texturing with the Surface Editor.

Wood 2

A three dimensional texture that produces a would like pattern of concentric rings. Wood2 offers the ability to phase the 
transition gradient ramp of the rings.

Unique Inputs

Ring Spacing (scalar) - Defiance the ring spacing in relationship to the texture Scale value. For example with a 
scale value of 1m for X, Y, and Z , a Ring Spacing value of 0.5 would result in a ring every 50cm or 2 rings per 
meter.
Phase (scalar) - The Phase value phases or “moves” the gradient transition in respect to the ring inner (start) and 
outer (end) edges.

Smaller values place the background to foreground gradient ramp start nearer the inner edge of the ring. Larger 
values place the gradient start nearer the outer edge of the ring. 

A Phase value of 0.5 will center the gradient peak between the beginning and end of the ring width.

The length of the gradient ramp is equal to the span of a single ring.
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Distortion (scalar) - Defines the amount of influence that Noise Scale may introduce to the shape of the rings.

Depending on the value of the noise scale this has the effect of “distorting” the otherwise concentric circular 
shape of the rings.
Noise Scale (scalar) - Defines the scale of the single noise pattern. 

Smaller values result in a smaller noise scale.

Edit Panel

fBm Noise

A fractional Brownian motion (fBm) fractal noise texture. The results of several scientific studies have shown that many 
real world textures have the same kind of spectra noise as produced by fBm making it a natural choice for various kinds 
of naturally occurring texture noises and patterns.
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Edit Panel

 
Reference Object, World Coordinates and Automatic Sizing are features exclusive to this nodes Edit Panel. Please see 
the explanation for these items in the chapter that covers texturing with the Surface Editor.

The Noise Type selection popup menu also remains a feature exclusive to this nodes Edit Panel. Without going beyond 
the descriptions offered in the Surface Editor section of this manual for these related features, you can get a very good 
idea of what each Noise Type looks like by following these few simple steps:

Set the texture Scale values small enough that you can see the full pattern of the texture on the geometry you’re 
working with.
Set Increment to zero.
Set Lacunarity to zero.
Set Octaves to zero.
Set the Offset value anywhere between 0.25 and 0.75
And select the various Noise Types one at a time while watching the VPR preview update.
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Additional

Particle Info

This node presents two dropdown menus to garner information from scene particles. Double-clicking the node will 
present a panel with a dropdown to choose the item providing the outputs and one for determining the use mode.

Particle - Choose the scene item emitting the particles you are interested in querying
Mode - Three choices:

Nearest - Uses the nearest particle based on its world position, probably the most useful choice
Polygon Index - Uses the Particle ID number to affect the polygons in your target object. By default, the 
Particle ID number used is 0
Point Index - Uses the Particle ID number to affect points in your target object. By default, the Particle ID 
number used is 0

Python

Adding this gives you a node with no inputs or outputs initially. Double clicking on the node will open a file requester to 
allow you to choose the python script of your choice.
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Constant

Click here to expand Table of Contents...
Angle

Edit Panel

Color
Edit Panel

Direction
Edit Panel

Integer
Edit Panel

Pi
Scalar

Edit Panel

Vector
Edit Panel

The nodes in this group are all single use nodes that contain a single value - a constant. They are used to represent 
Colors and various numbers in order to pipe into inputs. For example, you have a particular shade of red you wish to 
communicate to a bunch of nodes. You could either go into each node’s Fg Color field and put the red value in, or you 
could add a Color Constant node and pipe its output into the Fg Color inputs on all your nodes. That way you can also 
swiftly change the color if your director decides that black is the new red.
It’s also useful to use a Scalar constant as an input on the Scale vector input on procedural textures. That way you can 
change the scale for the X, Y, and Z values all in one go, rather than one by one.

Constants have no inputs.

Angle

This is a standalone node capable of outputting a single angular value as defined by the user. This can be used to drive 
any number of angular inputs, allowing them to be set up and controlled from a single node.

Edit Panel

Output Scalar

Color

This is a standalone node capable of outputting a single color as defined by the user. This can be used to drive any 
number of color inputs, allowing them to be set up and controlled from a single node.


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Edit Panel

Output Color

Direction

This is a standalone node capable of outputting a direction vector as defined by the user. This can be used to drive any 
number of direction inputs, allowing them to be set up and controlled from a single node.

Edit Panel

Output Vector

Integer

This is a standalone node capable of outputting an integer as defined by the user. This can be used to drive any number 
of integer inputs, allowing them to be set up and controlled from a single node.

Edit Panel

Output Integer

Pi

A standalone node with a constant Scalar output of the value Pi. This can be used to drive any number of inputs, 
allowing them to be set up and controlled from a single node. There is no Edit panel. This node outputs a high precision 
value of Pi - this number: 
3.14159265358979323846264338327950288419716939937510582097494459230781640628620899862803482534211706
7982148086513282306647093844609550582231725359408128481117450284102701938521105559644622948954930381
9644288109756659334461284756482337867831652712019091456485669234603486104543266482133936072602491412
7372458700660631558817488152092096282925409171536436789259036001133053054882046652138414695194151160

A good use for this node would be to add two integer constant nodes and connect them to the U Tile and V Tile 
inputs of all 2D nodes. This would allow the tiling of the entire texture to be controlled from two simple 
controls.


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9433057270365759591953092186117381932611793105118548074462379962749567351885752724891227938183011949
12 to be precise.

Scalar

This is a standalone node capable of outputting a scalar as defined by the user. This can be used to drive any number of 
scalar inputs, allowing them to be set up and controlled from a single node.

Edit Panel

Output Scalar

Vector

This is a standalone node capable of outputting a vector as defined by the user. This can be used to drive any number of 
vector inputs, allowing them to be set up and controlled from a single node.

Edit Panel

Output Vector
These two nodes are for managing object displacement in Layout and are covered in their appropriate chapters.
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Displacement

Click here to expand Table of Contents...
Deform Nodes

Deform: Bend
Deform: Pole
Deform: Rotate
Deform: Shear
Deform: Stretch
Deform: Taper
Deform: Transform
Deform: Translate
Deform: Twist
Deform: Vortex

Falloffs
Falloff: Axis
Falloff: Cubic
Falloff: Cylindrical
Falloff: Spherical

Deformer Examples
MDD Displacement
MetaLink

Deform Nodes

There are ten Deform nodes and four Falloff nodes to go with them. All ten have the following inputs:

Point Position (Vector) - position to deform
Falloff (Scalar) - falloff of effect Filter
Filter (Scalar) - fraction of deformation to apply

Some have one or more of the following inputs:

Base Control (Vector) - position of base control
Effect Handle Control (Vector) - position of effect handle control
Effect Center (Vector) - position of center of the box containing the effect
Effect Corner (Vector) - position of the corner of the box containing the effect
Angle (Scalar) - amount to rotate by
Stretch (Scalar) - stretch scaling amount
Scale (Vector) - scaling at effect center



These nodes might not have any function in surfacing per se. They both offer vector outputs that will change 
with every frame based on the movement of the vertices of the objects they reference. It is up to you, the user, 
to determine if they can fit into your surfacing pipeline and how.





LightWave 2020  –  LightWave 2020

Reference –  2414

•

•

•
•

•
•

Axis - axis for operation (defaults to +Z)

All have a single output:

Deformed - deformed position

Some nodes have settings that are accessed by double-clicking on the node concerned. All deal with how to interpret 
the axis value:

Vector - axis is given as a vector (will be normalized internally)
HPB Rotation - axis is given as heading, pitch, bank rotation of a +Z direction

Additional inputs and node settings will be listed for each node.

Deform: Bend

Node-specific:

Axis - axis from which to bend (defaults to +Z)
Settings? - Yes, double-click node to change

Deform: Pole

Deform: Rotate

Node-specific:
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Axis (Vector) - axis around which to rotate (defaults to +Z)
Settings? - Yes, double-click node to change

Deform: Shear

Node-specific:

Axis (Vector) - axis from which to shear (defaults to +Z)
Settings? - Yes, double-click node to change

Deform: Stretch

Deform: Taper

Node-specific:

Axis - axis of taper
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Base Taper - scaling at the base (X and Y components used, Z ignored)
Base Taper Axis - X taper direction for base
Effect Handle Taper - scaling at the effect handle (X and Y components used, Z ignored)
Effect Handle Taper Axis - X taper direction for effect handle
Settings? - Yes, double-click node to change

Deform: Transform

Node-specific:

Translation (Vector) - translation transform
Rotate (HPB) (Vector) - heading, pitch, bank rotation
Rotation Axis (Vector) - axis around which to rotate (for Rotation Angle)
Rotation Angle (Scalar) - angle to rotate by around Rotation Axis
Stretch (Vector) - scaling transform
Settings? - Yes, double-click node to change

Evaluation Order - order in which the transforms are applied

Deform: Translate

Node-specific:

Translation (Vector) - translation transform
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Deform: Twist

Node-specific:

Axis (Vector) - axis of twist
Twist (Scalar) - angle to twist by
Settings? - Yes, double-click node to change

Deform: Vortex

Node-specific:

Axis (Vector) - axis of vortex
Twist (Scalar) - angle to twist by
Settings? - Yes, double-click node to change

Falloffs

All Falloffs have a settings window opened by double-clicking on the node.

The two Axis Types are:
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Vector - axis is given as a vector (will be normalized internally)
HPB Rotation - axis is given as heading, pitch, bank rotation of a +Z direction

The Falloff Types are:

Linear - linear falloff (Power input is ignored), Range indicates where falloff reaches 1
Power - falloff is based on the distance, Range indicates where falloff reaches 1
Inverse Power - falloff is based on inverse distance, Range indicates where falloff reaches half

Equally, they all have two outputs:

Falloff - the falloff fraction (0 == no falloff, 1 == complete falloff)
Strength - the opposite of the falloff (1 - falloff)

Falloff: Axis

Falloff according to distance along an axis. The simplest of falloffs.

Base Position - position with no falloff
Axis - direction of falloff
Range - range over which the falloff occurs
Power - the falloff power

Falloff: Cubic

Falloff according to maximum of X, Y, Z distance from a center position

Center Position - position with no falloff
Orientation - rotation of the box
Range - range over which the falloff occurs
Power - the falloff power

Falloff: Cylindrical

Falloff according to perpendicular distance from an axis. Cylinder does not have an Axis Type.

Center Position - position with no falloff
Orientation - rotation of the cylinder
Range - range over which the falloff occurs
Power - the falloff power

Falloff: Spherical

Falloff according to distance from a center position

Center Position - position with no falloff
Orientation - rotation of the sphere

Sometimes it is easier to define the displacement based on how far away you are (in which case using Falloff is 
better).
Sometimes it is easier to create a displacement based on how strong the influence is (so you would use 
Strength).


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Range - range over which the falloff occurs
Power - the falloff power

Deformer Examples

Several examples to introduce how to set up deformers, including using multiple deformers for a single object.

MDD Displacement

The MDD Displacement node offers a single Vector output that is the result of the loaded VertCache file. There are 
several controls for playback:

Frame Offset - Allows delaying or bringing forward the start frame of the animation contained in the VertCache 
file
Replay Speed - Slows down or accelerates playback of the VertCache.
End Behavior - You can choose what happens when the end of the VertCache frame range if it is not the same as 
your scene frame range. The choices are

Stop - Animation playback stops on the last frame of the VertCache
Loop - Animation recommences playback from the first frame
PingPong - Animation reverses direction playing back last frame to first, then back again

Scale - This value sizes the object to which the VertCache is applied and uses the Units measurement below
Match By - The choice is between Coordinates and Nodes . Coordinates will be used for MDD files, but other sorts 
of VertCache can also use nodally-based systems.

MetaLink

Metalink is a very powerful tool that allows you to use the dynamic motion from one object and apply it to another. In 
most cases the dynamic object contains very few polygons (2-point polygons) while the “MetaLink” object has a higher 
polygon count.
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Distance Tools

Distance functions drive the iso-surface boundary finding. A simple node showing the sphere primitive shape in an 
empty volume.

SDF Sphere.7z

A rounded box derived from http://iquilezles.org/www/articles/distfunctions/distfunctions.htm 

SDF Rounded Box.7z

Distance Tools

Distance Tools menu heading contains nodes to create or modify distance functions.

https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Sphere.7z?api=v2&modificationDate=1549356941000&version=1
http://iquilezles.org/www/articles/distfunctions/distfunctions.htm
https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Rounded%20Box.7z?api=v2&modificationDate=1549357009000&version=1
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Capsule

SDF Capsule Compound.7z
The capsule node relies on positional information based on the End A and End B inputs, or two items (nulls were made 
for the preset) to form each end of the capsule.

The capsule inputs determine:

Position - the location of the capsule shape. Usually the object itself, however, this can be driven by nodes
End A - One end of the capsule shape
End B - Opposite end of the capsule shape
Radius - the radius of the capsule shape

Setting both the end values to 0 will produce a spherical shape.

The attached surface preset available here relies on positional information for two items (nulls were made for this) to 
form each end of the capsule. The first input is taken from the Input node's World Position, and the Radius is based on a 
Scalar constant. The attached surface preset merely renames the inputs to make them easier to understand.

Mobius

A twisted set of a single ring. The inputs determine:

Radius - The overall size of the ring set
Cylinder Radius - The radius of the cylinder that is being twisted
Group Radius - How tightly packed the ring is
Order - How many apparent rings are being twisted together
Twist - The spiraling of each apparent ring
Coil - The spiraling of the total rings

Shape CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

https://docs.lightwave3d.com/download/attachments/8198081/SDF%20Capsule%20Compound.7z?api=v2&modificationDate=1549357089000&version=1
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Union - Combines the two shapes
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B

Using the Shape CSG node can create interesting effects. Here, a Scalar attached to a procedural texture controls the 
CSG effect

SmoothMin

Will blend between the Results from two SDF shapes with a user-definable radius.

The two shapes must be built in the same Empty Volume for Shape CSG to work. At this time, the Capsule and 
Mobius preset nodes are the only two currently available to work with, but shapes created - such as the 
spheres above - can also use the Shape CSG node



https://docs.lightwave3d.com/download/attachments/8198543/corruption.mp4?api=v2&modificationDate=1527600969000&version=1


LightWave 2020  –  LightWave 2020

Reference –  2423

Smooth Min adds three shapes using a blend

Additional Nodes

You can use a Vector Mod(ulo) for repetition. The initial Empty Volume radius determines how many shapes will fill it. 
The Vector Mod can be left at 1.0, 1.0, 1.0 and the Scalar will determine the size of the individual shapes

A grid of SDF spheres

A texture distortion of the above distance field.



LightWave 2020  –  LightWave 2020

Reference –  2424

Use a Vector Max when constructing unsigned shapes, with a per axis maximum.
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FiberFX Group

FiberInfo

Fiber U/V - The position of the evaluation around (U) and down (V) the length of the fiber. V starts from 0.0 at the 
root to 1.0 at the tip. Use this as an input to opacity on a node to control effect strength down the length of your 
fibers.
Poly Normal - The normal vector coordinates of the underlying polygon that the fiber is growing from.
Poly Center Position - The center position of the underlying polygon that the fiber is growing from.
Offset - The offset position of the fiber currently being evaluated.
Fiber Tangent - Vector pointing towards fiber tip.
Fiber Tangent Normal - Vector pointing outwards from fiber curve.
Fiber Tangent BiNormal - Vector completing the orthonormal basis. The cross product of tangent and tangent 
normal.
Fiber Tangent World - Vector pointing towards fiber tip transformed into world space coordinates.
Fiber Tangent Normal World - Vector pointing outwards from fiber curve transformed into world space 
coordinates.
Fiber Tangent BiNormal World - Vector completing the orthonormal basis. The cross product of tangent and 
tangent normal transformed into world space coordinates.
Fiber Base Position - Position in local coordinates of the base of each fiber currently being evaluated.
Fiber Edge Position - Start position in local coordinates of the edge currently being evaluated.
Fiber Number - Returns the fiber number that is being evaluated.
Offset Amt - The offset of each added fiber from the parent guide fiber.
Cluster - Returns the fiber’s Cluster number. Use it to determine if a clustered fiber is being evaluated.
To Up Right - Transform from polygon coordinates to up right.
To Up Up - Transform from polygon coordinates to up up.
To Up Forward - Transform from polygon coordinates to up forward.
From Up Right - Transform from up right to polygon coordinates.
From Up Up - Transform from up up to polygon coordinates.
From Up Forward - Transform from up forward to polygon coordinates.
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Double clicking the FiberInfo node presents a window allowing the user to choose which FiberFX object is being used 
for evaluation:
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Flocking Group

AgentInfo

Provides a vector output for a flock's Position, Velocity and Bank Up Vector.
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Fresnel Functions

These fresnels are designed to work with shader components so that as roughness increases, the fresnel 
function is modified. The standard fresnel does not modify the shader.

Fresnel Conductor - The same effect as using a Conductor node
Fresnel Dielectric - The same effect as using a Dielectric node
Fresnel Iridescent - A perfect way to create iridescent effects. Change the quantity of Iridescence to 100 % to 
start with and just adjust the Thickness to see the colored effect. You won't need to adjust the Wavelength 
settings or Refraction Index normally, they are there for added control.
Fresnel Multiply - Multiplies two Fresnel functions together for further control
Fresnel Schlick - Schlick's approximation is a fast way of creating a fresnel effects that eschews physical 
correctness for speed and artistic control
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Functions

Click here to expand Table of Contents...
Bias

Edit Panel

BoxStep
Edit Panel

Gain
Edit Panel

Gamma
Edit Panel

Light Falloff
Edit Panel

Modulate
Edit Panel

Noise
Edit Panel

Sine
Edit Panel

SmoothStep
Edit Panel

Wrap
Unique Inputs

The nodes in this section are mathematical functions to control other inputs. They are noted by their yellow input and 
output icons.

Bias

The Bias function allows the brightness of the connected node to be controlled. This function node provides a standard 
bias function. Bias is a specific function that can be used to control the brightness on any texture with a function input. 
This function acts much like the brightness control on a television.


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Edit Panel

Connect the result output to the function input on any texture node (3D or 2D). By adjusting the Bias control you can 
then control the brightness of the attached node.

BoxStep

The Box Step function allows a connected node to be clamped between two specified values.This function node 
provides a box step function. A box step is a ramped step between two user specified values. This function effectively 
clips the connected texture, allowing flats and plateaus to be created.

Edit Panel

 
Connect the result output to the function input on any texture node (3D or 2D). By adjusting the Begin and End points, 
the valleys and peaks of the connected texture can be flattened.

Gain

The Gain function allows the contrast of the connected node to be controlled. This function node provides a standard 
gain function. Gain is a specific function that can be used to control the contrast on any texture with a function input. 
This function acts much like the contrast control on a television.
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Edit Panel

 
Connect the result output to the function input on any texture node (3D or 2D). By adjusting the Gain control you can 
then control the contrast of the attached node.

Gamma

The Gamma function allows the connected node to be gamma corrected. This function node provides a standard 
gamma correction function. Gamma correction is a function that adjusts the brightness and contrast simultaneously.

Edit Panel

 
Connect the result output to the function input on any texture node (3D or 2D). By adjusting the Gamma control you can 
then control the brightness and contrast of the attached node.

Light Falloff

This node allows you to create your own falloffs for lights rather than using none or the standard Inverse Distance^2. 
The outputs are color to hook directly into the Light Shader destination node.
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Edit Panel

Double-clicking the node presents a panel to enter the range/nominal distance manually rather than hooking in the 
Distance output. An Envelope can also be used for a distance that changes over time.

Modulate

The Modulate node allows two functions to be combined in a variety of ways. This function node provides a method 
that allows two other functions to be combined. The combination may be Add, Subtract, Multiply, Maximum, or 
Minimum. This node extends the tools available for creating new functions by combining two others.

Edit Panel

Noise

The Noise function allows the connected nodes texture blending to be disturbed. This function node provides a 
standard noise function. The noise function is a standard Perlin noise function, which can be used disturb the blending 
or transition of the attached texture.

Edit Panel

 
Connect the result output to the function input on any texture node (3D or 2D). You can now disturb and add noise to 
the transition of the attached texture.
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Sine

The Sine function allows the connected nodes texture blending to be sine modulated. This function node provides a 
standard sine function. This can then be used to modulate the blending of the attached texture. The sine function may 
also be shifted to provide a cosine as required.

Edit Panel

SmoothStep

The Smooth Step function allows a connected node to be clamped and then smoothed between to user specified 
values. This function node provides a smooth step function. A smooth step is a ramped step between two user specified 
values that has been smoothed so that the transition is more rounded. This function effectively clips the connected 
texture allowing flats and plateaus to be created, much like box step except the transitions are rounded.

Edit Panel

Wrap

The Wrap node allows a scalar output to be post-processed using a function. This node allows the scalar output from a 
texture to be modified by a function. Effectively, this allows the output from a texture to be transformed by a function 
without the need to use the dedicated function input. This makes it ideal for use when the final output is the result of a 
mathematical node. There is no Edit Panel.

This may be used in preference to the BoxStep function, as it provides automatic anti-aliasing.
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Unique Inputs

Input (Scalar) - A link only input. The scalar to be modified by the function should be connected to this input.
Function (Function) - The function input. The function required to modify the scalar should be connected to this 
input.
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Gradient

Click here to expand Table of Contents...
Tools

Incidence
Thickness

Curve
Inputs
Edit Panel

Gradient
Unique Inputs
Edit Panel
Basic Gradient Creation
Individual Key Editing
Driving the Gradient

The nodes in this group are all related to the gradient in the normal Surface Editor and present two different ways of 
creating gradients.

Tools

Incidence

The Incidence node derives the angle between the current hit point and the camera. It may also be used to derive the 
angle between the current hit point and any arbitrary vector. When a polygon is completely facing the camera, the 
output will be 1.0. When it is parallel to the camera, it will have what's called a glancing angle and the output will be 0.0.

Vector - By default, the Result output is defined as the angle between the viewing vector and the normal at the 
current hit point. However, any vector can be used to replace the viewing vector. For example, you may wish to 
drive the Vector input from a Make Vector node and define the input vector as 0.0, 1.0, and 0.0 for X, Y and Z 
respectively. This means that the Result output will the angle between hit point and a vector defined as being 
straight up. The output will then appear as a “snow cap” for the current object.
Normal - The Normal input allows the angle to be perturbed. This input can be driven with any normal and is 
perturbed by the direction of that normal for the current hit point.

Incidence outputs a Scalar of the angle generated by the Vector input and Normal input. Double-clicking on the node 
presents the possibility to Invert the output (or you could insert an Invert node). You can make the range over 90 or 180 
degrees. This is to cover situations where highly reflective objects can sometimes have reflections from behind the 
outside curve of the object - think of a chrome ball where highly-lit reflections from the back side can be visible.


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Thickness

The Thickness node derives the thickness as defined by the length from the current hit point to the back of the object. 
This node provides a thickness function by firing a ray from the current hit point to the back of the object. This distance 
is output as the Length. For this node to function correctly, ray tracing must be enabled by checking anyone of the four 
ray trace options (i.e. ray trace shadows, transparency, reflection or refraction) in the rendering options. The object 
must also have the double sided option enabled or all of the polygons correctly aligned so that the rays fired back to 
determine the thickness have something to hit.

Curve

The Curve gradient node uses a graph editor to create a color gradient. Using red, blue and green color channels, as well 
as an alpha channel, limitless color gradients are available. The Curve Editor works much like the Graph Editor, you can 
add/subtract and edit keys and change the type of curve. The Curve Editor has the advantage of being able to tie into 
the Graph Editor via envelopes to have animated curves.

Inputs

Bg Color - Can receive colors and patterns from other nodes in the network. Users may also specify a color using 
the controls found in the Edit Panel for this node.

Specifies the color of the background color layer.
Blending - Can receive input from other nodes in the network or can be specified to by selecting a blending 
mode from the Blending pull-down menu in the Edit Panel for the node.

For general use specifying the blending mode by using the Blending pull-down menu in the Edit Panel will 
probably be the most desirable method of use. However, for larger networks where control of the blending 
modes of many texture nodes simultaneously is needed or when conditional blending is desired then using a 
node connection to control this value may be advantageous.
Input - The output color and alpha are derived using the gradient based on this input.
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1.
2.
3.

Edit Panel

Bg Color
Blending Menu
Input Menu - If nothing is attached to the Input for the Curve node, five choices are presented:
X Coordinate - where the output is interpolated based on the gradient using the object’s X coordinate for the 
current hit point as the input.
Y Coordinate - where the output is interpolated based on the gradient using the object’s Y coordinate for the 
current hit point as the input.
Z Coordinate - where the output is interpolated based on the gradient using the objects Z coordinate for the 
current hit point as the input.
Slope - where the output is interpolated based on the gradient using the angle between the current hit point and 
the object’s up direction as the input.
Incidence - where the output is interpolated based on the gradient using the angle between the current hit point 
and the camera’s viewing direction as the input.
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10.
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Edit Menu - presents these options:
Delete Selected Keys - This function deletes any selected keys.
Undo/Redo - This function will undo or redo a function performed in the curve editor.
Purge Undos - Removes the Undo stack
Select All - Selects all selectable keys in the curve editor
Clear Selection - Clears all selected keys
Invert Selection - Keys that are selected will no longer be selected and keys that are not selected will now be 
selected
Copy/Cut/Paste - These functions will copy, cut or paste keys in the curve editor
Fit All - The function will fit all keys into the view
Fit Selected - This function will fit the selected keys into the view
Line Antialiasing - This toggle will antialias curves
High Quality Lines - This toggle will change between a quickly-drawn curve and a more accurate one
Show Control Points - Toggles the control handles for the keys

Add Keys will add additional keys to the Curve Editor when the button is activated and you click the LMB on the 
curve window. Stretch mode will move the keys when activated and you click the LMB. LMB stretches the values 
(Y), and holding down Ctrl stretches the positions (X).
Pan and Zoom buttons.
Value and Position - Specifies the value and position for the selected key. The values can be enveloped.
Curve Menu - Selects the specific curve type to be used for the selected key.
Lock CP - Locks the curve control point. Unlocking allows each side of the control point to be edited individually.
Channels - Selected channels will be highlighted. Multiple channels can be selected at once and the selected 
channels will receive any editing done by the user.

Gradient

This node allows for either a color or an alpha gradient to be created. This gradient is then interpolated based on the 
input. The input may come from an external connected source such as a texture node or from one of the user selectable 
internal sources (e.g. Slope).

Unique Inputs

Key(n) Color (Color), Key(n) Pos (Scalar), Key(n) Alpha (Scalar) - When the Show Output toggle is engaged for a 
key, these inputs will appear on the node so you can hook up other nodes to them.
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Edit Panel

Basic Gradient Creation

In its simplest form, the gradient node allows a color gradient to be created. In the bottom of the edit panel you can see 
a vertically aligned gradient. The range of the gradient is defined by the start and end values at the top and bottom of 
the gradient. These can be changed as required for different input ranges. For example, with the thickness you may 
wish to define a range from 0.0 to 10.0 meters. This can be achieved by editing these boxes.

You can add keys by clicking at the required insertion point on the gradient. Keys may be moved by clicking and 
dragging its associated square (on the left of each key). A single click on a key’s square will select it. The currently 
selected key will have its bar turn white.

Keys may be deleted by clicking the X on the right of the bar.
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Previous Key and Next Key - These are for cycling through the keys in a gradient
Invert Values - inverts (top to bottom) the values on all the keys in the gradient
Distribute Keys - spreads the keys out evenly between the top and bottom of the gradient
Fit All - Resizes the gradient so that all keys are visible by changing the End value appropriately

Individual Key Editing

Once the range has been set and keys added, these can be edited individually using the control in the section above the 
gradient.

The Key text box will display the name of the currently selected key.

Show Output - this check box allows the currently selected key to be added to the nodal inputs (i.e. the inputs 
will appear on the node and may then be connected to). When this is enabled Color, Position, and Alpha inputs 
are added for that key. This allows these parameters to be driven from other nodes so you could, for example, 
have the color for a key driven by the color output from a texture node.

Color - allows the color for that key to be defined. The output of the gradient is defined by the color of each key. 
Each key color can be enveloped and changed over time.
Alpha - allows the alpha value for that key to be defined. The alpha values primarily define how the current 
gradient is blended with the Bg Color. The blending is defined by the user controlled Blending input. The 
different blending modes are covered in the Reference Section on Blending Modes. Again, the alpha values may 
be enveloped and change over time.
Position - defines the position of the key on the gradient. For the key to appear on the gradient, the value must 
be between the start and end values (or equal to one of them). The key positions can be enveloped and changed 
over time. It is possible to provide a position outside the range of the gradient. This means that the key will not 
appear on the gradient and may only be selected using the Previous and Next Key selection buttons.
Smoothing - defines the transition from the current key to the next. By default, this is a blend based on a Hermite 
curve. However, this also can be Linear for a straight blend, Step for a discrete step, or Bezier for a blend based 
on a Bezier curve.

Driving the Gradient

The color output is defined by the gradient and some input. The input may be from an external node driving the Input 
node or from an internally-selected gradient type. Essentially, the gradient provides a look-up table of colors. The input 
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(internal or external) provides a position on the gradient. This gradient then uses the keys to interpolate an output color 
and alpha based on the input.

With nothing connected to external Input the gradient type may be selected using the Input drop down list. The choices 
are:

X Coordinate - where the output is interpolated based on the gradient using the object’s X coordinate for the 
current hit point as the input.
Y Coordinate - where the output is interpolated based on the gradient using the object’s Y coordinate for the 
current hit point as the input.
Z Coordinate - where the output is interpolated based on the gradient using the object’s Z coordinate for the 
current hit point as the input.
Slope - where the output is interpolated based on the gradient using the angle between the current hit point and 
the camera’s up direction as the input.
Incidence - where the output is interpolated based on the gradient using the angle between the current hit point 
and the camera’s viewing direction as the input.When the external Input is connected to another node, these 
options become unavailable, and then the output is based on the gradient using the connected node as the 
input.
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Item Info

Click here to expand Table of Contents...
Bone ID
Bone Info
Camera

Outputs
Edit Panel

Device
Dynamics Part Info
Item ID
Item Info

Edit Panel

Light Info
Outputs

Mesh Info
Mesh Part

Inputs
Outputs:

Mesh Tangent
Mesh Vertex Find
Studio Trait
Time

Outputs:

This group contains nodes to control or be controlled by scene items. Those items could be Objects, Lights, Cameras or 
control surfaces like 3D mice. If you need to base your surface on the position or rotation of one of these items you’ll 
need these nodes.

Bone ID

Select the object and appropriate bone and the node outputs the bone state.

Bone Info

Outputs bone item ID, and the item ID of the owning object, of the bone selected in its settings.


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Camera

This is a standalone node that provides access to a camera’s current settings. Any of the cameras in the current scene 
may be selected by double-clicking on the node. The outputs are then derived from the settings for the selected 
camera.

Outputs

Zoom Factor (Scalar) - The Zoom Factor output is taken from the zoom factor as defined for the selected camera.
Focal Length (Scalar) - The Focal Length output is taken from the lens focal length as defined for the selected 
camera.
Focal Distance (Scalar) - This value is taken from the DOF tab Focal Distance value for the current frame.
Lens F-Stop (Scalar) - This value is taken from the DOF tab Focal Distance value for the current frame.
Blur Length (Scalar) - The Blur Length output is taken from the blur length as defined for the selected camera.
Horizontal FOV (Scalar) - The Horizontal FOV output is taken from the horizontal FOV as defined for the selected 
camera.
Vertical FOV (Scalar) - The Vertical FOV output is taken from the vertical FOV as defined for the selected camera.
Width (Integer) - The Width output is taken from the image width as defined for the selected camera.
Height (Integer) - The Height output is taken from the image height as defined for the selected camera.
Pixel Width (Scalar) - The Pixel Width output is taken from the pixel width ratio as defined for the selected 
camera.
Eye Separation (Scalar) - The Eye Separation output is taken from the eye separation as defined for the selected 
camera when stereoscopic rendering is enabled.

Edit Panel

The Render Camera is the one used on a specific frame for rendering but you can also choose other scene cameras if 
you want to base the surface on a camera positioned differently.

Device

The Device node initially appears with no connections at all. You will need to double-click on it to open this requester:

You can either type over the (enter name) text or select from the dropdown menu. If your devices are not found you may 
need to visit the Virtual Studio > Device Manager window and make sure the device type you wish to use is enabled. 
Manager Names choices are:

HID - The Microsoft Human Interface Device standard is home to many mice and other devices and is your first 
port of call
Intersense - A manufacturer of high-end virtual cameras
Kinect for Windows - to use the Kinect device for motion capture or surfacing
PS3 Move.Me - A system to use the PlayStation 3 Eye Toy camera
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Device Name can be a vast list of devices if HID is chosen as the Manager type. Once you have chosen a Manager and 
Device, the Device icon will look like this:

You can now connect the outputs from this device into your network. Most devices aren’t very useful for creating a 
surface, this one is more useful for the Virtual Studio part of Layout. However, they are still available since The Control 
Booth panel part of Virtual Studio does have access to the button presses for Virtual Studio devices. An LScript or 
Python script or Generic plugin can be assigned to the button press. Arguments to pass to the command can be 
specified in the Control Booth as well.

Dynamics Part Info

For use with Bullet Dynamics object, this node enables control over the individual elements of a Parts object. This node 
has no panel just connections.

Inputs are the Item ID of the dynamics body, and either the Part Number or the Polygon Index. If the part number is 
connected it will use that part, otherwise it will use the polygon index to figure out the part that the polygon is in. If the 
item or polygon index are not connected, the node will get them from the evaluation context.

Outputs are:

Part Number - the index of the part
Internal Polygon - 1 if the polygon is currently internal, 0 otherwise
Part World Position/Right/Up/Forward/Rotation - current transform of the part in world coordinates

For parts objects, internal polygons are those that join two parts together. When the parts break those polygon stop 
being internal and become part of the outer surface.

If the object is transparent, like glass, you probably don't want internal polygons to show until the glass fractures. You 
can achieve that in a nodal shader by hooking the Internal Polygon output to the Clip input of the Surface node. Or 
alternatively use it to switch between two different materials or material properties.
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Another use of the Dynamics Part Info node is in a nodal motion setup to track the position and orientation of a 
particular dynamic part. Hook up an Item ID node to the Item ID input to select the dynamics item, an Integer constant 
node to the part number to select the part, and use the part position and rotation outputs to get the motion.

Note that the position and orientation is for the center of mass of the part, not the pivot of the item.

Item ID

Double-clicking on this node will open a window with all scene items in a dropdown list. The single integer output gives 
the item's ID.

Item Info

This node can report on an item in a scene: Object, Light or Camera (for Bones, use the Bone Info node). It gives details 
the item’s position, rotation and other vector information.

Edit Panel

Light Info

This is a standalone node that provides access to a light’s current settings. Any of the lights in the current scene may be 
selected by double clicking on the node. The outputs are then derived from the settings for the selected light.

Outputs

Color (Color) - The Color output is taken from the color selected for the light.
Range (Scalar) - This is the value set when Falloff is engaged. If no falloff has been used, the value is 1.0.
Intensity (Scalar) - Based on the Intensity set in Light Properties.

Note that this node works from Frame 1 of a dynamics simulation. At Frame 0 it is not yet activated

New to 2018

Item Info now has an Item ID input rather than just double-clicking on the node to choose a scene item.

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Shadow Color (Color) - Taken from the setting on the Shadow tab.
Direction (Vector) - For a directional light, like the Dome or Area, this is the vector for the direction. For a Point or 
Spherical light this is 0, 0, 0.

Mesh Info

Input item ID of an object and a point index, outputs info about that point.

Mesh Part

Gets information about the mesh part the current vertex is in

Inputs

Object - mesh item to get part info from (defaults to the object being evaluated)

Outputs:

Part Index (Integer) - index number of part
Part Center (Vector) - center position of the part
Part Box Min, Part Box Max (Vector) - the bounding box of the part
Part Normal (Vector) - normal of the first polygon of the part

Mesh Tangent

Input item ID of an object and a point index, outputs the tangent, normal, and binormal directions at that point. 
Tangent is based on texture coordinate direction specified in the node's settings.

Mesh Vertex Find

Input item ID of an object and a position in object coordinates, outputs the point index of the vertex matching that 
position in either base or final deformed coordinates depending on the node's settings.

Studio Trait

This node is intended for use with LightWave’s Virtual Studio. It can be made use of in the Surface Editor, but similar 
outputs are available without the setup needed to use a Studio Trait node. If you would still like to use it, you will need 
to choose your scene item, go into its Motion Options and add the Virtual Studio Trait modifier. At that point, it 
becomes visible to the Studio Trait node and can be selected. You will get vector outputs of Position, Rotation and 
Scale.

Time

Information about the current scene time and frame

Outputs:

Time (Scalar) - The current frame time
Frame (Integer) - The current frame
Blurred Time (Scalar) - The current frame time plus any offset due to motion blur
Blur Fraction (Scalar) - The motion blur fraction of the current evaluation (0 == start of blur, 1 == end of blur)
Frame Start (Scalar) - Start time of the current frame
Frame Duration (Scalar) - Integration time of the current frame (i.e. the motion blur duration)
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Frame Stride (Scalar) - Time between the start of this frame and the next
FPS (Scalar) - Scene Frames per second setting
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Layers Group Nodes

These nodes allow access to the standard layered procedural textures within LightWave. The primary role of this 
component is to allow the integration of LightWave’s layered procedural texture and gradient scheme into the nodal 
domain. 

Bump Layer
Color Layer
Scalar Layer

Bump Layer

The interface for the Bump Layer node is the same as that for a standard LightWave texture layer. For more information 
on this, see reference LW Layer Texture Documentation. The only difference here is that the background for the texture 
is available as a connectable Bump input and an Alpha output is available as a scalar, based on the last texture layer’s 
result.

Edit Panel
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Color Layer

The interface for the Color Layer mode is the same as that for a standard LightWave texture layer. For more information 
on this, see reference LW Layer Texture Documentation. The only difference here is that the background for the texture 
is available as a connectable Color input and an Alpha output is available as a scalar, based on the last texture layer’s 
result.

Edit Panel

Scalar Layer

All the other types of Surface Channels in the Surface Editor are based on Scalars - values of 0-100% for the most part. 
The interface for the Scalar Layer node is the same as that for a standard LightWave texture layer. For more information 
on this, see reference LW Layer Texture Documentation. The only difference here is that the background for the texture 
is available as a connectable Scalar input and an Alpha output is available, based on the last texture layer’s result.
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Material Components

Click here to expand Table of Contents...
Introduction
Components List

Beckmann
Blinn
GGX
Lambert
Oren-Nayar
SSS
Specular

Introduction

The two types of component here are used for reflection and transparency and are fully named:

Bidirectional Reflection Distribution Function
Bidirectional Transmittance Distribution Function

Each has further options that are revealed by double-clicking on the nodes.

Components List

Beckmann

Good for metals or glass, hard glossy specular surfaces that have very short tails for specular highlights.

Blinn

One of the oldest material components for glossy specular reflectance, this along with Lambert was the basis for 
LightWave surfacing in LightWave 2015 and before.



Basic Terminology

"Reflection from surfaces can be split into four broad categories: diffuse, glossy specular, perfect specular and 
retro-reflective. Diffuse surfaces scatter light equally in all directions. Most real surfaces exhibit reflection that 
is a mixture of these four types. Although a perfectly diffuse surface isn't physically realizable, examples of 
near-diffuse surfaces include dull chalkboards and matte paint. Glossy specular surfaces such as plastic or 
high-gloss paint scatter light preferentially in a set of reflected directions - they show blurry reflections of other 
objects. Perfect specular surfaces scatter incident light in a single outgoing direction. Mirrors and glass are 
examples of perfect specular surfaces. Finally, Retro-Reflective surfaces like velvet or the Earth's moon 
scatter light primarily back along the incident direction."

- Physically Based Rendering 2nd Edition, Matt Pharr, Wenzel Jakob and Greg Humphreys


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GGX

GGX is Walter, Marschner, Li and Torrance's expansion on the Generalized Trowbridge-Reitz model for shading of 
metallic surfaces. This is currently the cutting edge for glossy specular reflection, with a longer tail for specular 
reflections.

Lambert

The simplest form of diffuse reflection, also a staple for LightWave up to 2015.

Oren-Nayar

A shader updated from Lambert that deals with matte surfaces in a far more realistic manner.

SSS

A simple subsurface scattering shader. It has no forward/back scattering switch, but will be faster than using the SSS 
from a more complex shader like PBSDF.

Specular

A simple specular shader with no reaction to lights, etc. It uses one sample. Extremely fast if you just want glass or liquid 
that doesn't react to scene lights.
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Material Integrators

Illumination

Allows you to use materials for texture production in other materials.

Outputs

Color - A combined result of direct and indirect lighting
Direct - Only the direct lighting on the shading model
Indirect - Only indirect lighting, such as bounced radiosity light, on the shading model

Using a Lambert BRDF piped through the Illumination node into a gradient can create a simple, customizable cel 
shading method
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Slightly more complex, but very satisfying. Create surfaces where the yellow texture you see moves around the sphere 
as the light plays over it
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Material Tools

Material Tools are nodes that help mix two or more Materials together. They all take Materials as inputs.

Material Mixer — Gives you two inputs to blend materials with an Alpha to decide between them.
Mesh Element Switch — This Material Tool node allows you to shade individual parts of your objects. Where the Edges for 
objects allowed simple color and texture settings, this node will allow full material use for parts of an object.
Multi Switch — This node can add as many Material inputs as you like and switch between them using an integer switch 
(you can also use a scalar).
Ray Type Switch — This switch node will take the Ray Type output from the Surface Editor Input node and allow you to 
specify a different material depending on the type of ray encountered.
Switch — The Switch node simply switches between two materials based on an Integer input. Often, it will be used to 
surface things differently depending on what side is showing to the camera. Note that this functionality cannot be applied to 
primitive objects, only polygonal.
Combine Materials — Nodes to combine materials in different ways
Layer Materials
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Material Mixer

Gives you two inputs to blend materials with an Alpha to decide between them. 
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Mesh Element Switch

This Material Tool node allows you to shade individual parts of your objects. Where the Edges for objects allowed 
simple color and texture settings, this node will allow full material use for parts of an object. 

This switch gives you complete control over how the edges of your objects are surfaced. In previous versions of 
LightWave, you could determine a border for your objects that could be colored. In LightWave 11.5 nodal control of 
edge coloring and taper was added but it was strictly color or procedural texture-based. In 2015 more edge types 
including Intersection were added, but still on the same basis. Now in 2018, we offer the choice of simply coloring edges 
as LightWave has offered for a decade or more, nodally coloring edges as introduced in LightWave 11.5 or now fully 
shading edges and other mesh elements. To switch between these different styles, use the Object Properties panel:
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In the image, Silhouette Edges are thicker than Sharp Creases and both are controlled with the Mesh Element Switch

The PBSDF material shades the polygons of our cube. The first Conductor node gives us the silvery silhouette edges, while 
the gold Conductor gives us the Sharp Creases

Polygon (Material)

The main input for shading your objects. Input your material for the object surface here, and add additional materials 
for the edges you wish to shade.

Edge (Material)

This input acts as an override for the more-specific input listed afterwards. If you have nothing in them, the Edges input 
will provide shading if they are selected in Object Properties.

Edge Silhouette, Edge Unshared, Edge Sharp Crease, Edge Surface Border, Edge Intersection (Material)

Edge types. If these are not connected up with their own materials, the general Edges material will be used. The Edge 
types are described here.

Line, Partigon, Point (Material)

These mesh elements are for two-point polygons, objects parts and single-point polygons created in Modeler,
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Multi Switch

This node can add as many Material inputs as you like and switch between them using an integer switch (you can also 
use a scalar).

Edit Panel

Add Input adds a new Input to the node and the dropdown list in the panel can be used to select an input that can be 
removed with the Remove Input button.
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Ray Type Switch

This switch node will take the Ray Type output from the Surface Editor Input node and allow you to specify a different 
material depending on the type of ray encountered. 

Ray Type - Should be hooked to the Ray Type output from the Input node
Default - This is the override material input. Materials hooked to this will be used for all other ray types if 
nothing is hooked to them
Reflection - For inputting a different material for Reflection rays
Refraction - For inputting a different material for Refraction rays
Dissolve - For inputting a different material for Dissolve rays
Shadow - For inputting a different material for Shadow rays
Occlusion - For inputting a different material for Occlusion rays
Radiosity - For inputting a different material for Radiosity rays
Caustics - For inputting a different material for Caustics rays

Example - Ray Type Switch



LightWave 2020  –  LightWave 2020

Reference –  2462

Switch

The Switch node simply switches between two materials based on an Integer input. Often, it will be used to surface 
things differently depending on what side is showing to the camera. Note that this functionality cannot be applied to 
primitive objects, only polygonal. 
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Combine Materials

Click here to expand Table of Contents...

Add Materials
Layer Materials
Multiply Material
Scale Material

Add Materials

Combine materials in a straightforward add operation. The result of this operation is not energy conserving, even if the 
original materials are.

Layer Materials

Layers two materials using the top material's weight so that the result is energy conserving.

Example - Layer Material Components

Multiply Material

Tints the material using a color input.

Scale Material

Changes a material's intensity using a scalar input.
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Layer Materials

This deceptively simple node is designed to add Material components together to create new, custom materials. The 
node has no interface, just two inputs counterintuitively named, and a single Material output.

Because LightWave wants to start evaluating any stack of material components from the bottom to the top, the inputs 
are so ordered. Inputting different Material components can create materials impossible otherwise, or can enhance 
existing materials - if you want a carpaint whose clearcoat can be more actively controlled, use Layer Materials to join a 
Carpaint material with a GGX BRDF to create a unique iridescent Clearcoat finish like so:
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Materials

The Material nodes combine features of existing nodes into a more convenient and easier to use node system. The 
Material nodes duplicate specific surfaces, but can still access the power of the node system. Several types of material 
nodes are available. They have an offwhite-colored output that can only be linked to the offwhite-colored input on the 
destination Surface node.

CarPaint
Conductor
Delta
Dielectric
Hair
Principled BSDF
Sigma
Sigma2
Skin
Standard
Unreal
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CarPaint

Click here to expand Table of Contents...

Paint Color (Color)
Paint Specularity (Scalar)
Paint Roughness (Scalar)
Paint Bump Height (Scalar)
Iridescence (Scalar)
Thickness (Scalar)
Wavelength (Vector)
Refraction Index (Scalar)
Clearcoat Specularity (Scalar)
Clearcoat Roughness (Scalar)
Clearcoat Bump Height (Scalar)
Flake Height (Scalar)
Flake Density (Scalar)
Flake Distance Falloff (Scalar)
Flake Scale (Scalar)
Paint / Clearcoat Normal (Vector)
Paint / Clearcoat Bump (Vector)

CarPaint

CarPaint is a material for creating vehicle paint-like effects. It has settings to create varying depths of varnish (called 
Clearcoat) and the ability to have iridescent effects.
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Paint Color (Color)
The color of the paint layer for your Carpaint.

Paint Specularity (Scalar)
The amount of shine from the paint itself, before the Clearcoat layer is taken into account.

Paint Roughness (Scalar)
A Roughness of 0 % will give a completely.

Paint Bump Height (Scalar)
The amplitude assigned to the Paint Bump Map.

Iridescence (Scalar)
Also known as goniochromism, this describes how some surfaces change color with the viewing angle such as is seen 
with soap bubbles and sea shells. It is a percentage value dictating how much light will be reflected from your surface 
and has some specific parameters:

Thickness (Scalar)
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This is the distance, measured in nanometers, between the surface of your car paint and the paint layer itself. Varying it 
will cause interesting effects as the wavelengths from the following three fields complement and interfere with each 
other.

Wavelength (Vector)
The three Wavelength fields labelled X, Y and Z each representing the visible portion of the light spectrum where 
numbers near the low of 380 nm will be blue and those near the upper level of 750 nm red.

Refraction Index (Scalar)
Since the Clearcoat has a depth, it needs an Index of Refraction. The default 1.5 should be good for most instances, but 
for those times when you need diamond Clearcoat put it up to 2.4.

Clearcoat Specularity (Scalar)
The Clearcoat can have a different level of specularity to the underlying paint color.

Clearcoat Roughness (Scalar)
This value diffuses the sharp reflections in the Clearcoat layer.

Clearcoat Bump Height (Scalar)
The amplitude assigned to the Paint Bump Map.

Flake Height (Scalar)
How far they stand out from the paint layer.

Flake Density (Scalar)
How much of the surface is covered by flakes. at 0 %, no flakes are visible and at 100 % no paint is (unless Opacity is set 
to less than 100 %). 

Flake Distance Falloff (Scalar)
Because the flakes could play havoc with anti-aliasing when they are far away, the FallOff is for the flakes to become 
invisible when the camera is the defined distance away.

Flake Scale (Scalar)
The size of individual flakes as a percentage of coverage. Small values here are better.

Paint / Clearcoat Normal (Vector)
This input offers the possibility to add a normal map to the Paint and Clearcoat layers.

Paint / Clearcoat Bump (Vector)
And this will add a more simple bump map.
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The two scenes are identically surfaced with the Carpaint material, except the scene on the right has no Iridescence, the 
one on the left has Iridescence at 100% with a thickness of 2.0nm and a Wavelength of X: 425 Y: 380 Z: 750.
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Conductor

Conductor

Appropriate for simulating metallic surface finishes accurately. The appropriate values for various conductors (metals) 
can be obtained from published data in handbooks of optical constants.

Edit Panel

Color (Color)
The surface color, often supplied by texture maps.

Specular (Scalar)
Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).

Roughness (Scalar)
This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.
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Anisotropy (Scalar)
Anisotropy is a bias in the direction of lighting a surface. At 0 % a surface is isotropic, meaning there's no bias. As you 
approach 100 % your surface will become maximally anisotropic. Some degree of Roughness is necessary for 
anisotropy to be visible, and the amount tells the anisotropic highlight how far to "spread".

 
Rotation (Scalar)
This determines the angular rotation for your anisotropic highlights. At 0 % the rotation will follow the curve of your 
object and at 50 % will be perpendicular to it.

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.

Anisotropy requires that there is a Projection node input otherwise you will get strange polygonal shapes in 
the render.

Left: Anisotropy at 100 %, Rotation at 15 %, Roughness at 30 %. Right: No Projection


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Delta

Delta

Delta is an energy conserving material. What this means is that it has realistic properties like when specularity is 100% 
the diffuse in turn will drop to 0%. Faster than Dielectric while offering less control, it is an excellent node for 
background glass or metal objects.

Edit Panel

Color (Color)
The surface color, often supplied by texture maps.

Specular (Scalar)
Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).

Transparency (Scalar)
Defines how transparent a surface is, often paired with

Refraction Index (Scalar)
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This value is for the Index of Refraction of your material. Often used - 1.33 for water, 1.5 for glass, 2.4 for diamond.

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.
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Dielectric

Dielectric

Dielectric is a physically accurate node for simulating glass-like materials. Use this state-of-the-art node when you want 
to create realistic glass. Dielectric uses Beer’s Law, which is about energy absorption, occurring when light passes 
through a surface. The more light that is absorbed by the material, the darker it will look.

Edit Panel

Color (Color)
This value is almost like a varnish applied over the surface of this material. If you wish to make colored glass, like a 
bottle for red wine, use the Transmittance field.

Transmittance (Color)
The transmittance of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Transmittance Distance (Scalar)
This is the distance at which the medium absorption color reaches Transmittance Color.
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Roughness (Scalar)
This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.

Refraction Index
The Index of Refraction determines how much light is bent when it enters a material. Common values include 1.33 for 
water, 1.42 for olive oil, 1.52 for crown glass, 2.42 for diamond.

Refraction Dispersion (Scalar)
Controls the amount of light dispersion. Dispersion is a phenomenon that causes the separation of a wave into spectral 
components with different wavelengths, due to a dependence of the wave’s speed on its wavelength. This will cause the 
surface to render more slowly as it renders each spectral component separately (red, green and blue).

Dispersion as used in this shading model simulates real light dispersion. The higher the value the greater the amount of 
dispersion that will be simulated and applied.

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.

Transmittance requires Volumetrics to be enabled; otherwise, there will be no color.
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Hair

Hair

Hair is based on the Kajiya-Kay paper for hair shading in 3D. It is strictly meant for use with FiberFX's thin cylinders or 
ribbons.
Edit Panel
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•

Color Group
The base color of your rendered fibers. At the top of this tab is a dropdown menu where you choose the type of 
texturing you wish to use. There are two modes for coloring fibers, Mixed and Textured (default).

Mixed - This color mode blends between two fiber colors (each with a different root and tip color). You can also 
set the amount each color influences the overall fiber color. At 0% Root / Tip Color 1 will be the predominant 
color, at 100% Root / Tip Color 2 will be the predominant color. 
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•

•

   

  
Color Mix 0%, Color Mix 25%, Color Mix 50%, Color Mix 75%, Color Mix 100%

Blend - When Blend is checked, the color values themselves are actually mixed, as opposed to just the quantity 
of fibers using those colors.

   

  
With Blend 0%, With Blend 25%, With Blend 50%, With Blend 75%, With Blend 100%

Textured - When this mode is selected you will be left with only one Color setting. Unlike Mixed color mode, all 
your fibers will be the same color. However, you can now also use the standard LightWave 3D texture editor to 
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•

•

color your fibers; this offers many options for texturing your fibers.

   
Plain Color, Texture Map, Fiber V Gradient* 

Highlight - This setting randomizes fiber shading by choosing lighter and darker values based on the original 
base colors used. The percentage determines how different the light or dark values are from the original colors.

   

  
Highlight 0%, Highlight 50%, Highlight 150%, Highlight 200%, Highlight 400%

Diffuse - Determines how much your fibers react to the diffuse setting on lights. Essentially simulating the 
scattering of light over the fiber surface (not to be confused with sub-surface scattering). The higher the 
percentage, the brighter overall your fibers will look.
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•

   

  
Diffuse 10%, Diffuse 50%, Diffuse 100%, Diffuse 200%, Diffuse 400%

Translucency - Translucency is only really apparent with lights placed behind the subject. Higher translucency 
settings give the impression of more light passing through the fibers making them lighter. This affects the outer 
edges of your fibers more than the main body. In the examples below ‘Diffuse’ was set to 75% and ‘Specular’ 
100% to better see the effect (more noticeable down the right-hand side).

   

  
Translucency 10%, Translucency 50%, Translucency 100%, Translucency 200%, Translucency 400% 
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•

Tip Transparency - Tip Transparency controls at what percentage along your fibers length (starting from the 
root) your fibers start to have transparency down to 0% at the ends, effectively ‘fading them out.' 0% means 
your fibers have no transparency, and so will appear solid right to the tips. 50% would mean that at 50% along 
your fibers, they start to ‘fade out’ until they reach 100% transparent at the tips. Makes hair look thick (0%) or 
fine and fly-away (100%). In the examples below Diffuse was set to 75% and Specular 100% to better see the 
effect.

   

  
Tip Trans 0%, Tip Trans 25%, Tip Trans 50%, Tip Trans 75%, Tip Trans 100%

Shadow Transparency - Shadow Transparency controls the density of shadowing on fibers and from fibers.
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•

    

 
 Shadow transparency 0%, 25%, 50%, 75%, 100%

Primary Specular Group
Specular Color / Specular - Controls how much your fibers will react to specular settings on lights. As with other 
specularity settings in LightWave, this is the ‘simulation’ of lights being reflected on your fibers. Higher values 
will increase the intensity of this effect. You can also specify the color of the specular highlights using the 
Specular Color picker.

   

  
Specular 10%, Specular 50%, Specular 100%, Specular 200%, Specular 400%
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•

Glossiness - To see the effect of the gloss setting, you must have Specular above 0%. Much like the gloss setting 
in the surface editor, the gloss setting controls the spread of the specular highlights on your fibers. This setting 
works slightly differently, however. At 0% gloss is off, once over 0%, low values result in a broader spread of your 
specular highlights, as the percentage goes higher the spread then becomes narrower. In the examples below, a 
specular value of 200% was also used.

   

  
Gloss 5%, Gloss 10%, Gloss 30%, Gloss 60%, Gloss 90% 

Cuticle Tilt - This setting only works when the Specular setting is above 0% as it controls the position of the 
specular highlight on the fibers. At 0% the specular highlight is where it naturally lies when light hits it, negative 
values pull the highlights towards the roots, whereas higher, positive values push the highlights away from the 
roots and towards the tips. Think of it as a ‘manual override’ for where specular highlights hit your fibers. In the 
examples below Diffuse was set to 75%, Specular 100% and Gloss 5% to better see the effect. This is a setting 
that has no Envelope or Texture editor access.
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•

  
Cuticle Tilt -100%, Cuticle Tilt -50%, Cuticle Tilt 0%, Cuticle Tilt 50%, Cuticle Tilt 100%

Secondary Specular
Secondary Glossiness / Secondary Cuticle Tilt - This is only available if Secondary Specular is set to more 
than 0 %. Simulates the secondary ‘gloss’ or ‘shine’ fibers display (mainly hair) when light is bounced around 
inside the fibers as a result of being naturally translucent (not linked to ‘Translucency’ setting). Works the same 
way as the first Gloss setting. Cuticle Tilt 2 controls the position of the secondary gloss in the same way Cuticle 
Tilt controls the first Gloss setting.

   

  
Sec’dry Gloss 5%, Sec’dry Gloss 10%, Sec’dry Gloss 30%, Sec’dry Gloss 60%, Sec’dry Gloss 90%, 
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Cuticle Tilt2 -100%, Cuticle Tilt2 -50%, Cuticle Tilt2 0%, Cuticle Tilt2 50%, Cuticle Tilt2 100%

* In order to use a Fiber V gradient, add the FiberInfo node and a Gradient node. Create the gradient you wish to use and 
attach Fiber V as the Input on the Gradient and take the Color output from the Gradient and apply it to Textured Color
on the Hair node.
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Principled BSDF

Principled BSDF

This material is physically plausible* and can be used exclusively for predictably texturing a whole scene. With it, you 
can create plastics, glass, metal and plenty of other surface types. By doing so, you will create consistent, predictable 
surfaces that will react to light and other scene elements the same way every time. BSDF stands for Bidirectional 
Scattering Distribution Function.



LightWave 2020  –  LightWave 2020

Reference –  2487

In previous versions of LightWave, sub-surface scattering was created using diffuse lighting. New to 
LightWave 2020 is the far superior Random Walk multi-spectrum SSS. The math is complex and can take longer 
to calculate, but the result is much better subsurface scattering. The settings in the Principled BSDF Material 
are similar to those in LightWave 2019 but the effect is far more controllable.

SSS used to have three control settings but now has four. Now, the Subsurface Scattering color input gives 
the scattering radius of the three colors not the base color of the subsurface scattering itself and uses Color as 
an input. To make a flesh tone, make the main Color a skin color and make Subsurface pinkish to scatter red 
more than green or blue.



It's perhaps easier to visualize the subsurface scattering radius if you change the Color Format in 
Options to Float rather than the default of Integer. Then you will see that 255 Red becomes 1.00. The 
three color values are multiplied by the Distance to calculate how deep inside a surface rays 
penetrate.


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Renders courtesy Andrew Comb. Mutant model by Luis Santos
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Render courtesy Tim Laird, who says, "The node setup uses the component nodes. Two SSS nodes, one fully 
forward scattering (blue), and the other one fully backward scattering (orange). It then uses their respective 
SSS distance settings to mix the SSS. Then I added an iridescence fresnel with the GGX reflection, to give that 
look."

A comparison between 2019.1.5 and 2020:
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Note the Subsurface amount is much reduced in 2019.1.5 for a more accurate comparison with 2020

The new Random Walk SSS is included in these new content scenes, kindly provided by ace 
LightWaver Tim Laird, for you to try. One of the main results of this new implementation is that 
subsurface colors converge on white in use but don't get there.

SSS Bleed Logo and SSS Milk (which will need a new HDR for the background. The one used in 
the render is not included)



https://docs.lightwave3d.com/download/attachments/8204146/SSS_Bleed.zip?api=v2&modificationDate=1587738293000&version=1
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Lemons! by Dave Tracey (using PBSDF)

  

Three examples of surfacing using the Principled BSDF material. Only settings in the panel have been changed; no 
inputs have been filled.
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Edit Panel
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Color (Color)
The surface color, often supplied by texture maps.

Roughness (Scalar)
This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.

Specular (Scalar)
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Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).

Specular Tint (Scalar)
A concession for artistic control that tints incident specular towards the base color. Grazing specular is still achromatic.

Sheen (Scalar)
An additional grazing-angle component (primarily for cloth)

Sheen Tint (Scalar)
Amount to tint sheen towards base color.

Thin
Thin mode makes translucency function, so you can use that instead of subsurface scattering, for making leaves from 
single thickness objects with double sided turned on.

Translucency
The amount of translucency to use with the Thin switch.

Flatness (Scalar)
Flatness is an alternate, flatter diffuse shape. The effect is subtle and not always easy to see when combined with other 
material properties. The example has 100 % Roughness, 0 % Specular and 0 % Fresnel.

Also, for artistic freedom, setting Specular at 0 % turns off the Fresnel function for entirely matte surfaces. The 
following animation shows this clearly. Specular is progressively lowered, but even at 0.1 %, the fresnel effect 
of a slight sheen at the edge of the sphere is visible. Only when Specular is at exactly 0 % is the sphere 
completely matte.


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Subsurface (Scalar)
Defines how much you want your subsurface color to be visible. If you set this to 100 % it completely replaces the 
surface color.

Subsurface Color (Color)
The subsurface color you want under the surface of your material. The quantity of visible subsurface color is defined by 
the following two options:

Distance (Scalar)
How far "into" the surface before the subsurface color is seen. If you make this value larger than the object that uses 
this material then the subsurface scattering will not be visible.

Luminous (Scalar)
How luminous your material is. This value can far exceed the 0-100 % range.

Luminous Color (Color)
The color with which your surface will glow. As normal, glowing objects only light others if GI is used.

Metallic (Scalar)
The metallic-ness (0 = dielectric, 1 = metallic) - this is a linear blend between two different models. The metallic model 
has no diffuse component and also has a tinted incident specular, equal to the base color.

Anisotropy (Scalar)
Anisotropy is a bias in the direction of lighting a surface. At 0 % a surface is isotropic, meaning there's no bias. As you 
approach 100 % your surface will become maximally anisotropic. Some degree of Roughness is necessary for 
anisotropy to be visible, and the amount tells the anisotropic highlight how far to "spread".

Use luminous geometry sparingly for lighting a scene - using lights is far more efficient. If the luminous object 
you want to use to light the scene is roughly spherical, add a Spherical Light for the effect instead. If it's more 
of a box shape, use an Area Light shaped to the rough dimensions. Only use a Primitive Light when you cannot 
roughly replicate the shape of your luminous object

Lights are directly sampled, and Importance sampled, by a scene's GI. Luminous geometry is not. The scene 
knows exactly where the lights are and samples them, luminous objects are only sampled when hit by GI 
calculations.


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Rotation (Scalar)
This determines the angular rotation for your anisotropic highlights. At 0 % the rotation will follow the curve of your 
object and at 50 % will be perpendicular to it.

Clearcoat (Scalar)
A second, special-purpose specular lobe.
Clearcoat Gloss (Scalar)
Controls clearcoat glossiness (0 = a "satin" appearance, 1 = a "gloss" appearance).

Transparency (Scalar)
The amount of transparency for the surface.

Transmittance (Color)
The transmittance of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Transmittance Distance (Scalar)
This is the distance at which the medium absorption color reaches Transmittance Color.

Anisotropy requires that there is a Projection node input otherwise you will get strange polygonal shapes in 
the render.

Left: Anisotropy at 100 %, Rotation at 15 %, Roughness at 30 %. Right: No Projection


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Refraction Index (Scalar)
When there is some level of Transmittance (Transparency), this determines how light passing through the medium is 
bent.

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.

Video

Transmittance requires Volumetrics to be enabled; otherwise, there will be no color.

* Physically plausible materials forgo 100 % reciprocality for artistic control. For PBSDF, the fact that a 0% 
Specular turns off the Fresnel effect, is not strictly accurate but it works well for artistic purposes. However, for 
almost all other values, PBSDF is energy conserving and designed to mimic real-world materials.



Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://www.youtube.com/watch?v=fojnvFIQRsg/

http://www.youtube.com/watch?v=fojnvFIQRsg/
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Sigma

Sigma

A material node which uses subsurface scattering, which occurs when light partially passes through a surface, and is 
scattered within the object, then exits through a different location. Subsurface scattering is an important addition to 3D 
computer graphics for the realistic rendering of such materials as marble, skin, and milk and other real-world semi-
transparent substances. The image above shows the LightWave logo with an additional bright Spherical light behind it.

Edit Panel

Diffuse Color (Color)
The surface color
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Diffuse Weight (Scalar)
Controls the strength of the diffuse color

Specular Color
The color of specular highlights

Specular Weight
Controls the strength of the Specular Color

Roughness (Scalar)
This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.

Scattering Color
The Subsurface color

Scattering Weight
Controls the strength of the subsurface color

Distance X, Y, Z
The subsurface Scattering distance

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.



LightWave 2020  –  LightWave 2020

Reference –  2501

Sigma2

Sigma2

Sigma2 is a volumetric scattering material node. Volumetric scattering is an important addition to 3D computer 
graphics for the realistic rendering of such materials as marble, skin, and milk and other real-world semi-transparent 
substances. The image above shows the LightWave logo with an additional bright Spherical light behind it.

Edit Panel
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Color (Color)
The surface color, often supplied by texture maps.

Specular (Scalar)
Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).

Roughness (Scalar)
This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.

Transparency Weight (Scalar)
This is the distance at which the medium absorption color reaches Transmission Color.

Transparency Color (Color)
The transmission of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Scattering (Color)
Scattering is a volumetric effect. To work properly, it needs to have Affect Volumetrics turned on in lights. Otherwise, it 
only absorbs light according to the scattering color.
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Absorption (Scalar)
How quickly light passing inside an object is extinguished. A low value here with indicate greater transparency. Based 
on Beer’s law of absorption, to give a more realistic and non-linear result.

Scale (Scalar)
Scales the Scattering and Absorption values.

Asymmetry (Scalar)
Ratio between the amount of forward to backward scattering. With a positive value, more light is scattered from behind 
the object, with a negative value more light is scattered from in front of the object, relative to the observer.

With this example we have two lights, one in front, one behind our sphere. Both are very strong and the one behind is 
colored green, the one in front red. With Asymmetry set to 0.5, the light from the green light is scattered forward 
towards the observer, in this case the camera. When Asymmetry is set to -0.5 the light from the red light behind the 
camera is reflected toward the observer.

Step Size (Scalar)
This is the volumetric scale for your surface. Larger numbers will render faster but be less defined.

Refraction Index
The Index of Refraction determines how much light is bent when it enters a material. Common values include 1.33 for 
water, 1.42 for olive oil, 1.52 for crown glass, 2.42 for diamond.

Bump Height (Scalar)
Specifies the bump height or “amplitude” of the Bump directional vectors.
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Skin

Skin

Skin, as the name implies, is a single node for creating a skin-like material with subsurface scattering, The image above 
shows the LightWave logo with an additional bright Spherical light behind it.
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Model: The WikiHuman Project, Render: Craig 'Rebelhill' Monins
Inputs
The Skin node contains the following Inputs:
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Specular Weight (Scalar) - Determines how intense the Specular Color is
Specular Color (Color) - Colors the specular component of the skin
Specular Roughness (Scalar) - The roughness of the surface
Specular Fresnel (Scalar) - The specular amount at parallel angles
Sheen Weight (Scalar) - Determines how intense the Sheen Color is
Sheen Color (Color) - Colors the sheen component of the skin
Sheen Roughness (Scalar) - The roughness of the sheen
Sheen Fresnel (Scalar) - The specular amount of sheen at parallel angles
Epidermis Weight (Scalar) - Determines the visibility of the outer layer of the skin shader
Epidermis Color (Color) - Specifies the color used for the outer layer of skin
Epidermis Distance (Scalar) - How far light is absorbed into a surface
Dermis Weight (Scalar) - Determines the visibility of the second layer of the skin shader
Dermis Color (Color) - Specifies the color used for the second layer of the skin shader
Dermis Distance (Scalar) - How far light is absorbed into this second layer
Hypodermis Weight (Scalar) - Determines the visibility of the inner layer of the skin shader
Hypodermis Color (Color) - Specifies the color used for the third layer of the skin shader
Hypodermis Distance (Scalar) - How far light is absorbed into this third layer
Normal (Vector) - Uses a normal map for skin displacement
Bump (Vector) - Uses a bump map for skin displacement with the Bump Height field to determine the quantity
Bump Height (Scalar) - Amount to displace the Bump input
 

Edit Panel



LightWave 2020  –  LightWave 2020

Reference –  2507

Images applied to the inputs for Epidermis, Dermis and Hypodermis inputs will always give a more realistic result.
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Standard

Standard

Standard is the basic material node applied to all surfaces before they are specialized. It takes its settings directly from 
the entries in the Surface Editor. Envelopes and textures applied in the Surface Editor are reflected in the node editor, 
but are not created as separate nodes.
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Color (Color)
Color is probably the most obvious surface parameter. It doesn’t take much experience to know that if we want 
something to look like a banana, we need to make it yellow, right? However, although Color might be the most obvious 
setting it is not the only one that is important to a satisfying finished surface. At the very least, make sure that your 
Specular and Bump channels have some values.

Luminosity (Scalar)
Luminosity refers to how much a surface appears to glow of its own light. However, unless you use Radiosity, 
Luminosity does not have any actual light emitting properties - you need to add an actual light for that. A value of 0% is 
most common for this setting, unless a special need arises such as the surface of a modeled light bulb.

Other materials have energy conservation, which means that they automatically balance their Diffuse, 
Specular and Transparency components. It is up to the user to do the same with Standard, as they wish. To 
balance, try to ensure that the three groups separated at the top of the panel - Diffuse, Specular and 
Transparency - don't add up to more than 100 % together (in fact a little less together. 100 % would equate to 
a perfect surface)


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Luminosity from left to right: at 0%, 50%, 100%, 500%
Diffuse (Scalar)
Diffuse is the amount of light scattered by a surface. A high level scatters a lot of light, and therefore, the surface 
appears bright. A low level absorbs most of the light, and therefore, the surface appears dark and dull. Metal, reflective 
and dirt surfaces are good candidates for a low Diffuse level. Common values are 40% to 80%. Surfaces must have some 
diffusion for shadows cast on them to be visible.

 

 Diffuse from left to right: at the default 80%, 50%, 0%

Specular (Scalar)
Specularity is reflection. Where in previous versions of LightWave you'd think nothing of having Specularity settings of 
100 %, now you'd only want that if you want perfect reflections. To give an object a shine and slight reflectivity, stick to 
0-20 % values. By default, Specularity is set to 5 % because everything has a little reflectivity.

Specularity and Glossiness have changed a lot. Where once they strictly meant the reflection of scene lights 
and how sharp they were and nothing else, specularity is now reflection of everything (if you have used the 
Dielectric or Conductor nodes you will be familiar with their settings) and Glossiness will be the inverse 
equivalent of Roughness. This means that old objects created in pre-2018 versions of LightWave that have a 
high specular component (to create lighting hotspots on the surface) will now be very reflective. Likewise, if 
they also have Reflection, they will need to be adjusted before they can be used. The math behind Lights is 
also more physically-based and realistic in 2018 and newer and thus much stronger, so this needs to be taken 
into account when importing old assets.


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Specularity from left to right: at default 5 %; Specularity at 50%, Diffuse at 50%; Specularity at 90 %, Diffuse at 0 %
Glossiness (Scalar)
When some level of Specularity exists, Glossiness determines how rough the surface is. A low Glossiness is equal to a 
high roughness and vice versa. Using the last image from the Specularity examples, you can see the difference:

 Glossiness left: 40 %, right: 100 %
Reflection (Scalar)
The Reflection channel is now less needed since Specular will reflect the environment as well as lights. To replicate the 
Reflection Blurring from previous versions of LightWave, make sure Glossy Reflections is turned on in the Shading 
Model for your material and then manage your Glossiness setting. If you have Glossy Reflections turned off you should 
set your Reflection to the same level it was at in 2015.

Transparency (Scalar)
Transparency lets you make a surface see-through; it is the opposite of Opacity. Whenever light passes through a 
transparent object, the light will bend. An example of this can be seen when you look through a glass of water or down 
through a clear pool of water. The amount of this light bending is controlled by the Refraction Index.

Image by Christophe Desse
Refraction Index (Scalar)
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Refractive Indices left to right: Vacuum (1.0), Water (1.33), Crown Glass (1.52), Diamond (2.42)
The index of refraction determines how much light is bent when entering the material. It is responsible for straws 
appearing bent when placed in a glass of water at the most quotidian level, and usually applies to liquids. There are 
transparent solids, like ice, glass and diamond that have increasingly higher refraction indices.

There are features such as Total Internal Reflection and Dispersion, but you would be advised to use a material like 
Dielectric to better duplicate these since that is its dedicated use.

Refraction Blur (Scalar)

Refraction Blur Off, 10 %, 50 %
Refraction blur will cast more rays in different directions at the point a ray enters a surface.  This breaks up the 
refraction effect to create additional detail in forms seen through the refraction. Low numbers can be used for this just 
to add a degree of interest to the interior of the glass. Note how the surface light hotspots in the example images are not 
blurred, but interior refractions are.

Translucency (Scalar)
Translucency allows back lighting. The effect can be seen when someone stands behind a curtain and you see their 
silhouette through the material. Other examples include seeing bones in your hand with a flashlight in your palm, or 
bugs crawling on the underside of leaves.
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The plane has no Transparency, but Translucency is at 100 % and there is a strong light behind the rock
Translucency is similar to Transparency in that all lighting properties, like color and luminosity, will show through. The 
obvious difference is that translucency doesn’t add a see-through effect. If you want to make a silhouette visible, 
something must cast a shadow on the back side. Note that you do not need rear-facing polygons for the back side, nor 
must you use a double-sided surface to catch the shadow.

Color Highlight (Scalar)

Color Highlight left: 0 %, right 100 %
Causes a surface’s own color to show through a specular highlight. Normally, a specular highlight shows in the color of 
the light striking the object. For example, a white light illuminating a red ball leaves a white specular highlight on the 
surface of the ball. But with Color Highlights, the highlight appears red. A color highlight blends the object’s surface 
color with the color of the light source, which causes a more metallic appearance. 

Color Filter (Scalar)
Available when a surface has some degree of transparency. It allows the surface color of an object to tint all of the 
objects seen through it. A good example is a green wine bottle. Light shining through the bottle tints all objects seen 
behind it with green.

Diffuse Sharpness (Scalar)
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Causes a more severe shadow cutoff zone on objects rather than the gradual falloff of light. It enhances the appearance 
of contrast between the lit and unlit sides of the object. Diffuse Sharpness is usually used for very large-scale objects, 
like planets.

Bump
The T button is is to attach a Texture map and a Bump Map. You can use the input instead for a more nodal setup.

Bump Height (Scalar)
How far the bump extends. Bumps can go inwards as well as outwards but remember a bump map is a shading trick, it 
won't change the silhouette of the object. For that a Normal map is needed.

Normal (Vector)
Only available in the Node Editor and as an input. It allows the deformation of the surface's normals.
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Unreal

The Unreal material is a pared down version of the Principled BSDF material adapted for games. It is designed 
specifically for use with the Unreal games engine however it will work perfectly well inside LightWave too and can be 
very useful as a simpler version of PBSDF. Like that material, Unreal can be used for surfaces of many different kinds 
including glass, metals and plastics though subsurface scattering or carpaint-type settings are not available directly 
inside the Unreal material.

Base Color (Color)

Choose the base color for your material

Roughness (Scalar)

This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.

Specular (Scalar)

Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).
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Metallic (Scalar)

The metallic-ness (0 = dielectric, 1 = metallic) - this is a linear blend between two different models. The metallic model 
has no diffuse component and also has a tinted incident specular, equal to the base color.

Anisotropy (Scalar)

Anisotropy is a bias in the direction of lighting a surface. At 0 % a surface is isotropic, meaning there's no bias. As you 
approach 100 % your surface will become maximally anisotropic. Some degree of Roughness is necessary for 
anisotropy to be visible, and the amount tells the anisotropic highlight how far to "spread".

 

Rotation (Scalar)

This determines the angular rotation for your anisotropic highlights. At 0 % the rotation will follow the curve of your 
object and at 50 % will be perpendicular to it.

Emissive Color (Color)

The color that your surface will glow with. You can use the multiplier setting in LightWave's color picker to increase the 
amount of light emitted.

Anisotropy requires that there is a Projection node input otherwise you will get strange polygonal shapes in 
the render.

Left: Anisotropy at 100 %, Rotation at 15 %, Roughness at 30 %. Right: No Projection


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There is a Constant Color node feeding the Emission Color input

In the Color Picker, change the X multiplier to 10.0
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Now the glow is much brighter

Opacity (Scalar)

How transparent your surface is.

Refraction Index (Scalar)

The index of refraction for the surface. Only useful when Opacity is less than 100 %.

Unreal Tessellation

This toggle has no effect in LightWave but converts geometry to Curved PN triangles inside Unreal. These triangles offer 
better normals and displacements than regular geometry and are optimized directly on the graphics card.

Use emissive geometry sparingly for lighting a scene - using lights is far more efficient. If the emissive object 
you want to use to light the scene is roughly spherical, add a Spherical Light for the effect instead. If it's more 
of a box shape, use an Area Light shaped to the rough dimensions. Only use a Primitive Light when you cannot 
roughly replicate the shape of your luminous object

Lights are directly sampled, and Importance sampled, by a scene's GI. Emissive geometry is not. The scene 
knows exactly where the lights are and samples them, luminous objects are only sampled when hit by GI 
calculations.


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Math

These are all helper nodes to deal specifically with Scalar, Trigonometry and Vector mathematics. Most have no edit 
panel and are just designed to modify data passed through their in and outs.

Scalar — The nodes here all have green Scalar inputs and outputs.
Trigonometry — The nodes in this section are all concerned with angular values.
Vector — Nodes here are for vectorial math.
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Scalar

Click here to expand Table of Contents...
Abs
Add
BoxStepF
Ceil
Clamp
Divide
Exp
Floor
Fresnel
Invert
Log
Log10
Logic
Max
Min
Mod
Multiply
Pow
Remap
Sign
Smooth StepF
Subtract

The nodes here all have green Scalar inputs and outputs.

Abs

In mathematics, the modulus or “absolute value” (abbreviated Abs) of a real number is its numerical value without 
regard to its sign. So, for example, 5 is the absolute value of both 5 and −5 and 3.14159 is the absolute value of both 
−3.14159 and 3.14159.

In a general frame of reference you can think of this node’s function as changing negative values into positive values or 
in other words inverting only the numbers that exist on the negative side of a number line. The absolute value of a 
number is always either positive or zero, never negative.

Add

The Add node adds the incoming or user specified value B to the incoming or user specified value A and supplies their 
sum as the Result output.

It is important to note the order of the values in all the math nodes as inverse operations do not always produce the 
same result. Addition and multiplication are exceptions but if you keep this rule throughout all of the math nodes you 
will run into fewer problems.


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BoxStepF

A box step is a ramped step function. Two limits are set by the Begin and End inputs or through the edit panel. If the 
input is less than the Begin input, then the output will be 0.0. Conversely, if the Begin input is greater than the End 
input, the output will be 1.0. If the input is between Begin and End, then the output will vary between 0.0 and 1.0 
proportionally.

Effectively, the Box Step clamps between the Begin and End values and normalizes the output between 0.0 and 1.0.

Ceil

Ceil is the abbreviation for “ceiling”. This node receives scalar data from an arbitrary data item such as the luminance 
values of an image, the Alpha channel of a procedural or the output from another math node. It evaluates the incoming 
value and rounds that value up (hence the name “ceiling”) to the nearest whole number which is then output as the 
result.

This can be very useful for extracting stepped data from smooth gradations among many other things. See the I/O 
graph below to get an idea of what is going on under the hood:

Input: 0.2 0.6 1.0 1.4 1.8 2.2 2.6 3.0

Result: 1 1 1 2 2 3 3 3

Clamp

This node will clamp incoming values to a user specified cap or limiter value. There is a cap for the high limit (or top of 
the range) and one for the low. Values that are greater than the specified high limit will be set to the high limit value. 
Values that are lower than the low limit will be set to the low limit. Incoming values that are between the specified high 
and low limits will not be modified or scaled.

Divide

The Divide node simply divides one scalar number by another.

Exp

Input a scalar and its exponent is output.

Floor

The Floor node finds the largest integer less than or equal to the In input. A few examples:

In: -2.9 -2.0 -1.5 0.0 0.5 1.5 2.0 2.9

Out: -3 -2 -2 0 0 1 2 2

A computer finds it easier to multiply than divide. Consider multiplying instead of dividing. 4 x 0.5 gives the 
same result as 4/2.





LightWave 2020  –  LightWave 2020

Reference –  2522

The floor function can be considered as a round function much like Ceil, with the exception that it is derived from the 
lowest integer (the floor) rather than the highest integer (the ceiling).

Fresnel

The Fresnel equations involve the amount of reflected light based on the incidence angle. You can input a Refraction 
index by double-clicking on the node and you should input a normal to base the math on from the Input node’s Normal 
outputs. The Result or Inverse can be chosen as output.

Invert

The invert node simply inverts the input. The is done by subtracting the In input from 1.0, so 0.0 will become 1.0 and 1.0 
will become 0.0. The inversion will occur for intermediate values also, so 0.2 inverted is 0.8, 0.7 inverted is 0.3 and so on.

Log

Outputs the logarithm of the scalar input.

Log10

Outputs the base-10 logarithm of the scalar input.

Logic

This node does have an edit panel. The Logic node can be used for typical “If, then, else” logic flow within a network. 
There are two inputs that can be compared in various ways. If the given comparison evaluates true then the value 
entered or connected to the true input is passed to the Out output. If the comparison evaluates as false then the value 
entered or connected to the False input is passed to the Out output.

The Out output from this node is either a pass-through of the True or False connections or the value entered into those 
variables via the Logic node’s Edit panel. Which input True or False is passed through depends on the result of the 
selected Operation. The available Operations are shown here:
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So for example if A Equal To B were selected the True value would be output if the vales for A and B were the same. If 
they were different then the value entered or connected to False would be passed to the Out output.

Max

The Max node simply takes the A and B inputs and outputs the largest. A and B may be connected to other nodes or 
controlled manually. This means that the node can be used to clamp the minimum value of a scalar.

Min

The Min node simply takes the A and B inputs and outputs the smallest. A and B may be connected to other nodes or 
controlled manually. This means that the node can be used to clamp the maximum value of a scalar.

Mod

The Mod node derives the modulus of the A input in the form Result=A mod B. The modulus is effectively the remainder 
leftover when A is divided by B, as in 7 divided by 2 is 3 with a remainder 1. So a few examples would be:

Input A: 0.0 1.0 2.0 3.0 4.0 5.0 6.0

Input B: 2.0 2.0 2.0 2.0 2.0 2.0 2.0

Result: 0.0 1.0 0.0 1.0 0.0 1.0 0.0

This function is useful because it can be used to repeat a regular function over a shorter period. Take, for example, a 
linear gradient that varies from 0.0 at the top of an object to 6.0 at the bottom. By using this gradient as the A input and 
making B 2.0, you can see from the above table that the gradient would ramp from 0.0 to 1.0 three times.

Multiply

The Multiply node allows one scalar to be multiplied by another.

Pow

The Pow node allows one scalar to be raised to the power of another (A Pow B or AB). For example, 23 is 2 x 2 x 2 = 8. 
Interestingly, you can also raise a scalar to the power of 0.5 if you wish to calculate the square root.



LightWave 2020  –  LightWave 2020

Reference –  2524

Remap

This node remaps a scalar input to a new range. Ranges can be enveloped for further flexibility.

Sign

The Sign node simply changes the sign of the input so that positive scalars become negative and negative scalars 
positive.

In: -2.0 -1.0 -0.5 0.0 0.5 1.0 2.0

Out: 2.0 1.0 0.5 0.0 -0.5 -1.0 -2.0

Smooth StepF

A smooth step is a rounded, ramped step function. Two limits are set by the Begin and End inputs. If the In input is less 
than the Begin input, then the output will be 0.0. Conversely, if the In input is greater than the End input, then the 
output will be 1.0. If the input is between Begin and End, then the output will vary between 0.0 and 1.0 proportionally as 
a smoothed ramp. Effectively the Smooth Step clamps between the begin and end values and normalizes the output 
between 0.0 and 1.0 with a smoothed transition.

Subtract

The Subtract node allows one scalar to be subtracted from another.



LightWave 2020  –  LightWave 2020

Reference –  2525

Trigonometry

The nodes in this section are all concerned with angular values.

ArcCos

The ArcCos node takes the inverse cosine of the input scalar. The input can be in the range -1.0 to 1.0 for a real result. 
The result will be in the range PI to 0. If the input is not in range, the result will be an invalid floating point value.

Example: cos(x) = y implies arccos(y) = x

ArcSin

The ArcSin node takes the inverse sine of the input scalar. The input can be in the range -1.0 to 1.0 for a real result. The 
result will be in the range -PI/2 to PI/2. If the input is not in range, the result will be an invalid floating point value.

Example: sin(x) = y implies arcsin(y) = x

ArcTan

The ArcTan node takes the inverse tangent of the input scalar. The input can be any scalar value. The result will be in 
the range -PI/2 to PI/2.

Example: tan(x) = y implies arctan(y) = x

Cos

The Cos node takes the cosine of the input scalar.

Sin

The Cos node takes the sine of the input scalar.

Tan

The Cos node takes the tangent of the input scalar.
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Vector

Click here to expand Table of Contents...
Abs
Add
Add4
Add Scaled
Cross
Distance
Divide
Dot
HPB
HPBAdd, HPBMatrix, MatrixHPB, Multiply Matrix 3x3, Transpose Matrix 3x3
Length
Matrix4
Max
Mod
Multiply
Normalize
Scale
Subtract
Subtract Scaled
Transform
Transform2
Transform Point

Nodes here are for vectorial math.

Abs

Outputs the absolute value of a vector (no negative numbers).

Add

The Add node simply adds two vectors. Vectors are assumed to contain three elements X, Y, and Z. This node adds the 
vectors so that:

ResultX = AX + BX

ResultY = AY + BY

ResultZ = AZ + BZ

Add4

The Add4 node simply adds together four vectors. Vectors are assumed to contain three elements X, Y, and Z. This node 
adds the four input vectors together so that:

ResultX = Vec 1X + Vec 2X + Vec 3X + Vec 4X

ResultY = Vec 1Y + Vec 2Y + Vec 3Y + Vec 4Y


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ResultZ = Vec 1Z + Vec 2Z + Vec 3Z + Vec 4Z

Add Scaled

The Add Scale node adds a value to a scaled value. The scale works based on a percent, which means a scale of 100% is 
the same as multiplying by 1.0. A scale of 50% is the same as multiplying by 0.5, and a scale of 0% is the same as 
multiplying by 0.0. Vectors are assumed to contain three elements X, Y, and Z. This node adds the A and B vectors 
together and scales the result so that:

ResultX = AX + BX x Scale

ResultY = AY + BY x Scale

ResultZ = AZ + BZ x Scale

Cross

A vector cross product calculates the result as being the product vector orthogonal to both input vectors. Imagine two 
vectors X and Y on a plane where Y points up the plane and X across it. The cross product would be a vector that points 
directly out of the plane, which is otherwise referred to as the Z vector (this can also be considered the normal to the 
plane).

Distance

The distance node derives the distance between the two input points To and From.

Divide

The Divide node simply divides one vector by another. Vectors are assumed to contain three elements X, Y, and Z. This 
node divides the vectors so that:

ResultX = AX / BX

ResultY = AY / BY

ResultZ = AZ / BZ

Dot

A vector dot product calculates the cosine of the angle between two vectors. The dot product ranges from -1.0 to 1.0. 
Taking the inverse cosine of this output yields the angle between the two input vectors.

HPB

 Inputs a vector and separate Bank scalar and outputs a Vector result. The input vector can be coordinates or 
a color.

A computer finds it easier to multiply than divide. Consider multiplying instead of dividing. 4 x 0.5 gives the 
same result as 4/2.


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HPBAdd, HPBMatrix, MatrixHPB, Multiply Matrix 3x3, Transpose Matrix 3x3

These nodes are intended for the Virtual Studio rather than the Surface Editor and are described in that section of the 
manual.

Length

The Length node determines the length of any vector.

Matrix4

Creates an affine transform matrix (translate, rotate, scale).  Users can envelope the values.

Max

Will compare the Vector input with the numbers entered and return the higher value.
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Mod

Will take the vector input, divide it by the numbers entered and return the remainder as a vector.

Multiply

The Multiply node simply multiplies one vector by another. Vectors are assumed to contain three elements X, Y, and Z. 
This node multiplies the vectors so that:

ResultX = AX x BX

ResultY = AY x BY

ResultZ = AZ x BZ

Normalize

Vector normalization involves taking a vector and finding its length. All three elements of the vector are then divided by 
this length. This has the effect of creating a normalized vector, that is, a vector with the same direction as the input 
vector but with a unit length.

Scale

The scale function simply scales the size of the vector. The scale works based on a percent, which means a scale of 
100% is the same as multiplying by 1.0. A scale of 50% is the same as multiplying by 0.5, and a scale of 0% is the same as 
multiplying by 0.0. Vectors are assumed to contain three elements X, Y, and Z. This node adds the A and B vectors 
together and scales the result so that:

ResultX = VectorX x Scale

ResultY = VectorY x Scale

ResultZ = VectorZ x Scale

Subtract

The Subtract node simply subtracts one vector from another. Vectors are assumed to contain three elements X, Y, and 
Z. This node subtracts the vectors so that:

ResultX = AX - BX

ResultY = AY - BY
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ResultZ = AZ - BZ

Subtract Scaled

The Subtract Scale node subtracts two vectors, then scales the result. The scale works based on a percent, which means 
a scale of 100% is the same as multiplying by 1.0. A scale of 50% is the same as multiplying by 0.5, and a scale of 0% is 
the same as multiplying by 0.0. Vectors are assumed to contain three elements X, Y, and Z. This node adds the A and B 
vectors together and scales the result so that:

ResultX = ( AX - BX ) x Scale

ResultY = ( AY - BY ) x Scale

ResultZ = ( AZ - BZ ) x Scale

Transform

The Transform node allows a vector in object space to be transformed into the same vector in world space. This may 
also be applied in reverse so that a vector in world space can be transformed into object space.

Transform2

The Transform2 node allows a vector to be translated using a 3x3 transformation matrix as defined by the user. Here, 
the Right input defines the top row of the transformation matrix, the Up vector the middle row, and the Forward vector 
the bottom row. A switch is provided so that the inverse transform and/or a transposed transform can be performed 
using the same transformation matrix.

Transform Point

A more general transform node. Can apply translate/rotate/scale to a vector with a pivot position and pivot rotation. 
Can also use Right/Up/Forward inputs to define a transformation from a coordinate system. Outputs the transformed 
vector, and the transform itself in the form of a translation and a transform coordinate system.
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OpenVDB group

Click here to expand Table of Contents...
Common
Solid Volumes from Meshes and other Scene Items

Mesh To Volume
Shape To Volume
Fog To LevelSet
From Particles

Gaseous Volumes from Scene items
Gas Solver
To Fog Volume

Tools
Advect
Advect Points
Analysis
CSG
Combine
Filter
Level Set Morph
Noise
OpenVDB Info
Partio Node
Attributes list
Resample
Saver
Scatter
Solver
Vector Merge and Split
Velocity
Visualize

Click here to expand Table of Contents...

Common

 OpenVDB nodes may have the following common settings:

Voxel Size - Size of the voxel grid in meters (LightWave supports uniform grids); the size of the voxel "blocks" 
that will make up your object
Inner Bandwidth - Inner Bandwidth for level set in voxels
Outer Bandwidth - Outer Bandwidth for level set in voxels. For fog volumes, this defines the "softness" until 
maximum density is reached.
Fill Interior - Toggle for whether the volume will be solid when cut into or just a shell - like polygons are. Turning 
on Fill Interior with a Fog Volume will soften the outside of the fog
Coordinate System - How the voxel will be transformed. There are three choices




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Local - No transform
World - Transform into world space
Parent - Use the parent item's space

Grid Name - the base name of savedgrid.vdb files. Files will be appended with the frame number and written 
with temperature, density, and velocity grids

Solid Volumes from Meshes and other Scene Items

Creating a volume this way requires a target mesh, primitive shape or Particle emitter that needs to be in the scene. It 
can be out of camera view, hidden from render and hidden in OpenGL and the Object Replacement will still work. To 
create a volume from this item requires adding a null and using the Object Replacement entry OpenVDB Evaluator. 
Clicking Properties for it will bring up a Node Editor window.

Mesh To Volume

Creating volumes from meshes relies on polygons being tris or quads. NGons are not supported
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In the OpenVDB nodes group, Mesh To Volume will be the node to convert your mesh objects into volumes. There are 
two choices for conversion, Fog Volume will convert a mesh into a volumetric fog, much like the image at the top of this 
page, but you need to use an OpenVDB primitive. The second option is Level Set, which creates a volumetric mesh 
object. The Voxel Size setting will determine the resolution of your volumetric object. For the Logo Rezzing Up
example, a Scalar Constant node was used with an envelope that went from the default 1 down to 0.0025 to create the 
increasing resolution of the volume.

Particle Radius is where you set the size of individual particles if you will be outputting a particle system from this 
node.

The new Attributes tab, added in 2020, is where you can transfer details like vertex maps or surfacing information from 
the original mesh to your OpenVDB object.

Surfaces will all be added. You cannot just choose one.

Shape To Volume
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Will create a volume from LightWave primitive objects.

Fog To LevelSet

Converts a Fog grid to a Level Set mesh object. A fog grid can be imported using the OpenVDB Info node. Double-
clicking the node brings up its window with Iso setting and Normalize toggle.

From Particles

New to 2020. There is now a Particle System output to send particles directly to the Editor Input. You can choose to 
represent particles as individual spheres or a trail (of connected spheres). When you select Trail, a Trail Resolution
setting becomes available. Higher values mean more trail particles and might be needed for high-velocity trails.

The Morphology tab includes elements that are found in the Filter node that can be applied directly, without needing a 
discrete Filter node.
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This node will create a volumetric object from a stream of particles created using the FX Emitter or the Scatter or Solver 
nodes here. You have the option to either create sphere shapes or a trail per particle derived from their position, radius, 
and velocity. Each trail is generated as CSG unions of sphere instances with a decreasing radius.

When you have a particle emitter being meshed, you cannot bring up the particle properties, as upon meshing 
(the OpenVDB Evaluator being an object replacement procedure), the PFX Emitter server pane will close. The 
only way to adjust particle properties, in this case, is by using the modal FX Browser panel.

The same is true for other server pane items - changing the subdivision level, for example - but in that case, the 
only workaround is to disable the VDB object in the Scene Editor by unchecking the render flag.



FX Emitter particles must have a Size, and that size must be output with the Output Size toggle. You don't 
need to Show Size; it just helps visually.


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Particle System - A dropdown for choosing the specific particle system you want to use. Using the Input ghosts 
this control
There are two tabs next:
Surface - Details how the particles look:

Particle Count - A readout of attached particle system particle count
Space - Choose whether your particles are situated in Local, Parent or World Space
Particle Type - Choice between Sphere and Trail. Sphere will create distinct bubbles whereas Trail will 
attempt to use particle velocity to create a trail of diminishing size. Each trail is generated as CSG unions 
of sphere instances with a decreasing radius
Trail Resolution - Only available when the Trail Particle Type is chosen. The default of 1.0 trails off 
"normally". Less than 1.0 means fewer trail particles and separation might be noticeable. More than 1.0 
means more trail particles are created. Higher trail speeds might need more particles to stay stream-like 
so separation doesn't show
Voxel Size - Size of the Voxel for the particles. Voxels sizes in a network should be the same, especially 
combining or collisions between VDB grids
Iso Surface - Iso sizes in a network can be different but the editor input node will create the final meshing

Morphology - Operators so additional nodes are not needed
Dilation - Dilate the grid along its normals making it bigger
Closing - Dilate the grid to close holes then erode closing openings
Smoothing - Gaussian smoothing

The direction of a trail is inverse to the direction of the Velocity vector, with a length of |V|. The radius at the 
head of the trail is given by the radius of the particle and the radius at the tail of the trail is Rmin voxel units 
which has a default value of 1.5 corresponding to the Nyquist frequency.


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Gaseous Volumes from Scene items

Gas Solver

Gas solver.  Use Stam's stable fluids method to advect density and temperatures. Both the density and the temperature 
affect the fluid’s velocity. Heavy smoke tends to fall downwards due to gravity while hot gases tend to rise due to 
buoyancy. We use a simple model to account for these effects by defining external forces that  are directly proportional 
to the density and the temperature.

buoyancy = (-densityscale * density * Vec3f(0, 1, 0)) + (temperaturescale * temperature 
* Vec3f(0, 1, 0));

External forces can be added on the Force Grid input. This input accounts for external forces like gravity, wind, 
turbulence and merely is added onto the end of the momentum equation.

Temperature Tab
Ambient Temperature - Ambient air temperature
Clamp Temperature - Clamps the temperature to the minimum value set below (otherwise the gas cools to the 
point where it falls like dry ice)
Min - The minimum temperature (in Celsius) for the gas to fall to
Normalize Temperature Grid - Outputs the temperature grid as a scale between 0 and 1, rather than, say, 60 
and 900
Fuel Temperature - Fuel temperature as it is emitted
Gas Density - Density of emitted smoke from the fuel grid

http://physbam.stanford.edu/~fedkiw/papers/stanford2001-01.pdf


LightWave 2020  –  LightWave 2020

Reference –  2538

•
•
•
•
•

•

•

•

•

•

•
•
•

•

•
•
•
•

•

•

•
•
•

•
•
•

Fuel Velocity - Velocity of emitted smoke and heat from the fuel grid
Density Scale - Scale of the downward pull on dense smoke
Buoyancy Scale - Scale of the temperature gradient pulling smoke upward
Cooling Scale - Scales the cooling rate
Dissipation - The amount of density that falls off over each iteration so that the gas thins over time

Advection Tab
Spacial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spacial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Max Divergence Steps - Maximum number of iterations of the pressure solver
Advection Sub Steps - Substeps per integration step. The only reason to increase it above its default value of 
one is to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Curl Scale - Curl strength of the vorticity confinement

Domain Tab
Boundary - One of three choices:

Free Slip - Velocity is negated at the boundary axis
No Slip - Velocity is set to 0 at the boundary
Outflow - The grid is clipped at the boundary

The Min and Max domain fields are for setting the minimum and maximum extents (corners) of the simulation's 
domain.

Cache Tab
Cache Grids - Toggle for enabling the caching of grids to Cache Path folder. Once cached they can be loaded 
without simulation
Cache Name - Base name of saved grid . vdb files. Files will be appended with the frame number. Files will be 
written with temperature, density, and velocity grids
Grid Path - Path to save folder
Clear Cache - Clear all files in the cache folder
Behavior - A dropdown with three choices:

Manual - Cache control is completely up to the user
Warn - A message will warn "The cache is invalid, should it be cleared?"
Automatic - The cache is cleared automatically, when necessary

To Fog Volume

Converts an SDF grid (signed) to a fog volume (unsigned) with a filled interior. There are no options.
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Tools

You can manipulate OpenVDB volumes with the following included tools.

Advect

Advect a Signed SDF grid with a velocity grid. Requires a Velocity Grid vector to give movement and direction.

Spatial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spatial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Normalizing Steps - A number of renormalization passes can be performed between each substep to convert it 
back into a proper signed distance field. Prevents jerky motion but soften and slows the velocities
SubFrame Steps - Substeps per integration step. The only reason to increase it above its default value of one is 
to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Rebuild SDF - Toggle to rebuild and retrack the narrow band of the SDF
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Advect Points

This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for
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Analysis

This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.

CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes, and is the default option
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B
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The velocity of the input grids will be reconstructed and output.

Combine

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
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rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background


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Filter

  

This node adjusts the inner bandwidth of a volumetric signed distance field represented by a VDB volume
Filters the level set grid:

Filter Type:
Renormalize - Repair level sets represented by VDB volumes. Certain operations on a level set volume 
can cause the signed distances to its zero crossing to become invalid. This node iteratively adjusts voxel 
values to restore proper distance
Mean Value - This performs the equivalent of a simple box blur by taking the mean of the surrounding 
values
Median Value - This chooses the median of the surrounding values, good for homogenizing noisy data to 
avoid spikes
Mean Curvature - Finds the average curvature for a location and moves the surface along its normal to 
smooth out bumps
Laplacian Flow - Uses a local Laplacian value for movement along a normal
Dilate - Dilate the grid along its normals making it bigger
Erode - Erode the grid along its normals making it smaller
Close - Dilate the grid to close holes then erode closing openings
Open - Erode the grid then dilate to create openings
Track - the grid topology is updated by rebuilding the inner band so that it tracks the new iso interface
Gaussian - Gaussian smoothing
Resize - Change the width of the inner band of a VDB signed distance field

Accuracy - Increasingly complex algorithms for the accuracy of the integration
World - Performs the math for creating the levelset in World space, rather than Local
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Half Bandwidth - Level sets are normally symmetrical on the inner band. Half Bandwidth uses this fact to halve 
calculation times but at the cost of accuracy
Iterations - the maximum number of attempts to achieve a divergence-free pressure matrix
Voxel Offset - Offsets the iso surface from the actual value. For instance, using

Level Set Morph

You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

The above node tree will synchronize your surface morphing at the same time as the geometry

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out

Noise

Add the Bump output from an image or a 3D Texture to this node and pipe the output through.

OpenVDB Info
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The values for the Fuel channel of a VDB sequence
You can pipe a Level Set or Fog grid into this node and see the values contained within the file, but this node becomes 
more useful when you load a vdb file directly in the node. You can see info from whatever channels the vdb file contains.

Partio Node

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.


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Target - If you are using a volumetric object with the particle system, make sure it is targeted here
Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list

Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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Using the Partio node with a From Particles node

As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab
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You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Resample

Resample input grid to new voxelsize to output grid.

Interpolation - Different interpolators with increasing complexity
Rebuild SDF - Rebuilds and normalizes the narrow band of the level set
Prune - Removes values from the level set that are smaller than the Prune Tolerance set below

Saver

Pipe a grid into here and the frame or sequence is saved as VDB files upon clicking the Save button.

Save Type - a choice of Frame or Sequence. In both cases, a files or files will be saved using the File Name 
chosen appended with the frame number
Save Path - Choose a folder for the frame or sequence
File Name - The chosen prefix for the frame or sequence
Save - Immediately saves the frame or sequence. There is no visual confirmation apart from the playhead 
stepping through the scene in case of a sequence save

To load files saved this way, use the OpenVDB Info node to choose the VDB file and its channel saved.
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Scatter

Scatter creates particles on the input grid.  The particle system constructed belongs to the scatter target item. Particles 
can be scattered on or in both SDF and fog volumes.

Scatter Target - The input grid to scatter on
Scatter Mode - Dropdown to specify how the particles will be placed:

Point total - Absolute number of particles to be scattered
Point Density - Percentage of voxels in which to place a particle
Points Per Voxel - Number of particles to put in each voxel

Seed - Sets the random seed
Spread - Distance to randomly move from the voxel center

Depending on the scatter mode chosen:

Point Count - When Point Total is chosen (integer)
Density - When Point Density is picked (percentage)
Points Per Voxel - When Points per Voxel is chosen (scalar)

Multiply - Density multiplier
Animate - Reseed the random generator each frame
Fill Interior - Fill particles inside the sdf narrow band
Size Factor - The size of the particles created
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Creating bubbles inside a VDB toroid is simple with the Scatter node. The Filter node has been used here in Erode mode 
to ensure that the bubbles are created inside the toroid volume and not at the boundary.

Solver
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A particle solver that uses a particle system to initialize a temporal PIC/FLIP feedback loop. Particles from the particle 
system are input as they are born. Then are advected by the integrator using the gravity over the frame substeps. PIC 
(Particle In Cell) produces smoother motions, and FLIP (FLuid Implicit Particles) is splashier. The two methods can be 
combined.

The Navier-Stokes equations that the PIC/FLIP system uses do not dictate position but velocity. The vectors contained 
are not coordinates but velocities. PIC / FLIP is an advection equation, which is how the particles in these objects move 
within velocity fields.

Particles In Cells (PIC) works by evaluating particles as groups of particles in cells (like voxels)

FLIP stands for FLuid-Implicit Particles and uses a grid rather than particles. Grid-based methods were great for large 
ocean effects, but not fine detail close up visual effects work. Things can look globby and unrealistic at a small scale 
(thin fluids).

Inputs
Collision Grid - SDF grid to be used for collisions
Particle System input - Use a separate particle system

Outputs
Grid - Outputs an SDF grid
Particle System Out - Particle system output
Start Only - Only uses the first frame of the particle system
Voxel Size - Size of the gid voxels
Integrator - In short, the upper choices from this dropdown menu are faster but the lower choices are better 
quality
Subframe Steps - More steps per frame is more accurate but takes longer
PIC↔FLIP - Ratio of PIC velocities to FLIP velocities
Blobby - Check to treat the particles as spheres
Gravity - Downward pull in meters per second squared
Stickiness - Amount of velocity absorbed by contact with collision object
The next three checkmarks are to help visualize the grid:

Show Particles
Show Grid velocity
Show Collider grid

Vector Merge and Split

The Solver is time-based so scrubbing the scene will break it, particularly going backward. Create previews to 
see a smooth animation if your scene is too heavy.


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New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states

Velocity

This node will construct a velocity grid for motion blur use.

Reference Grid - Use to populate the velocity grid on the active values
Velocity - Vector of velocity evaluated during grid building
Rebuild Velocity - Rebuild Velocity at each evaluation rather than creating a static field

You can use an envelope or a texture map to adjust the velocity grid over time for more control

Visualize

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
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Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform
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Projections

Click here to expand Table of Contents...
Image Map Projection
Cubic

Cubic Projection

Cylindrical
Cylindrical Projection

Front
Front Projection
Fixed Projection

Planar
Planar Projection

Spherical
Spherical Projection

UV
UV Texture Maps
UVs and Projection

UV Tiles and Offsets

Image Map Projection

Since images are usually rectangular and surfaces may or may not be, you must tell LightWave how you want the image 
map projected onto the surface. The common projection types settings are Planar, Cylindrical, Spherical, Cubic, Front 
and UV.

Generally, you should pick the shape that best describes the surface shape. (Note that this is not necessarily the object’s 
overall shape since that may be made up of many surfaces.) For example, if you were mapping a label image on the 
sides of a soda can, you’d use Cylindrical. For a planet, you’d use Spherical. For a wall, Planar would do the trick. For a 
brick, Cubic might be best.

What about a die? Cubic? This may be a trick question. Since a die has a different number of dots on each side, you’d 
use a different Planar map on each one.

Standard Image Mapping tools (i.e., planar, cylindrical, and spherical mapping) may be somewhat limiting when the 
surface is irregular in shape. These techniques usually work well only in cases where the entire texture image can be 
globally mapped using a linear interpolation along two axes. The object geometry essentially has no influence on how 
the texture is applied.

However, what if you could assign areas of a texture image to points on the surface, essentially tacking it down at key 
points? This is what UV Mapping in Modeler allows you to do. Between the tacks, the image is stretched smoothly.

The projections nodes are for determining how images are mapped when using the Image Sampler and Normal 
Sampler nodes.


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Cubic

 

Replicates the Surface Editor Cubic image mapping available in LightWave.

Click here to expand explanation...

Cubic Projection

Cubic projection is essentially the same as Planar, except that you cannot select a Texture Axis. Cubic projects the 
image from all three axes at the same time. The image is projected like Planar, except simultaneously along all three 
axes. Use Cubic when you wish to apply the same image to all sides of a rectangular shape, such as an image of tiling 
bricks wrapped around the sides of a building, or wallpaper on the walls of a room.
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Cylindrical

 

Replicates the Surface Editor Cylindrical image mapping available in LightWave.

Click here to expand explanation...

Cylindrical Projection

Cylindrical projection wraps an image around the selected axis like a paper towel wrapped about a cardboard tube. 
By default, an image is wrapped so it covers the surface once, allowing the side edges of the image to meet on the 
back of the surface. A soda can and a tree trunk are both good examples of surfaces that would use Cylindrical 
projection.

Note that Cubic Projection projects along the X, Y and Z axes and objects merely intersect these 
projections. This means that images like text will only be correct on three sides, the others will be reversed 
as shown here with the images that have the arrow coming out of them rather than going in. Creating an 
item like a dice needs six planar projections to be correct.


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Cylindrical projection is always wrapped around a surface so that the top of the image appears towards the positive 
axis side of the Texture Axis.

Front

 

Replicates the Surface Editor Front image mapping available in LightWave.
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Click here to expand explanation...

Front Projection

The concept of Front projection is very simple and quite similar to a chroma-key effect. However, instead of 
applying an image where a color screen is, it replaces the selected surface(s) with a selected image.

In most cases, the image you select for a Front Projection Map is the same image you use for the Background Image 
on Layout’s Compositing Tab of the Effects Panel (Windows > Compositing Options).

Scale, Position, and so on, are not relevant with Front projection. It is always the size (and frame/pixel aspect) it 
would be if loaded as a Background Image. As such, changing the Resolution or Pixel Aspect Ratio on the Camera 
Properties Panel will also affect the Front projection.Front projection is used primarily for comp (compositing) work 
where you combine LightWave objects with a live-action background image or sequence. A common example 
occurs when you want a LightWave object to cast a shadow (believably) onto the image or behind a portion of the 
background image.

The image used in the surface and the background will pin-register the surface to the background, letting you go in 
front or behind. Your object then appears to interact with the environment. You can cast shadows or cause 
reflections from a regular 3D object onto the surface that is front projection mapped.
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Front-Projection mapped Ground surface catches the character’s shadow.
The ground object is just a flat box with Front Projection Image Mapping that uses the same image as the 
background. Its job is merely to catch the object’s shadow.

Another example is to use an image of trees as your background image and fly a UFO between them so the UFO 
appears to go in front of some trees and behind others. All you need to do is model some rough shapes that match 
the trees you wish to fly behind (they could even be flat planes).

Another good example for Front projection is to create a flat plane and align it to an image of an ocean or a lake. 
Front projecting the water surface onto it lets you place an object beneath the water and push it through the 
surface. Submarines and sea creatures will appear to break the surface this way.

The hardest part of Front projection is aligning the objects, matching lighting, and getting the right camera angle. 
Using Background Image as the Camera View Background on Layout’s Display Options Tab of the Preferences Panel 
(Edit > Display Options) will allow you to do all that. You also must search for the right balance of Luminosity and 
Diffuse for the Front projection surface so that the object’s true shape is not revealed by shading.

Fixed Projection

Front projection surfaces will always look the same no matter where you move the object or which way you rotate it. 
The image does not normally stick to the surface. However, if you activate the Fixed Projection option (previously 
Sticky Projection), it fixes (i.e., locks) the projection from the camera’s perspective at the specified Time.

The default unit of measure for Time depends on the Frame Slider Label setting on the General Options Tab of the 
Preferences Panel in Layout or the Time Format setting on the Display Options Panel, Units Tab in Modeler. You may 
specify the unit of measure by appending f for frames or s for seconds to the entered number (e.g., 22f for frame 22, 

NOTE: Don’t use the Soft Filter (Camera Properties Panel) with Front projection. It will soften only the 
image used on the object surfaces, not the background.


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31s for 31 seconds). You may also enter SMPTE time code, like 00:00:01:16 for one second, frame 16. The entry is 
converted to the default unit of measure.

Use Fixed Projection to create parallax with two-dimensional images by using a technique called Camera Mapping. 
(Use the Reference Camera setting to select the camera, if you have multiple cameras in your scene.)

Essentially, you set the frame where the texture will be pin-registered to the background (like normal Front 
Projection Mapping). On all other frames, the texture is stretched to compensate for more or less of the texture 
being visible, which is caused by factors like the camera being moved.For example, in a picture of some buildings, 
you could place the LightWave camera in the same place as the original camera in relation to some simple 3D 
buildings; then, you could project the picture onto the buildings and lock it at frame 0. You’ll need a doctored 
background image/object - with Fixed projection - to reveal what’s behind the buildings. If you move the camera 
forward, it will appear to fly into or around the buildings.

Use your paint program’s rubber stamp function to erase areas where background Fixed projection 
surfaces will be revealed.

Obviously, there are great limitations in getting three-dimensional data out of a two-dimensional picture. 
However, short slow-moving sequences can be quite realistic.



Using the Shadow Catcher workflow offers a more modern way of achieving the result
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Planar

 

Replicates the Surface Editor Planar image mapping available in LightWave.

Click here to expand explanation...

Planar Projection

Planar projection will project an image onto a surface as if you were projecting the image through a slide projector 
onto a wall. Planar Image Maps are best used on flat, or nearly flat surfaces like the sides of buildings and the 
screens of video monitors.
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For the X and Y axes, Planar images are projected from the positive axis side of a surface towards the negative axis 
side. This means that the image appears correct when viewed from the positive side and it appears reversed if you 
view it from the negative side. For the Z axis, Planar images are projected from the negative side.

If you encounter this reversing effect and it isn’t what you want, you can reverse an image back by making the Scale 
value negative for the axis that needs to be reversed.
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Spherical

 

Replicates the Surface Editor Spherical image mapping available in LightWave.

Click here to expand explanation...

Spherical Projection

Spherical projection wraps an image around a surface as if you were stretching a flat piece of rubber around a ball, 
but without having to worry about the edges all meeting. Planets, basketballs, and marbles could all use Spherical 
projection.
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Spherical projection does not use Scale parameters. Images are wrapped completely around the surface (using the 
Wrap values, discussed later). Spherical projection is always oriented so that the top of the image appears toward 
the positive side of the Texture Axis.

UV

Replicates the Surface Editor UV mapping available in LightWave.

Click here to expand explanation...
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UV Texture Maps

The U and V refer to Texture Map coordinates and are really not very different from the XYZ coordinates you are 
familiar with. In fact, UV Mapping is the process of setting up a relationship between the two dimensions of an 
image, U and V, with the three dimensions of an object surface, XYZ.

Once this relationship is set up, changing any parameter (i.e., U, V, X, Y, or Z) will also relatively change the 
appearance of the Texture Mapping. With UV Mapping, the object provides additional information for Texture 
Mapping, which can be different for any given point on the surface. The texture is more or less stuck to points on the 
surface using a relationship that you define.

UVs and Projection

UVs have to come from somewhere. For existing polygonal models, the choices are limited to setting the UV 
coordinates for each point in the object manually, or applying some projection, which automatically generates the 
2D Texture coordinates from the given 3D point positions. In LightWave, you can create UVs by using projections, 
which also happen to be the same as the standard projections for Texture Mapping (i.e., Planar, Cylindrical, and 
Spherical).Usually, the projection for the UV Map is not suitable for the whole model. The projected UV Map must be 
tweaked - eyes and nostrils moved over the right parts of a face, or texture features matched to geometry features.

For illustration purposes, let’s say you had your texture image printed on a piece of very flexible rubber and wanted 
to fit it on a toy car made of wood. You could conform the rubber material to contours of the car by tacking it down 
with thumbtacks. That is more or less what UV Mapping does. However, it is slightly reversed: what you do is tack 
the UV points down onto the image. Alternatively, imagine that your image is printed onto flat paper and you use an 
advanced form of Origami to fold it into shape.

Keep in mind that standard Projection Mapping is more accurate because it has some exact, continuous 
value over the entire surface. UV Mapping, on the other hand, is technically accurate only at small sample 
points. The surface for the large areas in between the sample points is interpolated. Adjusting the sample 
points so that the interpolated areas look right is difficult and the reason why UVs are more difficult to use.


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UV Tiles and Offsets

In all cases, except Front, Projections include Tiles and Offsets options. These options apply equally to images that are 
not UV mapped, despite their naming, and simply refer to the horizontal (U) and vertical (V) directions. Using tiles and 
offsets it is possible to tile image maps over the polygons of a surface. It can also be used as a way of offsetting UDIM
tiles.

Using projections with Object UVs from Primitive Shapes is not necessary. You can pipe the Image Sampler 
node with your image directly into the input you want on the surface of a Primitive Shape



Anisotropy requires that there is a Projection node input otherwise you will get strange polygonal shapes in 
the render.

Left: Anisotropy at 100 %, Rotation at 15 %, Roughness at 30 %. Right: No Projection


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RayTrace

Raycast Geometry

RayCast

The RayCast node allows rays to be cast into the scene. The rays are “fired” from the Position input vector and will 
travel in the direction of the Direction input vector. This is the fastest way of tracing rays through the scene, as the ray 
casting only returns the length the ray traveled before it hits another surface (on any object including the objects whose 
hit point is currently being evaluated). Both the Position and Direction inputs must be specified in world coordinates 
(the Transform and Transform2 nodes can be used as required). If the ray fired does not hit another object, then the 
Length is returned as being -1.0.

RayClosest

This node returns the distance to the closest mesh element in the hemisphere above the position supplied and in the 
direction supplied. This means that a Scalar value is output that can shade nearby geometry. In the example pictured 
we have used the settings to drive the colors of the outside edges of the LightWave logo.
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RayTrace

The RayTrace node allows rays to be traced through the scene. The rays are “fired” from the Position input vector and 
will travel in the direction of the Direction input vector. As with the RayCast node, the ray trace function returns the 
length the ray traveled before it hit another surface. However, with RayTrace, the surface which the ray hits is also 
evaluated, and the result is returned as the Color output. This means that it may be used to trace reflection and 
refraction. Both the Position and Direction inputs must be specified in world coordinates (the Transform and 
Transform2 nodes can be used as required). It the ray fired does not hit another object, then the length is returned as 
being -1.0 and the color black.
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Spot

This group contains the Instance Info node. It allows access to all information regarding the current hit point for 
instances.

First let’s define what a “spot” is. A spot is just a spot - a fleck, a pinpoint. You can think of a spot as a single element 
area that is calculated or evaluated, on a surface and that it is arbitrary in size. Any given spot contains several types of 
data including color, normal angle, the direction that a ray is coming or going from relative to that spot, and so on. 
Remember Node Editor is a surface texture and shading editor so the word spot here pertains to the spots of an object’s 
surface. Spots are a useful primitive type for texture design, because, in general, the relations between features of the 
spot and features of the texture are straightforward.

Instance Info

This node gives control over instances - virtual polygons. I can be used to gain an ID Index for a particular instance, or 
get a Fixed Random index number for a non-specific instance.
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Tools

Click here to expand Table of Contents...
BlackBody Radiator
Color Scalar
ColorTool
Compound

Example - Simplifying the Benchmark Marbles nodes

Convert Color Space
EdgeShader
Limiter
Make Color
Make Vector
Mixer
Occlusion
Patina
Random Integer
Random Scalar
Random Vector
Vector Scalar

BlackBody Radiator

A Black body is an object that absorbs all energy falling on it. In LightWave, it can be used to give a color suitable for fire 
or explosions. The Color output is decided through a Kelvin temperature between 1000-25000, where 6500 is equivalent 
to daylight (and equivalent to 1).

Color Scalar

The Color Scalar node allows a color to be converted into a scalar. Double clicking the node will present a dropdown list 
of modes that determine how the conversion occurs. These are:

Average - this outputs a scalar as the mean of the three color components. 
Scalar = (Red + Green + Blue) / 3.0

Maximum - outputs the scalar as the largest of the three color components. 
Scalar = Max(Red, Green, Blue)


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Minimum - outputs the scalar as the smallest of the three color components. 
Scalar = Min(Red, Green, Blue)

Red Channel - outputs the scalar as the value of the red component.
Scalar = Red

Green Channel - outputs the scalar as the value of the green component.
Scalar = Green

Blue Channel - outputs the scalar as the value of the blue component.
Scalar = Blue

Luma - outputs the scalar as the luminance of the input color.
Scalar = CCIR 601 luminance values formula Y’ = 0.299 R’ + 0.587 G’ + 0.114 B’ so (Red x 0.299 ) + (Green x 0.587 ) + 
(Blue x 0.114 )

ColorTool

The Color Tool node takes the input color and provides a set of controls that allow it to be manipulated or processed 
and then output. The available manipulations are:

Hue - allows the hue of the input color to be shifted by any number of degrees. The HSV color model specifies H 
as Hue being an angle with red at zero degrees, green at 120 degrees, blue at 240 degrees, and so on. The input 
color is converted to HSV and the derived hue shifted by the specified amount.
Saturation - works in much the same manner as Hue. Again, as with the HSV color model, S is the saturation 
where 0% is the absence of any hue (gray scale) and 100% is full color saturation. The input color is then 
converted to HSV. This control is used to specify the saturation. This has the effect of being able to fade colors to 
gray.
Brightness - allows the overall brightness of the color to be controlled. Again, this is based on the HSV color 
model and here it is the V, or value, that is specified by this control. This control works in the same way of the 
brightness control on a television.
Contrast - allows the contrast of the input color to be altered. This control works in the same way of the contrast 
control on a television.

Compound

A Compound node is a container for other nodes, or networks of nodes, simplifying complex networks and making for 
easy reuse. The easiest way to understand it is with a quick example.

Double-clicking on the Compound node will enter a new Node editor with Compound as its title. You will see two nodes, 
an Input and an Output. If you have dragged an output to the Compound already, the Input node inside the Compound 
Node editor will show it as an output. A nodal network can be built inside the Compound Node editor and when either 
the Compound’s Input or Output nodes are double clicked you will be returned to the main Node editor.

Inputs to the Compound node can be renamed by right clicking on the entry. Renamed entries are also renamed inside 
the Compound node window.



LightWave 2020  –  LightWave 2020

Reference –  2576

 

Example - Simplifying the Benchmark Marbles nodes

Convert Color Space

For use with images that are already profiled, pipe the image's color output through the Removed output to linearize 
them. Or if your images are linear use Applied to add the color space selected in the node's interface.

Why is this handy? Assuming you're using the sRGB preset, then the Color Constant node will be supplying the 
linearized version of the color on its output connection (it removes the Picked Colors space). Something like a vector 
node does no such conversion therefore connecting a vector node to a material's Color input will produce a brighter 
color compared to the Color constant node with the same numerical values. Pipe the vector node through this node 
and "remove" the same space as Picked Colors and they'll then match.

EdgeShader

You can rename the Compound node and also use the notes function to make its function more 
understandable. Double clicking to enter the Compound will put Compound in the title bar.


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The edge shader will perform a rendertime smoothing of hard geometry edges. It's not a replacement for 
good modeling, but it will create a smooth appearance for less important scene items. The controls are:

Radius - the size of the rounding effect. The default is 10 mm, and while you can go bigger, the effect quickly 
becomes unrealistic depending on the scale of your object
Concave - The Edge shader acts on concave edges by default
Convex - The Edge shader acts on convex edges by default
Bevel - Add a straight bevel to an edge. The field determines what percentage of the created edge is a hard bevel
Angle - The Edge Shader will only work on edges between polygons that are at an angle greater than this field. 
The default is 15 %
Only Self - If you have multiple objects or surfaces using the Edge Shader, and they encroach on each other's 
position, the Edge Shader will smooth over the join unless this option is checked

Limiter

The Limiter node clamps each channel of the input color between the user-specified low and high limits. Therefore, 
none of the Red, Green, or Blue components of the input color will be output as being lower than the value specified by 
the Low input. Conversely, none of the Red, Green, or Blue components of the input color will be output as being higher 
than the value specified by the High input. Imagine three Clamp nodes each with the same limits placed on the red, 
green, and blue components of the color.

Make Color

The Make Color node allows a color to be constructed using three scalars. The scalars used are input on the Red, Green, 
and Blue inputs, respectively, and must each vary between 0.0 and 1.0.

Make Vector

The Make Vector node allows a vector to be constructed using three scalars. The scalars are input on the X, Y, and Z 
inputs, respectively.

Mixer

The Mixer node allows two colors to be mixed based on a scalar using the standard nodal blending modes. In other 
words, it can be used to composite two colors. The Fg Color is mixed with the Bg Color using the Opacity as the alpha 
component for the mix. The two colors will be mixed based on the selected Blending mode. For more information about 
the blending modes see the Common Input and Outputs section. The mixed, or blended, color will be output on the 
Color output, while the Alpha output is driven with the value used for the opacity input.

Occlusion



LightWave 2020  –  LightWave 2020

Reference –  2578

•
•
•
•

Occlusion is a shading method that looks at how accessible areas of a polygon are to ambient light. It is not as accurate 
as true radiosity, but much faster to calculate and can be used as a "dirt shader". There are two modes - Infinite and 
Range. Ranged can be driven by a distance or a node.

Patina

The Patina node can add Wear (a convex shader) to a surface, or Dirt (concave) based on a radius and offset. 
The fields are as follows:

Radius - The area to be used for the Wear and Dirt outputs
Offset - Offsets the evaluation position to get rid of artefacts if encountered
Samples - The number of samples to use for Patina
Only Self - Hits are only from only occlusion by the geometry in the same object with the same surface

The Patina offset will correct shading artefacts by offsetting the evaluation position
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Demonstration of Only Self toggle use with two objects

Random Integer

Creates a random integer based on the Seed value input either in the Edit Panel or from an integer input connection.

Random Scalar

Creates a random scalar value based between the Min and Max Range in the Edit Panel. These ranges can also be 
enveloped and the Edit panel offers switches to include the Min and Max values.

Random Vector

Like Random Scalar, but for vectors.

Vector Scalar

The Vector Scalar node allows a vector to be converted into a scalar. Double clicking the node will present a dropdown 
list of modes that determine how the conversion occurs. These are:

Maximum - outputs the scalar as the largest of the three vector input components.
Scalar = Max(X, Y, Z)

Minimum - outputs the scalar as the smallest of the three vector input components.
Scalar = Min(X, Y, Z)

X Channel - outputs the value of the X component of the input vector.
Scalar = X
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Y Channel - outputs the value of the Y component of the input vector.
Scalar = Y

Z Channel - outputs the value of the Z component of the input vector.
Scalar = Z

Length - outputs the length of the input vector.
Scalar =Length(X, Y, Z)
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Vertex Map

These nodes give access to vertex maps stored in objects.

Morph Map

The Morph Map node allows access to any morph maps assigned to an object (relative or absolute). Once selected, the 
Position output will be driven with the morph amount derived for the current hit point and the selected morph map. 
This allows the amount of morphing to be considered in any shading or texture networks such as making the surface 
color change proportionally.

UV Map

Once a specific UV Map is selected in the Edit panel, the two scalar outputs will give the U and V values.

Vertex Color

The Vertex Map node allows access to any color maps assigned to an object. Once selected, the Color output will be 
driven with the color of the selected vertex map. As with all color-based nodes, the vertex map color can be mixed with 
the Bg Color. This mixing is based on the currently selected blending mode and the alpha channel derived for the color 
map.

To apply a vertex color map to a material other than Standard, you will need to use the Node Editor in which you add a 
Vertex Map > Vertex Color node.

Take the Color output from this and apply it to your material's Color input:



LightWave 2020  –  LightWave 2020

Reference –  2582

For more information on how the vertex map color and Bg Color are mixed based on the blending modes see the 
Connections section.

Weight Map

The Weight Map node allows access to any weight maps assigned to the object being shaded. Once selected, the Value 
output will be driven with the morph amount derived for the current hit point and the selected weight map.
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Volume Components

These volume components are designed for use with the material components for refraction/transparency - Beckmann 
BTDF, GGX BTDF and Specular BTDF.

Transmittance

Exactly the same Transmittance as in the Dielectric material.

Transmittance (Color)

The transmittance of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Transmittance Distance (Scalar)

This is the distance at which the medium absorption color reaches Transmittance Color.

Transmittance requires Volumetrics to be enabled; otherwise, there will be no color.
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Volumetric

Volumetric works in the same way as the Sigma 2 material.

Scattering (Color)

Scattering is a volumetric effect. To work properly, it needs to have Affect Volumetrics turned on in lights. Otherwise, it 
only absorbs light according to the scattering color.

Absorption (Scalar)

How quickly light passing inside an object is extinguished. A low value here with indicate greater transparency. Based 
on Beer’s law of absorption, to give a more realistic and non-linear result.

Scale (Scalar)

Scales the Scattering and Absorption values.

Asymmetry (Scalar)

Ratio between the amount of forward to backward scattering. With a positive value, more light is scattered from behind 
the object, with a negative value more light is scattered from in front of the object, relative to the observer.

With this example we have two lights, one in front, one behind our sphere. Both are very strong and the one behind is 
colored green, the one in front red. With Asymmetry set to 0.5, the light from the green light is scattered forward 
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towards the observer, in this case the camera. When Asymmetry is set to -0.5 the light from the red light behind the 
camera is reflected toward the observer.

Step Size (Scalar)

This is the volumetric scale for your surface. Larger numbers will render faster but be less defined.
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Color Spaces
What is Linear Workflow?
Using LightWave’s CS Settings
Convert Color Space to Linear
Apply Color Space
Other Options

Before we delve into surfacing proper, an increasingly important part of graphics workflow today is making sure you 
have the correct color workspace set for your target support for your graphics. Rendering for print is different to 
rendering for the screen, and even there, rendering for the web is different to rendering for the cinema screen. 
LightWave supports loading and saving color space information to work within pipelines requiring it. This is called 
Linear Workflow.

What is Linear Workflow?

Color is not just the simple triplet of 0-255 RGB values we’ve always known. When you view work on a computer screen 
it has a “gamut”, that’s to say a range of colors the screen can present. Images are displayed with a value called Gamma 
to match the initial colors with what the monitor can show. A Gamma value is an exponent of the curve that is created 
from the input voltage to your monitor to the output light intensity. Ideally, this would be linear but in reality follows 
what is called a powerlaw function. Gamma compensates for this curve by applying a reverse curve that flattens our 
output line.

  

LightWave’s render engine is linear internally, meaning there is a 1:1 relationship between Input Signal and Light 
Intensity, but images that you will use for textures and colors you pick in the color picker will have gamma applied so 
that they display correctly onscreen. What LightWave’s Color Space settings do is to bring everything to a linear state so 
that you are comparing like with like. It also prevents the problem where images, that already normally have Gamma 
applied, don’t have it applied again needlessly washing out textures. It does this by stripping the gamma correction 
from an image (purely the image loaded in LightWave, not the one on disk) to make it linear and then only applying 
Gamma correction to the rendered image.

The Gamma correction applied differs depending on the final destination of the image. For a computer screen, the color 
space used is called sRGB; for images destined for HDTV you will want to use Rec. 709. The Cineon color space is most 
often used for cinema, while ciexyz is the complete gamut of visual light. In addition you can load custom Look Up 
Tables (LUTs) in order to suit a custom pipeline. These settings can also be saved as presets making reuse simple.
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Materials rendered in Linear and with sRGB color space applied - no changes were made to lighting

 

Kitchen rendered in Linear and with sRGB color space applied - no changes were made to lighting
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Linear workflow

LightWave has the ability to load *.csp, *.3dl and *.cube LUTs

Using LightWave’s CS Settings

Since LightWave 10, LightWave has been able to use Color Space information to give better results, above all with 
images used for texturing. Color space conversion is performed in four places in LightWave.

On loading, an image can be converted from its native color space format to linear.
When sent to the Image Viewer, an image can be converted from linear to another color space.
When saved from the Renderer, an image can be converted from linear to another color space.
When picked from the Color Picker, a color can be converted from and then to linear color space.

By default, LightWave is set not to do any conversion - the Linear setting, but to better suit work for the monitor, switch 
to sRGB. For better work for cinema choose Cineon and for widescreen high-definition TV choose Rec.709. These 
choices will help convert images that may already have color space definitions and keep their colors pure.

LightWave provides presets for sRGB and rec.709 but a personalized mix can be set up with the dropdown choices for 
each of the different elements and saved as a preset for future use. You can also load in color space definitions to 
exactly match existing setups. A color table can be loaded by using Load Table from the pop-up. The color tables are 
stored in the project directory, in a directory called ColorTables.
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The options are as follows:

Convert Color Space to Linear

Picked Colors - Colors chosen from the LightWave or other color picker
Light Color - The color chosen for lights
Palette Files - Palettes loaded into LightWave
8-bit Files - 8-bit here refers to images that are 8 bits per channel such as JPGs, PNGs or TGAs, previously known 
as 24-bit or 32-bit. These benefit the most from color space conversion.
Float files - Images using floating point colors schemes don’t benefit from color space conversion, indeed it 
would cause severe banding and thus this should always be left on Linear
Alpha - Again, alpha images need to be preserved exactly as they are since the level of gray indicates distance. As 
such they don’t require or want color space conversion

Apply Color Space

Display Color Space - What Layout looks like. Normally, this should be left at sRGB unless you are working on a 
cinema screen or loom or something
Output Color Space - This is the color space for your renders. Again, if they are for the monitor choose sRGB
Output Alpha Color Space - This should be left at Linear as for the conversion settings

Other Options

Auto Sense on Load - when you load a scene LightWave detects what CS setting were already in use and changes 
to them automatically when this option is activated
Color Correct OpenGL - to better match the colors of polygons and lights when not viewig in VPR or a render
Affect Color Picker - Best left checked since otherwise the colors you choose in the color picker won’t be those 
you get in the render
Convert 8-bit to Float - Converts 8-bit per channel files, otherwise known as 24-bit, to floating point files. This 
increases the memory overhead a lot for textured images. It will increase the fidelity of the results but is not 
always needed
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Surface Editor
Click here to expand Table of Contents

Introduction
Surfacing Objects
Assigning Surface Names
Surfacing Ideas

Surface Editor Panel
Surface Search
New Panel Hierarchies
Surface List
Surface Libraries
Node Conversion
Surface Preview

VPR Surface Picking
Mass Surface Changes
Preset Shelf
Basic Surface Parameters
Shading Models
Bump Map
Envelopes and Textures
Surface Smoothing

Smooth Threshold
Sharing Points
Using Separation

Vertex Normal Map
Clip Map
Double Sided
Opaque

Introduction

Except for new Primitive objects, LightWave objects are composed of one or more polygons. What each polygon looks 
like is defined by its surface attributes or usually just surface for short. Groups of polygons can share the same surface, 
and the polygons need not be contiguous. The polygons can even be in different objects.

Surfacing Objects

Let’s take a simple cube. It has six sides and, therefore, at least six polygons. Each side could have its own individual 
surface; all six sides could use the same surface or any combination in between.
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The polygons that make up a surface are given a name, usually in Modeler. The surfacing information associated with 
the surface name is stored in the object file. When an object is later loaded, the surfaces used in it are also loaded, 
including any image files referenced in the surface attributes.

WARNING: Surface settings are saved as part of the associated object file(s), not in the Scene file, with the 
exception of primitive objects. To save Surface settings, save the object.


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Assigning Surface Names

In Modeler, select the polygons that you would like to surface

When you rename all of the polygons that already have a surface name, use the Statistics Panel (open/close with 
the Statistics button at the bottom of the interface - or press W) to select them. Also, if you are naming all 
polygons, you don’t need to select any.

Choose Surface (located at the bottom of the interface, or press Q) to open the Change Surface dialog.
Enter the surface name for the selected polygons and click OK. You can also select an existing surface name from 

the pop-up menu.

You should strive to give your surfaces meaningful names. For example, say you had a car object. One surface 
might be called “chrome,” which you apply to the bumper, door handles, antenna, etc. “BlackRubber” might be 
another surface, which you apply to the tires, rubber gaskets, etc. You might use “RedMetal” for all of the 
exterior painted metal parts of the car.

To set some basic Surface settings, activate Set Initial Color, and adjust the available settings as desired. You can 
perform more advanced surface editing using the Surface Editor.

The Make Default option automatically updates the Surface option on Modeler’s General Options Panel ( Edit > 
General Options ). This controls the default surface name used when you create new geometry.

Click OK to confirm.
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Surfacing Ideas

By no means should you restrict yourself to using, say, a procedural texture for what its name implies. The unlimited 
combination of settings, layers, nodes, and different surface attributes yields an infinite number of visual possibilities.

You are encouraged to load and render the various objects that come with LightWave. Study their surfacing techniques. 
Change them if you want. However, do not fall into the trap of thinking the surfaces are perfect. Many of them are far 
from it. Surfacing is an art form, and 3D artists each have their own opinions on the best approaches. You need to 
develop your own.

Surface Editor Panel

The Surface Editor Panel will list the characteristics of your named surfaces; you can access this panel from both the 
Layout and Modeler modules. There are four buttons at the top of this list:

Think about your surface names. With the car example above, you may want to name the area of the car to 
have more granularity and better surface sorting. For instance, you could name the surfaces for the wheels as 
"wheels.tire", "wheels.rim", "wheels.caliper" and so on. That way, all your wheel surfaces will be gathered 
together.


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File... - A dropdown menu to load and save individual surfaces or libraries of surfaces
Preview - this button opens the selected surface in a Surface Preview window

Preset... - A dropdown menu to save surfaces to the preset window
Edit Node Graph - Opens the Node Editor. You can also double-click on a surface name in the Surface Editor to 
open the Node Editor
Search - Searches the surface names. The search can be made case sensitive or cleared using the dropdown

Click here to expand Surface Search...

Surface Search

Searching in the Surface Editor is based on the following string:

ObjectName/SurfaceName@MaterialName#ShadingModelName

This means that you can search for objects and get their surfaces, or search for surfaces or materials or even shading 
methods by preceding them with:

/ - for surface names
@ - for materials
# - for Shading models

Note that the Preview button does not work in Modeler since there is no VPR
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Regex example 1

To get more control over your searches, you can use Regular Expressions. The last search in the example above 
reads:

re:mar.+/.+lor

which translates to

RegEx: find all objects starting with "mar" with surfaces starting with anything but 
having "lor" in them

resulting in only the Marble-GlassTwist object being found with the GlassColor1-4 surfaces.

Regex Example 2

In the same scene, we want to only select surfaces on objects that have swirl in their object name, but just surfaces 
ending in the letter s. We can do this thanks to regex with re:+swirl.+/.+s@.
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I was going to write swirl but decided just to put the wildcard in again.

The Surface Editor regex style is taken from QT. More information and syntax can be found here.

http://doc.qt.io/qt-5/qregexp.html#introduction
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Surface List

The list on the left has the surfaces available for edit and gives the material used. It is divided into groups by object. 
Surfaces that have no object can appear here but will be removed when the scene is cleared.

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.



Double-clicking on a Surface name will open the Node Editor
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Right-clicking on a surface name will bring up several options:

Copy - Copies the selected surface or surfaces
Paste - Pastes copied surfaces. It will paste the same surface over all selected surfaces
Paste Common - Pastes attributes under the Material: Clip Map, Smoothing, Smoothing Threshold, Vertex 
Normal Map, Double Sided, Opaque
Paste Shading Model - Pastes only the shading model used for the copied surface
Paste Node Graph - Pastes only the node graph used for the copied surface
Rename - Renames the selected surface. Selecting multiple surfaces will result in a Rename requester for each 
surface. Hitting Cancel in any of the Rename requesters will cancel any further renames in the selection.
Select by Same - Brings up choices for selecting similar surfaces

Name - If there are surfaces with the same name they will be chosen (good for getting rid of duplicates 
with imported assets)
Material - Surfaces using the same material will be selected
Shading Model - Surfaces using the same Shading Model will be selected
Material/Shading Model - Surfaces matching Material and Shading Model
Name/Material/Shading Model - Surfaces matching Name, Material and Shading Model

Load - A submenu of loading choices
Load Surface - Loads a saved surface
Load Library by Index - Loads a surface library assigning surfaces by object index
Load Library by Name - Loads a surface library assigning surfaces by object name
Load Library by Name, Append Extra Surfaces - Loads a surface library assigning surfaces by object 
name and also loads surfaces that are contained in the library for which there are no scene objects

Save - A submenu of saving choices
Save Surface - Saves an .srf file referencing a single surface
Save Library - Saves a .lib file referencing all the surfaces for an object or objects. Libraries are named 
the same as the object that hosts the surfaces saved

Convert - Offers two choices:
Layered to Standard Nodes - Converts surfaces created using the T buttons in Surface Editor to a node 
equivalent
Layered to Principled Nodes - Converts surfaces created using the T buttons in Surface Editor to a node 
equivalent based on the Principled BSDF material
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Surface Libraries

A surface library is a file containing one or more surface definitions that can be loaded onto an object's surfaces. 
Surface libraries can be loaded by Index or Name. Loading a library by index means the order of surfaces in the library 
will be matched to the surface IDs for your object(s). Loading by name will look for exact Surface name matches. The 
last option - Load by Name, Append Extra Surfaces - will load all the surfaces in the saved library so that they can be 
copied if the surface naming isn't exact.

Example - Surface Library

Node Conversion

The Surface Editor RMB menu offers Layer to Node conversion. Textures located in T buttons on the main Surface Editor 
interface are converted to Layer nodes in the node editor, preserving their Layered basis. There is a Base Color node 
attached upstream to duplicate the use of the base color setting in the Surface Editor.

Converting to Standard
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When converting to Principled, the Standard material is included for fallback. Values for Standard channels like Reflection 
are converted to Principled equivalents where appropriate

Surface Preview

The options to create surface previews.

VPR Surface Picking

Even while VPR is still resolving, you can Shift-Click on part of the image, and the Surface Editor will open with the 
selected surface, or switch to that surface if the editor is already open.

Mass Surface Changes

You can select multiple surfaces in the Surface Name list and make mass surface changes. Hold the Shift key to select a 
range of surfaces or hold the Ctrl key to select/unselect surfaces independently.
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Parameters with input fields that have different settings for the selected surfaces will show (mixed) in the field. If 
textures are different, the T button will appear in an intermediate state. Differing colors will show as dashes in the color 
gadget. Changing a surface attribute changes it for all selected surfaces, including mixed states. Shift-clicking on the T 
or E button removes the texture or envelope for all selected surfaces.

Preset Shelf

If you would like to use the Preset Shelf, click its button on the interface. The Preset Shelf is a resizable floating window 
that holds a list of previews along with all of the associated settings in Modeler and Layout.
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Basic Surface Parameters

All of the Numerical settings have mini-sliders. You can enter a numerical value into the input field or use the slider. The 
range of the slider is based on realistic settings; however, the input field will accept values beyond the maximum and 
minimum possible with the slider, including positive and negative values. Keep in mind that, except for maybe 
Luminosity, values outside the normal range of 0 to 100 percent will be unrealistic.

The surface attributes on the Material Tab are fundamental for virtually all objects. Each represents a particular 
characteristic of a surface’s appearance. At the top of these fundamental attributes is a Material Selector that allows 
you to jump directly to an appropriate material for your surface - making something metallic? Try Conductor. 
Something transparent? Try Dielectric (or try Principled BSDF for either). You may never have thought about it before, 
but if you look at the surface of objects around you, they differ by much more than their color. Are they shiny? Dull? Do 
they reflect other items in the room? Can you see through the material? These characteristics help you determine from 
what materials objects are made.

LightWave attempts to divide the different surface characteristics into controllable parameters. We will detail each 
Material, starting with the default of Standard.

Standard
CarPaint
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Conductor
Delta
Dielectric
Hair
Principled BSDF
Sigma
Sigma2
Skin

There are also Material tools. These don't have much interactivity in the Surface Editor and should be edited in the 
Node Editor:

Material Mixer
Mesh Element Switch
Multi Switch
Ray Type Switch
Switch

Shading Models

LightWave has multiple shading models on the second tab at the top of the Surface Editor window. The one you will use 
most often is probably Photoreal, but there is also Cel, Shadow Catcher, and Sublimation Cel Shader (created by famed 
Japanese anime studio Sublimation).

Bump Map

Nearly all real-world surfaces have some amount of texture or bumpiness. Such bumps are apparent due to the way 
light falls across the surface. A Bump Map is applied to a surface to give the appearance of a texture. However, no real 
geometry is added, and looking across the surface from the side could ruin the illusion. Shadows and edges can also 
reveal this lack of geometry in certain circumstances. The default setting is 100%.
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Left: No Bump, Right: Bump at 500%. Note the silhouette is still perfectly round

If you want your bumps to actually displace geometry, try a Displacement Map in Object Properties > Deform.
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Envelopes and Textures

Very few things in the real world have constant surface properties. Color patterns, discoloration, nicks, scratches can all 
subtly contribute to an object’s appearance. The real world is anything but consistent, but that is what makes things 
look real. The E and T buttons let you use envelopes and textures, respectively, instead of a static numerical value. The 
proper use of these features often results in a much more realistic surface.

Envelopes let you vary a value over time. For example, instead of Luminosity having the same value throughout your 
animation, it can differ on each frame. However, in any particular frame, it will have that value over the entire surface. 
To vary the value over the surface area, you must use a Texture. 

Envelopes use the Graph Editor, and Textures are discussed in Texture Editor. While Envelopes are available on all 
Materials Texture buttons are only available on the Standard material. Applying textures to other Materials is done 
through the Node Editor.

Surface Smoothing

Smoothing causes objects to appear to have smoothly rounded surfaces even though the object is composed of flat-
faced polygons. To do this, LightWave uses a technique known as Phong shading. If the edges of two smooth-shaded 

Envelopes are not limited to surface values, so you will find Envelope E buttons throughout LightWave.
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polygons share vertices (points), they appear as one continuous, curved surface. The shared edge between them is no 
longer visible.

 

Left: No Smoothing, Right: Smoothing

Smooth Threshold

By default, LightWave will not smooth across two polygons if the angle between them is 90 degrees or greater unless 
you adjust the Smooth Threshold. This value adjusts the range of the smoothing function; it defines the angle beyond 
which LightWave will not smooth over the seam between adjoining polygons. The angle is measured using the surface 
normals of the adjoining polygons. If this angle is less than the Smooth Threshold, the surfaces are rendered smoothly. 
The default of 89.5° assures that any surfaces at right angles (90°) or greater to each other are not smoothed.

Sharing Points

The concept of sharing points is vital in surface smoothing. Unlike the real world, objects, and their points, can occupy 
the exact same space. A simple cube has eight points and six sides. Any one point is shared by three sides. However, you 
can create a seemingly identical cube that doesn’t share any points or sides. Each side would be a totally independent 
polygon, thus there would be 24 points (six sides times four points).

The obvious reason for using shared points and sides is that it creates a more compact object. Remember, the simpler 
the object, the faster it renders, and the lower the number of resources used (i.e., RAM). However, sometimes, you will 
find that the polygons need to be separated.

Using Separation

Surface Smoothing can occur only where two polygons share all of the points along an edge. However, sometimes this 
smoothing is not what you want. For example, if you were Modeling something where you wanted a visible physical 
break, like a seam, you’d want to cut the polygons away and then paste them right back in. You may also find that when 

As with Bump Mapping, Smoothing does not change the surface’s geometry. As such, the edges of a ball can 
still expose the straight polygon nature of the object. If this becomes a problem, make the actual geometry 
smoother. You can use Modeling tools like Subdivide, for example.





LightWave 2020  –  LightWave 2020

Reference –  2608

you have a flat surface that rounds over a corner, separating the flat polygons from the initial rounded polygons gives a 
more realistic look.

 
Left: Surface Smoothing, Right: Surface Smoothing with Separated Polygons

If you examine objects around you, you should notice that they all have seams. Very few objects in the real world are 
perfectly smooth, with edges that align. Separating polygons can add subtle detail to objects and give them a real-
world look.

This technique lets you control smoothing by using a single surface name. Although you could create independent 
surfaces with identical settings - except one has smoothing on and the other does not - you may prefer to have one with 
smoothing on and use this separation technique to create the seam.

Vertex Normal Map

Although LightWave has no way of generating vertex normal maps internally yet, Layout can still work with them in 
objects obtained from other sources. This dropdown allows you to select the maps included with the object, or you can 
choose (none).

Clip Map

The Clip Mapping function, located on the Rendering Tab of the Object Properties Panel and in the Surface Editor, offers 
a way to quickly alter an object. Basically, it allows you to cut away portions of an object using a texture. This is a great 
way of creating 2D pop-ups, as well as holes, tears, or grids in objects without having to model them.

Separating polygons will double the points along the previously shared edge since each polygon now has its 
own set of those points.
Using the shortcut keys, Ctrl X and Ctrl V, to cut and paste is a quick way to separate polygons.


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Double Sided

Sometimes it’s necessary to see both sides of a polygon, such as when you want to go inside a model (and wall 
thickness is not a concern). Also, if you import objects from other 3D modeling programs, either directly or through a 
conversion utility, some polygons may end up facing the wrong direction, which causes the object to render improperly. 
Click Double Sided to treat all polygons on the selected surface as two-sided.

 

Left: Single-Sided Polygons, Right: Double-Sided Polygons

As a consequence of using Double Sided, rendering time will increase because LightWave must calculate more 
polygons. Note also that Double Sided is only a surface attribute. The object, when loaded into Modeler, will show the 
true single-sided polygons.

Opaque

Dielectric without and with Opaque, Principled BSDF without and with Opaque

When surfaces are fully transparent, sometimes the shadows created by such surfaces are weak to non-existent. If you'd 
like to have solid shadows, use the Opaque switch to create a shadow as if from an opaque surface. Opaque also 
bypasses raytracing, meaning that shadows are created more rapidly than they would be tracing through transparent 
materials.
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Color Picker

LightWave’s default color picker was renewed for 2015 and given powerful new features.

This main area will change depending on which of the buttons below it (Red, Green, Blue, Hue, Sat., Value, 
Kelvin, Wave) is selected. Here we have Hue.
This area will also change dependent on which button below is chosen. Here we can see the Hue wheel of colors, 
but if Sat is chosen below there will be an increase in saturation of the color chosen from bottom to top.
This color wheel is either based on the RGB or RYB method chosen with the small swatch in the upper left corner. 
The two systems are based on light for RGB and the primary colors of pigment for RYB. The RYB color wheel 
contains a second wheel inside and holding down Shift will constrain movement around the wheel to 15 ° 
jumps.
This dropdown shows different kinds of complements on the color wheel. By default it is set to Complementary , 
which shows the color and its opposite, but it can also show Analogous, Triadic, Tetradic and Tints and Shades 
as shown in the image above. There is a Custom setting too that allows the user to pick and choose colors.
Usually a single byte is used to represent the values of a color and is therefore limited to a range of 0-255 for red, 
green and blue. However the LightWave Color Picker internally uses floating point numbers to store and handle 
colors (where 1.0 in a Floating Point numeration would be the same as 255). This allows you to use bright colors, 
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those with values above 255 (1.0), by either entering a high number into the Red, Green or Blue numerical inputs 
or by using the X multiplier 1 . The multiplier can also be used to reduce a color by entering a number less than 
one. Thus 0.5 would return a color half as bright as the current color. Note: the HSV model doesn't inherently 
support HDR values. The Hue is 0-360 degrees, the Saturation and Value are 0.0-1.0. That's why those controls 
clamp to within those ranges.
This section of the Color Picker compares the color chosen with the color that was previously attributed. The 
user can revert to the previous color by clicking the large swatch under the current color (the white in our 
example). You can also set the color as part of the permanent swatches in the lower center of the Color Picker by 
clicking on the Set button. If you wish to set a different swatch as the current color, Ctrl clicking on the swatch 
will set it. Shift clicking on a swatch will switch to that swatch without choosing its color.

The M and P buttons represent a Color Mixer or the Palette swatches. By default the Color Picker is set to the 
Palette swatches. If you click the M button you will see four color sliders by default, showing an approximation of 
your chosen color in CMYK or Subtractive values. You can Ctrl click on a mixer bar to set it to the currently-
chosen color.
These two buttons will replace the area shown in 1 with a magnified zone of the screen or a separate window 
with the image chosen. If you are picking from screen, s will swap between different sample sizes and holding 
down Shift will slow mouse movement to 1/20 to make precise picking more easy. If you are picking from an 
image, the image will be shrunk to fit the window, but you have alternate sizes available in the top right corner. 
You can change the Sample Size and the number of clicks a Sampling will be made of above the image.
Clicking the Open Library button with expand the Color Picker sideways and offer a history of colors chosen and 
a set of collections that can be added to or exported in the lcl format. When the Library is open an additional 
button becomes available, Live Matching . This looks at what you are choosing in the Color Picker and shows the 
library with the closest matches. If you know roughly the color you are after this is a good way of matching the 
exact color from a library swatch.
The Settings button offers a choice of Integer or Float for RGB Display Mode (0-255 or 0.0-1.0) and can set the 
Kelvin range, the Wavelength direction and clipping of high colors. You also have settings for the color library 
including how much History to keep, how color names are formatted and how close a color needs to be to be 
matched in the library.

Colors can be copied and pasted by clicking Ctrl RMB on the swatch, then Alt-clicking RMB on the target 
swatch. (On the Mac, use Option for Alt)

Ctrl right-clicking on the blue swatch, then Alt right-clicking on the green replaces it with blue.



Converting from RGB to Kelvin requires expensive processing, too much to do for every color change. Instead, 
RGB->Kelvin processing is done when loading the panel or when switching to Kelvin mode. This RGB->Kelvin 
process can also be inaccurate, for example there’s no green in the Kelvin scale.


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The X Factor

The Clip High Colors to X setting only plays a part during the opening of the color picker. When enabled, and an 
HDR color is passed to the picker, the highest RGB component is used to normalize the color back into the 
0.0-1.0 range. Then the X field is set to the value needed so that when the picker is closed the color is 
multiplied back to its former HDR intensity. Thus:

Incoming color: 100.0, 1.0, 1.0 (super bright red, but which just shows as white in the UI)
In the picker you'd get, RGB: 1.0, 0.01, 0.01 X: 100.0
Because the color has been normalized you'll see red (with a tiny bit of green and blue).
Changing the color to: 1.0, 0.5, 0.01 will show orange in the picker UI.
Confirming the color will apply the value in X and you end up with: 100.0, 50.0, 1.0
The color again just shows as white but is actually a super-bright orange.

You may want to try the X multiplier if you simply need to brighten a color above the 1.0 threshold, just keep in 
mind that the X multiplication doesn't take place until the color is confirmed and returned to the system.


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Surface Preview

(Default keyboard shortcut: Ctrl-F10)

Click here to expand Table of Contents...
Surface Preview Choices

Floating Window
Viewport
Options

Viewport options
Buffer Menu
Presets Menu



UV-mapped surfaces represented by preset objects will show as untextured, because the UV maps do not have 
the correct coordinates to attach to. If you are using UV-mapped surfaces, choose Scene Object from the 
Preview Object Mode list in Surface Preview options.


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This dropdown menu offers three choices.

Surface Preview Choices

Floating Window

Opens an additional viewport that can be resized. The Object viewed can be chosen from the Surface Preview Options 
panel as can the background and lighting.

Viewport

Uses the viewport that has the Camera icon on it in a multi-viewport Layout.

Options

You can also use the VPR Options button in the viewport menu here:
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The object list shows scene objects that can be selected for the Scene Object display mode.
Preview Light Mode - Presents three options:

Preset Light - A default light
Scene Lights - The lighting set up in the scene
Selected Light - Uses the Layout selected light

Preview Object Mode - Presents three options:
Preset Object - Sets the Surface Preview object to one of the five presets in the Preset Object dropdown
Scene Object - Uses an object selected from the object list above
Selected Object - Uses a Layout selected object. Primitive Shapes don't work

Preset Object - Only available when the Preview Object Mode is set to Preset Object. Presents five options:
Cone
Cube
Cylinder
Sphere
Torus

Background - Presents three options:
Layout - Uses the Layout Backdrop settings. If there are multiple Environment plugins, the last one is 
used
Checkerboard - Presents a checkerboard pattern hanging in space behind the object. You might need to 
rotate the display to bring it into view

This preset objects list is generated with real objects that are stored in the install directory's support/
surface_preview_objects folder. New objects can be added to the list or replace existing entries. 
You should change entries only when LightWave is not running.


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Color - Uses the color defined in Background Color

Background Color - Only available when Background is set to Color

Viewport options

The viewport itself, when in Surface Preview mode, has several menu items unique to it.

At the default size, some menus are only represented with triangles

Now wider, we can see the buffer and preset menus fully

Buffer Menu

By default on Final_Render, all available buffers can be examined individually. If there is nothing in a buffer, it will be 
black.
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Presets Menu

Offers the following options:

Load (surface or preset) - Loads a new surface or preset from disk
Save to Disk - Writes the surface you are currently viewing to disk as an .srf file
Save Preset - Saves to the user's Workspace Preset space
Open Preset Shelf - Opens the Preset Shelf window. The Keyboard shortcut F8 does the same
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Texture Editor

Introduction
Texture Layers
Copy and Paste
Layer Order

Blending Layers
PShop Filters

Image Properties
MipMap

Tiling
Reset
Repeat
Mirror

Texture Placement
Surface Size, Position, and Rotation
Falloff

Using a Reference Object
Freezing Reference Object/Camera

World Coordinates

Introduction

While you can vary a parameter over time with an envelope, the parameter is not dynamic over the surface: the value 
for a particular frame is the value for the entire surface. Textures, on the other hand, essentially let you vary the value 
dynamically over the surface (as well as in time). A Color texture is probably the easiest illustration. Instead of using the 
same color on a surface, you can map a picture (a color texture image map) onto the surface that lets the color differ 
over the surface area.
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You can use Image Maps for more than just color. On other surface parameters, the color element is ignored and only 
the brightness of each pixel varies the value over the surface. For example, you can use an Image Map with Specularity 
to suggest scratches on a surface. Textures let you divide a surface into thousands of smaller areas and apply a different 
level of the surface attribute to each individual area.

In addition to Image Map textures, you can also use Procedural Textures and Gradients. Procedurals are mathematically 
computed images. Gradients act as a type of envelope, except that the value can change over a condition other than 
time. Select these options by using the Layer Type pop-up menu.

Texture Layers

LightWave can layer surfaces infinitely; once you set the original texture, you can add another layer by using the Add 
Layer pop-up menu. You can choose to add any of the layer types - the type can be changed later if necessary.

The layer list window shows you all of the layers. The first column indicates whether the layer is active (checked) or not 
(blank). You can toggle the status by clicking in the column. The next column shows the layer name, which indicates the 
type of layer. Next is the opacity percentage, followed by the Blending Mode (e.g., + for Additive).
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You can choose which layer to work on by simply clicking on it in the window. To remove a layer, select it and then click 
Remove Layer.

Copy and Paste

You can copy the currently selected layer or all of the layers in the Surface list to a memory buffer by using the Copy 
pop-up menu. For the Paste operations, Replace Current Layer will replace the selected layer with the buffer contents, 
even if the buffer contains more than one layer. Replace all Layers will clear all existing layers and then add the buffer 
contents. Add to Layers simply appends the buffer contents to the end of the list.

Layer Order

Texture layers are always listed in order from top to bottom. New layers are added on top of existing layers. Keep this in 
mind when you set up multiple layers. For example, if you want an Image Map with fractal noise across the entire 
surface including the image, you must map the image first and add the fractal noise afterwards. Of course, you can 
reorder layers by dragging them with your mouse.

Blending Layers

To set the opacity of a texture, use the Layer Opacity field. Reducing the value from 100% makes the overall texture 
more and more transparent. Setting it above 100% can force a texture layer to unnatural values.

The Blending Mode determines how the layer is blended with other layers. With Normal, underlying layers will be totally 
covered (i.e., replaced) by the texture, assuming Layer Opacity is 100%. The texture acts like an alpha matte; thinner 
areas of the texture allow the underlying layers to show through. If Layer Opacity is 50%, you get 50% of the layer and 
50% of the underlying layers. Additive, adds the texture (times the Layer Opacity) to underlying layers.

To achieve an even blend between multiple texture layers, use Normal. Then divide the number of the layers into 100% 
and use the resulting value as your Texture Opacity value. For example, the first (bottom-most) layer would be set to 
100% (100/1), the second layer will be set to 50% (100/2), the third layer will be set to 33% (100/3) and the fourth layer 
will be set to 25% (100/4). Subtractive subtracts the layer from the underlying layers. Difference is similar to Subtractive 
but takes the absolute value of the difference. Multiply factors the layer by the underlying layers. Multiplying by darker 
colors will darken the image, while brighter colors will brighten. Divide multiplies the underlying layers by inverse of the 
layer. This generally has the opposite effect of Multiply.

The buffer contents will remain until you quit LightWave.

The base Surface settings - those set on the Surface Editor’s Basic Tab - always sit beneath all layers.
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The Alpha Blending Mode makes the layer an alpha channel on the preceding layer. In other words, it cuts out parts of 
the preceding layer and makes those areas transparent. White in the alpha image creates opaque areas and black 
creates transparent areas. Shades in between will do a little of both. If the image, procedural, or gradient has color, the 
alpha image is based on the brightness of the areas.

Each layer’s Blending Mode is indicated in the right-most column of the layer list.

Texture Displacement displaces (distorts) layers above it, similar in effect to a Bump Map.

PShop Filters

Photoshop-style filters have been added to the Blending Mode menu in the Texture Editor. They are designed to work 
like the blending modes found in Photoshop. While the names may be similar in some instances, such as LightWave’s 
native Multiply and the Pshop Multiply mode, the Photoshop modes are mathematically different from the native 
LightWave blending options, and therefore produce different results.

PShop Multiply - Blends the base color with the blend color, making the image darker by multiplying the color 
values together. A black color will make the final blend black. A pure white color will change nothing. Working 
with colors other than black or white will produce a darker color.
PShop Screen - The opposite of PShop Multiply, the color values are inverted, multiplied together, then inverted 
again. A black value will change nothing, while a white color will produce a white result.
PShop Overlay - A combination of PShop Multiply and PShop Screen, the formula is dependent on the base 
color. A lighter base color will produce a lighter result, while a darker base will result in a darker color.
PShop Softlight - Similar to PShop Overlay, except the blend color is the determining factor. A lighter blend color 
will produce a lighter result and a darker blend color will produce a darker color. Colors are mixed, so a pure 
white or pure black blend color does not produce a result of pure white or pure black.
PShop Hardlight - The opposite of PShop Overlay (not PShop Softlight!) and is dependent on the blend color. 
Multiplies the blend and base colors, with a lighter blend color resulting in a lighter result and dark blends 
producing darker results.
PShop Colordodge - The base color is brightened to reflect the blend color by reducing the contrast. A blend 
color of black changes nothing.
PShop Darken - The base and blend colors are compared and the darker color is the one used.
PShop Lighten - The base and blend colors are compared and the lighter color is selected.
PShop Exclusion - Subtracts the blend color from the base color, or base from blend, whichever has the brighter 
color value. A pure white blend value will invert the base color value.
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Image Properties

After you select one of the Projection settings, use the Image pop-up menu to select or load an image/sequence. 
Clicking the Edit Image button launches the Image Editor Panel. Here you can adjust certain aspects of the image(s).

The available Image settings on the Texture Editor Panel vary depending on the Projection setting. Two settings always 
appear, however. Pixel Blending smooths out the pixelation that can occur when a camera gets close to the mapped 
surface.

MipMap

Mip-mapping is used in LightWave and today’s games to avoid texture graininess at a distance or at a low angle. 
Basically, lower-res versions of the texture are generated in real time to save time processing the original image to map 
onto a polygon. Please note that due to the nature of this filtering method, low-res textures may appear somewhat 
blurry. Mip-mapping is very useful in animation projects because it ensures that the same image is used no matter 
where the image-bearing object is in the scene, however, the total memory cost for mip-mapping tends to average out 
at 1.5 times the image size in memory. On still renders, you can turn off mip-mapping to save memory.
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The antialiasing Strength value determines the amount of antialiasing. The default setting of 1 should be used in most 
cases; however, the level may need to be raised or lowered slightly to better match the particular image. This value can 
be set to higher levels to add blurring effects to the image.

Tiling

Planar, Cubic, and Cylindrical Image Map projection have Tiling (i.e., repeating) options, which you can set 
independently for the horizontal and vertical repeating directions.
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Image used for the following examples

Reset

Reset is the no-repeat mode. The underlying surface will be visible if the image is smaller than the surface area.

Repeat

Repeat tiles the image until it fills the surface.
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Mirror

Mirror tiles the image, but flips the image horizontally or vertically.

Edge Edge extends the edges of the image to cover the surface. This setting works best when the outer edges are a solid 
color.

Cylindrical and Spherical have Wrapping options that set how many times the image appears horizontally, Width Wrap 
Amount, and vertically, Height Wrap Amount (not applicable to Cylindrical). This sets how many times you want the 
image wrapped for the given Scale values. Generally, you’ll want this set at 1.

Texture Placement

Once you set the image properties, you must now scale and position the image. Textures are initially positioned 
referenced to the X, Y, or Z Texture Axis. For Planar projection, think of the axis as a nail used to hold a photograph to a 
wall. For Cylindrical, think of the axis as the cardboard center of a roll of paper towels. Spherical is very similar. 
However, you cannot select an axis for a Cubic map.

The repeating options are relevant only if the Scale, Position, and Rotation settings (at the bottom) are set in 
such a way that the image will not fill the surface area.



Wrap amounts can be negative, which will reverse the image as it is wrapped around in the opposite direction.
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For example, a soda can would use a Y Texture Axis because it sits vertically. The fuselage of an airplane, on the other 
hand, would probably use the Z Texture Axis.

If the Texture Axis is perpendicular to a surface (such as the sides of a box using the same surface name as the projected 
side, the image will run through the surface.

Surface Size, Position, and Rotation

Scale defines the size of the surface to which the texture is applied. Position defines the coordinates of the center of the 
texture on the surface. Rotation defines how much the texture rotates around the center Position.

Generally, you want to match these settings with the actual surface. Automatic Sizing causes LightWave to calculate the 
Scale and Position of a selected surface and input those values. It computes an imaginary bounding box around all 
areas using the current surface. This will fit an Image Map perfectly onto the surface.

If the Scale is smaller than the surface size, an Image Map will tile across the surface (assuming that one of the Repeat 
options is active). You might also see the tiling effect if the Position is not set to the actual surface center.

You should generally model objects so that they face the positive Z axis.

Different combinations of Texture Axis and Rotation can achieve the same results.

Use Automatic Sizing for starting values when using procedural textures.
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Because LightWave’s textures are three-dimensional, there is no rule stating that the center of a texture must be located 
somewhere within the bounds of the surface. You can place the texture center outside of the surface and still get a 
texture to appear across the surface. Textures extend in all directions throughout the virtual space in Layout, but 
appear only on the surfaces that are set to display them.

There are definitely times where you don’t want the texture sized exactly to match the surface. Such is the case with 
Procedural Textures, which usually look better when the Scale is smaller than the Surface Size because it adds more 
detail. Another example is when you use only part of an image that is texture mapped.

Falloff

The Falloff values specify the apparent falloff for every unit of distance moving away from the texture center, defined by 
the Position settings. (The unit of distance is defined by the Default Unit setting on the General Options Tab of the 
Preferences Panel.) When you animate the Position with an envelope, the position at frame 0 is used as the center for 
falloff purposes.

The Type pop-up menu determines the shape of the Falloff. (In previous versions, the Falloff was always cubic.) Linear 
Falloff types (i.e., LinearX, LinearY, and LinearZ) operate only in one direction. If you use 100% LinearX, for example, the 
texture will fall off only in the positive X direction from the texture center. To fall off towards negative X, use -100%.

With Cubic, the Falloff occurs on both the positive and negative sides. You can achieve a linear-type falloff in both 
directions by using Cubic and setting the two axes you do not wish to fall off to 0%.

Using a Reference Object

Although you can explicitly set the Position, Size, and Rotation of a texture, you can also assign a Reference Object - 
normally a Null object - and get similar results. The Reference Object makes all of these settings operate relative to 
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itself. You can better control the texture animation by animating the Reference Object. Moreover, you can use different 
Reference Objects for different Surface Textures (e.g., surface color, diffusion, specular, and so on).

Freezing Reference Object/Camera

If you set a Reference Object (or Reference Camera used with Front Projection Mapping) and then select (none) from the 
related pop-up menu, a dialog appears that asks, “Do you want to keep item’s parameters?”.

If you click Yes, you will store the reference item’s state at the current frame in the object. (Don’t forget to save it.)

World Coordinates

Normally, textures are locked to a surface and travel with it, as the object is moved, stretched, rotated, or deformed. 
Selecting World Coordinates will lock the texture to LightWave’s Origin instead of those of the surface. Moving the 
object now will result in the object traveling through the texture. All Texture settings continue to be valid, but now are 
relevant to the World Coordinates.

World Coordinates can create the look of light beams moving through a fog. You create this effect by using transparent 
light beams with a fractal noise texture for Color and/or Luminosity activated. As the light beam is moved about, it will 
move through the fog created by the fractal noise. Using World Coordinates on a Transparency Map with Falloff can 
make a spaceship cloak (turn invisible).

Layer Type: Image Mapping
Layer Type: Procedural Texture
Layer Type: Gradient

An object’s pivot point does not affect surfacing.
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Layer Type: Image Mapping

Image Map Projection
Planar Projection
Cylindrical Projection
Spherical Projection
Cubic Projection
Front Projection
Fixed Projection
UV Texture Maps
UVs and Projection

UV Aspect

Except for the Color surface attribute, when you use image maps the brighter the data, the higher the setting, and the 
darker the data, the lower the setting. A totally white image is the same as a 100 attribute value and a totally black 
picture is the same as a 0 attribute value. As such, if you use a standard RGB picture, you cannot get values higher than 
100 or less than 0, but it will usually contain a wide array of brightness values. However, if you use a high dynamic range 
image, you can exceed this limit.

Image Map Projection

Since images are usually rectangular and surfaces may or may not be, you must tell LightWave how you want the image 
map projected onto the surface. The common projection types settings are Planar, Cylindrical, Spherical, Cubic, Front 
and UV.

Generally, you should pick the shape that best describes the surface shape. (Note that this is not necessarily the object’s 
overall shape since that may be made up of many surfaces.) For example, if you were mapping a label image on the 
sides of a soda can, you’d use Cylindrical. For a planet, you’d use Spherical. For a wall, Planar would do the trick. For a 
brick, Cubic might be best.

What about a die? Cubic? This may be a trick question. Since a die has a different number of dots on each side, you’d 
use a different Planar map on each one.

Standard Image Mapping tools (i.e., planar, cylindrical, and spherical mapping) may be somewhat limiting when the 
surface is irregular in shape. These techniques usually work well only in cases where the entire texture image can be 
globally mapped using a linear interpolation along two axes. The object geometry essentially has no influence on how 
the texture is applied.

However, what if you could assign areas of a texture image to points on the surface, essentially tacking it down at key 
points? This is what UV Mapping in Modeler allows you to do. Between the tacks, the image is stretched smoothly.

Planar Projection
Planar projection will project an image onto a surface as if you were projecting the image through a slide projector onto 
a wall. Planar Image Maps are best used on flat, or nearly flat surfaces like the sides of buildings and the screens of 
video monitors.

To see image maps in the Layout view, make sure the viewport is set to Textured Shaded Solid. You can 
change this on a viewport’s titlebar.


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For the X and Y axes, Planar images are projected from the positive axis side of a surface towards the negative axis side. 
This means that the image appears correct when viewed from the positive side and it appears reversed if you view it 
from the negative side. For the Z axis, Planar images are projected from the negative side.

Cylindrical Projection
Cylindrical projection wraps an image around the selected axis like a paper towel wrapped about a cardboard tube. By 
default, an image is wrapped so it covers the surface once, allowing the side edges of the image to meet on the back of 
the surface. A soda can and a tree trunk are both good examples of surfaces that would use Cylindrical projection.

If you encounter this reversing effect and it isn’t what you want, you can reverse an image back by making the 
Scale value negative for the axis that needs to be reversed.


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Cylindrical projection is always wrapped around a surface so that the top of the image appears towards the positive axis 
side of the Texture Axis.

Spherical Projection
Spherical projection wraps an image around a surface as if you were stretching a flat piece of rubber around a ball, but 
without having to worry about the edges all meeting. Planets, basketballs, and marbles could all use Spherical 
projection.
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Spherical projection does not use Scale parameters. Images are wrapped completely around the surface (using the 
Wrap values, discussed later). Spherical projection is always oriented so that the top of the image appears toward the 
positive side of the Texture Axis.

Cubic Projection
Cubic projection is essentially the same as Planar, except that you cannot select a Texture Axis. Cubic projects the 
image from all three axes at the same time. The image is projected like Planar, except simultaneously along all three 
axes. Use Cubic when you wish to apply the same image to all sides of a rectangular shape, such as an image of tiling 
bricks wrapped around the sides of a building, or wallpaper on the walls of a room.
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Front Projection
The concept of Front projection is very simple and quite similar to a chroma-key effect. However, instead of applying an 
image where a color screen is, it replaces the selected surface(s) with a selected image.

In most cases, the image you select for a Front Projection Map is the same image you use for the Background Image on 
Layout’s Compositing Tab of the Effects Panel (Windows > Compositing Options).

Note that Cubic Projection projects along the X, Y and Z axes and objects merely intersect these projections. 
This means that images like text will only be correct on three sides, the others will be reversed as shown here 
with the images that have the arrow coming out of them rather than going in. Creating an item like a dice 
needs six planar projections to be correct.


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Scale, Position, and so on, are not relevant with Front projection. It is always the size (and frame/pixel aspect) it would 
be if loaded as a Background Image. As such, changing the Resolution or Pixel Aspect Ratio on the Camera Properties 
Panel will also affect the Front projection.Front projection is used primarily for comp (compositing) work where you 
combine LightWave objects with a live-action background image or sequence. A common example occurs when you 
want a LightWave object to cast a shadow (believably) onto the image or behind a portion of the background image.

The image used in the surface and the background will pin-register the surface to the background, letting you go in 
front or behind. Your object then appears to interact with the environment. You can cast shadows or cause reflections 
from a regular 3D object onto the surface that is front projection mapped.
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Front-Projection mapped Ground surface catches the character’s shadow.

The ground object is just a flat box with Front Projection Image Mapping that uses the same image as the background. 
Its job is merely to catch the object’s shadow.

Another example is to use an image of trees as your background image and fly a UFO between them so the UFO appears 
to go in front of some trees and behind others. All you need to do is model some rough shapes that match the trees you 
wish to fly behind (they could even be flat planes).

Another good example for Front projection is to create a flat plane and align it to an image of an ocean or a lake. Front 
projecting the water surface onto it lets you place an object beneath the water and push it through the surface. 
Submarines and sea creatures will appear to break the surface this way.

The hardest part of Front projection is aligning the objects, matching lighting, and getting the right camera angle. Using 
Background Image as the Camera View Background on Layout’s Display Options Tab of the Preferences Panel (Edit > 
Display Options) will allow you to do all that. You also must search for the right balance of Luminosity and Diffuse for 
the Front projection surface so that the object’s true shape is not revealed by shading.

Fixed Projection
Front projection surfaces will always look the same no matter where you move the object or which way you rotate it. 
The image does not normally stick to the surface. However, if you activate the Fixed Projection option (previously Sticky 
Projection), it fixes (i.e., locks) the projection from the camera’s perspective at the specified Time.

The default unit of measure for Time depends on the Frame Slider Label setting on the General Options Tab of the 
Preferences Panel in Layout or the Time Format setting on the Display Options Panel, Units Tab in Modeler. You may 
specify the unit of measure by appending f for frames or s for seconds to the entered number (e.g., 22f for frame 22, 31s 
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for 31 seconds). You may also enter SMPTE time code, like 00:00:01:16 for one second, frame 16. The entry is converted 
to the default unit of measure.

Use Fixed Projection to create parallax with two-dimensional images by using a technique called Camera Mapping. (Use 
the Reference Camera setting to select the camera, if you have multiple cameras in your scene.)

Essentially, you set the frame where the texture will be pin-registered to the background (like normal Front Projection 
Mapping). On all other frames, the texture is stretched to compensate for more or less of the texture being visible, which 
is caused by factors like the camera being moved.For example, in a picture of some buildings, you could place the 
LightWave camera in the same place as the original camera in relation to some simple 3D buildings; then, you could 
project the picture onto the buildings and lock it at frame 0. You’ll need a doctored background image/object - with 
Fixed projection - to reveal what’s behind the buildings. If you move the camera forward, it will appear to fly into or 
around the buildings.

UV Texture Maps
The U and V refer to Texture Map coordinates and are really not very different from the XYZ coordinates you are familiar 
with. In fact, UV Mapping is the process of setting up a relationship between the two dimensions of an image, U and V, 
with the three dimensions of an object surface, XYZ.

Once this relationship is set up, changing any parameter (i.e., U, V, X, Y, or Z) will also relatively change the appearance 
of the Texture Mapping. With UV Mapping, the object provides additional information for Texture Mapping, which can 
be different for any given point on the surface. The texture is more or less stuck to points on the surface using a 

Use your paint program’s rubber stamp function to erase areas where background Fixed projection surfaces 
will be revealed.
Obviously, there are great limitations in getting three-dimensional data out of a two-dimensional picture. 
However, short slow-moving sequences can be quite realistic.


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relationship that you define.

UVs and Projection
UVs have to come from somewhere. For existing polygonal models, the choices are limited to setting the UV coordinates 
for each point in the object manually, or applying some projection, which automatically generates the 2D Texture 
coordinates from the given 3D point positions. In LightWave, you can create UVs by using projections, which also 
happen to be the same as the standard projections for Texture Mapping (i.e., Planar, Cylindrical, and Spherical).Usually, 
the projection for the UV Map is not suitable for the whole model. The projected UV Map must be tweaked - eyes and 
nostrils moved over the right parts of a face, or texture features matched to geometry features.

For illustration purposes, let’s say you had your texture image printed on a piece of very flexible rubber and wanted to 
fit it on a toy car made of wood. You could conform the rubber material to contours of the car by tacking it down with 
thumbtacks. That is more or less what UV Mapping does. However, it is slightly reversed: what you do is tack the UV 
points down onto the image.

Keep in mind that standard Projection Mapping is more accurate because it has some exact, continuous value 
over the entire surface. UV Mapping, on the other hand, is technically accurate only at small sample points. 
The surface for the large areas in between the sample points is interpolated. Adjusting the sample points so 
that the interpolated areas look right is difficult and the reason why UVs are more difficult to use.


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UV Aspect

UV Aspect was added in 2015 and is only available through the layers texture editor window. Designed for occasion 
where you have created a UV map for a specific shape of image and need to use an image with a different aspect ratio.

Example - UV Aspect
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Layer Type: Procedural Texture

To add a procedural texture layer
Texture Color and Texture Value
Texture Scale

Procedural Texture Settings
Brick
Bump Array
Checkerboard
Crumple
Crust
Dots
FBM
Fractal Noise
Grid
HoneyComb
Marble
Ripples
Looping Wave Ripples
Smoky 1, 2, and 3
Node Editor
Turbulence
Underwater
Value
Veins
Wood
Additional Procedural Textures
Coriolis
Cyclone
Dented
FBM Noise
Hetero Terrain
Hybrid Multi-fractal
Multi-fractal
Puffy Clouds
Ridged Multi-fractal
Turbulent Noise

An alternative to using an image as a Texture is to use built-in mathematical computations called Procedural Textures. 
These serve the same purpose as Image Maps; however, since they are mathematically computed, they are applied 
seamlessly on a surface. Thus, you do not need to worry about a projection method.
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All surfaces in the images above were created with procedurals.
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To add a procedural texture layer

Click on the Add Layer button and select Procedural from the pop-up menu. You can also change an existing layer’s type 
by changing its Layer Type to Procedural Texture.

Texture Color and Texture Value
Unless you are adding a texture to surface Color, you must specify a Texture Value, which is the value for the texture 
pattern at its most intense points. This can even be a negative value.If you are adding a texture to surface Color, you do 
not define a value but a Texture Color. The color chosen here will be the color of the texture at its most intense points.

Unless the texture pattern fills all of the surface area, there will be transparent and semi-transparent areas, revealing 
underlying layers. In areas where the texture is below 100%, the texture will blend with underlying layers.

You can change the background color used in the thumbnail window by right-clicking on it - a Color Selection dialog will 
appear. You can also drag the texture around with your LMB.

Texture Scale

All Procedural Textures are available for use on each surface attribute.
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Generally, you want your scale to be a fraction of the surface size to properly see the texture on the surface. Unless you 
know the exact dimension of your surface, it may be handy to click Automatic Sizing first and then modify the resulting 
Scale values.

Procedural Texture Settings

The following is a list of the Procedural Textures. Remember that although they are described in essentially surface 
color terms, they can also be used for Diffuse, Specularity, Transparency, and so on.

Brick

Brick produces an array of symmetrically spaced bricks. The Texture Color is the color of the mortar. Mortar Thickness 
determines the width of the mortar. At 1.0, no brick is visible. Fuzzy Edge Width makes the outer brick edges soft and 
faded. Since Procedural Textures are three-dimensional, you may need to tweak Size and Position values if a surface 
cuts through mortar and that is all you see on an edge.

Bump Array

Use LightWave’s maths feature and append, say, “/4” to the automatic-sizing values. This divides the value by 
four. For example, adding “/4” to a value of “24 m” would look like “24 m/4” (don’t enter quotes). When you 
move to the next field, the result is calculated automatically!


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Bump Array produces an array of symmetrically spaced circular dots that appear to have depth. You can use this texture 
to create a golf ball surface.Radius sets the radius of each bump used in the bump array pattern. Spacing sets the 
spacing between each bump.

Checkerboard

Checkerboard generates a tiled appearance on an object’s surface, like that of a checkerboard or chessboard. Your XYZ 
Scale values set the size of each square in the pattern. For example, to see ten checkerboard squares on the surface of 
an object, divide its length by ten. A 50-meter cube would yield a Scale of 5 (for X, Y, and Z) to achieve ten squares.

Crumple
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Crumple is a very detailed texture that gives the appearance of a surface that was crumpled under pressure. You can 
use it to simulate crumpled paper, hammered metal, ice cubes, stucco, and even cauliflower.

Frequencies refers to the number of different scales of detail added to the pattern. A value of 1 makes a surface appear 
partially crumpled so that it has only a few large dents. A value of 5 makes a surface appear very crumpled so that it has 
many smaller dents.

Small Power affects the appearance of the large and small features added to a surface. The Default values create the 
appearance of a surface with large and small dents. A higher Small Power (1.0 or above) causes the smaller dents to be 
shaded with the same degree of intensity as the larger dents so that the surface becomes busier and the larger dents 
lose some of their distinction. A lower Small Power (under .50) makes for less distinction between the large and small 
features.

Crust
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Crust is one of the more complex textures. It produces raised circular splotches on a surface. This is good for barnacles, 
warts, or moon craters.

Coverage determines how much of the crusty pattern covers the surface. A low value (0.0 to 0.5) makes many small 
islands of crust across the surface, whereas if you use a high value (0.6 or higher), the crust pattern begins to cover the 
surface color underneath.

The patterns that display Ledge Level are shaded so that the surface appears to have raised edges. Ledge Level shifts 
the position of the ledge that defines the edges of the pattern further outward from the pattern itself, into the surface 
color. The values that make visible changes in these patterns are subtle, so change them in small increments until you 
understand their effects well (on the order of 0.1 at a time).

Ledge Width alters the apparent depth of the valleys formed by the ridges in the pattern. The values that make visible 
changes in these patterns are subtle, so change them in small increments until you understand their effects well (on the 
order of 0.1 at a time). Ledge Width will affect the sharpness of the slope falling off of the discoloration pattern. The 
Default values create a ridge just along the outside of the pattern discoloration. Higher values move the ridge further 
outward from the pattern, lower values move it inward. The most useful values will fall between 0.3 and 1.0.

Dots
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Dots produces an array of evenly spaced dots. The dots can optionally have a soft edge. Dot Diameter determines the 
size of the dots in the dot pattern. At 1.0, the edges of dots will touch. Fuzzy Edge Width makes the outer dot edges soft 
and faded.

FBM

FBM is another fractal pattern that uses the same settings as Fractal Noise.

Fractional Brownian Motion (FBM) is named after botanist Robert Brown, who observed the random 
movement of pollen grains. Einstein later explained that the movement was due to surrounding molecules 
moving in random directions.


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Fractal Noise

Fractal Noise produces a random fractal pattern. It is undoubtedly the most commonly used texture, since it can quickly 
mask somewhat the look of 3D imagery. Use this as a Bump Map for terrains and brushed metal (use an exaggerated 
value along the grain direction). As a Transparency Map, Fractal Noise can generate realistic-looking clouds. As a 
surface Color (or diffuse) Map, it can give a weathered look to surfaces, such as grass or dirt ground. You’ll find 
numerous possibilities for this texture. (Also see the Turbulence texture.)

Frequencies affects the level of detail produced in the noise pattern. Increasing this level will increase the variation in 
the pattern. Values above 6 are not useful (the level of detail is so small that it may not be noticeable, and it will 
increase rendering time unnecessarily). Contrast adjusts the blending of the texture. The higher the level (above 1.0), 
the greater the contrast, and the more pronounced the pattern. Values lower than 1.0 (between 0 and 1.0) produce a 
less stark, more softly blended pattern. Small Power refers to the amount of intensity applied to both large and small 
details. It changes the intensity of the smaller details. A higher Small Power (1.0 or above) causes the smaller dents to 
be shaded with the same degree of intensity as the larger dents so that the surface becomes busier and the larger dents 
lose some of their distinction. A lower Small Power (under .50) makes for less distinction between the large and small 
features.Use very small XYZ Scale values in a Bump Map to add random pits to surfaces.

Grid
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Grid generates a grid across an object’s surface. The grid is a three-dimensional grid. Therefore, lines project into all 
three dimensions. Often, you want a 2D grid superimposed on an object’s surface, like graph paper. In such cases where 
you use the Grid texture and see unwanted portions of the grid, try expanding the size of the Grid texture along that axis 
(this expands it off the surface of the object). For example, if you map a grid onto a one-meter ball, the Texture scale of 
the Z axis can cause the appearance of ripples that break up the nice graph paper look of the X and Y Texture scale. 
Using a Texture scale of 0.25m, 0.25m, 1m will get the proper look.

The Line Thickness value determines the thickness of the lines in the grid pattern.

HoneyComb

HoneyComb produces a hive of activity in the form of a honeycomb. The Texture Color is the color of the lines. Line 
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Thickness determines the width of the lines. Fuzzy Edge Width makes the outer dot edges soft and faded. Unlike Grid, 
Honeycomb is a two-dimensional texture where axis is important.

Marble

Marble produces fractal-like patterns that imitate marble veins. The pattern is calculated in veins that wrap around a 
selected axis, just like rings wrap around the center of a tree.

Frequencies sets the level of detail produced in the pattern. The higher the value, the better-looking the pattern 
becomes, but the longer it takes to render as well. (A value above 6 is not useful here, because the variance is 
microscopic in size and virtually invisible.) The Turbulence value should be a fraction (often one-half) of the Vein 
Spacing value. It determines how close a vein may come to a neighbouring vein. Vein Spacing sets the distance between 
veins in the marble pattern. Vein Sharpness sets the level of blending/contrast of the pattern. The lower the value, the 
more blending will occur. Higher values will produce very sharp, distinct veins.

Ripples

First select a Vein Spacing and Texture Axis that you like, then set Frequencies, Turbulence, and Scale.
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Ripples and Ripples2 produce the appearance of fluid waves or ripples to a surface. Use small ripples to simulate water, 
or large ripples to put a wave in a flag.

Wave Sources determines the number of ripple sources. The higher the value, the greater the number of areas rippling 
with waves. A value of 1 will create a single ripple pattern, like that of a solitary water droplet falling into a pond. Values 
higher than 16 are not recommended; they require longer rendering time and may not add to the appearance of the 
texture.

Wavelength controls the distance between the ripples. The lower the value, the closer the waves will appear to each 
other. Wave Speed sets the speed of the ripples.

Looping Wave Ripples
In order to loop the movement of ripples throughout the course of the animation, use this formula to determine the 
proper Wave Speed: Wavelength divided by the number of frames over which the pattern should loop equals the Wave 
Speed (i.e., Wavelength/number of frames to loop = Wave Speed).

Smoky 1, 2, and 3
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Smoky 1, Smoky 2, Smoky 3
The Smoky textures use the same settings as Fractal Noise with the addition of a Turbulence control, which lets you 
adjust the pattern disturbance.

Node Editor
LightWave makes accessing nodes through any Texture Editor (T button) simple by choosing Node Editor as the type of 
Procedural texture.
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Turbulence

Turbulence combines Fractal Noise layers, each at a different scale (or frequency). It produces an effect very similar to 
Fractal Noise, but will normally yield more eye-pleasing results. It also gives better control over the range of frequencies 
found in the noise, from smooth to detailed, grainy textures, due to the small scale noise that is added in. The settings 
are the same as those for Fractal Noise.

Gradient and slopes may be limited since there are no normals for procedural textures.
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Underwater

Underwater produces the rippling pattern effect of refracted light which you would see for instance on the bottom of a 
swimming pool. You can also use this texture to simulate nighttime sky effects such as the Aurora Borealis, changes in 
cloud patterns, or even electrical shocks.

Wave Sources determines the number of ripple sources. The higher the value, the greater the number of areas rippling 
with waves. A value of 1 would create one ripple. Values higher than 16 are not useful. Wavelength controls the distance 
between the ripples. The lower the value, the closer the waves will appear to each other. Wave Speed sets the speed of 
the ripples. Band Sharpness sets the level of blending/contrast of the pattern. The lower the value, the more blending 
will occur. Higher values will produce very sharp, distinct bands.

Looping Wave Ripples
In order to loop the movement of ripples throughout the course of the animation, use this formula to determine the 
proper Wave Speed: Wavelength divided by the number of frames over which the pattern should loop equals the Wave 
Speed (i.e., Wavelength/number of frames to loop = Wave Speed).

Value
The Value procedural lets you create a layer of uniform value or color. You can use this to composite layers with Alpha 
Channels.

Veins

You can generate actual real world effects by using Layout’s Caustics feature (Global Illumination > Enable 
Caustics), but rendering times will be significantly greater.


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Veins produces a series of raised areas separated by canals or veins. This is great for cracked mud, leaded glass, stone 
walls, leaves, and so on.

Coverage determines how much of the vein pattern covers the surface. A low value (0.0 to 0.4) applies the vein color 
only to veins themselves, whereas a high value (0.5 or higher) causes the vein color to fill in between the veins, 
overtaking the surface color underneath.

The patterns that display Ledge Level are shaded so that the surface appears to have raised edges. Ledge Level shifts 
the position of the ledge that defines the edges of the pattern further outward from the pattern itself, into the surface 
color. The values that make visible changes in these patterns are subtle, so change them in small increments until you 
understand their effects well (on the order of 0.1 at a time).Ledge Width alters the apparent depth of the valleys formed 
by the ridges in the pattern. The values that make visible changes in these patterns are subtle, so change them in small 
increments until you understand their effects well (on the order of 0.1 at a time). Ledge Width affects the depth of the 
veined ridges. Values just above the default setting have the most visible effect. The default values create a ridge just 
along the outside of the pattern. Higher values shift the ridge further outward from the pattern, lower values move it 
inward. Most useful values fall between 0.2 and 1.0.

Wood
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Wood is similar to Marble, but produces a pattern imitating the rings in a piece of wood. Frequencies sets the level of 
detail produced in the pattern. The higher the value, the better-looking the pattern becomes, but the longer it takes to 
render as well. (A value above 6 is not useful here, as the variance is microscopic in size and virtually invisible.) The 
Turbulence value should be a fraction (often one-half) of the Ring Spacing value. It determines how close a wood ring 
may come to a neighboring ring. Ring Spacing sets the distance between rings in the pattern. Ring Sharpness sets the 
level of blending/contrast of the pattern. The lower the value, the more blending will occur. Higher values will produce 
very sharp, distinct rings.

Additional Procedural Textures
A number of additional Procedural Textures are available; these textures are based on the noise and fractal routines 
presented in the textbook Texturing and Modeling: A Procedural Approach by David Ebert, F. Kenton Musgrave, Darwyn 
Peachey, Ken Perlin, and Steve Worley (Morgan KaufmannPublishers, 2nd Ed., July 1998, ISBN 0122287304).

Fractals are the most commonly used tool in computer graphics for adding visual complexity to 3D surfaces. Fractals 
create this complexity by repeating a common underlying noise pattern at various scale sizes, and accumulating those 
scaled patterns into a final surface texture.The following parameters are common to most of the following Procedural 
Textures:

Increment - controls the fractal dimension of the texture. When set to zero, the fractal function looks like white 
noise. As the value gets larger, the fractal will become smoother.
Lacunarity - is the amount of change in the frequency of noise that occurs between each successive iteration of 
the fractal calculation. As this parameter increases, the average size of the gaps between the scaled patterns will 
also increase.
Octaves - are the number of times the texture is scaled down to a smaller pattern, and added back again to the 
larger pattern. Larger values add more small details to the final texture, but also increase rendering times.
Offset - exists in all the multi-fractal procedurals (where the fractal dimension varies throughout the texture). 
When set to zero, the fractal dimension will change greatly throughout the texture. This causes the roughness of 

First start by selecting a Ring Spacing and Texture Axis that you like, then set Frequencies, Turbulence, and 
Scale.


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the texture to vary greatly across the surface of the texture. Larger values cause the roughness (or smoothness) 
to be more consistent across the entire surface of the texture.
Threshold - specifies a Threshold value that is used to determine whether the texture should be displayed or not. 
If the Procedural Texture value is higher than Threshold, that value modifies the surface. If the Procedural 
Texture value is lower than Threshold, that value does not alter the existing surface attribute at all.
Noise Type - uses Perlin Noise as the most common and fastest noise function available in these procedurals. 
The other options (Value, Gradient, Value-Gradient , Lattice Convolution and Sparse Convolution) are different 
implementations of noise written by Darwyn Peachey and described in chapter 2 of Texturing and Modeling: A 
Procedural Approach, referenced above. While these implementations may provide better quality noise, they are 
definitely slower than Perlin Noise.

Coriolis

Coriolis is a texture used to simulate the shearing effect of the atmospheric flow on earth caused by the earth spinning 
faster at the equator, and slower towards the north and south poles.

Coriolis Scale scales the value calculated by the Coriolis texture. Its effect is to vary the contrast between the clouds and 
the underlying surface. Smaller values create less contrast, and larger values display a high contrast between the clouds 
and the surface.

Coriolis Twist is the amount of twist or rotation of the clouds from the poles to the equator.

Coriolis Offset is added to the value calculated by the Coriolis texture. Larger values create denser clouds and smaller 
values result in fewer, thinner clouds.

Cyclone
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Cyclone is a Turbulence texture with a single vortex, used to simulate cyclones and hurricanes.

Cyclone Radius is the maximum radius of the cyclone. Outside of this radius, the clouds will not appear twisted.

Cyclone Twist is the amount of twist or rotation of the clouds within the Cyclone Radius.

Cyclone Offset is added to the value calculated by the Cyclone texture. Larger values create denser clouds and smaller 
values result in fewer, thinner clouds.

Dented
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Dented is a turbulent noise function that creates crumpled dent patterns. Scale adjusts the magnitude of the texture 
output.

Power is the fractal dimension of the Dent texture. A value of 1.0 looks like crumpled paper. 3.0 makes smaller, isolated 
dents on the surface.

Frequency is the frequency of the dents, affecting the detail of the pattern. 

FBM Noise

 

FBM Noise is a typical homogeneous fractal noise function since the fractal dimension does not vary.

Hetero Terrain
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Hetero Terrain is a multi-fractal texture that is smoother at lower elevations and progressively gets rougher as the 
altitude increases.

Hybrid Multi-fractal

 

Hybrid Multi-fractal is another multi-fractal texture that smooths the valleys of the texture at all altitudes, not just at 
lower elevations.

Multi-fractal
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A Multi-fractal is a function whose fractal dimension varies depending on the location of the point being shaded or 
displaced. This is similar to FBM, except that it uses multiplication in its inner loop computation rather than addition.

Puffy Clouds

 

Puffy Clouds is a thresholded FBM noise function that creates soft, puffy cloud patterns.

Ridged Multi-fractal
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Ridged Multi-fractal is a hybrid multi-fractal texture that uses a Threshold value to create ridges in the terrain.

Turbulent Noise

 

Turbulent Noise is a modified FBM texture that uses an absolute value function, adding a turbulent effect to the texture.
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Layer Type: Gradient

The Gradient Bar
To add a key:
To delete an existing key:
The Current Key
Changing Key Values
To prevent a key from being changed:
Changing Key Positions
Smoothing Between Keys
Scale and Shift

While Envelopes let you vary a setting based on time, a Gradient lets you vary a setting (Color, Luminosity, etc.) based 
on features like height of surface bumps, or distance to another object. So, for example, with an Envelope, you can 
make the Diffuse level 20% at frame 23. With a Gradient, you can make the Diffuse level 20% if a surface is 3.23 meters 
from the Cow object or the slope angle of the surface is 26.2 degrees.

The Input Parameter determines what feature the setting varies over. Think of Gradients as filters for the selected Input 
Parameter. For example, if the surface is bumpy, colors can be different based on the height of the surface being 
colored if the Bump option is used. You can even use the preceding texture layer.

Gradients use gradient ramps (the colored bar) to depict the value change. You define different values along the bar. 
LightWave automatically determines the in-between values. Essentially, the different colors along the gradient 
correspond to texture color/values for the related Input Parameter. The gradient is just a colorful (and clever) way to 
create a graph.The Input Parameter defines what item will dynamically control the parameter.
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Previous Layer - uses the brightness data from the immediately underlying layer.
Bump - uses the height of a surface using Layout’s Default Unit on the General Options Tab of the Preferences 
Panel.
Slope - changes the parameter based on the angle (in degrees) of the surface relative to the ground (flat on Y 
axis).
Incidence Angle - uses the angle (in degrees) of the surface relative to the Camera.
Light Incidence - is similar to Incidence Angle, but the angle is relative to the selected light. Use the Light pop-up 
menu that appears.
Local Density (HyperVoxels only) - uses the density of the HyperVoxel .
Distance to… - settings change the parameter independently based on the distance from the surface to the 
selected camera or object. The X, Y, and Z Distance settings measure the distance only along the respective axis. 
If you select the distance to an object, an Object Selection pop-up menu will appear.
Weight Map - uses the Weight Map selected on the Weight Map pop-up menu.
Surface Thickness - is a method of faking sub-surface scattering. IMPORTANT: The surface must be set to double-
sided and Trace Transparency needs to be activated.

The Gradient Bar

Once you have determined your Input Parameter, you need to set the value of the new texture color/value. The 
Gradient Bar allows you topographically set your Key values. (A Key is characterised by three numbers: its Value, 

Other Input Parameter options may be available depending on what feature the Gradient texture controls.
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Parameter, and Alpha.) As with Envelopes, you can create, edit, and delete keys. The Keys change the color of the 
Gradient and ultimately the Parameter values.

If the parameter is a color, the bar is in color and color transitions appear from one key to the next. If the parameter 
relates to numeric values, the bar appears in greyscale. The lowest set Key value is black and the highest is white.

The Start and End fields, at the top and bottom of the Gradient Bar, respectively, set the beginning and end of the 
visible area of the gradient. Whether or not these values are editable, depends on the Input Parameter you selected; 
however, their default values should work for most situations. Also, you can set keys outside this range.

To add a key:

Click on the Gradient Bar and hold down your LMB. A key marker that looks like an arrow will appear. If you 
continue to hold the mouse button down, you can drag to refine the position of your key. The Parameter field 
will change as you drag your mouse. Note that this value is not limited to whole numbers.

Release the mouse button to create the key.

To delete an existing key:

Click on the end of the arrow with the square.

To prevent accidentally adding a new key, you can drag the key using the arrowhead.



LightWave 2020  –  LightWave 2020

Reference –  2666

The Current Key

The Value/Color, Alpha, and Parameter fields show the corresponding settings for the current key. This is the key that is 
highlighted in the Gradient Bar. Click on a key’s arrowhead to select it as the current key. When the panel is active, you 
can also use your Up and Down Cursor keys to select the preceding or next key as the current key. (Make sure that you 
do not also have an input field active.)

The Parameter setting determines the current key’s numerical position on the bar. Note that this setting can have 
decimals. The Value/Color is the texture value or color for the current key.The Alpha setting is the amount of opacity. 
Higher values are more opaque: 100% is fully opaque and 0% is fully transparent. You can see a background 
checkerboard when you use Alpha settings below 100%.

Changing Key Values

You can change the current key’s Color or Value, as the case may be, by adjusting that setting. You see the Gradient Bar 
change as you adjust the setting.

To prevent a key from being changed:

Right-click on the arrowhead. It will invert, indicating the key is fixed and cannot be altered.

 

Right: Unlocked / Left: Locked

When you edit a surface Color, the value is a color selector. All other types of textures have a numeric input 
field for value.


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Changing Key Positions

You can move a key - but not past a neighboring key - by dragging the key’s arrowhead with your mouse.

You can also numerically move a key by entering a value (including a decimal if needed) into the Parameter field. Note 
that you still cannot move the key past a neighbouring key.

Smoothing Between Keys

By default, the values between a key and the preceding key (next one above it on bar) are transitions in a Spline fashion 
with an ease-in/ease-out transition to the preceding key. Setting the Smoothing pop-up menu to Linear will apply a 
straight-line transition. The Step setting will hold the preceding key value until the next key.

Scale and Shift

You can scale and shift the key positions by dragging up and down on the Scale Keys and Shift Keys buttons. Similarly, 
you can scale and shift the key values by dragging on the Scale Values and Shift Values buttons. Invert Keys reverses the 
values of the keys. This will not affect the position of keys on the bar, however.

Although you can also drag the middle of the arrow, it’s not recommended because you can accidentally add a 
new key.


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Clip Map

Clip Mapping

The Clip Mapping function, located on the Rendering Tab of the Object Properties Panel and in the Surface Editor, offers 
a way to quickly alter an object. Basically, it allows you to cut away portions of an object using a texture. This is a great 
way of creating 2D pop-ups, as well as holes, tears, or grids in objects without having to model them.

In LightWave 2019, Clip Maps are still available in Object Properties as before, but they can also be saved as a Surface 
Editor property meaning that clips now become part of surfacing and thus saved with the object rather than only being 
a Scene property. This means that there is no longer a need to use Load from Scene to load an object with clip maps - as 
long as said clip maps have been assigned using the Surface Editor.

This change also means that you can have multiple clip maps that are surface-limited rather than having to juggle 
different layers in the Texture Editor to create the clip map arrangement you want.
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Left: Flat Plane Object, Right: Clip Map Image

Rendered Image
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Object Cloned Several Times Army of Dorks with Cute Anime Girls

There is one important distinction between a Clip Map and normal texturing options: there is no partial clip. The 
information in the Clip Map either cuts the relevant area away or leaves it intact.

If an image is used as a Clip Map, any value of 50% luminance (brightness) or higher will clip the corresponding part of 
the object, while a value below 50% will not. Using Procedural Textures works similarly, except LightWave calculates 
the image data instead of providing it in a picture. A two-color image will give you the most control over the results of a 
Clip Map.

Like Displacement Maps, Clip Maps are also saved as part of the scene file and not as part of the object if you use them 
through Object Properties. In order to load an object and its Clip Map, use File > Load > Load Items From Scene.

If, on the other hand, you used the Surface Editor to place your clip maps, they will be saved with the object directly 
making reloading into another scene simple.

If you need a partial-clip effect, try using a Surface Transparency Map instead.

Place a clip-mapped flat polygon outside the camera view to fake shadows through grids, trees, or a window.
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Surface Search

Surface Search

Searching in the Surface Editor is based on the following string:

ObjectName/SurfaceName@MaterialName#ShadingModelName

This means that you can search for objects and get their surfaces, or search for surfaces or materials or even shading 
methods by preceding them with:

/ - for surface names
@ - for materials
# - for Shading models

Regex example 1

To get more control over your searches, you can use Regular Expressions. The last search in the example above reads:

re:mar.+/.+lor

which translates to

RegEx: find all objects starting with "mar" with surfaces starting with anything but having 
"lor" in them
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resulting in only the Marble-GlassTwist object being found with the GlassColor1-4 surfaces.

Regex Example 2

In the same scene, we want to only select surfaces on objects that have swirl in their object name, but just surfaces 
ending in the letter s. We can do this thanks to regex with re:+swirl.+/.+s@.

I was going to write swirl but decided just to put the wildcard in again.

The Surface Editor regex style is taken from QT. More information and syntax can be found here.

http://doc.qt.io/qt-5/qregexp.html#introduction
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Preset Shelf

The Preset Shelf is a resizable floating window that holds a list of previews along with all of the associated settings in 
Modeler and Layout. It can be used for settings with surfaces, volumetric lights, HyperVoxels, Bullet Dynamics, Flocking, 
Navigation devices and more. It is accessed using the Presets button (Windows > Presets) or from some plugin panels. 
You add to the shelf by double-clicking on the preview, if one exists on the panel (e.g., Surface Editor), or by using the 
Save Preset button found on panels supporting Presets. The shelf survives from session to session.

 

The window is context sensitive, so if you are working on surfaces, surface presets are displayed, if you are working on 
HyperVoxels, those presets are shown, and so on. If you have no windows that accommodate Presets, the Presets Shelf 
will still open, but will appear to be empty. Each editor has a default library named Workspace - a library is a grouping of 
presets for a particular editor.

Third Party tools can take advantage of the Preset Shelf as seen in the plugin Bevel ++ for example.
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Libraries

You can create a custom library by right-clicking over a preview and choosing Library > Create Library. For example, 
using the Surface Editor, you might make a library of Wood presets, a library of Stone, etc. Library > Delete Library will 
do just that, and Library > Discard Presets menu clears all of the presets from the displayed library.

Hierarchy View

The small L-shaped button in-between the Library list and the ordering dropdown switches how libraries will be shown. 
With the Hierarchy display active, preset libraries will be presented as sub-menus. With it off, everything is in a long list.
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To apply one of the presets:

Double-click on a preview or select Preset > Open from the RMB pop-up menu.Click the Yes button on the confirmation 
dialog.

Preset > Open w/Parameters works with certain preset groups, like HyperVoxels, and allows you to pick which 
part of the settings you want to use.


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From the Presets menu choose Set Name to open a dialog box where you can set a Name to be used for the sample, it 
appears underneath the sample image. You can add a longer string of text in the Description field, which appears at the 
bottom of the panel when your mouse pointer is over a preview.

There are also options to Move/Copy presets between libraries. The Delete option removes the sample from the shelf.

The Presets Panel has been updated with all available menus listed. Each library is listed in a separate category. The 
light colored lines indicate available 'library containers' and their lock state, which depends upon design decisions and 
folder permissions.

The 'Bundled' container refers to presets stored inside the Layout application (inside the application bundle); these 
would be specific to that application and provided solely by NewTek. The "Built-In" container refers to presets stored in 
the "SharedSupport" folder, which is shared among all the LightWave applications; these would be provided solely by 
NewTek and is not modified by the user or third party installers. There is a "This Network" container (not shown here) 
that would refer to presets shared among members of a Mac network The "This Machine" container refers to presets 
stored on the local machine and shared among all users that can log into this machine. This is where third party presets 
would normally go (so that they can be shared among all users on the machine). The "This User" container refers to 
presets stored specific to current logged in user and are not shared with any other users. The "Custom" container (not 
shown here) refers to the user define preset folder that can be specified within Layout. The lock symbol means there is 
no write access allowed to the container. For the current library, you will also see the lock state if that particular library 
has not write access.

Double-clicking on the preset image (like before) will activate that preset. One difference now is that double-clicking on 
the name will open up the editing dialog to set the name and description of that preset.

Changes to the preset folder made outside of LightWave are okay and will be realized when the preset shelf is brought 
to the foreground.

Keeping your Presets organized will pay off in the end. After a while you may find that you have quite a large 
collection.


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This new capability removes a restriction and allows LightWave to be operated from a read-only device such as a DVD, a 
network application server (educational environments), a mounted DMG file. In many environments, users do not have 
write access to the previous single preset folder, so having these other locations is useful. Also, third party UB installers 
now have a reliable location to place their preset updates. Also, when updates to the Universal Binary version of 
LightWave are made via the intended drag-drop install, the previous Applications/LightWave3D folder will be totally 
replaced; so it is important not to make third party or user modifications to that folder.

Preset Location List

The Preset Location List replaces the single Custom Preset location in previous versions so that you can define multiple 
preset locations.

A custom location can be marked as Read Only, this means that presets cannot be created or removed from this 
location. For instance a team might have a set of shared presets residing on a network share, marking the location as 
Read Only would prevent a team member from making changes to those shared presets.

The Preset Shelf's Add New Preset right-click menu entry will attempt to create a new preset for the current Preset Shelf 
client, this new preset will be created in the currently viewed location and folder. This option is only active if the 
location can be written to. Read Only locations are denoted will a lock icon in the locations popup.

When creating a preset from somewhere other than the Preset Shelf's Add New Preset entry, for instance from the 
Surface Editor's Preset popup menu, then the Default Save Location in the Preset Location List marks the custom 
location as the one to use when saving a new preset.

You can remove and add new locations with the buttons at the bottom of this panel.

Presets normally reside in three locations as shown in this image:
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Rendering

Rendering is the final purpose of LightWave for many. This section details the different ways LightWave offers for 
creating final imagery. If you haven't read it already, please start with Getting Started with Rendering.

VPR
Render Settings
Rendering and Compositing
Shading Models

Sponza cathedral by Craig "RebelHill" Monins
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VPR
Click here to expand Table of Contents...

VPR Render Controls
VPR Progress Meter
Normalizing

Alpha Channel Support for VPR
VPR Save and View Controls
Add Display
Additional VPR Controls

VPR Draft Mode Limitations
VPR Examples
Creating a VPR Preview

VPR (Viewport Preview Renderer) is Layout’s native Interactive Render. Essentially, VPR is the LightWave renderer in a 
next gen interactive form. The VPR Interactive Renderer handles Radiosity, Ray-Tracing, Reflections, Refractions, and 
Transparencies - pretty much anything in short - to provide stunning LightWave renders as quickly as possible.

 
VPR is activated in the Viewport Display menu by selecting VPR instead of one of the standard OpenGL view types. Once 
activated the viewport will begin rendering using the settings in the Render Globals panel. VPR will continually update 
when changes are made.

VPR Render Controls

The render settings for VPR are located in the top-right section of each viewport. Look for the highlighted button.


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Draft Mode - an optional way for VPR to start, is an optimized setting for VPR which has limitations but results in 
faster image iterations. Using this mode does not affect any of your F9 renders. This setting is also available in 
the Viewport Options menu.
Render Alpha - Available only when not in Draft mode and checked by default. See below
Half Resolution - will cause VPR to render only at half-resolution.
Pixel Smoothing - Affecting the initial drawing of the VPR image, Pixel Smoothing interpolates between the 
power of two pixel sizes resulting in a more “readable” image earlier.
Render Outside Camera - Unchecked by default. This renders only the view seen by the camera. If you want the 
whole viewport rendered you can check this option.
Volume Shadows - will render shadows resulting from volumetrics in the scene. This includes fibers generated 
from Fiber FX.
Normalize Display - Designed for viewing buffers in VPR that would normally exist in a 0-1 representation that 
results in a white screen in VPR. Buffers like Depth just present an all-white screen in VPR, but the information is 
there. Using Normalize Display will convert the depth values into a 0-255 scale.
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• Interactive FPS - is the frames per second VPR will attempt to update the render. A Render FPS setting of 30 will 
attempt 30 redraws per second, while a Render FPS setting of 1 will attempt only one redraw per second.

VPR Progress Meter

2019.1 adds progress bars to VPR viewports to give a better guide to completion. A progress bar is added for 
each VPR viewport:

With one, then two VPR viewports above, but also more:
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This meter is switched off by default, so don't be surprised if you don't see these bars right off. Visit Options (O), and at 
the bottom of the first tab you'll see a new option, Viewport Monitor.

Normalizing
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Normalize Display shows spheres at varying distances from the camera in the Depth buffer

Alpha Channel Support for VPR

VPR supports the saving of images with Alpha channels. This functionality is limited to Final quality VPR images, not 
Draft. Images will take a very small amount more time to render to completion, but all image savers listed as 32 in the 
Image Saver list will save with an Alpha Channel. Savers that only have 24 listed will still not have Alpha Channels.

VPR Save and View Controls

These settings are applied to the Save button in the viewport that will save an image with the settings here without 
dialog. Images will not have OpenGL overlays and will be saved at the moment you hit the button, which means that 
they might not be in a final state.

Type - is the image file type.
RGB Files - is the location where an image saved with the viewport button will go and with what base name, by 
default Image .
Color Space - sets the color space options for the saved image.
Alpha Color Space - The Color Space for the Alpha channel. Normally, this should be left at Linear.

If your normalized depth buffer is only showing black or white for geometry, make sure the Depth Buffer 
options are set correctly for your scene. Visit Render Properties (Ctrl+F9) > Buffers > Depth and set the Options 
to an appropriate range for your scene.


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Add Display

You can send the VPR viewport to an external display. Provided is 3D Vision Pro for use with NVidia graphics cards and 
suitable 3D viewing hardware.

Additional VPR Controls

More options are available in the Viewport Options menu:

OpenGL Wireframe will display the wireframe of the mesh over the VPR rendering.
OpenGL Overlay will display the OpenGL components such as the grid and transform widgets over the VPR 
render.
Draft Mode presents a faster render, but with limitations, as described below.
Mouse Refinement was added in LightWave 2018 and concentrates rendering on where the mouse is over the 
viewport. It means that you can have a faster preview of an area of interest without having to wait for the whole 
render to finish. Mouse refinement doesn't start immediately, there needs to be a level of rendering complete 
overall before it can work.

When VPR finishes rendering, information about the Render Duration and the number of Rays per Second fired is shown 
in the Tool Tips.

VPR Draft Mode Limitations

VPR’s Draft Mode is designed to show you renders as quickly as possible, however, it doesn’t support everything of 
which VPR is capable. Here’s a list of VPR Draft mode limitations:

Motion Blur is disabled
Depth of Field is disabled
The Adaptive Threshold is set to 0.1
Minimum Samples is set to 1 and Maximum Samples is 9
Oversampling is set to 0.5 and uses Filter Radius
Light, Reflection, Refraction and Scattering samples are limited to 4.
Ray Recursion Limit and Reflection Bounces are set to 4 but the Reflection Recursion Limit is set to 2
Diffuse Bounces is set to 1

As you can see, to get a true view of your render, better to get out of Draft mode as you are nearing project completion, 
especially if you are going to require an F10 render sequence and want no surprises because your rendered images 
don’t look the same as your VPR previews.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=WUpC5-awxEo

https://www.youtube.com/watch?v=WUpC5-awxEo
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VPR Examples

Some pictures of the Layout interface showing VPR’s different modes. We haven’t shown Stereoscopic or Depth of Field 
but both require VPR to be in Final mode.

OpenGL Textured Shaded Solid
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OpenGL Textured Shaded Solid Wireframe

VPR Draft
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VPR Final

VPR Final with OpenGL Wireframe
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VPR Final with OpenGL Overlay

VPR Final with limited region. Useful for when you just need to verify a detail but don’t want to wait for a complete 
render.
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VPR Final with all the overlays

VPR Final with Depth of Field and Stereoscopy

Creating a VPR Preview

While VPR is running, you can create previews just as with any other viewport display mode. You also have the choice of 
either making the preview in a viewport or as a separate window. To do so, visit the Display Options tab of the 
Preferences window (D) and check Undock Preview Win. You can also choose to use the Camera Resolution, but beware 
with this that your camera resolution isn’t bigger than your screen resolution (you can hit Esc to leave the window). This 
setting is only kept for the scene you are in, so when you create a new scene you will need to Undock the preview 
window again if you so desire.

The last option is to set the Preview Scale Level. This setting applies whether you undock the Preview window or create 
a preview in a viewport and offers a dropdown with a choice of Antialiased at the top down to Every 32 pixels at the 
bottom. Obviously, the lower the resolution, the faster the preview will render. It’s up to you to determine what level of 
detail you require from your preview.
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Antialiased

Every 4th Pixel
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Every 32 pixels
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Render Settings

Rendering and Compositing

A render is the image created by what the camera sees. A composite is a blending of two or more image layers. This 
chapter covers the details of creating the final image, sequence of images, video, and, any post-rendering effects you 
might add to the image.

In addition to pressing F9 or F10 for final renders, you can create images using LightWave’s VPR system that uses your 
OpenGL viewport to perform a full render of your image. Obviously, if you require a single image larger than your screen 
resolution, an image with a lot of post-processing or a sequence of images, then you will need to use the F9 and F10 
shortcuts, but for a rapid full-quality render VPR is ideal. There are additional benefits to using VPR, for instance you can 
render any view, not just the camera; you can select surfaces directly from the screen simply by Shift-clicking on the 
rendering image; optionally see and move your scene items; quick save images directly from the screen and more. 
Additionally, you can create a high-quality preview of your animation.

Render Properties

(Default keyboard shortcut: Ctrl-P)

This is the heart of how you render your creation. In this window there are buttons, drop down menus and tabs to 
control how long your render will take, what format your individual frames or animation will be in. This window consists 
of the six tabs detailed below:

Render Properties - General
Render Properties - Render
Render Properties - Global Illumination
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Render Properties - Volumetrics
Render Properties - Buffers
Render Properties - Output

Light and Camera Properties

Lights
Camera
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Rendering and Compositing

Rendering and Compositing

A render is the image created by what the camera sees. A composite is a blending of two or more image layers. This 
chapter covers the details of creating the final image, sequence of images, video, and, any post-rendering effects you 
might add to the image.

In addition to pressing F9 or F10 for final renders, you can create images using LightWave’s VPR system that uses your 
OpenGL viewport to perform a full render of your image. Obviously, if you require a single image larger than your screen 
resolution, an image with a lot of post-processing or a sequence of images, then you will need to use the F9 and F10 
shortcuts, but for a rapid full-quality render VPR is ideal. There are additional benefits to using VPR, for instance you can 
render any view, not just the camera; you can select surfaces directly from the screen simply by Shift-clicking on the 
rendering image; optionally see and move your scene items; quick save images directly from the screen and more. 
Additionally, you can create a high-quality preview of your animation.
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Render Properties
Distributed Rendering - An Introduction
Image Viewer
Print Camera
Rendering and Compositing - Utilities
Set Limited Region
Render-Q
Create Preview
Effects Window



LightWave 2020  –  LightWave 2020

Reference –  2697

•
•
•
•
•
•

•
•
•
•

Render Properties

(Default keyboard shortcut: Ctrl-P)

This is the heart of how you render your creation. In this window there are buttons, drop down menus and tabs to 
control how long your render will take, what format your individual frames or animation will be in.

Render Properties - General
Render Properties - Render
Render Properties - Global Illumination
Render Properties - Volumetrics
Render Properties - Buffers
Render Properties - Output

Render Presets

At the top of the window is a dropdown for creating Render Presets. There are four options:

Load From Disk - Loads a preset previously saved to disk
Save To Disk - Saves a Preset to disk
Save To Preset Shelf - Saves the preset to LightWave's preset shelf
Open Preset Shelf - Opens LightWave's Preset Shelf

When you save to disk or shelf, requesters will open for choices of what to save:
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Save to Disk

Save to Preset Shelf

You can save presets for only render properties, only GI properties or both.
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Render Properties - General

The General tab covers overall settings for your rendering. Here is where you’ll set a render range and choose what 
portion of the scene you wish to render.

Range Type - There are three options to choose from this menu:

Single - this allows you to set a range of frames to render the way existing users of LightWave will be 
familiar with. You set a first frame to render, a last frame to render and you can set a Frame Step. If you 
decide that you only want to render every other frame, set this to 2, every third frame? Set it to 3, and so 
on.

Arbitrary - parses the frames you choose to render. You can set a frame range, a disparate single frame or 
two and a range again. To mark non-contiguous frames, put the frame number followed by a comma. To 
mark a range put the first frame number, a dash and then the last frame number in your range.

If you wish to you can render frames one to ten of your sequence, jump to frame 18, then render frame 25 
and finish up by rendering frames 40 to 50 of your scene. 

Keyframe - is very useful for creating storyboards. You have access to any object, light or camera in your 
scene and you can use the channels for movement, rotation or sizing for the item in question (you can’t 
choose channels that don’t exist - for instance, there are no size options for the camera). Every time that 
a keyframe for the item and channel appears in the scene, LightWave will render the frame.
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The render range you choose is set independently from the scene frame range. If you use the Single range 
- the range that’s always been available in LightWave - you will be asked to confirm if the range you’ve 
selected does not match the number of frames in the scene.

Auto Frame Advance - If this is unchecked you will need to hit the Continue button on the Render Progress 
window at the end of each frame. This option is checked by default.
Frame End Beep - A beep will sound once a frame has finished rendering.
Animation End Beep - A beep will sound once all frames in a render range have finished rendering.
Preview - This dropdown menu offers ten choices:

 
Off 

 
320 x 240 
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640 x 480 

 
800 x 600
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1280 x 720 
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 1920 x 1080 (on UHD screen)

 
Camera Resolution 25%
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Camera Resolution 50% (showing green preview pass boxes)
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Camera Resolution 75% (showing blue render pass boxes)

Camera Resolution 100% (on UHD screen)

None - There will be no render preview image, but the scene stats and progress bar will be retained.
320 x 240, 640 x 480, 800 x 600, 1280 x 720, 1920 x 1080 - LightWave scales the rendered scene to fit inside this 
window where necessary, so turning off the preview can make rendering slightly faster.
Camera Resolution 25 %, 50 %, 75 %, 100 % - Rather than a defined size, this version of the preview will conform 
to your camera resolution.

Render Display - This sets the destination for your F9 renders. It can be set to:

(none) - Renders will finish and be thrown away. Not useful for F9 renders, but indispensable when using F10 to 
render.
DVView - Renders will be sent to a DV device. Only NTSC DV devices are supported.
Image Viewer - The entry you will normally choose. Renders will be displayed in LightWave’s Image Viewer 
window.
Python Frame Buffer - Renders will be sent to a demonstration Python script that will display them.
Python - Selecting this will open a file requester for you to choose a Python script that will be called once your 
render finishes.
Render2Image - Uses an Object custom object called Visor to present renders. Visor is explained here.

Preview Pass - This toggles whether the initial green pass will be shown in the Render Display window. A render 
without this separate prelimnary pass gives exactly the same end result, but more rapidly since there isn't an 
extra pass made.
Limited Region - This dropdown presents three choices - Off, Include Borders and Exclude Borders/Cropped. 
They can be switched between with the default keyboard shortcut of L.

https://docs.lightwave3d.com/display/LW2018/Appearance+Tab#AppearanceTab-Visor
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This command allows you to limit the area of your screen that is rendered. Hitting L a single time will give you 
Limited Region Include Borders - that is to say an area of your scene renders inside an image at complete size. If 
you press L again, you get Limited Region Exclude Borders / Cropped, which will render just the segment of your 
image at whatever size you chose. Pressing L a third time will remove the Limited Region.

Further, if you engage Limited Region, the Render Preview window will respect the Limited Region set, as shown 
below:

Overlay - The Data Overlay option lets you place a descriptive title (of up to 20 characters) along with a frame 
reference in the lower portion of the rendered image. This is useful when you generate large numbers of 
animations for others to review and approve before final rendering. It can serve to identify the scene being 
rendered, and the specific frames you may wish to change. The Data Overlay pop-up menu setting determines 
the format for the frame reference. Enter the text in the Label field. If Data Overlay is not set to Off and the Label 
field is blank, the scene name will be used automatically. There are five options:

Off - The default option
Frame Number - The frame number being rendered.
SMPTE Time Code, Film Key Code, Time in Seconds - Appropriate to the frame being rendered.
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If anything other than Off is chosen, the Overlay Text option becomes available into which explanatory text for the frame 
can be inserted.
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Render Properties - Render

Click here to expand Table of Contents...
Renderer Dropdown
Renderer Switches
Ray Trace Shadows
Ray Trace Reflection
Ray Trace Refraction
Render Lines
Render Instances
Enable Mipmapping
Enable Lens Flares
Diffuse Bounces
Ray Recursion Limit
Transparency Recursion Limit
Reflection Recursion Limit
Refraction Recursion Limit
Ray Precision
Reflection Samples
Refraction Samples
Subsurface Scattering Samples
Global Mipmap Multiplier
Global Flare Intensity
Global Light Intensity
Global Edge Multiplier
Edge Vertical Points
Diffuse Limit
Reflection Limit
Refraction Limit
Enable Despike
Noise Filtering
Render Tile Size
Tile Colors
Polygon Intersection Mode
Multithreading


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The Render tab covers general options for rendering. Here is where you’ll choose what options you want to use. Most of 
the defaults won’t need to be changed except for special purposes.

Renderer Dropdown

If you choose to add a third-party render engine to your LightWave, this menu at the top of the Render tab allows you to 
choose which you will use when pressing F9. The Renderer Options button will open settings specific to that engine if 
necessary.
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Renderer Switches

All options are switched on by default for a realistic render, but you can change them as you like. These options are 
global to the render. Objects have their own individual settings if you need to get more atomic.

Ray Trace Shadows

When you enable “Ray Trace Shadows”, any lights that have shadows enabled will now calculate ray-traced shadows.

To optimize your rendering times, you should carefully consider which shadow options you wish to have active 
for each object – for instance, objects that are in the background can probably have their shadows turned off 
completely.


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Ray Trace Reflection

Enabling this feature will cause LightWave to calculate ray trace reflections between objects and the background 
depending on the settings for the surfaces in the Environment Tab in the Surface Editor. Again, you can optimize your 
rendering times by using images as Reflection Maps instead of raytraced reflections or by turning off reflections 
altogether for objects with lower importance.

Ray Trace Refraction

You can get LightWave to ray trace only transparent surfaces with refraction using this feature, allowing you to further 
optimize only those surfaces that have to undergo the ray tracing procedure. It works for surfaces that have some 
degree of transparency and a refractive index other than 1.0.
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Render Lines

This needs to be enabled to render the edges of your geometry using the control on the Edges tab of Object Properties, 
or for single points or two-point poly chains.

Render Instances

Turns on and off instance rendering immediately.

Selecting Unseen by Rays for an object tells LightWave to ignore the object in its ray-tracing calculations when 
reflection and refraction are involved. This means that the object that is unseen by rays will not appear in the 
reflections or refraction of another object. It will, however, render normally in the scene. This is especially 
handy for objects that are front projection-mapped; you probably do not wish them to show up in the 
reflections within other objects. Unseen by Rays will not affect the shadow options of a given object.


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Enable Mipmapping

(Default Off)

Activates or deactivates Mipmapping globally for a scene.

Enable Lens Flares

(Default On)
Globally enables LightWave's post-process Lens Flares effects.

Diffuse Bounces

(Default 2)

This sets how many bounces are generated in Global Illumination.

Ray Recursion Limit

(Default 6)

Ray Recursion is the maximum number of times you want ray-traced reflections reflected off reflective surfaces. In the 
real world, things can be reflected a seemingly infinite number of times. For instance, if you stand between two mirrors 
facing each other you will see a seemingly countless number of reflections, repeating until the imperfect transmission 
of light due to the density of the glass and air causes them to fade into blackness. In the world of 3D animation, you 
must set a limit for the number of reflections. The default value is 6, but you can set this field from 0 to 24. Lower 
numbers will yield faster rendering times.
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With 1 bounce of recursion we get a very empty scene, but a render time of only 46.4 seconds. The second image has 
recursion set to 2 and renders in 74.9 seconds.
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Now we’re up to the default of 6 for recursion and a render time of 157.5 seconds. With 8, we get 221.7 seconds. Moving 
up to 16 and 24 levels of recursion and we no longer see the difference apart from render times. At 16 we get a frame in 
237.4 and 24 is 244.4 seconds. Using Difference mode in Photoshop shows that the only pixel changes are in rendering 
time and window border.
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Transparency Recursion Limit

(Default 6)

This is purely for non-refracted Opacity Rays, Clip maps and Shadow Rays

Reflection Recursion Limit

(Default 4)

How many bounces of light between surfaces. Once the recursion limit is reached rays can return nothing and so are 
black. This is an additional limit to place specifically on reflections when a scene might need more reflection samples 
than are desired for recursion.

Refraction Recursion Limit

(Default 4)

How many times light rays are bent between surfaces. Once the recursion limit is reached rays can return nothing and 
so are black. This is an additional limit to place specifically on refractions when a scene might need more refraction 
samples than are desired for recursion.

Ray Precision

(Default 6.0)

Is the mathematical digits of precision used for intersection tests. Typically it is 6 (or 1.0e-6) which works well in most 
scenes. It may need to be decreased for very rough objects with non-planar faces and this can be used to figure out 
problems with a model. If reducing the number fixes a rendering issue, the model is probably not well constructed. It 
determines if two slightly different intersection points are really the same intersection point with a precision error. Most 
users should not need to edit this value. If changed, they should plan on changing it back to 6 again when they are done 
fixing their models.

Reflection Samples

(Default 1)

Reflection samples define how many glossy rays are cast from the surface by the integrator to determine a pixel's 
overall shading. Every pixel in the rendered image is hit by an initial ray cast from the camera; when a ‘hit’ occurs, if you 
have Shading Samples higher than 1, more rays are cast. The amount cast is set by the number of Reflection Samples, 
so if you set it to 4, that many rays are fired. This process is repeated for each pixel if Minimum Samples is higher than 
1, and is repeated as many times as set by the Maximum Samples in Camera Properties.

Lower numbers render faster at the expense of quality or noise in the image, the reverse is true for higher numbers.

Refraction Samples

(Default 1)

Going below 3 for Ray Recursion can cause problems with things such as Clip Maps, so it’s always a good idea 
to have some Ray Recursion in the Render Globals.


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Refraction samples define how many refraction rays are cast from the surface by the integrator to determine a pixel's 
overall shading. Every pixel in the rendered image is hit by an initial ray cast from the camera; when a ‘hit’ occurs, if you 
have Shading Samples higher than 1, more rays are cast. The amount cast is set by the number of Reflection Samples, 
so if you set it to 4, that many rays are fired. This process is repeated for each pixel if Minimum Samples is higher than 
1, and is repeated as many times as set by the Maximum Samples in Camera Properties.

Lower numbers render faster at the expense of quality or noise in the image, the reverse is true for higher numbers.

Subsurface Scattering Samples

(Default 1)

Subsurface Scattering samples define how many subsurface scattering rays are cast from the surface by the integrator 
to determine a pixel's overall shading. Every pixel in the rendered image is hit by an initial ray cast from the camera; 
when a ‘hit’ occurs, if you have Shading Samples higher than 1, more rays are cast. The amount cast is set by the 
number of Reflection Samples, so if you set it to 4, that many rays are fired. This process is repeated for each pixel if 
Minimum Samples is higher than 1, and is repeated as many times as set by the Maximum Samples in Camera 
Properties.

Lower numbers render faster at the expense of quality or noise in the image, the reverse is true for higher numbers.

Global Mipmap Multiplier

(Default 1.0)

You can increase the multiplication level globally for Mipmaps here.

Global Flare Intensity

(Default 1.0)

Determines the Global strength of all Lens Flares in the scene. A setting of 1.0 uses the same setting, a setting of 0.5 
would cut the strength in half, while a setting of 2.0 would double the strength. The Enable Flares button needs to be 
checked for changes here to make a difference.

Global Light Intensity

(Default 1.0)

Determines the Global strength of all lights in the scene. A setting of 1.0 uses the same setting, a setting of 0.5 would cut 
the strength in half, while a setting of 2.0 would double the strength.

Global Edge Multiplier

(Default 1.0)

The Global Edge Multiplier is a simple way of being able to rapidly change edge sizes for different resolutions. Imagine 
that you have created a scene using edges for 1080 and the director wants to go to UHD. Before the Global Edge 
Multiplier you would need to adjust the edge sizes for all objects. Using this field, it would be a simple matter of 
changing from 1.0 to 2.0 when the camera resolution is changed.

Edge Vertical Points

(Default 0)
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Edge Vertical Points (EVP) offers a more advanced way of doing the same thing. An explanation of the control name is 
needed first. Edge, because the setting relates to the edges in your scene; Vertical, because it is only concerned with the 
vertical scale of such edges, given that the horizontal scale will match; Points, referring to the abstract measurement 
used for text on a computer screen to disassociate from the rigid pixel. The idea here is to set the EVP to a number you 
feel represents the majority of your work, your standard. As an example, we'll use 1080. Now, as the resolution of your 
output changes, the scale of the edges compared to their width onscreen rendered will stay consistent - edges on a 60" 
HD screen will appear the same as a 60" UHD screen (but the UHD screen will be sharper).

An example that shows the principle well. Imagine that rather than changing the viewport size we are changing the 
camera resolution between SD, HD and UHD. The EVP maintains the ratio of the space edges take onscreen

Diffuse Limit

(Default 5.0)

Used to clamp the maximum value of indirect rays

Reflection Limit

(Default 5.0)

Used to clamp the maximum value of indirect rays

Refraction Limit

(Default 5.0)

Used to clamp the maximum value of indirect rays

Enable Despike

Despike examines buffers for anomalous spikes in their data while rendering and attempts to smooth them out.

Despike Tolerance - Defaults to 0.8, any brightness below 0.8 will be affected by neighboring samples. Do not 
use Despike unless you have actual bright spikes in the render you want to remove.
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Noise Filtering

This dropdown offers three choices.

Off - No noise filtering
On - CPU - Uses CPU-based noise filtering first seen in LightWave 2018. The options are described here
On - GPU - Uses NVidia Optix 6.5 AI denoising, and requires NVidia drivers of at least v435. Only works for still 
images (not network rendered) and requires an Nvidia Geforce, Quadro or Tesla graphics card with at least a 
Kepler chipset. There are no user-configurable options

Render Tile Size

(Default 32)

This dropdown giving a choice from 8 pixels square to 1024 will require your judgment to get the most rapid render. 
There is no easy way to judge whether large tiles will make more sense than smaller ones because the setting you 
choose will be completely scene-dependent. Test renders and limited region renders will allow you to tune to get the 
best performance.

Tile Colors

Render tiles come in three colors. Green, Blue, and Gold. There will be a tile for each core of the processor rendering. 
The three colors appear at different stages of rendering and the first to appear; once any GI work has been done, are 
green. Tiles that are green represent the first sampling for a section of the render. Once the first pass has been made, 
the tiles turn blue to show the adaptive sampling passes taking place. This is the usually the longest stage. Towards the 
end of the render, some cores may have finished any available tiles and would otherwise sit idle. LightWave will start to 
split tiles to keep all cores engaged until the end of the render. These split tiles will be gold.

MacOS no longer supports the NVidia CUDA system. This means that Optix denoising will not be 
available for the MacOS platform - Source



If you choose a small size your render will be slowed slightly because each tile needs to have an unseen border 
rendered for matching to other tiles. The smaller the tile, the more time is spent on these unseen borders



https://devtalk.nvidia.com/default/topic/1027650/optix-5-1-macos-download-missing-/?offset=13
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This animation shows the different tiles used for rendering. The system used consisted of a Dual E5-2698 v4 with 40 
cores and 80 threads resulting in a lot of tiles for the render.

Polygon Intersection Mode

(Default Watertight)

There are three intersection modes with increasing precision:

Fastest - This is the speediest of the three, but can sometimes return dots where edges between polygons don't 
line up precisely
Watertight - Should work in all cases, but still uses single precision math that might fail in extreme situations
Double Precision - Bulletproof but not as fast

Multithreading

The Multithreading setting is used for systems with multiple CPUs or CPUs with multiple cores. Normally, you should set 
this to the number of processors on your system; however, there are times when you will get faster rendering with this 
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set at a greater or lower number. For scenes that are very simple and render in seconds, you may find that setting 
multiple processors to the task will actually slow down renders because of the overhead of the communication 
between the processors. For such scenes, it is better to set up batch rendering so that each processor can render its 
own frames. Checking the Automatic Multithreading button will set the number of threads to the maximum on your 
computer. There is a maximum of 64 threads for rendering.

A potential for problems exists with some older plugins that were not designed with multi-threading in mind. If 
problems occur, try using the 1 Thread setting.


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Render Properties - Global Illumination

Click here to expand Table of Contents...
Introduction

How Global Illumination Is Calculated
New Panel Hierarchies

Global Illumination
Brute Force
Irradiance Cache
Interpolated Cache
Debug Display Options

Lighting Considerations
Troubleshooting


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(Default keyboard shortcut: Alt-P)

Introduction

Without Global Illumination, lighting in LightWave is relatively simple, based on a scene's lights. Their range of 
intensities and a mapping of the resulting surface brightness translate into image pixel values. Global Illumination (GI) 
simulates light that bounces between surfaces in your scene. In real life when light hits a surface, some of it bounces 
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away from the surface and can illuminate other surfaces around it. For a diffuse surface this bounced light is spread 
evenly in all directions. For a reflective surface, the light bounces with different intensity in different directions creating 
bright rings of light, known as caustics, on the surfaces it illuminates.

Sponza cathedral courtesy Craig Monins
GI is a physical simulation of real-world lighting. Scenes rendered with GI enabled have far more realistic shading. 
Corners appear darker. Interiors of rooms emerge from the shadows. Colored objects can cast colored light on other 
surfaces around them. However, GI can be slow if using purely Brute Force. The interpolated mode trades a small 
amount of realism for a lot of render speed. It can create noise-free global illumination with reasonable render times. 
When combined with the high dynamic range calculations, renderings can become astoundingly realistic.

How Global Illumination Is Calculated
LightWave approximates Global Illumination using “projection hemispheres.” These basically “sit” on surfaces, each 
projecting out multiple Global Illumination rays at various angles using the theoretical normals of each polygon in the 
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hemisphere. This is called an “irradiance evaluation.”

An Illustration of a Projection Hemisphere
If a Global Illumination ray strikes a surface that scatters light, some amount of that light illuminates the surface where 
the ray originated - colors are determined in the usual (non-Global Illumination) way, which can include the effects of 
luminosity, mirror reflections, caustics, and so on. The light-scattering surfaces are essentially extra little light sources 
that affect the diffuse shading of the current surface. Evaluated and non-evaluated areas are blended to compute the 
final effect.

Performing a full irradiance evaluation (tracing hundreds of rays) every time a point must be shaded is too time-
consuming. Fortunately, unlike direct lighting, with its concentrated sources that can cause sudden changes across a 
surface (e.g., shadow boundaries), the indirect lighting that Global Illumination is meant to handle tends to change 
gradually over a surface. LightWave can use the results of each previous evaluation and smoothly interpolate between 
them. Only when no previous evaluations are close enough to the point being shaded, is it necessary to fire a new set of 
rays.

What is close enough? Each time LightWave performs a full evaluation, it estimates the size of the area that can produce 
valid results. This depends on factors like how far the rays traveled. This depends on the distance from the camera and 
the field of view per pixel. If all rays went a great distance before hitting anything, then the indirect light must be fairly 
constant and the calculated irradiance should be good for a large area. But if several rays hit nearby objects, then the 
indirect light might be varying more rapidly across the surface and the irradiance evaluations should be more closely 
spaced.

Once you have checked Enable GI, you have the possibility of two passes of GI evaluation, a choice of Brute Force or 
Irradiance Cache. Irradiance caching is an interpolated form of GI calculation that allows you to fine-tune how your 
Global Illumination is calculated by setting how many Rays are sent out, what Distance and Angular Tolerances are 
used and either Minimum and Maximum Pixel Spacing, if you are using Screen Clamping, or Minimum Size if your 
scene depends on real-world scale.
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Global Illumination

Enable GI - On by default, there are two choices currently: Brute Force and Irradiance Cache. You can use any 
combination of the two engines you like but using Brute Force as the Primary and Irradiance Cache as the secondary 
makes the most sense. Be aware that the interactive version of VPR will not do any preprocessing, so a pure Irradiance 
Cache render, without existing cache, will probably end up blotchy.

Brute Force
Intensity - A multiplier applied to overall GI brightness. Useful especially for interior scenes. GI is a type of 
illumination and like other lights, its intensity can be modified. However, only an intensity of 100 % is close to 
physically accurate.
Rays - It is the number of brute force rays to use per pixel sample when not using interpolated or in regions of 
interpolated GI when interpolated samples could not be generated.
Caustics - Generally, a caustic occurs in the real world when light reflects off a curved surface or refracts through 
a transparent surface so that it is focused on a small area. Light through a wine glass is a good example. With a 
more complex surface, the caustic can create a random pattern like those seen on the floor and sides of a 

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.



In 2015 and earlier versions of LightWave, the Indirect Bounces setting on the Global Illumination tab 
controlled how many bounces were rendered. That setting is now on the Render tab and named Diffuse 
Bounces. It performs the same function.


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swimming pool. Switching Caustics on here will generate accurate caustics rather than the approximations seen 
in previous versions.

Caustics can add a significant amount of time to your render, so it's all about balancing your time 
budget with your quality requirements. Our first shot is purely brute force, with no secondary GI, and it 
took 1918.9 seconds to render:

The second test used just primary brute force again but lowered the quantity or rays from 128 to 64 to 
try and improve render time. The following render took 722.6 seconds to complete:

The caustics aren't quite as good as the first render, but the time taken was significantly less. We should 
try further:


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Affected by Volumetrics - Allows volumetrics to be included in the global illumination calculation. This can slow 
rendering but is more accurate if there are volumetrics in the scene.

Irradiance Cache
Irradiance Cache GI presents more options than Brute Force. It is also, by its nature, not something that will work 
perfectly out of the blocks without preparation. The "Cache" in the title is the giveaway. VPR and F9/10 will still work, 
but without a cache, VPR risks being "blotchy."

Rays - the number of evenly-distributed Global Illumination rays sent out for evaluation. As you might expect, 
the higher the density, the more accurate, but the longer the rendering will take.
Interpolation Accuracy - Increasing accuracy will mean better contact shadows, but requires more rays thus 
slowing down the render

The overall quality is fine in this Irradiance Cache render at the default 512 rays, and the render time is 
great at just 125.5 seconds, but the caustics are without detail. Try again.

Now we have a happy compromise. Brute Force primary rays at 64, and default Irradiance Cache 512 
ray secondary GI with Caustics on gives a result that fits our time budget at 505.1 seconds, and the 
quality is pretty similar to our first image but at a quarter the cost in render time.



LightWave 2020  –  LightWave 2020

Reference –  2731

•

•

•

•

•

Minimum Pixel Spacing (MinPS) -  Controls how tightly GI samples are packed near corners and measured in 
pixels. Larger values reduce the number of GI samples near corners which makes the GI less accurate but also 
can decrease render times.
Maximum Pixel Spacing (MaxPS) - Controls the maximum distance in pixels between interpolated Global 
Illumination samples. Larger values (100 is typical) reduce noise in large flat areas. Lower values make shadows 
more accurate but need more rays to reduce noise.
Distance Tolerance (DT) - is set in millimeters and controls the density of samples on flat surfaces. It is the 
maximum variation allowed in the sample direction in order to blend. Smaller distances will cause more 
samples to be taken for a surface but will help with small details like louvers, etc.

Angular Tolerance (AT) - is set in degrees and controls the density of samples on curved surfaces such as a 
sphere or a cylinder. It is the maximum variation allowed in the sample direction in order to blend. Smaller 
tolerances will cause more samples to be used on curved surfaces, but will help with details.
Screen Clamping - When Screen Clamping is checked, the MinPS and MaxPS fields are used. If Screen Clamping 
is unchecked, the Minimum Size field will be consulted for samples

Left: Distance Tolerance is too large for this scene. Note the leak of light to the step below. Right: 
Reducing the Distance Tolerance size has cured the light leak


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Use Specular - Uses specular effects from the scene to inform the radiosity solution
Use Glossy - Uses Glossy Reflection samples for the radiosity solution
Use SSS - Uses Subsurface Scattering samples for radiosity
Resolution Multiplier - Create a radiosity solution that is smaller, or bigger, than your render resolution

Interpolated Cache
Use Cache - When checked, a cache can be created and used for rendering. When unchecked the following 
settings are all ghosted and unavailable
Cache Type - Two choices:

Frame - is used for scenes where you have moving geometry or lights
Scene - is used if the camera in your scene is the only thing moving (flythroughs, etc)

Cache File - The name of your Irradiance Cache file. Clicking on the paper icon at the end of the filed will open a 
requester to set the name and path
Clear Cache - Click here to remove an existing cache so that a new one can be baked
Scene Baking Frame Step - How often to bake a cache for your scene. The default of 1 might take a long time 
where every 10 frames, or even more, might be suitable for your scene

Bake Grid - If you don't know where your camera will be going in your scene yet, or you want a belt and braces 
approach that ensures that every eventuality will be covered, you can bake a grid cache. The grid cache sets a 
grid at the spacing set for the bounding box of your whole scene.

Ray Recursion is the upper limit on the number of Diffuse Bounces you are allowed. For example, if you have a 
Ray Recursion Limit set to 1 and Diffuse Bounces set to 8, only one Global Illumination bounce will be 
calculated. However, if you have Ray Recursion Limit set to 8 and Diffuse Bounces set to 4, you will still get four 
bounces of Global Illumination.


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The first image shows our test scene with a chair separated from the room we are trying to bake, the 
second shows the chair in the room. In this simplified diagram, every vertex in the blue bounding box 
represents where the 360° camera is taking samples (Grid Spacing), at the resolution chosen (Grid 
Resolution)


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When you check this option, two further suboptions become available:
Grid Resolution - By default, this is set to 1024. The resolution of the cache. A cache is not an image, nor 
a set of images, but the resolution here is similar to the resolution of an image. The higher the resolution 
the longer each grid will take to bake but the more detail it will contain
Grid Spacing - This is how frequently you will be taking snapshots for this cache, at the resolution 
specified above

Caching saves Global Illumination data for subsequent render passes and frames, which can significantly reduce 
rendering time. The Global Illumination cache gets loaded before baking begins if it exists. This will allow you to 
continue baking an existing Global Illumination cache. You could, for example, extend an animation by setting your 
start and stop frames beyond those you have already baked and clicking Bake Global Illumination Scene. You could add 
just a single frame to the cache by selecting a frame and clicking Bake Global Illumination Frame.

Debug Display Options
The Show Nodes toggle shows the octree nodes that are used for storing the radiosity solution.

Lighting Considerations

Global Illumination must consider global illumination, which means accounting for all lighting, whether direct or 
indirect. This includes indirect light provided by the Environment light and its plugins, sometimes referred to as "sky 
lighting."

When the Global Illumination rays are fired, the color and brightness of the closest element hit by each ray (other than 
direct light sources, which are accounted for separately) are added into the global illumination for that point. It doesn’t 
matter if a ray hits another diffuse shaded polygon, a luminous polygon, or the backdrop - whatever is hit will be taken 
into account.

If the backdrop is blocked by objects, it won’t affect shading. For example, in a scene with an imaginary infinite ground 
plane object, the lower half of the backdrop gradient won’t matter since no rays will ever reach it. Similarly, when 
shading the floor of an enclosed room, only the areas of the backdrop seen through open doors, windows or skylights 
will contribute.

Moreover, with gradient backdrops, orientation matters. If the sky is dark blue at the zenith, but bright at the horizon, 
then the sides of an outdoor object may get more sky lighting than the top. This is because Global Illumination rays are 
fired more densely near the direction of the surface normal than around the base of the sampling hemisphere for each 
shaded point. Thus, light coming in perpendicularly is more important than light coming in at a glancing angle.

The baking process shows this clearly - in the grid bake shown on the left there are large expanses of 
nothing. Notice also that there are 4,698 locations to bake, adding to the time needed for a render of 
the cache. In the image on the right, we have returned the chair to within the room we are trying to 
bake. Already we can see that there are only 132 locations to bake and there will also be very little 
checkerboard because there are only a few openings (the windows).

1.

2.

3.

If your grid is taking longer to bake than you expect, check several things:

That the resolution and spacing of the grid is appropriate to the scene (no point baking extreme detail 
when it won't be seen)
The grid encompasses the bounding box for the scene. As the example in the wiki shows, don't have 
elements outside the area you are concentrating on
That you are not baking the grid to a slow network location


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Troubleshooting

“Blotchiness” in areas lit by Global Illumination occurs when different evaluations come up with different results. If the 
lighting environment is complex and there are not enough rays to properly sample it, then two or more nearby 
evaluations can be different enough to cause blotchiness. This can occur, for example, when Angular Tolerance is set 
too high.

Consider a scene lit only by a single luminous polygon. The smaller that polygon is (as seen from the surface being 
shaded), the larger the number of rays necessary to ensure that at least one of them hits it. If only one of two adjacent 
Global Illumination evaluations contains a ray that hits that polygon, then the other evaluation will result in a dark 
patch on the surface. You can minimize this effect by increasing the evenness of the environment - that is, making the 
luminous polygon bigger or dimmer or using more rays to increase the density of the sampling pattern.

The same principle applies to indirect lighting. A brightly lit area is very much like a luminous polygon as far as Global 
Illumination is concerned. For example, when shading a ceiling, more rays are required if the adjacent wall has a few 
tight spotlights shining on it than if the wall is lit by a broad floodlight. Specular highlights or caustics can also act as 
tiny indirect light sources that can require a higher sampling density.
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Render Properties - Volumetrics

This is the tab to use for volumetrics, both new style and legacy HyperVoxels. The original fog settings are here too. The 
settings are as follows:

Enable Volumetrics - Global switch for all scene volumetrics
Volumetric - Thisdropdown contains any third party volumetric solutions
Indirect Sampling - When this is enabled, Global Illumination (Indirect Lighting) will contribute to Volumetric 
shading
Indirect Samples - (Default 16) The quantity of samples to use for indirect sampling
Unseen by Camera - Hides all volumetrics in a scene (fog is not affected)
Use Legacy Volumetrics - If you would like to use the HyperVoxels that have come with LightWave in previous 
versions you will need to check this. You cannot mix old-style and new volumetrics in the same scene

Legacy Volumetrics can be found in the Effects panel (Ctrl F5) on the Legacy Volumetrics tab
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This cube HyperVoxel primitive has a non-pyroclastic texture to deform it and the Scattering color is light blue with a Scale 
of 400. The scene is lit by a direct light and GI taken from the gradient backdrop. The HyperVoxel on the left has Indirect 
Sampling on and the backdrop is contributing to lighting parts of the cube that are not illuminated by the direct light. The 
HV on the right has no Indirect Sampling and the tendrils around the edges aren't receiving direct light. The scene is in the 
content (Volumetric_Indirect_Sampling)

Fog

The Fog Type pop-up menu sets the characteristics of your fog.

Off - turns off the fog effect. The other fog types differ in how the effect falls off toward the camera
Linear - falls off in a linear manner
Nonlinear 1 - is somewhat more realistic in appearance, since the fog will appear to grow thicker with distance
Nonlinear 2 - has a steeper falloff curve
Realistic - generates realistic fog that works correctly with objects that have reflection, refraction and/or 
transparency that are inside the fog. Unlike the other fog modes, it has no exact limit to the fog range.

It’s important to realize that the Fog feature doesn’t actually calculate a wispy volumetric fog around objects, but rather 
changes the color of the objects to that color chosen as the Fog Color. As such, the backdrop will receive no amount of 
fog.

With Linear, fog is applied linearly between the Minimum Distance and Maximum Distance. Non-Linear 1 and 2 apply 
the fog amount more rapidly as they are moved away from the camera, then less so as they approach the maximum 
distance.

The Fog Color color gadget allows you to pick the fog color you wish to use.
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The Use Backdrop Color option causes an object to blend in with whatever backdrop you have set, including a 
background image. This can have the effect of making objects appear slightly transparent. Use this option to simulate 
the effects of an underwater environment or a hazy, foggy day with an appropriate Backdrop Color like bluish green for 
underwater and grayish white for a foggy day.

Volumetric Scattering

Volumetric Scattering is a scene-wide way of creating participating media - the dust that's required for volumetric 
lighting or "God rays". Turning on Use Volumetric Scattering here will fill the scene with electronic dust only visible to 
lights that have Affect Volumetrics engaged. You can alter the Color, Scattering Weight and Asymmetry here including 
setting envelopes for changes over time. Further modifications can be made in the node editor where a destination 
node for Scattering Color, Scattering Weight and Scattering Asymmetry allows for further customization. Volumetric 
rendering is no longer a post-process so incorporated directly into image rendering.

Note that Volumetric fog is part of the volumetric engine and thus blocks the alpha, unlike the fog in previous 
versions of LightWave


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Render Properties - Buffers

Buffers allows you to set up all the buffers you wish to export in a single window. By default, Final Render and Alpha are 
checked but compositors can choose the buffers they need for the package of their choice. All buffers are listed here.

Once a buffer has been selected Options become available.

Render Buffer - This duplicates the switch next to the buffer name in the upper part of the window
Adaptive Sampling - Always enabled for the Final_Render buffer, Adaptive Sampling can be enabled for other 
buffers. Buffers with Adaptive Sampling checked will be used to determine when more refinement is needed. 
This will increase render times but the benefit is reduced noise and smoother anti-aliasing
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Noise Filtering - Enables filtering for the specific buffer. Noise filtering must be engaged on the Render Tab for 
this to have an effect.
Use Custom Name - If unchecked, the name of the buffer will be the Buffer name as presented in the upper part 
of the window
Custom Name - Becomes unghosted if Use Custom Name is checked
Reconstruction Filter - This chooses the reconstruction filter used to rebuild the buffer. In previous versions of 
LightWave this setting was in Camera Properties, but is now available on a per-buffer basis

The complete Buffer list is described here.

Reconstruction Filters

The LightWave 3D renderer includes a full implementation of reconstruction filters. These filters determine how the 
rendering data is combined into a final image at a sub-pixel level in order to produce a final image. Reconstruction 
filters have been a subject of research over many years and the names of these filters are often derived from the 
research that led to their development. Reconstruction filters are not set on the Camera Properties panel, but rather per 
buffer in the Buffer tab of the Render Properties panel.

LightWave filters are outlined below:

Box

This is the most common form of filtering, and the method that most traditional applications use to reconstruct an 
image from raw rendering samples. These samples are simply places in a pixel “box” and averaged. Although this 
technique is fast, it can exhibit significant artifacts on motion and when there is fine image detail. From a signal 
processing point of view, this is a very poor technique for reconstructing an image from the raw data that comprises it. 
This mode is very close to the traditional LightWave modes.

Circle

Different buffers can have different filtering applied but beware of mixing different filters on buffers for the 
same render since it will be difficult and perhaps impossible to reconstruct a final image.


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Based on Box, it uses a 6x6 matrix based on the Filter Radius size. Anything within the filter radius is given full 
importance. Anything outside is cut off.

Triangle

Based on a cone with filtering taking place on pixels in a 6x6 matrix.

Gaussian

Gaussian filter based image construction takes the samples that compose the image and builds the final pixel data by 
weighting their contributions based on a Gaussian kernel of approximately one pixel in size. This technique typically 
performs quite well, although images tend to have a “soft” look. In practice this mode can be very valuable for video 
output where it can help hide some of the artifacts introduced by fielded or reduce bandwidth content.

Mitchell
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Mitchell filtering is a technique that is now very popular and was suggested as an alternative to Lanczos filtering (see 
below). It does not suffer many of the ringing artifacts of Lanczos filtering and generally is a very good starting point for 
most situations.

LanczosSinc

Lanczos filtering is arguably the technique that yields the closest to the perfect results for image reconstruction. This 
technique is based on a windowed sinc function (a sinc function being the optimal infinite image reconstruction filter). 
Unfortunately in practice Lanczos image reconstruction tends to produce overly emphasized edges and “ringing” in 
high contrast areas of the image.

Usage Tip

Box, Circle, Triangle and Gaussian may provide better results for moving images, whereas Mitchell and 
LanczosSinc may be more suited to stills due to their tendency to sharpen the image.


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Render Properties - Output

Click here to expand Table of Contents...

Saving Animation
Saving Individual Images

Selecting a Filename Format

Monitoring Progress
Viewing the Finished Image
Render Frame
Render Scene
Render Selected Object

This is where you decide just how you want to save your renders when you hit F10 to render your scene. You can save 
multiple image types - animations, still frames, alpha images - all at the same time at no extra cost in rendering time.

If you are network rendering, you will not be able to save an animation, only still frames.
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To choose a save type, just click on the tick box associated with it. This will open a file requester where you can choose 
a base filename and location. The file extension will be added according to your setting in the Output Filename Format 
drop down menu.

If you wish to change the base filename, just click on the File Type button (Animation, Image, Alpha) again. This will 
open the File Requester again and you can change the base name.You can turn on and turn off any of the save types 
without losing their settings.

Saving Animation

Saving Individual Images

You have several choices for saving images, you can either save them at 32-bit to have an included alpha, for those 
formats that support it; in 24-bit with no alpha or with a separate alpha file (by selecting the Alpha buffer output) or if 
you are working with HDR images, you have the choice – some formats support built-in alphas, some don’t (LightWave’s 
native FLX and the SGI 64-bit do; Cineon, Radiance and TIFF LogLuv don’t).

Selecting a Filename Format
LightWave 2019 creates filenames based on the buffers used and numbering automatically.

You don't need to name files at all. As you can see, the final filename is based on the Base Filename settings, in this case 
%buffername%_%###%.

The text, translated into English reads "name of the buffer type selected underscore three-digit number". Like this you 
can be sure that your buffers, and final images will be named appropriately. This Base filename can of course be 
customized. You could choose to name your files "Render_%######%" to have each file named Render with an 
underscore and a six-digit number. There are several possible automatic naming keywords, surrounded by % signs:

Name Buffer Tag Notes

Scene Name %scene% Adds the name of the scene to the filename

Camera Name %camera% Adds the name of the camera to the filename

Eye %eye% Adds R or L to the filename (R renders first)

If you are rendering using LWSN (including the new NRC), do not check "Use Preferences Output Path". Set the 
path explicitly.


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Name Buffer Tag Notes

Frame Width %framewidth% The rendered pixel width of the frame

Frame Height %frameheight% The rendered pixel height of the frame

Frame Number %###% As we could see from the second example above, the 
Frame Number keyword can be extended or 
contracted for as many frames as you have.

Frames per Second %fps% The scene's frames per second setting

Current Time %time% Adds the time in seconds (dependent on the scene's 
FPS) accurate to eight places

Buffer Name %buffername% The name of the buffer saved - a custom name can be 
set on the Buffers tab

There are safety nets:

A blank filename will default to: %buffername%_%###%
If a frame number tag is missing from the whole path, then this gets appended at the end: _%###%
If stereo is enabled and the whole path is missing an %eye% tag then the follow is inserted in front of the last 
frame tag: %eye%_

Monitoring Progress

Frame progress is complex to estimate from the start, so don’t be discouraged when you see a Frame Time Remaining 
that seems like your frame sequence is going to take months to complete. As LightWave understands more about what 
you are asking of it, the estimated render time will become more accurate. If you are rendering still frames using F9, 
then LightWave has to start from scratch every time it renders so you will always start with a high estimate that comes 
down over the course of rendering. If you are rendering a sequence with F10, LightWave can use the previous frames’ 
render time to better estimate how long the current frame will take (although obviously if you have something that 
causes a render time spike like motion blur or entering into a HyperVoxel field, that will throw off subsequent frames).

The Render Status Panel that appears when you render contains information about the settings used and can have an 
image of the render in progress at several different resolutions to give you some indication of what is going on.

(empty filename) becomes "%buffername%_%###%"
"BlahBlah" becomes "BlahBlah_%###%"
and with stereo
"BlahPath-%#%\BlahFile_%#%" becomes "BlahPath-%#%\BlahFile_%eye%_%#%"

The tags allow the parts of the filename to be configured, but in their absence a reasonable default is used. 
The placement of the %eye% tag with the _ matches the behavior of 2015.


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Rendering without a preview image will be a little faster than with one.
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The scale of the render preview is set In the Render Properties panel (Ctrl F9) on the General tab:

At any time you can cancel a render by hitting the Abort button or the Esc key. It may take a while for LightWave to 
respond depending on the speed of your machine and the complexity of the scene being rendered.
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Viewing the Finished Image

Before you start rendering, make sure you have the viewing option you want for the end of the render enabled. For 
rendering a sequence of images using F10, it’s certain that you will already have seen all your images and thus you can 
happily switch the Render Display to (none). Otherwise, you will want to see what you’ve done. Be warned that if you 
have no render display set, you won’t be able to change that once you start rendering. You will not be able to change 
viewing choices during the render or after it has been completed without requiring a new render.

Render Frame

(default keyboard shortcut F9)

To render the current frame, determined by the position of the frame slider, choose Render > Render Current Frame or 
press F9.

Render Scene

(default keyboard shortcut F10)

Select Render > Render Scene to render the entire scene using the defined range of frames on the Render Globals Panel, 
or press F10. Make sure Auto Frame Advance is set as desired!

Render Selected Object

(default keyboard shortcut F11)

You can render only the selected object(s) at the current frame by choosing Render > Render Selected Objects. 
Unselected objects can still cast shadows or be seen in reflections on the rendered objects.

The Render Status window is a modal window. You may not be able to access options on other windows until 
it is closed.



The Render Status window is a modal window. You may not be able to access options on other windows until 
it is closed.



The Render Status window is a modal window. You may not be able to access options on other windows until 
it is closed.


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If you are using LightWave on a Mac using OSX 10.7 or higher, Apple’s Exposé might interfere with LightWave’s 
default rendering keyboard shortcuts.


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Render Properties - Output - Saving Animation

AVI
QuickTime
Special Animation Types

Flexible Float / Integer
Storyboard / 4x Storyboard
FilmExpand
SpriteGen

Once you have chosen a base name for your animation you can choose a type. It’s a good idea to save an animation 
only in addition to, not instead of a file sequence. The reason for this is that in the case of a crash during a render you 
will have to re-render an animation from the start again, but with an image sequence you will be able to resume from 
the last frame rendered.

AVI
There are two AVI encoders in Output. You can choose from the system AVI that shows all system AVI codecs, or 
NewTek's own DirectShow AVI output.

QuickTime
Special Animation Types
Although most of the animation file types are self-explanatory, there are some that may require some explanation.

Flexible Float / Integer
NewTek experimental codecs for creating HDRI animation. They can only be played within LightWave itself.

Storyboard / 4x Storyboard
There are two storyboards in the list of file formats. They are unusual in the sense that they don’t make an animation, 
but rather a series of images as a storyboard. LightWave renders out each frame and pastes them together in grids of 
either 4 x 4 or 6 x 5 images, skipping every fifth frame. The standard storyboard makes a grid of 6 x 5 images with each 
image of 30 frames no bigger than the full individual image size (so a 640 x 480 storyboard frame will contain a grid of 30 
images that would normally be 640 x 480). The 4X Storyboard will composite the images together at the size you render 
at, making for large images if you render at video resolution.

A file sequence is easily made into an animation using LightWave. Simply use the sequence as a background 
image sequence in an empty scene. If you set the resolution the same as the original frame size and save an 
animation, you will rapidly convert your still frames into an animation.


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The 100 frames of this animation create three Storyboard images at 1280x720, or seven at 5120x2880 when using 4x 
Storyboard.

FilmExpand

This converts an animation from 24 fps (film speed) to 30 fps (NTSC video speed) by rendering 30 frames for every 24 of 
the original animation. The interpolation works best when you use Field Rendering (Camera Properties Panel). When 

If you are using either storyboard function in realistic render mode, it’s a good idea to turn off antialiasing and 
effects you may have activated, just so you can make the storyboards more quickly.


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you select Field Rendering, an Options Panel appears where you can select the type of image to save and set the field 
dominance. It only works for NTSC video, not PAL.

SpriteGen

SpriteGen is an output to create sprites for games. It will create a single image that can be referenced by game engines 
to provide animation in games. Its encoding options are as follows:

Tile Columns - The number of tiles across you want for your sprite sheet.
Tile Width - How wide each sprite will be. Your camera resolution will still be rendered at, then each frame will 
be sized to fit this number. Make the camera resolution much bigger and the render will take longer than it 
needs to. Make the camera resolution much smaller than your tile and the sprites will be pixelated.
Lock Aspect Ratio - With this checked, the Tile Height field is ghosted. If you want to have non-square sprites 
you can uncheck.
First Frame - The first frame of your sprite sequence.
Last Frame - The last frame of your sprite sequence.
Frame Step - Set at 1, LightWave will render each frame between first and last. It can be increased for stylistic 
reasons.
Premultiply Alpha - Checked by default, this will premultiply the alpha for the sprite making it fit against any 
background.
Type - The image type for the sprite sheet.
Animation File - A misnomer since the output is a single image.xxx
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QuickTime
Apple has never provided a 64-bit version of QuickTime for Windows systems, however LightWave has a pass-through 
that will make saving to QuickTime possible again on such systems. When saving a QuickTime animation you will note 
that a new icon appears in your taskbar labeled QT32_Server.

It’s not likely you’ll need to do anything with this application and it will quietly shut itself down when no longer needed. 
If you do need to you can open the window with a double-click on the taskbar icon, or a right click and choosing Open 
from the menu. You’ll get this window:

In which you can change the Shutdown time and see how ongoing jobs are proceeding.

When you select QuickTime as your output format clicking on the Encoding Options button will show the following 
window:

The first setting is Stereo and you can choose different types:
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The choices are:

None - Even if you are using a stereo camera, this outputs a flat QuickTime animation.
Right Frame Only - Only output the right eye camera for tests.
Side By Side - Outputs the left eye and right eye side-by-side to create a double-width QuickTime file.
File Name Left/Right - Outputs two movs, one for the left eye, one for the right.
Anaglyph - Produces an animation that can be viewed with red/blue glasses

Alpha is the next choice. It creates a QuickTime animation with integrated alpha channel.

QuickTime VR Object - QuickTime VR Objects are QuickTime movies that display an object from multiple views. Special 
data embedded in an otherwise ordinary movie tells QuickTime how to play through the frames of a movie as a viewer 
moves the mouse across the image. When the viewer moves the mouse down, the player skips a large number of frames 
to find one that corresponds to a view of the same side of the object, from a lower position. This can simulate rotating 
the object in space, if the views are right.

Once a scene with the appropriate camera and/or object movement is created, open up the Render Properties Panel 
and select QuickTime (.mov) under the File Format dropdown menu. Click the Encoding Options button to set the 
critical parameters for your animation.

The Compression Options button will invoke the standard QuickTime Compressor selection dialog. The choices are 
many and the differences subtle. The only relevant warning for QTVR is that you should set the compression to use 
keyframes at every frame, since these movies are not played in a linear fashion.

You can choose to render out a sequence in one of the Stereo types, but unless you have set up Stereoscopy in 
the Camera Properties window you will just get output that is "flat".


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1.

If you receive error messages telling you to install QuickTime like so:

even though you do have QuickTime installed, you need to edit your system path, so that QuickTime is nearer 
the start. This is a QuickTime problem rather than a LightWave one, and on Windows, it is resolved like so:

Right click on your computer icon and select Properties


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2.

3.

On the left-hand side of this window, click Advanced System Settings, which will take you to:

Choose the Advanced tab as shown.

Click Environment Variables to open the next window:

You need to select the Path as shown and click the Edit... button.
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VR Object Settings Tab
Columns (Pan Frames) - is the number of frames of horizontal views in the animation. If your view is from 0 
degrees at frame 0 to a full 360 degrees at frame 20 (the same view as 0°), then you will have 20 columns (frames 
000 to 019). In a typical movie, the row angle will step up after this many frames.
Start Pan and End Pan - These values set the angle range of the horizontal views.
Flip Horizontal Control - reverses the object’s direction of rotation with regard to horizontal mouse movement. 
In other words, if you drag the object left and it turns to the right, you need to change this setting (or reverse 
your entire animation!).
Rows (Tilt Frames) - is the number of frames of vertical views in the animation. In a QTVR Object Movie, the 
animation moves through all the pan frames in a row before moving to the next tilt frame, and does all the pan 
views again with that tilt.

If there are 20 pan frames (000 to 019, as above), the tilt angle will change every 20 frames, so sequential tilt 
values will be at frames 000, 020, 040, 060, etc. This means that your entire animation must be (tilt frames)*(pan 
frames) long.

Start Tilt and End Tilt - These values set the angle range of the vertical views.

Flip Vertical Control - reverses the direction of rotation of the object with regard to vertical mouse movement. If 
you drag the object up, and it rotates down, you need to change this setting.

VR Animation Settings
This tab sets some advanced QTVR options.

Frames Per View - sets the animation loop size that will run from each view. If this value is greater than one, 
then your animation should hold each pan view for this many frames, as the loop happens. This also means that 
your animation length must be multiplied by this number. You should not alter the pan or tilt frame counts; 
QTVR will handle that.
View States - The QTVR object format features an alternate state that can be displayed based on some user 
input, for example, when you click the mouse. The View States value supports this alternate state, but will also 

4. The Path gadget will present you with the complete system path in a single line. QuickTime will be in 
there somewhere and needs to be moved further to the start of the pathline. Copy and Paste the whole 
line to a decent text editor so that you don't go mad trying to edit in the single line.

The default Columns and Rows settings (20 x 20 = 400 frames) are more than enough for most uses and you 
may be able to use lower values to reduce the size of the file.



The Start and End settings may not seem to change simple viewing of the objects, but may be critical if the 
object is embedded in a larger QTVR world.


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multiply your animation frame count. These extra frames take the form of an entire identical animation of the 
object in an alternate state, appended onto the first. Currently, the QuickTime player appears to support only 
two usable states, not clicked and clicked. In theory, higher values could be used.

Example - Setting up a QuickTime VR Scene
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Render Status Settings

Frame Antialiasing Particle Blur RT Shadows

Current frame being 
rendered

Either a single number, or a pair of 
numbers when Adaptive Sampling is on 
in Camera Properties. The pair of 
numbers are the Minimum Samples and 
Maximum samples potentially taken

Whether

Frame Step Rec Filter Field Rendering RT Reflections

Resolution Adaptive Stereo Render RT Refractions

Pixel Aspect Motion Blur Radiosity Tile Size

Camera Name MB Amount Samples (Rl/Rf/SSS) Render Threads

Camera Type MB Subframes Depth of Field Output Files
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Distributed Rendering - An Introduction

Introduction

Distributed rendering is using the computer resources at your disposal to speed the rendering of frames across a 
network. If you have access to several machines, they can all be pressed into service as render slaves. It means that your 
main workstation can get on with more creative work while machines that are going unused get on with rendering.

LightWave 2018 added a rapid, modern network render controller (NRC) that intelligently seeks render nodes across a 
network and applies them to the task of rendering your scenes.

NRC Installation — Installing NRC for Windows and Mac with additional options
Preparing Scenes for NRC rendering — Before you start trying to render on a network, make sure your scene will work
NRC Interoperability — Running NRC in a heterogeneous network
Screamernet

NRC Tutorial

Machines do not need the full LightWave installation to act as render nodes for an NRC render farm. When 
installing LightWave there is an option for installing purely the aspects needed for a render node. Any 
machines on your local network can be pressed into service when there's rendering to be done.



Layout ScreamerNet Controller is now deprecated in favor of the NRC system, but instructions are left for 
people wishing to troubleshoot existing ScreamerNet installations or create new ones.


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NRC Installation

Click here to expand Table of Contents...
Introduction
Windows

Advanced Options
Type of Service
Logging
Windows Service
Discovery Fallback Port
Service Identifier

Mac OS X
Advanced Options
Type of Service
Logging
Discovery Fallback Port
Service Identifier
UNC Mapping Folder

Introduction

LightWave 2019's distributed rendering system, the Network Render Controller - hereafter referred to as NRC - is a 
modern, GUI-based network controller designed to make network rendering simple to set up and control.

The NRC controller and Service are installed with LightWave. These two elements have questions asked about them at 
installation time:

Windows

Advanced Options


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The first is whether you want to set advanced options for the service. If you select No, the controller will run as a Task 
Tray service on demand with the default System Console logging option.

Type of Service

Those advanced options are whether you want to run the service on demand, or as a Windows service when the 
machine boots for the LightWave user. If you choose Task Tray, you will then be asked:

Logging
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Where the log file gets saved/displayed. Be aware that if you choose System Console the log file is truncated to 
whatever is in the NRC log window at whatever length you set it to in the NRC window. For a permanent log, select Log 
File and a path will be asked for next. Once complete, you will move to Discovery Fallback Port.

Windows Service
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If you chose Windows Service you will be asked if the service should run under a user account, chosen in the next step 
(06), the NETWORK Service account - a limited account that deals exclusively with network-related tasks or the SYSTEM 
account that has more privileges than an Administrator account. We strongly recommend you do not use this type of 
account. Once completed here you will be sent to the Logging section.

Discovery Fallback Port
Once LightWave is installed, Bonjour is used by default to discover render nodes. In the NRC preferences you can 
uncheck Use Bonjour services to discover nodes, but if you choose not to use the Bonjour network discovery method 
for render nodes you will use IPv4 discovery. If, however, your network requires the default port number of 29572 to be 
changed, this needs to be set up when installing LightWave.
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Service Identifier

Last is the name for the Service identifier - how your machine will appear to the NRC.

Once LightWave is installed, the name you supplied for the Service Identifier will be used by any controllers on your 
network to automatically find your machine and press it into service as a render node.

Mac OS X

Advanced Options
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When installing LightWave you are asked if you'd like to configure advanced options for NRC. If you select No, the 
controller will run on demand when started with the default System Console logging option.

Type of Service

If you select Yes for Advanced options, you can choose between a Login Process (the default) or as a System Service. 
The advantages and limitations of both are listed onscreen.

Logging
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Once Next is clicked, Logging options will be presented. The System Console will be limited to the settings in the NRC 
Controller Log view, but a permanent log file can be created on disk with the Log File option (04). The content level for 
the log is chosen below.

Discovery Fallback Port
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If you choose not to use the default Bonjour node discovery service in the Controller Preferences, you can specify an 
IPv4 address instead. This address can be changed at installation if it conflicts with an address already in use.

Service Identifier

Specify the name by which you which to identify a machine's NRC service when viewed through the controller.
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UNC Mapping Folder

Lastly, for operating NRC on a mixed network of PCs and Macs, you can specify how UNC pathnames will be mapped to 
OS X Unix-style pathnames.

If you need to change the name of a an already installed node running on Windows, make sure the NRC tasker 
isn't running. Then, visit C:\ProgramData\NRC and look for a file whose name starts config_ followed by a 
hexadecimal number. Open this file in a text editor. The line starting id= is the name of your render node. You 
can change the name as you like, but keep the name length to below 60 characters.


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2.

3.

Preparing Scenes for NRC rendering

Click here to expand Table of Contents...

Introduction
Render checklist

Assets
Simulation
Output

UNC Paths

Introduction

Preparing a scene for distributed rendering requires a certain rigor that is not necessary when all assets are local to the 
machine rendering them. While Layout will complain if it can't find an asset or plugin and allow user interaction to find 
the right file, rendering on a network is not interactive. You must adhere to LightWave's content directory structure, and 
elements that use random numbers need to be fixed (baked) to ensure identical rendering across different machines. 
Also, since you will be relying on machines that are not the one you are sitting in front of, you need to be sure that not 
only is everything accessible across a network, but that it can be written to as well as read from. NRC is not going to ask 
if it can't find something, it will plow ahead assuming what you did was intentional.

Render checklist

Go through the scene before you "send it to the farm" to be sure that:

Assets
All assets used for scenes need to be accessible to all nodes rendering. At the simplest, this entails using the 
Package Scene tool to make sure all your scene assets are contained within a content directory, then moving 
that content directory to somewhere accessible to all nodes on the network. 

Simulation
All simulations must be baked. By simulation, we are referring to anything in the scene that requires random 
numbers, including radiosity solutions and dynamics (Bullet, FX dynamics, including particles, and Flocking). To 
bake simulations, refer to the documentation for those sections and using MDDs or other Vertex Caching 
mechanisms. 

Output

All output paths need to be correct. The output path should be manually defined to ensure correct operation for 
a network render. Don't leave it to the default Use Preferences Output Path. If you are rendering with a Mac-

https://docs.lightwave3d.com/display/LW2020/Baking+Radiosity
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based farm, Unix-style paths will be used. If rendering on a mixed farm, Unix paths will be translated internally to 
UNC paths for the Windows machines in the farm.
Make sure that your output format is what you want at the end of the render - network rendering cannot write 
animations, you need to be sure that your scene length is correctly set and the right buffers are being saved to 
the paths indicated.

UNC Paths

For Windows users, the best way to ensure network discoverability is to use UNC path conventions. Render networks 
using purely Windows machine can use drive mapping, but this is prone to failure if all drives are not mapped the same 
way. UNC paths are, like drive mapping, unique to Windows. However, NRC can translate UNC paths to Unix-style paths 
internally, meaning that they are ideal for cross-platform rendering. UNC paths are created starting with a double 
backslash, then the machine name, drive letter and directory, like this example:

\\machine\drive\directory\subdirectory\file.ext

A Windows machine will understand such a path implictly. Mac OS X machines using NRC will see the following:

/Volumes/drive/directory/subdirectory/file.ext

This enables cross-platform communication between Windows and Mac OS X.
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NRC Interoperability
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Introduction

LightWave's NRC tool takes care of everything to allow Macs and Windows PCs to render scenes together in total 
harmony, but there are a couple of things you need to do to ensure smooth operation. Like all network rendering, care 
needs to be taken with paths, etc. as covered here.

NRC can be run in heterogenous render farms where there are Macs and Windows PCs. You can render the same scene 
on OS X and Windows render nodes.  However, OSX doesn't support Microsoft UNC paths, so NRC has to translate UNC 
paths internally to the Unix style required by the Mac in a render farm using both operating systems.

To get OS X and Windows to render the same scene, you must use the UNC format for the shared network paths.  The 
NRC Service under OS X will automatically map UNC paths to mounted paths in the /Volumes folder by default. If you 
changed this directory during installation, that will be used instead of /Volumes.  The host name (the first component of 
the UNC path) should be the top-level folder name under /Volumes, and the remainder of the path should be visible 
under there.

For example, if you have the following UNC path as a render task in the NRC Controller:

\\sikun\NewTek\NewContent\Scenes\Toys\Toys_2018.lws

This path will be sent to the OS X node, and the NRC Service will try to find a mounted share called /Volumes/NewTek
under which it will expect to find /NewContent/Scenes/Toys/Toys_2018.lws.

If you correctly use UNC paths when you configure render tasks in the NRC Controller, and you map the correct paths 
in /Volumes under OS X (using the "Go -> Connect to Server..." option in the Finder), the NRC Controller will render the 
same task on heterogeneous render nodes (OS X and Windows) simultaneously.

NRC for the Macintosh requires at least version 10.7.5 (Lion) of OSX to run
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Elements to organize

Configs
In a folder designated for the purpose, copy your <user>\.NewTek\<LightWave 
version>\LW2019.x-64.CFG and Extension Cache-64 files on a Windows PC, and <user>/Library/
Application Support/NewTek/<LightWave version>/Layout 2019.x and Extension Cache on a 
Macintosh.

Plugins
The whole support folder should copied to osx and windows subfolders. The support folder not only includes 
LightWave's own plugins and third party plugins, but also support programs for Layout and Modeler. Setting up 
such a system requires more attention, see here.

Content
Content needs to be created for network rendering - render paths should be defined and not left to the "Use 
Preferences Output Path" switch, even if rendering to the content's own directory. All dynamic content needs 
to be baked including radiosity and dynamics solutions, as covered here.
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Screamernet
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Introduction

The distributed rendering program that is packaged with LightWave is called ScreamerNet. It uses Layout’s Network 
Rendering Panel (Render > Network Render) to control submitting scenes to networked computers running the 
ScreamerNet process. ScreamerNet can control up to 1,000 CPUs. Each CPU takes a frame, renders it, and then grabs 
the next available frame in the animation until the scene is complete.

Are You Talking to Me?
Before ScreamerNet is discussed, your computers must be talking to each other, which means they need to be 
networked together. Setting up a network is beyond the scope of these instructions, though the experience can be quite 
rewarding.

Share and Share Alike
Once you have created your network and the computers are talking to each other, you’re ready for the next step. On our 
render farm, let’s say that we have four computers (Pig, Horse, Cow, and Chicken) networked together. (For now, 
imagine that they are all single CPU machines.)

Screamernet is now deprecated in favor of the NRC system, but instructions are left here for people wishing to 
troubleshoot existing Screamernet installations or create new ones.

Screamernet OSX - Instructions for Mac OS systems



Since ScreamerNet communicates by writing files, NetBEUI and TCP/IP are not required. As long as each 
machine can see each other and write files across the network, ScreamerNet should function properly.



If you are network-deprived, you still can use ScreamerNet to batch-render multiple scenes on a single 
computer. See the Batch Rendering on One Computer information near the end of this chapter.


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In a ScreamerNet setup, you designate one of the computers as the control or host machine. It hands out the rendering 
assignments, (called jobs), to the nodes (the CPUs on the network used for rendering). The host must have LightWave 
installed on it.

In this scenario, Pig will be the control machine. Node machines do not need any NewTek software or hardware on 
them.

For ScreamerNet to work, all the nodes need to access specific files. Of course, all the nodes need to share the scene file 
and all its accompanying data including object and image files. If you’re organized, all these will be tucked away in your 
LightWave Content directory. Also, the nodes need to save the rendered frames to a shared directory. Each node must 
be able to load a plugin configuration file (LWEXT2018.CFG) that has the plugin files mapped with a path that the node 
can access. Finally, the ScreamerNet command program, (LWSN.EXE), needs to be visible to all the nodes.

Perhaps some of the confusion about setting up a ScreamerNet system arises because there is more than one way to 
organize a sharing scheme and you may have read tutorials that herald one method over another. If set up properly, all 
the schemes will work. So depending on your situation and disposition, you should choose the most suitable one for 
you.

Windows Setup

Drive Mapping
To share, data must be at a unique address that all the nodes on the network can access. Normally, your scene file is 
sitting in your LightWave Content directory, which is typically on your C drive. In our case, the scene, oldmacdonald.lws, 
would be in Pig, the host computer. Now in our animal farm network, Pig, as the host, would distribute out a rendering 
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job that said, “Render oldmacdonald.lws that is on the C drive.” The problem is that when Horse gets that instruction, it 
looks on its C drive and can’t find the scene. So Horse says, “neigh.” It cannot render a scene that it can’t find.

The solution is to map a unique network drive (or drives) that contains all the necessary LightWave files. Normally, 
these files will be on the host computer. If that is your case, go to your host computer and from your Start menu Open 
your computer. You should see your drives and the Map Network Drive icon above.

In the panel, when you specify a drive letter, make sure that it is unused by any of the computers on your network. For 
example, Pig might only use five drive letters, A to E, so letters F to Z are available. But Chicken may have a dozen hard 
drives on its computer, which means it is using drive letters A to L. If you mapped a drive on Pig with the letter G, 
Chicken could still be confused. In our situation, we’ll pick S for the drive letter.

Next, you specify the folder that you want to connect to this drive letter. There are two schools of thought about the 
folder. The orderly and efficient approach makes a folder with only the necessary files in it and attaches it to the 
mapped drive letter. The “kitchen sink” method simply picks the hard drive LightWave is in and selects that as the 
folder. For example, on Pig, LightWave is on the C drive. In the Map Network Drive panel, you would click Browse… next 
to the Folder entry box. Under Microsoft Windows Network, go to Pig and highlight the C drive. Click OK. The Folder box 
would read \\Pig\C.
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Now if you want to be more elegant about your mapped drive, you can just map your LightWave folder. The process is 
the same, right click on the Network Places icon, choose Map Network Drive… and specify a unique drive letter. This 
time when you browse for a folder to attach, select your LightWave folder.

Both of the above methods assume that all the necessary files are in your mapped drive. If you’re organized, then all of 
your objects and images will be in your Content folder. Back in the old days of the 20th Century when humongous hard 
drives were nine gigabytes and drive space was scarce, often you would store your rendered frames on another drive. If 
your scene accesses any data from other drives or stores frames elsewhere, then those folders must be accessible to the 
network nodes. That means that you will need to map more drives.

For another way of sharing folders, Matt Gorner, in an exhaustive, informative ScreamerNet tutorial available , shuns 
the drive mapping technique. In his method, (which you should read about directly), he simply sets up network sharing 
access of his LightWave folder. Matt goes into great detail about the whole process.

Since all the computers on your network need to share files with this mapped drive, you will need to map that drive on 
all your computers. After you have, you can test the connection by copying files into that drive from the node 
computers.

Organizing Configuration Files

Unfortunately, we are not finished with this job. But before we move on, let’s discuss alternatives for content 
directories. Often you will read about ScreamerNet setups that construct two file directories, one specifically for 
ScreamerNet and another for when you don’t use ScreamerNet. This is a great deal of extra trouble to go to, given that 
you’ll see no difference in running LightWave on your workstation under a setup for ScreamerNet, and when you decide 
to render across your network, you’ll be ready to go without having to relocate a set of files for the scene in question. Of 
course, if you prefer that approach, then Matt Gorner explains a nifty way of organizing a dual setup.

The next steps involve changing certain LightWave configuration files so that they are ScreamerNet-friendly. Before you 
do, you should get those files where you can see them. Start by creating a new folder in your LightWave directory called 
Config. Now, click on the My Computer icon and do a search for LWEXT2018.CFG, (the plugin configuration file), and 
move it to the Config folder. It will be in the %USERPROFILE%\.NewTek\LightWave\2018 folder if you just want to go 
directly there. Do the same for the LW2018.cfg file.
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Next, you need to point LightWave to that Config folder when you start the program. On your Windows desktop or in 
your Start menu, right-click on the Layout icon and select Properties.

Depending on your setup, in the Target box, it will say something like:

C:\LightWave\bin\Layout.exe

This points to Layout’s program file.

If you have set up the Config folder, change this line to read:

C:\LightWave\bin\Layout.exe -cc:\LightWave\config
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The first part is unchanged. The second part, ( -cc:\LightWave\config), tells LightWave where to look for the 
configuration files. The -c is the config cue. The rest (c:\LightWave\config) is simply the path. 

Command Directory

When you run ScreamerNet, the host sends out Job files to the nodes and receives Ack (Acknowledgement) files back. 
You need to set up a Command directory to store these files. So, in your LightWave directory, create a new folder titled 
Command.

This is a command between you and your host computer so the path does not need to reflect the network 
mapped drive letters. Though if you want to remain consistent, than you would write this Target command in 
ScreamerNet terms. In our case, it would then read:

S:\LightWave\Programs\lightwav.exe -cS:\LightWave\config

Please notice that there is no space between the -c and path name.


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Now open up Layout on your host computer. Click on the Render Tab and under Utilities, click on Network Render. In 
the Network Rendering Panel, click on Command Directory and locate the newly created Command folder on your 
mapped drive. In our case, S:\LightWave\Command.A message pops up that says,

ScreamerNet must be reinitialized whenever the command directory is changed. Initialize 
now?

Click Yes. You can then close the Network Render Panel.
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Next, click Edit > Set Content Directory. Choose the content directory on your mapped drive, in our case, S:
\LightWave\Content.

Finally, you need to remap your plugins. And again, there are two methods. The search and replace technique involves 
opening the LWEXT2018.cfg file in a text editor. The lines would originally look like this:

    { Entry
      Class “AnimLoaderHandler”
      Name “AVI(.avi)”
     Module “C:\\lightwave\\plugins\\input-output\\avi.p”}
     { Entry
      Class “AnimLoaderHandler”
      Name “DirectShow(.avi)”
     Module “C:\\\\lightwave\\plugins\\utility\\dvview.p”}

You would search for C: and replace it with your mapped drive letter. In our case, it would be S:. Save your changes and 
you’re done. This method is great if you like to dig in there, get your hands dirty and see exactly what you are doing.

In Matt Gorner’s solution, you click on the Utilities Tab in Layout and select Edit Plugins. Clear all your existing plugins 
and in the panel, choose Scan Directory. Browse to your mapped drive and highlight the support\Plugins folder. Hit OK 
and an Add Plugins window will pop up. Now, if you open the LWEXT2018.cfg file in a text editor, you should see that all 
of the plugins have been remapped to the network drive.

To save the changes to the configuration files, you need to quit LightWave. When you start it up again, the new 
configurations will be loaded.

Setting up ScreamerNet

All right, now that you have all the necessary files configured and in folders that can be accessed by all the nodes, it is 
time to set up ScreamerNet itself. In our example, we have four computers in our ScreamerNet render farm. Pig is the 
host and will be handing out directions to the other three rendering nodes. To keep organized, you will assign a unique 
number to each node.

To initialise a node for ScreamerNet, you need to create a separate file that you will store and run on each node. It 
should be a text document called startlwsn_node.bat. Open it up in a text editor and set it to read:

    cd S:\LightWave\Programs
    LWSN.exe -2 -cS:\LightWave\Config S:\LightWave\Command\job1 S:
\LightWave\Command\ack1

You can use this example as a guide. It consists of two lines (everything from LWSN.exe to ack1 is the second line). Edit it 
to fit your specific setup and save it with a new name. Each computer that is a rendering node needs this file on it. You 
can call it whatever you want, just remember to keep the .bat extension. Be creative - YouScreamIScream.bat or 
SpeedKills.bat.

Since being the Host computer is not too taxing, you probably also will want to use it as a rendering node.
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The first line indicates where to find the lwsn.exe program. The second line begins by running the ScreamerNet 
program in –2 mode. (There are –3 and -5 modes that are explained later.) Simply, leave this part of the line as it is.

Next is a –c command, which indicates where to find the configuration files. If you have been following along, you will 
have set up a Config folder and moved your LW2018.cfg and LWEXT2018.cfg files there. If it is located elsewhere, change 
this path.

The next path tells ScreamerNet where to find the job commands. Again, if you have been following along, you have 
created a Command folder and changed the Command Directory path in Layout. The last path simply indicates where 
the acknowledgement (ack) files are located. The numbers after job and ack indicate the node that is running this batch 
file. Each node has a unique number. Usually, if you are using the host computer as a rendering node, you assign it 
number 1. So, its batch file would read job1 and ack1. In our case, Pig would be node 1. You then number the other 
nodes. For example, Horse would be 2, Cow would be 3, and Chicken would be 4.

Each of the computers on your network needs a copy of this node initialization batch file customized to it. For example 
Horse’s file would read:

    cd S:\LightWave\Programs
    LWSN.exe -2 -cS:\LightWave\Config S:\LightWave\Command\job2 S:
\LightWave\Command\ack2

Cow’s would say:

    cd S:\LightWave\Programs
    LWSN.exe -2 -cS:\LightWave\Config S:\LightWave\Command\job3 S:
\LightWave\Command\ack3

If any of the computers have more than one processor, or a processor with multiple cores, then you could use multiple 
batch files and set each computer to rendering multiple frames. Let’s say Chicken is a dual processor machine. You 
might create one file for each processor. The first might read:

    cd S:\LightWave\Programs
    LWSN.exe -2 -cS:\LightWave\Config S:\LightWave\Command\job4 S:
\LightWave\Command\ack4

The other would say:

    cd S:\LightWave\Programs
    LWSN.exe -2 -cS:\LightWave\Config S:\LightWave\Command\job5 S:
\LightWave\Command\ack5

Obviously, you would have to name the batch files differently, such as StartNode4.bat and StartNode5.bat.

The main issue with dividing up your computers in this way is that they may have multiple processors but only one 
stock of RAM. If your scene is light you can get benefit from making multiple batch files per computer, otherwise it’s 
probably better not to these days.

When you have all the batch files placed on the node computers, create a shortcut for them on the desktop of the host 
computer.
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Show Time

You are about ready to make the magic happen. Go back to your host computer, open Layout and load the scene that 
you want to render over the network. Make sure that the Content directory is set to the mapped drive.

Under the Render Tab, open up the Render Globals Panel. Sometimes, you may not want to render all the frames in the 
scene. What you can do is set the Render First Frame and Render Last Frame fields to the desired range of frames. Make 
sure that you have Auto Frame Advance checked. Also, check Save RGB. Remember, ScreamerNet only renders 
individual frames. It will not render animation files. In the RGB Files field, indicate the network-mapped path of where 
you are saving files. For example, S:\LightWave\Frames.

Save the scene.

Once the scene(s) are saved, click on the Render Tab and Network Render. The number that you enter in the Maximum 
CPU Number field should be the highest number node that you will be using. For example, if we would be using just 
node 1 (Pig) and node 2 (Horse), you would enter 2. But let’s say that Horse wasn’t available but Cow was. Even though, 
you are still using only two nodes, you would enter 3 so that ScreamerNet would look for node number 3, which is Cow.

Now go to the node computers and click on the batch file icons that you created. A black MS-DOS window will open up 
and before you can start reading what it says, a continuous flow of repeating messages will probably begin. Depending 
on your exact setup, the message will read like:

Can’t open S:\LightWave\Command\job1

This will be normal until LightWave initializes ScreamerNet. Once you have started all your nodes, return to Layout and 
click on the Screamer Init button.

You can batch render scenes in ScreamerNet. So you could save a scene and then go back and change it (for 
example, to render a different range of frames) and then save the scene with another name.


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After a brief pause, you will receive a confirmation of the number of CPUs detected and the Screamer Init field will say 
Ready.
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Now, if you look back at the node’s MS-DOS window, the message will say Init and then Wait. The nodes are waiting for 
their job commands.

In the Network Rendering Panel, click on Add Scene to List and find the scene or scenes. They will be displayed in the 
Scene List in the order they were selected. Notice that the List indicates the First and Last Frame to render, the frame 
advance Step, and the % of those frames that have been rendered.

If you added a scene by mistake, highlight it and click Remove Scene. If you want to remove all the scenes, click Clear 
List.
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When the list is complete, click on Screamer Render. The job commands will be sent to the nodes, which are waiting in 
line. Node 1 receives the first frame, node 2 will take the second, and so on down the queue. If you look back at the 
node’s window, you will see it document its progress in the render.

As soon as a node finishes a frame, it receives the job to render the next available frame in the scene. When the scene is 
completed, ScreamerNet jumps to the next scene in the list.

When you are finished rendering all the scenes and are ready to close ScreamerNet, click the Screamer Shutdown 
button. A panel will pop up that says, “Are you sure you want to shut down the ScreamerNet CPUs?” If you choose Yes, 
the nodes are closed and their MS-DOS windows disappear. Now, if you wish to start a new session, you must restart 
ScreamerNet on each CPU and re-initialize the CPUs from the host machine.

If you want to stop rendering before ScreamerNet is finished, press the Esc key to abort the session. A message will 
appear in the Screamer Init window saying, “Waiting for CPUs to finish rendering.” If the scene is complex or one of your 
nodes is slow, waiting could take a quite a while.

Screamernet Time Flag

A new flag has been added to Screamernet with different operation in the main two modes. In -2 mode, the -t value 
indicates the polling time for the job file (how often it should be checked for new commands). In -3 mode, there’s no 
concept of a “job” file, so -t is used to indicate the frequency of diagnostic output during a render.

Installing Nodes

When installing Screamernet nodes for LightWave 2018, make sure that the Microsoft Visual C++ 2008 SP1 
Redistributable Package is installed on each render machine running LWSN.exe. Normally, this package gets installed 
along with LightWave when using the LightWave installer. However, not everyone uses the installer when setting up 
LWSN.exe on a render node.

For a LightWave 2018 render machine running a 64-bit version of Windows, install the Microsoft Visual C++ 2008 SP1 
Redistributable Package (x64). For a LightWave 2018 render machine running a 32-bit version of Windows, install the .

Rendering Without LightWave

The LWSN program has a third option that lets you render a scene without running LightWave. There is no control 
machine and thus it is not a distributed rendering situation. You must tell the program specifically what to render. The 
method is run from a DOS prompt using the following syntax (one line):

You may wish to check some of the first frames in a photo editing program to see if they are what you expect. If 
you are having problems, please read the Troubleshooting section below.



If you are impatient, there is no elegant way to force the nodes to quit in mid render. If you can’t wait, you can 
close LightWave by hitting Ctrl + Alt +Del, clicking the Task Manager button, highlighting LightWave and 
selecting End Task. Then, you can stop each node by closing its MS-DOS window. It’s brutal, but it works.



If you close the MS-DOS window on any of the render nodes, you may have to restart all nodes and re-initialize 
them.


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1.

2.

3.

4.

5.

6.

7.

    LWSN -3 [-c<config dir>] [-d<content dir>] <scene file> <first frame> <last frame> 
[<frame step>]

As you can see, you supply the program with the basic information needed to render a scene. An example would be:

    LWSN -3 -cS:\Lightwave\Config -dS:\Lightwave\Content oldmacdonald.lws 1 900 1

In the example, the program would render frames 1 through 900 of the oldmacdonald.lws scene using the config files 
stored in the S:\Lightwave\Config and using S:\Lightwave\Content as the Content Directory.

Preparing Scenes for Screamernet

Since Screamernet is designed to function without interaction it is important that you prepare scenes completely 
before submitting them to your farm. This means making sure all your objects and images load correctly and that all 
your rendering and saving options are set before you go. Here’s a simple checklist:

Are you using LightWave’s content directory for your scene? If you are unsure, use the File > Package Scene tool 
to create a new content directory and populate it with the scene you currently have loaded.
Have you set your camera’s properties correctly? Do you want Depth of Field or Stereo? Now is the time to 
decide because once you send your scene to the farm, the only way to make that “Oh, I forgot such and such” 
change is to stop the farm and start it again. Make sure your anti-aliasing is sufficient.
Have you set your output options? Screamernet can’t save animations, so make sure that each frame’s images 
are being saved in a suitable format.
Are you using any third-party plugins? Make sure that your nodes have the plugins too, otherwise the renders 
will fail.
Have you locked your configs? To be sure they don’t get overwritten while rendering, making sure your config 
files are read-only. Also, turn off Autoscanning plugins in Options.
Have you baked? Things like flocking, dynamics and even deformations are best baked to MDD files to ensure 
they are exactly the same across your render nodes. It also means that those nodes only need to render final 
images and not mess with dynamics calculations.
Have you set a frame range? This one is last since it’s not something you will always do, but Screamernet renders 
whatever range has been set up in the scene. If you’d like some nodes to render the scene backwards and some 
forwards to meet in the middle, set a frame range for it and save a different scene file.

Troubleshooting and Limitations

The most common cause of ScreamerNet crashing is when too many nodes try to write or read their information to or 
from the host computer while the host renders. If that seems to be the case, try saving the frames to a mapped network 
drive on another computer. You will have to go back to your scene and redirect the path for saving frames. Of course, 
make sure that the new drive has enough space to store the frames.

If that doesn’t solve your crashing problems, do not use the host machine as a render node. Use it only as a server 
where the hard drives are found.

ScreamerNet can be finicky about how filenames and directories are composed. Putting spaces in a name, for example, 
old macdonald.lws, might cause a problem. Try using a dash, -, or an underscore, _, instead of spaces, 

You can get the syntax for ScreamerNet by simply typing LWSN with no arguments.
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old_macdonald.lws. You should also never use accented characters such as é, à or ç since there is no guarantee that 
these characters will all be rendered correctly through your farm.

Some plugins don’t like running with more than one thread. For ScreamerNet scenes, go to the Render Globals Panel, (R
ender > Options > Render Globals). In the Multithreading drop down menu, change to 1 Thread, and save the scene. Quit 
LightWave and start it again. This will update the configuration files. You then will need to restart all the nodes so they 
will read the updated configuration files.

Hopefully everything is running smoothly, but problems can occur, usually because something is setup wrong. Some of 
the main problems that arise are listed here along with possible remedies.

The biggest limitation to ScreamerNet are plugins that are not written to take advantage of it. I’m not aware of a 
definitive list of all the ones which do and don’t work. If in doubt read the documentation that came with the plugin, it 
should say whether it has problems or not. If it doesn’t say but the plugin still doesn’t seem to work, re-scan your 
plugins to update the LWEXT2018.cfg file. If it still doesn’t work then chances are it’s not compatible with ScreamerNet.

If your scene uses procedural textures (fractal noise etc.) you may experience differences in the pattern if you render on 
machines with different processors. Mixing old and new processors; AMD and Intel; could lead to problems. This is really 
only a problem with animations as textures could suddenly change from frame to frame, if in doubt run a test or use all 
computers with the same processor type.

Problem - “My nodes can’t find the job files.”
Possible solution - They can’t find the job files because they can’t see the Command folder, which holds them. 
So open up the node batch file and check the script lines that end in job and ack. Make sure that pathname 
before these words point to your Command folder. 

Also check that all the render node computers have access to read and write to the folder.

Problem - “My nodes seem fine but when I press Screamer Init it can’t find any CPUs.”
Possible solution - Again this is a command folder problem, check that the Network Render Panel has the same 
Command Directory path as the nodes batch file. Also check that the host computer has access to read and write 
to the folder.

Problem - “Rendering seems to be working but no files are saved.”
Possible solution - The messages output in the node’s MS-DOS window will often give you a clue to the problem. 
For example, it might say that it could not find an object or image that was in the scene. This can be caused 
when the Content directory that the rendering node is accessing does not contain all the scene’s data. Check 
that the render batch files are looking in the correct place for the config files, and that they can access the folder 
on the network.

Next, make sure your scene file is saving RGB files and not an animation (.MOV / .AVI etc.) in the Output Tab of 
the Render Globals Panel. ScreamerNet can ONLY save individual frames.

Finally, check that your plugins (LWEXT2018.cfg) file is up-to-date by re-scanning the plugins using the 
pathname all the nodes will be using to find them on the network.

Problem - “Rendering seems to work okay but all my saved files are in .FLX format.”
Possible solution - There are two possible reasons. The first is that ScreamerNet can’t find the plugin to save in 
the format you’ve specified, so check that your plugins (LWEXT2018.cfg) file is up to date by re-scanning the 
plugins using the pathname all the nodes will be using to find them on the network. Also check that the render 
batch files are looking in the correct place for the config files, and that they can access the folder on the network.
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The second reason is that the render node that saved the file ran out of memory to load the saver plugin so, as a 
last resort, it used the built-in FLX saver.

If you have a whole scene’s worth of FLX images, you can use LightWave to convert them into your desired 
format. Simply load the series as a sequence of images for the Backdrop in a blank scene and render in the 
proper format. If you only need to convert a few FLX images, load them into the Image Editor Panel . Highlight 
the name of an image and double-click on the preview, (or just double-click on the name), to open it up in the 
Image Viewer . Now, click on File > Save RGBA , and pick your format.

Problem - “My particles aren’t working.”
Possible solution - Particles are a mathematical simulation. Therefore, each computer would start calculating 
the particles at the start of each frame rendered. The way to fix this is to “bake” the motion of the particles. You 
need to save the particle FX calculation to disk (as a .PFX file) in the folder with the scene file, or to a mapped 
drive that can be seen by all the networked computers.

Problem - “Motion designer isn’t working.”
Possible solution - Same as particles, this is a mathematical issue. The way to handle this is to bake the motion, 
and save the motion designer calculation to disk (as a .MDD file) in the folder with the scene file.
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1.

Screamernet OSX

Click here to expand Table of Contents...
Introduction
Updating LightWave’s Config Files
LightWave’s Config File Path on Mac OS X
Creating a New Set of Config Files
Config Settings for LWSN

Content Directory
Command Directory

Starting an LWSN Session
Rendering Mode
-c Config Directory
-d Content Directory
-l Log File
-q Quiet Mode
-t Time Check Interval

Batch/Network Mode (-2) Command Line Syntax
Job File
Ack File

Standalone Mode (-3) Command Line Syntax
Scene File
Frames to Render

Mac Alternatives

Introduction
LightWave’s LWSN (LightWave ScreamerNet) allows standalone, batch and network rendering across multiple 
platforms including Mac OS X.

LightWave’s Config Files are plain text files that store basic configuration information for LightWave and LWSN. It’s very 
important that you know where these config files are located so that both LightWave and LWSN can access them. It’s 
also important to understand which LWSN relevant settings are stored in the config file, and how to use them.

The explanation in these docs is mainly written by Mike Scaramozzino from DreamLight Interactive and are published 
here with his kind permission. Mike has spent many years rendering using Screamernet and has created a tool to make 
it all much easier with no use of Terminal required. Visit his site at and check out the DLI_SNUB-Launcher.

Updating LightWave’s Config Files
LightWave only updates the config file when you quit the program. Therefore anytime you make changes to any of the 
config settings you must be sure to quit LightWave to ensure that the changes are written to the config file itself. LWSN 
only reads the config file when first launched. Therefore, if you wish to make changes to the config file for LWSN and you 
are using a single config file for both Lightwave and LWSN, you should perform the following steps:

Quit LWSN.



Screamernet is now deprecated in favor of the NRC system, but instructions are left here for people wishing to 
troubleshoot existing Screamernet installations or create new ones.


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Launch LightWave.
Make changes to the desired config settings in LightWave, as discussed later.
Quit LightWave to write the changes out to the config file.
Launch LWSN again so it reads the updated config file.
Launch LightWave again if you are using the built-in network controller to manage LWSN.

LightWave’s Config File Path on Mac OS X
On Mac OS X the default location of the config files is:

YourHD/Users/username/Library/Preferences

Replace YourHD with the name of your hard drive where your home directory is located and replace username with your 
user name.

Keep in mind that, by default, the config files are stored in the Library:Preferences folder that’s inside your home folder, 
not in the Library:Preferences folder at the top level your system hard drive.The config files for LightWave 2019 on Mac 
OS X are named as follows:

Extensions 2019 - Complete list of file paths to all available plugins
Hub 2019 - Basic Hub Settings
Layout 2019 - Basic Layout Settings
Modeler 2019 - Basic Modeler Settings

You don’t need to specify any of these config files by name, only the path to the directory where they are stored, and 
that’s only if you decide to keep your config files in a location other than the default. If you leave the config files in their 
default location, you do not need to specify their path for LightWave, Modeler, the Hub, or for LWSN. In this case each 
individual Mac OS X user would also have their own configs, since they would be stored in each user’s home folder.

You may wish to store your configs in different locations in some advanced situations, such as:

When running different versions of LightWave on the same machine.
When different users use the same Mac and you all wish to use a single set of configs.
When running ScreamerNet over a network with a common set of configs for all nodes.
When running ScreamerNet over a network and using separate configs for machines with varying resources, 
such as available RAM or number of processors.

Creating a New Set of Config Files
The following steps will show you how you can easily create a fresh new set of config files in a new location if desired.

Locate your LightWave installation, typically: YourHD:Applications:NewTek:LightWave2019
Inside the LightWave2019 directory, create a new directory named Preferences.
Start Layout and Modeler and quit them. You will find your Preferences folder contains config files for LightWave.

If you run into various problems with LightWave and suspect corrupted config files, you can delete them and use the 
above steps to recreate a fresh new set of config files in their current location.

Config Settings for LWSN
The following settings are stored in the LightWave Config file named: LightWave Layout 2019 Prefs and are used by 
LWSN: Content Directory, Command Directory, Default Segment Memory, and Multithreading.

Content Directory
ContentDirectory YourHD:Applications:LightWave2019:Content:Along with a full complement of paths to the Content 
Directory’s special subdirectories, such as :Images, :Objects, :Scenes, etc. If you wish to use LWSN successfully you must 
learn to properly use LightWave’s Content Directory structure to package your projects correctly.
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A Content Directory in LightWave is very similar to a Web site’s root directory. When used properly, all necessary file 
paths are specified relative to the root directory, and all files are located in subdirectories of the root directory. This 
means the root directory is a self contained unit that may be moved as desired, including to other machines, without 
breaking all the dependent file/directory links.

In LightWave, the Content Directory itself may be named whatever you like, but there are some specific subdirectories 
that LightWave expects to find inside the Content Directory that you should not rename or move. These special 
subdirectories are named Images, Scenes & Objects. They are where you should store all your image, scene and object 
files respectively, for a project. You may name your files anything you wish (being sure to use proper file extensions), as 
long as you place them in the proper subdirectories.

Command Directory
CommandDirectory YourHD:Applications:LightWave2019:bin:The Command Directory is the directory that contains the 
job command file and the acknowledgement file. These are two plain text files that the network controller uses to 
communicate with an instance of LWSN during batch or network rendering.

The communication goes like this:

The network controller creates a job file.
The network controller writes a command into the job file.
LWSN reads the command from the job file.
LWSN attempts to perform the command.
LWSN creates an acknowledgment file.
LWSN writes a reply to the acknowledgment file.
The controller reads the reply from the acknowledgment file to decide what to do next.

These files are named: job# and ack# where # is replaced with the number of the LWSN node to control. If only one 
instance of LWSN is being used these files would be named job1 and ack1. For a second instance of LWSN, they would 
be named job2 and ack2, and so on. As in config files, no “.txt” extension is used. Also note that there is no leading zero, 
space or anything else between the number and the words job or ack.

LightWave defaults the Command Directory to the LightWave bin Directory. LWSN on Mac OS X however uses the 
Content directory as the default Command Directory. This means it will not run as configured with the defaults, you 
must at least change one of these two settings.

Both the user running the network controller (typically LightWave or a third party controller) and the user running 
LWSN (if different) must have read/write access to the same Command Directory. Non-administrator users don’t 
typically have write access to the Applications directories on Mac OS X. Therefore, it is suggested to use a shared 
Content Directory, with read/write access for all users, and keep everything relative to this shared Content Directory, 
including my Command Directory.

A typical Content Directory , with its own Commands directory may look like this:

Here’s a step-by-step example of how to configure such a simple self contained Content Directory with its own 
Command Directory.

Launch LightWave.
Set LightWave’s Content Directory with: Edit > Set Content Directory… to your desired Content directory, or by 
loading the scene you want to render.
Select Utilities > Network Render .
Click the Command Directory button.
Navigate to the same Content Directory you set in step 2.
Create a new folder named Commands inside the Content Directory.
Click the Choose button to close the dialog and accept the changes.
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If asked to initialize the ScreamerNet, click No.
Quit LightWave to save your changes to the config file.
When using the Terminal to launch Screamernet (fully explained later) use the following Content relative 
command file paths, replacing # with the number of the LWSN node: 

“:Commands:job#” “:Commands:ack#”

Starting an LWSN Session
ScreamerNet lwsn is a Unix executable that runs in the Mac OS X Terminal. You can use a variety of command line 
parameters to manually configure and launch lwsn in Terminal.

There are a few common command line parameters that are used to tell ScreamerNet lwsn what to do. The following 
general command line parameters may be used when running ScreamerNet lwsn in any mode. Additional mode specific 
command line parameters are discussed later.

The general command line syntax is as follows, all on one line.

<mode#> [-c<config directory>] [-d<content directory>] [-l<log file>] [-q] [-t] 

Rendering Mode
-<mode#> : The mode number parameter specifies which rendering mode to use.

-2 - Signifies batch or network rendering mode which may render multiple scenes on multiple nodes.
-3 - Signifies standalone rendering mode which renders a single scene on a single node.

-c Config Directory
-c - Optional: Path to the folder that contains the config file.

An example of this parameter with the initially searched Config Directory path is as follows:

-c”/Applications/NewTek/LightWave3D2019/Preferences”

-d Content Directory
-d - Optional: Path to the folder that contains your content.

An example of this parameter with a sample Content Directory path could be as follows:

-d”/Users/username/Documents/LWContent”

Where username should be replaced with the current user name. This example would be to use a folder named 
LWContent in your Documents folder as your content folder. If this option is not specified, the content directory 
defaults to the content directory specified in the config file through LightWave. Therefore, if you set your content 
directory in LightWave itself, and you have ScreamerNet lwsn on the same machine using the same config file as 
LightWave (which it does by default), you do not need to specify this option in the ScreamerNet lwsn terminal 
command line, unless you wish to use a content directory that is different than the one currently set in 
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LightWave. You would also need to specify this path if you were running ScreamerNet lwsn on a different 
machine than you are running LightWave.

Please review Config Files: Content Directory, for important information about using LightWave’s Content Directory 
properly.

-l Log File
-l - Optional: Path to a text file to write the ScreamerNet lwsn output into.

An example of this parameter with a sample Log File path could be as follows:

-l”/Users/username/Documents/LWContent/ScreamerNetLog.txt”

Where username should be replaced with the current user name. This example would use a Log File named 
ScreamerNetLog.txt in a LWContent folder in the current user’s Documents folder. If this option is not specified 
then the text messages generated as output would appear in the Mac OS X terminal window that is running 
ScreamerNet lwsn. The current user must have read/write permissions for this file.

-q Quiet Mode
-q - Optional: Suppresses terminal output during frame rendering, still reports as each frame finishes.

Normally while ScreamerNet lwsn is busy rendering it outputs quite a bit of text information to the terminal 
interface. This can be useful for monitoring progress and troubleshooting problems such as missing plug-ins, 
etc. Once everything is up and running however, all this text writing to the terminal may be unnecessary. The -q 
parameter turns off all the output during the rendering of an individual frame. You’ll still get text output during 
the scene loading and between rendered frames, but not during frame rendering.

Here’s an example of what the output for one frame normally looks like, without the -q parameter:
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Scene loaded.
Allocating frame buffers.
Allocating segment buffers.
Frame: 1.
Segment: 1/1.
Pass: 1/1.
Updating geometry.
Moving DLI_Floor_01F (1).
Moving DLI_SuperBall_01H.
Moving DLI_Floor_01F (2).
Preprocessing Frame....
Computing preliminary radiosity solution....
Rendering frame 1, segment 1/1, pass 1/1.
Image Reconstruction.
Image Reconstruction : 0%.
Image Reconstruction : 4%.
Image Reconstruction : 8%.
Image Reconstruction : 13%.
Image Reconstruction : 17%.
Image Reconstruction : 22%.
Image Reconstruction : 26%.
Image Reconstruction : 31%.
Image Reconstruction : 35%.
Image Reconstruction : 40%.
Image Reconstruction : 44%.
Image Reconstruction : 49%.
Image Reconstruction : 53%.
Image Reconstruction : 58%.
Image Reconstruction : 62%.
Image Reconstruction : 67%.
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Image Reconstruction : 71%.
Image Reconstruction : 75%.
Image Reconstruction : 80%.
Image Reconstruction : 84%.
Image Reconstruction : 89%.
Image Reconstruction : 93%.
Image Reconstruction : 98%.
Freeing segment buffers.
Allocating filter buffer.
Freeing filter buffer.
Allocating segment buffers.
Writing RGB image to /Users/user/Documents/DLI_SuperBalls/Renders/DLI_LW-
SuperBalls-Anim_001.jpg.
Frame completed.
Last Frame Rendered: 1.
Rendering Time: 1m 9s (69.3 seconds).
Freeing segment buffers.
Freeing frame buffers.

Here’s what the the same output looks like with the -q parameter included:

Scene loaded.
Last Frame Rendered: 1.

-t Time Check Interval
-t - Optional: Time check interval in seconds.

An example of this parameter with a sample Time Check Interval could be as follows:

-t60

This sample would have ScreamerNet lwsn attempt to check the job file every 60 seconds for status or abort 
commands when rendering in batch/network mode -2. Other commands in mode -2 are ignored. When 
rendering in standalone mode-3 ScreamerNet lwsn would report its current status every 60 seconds.

Normally, once ScreamerNet lwsn begins rendering a frame, it does not check the job file for any further 
instructions until the frame finishes rendering. During the initial setup and testing of your render farm or when 
testing a new scene, it may be useful to allow ScreamerNet to check the job file for abort or status commands. 
Particularly if individual frames take a long time to render. This way, if you notice a problem at the beginning of 
rendering (a missing plug-in for instance), you can abort the rendering without having to wait for all your nodes 
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to finish rendering an entire frame each or force quitting each node.

For instance, if your frames use ray tracing, area lights, radiosity, caustics, high antialiasing levels, motion blur 
and/or depth of field, they may take a long time to render. In this case you could set -t to 60 seconds, then 
ScreamerNet would try to check the job file every 60 seconds to see if the job should be aborted or if status 
information should be written to the output. During certain processing, ScreamerNet may still take longer than 
60 seconds before it can check, but it doesn’t have to wait for an entire frame to render before being able to stop 
or report status. Once you are sure everything is running smoothly, it is best to remove this option, so that no 
extra time is taken checking the job file or reporting status unnecessarily, especially if you are network rendering 
many frames.

Batch/Network Mode (-2) Command Line Syntax
The batch & network mode (-2) specific command line syntax is as follows, all on one line.

-2 [-c<config directory>] [-d<content directory>] [-l<log file>] [-q]

[-t<check interval>] <job file> <ack file>

The first five parameters are explained above under General ScreamerNet Command Line Syntax.

Job File
<job file> - job# File path & node number for lwsn to read commands from.

A sample job file path could be as follows:

“/Users/username/Documents/DLI_SuperBalls/Commands/job1”

This example reads the job1 text file in a Commands folder in a DLI_SuperBalls folder in the user’s Documents 
folder, where username should be replaced with the current user name.

The number should immediately follow the word “job” without any spaces and there must be no file extension, 
such as “.txt” added to the end of the path.

Make sure that your job# and ack# both use the same number. This number is what actually determines the CPU 
number of the ScreamerNet node so that the ScreamerNet network controller may communicate with this lwsn 
render node.

Ack File
<ack file> - ack# (acknowledgment) File path & node number for lwsn to write replies to.

A sample ack file path could be as follows:
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“/Users/username/Documents/DLI_SuperBalls/Commands/ack1”

This example writes to the ack1 file in a Commands folder in a DLI_Superballs folder in the user’s Documents 
folder, where username should be replaced with the current user name. The current user must have read/write 
permissions for this file.

Standalone Mode (-3) Command Line Syntax
The standalone mode (-3) specific command line syntax is as follows, all on one line.

-3 [-c<config directory>] [-d<content directory>] [-l<log file>] [-q] <scene file> 
<first frame> <last frame> [<frame step>]

The first five parameters are explained above under General ScreamerNet Command Line Syntax.

Scene File
<scene file> - Full path to the scene file.

A sample of a full scene path could be as follows:

“/Users/username/Documents/DLI_SuperBalls/Scenes/SuperBalls-Anim.lws”

Where username is replaced with the current user name. Be sure to use a full path to the scene file rather than a 
Content Directory relative path because Content Directory relative paths may not work on some versions of 
ScreamerNet UB lwsn on the Mac. Also be sure to enclose the entire path in double quotes, especially if it 
contains spaces or other special characters.

Frames to Render
<first frame> - First frame to render. Normally less than last frame but may be greater than last frame if frame 
step is negative.
<last frame> - Last frame to render. Normally greater than or equal to first frame but may be less than first frame 
if frame step is negative.
[<frame step>] - Optional: defaults to 1, may be positive or negative.

Frame step specifies which frames to render between the first and last frame, and in what order. When set to 1, 
ScreamerNet would render every frame from the first frame, up to the last frame. When set to 2, ScreamerNet 
would render every other frame from the first frame up to the last frame. If set to -1, ScreamerNet would render 
every frame from the first frame, down to the last frame and in this case the first frame should be greater than 
the last frame to render in reverse order.

Mac Alternatives
For using Screamernet on the Macintosh, Dreamlight Interactive’s DLI_DSNUB Launcher is a simple drag and drop 
configurator for Screamernet, removing the need to use the Terminal.

http://dreamlight.com/shop/dli-snub-launcher-lightwave-3d-network-rendering/
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NRC Tasker

The NRC Tasker is the tool that lets NRC know a machine is ready to render. By default, when you install as a render 
node, it is started at login when you boot the machine. It is recognized by a green LightWave icon in the Windows 
taskbar or the Macintosh Dock. In a normal install, you are asked at the end of the install procedure if you'd like to start 
the NRC Tasker.

Once you have started the Tasker, you can right click on the green LightWave icon and set the NRC Tasker to start at 
Login.
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Send to NRC

This script on the Render Tab in Layout will take a scene from Layout and add it to the scene queue in the NRC 
controller window. You need to be sure that a scene is in a proper content directory with output paths set for the 
automatic render start to work.
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NRC Controller

Click here to expand Table of Contents...

Introduction
NRC Controller Interface

Menus
Config
Shared Plugins Directory
Validate Environment
Nodes
Scenes

Framing and Ordering
Throttling
NRC Tutorial

Introduction

Once installed on the machines in your network, the next thing to do is feed your Network Renderer with nodes and 
scenes. Nodes are the machines on your network running LightWave 2019 or that have the LightWave 2019 rendernode 
installation. If the rendernode hasn't been automatically started by the installer, or is not running for whatever reason, 
find the Network Render Controller Service 2019.x (64-bit) (NRC Tasker) in your Start menu.

The Service puts a green LightWave icon in your Task Tray. Right-clicking it offers two options:

Start at Login - This will start the service once the user has logged in at boot-time. The entry will then have a 
check and selecting it a second time will remove the check and the service will only be started on demand.
Quit - Stops the service. The machine on which it was running will no longer appear to the NRC
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NRC Controller Interface

1 Menus, 2 Configs, 3 Nodes, 4 Scenes

Menus

The NRC has three menus, File, View and Help. The File menu contains just the Quit command (Ctrl-Q) and the NRC can 
also normally be quit by closing the window. The Help menu contains the links to the pages you are reading now.

The View menu contains two options:

You can drag and drop scenes up from the Scenes section onto Nodes, or drag Nodes onto scenes
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Log
Shows the Log window.

The icons at the bottom left indicate the severity of information messages presented. From the left they are:

Informational -  General activity messages like loading scenes, rendering frames and the like
Warning - Messages containing "can't find"
Error - Messages prefixed with "Error"
Fatal - Exception messages (code runtime errors)

NRC Preferences
Config

Here is where you will set your initial paths - for content and for plugins. Care should be taken to use a path that all 
nodes in your network can access. The use of UNC-style path naming is strongly recommended as it is unambiguous, 
reliable and will work across Windows and OS X machines for NRC. Mapped network drives are also permissible for 
Windows-only farms provided the same drive name has been used across the network.

Shared Plugins Directory
The Shared Plugin Directory is where the plugins your render nodes will use live. If the field has a red tint, check your 
plugins using the Manage Plugins button. This needs careful attention when you are working in a rendering 
environment with both Windows machines and Macs. More detail is given on the Shared Plugins Directory page.

Validate Environment
Once your nodes have been set up and tasked with scenes to render, clicking the Validate Environment button should 
hopefully get you green across the board for your nodes, plugins, configs and content. Any time you get a red dot you 
should verify before starting the render.
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For the Validate Environment button to be available the following conditions must be met:

A single scene must be selected
A node or nodes must be selected
The Config field must have a value
The Plug-in path must have a value
The selected scene must have a content path
The selected scene must have an output path

Nodes

This section contains the machines on your network that are running the LightWave NRC service. There are four 
columns here:

OS - The OS of the node
Node ID - The Identifier for the node as defined at install time
Task Scene - The scene or scenes that nodes have been tasked with

You can drag and drop scenes up from the Scenes section onto Nodes
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Screamernet Status - What the node is doing right now. Before it is tasked, the node will have a status of Ready

At the bottom of this section are four buttons:

Start Node - Once a Node has been tasked, hitting this button will start the selected node or nodes on the 
allotted tasks
Start All/Selected Nodes - Starts all Nodes, or those that have been selected
Stop Node - Stops the selected nodes immediately
Stop All Nodes - Stops all nodes immediately

Scenes

The scene queue. Scenes in here are setup for rendering and are tasked to selected nodes by dragging the scene onto 
them.

Framing - When checked, the first and last frames of the scene will be rendered before any of the others
Scene - Name of the scene file
Start/Range - The start frame value, or range if an arbitrary range has been set
End - The end frame. Empty if an arbitrary range has been set
Step - The frequency of frames to render, 1 means every frame, 2 means every other frame and so on
Progress - How far through the scene has been rendered

The Scene Content Directory should be filled in automatically for each scene but can be overridden. Likewise, the 
Image Output Directory will normally be blank for using the scene's own path, but can equally be overridden.

The NRC Controller now uses the following heuristics when auto-determining the Image Output path for a 
new scene:

1. If an explicit override path has been defined in the NRC Controller preferences, that is used, and any values in the 
scene file are summarily ignored;

Note that stopping nodes also clears their render queues

You can drag and drop Nodes onto scenes



LightWave 2020  –  LightWave 2020

Reference –  2809

•

•
•
•

2. If all defined output paths for all active buffers point to the same location, then that path is used;
3. If the (legacy) 'SaveRGBImagesPrefix' value is set, then its path value is used;
4. If the 'ContentDir' value is present in the scene, then it is used;
5. Finally, the scene file's derived content directory (same value placed into the 'Scene Content Directory' field) will be 
duplicated into the 'Image Output Directory' field, if feasible.

There are four buttons here:

Add Scene(s)... - Scenes are added to the queue

Remove Scene - Scenes are removed from the queue
Start Render - Starts all nodes associated with the selected scene rendering
Stop Render - Stops the selected scene rendering. If more scenes are queued, work will start on them instead

When a scene is in progress, right-clicking on it will give a context menu with a render preview

Framing and Ordering

When a scene is loaded into the NRC, there are several options for rendering it in addition to scene settings.

Scenes can now be dragged and dropped onto the Scene window of NRC.

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The first is a Framing checkbox. This will render the first and last frames of the sequence before any of the others to set 
the bounds of the rendered sequence. The second is the fact that the frame start and end points can be double-clicked 
and modified. Render sequences can be in reverse or arbitrary frames rendered.

Throttling

Normally you want to take full advantage of the machines in your network to render your scene at full speed. However, 
if said machines also perform other functions, rather than taking them over completely, you can throttle LightWave's 
use. It will make renders slower - and the machines - but it won't use all their resources. When setting up the scene, visit 
the Render Tab in Render Properties and turn off Automatic Multithreading. Set the number of cores to whatever you 
think will be safe to allow continued use of the nodes for other purposes.

NRC Tutorial

This tutorial walks you through the simplest setup but also covers heterogeneous farms.
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NRC Preferences

The NRC Preferences are well-explained in the interface:

Tasks

If you tick the first two boxes here, you can have an automatically-fired renderfarm. In Layout, on the Render tab, there 
is a command Send to NRC. Loading a scene in Layout and setting it up for a network render then hitting that button 
will result in your scene getting "sent to the farm" and rendering starting leaving Layout free to carry on. No more 
waiting for a render before you can carry on working.

Scenes

Scenes sent to NRC through Layout should be in complete content directories, otherwise, the NRC Scene 
Content Directory entry won't be filled, and nodes won't get assigned scenes or automatically start rendering


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Scenes can have their path settings overridden by the options here.

The Organize output into subfolders by task name option will render the auto-assigned Output path unique per task 
by appending the task name.  Output for the task will then go into that subfolder in the common output path to avoid 
name collisions (and likely file overwriting). It only applies when the Output auto-assign option is enabled.

Previews



LightWave 2020  –  LightWave 2020

Reference –  2813

This option, enabled by default, means that right-clicking on a selected scene while it is rendering will give you a 
preview of frames completed.

Queue

•
•

The Render Output will only be available only if all the following conditions are met:

The Controller can access your image output path
The format used is supported for the preview (JPG, PNG, TGA, TIFF or BMP)


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The Controller can be configured to watch a folder for submissions (from the Layout "Send to NRC" script). The 
Controller must be running, and that folder setting must have been written into the Controller's config so the script can 
read it and know where to send scenes for rendering. There is an option to remove finished scenes. This kind of 
automatic setting is best used in conjunction with the settings on the Tasks tab.

Nodes



LightWave 2020  –  LightWave 2020

Reference –  2815

The next tab used to be called Discovery and is now called Nodes. By default, NRC uses the Bonjour service for 
discovery, but you can turn this service off (a restart of the NRC controller is required) if for some reason Bonjour fails to 
operate properly, or you would prefer to use a standard IPv4 way of locating nodes. A default port number is provided.

If this number is not suitable for your network, render nodes will need to be reinstalled with an appropriate port 
number chosen during installation in the advanced NRC options.
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If you have turned off Bonjour, an option new to 2019.1 becomes available, Enable Pick Up Nodes. As the explanatory 
text states, checking this button allows you to enter an IP address (v4 or v6) in the main NRC Controller interface to 
access a machine anywhere on the Internet and was added to allow people within a corporate intranet to access a 
different segment where their render machines may be sitting. It is not designed to create a global render network, 
although you can try.

When Enable Pick Up Nodes is checked, a new button appears in the Controller window called Discover Nodes.
Discover Nodes uses a "well-known" port (which is the default value in prefs).  If you change the port number in 
Preferences, you have to be sure to match it on each build slave, or you won't see anything. The Pick-Up node field can 
take an ip address, a range (IPv4 only) or a URL and you can add subnets with a dash (e.g., 10.38.1.110-115). This 
replaces the previous Scan for Nodes button that manually forced a scan for IPv4 nodes.
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Bonjour on, Bonjour off
Interface
The penultimate tab relates to NRC Interface options:
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 The options provided deal with minimizing the window to the taskbar on minimize or close.

Monitoring

Added in LightWave is a page for controlling how you will monitor your NRC with an Android or Apple phone 
or tablet.
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•
•

•

•

•

•

•
•

Items on this tab are as follows:

NRC Key - Unique identifier for the NRC Controller generated on the first run
NRC Identifier - Human-readable name for the controller (optional). If none is set here or in the mobile app, the 
NRC key value will be used instead
Enable Monitoring - This needs to be checked for monitoring to work at all, and should be checked before you 
start rendering. Once checked, there are two further options:

Direct Access - The default access method for monitoring; this requires that you open an IP address and 
specific port in your Windows services.msc tool. This method allows viewing of rendered images

Server Port - The default port number is 4431

Hosted - A more limited way of monitoring. Image viewing is not available with this method. Hosted links 
to an NT-hosted NoSQL server that keeps the log results of NRC. If you choose Hosted, further options 
appear:

Manually - Only when you request an update
Automatically - You can specify an interval between 5 and 60 seconds (default 10 seconds)

Getting started with the app
Android
The Google Play store has the application under the name NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

iOS
The App Store is where to go to get the iOS version of NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

Starting the app for Android or iOS for the first time presents a screen urging the user to create a server to monitor:



LightWave 2020  –  LightWave 2020

Reference –  2820

As the message says, hitting the + icon at the bottom of the screen will open a new window where you can add an NRC 
Key - all that's necessary for the monitor to function. Adding an Identifier is optional, and in any case, your device will 
refer to the specific controller by its NRC key. If you enter an Identifier here, it will propagate to the Controller on your 
Windows or Mac desktop machine where you are running NRC; the same is true in the other direction.
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To add a controller, you need an NRC key first, which can be found in the NRC Controller preferences window > 
Monitoring tab. Copy this carefully onto the app and then proceed with your choice of Direct, or Hosted modes

Direct
You will need to enter an IP address along with the port number to be used. Until you have something that the NRC 
Monitor is happy with, you will see the following icon on the controller card:
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Once the connection is made, the bar will be removed:

Hosted
With Hosted mode, the NRC Monitor links to an NT-hosted NoSQL server that keeps the log results of NRC. The same 
iconography shows whether the connection has succeeded or not:

Here there have been no tasks assigned to the renderfarm yet.

If your controller resolutely refuses to connect and you can't get rid of the bar even though you're sure you've 
done everything right, shut down the app and the NRC Controller and restart both. That usually unblocks 
them.


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Using the App
Once you have your controller added, with no bar, it's time to start your scenes working. Both Direct and Hosted work 
the same way to begin with. Both have the same cards showing an overview of how many tasks have been assigned. 
You can tap on this card to see an overview of individual tasks:
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When a task is started, as shown left above, it will have no renders to show hence the line through the eye icon. Once 
renders are available the eye will be unbarred and can be clicked on to show previews of rendered images, right. Each 
buffer is treated as a separate task inside the scene.
With Hosted mode, the eyeball will always be barred because images cannot be previewed. In Direct mode, when the 
eyeball becomes unbarred you can click on the card to see thumbnails of all images rendered so far, and clicking on a 
thumbnail will display a full-scale image.

The three-dot menu on the right of each card will show the log for the task
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NRC Log
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Shared Plugins Directory

Managing plugins should be a simple task of verifying that all render nodes have access to the shared plugins directory. 
If, however, you are running a render farm over both platforms, you should know that LightWave needs a config file for 
plugins (Extension Cache-64 on the PC, Extension Cache on the Mac) to tell render nodes where to find the 
plugins they will need for operation.

Make sure that the "cross-platform" switch is checked for mixed platform render farms
In this example, a drive shared between Windows and OSX machines in this network contains the configs, content and 
plugins necessary for operation. As previously stated, the configs directory contains the config files from both 
platforms, since the names don't collide. The plugins folder has two subdirectories - osx and windows and each contain 
the entire support directory from the LightWave installations on the respective platforms.

If you are running a render farm on a network of homogeneous operating systems - all Windows PCs or all 
Macs - the following explanation is not needed. You still need to make sure your nodes all have access to the 
shared plugins directory over the network.


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This animated GIF shows paths for configs and plugins on a mixed platform farm with a Windows controller
Our goal is to ensure that the plugins can be read from their directories and to do so requires editing of the extension 
cache config file. NRC will do this automatically, backing up the original configs.
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At the end of the animation we can see a warning that the original Extension Cache file will be overwritten. The starting 
version of this file is retained and called Extension Cache.original.

Options

The options for replacing the path for the plugins config are as follows. Hitting Apply or Enter will make the change to 
the Extension Cache file. If you wish to check the changes, hit Tab instead.

Replace All Paths - The option most used. Will globally replace the 'Path Prefix' text found in each path entry 
with whatever is entered here
Replace Prior To - Will change the Path Prefix prior to the keyword entered
Replace Regexp - Will use Regular Expressions to edit the path
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• Replace Components - Will replace whatever is in the top field of the pair with whatever is in the bottom field of 
the pair. Multiple items can be replaced in this way as shown with a comma (,) separator
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Image Viewer

1 Titlebar Pixel Information
2 File Menu
3 Metadata
4 Save Color Space
5 Save Alpha Color Space
6 Magnify
7 Display Color Space
8 Normalize
9 Image Layer
10 Buffer Layer
11 RGBA
Image Control Panel
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The Image Viewer is used throughout LightWave (Render Display, Image Editor, etc.) to show an image using colors up 
to the capabilities of your computer’s display. Once open, you do not need to close the Image Viewer window. In fact, if 
you do, any unsaved images will be lost.

The Image Viewer can hold multiple images, depending on how it is used by LightWave. You can switch between 
multiple images using the Layer pop-up menu (or the keyboard shortcuts PG Up and PG Dn). 1. Titlebar Pixel 
Information, 2. File Menu, 3. Metadata, 4. Save Color Space, 5. Save Alpha Color Space, 6. Magnify, 7. Display Color 
Space, 8. Normalize, 9. Image Layer, 10. Buffer Layer, 11. RGBA

You can choose to see the regular image or whatever buffers you have rendered using the Image pop-up menu in the 
upper-right corner.
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1 Titlebar Pixel Information

If you click and drag your mouse pointer over the image, information about the pixel beneath the pointer will appear in 
the titlebar. The first set of values is the X and Y position. This is followed by RGBA color information for non-floating-
point images. For floating-point images, percentages are used.

 

You can adjust the size of the window by dragging any corner. Any time the entire image is not fully visible in the viewer 
window, use the scrollbars or hold the Alt key to scroll around. The Metadata panel will open when you click on the 
Metadata button. Metadata is information about the image and can be stored with the image.

2 File Menu

Using the File pop-up menu, you can save the current image to a file.There are several different ways of saving a file:

Save RGBA - The default option. Use this to save any kind of image (8 bits per channel up to floating point). 
Versions of savers with built-in Alpha channels are referred to as 32, while those without are 24. Images without 
a 24 or 32 are saved without Alpha.
Save Exposed - if you use the Image Viewer Image Controls you can define a new Black Point and White Point for 
your image. If you wish to save this version use Save Exposed.
Save Resampled - Asks for a filename first then opens a window where you can choose the size you want, with 
optional locked aspect.

Save All Buffers - Saves all rendered buffers for an image in one operation. Buffers will be named with the 
format NAME_BUFFERNAME.
Copy to Clipboard - Hitting Ctrl C will copy the current Image Viewer layer to the clipboard so that it can be 
added to an image editor.
Frame Buffer - Sends the current layer to a dedicated frame buffer such as a DV camera. Once a device has been 
selected, Auto-send and Send options become available.
Stereo - Shows Stereo images in different ways:
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None - Images not shown in stereo
Anaglyph - To be viewed with red/blue glasses
3D Glasses - To be viewed with NVidia stereo glasses or similar
Side by Side - Views left and right images side by side

Image Controls - Opens the Image Controls window detailed below.
Clear Current Layer - Deletes the layer being shown
Clear All Layers - Deletes all layers in the Image Viewer

3 Metadata

Presents a window containing EXIF data for the render. Detailed information on the render is in the Maker Note 
hierarchy.

4 Save Color Space

Allows you to choose a color space for files saved to disk.

5 Save Alpha Color Space

Allows you to choose a color space for alpha channel files saved to disk.

6 Magnify

The Magnify menu has several settings that will affect the magnification level of the image. You may also press the plus (+)
or minus (-) key to increase or decrease the level of magnification. If the entire image is not visible in the window, 
holding the Alt key down as you drag on the window will scroll the image around.

7 Display Color Space

The color space used for display in Image Viewer.
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8 Normalize

The N button switches between a linear view of a buffer, which may have many thousands of different levels not all of 
which can be shown on screen to a Normalized version where all data fits in the 0-1 range to be able to be displayed. Depth 
Options in Render Properties have been adjusted to make a pleasing gradient for this image

9 Image Layer

Chooses between the different image stored in the Image Viewer. The keyboard shortcuts PG Up and Pg Dn can also be 
used to switch images.

10 Buffer Layer

Chooses between the buffers rendered for an image. Each image in the Image Layer list can have multiple Buffers.

11 RGBA

Quick buttons to show individual channels or the alpha for a render without needing to go into the Buffer Layer list.

Image Control Panel

An Image Controls menu item also appears on the File menu. On the Controls dialog, you can select a foreground image 
by clicking in the FG column. You can also blend a foreground and background image in real-time using the Blend Mode 
pop-up menu and then dragging the Blend slider.
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Most of the modes are self-explanatory. The Difference mode shows the difference between the foreground and 
background pixels (i.e., foreground minus background). If the Blend slider is all the way to the left, the actual difference 
is shown. Increasing the Blend scales up the difference to make it more noticeable. If the foreground and background 
pixels are very close, the result looks black.

If you are displaying a high dynamic range image, you can access special parameters if you activate the Exposure 
option. This allows you to adjust HDR data much like the HDRExpose image filter, but in real-time.

The White Point is the input intensity considered to be the hottest white. Anything above this will be the same white in 
the output. The Black Point, expressed as a percentage of the nominal black point (1/255), is the darkest non-black pixel 
level in the input image that will be preserved. Anything darker will come out black. This control is overridden by the 
Auto option, which uses the image data to compute a black point.

When the Image Viewer is the active window, pressing the P key will display/hide the Control Panel.
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Print Camera

Print Camera

To aid those working in print, LightWave has a utility to help work out the camera frame size (in pixels) that would be an 
equivalent size in print. This replaces the previous Print Assistant utility and features more settings, as well as 
international standard paper presets. It is accessed through the Print Camera button on the Render tab in the default 
and Studio Production Style menus.

Use Template - Leaving this ticked gives you the dropdown list just underneath with a long list of standard page 
sizes.
Template - If Use Template is not checked, this dropdown list will be ghosted. If Use Template is checked you 
will be presented with 47 different standard sizes of paper.
Size Unit - Whether you use any of the standard templates or create your own measurements, you can choose to 
display the page size in the units of your choice: Decimal Inches, Centimeters, Millimeters or PostScript Picas.
Constrain Proportions - This option is ghosted if you are using Templates but if you are rendering to a custom 
sheet size, checking this option will keep the proportions the same between width and height values you set.
Width and Height - These values are only available if Use Template is unchecked. The dimensions will be in the 
Size Unit you have chosen.
Bleed - Adds the amount of bleed to the resulting camera frame size. The value is specified by the ‘Size Unit’ 
setting and is added to all sides.
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DPI/PPI - This is the target resolution when printed. Images on screen have no DPI since that is a print concept. 
PPI (or Pixels Per Inch) is perhaps more appropriate here, but the label DPI has been cited on the interface for 
those who are more familiar with that term.
Format - You can quickly choose between Landscape and Portrait here.
Set Camera Frame Size - Checking this option will set the selected camera’s frame size to the new size when you 
click OK to close the window. It will also set the camera Pixel Aspect Ratio to 1.0, as any other value would make 
little sense for print.

Information regarding the size your image will be in pixels is shown underneath the controls, along with a graphical 
representation that displays any bleed specified. The percentage value marked in the upper left-hand corner shows an 
approximate scale value compared to the real size of the page.

When you open your render in a package such as Photoshop, then look at the ‘Image Size’, it will probably say the 
image DPI is 72. This does not mean that the 300 DPI/PPI image size you set in the Print Camera settings is wrong. It 
simply means you need to set the image DPI that will be stored with the document in Photoshop. When you set your 
print size and DPI in the Print Camera utility, it calculates how many pixels need to be in your resulting image, so that 
when printed at the target DPI you specified, it will print with the correct quality.

To change the DPI of a document in Photoshop, go to the ‘Image Size’ window, uncheck ‘Resample Image’ and 
enter the DPI you want the document to be set to. Notice how the size of the image on screen did not change. 
There are still the same number of pixels in the document, all you are adjusting is how many of those pixels to 
use per inch when printed, which is why the ‘Document Size’ changes.


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Rendering and Compositing - Utilities

Network Render
Batch Render on One Computer

Troubleshooting

Rendering Without LightWave
Compositing Options
Effects > Compositing

Background Image
Foreground Images
Alpha Images
Creating Alpha Images
Foreground Fader Alpha
Foreground Key

TimeWarp

Network Render

LightWave allows you to use the processing power of other computers on a network to render scenes. This is called 
distributed rendering or sometimes a rendering farm. There are a few basic approaches to distributed rendering with 
LightWave.

ScreamerNet uses Layout’s Network Rendering Panel (Render > Network Rendering) to control submitting scenes to 
networked computers running the ScreamerNet process. ScreamerNet can control up to 1,000 CPUs. Each will render a 
frame from the animation until the scene is rendered.

Batch Render on One Computer

You do not actually need a network in order to use ScreamerNet. Just follow the network instructions as if the computer 
was the node and control machine. It’s a little easier since you won’t have to worry about shared directories and 
volume names. ScreamerNet is useful for rendering a series of scene files unattended, and it is most beneficial if you are 
using a dual-processor system - each processor could be treated as a separate CPU for rendering.

Troubleshooting

If clicking the Screamer Init button doesn’t find the other CPUs, go back and start at the Host Machine Setup section.

If images seem to render unrealistically fast and no images are saved:

Check to make sure that you have full sharing access across the network. You can check this by copying a file at 
random back and forth across the network.

Screamernet is now deprecated in favor of the NRC system, but instructions are left for people wishing to 
troubleshoot existing Screamernet installations or create new ones.



See the Distributed Rendering section for more information.
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• If the scene and/or objects were created without taking into consideration the new drive path names, rendering 
may occur on only the host machine.

The most common cause of ScreamerNet crashing is when too many computers try to write or read their information 
to/from the Host computers while the host renders.

Do not use ScreamerNet to render on the host machine, but rather use it only as a server where the hard drives are 
found. Map a drive from a different computer as drive Y:, for example, and set your scene to save the animations to that 
drive. The computers don’t know that drive Y: is not on the host, just that it’s present.

Another problem occurs when the hard drive where you save the images or animation is full. This problem creates an 
error in LightWave and on each ScreamerNet node.

Rendering Without LightWave

The LWSN program has a third option that lets you render a scene without running LightWave. There is no control 
machine and thus it is not a distributed rendering situation. You must tell the program specifically what to render. The 
method is run from a DOS prompt using the following syntax (one line):

LWSN -3 [-c<config dir>] [-d<content dir>] <scene file> <first frame> <last frame> 
[<frame step>]

As you can see, you supply the program with the basic information needed to render a scene. An example would be:

LWSN -3 -cD:\Lightwave\Configs -dM:\Newtek Spicegirls.lws 1 900 1

In the example, the program would render frames 1 through 900 of the Spicegirls.lws scene using the Lw.cfg file stored 
in the D:\Lightwave and using M:\Newtek as the Content Directory.

The configuration file specification is optional, if the Lw.cfg file is in the current directory. Likewise, if the Content 
Directory is correctly specified in the configuration file, you do not need to give that parameter.

Compositing Options

(default keyboard shortcut Ctrl F7)

You can get the syntax for ScreamerNet by simply typing LWSN with no arguments.
See the Distributed Rendering section for more information.


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Effects > Compositing

The Compositing tab of the Effects window has had a small but significant change. You can now set a background color 
that can be enveloped to be animated over time. The significant detail here is that it means there is no longer a need to 
use a small image to hide an HDRI used for reflections and lighting a scene. If you don’t check the Use Background Color 
box, then the old behavior is still available using a background image. Another benefit is that the Perspective viewport 
is affected in addition to the Camera viewport.

Background Image

The Background Image is similar to the gradient backdrop; however, it is always registered to the camera. That is, it will 
always appear in exactly the same position/location no matter which way you tilt or move the camera. You set this 
option on the Compositing Tab of the Effects Panel. Background images are considered infinitely distant from the 
camera. You can never have an object behind a background image, nor can you light a background image or cast 
shadows upon it.

Background images stretch to fit the Camera resolution and frame aspect that you are using. Make sure to use similar-
sized background images if you wish them to match.

In addition, when you set an image as a background for the camera, the Display Preferences for LightWave 
automatically updates to set Camera View Background to Background Image.


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You often use background images to merge live action and 3D elements, like creating the illusion that a UFO crashed 
into the Empire State building. An image of the New York skyline would be the background image and the UFO would be 
a LightWave object.

If you set Camera View Background on the Display Options Tab of the Preferences Panel (Display > Display Options) to 
Background Image, you will see the set Background Image in Layout’s Camera View. Of course, actually seeing the 
background in the Layout window is optional. The background image will always appear in the rendered frame.

The whole idea behind traditional image compositing is quite simple: take two or more images, and merge them into a 
new composite image. LightWave lets you do this, but also takes it one step further by letting you throw objects into the 
mix.

Background images are visible only through the Camera View. 
If you actually need your background image to interact with objects, use the image as a surface color texture-
mapped on a flat plane object and place the plane at the back of your scene.



Displaying background in the Layout window, particularly a color one, is processor intensive, so use this 
feature sparingly.


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The images can also be a sequence of pictures, so you may use captured video footage as a background for your 
objects. A simple example would be a modeled UFO moving against a real sky and trees. Images can appear behind all 
objects, in front of all objects, or a combination of the two with objects showing in-between.

Compositing can be a render time-saver. If you set up a scene with many objects, but only a few are moving, you could 
render one frame with only the inanimate objects, and then remove all of those objects and render the animated 
objects against the single frame saved earlier. This is especially useful when the still objects are complicated or involve 
radiosity, refraction and/or reflection.

Foreground Images

Placing an image in front of everything may seem like a silly thing to do. However, some options let you cut parts of the 
image away so you can see through it. You can also make the image partially dissolved or even envelope the dissolve. 
Dissolving in a black image in the foreground will produce the common fade-to-black effect, or reverse the dissolve to 
fade in from black.

You can make holes in the foreground image based on a defined color range in the image. However, the biggest 
drawback to simply clipping out portions of the foreground image is that you will have hard edges. A color is either 
clipped or it isn’t, so you see either the foreground image or the background image.

Use the Foreground Image pop-up to set the foreground image.
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Alpha Images

You may also use a special alpha image to merge the background and foreground images. This type of alpha image is 
very different from the type you use to set up a transparency surface texture. LightWave composites the foreground 
image over any objects or background by adding their colors to the foreground image. How much background is added 
is determined by the alpha image. The darker the area of an alpha image, the more background is added to the 
foreground. The pseudo-mathematical equation might look like: Foreground + (1 - Alpha) * Background

If you used the same exact image for both the background and foreground images, plus a solid black image as the alpha 
image, you will receive a final rendered image where every pixel is twice the color value it was. This results from the 
background image being completely added to the foreground image.

Creating Alpha Images

Generally, alpha images will be generated when you render a scene to create the foreground images. When you select 
Save Alpha on the Render Properties Panel’s Output Files Tab, LightWave will generate and save an alpha image in 
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addition to the normal RGB output. The alpha image will be composed of grayscale values representing the opacity of 
any objects that were rendered in the scene.

An object that contains no transparent surfaces will be rendered as solid white. Transparent surfaces will render in 
some shade of grey depending on how transparent they are. One hundred percent transparent surfaces render as black. 
A 50-percent transparent surface will render as 50-percent grey. Using object dissolve, antialiasing, motion blur, and so 
on. will also give you values other than white in an alpha image. Any background (image or colors) will be black in the 
alpha image, as will any additive effects such as glow or lens flare.

 

Image and Alpha
Since glows and lens flares are additive effects and are assigned a value of black in an alpha image, glows and lens 
flares in the actual foreground image will simply have the background values added, so they will appear brighter where 
the background is a value other than black.

Generally, due to LightWave’s additive compositing method, foreground images are created using a solid black 
backdrop. This allows the composited background to show through unaltered when it is mixed 100 percent 
with the foreground.


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Foreground Fader Alpha

What happens if you want to composite a foreground element on top of objects or a background, but the foreground 
image was not rendered over black? In this case, LightWave provides a Foreground Fader Alpha button that can be 
selected. In this mode, LightWave will ignore any areas of the foreground image corresponding to black areas in the 
alpha Image. These areas of the foreground image will be faded away to nothing so you see 100 percent of the 
background instead.

When using Foreground Fader Alpha, glows and lens flares will not be added to the final rendered image (their 
corresponding alpha is black) unless you are using a different alpha image containing non-black areas in those 
locations. Additionally, antialiased object edges most likely will stand out because they contain bits of color from the 
original non-black background.

Foreground Key

Activate Foreground Key when you want to key out (i.e., not render or see) a color (or range of colors) from the 
foreground image. Use the same color value for both Low Clip Color and High Clip Color if you wish to key out one color 
only. Use different values to key out the Low Clip Color and High Clip Color values, and all those in between.

The Low Clip Color is the color value for the darkest color value that will be keyed out. High Clip Color is the brightest 
color value that will be keyed out.

TimeWarp

If you want to create a giant space battle and lack the RAM to hold all of the objects and image files, you could 
composite layers of ships and achieve the same results. This is, in fact, how some broadcast TV shots were 
done using machines with only 32MB of RAM in the early days of LightWave.


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TimeWarp

TimeWarp (Camera Motion Options)
Timewarp basics
Render frame versus Scene frame
Motion blur and camera warping
Plugin usage
Timewarp interface
Frame warp
Warp blur
Warp camera
Fix camera
Sub frames
Preview
Timewarp Preview
Timewarp preview interface

TimeWarp (Camera Motion Options)

Timewarp manipulates time. Previously time has just been a steady clock ticking away at a certain number of frames 
per second. Now with Timewarp you can slow the clock down, speed it up, even wind it back, all during an animation.

Timewarp can warp the time in a scene while keeping the camera unwarped. Effects like bullet-time can be created in 
this way. Timewarp can also manipulate motion blur in new ways for special effects. You can now fly through a motion 
blur.

Timewarp basics
The Timewarp plugin is implemented as a motion modifier plugin that needs to be attached to the camera. There is also 
a generic layout plugin that is used to preview timewarping in layout. It is highly recommended that fractional frames 
be enabled in layout when using Timewarp.

Render frame versus Scene frame
From within the Timewarp interface, a mapping from Render Frame to Scene Frame is set through the Frame warp 
expression or graph.

Render Frame - The sequence number of a frame in a rendered animation.
Scene Frame - The frame number given by the frame slider.

Understanding the distinction between render frame and scene frame is crucial for effectively using Timewarp. The 
scene frame number is what is shown by the frame slider in LightWave. The render frame number is given by the 
position within a rendered animation.

Normally the render frame number and scene frame number are always the same. The 14th frame in an animation 
matches the 14th frame in the LightWave scene. With Timewarp however, an arbitrary mapping from render frame 
number to scene frame number can be established. When rendering frames, Timewarp makes the scene frame number 
a function of the render frame number. By default the mapping is simply an identity function, where the render frame 
number is equal to the slider frame number.

As the scene frame number is now an arbitrary function of the render frame number, multiple render frame numbers 
may map to the same scene frame number. While the render frame number always increases, the scene frame number 
may increase, stay the same, decrease, or jump around.

Motion blur and camera warping



LightWave 2020  –  LightWave 2020

Reference –  2848

•

•

•

Motion blur warping - Motion blur is done by LightWave by rendering the scene at slightly different times and 
then combining the results. The times are computed by adding small amounts to the current frame time, up to 
the value given by the blur length. Timewarp can warp the blur length as well. This can keep the motion blur as it 
looks like without Timewarp applied, or modify it to take into account the fact that the scene is Timewarped.
Camera warping - When mapping render frame to scene frame, Timewarp can either keep the camera as it is in 
the scene frame, or set it to be the same as it is at the render frame time. In the former case, the effect is similar 
to changing the speed of a video playback. The latter case gives effects such as bullet-time and time freeze. It 
disconnects the camera’s timeline from the rest of the scene.
Fixing the camera - When motion blur is enabled, the camera settings used for each pass are the settings at the 
motion blurred time. With Timewarp it is possible to optionally keep the camera at the unblurred time. The 
effect is that there is motion blur in the scene due to movement of objects, but no blur because of camera 
movement.
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Plugin usage
The Timewarp plugin needs to be added to the camera as a motion modifier. There can be only one instance of the 
Timewarp plugin in a scene.

The first step in using Timewarp is to plan your scene carefully. Plan how objects in the scene should move as a function 
of scene frame time (i.e. without any timewarping). If you intend to warp the camera as well, set out the camera motion 
as a function of scene frame time, like the other objects in the scene.

The most difficult aspect of Timewarp is if the camera is not timewarped. The camera motion is then a function of 
render frame time, while the rest of the scene is in scene frame time. When working with the camera, the frame set with 
the layout frame slider should be considered to be the render frame. When working with any other items in the scene, 
the layout frame slider should be interpreted as indicating the scene frame number.

To help with working with Timewarp, there is a preview mode. This presents a preview slider, which acts like the layout 
frame slider. When the preview is enabled, the preview slider is used to set the render frame. In layout the scene frame 
for that render frame will be shown. In the preview mode, it is possible to set keyframes for the camera as a function of 
render frame number instead of scene frame number.

Timewarp interface

The timewarp interface is used to set the timewarp function and the various camera and motion blur warping options. 
The timewarp preview mode can also be launched from this interface.

Frame warp
The frame warp defines the mapping from render frame to scene frame. This uses frame numbers, rather than time. The 
frame numbers do not need to be integers, but can be fractional.

Although you can just set a constant here, it is more typical to use the envelope to set a graph or expression. A constant 
would mean that the given scene frame will be used for all render frames. When set to a graph, the horizontal axis 
indicates the render frame number, while the vertical axis is the scene frame number.
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Warp blur
Sets whether or not to warp the motion blur. This will only have effect if motion blur has been enabled for the scene.

Warp camera
Enables and disables applying the timewarping to the camera.

Fix camera
When set, fixes the camera in place when doing motion blur. This option is not available for some combinations of 
options.

Warp blur Warp camera Fix camera

available

Yes

Yes

No (camera

always fixed)

Yes

If the scene does not have motion blur enabled, this option will have no effect.
Sub frames
When doing a timewarp, the computed scene frame number is very likely to be a fractional frame number. However, 
LightWave can only render the scene at whole frame numbers. If the fractional scene frame number were to be rounded 

When adding a key manually using Create Key with Cam Rekey turned on, the frame number given will be 
ignored for the camera, and the current Render frame slider value in the Timewarp Preview used instead.





LightWave 2020  –  LightWave 2020

Reference –  2851

•

•

•

to the nearest integer, the resulting timewarp animation will appear to stutter, especially when time is slowed down. 
The Timewarp plugin can overcome this by manipulating the frames per second setting for the scene.

The Sub frames setting tells Timewarp the desired sub-frame resolution. The default of 10 means that the time of the 
rendered frame will be accurate to within 1/10th of a frame. A value of 30 would mean an accuracy of 1/30th of a frame.

What Sub frames does is multiply the frame per second setting with the given value. For example, say the FPS is 30, and 
the fractional scene frame number that needs to be rendered is 1.53. Without the use of the Sub frame setting, this 
would be rounded to scene frame 2, an error of almost half a frame or 0.5 / 30 = 1/60th of a second. With Sub frames set 
to 10, the FPS is modified to 30 * 10 = 300, the fractional frame number becomes 1.53 * 10 = 15.3, which is rounded for 
rendering to 15. That results in an error of only 0.3 frames or 0.3 / 300 = 1/1000th of a second.

Put in another way, without Sub frames, the scene frame number would have to change by 1/30th of a second before a 
different frame is rendered. If the timewarp slows down time by a factor of 5, this would mean you’ll only get 30 / 5 = 6 
unique frames per second in the final animation. With Sub frames set to 10 you have up to 300 / 5 = 60 unique frames 
per second available.

This disadvantage of setting Sub frames very large is that the number of frames in the scene becomes very large, which 
may have implications with memory usage. Also keep in mind that Sub frames will multiply the scene frame number. 
This will affect the results of any setting which is dependent on scene frame number rather than scene frame time. For 
example, animated images which are animated as a function of frame number.

Preview
The Preview button activates the Timewarp Preview interface, which is explained in the next section. Note that the 
preview interface can also be opened by activating the TimewarpPreview generic plugin.

Timewarp Preview
The Timewarp Preview can be used to preview the effect of the timewarp in layout. It presents a simple slider and 
animation controls. The slider sets the render frame. When changed, the frame shown in layout is the scene frame that 
would be rendered for the given render frame number. When the Timewarp Preview is active, it is possible to set 
camera keyframes as a function of render frame number instead of scene frame number. This is very useful when the 
Warp camera option is switched off.

Timewarp preview interface
The Timewarp Preview interface can be activated in two ways. The first is to use the Preview button on the Timewarp 
interface. The second is to start the TimewarpPreview generic plugin.

6.1.1. First frame, Last frame - The first and last render frame specify the range over which the preview is done. 
These are initially equal to the rendering options first and last frame.
6.1.2. Render frame - The slider is used to set the render frame. The view in the layout and the layout frame slider 
will be adjusted to show the matching scene frame.
6.1.3. Play > - Toggling the Play button on starts playing the timewarped animation. The animation is looped 
from First frame to Last frame. Toggle the Play button off to stop the animation.

If the camera type is anything other than Classic or Perspective, anytime-varying camera type parameters may 
not be correct if the camera is left unwarped. It may end up using the warped time for those parameters.


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During the playing of the animation, interactions with Layout other than with the Timewarp Preview panel is 
blocked.
6.1.4. +<< >>+ - When Warp camera is off, the +<< and >>+ buttons change the render frame to the previous and 
next camera keyframes respectively in render frame time.
6.1.5. Cam Rekey - In the case where the camera is not warped (Warp camera is turned off), the camera 
properties change as a function of render frame number instead of scene frame number. The layout frame slider 
controls the scene frame number. Normally, when a keyframe is created for the camera it will be set at the 
current scene frame. With Cam Rekey turned on, keyframes for the camera will be created at the render frame 
number indicated by the Timewarp Preview slider.

In combination with the +<< and >>+ buttons this allows you to easily edit the camera in render frame time and 
the rest of the scene in scene frame time.

The Cam Rekey toggle is only available if the Warp camera option is off. Cam Rekey will only be applied when the 
toggle is turned on and (to avoid confusion) the Timewarp Preview interface is open.
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Set Limited Region

On Layout’s Render tab, you can find the Set Limited Region command. This allows you to be precise about the size you 
wish to set, instead of just dragging the handles in the viewport.

Here are the settings:

Left (X) - The offset for your limited region from the left side of the screen.
Top (Y) - The offset for your limited region from the top of the screen.
Right (X2), Bottom (Y2) - These values are ghosted while Maintain Width and Height is checked.
Width , Height - These values are ghosted while Maintain Width and Height is unchecked.
Constrain - Only available while Maintain Width and Height is checked. This keeps the proportion of Width and 
Height proportional.
Center - this centers the Limited Region. The Left (X) and Top (Y) values will change to show revised settings, but 
if you already have a Limited Region displayed it won’t be updated until you hit OK in this window.
Borders - You can choose to turn Borders On or Off. If you already have a Limited Region displayed it won’t be 
updated until you hit OK in this window.
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Render-Q

If you only have one computer, Render-Q (Render > Render-Q > Launch/Open) is the tool you should use to batch 
render. You can choose scenes from different content directories, change their priority and Bake Radiosity for a 
selection of scenes if needed. Remember, the scenes will render as you have set them so make sure all the details are 
right by first loading each scene, checking paths and save options to be sure that your computer will be able to chain 
the scenes together for continuous rendering.
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4.

Create Preview

Creating a Preview Animation
To Create a Preview Animation:
Preview Options

Creating a Preview Animation

In addition to playing a scene using the transport controls, you can also create special preview animations. In most 
cases, these will give you a more accurate preview of your final animation.

To Create a Preview Animation:

If you are using multiple viewports, you will be asked which you wish to use. You can indicate the viewport for 
the preview by clicking the small camera icon that appears when you have multiple viewports.

Make sure the viewport’s Maximum Render Level is set as desired. If you would like a full-rendered preview, set 
the viewport to VPR (there are other options if you do so).
Select Make Preview from the Preview pop-up menu. A dialog will appear asking you for first and last frame 
settings, as well as Step. This initially defaults to the scene settings, but may be set independently. Click OK and 
the preview animation will be created.

When the preview is complete, the Preview Playback Controls Panel will appear.

You can press the Esc key to stop creating the preview animation. The animation will still be playable up to the 
point of termination.


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Here’s a rundown of the Preview Playback Controls:

01 Go to the end of playback, 02 Step, 03 Pause, 04 Play, 05 Multiplier, 06 Slider, 07 End Preview, 08 Playback rate

Preview Options

Also from the Preview pop-up menu, you can replay the preview currently in memory, free it from memory, and load/
save a preview animation file. Selecting Preview Options from the Preview pop-up menu will display a dialog.

Here, you can select a compression level for preview animations, as well as select the format and codec used when you 
save them. Compressed previews use much less memory, thus you can have a lot more frames before virtual memory 
starts being used, which bogs down playback.

To save time creating a preview animation for a complex scene, do the Texas Two Step: use a Step of 2 and 
playback using a frame rate one-half the desired rate.


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Compressed preview files are also smaller when saved to disk. You can also set whether or not to use virtual memory for 
preview animations.

Using the Make Preview Buffer option, you can choose to record the OpenGL back (offscreen) or front (on screen) 
display buffer. Other options may be available (e.g., Direct Draw). You may get better performance with different 
settings, depending on your video card.

When Virtual Memory is set to Disabled, LightWave attempts to use only RAM for storage and playback. (Your operating 
system can still ultimately swap the data to virtual memory, however.)Setting Screen Size to Stretch to Fit causes the 
image to fit the window, even if it is a different size than what was used when the preview was made.

 

You will want to install additional codecs, especially on Windows systems. The only codecs built into Windows 
tend to be very old. Consider XViD, QuickTime and Lagarith codecs.


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Effects Window

The Effects window contains four tabs relating to scene setup.

Backdrop Tab
Compositing
Legacy Volumetrics
Processing
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Backdrop Tab

Click here to expand Table of Contents...
Backdrop

Gradient Backdrops

Other Environments
Image World
Physical Sky (Hosek-Wilkie)
Python
Python Horizon
SkyTracer 2
Textured Environment

(Default keyboard shortcut: Ctrl F5)

This tab is for backdrops global to the scene, rather than specific to Environment Lights. There are a variety of 
different environment types, and by default, the Backdrop tab will always contain the Backdrop environment in a new 
scene.


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Backdrop

LightWave lets you change the colors of the backdrop behind all of the objects in a scene. You can elect to have a solid 
color using the Backdrop Color setting or a Gradient Backdrop. By default, the gradient backdrop is used.

Gradient Backdrops
LightWave’s Gradient Backdrop settings essentially provide a quick earth-like environment background. Note that no 
shadows can be cast on the backdrop since it isn’t there. Although you're unlikely to use it much for real-life imagery, it 
is great for faking a sky behind mountain objects, instructional animations, and logo animations. Use it when you need 
something to stick in the background.

There are two gradient areas. Think of it as a huge sphere cut into two halves. One half rests on top of the Y-axis plane, 
and the other half sits directly beneath it.

The Sky Color begins all around the edge of the top half of the sphere and gradually turns into the Zenith Color moving 
towards the top. The Ground Color starts all around the edge of the bottom half of the sphere and progressively turns 
into the Nadir Color moving towards the bottom. Note that there is no gradual change of color between the Sky Color 
and Ground Color.

If you want the Gradient Backdrop to blend everywhere with no sharp color change, make the Sky Color and 
Ground Color the same.


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The camera is always positioned right in the center of the sphere. Thus, if you move the camera, the Gradient Backdrop
will always look the same. However, if you rotate the camera, you will see the various colors.

There are several additional Gradient backdrops available using the Textured Environment plugin available on this tab. 
Select it and hit F8 to bring up the Presets window in which you will see several choices, including an updated oldskool 
Desert Chrome backdrop.
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Left: Sky and Ground Squeeze both at 6.0, Right: Both at 20
The Sky Squeeze value determines how the Zenith and Sky colors are blended. The Ground Squeeze value determines 
how the Ground and Nadir colors are blended. The default value of 6.0 yields a nice spread between the various colors. 
A lower value will spread the change in colors over a greater area, and a higher value will compress the change.

Other Environments

Several plugins may be used to create exciting backgrounds for your animations. You access these plugins by adding 
them on the Add Environment pop-up menu on the Backdrop Tab of the Effects Panel.

Image World
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The Image World Environment lets you apply an image as a spherical environment wrap; this approach is perfect for 
high dynamic range images. You can offset the heading and pitch of the image, as well as adjust its brightness.

Physical Sky (Hosek-Wilkie)

Physical Sky is a Backdrop shader, with its elements rendered beyond the furthest extremities of the scene.  It is based 
on papers written by Lukas Hosek and Alexander Wilkie, the current best approximation of atmospheric light scattering. 
As can be expected from our everyday experience the atmosphere is thickest with the sun at the horizon, so, with 
default settings, more blue light is removed and the red is left, but these same settings allow for a wide range of 
different planetary atmospheres, real and imagined. This shader also allows multiple celestial bodies to be easily added 
and influence the atmosphere (Did someone say "binary star system"?)

Because SunSky is a backdrop shader, it means that although it can contribute to the lighting of a scene - using an 
environment light, say - you cannot interact with it. It's not possible to generate clouds using SkyTracer that will react 

https://docs.lightwave3d.com/display/LW2019/Example+-+SunSky+and+Environment+Light
https://docs.lightwave3d.com/display/LW2019/Example+-+SunSky+and+Environment+Light
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accurately to it, but these things can be worked around using additional lights positioned in a similar position relative 
to the camera.

A softened horizon line and the possibility to color the "ground" portion of the backdrop were added in 
LightWave 2019.1.

To do so, add a Textured Environment, make sure it is above Physical Sky in the Environment list, and you can 
have something like this:


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Surface Albedo - Reflectance color from the planet. The default value of blue has been set because our planet is 
mostly water
Turbidity - The reduction in the transparency of air because of the scattering of light by dust and smoke 
particles and water droplets. Increase the turbidity to make the atmosphere denser - hazier. Great for recreating 
LA sunsets
Scattering - The scattered color of the sky itself
Tint - Added for tinting skies. Leave white to use the sky color as normal, change the scattering color to multiply 
with the end result
Max Luminance - Function added for tone mapping the final result. This will tone down the brightness value of a 
star to better match the rest of the scene
Add/Rename/Remove Star - Add, rename or remove additional stars adding each to the bottom of the list. 
Because a backdrop is effectively flat, getting the stars in the right order for proper layering is done by dragging 
and dropping to reorder in the star list
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Item - Use an item's rotation to change the position of the sun in the scene. Because a sun is so far away, 
changing the position makes no sense. When using an item to control the sun's position, the following three 
options will be ghosted:
Pick Location - Opens the Location Picker window
Azimuth - The sun's position across the sky
Elevation - The sun's vertical position in the sky

Temperature - Similar to using the Kelvin scale in the color picker. The scale starts at 1000 and can go up and 
up, for instance, the temperature of Sirius is 25,200 K. The default value of 5,778 K is representative of the Earth's 
sun
Intensity - A value to choose for the overall intensity of your star in the sky. The default value of 5.0 has been 
chosen for the Earth's sun
Size - A value to choose for the overall size of your star in the sky. The default value of 5.0 has been chosen for 
the Earth's sun

The following three options are all linked - a low temperature implies a large size, a small size implies a 
high intensity and a high intensity implies a high temperature and vice versa. Care should be taken to 
balance



If you are linking your SunSky with a light (in the Item dropdown), you should set the SunSky light to 0 to 
disable the SunSky version and only use the light in the scene. Otherwise, you will have a doubling of lights, 
and more noise inherent.



https://docs.lightwave3d.com/display/LW2019/Location+Picker+window
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A small change to the Turbidity and Scattering color makes a dramatic difference
Python
Opens a file requester for a Python script-based backdrop.

Python Horizon
A script example of an environment created in Python.

SkyTracer 2
An older environment for non-realistic scenes.
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Textured Environment
The Textured Environment lets you apply a texture as a spherical environment wrap; this approach is perfect for high 
dynamic range images. Clicking the Texture button launches the standard Texture Editor giving you access to gradients, 
procedurals, and the use of images to create an endless variety of textures.

 
The texture is not stuck to the camera background, like a normal background image. Therefore, as you move the 
camera, you will pan over the environment.

An interesting application would be to use a gradient and select the (camera) Heading or Pitch as the Input Parameter. 
This lets you vary a glorious sunset sky based on the rotation of the camera. You might also use this to add a nebula 
behind your starfield using a simple Turbulence or Fractal Noise procedural texture.
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Compositing

Background Image
Foreground Images
Alpha Images
Creating Alpha Images
Foreground Fader Alpha
Foreground Key

(default keyboard shortcut Ctrl F7)

Image Sequence Global Offset - When you have an image sequence loaded for use in texturing or as a 
background element, you can define where the sequence starts here.
Use Background Color - This toggle allows you to define a background color to use to overlay HDR Image World 
images so that they only appear in reflections and not in the background of your render.
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Background Image

The Background Image is similar to the gradient backdrop; however, it is always registered to the camera. That is, it will 
always appear in exactly the same position/location no matter which way you tilt or move the camera. You set this 
option on the Compositing Tab of the Effects Panel.

Background images are considered infinitely distant from the camera. You can never have an object behind a 
background image, nor can you light a background image or cast shadows upon it.

Background images stretch to fit the Camera resolution and frame aspect that you are using. Make sure to use similar-
sized background images if you wish them to match.

You often use background images to merge live action and 3D elements, like creating the illusion that a UFO crashed 
into the Empire State building. An image of the New York skyline would be the background image and the UFO would be 
a LightWave object.

If you set Camera View Background on the Display Options Tab of the Preferences Panel to Background Image, you will 
see the set Background Image in Layout’s Camera View.

Of course, actually seeing the background in the Layout window is optional. The background image will always appear 
in the rendered frame.

The whole idea behind traditional image compositing is quite simple: take two or more images, and merge them into a 
new composite image. LightWave lets you do this, but also takes it one step further by letting you throw objects into the 
mix.

The images can also be a sequence of pictures, so you may use captured video footage as a background for your 
objects. A simple example would be a modeled UFO moving against a real sky and trees. Images can appear behind all 
objects, in front of all objects, or a combination of the two with objects showing in-between.

Compositing can be a render time-saver. If you set up a scene with many objects, but only a few are moving, you could 
render one frame with only the inanimate objects, and then remove all of those objects and render the animated 
objects against the single frame saved earlier. This is especially useful when the still objects are complicated or involve 
radiosity, refraction and/or reflection.

Foreground Images

Placing an image in front of everything may seem like a silly thing to do. However, some options let you cut parts of the 
image away so you can see through it. You can also make the image partially dissolved or even envelope the dissolve. 

Background images are visible only through the Camera View.
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Dissolving in a black image in the foreground will produce the common fade-to-black effect, or reverse the dissolve to 
fade in from black.

You can make holes in the foreground image based on a defined color range in the image. However, the biggest 
drawback to simply clipping out portions of the foreground image is that you will have hard edges. A color is either 
clipped or it isn’t, so you see either the foreground image or the background image.

Use the Foreground Image dropdown to set the foreground image.

Alpha Images

You may also use a special alpha image to merge the background and foreground images. This type of alpha image is 
very different from the type you use to set up a transparency surface texture. LightWave composites the foreground 
image over any objects or background by adding their colors to the foreground image. How much background is added 
is determined by the alpha image. The darker the area of an alpha image, the more background is added to the 
foreground.

The pseudo-mathematical equation might look like:

Foreground + (1 - Alpha) * Background

If you used the same exact image for both the background and foreground images, plus a solid black image as the alpha 
image, you will receive a final rendered image where every pixel is twice the color value it was. This results from the 
background image being completely added to the foreground image.

Creating Alpha Images

Generally, alpha images will be generated when you render a scene to create the foreground images. When you select 
Save Alpha on the Render Properties Output Files Tab , LightWave will generate and save an alpha image in addition to 
the normal RGB output. The alpha image will be composed of grayscale values representing the opacity of any objects 
that were rendered in the scene.

An object that contains no transparent surfaces will be rendered as solid white. Transparent surfaces will render in 
some shade of grey depending on how transparent they are. One hundred percent transparent surfaces render as black. 
A 50-percent transparent surface will render as 50-percent gray. Using object dissolve, anti-aliasing, motion blur, and so 
on. will also give you values other than white in an alpha image. Any background (image or colors) will be black in the 
alpha image, as will any additive effects such as glow or lens flare.

Since glows and lens flares are additive effects and are assigned a value of black in an alpha image, glows and lens 
flares in the actual foreground image will simply have the background values added, so they will appear brighter where 
the background is a value other than black.

Foreground Fader Alpha

What happens if you want to composite a foreground element on top of objects or a background, but the foreground 
image was not rendered over black? In this case, LightWave provides a Foreground Fader Alpha button that can be 
selected. In this mode, LightWave will ignore any areas of the foreground image corresponding to black areas in the 

Generally, due to LightWave’s additive compositing method, foreground images are created using a solid black 
backdrop. This allows the composited background to show through unaltered when it is mixed 100 percent 
with the foreground.


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alpha Image. These areas of the foreground image will be faded away to nothing so you see 100 percent of the 
background instead.

When using Foreground Fader Alpha, glows and lens flares will not be added to the final rendered image (their 
corresponding alpha is black) unless you are using a different alpha image containing non-black areas in those 
locations. Additionally, anti-aliased object edges most likely will stand out because they contain bits of color from the 
original non-black background.

Foreground Key

Activate Foreground Key when you want to key out (i.e., not render or see) a color (or range of colors) from the 
foreground image. Use the same color value for both Low Clip Color and High Clip Color if you wish to key out one color 
only. Use different values to key out the Low Clip Color and High Clip Color values, and all those in between.

The Low Clip Color is the color value for the darkest color value that will be keyed out. High Clip Color is the brightest 
color value that will be keyed out.
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Legacy Volumetrics

You can add the HyperVoxels system available in previous versions of LightWave here, along with third-party volumetric 
solutions like Volumedic and Turbulence.
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Don't forget that Use Legacy Volumetrics has to be enabled in the Render Properties > Volumetrics tab for 
HyperVoxels to work, and that new Volumetric Primitives and the original HyperVoxels cannot coexist in the 
same scene.


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Processing

Click here to expand Table of Contents

Image Processing Options
Limit Dynamic Range
HDR Filtering

Pixel Filters
FiberFilter (FiberFX)
Halftone
Tone Mapping
Examples
Tone Mapping
Uses

Image Filters
Image Filter List

Image Processing Options

(default keyboard shortcut Ctrl F8)

The Processing Tab on the Effects Panel contains functions that apply effects to the rendered image. Choose Editors > 
More Windows > Image Processing to directly bring up the Processing Tab of the Effects Panel.



LightWave 2020  –  LightWave 2020

Reference –  2876

Limit Dynamic Range
Limit Dynamic Range clips the pixel color components of each rendering pass at the Dynamic Ranges chosen, improving 
the anti-aliasing of extremely bright areas. This option should not be used with filters or image savers that expect high 
dynamic range data.

HDR Filtering
Filters HDR images to aid with the control of hotspots.

Pixel Filters

Pixel filters let external applications affect LightWave’s rendering engine. Filters in this class can be affected by motion 
blur and other sub-frame operations during the render rather than as a post process, as image filters are.
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FiberFilter (FiberFX)
FiberFX allows you to create a variety of fibers, hair, and fur effects. For more information see FiberFX.

Halftone
In print, halftone screens are made up of dots that control how much ink is deposited at a specific location. Varying the 
resulting dots’ size and proximity creates the illusion of variations of gray or continuous color.
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The X Tiles and Y Tiles values determine the number of possible horizontal and vertical dots. If you would like to 
randomise either of these settings (throughout your animation), use the corresponding Jitter fields.

In the photography world, this type of effect is achieved with a (physical) screen that breaks up the image into dots. 
Think of the Screen Angle setting as the rotation of that screen. It controls the angle of the dots.

You can control the overall amount of effect by adjusting the Effect Strength setting. Settings below and above the 
default of 100% are allowed.

You can change the pattern by changing the Spot Type. Specify and animate a Screen Tack Object to animate the 
pattern position.

 

Left: With Halftone, Right: Without Halftone
Tone Mapping

A new Pixel Filter to enable control over how your rendering looks. Tone mapping is a way of taking the high 
dynamic range of a LightWave render and massaging the contents to display them to the best effect. As an example, 
imagine you take a picture indoors on a sunny day with a window in the background. Your camera will do one of two 
things. It will either think you are really interested in what's outside the window, despite you having taken the picture 
indoors and make everything indoors in the picture really dark to give you a nice view of the sky outside with all the 
little, fluffy clouds; or it will expose correctly for inside concentrating on your TV figurine collection, and the world 
outside will be reduced to a bright white square. When LightWave renders an image, it has both sets of data. Normally, 
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we accept what LightWave gives us because we can steer it to what we want to see, but it has seen all. The trick is to 
combine that view of outside while maintaining the visibility of what is inside the room. Tone mapping can help with 
this task, and because it's a Pixel Filter, not an Image Filter, it can be used in VPR.

LightWave came with a Kitchen HDR image in the LightWave [6] days. It could be used for lighting a scene for global 
illumination back in GI's earliest days. It's a 360° photograph of the inside of a kitchen, and look in the background, 
there's a white window!

That window isn't just white, this is a high dynamic range image. Here's a close-up on that window exposing more for 
what's outside the kitchen. We can see the top of a building, and yes, fluffy clouds...
Examples
Here are some examples with the Hero scene from the supplied content:

Just a straight render with no Tonemapping Reinhard tone mapping. The difference is incredibly 
subtle between this and the straight render
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The ACES Filmic TMO applied with an exposure of 1.0. 
Notice the increased depth in the blacks and the overall 
"polish" of the image

ACES Filmic again, but with an Exposure of 2.0. A similar 
level of brightness to the straight render, but increased 
detail in dark areas

ACES Filmic with Exposure 4.0. It's probably best to 
render the background separately

ACES Filmic, Exposure 2.0. You can also play with Hue 
and Saturation. The Hero should definitely be rendered 
separately from the background here

Tone Mapping
Four types of Tone Map Operator (TMO):

Linear - This is the default LightWave render. You can control Exposure, Hue, Saturation, Brightness, and 
Contrast
Reinhard - The Reinhard method (just to be clear, because Max Luminance is controllable, this TMO is Extended 
Reinhard) is one of the simplest tone-mapping methods. It guarantees a solution that contains your brightness 
levels within the 255, 255, 255 range for LDR images, with no blowout. You can control Exposure, Max 
Luminance, Hue, Saturation, Brightness, and Contrast. Results can look grayish if you are working with brightly 
colored, highly saturated subjects
Filmic - The Filmic TMO is designed to replicate the look of film in the real world. It is based on John Hable's 
work. You control Cutoff, Max Luminance, Hue, Saturation, Brightness, and Contrast
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ACES Filmic - The Academy Color Encoding System (or ACES) is a color image encoding system created by 
industry professionals with guidance from AMPAS (Academy of Motion Picture Arts and Sciences). It is rapidly 
becoming an industry standard. You can further control Exposure, Hue, Saturation, Brightness, and Contrast. 
ACES Filmic is much-praised for its film-like color response with rich blacks, and vibrant lighter tones

Some TMOs have the following settings:

Exposure - (Default 1.0) The Exposure control is a multiplier for your color channels
Max Luminance - (Default 1.0) Luminance is the value of light reflected off a surface. The Max Luminance setting 
allows further control for exaggeration or damping down of reflections
Cutoff -  (Default 0.025) Values below this level are treated as black

All TMOs have the following settings:

Hue - (Default 0.0 °) Rotate the color wheel to tint your render
Saturation - (Default 100 %) Reduce or increase the amount of saturation in the render
Brightness - (Default 100 %) Reduce or increase the overall brightness of the rendered image
Contrast - (Default 0 %) Reduce or increase the overall contrast of the rendered image

Settings are maintained between TMOs where possible.

Uses
Tonemapping is a great way to get a quick look at how to push your images for the best look. It's ideal in that it can be 
used in VPR, but it does take a floating-point image and remap it into display space; your images will no longer be in 
high dynamic range. If you are using LightWave in a compositing workflow, you should definitely not use tone mapping 
in LightWave because it is inherently destructive for final renders. Tone mapping should occur in the compositing 
application.

Image Filters

Image filters, unlike Pixel filters in the previous section, act on an image as a whole. They can be used for a variety of 
things, from saving out a layered Photoshop file to achieving a light bloom effect on your render, or making it into a 
sepia or monochrome image. Some of the filters can be applied directly to images you use within LightWave - for 
instance, full precision blur can be used to soften black and white images intended for a Bump Map.

Image filters are a post-process effect. This means that they get applied only once all rendering has been 
performed.


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Image Filter List
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Shading Models

Click here to expand Table of Contents...
Photoreal

Alpha
Reflection
Refraction
Optimization

Cel
Shadow Catcher
Sublimation CelShader

Switching between Integrators has no undo. When you switch previous settings are lost. Make sure you create 
a preset of your surface before you switch integrator. If you are switching integrator for multiple surfaces, save 
a library.




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Integrators are the middlemen between the camera projections and render engine. They take the projections - what the 
camera sees - and pass it through the shading engine to be rendered. Integrators are per surface and you can mix and 
match them in a scene. LightWave has four integrators right now. You can access the integrator assigned to a surface by 
moving to the Shading Model tab of the Surface Editor.
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Photoreal

The integrator you will use most often. This integrator is responsible for passing your realistic surfacing to the render 
engine. Here are the settings:

Alpha

Alpha Channel - Four choices as follows:
Unaffected by Surface - the surface has no effect on the alpha image
Constant Value - the Constant Alpha field can be set to a specific number from 0 to 1
Surface Opacity - the default, uses the opacity of a surface to create the corresponding alpha area. Thus, 
if a surface has some level of transparency, the alpha channel information will be somewhere between 0 
and 255
Shadow Density - uses the density of shadows in creating the alpha image



LightWave 2020  –  LightWave 2020

Reference –  2886

• SurfaceID - You can override the numeric identity of the current surface by changing the number in this field

Surface Opacity, the default choice for rendering can sometimes give unwanted results. Take 
this simple example of a sphere entirely in front of a box. At first glance, the alpha for the sphere 
should be white because the sphere is entirely inside the box's dimensions. However, as the 
surface of the sphere reaches the glancing angle refractions will be coming from the 
background, not the cube, making the render difficult to composite. In such cases, switching the 
Alpha channel to Constant Value makes sense to preserve the alpha for the scene.


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Reflection

Glossy Reflections - Toggle for indirect specular reflection, enabling this causes specular to reflect not only 
lights but also the entire environment

Reflection Options - Three choices:
Raytrace - Ray traces any reflections
Raytrace + Spherical Map - Raytraces reflection but also uses a spherical map
Spherical Map Only - Only uses a spherical map as the reflection source (very fast, but a complete cheat)

If you choose either of the last two options, you can select the image to use below the Reflection Options. 
The image will be displayed in the window below the Spherical Map Image dropdown and you can set a 
spherical seam angle.

Refraction

Refraction Options - Three choices:
Raytrace - Ray traces any reflections
Raytrace + Spherical Map - Raytraces reflection but also uses a spherical map
Spherical Map Only - Only uses a spherical map as the reflection source (very fast, but a complete cheat)

If you choose either of the last two options, you can select the image to use below the Refraction Options. 
The image will be displayed in the window below the Spherical Map Image dropdown and you can set the 
seam angle.

Optimization

There is now the opportunity to limit, or boost, samples for a particular surface. Use the check boxes for 
Reflection or Refraction overrides, and change the sampling for a specific surface

•

•
•
•

When Glossy Reflections is not checked, the Specular component of a surface behaves just as it did in 
previous versions of LightWave - that is to say that only light reflections were taken into account (Direct 
Specular). When this setting is checked, the environment is taken into account too (Indirect Specular). Three 
things to note:

The Reflection Recursion setting in the Render tab of Render Properties controls the numbers of 
bounces for the reflections
Reflection Samples on the same tab will control how many samples to take for such reflections
Raytrace Reflection in the same tab enables/disables those bounces completely
Results can be seen in VPR viewing the Specular_Indirect channel



In previous versions of LightWave, you had Specular which was only light reflections, and 
Reflections which was the indirect reflections - the reflections of other scene objects. Now, they are 
unified into a single value, so the result is physically correct, and separated out so you can focus 
samples on a per render basis, depending on how much depth and quality you need


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Cel

The Cel Integrator is an advanced way of cel shading that replaces previous shading models like BESM, SuperCel and 
others.

Shadow Catcher

This shader replaces the Shadow Catcher Material node in previous versions of LightWave and behaves similarly. The 
Shadow Color is set here as is the type of image to use. A Textured Environment is required. Otherwise the Backdrop 
Color in the Effects > Backdrop panel will be used.

Backdrop Image - Used in Backdrop Image mode, the Shadow Catcher integrator operates similarly to 2015's 
Shadow Catcher material node. It will use the image assigned as a Textured Environment, wrapped around the 
scene to create reflections of scene elements and shadowing. This will work well for simple scenes where no 
precision is required, just an overall feeling of integration. If you have an image probe of your scene and wish 
your object to have correct reflections and shadowing, you should use:
Environment - Environment mode requires a lighting probe sphere to be set as the textured environment, but 
when one is used, rotating the camera and scene elements can map exactly to the projected image.

Example - Shadow Catcher: Environment Mapping

Example - Shadow Catcher: Spyder on the beach

https://docs.lightwave3d.com/display/LW2019/Example+-+Shadow+Catcher%3A+Environment+Mapping
https://docs.lightwave3d.com/display/LW2019/Example+-+Shadow+Catcher%3A+Spyder+on+the+beach
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Sublimation CelShader

When you select this Shading Model, the only thing presented in the Surface Editor is a button marked Options...

Clicking it opens the Sublimation CelShader settings.

Two things are necessary for the Sublimation cel shader to work - the surface to which Sublimation is applied 
has to be Standard and lights need to be set to 1 lx. In addition, Sublimation won't work with object shapes, 
and if you use the Opacity settings, Double Sided needs to be checked.


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Cel
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Model courtesy Russell Tawn

Introduction

The Cel Integrator is an advanced way of cel shading that replaces previous shading models like BESM, SuperCel and 
others.The cel integrator's two gradients complement surface settings for color and specular. The choice is up to the 
user whether to use the integrator's gradients to overwrite

Zoom levels

The gradients have three different levels of zoom.

At the smallest level - The gradient can be viewed
At the intermediate level - keys can be moved, added and removed
At the biggest level - All the above, plus the Curve style can be chosen

Operation

Double-click - Adds add new key
Shift Double-click - Removes key
LMB Drag - Move key

Once you have created keys, you can select multiple by dragging the LMB over several at which point selected keys 
become green.
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Clicking off keys deselects as shown.
Selecting multiple keys also affects the choices from the dropdown options menu.

Choices are as follows:

Select All - Selects all keys in the gradient
Deselect - Deselects all selected keys
Lock - Locks selected keys so they cannot be moved. Locked keys have a red tick under the gradient instead of 
the usual yellow
Unlock - Unlocks selected Locked keys
Fit - Fits selected keys to the extents of the gradient window
Fit Reset - Restores the default Fit condition
Distribute - Spreads selected keys over the width of the gradient window with equal spacing
Reverse - Reverses the positions of selected keys. If none or one are selected nothing happens
Flip - Does the same but changing key position.
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Reverse and Flip difference
Erase - Deletes the selected key(s)
Zoom In - Zooms the gradient window in 25% to a narrower view
Zoom Out - Zooms the gradient window out 25% to a wider view
Copy - Copies the entire gradient to a LightWave clipboard
Paste - Pastes the entire gradient

Keyboard Shortcuts

Common:

Alt LMB - rolls gradient left and right

With Selection:

Ctrl LMB - Zooms gradient
Shift LMB - With vertical movement adjusts selected values
I/Shift-I - Makes selected keys inactive and active again
L/Shift-L - Locks and unlocks keys
Shift-A - deselects all keys
Cursor Left/Right - Selects previous next key in gradient. If multiple keys were selected before Left/Right only a 
single key is still selected after

Without Selection:

A - Select all keys in gradient
Ctrl+Alt+LMB - Zooms gradient
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Cel shading in LightWave 2019.1 now responds to light colors and intensities correctly.
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Sublimation CelShader

Click here to expand Table of Contents...

Zone
Specular
Opacity
Light
Edge
Misc

Zone

Sublimation always uses four color zones, that can set to any shade desired. The Min/Max values underneath are for 
where each band starts. By default, the next starts at the same place as the previous one ends, but by changing the 
values so that a Max value is smaller than the following Min value, you will create a softening of the border.

Two things are necessary for the Sublimation cel shader to work - the surface to which Sublimation is applied 
has to be Standard and lights need to be set to 1 lx. Also, Sublimation won't work with object shapes, and if 
you use the Opacity settings, Double Sided needs to be checked.



The easiest way to reset default values for the Sublimation shader is to switch the Shading model to a different 
shading model and back





LightWave 2020  –  LightWave 2020

Reference –  2896

•
•

•
•
•

Specular

The Specular tab gives control over specular highlights. The control will affect all scene lights (unless changed in the 
Light tab).

Color - The color of the spec hit
Min/Max - the minimum and maximum sizes for the spec hit. If Max is bigger than Min, the edge of the spec hit 
will be softer.
Type - The two choices are:

Rounded - The spec hit will be circular (when seen head-on)
Crescent - The circle will be made oblate
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Opacity

Allows creating transparency for one or more bands.
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Light

By default, Use All is checked, but you can select up to three specific lights to use.

Double Sided needs to be checked for the Sublimation surface when using Opacity!
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Edge

Enabling Edge will create a silhouette edge for the surface. It can be combined with other Edge settings found in Object 
Properties.

Misc

Unchecking the labels here returns grayscale values, instead of any colors you might have associated with the different 
zones. The grayscales are the percentages shown, which mimic the default values.
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Interchange

Click here to expand Table of Contents...
Collada Export Options
FBX Export Options
Export Alembic
MD Multi-Baker
Save 4.0, 5.6, 6.0, 9.2 Scene
Export as VRML97
Image List
Package Scene
OBJ Import
OBJ Export
DPX (Digital Picture Exchange) Image Loader/Saver

Collada Export Options

The exporter for Collada will save as a .dae file and offers the opportunity to scale the scene for use with other 
applications.

FBX Export Options
The exporter for FBX has different options, such as Binary or ASCII types, and allows you to save as different FBX 
versions.


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FBX Filename - This where you set the name of the FBX file and the location where it will be stored.
Export - Choose whether you want to export the Models and Morphs (Blend Shapes) in the scene.
Mesh Type - Cage (Subdivision Off) will export the object without any subdivision applied to it. Subdivision 
will apply subdivision to the mesh when it is exported.
Re-parent bone hierarchy - when exporting a rig from Layout with the bone hierarchy parented to the mesh, 
the actual movement of the deformed mesh is double of what it should be. Checking Re-parent bone hierarchy 
creates a null which acts as the new parent of the bone hierarchy, keeping the mesh in place.
Materials - LightWave’s standard Surface channels and image maps can be translated through FBX to appear 
correctly in a different application. Procedural textures and nodes cannot be translated.
Embedded Textures - Embedded Textures are image maps included in the FBX file directly, rather than as a 
separate image directory. Embedding will create much larger FBX files, but self-contained.
Smoothing Groups - Converts LightWave's normals into smoothing groups.
Collapse Materials - This switch will collapse surfaces with identical names, but there are some rules:

Material names match, and all surface parameters match - the two materials always get merged, 
independent of the export settings
Only Material names match - materials are exported separately, except when the collapse material setting is 
switched on

Merge UVs - Collapses multiple UV maps into a single map per object.
Unity 3D Mode - See below.
Cameras - Export a scene’s cameras in the FBX file.
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Lights - Export a scene’s lights in the FBX file.
Animations - Simple animations based on movement, rotation or scaling can be exported without baking. 
Character animation or other animation using IK or dynamics should still be baked, using the next item.
Bake Motion Envelopes - This will only be available if Animations is checked and allows you to set an arbitrary 
start and end point for baking, in case there are setup frames you do not wish to capture.
Scale Scene - This setting will scale the scene based on the input entered.

FBX support is to version 2016 to support the most recent version of Autodesk’s MotionBuilder™ at time of writing.

Please note that Camera Export from Maya to LightWave is only pixel-perfect when baking the envelopes in Maya since 
curves are interpreted slightly differently between applications. A command has also been added so that you can script 
FBX export. The command Generic_ExportFBXCommand has the following arguments:

<SceneFile>
<Version>
<ExportCameras>
<ExportLights>
<ExportMorphs>
<ExportModels>
<ExportAnimations>
<ExportMaterials>
<EmbedMedia>

Re-parent Bone Hierarchy - This option, off by default, lets LightWave deal with Maya scenes where a deformed mesh 
is not in the same hierarchy as the bones. In LightWave, we usually have bones parented to the mesh directly (that’s 
how LightWave understands what it has to deform using the bones). For a Motion Capture workflow to work properly, 
this option needs to be off.

The FBX and Collada exporters do not export information associated with plug-ins, including plug-ins shipped 
with LightWave. In addition, image maps will get passed into the FBX only for Standard or Principled BSDF 
materials with images in a UV-mapped Color T slot or Image node. The Image Sampler node does not work for 
export.



Unity 3D Mode switch

Both LightWave and Unity use "left-handed" coordinate systems but FBX is right-handed, which means 
LightWave has to convert to the right-handed coordinate system, and Unity has to convert from the FBX right-
handed coordinate system back to its left-handed system. The way to convert from left to right-handed 
coordinate systems is to invert one axis and change the sign of the rotations on the other axes. That means you 
have three choices: X, Y or Z. The typical choice is to do it along the Z axis, which LightWave does. Unity uses 
the X axis, which results in an apparent 180 degree rotation of the scene.

Another oddity on FBX import is the wrong rotation of Lights and Cameras, caused by Unity ignoring any pre-
rotation setting stored in the FBX file, so these need to be compensated as well, again only for Unity.

Using this switch means that when you go into Unity and look down the Z axis the imported FBX looks exactly 
the same as it does inside LightWave.


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Export Alembic

When you export an Alembic file, you now have the opportunity to include the active camera in the scene. Since you 
need to select the geometry you wish to export in Alembic, the Active Camera is the one you would switch to if you went 
into Camera mode. The Alembic exporter can export in either the rapid Ogawa format or the original HDF5 format for 
programs that don’t yet have Ogawa.

MD Multi-Baker
Bakes selected object animation to MDD or GeoCache file.

Save 4.0, 5.6, 6.0, 9.2 Scene
This command will save the scene data to the LightWave scene format for the numbered version to ensure that older 
versions of LightWave can read the file.

Export as VRML97

Image List
This command will save a text file that contains a list of every image used in a scene and its location.

LightWave Image List

6769194: LW_Box_Front.tga E:\images\Endo_Sliders\LW_Box_Front.tga

6769195: LW_Box_Back.tga E:\images\Endo_Sliders\LW_Box_Back.tga

6769196: LW_Box_SideL.tga E:\images\Endo_Sliders\LW_Box_SideL.tga

6769197: LW_Box_SideR.tga E:\images\Endo_Sliders\LW_Box_SideR.tga
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Package Scene
Package Scene gathers information from your scene and locates the items into the specified directory. You can choose 
to Package Files for transporting it to a different hard drive location, either locally or on another machine; Consolidate 
Files, which will bring any files that are currently not in your content directory into it; or Create a Zip Archive of your 
scene. This last is like Package Files but with the addition of archiving the content directory.

Package Scene is an LScript that uses only Lightwave/LScript commands to accomplish everything that the previous 
Content Manager tool did, but also will work with .MDD, .BDD, and .PFX files, and works whether or not your content is 
actually in the current content structure. If a content element is currently loaded into your Lightwave scene, Package 
Scene will find it.

Select the destination folder and if you want a new level under that for each subdirectory, type the name in the 
Subdirectory box. The paths will be updated after tabbing or pressing the Enter key.

After the interface in which you select the target directory for the export, the script:

Gets a list of all images and their paths.
Copies these images to the target directory.
Replaces all the images with their new location.
Changes the content directory to the target content directory.
Saves each object to the target location.
Saves the scene to a temp location.
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Parses the scene file to find .MDD, .BDD, and .PFX references.
Finds and copies the dynamics files to their target location.
Rewrites the scene file, changing the respective dynamics paths, to the target location.
Loads the new scene file. This means at the end of operations, the user is now active in the newly exported and 
saved version of the scene, not the original scene from the original location.
If Reload Original Scene is checked, it will instead load the original scene.

OBJ Import

LightWave will now import OBJs using Smoothing Groups and/or vertex color maps. Vertex Color maps need 
to be added to the surface nodal network with a Vertex Color node.

OBJ Export
OBJs textured with image maps or numeric values in other packages will come in textured but Nodal or procedural 
textures will not translate in either direction. Autodesk’s Maya™ and Max™ reverse diffuse and ambient, so the default 
behavior of LightWave now is to Reverse Ka & Kd for OBJ export. If you find that textures are being transferred 
incorrectly, try switching this off in Layout Preferences OBJ Tab or Modeler Preferences OBJ Tab.   OBJs exported from 
LightWave support continuous and discontinuous UV maps.
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DPX (Digital Picture Exchange) Image Loader/Saver

DPX is the most common digital intermediate format for scanned film plates, whether analog or digital. It is the sister 
format to Cineon, and it can hold more color depth than a PNG or TGA file with varieties at 10-bit, 12-bit and 16-bit 
being most commonly used. Many facilities convert DPX files into low res JPG files purely to act as proxies for 
background images in a scene for compositing against, but LightWave now offers the possibility to use DPX files in a 
scene directly. You can even save renders in DPX format, though this is not advised for typical visual effects productions.

Interchange Bridge
Unreal Bridge
After Effects
GoZ
MDD Multi-Loader
Alembic
MD Multi-Baker
Unity
Export as VRML97
The Hub

LightWave offers RGBA savers for the DPX file format in addition to RGB. However, few packages accept DPX 
files with an embedded alpha channel at the time of this writing. Do not use one of the RGBA savers unless you 
know that your destination package can open a DPX with an embedded alpha channel. For most production 
needs, the RGB savers should suffice.


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Interchange Bridge
Click here to expand Table of Contents...

Introduction
First Use
Left Column
Local Column

Local Options

Transfer
Transfer only animations

Remote Column
Import Options

The new Interchange Operator window presents two lists. The left list, or local, shows the current LightWave scene content. 
The right side - remote - is the FBX file currently loaded.



It is best to use the existing FBX Export right now. The Interchange Bridge works well for importing, less so for 
exporting in this initial implementation.


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Introduction

LightWave 2019 introduced the new Interchange Bridge for better importation and exportation of assets. An 
interchanger is the interface between files created in other applications and LightWave. For the moment, the only 
interchanger is FBX. There are three columns in the Interchange Bridge. On the left are general options and info, the 
middle section concerns items local to LightWave already in the current scene. The right section contains loaded FBX 
files brought in with the Read File button in the left column.

First Use

When you first open the Interchange Bridge panel, click on the Read File... button to add an FBX file to the right column 
headed Remote Assets. This will show the following window:

where you can choose the options for the FBX file you have chosen. Clicking on OK will add the FBX file to the right 
column headed Remote Assets. To add the whole thing to LightWave (either Layout or Modeler) drag the topmost entry 
- Scene - to the column headed Local Assets. Alternatively, click the left-pointing arrow between the Local and Remote 
columns. If you only want a specific part from the FBX file just drag the corresponding item. Whatever you have dragged 
should appear in the Layout or Modeler viewport(s) immediately (depending on the size of the asset).

Left Column

At the top of the leftmost column are:

Add Interchanger - Adds an additional FBX interchanger to allow for multiple FBX files in the same bridge. 
Useful for when you want to mix and match FBX file contents. You can have several interchangers active
Workspace - Tools to deal with the workspaces set by Interchangers. There are three options in the dropdown:

Reset - After a warning will reset the Interchanger window to its initial view with no interchangers
Save... - Saves workspace for later retrieval
Load... - Loads saved workspaces

Down the left side of the window are:
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The Interchanger workspace:

Interchangers can be right-clicked to rename or remove them

Read File... - This is where to choose an initial FBX file to import. Once determined, the following window 
appears, where you can select the options you want to include from the FBX file chosen:

Although there are many options listed here, LightWave does not currently understand or implement them all. 
However, if they are read from the FBX file to memory, they can be written back out.  They are not represented by 
any assets in the GUI and can not be transferred back and forth
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• Write File... - This is for exporting your scene in the Interchanger format, here FBX. When you click this button, a 
settings window appears where you can finetune your FBX export.

Although the number of options is smaller for writing out FBX files, the FBX API dictates the choices. Options read in 
will be written out

•
•
•

•
•
•

It is important to note the following

FBX has a concept of item position separate from the animation of the item.
FBX has a concept of poses, which store positions of item.
FBX has a concept of skin cluster binding, which can be separate from poses and animation and 
non-animated position.

Layout only has one concept, the animation

Frames less than zero to support these FBX concepts that Layout does not support directly.

Frame -1: the binding position (applicable when skin clusters are used)
Frame -2: the not-animated position (can be same as Frame 0, but may differ)
Frames < -2: poses (if any); each pose on a different frame.


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Scene Info... - Opens a window to input the LightWave (local) scene information in the FBX file for export

Unload - Unloads the FBX file from the scene. It is still shown in the Interchanger lister, and the FBX files will still 
be on disk
Scene Info - Technical details about the FBX file's content

Active Take / Active Layer - FBX files can contain several "Takes," different animations, and each take can 
include several layers that can be mixed and layered, much like LightWave's Motion Mixer. Only one Take, with 
one layer, can be active at any one time in LightWave.
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The Flatten Layers button here will collapse animation layers down to the selected take. Other layers are lost when 
the file is written out but can be reclaimed up to that point by reloading the FBX file with the Read File... button. 
Animation layers can be added to the stack as needed

LightWave List - Group the left lister in one of two ways: 
By Parenting - The standard LightWave hierarchical view

By Ownership - In LightWave, the scene is always the owner of all scene items - Lights, Cameras, Objects. 
Objects are the owners of bones.
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• Include Children of Selected - This toggle (that defaults to on) means you don't need to explicit select all the 
elements of a scene to import or export, just the parents of hierarchies - the scene entry, for instance, would 
transfer the scene setup plus all the objects, lights and cameras

Local Column

The middle column contains a view of your current LightWave scene. You can copy elements from your external file into 
this column piecemeal or load an FBX wholesale to add to a new scene.

Hit Rebuild to update changes
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Local Options

The Export Options panel contains settings for writing to FBX files

Reset - Return settings to hardcoded factory defaults

At the bottom of the panel, you will see:

Set Defaults - Click this button to record your current set of options as your default set
Get Defaults - If you have made changes to your usual defaults, clicking this button will restore your chosen set

Defaults you set are saved in your configs on disk and kept across sessions.

The next section deals with import settings that are common across FBX interchange within Layout and Modeler:

Vertex Map: Color - Enable exporting of LightWave color vertex maps to FBX vertex color layers
Vertex Map: Normal - Enable exporting of LightWave normal vertex maps to FBX normal layers
Vertex Map: Morph - Enable exporting of LightWave morph vertex maps to FBX blend shape deformers
Vertex Map: Bone Weight - Enable exporting of LightWave weight vertex maps to FBX clusters
Vertex Map: Texture UV - Enable exporting of LightWave texture UV vertex maps to FBX UV layers
Polygon Tag: Smoothing - Enable exporting of LightWave smoothing group ('SMGP') polygon tags to FBX 
smoothing layers
Polygon Tag: Parts - Enable exporting of LightWave part ('PART') polygon tag to FBX polygon group layers
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Layout

These options apply to Layout and not Modeler
Animation - When enabled FBX animation is exported according to the settings in the "FBX Animation" options 
panel. Although FBX animation is layered, LightWave supports a single animation layer; so, one must choose 
which FBX layer is active before the export
Animation Shift - This is an offset (in seconds) of the FBX animation time relative to the LightWave animation 
time
Animation Baking - FBX animation evaluation can differ from how LightWave evaluates animation. Animation 
baking allows FBX to store approximate or accurate versions of the LightWave animation. The exported 
LightWave animation is stored in the currently active FBX animation layer. It is possible to store different 
animations for the same asset by choosing a different FBX animation layer each time:

(none) - Don't bake at all. The envelope keys (key frames) in LightWave are mapped directly into FBX 
animation key frames. (see "Bake Rotation Order" below for how to interpret LightWave HPB envelopes)
Start Frame - Only the start frame of the animation is baked. The start frame is the time of the first 
keyframe. This is often 0.0, but does not have to be
Key Frames - Only the keyframes of the animation are baked, without any between frames. This is often 
sufficient for export to FBX
All Frames - All frames in the Layout preview frame range are baked
Frame Range - All frames in a custom frame range (from "Bake Range Start" to "Bake Range Stop" (in 
seconds)) are baked

Bake Rotation Order - The LightWave motion rotation order is presumed to be HPB (YXZ), but the intent may be 
different; especially if the animation was imported from an FBX using a different rotation order. The choices here 
are FBX-supported rotation orders of how to interpret LightWave's Rotation HPB channels
Displacement: MDD - Enable exporting of MDD displacement nodes as FBX vertex cache deformers
Child Bone Defines Skin - The skin in FBX is similar to a bone weight map in LightWave. Rigs in LightWave come 
in many varieties; sometimes, the weight map is applied to the child bone because of how an FBX rig was 
imported. This feature allows the export to compensate for this
Freeze Mesh - Use the mesh in its frozen state (deformations applied) before exporting as an FBX mesh
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Modeler

There are no Modeler options

Transfer

Two Transfer arrows between the listers will transfer the selected items from one lister to the other. If nothing is 
selected, the entire contents of a lister will be copied over. Equally, with the Include Children of Selected toggle 
checked, clicking on the Scene name will transfer the entire lister contents over. Items can be transferred by double-
clicking on them.

As of 2019.1, you can drag and drop between the local and remote columns.



LightWave 2020  –  LightWave 2020

Reference –  2917

Transfer only animations

Since 2019.1, the Interchange panel has two options for the Transfer Mode. You can either Append Assets or Replace 
Animation. Append Assets was the default functionality from before, but Replace Animation is new and can be used to 
transfer animation over items that are already animated. In this way, it can serve as an undo or an easy way to copy 
animations to multiple items.

Remote Column

The remote column contains assets in the target format, for now, just FBX. You can add items from one or more local 
scenes to a single FBX file, which will be written to disk once the Write File... button is clicked. Multiple Interchangers 
can be added, and each has its own remote display chosen by clicking on the integrator in the Workspace area of the 
panel.

2019.1 added specifying that remote assets will be brought in with Standard or PBSF materials with the Use Standard 
Material option (on by default). The surfaces will now be created similarly to the Surface Editor's Convert > Layered to 
Principled option. Images linked to a surface will be recreated using the Layered nodes.

Hit Rebuild to update changes
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Import Options

The Import Options panel contains settings for reading from FBX files. Again, user Defaults can be set, and this time the 
Modeler tab has further options relating to how objects will be treated when imported from FBX.

Reset - Return settings to hardcoded factory defaults

At the bottom of the panel, you will see:

Set Defaults - Click this button to record your current set of options as your default set
Get Defaults - If you have made changes to your usual defaults, clicking this button will restore your chosen set

Defaults you set are saved in your configs on disk and kept across sessions.

The next section deals with import settings that are common across FBX interchange within Layout and Modeler:

Layer: Vertex Color - Enable importing of FBX Layers that pertain to Vertex Color. These are mapped to 
LightWave color vertex maps
Layer: Smoothing - Enable importing of FBX Layers that pertain to Smoothing. These are mapped to LightWave 
smoothing features
Layer: UV - Enable importing of FBX Layers that pertain to UV coordinates. These are mapped to LightWave 
Texture UV vertex maps
Search for Missing Files - When FBX refers to external images and other files, they are usually expected to exist 
in an "fbm" (FBX media) folder. This is not always the case in reality. When enabled, this feature will attempt to 
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find files in nearby other locations and with potentially different file extensions. This can be turned off to find out 
if referenced files are not where they are expected
Pivot Mode - FBX supports multiple pivots, one for rotation and one for scale, while LightWave only supports 
one. In Layout, the pivot is used for both scaling and rotation. In Modeler, the modeling pivot is actually different 
from Layout but gets assigned during object load. This popup chooses which FBX pivot to assign to LightWave 
during import. Some understanding of the FBX scene may be needed to make the proper choice. One option is to 
ignore the pivot altogether
Unique Surface per Mesh - This ensures that each imported mesh does not share surfaces with existing meshes. 
This is more effective in Modeler than Layout when trying to segregate multiple imports that use the same 
surface name
Use Standard Material - FBX materials are normally mapped to a LightWave surface using the Principled BSDF 
material. As such, any texturing requires the use of the node graph. The Standard material, however, supports 
textures outside of the node graph and may be more comfortable to some users

Layout

These options apply to Layout and not Modeler
Animation - When enabled FBX animation is imported according to the settings in the "FBX Animation" options 
panel. Although FBX animation is layered, LightWave supports a single animation layer; so, one must choose 
which FBX layer is active before the import
Animation Shift - This is an offset (in seconds) of LightWave animation time relative to the FBX animation time
Animation Baking - FBX animation has a wide variety of evaluation possibilities that are not all supported 
natively in LightWave. Animation baking allows LightWave to store approximate or accurate versions of the FBX 
animation. Animation layers, rotation order, pivot effects, inverse kinematics are just some of the factors that 
may produce different results in LightWave versus the intent of the FBX file creator

(none) - Don't bake at all. The animation keys (keyframes) in FBX are mapped directly into LightWave 
envelope keys. Rotation order customization is not supported
Start Frame - Only the start frame of the animation is baked. This does not have to be at time 0.0
Key Frames - Only the keyframes of the animation are baked, without any between frames. This is better 
for editing than "All Frames", since only the keyframes need editing; but, the results will not always be 
accurate to the FBX intent
All Frames - The Layout preview frame range is baked for animation that will exist in Layout between 
that range
Frame Range - A custom frame range (from "Bake Range Start" to "Bake Range Stop" (in seconds)) is 
baked for animation that will exist in Layout between that range
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Deformer: Skin - Enable importing of FBX skin deformers that are mapped to LightWave weight vertex 
maps
Deformer: Vertex Cache - Enable importing of FBX vertex cache deformers that are mapped to 
LightWave MDD displacement nodes. Only positions are supported. The MDD node can understand Maya 
and Alembic files
Deformer: Blend Shape - Enable importing of FBX blend shape deformers that are mapped to LightWave 
morph vertex maps in a way that Morph Mixer can understand
Apply Skin To Child Bones - Bone Rigs specified in FBX can differ greatly based on which application 
generated the FBX content. LightWave does not support all industry-standard approaches to bone 
hierarchies. Some approaches use the bone tip as the location and some the bone base. In addition, the 
parent of the bone may be interpreted as the bone base or the higher level bone. LightWave has some 
bones options to help match the intent but the FBX skin (LightWave bone weight map) may still be 
mapped to the wrong LightWave bone. This option chooses to apply the weight map to the child bone, 
instead of the expected bone, just to get the evaluation to be correct. This can result in extra tip bones 
being generated to specify the proper weight maps. Good knowledge of the FBX rig is needed to make the 
best decision whether this option should be used
Transfer Scale To Mesh - Enable transforming the mesh vertices by the scaling on import. This can help 
deal with differences in how scale is interpreted by FBX and LightWave, including the effect of negative 
scaling. By scaling the mesh prior to higher-level transforms, a final transform can often be more as 
expected. For simple, compatible scaling effects, though; this should not be necessary. Knowledge of the 
FBX scene construction may be needed to make the best judgment call here.

Modeler

These options apply to Modeler and not Layout
Transform Level - This determines what level of FBX evaluation is performed on the FBX mesh and then treated 
as the static Modeler mesh:

None - Do not apply any transform evaluations. This is most like the modeled vertex coordinates
Geometry - evaluate only the FBX geometry transforms
Local - Evaluate geometry and other local transforms
Global - Evaluate all transforms to obtain the global coordinates of each mesh vertex

Transform Time - When evaluating transforms, this determines the animation time (in seconds) at which to 
evaluate
Mesh Destination - A dropdown menu with four choices:
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Combine - All FBX meshes are combined into a single Modeler mesh layer
Separate Layers - Each FBX mesh is imported to its own Modeler mesh layer
Separate Objects - Each FBX mesh is imported to its own Modeler object (with a single layer)
Custom - Each FBX mesh is assigned a layer and object based on the order it is processed and the 
settings for "Meshes per Layer" and "Layers per Object". This is useful when trying to combine hundreds 
or thousands of FBX mesh parts into a more manageable number of Modeler objects and layers
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Unreal Bridge
Click here to expand Table of Contents...

Introduction
Installation
First Use
Advanced Connection Settings
Preparing LightWave content for Unreal

Supported for transfer

Realtime content created by Tony Prohl for the VR/AR Industry

Introduction

Unreal Bridge is a real-time workflow link between the Unreal Engine (v4.20 and newer) and LightWave, focusing on 
LightWave driving Unreal changes. It can be limited to single project use in Unreal or installed as a general plugin for 
use in all Unreal projects. The Unreal Bridge will transfer objects, materials and animation from LightWave to Unreal to 
create a powerful realtime system that can leverage Unreal's powerful capabilities for presentations, games and more.

Installation

In LightWave, Unreal Bridge is a Master Plugin that can be opened from the I/O tab in Layout. To install for the Unreal 
Engine, go to your LightWave install and select the lightwavebridge folder in support/3rdparty_support/
UnrealEngine/[version] and:


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copy the contents to your Unreal Engine install folder under 
YOUR_INSTALL_LOCATION\Engine\Plugins\Editor for system-wide access (Users/Shared/Epic Games/
UE_4.xx/Engine/Plugins/Editor on the Mac),
OR
create a folder called  Plugins in your Unreal project and copy the Lightwavebridge folder there for single 
project use

Launch the Unreal editor. If you have installed lightwavebridge for single project use, the plugin will be automatically 
activated. If you have installed system-wide, you will first need to activate the Unreal-side lightwavebridge plugin:

When you restart Unreal after installing the LightWave Bridge plugin system-wide, you will get a message telling you 
"New plugins are available." Clicking "Manage Plugins..." you can activate the LightWave Bridge. You can also visit Edit > 
Plugins to activate. You will need to restart the Unreal engine once LightWave Bridge is activated.

First Use

Unreal
Once installed, and activated as necessary, visit the Unreal Engine preferences and in the Performance tab 
uncheck Use Less CPU When in Background - this is only necessary to allow the real-time updating between UE 
and LightWave. If real-time updates are not crucial for your project, you can leave this setting checked and 
simply Send from LightWave when necessary.
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LightWave 3D
In LightWave, change the color space to sRGB to match with Unreal and go to the I/O tab to launch Unreal 
Bridge. Start by clicking the Connect button to link LightWave to the Unreal Editor.

Check the options required:
Overwrite options:

Overwrite Meshes - will update meshes on the Unreal side
Overwrite Materials - will update materials on the Unreal side
Overwrite Transforms - will overwrite any transformations made on the Unreal side
Bake Animation - will create baked keyframes for all scene animation

Live Sync - Will send updates to Unreal in real-time while you interactively edit in LightWave
Items to Sync - Use "Selected" to limit interactive synchronization to the currently selected scene 
items

Items to Send - Use "Selected to limit the following "Send" actions to the currently selected scene items
Send - Send scene items limited by the "Items to Send" selection
Send Transforms Only - Sends only transforms of items limited by the "Items to Send" selection
Send Animation Sequence - Sends animation envelopes of items limited by the "Items to Send" 
selection
Fetch Transforms from Unreal - this performs a single grab of the current state of Transforms from 
Unreal to bring them back to Layout

Unreal
Start by creating a new project with no Starter content. Once the editor window is open, remove everything from 
it apart from the PlayerStart item to start with a blank slate. Now change back to LightWave.
LightWave 3D
Add a polygonal object to your scene and convert its surface(s) to the Unreal material. Now you can send it to 
Unreal. You can also create keyframe animation for your object and send that through as well, as a separate 
operation.
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5. Unreal
Changes to animation or transforms will not carry back through to LightWave. Make those changes in Layout to 
avoid any confusion. In Unreal, make changes that will affect your game or presentation's code.

Advanced Connection Settings

Clicking on the "Advanced Connection Settings" button on the Unreal Bridge panel will open the following dialog:

In the "Unreal IP Address" input field you may enter the IP address of the Unreal instance to which you wish to connect.

Alternatively, you can select one of the Unreal Instances discovered in your network.

The change is only applied after you press the "OK" button.

If you have used the Send Animation Sequence in The Unreal Bridge plugin to transfer LightWave keyframe 
animation into Unreal, you will need to set the playrange for the animation to plaback. Do so by double-
clicking on the animation icon in your Content Browser to bring up the Sequencer.

You need to set the playhead to 0, if not already there, and click the left square bracket icon to set the start of 
your range. Then, you need to go to the end of your animation and click the right square bracket to set the end 
of the animation range. Now, the animation will play in Unreal's editor.


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Preparing LightWave content for Unreal

There are always strictures when making content for a game engine, and Unreal is no exception. Right now, these are 
the main points for LightWave use.

Supported for transfer

Meshes
Positions
Normals
UVs (maximum of seven UVs per object, not layer; no overlaps allowed)
Color Maps

Nulls
Lights - Supports basic light settings like color and intensity 

Point Light
Spherical Light

Size

Linear Light
Length

Spot Light
Cone Angles

Distant Light

Cameras
Field of View

Materials
In principle, all Materials are supported, but only the Attributes with the same name as in Unreal are sent.
They are:

Base Color or Color
Roughness
Specular
Metallic
Emissive Color
Opacity or Transparency

Unreal will use a material connected to the OpenGL surface input in preference if one exists (allowing for 
a rendered material and a realtime one simultaneously)

Transformations
Keyframe Animations can be sent optionally

The Unreal Bridge plugin allows multiple connections to the same Unreal instance, enabling collaborating on 
the same scene by multiple artists if desired.


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Dynamic animations can be sent baked

Parenting
If the parent of an object exists in the Unreal level/world, the sent object will be parented to it
If the parent of an object does not exist, it will be parented to the Unreal level/world root

Alternatively, if an Actor of the name LightWaveAnchor exists in the Unreal level/world, the new 
object will be parented to it

Parenting information is sent with every update, and parent relations will be updated in Unreal on 
incremental sends

When editing material properties in Modeler for a LightWave asset that is being sent to Unreal, it is important 
to remember that the LightWave Bridge is converting standard LightWave texture projections (Planar, 
Cylindrical, Cubic) to UV maps on the fly. This means that sending materials only is not sufficient, the mesh 
also needs to be sent. Note, this is only for objects using standard texture projections. Objects using UV maps 
already will update fine without needing to resend meshes.


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Example - Using Unreal for Real-Time Architectural Visualization

Click here to expand Table of Contents...
Introduction
1 Objects
2 Surfacing

LightWave Materials
Octane Materials

3 Lighting
4 Scene

Introduction

The Unreal Bridge is a massive boon for LightWave artists, but using a game engine for real-time visualization of your 
architectural project will possibly require some changes in your workflow.

1 Objects

All objects for the scene you wish to send to Unreal must be UV mapped for texturing. Where LightWave does not limit 
the number of UV maps for objects, Unreal does and while Unreal supports up to seven UV maps, restricting your UVs to 
a single map with no overlaps is possibly the best approach (if you use multiple UV maps, they are always ordered with 
the first for texturing, the second for lightmapping - with no overlapping UV islands - and then the others as you like). 
Unreal does support UDIM so your single UV map can comprise many tiles, but UDIM support in Unreal is awkward 
currently. The "one UV map per object" rule means that massive objects with many layers comprising all the elements 
for your archviz project can still only have one UV map, not one per layer. A better workflow to counter this issue is to 
have simple objects that you put together in Layout, not Modeler. Doing so will also make it far more likely that you will 
have pivot points for said objects at the origin, rather than in some random place.

2 Surfacing

Surfacing for LightWave proceeds in two fashions these days - either you have Octane, or you don't. The vast majority of 
LightWave users use LightWave's own Surface Editor or Nodal surfacing, and it's here we'll start.

LightWave Materials

Unreal will use its own nodal surfacing in the form of the Unreal material but is also content to work with standard 
LightWave materials like PBSDF, Dielectric, and Conductor, so it may be that to present an object for Unreal use takes 
very little adaptation, if your nodal components are compatible with Unreal. Here are the material components that 
Unreal looks for:

Base Color or Color
Roughness
Specular
Metallic
Emissive Color
Opacity or Transparency


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If your surfaces are already using these material components, then you are good to go. If you are using materials like 
Carpaint, you may have to be a little more inventive to get the same results in real-time than merely applying the 
Carpaint node.

Octane Materials

Octane materials won't work inside Unreal, so nodeflows for images etc. will need to be duplicated with regular 
LightWave nodes. To not affect your existing Octane workflow, these duplicate nodes can attach to an Unreal material 
node hooked to the OpenGL Surface input.

3 Lighting

Talk about luminous surfaces and real lights (duplicating Octane lights is needed).

4 Scene

Unreal works with LightWave instances. xxx

Converting clip maps for Unreal

Right now, LightWave does not convert clipmaps automatically so if you want to do it manually, you need to 
bring your object into Unreal, add the image(s) into the content browser as necessary, and hook them to the 
appropriate connections by hand. Open the Unreal Material Editor for the surface you wish to clip map and 
drag the image you wish to use into the node editor. Drag the color connection to Material node's Base Color
input, and the bottom Alpha output to the grayed out Opacity Mask input. To activate the Opacity Mask input, 
click the destination node and on the left side of the node editor change the Blend Mode of the material from 
Opaque to Masked.


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After Effects
LightWave offers a bidirectional link between LightWave and Adobe After Effects CS5 and higher. This link can deal with 
cameras, lights and nulls. To set up After Effects to make it ready to communicate with LightWave, you need to activate 
full scripting features in After Effects.The default is for scripts to not be allowed to write files or send or receive 
communication over a network. To allow scripts to write files and communicate over a network, in After Effects choose 
Edit > Preferences > General (Windows) or After Effects > Preferences > General (Mac OS), and select the Allow Scripts To 
Write Files And Access Network option.

 
The other step you need to do is to copy the AEtoLW.aex file from LightWave2015/support/3rdparty_support/
AfterEffects to your After Effects Plug-Ins folder normally found in Adobe/Adobe After Effects CS5 (or higher).

In Layout the AE link is on the I/O tab in Layout where there are two buttons.

Send to AE sends your scene to After Effects and the Settings button allows you to change the path After Effects is 
installed on after the first use where you are asked for the path. If you have multiple versions of AE installed select the 
one you want to use with the Settings button.

You can send multiple selected layers from After Effects to LightWave at the same time. Simply select the layers you 
wish to send in After Effects and use the File > Export > Send Selected Layers to LightWave.

Select your scene’s camera and hit the Send to AE button. If After Effects is not running it will start and your camera will 
appear in a new composition named Default. If After Effects is running the item(s) sent from LightWave will appear in 
the currently active composition. You can undo this action in After Effects.

Make sure your layers in After Effects and items in LightWave have unique names since it is those names that 
are used to match with LightWave scene items.


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Once taken to After Effects and modified, you can send the camera and reference nulls back to LightWave using the File 
> Export > Send Selected Layer to LightWave 3D menu item. Make sure you have the After Effects camera selected for 
this to work. LightWave will appear with a camera with a baked motion path. You can repeat the same operation with 
reference nulls if you have any. Be aware that as of this time, only one item at a time can be sent.

If required, you can reset the path to LightWave in After Effects using the Edit > Preferences > Reset Path to LightWave 
3D menu item.
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GoZ
Setting Up GoZ™ for LightWave

LightWave support of GoZ by ZBrush
GoZ for Modeler
GoZ for Layout

Multi-Tool Support
Examples
Additional GoZ™ Notes

GoZ™ support is available in both Modeler and Layout. As with any data interchange there are certain ideal workflow 
practices to be aware of to achieve the best results. You should prepare geometry with tri and quad polygons only. 
ZBrush™ also expects one surface name and a single UV map on the object.

Our GoZ implementation is flexible enough to allow you to work in a variety of different ways.

You can begin your model in LightWave Modeler and send to ZBrush to create the UV map and paint your color texture 
map and generate your displacement and normal maps for the object. Then with a press of the GoZ button in ZBrush 
you can load the changed model back into Modeler and your shaders will be automatically applied to the object 
containing all color, displacement, and normal map information. Our LightWave Modeler GoZ implementation allows 
you to send an Endomorph on your object for further sculpting to ZBrush and back to Modeler. Imagine the facial 
targets and other effects you can create with this technique.

Alternatively, you could begin the model in ZBrush and use GoZ to send your sculpt to Modeler for more detail, then go 
back to ZBrush to continue sculpting. You could then send your final result directly to LightWave Layout, again with all 
the texture, displacement, and normal map shader information automatically set up. In Layout, even your bump 
displacement will be automatically set up on the object with the bump distance supplied by ZBrush to make it easier for 
you to get to the render quickly.

Setting Up GoZ™ for LightWave

For our purposes here we will assume you have already installed and are using ZBrush and now you would like to add 
LightWave to your sculpting pipeline.

For Windows users, normally the installation of LightWave sets up the necessary links with ZBrush, but just in case and 
also for OS X users, here are the steps to ensure communication between the packages:

LightWave support of GoZ by ZBrush

ZBrush “out of the box” doesn’t have built-in support of LightWave. LightWave itself supports GoZ. You, the end user, 
needs to copy a few files into the right location to activate this support inside of ZBrush.

LightWave GoZ support files are located here:

Windows: C:\Program Files\NewTek\LightWave2018\support\3rdparty_support\GoZOS X: ~Applications/
Lightwave2018/support/3rdparty_support/GoZ
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With LightWave and ZBrush NOT RUNNING, Copy both the LightWaveLayout and LightWaveModeler directories 
from that folder to:

Windows: C:\Users\Public\Pixologic\GoZApps\ OS X: MacHD:/Users/Shared/Pixologic/GoZApps/
Now launch ZBrush and open Preferences and choose GoZ at the bottom.You will then find LightWave Layout
and LightWave Modeler

From there, you can have ZBrush find the install - or you can point it there yourself.

Load the model you wish to sculpt in either Layout or Modeler. In Modeler it is the current foreground layer (or the 
selected endomorph) that will be sent while in Layout it is the currently selected object. Now go to the I/O tab in either 
application and choose GoZ. The first time you do so there will be a slight pause as LightWave copies the necessary files 
to your ZBrush installation and then you will be in the ZBrush interface waiting to draw your object onscreen as a tool. 
Once done and modified to your satisfaction, pressing the GoZ button at the top right of ZBrush’s interface will send 
your object back to LightWave, now with the additional sculpting.

Here is an overview of what GoZ offers in both LightWave Modeler and Layout:

GoZ for Modeler

Geometry (tris and quad polys required)
Color Map
Displacement Map
Normal Map
Endomorphs
UV maps can be created in Modeler or ZBrush. ZBrush only supports one UV map per object.
The shader nodes are set up on the object but are not all present in Modeler. You need to open the object in 
Layout to access or edit all the nodes.
Sub Tools are separate objects and that is how you should think of them in Modeler, not additional layers.

GoZ for Layout

Geometry (tri and quad polys required)
Color Map
Displacement Map
Normal Map
Bump Displacement (with bump distance automatically supplied by ZBrush)
When you send your ZBrush Item with Color, Displacement, and Normal map to Layout nodes are automatically 
set up on the object and bump displacement in the object properties is activated.
There is a continuous update of texture maps as long as you are painting to actual texture maps in ZBrush and 
not just poly painting.
You can see your displacement and normal maps with VPR.

Finally, note that if you change the geometry or polygon count in the middle of your process then vertex maps could be 
lost when exporting back to Modeler or Layout. This means you should get your geometry up to a certain level where it 
has enough points and polys to hold the sculpted detail when you “res up” in ZBrush. Do your sculpting and painting at 

If you select an endomorph in Modeler to send to ZBrush via GoZ, sculpt that endomorph and then send back 
to Layout instead of Modeler the base mesh will be overwritten. Always select the endomorph that you want to 
send and then make sure that same endomorph is selected on the object in Modeler before exporting back 
from ZBrush.



http://MacHD/Users/Shared/Pixologic/GoZApps/
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that higher resolution level then when you hit GoZ in ZBrush to send back to LightWave the resolution automatically 
gets lowered back down to the base mesh. This is the typical workflow most often used with ZBrush and other 
applications.

Multi-Tool Support

LightWave can export Sub-Tools from ZBrush into LightWave. Sub-Tools come into LightWave as distinct objects, rather 
than the usual LightWave layered object concept. To send Sub-Tools, use the All button next to the GoZ button as 
shown.

Examples

Example - Using ZBrush to Edit Morph Maps
Example - Converting ZBrush Fibermeshes to FiberFX guides

Additional GoZ™ Notes

Surfaces and UV Maps - Don’t forget that ZBrush only expects one of each and will discard any others you have in 
your object. Make sure that if you have several of either you reduce them before sending to avoid losing your 
work.
Saving your objects - It is a good idea to save your sculpt as a ZBrush tool. In case of any problems or wanting to 
continue work started before, saving the LWO from Modeler alone will not keep your sculpting information.
Object assemblies - If you want to sculpt an object assembly as one piece in ZBrush, make sure the parts are 
separate objects (not just layers) and tick Import as SubTool in ZBrush GoZ Preferences.
Cache - to perform the task of shifting data between ZBrush and LightWave, ZBrush has a directory of 
intermediate files. These are normally kept in C:\Users\Public\Pixologic\GoZProjects\Default on a Windows 
system and /Users/Shared/Pixologic/GoZProjects/Default on a Mac. These temporary files are not automatically 
deleted and can take lots of room. If you see messages asking if you would like to use the object from disk, it is 
almost certainly because your ZBrush cache already has an object by the same name in it. You can clear this 
directory safely (when no GoZ process is running). Alternatively in ZBrush GoZ preferences there is an option to 
clear cache files.
Layout or Modeler? - When you first start sending your object between LightWave and ZBrush, you will possibly 
begin using GoZ with Modeler to initially prepare your object for sculpting and texturing. Once you are happy 
with this first stage, you can tell ZBrush to start sending to Layout instead. To do this, can click the ‘R’ icon on 
the ZBrush interface near the GoZ button to change which application GoZ communicates with. In this case, 
change it over to use Layout rather than Modeler.
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MDD Multi-Loader
Click here to expand Table of Contents...

Top Row
Left Panel
Right Panel

Frame Offset
Replay Speed
Options

MDD Multi-Loader, available from the IO menu tab, or the Load > Import group, associates geometry with matching 
vertex cache files. A check by the item in the left window indicates when a match has been made. Here is a description 
of the elements in the window one by one:

Top Row

Once MDD files populate the right window, the buttons at the left become available:

Match By... - Clicking this button will match the caches in the right panel with the objects in the left panel. By 
default, the matching is done by name, but there are further possibilities
Names - This dropdown list presents four choices:
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Names - Caches are matched with objects on the basis of their filenames. This is the default and usually 
works well. Be aware that if filenames have spaces in them, MDD files created with the MultiBaker will 
replace spaces with underscores. Such entries will need manual matching
Points - Compares the point count of the object with the point count in the cache file
Points & Name - Compares and only matches if both point quantity and filename are the same
Points or Name - Matches if one of other criteria fit

Cage - A dropdown with three entries:
Cage - Matches by point count for the base object before subdivision
SubD - Matches by SubD point count
Cage + SubD - Compares both

Assign Random - Assigns a random cache file to an object. Useful for when similar objects need to have different 
motions
Unassign - Available when an object with a cache associated is clicked on. Removes the association.
Unassign All - Removes all cache associations
Add MDD File(s) - Opens a requester to choose one or more MDD files to load
Scan Folder - Dropdown with two entries:

Scan Folder - Opens a Folder tree to choose a vertex cache folder from
Recursive Scan - Recurses through directories to find caches in subfolders

Remove MDDs - Removes selected MDDs
Clear All MDDs - Clears the MDD list

Left Panel

Contains a list of scene items for which there may or may not be MDD files. As such, the list is populated only by 
geometry, with no lights, cameras or null objects. Under the list there are several options:

Object Layer Names Only - Normally, if an object is on several layers, it is represented in the list by the object 
name, then underscore, then the layer name. With this option checked, only the Layer Name will be used to 
identify items. Use this toggle for visual clarity once you have matched your vertex cache files.
Ignore Clone Suffix - Turns off the clone suffix for visual clarity. Use this toggle once your vertex caches have 
been matched.
Name Match Tolerance - Uses Levenshtein matching of text to match based on tolerance. The default 0 % 
tolerance means exact matches only. Increasing the tolerance can help in the case where cache filenames have 
been altered to suit storage needs, but caution is advised when using this.
MD Multi-Baker Clone Names - When MDD files are written to disk, the filenames are changed because of 
filenaming conventions. The "object (1)" you see in Layout becomes "object_1_" when written to disk. This 
toggle changes the names in the left panel to match the naming style used for the cache filenames, to make 
matching easier.

Right Panel

At the top of the panel, there is a list of all loaded MDD files. Under this list is a check to show MDD Paths, then options 
for randomizing MDD playback as follows:

Matching manually can also be done by clicking the object first, then the MDD you wish to associate it with.
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Frame Offset

Options to vary the start frame for MDDs. An overall offset can be used, or a random offset with minimum and maximum 
offsets. There is additionally an option to allow for Fractional Frames.

Replay Speed

An overall speed change can be specified or a random speed for each item with a minimum and maximum.

Options

A variety of options to use for all caches used (If you wish to alter on an individual basis go into each items' MD Reader 
panel) :

End Behavior - A choice between:
Stop - the MDD playback stops when it reaches the end of recorded frames
Loop - MDD playback keeps playing in a loop from the first frame
Comp - Replaces the vertex positions between beginning and end of the cache, but leaves the points as 
they are otherwise
Ping Pong - MDD playback plays through and when it reaches the last frame plays backwards through 
the recording

Coord Space - A choice of Object or World (defaults to World)
Match By - A choice of Coordinates or Point Order (defaults to Point Order)
Vertex Cache Units - A number field is followed by a choice of Meters or centimeters
Clear Existing MDDs - Defaults to on and replaces any MDDs already on an object when this panel is Okayed
Reset MDD Settings - Resets all values to their defaults
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If your objects are subpatched, they will not be displaced by the MDD before it has been moved before the 
Subdivision entry in Object Properties.


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Alembic

Alembic Support

Alembic is an open-source object and scene format that was created primarily by Sony Pictures Imageworks and 
Lucasfilm and presented at SIGGRAPH 2011. It is supported by most production 3D packages and LightWave 3D 
introduced support for Alembic v1.5.5 in 2015. Unlike MDD files that are point-based, Alembic supports polygons and 
subdivision-surfaced objects. In LightWave it is similar to using Load from Scene in that it doesn’t overwrite an existing 
scene file, but instead adds an object, or several, to an existing scene. Objects brought in with Alembic are purely 
controlled by the baked animation and cannot be moved, rotated or scaled otherwise.

Overview of Controls

Importing Alembic

Unlike most other packages, LightWave supports replacing an Alembic file while the application is running, but 
you should avoid working in Layout until the new version of the Alembic file has finished writing!


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To import Alembic .abc files into Layout you need to either visit File > Import > Alembic Loader, or the I/O tab and 
choose Import > Alembic Loader. A window will present a choice for scaling the Alembic file and for importing the file in 
a hierarchy with the selected item in Layout. When Alembic files are brought into Layout, two things happen. The first is 
that all the objects contained withint the Alembic file are converted to LightWave objects (LWOs), then second is that 
each object gets a Motion Modifier (AlembicMotionController) that deals with differing rotation orders, and a Deform 
modifier (MD_Reader) that handles deformation of the object.Surfacing is not maintained through Alembic but multiple 
Alembic files can be brought into the same scene. Dynamically-generated geometry is not currently supported.

Exporting Alembic

To export to an Alembic file you need to have the objects selected that you wish to export. Items to be exported can be 
nulls as well as geometry and things like Bullet dynamics are taken into account. Items will be baked to create the 
deformation/motion, so simulations are converted into frame-by-frame keyframe animation. The Alembic Exporter now 
allows you to export the active camera in addition to objects from your scene. To do this, in Camera mode, choose the 
camera you wish to export. Then, go into Object mode and select the objects you wish to export and then choose I/O > 
Export > Alembic Export and check the Export Active Camera option.

You can choose whether to use the standard HDF5 export format or the new Ogawa format for applications that support 
it.

Objects exported to Alembic can only have a single UV map. If there are multiple maps on an object, only the 
first will be taken.


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MD Multi-Baker

Similar to MD_Bake, MD Multi Baker contains the following options for exporting motion data and objects:

Output Directory - This sets the directory where the MDD files will be saved. The default directory is the 
VertCache folder of the scene’s content directory.
File Format - Determines the file type the motion data will be saved as.
Bake Mode - Sets what the motion data will record. Some file types only recognize data from specific mesh 
types.

MDD - LightWave’s own motion data cache format
GeoCache Single - Motion data is saved as a single vertex cache
GeoCache Multi - Motion data is saved for every frame as individual files. If the motion cache file will be more 
than 2 GB in size, this mode becomes necessary if you are using MC mode. MCX mode allows for files bigger than 
2 GB.
MC/MCX - This option only becomes available when GeoCache Single or Multi are chosen as the cache format.

Cage Only - The cage is the mesh before any subdivision is applied. Choosing this option will apply only motion 
data of the cage.
Subdivision Only - Subdivision occurs after the cage. Choosing this option will record only the subdivided mesh 
data.
Cage and Subdivision - This option will record both the cage and subdivided mesh data.
If you would like to export the objects as an OBJ file, select Save OBJs.
If you would like to export the objects as a LWO file, select Save LWOs.
First Frame - Sets the first frame to start recording on.
Last Frame - Sets the last frame for recording.
Frame Step - Sets the number of steps for recording. A setting of 1 will record the next frame, while a setting of 2 
will record every other frame.
Up Vector - Sets the up vector. Consult your specific software package to determine which direction the Y-Axis is 
set but most packages, including LightWave, set the Y-Axis to up.

One advantage for MD Multi Baker over MD_Bake is that it can export multiple object’s motion files at once. Select all of 
the objects you would like to export and activate MD Multi Baker. After selecting the settings desired, select OK and MD 
Multi Baker will bake out all of the motion data for each object you have selected. Each motion file will have the name of 
the object from which it originated.
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Example - Baking Simulations
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Unity

Unity Interchange

xxx

LightWave can save scenes for Unity to enable a seamless transfer between the two programs.

It is important to note, to avoid disappointment, that Unity is a very different beast to LightWave, with different 
restrictions and benefits. There is a certain workflow to follow to ensure that your Unity scene works as well as your 
original LightWave scene.

First things first, Unity is a game engine. It can create beautiful imagery but:

Everything is dependent on UV mapping;
A maximum of two UV maps per object are allowed;
Procedurals, gradients, clip maps and nodes will not carry across - everything needs to be baked to image maps.

LightWave’s node system is a great benefit here. If you can texture your scene as you would like using nodes, then bake 
out those textures to use as image maps in LightWave’s layered system then you can keep both ways of texturing in the 
same scene. If not, then you will probably want to set up a second content directory containing your scene repurposed 
for Unity.

It is probably best not to assume that your delicate surfacing in LightWave will carry across and actually texture in Unity 
where possible, using LightWave to model the geometry and place lights, etc. Transferring surfaces between LightWave 
and Unity will use LightWave’s Color channel (Diffuse in Unity) and Luminosity channel (a second channel in Unity, 
usually used for Lightmaps, but also for Bump/Normal maps). The example scene provided in the 11.5 content shows 
various surfacing techniques in LightWave and how they translate.
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 Example: Texturing in Unity

(Texturing_in_Unity.7z, 2.36 MB)

We’ll use this scene to get to grips with how texturing works in Unity. If this is your first taste of Unity, install it, 
and in the Hub that opens choose a new 3D project. The Editor will then load and present you with a view that 
will look familiar but with side panels that decidedly don't. We need to install the LightWave applink for Unity to 
make sure that we can send items to and fro. In the Assets menu, choose Import Package. Go to the LightWave 
install directory > Support > 3rdparty_support > Unity3D, and choose LightWaveAppLink.unitypackage. 

Go to the folder you have created for this project and you will find an Assets directory in it. Copy the above 
content folder into it. You should only use this version of the scene when you want to modify your Unity project.

Open the scene in Layout and hit S. This saves the scene and tells Unity that something has changed. Unity will 
re-import the scene as an FBX file.

https://docs.lightwave3d.com/download/attachments/8199952/Texturing_in_Unity.7z?api=v2&modificationDate=1594385863000&version=1
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In Unity, click the FBX version of the scene file and in the Inspector panel on the right set the Scale Factor to 1.0. 
Drag the icon into the Hierarchy window on the left side of the screen. The FBX version is the icon with the image 
of the scene rather than the LightWave logo and is highlighted in the image above.

Now we will go through the textures in Unity, because you can see right away that they are not the same as those 
in LightWave. Right away, you will need to unpack them to make them available to edit as you will see they are 
ghosted if you try to edit them, as they are, on each object. To do so, click on the FBX file again. In the Inspector, 
on the right, you will see there are four sections - Model, Rig, Animation, and Materials. Click Materials, then 
Extract Materials. You will be asked to select a folder to save the extracted materials into and I'd suggest you 
simply add a Materials folder to the content directory you are using.

Clip - Change the Rendering Mode to Cutout and you should get a clipmap-like behavior.

Tex_Bump - This is the most awkward one. Unity has assumed that this and the Tex material are the same 
because they have the same image in the Color channel in LightWave. We need to make a new Material in Unity. 
Do so by right-clicking in the Project window and selecting Create/Material. This will put a new material in the 
Assets/Texture/Scenes/Materials folder ready to be named. Call it Tex_Bump, change its Shader to Bumped 
Diffuse, select the UV-Fill image as the Base (RGB) image and the UV-Fill_BMP image as the Normalmap. You 
will be told that the image chosen isn’t a Normal map, but do not click the Fix Now button. Instead, find the 
image and click on it and change its type to Normal map in the Inspector and hit Apply.



LightWave 2020  –  LightWave 2020

Reference –  2947

•
•

•

•

 

Lastly, go back to the Materials folder and drag and drop your new Tex_Bump material onto the appropriate 
polygon in the viewport. There is a second way of importing the scene so that this issue doesn’t come up. Before 
you drag the scene into the Hierarchy list in step 5, click on the scene and look at the Inspector pane.

 

Note the Material Naming dropdown at the bottom of the image. By default it is set to Base Texture Name, but 
set it to From Model’s Material and you shouldn’t have the problem described above.
Tex - This one should have come in okay. You should just change the Shader to Diffuse.
Bump - This one is nearly okay. Change the Shader to Bumped Diffuse, clear the image in the first slot and put 
the same image in the second slot. The same warning will appear about it not being a Normal map, so repeat the 
process from before of finding the image, changing it to Normal map and hitting Apply.
Proc - As you know, procedural textures don’t travel between applications so they have to be baked, so for Unity 
this surface is the same as the Tex surface. You should just change the Shader to Diffuse.
Floor - Change the Shader to Bumped Specular and set the Normal map to FlrTile-Bump. You will need to 
change it as per Bump and Tex_Bump.
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You have now brought your LightWave scene into Unity and converted the surfaces into Unity materials. Any 
time you make a change in LightWave and save the scene it will be reflected in Unity, but this means that you 
may have to revisit some of the steps listed above to get things right again. To take things further and create a 
walkthrough, you can add the following Components:

Camera:
Physics/Mesh Collider

Character/Character Controller
Character/FPS Input Controller
Camera-Control/Mouse Look
Floor Object:

Now you can hit the Edit > Play command and your camera should fall to the floor where you can pilot it using 
the FPS controls of the WASD keys and your mouse.

The first time Unity uses the LWS importer it will ask for the path to your LightWave directory and the path you specify 
will be remembered across sessions. If you would like to use a different path, use the “Unity > LightWave > Choose 
LightWave Install Path” menu button:
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Additional Unity Interchange notes

Unity does not support animations with a scale of 0. For scenes where you will have explosions or other things 
that require a scale of 0 in LightWave, use a very small but non-zero value.
LightWave lights and cameras are not carried across. The items only serve as place holders for Unity lights and 
cameras in the hierarchy view if needed.
Textures for your LightWave scene should be baked to UV maps for the most faithful duplication inside Unity. 
Unity only allows two UV maps per object. The first should be used in the Color channel, the second in the 
Luminosity channel, even if the LightWave textures are not intended for these channels.
Because LightWave saves objects separately from scene files, you need to save both when you make texturing 
changes in LightWave. Unity’s surfacing isn’t as dense as LightWave so you will have to bake your surfaces (and 
lighting) to image maps since procedurals and nodes don’t translate.
While you don’t absolutely have to stick to sizes at “power of 2” values (256, 512, 1024, 2048, etc.), if you don’t 
use them Unity will not be able to compress your images, meaning they will make the binary game file larger and 
might use more texture memory.

Use the Inspector before you bring in your LightWave scene. You can change your scene’s Scale, turn on Mesh 
Colliders for all your objects so that you don’t need to enable them piecemeal as you create your Unity scene, 
and also use the From Model’s Material Material naming setting to better match your LightWave surfaces.
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Export as VRML97
Export Scene As VRML97

VRML Creation Settings
So What is VRML?
Animation
Surfaces
LightWave VRML Implementation
Performance Notes
Scene Tags

Export Scene As VRML97

The VRML97 Exporter plugin (File > Export > Export Scene as VRML97) creates a VRML97 World based on the current 
scene. The VRML output complies with the ISO-VRML97 specification. The objects in the scene may be saved as separate 
files into the Content Directory or an alternate path. The following list shows some highlights:

Accurate Translation
Keyframed hierarchical animation
Light intensity envelopes, including ambient
Non-linear fog
Color image texture mapping using projection or UV maps
Solid, non-linear gradient and image backgrounds
Support for SkyTracer warp image environments
Particle animation with single-point-polygon object to PointSet node conversion
Two-point-polygon object to IndexedLineSet node conversion
SubPatch object morph capture (for capturing morph, displacement map and bone effects on SubPatch 
objects).
High-performance output
3D Sounds
Level-of-detail object replacement animation
Object instancing
Vertex color and lighting support
Multiple custom viewpoints
Custom VRML nodes
Touch activated behaviors
Viewer proximity activated behaviors
Object visibility activated behaviors
Objects output as prototypes (PROTO) definitions (optional)
Scene object ignore
Standard object viewpoints (optional)
Optional embedded objects for single file scene output!
Optional lowercase conversion for embedded object/image filenames
Direct avatar navigation speed control
Improved compliance for export to VRML97 editors, including conversion of illegal VRML97 names (like 2Legs or 
My Light), and reflection of illegal negative scaling
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VRML Creation Settings

Output .wrl is the file path for the VRML97 World.

Author is comment text to embed in the file.

Use Prototypes is used to define and use objects in the VRML scene more efficiently. Some older importers may not like 
this, but it is required for morph capture.

When Lowercase Filenames is enabled, the filenames used in the file can all be converted to lowercase. This can be 
helpful on UNIX-based Web servers, where filenames are case sensitive, and links with mismatched cases will fail.

Use Embed Objects to include the geometry for all meshes in the main VRML97 World file. This may be more convenient, 
but for complex worlds, or reusing objects, it is less efficient. Using external object files allows the main world to load 
faster, and display bounding boxes while the objects are loaded. This option must be off for morphing objects as well as 
LoD objects - loading them all at once would defeat their purpose!

If Overwrite Objects is enabled and the Embed Objects option is not used, external object files will be created for 
objects in the scene. If the objects already exist, this option must be enabled to overwrite the objects, thus updating 
surface or morph changes.

Local .wrlPath is the file path on your machine where external VRML objects will be found and/or saved. This will default 
to the current LightWaveContent Directory.

VRML Object URL is the URL where browsers will search for external objects, this should be the web equivalent of the 
local path (e.g., http:\ \ www.someplace.net\ vrml_objects\).

Text entered into the Texture URN field will be pre-pended to texture map image filenames, as an alternate texture 
location. This should facilitate work with libraries like the Universal Media textures. This information, when specified, 
will appear in addition to the regular URL elements.

http://www.someplace.net
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On the Scene Item pop-up menu, select a scene element to which you want to apply the settings on this tab.

The Sensor Type is the sensor used to start the item’s animation.

For some sensor types, like Proximity, a distance range is required. When the viewer approaches the item within the 
Range, the animation is triggered.

Alternate Trigger is an alternate item to serve as the animation trigger for this item.



LightWave 2020  –  LightWave 2020

Reference –  2953

On the Object pop-up menu select an object whose settings will be edited on this tab.

The Ignore Object option will exclude a selected object and its children objects from export.

Use Attach Sound to add a sound effect, triggered with the selected object’s animation. Enter the URL for the audio file 
triggered in the URL field. You can also set the volume and whether the sound should be looped once it has started.

The Record Morph option saves a Morph Object - a special animated Proto object - in place of the standard external 
object files. This requires that the exporter step through the animation and capture the deformed mesh at different 
times. The deformed positions are used in a CoordinateInterpolator node hidden in the morph object. This currently 
works for SubPatchobjects.

First Frame is the starting frame for the Morph Object animation. Last Frame is the final frame in the morph capture for 
this object. Frame Step is the number of frames between captured morph keys. Making this too small results in huge 
objects; making it too large results in an animation that is not smooth or points with motion that is too linear.

Enable Loop to repeat the morph animation, once it has been triggered.

Enable the AutoStart option to make the animation start as soon as the world is loaded.

Use the Navigation Mode pop-up menu to set the initial navigation mode for Web browsers.Enable Headlight for good 
defaults in dark places.

Standard Viewpoints creates extra ViewPoint nodes (top, left, etc.) for scene and external objects.

Avatar Size lets the browser set appropriate movement for the dimensions of your world.

Global Light Scale globally scales all light intensities.

Environment Images are warp images generated by SkyTracer. These map nicely to VRML’s idea of environment 
mapping. Enter only the basename portion of the image files. (For example, if you had skyWarp__back.jpg, 
skyWarp__front.jpg, etc., you would enter skyWarp.) Note that any panoramic images should be compatible, provided 
they are renamed to match the SkyTracerfilenamingconvention.
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The text in the Image URN field will be pre-pended to the image filename and added to the list of URLs for the 
environment image.

So What is VRML?

VRML, also known as ISO-VRML97 (ISO/IEC 14772-1:1997), stands for Virtual Reality Modeling Language. It is a standard 
for describing 3D objects and scenes via the Internet.

Like HTML-based web pages, VRML worlds can contain links to remote files. However, rather than using text or images 
for links, VRML uses 3D objects. As a result, the Web browser for VRML resembles a 3D animation program or video game 
more than a word processing program.

VRML worlds can be embedded in HTML pages and vice versa. VRML models are based on either primitives, like spheres, 
cubes, and cones, or, more likely, sets of points and polygons. Since the latter is basically the approach used by 
LightWave3D’s polygonal models, there is a pretty good match between LightWave scenes and VRML worlds.Before you 
can view any of your VRML creations, you’ll need to get a VRML 97 Browser. The VRML files produced by LightWave are 
text files that follow LightWave’s style of separate object and scene files. This is not a requirement of VRML, but a 
powerful feature that lets a VRML scene include objects from different files, even from some remote library.

These external objects in the scene file consist of a file URL, a bounding box, and a set of position, rotation and scaling 
transformations. The bounding box information is used by browsers to render stand-ins while the objects are loaded.

VRML scenes also include multiple point lights, directional lights, and spot lights with adjustable cones. The VRML 
equivalent of the LightWave camera is a viewpoint. The exporter will add a named viewpoint for each camera in the 
LightWave scene, which browsers can use to jump between points of interest or standard views. In addition, VRML 
objects created by LightWave may include a set of standard viewpoints for the object.

Animation

Objects in your LightWave scene that have keyframes in any motion channels will be given linear motion keys in the 
VRML file, through PositionInterpolator and OrientationInterpolatornodes.

The Pre Behaviour and Post Behaviour set for the channels in the LightWave motion has a critical influence on the VRML 
behaviour of an object. If the Pre behaviour is set to Repeat, the motion will begin when the world is loaded and keep on 
playing. Otherwise the motion will begin when the item is triggered. If the Post behaviour is set to Repeat, the 
animation will loop until re-triggered, otherwise it will stop after playing.

The default triggering is a click (TouchSensor) on the object that causes the animation to run from the beginning. 
Currently, the TouchSensorswitch is placed on the highest-level animated object in a hierarchy, and triggers the 
animation of all the children simultaneously (as one would expect).

Morphing in VRML uses a CoordinateInterpolator node. The node is part of the Proto in the object file, if morph data has 
been captured. For this reason, Prototypes should be enabled and embedded objects disabled for morphing worlds.

Surfaces

Double-sided surfaces are not supported in VRML97. Thus LightWave objects with polygons whose surfaces are double-
sided are translated as if they weren’t double-sided. VRML objects that seem to be missing polygons may actually have 
double-sided surfaces that need to be either flipped or aligned in Modeler. If the surface is truly meant to be double-
sided, you will need to model the geometry with double-sided polygons.

If your model has a texture map image associated with it (color only, not diffuse, specular, etc.), there are a few tricks 
that can minimise the nuisance of hand-editing your VRML models. Since some browsers will have to load the image 
named in the object, that image name, saved in the LightWave object, is critical.
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It pays to use LightWave’s Content Directory system properly, so that the image path will be relative to that content 
directory (i.e., images\ wood.jpg rather than C:\ NewTek\ images\ wood.jpg). You may also want to move the image to 
the Content Directory so that the name in the object will have no path, and browsers will seek the image in the same 
directory as the object.

In any event, wherever the VRML object finally resides, you will want a matching directory hierarchy where the browser 
will find the image or you can just edit the VRML file.

Another image issue is that of file format. JPEG and GIF images are almost universally supported on the Web, but the 
PNG format is gaining acceptance as a modernised, yet unencumbered, replacement for GIF. JPEG images are nice and 
small, and compression artifacts should be virtually invisible at Web/VRML resolutions. If you have nice high quality 
texture images for your rendering work and want VRML versions, make smaller JPEG versions of the images for the Web. 
Large textures may be limited by the browser’s rendering engine in most cases anyway. When you install the VRML 
model, just use the smaller JPEG image or edit the VRML file.

LightWave VRML Implementation

The organization of LightWave’s VRML object output follows that of LightWave’s own object format. A list of XYZ 
coordinate triples describe the vertices in the object. For each surface, there is also an IndexedFaceSet node that holds 
the polygons with that surface, described as a number for each point in the polygon, which refers to an entry in the 
main list of point coordinates. There may also be an IndexedLineSet node or a PointSetnode containing any two-point 
and one-point polygons.

If the original LightWave object had a color texture map image, there will be an image file name and a set of texture 
coordinates. Texture coordinates, also known as UV coordinates, are 2D pixel positions in an image. They describe how 
the image lies on the 3D surface by pinning certain pixels to each polygon’s vertices. These values can be calculated 
from LightWave’s mapping and texture size settings.

In the case of planar UV mapping, U and V are simply x and y, (for Z-axis planar). Spherical UV mapping yields U and V 
coordinates somewhat analogous to longitude and latitude, with the U’s all bunching up at the poles. Cylindrical 
mapping uses U’s from the spherical case, then the V’s are the coordinate lying along the texture axis. If the LightWave 
texturing is using UV mapping already, then these coordinates are used, since VRML texture coordinates are defined in a 
per-polygon fashion (i.e. discontinuous UVs).

The entire object may be embedded in a VRML Anchor, which makes it an active link on the Web. If you supply a URL for 
the object when you create it, then anytime that object appears in a scene, it will act as a clickable link to some other 
page. This should be used sparingly, as it can be quite annoying to keep jumping around the web when you’re just 
inspecting an object.

The uses for URLs in your objects can range from booby traps or ads for your favorite Web site, to inventory data for 
some widget. A nice example is a VRML origami site, where each step in the folding of a paper menagerie has a simple 
model with a link to the next stage. This is similar to the VRML level-of-detail mode, where multiple models are grouped 
together and the viewer’s distance determines which model, if any, is actually rendered.

Performance Notes

Although the VRML format is capable of describing complex scenes, current 3D browsers are limited by the real-time 
rendering capabilities of their underlying computers. Thus, exquisitely crafted models with painstaking detail, suitable 
for those print-res close-ups, may fail painfully when they enter the realm of VRML renderers. To avoid the twin perils of 
long download times and slow rendering, remember: the first key to VRML success is efficient, low-polygon count 
Modeling.
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Similarly, elaborate layers of diffuse, specular, and luminosity textures, whether images or algorithmic, will not survive 
any conversion to VRML. Don’t even ask about bump maps, displacement maps, or surface shaders. Love it or leave it, 
VRML supports a single image map for a color texture, as well as diffuse, color, specular, and transparency values. Since 
that texture image may very well have to fly through a modem, you’ll probably want to keep it small.

Elaborate textures and lighting can be baked into a model’s image map however, and lighting effects and coloring can 
also be baked into vertex color maps.

PointSetobjects are stored most efficiently if there is only one surface per object. Otherwise, duplicate references to the 
vertices are required. For large scenes, this could be significant.

Scene Tags

Many of the VRML attributes set in the exporter UI are stored in the LightWave scene file as comments. These comments 
can be viewed and edited on an item-by-item basis with the Comments (Layout Generic) plugin. These Comments 
should be formatted as <Tag>=<value> where the Tag is one of the following:

Item - Tag Name/Usage Description

URL - URL=<url> (URL=”http://etc.”)

Item URL, overrides object and children’s URLs.

SOUND - SOUND=<url> [<volume> <loop?>]

Sounds can be added to objects. Currently these are triggered with any animation

TOUCH - TOUCH=

Trigger when mouse is over object (mouse grope).

PROXIMITY - PROXIMITY=W H D

Trigger if viewer enters active region (WxHxD).

VISIBILITY - VISIBILITY=

Trigger when viewer sees object.

INCLUDE - INCLUDE=<filename>

Dump contents of file directly into output.

IGNORE - IGNORE=

Skip this object and its children.
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TRIGGER - TRIGGER=<object&gt;<br />

Other object for sensor.

VRML - VRML=nodeName{node fields}

Node creator, dump node from comment into file.

LABEL - LABEL=<text>

Create text node.

MORPH - MORPH= <start> <end> <step> <loop?>

Morph animation capture. Creates external MorphObject.

LOD - LOD=<objectfilename> [<range>]

Level of Detail node. Use multiple tags in order of decreasing complexity (increasing range).

Camera - Tag Name/Usage Description (stored in first camera in scene)

NAVIGATE - NAVIGATE=<type> [<speed>]

NavigationInfo Type is one of

NONE, WALK, EXAMINE, FLY, ANY

 Browsers may restrict user navigation with this.

ENVIRONMENT - ENVIRONMENT=<basename>

Override scene background image with URLs for front, back, left, right, and top images named like basename_front.jpg, 
etc.

HEADLIGHT - HEADLIGHT=

NavigationInfo Headlight on, if present.
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The Hub

xxx -This image needs replacing when final branding is done

LightWave's Hub was introduced with version 6 of the software in order to create an automated communication 
between the two halves of the program. It has been updated in various ways since then, but is really an element of 
LightWave you might not notice except as a troubleshooting tool.

Double-clicking on the Hub icon in your Taskbar or Dock will open the above window detailing the current state of 
LightWave - what parts are running, what assets are loaded and other information.

If you expand the Launch Processes menu, you should see applications that the Hub is aware of (e.g., Layout and 
Modeler). You can launch the application by double-clicking it. If you single-click (to select it) and then press the L key, 
you will also launch the application. If you press the DEL key instead, you will delete the application from the launch 
list. (This has no effect on the program files on your hard drive, but whichever program you deleted from the list (Layout 
or Modeler) will need to be started manually for F12 to work.)

The Launch Processes menu will be empty initially. However, once you run Layout or Modeler, entries will be added.

Under Windows, the Hub icon will appear in the System tray. You can right-click on it to access a small menu:

Open - Open Hub window
Close - Close Hub window
Launch - Launch applications that the Hub knows about
Properties - Set options to quit the Hub after you exit LightWave
Exit - Close the Hub program (can't be done while Modeler or Layout are running, if attached to the Hub)

You can set the Automatic Shutdown to various time intervals, after which the Hub will shutdown when there is no 
activity. Note that even when Layout and Modeler are idle, there is still some minimal communication activity which will 
keep the Hub from shutting down.

Options

In the Options dropdown at the end of the list there are two options that can be freely changed - the Automatic 
Shutdown Time, which is the delay before which the Hub will shut itself down after quitting Layout, if it is not explicitly 
shut down, and Language, which can be used to change the language of Layout, Modeler and the Hub itself. Several 
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choices are available, but the only one that is fully fleshed out is US English. Language files can be found in the support/
l10n folder if you wish to create a translation of the interface files.

Running without the Hub

There are several ways to run without using the Hub, if it does not suit your way of working. If you would like to run 
Layout and/or Modeler independently, append -0 to the command (e.g., Lightwav.exe -0. That’s a zero, by the way.) You 
will have to load and save objects manually.

Command IPC

We have implemented an interprocess communications system, CommandIPC, into Layout and Modeler. When 
LightWave is started without Hub support (the -0 command line option), Layout and Modeler still notify each other 
when a mesh file has been saved to disc, and the applications that have that file open and have not applied 
modifications during the session will update from the new version on disc. For example, if both Layout and Modeler 
have “bob.lwo” open, Modeler has some edits applied to it, and Layout saves it transformed, Modeler will not 
automatically update from the disc.

If subsequently the object is saved out from Modeler, that will overwrite the changes made by Layout, and Layout will 
update from the save if no further changes were applied in Layout during the interim.
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Isolate

The ‘isolate’ flag (‘-i’) will completely disable all IPC mechanisms (Hub and CommandIPC), leaving the application 
isolated from all other product actions.
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Scripting

Once you get past modeling, animating and rendering, then the next step is to help your workflow by scripting 
LightWave.

Relativity
Command Port
Expressions

LScript and Python instructions can be found in the SDK.
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Relativity
Click here to expand Table of Contents...

What is Relativity?
The Relativity Morph Plugin
The Relativity Expression Language

Syntax
Object Names
Variable Substitutions
#ex
#frm
#fps
#def
Comments
Functions
Tips for using Fractal noise:
The Relativity Staff Directory

Dr. Item Picker
Dr. Equation Maker
Dr. Wheel Rotator
Dr. Follower - Multi-slot professor
Dr. Oscillator - Multi-slot professor
Dr. Delayer - Multi-slot professor
Dr. Gear Grinder
Dr. Cycler
Dr. Motion Blender - Multi-slot professor
Dr. Blend Machinist
Dr. Dist Maintainer - Multi-slot professor
Dr. Event Maker - Multi-slot professor
Dr. Camera Shaker - Multi-slot professor
Dr. Morph-o
Dr. Target
Dr. Matcher
Dr. MoveVec
Dr. Snake Maker

What is Relativity?

Relativity is a motion and displacement plugin (applied via the Motion Options panel and/or the Object Properties 
panel) that allows the motions and/or deformations of one item (camera, light, object, or bone) to be related to the 
motions of another item via mathematical expressions. Below is a picture of the main Relativity motion plugin panel 
(accessed via the “Options” motion plugin button):


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Current Item - This menu allows you to bring up and edit the expressions of any item in LightWave that is 
currently using Relativity.

Disable - Turning this button on will disable this instance of Relativity for this object, allowing the original 
keyframed motion to play through untouched. This setting is saved in the scene file for this instance of the 
plugin as well.
Rot in Deg (Rotation in Degrees) - Allows rotation values to be calculated in degrees, as opposed to the default 
radians that LightWave uses internally. For most, it is much easier to think in degrees.
Explicit WC’s - This button forces Relativity to calculate the global position of a child object based on just the 
rotation, scale, and motion of each of its parents. LightWave normally supplies this information, but in the case 
of Full-Time IK and in cases where a motion plugin controls the motion of a parent or ancestor of the particular 
child object, LightWave supplies bogus world-coordinate information to a plugin. So, Relativity can go in and 
reconstruct the position explicitly using position, scaling and rotation data. Using this option can slightly 
increase the amount of time needed to perform an expression in Relativity.
Motion Channels - It is ultimately the contents of these nine little fields that comprises all that Relativity really is. 
At its heart, you enter expressions defined in a simple expression language that end up relating the value of each 

You cannot access Relativity morph expressions from the motion panel or vice versa.
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motion channel to something else happening in LightWave. For instance, you could enter in the H slot the 
expression “X(light,t+2)”. What would happen then is that the expression interpreter would look at the light’s X 
position at 2 seconds before the time for the current frame and then pass that into LightWave as the heading 
rotation value for the camera. I could also make the expression 3*X(light,t+2) and then have the X position of 
“light” multiplied by 3 before being passed as the heading value for the camera.
Special Functions - This slot is used for several special functions that Relativity can perform, like targeting and 
dynamic parenting.
Clear - Clicking this button will clear everything out of the current panel, allowing you to start over. If you 
happen to do this accidentally, click Cancel to lose the changes and then come back in.
Copy/Paste - Copies/Pastes the expression into/from an internal buffer, all settings and variables will be copied 
and pasted as well.
Copy to Descendants - Copies the current set of expressions to the descendants of an object. An example would 
be in setting up a motion cycle for the thigh of a character. You could then take those same expressions and copy 
them to the descendants of the current object. NOTE: The descendants will need to already have Relativity 
applied to them via their own Motion Graph panels. Relativity is unable to do this automatically due to 
limitations in the LightWave plugin architecture.
Load/Save - Loads and Saves the expression settings To/From a file. The file format is just text with all the 
parameters listed sequentially in it.
Search/Replace - Search for instances of a text string, and replace it with another. The search can either be case-
sensitive or not.
Comments - Put in anything you darn-well please in these slots… they are there to help you remember why you 
set up an expression the way you did.
Professors - For those who feel rather math-shy, there are a number of “Professors” that allow you to set up 
common types of expressions. Note that next to the expression slot for each motion channel, there is an “Ask a 
Professor” menu choice. For most professors, it is context sensitive (i.e. for the Gears professor, the rotation 
used in the expression will match that of the slot selected… so the bank slot would be filled with a “B(object,t)”, 
the heading slot with H(object,t) and so on.). The “Dr. Follow” professor will actually place data in any slot 
specified and is thus not context sensitive. To use a professor, select it from the choice menu and fill in the 
blanks. If you’ve filled in everything correctly, your expression will be automatically set up for you. You can then 
take the expressions created and tweak them further. 

A detailed staff listing of the professors and what they do can be found later in this chapter.
Variables Panel - Above is a picture of the variable panel, accessible via the “Variables” button on the main 
panel. Relativity has a number of variables available that you can use in your expressions. Basically, each 
variable can be a sub-expression which then gets dropped into the grand expression for each motion channel. 
For instance, I could define the sub-expression

X(object1,t)*sin(t*5) 

as a sub-expression for variable “A”. This can then be substituted into the final motion channel expressions. 

Say we put the expressions:

3*#a

and
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2*#a 

in the X and Y slots of Relativity… if you expanded things out, you’d end up with:

3*(X(object,t)*sin(t*5)) 

and

2*(X(object,t)*sin(t*5)) 

which are certainly more unwieldy to manage than putting the sub-expression in A and substituting in "#a” 
where needed. 

In addition, note the two buttons, “ Shift Variables Up ” and “ Shift Variables Down ” on the panel. What these 
buttons do is move the variables up or down in the slots, replacing the variable names in all expressions 
accordingly. The reason for these buttons is if you as the expression designer decide you need some extra slots 
at the beginning or end of a group of expressions… finding and replacing all references to variables within the 
expressions as necessary.

The Relativity Morph Plugin

 
Using the Relativity Morph plugin, found in the Object Properties panel Deform Tab, you can easily morph from one 
object to many potential targets, using complex expressions. You can even do additive, subtractive, multiplicative, and 
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division-based morphs. There is a single expression slot “MORPH” into which you can enter any number of morph 
expressions (any other expressions in this slot will be ignored). Each morph expression has the following syntax:

<command character>MORPH(target,value) 

where “command character” can be any of the following:

&

- replacement morph - this interpolates from the presently calculated morph into the target.

+

- additive morph - adds the values of the target points to the currently calculated morph

-

- subtractive morph - subtracts the values of the target points from the currently calculated morph.

*

- multiplicative morph - multiplies the currently calculated morph by the values of the target.

/

- division morph - divides the calculated morph points by the point values of the current target

So, a typical morph expression might look like this:

&MORPH(morph1,#a)+MORPH(morph2,#b)-MORPH(morph3,#a+#b) 

where #a, #b, etc. were derived from expressions in the variables panel.

You can enter any of the standard Relativity expressions in the variable slots, A through R, and then use these in the 
MORPH expressions. You can also place expressions directly in the morph value of the MORPH expression as well (e.g. “M
ORPH(targ1,sin(t))”)

You will also notice the options buttons at the top of the morph panel, labeled Evaluate Expression Point-by-point, 
Evaluate Point using World Coordinates, and Transform Morph Target(s).

Evaluate Expression Point-by-Point - If this option is on, then the variables x, y, and z are replaced with the value 
of each point in the original object, as they are moved. This is useful for creating partial morphs, like effector-
morphs, gradient morphs and ripple morphs. If this option is off, then x, y, and z use the keyframed motion 
values from the object itself for these variables.



LightWave 2020  –  LightWave 2020

Reference –  2967

•

•

•

•

•

Evaluate Points using World Coordinates - If this option is on, then the world x, y, and z values of each point is 
used in evaluating the morph. This will also cause the morph to be evaluated after bones have been applied. If 
this is off, then individual points are evaluated using their before-bones local coordinate.

Transform Morph Target(s) - If this option is on (and it must go hand-in-hand with “Evaluate Points using World 
Coordinates”), the morph plugin will transform the target points by the motion of the morph target object, 
allowing you to have the morphed points move with their target.

It is highly recommended that you avoid using functions like

DIST 

and

ODIST

in the expressions if you have any of the point-by-point options on… you will be waiting a long time for those 
expressions to finish with objects that have any significant point count.

There are several example scenes included in the latest example scene archive that show the Rel_Morph plugin in 
action.

In addition to the object morphing, the X, Y, and Z slots allow for expression based deformation on the X, Y, and Z 
coordinates of each point in your object.

The Relativity Expression Language

Syntax

The Relativity language syntax is very similar to that of the NewTek “Math Motion” and “Math Morph” plugins, which 
ends up being a sort of LISP-ish type programming language. Basically, you enter a mathematical expression in a slot, 
and the plugin will evaluate it, applying the final value of that expression to that channel. In the slots on the variable 
panel, the expression is applied to that variable, whose value can then be placed in other expressions. Some simple 
expressions would be:

sin(t)

- the sine of the current time value

cos(x)

- the cosine of the x value of the object’s own keyframed motion

X(blah1,t)+Y(blah2,t)

- adds the X value of blah1 and the Y value of blah2
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#a*sin(t)+XS(SELF,t)

- multiply whatever’s in the “A” slot by the sine of t and add the X scale keyframe value of its own keyframed 
motion at the current time.

X(something,t-.5)

- gets the X motion value of object “something” where it was a half second ago (time is always in seconds)

The goal is to create an expression for each motion channel of interest. For motion channel slots left blank, the 
keyframed value for that channel will default through to the motion of the object.

Object Names

In order for relativity to grab object names, full names (case insensitive) need to be supplied for all functions, object and 
bone names also need to be unique in order for Relativity to find the correct object. Object names that end with the 
“.lwo” extension need to have their names specified in functions in Relativity with their extension.

Null objects should be specified with their exact names (typically, they do not have the “.lwo” extension on their 
names). There are also 3 predefined object names:

camera - grabs motion info from the camera
SELF - grabs information from the item’s own keyframe data
PARENT - grabs information from the object’s parent.

Variable Substitutions

If you click on the “Variables” button on the main Relativity options panel, you will notice a panel with a number of 
additional slots: A through R. These are there to allow the build-up of complex multi-expressions that would become 
quite unmanageable very quickly if all strung into one string. Relativity will scan each string, looking for a ‘#’ character 
followed by a variable name and substitute that value in. For example, if I had:

X: 3*#i 

Y: 4*#i 

I: sin(X(something,t)) 

the value of I would be evaluated and X would be essentially set to

3*sin(X(something,t))

and Y to
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4*sin(X(something,t))

. Note how using the variables also allows you to remove repetitive sub-expressions from your main expressions. In 
addition to that, each variable slot can take variables from the previous slots… so, we could have:

I: X(blah,t) 

J: Y(more,t) + #i 

K: Z(amore,t) + #i + #j 

etc. Relativity also has several special variables:

#ex

takes the numeric extension of the object’s name, either the “(1)”, “(2)”, etc.) of a cloned object’s name, or any numeric 
extension on an object’s filename (i.e. myobject001.lwo, myobject002.lwo). This can be useful in setting up a set of 
expressions that automatically offset clones and numeric duplicates of objects into their appropriate position when 
cloned (this was used in the “newtank.lws” example scene to make all the tread links fall into their correct position. A 
simple example would be:

X: #ex 

Now, anytime this object is cloned, the clones will each offset themselves by one meter in the X direction.

#frm

gets the number of the current frame.

#fps

gets the current frames-per-second value

#def

this passes through the default value for whichever motion channel it’s on.. So, for example, if you had an object 
keyframed at X=2, Y=-3, Z=5, and then had the following expressions:

X: #def+2 

Y:#def-6 
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Z:#def*2

would change the coordinates of our object to 4, -9, 10.

In addition to the user-defined “slot” variables, Relativity has several predefined variables (these SHOULD NOT BE 
PRECEDED BY THE ‘#’ SYMBOL):

x

- the x position of the current item (in local coordinates)

y

- the y position of the current item (in local coordinates)

z

- the Z position of the current item (in local coordinates)

t

- the current time

Comments

You can put whatever you want into the comment fields, which will be saved with the expressions in the scene file. In 
addition to that, the user can end any expression line with a comment preceded by either a double-forward-slash “//”, 
or a forward-slash followed by an asterisk “/*”, Relativity will ignore anything after the comment character and will not 
send that part of the expression on to the parser/compiler/evaluator. An example would be the following, entered in the 
X field of the main panel:

X(object1,t) //here we’re getting the X value of an object 

or

X(object1,t) /*here we’re getting the X value of an object 

Functions

Relativity supports all of the standard math functions supported by LightWave. These can be found listed in the 
appendix in the Reference manual. In addition, Relativity supports the following functions (NOTE: the function names 
are case sensitive, X is not the same as x). It should also be understood that object names containing these functions in 
their proper case may confuse the Relativity expression parser… so, for example, don’t include an object’s name as 



LightWave 2020  –  LightWave 2020

Reference –  2971

“myXobject”, instead, change the name to “myxobject” and all will be well with the world. IT IS HIGHLY RECOMMENDED 
THAT ALL OBJECT NAMES USED IN RELATIVITY EXPRESSIONS BE DONE IN ALL-LOWERCASE:

X(object, time expression) 

Y(object, time expression) 

Z(object, time expression) 

H(object, time expression) 

P(object, time expression) 

B(object, time expression) 

XS(object, time expression) 

YS(object, time expression) 

ZS(object, time expression) 

gets the x, y, z, heading, pitch, bank, x scale, y scale, and z scale of “object”, respectively.

XW(object, time expression) 

YW(object, time expression) 

ZW(object, time expression) 

gets the world coordinate position of “object”.
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XL(object, time expression) 

YL(object, time expression) 

ZL(object, time expression) 

converts the global coordinate of “object” into the local coordinate space of the object to which we’re applying 
Relativity.

Example:

X(object,t) 

This would get the X position of “object” at the current time.

MOTX(object, time expression) 

MOTY(object, time expression) 

MOTZ(object, time expression) 

These functions return a normalized vector representing the motion of the object. This can be useful, when combined 
with the vector parameters below, to gauge how much of the object’s motion is forward and how much is side-to-side.

Example:

X: MOTX(object,t) 

Y: MOTY(object,t) 

Z: MOTZ(object,t) 

would cause our Relativity instance to “point” in the direction of motion of “object”.

UPX(object, time expression) 
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UPY(object, time expression) 

UPZ(object, time expression) 

FORX(object, time expression) 

FORY(object, time expression) 

FORZ(object, time expression) 

RITX(object, time expression) 

RITY(object, time expression) 

RITZ(object, time expression) 

These are the Relativity vector parameter functions, and return a normalized vector representing the orientation of 
“object”’s local X, Y, and Z axes in global space (UP = Y, FOR=Z, RIT=X).

OBJDIZ(object, time expression) 

evaluates the dissolve factor of “object”, which can then be used in your expressions.

Example:

OBJDIZ(myobject,t)

will evaluate the dissolve amount for “myobject”.

BONERX(bone) 

BONERY(bone) 
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BONERZ(bone) 

BONERH(bone) 

BONERP(bone) 

BONERB(bone) 

BONERL(bone) 

Get the rest X, Y, Z, heading, pitch, bank, or rest length of “bone”.

Example:

BONERX(bone)+BONERY(bone) 

adds the X and Y rest positions of “bone” together.

CAMZOOM(time expression) 

CAMHORZ(time expression) 

CAMVERT(time expression) 

CAMFL(time expression) 

CAMFD(time expression) 

CAMFSTP(time expression) 
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CAMBLR(time expression) 

Gets the zoom factor, horizontal view angle, vertical view angle, focal length (in millimeters), focal distance, f-stop, and 
motion blur factors, respectively, for the camera at time “time expression”.

Example:

Z: Z(CAMERA,t)+CAMFD(t) 

would position a null right at the focal point of the camera, provided it’s looking down the Z axis and unrotated.

LIGHTCON(light,time expression) 

LIGHTEDG(light,time expression) 

LIGHTRED(light,time expression) 

LIGHTGRN(light,time expression) 

LIGHTBLU(light,time expression) 

Gets the cone angle, soft edge angle, red color, green color, blue color, respectively of “light” at time “time expression”.

Example:

LIGHTCON(light,t) 

would get the cone angle of “light” at time “t”.

XCYCLE(object, driving expression, start time in seconds, end time in seconds) 

YCYCLE(object, driving expression, start time in seconds, end time in seconds) 

ZCYCLE(object, driving expression, start time in seconds, end time in seconds) 



LightWave 2020  –  LightWave 2020

Reference –  2976

HCYCLE(object, driving expression, start time in seconds, end time in seconds) 

PCYCLE(object, driving expression, start time in seconds, end time in seconds) 

BCYCLE(object, driving expression, start time in seconds, end time in seconds) 

XSCYCLE(object, driving expression, start time in seconds, end time in seconds) 

YSCYCLE(object, driving expression, start time in seconds, end time in seconds) 

ZSCYCLE(object, driving expression, start time in seconds, end time in seconds) 

Cycles the object’s motion from the start time to the end time… whenever the decimal portion of the driving expression 
is 0, the position of the object at the start time is copied… if it is .99999, the position at the end time is copied, if it is 0.5, 
the position halfway between the start and end times is returned, etc.

Example:

XCYCLE(SELF, t, 0, 0.333) 

This would cycle the X values between 0 and 10 frames (frame 10 = 0.333 seconds), repeating the cycle each time the 
time value ticks off a second.

XMINPATH(object, following distance, time expression) 

YMINPATH(object, following distance, time expression) 

ZMINPATH(object, following distance, time expression) 

HMINPATH(object, following distance, time expression) 
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PMINPATH(object, following distance, time expression) 

BMINPATH(object, following distance, time expression) 

XSMINPATH(object, following distance, time expression) 

YSMINPATH(object, following distance, time expression) 

ZSMINPATH(object, following distance, time expression) 

Gets the motion value at a minimum path distance of “following distance” behind the object’s position at time t.

Example:

XMINPATH(leader, 1, t) 

This would get the X coordinate of object “leader” 1 meter in path-length behind its current position.

TARGET(object, time expression) 

Entered in the special expression field for the object, target will target the heading and pitch of the item toward the 
target object, pointing the local Z axis at the targeted object.

Example:

TARGET(object, t) 

would target the position of “object” at time t.

MATCH(object, time expression) 

This function will match an unparented object to correcspond with the object listed in the MATCH function, no matter 
how deeply “object” is buried in a hierarchy (including bones and child bones). Useful for such things as attaching 
objects to bones properly. MATCH is a special function, and as such, should go in the Special Functions slot.

Example:

MATCH(footbone, t) 

This would match the position of our object to that of “footbone” at time t.
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GAP(object1, time expression1, object2, time expression2) 

This function measures the gap between the global position of object1 at time “time expression 1” and object2 at “time 
expression 2”

DIST(object, time expression) 

Gets the total path distance traveled (in global coordinates) from time 0 to the time specified.

Example:

DIST(whatever,t-0.5) 

Gets the total path distance traveled by “whatever” from time 0 up to 15 frames ago.

ODIST(object,time expression) 

This returns the oriented distance traveled by the object, with the orientation being determined by the direction of 
travel and where the object’s own local Z axis is pointing. Using this distance function, it is possible for an object to 
“walk” forward and backward, stepping properly as it does so. The original DIST function did not take object orientation 
into account and will return the total path distance traveled by an object regardless of the direction of the path motion 
with respect to its orientation.

Example:

ODIST(PARENT,t) 

Gets the oriented distance traveled by the parent of our object.

MOVEVEC(velocity,time expression) 

Entered in the Special Functions slot, this will move the object along the Z direction (wherever this happens to be 
pointing) at the specified velocity (in meters/second). Using this function, you can simply rotate your object and have it 
smoothly fly wherever you need it to go. This function is perhaps most useful for situations where you have the rotation 
of an object controlled by some sort of “virtual steering mechanism” (like a virtual joystick or steering wheel) and want 
the object to respond to the rotation changes by moving in the new direction.

Example:

MOVEVEC(X(controller,t), t) 

Moves the object by the velocity indicated by X(controller,t), incorporating the rotations of our object up to the current 
time to determine its current position.
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SUMX(object,time expression) 

SUMY(object,time expression) 

SUMZ(object,time expression) 

SUMH(object,time expression) 

SUMP(object,time expression) 

SUMB(object,time expression) 

SUMXS(object,time expression) 

SUMYS(object,time expression) 

SUMZS(object,time expression) 

This function adds the value of the object’s respective motion channel incrementally, once per frame. So, for example, if 
you have an object keyframed to X=0.5, at frame 1,

SUMX 

would equal 0.5, at frame 2,

SUMX

would equal 1.0, etc. To use the SUM functions as a pseudo-time function (for throttle type controls), you will probably 
have to multiply the SUM expression by 1/(frames per second rate), i.e. 1/30 or 1/24, etc.

Example:
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SUMX(blah, t) 

This would sum the X component of object “blah” from time 0 to the present time.

IF(expression1 <comparison character(s)> expression2) 

the IF function will evaluate expression1 and expression2, compare them using the <comparison> character(s) and 
evaluate to 1 if the comparison is true, 0 if it is false. The following comparisons are supported by IF:

< - less than
> - greater than
<> - not equal to
<= - less than or equal to
>= - greater than or equal to

Example:

IF(X(blah,t) < 0) 

This will evaluate to 1 if the x coordinate of “blah” is less than 0, and will evaluate to 0 if the x coordinate of “blah” is 
greater than or equal to 0.

AND(expression1,expression2) 

Performs a logical AND between two expressions, if expression 1 and expression 2 are BOTH not 0, then the AND 
function evaluates to 1, if either or both are 0, then the AND returns 0.

Example:

AND(IF(X(blah,t)<0),IF(Y(blah,t)>0)) 

would return 1 if the X value of “blah” is less than 0 and the Y value of “blah” is greater than 0, otherwise, the AND would 
return 0.

OR(expression1,expression2) 

Performs a logical OR between two expressions, if either or both expression 1 and expression 2 are not 0, then the OR 
will return 1. If they are both 0, the OR will return 0.

Example:

OR(IF(X(blah,t)<0),IF(Y(blah,t)>0)) 

Would return 1 if either the X value of “blah” is less than 0, or the Y value of “blah” is greater than 0, or both. If neither is 
true, then the OR would evaluate to 0.
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NOT(expression) 

NOT will return 0 if the expression’s value is not 0 and 1 if it is zero, i.e. a logical NOT operation. This is most useful for 
negating IF() expressions.

Example:

NOT(IF(x>0)) 

Will return 1 if the x value of our item is not greater than zero, and 0 if it is greater than 0.

COND(expression <comparison character(s)> expression,trueresult,falseresult) 

this function implements a conditional expression, basically giving the user an IF… ELSE kind of logical decision-
making. The first part is identical to the format of the IF statement, this is followed by an expression to evaluate to if the 
condition is true (i.e. “trueresult”). If the condition is false, then “falseresult” is returned instead.

Example:

Y: COND(X(self,t)<=0,1,Z(object,t)) 

in this example, if the X position of the object itself is less than or equal to zero, COND will evaluate to 1. If it is greater 
than zero, the COND expression will evaluate to the Z value of “object”.

FT(framenum) 

converts a frame into a time value in seconds (as Relativity equations use seconds to calculate the time). NOTE: 
framenum must be a constant value… it cannot be an expression.

Example:

FT(30) 

would convert to 1.0000, or 1 second, in the typical 30 fps scenario.

EVTIME(expression) 

this function is a very powerful one, using it, you can set up an animation to play back when a specific trigger condition 
occurs. The way this function works is it will return a time value, indicating the last time that “expression” changed from 
0 or less than zero, to greater than zero, most typically done by some form of IF statement. As long as “expression” 
remains greater than 0, EVTIME will keep ticking off time. Whenever the expression is 0, or less than zero, EVTIME will 
return 0. EVTIME will also return 0 if the expression starts out as true (i.e. greater than zero) without having switched 
from a false condition to a true condition. NOTE: EVTIME will only evaluate “expression” at frame boundaries, not at 
interframe time values in order to save calculation time. If “expression” changes from false to true at an interframe 
time, the time at the next frame will actually start the count.
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Example:

Y(SELF,EVTIME(IF(Y(botfoot,t) < 0.1))) 

This would start playing back the animation of the object itself once the Y value of botfoot gets reasonably close to zero. 
Something like this could be used to simulate camera shake whenever a bot ‘s foot hit the ground.

Another Example:

A: EVTIME(IF(GAP(object,t,sensor,t) < 1)) 

B: COND(#a <= FT(5), #a, FT(5)) 

C: EVTIME(IF(GAP(object,t,sensor,t) > 1)) 

D: COND(#c > 0,FT(5)+#c,#b) 

X: X(SELF,#d) 

Y: Y(SELF,#d) 

Z: Z(SELF,#d) 

In this example, say we have a door keyframed to open from frames 0 to 5 and keyframed to close from frames 5 to 10. 
In this example, an event trigger is thrown by A when object and sensor come within one meter of each other, causing 
the open animation to play. However, we don’t want the close animation to occur until our object gets far enough away. 
So, the B expression limits the playback of A to frames 0 through 5 by returning the time value for 5 frames if A gets 
bigger than that. The C expression is set up so that it’s triggered when the object moves further than a meter away. 
Finally, the D expression is set up to return the C value if it has a value, and the B expression otherwise. The net result of 
all this gibberish is that when “object” gets close to “sensor” the doors fly open. When it moves away from “sensor”, 
they fly shut again.

EVONE(expression) 

This function is the same as EVTIME, except it doesn’t reset when the condition becomes false again. EVONE remains 
triggered no matter what happens to the tracking event.
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VX(object,t) 

VY(object,t) 

VZ(object,t) 

VH(object,t) 

VP(object,t) 

VB(object,t) 

VXS(object,t) 

VYS(object,t) 

VZS(object,t) 

computes the directed velocity of an object along the appropriate motion channel. NOTE: This value is sensitive to 
direction, so an object moving in the positive direction at the same speed as one moving in the negative direction would 
have opposite X velocities, one positive and the other negative, respectively. NOTE: All velocities are in meters per 
second (except rotational velocities which are in degrees per second if the “Use Degrees” button is on, in radians per 
second if “Use Degrees” is off), if you need a different velocity measurement, such as miles per hour, you will need to 
multiply the velocity value by the appropriate constants.

Example:

VX(object,t) 

gets the X velocity of our object at time t (in meters per second)

SPEED(object,t) 
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SPEEDW(object,t) 

Gets the speed in local coordinates or world coordinates, respectively, of the object at time t. Speed is irrespective of 
direction, and takes all axial motions into account.

Example (a simple speedometer):

B: 180*SPEED(car,t) 

AX(object,t) 

AY(object,t) 

AZ(object,t) 

AH(object,t) 

AP(object,t) 

AB(object,t) 

AXS(object,t) 

AYS(object,t) 

AZS(object,t) 

computes the acceleration of an object along the motion channel. In this case, acceleration is direction insensitive, 
returning the change in the absolute value of the velocity on the channel in question.

Example:
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AH(object,t-0.1) 

this would get the heading velocity of “object” at .1 seconds behind the current time.

SPDCHNG(object,t) 

SPDCHNGW(object,t) 

gets the change in speed over time of an object at time t, in local or world coordinates, respectively. This can be 
considered akin to acceleration, but in all directions, rather than just one axis.

Example:

Y: 30*SPDCHNG(myobject, t-X(timecontrol,t)) 

This would measure the rate of speed change for object “myobject” at the current time minus the X value of 
“control” (in seconds).

ABSDEG(expression) 

converts a rotation value in “expression” into an absolute degree value between 0 and 2*PI radians, or between 0 and 
359 degrees if the “Use Degrees” button is checked on. This can be useful when you have something continually 
rotating, and yet you want to create a behavior that works between a set of rotation values, like bones placed in a tire to 
do tire-bulge.

Example:

ABSDEG(P(obj,t)) 

would have the following values with corresponding values for the pitch of “obj”.

Value of Pitch of obj Value of ABSDEG

30 degrees 30 degrees

360 degrees 0 degrees

740 degrees 20 degrees

FRAC(controller object, # of frequencies) 

gets a fractal noise value (a single value between 0 and 1.0) at the global position of an object, using the controller 
object to determine the position, rotation, and scale of the fractal texture. The way this works is as follows:
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1.

2.

Relativity will grab the global position of an object and transform that coordinate into the coordinate space of the 
controller null. - Using this information, and the # of frequencies value, Relativity will apply a Perlin fractal turbulence 
function to the coordinate and wrangle out a single value between 0 and 1 for that point.

Example:

X: X(SELF,t) + 0.5*FRAC(fracnull,3) 

this will add a bit of fractal noise to the X position of our object

Tips for using Fractal noise:

Since the FRAC function will only return a single value for the coordinate of the item involved, you may want to 
use several fractal controllers to apply different fractal values to different motion channels of an item to shake 
things up a bit more.
The fractal controller null determines the size, position, and rotation of the fractal texture permeating 
throughout space. So, for example, you have an object sitting still, but you want it to wiggle a bit, no problem, 
move or rotate the fractal controller object(s) and the fractal texture at the object’s location will change. Another 
example: Say you want an object to bump around very quickly, changing values dramatically at almost every 
frame, just scale the fractal controller null to a very small size, and you’ll reduce the size of the fractal “lumps” 
causing the texture to vary much more quickly from point to point. Conversely, larger scale values for the fractal 
controller will cause the variation to be much more smooth between points.

Remembering these tips can give you a high degree of control of the fractal randomness.

NOISE(expr) 

returns a noise value based on the value of “expr”. Basically, you feed it a value, and out pops a fractal noise value.

Example:

NOISE(t) 

will return a noise value based on the current time.

NOISE(3*t) 

will return a more “jagged” noise value.

BLEND(value 1, at point 1, value 2, at point 2, current position) 

TBLEND(value 1, at point 1, value 2, at point 2, current position) 

Blend can be used to linearly blend between values 1 and 2, with the result of blend equaling “value 1” when the 
“current position” expression is at “at point 1”, and will return “value 2” when the “current position” expression is at “at 



LightWave 2020  –  LightWave 2020

Reference –  2987

•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•
•
•

point 2”. BLEND basically sets up a linear interpolation relationship between the values, and will over-interpolate if 
“current position” is less than “at point 1” or is greater than “at point 2”…

Examples:

BLEND(0,3,5,6,X(blender,t)) 

this would blend between the values 0 and 5, with 0 being returned by BLEND when X(blender,t) is 3, and 5 being 
returned when X(blender,t) is 6. Note: if X(blender,t) were 9, then the blend function would return 10 for its value, as it 
overinterpolates based on the value of X(blender,t). If this were a TBLEND instead, then the maximum value that the 
BLEND function would ever have would be 5, no matter how high X(blender,t) got.

BLEND(X(obj1,t),0,X(obj2,t),1,X(blender,t)) 

this would blend from the X motion channel of obj1 when X(blender,t) is 0 to the X motion channel of obj2 when 
X(blender,t) is 1. So, basically, X(blender,t) can be used as a toggle to switch the motion of our item from obj1 to obj2.

The Relativity Staff Directory

The following information will give you an overview of the professors in Relativity and what they do.

Dr. Item Picker
Dr. Wheel Rotator
Dr. Oscillator
Dr. Gear Grinder
Dr. Motion Blender
Dr. Dist Maintainer
Dr. Camera Shaker
Dr. Target
Dr. MoveVec

Dr. Equation Maker
Dr. Follower
Dr. Delayer
Dr. Cycler
Dr. Blend Machinist
Dr. Event Maker
Dr. Morph-o
Dr. Matcher
Dr. Snake Maker

Most of the professors in Relativity are accessed from the menu next to an expression slot on the Relativity panel. What 
they do, is allow the point-and-click automated set-up of many commonly used expression set-ups. It is quite likely that 
this list will expand in future releases of Relativity. One thing to note about the professors: some professors are context 
sensitive, they will only set-up the expression for one motion slot at a time, and may change how they set up the 
expression based on which motion slot they’re being run from. Other professors work on a more global level, and can 
set up multiple motion expression slots all at once. A few will even commandeer some variable slots. This will be noted 
as we go through the documentation, professors that set up multiple slots will have the statement “Multi-slot 
professor” before their description.

Over-interpolation is not necessarily a bad thing, as many mechanical relationships can be set up by knowing 
relationships between various values at two distinct points, which can be used to define behavior outside of 
the range of those two points. If you desire the blend to stop when the current position goes outside the range 
specified by “value 1” and “value 2” , use TBLEND (short for Truncated-BLEND) instead.


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Dr. Item Picker

Dr. Item Picker is a simple professor panel that will blast an object name onto the end of whatever you are typing. So, 
for instance, if you were typing:

2+X( 

and then forgot the name of the object you wanted, you could use Dr. Item picker to pick the name you’re interested 
in… so you would end up with:

2+X(mynull 

and then you could add the “,t)” to finish off the expression. If you need to insert an object name into an existing 
expression, like:

2*sin(XW(blah,t)) 

and realize that you forgot your object name and need to replace “blah” with the correct name, use Dr. Equation Maker 
below.

Dr. Equation Maker

This professor is the most powerful, complex, and yet easy-to-use in your arsenal. It turns the task of hand-building an 
expression into an exercise in point-and-click. Now, whether or not your expression does what you expect, that’s up to 
you, but this professor will do all it can to help steer you in the right direction. On this panel, you have a total of eight 
menus that allow you to pick eight different possible elements that make up your expressions: LightWave’s math 
constants and functions, Relativity’s arsenal of expression functions, Rel’s special functions (for use only in the “Special 
Function” slot), Object names, bone names, light names, and special reserved Relativity objects (PARENT, SELF, 
camera, etc.).

To use this professor, simply select what you want from a menu and click it into place. As you select items, the text 
control at the top will give you a description of the choice you’ve made, to make sure you have what you’re looking 
for… in this sample image, X(obj,t) has been selected, and the description tells you what this Relativity function does. If 
you click Add Choice to Expression, the professor will append your choice to the current expression in the edit field.

You can also tell this professor that you want to insert a choice into the middle of your current expression, rather than 
just at the end. By placing an ‘@’ character wherever you want an insertion point, you can make the professor insert 
your next choice where the ‘@’ is, rather than at the end of the expression. So, we could start by selecting ‘X(obj,t)’ and 
clicking that into place. Then we could edit out the ‘obj’ and replace it with an ‘@’. Finally, we could select the actual 
object name we were interested in from the object menu, say it was called ‘heavynull’. Once we click the Add Choice to 
Expression button, ‘heavynull’ will replace the ‘@’ character, turning our expression into

X(heavynull,t)

.
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Dr. Wheel Rotator

This professor has a simple task, making your object rotate as it tracks the motion of some other object. To use it, pick 
the object that will drive this rotation (this will most often be the direct parent, or an otherwise ancestor of your object). 
However, there is nothing that can stop you from letting the object’s own motion drive it’s own rotation. Here is a field-
by-field break-down of the panel:

Object Driving the Rotation - This is the object whose motion will cause the rotation of our current object to 
occur.

Pick Vehicle - Brings up the object picker panel to get a point-and-click selection of the object you want.
Diameter - Here you enter the diameter (i.e. the total distance across) of the wheel.

Dr. Follower - Multi-slot professor

This is the professor for setting up following motions of all kinds. You can set up many kinds of relationships, like a 
delayed following of another object, or have an object follow at a specified distance. You can even set up an offset-
following motion where an object or group of objects will follow a leader, yet maintain a respectable distance from it. 
Here is a break-down of the fields:

Object to follow - This is the object we want to follow… this is hopefully not a hard concept to grasp
Pick follow object - allows point-and-click selection of object
Channels to follow - allows you to determine which channels we’re going to follow on… this will set up multiple 
expression slots at one time.
Offset Motion by Difference at Frame 0 - If this button is clicked on, then this object will follow its leader in a 
“flocky” sort of way… so the follower object will move with the leader, but maintain its relative position with 
respect to the leader.
Follow at a specified distance - This slot, if it contains a value, specifies that we want to follow at a specific path 
distance behind the lead object. This is useful for things like roller coasters, trains, etc. etc. where you need 
successive cars to maintain an exact distance behind the leader or behind the car in front of it. The distance will 
be maintained no matter how fast the lead object moves.
Follow with a constant time delay - This slot, if filled, will cause the follower object to either lag behind or 
anticipate the motion of the lead object by a specified time delay.
Optional Time Delay Control Object - This slot will allow you to specify an object (often a null) as a delay 
controller.
Channels to Control - Select the channel(s) for the delay object to control. If you only select the X channel, the X 
channel of the object will control the delay on ALL THE MOTION CHANNELS of our follower object. Otherwise, 
the X channel of the delay control will determine the X delay, the Y channel will determine the Y delay. Unclicked 
channels will not have the delay controller specified in them.
Use Object Extension for Follow Delay - This will multiply the object’s numeric extension or clone number (i.e. 
the (1) in ‘null (1)’ or the 3 in obj003.lwo) by the delay factor, either the time delay or the distance delay. This 
way, you could set up an expression for one object and copy it verbatim to other objects and have them lock into 
the right place behind the leader.
Extension Offset - This is the offset for the extension… for instance, if you want object001.lwo to not have any 
delay, but object002.lwo to delay by one delay factor, you could make the offset 1, this would zero out any delay 
for object001 but turn it on for subsequent objects.
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Dr. Oscillator - Multi-slot professor

This professor is the one for setting up any and all oscillating motions (i.e. objects swinging back and forth, bobbing up 
and down, wiggling around, weaving side-to-side, etc.). The setup of this panel is quite simple:

Channels to wiggle - Select any and all channels that you want to oscillate.
Wiggles per second - This determines the frequency of the oscillation.
Frequency Controller - You can optionally have a frequency controller instead, it’s set up so the X channel of the 
controller object controls the frequency (this can always be edited after the fact to a different channel).
Wiggle Intensity - Determines the intensity of the oscillation.
Intensity Controller - You can optionally have an intensity controller whose X channel controls the oscillation 
intensity.

Dr. Delayer - Multi-slot professor

Dr. Delayer allows you to delay an object’s own motion by an offset in time. This is useful for moving the dreaded 
“locked 0 keyframe” to another time, so cyclic motions can start off at frames other than 0. It’s also possible, using a 
delay controller, to soften acceleration and deceleration much more than when using just tension on your spline values. 
Here’s a breakdown of the fields on this professor:

Fixed Time Delay - Enter a value (in seconds, or add a ‘F’ at the end to specify frames) and your motion will be 
delayed by that amount.
Delay Controller - Choose an object to control the amount of the delay, which makes the delay factor 
animatable.
Channels of the controller object - This specifies which single channel of the delay controller will control the 
delay. You can also choose “all channels” to get a channel-by-channel delay control.
Delay on which channels - Pick the channels to set up a delay on.
Tie Delay to Object Extension - Use the object number extension in the expression as a multiplier by the delay 
factor. This is useful for setting up a sequence of numbered objects to delay by specified amounts.
Extension Offset - This value is subtracted from the object extension before applying it to the expression.

Dr. Gear Grinder

Dr. Gear Grinder is great for relating the rotation of one object to the rotation of another. You pick the controlling gear 
and then tell it the radius or diameter of each gear (note: you must use either radius or diameter values for both slots). If 
you are actually setting up gears, you could specify the number of teeth for each gear instead of radius.

Dr. Cycler

Dr. Cycler is the ultimate professor for setting up all sorts of nifty cyclic relationships in LightWave. Before you run the 
professor, though, you need to have a cyclic motion keyframed for your object. Dr. Cycler will take that cyclic motion 
and figure out a way to apply that motion over-and-over-again (i.e. cyclically) over the course of your animation. Here’s 
what all the fields mean:

Motion Channel to Cycle on - The motion channel the cycle will be applied to.
Object to Pull the Cycle from - You can select any object as the source of the cycle. In many cases, you would 
select “SELF” to choose the object’s own keyframed motion as the basis for the cycle.
First and Last frame of the Cycle - Again, this should be self-explanatory.
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Object driving the Cycle - This is the object whose motion is driving the cycle, unless you select “time” as the 
driving function, which makes the object irrelevant.
Driving function - Choose what aspect of the object’s motion is going to drive the cycle. Most of the options 
should be clear, path distance means the absolute path distance traveled by the object with no sense of 
orientation. Oriented distance will grow larger as the object moves “forward” and grow smaller as the object 
moves “backward”. Oriented distance is probably what will be most often used. NOTE: if you happen to have 
constructed your object so that its “forward” end faces down the negative Z axis, you will need to go in by hand 
and edit the expression to have a negative ODIST value.
Stride Length - Quite often a cycle will need to repeat over a specific distance (like 2 times the step distance of a 
character, or the distance around the path of a tank tread unit), the distance over which the cycle repeats is 
known as the “stride length”.
Optional Length Delay - This field can be used to push the cycle back over its stride length, used to offset 
opposing legs in a walk cycle, or pushing one element of many back down its path a little bit.
Tie length delay to object extension - Use the clone number (i.e. the 3 in “null (3)”, or the 10 in “obj10.lwo”) as a 
multiplier for the length delay. You can use this field to create an expression that should automatically tailor 
itself to clones of that same object.
Extension offset - This value is subtracted from the object’s extension and can be used to turn the clone number 
of “null (1)” to 0, so the first object doesn’t have an offset along its path.

Dr. Motion Blender - Multi-slot professor

Dr. Motion Blender can be used to blend between the motion paths of two objects interactively during an animation. 
What applications that might have in your animations is entirely up to you. Here is a breakdown of the fields:

Object 1 and Object 2 - Pick the objects whose motions you want to blend between. NOTE: if you put SELF in for 
one of the objects, it would blend this object’s own keyframed motion with something else.
What Channels will we be blending between - Pick one or more motion channels for the motion blend.
Constant Blend Percentage - Pick a constant blend percentage between the motions.
Blend Control Object - If this field is filled, it negates the blend percentage field. Use an object to control the 
blend.
Channels of the controlling object - You can choose a single channel of the controlling object to control the 
blend on all channels of our blend object (for instance, the Y value of our object would control the blend as it 
moved from 0 to 1). If you pick “All Channels”, then the X value of the control object will determine the X blend 
percent, the Y value will control the Y blend, etc.
Truncated Blend - If the control object’s values get above 0 or 1, cut them off at 0 or 1, otherwise, you’ll get an 
“overblend”.

Dr. Blend Machinist

Dr. Blend Machinist is one of the most powerful professors. Using this panel, you can set up lots of interesting 
relationships between objects, where one channel of one object control the action on one or more channels of another 
object. For instance, imagine a foot where you need the toes to curl as it lifts off the ground. Or imagine a mechanical 
system where you need a piston to expand and contract with a rotation. Or imagine a key-state animation, where you 
can control the opening and closing of multiple bones/segments using a single control null (or group of nulls)… 
basically any kind of “reaction” to some slider value… Blend Machinist can do these and much more. Here’s a 
breakdown of the fields:

Truncated Blend - This will cut off the blend as it reaches its min and max values, a non-truncated blend will 
continue the blend beyond the min and max values.
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Type of Blend - A blend between values will do just that, blend between two values. A time blend will push the 
time value back and forth and play back a keyframed motion. Quite often, a time-based blend is what’s required 
to properly blend-animate a motion that has more than two distinct keyframed values.
First and Second Value - These can either be straight numerical values or expressions unto themselves… only 
used if we’re blending between two values.
First and Second Frame - Used if we’re blending time, at the lower blend value, the current motion channel will 
go back to the start frame. As the blend value increases to the upper blend value, the current motion channel 
will play along to end at the second frame value when the blend value reaches the upper value.
Track what value for the blend - You can either click on a motion channel to track, or enter an explicit expression 
by clicking on the Custom Expr button and designing an expression using Dr. Equation Maker from the 
Expression button.
Expression - Used when the Custom Expr button is clicked.
Lower/Upper Blend Trigger Values - Lower and upper values for the blend to track.

Dr. Dist Maintainer - Multi-slot professor

In order to understand how to use this professor, you need to understand the two modes it works in. One is a linear 
distance maintainer, the other is a spherical distance maintainer. For the first mode, it’s important that you choose 
wisely which motion slot you select the Dist Maintainer professor from, this will become the “sliding axis”. For instance, 
say you want an object to slide up and down the Y axis to try to keep its distance constant to some other object, you 
would then select Dr. Dist Maintainer next to the Y slot. Note that Dr. Dist Maintainer doesn’t make much sense in the 
rotation or scaling slots. In spherical distance mode, the expressions generated will draw a line from the current object 
to the tracking object and measure the length of that line. It will then move the current object along that line until the 
distance is the value desired. Here’s a breakdown of the fields:

Other object - This the object that you want to maintain a constant distance to.
Distance to maintain - Distance to the maintainer.
Spherical distance - Throw the professor into spherical distance mode, as described in the preceding paragraph. 
If this button is off, the distance formula works in sliding-axis, linear mode.

Dr. Event Maker - Multi-slot professor

Dr. Event Maker is one of the most powerful professors available in your arsenal. Using this professor, you can set up an 
animated event to play back when some particular action occurs: the object will play back its own keyframed motion in 
response. You can also set up a “closing event” for when the particular action undoes itself. A good example (indeed, an 
example scene), is a set of sliding doors, like on the turbo lift in Star Trek. As an object approaches the doors, they slide 
open, and then as the object gets far enough away, they slide shut again. But there’s lots more events than that… play 
around, experiment… see what automated responses you can come up with. Here’s what the fields on the panel do:

Type of Event - If set to Resettable , the time of the event will reset every time the trigger event becomes false 
again, and then start ticking again while the trigger event is true. A One-time-only event will keep ticking even if 
the condition for the trigger event becomes false.

If you need to set up a blend for more than one motion slot, you will need to re-select the professor next to 
each slot that you want set up.


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Channels for Event : Pick the channels that you want this event to play back on. Note, you are selecting the 
object’s own keyframed motion for this event. If you want to play another object’s motion back instead, you will 
need to hand-edit the expressions generated to point to the object in question.
Object to control the event - This is the object that we’re tracking.
Look for Event - Here, you choose what event to look for. For now, it simply tracks whether a motion channel 
becomes greater than “>” or less than “<” a specific value. Notice if you choose “Dist >” or “Dist <”, the ‘From 
what object” field becomes active.
Value - this is the value that our object must hit to trigger the event. Once it falls above or below this value 
(depending on whether you chose a greater-than or less-than button), the event will be triggered.
From what object - If you are tracking distance, there needs to be an object to track the distance from.
Play Event From/To Frame - Pick the first and last frame that our object will play back in response to the event 
trigger.
Closing Event - You can set up a closing event that happens when something else occurs. NOTE: if you are 
choosing to undo some action, like having a door close back shut, it’s important that you set up both events so 
that they are mutually exclusive… i.e. if you have a door open when an object gets closer than 1 meter, you 
should not have it close when the object gets out to 0.5 meters… otherwise, there will be a conflict between the 
two conditions.
All the other fields are functionally equivalent to the original event fields.

Dr. Camera Shaker - Multi-slot professor

This professor is great for not only setting up a camera shake when an event occurs, but also for making stuff jiggle with 
impact, and other sorts of impact-related events.

Channels to shake up - Pick what channels you want to set the impact on. Next to each channel selector is a 
power field… increasing this value will increase the intensity of the impact. Decreasing will do the opposite.
Object that should shake the camera - This is the object that will make the camera shake occur.
Look for Event - Look for either a motion channel or the distance of this object from another to either become 
less or greater than some value.
Length of shaking - Determines the length of the shaking.
# Shakes/second - This is the frequency of the shaking, higher values for this will make faster shakes, lower 
values will make slower shakes.
Would you like shake to fall off with distance? - You can have the shake fall off with distance.
Distance when shake is optional - The impact expression will be at full force at this distance; closer, and it will 
become a super-impact; further, and it will become a soft impact.
Quadratic Falloff - Make the impact distance expression fall off more rapidly as the object gets further away. A 
non-quadratic falloff doesn’t decay down as rapidly as the object moves further from the camera.
Would you like the shake to fall off with impact velocity? - Turning this on will cause the shake to change 
depending on how hard the object hits the ground.
Velocity strength factor - Changing this to a higher value will make the shake more sensitive. Changing it lower 
will make it less sensitive.

Dr. Morph-o

Dr. Morph-o is the professor to use for setting up Relativity morphs. It should be noted that Dr. Morph-o currently only 
sets up morph expressions with either a morph controller or an effector. If you need some other expression to control a 
morph other than just the X value of a control null, you will need to hand-edit the expression to make it happen.
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Target - This is the target for the morph. NOTE: it doesn’t have to have the same number of points as the base 
object, but it would be quite advisable.
Sign of morph - Determines how the morph is applied; replace is like LW’s traditional morph; add will add the 
values of the target points to the base object; subtract will subtract the points; difference is a cool morph, it 
morphs only points that are different between the base and target objects.
Type of morph - Normal is like LW’s regular morph. Effector will apply a morph in an effector like fashion, in a 
spherical gradient around an effector object.
Object to control morph - Choose an object to control the morph.
Morph effector - This is the effector that controls an effector morph.
Min radius - This is the area around the morph effector when everything is fully morphed.
Max radius - In the area between the max and min radius, points close to the max will be barely morphed, while 
points close to the min will be almost fully morphed. Points outside the max radius are not morphed at all.
I want a min and max null : Choose a min and max null to interactively animate the min and max values for the 
effector.
min null - The minimum value for the null
max null - The maximum value for the null.

Dr. Target

Dr. Target is used to set up a targeting relationship between the current object and a target.

Dr. Matcher

Dr. Matcher is used to match an unparented, free-floating object to an object or bone deep in a hierarchy. If you want to 
dynamically parent/unparent an object to another, here’s how to set it up:

Create a null and use Dr. Matcher to match to whatever child object/bone/whatever you’re interested in.
Set up a motion blend using Dr. Motion Blender between your unparented object and the MATCH’d null.
When you want the object to move from unparented to parented, quickly keyframe the blend null over one 
frame. If you need to have motion blur and not have your object do some sort of odd sub-frame rotation, you 
might want to change the expressions for the Motion Blend from:

X=BLEND(X(SELF,t),0,X(matcher,t),1,X(blah,t))

to

X=BLEND(X(SELF,t),0,X(matcher,t),1,IF(X(blah,t)>0))

That will cause your motion blend to be instantaneous, even on a sub-frame level.

These last two don’t have to be nulls, but usually are.
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Dr. MoveVec

Dr. MoveVec sets up a really odd form of motion… basically, whichever way a MOVEVEC’d object is turned, it will move 
in that direction. This was originally done as a means of making an object move as if it were under the influence of a 
joystick… just set up an expression to make it rotate accordingly and the object will act like it’s in a video game.

Dr. Snake Maker

Dr. Snake Maker is a generic level plugin that can set up a scene for you with a bone-snake (for path-level deformations) 
stretching through an object. Here’s a breakdown of the fields:

Set up bones for object - Picks your object.
How many bones do you want - Tell it how many bones in the snake. Keep in mind, you want to balance between 
having enough bones for a smooth path deformation but not having so many that the scene becomes unwieldly.
How long is your object - Measures your object and tell the nice professor how long it is. As an aside, the “head” 
of your object should rest at the origin (i.e. XYZ=0,0,0) and the “tail” stretch out into positive Z.
Bone name prefix - Each bone will be named with whatever prefix you choose, followed by a number… i.e. 
SnakBon01, SnakBon02, etc.
Target name prefix - The way a bone snake is set up in Relativity, a train of nulls follows your object around, and 
the bones target those nulls. This lets you choose the prefix for each target null.
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Command Port
Introductory videos describing how the new Command Port functions. The command port allows instructions to be 
sent to Layout and Modeler over the Internet.

Intro and Activate

First steps

Python Package

The Command Port automatically generates a Python package of commands for Layout and Modeler.

Auto-discovery

Command Port automatic port discovery setup

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=Uha2q7ziX1Q

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=CWKH_gctpWQ

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=Wpi_2qF5kJw

https://www.youtube.com/watch?v=Uha2q7ziX1Q
https://www.youtube.com/watch?v=CWKH_gctpWQ
https://www.youtube.com/watch?v=Wpi_2qF5kJw
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Expressions
Click here to expand Table of Contents...

Introduction
Graph Editor: Expressions Tab

To create an expression:
Additive Expression
To rename an expression:
To attach an expression on a channel:
To determine what channels are attached to an expression:
To remove a channel from an expression:
Libraries
Expression Syntax
To use bracket notation expressions:
Bad Expressions
Subexpressions
Vector References
Expressions Tree
Expression Builder
Bracket Expressions - Syntax
LScript Expressions - Syntax

Using Expressions - Examples
Example 1: Expression Basics: Rotating a Gear
Creating an Expression:
Applying an Expression:
Example 2: Expression Builder
Example 3: Joystick Control for Morphs
Wink right
Blink Both
Wide Open
Connecting LScripts to Expressions
Object References
Built-in Functions
Sample Expressions

Object References
Built-in Functions
Common Object Methods and Data (all objects respond)
Mesh Object Methods and Data
Light Object Methods and Data
Camera Object Methods and Data
Scene Object Methods and Data
Selector/Converter items


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Introduction

Expressions are an advanced LightWave 3D feature that uses mathematical formulas to modify the value of any 
animation channel. Expressions let you make the motion of scene items dependent on other item motions or factors in 
a scene. You could, for example, force an object to stay between two other objects, keep feet from going through the 
floor, or even control the entire posture of a character based on its feet! The possibilities are endless.

There are two types of expression, "Bracket" expressions and "LScript" expressions. Each has their advantages and 
disadvantages. Bracket expressions take their name from the fact that the channel they are reading is always enclosed 
in square brackets, "[" and "]". The LScript expressions have a syntax similar to that of LScript. You can use much of the 
LScript documentation to help with the use of the functions available for using in LScript expressions.

Graph Editor: Expressions Tab

Expressions are built right into the Expressions Tab on the Graph Editor. This implementation has several advantages 
over the channel expression modifier. First, expressions are not an attribute for a single channel. Instead, the 
expressions stand alone and channels are attached to them. This allows you to attach multiple channels to a single 
expression! Moreover, you can save and load libraries of expressions you create.

To create an expression:

Click the New expression button. No channels need to exist in the Channel Bin nor does any channel need to be 
selected-expressions stand alone.
Enter a name for your expression in the Name field.
Enter your expression in the Value field.

You may also copy the selected expression by clicking the Clone button. This creates an independent copy that you can 
alter.

You can obtain a reference of available functions from the LScript documentation or from Expression Builder.

To get interactive updates in Layout for expressions, make sure you have Auto Key active.
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Additive Expression

You can use the Value variable to make an additive expression. Value is equal to the (base) keyframed value. For 
example, if the camera's keyframed X position was 2m and the Light's keyframed X position was 3m, the expression 
Value + [Light.Position.X], placed on the camera's X position, would move it to 5m.

Note that editing an item in Layout with an additive expression attached (e.g., Value + [Null.Position.X]) can cause 
recursive updates, since you're changing the Value. There are a few work-arounds:

Do the edit in the Graph Editor;
Turn off the expression in the Graph Editor. Perform the edit and then turn it back on; or
Add a null and animate it the same way as the item itself (except without the expression). Then, replace Value in 
the expression with the null's corresponding channel (e.g., if Value was the item's Y position, then use the null's Y 
position instead).

To rename an expression:

Make sure the expression is selected. Its name will appear in the Name field. To select a different expression, 
choose it from the Expressions... pop-up menu.
Type a new name into the Name field. This will have no effect on any of the expressions channels.

To attach an expression on a channel:

Make sure the expression is selected. Its name will appear in the Name field. To select a different expression, 
choose it from the Expressions... pop-up menu.
Select the channel(s)in the Channel Bin.
Click the Apply button. The modified dot (•) will appear to the left of the channel name in the Channel Bin. The 
expression must be legal, of course.

To determine what channels are attached to an expression:

Make sure the expression is selected. Its name will appear in the Name field. To select a different expression, 
choose it from the Expressions... pop-up menu.
Click the Get Channels button. The contents of the Channel Bin will be replaced with the channels attached to 
the current expression.

It is possible to attach multiple expressions to a single channel, but this is not recommended. The expressions 
will be evaluated in the order they were attached; however, there is no way to determine that order.



The name of an expression on the Expressions... pop-up menu will list the number of channels attached to it in 
parentheses.


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To remove a channel from an expression:

Select the channel(s)in the Channel Bin.
Click the Remove button.

Libraries

You can save all of the existing expressions to a file on your hard drive by choosing Expressions... > Save Library. To load 
a previously saved library, choose Expressions... > Load Library. If an expression exists with the same name, it will be 
replaced. Otherwise, the library of expressions will be added to the list.

You can clear all unused expressions by choosing Expressions... > Clear Unused. This clears out any expressions that do 
not have any channels attached.

Expression Syntax

LightWave supports two types of expression syntax. The first is identical to the Channel Expression syntax (e.g., the x 
position of a light at time t is given by Light.pos(Time).x). This works normally, as does all of the control syntax (x < 5 ? y : 
-y).

With integrated expressions, you can also use a bracket notation syntax to reference any channel in the system. By 
placing square brackets ([]) around a full channel name, you may access any channel in the system. This includes 
MorphMixer channels, envelopes, and so on (e.g., [Camera.Rotation.H]). You can freely mix and match the two methods 
of referencing item information ([Light.Position.X] and Light.pos(Time).X).

Channels referenced in this way will be evaluated in a dependency-conscious way. In other words, if channel X 
references channel Y, which has an expression that follows channel Z, then the bracket notation insures that the Y 
channel's expression (referencing Z) is evaluated before computing channel X.

Bracket notation expressions may also take an optional time argument. The syntax is [Channel,Time_arg] where 
Time_arg may be any legal expression, but cannot include anything using the bracket notation syntax. An example of a 
bracket notation expression that follows the camera's X position, but lags by half a second, would be 
[Camera.Position.X,Time - 0.5]. To make it lag by four frames, it would be [Camera.Position.X,Frame - 4].

To use bracket notation expressions:

Add two null objects named Control and Action to an empty scene.
Animate the Control null on its Y axis.
Attach the expression

[Control.Position.Y]

to the Action null. This would lock the two together on the Y axis; wherever Control goes, Action follows.
Change the expression to

[Control.Position.Y,Time]

. This has the exact same result. As such, unless you want to modify Time, you do not need to use the time 
argument.
The expression
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[Control.Position.Y,Time - 1]

would lock Action to Control, but give it a one second delay.
The expression

[Control.Position.Y,Frame]

also has the same result as the original expression, but differs in that it feeds the time of the current frame to the 
expression. This lets you do something like:

[Control.Position.Y,Frame - 30]

.

[Control.Position.Y,Time - 1]

and

[Control.Position.Y,Frame - 30]

yield the exact same results (assuming 30 fps). One expression is working with seconds and the other is working 
with frames.

Bad Expressions

If an integrated expression is erroneous, an error dialog will appear when you attempt to apply it or otherwise exit the 
input field (e.g., using TAB key, ENTER key, mouse click, etc.). Also, the Apply button will show Uncompiled instead of 
Apply.

Subexpressions

An expression may reference another expression (subexpression). The format is identical to other bracket notation 
calls, except that in place of a channel name, you supply an expression name. Time may still be specified, just as if it 
was a channel reference.

So

[myCenter, Frame - 5] 

would cause the system to evaluate the expression

Make sure you use spaces around math operators, like the minus sign used above. Not doing so may confuse 
the expressions parser, which allows some of those characters in scene item names. Loops are not allowed 
and the system will report an error if any are detected.


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myCenter 

at the current Frame - 5 and return that value.

If the subexpression contains a reference to the Value variable, then the current value of the channel - whose expression 
is using the subexpression - will be used. In other words, all expressions within an expression are using the same Value 
variable.

Also, subexpressions may not themselves contain subexpressions. There will be no error, but any sub-subexpression 
will always return 0.0 upon evaluation.

Vector References

Bracket notation references to channels may also reference a vector for position, rotation, or scale. This works with the 
built-in expression functions that take vectors as parameters.

For example, this expression shows how you could find the center X coordinate of two items using scalar values:

([Left.Position.X] + [Right.Position.X]) / 2.0

Here is an expression that performs the same feat, but using vectors:

center ([Left.Position], [Right.Position]).x

An advantage to the second method is that items with spaces in the names can now be referenced by vector functions.

Expressions Tree

The Scene list area for the Graph Editor has an Expressions Tab. The Expressions tree shows all the expressions in the 
system. The first column reflects the active state of an expression. You may toggle the expression on and off by clicking 
in the On column. All attached channels will be affected.

The Attached column shows the number of channels attached to the expression.

Double-click an expression name and the contents of the Channel Bin will be replaced with the channels attached to 
that expression. You will also select the expression. Hold the Shift key and double-click to add the channels without 
removing any.

If you right-click an expression name, a pop-up menu appears, allowing you to delete the expression. This will detach 
any channels that may be using it.
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Expression Builder

The Expression Builder is a "wizard-type" feature designed to help you write expressions. To access it, click the Builder 
button on the Graph Editor's Expressions Tab. This will guide you through setting up a single function as an expression.

To use, first select an expression function from the Expression Builder Basics pop-up menu at the top.

The Description Tab gives you a description of what the expression is. The Example Tab gives you an example of how to 
use the expression. The Applications Tab explains why the expression might be used.

Once an expression "template" is chosen you will be presented with a composite of the expression below the info 
windows where you are presented with pop-up menus to set what values and/or channels are driving each of the 
components.

Once you've set the inputs, click Accept. You will be able to rename and modify the expression on the lines below. Click 
Create Expression to add the expression to the Graph Editor's list.
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Bracket Expressions - Syntax

Bracket expressions always have the channel reference enclosed in square brackets and have the general syntax as 
shown in the figure.

You can also use "Frame" in place of the "Time" and you can also do things like refer to earlier times e.g. 
[objectName.Position.X, Time – 0.1]

The primary disadvantage of Bracket expressions is that they may only be used via the Expressions Tab in the Graph 
Editor.

LScript Expressions - Syntax

LScript expression are not enclosed by square brackets. The object property is all lowercase, as is the channel - see the 
figure below.

LScript Expressions are generally used via the Modifiers Tab in the Graph Editor, or, more typically, via the Motions 
Options Panel.

One advantage of LScript expressions applied in the Motion Expressions Panel is that they can act after an IK example.

LScript expressions can also be used to create expression-controlled displacements via the Displacements Panel where 
the expression can act before or after a bone deformation.
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Using Expressions - Examples

Example 1: Expression Basics: Rotating a Gear

William Vaughan says: "I've been using LightWave for many years now and Expressions have always been something 
that I considered too technical, something that I'd give my math friends to work on. It wasn't until recently that I found 
out that it's quite simple to use expressions. This tutorial will walk you through setting up a basic expression that will 
help speed up animating gears on a Mech."

Creating an Expression:

Load the Crunk scene attached here. 

Our goal in this setup 
is to have the gears automatically rotate when the Thigh "Crunk_rightthigh" is rotated. The lower gear 
"Crunk_Gear01" is already setup to rotate by being parented to the thigh. We can do this because the lower 
gear's pivot point is in the same place as the Thigh. The upper gear "Crunk_Gear02" doesn't share the same 
pivot point and needs to rotate in the opposite direction. You could manually animate the upper gear but using 
an expression will save you the hassle.

Select "Crunk_rightthigh" as the Current Object.

https://docs.lightwave3d.com/download/attachments/8197601/Expressions.7z?api=v2&modificationDate=1546275245000&version=1
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Open the Graph Editor by clicking on the Graph Editor button, or use the keyboard shortcut of Ctrl F2 .
Click on the Expressions Menu Tab located under the graph display.

Click the button labeled "New" and give it a name. I chose to name mine "Gear_02".
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In the Value field, select "Value" and replace it with "-".

 

The "-" will make the gear spin the opposite way of the thigh by giving it a negative value.

We want the Gear to spin the opposite way of the Thigh by giving it a negative value of the Thigh's Pitch. The "-" 
makes it negative, now all we need is the Pitch value of the Thigh. From the Channel List choose 
"Crunk:Crunk_rightthigh.Rotation.P".

Right-click and choose Append to Expression.
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The Value Field should look like this:

 

Congratulations! You have just written your first expression. Now that wasn't so hard was it? All we need to do 
now is apply this expression to "Crunk_Gear02" and we'll be finished with the setup.
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Applying an Expression:

Now that we have our Expression let's apply it to the Gear. From the Channels list select "Crunk_Gear02".

From the Channel List choose "Crunk_gear02.Rotation.P".
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Click Apply.

Let's take a look at what happens when we rotate the Thigh.

Close the Graph Editor window and make sure that Auto Key Create is selected.
Select "Crunk_rightthigh" as the Current Object, and rotate its Pitch.

Crunk_Gear02 should rotate on its Pitch in the Opposite direction of Crunk_Gear01 and Crunk_rightthigh.

A small dot is placed next to the channel to let you know that it has an expression attached to it.
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Well, there you have it. Your first expression applied and in action. We've only scratched the surface on the power of 
Expressions in LightWave.

Example 2: Expression Builder

In this example we will use the Expression Builder to center the hips of a character between its two feet. This example 
assumes the character's hips are not determined by any form of IK calculation. If that is the case you will need to use 
LScript expressions (applied via the Motion Options Panel) as only Lscript expressions can act after IK.

Assume the name of the character's two feet are "footLeft" and "footRight" and that the position of the hips are 
controlled by a single null called "hip". To center the hip null we will fix its X and Z coordinates (and leave the height, Y, 
to the animator).

Open the Graph Editor and load the hip channels. Click on the Expressions Tab - your panel should look like the figure.
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If you select your hip null before opening the Graph Editor the hip channels will automatically be added to the channel 
bin.

First we will create the bracket expression to center the X coordinate of the hip null. Click on the Builder button to open 
the Expression Builder Panel, click on the Expression Template button at the top of the panel and select the Hip Center 
(Type A) menu option as shown below.
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This brings up the expression template - all you have to do is say which channels you want to slot into the template. 
Expression builder will then create the full expression for you and add it to the Graph Editor. The template for hip 
centring can be seen below.
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The good thing about the Expression Builder (apart from creating a template for you) is that it also gives an explanation 
for how to use the expression template. To center the hips we will use the "center" function. This function takes two 
arguments, the two coordinates between which you want to center the object. The important thing to understand is 
that the expression can only center in one dimension. To center in two dimensions (ie. the X and Z coordinates) we use 
the expression twice. Once to center the X coordinate and a second time, using the Z coordinates, to center in the Z 
direction.

Back to the Expression Builder template First for the X direction. We need to enter the X position of the left foot and the 
right foot. To do this for the left foot click the Left Foot pop up menu button and select the Channel option to bring up 
the Channel Selection Panel as shown:
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 and 
then select the "Position.X" of the footLeft object. Click Choose and you should notice that the X position channel of the 
footLeft object has been entered into the expression (which is written in the "Value" field on the panel) as shown:
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 Do the 
same for the "Right Foot" pop up menu, but now select the Position.X channel for the rightFoot object. The Expressions 
Builder Panel should now look like this:

 
Now, click the Accept button to accept the expression. Expressions Builder gives the expression a name in the Name 
field - usually something like "newExp_2" - delete this and replace it with something meaningful like "centerHips_X". 
Finally, click Create Expression - this tells Expressions Builder to enter the expression in the Expression fields in the 
Graph Editor. Close Expressions Builder and the Graph Editor should now contain your expression as shown below.
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In order for the expression to actually affect the X coordinate of the hip object we need to "Apply" the expression the X 
channel of the hip object. To do this select the "hip.Position.X" channel in the channel bin and then click the Apply 
button. The hip.Position.X channel should then have a dot to the left of the name to show that that channel has an 
expression applied to it. If you have the Always Show Modified switched on in the Graph Editor options then as soon as 
you apply the channel the modified curve will appear in the curve window as shown:
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We still have to center the Z coordinate of the hip object. To do this you could use the Expression builder again 
(choosing the Position.Z channels for the foorLeft and footRight template slots), however, there is a quicker method. 
Since the expression for the Z coordinate is similar to the X coordinate we can create it by "Cloning" the centerHip_X 
expression. You do this by clicking the Clone button (on the Expression Tab of the Graph Editor). This will create the 
same expression, but with the new name "centerHip_X (Clone)". All you need to do is edit the expression name – change 
it to something like "centerHip_Z" and then change the X's in the actual expression to Z's. Then select the hip.Position.Z 
channel in the channel bin and click "Apply" to get:
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Your hips will now remain centered between the character's feet no matter what the feet do.If you look at the Utility 
functions in Expression builder you will notice there are several variations of hip centring which are a little more 
complex to set up but they give you more control over your character.

Example 3: Joystick Control for Morphs

In this more advanced example we will use Expression Builder to create the expressions for a joystick control. The 
joystick will be used to control the blinking of a character's eyes.

Overview: We begin by explaining what we are trying to do. The blinking of a character's eyes is modelled using four 
morphs: A left eye blink, a right eye blink, both eyes blinking and both eyes opening wide. We will control the left and 
right eye blinking by moving a null to the left and right respectively. The opening and closing of both eyes will be 
controlled by the same null, not with the left/right motion, but with the up/down motion of the null. We will call this null 
the "joystick" null. The big advantage of using this method is that if we move the null both sideways and up (or down) 
ie. diagonally, we will simultaneously combine all four morphs by using only one controller - the joystick null.

How do we achieve this with expressions? We will use four expressions:

blinkLeft,
blinkRight,
blinkBoth and
wideOpen.

Each expression will connect the joystick null to one of the four morph channels:

object.Body.Eyes.Blink_Left,
object.Body.Eyes.Blink_Right,
object.Body.Eyes.Blink_Both and
object.Body.Eyes.Wide_Both.
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(The actual object in the screenshots is called William_Rig.) There remains one further hurdle: when the joystick null 
moves, it will move a certain distance (eg 50mm) which will need to be converted into a morph percentage. When using 
morphs, 100% is actually represented by the number 1 (and 0% by 0). Thus if we want a distance change of 50mm to 
correspond to a morph percentage change of 0% to 100% a function called "maprange" will convert this range of 0 to 1 
for us.

The joystick is just a null which we will move in the XY plane to control the morphs. The utility of the joystick approach is 
greatly enhanced if there is some graphic on-screen indicating which directions correspond to which morph changes, 
and also, where 0% position is. For this example we have created all of these using five other nulls. Four nulls are used 
with an "Item Shape" custom object whose only purpose is to place some text in the viewport. The last null has a square 
as the custom shape showing the range for the joystick (and the center). Also, all the nulls are parented to the "square 
window" null. This allows us to position the whole joystick control setup anywhere in the scene. For convenience, the 
joystick is usually placed in a viewport by itself (or alongside any other such controls).

We will start by creating the BlinkLeft expression. This expression will control the closing of the left eye as the joystick 
moves from O to A (see the figure).
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In terms of distance the null is moving from X=0 (at O) to X=-50mm (at A) the full range of the eye closing corresponds to 
a morph percentage change of 0 to 75% or, for the expression, a change from 0 to 0.75.
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We will use Expression Builder (EB), so open the Graph Editor, click the Expression Tab and click the Builder button. 
Once the EB is open, use the pop-up menu to choose the Clamped Range utility function as shown:

We now have an expression template with five inputs.
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This is the function that "maps" the range of the joystick controller (ie. –50mm to 0mm) to the range of the morph (ie 
0.75 to 0.0) To use it we need the joystick controller to go in the first input, so, select the "Channel" from the Controller 
input

and then select the X position channel of the joystickControl object.
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Now, the "Input Min" is the minimum value (as a number) that the joystick controller will take. In this case it is –50mm, 
or –0,05. Thus, choose the number option in the "Input Min" popup,

and enter –0.05. Similarly, for the remaining three entries: The "Input Max" is the maximum value we expect the X 
coordinate of the joystick to take (for controlling the left wink – it will actually move to +50mm for the right blink, but for 
the left wink we want an X value of 0 to correspond to the 0 morph percent. Thus the "Input Max" is 0. For the "Output 
Min" we want 0.75 – the morph percent that corresponds to –50mm (which isn't actually the smallest number), and for 
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the "Output Max" we want 0 (giving a morph percent of 0%). Once all your numbers are entered, the template should 
look like this:

Now, click the Accept button, which tells EB to accept all your template entries. EB usually gives the expression some 
generic name; so delete it and type in "winkLeft" for the expression name.

Finally, click the Create Expression button. This tells EB to send the expression to LightWave. If you now open the Graph 
Editor and click on the Expression Tab you should see your expression!

You can close the EB Panel as we won't need it until later. Back in the Graph Editor (GE), we now have to attach or apply 
the expression to the channel which it is going to control ie the left blink morph channel. To do this you need to get the 
channel into the channel bin (the list is on the top left of the GE). In our scene the morph channel is called 
William_Rig:Body.Eyes.Wink_Left". Once it is in the channel bin select it and then click the Apply button on the 
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Expression Tab. A dot should appear next to the morph channels name telling you it now has an expression attached to 
it.

That's it for the left eye winking. If you move the joystick controller's X position from –50mm to 0 the left eye should 
wink.

We now have to repeat this three more times to create the expression to control the right wink, the wide open case and 
the both closed case. The process is exactly the same except that the numbers entered into the Expression builder need 
to be changed and, for the blinkboth and wideOpen cases, it is the Y position of the controller that is used. These three 
EB Panels are shown below:

Wink right

Blink Both
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Wide Open

Once you have applied these three expressions to their respective channels your joystick controller should be fully 
functional.

One last thing. Why is the "clamp" function part of each expression? The maprange function can take values outside the 
range of the "output" min and max values i.e. it can give negative morph percents or percents greater than 100%. But 
the clamp function stops this from happening. It takes in the values of the maprange function and forces them to stay 
within the range of the very last two numbers in each expression (in this case, the range 0 to 0.75)

Connecting LScripts to Expressions

You can write an Lscript function, or user defined function (UDF), using all the keywords available in LScript and then 
access the function in an expression.

Employing embedded LScript, users can now write their own functions to use with LightWave Expressions.

Expressions UDFs are used just like any built-in Expressions function. Parameter passing is limited to simple data types - 
strings, numbers and vectors. As long as an expression evaluates to one of these data types, it can be used as an 
argument. Expressions UDFs are stored in the LightWave->LScripts directory within their own directory called 
"expressions". A default library of functions can be maintained within this directory called "library.ls". This library of 
functions is automatically loaded into the Expressions engine when LightWave is initialised, and its defined functions 
are consequently available to any LightWave expression or Expressions UDFs that references them.

Additionally, individual Expressions UDFs can be stored in their own files in this same directory. The name of the file 
containing the UDF must exactly match that of the function name being referenced. The file may contain any number of 
other UDFs to support the main function, but must contain at least a UDF whose name and argument count matches 
that being referenced in the expression.

Data exchange between UDFs is not limited in their types. UDF-to-UDF calling is exactly the same as it is in LScript.

By way of example, assume the following files exist in the required directory:

\LightWave\support\plugins\scripts\LScript\expressions->library.ls

\LightWave\support\plugins\scripts\expressions->channelValue.ls

The "library.ls" file contains the following content:

http://library.ls
http://library.ls
http://channelValue.ls
http://library.ls
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locateChannel: fullchannel
    {
        parts = parse(".",fullchannel);
        group = ChannelGroup(parts[1]); // start with root channel group
        lastgroup = group;
        subgroup = nil;
        x = 2;
        while(group)
        {
            // scan sub-groups to match parts[x]
            // if a match can't be found, then it
            // is probably the start of the channel
            // name
            subgroup = ChannelGroup(group,subgroup);
            last if !subgroup;
            if(subgroup.name == parts[x])
            {
                group = subgroup;
                lastgroup = group;
                subgroup = nil;
                ++x;
            }
        }
        if(!lastgroup) return(nil);
        // anything left in the parts[] array are the components
        // of the channel name itself. put them together for
        // channel searching
        channelname = "";  // avoid creating an array
        psize = parts.size();
        while(x <= psize)
        {
            channelname += parts[x];
            if(x < psize) channelname += ".";
            ++x;
            }
        // scan the defined channels in the final group to see
        // if we can match the channel name
        chchannel = lastgroup.firstChannel();
        while(chchannel)
        {
            last if chchannel.name == channelname;
            chchannel = lastgroup.nextChannel();
        }
    return(chchannel);
    }
    // replace the built-in clamp() function
    clamp: val, lower, upper
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    {
        result = val;
        if(val < lower)   
        result = lower;
        else if(val > upper) 
        result = upper;
        return(result);
    }

While the "channelValue.ls" file contains the following content:

    chan;
    chanName;
    channelValue: channel, time
    {
        if(chanName != channel) chan = nil;
        if(!chan)
        {
            // cache the channel for speed
            chan = locateChannel(channel);
            if(!chan) return(0);
            chanName = channel;
        }
        return(chan.value(time));
    }

In Layout, you might then enter an expression like: clamp(channelValue("WashLight.Intensity",Time),0.0,1.0)

This will invoke the channelValue() UDF, which then invokes the locateChannel() UDF (defined in the default library file "l
ibrary.ls") to resolve a string channel reference to an actual LScript Channel Object Agent. The channelValue() UDF 
returns the value of the specified Light Object's intensity value at the current time. This value is then passed to the 
(script) clamp() UDF (also defined in "library.ls") to keep it in a specified range.

Alternately, you could use the Graph Editor's direct channel reference syntax with the UDF call:

clamp([WashLight.Intensity,Time],0.0,1.0)

UDF references that have been loaded into the Expressions engine are automatically updated the next time they are 
evaluated when their respective files have been modified. For instance, if you have expressions referencing 
channelValue(), altering the last line of the function to read:

return(chan.value(time) + 1.0);

will instantly return new values the next time the expression is evaluated (e.g., on the next frame).

http://library.ls
http://library.ls
http://library.ls
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Object References

Objects are referenced by their name. The system does not currently support space characters (' ') in object names, so 
cloned objects (i.e., "Null (1)", "Null (2)", etc.) cannot be used unless they are renamed.

The "Scene" object is the only pre-defined object in the system. All other object references must equate to an object in 
the current scene.?

Built-in Functions

All the built-in functions are described in the coding manual available with the SDK.

Sample Expressions

HeadLight.rot(Time).h

returns the heading rotation value of the HeadLight item at the current time.

Left.pos(Time).x + Right.pos(Time).x

returns the sum of the Left and Right items' positions on the x axis.

<1,2,3>.y returns 2
<1,1,1>.rgb returns <255,255,255>
<.5,.25,1>.rgb returns <127,63,255>

BackLight.color(frame / Scene.fps).rgb

returns RGB vector value for color BackLight at a user-defined frame converted to a time index using the Scene object's 
fps setting. The frame variable is returned to the caller and can have its value explicitly set before each evaluation of the 
expression.

2 * "1 2 3".asVec.y returns 4

((Scene.usingLR ? (Scene.lr.right - Scene.lr.left) : Scene.width) / 2).asInt

finds the horizontal center of the frame.

A vector is a group of related values. They could relate to position (X, Y, Z), rotation (H, P, B), color (R, G, B), etc. 
To get only one component, use a selector as demonstrated below.
Expressions react to interactively moved items, even if Auto Key is turned off.
You may use XS, YS, and ZS as aliases for Scale.X, Scale.Y, and Scale.Z.


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Object References

Objects are referenced by their name. The system does not currently suport space characters (' ') in object names, so 
cloned objects (i.e., "Null (1)", "Null (2)", etc.) cannot be used unless they are renamed.

The "Scene" object is the only pre-defined object in the system. All other object references must equate to an object in 
the current scene.

Built-in Functions

double sqrt(double)

double exp(double)

double log(double)

double sin(double)

double cos(double)

double tan(double)

double asin(double)

double acos(double)

double atan(double)

int random(int,int)

double vmag(vector|double,double,double)

(int|double|vector) abs(int|double|vector)

double ceil(double|vector)

double floor(double)

double cosh(double)

double sinh(double)

double tanh(double)

double mod(double|vector,double|vector)
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double pow(double,double)

double rad(double|vector)

double deg(double|vector)

(double|int|vector) max(double|int|vector,double|int|vector)

(double|int|vector) min(double|int|vector,double|int|vector)

double range (double,double,double)

double selector(double,double,double,double)

double step(double,double,double)

double round(double,int)

double frac(double)

double fac(double)

double cot(double)

double sec(double)

double csc(double)

vector cross3d(vector,vector)

double dot3d(vector,vector)

double cross2d(double,double,double,double)

double dot2d(double,double,double,double)

vector normalize(vector)

vector center(vector,vector)

vector extent(vector,vector)

string parse(string,string)

double number(string)
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vector vector(string)

string string(double + int + string + vector)

int integer(double|string)

string strleft(string,int)

string strright(string,int)

string strsub(string,int,int)

string strupper(string)

string strlower(string)

double randu([double|int])

string hex(int[,int[,int|"true"]])

string octal(int[,int[,int|"true"]])

double angle(vector,vector,int)

Common Object Methods and Data (all objects respond)

vector pos(double)

vector position(double)

vector rot(double)

vector rotation(double)

vector right(double)

vector up(double)

vector forward(double)

vector pivot(double)

vector wpos(double)

vector wposition(double)
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vector wright(double)

vector wup(double)

vector wforward(double)

vector limits.pos.min

vector limits.pos.max

vector limits.position.min

vector limits.position.max

vector limits.rot.min

vector limits.rot.max

vector limits.rotation.min

vector limits.rotation.max

vector limits.right.min

vector limits.right.max

vector limits.up.min

vector limits.up.max

vector limits.forward.min

vector limits.forward.max

vector limits.pivot.min

vector limits.pivot.max

vector limits.wpos.min

vector limits.wpos.max

vector limits.wposition.min

vector limits.wposition.max



LightWave 2020  –  LightWave 2020

Reference –  3035

vector limits.wright.min

vector limits.wright.max

vector limits.wup.min

vector limits.wup.max

vector limits.wforward.min

vector limits.wforward.max

Mesh Object Methods and Data

double dissolve(double)

int points

int polygons

Light Object Methods and Data

vector color(double)

int points

int polygons

double coneangle.rad

double coneangle.radius

double coneangle.edge

Camera Object Methods and Data

double zoom(double)

double zoomfactor(double)
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double focallength(double)

double focaldistance(double)

double fstop(double)

double blurlength(double)

double fovhor(double)

double fovhorizontal(double)

double fovver(double)

double fovvertical(double)

Scene Object Methods and Data

int points

int polygons

int renderstart

int renderend

int renderstep

double fps

int width

int renderwidth

int height

int renderheight

double aspect

double pixelaspect

double aspectratio

int minspp
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int maxspp

int recursion

int maxrecurse

int recursedepth

int usingTraceShadows

int usingTraceReflection

int usingTraceRefraction

int usingFields

int usingEvenFields

int usingMotionBlur

int usingDOF

int usingLR

int usingLimitedRegion

int lr.x1

int lr.left

int lr.x2

int lr.right

int lr.y1

int lr.top

int lr.y2

int lr.bottom

int limitedregion.x1

int limitedregion.left
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int limitedregion.x2

int limitedregion.right

int limitedregion.y1

int limitedregion.top

int limitedregion.y2

int limitedregion.bottom

Selector/Converter items

double x (selects the first element of a multiple-data type)

double y (selects the second element of a multiple-data type)

double z (selects the third element of a multiple-data type)

int r (selects the first element of a multiple-data type)

int g (selects the first element of a multiple-data type)

int b (selects the first element of a multiple-data type)

vector rbg (converts a vector data into color-normalized data)

string asStr (converts int,double,vector to string)

string asString

int asInt (converts string,double to integer)

int asInteger
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double asNum (converts string,int to double)

double asNumber

vector asVec (converts int,double,string to vector)

vector asVector

A vector is a group of related values. They could relate to position (x,y,z), rotation (h,p,b), color (r,g,b), etc. To 
get only one component, use a selector as demonstrated below.



Expressions react to interactively moved items, even if Auto Key is turned off.

You may use XS, YS, and ZS as aliases for Scale.X, Scale.Y, and Scale.Z.
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Glossary

Introduction
In no time, you’ll find yourself mastering LightWave’s intuitive interface. LightWave uses very few graphical icons. 
Instead, most functions are listed on the interface panels in plain text. Listed below are a few other conventions 
involved with the LightWave interface:


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Throughout

LightWave Panels and Dialogs
LightWave’s panels and requesters are generally non-modal and can be left open even while you interact, say, with the 
Layout window and its controls.

Math in Input Fields
Numeric input fields support basic math operations (+, -, *, /, and ^) and algebraic equations. You can even mix units. 
Here is an example: (12ft+14m)^2+(3/5). The result, 312.3908 m, would appear after you press the Enter key. Note that 
the result is shown using the default unit; here, it is meters. Also, since we didn’t specify the unit of measure for the 3 
and 5, the default is used.

Enter/Tab Keys with Input Fields
When you enter values into dialogs that have multiple input fields, the Tab and Enter keys have special functions to 
save you time. Pressing the Tab key stores the entered/current value and automatically advances you to the next input 
field. Shift + Tab moves to the previous field. The Enter key also stores value, dismisses the dialog, if appropriate.

Yes and No
Whenever a requester asks you a Yes or No question, pressing the Enter key is the same as selecting Yes, while pressing 
the Esc key is the same as selecting No. Likewise, an Error, Warning, or Reminder requester with a choice of Continue or 
Cancel can use Esc for Cancel and Enter for Continue. For those requesters with only a Continue, pressing either Esc or 
Enter will close the panel.

Mini-Sliders
The mini-sliders to the right of numeric entry fields have particular properties. If a field is for a percentage percent steps 
are made in half-percent increments. For a field in Degrees, angles are in half-degrees, and the scalar and distance 
modes use a sliding scale so that as the value gets larger, so does the step size.

There is a soft-limit on the numerical edit fields when in Percent mode. When the number is in the range of 0%-100%, 
the mini-slider will stay within that range. Manually entering a number outside that range (if a hard limit has not been 
set) will allow the mini-slider to slide outside the 0%-100% range.

Shift-Clicking
Holding down the Shift key and clicking the left mouse button (LMB) on an E, or T icon in LightWave's user interface 
removes an Envelope or Texture, respectively.
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Menu Navigation
LightWave's internal menus can be filtered, navigated rapidly and scrolled up and down. Filtering works as soon as you 
start typing and is based on the localized name. To remove filtering without clicking away from the menu, you can use 
Backspace.

This scene has almost 2,000 objects, but typing narrows that down

The Additional menu always has a large number of entries. Scrolling through them is easier than having to go to the base of 
the menu to initiate a scroll

Keyboard Navigation/Selection
The keyboard shortcuts for navigation and selection are as follows:
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Home - Goes to the top
End - Goes to the bottom
Page Up - Goes one page up (towards the top of the menu)
Page Down - Goes down one page (towards the bottom of the menu)
Up/Down Arrow keys - Change the selection (highlighted entry)
Right Arrow key - Opens the submenu if the current entry has one
Left Arrow key - Closes the active submenu
Enter/Return key - Accepts the highlighted entry

If you have deep hierarchies then sometimes there isn't the room onscreen to fit the item names. Hitting Shift-
Left or Shift-Right will navigate inside such hierarchies


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Regular expressions can also be used to filter menus. Start typing and hit TAB to switch into and out of regexp 
mode. (Go here for a tutorial on how to get started with regex)

As an example, to find all the numbered spoons in the Ratatouille kitchen scene with 2,000 objects, open the 
objects list, type . and hit tab (and you'll see (.*) instead of the magnifying glass indicating you are in regexp 
mode). Now you are in Regep mode, you can type spoons\d to find just the objects containing the word 
"spoons" followed by a number.



https://en.wikipedia.org/wiki/Regular_expression
https://regex101.com/
https://en.wikipedia.org/wiki/Regular_expression
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Flat Menu
You can now call up a flattened version of every entry that exists in the main menu with the keyboard shortcut CTRL 
Space. Doing so presents a list of all available commands in Layout or Modeler (with their associated keyboard 
shortcuts). As with other LightWave menus, you can type to narrow down your selection and the cursor keys and Enter 
can be used to choose the command you require.

Node Editors

Edit Nodes buttons in panels are accompanied by a check to activate nodal options and a clipboard icon that allows 
copying and pasting of node flows between node editors.

Dragging and Dropping
Many files can be loaded simply by dragging and dropping them onto LightWave's interface, including scene files, 
objects, images, and animations.

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.


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Color Selection
Where you must select a certain color (e.g., surface color), there will be a three-number color component display and a 
color swatch box. You can also drag your mouse on each color component to change its value. By default, the standard 
RGB color space is displayed; however, if you right-click on the display, you may also use the Hue, Saturation, and Value 
(HSV) color space, if that is more familiar to you. HSV is based on the artist’s concepts of tint, shade, and tone. There are 
over 16.7 million possible color combinations.

 

Left: RGB, Right: HSV
Unlike RGB, HSV color components are not independent. For example, if Value is 0 (i.e., brightness is 0), you will not be 
able to change Hue (color) nor Saturation. Similarly, if Saturation is 0, you will not be able to change Hue. Moreover, 
reducing one component may cause another component to decrease.
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Color Picker

LightWave’s default color picker has been renewed and given powerful new features. The color picker’s features are 
fully explained in the Surface and Render guide - Color Picker.

Colors can be copied and pasted by clicking Ctrl RMB on the swatch, then Alt-clicking RMB on the target 
swatch. (On the Mac, use Option for Alt)

Ctrl right-clicking on the blue swatch, then Alt right-clicking on the green replaces 
it with blue.


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Standard List Windows
Windows that contain lists of items (surfaces, scene items, menu items, etc.) all have a slider bar to scroll through the 
list. If the list is hierarchical in nature, there will be arrowheads to the left of item names. If the arrowhead is facing to 
the right, then they are subordinate items to this parent item. Clicking the arrowhead will make it point downwards and 
also reveal the subordinate items.

Clicking the arrowhead expands and contracts hierarchies
If selection is appropriate, you can click on an item to select it. Ctrl + click will select non-contiguous items, and Shift + 
Click will select a range of items.

List windows that are hierarchical in nature can be reorganized by dragging items around in the list. Where appropriate, 
multiple selection is supported.

Reorganizing Lists
In some list windows (e.g., menu configuration), you can reorganize entries by just dragging them in the window. Place 
your pointer over the entry and drag it up or down. You will see a thin line appear as you drag. This is the insert point. 
Releasing the mouse button will drop the entry here.

Now, if your pointer is at a position where the dropped item could be, say, a sub-item of an entry, the same level as the 
entry, or even the same level as the next entry, the length of the line would change as you drag. The position of the left 
end of the line determines the level of the drop.

Finding Assignments and Commands
If you have a command selected in the left window and click Find, the command, if any, on the right will become 
selected. Selecting a command in the right window and clicking Find will select the matching command in the left 
window.
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Since a command can be assigned to more than one menu location, successive Find clicks will show the next 
assignment, if more than one exists.

Clicking Search allows you to type in a search phrase to find a command. Note that this will only find the first instance, 
and it is case-sensitive.

If you know the keyboard shortcut, but want to find the corresponding menu location, use the Find function on the 
Configure Keys Panel to determine the command name. Then, use the Find function on the Configure Menus Panel to 
see where it is assigned.

Deleting Menu Items
To delete a command/group, select it, and click the Delete button.

Window Pop-up
The Window pop-up menu lets you select different menus to edit (e.g., Graph Editor), if available.

Maintaining Menu Sets
The Load and Save buttons let you retrieve and store menu sets that you develop. To restore the default menu 
configuration, choose Default from the Presets pop-up menu. If you’d like to have a menu set for Layout similar to 
previous versions, these are also available, but tools newer than the version chosen will not be available in the menus. 
In Modeler’s Configure Menus tool you have similar options.

Arranging Menu Tabs
You can reorganize the main menu tabs by simply dragging them left or right on the main interface. Before you release 
the mouse button you will see an insertion point marker appear.

Keyboard Shortcuts
In the LightWave user interface, keyboard shortcuts are displayed on the right side of buttons, if applicable. Keystrokes 
that need the Shift key are displayed in uppercase if they are letters. (e.g., +A) Unshifted keystrokes are displayed in 
lowercase. (e.g., a) For example, +M is Shift + M and & would be Shift + 7 on a US keyboard.

If a keyboard shortcut needs a modifier it is presented in the interface by one of three symbols:

^ = Ctrl
+ = Shift
* = Alt

This manual, however, always explicitly indicates when the Shift key should be used, and upper case will always be 
used for shortcut letters.

You need to be aware of the state of your Caps Lock. If this is active, it can affect upper and lowercase 
keyboard shortcuts.


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Panel-Specific Shortcuts
Some panels have special keyboard shortcuts. To use them, you must have that panel active. (Click on it if it isn’t 
already active.) If the panel is not active and that shortcut has another meaning for LightWave in general, the general 
function will run. Moreover, if the panel is active, but doesn’t use the keyboard shortcut, it will be passed to the main 
interface.

Context Pop-up Menus
Both Layout and Modeler have special "context" pop-up menus that you display by holding Ctrl + Shift and clicking your 
LMB, MMB, or RMB with your mouse pointer over a viewport - there are different menus for each mouse button. This 
keyboard shortcut is hardcoded.

Left Mouse Button Menu
This menu contains commands for Loading and basic creation tools.

Middle Mouse Button Menu
In Layout, the MMB menu is used for character rigging and animation. In Modeler, the context menu for the middle 
mouse button exactly mirrors the group structure for commands, as found in the menu and key editing dialogs - 
including any plug-in commands added to the system. If you know where a command is located in the master 
groupings, you can find it in the middle button menu.

Right Mouse Button Menu
Contains settings tools and utility windows. For example, the Layout RMB menu contains commands to launch the 
Scene / Dope Editor, Graph Editor, and Preferences windows.

Glossary

You can type in any of these context menus to find the command you need
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Glossary

Glossary
Button - A button refers to an area on the screen that you click on with your mouse to cause some function to occur. 
Generally, only a single click is required. There are also special types of buttons, like toggle, pop-up menu, and envelope 
buttons. Some buttons become highlighted, indicating a chosen or active status.

Contextual Pop-ups - This refers to context-sensitive pop-up menus. Such menus appear when you Shift + Ctrl +LMB
and are aware of the area the mouse pointer is over.

Dialog - See Requester

Drag Button - A drag button is similar in effect to a slider, except the button does not move. To use, just click on it and 
hold the mouse button, then drag the mouse. Depending on the parameter being adjusted, the direction and mouse 
button used will have different specific effects.

Envelope Button - An Envelope button is a small button marked with an E. Selecting this button will display the Graph 
Editor where you can create an envelope for the setting. A highlighted envelope button indicates a value has an 
envelope applied. To turn off (i.e., remove) an envelope, hold the Shift key and click on the Envelope button.

Ghosted Item - LightWave will ghost out parameters that are not available to you. This is usually the result of a certain 
option not being activated. Selecting a ghosted item will display a message informing you why it cannot be used.

Information Field/Display - Information Fields/Displays are text displays found throughout the different panels. These 
displays cannot be changed directly and simply provide information and feedback.

Input Field - Input fields are areas on the screen where you can enter data.

Mini-Slider - A mini-slider is a button with two arrows on it, pointing right and left. Clicking on one and holding the LMB, 
then dragging to the right or left will raise or lower the value of the parameter next to it. In many cases, however, the 
slider does not encompass the entire spectrum of possible values.

Panels - Panels are any one of the windows that open when you click on a button in LightWave. Many panels have 
additional tabbed sections that are selected when you click on a tab. Panels may be Modal or Non-modal. A modal 
panel must be closed before you can continue working with the rest of the application. A non-modal panel lets you shift 
the focus between it and another part of the application without having to close the panel - you can continue to work 
elsewhere in the current application while the panel is displayed. Modeler’s Numeric Panel is non-modal because you 
can do other things while it is open. In contrast, Modeler’s Display Options Panel is modal because you must close it 
before you can continue working.

Pop-up Menu - Pop-up menu buttons have a downward facing arrow on their right edge. To use, click on it and hold the 
LMB. The menu will pop up and as you move your pointer over the menu, each item will become highlighted. When the 
desired selection is highlighted, release the LMB. If you decide not to select an item, simply move the pointer off the 
menu and release the LMB. Certain pop-up menus contain lists of objects, images, and lights, which are normally listed 
in the order they were loaded or created.

Requester - A requester is also known as a dialog box. These appear on the screen for operations like file loading and 
saving. This also refers to smaller windows that appear requesting you to input data into various fields.

Reset Area - The reset area is a non-active open area (e.g., not a button) on the Modeler toolbar that acts as a reset 
button, much like you might use the ESC key on other applications.
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Scrollbar - See Slider

Shaded Display - See Solid-Shaded Display.

Slider - A slider allows you to modify a setting by dragging the slider’s button along the bar. Alternatively, you can click 
to the right or left of the button or use the arrow buttons at either end to incrementally change the setting value. (Also 
known as a scrollbar.)

Solid Shaded Display - Solid shaded display refers to a non-wireframe display mode where some level of surface texture 
detail is visible.

Texture Button - A Texture button is a small button marked with a T. Selecting this button will present a texture panel 
allowing you to define a texture for the chosen parameter. A highlighted texture button indicates a texture in use for the 
given parameter. To turn off (i.e., remove) a texture, hold the Shift key and click on the Texture button.

Toggle Button - A Toggle button is a small button that becomes highlighted with a check mark when clicked. This 
indicates the adjacent feature is active.
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Default Keyboard shortcuts
Here is a list of default keyboard shortcuts in Layout and Modeler.

If a keyboard shortcut needs a modifier, it is presented in the graphical user interface by one of three symbols:

^ = Ctrl,
+ = Shift,
* = Alt

Here we will use the standard notation:

Click here to expand Alphabet section...

Shortcut Layout Modeler

CTRL-A Select All Objects Fit All Items in One View

CTRL-B IK_BoostTool Chamfer

CTRL-C Clone Current Item CopyEdges

CTRL-D Sliders Freez Curves & Patches

CTRL-E FX_Tool Measure Tool

CTRL-F Lens Flare Options Make Spline Patch

CTRL-G Move TCB Tool Selection Mode: Point

(BS) CTRL-H Light Intensity Tool Selection Mode: Polygon

CTRL-J (Bone) Joint Move Selection Mode: Volume

CTRL-K (Bone) Twist Spin Quad Pairs

CTRL-L Limited Region On/Off Split Polygons

CTRL-N Add Null End Control Point On/Off

CTRL-O Load Scene Load Object

CTRL-P Render Properties Make Open Curve

CTRL-Q Master Plugins Zoom Tool
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CTRL-R Bone Activation On/Off Rail Extrude

CTRL-S Save Scene As Save Object As

CTRL-T (Bone) Tip Move Drag Tool

CTRL-U (Bone) Unparent Unweld Points

CTRL-V PasteNew

CTRL-W (Bone) Mirror Hierarchy Weld 2.0

CTRL-X FX_Start Cut

CTRL-Y PathTool Array

CTRL-Z Undo Undo

Shift-A Fit Selected Items in View Fit Selected Items in Views

Shift-B Edit Mode: Bones Boolean CSG

Shift-C Edit Mode: Cameras Solid Drill

Shift-D (Bone) Exit Setup Subdivide Polygons

Shift-E (Bone) Enter Setup Extrude Tool

Shift-F Enable Lens Flares On/Off Smooth Shift

Shift-G Snap Drag Tool

Shift-H Size Tool Size Tool

Shift-I (Bone) Import Hierarchy Unify Polygons

Shift-J (Bone) Export Hierarchy Jitter

Shift-K Knife Tool

Shift-L Edit Mode: Lights Lathe Tool

Shift-M Smooth

Shift-N Clear Scene New Object
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Shift-O Edit Mode: Objects Ball Tool

Shift-P (Bone) Record Pivot Position Motion Path Extrude

Shift-Q Quit Quit

Shift-R Bone Rest Length Tool Template Drill

Shift-S Incremental Scene Save Incremental Object Saver

Shift-T Convert Polygons to Triangles

Shift-U Cut

Shift-V Mirror Mirror Tool

Shift-W Text Tool

Shift-X Box Tool

Shift-Y Symmetry On/Off

Shift-Z Merge Polygons

a Fit All Items in View Fit All Items in All Views

b Bevel

c Clone

d Display Options Display Options

e
Parent

Extender Plus

f Go to Frame Flip Polygons

g Center View on Mouse Pointer Center View on Mouse Pointer

h Stretch Tool Stretch Tool

i Selection Info Open/Close

j Jump Points

k Remove Polygons
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l Adjust Limited Region Tool Connect

m Motion Options Merge Points

n Numeric Input Numeric Options Open/Close

o General Options General Options

p Properties Open/Close Make Polygon

q Change Surface

r Record Bone Rest Position Rotate 90 Right

s Save Scene Save Object

t Move Tool Move Tool

u Smoothing Info Open/Close

v Set Value

w Scene Statistics Statistics Open/Close

x

y Rotate Tool Rotate Tool

z Redo Redo

Alt-A

Alt-B

Alt-C Clone Instance

Alt-D

Alt-E

Alt-F

Alt-G

Alt-H
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Alt-I

Alt-J

Alt-K

Alt-L

Alt-M

Alt-N Rename Current Item

Alt-O

Alt-P Global Illumination Options

Alt-Q

Alt-R

Alt-S Save All

Alt-T Transform

Alt-U

Alt-V Paste

Alt-W

Alt-X

Alt-Y

Alt-Z

Shift-Alt-A

Shift-Alt-B

Shift-Alt-C

Shift-Alt-D

Shift-Alt-E
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Shift-Alt-F

Shift-Alt-G

Shift-Alt-H

Shift-Alt-I

Shift-Alt-J

Shift-Alt-K

Shift-Alt-L

Shift-Alt-M

Shift-Alt-N

Shift-Alt-O

Shift-Alt-P

Shift-Alt-Q

Shift-Alt-R

Shift-Alt-S

Shift-Alt-T

Shift-Alt-U

Shift-Alt-V

Shift-Alt-W

Shift-Alt-X

Shift-Alt-Y

Shift-Alt-Z

Shift-Ctrl-A

Shift-Ctrl-B
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Shift-Ctrl-C Clone Hierarchy

Shift-Ctrl-D

Shift-Ctrl-E

Shift-Ctrl-F

Shift-Ctrl-G

Shift-Ctrl-H

Shift-Ctrl-I

Shift-Ctrl-J

Shift-Ctrl-K

Shift-Ctrl-L

Shift-Ctrl-M

Shift-Ctrl-N

Shift-Ctrl-O

Shift-Ctrl-P

Shift-Ctrl-Q

Shift-Ctrl-R

Shift-Ctrl-S

Shift-Ctrl-T

Shift-Ctrl-U

Shift-Ctrl-V

Shift-Ctrl-W Weld Average 2.0

Shift-Ctrl-X

Shift-Ctrl-Y
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Shift-Ctrl-Z

Click here to expand Function keys section...

Shortcut Layout Modeler

F1 Help Help

F2 Motion Mixer Center All

F3 Previous Viewport Layout Rest on Ground

F4 Next Viewport Layout Rotate to Ground

F5 Surface Editor Open/Close Surface Editor Open/Close

F6 Image Editor Open/Close Image Editor Open/Close

F7 Layer Browser Open/Close

F8 Presets Open/Close Vertex Maps Open/Close

F9 Render Current Frame Preset Shelf Open/Close

F10 Render Scene Edit Font List

F11 Render Selected Objects Add Plugins

F12 Switch to Modeler Switch to Layout

Shift-F1 Auto Key On/Off Set Viewport: Back/Front

Shift-F2 X Axis/Heading Angle On/Off Set Viewport: Top/Bottom

Shift-F3 Y Axis/Pitch Angle On/Off Set Viewport: Right/Left

Shift-F4 Z Axis/Bank Angle On/Off Set Viewport: Perspective/UV

Shift-F5 Coordinate System: World Action Center: Mouse

Shift-F6 Coordinate System: Parent Action Center: Origin

Shift-F7 Coordinate System: Local Action Center: Pivot

Shift-F8 Enable Inverse Kinematics On/Off Action Center: Selection
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Shift-F9 Motion Blur/Depth of Field Preview On/
Off

Guess Viewport UV Image

Shift-F10

Shift-F11

Shift-F12

Ctrl-F1 Open Scene Editor

Ctrl-F2 Graph Editor Open/Close

Ctrl-F3

Ctrl-F4

Ctrl-F5 Backdrop Options

Ctrl-F6 Volumetrics and Fog Options

Ctrl-F7 Compositing Options

Ctrl-F8 Image Processing

Ctrl-F9 View Port Toggle VPR

Ctrl-F10 Toggle Shader

Ctrl-F11

Ctrl-F12

Alt-F1 Hide Floating Windows On/Off

Alt-F2 Hide Toolbar On/Off Hide Toolbar On/Off

Alt-F3 Show SubPatch Cages On/Off

Alt-F4 Show Motion Paths On/Off

Alt-F5 Show Handles On/Off

Alt-F6 Show IK Chains On/Off

Alt-F7 Show Safe Areas On/Off
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Alt-F8 Show Field Chart On/Off

Alt-F9 Edit Keyboard Shortcuts Edit Keyboard Shortcuts

Alt-F10 Edit Menu Layout Edit Menu Layout

Alt-F11 Edit Plugins Edit Plugins

Alt-F12 Set Content Directory

Ctrl-Alt-F1

Ctrl-Alt-F2

Ctrl-Alt-F3

Ctrl-Alt-F4

Ctrl-Alt-F5

Ctrl-Alt-F6

Ctrl-Alt-F7

Ctrl-Alt-F8

Ctrl-Alt-F9

Ctrl-Alt-F10

Ctrl-Alt-F11

Ctrl-Alt-F12

Click here to expand Numbers section...

Shortcut Layout Modeler*

0 Single View On/Off Single Viewport On/Off

1 Toggle View: Back/Front Layer 1

2 Toggle View: Top/Bottom Layer 2

3 Toggle View: Right/Left Layer 3
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4 Toggle View: Perspective/Camera Layer 4

5 View Mode: Light Layer 5

6 View Mode: Camera Layer 6

7 View Mode: Schematic Layer 7

8 Layer 8

9 Layer 9

* Modeler number key shortcuts here apply to the alphanumeric keys above the letters on the keyboard. You can 
also use them with the modifier Shift to select additional layers or Alt to select background layers 
(Alt+Shift+number will select additional background layers). The number pad number keys have a different 
function explained here.

Click here to expand Punctuation keys section...

Shortcut Layout Modeler

Tab Hide Floating Windows On/Off ToggleFaces/SubPatches

Escape

Space Change Tool Change Selection Mode

Ctrl-Space Flat Menu Popup Flat Menu Popup

Shift-Space

!

" Invert Selection

#

$

%

&

' Select Item by Name Swap Front and Back Layers

(
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)

*

+ Load Object Point Tool

, Zoom Out Zoom Out

- Clear Selected Items Hide Selected

. Zoom In Zoom In

/ Camera Zoom Tool Drop/Restore Selection

: Magnet Tool

; Drag Network Tool

< Zoom Out x2 Zoom Out x2

= Add Child Bone Hide Unselected

> Zoom In x2 Zoom In x2

? Invert Connected

@

[ Decrease Grid Size Shear Tool

\ Unhide All (Make Visible)

] Increase Grid Size Select Connected

^

_ Clear Map From Vertices

` Sketch Tool

{ Record Minimum Joint Angles Contract Selection

| Invert Hidden

} Record Maximum Joint Angles Expand Selection



LightWave 2020  –  LightWave 2020

User Interface Conventions –  3065

~ Bend Tool

Delete Delete Key Remove

Insert Pause Insert Layer

Home First Frame Delete Layer

End Last Frame ObjectCollapser

Page Up Play Forward Prev Layer

Page Down Play Back Next Layer

Click here to expand Cursor section...

Shortcut Layout Modeler

Left Go to Previous Frame

Right Go to Next Frame Select Loop

Up Select Previous Item Prev Loop

Down Select Next Item Next Loop

Shift-Left Go to Previous Key Scroll Left

Shift-Right Go to Next Key Scroll Right

Shift-Up Select First Item Scroll Up

Shift-Down Select Last Item ScrollDown

Ctrl-Left

Ctrl-Right Ring

Ctrl-Up Select Previous Sibling

Ctrl-Down Select Next Sibling

Alt-Left Go to First Frame Nudge Left

Alt-Right Go to Last Frame Nudge Right
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Alt-Up Nudge Up

Alt-Down Nudge Down

Ctrl-Alt-Left

Ctrl-Alt-Right

Ctrl-Alt-Up

Ctrl-Alt-Down

You can edit these shortcuts here.
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Appendices
Sections you won't normally need to trawl through, but are here for completion or for use inside other pages.

Customizing LightWave
Examples
LightWave 3D Resources
Common
User-created Tutorials
LightWave History
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Customizing LightWave
Click here to expand Table of Contents...

Clearing Configs
Windows
Macintosh

Config Backup
Edit Keyboard Shortcuts

To assign a command to a key
To unassign a command to a key
Finding Assignments and Commands
Maintaining Key Mapping Sets

Edit Menu Layout
Finding Assignments and Commands
Menu Branches
Maintaining Menu Layouts

Edit Plugins Command
To delete a plugin command
File Grouping Method

Window Config Loader
Scene Metadata
Interface Color Customization
Configuration Files
Startup Options

-c for Configs
-d for Content
-p for Plugins
-0 for Command IPC
-i for Isolate
--frame-end-beep
--anim-end-beep
--preview-end-beep
-f for Font
--command-port
--dpiaware
-r

HiDPI
Layout Startup Command
Default Scene at Start
Customizing Layout Viewport Navigation
Customizing Camera Presets
Customizing Image Savers for Output


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Clearing Configs
If you are required to clear configs for any reason, the way to do it is to make sure LightWave is closed, including the 
Hub application (in your Windows taskbar or Macintosh dock). Then, navigate to:

Windows

<user>\.NewTek\LightWave\2019.0

and delete

Extension Cache-64
LW2019.0.3-64.CFG
LWEXT2019.0.3-64.CFG
LWHUB2019.0.3-64.CFG
LWM2019.0.3-64.CFG

Macintosh

 ~/Library/Application Support/NewTek/LightWave/2019.0/

and delete

Extension Cache
Extensions 2019.0.3
Hub 2019.0.3
Layout 2019.0.3
Modeler 2019.0.3

now when you launch anew, you can be sure everything in LightWave will be factory fresh.

Config Backup
When configs are changed now, a backup is created of existing settings before changes are enabled.

Edit Keyboard Shortcuts
(default keyboard shortcut Alt F9)

There may be plugin configs and color picker configs still to clear. If you wish to remove all traces completely, 
delete the 2019.0 folder but be warned you will have to license your LightWave again (you can retrieve your 
license key from your account at http://lightwave3d.com).



We strongly suggest that you keep the default keyboard mapping assignments and make new shortcuts only 
to unmapped keys. (Most of the function keys are open.) Otherwise, technical support and using the 
documentation may become difficult.



http://lightwave3d.com
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2.

3.

1.
2.

Like the menus, keyboard shortcuts can be configured to suit your needs. To display the Configure Keys Panel, choose 
Edit > Edit Keyboard Shortcuts.

 
The window on the left contains a complete list of all assignable commands grouped by type. The right window shows the 
full list of all keystrokes and assigned commands, if applicable.

To assign a command to a key

Select a command in the left window.
Choose the target key in the right window. (You can hit the desired key or keystroke combo to select the key 
quickly.)
Clicking the Assign button will overwrite any existing assignment. Alternatively, you may drag the command to 
the right window.

To unassign a command to a key

Select the target key in the right window.
Click the Unassign button.
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Finding Assignments and Commands

If you have a command selected in the left window and click Find, the command, if any, on the right will become 
selected. Choosing a command in the right window and clicking Find will select the matching command in the left 
window.

Clicking Search allows you to type in a search phrase to find a command. Search is case-sensitive and will find the first 
instance when first run, and can be used iteratively to find additional instances by just hitting the button again, as it 
retains the string until you type in a new one.

Maintaining Key Mapping Sets

The Load and Save buttons let you retrieve and store key mapping sets that you develop. The Clear button clears out all 
assignments, so use with caution. Any available preset key mapping sets can be chosen from the Presets pop-up menu. 
The Window pop-up menu lets you select different menus to edit (e.g., Graph Editor), if available.

Edit Menu Layout
(default keyboard shortcut Alt F10)

LightWave menus are customizable. You can add, remove, group, and reorganize commands. Choose Edit > Edit Menu 
Layout to open the Configure Menus Panel.

Keyboard shortcuts can be assigned to only one command. Assigning a command that is already assigned to a 
different key will assign it to the new key, but remove it from the old one.



We strongly suggest that you keep the default menu organization intact. Otherwise, technical support and 
using the documentation may become involved. A better solution is to create a new menu tab and/or groups 
and place your frequently used tools in them.


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In the (left) Command window, a list of available commands will appear. These will be grouped by type.

In the (right) Menus window, several main sections have sub-items, which are indented to show the hierarchical 
relationships. Top Group contains the items that are always visible no matter which tab is selected. Main Menu items 
are the main tabs and related buttons for the main interface toolbar. Left, Middle, and Right Mouse Button Menu (when 
available) are the menus that appear when the Shift + Ctrl keys are held down along with the corresponding mouse 
button. There may be other menu sections defined.

In the Menus window, dots indicate commands while arrows indicate groups of commands/sub-groups beneath it. If 
the arrow points to the right, the group’s sub-menu items are collapsed and not visible. To reveal the sub-menu items 
for a collapsed group, just click on its right-facing arrow. To collapse an open group, click on its downward-facing 
arrow.

Finding Assignments and Commands

If you have a command selected in the left window and click Find, the command, if any, on the right will become 
selected. Selecting a command in the right window and clicking Find will choose the matching command in the left 
window.
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Clicking Search allows you to type in a search phrase to find a command. Search is case-sensitive and will find the first 
instance when first run, and can be used iteratively to find additional instances by just hitting the button again, as it 
retains the string until you type in a new one.

Menu Branches

Menu branches can be exported and imported allowing for rapid customization of several menu entries. To export a 
menu branch, right-click over the group you wish to export and choose Export Branch.

The file saved can be loaded into a different installation of LightWave using the same method - right-clicking the area in 
which you wish to import a menu branch and choose Import Branch.

New to LightWave 2019 is an additional command Import and Replace Branch.
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Maintaining Menu Layouts

The Load and Save buttons let you retrieve and store menu layouts that you develop. Any available preset menu layouts 
can be chosen from the Presets pop-up menu. The Window pop-up menu lets you select different menus to edit (e.g., 
Graph Editor), if available.

Edit Plugins Command
(default keyboard shortcut Alt F11)

Use the Edit Plugins command to review and delete plugins that have been added. In Modeler, choose Utilities> Plugins 
> Edit Plugins.

To delete a plugin command

You can delete a plugin command by selecting it and clicking the Delete button. (Other commands from the plugin will 
continue to exist.) Click Clear to delete all plugins listed. These operations do not affect the actual files stored on your 
hard drives.

To rename a plugin command: You can rename a plugin command’s name by selecting it, clicking the Rename button 
and entering a new name.

You can also add plugins on this panel. The Add Plugins and Scan Directory buttons operate the same as they 
do for the Add Plugins Panel, discussed earlier.


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File Grouping Method

If desired, you can list the Plugin commands by their .p plugin filenames. Just select the File Grouping Method button at 
the bottom of the Edit Plugins Panel.

Window Config Loader
This command is a quick way to launch a window configuration that was generated by the Window Configure tool.

Scene Metadata
If your pipeline dictates that you need to use a different path structure for use with other applications, it can be 
awkward when you need to bring scenes back into LightWave for further editing, needing to tell LightWave where a 
project's images are for instance because you have them under a different path. You can now save metadata to a scene 
file as comments if your workflow dictates that you vary from the standard LightWave content directory structure of 
Images, Objects, and Scenes.

When saving out a scene file, append the content directory information as comments to the very end of the scene file.

If Use Custom Paths is left unchecked, this should be a single comment like this:

// ContentDir: "X:/project/_library/assets/LW_Content"

If Use Custom Paths is checked in your LightWave options Paths tab, append all of the custom paths as comments to 
the end of the LWS file as well:

// ContentDir: X:/project/_library/assets/LW_Content
// ObjectsDir: X:/project/_library/assets/LW_Content/Objects
// ImagesDir: X:/project/_library/assets/LW_Content/Images

The full list of custom paths is as follows:

ContentDir "X:/project/"
ScenesDir "X:/project/Scenes"
ObjectsDir "X:/project/Objects"
SurfacesDir "X:/project/Surfaces"
ShadersDir "X:/project/Shaders"
ImagesDir "X:/project/Images"
PreviewsDir "X:/project/Previews"
MotionsDir "X:/project/Motions"
EnvelopesDir "X:/project/Envelopes"
AnimationsDir "X:/project/Animations"
NodesDir "X:/project/Nodes"
SoundsDir "X:/project/Sounds"
DynamicsDir "X:/project/Dynamics"
RigsDir "X:/project/Rigs"
LightsDir "X:/project/Lights"
RadiosityDir "X:/project/Radiosity"
ColorTablesDir "X:/project/ColorTables"
ImageCacheDir "X:/project/ImageCache"
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VertCacheDir "X:/project/VertCache"
BackupDir "X:/project/Backup"

Interface Color Customization
Customizing the Interface colors for Modeler and Layout is accessed through the Options panels in both applications - 
the Display tab in Layout and the Display Options Interface tab in Modeler. You will need to restart LightWave to see the 
changes you have made.

Configuration Files
For Macintosh OS X, the LightWave configuration files are stored in your ~/Library/Application Support/NewTek/2019.0
folder like so:

Extension Cache
Extensions 2019
Hub 2019
Layout 2019
Modeler 2019

For Windows 7 and onwards, the configuration files are kept in <USERNAME>\.NewTek\LightWave\2019.0. They are 
named:

Extension Cache-64
LW2019-64.CFG
LWEXT2019-64.CFG
LWHUB2019-64.CFG
LWM2019-64.CFG

Generally, you will not need to edit these files directly; however, you might need to remove these files if they get 
corrupted.

Startup Options
The following options are described for use in Windows. At the end of the list of Startup options, there is an Info box for 
Macintosh OS X.
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Editing a shortcut's target path can add functionality to how LightWave starts up. Here shown, -d for startup content 
assignment

-c for Configs

If you wish to redirect where LightWave stores the configs it creates away from the regular C:
\Users\<username>\.NewTek\LightWave\<version> folder, you can add -c to the end of your shortcut's 
targetline with the path chosen for the configs.

-d for Content

Layout has a -d option for designating a content directory to be used at startup. In Windows, it can be added as a 
startup option by editing the icon properties of the shortcut created for launching Layout and adding -d and the 
directory you wish to use, like so:

In Windows, shortcuts need to be edited for both the Modeler and Layout applications where appropriate for 
flags to take effect.


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-p for Plugins

The -p option is for creating a different location for plugin files - useful for instance when running multiple copies of 
LightWave over a network with a central store of plugins.

-0 for Command IPC

Using the -0 commandline flag will not run the Hub but use an Interprocess communications system. Layout and 
Modeler all notify each other when a mesh file has been saved to disc, and the applications that have that file open and 
have not applied modifications during the session will update from the new version on disc. For example, if both Layout 
and Modeler have “bob.lwo” open, Modeler has some edits applied to it, and Layout saves it transformed, Modeler will 
not automatically update from the disc.

If subsequently the object is saved out from Modeler, that will overwrite the changes made by Layout, and Layout will 
update from the save if no further changes were applied in Layout during the interim.

-i for Isolate

The ‘isolate’ flag (‘-i’) will completely disable all IPC mechanisms (Hub and CommandIPC), leaving the application 
isolated from all other product actions.

--frame-end-beep

Use this flag to play an existing sound file when a frame finishes rendering. The syntax is as follows:

--frame-end-beep={sound_file}

--anim-end-beep

Use this flag to play an existing sound file when a frame sequence finishes rendering. The syntax is as follows:

--anim-end-beep={sound_file}

--preview-end-beep

Use this flag to play an existing sound file when a preview finishes rendering. The syntax is as follows:

--preview-end-beep={sound_file}

Shortcuts should be made for Layout and Modeler, with the same flags applied in both. In all cases, there is no 
space following the flag for the path chosen. The example below is for redirecting configs:

C:\NewTek\LightWave_2019.0\bin\Layout.exe -cF:\Configs


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-f for Font

Use this flag to call a system font as the typeface to use for Layout or Modeler. The syntax is as follows:

-f{font_name@font_size}

Layout displayed with Stencil Std Bold at 10pt; Giddyup Std Regular at 12pt and Georgia at 9pt. The flags used were ...
\bin\Layout.exe -fStencilStd@10; -fgiddyupstd@12 and -fgeorgia@9 - none of these are recommended for an 
ergonomic work environment...

--command-port

The --command-port option enables an operating system-based communication mechanism that allows external 
processes to feed LightWave Command Sequence commands directly into the LightWave application.  This allows real-
time and continuous execution of CS commands within running LightWave programs.

The distributed LightWave product includes a Python package that works with both Python v2 and v3 that allows 
Python programs to utilize this mechanism.

When enabled, the command port number selected is displayed in the LightWave application's titlebar.  (e.g., "--
command-port=45454").

This mechanism does not function with Screamernet.

(the command-port mechanism is somewhat reminiscent of the Amiga AREXX system LightWave used to support.)

--dpiaware

Described below.

Use the filenames for the typefaces you wish to use rather than the display names, but the extension is not 
necessary - Stencil Std Bold should be written as stencilstd (you can leave off the .otf).


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-r

Lastly, a joke entry for bamboozling co-workers. Enter this as an option, and watch your colleague's face as they start 
LightWave...

HiDPI

LightWave 2019 presents a new way of working with LightWave on screens at a resolution great than 1920 x 
1080 here.

Layout Startup Command
If the LW2019-64.CFG configuration file contains a line beginning with “StartupCommand,” Layout will try to execute 
the rest of the line as a command after the main interface is first opened. The command can have arguments and it can 
refer to a generic plug-in or script.

Default Scene at Start
If you'd like Layout to start with the same scene setup every time it's easy to achieve but you need to use a single 
content directory to do so (if you see the "Would you like to change content directory?" message when you load scenes, 
this will probably not work for you out of the box). To create a default scene, simply set up something obviously 
different - change the light color to red.

Now use the Save menu option Save Scene as Default. In Layout Options (O) check Clear Scene To Default and finally 
restart LightWave. Now, when you start Layout, you will see that the default light color is red.

1.
2.

3.
4.

macOS Specifics

For macOS, the procedure for adding command line arguments is more involved. Here is how to make a 
launch shortcut icon using AppleScript:

Open the /Applications/Utility/Script Editor.app application
Choose to create a New Document.
Enter the following text:
do shell script "/Applications/NewTek/LightWave_2019/Layout.app/Contents/macOS/
Layout" 
(command line arguments should be added here, before the quote marks, for instance do shell 
script "/Applications/NewTek/LightWave3D_2019.1.2/Layout.app/Contents/MacOS/
Layout -i" will set the Isolate flag.
In the Script Editor, use the dropdown to save the document as an Application to your Desktop.
Double-click the resulting application icon.

To re-edit the resulting application, drag it to the dock "Script Editor" icon.


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To check this is working correctly, try loading a different scene. If you get a window like this:

You will need to do more work. Your LightWave content is almost certainly arranged like so:

Content:

   Project 1

        Objects

        Images

        Scenes

   Project 2

        Objects

        Images

        Scenes

etc.

For the default scene to work reliably, you have two choices. The first is for your content to structure to look like this:

Content:

    Objects

        Project 1

        Project 2

    Images

        Project 1

        Project 2

    Scenes

        Project 1

        Project 2

This is the same kind of organization (global) as the stock LightWave content if you have a look. Both this and the 
project-based way of managing content present their own problems - the first creates lots of file duplication, the second 
is difficult to separate out for sending to the farm, etc.

The second choice, if you want to keep the benefit of a default scene but are committed to the project-based content 
route, is to simply create a template content directory structure that you can always use, including a scene with your 
preferred settings. Copy this into place at the start of a project.
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Customizing Layout Viewport Navigation
The mouse directions used for viewport navigation can be customized by editing the WorldNavigation entry in the 
LW2019-64.CFG configuration file. It has four boolean values that correspond to panning via icon and Alt key, and 
rotation via icon and Alt key. Zero values mean that the viewpoint moves in the same direction as the mouse, and ones 
mean that the world appears to move with the mouse. For example, the default in LightWave 9 is 0 1 0 1. The old 5.6 
setting would be 1 1 0 0. See also Navigation Options.

Customizing Camera Presets
The camera resolution presets are stored in the LW2019-64.CFG configuration file using the keyword 
“ResolutionPreset.” Each preset includes a width and height, pixel aspect ratio, mask settings (left, top, width, and 
height), and a name that will appear in the pop-up menu. They can be modified, deleted, or added to. If no presets are 
found in the file, the original list is restored. See the configuration file for examples.

Customizing Image Savers for Output
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•
•

Full image saver list reduced by removing plugins (Alias.p, Aura_Exporter.p, BMP.p, CineonFP.p, DPX.p, DRLA.p, IFF.p, PCX.p, 
PICT.p, RLA.p, SUN.p, TGA.p, VPB.p and YUV.p plugins removed for this example)

The standard LightWave Image Saver list in the Output tab is long but can be reduced if certain file types are sure not to 
be needed. The plugins for this list can be found in the following locations, depending on operating system:

Windows: LightWave_2019.0\support\plugins\input-output
OSX: /Applications/NewTek/LightWave3D_2019.0/support/plugins/input-output

1.

2.

3.

There are caveats with doing this:

A backup of the plugins should be kept. Perhaps the easiest solution is to add the unwanted filetypes to 
the legacy.zip in the plugins directory;
While this reduces the Output list it also cancels the ability for LightWave to handle removed filetypes 
for loading;
Doing this might cause problems with some distributed rendering plugins.


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Edit Plugins

Edit Plugins Command

(default keyboard shortcut Alt F11)

Use the Edit Plugins command to review and delete plugins that have been added. In Modeler, choose Utilities> Plugins 
> Edit Plugins.

To delete a plugin command

You can delete a plugin command by selecting it and clicking the Delete button. (Other commands from the plugin will 
continue to exist.) Click Clear to delete all plugins listed. These operations have no effect on the actual files stored on 
your hard drives.

To rename a plugin command:You can rename a plugin command’s name by selecting it, clicking the Rename button 
and entering a new name.

File Grouping Method

If desired, you can list the Plugin commands by their .p plugin filenames. Just select the File Grouping Method button at 
the bottom of the Edit Plugins Panel.

You can also add plugins on this panel. The Add Plugins and Scan Directory buttons operate the same as they 
do for the Add Plugins Panel, discussed earlier.


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It's a good idea to keep all third-party plugins separate from the NewTek-provided ones. Make a folder in your 
LightWave Support folder called 3rdParty or similar, and use that for any plugins you add to LightWave from 
third-party providers. Doing this has two benefits. 1) In case of problems, you can narrow down issues by 
moving the whole folder out of the directory structure and rescanning for plugins. 2) Updating to a new version 
is made easier by having all the third-party plugins in one place - most of the time, if you have this folder at a 
level above individual LightWave installations you won't even need to move the folder.


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Localization
Introduction
Localizing
Switching locales
Advanced

Character Literals
Debugging

Introduction

Since LightWave 2015, LightWave has had a localization system built in. For now, there are certain languages defined:

(system defined)
German
US English
British English
Spanish
French
Italian
Japanese
Korean
Russian
Spanish
Swedish
Chinese (simplified)

By default, LightWave runs in US English because LightWave is American. You can choose (system defined) if you want 
to use the language your OS is set to. Very few of the provided languages have any content and adding a new language 
to the system requires us to enter it. Otherwise, if you'd like to create a version of one of these languages for yourself 
you are more than welcome - perhaps you might like to share it!

Localizing

To start a new localization, you need to know how the system works. In the LightWave support directory there is a 
folder named "l10n". It contains folders for all the mentioned language and over 200 .resource files. These files contain 
the text displayed in the LightWave interface. To create a localization, copy the resource files you want to change into 
the language folder of your choice and edit them.

As an example, in the l10n install directory you will find partial translations for the LightWave Color Picker into German, 
British English, French, Italian, Russian, Spanish and Swedish.
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1.
2.
3.

Switching locales

We've told you how to create new localizations for LightWave, but not how to access them. The answer is in the Hub. 
Normally, it is started with LightWave, but if you don't run the Hub, the way to change language is thus:

Quit LightWave;
Run Hub on its own, change language, quit Hub;
Run LightWave (in no Hub or Isolation mode)

Open Hub. Open Options and click on Language to choose the language you wish to use. Restart LightWave for changes 
to take effect.

Once done, the areas that have been localized will be available in the language you have chosen. Anything that hasn't 
been localized will still be in the default US English.
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•
•
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•
•
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•
•
•
•
•
•

Advanced

Character Literals

A character literal is a combination of ASCII bytes that result in zero or more raw data bytes.  Literals are used to specify 
these data bytes when such bytes can not used when represented in other ways.  For example, a newline character may 
be interpreted as the end of the data when the true intent was to place the newline character into the data.  Placing a 
non-printable character into the data may only be possible with a literal.

Character literals for resource tags use a mechanism many are already familiar with: escape sequences.  Although only 
a subset is supported, it should fill most translators' needs.

\0 : null byte
\a : alert byte
\b : backspace
\f : form feed
\n : line feed (newline in OSX/Linux)
\r : carriage return
\t : horizontal tab
\v : vertical tab
\" : double quote
\& : no byte
\\ : backslash
\xhh : 8-bit data where each h is a hex digit
\ooo : 8-bit data where each o is an octal digit
\<newline> : continue on next line (effectively skips the following newline byte)

You may encounter resource keys containing these literals.  Your translations can also contain literals as needed.

An equal sign character can be represented as "\x3D" and a double-quote character as "\x22".

Debugging

There is a LightWave command to run the Localization tool inside LightWave to avoid having to restart LightWave each 
time when you are checking your work. In Layout run Locale and in Modeler the command is locale. The language 
you choose in here will override Hub settings so you can check your work without needing to continually restart. 
Changes made in the command are persistent, but only affect the app the command is run in. Setting the language in 
the panel to system-defined will revert to the Hub choice.
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Editing Help URL
By default, LightWave will launch an URL to the wiki based documentation located at https://docs.lightwave3d.com.
This might not suit your studio's needs, so a redirection can be created by editing the resource files that deal with the 
documentation.

Help is called by pressing F1 on the keyboard from Layout or Modeler.  The URL called can be made anything local or 
remote by editing support/l10n/HELP.resource. Users can also create their own local-level resources that will 
override the defaults found at the previous location by creating appropriate files in the user folder as shown:

The HELP.resource will be used with or without the Hub running

Windows

C:\Users\<user_name>\.NewTek\LightWave\2018.0\l10n\HELP.resource

OR

C:\Users\<user_name>\.NewTek\LightWave\2018.0\l10n\<language>\HELP.resource

Macintosh

/Users/<user_name>/Library/Application Support/NewTek/LightWave/2018.0/l10n/HELP.resource

OR

/Users/<user_name>/Library/Application Support/NewTek/LightWave/2018.0/l10n/<language>/
HELP.resource

To test, open the locale panel in Layout (with the "Locale" command). Then, choose the "Sync Resources" 
button, after ".resource" changes are made (without having to restart LightWave).



https://docs.lightwave3d.com.
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HiDPI Display Support
As LightWave transitions to a resolution-independent user interface, methods have been put in place to scale parts of 
the user interface using LightWave's existing graphics toolkit (how the user interface looks) for bigger screens. For 
macOS, such scaling is specified by the Displays category of System Preferences.

For Windows machines, if you don't have two displays at the same resolution, Windows 10 has per monitor scaling for 
elements:

In Windows 7 and 8 there is only a general Display scaling window that can lead to text being too small on one screen 
and overblown on the next:
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LightWave 2019 has the following Screen Scale argument when launching Layout and/or Modeler:

--ui_screen_scale_factors=2;1

The above code will add a scaling factor for a two-monitor system where the first monitor is UHD at a resolution of 3840 x 
2160 and the second monitor is HD at a resolution of 1920 x 1080

While title bars and other windows will still be small on the above multi-monitor display, LightWave UI elements will be 
sized correctly on this 2560*1440 screenshot:
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Menu Improvements

Menu Navigation

LightWave's internal menus can be filtered, navigated rapidly and scrolled up and down. Filtering works as soon as you 
start typing and is based on the localized name. To remove filtering without clicking away from the menu, you can use 
Backspace.

This scene has almost 2,000 objects, but typing narrows that down
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•
•
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•
•
•
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•

The Additional menu always has a large number of entries. Scrolling through them is easier than having to go to the 
base of the menu to initiate a scroll

Keyboard Navigation/Selection

The keyboard shortcuts for navigation and selection are as follows:

Home - Goes to the top
End - Goes to the bottom
Page Up - Goes one page up (towards the top of the menu)
Page Down - Goes down one page (towards the bottom of the menu)
Up/Down Arrow keys - Change the selection (highlighted entry)
Right Arrow key - Opens the submenu if the current entry has one
Left Arrow key - Closes the active submenu
Enter/Return key - Accepts the highlighted entry

If you have deep hierarchies then sometimes there isn't the room onscreen to fit the item names. Hitting Shift-
Left or Shift-Right will navigate inside such hierarchies


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Regular expressions can also be used to filter menus. Start typing and hit TAB to switch into and out of regexp 
mode. (Go here for a tutorial on how to get started with regex)

As an example, to find all the numbered spoons in the Ratatouille kitchen scene with 2,000 objects, open the 
objects list, type . and hit tab (and you'll see (.*) instead of the magnifying glass indicating you are in regexp 
mode). Now you are in Regep mode, you can type spoons\d to find just the objects containing the word 
"spoons" followed by a number.



https://en.wikipedia.org/wiki/Regular_expression
https://regex101.com/
https://en.wikipedia.org/wiki/Regular_expression
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Flat Menu

You can now call up a flattened version of every entry that exists in the main menu with the keyboard shortcut CTRL 
Space. Doing so presents a list of all available commands in Layout or Modeler (with their associated keyboard 
shortcuts). As with other LightWave menus, you can type to narrow down your selection and the cursor keys and Enter 
can be used to choose the command you require.
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Examples
Example - Baking Simulations
Example - Setting Up Visor
Example - Rolling Shutter
Example - New Delivery — Demonstrating how to use Match Perspective
Bullet Examples

Example - Getting Started with Bullet
Example - Hinge — Demonstrating the Hinge constraint in Bullet Dynamics
Example - Point-to-Point — Demonstrating the Point-to-Point constraint in Bullet dynamics
Example - Slider — Demonstrating the Slider constraint in Bullet dynamics
Example - Cone Twist — Demonstrating the Cone Twist constraint in Bullet Dynamics
Example - 6 DoF Camera Work — Demonstrating the 6DoF constraint in Bullet Dynamics
Example - Non-Object Dynamics — Demonstrating dynamics using things other than objects in Bullet Dynamics
Example - Choreograph your destruction — Using timing and other objects to control Bullet destruction
Example - Getting started with Deforming Bodies — Using Bullet to deform normally rigid objects
Example - Animating a chain with Bullet — Use Bullet to animate hanging chains
Example - Using Primitive Shapes with Bullet — Create a Bullet dynamics scene with no geometry only null 
objects

Flocking Examples
Example - Mecha Fish — An example to show Flocking behavior.
Example - Missile Launcher
Example - Avoid and Attract Mesh

Interchange Examples
Example - Converting ZBrush Fibermeshes to FiberFX guides
Example - LightMaps in Unity — Creating LightMaps in LightWave for Unity
Example - Realtime Visualization with Game Engines
Example - Using ZBrush to Edit Morph Maps — Demonstrating using LightWave and ZBrush for creating morphs

Instancing Examples
Example - Randomly surfacing Instances — Demonstrating surfacing instances uniquely
Example - Monitor Screens — Demonstrating uniquely surfacing instances
Example - Python City Block — Demonstrating creating instanced cities
Example - Building a wall with Instances — Creating blocks one instance at a time
Example - Kooky Cube Eyeballs — Using 2020's new Offset Normal function to create cartoon eyeball

Example - UV Aspect
Example - Creating a Volumetric Light — Creating volumetric lights is easier than ever in LightWave and they have 
become integral to rendering rather than a post-process meaning they are much better integrated.
Motion Mixer Examples

Example - Simple Motion Mixer — Using Layout Modeler tools we'll make a simple Motion Mixer scene
Example - Blending Motions with Transitions — Transitions are one of the most powerful features of Motion 
Mixer. They allow you to blend motions together.

Node Examples
Example - Getting Started with Nodes
Example - Displacing Primitives
Example - Simplifying the Benchmark Marbles nodes
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Example - Surface Side — Very simple surface side demonstration
Example - Ray Type Switch
Example - Shadowing Options with Edges — An example that shows use of the Mesh Element Switch and Ray 
Type Switch nodes to control shaded edge shadows
Example - Inside RayCast
Example - Layer Material Components — Creating a realistic soap bubble

Example - Shadow Catcher: Environment Mapping
Example - Volumetric Primitive Emitter
Example - Starting with HyperVoxels — This exercise gives you a quick hands-on feel for how to use HyperVoxels.
Example - HyperVoxel volumetrics — This exercise will give you a flavor of some of the volumetric features.
Example - Blending HyperVoxel Objects — This exercise shows how different HyperVoxel objects can interact with one 
another.
Example - Curve to Spline and Spline Instancing
Example - Setting up a QuickTime VR Scene
Example - Custom Buffer
Example - Light Group
Example - QuickBolt QuickStart
Deformer Examples

Example - Simple Twist Deformer setup — Using nulls to twist a bar
Example - Combining Deformers — Using more than one deformer at a time is a great way to add complexity, but 
deformation order is important to check
Example - Filtering a deformer — Using procedural textures to filter deformation

Example - Converting old scenes to 2020
OpenVDB Examples

Example - First OpenVDB Liquid — Showing OpenVDB creating flowing liquid
Example - Logo rezzing up — Demonstrating the use of OpenVDB to create an object at changing resolutions
Example - Volumetric Cheese — Creating Swiss Cheese with Open VDB
Example - Chocolate Sauce Donut Drape — Using VDB particles to pour a gooey fluid

Surfacing Examples
Example - Adding an Image with Nodes — Adding an image to a surface using nodes

Example - Texturing the box with UDIM

Example - Shadow Catcher: Spyder on the beach
Example - Surface Library
Example - UDIM texturing the Sugarcube character

Example - Surface Baking Camera — Baking surface displacement detail into a normal map for a low-polygon object.
Example - Volumetric planet and atmosphere — Creating a detailed planet with sunrise using no polygons
Example - New Light Options — Video showing how lights work in LightWave 2018
Animation Examples

Example - Door Pivot 1
Example - Door Pivot 2
Example - Spline Displacement Object CP — SplneDisplacement-ObjectCP.png
Example - Using FontMesh — Creating live animatable text in Layout

NRC Tutorial
Example - SunSky and Environment Light — Creating a beautifully lit scene without GI is quick and effective
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Example - Baking Simulations

Our simple scene has five objects that have all been assigned Bullet dynamics. The objects fall to the floor and bounce 
and roll around beautifully. To ensure the integrity of their motion, to not have to endure the time taken to repeat the 
Bullet calculation (which in this case is admittedly negligible) and to be able to export the scene to another piece of 
software we will bake the motions that the objects make.

To do this, select all the objects you wish to bake - in this case the five objects dropping to the floor. There is no need to 
bake the floor, there is no animation applied to it.

https://docs.lightwave3d.com/download/attachments/1859828/MDD_Example.zip?api=v2&modificationDate=1590600963000&version=1
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On Layout’s I/O tab you will find MDD Multi-Baker in the Export group. There are plenty of settings you can change for a 
variety of situations but for this exercise we will immediately hit OK. You may be prompted to create a VertCache 
directory in your content directory. Do so, this is where the MDDs will be stored.
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Further up the I/O tab, in the Import group you will find MDD Multi-Loader. Before opening it, we turn off Enable 
Dynamics in the FX Tools tab and press play to assure ourselves that the objects in the scene no longer fall to the floor. 
Now we return to the MDD Multi-Loader and open it. The window contains the six objects in our scene, the five falling 
shaped and the inanimate floor. On the right side we can either load the MDDs by multiselecting them in the load 
requester or by hitting the Scan MDDs button and navigating to the right folder. In either case, we rapidly get five MDDs 
in the right window.
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We can go through the objects one by one, carefully selecting the appropriate MDD file to go with the right object, or we 
can just hit Match By.... By default the choice is set to Names, which is fine. In either case, we will see that we have one 
MDD assigned to each of the five falling shapes and none to the floor. Now when we hit OK to close the window and 
press play on the scene we see our five shapes falling to the floor object exactly as they did when Dynamics were 
enabled on the FX Tools tab.
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1.

2.

Example - Setting Up Visor

Download the above scene, and we will make use of Visor.

Load the scene and add a null object called Visor (to make it easy to find). In the Appearance tab of the Object 
Properties window add Visor from the dropdown. Use F4 to split the viewport in two and make the left side 
bigger than the right.

Make sure you are in Object mode and that the Visor object is selected, then double click on the Visor entry in the 
Object Properties > Appearance list. In the new window that opens choose Add Pane. A new blue pane will be 
placed in the right-hand viewport. 

https://docs.lightwave3d.com/download/attachments/8200775/Mars_Explorer.7z?api=v2&modificationDate=1590656934000&version=1
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3.

4.

 

In order to push renders to Visor you have two options. You can choose Render2Image in Render Globals > 
General > Render Display or you can leave it at Image Viewer and pass finished renders from there. For your first 
tests, set the Render Display to Render2Image.

Render a couple of pictures so that you can see your pane filling up, then change the Render Display back to 
Image Viewer. Do another render and when the Image Viewer appears go to File > Frame Buffer > Render2Image 
and also choose Auto-Send Image.
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Visor keeps renders in RAM, so if you find yourself running short and/or you want to save your renders, you can 
go into Image Editor (F6) and delete or save images there with names starting !Render...





LightWave 2020  –  LightWave 2020

Appendices –  3107

Example - Rolling Shutter
Here’s a visual explanation courtesy of Dave Jerrard:

Here’s a shot of five marbles, all rolling in different directions. The ones along the edges of the frame are all moving 
along the edges of the frame in a clockwise direction. The white one in the center is moving diagonally from top left to 
bottom right.



LightWave 2020  –  LightWave 2020

Appendices –  3108

Now the same image with Rolling Shutter set to 100%.

Note that the marble on the right, which is moving down the frame, appears stretched vertically, while the one on the 
left is squashed vertically.

Now with Rolling Shutter set to -100%, the skewing effect is reversed.
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And finally with motion blur added. In this case, Shutter Skew is set to 100% again.

With spinning objects, this can look pretty weird...
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1.

Example - New Delivery

Start by loading the New Delivery scene. This will dump some surfaced objects in the middle of your scene. We're 
going to use Match Perspective to add the backdrop in such a way that you can position the objects to create a 
render of a parcel having been delivered to this address. 

Before using Match Perspective, start the Set BG Image tool just above it. This will open a window wherein you 
can choose the image you will be matching. Aside from choosing an image, leave the other settings at default.

New_Delivery.7z (1.5 MB)


https://docs.lightwave3d.com/download/attachments/8200766/New_Delivery.7z?api=v2&modificationDate=1594036281000&version=1
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2.

3.

Once you hit okay, the background image you chose will appear in the Camera Viewport. Now it is time to 
structure your scene so it can be populated. Hit the Match Perspective tool and you will see six lines appear - two 
red, two green, and two blue.

It doesn’t matter in what order you arrange these lines, nor which end is which, but the red ones should 
represent the X coordinate of your screen. There’s some architrave above the entrance that will work well so 
move the central handle up to the line, then double click to pin it. The central handle will turn solid red. Now 
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4.

that it is pinned you can line up either end of the line and the whole line will rotate about the fixed point. You can 
do the same for the other red line across where the house meets the ground.

I've continued with the green lines, representing the Y coordinate, but just from preference. You can arrange the 
lines in any order you like. If you right-click on a handle at the end of a line, or in the center, you will get a 
magnified view of the pixels of the image to better help you locate exactly the point you want.
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5.

6.

Now that the green lines are in place, just the blue lines left and there isn’t much that’s obvious. As you can see 
the grid starts to come into alignment with the image as you organize these lines. The bottom of the porch wall 
is a good candidate, and we'll use the side wall of the neighboring proch for the other. Try and scope out when 
photographing to make sure you have six useful axis lines.

Now that all our lines are in place, it’s time to organize the objects for our scene. It's not very likely they will be 
nicely set up. Switch to Perspective mode (Numpad 4), and move the objects so that they are in line with the 
camera.  They should look quite at home with the perspective used and just need shifting into better positions. 
You may find yourself changing views to organize this better and while there is some guesswork, it should be 
simple enough.
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7.

8.

One last thing to make sure we’re well situated in our scene. I know that the width of the black tiles on the porch 
is exactly 1.514 m across. So, I hit N to bring up the Perspective Match numeric window, set the On Floor 
measurement bar to stretch across the black tiling, and entered the measurement.

The Porch object behind the parcel, the floor below it, and the Wall object were given Surfaces with luminosity 
and a Shadow Catcher Shading Model. The Wall object serves to conceal one side of the box, to show it's "in" the 
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porch.
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Bullet Examples
Example - Getting Started with Bullet
Example - Hinge — Demonstrating the Hinge constraint in Bullet Dynamics
Example - Point-to-Point — Demonstrating the Point-to-Point constraint in Bullet dynamics
Example - Slider — Demonstrating the Slider constraint in Bullet dynamics
Example - Cone Twist — Demonstrating the Cone Twist constraint in Bullet Dynamics
Example - 6 DoF Camera Work — Demonstrating the 6DoF constraint in Bullet Dynamics
Example - Non-Object Dynamics — Demonstrating dynamics using things other than objects in Bullet Dynamics
Example - Choreograph your destruction — Using timing and other objects to control Bullet destruction
Example - Getting started with Deforming Bodies — Using Bullet to deform normally rigid objects
Example - Animating a chain with Bullet — Use Bullet to animate hanging chains
Example - Using Primitive Shapes with Bullet — Create a Bullet dynamics scene with no geometry only null objects
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1.

2.

3.

Example - Getting Started with Bullet

Let’s start with a simple example just to try it out. For this we won’t even need to use Modeler, since we will use 
primitives in Layout to create all the geometry we need for the scene.

To get going, we will make a standard cube. Add a Null (Ctrl-N) and go to Object Properties. Change Primitive 
Type from Mesh to Shape and select Cube. Make the Radius setting 0.5.

We need a floor for our test object to collide with, so create another Null, call it Floor and visit Properties again. 
Change Primitive Type from Mesh to Shape and select Plane. Make the Radius 5.

So far we can only see nulls. Select the cube null and visit the FX Tools tab and choose Dynamic Body > Rigid 
Body. You will see that your Rigid Body object has a wireframe overlaid. We'll need to do the same with our 
Floor, but will need to go a little further because a standard Bullet object is 1m. Our Floor is 10m square. Choose 
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4.

5.

the Floor null and visit the FX Tools tab and choose Collision Body > Static Body. Open the Bullet Item Properties 
window, select your Floor object and change to the Transform tab. Change the Scale X to 10, Scale Y to 0.1 and 
Scale Z to 10.

Next, we’ll make some clones of our cube, four should do the trick. We’ll need to move the cubes up from Y=0, 
separate them and rotate them to different angles to give them some distance to fall and more visual interest 
and you should end up with something like this:

If you hit play now, you will see your cubes hit the floor in a realistic, if not very interesting fashion. Set your 
timeline slider to the beginning of the scene at 0 and let’s spice up the uninteresting column with a different type 
of dynamic object. Still using Primitives, make a sphere at 0.5m radius and position it at the lower left of the view 
shown for step 4. 



LightWave 2020  –  LightWave 2020

Appendices –  3119

6. Line up your Perspective view so that you are behind the sphere and can see your column of uninteresting 
cubes. We should be at frame 0 on our timeline still but move to frame 3. Now move the sphere towards the 
column and up a bit - as though you were firing the ball at the middle of the column (for that is what we’re about 
to do). If you press play now, the ball will stop in mid-air, but if we change the ball to a Rigid Body you will see 
that the Sphere gives a little bounce but only slightly bumps into the uninteresting column.
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7. Now we’ll go into the FX Tools > Item Properties window. Choose your Sphere object and click on the Activation
tab. For Initial Activation choose Activate on Last Key. Your sphere should now fly faster and knock that column 
into a more interesting look.

For more variation, give your objects different properties in the Item Properties window.

Because LightWave primitives have no visible shape, try setting the Bullet World Properties Draw Bodies 
setting to All for this exercise. It will show all the objects we have made, not just the currently-selected item. 
We can also use Layout’s Modeler Tools to create our sphere for this quick example, for the best results with 
dynamic bodies always use a tessellation-type sphere, not a globe-type sphere. All those edges converging at 
the poles of a globe sphere makes for a weak spot, making it much easier to deform there than anywhere else 
on the sphere.


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1.

2.

Example - Hinge

The first thing to note is the five hinged blocks above the floor. The first one is Static and acts as the base for the 
other four plates, which each have two hinges to attach them to the next plate. Note also that the last plate in 
the chain is considerably heavier than the others.

All of the constraints for the plates are Hinges apart from one Point to Point. It is the connection between the 
final two plates that are different from the others. The Hinge constraint is Breakable and the Breaking Force
required is 10000 here. As noted in the General Constraint Rules, start with a breaking force based on the 
Mass*Gravity and adjust up and down. 

HingeBreak_2020.7z (2.38 MB)


https://docs.lightwave3d.com/download/attachments/8200795/HingeBreak_2020.7z?api=v2&modificationDate=1591631189000&version=1
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3.

4.

 

The other connection for this last plate is a Point to Point, so that when the Hinge breaks the last plate swings 
around. This constraint is also breakable and this time an envelope was used to dictate exactly when the 
constraint would break.

 

The scene also shows the destruction of the fractured cube sitting on the floor. Note that a solid cube is shown to 
hide the cracks in our cube to be broken. This cube is dissolved at the moment the last plate hits when the 
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cracks are perfectly natural to be shown.
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1.

2.

Example - Point-to-Point

To keep things simple, we will use Layout-created objects to keep things quick. Please apply what we do here to your 
own objects and scenes. Likewise, we will be using Bullet defaults. You can achieve a completely different effect by 
varying settings, particularly the weight of your pendulum object. 

As in our first constraint example, we will create a cube and sphere. Move the sphere to be below the cube. On 
the FX Tools tab, set the sphere to be Rigid and the cube to be Static.

 

Select the cube and then add the sphere to the selection and choose Point to Point from the Constraints group 
in FX Tools.
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3.

4.

 

The sphere won’t do much if we don’t give it an impetus. At frame 0, move it to the side and a little up on the Y 
and you will create a pendulum effect for the sphere. Hit Play to see it.

 

Rather than a simple pendulum, let’s make the motion more interesting. First, set your scene length to 600 so we 
have more time to see the swing. With Enable Dynamics switched off, go to frame 2 of your scene and move the 
sphere somewhat sideways. A little difficult to describe in text, but imagine you are holding a real sphere and 
you want to swing it in more of a circle under the cube. In the Bullet window, set Item > Activation > Initial 



LightWave 2020  –  LightWave 2020

Appendices –  3126

5.

Activation to Activate on Last Key, then click Enable Dynamics. Hit Play again.

 

The sphere will continue to swing for a very long time and as stated above, the Point to Point constraint has no 
damping feature. However, your Sphere already has the ability to be damped. Select your sphere in the Bullet 
window and on the Item > Properties tab you will see you have Linear and Angular Damping. You can increase 
the default values of 1.0 % to better control the swinging of your pendulum. Upping the Linear Damping to 50 % 
will stop your swinging sphere very quickly (within a couple of hundred frames), but setting it to something like 5 
% will still feel like a realistic rate.
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1.

2.

Example - Slider

Press Play on the scene when it loads. You’ll see the red shape tip over from one side to the other and also rotate 
on its pitch. The green shape follows, constrained to the axis shown in blue. The yellow squares at either end of 
the constraint are the linear limits for the green shape. The cylindrical shape is parented to the constraint and 
serves only as a visual "axle".

 

We have Slide Limits enabled and that’s why the green shape doesn’t intersect the smaller bar of the red shape. 
We could stop the green shape intersecting the other side by setting the Lower Slide Limit to -285 mm and then 
you would completely stop the green shape from intersecting the red.

SliderCollision_2020.7z (100 KB)


https://docs.lightwave3d.com/download/attachments/8200801/SliderCollision_2020.7z?api=v2&modificationDate=1591704479000&version=1
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3.

4.

 

Equally, we can Enable Spin Limits. This would allow us to restrict the angular movement of the green shape 
around the axis. The problem is that setting all these limitations is time-consuming (although sometimes they 
will be more useful than our next option).

 

That next option is to engage Enable Collision. This option will prevent the intersection of geometry that is 
linked by constraints. Other geometry, not associated with the constraint, will react following the type of 
dynamic object your constrained objects come into contact with. Motors can also be used to restrain the green 
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shape - to keep it at one end of the other of the axis, for instance.
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1.

2.

Example - Cone Twist

Only the tail item is Kinematic in Bullet, the rest of the objects are all Rigid bodies. When making the scene, the 
tail was added first, then the constraint and then a segment. Afterwards I was careful to copy the constraint and 
then copy the segment to add them in order to make the scene easier to read.

Doing it this way means you need to manually assign Attach Body 1 and Attach Body 2 . You might also need to 
turn the constraint on the heading if it is not facing along the snake (the snake in the example is running down 
the Z axis and the constraint had to be turned -90° on H). When setting the first constraint Swing and Twist Limits 

ConeTwist_2020.7z (1 MB)


https://docs.lightwave3d.com/download/attachments/8200807/ConeTwist_2020.7z?api=v2&modificationDate=1591786109000&version=1
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3.

were enabled to give the characteristic motion of a segmented snake toy. 

The motion of the snake is directed by the keyframes on the tail. The rest of the motion is dynamic. Tipping the 
tail up and twisting it seemed to produce the most satisfying motion.



LightWave 2020  –  LightWave 2020

Appendices –  3132

1.

2.

Example - 6 DoF Camera Work

Load the 6DoF_Van scene and hit play. Watch as the van bumps over the terrain (it doesn’t really, there are Noisy 
Channel modifiers on Y and P), but notice the camera bobbing around on top. LightWave's Bullet dynamics are not 
restricted to objects, you can apply constraints to other scene items. Particular things to note:

The van was given a simple path to follow, Align to Path was used on the Motion Options panel, and then the car 
set to Kinematic in Bullet.

The constraint was made by making the Camera a Rigid Body for Bullet and its 1 m box was reduced in size on 
the Transform tab to not take up so much room on-screen. The van object was selected and then while holding 
Shift, the Camera was selected again and the 6 DoF constraint was chosen.

6DoF_Van scene (340 KB).


https://docs.lightwave3d.com/download/attachments/8200812/6DoF_Van.7z?api=v2&modificationDate=1591787637000&version=1
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3. The constraint was set up with a small amount of movement on X, Y, and Z; H, P, and B. To dampen the 
movement, if desired, motors can be used. Our scene’s camera has a mass of 1000 kg/unit so start your Linear 
Motor forces around there. There is no need to add a Target Motor Speed. The same can be applied to the 
Rotation Motors.
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Example - Non-Object Dynamics

You can add dynamics to all scene objects. In this scene, a camera has been made a Rigid body and given a spherical 
shape to better bounce down the stairs. The other objects in the scene are set to Static bodies, apart from the cyan box 
on the stairs. It's a rigid body objectand its weight is very low. It will make our camera bounce down the stairs in a more 
interesting fashion

To make any item a dynamic object, simply add a dynamic type to it. Here we have selected a null in Layout and added 
a Rigid Body Bullet dynamic property to it. The Transform tab for the item allows you to create a specific size and shape 
for your item.

Stairs_2020 (61 KB)


https://docs.lightwave3d.com/download/attachments/8200816/Stairs_2020.7z?api=v2&modificationDate=1591789860000&version=1
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Example - Choreograph your destruction

Example - Choreograph your destruction

Achieving realistic destruction is as much as matter of choreography as it is modeling. You need the parts to break when 
most dramatically suitable. To do this you need more than just Bullet on its own. Let’s start with a modeled floor and 
tower. Use the box tool to create a wide and deep box, but don’t give it much height, the example here is 65 m2 by 
about 1.5 m high. Our tower stands about 30 m tall and is 4 m square. Note that the tower is subdivided - Fracture works 
better with square polygons so if it had been left as a single polygon we would have long thin splinters from a fracture.

  

Our Tower with the Floor in a Background layer. Fracturing the Tower using Voronoi shatter and 300 cells. The resulting 
Tower showing its exploded Morph. (The layer with the original tower model on should be removed from the Send to 
Layout list by clicking in the rightmost column in the Layers panel (F7) in case you wish to make further changes to the 
original.

Now that the preparation for our model is complete, we turn to Layout. In Layout, make the ground a Static object and 
the tower a Parts object in the FX Tools tab. If you run the scene now the tower falls apart instantly. What we want is for 
the tower to break only where and when we want it to. To do this, first we need to set our Tower not to fall apart 
immediately. Setting the Glue Strength to 100 % and turning off Breaking Distance will achieve that. Now if we run the 
scene we see that nothing breaks.

 Choreograph.zip - This zip contains Choreograph and Multiple Hits scenes (248 KB)


https://docs.lightwave3d.com/download/attachments/8200827/Choreograph.zip?api=v2&modificationDate=1518641786000&version=1
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We need a way to reduce the Glue Strength in an area of the Tower so it can break in that area. The way to do it is with a 
gradient on the Texture button of the Glue Strength. First, add a null to the scene and set a path for it that directly 
intersects the tower over the course of the animation.

 
We have given our Null an Item shape at 2 m to give some idea of the volume of breakage our null will cause. The ball won’t 
appear in the render, this is purely an invisible cause for the breakage.

Now we need to create the gradient for the Glue Strength value. In the Bullet Item Properties window click your Tower 
object's Glue Strength T button and change the Layer Type to Gradient as shown.
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1.
2.
3.
4.
5.

Things to note here are:

Set the Input Parameter to Object Distance
The name of the object you are using to provoke the breakage
Set the 0 m Parameter to a value of 0
Set the next parameter to the distance away you want to start reducing the Glue Strength
Switch the Smoothing to Step to get a clean break.

If you’d like to use multiple nulls to break your tower in different places at once, you must set the Blending 
Mode for each additional null to PShop Darken.


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All you now need do to complete your choreography is judge when and where the impacts on the tower take place by 
animating your nulls to suit. Don’t forget to turn off Enable Dynamics while you are creating the motion paths for the 
nulls and go to frame 0 to turn it back on, then go to the end frame of the scene to make Bullet calculate all the 
dynamics in one go.

In order to further improve your simulation, consider adding an Envelope to Breaking Distance to simulate 
overall weakening of the entire structure as impacts occur. The envelope should start large and get smaller 
with time to show increased fragility.


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1.

2.

Example - Getting started with Deforming Bodies

As for our first example with Rigid Bodies, we’ll repeat but with Deforming Bodies. This requires a very small amount of 
additional setup, but with satisfying results.

In common with the previous example, we need a floor for our deforming objects to fall on. Choose Modeler 
Tools > Create Geometry > Cube and set Width: 10 m, Height : 0.25 m, Depth: 10 m. Set the Surface to Floor.

 

Now make an element to bounce off the floor by using Cube again but this time setting it to Width: .5 m, Height: .
5 m, Depth: .5 m. The number of Segments should be set to X: 10, Y: 10, Z: 10, and the surface to Cube.
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3.
4.

 

In the FX Tools tab set the floor object to be a Static Body and the small cube to be a Deforming Body.
Now we need to make three clones of our small cubes. Then move the four objects up in the Y and rotate them 
randomly to end up with something like this:
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5. Open FX Tools > Item Properties. Select the four deforming cubes and set their Collision Margin to 10 mm and 
Shape Retention to 50 %.
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6. Give the four cubes different Shape Retention settings. 100 % will not deform the object at all, but setting it 
lower will give increasing amounts of deformation.



LightWave 2020  –  LightWave 2020

Appendices –  3144

•
•
•

•
•

1.

2.

Example - Animating a chain with Bullet

Click here to expand Table of Contents...
Introduction

Creating the Hero chain object
Creating the 2ptchain object

Bullet
For Bonus Points...

Introduction

Creating a convincing animation of cables or chains moving used to be quite a struggle, needing to use ClothFX and 
creating Metalink animations to convey the dynamic animation onto the full-resolution version of the mesh you want to 
animate. Bullet can easily perform the same function, and we'll show you here. Hero chain refers to the full-resolution 
polygonal object. 2ptchain refers to the 2-point poly object used for the dynamic animation.

Creating the Hero chain object

Begin with the Toroid tool and pull out a ring in the Top view. Select half the polygons and move them to stretch 
the toroid into more of a chain link shape.

Use Ctrl-C to copy the link, and immediately hit Ctrl-V to paste it down. It will be on top of the original link, but 
in the Right viewport hit R to make the new link perpendicular to the first, then T to move it to create the second 
link, trying to get the two interlocking polygons close but not touching. Now, deselect all polygons, hit Ctrl-C and 
Ctrl-V to copy and paste the link pair and then Move the new pair along the chain, ensuring the polygons don't 


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1.

2.

3.

interconnect. Deselect, and use Ctrl-C and Ctrl-V again, Move, and now you have eight links in your chain. Repeat 
as desired.

Creating the 2ptchain object

Start a new object and put the Hero chain in the background. Use the Box tool (Shift-X) to draw out a rectangle 
in the back view that encompasses the Hero chain in the background layer.

Hit the right arrow key to get as many segments as you have links in your chain. Once you have the same 
number, make the box. In Point mode, select all the points along the top edge of the box you have made and 
delete them. You now have a 2-point poly chain that will be the proxy for our Hero chain object in Bullet.

Select all the points in the chain and make a new Weight Map. Accept the defaults and deselect all the points. 
Select the point in your 2ptchain that is nearest the Origin and use Set Map Value in the Map tab to set this one 
point to 0 %
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1.

Save and send both objects to Layout.

Bullet

Open the Bullet Item Properties window and add the 2ptchain object. Set it to Deforming, and set the Mesh 
Filter to the Weight Map you created. If you hit Play now, you should see your 2ptchain object swing.
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2.

3.

To attach this movement to your Hero chain object, select Hero chain, and open its Properties window (P). In the 
Modifiers section, make sure Nodal Displacement is checked then double click to open its node editor.

In the Displacement section, choose Metalink. Add it, then double click the node to open it and set the Link To 
to your 2ptchain object. Drag the output node to the Displacement Destination Input.
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4.

1. a.
b.

If you press play now, your Hero chain object should be swinging in the breeze.

For Bonus Points...

You can set the Collision Margin for the 2pt-chain higher so that it's like the hero chain object, or
you can create a proxy object for the collision. Using the VDB tools may be ideal for this. Add a blocking 
object so that the 2pt-chain can collide with it. Make it static in Bullet, and hit play again. Now, the chain 
should hit the blocking object and react accordingly. If you notice interpenetration, you have two choices 
- make the collision margin higher, or change the proxy collision object, and one or other may be more 
appropriate depending on circumstances.
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Example - Using Primitive Shapes with Bullet

Click here to expand Table of Contents...
Preparation

Floor
Cube
Ball

Simulation

Preparation

In order to create a working Bullet scene that can be rendered, we'll start with three nulls called Floor, Cube and Ball. 
Let's take each individually:

Floor

Start by hitting Ctrl-N (or selecting Items > Add > Null) and typing Floor into the options panel that appears. Then hit P
(or choose the Properties button at the bottom of the screen) to bring up Object Properties. Set the Primitive Type to 
Plane and the Radius to 5.0 as shown:


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Cube

Repeat for the Cube.

There are no changes to the Radius.

Ball

One last time for the Ball null. Hit P to open the Properties panel, change the Primitive Type to Shape. The Sphere shape 
should be selected by default. Set the Radius to 0.25:
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You should now have a wireframe plane, box and sphere in Layout. Save the scene.

Simulation

With our three objects created, we need to set them up for simulation. To start with, move the Cube object up by so that 
it sits on our floor and the Ball so that it's above both. VPR should show something like this:

If we hit Play now, the three objects will just sit serenely in space and we want something more dynamic. Go to the FX 
Tools tab and select Item Properties from the Bullet group. With your Floor object selected use the Bullet Properties 
window to Add from Layout Selected for the three objects as shown:
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For the Floor object we selected Static, for the Ball object we chose Sphere as the Shape

Bullet puts an OpenGL overlay on our objects to show their bounds for simulation. While the Cube object is perfect, we 
changed the size of our Floor and Ball, so we need to change the size of our Bullet bounds too.

Select the Floor object first and change to its Transform tab:
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Change Scale to X: 10.0, Y: 0.2, Z: 10.0 and set Position to Y: -0.1 so that the shape is under the floor

Then choose the Ball and change Scale to 0.5:

You now have dynamic objects in the scene, but still no geometry. Save your scene. You will see that it is larger than 
normal of a scene of this type, but self-contained.

If you press Play now you will see the cube drop to the floor and the ball roll around a little on the cube but it's hardly 
exciting. Now you have created your starter objects you can duplicate those you want to and the settings will be ready. 
These Primitive Shapes can all be surfaced.



LightWave 2020  –  LightWave 2020

Appendices –  3155

Result with basic Motion Blur, Depth of Field and Surfacing
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•
•
•

Flocking Examples
Three demonstrations of Flocking's power.

Example - Mecha Fish
Example - Missile Launcher
Example - Avoid and Attract Mesh
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1.

2.

3.

4.

5.

Example - Mecha Fish

This example is a loose guideline to steps to follow since your own will doubtless follow a slightly different path, just 
like Flocking.

We’ll start with loading Lino Grandi’s menacing mecha fish. Use Load from Scene to bring in the fish from the 
link above.

In Layout, we’ll set our scene length to 600 frames and make a new Generator for a flock. Go to the FX Tools tab, 
open the Flocking window. Click Add New.. and choose Generator. Click the Presets button in the Flock Master 
window and choose the School preset. That will give us a flock of 125 agents that behave like fish. Once we’re 
happy with how they move we will vastly increase the numbers. Increase the size of the generator to 6 x 4 x 8 m.

We need to apply our fish model to our flock, so call up Object Properties for the Generator and go to the 
Instancing tab. Add an Instance Generator and set it to Particles. Add object and choose your fish model. You 
won't see any of your Mecha Fish until you Calculate All Motions in the Flocking window.

You now have a school of 125 fish with no goal, so we should add one. In the Flock Master window add a new 
Goal Director. Move the goal away from the fish so they have something to swim towards.

We have made an instanced school of fish swim towards our goal, but the animation is fairly static and the fish 
stay in their initial box shape so we need to add more interest. On the path between our Generator and Goal add 
a new Deflect Director and set its range to something adequate for your scene (try a Range of 10 m and a 

MechaFish animation (3.12 MB)


https://docs.lightwave3d.com/download/attachments/8200844/MechaFish.7z?api=v2&modificationDate=1592221193000&version=1
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6.

7.

8.

Deflect Core of 5 m to start and if that seems overlarge, adjust). Calculate again and now your fish will split to go 
around the obstacle.

It’s still not amazingly interesting so add two or three more Deflect directors and place them offset to the side 
and above of the direct path, making sure that they at least overlap the path a little and influence the flock as it 
passes them to the goal. They will also need Ranges and Deflect Cores adjusted. Lastly, add some Avoids 
starting at their default Range of 1, but with Envelopes set to stepped to explode them into 10 m balls as the 
school of fish passes.

 

Now, let’s move the Goal. Scrub through the timeline and watch for when your flock reaches the goal. At this 
frame, move the goal to a different location and keyframe it in place (if Autokey is active, this will happen 
automatically). Now calculate and watch the fish change direction. If the new position for the Goal takes the fish 
past the Avoid or Deflect directors so much the better.

To get rid of our original model and only leave the instances in our scene, we need to visit the Scene Editor and 
make sure that the original model is marked as inactive by unchecking the left-most column entry for it. This will 
stop the original fish from being rendered.

If your fish aren't swimming fast enough to reach the goal in 600 frames, speed them up in the Agents
tab by setting their Acceleration m/s2 and Max Speed m/s higher


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9.

10.

 

You have probably noticed that we have six entries in our Scene Editor for MechaFish. Our fish is animated 
through an MDD file and to prevent all our flock from making the same movement at the same time, we have 
cloned our initial fish several times. We then visited the I/O tab to use the MDD Multi-Loader.

 

Now that you have an animation you are satisfied with, all that remains is for our 125 fish to become a real 
school. Try upping the quantity to 10 on each axis for 1,000 fish, but you’ll also want to increase the size of the 
box they "hatch" from because if it’s too small they will explode out of there trying to maintain their distance. 
Bear in mind also that you will probably want to increase the size of your Avoid and Deflect directors so they 
have more impact on a much larger quantity of fish.
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In addition to moving your goals, try using the Envelopes for size and weight for the Avoid and Deflect directors 
to create sudden disturbances that make the fish create sudden turns or billowing in their movements.
If you need to use Calculate all Motions once you have applied your MDD-animated, subdivided fish, the 
chances are that calculations will be very slow. Turning SubD level down to 0 on the fish helps a lot, but better 
to remove the instances until you are ready to render your final animation.


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1.

2.

Example - Missile Launcher

We can use a new tool for Flocking to create smoke trails for a missile launcher firing. The scene requires a bit of setup 
and you’ll need to provide your own missiles. terrain and missile launcher.

Create a flat polygon with 12 subdivisions. This will be our launcher. Send it to Layout and open the Flocking 
Master window and choose
Add New... > From Scene Items > Generator - Mesh Polygons .

Add a Null, call it Path. Animate its passage over the course of your scene. Don’t make turns that are too sharp or 
you may lose your missiles. You can clone this null a couple of times if you like and change the course of the 
other nulls so you end up with a choice of paths your missiles can take.
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3. With your Path null selected, go back to the Flocking Master window and choose Add New... > From Scene Items 
> Director - Path . You may want to increase the Steps in your path if the course taken is intricate. We have given 
our three paths 39 Steps here.
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4. Add another Null and call this one Emitter. This will be your particle generator, so add an Emitter from the FX tab 
of Object Properties . In the settings for the emitter, go to the Motion tab and set Explosion(m/s) to 2.0. In the Etc
tab set Parent Motion to 0 %.
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5. Open the Motion Options for the Emitter null and add the Flocking - Item Motion modifier. You can choose which 
of the flock will have particles trailing by changing the Index number here, but we’re going to put this emitter on 
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6.

all of our missiles.

Clone the Emitter using Ctrl-C and set it to 11 clones. An emitter will be placed on each missile in the flock. You 
can now use Instances to change your flock members into missiles trailing smoke.
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Sometimes the link gets lost between emitter and flock agent. Hitting Calculate for the PFX gets that link going 
again.


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Example - Avoid and Attract Mesh

Meshes can be used both as things for flocks to avoid and things to attract flocks. In this simple example, we’ll do both.

You’ll need some asteroids. For this example, a level 4 tessellated sphere was used sized to about 1.5 m, sized in 
two dimensions to make it flatter and jittered to make it less regular. It was subpatched then frozen to give it 
more detail. In a second layer, a level 1 tessellated sphere was created and resized to be larger than our first 
layer. This is going to be our avoid mesh.

 

With our asteroid made, send it to Layout. Parent the Avoid layer to the Asteroid itself so that it moves with it 
and you may want to use the Scene Editor to hide the Avoid mesh since we’re more interested in what happens 
with the asteroid.
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3.

4.

 

Make a Clone Hierarchy of the Asteroid layer (so that the avoid layer is cloned too) and move and rotate it a bit 
in front of the first asteroid. Now we’ll open the Flocking Master window and first select our original asteroid 
and use Add New... > From Scene Items > Director - Goal. Now select the cloned avoid layer and choose Add 
New... > From Scene Items > Director - Avoid. Change the Director Type to Avoid Mesh (as shown in the green 
inset).

 

Clone Hierarchy our cloned asteroid with its Avoid Mesh layer a few times so you can create an asteroid field. 
Position them in all three dimensions and change rotation on each to get more variation
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5.

 

Now create a generator in the Flocking Master window. Use Add New... > Generator. Move it away from the goal 
asteroid. In our example we’ve moved it to about 15 m away in Z with the avoid asteroids between the flock and 
its goal. Your scene elements are complete. Now hit Calculate all Motions in the Flocking Master window (or 
Calculate Flocks in the main FX Tools menu). Your flock should go to the goal asteroid and alight. If they don’t 
avoid the other rocks we need to set the Probe Length and Strength accordingly - by default they are at 1.0 and 
are sensitive to the scale of your scene. When you select an Avoid Mesh director you should see a pincushion 
effect. This is that director’s Probe Length. Setting it too short will mean the flock has less chance of seeing it, 
setting it too long will result in avoidance long before necessary. To get this good effect here we have set it at 1.2 
for each of the Avoid Mesh Directors and upped the Strength to 10.
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6. This is a satisfying result, but let’s expand. Directors don’t have to stay as they are for the whole scene. Make 
your scene 500 frames. Using Envelopes, we can make the asteroid nearest to where they started more 
interesting. Select the asteroid nearest the Generator, not its child Avoid Mesh shell. Add a goal to it using Add 
New... > From Scene Items > Director - Goal. Add an envelope to this goal’s weight starting at 0 ending on 30 at 
frame 500. You can either change the TCB handles (as shown in the image) so that you have an increasing curve 
of weight or put in a third key somewhere in the middle so that the first asteroid doesn’t attract the flock before 
they have reached the other perch. Either way, your flock should avoid all the asteroids to get to the last one, 
land, then take off again to head back to the first asteroid before the scene finishes.
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Interchange Examples
Examples of using LightWave's Interchange facilities to communicate with other software.

Example - Converting ZBrush Fibermeshes to FiberFX guides
Example - LightMaps in Unity
Example - Realtime Visualization with Game Engines
Example - Using ZBrush to Edit Morph Maps
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1.

Example - Converting ZBrush Fibermeshes to FiberFX guides

ZBrush v4R3 adds the ability to export the fibers supported by ZBrush into LightWave to be used as guides for 
LightWave’s own fiber solution FiberFX. To do this is very simple:

Start with a project inside ZBrush and comb the hair as you’d like it. Since the hair from ZBrush will only be 
guides for FiberFX you will not need a large amount of fibers.

 

Reduce the Preview Fiber Visibility down to a low figure. ZBrush will give you the total number of fibers that will 
be saved.
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2.

3.

4.

Save your guides out of ZBrush as an LWO file and load it into Modeler.

The fibers need to be converted into guides for FiberFX using the StrandMaker tool on the Setup Tab, in the 
FiberFX group.

The new polychains will be created on a separate layer, so they need to be saved to a new object (you can 
replace the existing curves on Layer 1 and save over your original object if you prefer).
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5. Send this object to Layout and add FiberFX to it. Turn on Draw to see your newly-added fibers. You’ll see that the 
fibers aren’t exactly following your guides. This is because of the Random Length and Gravity settings. Set them 
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6.

both to 0%.

If you wish to increase the quantity of fur on your object, increase the number of fibers per guide using the Fiber 
Quantity setting in FiberFX.
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Example - LightMaps in Unity

One way to make your lighting more subtle in Unity is to use lightmaps to recreate your LightWave lighting. Transferring 
these lightmaps is done by assigning them to your surface’s Luminosity channel and Unity will automatically place 
them in a second material slot dedicated to lightmaps.

Here is a very simple scene with a box, with textures inside for the walls and floor. The textures are images 
applied to the UV Map in the Color channel.

 

The only light in the scene is a Sunlight outside the box angled so that the inside of the box is lit partially. We’ll 
add a new Spherical light to the scene and position it inside the box, with a falloff that means it just touches one 
wall and the floor.

 

Now we’ll set up a surface baking camera. Set it to the mesh for the box and the appropriate UV map. Set the 
resolution low. We’re using 256 x 256 but you may even be able to get away with 64 x 64.
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4.

5.

6.

 

Add a Compositing Buffer Export to your Image Filters (Ctrl F8) and choose Shading and/or Radiosity.

 

Render an image. In the Image Viewer’s Layer dropdown you will see the color rendered image, plus an image for 
the Shading and/or Radiosity.

 

In the Surface Editor, add the lightmap render to the Luminosity Channel. LightWave only supports grayscale 
images for any channel other than Color, but when the scene is sent to Unity, Unity will move the Luminosity 
Channel mapping to a secondary UV channel for a lightmap, which can be in color.
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7.

8.

 

Save your objects and scene to update them in Unity.

In Unity, select the object that has the lightmap and you will see that the texture concerned is listed as Legacy 
Shaders/Lightmapped/Diffuse. There will be two image slots in the Texture - one Base, which should contain 
your image map and one Lightmap, which may be empty. All you need is click the Select button to add the 
lightmap image you rendered. The Lightmap won’t look great in the viewport, but pressing Play should show it 
nicely in the game view.
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Example - Realtime Visualization with Game Engines

Click here to expand Table of Contents...
Introduction
Unity
Unreal

Introduction

One of the frequent requests we have is for some aspect of realtime visualization for architectural scenes. Unity, and 
Unreal, in their free versions, are very capable of not only providing a standalone executable to give to your clients but 
also a web player version so you can share using the web. Obviously, this tutorial is not to give you a full understanding 
of either Unity or Unreal, but rather a taste of what is possible.

For our example, we’re using the Lighting Challenge scene British Natural History Museum, modeled by Alvaro Luna 
Bautista and Joel Anderson. The archive is just a single object so we have put it in a scene with a series of spherical 
lights for the interior.



LightChal17_Museum.7z (4.49 MB)

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Unity

The texturing is not set up for LightWave (or Unity) but if we just wanted to get the scene into Unity quickly, the steps we 
need to take are as follows:

Once you have set up the scene for your Natural History museum in LightWave, we will create a new 3D project 
inside Unity. Once you have chosen a path for your Unity project and hit OK, the Editor will appear and assets 
will be written to the path you've chosen. In the Assets menu, choose Import Package > Custom Package... and 
navigate to your LightWave support folder. In there go to the 3rdparty_support folder, then into Unity3D, and 
choose the LightWaveAppLink.unitypackage. Accept to apply it to your scene and multiple things will be copied 
to the folder you set up. At that point, you will notice that there's a new LightWave menu in the Unity Editor. In 
this menu, click Choose LightWave install path and navigate to the directory where LightWave is installed.

 

Tick Character Controller.UnityPackage . This will give us FPS-style navigation, and also tick 
LightWaveApplink.UnityPackage . This will give us our LightWave automatic updating. Hit Create. Once Unity is 
loaded, you will see that there is an Assets folder inside your project directory. As an additional touch you can 
add the Skyboxes .UnityPackage   package to create a sky for around the museum.
Copy your LightWave content directory into the Assets folder. From now on, only load your scene from this 
directory for any modifications you do to the scene in LightWave.
If this is your first use of Unity, it will ask for the path to LightWave. Once you have set that, start Layout and load 
your scene from the Unity project Assets folder. Whenever you save the scene in LightWave now, it will be 
updated in Unity. Right now we need to make an initial save so that we have something we can position in Unity. 
If you switch to Unity as soon as you have saved your LightWave scene you will see Unity is waiting for something 
and you may see progress bars like this appear:

Once it has finished you will see a new item in the Project tab. In our Scenes folder there will be a new file with 
the same name as your scene with a different icon. Click on this file so it appears in your project’s Inspector 
pane, like so:
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The Scale Factor needs to be set to 1. If you tick Generate Colliders and Generate LightMap UVs , which would be 
good, the initial import will take a long time. Also change Material Naming to Use Model’s Materials Once you’ve 
done this, drag the FBX file up into the Hierarchy tab. Unity will ask if you want to apply settings, do so and your 
model will appear in Unity’s viewport.

In your Hierarchy view, select the Main Camera and in its Inspector pane choose Add Component. You will need 
to do this three times to add:

Character > Character Motor
Character > FPS Input Controller

Camera Control > Mouse Look

Our original LightWave scene had several lights, so we will now recreate them in Unity. Select the first light in 
Unity and select Add Component in its Inspector pane. Add Rendering > Light and make this light Directional in 
the Inspector. Now select the other lights you placed in your LightWave scene and choose Add Component and 
Rendering > Light again, but make them Point lights and increase their range.

The GlobalScale variable was set to 1 in Unity to make LightWave objects come in at the right scale since the 
script is LightWave-specific. However, it meant that all objects brought into a Unity project after that would 
also be set at 1, which could cause problems if you wanted to bring in OBJs or Max files into a project you 
created with LightWave assets. Thus the global scaling has been reset to 0.01 for safety and you will need to 
apply a scaling of 1 to your LightWave objects inside Unity.


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We have added a sphere GameObject to each of the lights so they show up in the “game” as glowing globes. 
Note also that we have set each of the lights to cast soft shadows. We are using the free version of Unity so it 
rightly warns us that we can only use realtime shadows with Unity Pro, however the aim here is to bake a 
lightmap.
Select all objects and lights in your scene and open the Lightmapping window. 

 

Tick the Lightmap Static box and up the number of Shadow Samples and the Shadow Radius to get better 
quality shadows. Now hit Bake Scene . It won’t take long to bake and apply the lightmaps and you will have 
shadows applied to your scene. Be aware that if you move something in LightWave or Unity, you will need to 
bake again.
Now you can hit the Play button at the top of Unity’s interface to go into your realtime version of the scene. You 
can navigate by using the traditional FPS controls of WASD on a QWERTY keyboard or the cursor keys while your 
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mouse dictates the view. 

 

You can now use the Build Settings item in the File menu to create an executable file for Windows, Mac OSX or 
Linux, or make a web player version for your clients to look at.

If you make changes to your LightWave scene, the changes will be propagated to Unity. Remember that since LightWave 
saves objects separately to scenes you will need to save both to get any changes you make to surfacing update in Unity.

Unreal

If you follow along with this tutorial you may note you need to jump to get up the stairs and wonder why. This 
is because Unity splits the single Natural History Museum object into 27 parts to fit within the maximum of 65k 
vertices in a single object and that means that the steps get carved up too. To keep the stairs in a single piece 
that can be climbed without jumping you will need to separate them from the main object manually.


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Example - Using ZBrush to Edit Morph Maps

 Example - Using ZBrush to Edit Morph Maps

One of the most exciting uses for the new GoZ functionality is to sculpt morphs for your characters. The process is very 
simple and straightforward, but illustrating it should set minds at rest. We will use the Mangalore warrior head for this 
example, found in the LightWave content (characters\Mangalore).

We’ll add a morph map to our Mangalore head. We’ve called it Morph.Mouth_Open . Make sure it’s selected in 
your Morphs list and hit the GoZ button on the Modeler I/O tab.

ZBrush will load or open and you can draw your warrior onscreen. Use ZBrush’s Move Brush to spread the lips 
apart and hit the GoZ button in ZBrush.
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3. The Mangalore head will reappear in Modeler and you’ll notice that you are still in the Morph.Mouth_open 
morph. 
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4. Now you can create a new morph to sculpt. This time we are typing Morph.Frown . Once added, hit the GoZ 
button again.
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5. In ZBrush we brush in the frown for the model and send back. You can carry on adding new morphs and 
sculpting them like this.
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Instancing Examples
Example - Randomly surfacing Instances — Demonstrating surfacing instances uniquely
Example - Monitor Screens — Demonstrating uniquely surfacing instances
Example - Python City Block — Demonstrating creating instanced cities
Example - Building a wall with Instances — Creating blocks one instance at a time
Example - Kooky Cube Eyeballs — Using 2020's new Offset Normal function to create cartoon eyeball
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Example - Randomly surfacing Instances

Surfacing Instances

Instances can be uniquely shaded using Nodes in the Surface Editor, whether just a simple color change, or completely 
different materials. This section deals with the options you have at your disposal.

Random Colors (‘Fixed Random’ Output)

Creating random coloring of instances is done using the Instance Info node, connecting the Fixed Random output into a 
Gradient node, and then into any color channel. Setting keys at 0 and 1 on the gradient represents the total number of 
instances. An easy way to understand this is to think of key 0 as being the first instance, and key 1 being the last. Every 
instance in between is then given a randomly picked color from the 0 - 1 gradient range. This is useful so that even if you 
change the number of instances in the Instance Generator, all instances will be included in the 0 - 1 range.

The colors are picked at render time, and remain associated with the instance they were assigned to for the life of the 
instance. However if you change the number of instances, then the coloring may change as there are now more 
instances to consider.

You can of course add as many gradient keys as you like to introduce more random colors

Setting Up Random Coloring

Once you have instances setup, open the Surface Editor and click Edit Node Graph.
Add the following nodes to your flow:

Spot > Instance Info
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Gradient > Gradient
(You can add these by typing the first few letters in the search field)

Connect Fixed Random on the Instance Info node to Input on the Gradient node, and then Color on the Gradient 
node to the Color input on the Surface node.
Open the options for the Gradient node and add gradient keys at several positions in the gradient by clicking. 
Choose a different color for each key.

When rendered, instances will now have random choices of the colors you set in the Gradient node.

Absolute Coloring (ID Index Output)

The ID Index output on the Instance Info node allows you to specify exact colors for each instance using gradient keys at 
set values, whole numbers that correspond to the instance ID number. Only keys set at whole numbers will be correctly 
assigned, as instance IDs are integer values, for example, setting a key a 1.5 will not change the color, it would have to 
be set to 2 to have any effect.

Setting a gradient key to Stepped mode will continue the previous key color until you specify a new one. You can also 
blend between colors by setting the gradient key to either Linear, Hermite or Bezier modes.
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Example - Monitor Screens

A project requires you to have monitor screens showing different images. Using Instancing means it is simple to have a 
large quantity of monitor screens, but showing different images?

In order to show different images we will need to use the Node Editor for texturing. First we will create a Gradient with 
several entries. You do not need to change anything about these entries except to toggle Show Output on each key, 
change the Smoothing to Step and the Post Behavior to Repeat.
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How many keys depends on how many different images you have. We are using four for this example, so we add five 
keys - one for each image and one for the repeat. This last one does not need its output shown.
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Use a 2D Texture > Image node for each of your images and a Spot > Instance Info node. Put the ID Index output from 
Instance Info as the Input for the gradient and load an image into each Image node and send its Color output to 
appropriate Key Color node on the gradient. You can also use the Fixed Random output from Instance Info, but then you 
need to be sure the keys on your gradient are at integer values. You can of course use image sequences instead of still 
images to have a set of television screen in a department store, for example.

Using Material Nodes (Multi Switch Node)

 

Material nodes are a special case when used with instancing. You can clearly use one Material node with random 
coloring on its inputs, but having completely different materials applied to individual instances is a different matter. 
There is a special node designed for this purpose.

The Multi Switch node allows you to switch between different Material nodes based on the instance ID. Here’s how to 
set it up:

Using an image sequence works with instances, but using an image sequence copied in the Image Editor 
(instanced) fails upon scene reload. If you need to modify a sequence, then just use a new original sequence to 
prevent the failure.


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5.

Once you have instances set up, open the Surface Editor and click on the Node Editor.
Add the following nodes to your flow:

 Connect ID Index on the Instance Info node to Switch on the Multi Switch node, and then Material on the Multi 
Switch node to the Material input on the Surface node.
Open the options for the Multi Switch node and click Add Input until you have three inputs in total on the Multi 
Switch node.
Connect each Material output on the Material nodes to each successive Material input on the Multi Switch node.

If using ID Index as the Instance Info input, every instance will cycle or switch through each of the Material nodes you 
have connected in the Multi Switch node, if you want to randomize the chosen materials, add a Random Integer node 
(Tools > Random Integer). Connect the ID Index to the Seed input on the Random Integer node, then the Out node to the 
Switch input on the Multi Switch node as shown in the diagram above.

•
•
•
•
•

Spot > Instance Info
Materials > Multi Switch
Materials > Car Paint
Materials > Dielectric
Materials > Conductor


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Example - Python City Block

Creates an instant, instanced grid-based city. To use this tool here’s a simple example:

Create your base block. We’ve added sidewalks and road around our block so that we can butt the instances 
together.

On the Instancer tab of Object Properties, add Python City Block from the Add Instancer dropdown menu. In the 
City Block window first click on Active . At this point the other settings become available and you can see 
instances of your block spreading out.
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Since we have created road and sidewalk around our block we need to turn off Randomize Width and Depth 
otherwise the blocks won’t butt together with our Building Margin set to 0 m.

Add a Gradient backdrop, position your view and hit VPR. The whole scene took less than five minutes to build 
including modeling the initial block.
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Example - Building a wall with Instances

Instances are excellent, the only problem that people have is trying to manipulate them individually. It can be 
frustrating to carpet a plane with instances only to find that one is badly placed and you want to move it. Likewise to 
use instances to create an animation, but nodes give us the tools we need to address individual instances - you just 
need to address them in a more abstract way.

For our test we want a wall to spring up, one block at a time on this red circle.

To start with, we'll use our ground object with the circle and add an Instancer. We'll add our block, set it to 
Radial Array with a count of 24 and adjust Radius and Start Angle as necessary to fit our blocks over their 
corresponding red circle segments. Don't forget to use Local Coordinates for the blocks and to set the Offset tab 
to Uniform!
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Right now if we add an envelope to the Offset on Y we can have all the instances moving up at the same time, but 
we want the individual blocks to appear one by one. To do so, we need the power of nodes. Tick Use Nodes and 
then Edit Nodes.

In order to create the animation we want we will need several nodes. Start with a Constant > Scalar node that we 
can call Time. Double-click it and add an envelope by clicking on the E. In the Envelope, make the first key be at 
0.0, add a new key and move it up to 0.6. Then set the Pre Behavior and Post Behavior for both to Linear.
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Next, add a Scalar > Multiply node. This one can be called Speed. It will be used to control the speed of "building 
the wall". Draw the ID Index from the Input node into B on the Speed, and set A to 1.0.

The results from Speed and Time should go into a new Math > Scalar > Subtract node with Time into A and 
Speed into B and the result from that subtraction should go into A on a Math > Scalar > Min node. This will be our 
final height for the wall block once "built".
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The result from the Min node should go into B on a new Math > Scalar > Max node. The A value on this node 
should be to hide our blocks at the start of our animation and so wants to be a minus number: -1.5 is perfect to 
hide our wall blocks.

Finally, the result from our Max node should go into the Y value on a Tools > Make Vector node, which converts 
our heights made by the Min and Max nodes into a Y height for the offset. Take the Vector output from this node 
and pipe it into the Offset input on the InstanceGenerator destination node.
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9. If you press play now, your wall should get built like this. If it is starting too early - the first block is already in 
place - slide the Time envelope along the time, so the first key is later in the timeline. You can also experiment 
with the speed by raising or lowering the second key. It should look much smoother for you than these GIF anims 
below. You can now also play with the speed settings in A in the Speed node. If you wish the wall segments to 
come up randomly, try using the Fixed Random into A on Speed, but you will need to increase B by a large 
amount for separation, try 30.
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1.

2.

Example - Kooky Cube Eyeballs

Click here to expand Table of Contents...
Introduction
Setup
Nodes
Final Touches

Introduction

I'm going to use LightWave 2020's new addition to Instancing, the ability to offset normals. This functionality can bring 
all sorts of things to the fore but we'll use it this time just to create a pair of strange eyeballs.

Setup

We'll start by adding the TestObjects file in the content/instancing section, or you can model a cube and a ball for 
yourself. With the Ball object, go into the Instancing tab and add an Instance Generator. The generator should be set to 
Surface and Coordinates should be Local. Add 500 instances to see how it will work. Set the Scale to Uniform and the 
amount to something that is big enough to see each box, but small enough that you can have a large number. On the 
Rotation tab, set the Alignment to Normals and the Rotation Axis to Local.

Nodes

Now, we need to visit the last tab, Nodes. Check Use Nodes and we can dive into the Node Editor. Let's add some nodes, 
then sort them out. Add the following:

Item Info
Vector > Subtract
Normalize
Incidence
Functions > Boxstep
Wrap
Gradient
Scalar > Multiply

Set that Item Info node you added to be for the camera by double-clicking on it. You should take the World 
Position from it into A on the Subtract node. Take the Base Position output on the Input node into B on the 
Subtract node. This is creating a vector of the intersection of the camera and the instances. Next, we want to 
turn that information from being a set of coordinates that could be anywhere to bring them within a 0-1 range. 
Pipe the result from Subtract into the Normalize node.

Now, we will take those normalized coordinates into the Incidence node using the Normal input, as you might 
expect. From the Input node, take the new Base Y Axis output into the Vector input on the Incidence node. That 
gives us the incidence of the camera's view of our instancer. There are a couple of additional settings inside the 
Incidence node we need to take care of with a double-click on the node. The first is the Invert Alpha toggle. You 
should be able to see by toggling this switch that it will either show instances towards the camera or in the same 
direction as the camera. The second is the area covered where you have the choice of 90 or 180 °. Since we're 
going for a pupil look, let's choose 90 °. It still seems too big but we'll take care of that next.


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Next, we want to have our instances disappear when they are not within our camera's field of view. We'll do this 
with a BoxStep function. Double-click the BoxStep node, and set Clamp High to 0.5. Also, set Begin to 0.47, and 
End to 0.52 - this will create a blend between the instance being there or not. We said in the previous step that 
even 90 ° is too big so let's make our pupil smaller, then we'll hook everything up.
Take the Gradient node. We only need to set an Alpha for this so at the 0 % Marker, set the Alpha to 0 %. Add a 
new key at about 0.9. Set the Smoothing for both keys to Step so you should have checkerboards for most of the 
gradient and a block of black at the bottom. If we take the result from our Incidence node (set at 90 °) into the 
Input on the Gradient that will cut our pupil down to size. Take the Alpha out of the Gradient into the Input on 
the Wrap node we added, and the BoxStep Result output into the Function Input on the Wrap node. Now, take 
the Result from the Wrap node into A on the Multiply node, and the output into the Scale of the Instance 
Generator destination node. At this point, your instances should be quite big on the sphere so double-click on 
the Multiply node and set the B input to something like 0.3 or so.

An overview of the node network for this example, and a view of the gradient

Final Touches

We have our eyeball and when we rotate our camera about the ball the pupil moves. To make that movement easier, 
let's add a null to the scene, parent the camera to it (make sure Parent in Place is on), and then all we need to rotate is 
the null to move our camera around the "eyeball". You can then select the Ball object and use Items > Clone > Clone, or 
Ctrl-C, to have a second eye that still has its instanced pupil following the camera's position, just move it to the side to 
have the pair of eyes following the camera.
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Example - UV Aspect

Example - Different Image Aspect Ratios

We’ve loaded a simple box that is 16:9 in aspect. It goes nicely with the lighthouse picture we’ve used. The picture uses 
a UV map for placement.
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We get told we need to change the image for a square logo! If I put it in my UV, it’ll get stretched out as shown…

Turning on the new UV Aspect tool means that our square logo regains its normal shape, even though our UV map is 
16:9.

There is an options panel just to the right of the dropdown for UV Aspect:
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•

•

The Aspect Type choice is:

Borders - The image will be shrunk to fit into the space allowed (note that the type of repeat for the image - 
Height Tile, Width Tile - plays a role here)
Best Fit - The image will maintain its aspect but fill the UV space as best as possible. In our example, the width 
will fill the polygon but the top and bottom will be cut off.

Fit Height and Fit Width are used for the aspect ratio of the image. You can enter something like 16 and 9 if you like, or 
the actual pixel dimensions of the image (1920x1080).
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1.

2.

Example - Creating a Volumetric Light
Here's a simple example showing how the default light can be simply transformed into a disco searchlight with a few 
clicks.

Start with a fresh scene

Add a floor, either with a Null with a Primitive shape or a Ground Plane and turn on VPR
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3.

4.

5.

Convert the light to a Spotlight, change its size to 1m, turn on Visible to Camera and rotate it so that it is visible

Right now we see no volumetrics. To do so open Render Properties Ctrl+P), go to the Volumetrics tab and turn 
on Use Volumetric Scattering

You will see a white beam coming from the light, but let's play. Open the Edit Nodes button in Light Properties 
and add a gradient. Hook the Input Distance to the Gradient's Input and the Gradient's Color Output to the Light 
Shader's Volumetric Color. Lastly, change the only key in the Gradient to white and you'll see what you had 
before you added the gradient.
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6. For this final image, I increased the intensity of the light, changed the Cone Angle and added some keys to the 
gradient resulting in this multi-colored confection that would be impossible to create with "real" lights...

Going Further

We have just used the Volumetric Color destination for this quick example, but you can also change the color of the light 
given and even that of the light itself - need a grill over your light? Add a texture to the luminaire and light will only be 
produced where the texture is not black.
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Motion Mixer Examples
Example - Simple Motion Mixer
Example - Blending Motions with Transitions
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1.

2.

Example - Simple Motion Mixer

Using Layout Modeler tools we'll make a simple Motion Mixer scene

In Layout, select the camera. Next, on the Motion Mixer Panel click Create Actor. Enter Camera as its name and 
click OK.

When you create an actor, you are telling Motion Mixer which items in the scene you want it to control as a 
group. Scene items may be added or removed at any time and an actor can contain items of different types (i.e., 
objects, bones, cameras, and lights). However, an item can only belong to one actor. An actor may represent a 
character and its bone structure, a mechanical apparatus such as an aircraft’s landing gear, or as in this case, an 
individual item such as the scene’s camera.

The panel will begin to come to life. The Actor List pop-up menu will display the “Current Actor”, which we just 
created. If you had other actors, you could use this pop-up menu to change the current actor.

If there were multiple actors in a scene, you would choose the “current actor” from the Actor List pop-up menu. 
The current actor is the one you want to work with and the one whose tracks and motions are displayed on the 
Timeline.

The actor information display shows the number of actors in the scene and the number of items defined in the 
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3.

4.

5.

6.

current actor.

Anything in Layout with an Envelope (E) button can be used by Motion Mixer. When you create an Actor, you will 
see that a new item has been added to the Actor, called ExternalXChannels.” This is a “virtual” item to which any 
channels that are not part of an items channel group are added. There is a new entry on the Actor menu, Add 
XChannels, which will bring up a panel that will allow you to choose channels to add to the Actor. Double-click 
on a channel in the left-hand tree view to add it to the selection list.

Repeat steps 1-2 with the Cube object so that you now have two actors in Motion Mixer. Select the Camera again.

Now, let’s create a motion. Motions are segments of animation that can represent anything from a character’s 
walk cycle to a jet fighter performing a barrel roll. When an actor is active, Motion Mixer controls it. So to create a 
motion in Layout, you must first deactivate the actor. Disable Actor Active.

In Layout, keyframe the camera so that it moves straight along the Z axis from frame 0 through 40. Make a key at 
frame 20 that makes it jump up along the Y axis.

Click Create Motion on the Motion Mixer Panel. Enter Jump for the Motion Name and set the End Frame to 40, 
since that is the end of the motion we set up. Leave other settings at their default and click OK.
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7.

8.

If we had used Selected Items instead of Actor Items, the motion would come from items selected in the scene.

XChannels are non-transformation channels (i.e., any channel other than Position, Rotation, and Scale). Select 
XChannels opens a new panel that allows you to specify which XChannels will be present in the motion. You can 
toggle them on and off later in the Channel Editor.

Clear Channels removes the animation from the items in Layout - after capturing into Motion Mixer of course. 
Since Motion Mixer normally overrides and controls the motion, the animation is not usually needed. However, 
you may wish to disable Clear Channels, so you can create further motions from different parts of the same 
animation.

The actual keyframed motion of the camera has now been “sucked” into Motion Mixer. If you drag the Layout 
frame slider, you will notice that the camera doesn’t move.

The motion information display will show the number of motions that are defined in the current actor and the 
number of items contained in the current motion. The Motion List pop-up menu will display the “current 
motion”, which we just created. If the current actor had other motions, you could use this pop-up menu to 
change the current motion - this is the motion you are working with.

We can now add a motion to the timeline. Click Add Motion on the toolbar and then click on the 00 Timeline slot 
at frame 25. This will add the motion to the timeline.
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9.

10.

11.

If you want to cancel the operation, prior to clicking in the Timeline, click in an empty area of the panel, outside 
of the Timeline display. To remove a motion from the Timeline select it, hit the RMB and select Remove from the 
menu that appears

Enable Actor Active.

Drag the Layout frame slider. Motion Mixer is now in control and moves the camera. You can reposition the 
motion by dragging the center of the motion bar. You can scale the motion by dragging either end of the bar to 
resize it. The range and scale of the motion will be displayed at the bottom of the panel.

That’s it for the Camera, apart from to make it target the Cube. With the Camera selected, hit M and choose the 
New Cube Object as a target.

Now we’ll get the cube doing something. Set a keyframe at 50 having moved the cube along the X axis. Then at 
each ten frames between, rotate the cube a little this way and that on the Pitch to give it a nice waddle.
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12.

13.

We’ll suck that motion into Motion Mixer like we did the Camera jump by choosing Create Motion and naming it 

Waddle.

Let’s do another. Keep Actor Active turned off and this time go to frame 10 and hit Return twice to make a key 
without changes, then go to frame 5 and raise the Cube up a bit. Call this motion Bounce.
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14.

15.

Now, make sure both actors are active, and add the Jump motion for the camera at frame 25. The camera will 
just follow where the cube goes and jump over its path, all the while keeping it in view.

Add Waddle to the Cube’s timeline, by having it visible in the Motion List, clicking Add Motion and placing it at 
frame zero. We want the cube’s motion to continue through our animation, so right-click on the motion in the 
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16.

17.

timeline and choose Add Post Behaviour. A small gray bar will appear after the blue bar of the motion and you 
can stretch this out with its handle to reach frame 150 (past the end of our scene). The gray bar will have 
Constant written on it, but right-clicking will allow you to change this to Offset Repeat, which will continue the 
motion of our cube.

Now swap the Motion List to our other motion, Bounce and add that to Timeline 01 a couple of times. My first 
was at about 30 and the second about 70. The only problem with our Bounce motion, as you’ll see when you hit 
Play, is that because our cube didn’t move along the X when we made it, every time it gets to a Bounce when we 
play, the cube jumps back to X=0!

To prevent this from happening, select the first Bounce in the timeline and click on the Channel Editor button at 
the top of the Motion Mixer window. Select the motion and then turn off every channel apart from Y, do the same 
for the second Bounce. Now the cube continues on its way bouncing at a couple of intervals.
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18. We’ll show you something else with the camera. With the Actor still active, go to the last frame in our scene (120) 
and move the camera along the X-axis, as though it’s tracking our cube. Again, we’ll have the same problem 
when the camera jumps, so use the Channel Editor again to remove channels from the Jump motion.
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1.

2.

3.

4.

5.

Example - Blending Motions with Transitions

  

We’ll start by loading ProtonJack again. Apart from the walking and running, we can make him look right and 
slow back to a walk using Motion Mixer. Make the end of the scene 250 frames so we have a bit more time for our 
extra stuff.

Already we can see there’s a transition between Jack walking and running. It is represented by the gray bar 
between the two motions. Let’s slow Jack down again. Change the Motion List to read Jack_Walk and add it to 
timeline 02 at frame 175. If we hit Play now we can see that Jack resumes walking, but it’s not a smooth switch 
from running to walking. 

Select the short blue Jack_Run Motion on timeline 01, click Add Transition at the top and then click on the 
Jack_Walk:01 you added to timeline 02. You can move the Jack_Walk:01 forwards and backward in time to get 
the transition you want.

Add a Post Behaviour to the Jack_Walk:01 motion and set it to Repeat. Make it last to the end of the scene and 
now your dog should start off walking, start running, then go back to walking in a loop. If there’s a slight hiccup 
just move the Jack_Walk:01 forwards or backwards a little on the timeline until the keys match up.
Press Layout’s Play button and watch the movement of the dog. During the frames controlled by the transition, 
the dog’s gait is interpolated to line up with the start of the second motion. You might notice that the movement 
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between the motions is quite abrupt. This is because it is a linear interpolation curve by default. For a smoother 
blend, read on.

Right-click on the transition bar and choose Edit Transition. This brings up the Graph Editor and the transition 
should be listed as an animation channel.

The vertical range of the curve represents the percentage of transition. For example, a value of 0% means 100% of 
the start motion and 0% of the end motion, 60% means 40% of the start and 60% of the end, and so on.

The horizontal axis, which is normally frames, represents how far through the transition you are - not the range 
of frames in the transition. For example, 0 means the start of the transition (i.e., 0%) and 100 means the end (i.e., 
100%).

Ignore the time slider in the curve window, if you’re scrubbing the animation in Layout. It does not reflect the 
position within a transition.To smooth out the transition, you simply set the Tension to 1 for both Incoming 
Curves (they are both TCBSplines). You can do this quickly by selecting both keys and right-clicking one of 
them and selecting Ease In/Out from the pop-up menu.

Of course, since this is like any other curve, you can add more keys, use different Incoming Curve options, and 
so on. However, the first and last keys should always be left at 0 and 100. If you add new keys, only add them 
between 0 and 100 or you will likely get unpredictable results.


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Node Examples
Example - Getting Started with Nodes
Example - Displacing Primitives
Example - Simplifying the Benchmark Marbles nodes
Example - Surface Side — Very simple surface side demonstration
Example - Ray Type Switch
Example - Shadowing Options with Edges — An example that shows use of the Mesh Element Switch and Ray Type 
Switch nodes to control shaded edge shadows
Example - Inside RayCast
Example - Layer Material Components — Creating a realistic soap bubble
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1.

2.

Example - Getting Started with Nodes

Let’s begin our exploration of the Node Editor, its interface and general use by performing some of the everyday tasks it 
was designed for. Pay close attention as we step through some of the simple operations used in common node based 
texturing. There will be a few hints and tips not covered elsewhere in this manual.

The object of this tutorial-style instruction that we are about to start is primarily to familiarize you with the process of 
working with nodes. We will be focusing more on mouse and keyboard operations and the way the Node Editor handles 
itself in use rather than the actual texturing techniques involved in the steps we’re about to perform.

Open Layout and add a Ground Plane using the Modeler Tools tab. You don’t need to make any changes to the 
settings so click OK. Next, start VPR by choosing it from the Viewport Display menu or hitting Ctrl-F9, then hold 
down Shift and click on the ground plane you made in the rendered view to open the Surface Editor.

Double-click on the Ground Plane surface in the Surface Editor to open the Node Editor. Take a little time to 
arrange opened windows/panels in a configuration so that you can still see the VPR render in progress. Don’t 
forget you can always hit Tab to hide all windows and just show the Layout screen. 

A good idea to perform any time you start a new surface is to create a new Preset Shelf Library. Open the Presets 
Shelf by hitting F8 and create a Library by right-clicking in the main area of the Surface Preset window and 
selecting Create Library from the Library submenu. Give the library the name you like.
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3. Add Grid2D from the 2D Textures group on the left side of the Node Editor by double-clicking on its name. If you 
are working with the Embedded Edit Panel Extension Area open the properties for the Grid2D node will be 
displayed on the right-hand side of the Node Editor window. If it is not, just press enter or double click the node 
to open its floating edit panel. The only thing we want to change in this panel is the Mortar Sharp value which 
we will set to 99.0% and the Axis which we will set to Y by clicking on the Y button in the same panel.

Clicking Undo at the top of the Node Editor window, we will notice that the Grid2D node is removed from the 
Workspace area - meaning that the Undo and Redo functions respect only Workspace area actions, which is 
good to bear in mind as we work with the Node Editor interface. 

Press Redo to get back the Grid2D node noticing that the 99% and the Y axis settings we entered before the undo 
operation are still intact.
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4. The Node Editor is set up with a logical flow construction from left to right. The colored dots and labels on the 
left-hand side of any node are that node's inputs. Any dots and labels located on the right-hand side of a node 
are that node's outputs. Inputs receive information from other nodes in the network while outputs send 
information.

Let’s see how this works by connecting the Grid2D's Color output to the material node's Color input. 
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Place your mouse cursor over the red dot labeled Color on the right-hand side of the Grid2D node. Now perform 
a click and drag operation toward the Surface destination Node’s Color input dot. As you drag, an arrow-headed 
line will extend and follow your mouse cursor movements. 

Notice that as your mouse moves into the body area of the Surface node that the arrowhead remains snapped to 
the input at the same latitude as your mouse cursor and not until your mouse cursor moves past the Surface 
node and emerges on the other side does the connection arrow unsnap and again begin following the mouse 
cursor. Position your mouse so that the arrow connects to the Surface nodes’ Color input and release the mouse 
button to complete the drag operation.

As you release your mouse button with the arrow connected to the Color input of the Surface destination node 
you will notice that the VPR display automatically renders the view of the floor object with the newly applied 
Grid2D procedural texture applied.

Add a preset for your surface in the Surface Editor.
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5. Click on the Grid2D node to select it, and press R. Enter the name "Mixer Mask" into the Rename Node requester 
that appears and press Enter. Renaming a node has no effect on its function but is useful for keeping track of 
what nodes are doing and the role they play in a network. The Node Comment Entry Area at the bottom of the 
Node Editor panel can also be used in this way. Whether either or both are used is a simple matter of user 
preference. With the node still selected click in the text entry area and enter some descriptive text such as: 
“Grid2D - Main Mask Mixer node defining the basic floor pattern” and press Enter when finished.

Collapse the newly named Mixer Mask node either by selecting it and pressing Shift-C or by clicking on the 
collapse toggle button in the node's title bar.
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6.

7.

Add the Parquet2D node from the 2D Textures group. Open its floating Edit Panel (Enter or Double Click) or use 
the embedded edit panel area to modify the following values:

Change U Tiles to 10, V Tiles to 10, and change the Axis to Y.

Now drag the Color output from the Parquet2D node to anywhere over the top of the Mixer Mask node and 
release the mouse button to finalize the drag operation.

Notice that dragging over the top of a collapsed node pops up an input selection menu.

Select BgColor from the menu and then expand the node either by pressing Shift-E or by clicking on the node's 
collapse toggle button.

You will also notice that VPR has again automatically updated with the new surface information.

Again double click on the Surface Editor preview display area to add a second preset to the preset library we 
created earlier. You can come back to this point in the texture creation anytime you may need to by double-
clicking on the icon in the surface preset window.

Let’s try that now by double-clicking on the first icon you created, answer yes to the requester that appears, and 
look at the Node Editor Workspace area. Now click on the second preset you made, answer yes to the requester 
that appears, and we should be exactly back where we started before double-clicking on any of the preset icons.

Next, hold down the control key while right-clicking anywhere in the Node Editor Workspace area. You should 
see a popup menu that looks exactly like the Add Nodes menu at the top left of the Node Editor window. 

Select Planks2D from the 2D Textures submenu to add that node to the Workspace area.
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8.

Connect the Color output from the Planks2D node to the Fg Color input of the Mixer Mask node and then edit 
the Planks2D node as we did the others before modifying the following values:

Set Mortar Width to 10%.
Set Mortar Sharp to 80%.
Set both U Tiles and V Tiles to 20.
Set the Axis to Y

Set the Heading to 45° in the Rotation tab.

Taking it one step further, let’s add bump to the Parquet and Planks parts of the node network. Here you will see 
that node outputs don’t always have to go to the same colored inputs. Add a Mixer node to your network by 
starting to type in the search field at the top of the node list. 
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Take the Bump output from the Parquet2D node and put it into the Bg Color input of the Mixer node. You’ll 
notice that the Bump output is blue, but the Bg Color input is red. The two connect all the same. Do the same 
with the Planks2D node to the Fg Color input on the Mixer. Lastly, add the Alpha output from the Grid2D node 
(now called Mixer Mask, remember) as the Opacity and take the Mixer’s Color output into the Surface node’s 
Bump input. You should now see that the planks and parquet have a subtle bump.

How does this work? A vector-type output supplies three channels of data (vertical, in-out and lateral). In the 
same way, a Color output also provides three channels of data (Red, Green, Blue) and all we are doing here is 
translating one to the other. The other potential connections are explained in detail here.
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9. You should see the lines of an uncolored wooden plank and parquet floor. The technique that is involved here is 
simple. The procedurally-generated Alpha channel of the Grid2D texture is being used to mask and contain each 
of the two patterns added to its foreground and background color layers respectively.

Go ahead and add another preset to the preset shelf.

On your own go ahead and try to add some wood grain and color the surfaces appropriately.

In conclusion, we saw the most common user operations for working with nodes in the Node Editor and explored 
several ways to achieve each one. Additionally, users new to node-based texture editing should have been able to 
glimpse some of the underlying power that node-based systems offer and how much easier they are to use.
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1.

2.

3.

Example - Displacing Primitives

The new Primitives are superb for creating instant geometry for scenes. They can also have displacements applied to 
make that geometry more interesting like so:

Create a Null and use its Properties panel. In the Primitive Type dropdown, switch from Mesh to Shape and 
choose Plane.

We're going to use an image for the displacement, but you can use a procedural texture. We will use this image 
of a landscape for our displacement.

To go for a more stylized look and to make any issues more obvious), we'll posterize this image in an image 
editor to create very obvious separations between contours (download this image from the wiki and drag it into 



LightWave 2020  –  LightWave 2020

Appendices –  3235

4.

5.

LightWave to follow along).

By default, the Displacement Height in the Object Properties is set to 0.05 and we'll leave it there for the time 
being. Switch to VPR and shift-click on the plane, then double-click the surface name in the Surface Editor to 
open the Node Editor. We can add an image node for our image and draw the Luma output from the Image to 
the Displacement input on the Surface Destination node.

You'll see that the displacement works, but seems to make layers of texture, rather than a solid displacement. 
Even at 0.1 displacement height you will often find similar effects.

The way to resolve the problem is to reduce that 0.05 to a lower level. It can be done directly in the Object 
Properties panel, or you can add a simple Scalar Multiply node to achieve the same effect in a more controllable 
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way.
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1.

2.

3.

4.

5.

Example - Simplifying the Benchmark Marbles nodes

We’ve loaded the Benchmark Marble scene included with the content. It’s a deliberately complex scene designed to 
torture your processor to find out how fast it is. Most of the surfaces are fairly simple, based around the Dielectric
Material node, but the floor is a bit more abstruse.

My Node Editor has to be at 61% magnification to see all those nodes. Let’s simplify.

Select all the nodes apart from the Scalar node at the start and the Surface node at the end and Copy them (Ctrl
C).
Add a Compound node from the Tools group. Double click on the new Compound node and you will enter a new 
Node Editor for that Compound. Here you can paste the nodes you copied. Select the Material output from the 
CarPaint material at the end of the node network and plug it into the Output node in the Compound node editor, 
where it says New .
Double click on the output node in the Compound node editor to return to the main node editor. The original 
nodes are still there because we want to have a control for this compound, that of Scale.
Drag the output from that first Scalar node to the New input on the Compound node. You will see it changes to 
Scalar and a second New node is added. Take note of where scaling is applied in the network, it is Input A on the 
Divide node, Scale on the Checkerboard node and Scale on the Grid 2D node. If you double click on the 
Compound node you will see the Input node now says Scalar and you can make the same connections.
Finally, you can delete all the nodes in the main node editor with the exception of Surface , Compound and 
Scalar.
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The image on the left is inside the Compound node. Note the lack of a Surface node and the title bar saying Compound. 
The image on the right is back in the main Surface for the Ground and you can instantly see how much simpler it is than 
originally.
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1.

2.

Example - Surface Side

Very simply, for creating surfacing for both sides of a polygon, you need to use the Surface Side output. It is an Integer 
switch, with 0 representing the side with the normal protruding, 1 for the side opposite the normal and 2 for the back of 
a double-sided polygon.

Create a mesh Ground Plane object. It will have the Principled BSDF material by default. Make the Color red.

Double click on the surface name in the Surface Editor to open the Node Editor, copy the Principled BSDF node. 
Paste it back in and change the color to blue.



LightWave 2020  –  LightWave 2020

Appendices –  3240

3. In the Material Tools section, choose the Switch node. Take the Material out from both materials and input them 
into True and False on the Switch node.
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4.

5.

From the Input node, pull the Surface Side output and attach it to the Switch's Switch integer input.

Take the Switch Material output and attach it to the Surface Material input. Lastly, ensure that Double Sided is 
checked in the Surface Editor.

Now, in VPR, when you rotate the plane to see both sides, you will note that one side is blue, one red.
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Example - Ray Type Switch

The Ray Type Switch node allows you to surface items differently depending on how they are seen by the renderer. Here 
is a very simple example to show it in action.

We have a red cube, a reflective cube and a glass sphere. You can just see the red cube in the refraction on the sphere 
(and if you're really sharp-eyed, a reflection of the sphere in the reflective cube).

We'll now adjust the surfacing for the red cube:



LightWave 2020  –  LightWave 2020

Appendices –  3244

To start with we just hooked a Ray Type Switch node between the Standard material and the destination Surface node. 
We used the Distance Input, which returns the "standard" rendered output.

On the Input node we hooked Ray Type to the appropriate input on Ray Type:

For this example we are merely going to duplicate the red cube's standard node, but change its color to show the effect 
clearly. The copy named Reflection is green, that named Refraction is purple. Hooking them to the appropriate inputs 
on the Ray Switch node doesn't seem to have an obvious effect:
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If we move the red cube between the two other objects, things become clearer:
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Example - Shadowing Options with Edges

The new edge options with Ray Type Switch bring a new level of artistic control for the user.

By default, negative value edges (those with a Particle/Line Thickness with a negative value) will cast shadows into the 
scene because they have a “physical” size and you have selected Surface Shaded Edges. If you do not wish to have 
shadowing for your edges, the solution is to edit the nodes for your edge surface.

In the Node Editor, we can see the nodes currently set up to provided shading for the edges.
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The two PBSDF nodes are providing the blue color for the polygons and the vivid red for the edges. Both are being piped 
into the Mesh Element Switch node and that is going into the Surface destination node. If we want to remove the 
shadow from our edges we need to play with the rays hitting our cubes, so we'll add a Ray Type Switch node. Take the 
Ray Type output from the Input node and bring it into Ray Switch.

To get rid of the shadows, we need to create a transparent node and pipe it into the Shadow input. For this it suffices to 
make a copy of one of the Principled BSDF nodes we have already used, and turn Transparency up to 100 %.

We add that node to the Shadow Ray input on Ray Switch, and use the Red PBSDF node in the Default input. The Ray 
Switch output goes into Edge on Mesh Element Switch. Now we have our dimensional red edges, but they cast no 
shadow on our cubes.
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1.

Example - Inside RayCast

 
With Inside you can create an intersection between geometry and instances where only the instances inside the 
geometry render. To make things clearer, we will refer to the geometry object as the Host and the instanced object as 
the Block. The Inside output is binary in nature and based on the pivot point of the Block - if the pivot point is inside the 
Host, the Block will appear. If the pivot point of the Block is outside the Host , the instance is not visible. It is very easy to 
set up as this example will now show.

Our example starts with two objects as shown in the image. Our Host is an abstract heart object called Squishy, 
the Block is a simple cube. We’ve visited the Edges tab in Object Properties and ticked Other Edges and set the 
color to white so that when the cube is repeated you can still see the individual cubes.

The first thing we’ll do is add a pair of objects to our scene. These will be the host object and the block that will 
recreate the host. There is no restriction of how your objects should be, but the host should definitely be much 
bigger than the block.
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2.

3.

•
•

Add a Null to the scene with Ctrl-N. Go into Object Properties for the null with the keyboard shortcut P and go to 
the Instancing tab. In here, add the block object and create a rectangular array with it. We have set ours to 20 x 
20 x 20. Set the Scale mode to Uniform.

Go into the Nodes tab in the Instancing window and add the following:

RayTrace > Ray Cast Geometry
Gradient > Gradient
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1.

Connect the Base Position from the Input node to Ray Origin on the RayCast Geometry node; then double click on 
the RayCast node to choose the item you wish to use. For us, it’s Squishy that is our Host object. Connect the Ray 
Cast Geometry’s Inside output to Input on the Gradient and set the Gradient up as follows:

Key at 0 - black Key at 1 - white (and set the Smoothing to Step)

Lastly, take the Color output and bring it into the Scale input on the InstanceGenerator end node.

Now when you have a look in OpenGL you should see your Host object filled with the Blocks. The ones that seem 
to be outside the heart still have their pivot points inside the Host. 
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2. If you really don’t want to see your two objects in OpenGL you can hide them, but it’s more important to only see 
the Blocks in the render. Here we have VPR with both the Host (Squishy) and Blocks (Cube) unchecked in the 
Render column in the Scene Editor, but both are still visible in OpenGL.

Going Further

This is a very powerful technique. The Host object can be deformed or moved, rotated and scaled without issue and the 
Blocks will follow (you may need to go forwards and backwards a frame), however it will severely slow down the 
program with large numbers. It would probably be better to use an MDD-scanned version of animation in order not to 
have too many evaluations going on.
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1.

2.

Example - Layer Material Components

Layer Materials can be used to create several texturing effects that would otherwise be difficult to achieve. In this 
tutorial we will create a soap bubble - not something we could attempt before this version of LightWave.

We'll start with a 1m sphere with lots of polys - it's best to use Tessellation for the creation. 

We'll set up the scene to show off our bubble by adding a ground plane and a sky. Start by creating a ground 
plane object with either a modeled object that should be at least 10m x 10m, a Layout Ground Plane from the 
Model menu, or a Ground Plane primitive added by creating a null and changing it from a Mesh primitive type to 
a Shape, and then changing the Shape to Plane and setting the Radius to 5m. 
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Then, go into Backdrop Effects ( Ctrl F5 ) and add the SunSky (Hosek-Wilkie) environment. Go into the Sunsky 
panel and set the scene's default Distant Light as the Item for the sun, and a Max Luminance of 1.8. We also need 
to add an Environment light to bathe our bubble with light. 

Using an Environment light means we need to make some other changes to our scene, so let's step through 
those quickly -
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a.

b.

c.

3.

Go to the Surface Editor (F5) and select both the sphere and the ground plane surfaces. Go to the Shading 
Model tab and set both Reflection and Refraction Options to RayTrace Only

Go to Render Settings, Global Illumination tab (Alt P) and turn off Sample Backdrop

In the Environment Light settings, make sure Visible to Camera is checked, otherwise the sky will be black 
seen through the bubble.

Add Layer Materials, GGX BRDF, Specular BTDF and Fresnel Dielectric nodes to your network, as shown. 
Change the Roughness of the GGX BRDF to 8 % and set the Refraction Index for the Specular BTDF to 1.0. With 
VPR on, you should see a pretty thin-walled bubble.
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4.

5.

To really sell the bubble we need three things - Double Sided needs to be on to better simulate the thin-walled 
nature of our sphere, iridescence and an odd shape. The first is easy. To get the other two, we'll add some more 
nodes. Add a Fresnel Iridescent and a Fresnel Multiply, then hook up your existing Fresnel Dielectric to Input B 
on the Fresnel Multiply node; Fresnel Iridescent to Input A. VPR should be looking really no different at this point, 
but that's because our Fresnel Iridescent is set with an Iridescence of 0 % - put it to 100 %. It still won't look 
much more interesting.

Change the Render mode to Specular Direct to get a better view of the iridescence. Open the Fresnel Iridescence 
panel and raise the Thickness setting little by little with the mini slider so you see the colors of your bubble shift 
through the spectrum. As you get past 3 or so, you should start seeing the spectrum begin to repeat and if you 
put the Thickness setting to around 30, you should have a nice quantity of repeats. 



LightWave 2020  –  LightWave 2020

Appendices –  3257

6. Now, let's add the deformity we're looking for. Add a standard (3D) Turbulence node to the network, and hook 
the Alpha to Displacement on the Destination node. In Object Properties, in your Modifiers list, turn Surface 
Displacement on and set the value to 150 mm. This should give your bubble a nice wobble and make the 
iridescent pattern swirl and loop around

The bubble doesn't look very interesting in the wiki, but will be far more impressive on your machine - and 
impossible in earlier versions of LightWave 3D.
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Mauro Corveloni has very generously given us the scene used for the Welcome to LightWave 2019 image as 
content. If you load it, you'll see how he used Layer Materials to create his beautiful bubbles.


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Example - Shadow Catcher: Environment Mapping
The difference between Backdrop Image and Environment might need a little explanation. We have loaded the TRex in 
the Garden scene from the content to show the difference.

This scene was originally provided in the LightWave 11 content, so say Yes to this requester and create a folder for the new 
version of the scene to protect the original. The Occlusion II node needed for the original scene no longer exists so say No 
when prompted.

To prepare our scene to show the difference between Backdrop Image and Environment we are going to start by 
making sure the Color Space settings are correct for 2019.

Next, we will turn off GI so only direct light is used. Hit Ctrl-P to open the Render Properties panel, go to the Global 
Illumination tab and Disable GI.
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If we now engage VPR you should see the TRex lit from overhead with most of the dino in shadow. To make things 
clearer we will also change the surfacing for the dino. Shift-click on it in the VPR window to open the Surface Editor with 
the correct surface selected. Change the Material from Standard to Principled BSDF and in the Shading Model tab turn 
on Glossy Reflections.

Right now, we are seeing a reflection of the front-projected backdrop image in the underside of the TRex, the green 
tinge is the grass, but because this image is flat there's nothing above the TRex for the "sky" to be reflected in its back. 
The Textured Environment in this scene (that basically wraps the same backdrop image around the scene spherically) is 
responsible for the reflections in the flanks of the dino, but these reflections are in no way accurate since they are just 
the backdrop image wrapped around. To get better reflections, we need a light probe

If we switch the Shadow Catcher's Backdrop Mode to Environment now, we won't see much difference, but that's 
because we don't yet have an environment apart from the black backdrop seen in the Effects panel (Ctrl-F5).

xxx
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•
•
•

Example - Volumetric Primitive Emitter
Introduction

Emitter
Volumetric Primitive

Introduction

To create a smoke plume in 2018 requires a little more work than HyperVoxels in 2015 and before, but the results can be 
spectacular. To start with, you will need to create your first particle. Make a null, call it HV and in the Object Properties 
panel set the Primitive Type to Volumetric Primitive. If you switch to a VPR view you will see a black ball with slightly 
indefinite edges.

Emitter

Next, we'll add our emitter to the scene. So come back out of VPR and use FXTools > Add Emitter. This will add a new 
null called Emitter. Match your settings to these:
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That should get you something that looks like:
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Volumetric Primitive

Switch to your HV null and change Emission to a mid-gray and set Texture Mode to Non-Pyroclastic. Now we need to 
set up the nodes for our HV. Start by adding a Turbulence node and dragging its Color output to the Emission input on 
the HyperVoxel Primitive node. Change the settings as follows:

If you move your view around the volume you'll see the enormous amount of detail it has throughout. Let's link it to the 
emitter we made. To do so, simply switch the Source item for the HV to Emitter and you'll see that you now have a 
plume of smoke.
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Unlike HyperVoxels of old, you can fly into the smoke without the huge increase in render time and playing with the 
gradients can turn your cloud into a fire...
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1.

2.

Example - Starting with HyperVoxels
This exercise gives you a quick hands-on feel for how to use HyperVoxels. 

Add a null object to an empty scene in Layout.

Before you do anything else, open the new Volumetrics panel with Ctrl-F6 or through Render > Render 
Properties and switch to the Volumetrics tab. Check Use Legacy Volumetrics otherwise you won't see any 
HyperVoxels. Also, to make things clearer in VPR we have changed the Backdrop from its normal gradient to 
black.
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3.

4.

5.

Open the Effects window by clicking Backdrop and then switching to the Legacy Volumetrics tab.

Open the HyperVoxels Settings Panel by double clicking on it in the list.

On the HyperVoxels Panel, double-click on the null in the list window. This will activate HyperVoxels for this 
object. A check will appear to the left of its name. (You could also select the object and click the Activate button.)
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6.

7.

8.

Object Type should be set to Surface. When you activate an object, the automatic size function is performed. The 
value 1 m should appear in the Particle Size field.

Turn on VPR. You should see a rather dull ball in VPR - of course it’s a lot more interesting than a rendered null.

Change the Particle size to 3 m. The ball will be larger in VPR. Click on the HyperTexture Tab. This is where you 
define the surface texture - essentially the terrain of the surface. Select FBM from the Texture pop-up. Notice 
that this is similar to setting a surface procedural texture.
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1.

2.

3.

4.

Example - HyperVoxel volumetrics
This exercise will give you a flavor of some of the volumetric features.

Using the HyperVoxel from the previous example, change the Object Type from Surface to Volume .

Go to the HyperTexture Tab and select Turbulence as the texture. You should now see a nice wispy volumetric 
cloud. This object is totally three dimensional. You could fly the camera into it and continue to see all of the 
details. 

Let’s add some color. Go to Shading Tab > Basic Tab and click the Color Texture button.

Change the default Layer Type to a Gradient and use Local Density as the Input Parameter. This will apply the 
gradient based on the density of the cloud.
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5. Create three keys: blue, yellow, and red, top to bottom. To create these keys, just click in the gradient bar and 
then adjust the appropriate Color. You will see VPR updating as you make changes. Click Use Texture to close the 

panel when you are done.
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6.

7.

8.

The options on the Shading > Basic Tab control the basic look of your volumetric HyperVoxel. You can adjust the 
color, luminosity, opacity, and density. The lower half of the tab controls the fractal look of the object. Try 
playing with the settings to see their effects.

Click on the Advanced Sub Tab. As you might expect, this tab contains more advanced options. Included are 
options to define how the HyperVoxel object is lit, as well as self-shadow options.

Try playing with the various settings, including the Sprite Mode.
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1.

2.

3.

Example - Blending HyperVoxel Objects
This exercise shows how different HyperVoxel objects can interact with one another. 

Add three null objects to an empty scene in Layout. Check Use Legacy Volumetrics in the Volumetrics tab of 
Render Properties.

Move Null (1) to Y = 1m and Null (3) to Y = -1m.

Choose Backdrop and switch to the Legacy Volumetrics tab to add HyperVoxels and double click to open its 
panel and activate HyperVoxels for all three objects.
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4. Switch to VPR mode using Ctrl-F9, or the viewport mode dropdown at the top of the viewport. Select Null (1) and 
choose New Group from the Blending Group pop-up menu on Geometry Tab. Accept the default name Blend 
Group (1) by clicking OK. For each HyperVoxel set the Blending Group to Blend Group (1) and the Blending Mode 
to Additive (Geometry Tab). By placing all of the HyperVoxels in the same group, they can interact with each 
other.
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5. Try changing the Color (Shading Tab > Basic Tab) of each null and giving them Texture (HyperTexture Tab).

Null (1) has the Turbulence HyperTexture and Null (3) has Ripples
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1.

2.

Example - Curve to Spline and Spline Instancing
In a very bling example, our client wants their name to appear in diamonds. We have created similar scenes with 
Flocking before, but now let’s use Curve to Spline and Spline Instancing for a similar effect.

Starting in a vector drawing package we will create our logo and export it as an EPS file.

Bringing the EPS into Modeler we will use the Spline Curves option and the Rough Curve Division Level will be 
plenty. Use Layers > Connected to Lyrs to split all the characters onto their own layers. Because we have 
imported splines, the centers of letters and dots on lower case Is will be separated. If you are using a script font, 
the text will come in as though joined, but you may well want to Kill Polygons and recreate the spline as a single 
loop.
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3.

4.

Name all the layers of your object to make things easier. For each object making the logo we will want an object 
to instance. For our example, use the Gemstone tool to create a new layer in our spline object.

Save the object and send it to Layout. In Layout use Setup > Edit > Curve to Spline to convert your curves into 
Spline Control splines. If the Bone icons are too big, hit D to enter Display Options and change the Bone Icon 
Size.
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5.

6.

Get Properties on your Spline objects and add an Instancer. In the Instancer choose the gem to Instance and set 
the Instance Type to Spline. Choose a number of instances that seems right for the letter and check Distribute. 
You’ll want to mess around with Scale and Rotation to give a more random appearance.

By default, an Instanced object is set to World Coordinates and we will use that to our advantage to create an 
implosion where the diamonds come together to form our word. At frame 0 move the instanced object away 
from 0, 0, 0. At after the delay you want, say 60 frames, move it back to 0, 0, 0. This will form a cloud of diamonds 
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that come together to create your logo.
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1.
2.
3.

4.

5.

6.

Example - Setting up a QuickTime VR Scene

To set up a basic QTVR scene:

Add two null objects to an empty scene, named Pan and Tilt.
Set the scene length to 400 frames.
Parent Tilt to Pan and parent the camera and light to Tilt.

Deselect the Camera's X and Y motion channels, as well as all the rotation channels. Moving the camera on Z will 
determine its distance from the actual object necessary for proper framing. All other camera motion is done with 
the Pan and Tilt nulls.
At this point, you should decide how many rows, columns, view states, and animation loop frames you want. 
Here, we will use the defaults presented in the VR Object Settings tab.

It is best to start on the innermost loop first. Since we’re using the defaults of 20 Pan frames and 20 Tilt frames, 
with no extra animation loop frames (Frames Per View is 1), the inner loop is the pan motion.
To start this inner loop, create a keyframe for the Pan object at frame 20, with the Heading at -360 degrees. Set 
the Post Behavior to Offset Repeat to continue the rotation to the end of our scene.
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7.

8.

Our Tilt motion curve should look more like stairsteps than the perfect line of the Pan Heading curve. To be more 
specific, Tilt’s Pitch Angle curve should be stairs of a height of 9.47 degrees, and a width of 20 frames, going from 
90 to -90 degrees. Fortunately for us, this is easily achieved.
In the Graph Editor, set the key at frame 0 in Tilt’s Pitch channel to a value of 90 degrees and create a key at 
frame 20, with a value of 80.53 degrees (90-9.47). Set the Incoming Curve to Stepped, and the Post Behavior to 
Offset Repeat. 

The camera motion is now complete. You can save the scene as a basic QTVR template that can be used with any 
object. If the object is off-center, it should be moved. The object should fit in the frame of all the views, so it is 
important to check the ends and middle of the animation, but only set the Z keyframe position at frame 0.

Try adding an object and follow the preceding steps to create your own QTVR animation.
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Example - Custom Buffer
LightWave offers a lot of different buffers to output your work for other applications but for those situations where the 
standard buffers just don't cut it, here's a way to make more specific ones.

World Position

For our example we need a world position buffer for depth of field and motion blur purposes but LightWave doesn't 
offer one out of the box. Here's our scene with the Buffers tab of Render Properties open, looking for a World Position 
buffer. Let's add one.
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Go to the Edit... dropdown menu and choose Create Custom Buffer. We named ours World Position and thus it is at the 
end of the Extra buffers list. Once added check the buffer so that it appears in renders. You won't need to do this to 
make use of the buffer, but you won't see its results if you don't.

Now go to the surface for the object for which you need a world position, in our case we'll get it for the toroid shape. 
Open the Node Editor by double-clicking on the surface name.

As you can see, the surface is already quite complex, but what we want to do is take the output from Input > World 
Position into the new World Position input on our Surface node.

You won't notice any difference in VPR to start with, the VPR render will seem the same; but if you switch the new 
render mode dropdown from Final_Render to your new World Position buffer you will see this:
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Example - Light Group
We'll start with our scene. There are three groups of lights over the table.

We'll take that center group and change the lights to blue and make them stronger to show the effect better.



LightWave 2020  –  LightWave 2020

Appendices –  3283

There's a definite blue tinge to the table now, but it's not very clear how the lights in the center contribute. If we add 
those lights to a group of their own, then we can separate their contribution from the other lights over the table. To do 
so, go to Render Properties (Ctrl-P) and the Buffers tab. In the Edit... dropdown menu choose Create Light Group...

Name your group, we chose Blue.

Then selecting the lights that will belong to this group, choose the group name from the Buffer Group dropdown.
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The result will still look the same if you choose final render, but now additional buffers are available in the Buffer 
dropdown menu. Choosing Direct_Diffuse will give us this render with all the lights apart from the ones in our group.

You will see there is also a buffer at the  bottom of the list called (in our case) Blue > Diffuse_Direct. That will give you 
the diffuse direct contribution solely of the lights in our light group.
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This gives an incredible amount of power to customize our image. If the art director decides that actually, that middle 
group of lights should be deep red instead? Rather than having to commit to a costly new render you can simply adjust 
the hue of this light group's contribution to the final image in a fraction of the time.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=EQYgsnQO2Dc

https://www.youtube.com/watch?v=EQYgsnQO2Dc
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1.

2.

3.

Example - QuickBolt QuickStart

To provide you with a flavor of the QuickBolt workflow we are going to make a standard 1" UNC hex nut and bolt as 
shown in the above image. The bolt will have a shank and there will be a chamfer on the upper surface of the head and a 
shoulder on its under surface. The nut will have chamfers on both the upper and lower surfaces.

Start the QuickBolt plugin and click on the "Reset To Defaults" button to make sure all selections are cleared 
and all values are returned to their defaults.
On the Presets tab, select UN from the Thread Type dropdown and Coarse from the Coarse/Fine dropdown. 
From the Thread Size dropdown select 1 (i.e. 1 inch). Leave the Thread Fit Class on the Standard setting and 
HiLo Profile unchecked. In the Values Calculated for: display you should now see "1 - 8 UNC - 2A/B x 2.25", 
which confirms that values have been calculated for a 1", 8 Threads Per Inch, Unified National Coarse (i.e. UNC), 
Standard fit (i.e. 2A/B), and thread length of 2.25".

Select the Thread tab. You should find Thread checked and all its values calculated. Nothing here needs 
changing!
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4.

5.

6.

Next select the Thread Extras tab. You will notice that neither box is checked, but the ghosted out values have 
been calculated. Check Shank.

Next select the Head tab. Again you will notice that nothing has been checked yet, but the ghosted out values 
have been calculated. Check Head to activate this option - the values and selectors for the head should all 
become accessible. Click on the Type dropdown and select "Hex" (if it is not already selected), then click on the 
head Chamfer dropdown and select "Top". Click on the Base Finish dropdown and select "Shoulder".

Select the Nut tab and check Nut. make sure that the nut Type is set to "Hex", then select "Both" from the 
Chamfer dropdown.
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7.

8.

9.

Click on the OK button at the top of the QuickBolt panel. After a few seconds the bolt should appear in the first 
layer, and the nut in the next available layer.

Fit All with the A key to fit the bolt into the view port(s) and then shift-select the layers so that both the bolt and 
nut are selected. Click on the Polygon Selection button at the bottom of the Modeler window and then press the 
W key to bring up the Polygon Statistics panel. If there are any 1 or 2-point polygons present, click on the + sign 
in the left-hand column to select them and then press K to kill these polygons.

Open the Surface Editor (F5) and select the Default surface for the nut and bolt. Activate Smoothing at the 
bottom of the panel and set the Smooth Threshold angle to 24 degrees (this smooths surfaces, but prevents 
loss of sharp detail in, for example, adjacent facets of the head and nut). For the example image on this page, 
you can use the attached surface to duplicate the look achieved. There is an HDR image in the scene and an 
Environment light to tint the colors reflected in the bolt.

https://docs.lightwave3d.com/download/attachments/8201044/QuickBolt.7z?api=v2&modificationDate=1466092620000&version=1
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•
•
•

Deformer Examples
Example - Simple Twist Deformer setup
Example - Combining Deformers
Example - Filtering a deformer

There are several example scenes in the LightWave content with the distribution that show multiple deformers 
being used


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1.

2.

3.

Example - Simple Twist Deformer setup

For our first foray into Deformers we will use the DeformMe bar object found in the 2018 content. This object has one 
end at 0, 0, 0 and so doesn't strictly need the base null but we will use one anyway to show the base null's use for other 
situations.

Add the DeformMe object and clear the camera and light out of the way to give us a clear view. Add two nulls, 
one called Base and the other Handle and use the Build Null Object's Edit function to add an ItemShape to each. 
For the Base, use a Box shape and for Handle use Pyramid on the Z axis. Move Handle to the other end of the 
DeformMe object.

Select DeformMe and hit P to open Object Properties. In the Modifier list, check Nodal Displacement and double 
click to open the Node Editor. Our first operation here is to double-click on the Displacement destination node 
and change the Mode from Displace to Set. 

Next we need an Item Info node for our Base and Handle nulls. Remember to double click on the Item Info nodes 
to select the Item.

We need two more nodes. First is a Deformer and for this example we are using Deform: Twist. Add the node 
and hook Current Position from the Input node into Point Position on Twist. Take Position from the Item Info for 
your Base object and hook it to Base Control on Twist. Then take Position from Item Info for Handle and attach it 
to Effect Handle Control on Twist. Lastly, we need to attach Handle's Rotation to the Twist input, but the output is 
a Vector and the input needs to be a Scalar. We can just hook them straight together, but the Scalar will just take 
the first of the three vectors output so we would have to rotate Handle on H to effect the twist and that looks 
ugly. To resolve, add a Vector Scalar node and double-click it to choose the channel we want to use, in this case 
Z.
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4. If you rotate Handle on B now you should see that the DeformMe object starts to Twist. You can also control 
along what portion of the bar the twist occurs by moving the Handle and Base objects in the Z axis along the bar.
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Example - Combining Deformers

In the first example, we used a single Twist deformer in order to have a twist along our example bar object. If we wanted 
to add a Bend deformer to our bar at the same time, what is the best way to do so?

For a start, we will use the two nulls we have, Base and Handle, as tools to control both modifiers. The main issue is 
chaining the deformers. Here's a simple network:
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In this network, the Twist deformer feeds the Bend deformer's Point Position input and Base and Handle are used for 
both.

The problem is that the Bend deformer gives ugly results once there is a twist in the bar. We need to separate the Effect 
Handles for Twist and Bend and also make sure the deformers are in the right order.

Before we do anything, select the Handle null and use Modifiers > General > Reset > Reset All to reset our Handle back to 
zero. You will need to move it back to the end of the bar (about 14 m). Add a third null to the scene, named Twist Handle 
and set things up as follows:
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Twist Handle's Position drives the Twist deformer's Effect Handle Control and its Rotation drives Twist's Twist through 
a Vector Scalar.

Now, the bar can be twisted into a torc shape with no unpredictability.

The Twist Handle null was rotated roughly 1080° on the Bank, and Handle was moved up on Y 5 m
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Example - Filtering a deformer

Adding a filter to a deformer will control what parts of the geometry will deform based on the alpha of the node used to 
create the filter.

Here, a simple gradient going from 100 % - 0 % in the Alpha is plugged into the filter resulting in:
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Example - Converting old scenes to 2020
xxx

Click here to expand Table of Contents...
Introduction
Automatic Scene Conversion

Surfaces
Lights
Dome Conversion
Photometric Conversion
Light Falloff
Global Illumination

Converting Studio Spyder to 2020
Comparing to 2015

Steps Taken
1. Loading the scene
2. First Steps
3. Radiosity
4. Surfacing - Standard
5. Surfacing - Wheels
6. Surfacing - Windshield
7. Replacing Standard Elsewhere
8. Other Materials
9. Render Quality

Conclusion

Introduction

LightWave has undergone enormous changes since 2015. The changes bring better quality to renders, but require 
attention to make sure your renders are a) as fast as possible and b) better quality than they were in previous versions. 
To do so can require some work and we'll lead you through an example scene from previous LightWave content - The 
Studio Spyder scene from LightWave 10, included here.

Automatic Scene Conversion

When you load a scene from a previous version of LightWave into 2019, two things happen. The first thing visible to the 
user is that you are asked whether you want to create a safe copy of the original scene:




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Answering Yes to this question will open a requester to choose a new location for the 2019 version of the scene, copy 
the old content there and then open from there, preserving the original scene where it was. Answering No will go ahead 
and load the scene with the following conversions:

Surfaces

Legacy Surfaces have the following changes made when loading into LightWave 2019:

If the surface loads in with the Standard material, then Glossy Reflections on the Photoreal Integrator will be 
turned off so that the surface's Specular only produces a specular hit and doesn't include the "blurred 
reflections" that Glossy Reflections adds.
Mipmapping on any Image Textures applied to the T channels of the Standard material will be turned off.

Lights

Light intensity adjustments are made based on the light type. Conversions from the old percentage scale to Lux are 
created according to the following rules:

Area * 3.14
Distant * 3.14
Dome * 1.57
Linear * 3.14
NGon * 3.14
Photometric no changes
Point * 3.14
Spherical * 6.28
Spotlight * 3.14
3rd party lights * 3.14

Dome Conversion

Because Dome lights were replaced by Distant lights in LightWave 2018, dome light conversion adds a multiplier to the 
angle of the old dome light to account for the general shift from radius to diameter for lights. The number will be 
different to the value you had in 2015, but the appearance will be the same.

Photometric Conversion

Photometric lights are left untouched and since they needed extreme settings to be correct in previous versions they 
will probably need to be set to 100 % in LightWave 2019.

Pi (either half, full, or double) is approximately the same light output as previous LightWave versions' 100%
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Light Falloff

To replicate light falloff from previous versions (where falloff distance could be set according to the user's whim, rather 
than physically accurately), a Light Falloff node is added to the light's Node Editor and the appropriate connection is 
made. The legacy light's "Range/Nominal Distance" value (and optional envelope) will be copied to the same setting on 
the added Light Falloff node.

Global Illumination

Settings are transferred from the original scene as best as they can be. Bear in mind that the Backdrop and Final Gather 
versions of Radiosity in previous versions no longer exist.

Everything else will depend strictly on individual scenes. Be aware that Shaders and Shader nodes from previous 
versions no longer exist and that the Shadow Catcher material node has been replaced with a Shadow Catcher 
Integrator. Cel shading, once done with shaders like BESM, Supercel or third party shaders like UnReal, no longer works 
in the same way. Now, we have the Cel Shading integrator.

Converting Studio Spyder to 2020

Comparing to 2015

The Studio Spyder red scene is purely lit by luminous panels in front of the area lights that are turned off. The reason 
they are there is that lights were not visible to the camera before. They can be now so we no longer need the luminous 
planes - this will give us a more controllable solution and we can even do without radiosity.

To match 2015's baseline we render the scene in that version with the camera at 100 % for a rendertime of 42.7s. Note 
the ridiculously refractive windscreen, noise and poor texturing. We wouldn't use this scene as is in 2015.

Don't save over your original scene or objects. If you do they will be unavailable to open in previous versions of 
LightWave if need be. LightWave 2020 will present you with an option to load a copy of a scene coming from a 
previous version of LightWave in order to preserve the original scene.


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Steps Taken

In order to convert the Spyder scene into something beautiful in 2020, we took the following steps:

1. Loading the scene

The first thing you see when loading old assets is a warning about conversion. While there is conversion of surfacing, 
lighting, and so on as detailed above, it's still up to the user to make the best of a scene. Right from the get-go with this 
specific scene we can see several things that need changing (we'll start with making sure the camera is set to 1280 x 720 
at 100 %).

The anti-aliasing didn't look good in 2015 and looks worse here, but the bigger problem is with the noise in the textures 
for the windshield, wheels and rims. The seats also look bad. The render time is also a lot slower. Let's roll up our 
sleeves and get to work fixing.

2. First Steps

Check the scene's settings. For Color Space, the scene was set to an odd mixture of settings (LightWave 10 was where 
we first introduced Color Space and things have moved on since), so update to the sRGB quick preset. Next, have a look 
at the scene's four lights. They are set at 4.71lx, which would seem a good start but changing the values makes no 
difference to VPR. Looking in the Scene Editor, we can see that they have been turned off from rendering.



LightWave 2020  –  LightWave 2020

Appendices –  3301

Turn them back on, but delete the luminous polygons that were in front of them called Studio Light. The scene will go a 
little darker and the highlights won't be obvious. The 4.71lx needs to be increased to get back what we had. Setting the 
lights all to 6lx gets us back something similar to what we had. These changes have made a massive change to our 
render time, which now stands 373.2s at with 95.4s for GI calculation. The lighting looks okay, but our colors look 
horrible.

3. Radiosity

Although this scene has radiosity, it almost certainly doesn't need it - certainly not three bounces. In order to get those 
render times down to make it easier to iterate our changes, let's try the scene without GI. A quick render later (140.1s) 
and we can see there is very little difference. The GI version is slightly brighter overall, but we can resolve that after 
everything else if we deem it worthwhile.
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4. Surfacing - Standard

The biggest problem with this scene is the Standard material used for most of it. More than anything it is that that 
causes problems with noise in the wheels, etc.

The result is a slightly faster render with improved steering wheel and front grill mainly, but there are bigger changes 
ahead.

5. Surfacing - Wheels

The wheel hubs are noisy and ugly. Although they use the Carpaint nodal material, it's not very attractive. Let's replace 
it with the new cure-all material Principled BSDF - PBSDF for short. In the Surface Editor if we just switch from Carpaint 
to PBSDF in the dropdown, the Carpaint node is preserved in the node editor so we can always switch back if we don't 
like the new material. PBSDF is a brand new material for 2018 that in some way replicates our trusty Standard material, 
but is energy conserving, no need to juggle things manually. Because the new rendering engine is built around 
materials like this, it also means that it renders faster than Standard and on top of that, because you can use PBSDF to 
produce almost any kind of surface (like Standard before it had to be pressed into service to produce everything) it's 
worth translating a few of these surfaces over to the new wonder material.
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Much nicer, a bit noisier and while it's only a tenth of a second faster, we're just getting started

One thing that's strange... our scene seem very washed out, like it's had the color space applied twice. A bit of detective 
work needed, and we find that an Image Filter called FP Gamma is being used in Image Filters. This plugin is from a time 
before linear workflow and no longer needed, so we'll remove it from the scene. This will give us our rich colors back.

6. Surfacing - Windshield

The ugliest thing in the scene is without doubt the windshield. Lots of noise and we see it's using the Standard material. 
Some of the surface entries are ghosted, because they have nodes controlling them and those nodes are for Fresnel. If 
we move to a more physically correct material we won't need additional nodes. We could use Dielectric, but let's use 
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PBSDF again for a completely different surface type. By default it comes in white, but just change the Transmission to 
100 % and we get a great simple windshield right away. The headlamps are covered with glass too, so we can copy the 
windshield surface and re-use it there. Right click on the spyder_windshield surface in the Surface Editor and right click 
on the spyder_glass_headlight surface to paste.

That's made a huge difference to our car. The windshield looks much better and we've nearly halved the render time.

7. Replacing Standard Elsewhere

We can see the benefits and versatility of the Principled BSDF material. I would urge you to replace the other surfaces 
on the car using Standard with PBSDF. Surfaces like spyder_license_plate will pose a slightly larger problem for people 
that haven't used nodes before because of the image, so let's take a closer look at that.

We can see that the Standard material has T buttons for Color and Bump and they both use the same image, which 
makes our life easier. If we switch the Material to PBSDF you will see that there are no T buttons with which to hook up 
the images and so the license plate goes white - we need to hook the image up nodally. To get into the Node Editor you 
can either click on the Edit Node Graph button at the top of the Surface Editor, or simply double click on the surface 
name.

You should see a node called Surface on the right of the window to which is hooked up the Principled BSDF node. Also 
present is the Standard node this surface used to use. If you need to remind yourself of the image name you can double 
click on the Standard node to be presented with a duplicate of the Surface Editor layout with T buttons.
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Clicking on the T button will give the familiar Texture Editor and we'll use the details from it to match up to our nodal 
version. In the Node Editor add an Image node. You'll find it in 2D Textures or you can just start tapping the name in  the 
search field. Double click on the Image node to open its interface and you can duplicate what you had in the Texture 
Editor. Hitting Automatic Sizing will give the same Scale measurements.

Now we need to hook the Color output of the Image node to the Color input of the PBSDF node.
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If you have VPR on you'll see the text appear on the license plate. Now hook the Bump output from the Image straight to 
the Surface destination node Bump input. Now you can go through and replace the other surfaces using images 
(spyder_front_logo and the four spyder_wheel_logo surfaces).

8. Other Materials

There are 35 surfaces in this scene and even those that are already nodal could be replaced with PBSDF equivalents as 
we've seen. As an example the spyder_seats surface uses the Delta node that needs a Fresnel node piped into it. If we 
replace those with a PBSDF we won't need an additional Fresnel node, The surface spyder_underbody is double sided 
and really doesn't need to be (saving a second or so there). Our render time is hovering around the 90s mark and I think 
we can draw our surfacing to a close here. There are still more to change over but we have other fish to fry.

9. Render Quality

If we go to the Render Properties > Render tab, we can economize here.

Diffuse Bounces - Reduce to 1. It's only for GI, but if we ever want GI back on, there's no point in rendering three 
bounces.
Reflection Recursion Limit - Reduce to 2. There aren't many inter-reflecting surfaces so we can speed up here 
(for this specific scene!).
Refraction Recursion Limit - Reduce to 3. We should be able to do the same here, but then we lose the bright 
reflections of the studio lights.

In Camera Properties, change:
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Maximum Samples - Reduce to 8. This should suffice
Threshold - Raise to 0.05. Raising the threshold means that the adaptive anti-aliasing will be satisfied more 
quickly and speed the render. Again, this is something we can "get away" with in this scene where there are few 
fine details.
Filter Radius - Raise to 1. This changes the radius of the filtering type to encompass the full pixel range for the 
filter.

The result is the following, in 61.3 seconds on this machine.

Conclusion

The work we have done on this scene is specific to this scene and not a general recipe to follow. It should give you an 
idea of what forensic procedures to follow to optimize your scenes. I spent roughly 20 minutes optimizing this scene.
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OpenVDB Examples
Example - Logo rezzing up — Demonstrating the use of OpenVDB to create an object at changing resolutions
Example - Volumetric Cheese — Creating Swiss Cheese with Open VDB
Example - First OpenVDB Liquid — Showing OpenVDB creating flowing liquid
Example - Chocolate Sauce Donut Drape — Using VDB particles to pour a gooey fluid
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1.

a.

Example - First OpenVDB Liquid

Click here to expand Table of Contents...
Introduction
Steps

Particle FX
OpenVDB

Introduction

Liquids in LightWave have never been as easy as now. We give you the tools to create OpenVDB-based liquids and gases. 
We can use tools that have been in LightWave for many years like the FX Emitter to generate a flow of particles that you 
can transform into flowing liquid.

Steps

Particle FX

Create a Null and call it Emitter. We'll add an FX Emitter on the Emitter tab of Object Properties, and we need to 
set a few things up.
To start with, raise the null from 0, 0, 0 and create an animation of the null moving around. We create a loose 
spiral. Next, add an FX Emitter from the FX tab, and we'll add some details:

Generator tab - Leave the Birth Rate at 100, but change Generate By to Frame. Change Generator Size
to 100 mm in X, Y, and Z. Increase the Particle Limit from 1000 or we'll run out of particles. We've set it to 



The playback rate in Layout has been halved to gain a better appreciation of the movement for the GIF 
animations on this page. Your liquid will flow twice as fast as that shown on this page


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b.

around 14000

Particle tab - It's essential that you set a Particle Size and check Output Size. We've set our particles to 
0.025 and changed their Life Time to 0 to make sure they live for the whole scene
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c.

d.

e.

Motion tab - Haven't changed much here apart from to add a little Explosion and Vibration

 

Etc tab - Set Gravity to -9.8 in the Y channel

Rotation tab - No change
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f.

2.

Interaction tab - Uncheck Detect Interaction

 

Add a floor for the emitter particles to hit, it can be as simple as another Null (called floor) with an FX Collision 
added. The only things that you need to change are the Type to Plane and the Radius/Level to 0 m
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3.

4.

1.

If you play your scene now, you should have something like this:

 
Once you are happy with your particle motion, visit the File tab. There you should click Save Motion, which will 
bake your simulation to a pfx file. If you need to make further changes to your particle sim edit what you need to 
and click the Update button to refresh your simulation. Baking your simulation will ensure that LightWave can 
concentrate solely on creating the VDB mesh.

OpenVDB

Now, we'll start to add the OpenVDB liquid to our scene. Adding fluid starts with a new Null, which you should 
name "VDB." On the Primitive tab, in the Object Replacement dropdown select OpenVDB Evaluator. If you click 
the Properties button next to the Evaluator menu choice, you will open a Node Editor. In the OpenVDB group, 
select From Particles, double-click and choose your Emitter's particles. Hook the Grid output to the Grid input on 
the destination node. There are two possibilities - 1. That you see your OpenVDB flow or 2. You continue to see 
the particles. The Voxel size you set in the From Particles node is vital in this. Too big and it will overwhelm the 
voxel space, and no VDB will be displayed. Too small and the particles won't stick together nicely - they'll look 
like a bunch of spheres. Once you can see your VDB, try the difference between Sphere and Trail in the From 
Particles node. Sphere will generate orbs, as the name implies, but Trail will create a series of spheres in a 
direction inverse to the velocity vector, getting smaller and smaller.

Because you are creating a virtual mesh, entirely created in Layout, its geometry and properties are tied 
to the scene file in Layout.


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2. Right now, our "liquid" isn't very convincing. Several nodes can help, and a combination can make a more 
convincing stream. For this tutorial, we will aim for a more conclusive result. The industry standard method for 
this is to "Dilate, Average and Erode" to enlarge the active voxels, blur the results and shrink the resulting voxels 
to get rid of any noise. We can do this in LightWave using the Filter node. Add it to your scene in the OpenVDB 
Evaluator node editor. First, choose the Close filter type - this will tighten the mesh removing as many holes as 
possible. Add a second filter and make it the Mean Curvature Flow filter type. It will flatten the lumps produced 
by stray particles to provide a smoother surface while preserving significant changes in curvature. Lastly, we will 
chain a third Filter node with the Gaussian filter type, which will smooth the final mesh. 

For this exercise, we don't need to change the settings available; we can see the results.
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1.

2.

3.

Example - Logo rezzing up

Click here to expand Table of Contents...
Introduction
Steps
Result

Introduction

For this simple example, we are going to convert a blob of polygonal material into the LightWave logo. We'll start by 
adding a LightWave logo to our scene. If you don't have one to hand, here you go - New_LW_Logo_v001.7z - it only 
needs to be in the scene for this effect, so you can move it out of sight, scale it, just hide it from rendering and make it 
invisible in OpenGL. Our result will not be affected.

Steps

Add a null to the scene. We'll call ours "Volume_Logo." In the Object Properties window, go to Primitive > 
Geometry > Object Replacement and choose OpenVDB Evaluator.

Click Properties in the Object Properties window to open the Node Editor. In the Node Editor window we see 
that the destination is OpenVDB and that its input is Grid. If you can, try to keep the Object Properties window 
open throughout this Example and visible because it will be interesting to see how it changes.

Moving the Node Editor window so you can still see OpenGL and the Object Properties window, go to the 
OpenVDB group and add the Mesh To Volume node. Double-click the node and in the window that appears, 
choose your  New_LW_Logo_v001 object as the Target Mesh and change the Type to Level Set. Pipe the Grid 
output to the Destination node. You should see a blobby object that looks something like our LightWave logo, 
but we need to increase the resolution to see it properly.



https://docs.lightwave3d.com/download/attachments/8201203/New_LW_Logo_v001.7z?api=v2&modificationDate=1533211273000&version=1
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4.

5.

To change the value over time, we will add a Constant > Scalar node and hook it to the Voxel Size input on our 
Mesh to Volume node. The Scalar node's default value is 1.0, so your blob becomes a small block with six 
polygons (a parallelepiped). You can change the Scalar's value down to what it was initially - 0.05 - or you can go 
a bit smaller to see the logo really develop.

If you set the Size to 0.45, you will still get  a six-sided block, but it will be bigger. Create a key at the other end of 
the timeline and make it 0.002 and you should see your logo take shape and improve its resolution over the 
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course of the scene.
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Result

From six to over 440,000 polygons in 120 frames

You can use an OpenVDB object made like this as a dummy object to stand-in for a high-resolution model that 
slows down your scene. Save

out the Volume_logo on the frame you like to get a lower resolution version to be switched out for the full-
resolution object at render time.



https://docs.lightwave3d.com/display/LW2019/Layout+Save+Menu#LayoutSaveMenu-SaveCurrentObject
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1.

Example - Volumetric Cheese

With its real-time Boolean operations, OpenVDB is ideal for creating complex shapes that can be animated. Here we'll 
use Primitive shapes to create a Swiss cheese object from a simple block. You can either create your own cheese block 
or load our provided scene:

 Swiss Cheese Demo

You can load the "from scratch" that provides the setup, the "finished" scene that contains the holes seen in the picture 
above or just load the cheese object. If you do that, read on and if not skip ahead to later in the tutorial.

The cheese object in the archive is a simple polygonal model created by welding the corners of one side of a box. 
It was then chamfered, subdivided and subpatched, but otherwise untouched.

https://docs.lightwave3d.com/download/attachments/8193770/volcheese_demo.7z?api=v2&modificationDate=1545044559000&version=1
https://docs.lightwave3d.com/download/attachments/8201211/Swiss_cheese_demo.zip?api=v2&modificationDate=1547544595000&version=1
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2.

3.

It is sent to Layout, where it can be converted into an OpenVDB levelset volumetric object. To do so, add a Null 
called, perhaps, Volcheese and open the Object Properties for it. In the Object Replacement dropdown choose 
OpenVDB Evaluator then click  Properties. This will open a Node Editor where we will convert the polygons 
(subpatches) we have created into voxels.

In the Node Editor, open the OpenVDB group on the left. Add the Mesh to Volume node and double click it to 
open the node window. We want to choose our polygonal cheese as the Target Mesh, change the Type from Fog 
Volume to Level Set and check Fill Interior. Close the Mesh To Volume window and hook its Grid output node 
to the destination Grid input.



LightWave 2020  –  LightWave 2020

Appendices –  3322

4.

5.

Now we have our volumetric object we can either move the polygonal version out of the way or hide it. Hiding it 
is achieved by going into the scene editor and choosing Hidden for the OpenGL level and unchecking the render 
column too. However, we can also see that our resolution isn't very good. The cheese has a pixelly look about it. 
Setting the Voxel Size to 0.02 in our Mesh to Volume node will improve that, but we are going to be adding lots of 
voxels so it would be better to set this once for everything. To do so, add a Constant > Scalar node, set it to 0.02 
and take its output into the Voxel Size input on the Mesh to Volume node.

Now we can start making our holes. Add a new null, call it Hole and make it a Primitive Shape, the default 
Sphere works perfectly for our needs. Parent it to the Volcheese object to make sure the hole moves with the 
cheese if you want to rearrange the cheese later. Position it on our Level Set object where you'd like the first hole 
to appear. Switch back to the Volcheese object and click Properties for the OpenVDB Evaluator to open the Node 
Editor again. Choose Shape to Volume, double click the node, choose your first Hole for the Source Primitive 
and check Fill Interior. Lastly, set the Space choice to Parent. 
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6.

7.

Now we can cut the cheese (stop giggling at the back!). Once our Hole object is placed as we like, we can choose 
CSG from the OpenVDB group, which will bring in a node that we can use to cut the Hole object from the 
Volcheese. Double click the CSG node to change its operation to Subtract and hook the MeshToVolume node's 
Grid output to the Grid 1 input, and the Shape To Volume's grid output to the Grid 2 input. Lastly, take the CSG 
node's Grid output and hook it to the OpenVDB destination node's Grid input. If the hole doesn't appear right 
away for you, step the frame number forward and back

The hole cut is still a little jaggy, so we can smooth things out by adding a Filter node just before the Destination. 
This Filter should be set to Gaussian and you can just put it between the CSG node and the Destination. It will 
round everything off a little to make sure there are no hard edges.
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8.

9.

All that remains now is to copy the Hole you created, move it to where you want to make a new hole, then copy 
the Shape to Volume node and assign it to your new hole, hook up the Scalar and add it to the New Grid input on 
the CSG node.

Add as many holes in different sizes, shapes and rotations as you like. Our example at the top of the page also 
has some nodal displacement on the volcheese object, along with a cheesy yellow color.
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Example - Chocolate Sauce Donut Drape

Click here to expand Table of Contents...
Introduction
Scene setup
VDB Setup

Making the Particles

Finessing the Scene
Last points

Introduction

Here's a simple, yet gooey, example to use with the new VDB particles. Imagine, if you will, a donut on a spit, with 
chocolate sauce pouring down from above.

Scene setup

First, we'll need some scene objects. Our donut, of course, then a floor to catch any drips - we don't want to waste 
chocolate, even if it's virtual. If you are using the Layout modeling tools, as I am, for this exercise, then the standard 
Layout Toroid is fine. Then, model a box that's about 5 m square and about .2 m thick. Lastly, we want a standard 1m 
tessellated sphere to act as our chocolate source. That's it for the modeling portion of this tutorial, apart from to add a 


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null we'll call VDB. Position VDB above the toroid, allowing enough space for the donut to rotate around. Position the 
floor a bit below the Y=0 line, and the donut a bit above, so that it hits neither the floor nor the null while rotating.

Perpetual donut rotation

To set the donut rotation up, go to frame 23 and change the Bank rotation for the donut to something like 42°, then go 
into the Graph Editor by clicking the E next to the field and set the Post Behavior to Linear. You should be able to play 
the scene and see your donut spinning freely. If you feel it's too manic, or too slow, for you change that keyframe value.
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VDB Setup

For our scene to work, we need to convert all of our scene objects into VDB objects. We can do this by opening 
Properties for our null called VDB. Set the Object Replacement to OpenVDB Evaluator, and hit the Properties button to 
open the Node Editor where we will add three Mesh to Volume nodes. Set them all to Level Set (the solid sort of VDB) 
and also set their space from Local to World. In the Target Mesh drop-down, set the first node to New Sphere Object; the 
second to New Toroid Object, and the third to New Cube Object. Our destination Grid node only allows for one Grid 
input, so we need to combine the two collision VDB objects. We can do this using the CSG node, so take the Grid outputs 
from the two Mesh to Volume nodes for the donut and floor and pipe them into Grid 1 and Grid 2 on the CSG node. The 
order doesn't matter.
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Making the Particles

To create our chocolate sauce, we need to bring the grid from our sphere Mesh to Volume node into the Particle 
System In of a Solver node. Change the Integrator to 3rd order Runge-Kutta and increase the SubFrame Steps to 
300. Adding some of the elements on the Visualize tab can make your particle fluid simulation easier to understand. To 
make sure our particles bounce off our donut and floor, bring the Grid output from the CSG node into the Solver's 
Collision Grid input. We have now done enough to be able to take the output from Solver and pipe it into the 
Destination node's Grid input.

If you make a Preview now, things should animate nicely, but our chocolate looks very grainy. To cure this issue, add a 
pair of Filter nodes. Make the first one Dilate and the second Gaussian and take the output from the Solver, into one, 
then the other filter nodes and finally into the destination node.

Finessing the Scene

Right now, we're pouring concrete over a spinning concrete ring before it hits a concrete floor, so let's at least make our 
chocolate sauce look more... chocolatey? Make sure you have your CS set to sRGB and change the RGB values for your 
VolumeMesh in the Surface Editor to:

R 21 G 8 B 0

Set the Roughness to 40 %, and Smoothing to On.

For the donut, we want that just-fried orange:

R 161 G 53 B 5

with Roughness at 60 % and Smoothing on.

Our floor can stay concrete. We do not need to see the sphere that serves as the target for our molten chocolate ball, so 
hide it from the scene and from the render using the Scene Editor (Ctrl F1).
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Last points

In the attached example scene, we have given the camera some kinetic animation using the new navigation controls. 
Feel free to tone it down...
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•

Surfacing Examples
Example - Adding an Image with Nodes
Example - Shadow Catcher: Spyder on the beach
Example - Surface Library
Example - UDIM texturing the Sugarcube character
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Example - Adding an Image with Nodes

Only the Standard material has T inputs with which you can add images, or procedural textures, quickly - so what to do 
with the all-powerful PBSDF node? The answer is simple but requires more than just the Surface Editor.

Let's start with our example object shown here. There's a box with a Left, Right, Back wall and Base surface to be 
textured.

For the sake of this tutorial, the flat colors and gradient have been made with images. If we click the T button for the 
Color channel of the Back Surface, we'll see the familiar sight of a Texture Editor.
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But if we switch material to the new PBSDF material that is the default now for surfacing we'll see that there are none of 
the T buttons with which we are so familiar.
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The reason is that an image needs to be attached nodally, so let's do that. Double click on the surface name, or click the 
Edit Node Graph button.

We have two ways to add the Image node we'll need to use. We can either explore the menu on the left - go into 2D 
Textures and choose Image - or we can use the search field above the list.
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Either way, double-clicking on the entry will add it to our node graph. Double-clicking the node will open its window.
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Although there are new entries, the interface for the Image node looks similar to the Texture Editor window, so there 
are definitely things that we can get started on right away. Clicking the drop-down at the top of the window is for 
choosing an Image, and we can map it in a Planar fashion in Z. We can also use Automatic Sizing for it to fit the wall. 
With that done, our Image node will show a thumbnail of the image chosen but our back wall is still default gray. We 
need to hook up our image node to make it work.

On all nodes, there are two columns of words with colored dots. The ones on the left side are Inputs, on the right they 
are Outputs. We need to hook the Color output from our Image node to the Color input on our material node - PBSDF - 
like so:
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Once this is done, the image will be visible in OpenGL and of course VPR.

Go further by surfacing the box with a single surface, single UV map and UDIM image textures - Texturing the box with 
UDIM
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Example - Texturing the box with UDIM

We can go further with nodal texturing by using a single UV map created with UDIM tiles to texture our container. This 
will reduce the number of separate surfaces we need to manage to one, and greatly simplify our nodes. We will start by 
creating a UV map for our object.

Let's start by selecting the four inner faces of our box and hitting Ctrl-U to unweld them. Once we have created our UV 
map we can merge them (M) to put them back together. Then, select the back wall. Select it and click the + button down 
at the bottom right of the Modeler interface to create a new Planar UV map.

Several things to note while we are creating our UV. Using Set as Default UV Map adds a bullet point (•) after the UV 
map name but, more importantly, a default UV map will be used when no explicit association has been made. We will 
see this in use later. Another thing to note is that Live Update has been checked. This will adds elements to a UV map as 
you create them. Hard to see here because I need to switch viewports, but with a dedicated UV viewport you will see 
how this speeds workflow.

The last new elements are the UDIM Tile Number entry and its associated Padding field. As you can see from UDIM 
Workflow, UDIM gives you the opportunity to have multiple full-scale image maps associated with a single UV map. 
Setting the padding to 5 % ensures that there's no overlap between tiles, but you can experiment.

Go through the individual polygons, using the same UV map name, setting each to the appropriate axis and increasing 
the UDIM tile number each time you add a new tile.

UDIM images have to be named in a specific fashion, with the number of the UDIM tile in the filename. We'll create four 
images named 1001-1004 to create images for the four UV-mapped polygons.
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In the Image Editor, load the first image and set the Image Type to UDIM. This will bring the other UDIM sequence 
images in automatically.

Since we are now using a UV map to texture the inside walls of our box, it makes no sense to have separate surfaces for 
our inside box walls. Select the four inside walls and assign them a new surface "Inside".

In the Surface Editor, select this new surface and double-click its entry to edit nodes for the surface. We will add an 
Image node, load our UDIM and set the Projection to Object UV (which will use a default UV map).
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We can see from our VPR render that our Right side wall is reversed. We can rectify by simply flipping the UV coordinates 
for this wall in Modeler.

We can do the same with the Image Sampler node. This normally requires a projection node piped in, but if the 
object has a default UV map this will be used automatically.


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Visit Modeler (F12) and go to the Map tab. In the UV/Texture section you will see Flip UVs. Start the tool and click OK 
(since we want to flip U). If you are presented with an error message, make sure the appropriate UV map is selected in 
the lower right corner. Save your object and return to VPR in Layout. You should see that the text is the right way around 
now.

Once we have the four inside walls - Base, Back, Left and Right assigned in the UV map, correctly textured and flipped 
where necessary we can merge our polygons back together with Merge (M). You should have 20 points eliminated.
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Example - Shadow Catcher: Spyder on the beach

Let’s take a look at setting up a relatively simple compositing exercise. This beach photograph will provide a useful 
background plate to composite the car model onto, the sand is wet and provides a perfect example to illustrate the 
reflection catching aspect of the Shadow Catcher integrator. 

Setting Up the Background Plate

We first need to bring in the background plate we want to composite over, we’ll be using the Background Image
method. Open up the Effects panel > Compositing tab (Ctrl F7) select (load image) from the Background Image 

Spyder_on_Beach.7z (1.85 MB)


https://docs.lightwave3d.com/download/attachments/8201103/Spyder_on_Beach.7z?api=v2&modificationDate=1594137893000&version=1
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dropdown menu and choose our image.

To help align items with the plate when we start placing objects into our scene, we need to see the background image in 
the camera view, it should be set by default. If it's not, open the Options panel > Display tab (D key) and set the Camera 
View Background to Background Image. You’ll need to set the viewport type to Camera to see the effect of this.

Setting Up the Camera

We now need to match the LightWave camera to that of the background photo. The easy way to do this is to use the 
Real Lens Camera. Select the Camera and bring up the Properties panel (P key).

Choose Real Lens Camera from the camera type dropdown (1), then choose (from image) in the camera type dropdown 
(2), select the image from the Image dropdown (3) and finally change Use fstop to Do not use fstop from the focal 
distance dropdown (4) as we don’t want to use Depth of Field (DOF) because this will also blur the background image 
which already has DOF in the image.
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Matching the Background Image Perspective

Once the background plate and camera settings have been set up, we need to position the LightWave camera in 
approximately the same location as the camera used to take the photograph so that our 3D objects match the same 
perspective as the background. Let’s start by adding the ground plane object that we will  use to ‘catch’ the shadows 
and reflections.

In LightWave 2019, we can create scene objects that have no geometry. To do so, we'll start by creating a null that we'll 
call "Beach_Plane".

Hit OK and open the Object Properties panel with P
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In case you don't see the GIF, we add a Shape Primitive to the null, choose Plane, and set the size to 5 m

Now we have the ground plane created, let’s load the object we want to feature in the composite scene. Moving and 
rotating the camera into the original photo’s camera position will match the perspective. This part is very much a 
matter of eyeballing until it looks right. You can try to use the Match Perspective function but a beach doesn't offer 
much orthogonality.

Our scene now looks like this:

When taking a photo for use in compositing, you should also note details that will help at the camera matching 
stage, such as camera settings, height, position from any key items in the photo, time of day, lighting 
conditions. Additional photos from different directions can also be used for reflection maps.


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Setting Up the Shadow Catcher Integrator

The Shadow Catcher works by only shading shadows and reflections from other objects in the scene onto surfaces the 
Shadow Catcher is applied to. Other material properties such as diffuse are simply ignored, which is why it gives the 
illusion of objects being part of the background image.

To apply the Shadow Catcher to the ground plane we created, open the Surface Editor (F5) and select the Beach_Plane 
object we created earlier.

We don't need to worry about the material on the surface or what color it is. We're going to the Shading Model tab. If 
you have VPR on while you do this you will see the change immediately. Change the Integrator from Photoreal to 
ShadowCatcher and you will see the car sitting on the sand right away.
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If the background image where your object will be placed has a reflective surface, here you can set the amount of 
reflection that matches, along with any roughness you judge the “ground” may have.

The beach under our car isn't perfectly flat, and the sand seems to be a little wet too, so we need to adjust our beach 
surface as well. Double click on the Default surface for Beach_Plane and you will open the Node Editor.

The default Principled BSDF settings aren't too bad and have a slight reflection of the car in the wet sand. To replicate 
the contours of the sand, just add a Turbulence node. I set the X and Z scale to 300 mm and 100 mm respectively and 
adjusted the Rotation heading to 5° to better match the sand of the beach.

Matching the Lighting

The last stage is to match the lighting and direction of the original background photo in your LightWave scene. For 
outdoor scenes like our example, you may want to use a Distant Light rotated to match the direction of the shadows in 
your photo (the light’s position doesn’t matter).

For sharper shadows use a low Angle for the Distant Light (5.2 is the actual diameter of sunlight falling on the earth on a 
clear day), higher angles result in softer shadows, For very diffuse overcast lighting, angles up to 90° may be required.

When rendered, your object should now look as though it was part of the original photo, as the shadows and reflections 
appear to interact with any shadow catcher objects (the ground plane in this example). Note the reflection in the wet 
sand as well as the shadow.



LightWave 2020  –  LightWave 2020

Appendices –  3348



LightWave 2020  –  LightWave 2020

Appendices –  3349

Example - Surface Library

You can set up a set of default surfaces and load them to objects. Since you append to libraries rather than overwriting 
you can start with a single surface. Create a simple object with a surface that describes what function it is performing - 
Plastic.black.shiny, for example or Glass.bottle.wine - and surface it appropriately.

With our Glass.bottle.wine and Wine.red surfaces established, we can start a surface library. To do so, right click on the 
object in the Surface Editor, or either of its surfaces and choose Save > Save Library. This will save all the surfaces for 
the object to a new file with the extension .lib. A library with two surfaces isn't very useful however, so let's add more.
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With our new object with its varied surfaces loaded, right click on one of its surface names and choose Save Library 
again.

Save to the same name as before. You will be warned that the file will be overwritten, but it will be appended with the 
new surfaces. With eight surfaces in our library we can start to make use of them.

We'll add a fresh, unsurfaced set of example objects to our scene. For the moment we won't name the surfaces 
specially, they should just be different for each object - 1, 2, 3, etc. will do for the time being.
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We can load our library to these untextured objects by right-clicking on one of the numbered surfaces and choosing 
Load Library by Index.

As you can see, our wine bottle and wine surfaces have come in (the second and third cubes) along with some of the 
others. To be sure you can load the appropriate surface to the object you want you need to use Load Library by Name. 
If we reload the boxes object so we are back to the unsurfaced objects, then we can do that.
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From my surface test objects, I want to use the Leather - oxblood surface. Right click on the original surface and choose 
Rename. Copy the selected name and add a 2 to the end (because even though they are separate surfaces they need 
unique name for the sake of this exercise). Choose one of the unsurfaced blocks and rename that too. Paste the copied 
name in so that the surface is now called Leather - oxblood instead of the number.

Once done, right click on the newly-renamed surface and Load Library by Name. You will see that only the surface you 
changed will have been loaded from the library.

There is another entry on the Load Library menu. It is Load Library by Name, Append extra surfaces. This allows you 
to load all the surfaces in your library and copy and paste to other surfaces, which can be quicker than renaming 
surfaces.
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Advantages over surface presets

Surface presets are excellent in that they give you a thumbnail to see what a surface will give, but this system is far more 
efficient when it comes to replacing multiple surfaces at once. If you create car models for instance, you will be 
guaranteed to need bodywork, chrome, glass and rubber surfaces. If you save your surfaces with precise names as a 
library it can be used to rapidly surface objects without needing to load individual presets and accepting the warning 
message a preset gives.
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1.

Example - UDIM texturing the Sugarcube character

As an example of using UDIMs to texture a character, we have chosen the Sugarcube from the Genoma examples.

We'll start by hiding everything we don't absolutely need:

With the Sugarcube character, the easiest way to hide the Skelegons used for rigging is to open the Statistics 
panel (W) while in Polygon selection mode and hit the + next to the Skelegons entry. Hit - on the keyboard to 
hide them once selected.

Select polys on the hands, arms legs, and feet, then use Select Connected (]) to make sure everything is selected, 

UDIM Sugarcube.7z (3.24 MB)


- Show only Layer 1

- Hide the Skelegons for Genoma (if present)

- Hide the limbs, leaving only the body on display

https://docs.lightwave3d.com/download/attachments/8201118/UDIM_sugarcube.7z?api=v2&modificationDate=1595855072000&version=1
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2.

then hide (-)

Once done, hitting A should fill the viewport with the cube.

Now we have our cube front and center we can UV map it. Since we want to use UDIM tiles for our map, we are 
going to proceed slightly differently to a standard Atlas map. First, switch one viewport to UV. Then, with the 
front of the cube in view (the side facing +Z), select the four polygons in the center

Use Selection > Modify Selection > Expand (}) to select the whole side (should be seven expands).
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Cut the polygons from the cube (Ctrl-X) and paste them back (Ctrl-V) to separate the polygons and then we will 
start our UV map. Click the T under the bottom right viewport and select (new) from the dropdown menu. Doing 
so will open the following window:

We want to leave the Map Type as Planar, but change the Axis to Z and at the bottom of the window, change the 
Padding to 0.05, and check Set as Default UV Map. Hit Create and we will start our UDIM UV map.
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3.

4.

We need to repeat the steps for the other sides of the cube. Do the top of the cube next, selecting the middle four 
polys and expanding the selection. Cut the selected poly and Paste them back in place, then choose the 
appropriate axis for the UV map. We keep the same Texture Name, but for each additional face of the cube, we 
increment the UDIM Tile # at the bottom of the Create UV window.

Proceed in this fashion from the most to the least important. I have chosen Front, Top, Left, Right, Back, Bottom 
for my order.
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5.

6.

Our UDIM UV map is complete. For this example, I created six images. The original images are included in the 
content directory, but need to share a name and have a suffix relating to the UDIM tile they are for - my image for 
the front of the cube is named Color-1001.png. This naming refers to the use for the image (a color map) and the 
tile for which it is intended.

All that remains now is to use this UDIM sequence to map our cube

Open the Surface Editor (F5) and double-click the SUGAR_BODY surface. Add an Image node and hook its Color 
output to the Color input on the PBSDF material. Double-click the Image node and set the Image to Color- 
(UDIM). Lower down, choose the UV Map Mapping option, and set the UV Map to Texture.
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7.

8.

One thing is still wrong with our texturing. Some of the tiles are mirrored - ears facing the wrong way, for 
example. Right now, our six faces for the cube are all separate objects so now is the right time to Flip UVs. Go 
into UV >UV Modify and choose Flip UV/U Selection. That should set your right ear in the correct direction. The 
same is also true for our bottom polys, so clear any selection, click on one of the bottom polys and use Flip UV/U 
Selection again.

To see the image map overlaid on the UVs, select the Color- (UDIM) image from the dropdown at the top of the UV 
viewport

Once the UVs are the right way around and the image map fits correctly you can merge points (M) for the cube 
and unhide (\) the additional elements before saving.
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•
•
•
•
•

Example - Surface Baking Camera
Modeling
Buffering
Surfacing
Rendering
Mapping

Modeling

To begin our tutorial we'll start with some detailed modeling. Our example is not high polygon count but will serve to 
simplify our steps. This technique is used in video games all the time to allow realtime performance with seemingly 
detailed models.

This shape consists of 3168 subpatches that at standard subpatch resolution resolve to some 28512 polygons. In our 
second layer we have the base for this object, which at 290 polygons is roughly 1000x less:
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We want to bake the detail from the first shape into the second to reduce the polygon "weight" of our scene. This 
technique requires a UV map for the low-polygon version of the object. We will select a line of edges and use the ABF 
Unwrap function to create a quick UV map.
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Use the Stretch tool (H), with the mouse at the left edge of the UV map and Ctrl held down to scale the UV map to fill the 
space.

Buffering

In Layout, we have added a Color custom buffer to our scene to capture purely the color of our surface with no 
additional information. We do so in the Render Properties panel - Buffers > Edit... > Create Custom Buffer. Call this 
custom buffer Color since that's what we want. A new entry has been added to your Node Editor's Surface destination 
node.
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Surfacing

To create the texture for our surface, I am using some chained procedurals (Turbulence into Turbulent Noise into 
Crumple to feed the Principled BSDF Color input as shown. Note that the color from the last procedural in the chain - 
Crumple - gets put into our custom buffer input

Rendering

We need to set up the camera for our scene. First we need to set a resolution common to UV maps of 1024 x 1024 pixels 
in the Width and Height fields. Next, switching from the default Perspective camera to the Surface Baking Camera will 
present the normal Camera Properties window with an extra panel.
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In this additional panel we need to select several things. In our example we need to set our Mesh to the low-polygon 
count version and the UV map to the Unwrap map created by the ABF process. If we render now, we will see there are 
holes in our render. These are caused by the camera being too close at the default setting of 100 um. We can increase 
that little by little to get exactly the right distance, each time you make the distance greater a little less of the object 
should appear in the final render buffer. The renders don't take long as can be seen from my screenshot, but for this 
example, a distance of 23 mm is just right - the final render buffer is completely black and the 
Camera_Tangent_Space_XYZ and Color buffers are complete.

The Camera_Tangent_Space_XYZ and Color buffers should be saved in an HDR format - EXR is the most modern - and 
can then be applied to the low-polygon object.

Mapping

Take the low-poly object's surface and input the Color buffer map into the Color input on the Principled BSDF material, 
and the Normal Map node should contain the Camera_Tangent_Space_XYZ buffer image. You will need to invert X to 
make sure it reacts the same way to light as the original. The Normal Map output goes into the Normal input on the 
Surface destination node.
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We can see from the silhouette that the foreground object has a much lower polygon count than the original in the 
background, but for many uses including background objects or games, this is ideal.
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Example - Volumetric planet and atmosphere

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=HLohazy4A-Q

https://www.youtube.com/watch?v=HLohazy4A-Q
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Example - New Light Options

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=_SjP11gFhwM

http://youtube.com/watch?v=_SjP11gFhwM
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•

Animation Examples
Example - Door Pivot 1
Example - Door Pivot 2
Example - Spline Displacement Object CP
Example - Using FontMesh
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Example - Door Pivot 1

This door was modeled in a layer here. For use in Layout, this would be a problem because the pivot will be where the 
darker cross is in the grid. Our first possibility is to move the door. For this example we'll use Rest on Ground since we 
are not worried how the door will rotate, it's only important that that corner of the door is at 0, 0, 0.

Once centered by Rest on Ground, you need to move it on the X axis so that the edge of the door is at X=0.
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Now the door is ready for rotation in Layout but will need to be moved into place.

Contrast with with the other methods.
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Example - Door Pivot 2

There are two ways to move a pivot, one in Modeler, one in Layout but the pivot for this door really needs to be moved

First, let's try in Layout using the Modify > Move Pivot tool

As you can see, this method works well, but you need to be more precise with the positioning of the pivot - the point of 
rotation is still off. You can use the other views Layout offers and make it more precise by zooming in on the door, etc.

The alternative is to move the pivot in Modeler where it's easier to be precise. Here we are using the Layers > Pivot Tool:
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The position of the pivot is stored in the object file, so this door will be ready to open in other scenes too.
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1.

Example - Spline Displacement Object CP

Spline Displacement can use other objects as controllers for the displacement. Here we look at moving our bar with null 
objects.

To create our controllers, we will start with our scene with just the object we want to control
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2.

3.

4.

5.

If we add Spline Displacement from the Modifiers list we can use the built-in controllers to modify our object like 

so:  
But we have to use the special Spline Disp Ctrl tool to move our control points. It's on the Modify tab at the 
bottom of the list. Instead, we could use standard objects to control the movement of our bar.
Reset the scene using Revert Scene to Last Saved from the Load menu to remove any animation done and 
reset the bar. Now add Spline Displacement again and add some control nulls to the scene. Any objects can be 
used as Control Points, but using nulls makes the most sense here.
Add five nulls and name them Spline0 to Spline4. You cannot rely on the automatic naming LightWave gives 
sequences of objects - the (1) at the end of cloned items for instance - the numbering must be explicit and should 
start at 0. You can add as many as 256 control nulls. Position them in number order along the bar's length. The 
example shown uses the Item Shape Custom object to make the nulls more visible.

Now, when we add Spline Displacement to our bar object we can choose Use Object CPs and enter the name of 
our nulls (without the numbering). This gives us the ability to use standard scene objects, and the standard Move 
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function, to control our bar's animation

Example-SplineDisplacement.zip

The Spline Displacement tool works uniquely with World Position displacement. There is no rotation 
functionality.



https://docs.lightwave3d.com/download/attachments/8201177/Example-SplineDisplacement.zip?api=v2&modificationDate=1517480451000&version=1
https://docs.lightwave3d.com/download/attachments/8201177/Example-SplineDisplacement.zip?api=v2&modificationDate=1517480451000&version=1
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Example - Using FontMesh

Click here to expand Table of Contents...
Introduction
Creating the Text Object
Animating

1 - Setup
2 - Animation
3 - Make Bones

Introduction

The FontMesh object replacement will create an animable Layout object using your system fonts.

Creating the Text Object

Add a null to an empty scene and name it if you like. Open the Object Properties window and click the Object 
Replacement dropdown. Choose FontMesh. The word "Test" will immediately appear, to change it click Properties in 
the Object Properties panel.

Animating

Of course, whole object animation can be created with a FontMesh, but it gets more interesting if individual letters can 
be manipulated. For this, click the Make Bones button at the bottom of the window.

For our example scene, we will take the word Layout and animate it.

1 - Setup

Create a Null called FontMesh, hit OK and then open Object Properties and choose FontMesh from the Object 
Replacement dropdown list.


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You will immediately see the word "Test" appear in shocking pink. Let's amend that. Click the Properties button next to 
the Object Replacement dropdown.

These are my settings. Choose a striking typeface and make it deep enough to notice with bevels that are obvious.

2 - Animation

Once you have made a final choice on your text, your font and your style save the scene. That way you can always return 
to it at this stage in case your animation choices don't work out. Let's examine those choices now.
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You can create a simple transformation of the whole text object - moving, rotating, scaling the word as a whole;
You can use the Part Move functionality to create an animation like those described here.

You can use the Make Bone tool to make individual letters become animatable, still keeping a single object. That 
is what we will cover here.

3 - Make Bones

Before you hit Make Bones, let's set the Vertical Alignment on your letters to Bottom. This will give us better alignment 
on our bones. Once you have created bones, you can move, rotate and scale them, and thus the letters in your word, 
individually.  For what we are going to do here, let's start by moving all the bones to their x-base (the bottom of the 
letters, not accounting for descenders). Select all the bones, click the Bone Active button to deactivate them, then set 
them all to Y=0. Now, hit R to rest the bones and make them active again at their new positions.

Now, all that remains is to manipulate the bones as you wish to produce something like the attached scene:
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Example-FontMesh_MakeBones-animated.7z

https://docs.lightwave3d.com/download/attachments/8201184/Example-FontMesh_MakeBones-animated.7z?api=v2&modificationDate=1531301358000&version=1


LightWave 2020  –  LightWave 2020

Appendices –  3381

•
•
•

•
•
•

•
•
•

NRC Tutorial
Click here to expand Table of Contents...

Introduction
Getting Started
Install

config
content
support

NRC Setup
Heterogeneous setups
Troubleshooting the Setup

Introduction

There are two parts to using NRC as a simple render controller for network rendering of LightWave scenes. First we will 
cover the use with homogeneous networks - that's to say networks of machines all running the same platform - then a 
smaller section on how to create renderfarms with a mix of Windows and OSX machines.

Getting Started

Network rendering has to be really locked down. If you are accustomed to having scenes with content brought in from 
all over the place - your desktop, a friend's USB key, your computer's Images folder - stop it. Right now. For successful 
network rendering (indeed, it's best for all rendering, particularly if you are not the only one working on a scene), you 
need to adhere to LightWave's holy trinity of Scenes, Objects and Images directories. Not only that, but you want to 
bake anything that is based on random factors that might be different on the different machines in your farm.

Install

NRC will work with your standard LightWave install, but wants to have its configs separate (so that plugins will work 
over the network). Create a folder called NRC in a network-accessible area of your machine. To make things simple 
create two subfolders - config and content. Copy the entire support folder from your normal installation of 
LightWave into the NRC directory.

config

Copy your LightWave configuration files into this config subdirectory. On Windows machines, by default the LightWave 
config files are located in C:\Users\<username>\.NewTek\LightWave\2020.x - copy the contents of this folder 
into the configs directory you have made. For OSX machines, the process is identical, but the folder is here: User/
<username>/Library/Application Support/NewTek/LightWave/2020.x. By default, access to this folder is 
restricted, but you can either use Go > Go to folder... or go to your Documents folder where there is a Symbolic Link to 
the correct folder.


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1.
2.

3.

Copy all the files in this folder to the config folder you have made

content

This is where you should store scenes that are going to be rendered. All scenes that will be rendered over the network 
need to be:

Contained within a LightWave content directory.
Should have a rendered image save path explicitly defined (It is best to define a save path inside the content 
directory).
Should have all random elements baked. This includes simulations, radiosity and images.

support

The third thing to organize for a render farm is your plugins folder. LightWave relies on its range of built-in plugins to do 
many things, from animation to saving images. These days, it is not just plugins either, but also supplementary parts of 
LightWave that live in the support directory above plugins. It is vital that all of these are available for the network render 
to work. This is perhaps the hardest thing to manage, but it shouldn't be. If you haven't already done so, copy your 
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LightWave's support directory to our network-accessible location. You should now have three folders in our NRC 
directory - config, content and support.

NRC Setup

The NRC Controller can be launched from the LightWave directory and will look like the above to start. Start filling it in 
by finding your config directory through the network. Next add the directory that contains your copied support folder 
(if you've been copying this tutorial, that would be your LightWave directory).

If you haven't started a render node yet, do so now on the same machine you are running the controller on. Lastly, we 
need a scene. Hopefully you have one ready to test. If not, start simple - choose a scene that takes seconds to render a 
frame, not minutes.
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If your Controller window looks like this, and you have selected the node; the scene and have an Image Output 
Directory set, you will see that the Validate Environment button gets highlighted. You can check that all is well with 
your setup by clicking this button, which will open a window showing either red or green dots by the entries. You are 
aiming for this:

If you have it, you should be good to go. Drag the scene from the bottom window onto the nodes to assign them the 
task. Do a test for a couple of frames, looking in the folder you set for renders to see the images arrive. Once you have a 
couple, stop the render and it's time to bring some other machines to bear.

For this example, I dragged six machines to bear on this curtain2018 scene. It's very satisfying to see all the machines 
start to work rendering frames.
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Heterogeneous setups

When dealing with a mix of OSX and Windows machines, there is one wrinkle. Plugins and configs need to work for both 
platforms, but there can only be one controller. When you are setting up a dual platform render farm (whatever 
platform your controller is on), the support directory we talked about making earlier needs to be contained within 
folders for OSX and Windows. Make a folder called Plugins that contains an osx directory and a windows directory. In 
these copy the support directories for each platform. The config folder can have the Windows and OSX config files (the 
extension cache, Layout and Masters configs for both platforms are essential) in the same directory since there is 
no conflict with the names.
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1.

2.

3.

4.

Troubleshooting the Setup

If you are having problems getting NRC to work, there are several easy points to bear in mind.

Are the paths in your scene network paths? Check that output paths are network accessible and that 
everything in the scene has been loaded from within a content directory.
Does the simplest scene work? Try creating a scene that consists of a null and saves its render output to 
the .FLX format in the content directory. FLX is LightWave's native image format and requires no plugin. If it 
works, check 1.
Are you having trouble validating (in a heterogeneous render farm)? Make sure your LightWave version is the 
same for both platforms.
Plugins come up as red when you validate? Go into Manage Plugins and use the Replace dropdown button to 
edit your path until you can follow it to find the scene plugins. Manipulating the Path Prefix field at the top of the 
window with Replace all Paths until the path is correct, then hitting the Apply button will create a modified 
extensions configuration file that will work across the network.
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Example - SunSky and Environment Light
Using SunSky to create an atmosphere for your scene is quick and simple and GI is not even needed for a beautiful 
result.

We'll start with an empty scene.

Hit Ctrl F5 to bring up the Effects window, or click the Editors > Backdrop button. In Add Environment, choose SunSky. 
Open its interface.xxx
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LightWave 3D Resources

Internet Resources
LightWave-specific forums, newsgroups and mailing lists are maintained on the Internet. Here you can find new users 
asking questions about using LightWave and experts answering them. Also, many topics related to computer animation 
are discussed in these groups, such as the performance of various graphics cards, CPU speeds, platforms, and many 
more. NewTek’s own forum can be found at and there are many others out there.

LightWave 3D is on Facebook, Google+, LinkedIn, Twitter and YouTube.

NewTek Web and FTP Sites
In addition to information about NewTek products, upgrades, and the latest releases of LightWave software, our 
websites ( and ) have tutorials, LightWave images and animations, technical support FAQs, tech support email links, and 
links to related sites. NewTek maintains an FTP site () on the Internet. Here you can find objects, scene files, images, and 
other items of interest to LightWave users.

Community
A unique attribute of LightWave 3D is the LightWave community. It is rare to find such a passionate group of 
professionals that are so talented and yet so willing to share their secrets, ideas, and creations. Make certain you also 
take a look into the available resources such as local users groups and training books and videos.

Technical Support
The best source for help with installing or configuring software or hardware is the retailer from whom you purchased 
your NewTek product. While we have made every effort to keep your software and hardware trouble-free and easy to 
use, you may occasionally need help right from the source. If you have problems with NewTek-supplied hardware or 
LightWave doesn’t seem to be functioning as it should, please contact technical support using the contact form:

https://www.lightwave3d.com/contact/tech_support/

Email support hours are between: 9am - 6pm US Central Time (-6hrs GMT), Monday - Friday.

In your communication, please include as much information as possible including:

Your computer’s operating system and version;
The version of LightWave you are using;
The amount of RAM in your computer;
Which display card you are using and what version of drivers are installed;
CPU and make and model of computer or motherboard;
Your product serial number

Your product must be registered before you can receive support.
LightWave’s Layout has been designed to provide the most efficient interface possible for your 3D animation work. By 
default, there is a single large viewport, but you can display multiple viewports if you desire. A viewport provides you 
with visual feedback about the virtual world you are creating. How well this corresponds to what the final output will 
look like is completely configurable by you. This can range from bounding box stand-ins to wireframe representations, 

https://www.facebook.com/LightWave3D
https://plus.google.com/+LightWave3DGroup
https://www.linkedin.com/company/the-lightwave-3d-group
https://twitter.com/lightwave3d
https://www.youtube.com/user/OfficialLightWave3D
https://www.lightwave3d.com/contact/tech_support/


LightWave 2020  –  LightWave 2020

Appendices –  3389

•

all the way to textured and solid-shaded displays. How you view your creations will vary depending on their complexity, 
your machine’s capabilities, and other factors.

For More Information and Updates
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For More Information and Updates
For updates to LightWave, this wiki and all the latest LightWave news including a gallery, tutorials, articles about 
LightWave artists and new third-party plugins visit:

http://www.lightwave3d.com

Learning Resources

For help learning LightWave visit:

http://www.lightwave3d.com/learn/
http://www.youtube.com/user/OfficialLightWave3D

Sales Inquiries and General LightWave Support

For questions related to Pre-Sales, Licensing, Installation, or General LightWave software support:

Email : support@lightwave3d.com
Website : http://www.lightwave3d.com/support/

LightWave Bugs & Feature Requests

Use the Feedback Agent,  the support form at https://www.lightwave3d.com/contact/tech_support/ or:

Bug Reports: bugs@lightwave3d.com
Feature Requests: features@lightwave3d.com

Bug report emails should have attached Zip-archived content (scenes, objects, images) simplified down to just show the 
problem. The file size for any attachments should not exceed 10 MB.

LightWave Community

To connect with other LightWave artists for tips, tricks and tutorials, visit our online community: http://
forums.newtek.com

Copyright and Trademarks

LightWave™ and LightWave 3D® are registered trademarks of NewTek, Inc.© Copyright 1990-2018 NewTek, Inc. All rights 
reserved.

ZBrush™ and GoZ™ are registered trademarks of Pixologic, Inc. Maya™, MotionBuilder™ and FBX™ are registered 
trademarks of Autodesk, Inc.

http://www.lightwave3d.com
http://www.lightwave3d.com/learn/
http://www.youtube.com/user/OfficialLightWave3D
mailto:support@lightwave3d.com
http://www.lightwave3d.com/support/
https://www.lightwave3d.com/contact/tech_support/
mailto:bugs@lightwave3d.com
mailto:features@lightwave3d.com
http://forums.newtek.com
http://forums.newtek.com
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Common
Items common to multiple pages, or items written but not yet placed

Common Layout
Common Lights
Common Nodes
Common Renderer
Sliders
Light Conversion
Scene Conversion
Common I/O
Common Modeler
Menu Navigation
Upgrading From a Prior Version
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Common Layout
Align and Distribute
Coordinate System
Edit Tool
Move TCB
Package Scene
New Panel Hierarchies
Depth Options
Adding HyperVoxels
Color Copy
FBX Import
Rotofix
Location Picker window
Controllers and Limits Tab
Parenting
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Align and Distribute

Align and Distribute

Align and Distribute

Located on the Modify Tab > Arrange Group in Layout, these small but useful tools make aligning and spacing items 
equally in Layout easier. The Align tools work in much the same way as the Align to Last Point tools in Modeler, but for 
any Layout Scene items. To use them select the items you wish to align, then select the last item to which you want to 
align the other items. From the Align menu choose which axis (X/Y/Z) you wish to align against. Once clicked, all the 
items you selected will be aligned to the last item’s axis you picked.

To distribute, or equally space items, you don’t need to worry about the selection order, simply select the items you 
wish to equally space between each other, and choose the axis (X/Y/Z, or All Axis) you want to space the items along.

Please Note: Due to the way Generic Scripts operate in Layout, these tools will not contribute to any Undo. 
Make sure you save your scene if you are unsure whether you want to keep the changes, or you will lose the 
original positions of the items.


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Coordinate System

Coordinate System

The Coordinate System setting (Modify > General > Coord System) affects the Move, Rotate, and Move Pivot Point tools.

World (default keyboard shortcut Shift F5)

World allows easy movement based on the world axes, even for items deep within a hierarchy that contain rotated 
parents.

Parent (default keyboard shortcut Shift F6)

Parent is for movement based on the axes of an item’s parent(s). If an item has no parent then this setting is equivalent 
to World.

Local (default keyboard shortcut Shift F7)

Local is for movement based on an item’s own axes (such as dollying a rotated camera along its view direction). For un-
rotated items it is equivalent to Parent. Local can be temporarily activated by holding Ctrl.

Example

Below, we have rotated a null and then parented a distant light to it. The Show Handles option, discussed later is also 
active for illustration purposes, as it is by default. The handles will line up with the movement axes that would be used if 
you dragged your mouse.

Local
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  Parent

World  
Note how with World, the handles line up with the lines on the grid. With Parent, the handles line up with the rotated 
(parented) null. Finally, with Local, the handles line up with the distant light’s rotation.

Avoiding Gimbal Lock

Gimbal lock normally occurs after you rotate an item 90 degrees on its pitch using the Parent coordinate system. Once 
this has occurred, rotating the object about either its heading or its bank axis gives you the same result-you have lost 
the ability to rotate about the object’s local heading. Gimbal lock is commonly a problem with bones in a hierarchy. By 
nature, bones have a starting position that is often rotated 90 degrees on their pitch, like bones in the arm of a human 
figure. You can avoid Gimbal lock by rotating using the Local coordinate system.

The Position and Rotation Coordinate System settings are independent. To change the system, select either 
the Move or Rotate tool first.
One thing to remember about Local and World rotation is that they are only for interactive manipulation. 
Internally, the Parent system is always used since it’s the only one that can encode absolute rotation values. 
This will affect how an item’s orientation is interpolated between two keyframes. As such, rotating the pivot 
point might still be useful in some situations.





LightWave 2020  –  LightWave 2020

Appendices –  3396

Reset

You can quickly reset position and rotation to their initial states by selecting the item, activating the channel you wish 
to reset (i.e., Move, Rotate, Size, and other tools), and then clicking Modify > Reset. You can reset individual channels 
without being in the mode by hitting Reset Position, Reset Rotation or Reset Scale and all channels with Reset All.

Reset is not an undo feature, although it can sometimes work similarly. Resetting restores the state for the selected 
channels to what it was when the item was first loaded or created.

If you plan to move a pivot point, you should reset the item’s position and rotation first.

If you have Position or Rotation axes deactivated, Reset will have no effect on those settings.
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Edit Tool

Edit Tool

(default keyboard shortcut Ctrl E)

The Edit tool (Modify > Tools > Edit Tool) activates the ability to edit points on dynamic objects and particles. You will be 
able to visually see that you’re in Edit Mode in the viewport. All the points that make up the object will become 
highlighted and all the Edit tool functions will become active.

For more information about the Edit tools and some of its options, see the Dynamics and Particles sections.
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Move TCB

Move TCB

Another tool in the Modify menu will directly affect your motion path. At the bottom of the Modify list you will find Move 
TCB. This allows you to set the biases discussed in the Graph Editor section of the manual, but from Layout, rather than 
having to visit the Graph Editor itself. To use it, move to a keyframe, click on the Move TCB tool and you will notice that 
the lower left corner now displays T, C, B instead of the more familiar X, Y, Z or H, P, B.

 
You can enter figures in here for what you wish your TCB settings to be, or you can use the mouse:

LMB: Moving left and right alters the Tension
Ctrl+LMB: Moving left and right controls the Continuity
RMB: Moving left and right controls the Bias
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Package Scene

Package Scene

Package Scene, found in the Save menu, gathers information from your scene and locates the items into the specified 
directory. You can choose to Package Files for transporting it to a different hard drive location, either locally or on 
another machine; Consolidate Files, which will bring any files that are currently not in your content directory into it; or 
Create a Zip Archive of your scene. This last is like Package Files but with the addition of archiving the content 
directory.

Typing a path name works, just remember to hit Tab once you are finished typing

Package Scene is a Python script that will organize your scene content. It will also deal with .MDD, .BDD, and .PFX files, 
and works whether or not your content is actually in the current content structure. If a content element is currently 
loaded into your LightWave scene, Package Scene will find it.

VDB files and sequences are not copied with content directories
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4.
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6.
7.
8.
9.

10.

11.

Select the destination folder and if you want a new level under that for each subdirectory, type the name in the 
Subdirectory box. The paths will be updated after tabbing or pressing the Enter key.

Preserve Existing Structure - When checked, Package Scene will keep any specific content directory structure 
you are using, preserving subfolders and naming conventions
Copy Image Sequences - Image sequences can often get very big so are often defined outside the normal 
content directory structure. If you'd like to keep the scene package integral, you can check this option to bring a 
scene's image sequences into the content directory structure. The choice of using a named subfolder for 
sequences is yours
Copy UDIM Sequences - As above, but for UDIM image sequences.
Copy Radiosity Cache File - If a cache has been generated it makes sense to include it with the package so it 
doesn't need to be regenerated.
Reload Original Scene After Export - if you are using Package Scene to prepare files for sharing, it may be that 
you want to reload the original scene, if so check this option. If you want to make sure the Package has worked, 
you will probably want to use the packaged scene so leave this option unchecked.
Export for 2015 - Saves a version of the scene that can be loaded in LightWave 2015. The scene file version is 
converted to one 2015 can load and objects are saved in LWO2 format. Be aware that 2018 has many features 
that don't exist in 2015, from lighting to surfacing so further editing of the 2015 version of the scene will no doubt 
be needed.

After the interface in which you select the target directory for the export, the script:

Gets a list of all images and their paths.
Copies these images to the target directory.
Replaces all the images with their new location.
Changes the content directory to the target content directory.
Saves each object to the target location.
Saves the scene to a temp location.
Parses the scene file to find .MDD, .BDD, and .PFX references.
Finds and copies the dynamics files to their target location.
Rewrites the scene file, changing the respective dynamics paths, to the target location.
Loads the new scene file. This means at the end of operations, the user is now active in the newly exported and 
saved version of the scene, not the original scene from the original location.
If Reload Original Scene is checked, it will instead load the original scene.
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New Panel Hierarchies

New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.


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Depth Options

If your normalized depth buffer is only showing black or white for geometry, make sure the Depth Buffer 
options are set correctly for your scene. Visit Render Properties (Ctrl+F9) > Buffers > Depth and set the Options 
to an appropriate range for your scene.


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Adding HyperVoxels

To add Legacy HyperVoxels to an object (null or geometry), go to the Effects window, Legacy Volumetrics tab and add 
HyperVoxels. Double-click the HyperVoxels 3.0 entry and add the object you wish to have HyperVoxels on. 
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Color Copy

Colors can be copied and pasted by clicking Ctrl RMB on the swatch, then Alt-clicking RMB on the target 
swatch. (On the Mac, use Option for Alt)

Ctrl right-clicking on the blue swatch, then Alt right-clicking on the green replaces it with blue.


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FBX Import
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It is important to note the following

FBX has a concept of item position separate from the animation of the item.
FBX has a concept of poses, which store positions of item.
FBX has a concept of skin cluster binding, which can be separate from poses and animation and non-
animated position.

Layout only has one concept, the animation

Frames less than zero to support these FBX concepts that Layout does not support directly.

Frame -1: the binding position (applicable when skin clusters are used)
Frame -2: the not-animated position (can be same as Frame 0, but may differ)
Frames < -2: poses (if any); each pose on a different frame.





LightWave 2020  –  LightWave 2020

Appendices –  3406

Rotofix

Rotofix

RotoFix is a Layout generic LScript, added to 2019.0.2, that adjusts the rotation keyframes of a selected item, in order to 
correct for rotation value wrap-around (e.g. heading jumping from 179 degrees to -179 degrees, instead of going from 
179 degrees to 181 degrees). This is important for correct interpolation (e.g. 179 degrees to -179 degrees is a change of 
358 degrees, while 179 degrees to 181 degrees is a change of only 2 degrees, even though the initial and final orientation 
of the item is the same in both cases).

It does this by minimizing the change in rotation values between keyframes while keeping the resulting orientation of 
the item unaffected.



LightWave 2020  –  LightWave 2020

Appendices –  3407

Location Picker window

The Location Picker window allows the user to choose an emplacement on the Earth to be lit. You can either choose by 
selecting on the map, by typing Longitude and Latitude coordinates or choosing a Location Preset from a dropdown 
menu. Choosing from the Preset locations will also set the Time Zone field, but equally any time zone, date or time can 
be set. The Get Current Date and Get Current Time buttons do just that, but where the user is situated, not the 
location chosen in the picker.

Note that while all details are kept upon reopening the Location Picker window, the Location Preset dropdown 
menu is reset.


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Controllers and Limits Tab

The Controllers and Limits tab has been updated to include Position and Scale controls. The limits are based on the 
parent space and not world coordinates.

The World options for Rotation will use the world coordinates, rather than the local coordinates.The “Transform” Item 
option will select the item which influences the current item.

Interpolate uses the blend to interpolate between Same As Item value and channel value.Compensate removes the 
Same As Item value from the channel value to a degree specified by the blend.

Heading, Pitch and Bank Limits

We can determine a range within which a rotational channel of an item can rotate. This is useful to keep joints from 
hyperextending or keeping IK controlled joints from “popping”. It is also useful to keep items that are very closely 
spaced from rotating in and through each other.

Heading, Pitch and Bank Stiffness

This setting allows you to set a stiffness or resistance on the rotational channels of an item. This works when the 
controller for a channel is set to IK. The Stiffness setting can help to determine which items in an IK chain will bend first 
or last. Higher values make a joint harder to bend and lower values easier to bend.
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Heading, Pitch and Bank Controllers
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1.

2.

3.

4.

5.

6.

7.

Scale Controllers

Position Controllers

Controller Types

These contain seven options for controlling the rotation, position and rotation channels. Not all options are available 
for all channels.

Keyframe - This simply means that you can manually orient an item in that channel and keyframe its position at 
anytime.
Point at Target - This allows a particular rotational channel to target an item. Target Item in the main motion 
panel must be set to some item.
Align to Path - This allows the rotational channel of an item to align to its motion path. With the Align to Path 
Look Ahead controller under the IK and Modifiers Tab we can make this channel look ahead or anticipate a turn.
Inverse Kinematics -This allows IK to control this channel. If other channels are set to FK we can selectively 
determine which rotational channels are controlled via IK or FK.
Align to Velocity - The channels controlled by this option will have the same values as the corresponding 
channels of the set item. The stiffness value can be used to interpolate. The one for position has the option to 
use the world coordinates of the position item (instead of local). The calculations currently assume that X, Y, and 
Z are controlled, so the result may not be optimal if not all three position channels are “Same as Item” 
controlled.
Align to Pole - This option adjusts the angle of the item so it points towards the pole. It is similar to the target 
item, and typically used in combination with it.
Same as Item - The channels controlled by this option will have the same values as the corresponding channels 
of the set item. The stiffness value can be used to interpolate. The one for position has the option to use the 
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world coordinates of the position item (instead of local). The calculations currently assume that X, Y, and Z are 
controlled, so the result may not be optimal if not all three position channels are “Same as Item” controlled.

Record Minimum/Maximum Joint Angles

You can interactively set the rotational Min and Max values by rotating the item to the desired minimum direction and 
choosing Setup > Motions > Limits > Record Minimum Joint Angles (default keyboard shortcut: {). This will activate 
minimum limits for any rotational parameters (heading, pitch, or bank) that are currently active for the chosen item. 
Similarly, rotating the item to the desired maximum range limit and choosing Setup > Motions > Limits > Record 
Maximum Joint Angles (default keyboard shortcut: }) will automatically input the values into the maximum limits for the 
active rotational parameters.

You should deactivate Heading, Pitch, and/or Bank to avoid setting limits for channels you don't wish to.
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Parenting

If you select multiple objects in Layout and hit the E key, the objects selected will be parented to the last 
object selected.

The E key is pressed after each lasso selection to parent one null to the other selected


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Common Lights
Light Affect Diffuse
Light Affect OpenGL
Light Affect Specular
Light MIS Samples
Light Normalize
Light Visible to Camera
Portal
Volumetric Distance
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Light Affect Diffuse

Affect Diffuse

Deactivate to prevent a light from affecting the general color or brightness of a scene. This is particularly useful when 
you add lights to a scene for creating specular highlights. Often you want a light that creates a nice specular highlight 
on a surface, but you don’t want it to affect the rest of the lighting.
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Light Affect OpenGL

Affect OpenGL

This option is for display purposes only. It will not change the effect a light has on a rendered image. With this option 
you can prevent the light from affecting Layout’s display, which uses OpenGL. This is important since the number of 
lights that can affect an OpenGL display is usually limited to 8 depending on the graphics card (if your card supports 
more, see the GL options tab of the Preferences Panel to increase your maximum).
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Light Affect Specular

Affect Specular

Deactivate to prevent the light from creating specular highlights; the light still affects the color and brightness of the 
scene, however. This is very nice for adding lights in a scene to approximate the look of radiosity. A scene often needs a 
very high number of lights to give it the appropriate realism and warmth. However, adding too many lights can cause 
objects with a high Specularity setting to reveal the light’s presence with multiple hot spots. By disabling specularity for 
these lights you can overcome the problem.
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Light MIS Samples

MIS Samples

Some lights perform Multiple Importance Sampling, a more accurate version of the Importance Sampling introduced in 
LightWave 2015 that is available through the Global Illumination tab in Render Properties. It is more accurate because it 
is directly sampling the environment image, whereas the GI version is one step removed sampling the GI result of the 
environment map.
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Light Normalize

Normalize

There is a Normalize toggle in most Light Properties windows. Light intensity is now set in Lux, which is Lumen per 
meter squared. This means that as your lights change size so does their intensity. With Normalize off, a smaller light of a 
given intensity will give out less light, a bigger light more. With Normalize on, the intensity stays the same. It might 
appear to become dimmer in some cases but this is merely because the light output is being spread over a larger area.

The area of a Distant light will decrease as you reduce the angle in the panel, and thus its power diminishes if Normalize 
is not checked. 0° is a special value, and the Distant light will behave the same Normalized or not, with hard shadows.
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Light Visible to Camera

Visible to Camera

A light with this option will be presented in the render as a visible light in the shape and size of its OpenGL 
representation. A light's size and shape can be altered in the Light Properties panel, or, in the case of Area and Linear 
lights, by using the Scale and Stretch tools in the viewport.

Though the Visible to Camera option may not be set in Light Properties, lights will still appear in reflections 
unlike earlier versions of LightWave.


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Portal

Portals

Area and NGon lights can be used as portals. Portal lights are guides placed in indoor scenes that help the 
renderer to concentrate environment lighting through openings like small windows.

The circle showing the ray source and box for the portal are purely for illustrative purposes. The light with the portal should 
be outside and larger than the opening

Portals work with the environment light and its plugins - Image World, Textured Environment, gradient backdrop or 
similar. While portals will add time to renders they also clear up noise and bring a lot of extra detail that you don't get 
using an environment light alone.

For copyright reasons, a gradient has replaced the HDR image for this scene. The effect is more 
interesting with a proper HDR image.



https://docs.lightwave3d.com/download/attachments/8201338/Light_Portals.zip?api=v2&modificationDate=1575626989000&version=1
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This scene is lit purely by the Environment light with an HDR image texture

The same scene, with an Area light with the Portal switch turned on. The increase in detail and color, and reduction in 
noise,  for the interior of the room is excellent considering the extra rendering time. The two scenes are available above to 
try for yourself.

The reason for turning Normalize off when using a portal light is that the color and intensity are coming from 
the backdrop environment rather than a localized light source. As such, the size of the portal has no bearing on 
the quality of light coming through the opening and so Normalize is turned off automatically when Portal is 
engaged. Normalize can be turned back on for artistic reasons.


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If your scene has multiple lights, or large openings for light to come in from the environment, using a portal is 
not necessary - it can unnecessarily slow down rendering and even create additional noise. Equally, complex 
material networks will benefit from direct lighting rather than the additional computation necessary for 
portals. Finally, if you have several small openings on a wall, consider using a single portal that spans them all 
instead of multiple portals that can increase render setup time.


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Volumetric Distance

Volumetric Distance

The Volumetric Distance setting, added in LightWave 2019, is the distance the volumetric effect reaches from the ray.
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Common Nodes
These nodes are common to multiple materials. The explanations here are then incorporated into the explanations for 
those materials.

Absorption
Anisotropy
Asymmetry
Bump Height
Color Input
Cubic Projection
Cylindrical Projection
Dispersion
Dynamics Part Info
Flatness
Front Projection
Image Sampler
Luminous
Planar Projection
Refraction Index
Roughness
Scattering
Sheen
Specular
Spherical Projection
Subsurface
Surface Input
Transmission
Transmittance
Transparency
Transparency 2
UV Projection
Default UV Map
OpenVDB nodes
Level Set Morph simple
Partio Node simple
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Absorption

Absorption (Scalar)

How quickly light passing inside an object is extinguished. A low value here with indicate greater transparency. Based 
on Beer’s law of absorption, to give a more realistic and non-linear result.
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Anisotropy

Anisotropy (Scalar)

Anisotropy is a bias in the direction of lighting a surface. At 0 % a surface is isotropic, meaning there's no bias. As you 
approach 100 % your surface will become maximally anisotropic. Some degree of Roughness is necessary for 
anisotropy to be visible, and the amount tells the anisotropic highlight how far to "spread".

 

Rotation (Scalar)

This determines the angular rotation for your anisotropic highlights. At 0 % the rotation will follow the curve of your 
object and at 50 % will be perpendicular to it.

Anisotropy requires that there is a Projection node input otherwise you will get strange polygonal shapes in 
the render.

Left: Anisotropy at 100 %, Rotation at 15 %, Roughness at 30 %. Right: No Projection


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Asymmetry

Asymmetry (Scalar)

Ratio between the amount of forward to backward scattering. With a positive value, more light is scattered from behind 
the object, with a negative value more light is scattered from in front of the object, relative to the observer.

With this example we have two lights, one in front, one behind our sphere. Both are very strong and the one behind is 
colored green, the one in front red. With Asymmetry set to 0.5, the light from the green light is scattered forward 
towards the observer, in this case the camera. When Asymmetry is set to -0.5 the light from the red light behind the 
camera is reflected toward the observer.
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Bump Height

Bump Height (Scalar)

Specifies the bump height or “amplitude” of the Bump directional vectors.
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Color Input

Color (Color)

The surface color, often supplied by texture maps.
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Cubic Projection

Cubic Projection

Cubic projection is essentially the same as Planar, except that you cannot select a Texture Axis. Cubic projects the 
image from all three axes at the same time. The image is projected like Planar, except simultaneously along all three 
axes. Use Cubic when you wish to apply the same image to all sides of a rectangular shape, such as an image of tiling 
bricks wrapped around the sides of a building, or wallpaper on the walls of a room.

Note that Cubic Projection projects along the X, Y and Z axes and objects merely intersect these projections. 
This means that images like text will only be correct on three sides, the others will be reversed as shown here 
with the images that have the arrow coming out of them rather than going in. Creating an item like a dice 
needs six planar projections to be correct.


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Cylindrical Projection

Cylindrical Projection

Cylindrical projection wraps an image around the selected axis like a paper towel wrapped about a cardboard tube. By 
default, an image is wrapped so it covers the surface once, allowing the side edges of the image to meet on the back of 
the surface. A soda can and a tree trunk are both good examples of surfaces that would use Cylindrical projection.

Cylindrical projection is always wrapped around a surface so that the top of the image appears towards the positive axis 
side of the Texture Axis.
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Dispersion

Refraction Dispersion (Scalar)

Controls the amount of light dispersion. Dispersion is a phenomenon that causes the separation of a wave into spectral 
components with different wavelengths, due to a dependence of the wave’s speed on its wavelength. This will cause the 
surface to render more slowly as it renders each spectral component separately (red, green and blue).

Dispersion as used in this shading model simulates real light dispersion. The higher the value the greater the amount of 
dispersion that will be simulated and applied.
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•

Dynamics Part Info

The Dynamics Parts Info node allows you to control an individual element of a Bullet Parts object. You need to attach an 
Item ID node pertaining to the Parts object into Item ID on this node and an Integer node to determine the part you wish 
to use.

In this screenshot we show the Pyramid-shaped Null has the Nodal Motion modifier attached. When we press play on 
the scene, the null will jump to the Part indicated by the Integer node. We have it set to the default 1, which means the 
Null will jump to the middle front box. As the boxes fall, the null will match movement and rotation to the part.

Inputs:

Item ID - The dynamic item in the scene that uses Parts
Part Number - The ID of the individual part
Polygon Index - The polygon index for the part

Outputs:

Part Number - Index number of the part
Internal Polygon - 1 if the polygon is a boundary between two parts which have not separated yet (i.e. the 
polygon is inside the volume, not on an outside surface), 0 otherwise. This is what you would use to clip away 
polygons that shouldn't be visible yet
Part World Position - World position of the center of mass of the part
Part World Right/Up/Forward - Right/Up/Forward vectors of the part in world coordinates. Parts start off with 
the same orientation as the item
Part World Rotation - HPB rotation of the part in world
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Taking the Internal Polygon output to the Surface Clip input will hide internal polygons for a fractured object 
in Bullet


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Flatness

Flatness (Scalar)

Flatness is an alternate, flatter diffuse shape. The effect is subtle and not always easy to see when combined with other 
material properties. The example has 100 % Roughness, 0 % Specular and 0 % Fresnel.
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Front Projection

Front Projection

The concept of Front projection is very simple and quite similar to a chroma-key effect. However, instead of applying an 
image where a color screen is, it replaces the selected surface(s) with a selected image.

In most cases, the image you select for a Front Projection Map is the same image you use for the Background Image on 
Layout’s Compositing Tab of the Effects Panel (Windows > Compositing Options).

Scale, Position, and so on, are not relevant with Front projection. It is always the size (and frame/pixel aspect) it would 
be if loaded as a Background Image. As such, changing the Resolution or Pixel Aspect Ratio on the Camera Properties 
Panel will also affect the Front projection.Front projection is used primarily for comp (compositing) work where you 
combine LightWave objects with a live-action background image or sequence. A common example occurs when you 
want a LightWave object to cast a shadow (believably) onto the image or behind a portion of the background image.

The image used in the surface and the background will pin-register the surface to the background, letting you go in 
front or behind. Your object then appears to interact with the environment. You can cast shadows or cause reflections 
from a regular 3D object onto the surface that is front projection mapped.
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Front-Projection mapped Ground surface catches the character’s shadow.

The ground object is just a flat box with Front Projection Image Mapping that uses the same image as the background. 
Its job is merely to catch the object’s shadow.

Another example is to use an image of trees as your background image and fly a UFO between them so the UFO appears 
to go in front of some trees and behind others. All you need to do is model some rough shapes that match the trees you 
wish to fly behind (they could even be flat planes).

Another good example for Front projection is to create a flat plane and align it to an image of an ocean or a lake. Front 
projecting the water surface onto it lets you place an object beneath the water and push it through the surface. 
Submarines and sea creatures will appear to break the surface this way.

The hardest part of Front projection is aligning the objects, matching lighting, and getting the right camera angle. Using 
Background Image as the Camera View Background on Layout’s Display Options Tab of the Preferences Panel (Edit > 
Display Options) will allow you to do all that. You also must search for the right balance of Luminosity and Diffuse for 
the Front projection surface so that the object’s true shape is not revealed by shading.

Fixed Projection

Front projection surfaces will always look the same no matter where you move the object or which way you rotate it. 
The image does not normally stick to the surface. However, if you activate the Fixed Projection option (previously Sticky 
Projection), it fixes (i.e., locks) the projection from the camera’s perspective at the specified Time.

The default unit of measure for Time depends on the Frame Slider Label setting on the General Options Tab of the 
Preferences Panel in Layout or the Time Format setting on the Display Options Panel, Units Tab in Modeler. You may 
specify the unit of measure by appending f for frames or s for seconds to the entered number (e.g., 22f for frame 22, 31s 

NOTE: Don’t use the Soft Filter (Camera Properties Panel) with Front projection. It will soften only the image 
used on the object surfaces, not the background.


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for 31 seconds). You may also enter SMPTE time code, like 00:00:01:16 for one second, frame 16. The entry is converted 
to the default unit of measure.

Use Fixed Projection to create parallax with two-dimensional images by using a technique called Camera Mapping. (Use 
the Reference Camera setting to select the camera, if you have multiple cameras in your scene.)

Essentially, you set the frame where the texture will be pin-registered to the background (like normal Front Projection 
Mapping). On all other frames, the texture is stretched to compensate for more or less of the texture being visible, which 
is caused by factors like the camera being moved.For example, in a picture of some buildings, you could place the 
LightWave camera in the same place as the original camera in relation to some simple 3D buildings; then, you could 
project the picture onto the buildings and lock it at frame 0. You’ll need a doctored background image/object - with 
Fixed projection - to reveal what’s behind the buildings. If you move the camera forward, it will appear to fly into or 
around the buildings.

Use your paint program’s rubber stamp function to erase areas where background Fixed projection surfaces 
will be revealed.

Obviously, there are great limitations in getting three-dimensional data out of a two-dimensional picture. 
However, short slow-moving sequences can be quite realistic.



Using the Shadow Catcher workflow offers a more modern way of achieving the result
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Image Sampler

An image node that allows more external control than the standard Image node. It uses the Projection nodes to 
determine how the image will be attached to the surface. A Projection node isn't needed for intrinsic Object UVs so the 
Image Sampler's Color output can be plugged straight into the Color Input on a primitive shape.

Invert Alpha inverts the alpha portions of the image so that the alpha region becomes solid and non-alpha becomes 
transparent.

Invert Color inverts the color of the image.

2019.1 brings separate color channel outputs to the Image Sampler node.



LightWave 2020  –  LightWave 2020

Appendices –  3441

Texturing the plane does not need a projection because the plane is a primitive with intrinsic UV map.
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Luminous

Luminous (Scalar)

How luminous your material is. This value can far exceed the 0-100 % range.

Luminous Color (Color)

The color with which your surface will glow. As normal, glowing objects only light others if GI is used.

Use luminous geometry sparingly for lighting a scene - using lights is far more efficient. If the luminous object 
you want to use to light the scene is roughly spherical, add a Spherical Light for the effect instead. If it's more 
of a box shape, use an Area Light shaped to the rough dimensions. Only use a Primitive Light when you cannot 
roughly replicate the shape of your luminous object

Lights are directly sampled, and Importance sampled, by a scene's GI. Luminous geometry is not. The scene 
knows exactly where the lights are and samples them, luminous objects are only sampled when hit by GI 
calculations.


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Planar Projection

Planar Projection

Planar projection will project an image onto a surface as if you were projecting the image through a slide projector onto 
a wall. Planar Image Maps are best used on flat, or nearly flat surfaces like the sides of buildings and the screens of 
video monitors.

For the X and Y axes, Planar images are projected from the positive axis side of a surface towards the negative axis side. 
This means that the image appears correct when viewed from the positive side and it appears reversed if you view it 
from the negative side. For the Z axis, Planar images are projected from the negative side.

If you encounter this reversing effect and it isn’t what you want, you can reverse an image back by making the Scale 
value negative for the axis that needs to be reversed.
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Refraction Index

Refraction Index

The Index of Refraction determines how much light is bent when it enters a material. Common values include 1.33 for 
water, 1.42 for olive oil, 1.52 for crown glass, 2.42 for diamond.
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Roughness

Roughness (Scalar)

This setting is usually paired with Specularity and defines how tight the reflection will be. A high roughness will mean 
that the surface might be reflective but the reflection will be diffused and unrecognizable.
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Scattering

Scattering (Color)

Scattering is a volumetric effect. To work properly, it needs to have Affect Volumetrics turned on in lights. Otherwise, it 
only absorbs light according to the scattering color.

Scattering Distance (Scalar)

How far Scattering reaches.



LightWave 2020  –  LightWave 2020

Appendices –  3447

Sheen

Sheen (Scalar)

An additional grazing-angle component (primarily for cloth)

Sheen Tint (Scalar)

Amount to tint sheen towards base color.
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Specular

Specular (Scalar)

Specularity is the correct term for reflection. Normally all surfaces have some element of incident reflection and this 
setting is usually accompanied by a Roughness setting (in the Standard material this accompanying setting is called 
Glossiness and works in the opposite direction - 100 % Glossiness is the same as 0 % Roughness).
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Spherical Projection

Spherical Projection

Spherical projection wraps an image around a surface as if you were stretching a flat piece of rubber around a ball, but 
without having to worry about the edges all meeting. Planets, basketballs, and marbles could all use Spherical 
projection.

Spherical projection does not use Scale parameters. Images are wrapped completely around the surface (using the 
Wrap values, discussed later). Spherical projection is always oriented so that the top of the image appears toward the 
positive side of the Texture Axis.
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Subsurface

Subsurface (Scalar)

Defines how much you want your subsurface color to be visible. If you set this to 100 % it completely replaces the 
surface color.

Subsurface Color (Color)

The subsurface color you want under the surface of your material. The quantity of visible subsurface color is defined by 
the following two options:

Distance (Scalar)

How far "into" the surface before the subsurface color is seen. If you make this value larger than the object that uses 
this material then the subsurface scattering will not be visible.
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Surface Input

Surface Input

When editing a surface, this node always appears in the Node Editor.
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Item ID (Integer) -  The LWItemID of the intersected primitive
Pixel X, Y (Integer) - The location of the pixel currently being rendered
Frame Width, Height (Integer) - The resolution of the image set in Camera 
Properties
Ray Position (Vector) - Origin of the ray that intersected this primitive (from the 
Camera, Reflection, Refraction, Shadow, etc.)
Ray Position dX, dY (Vector) - Ray origin differentials
Ray Direction (Vector) - The direction of the ray that intersected this primitive (from 
the Camera, Reflection, Refraction, Shadow, etc.)
Ray Direction dX, dY (Vector) - Ray direction differentials
Ray Weight (Color) The accumulated weight of the ray represented as a color
Ray Distance (Scalar) - The distance the ray traveled before intersecting the 
primitive
Shutter Time (Scalar) - The normalized shutter time (0...1)
Ray type (Integer) - Camera ray, Reflection ray, Refraction ray, Dissolve ray, Shadow 
ray and Occlusion ray. These can be fed into the Ray Type Switch node.
Ray Bounce (Integer) - The number of bounces the ray has taken to reach this 
intersection. Starts at 1
World Position (Vector) - The location of the intersection in world coordinates
World Position dX, dY (Vector) - The partial derivative of the world coordinate 
position in relation to X or Y coordinate of the pixel
World Position dU, dV (Vector) - The partial derivative of the world coordinate 
position in relation to the U or V coordinate of the pixel (for objects with automatic 
UV maps)
Perturbed Normal (Vector) - The interpolated normal perturbed by bump or 
normal mapping
Smooth Normal (Vector) - The interpolated normal
Geometric Normal (Vector) - The un-interpolated geometric normal
Normal dU, dV (Vector) - The partial derivatives of the normal along U and V 
coordinates
Barycentric Coordinates  (Vector) - The masses of each vertex on a triangle
Object Position  (Vector) - The location of the intersection in local coordinates
To Local, To World (Matrix) - Transformation matrices for the intersection
U, V (Scalar) - The U or V coordinate for the intersection, presuming the surface has 
UV coordinates
U and V dX, dY (Scalar) - The U and V partial derivatives along pixel X and Y
Primitive ID (Integer) - A Primitive can have an ID assigned that is different to the 
Item ID
Surface Side (Integer) - Determines if the intersection hit the front (0) or back (1) of 
the surface (2 double-sided back) (Example)
Polygon Index (Integer) - The numeric index for the polygon at the intersection
Mesh Element (Integer) - Outputs the element type needed for the Mesh Element 
Switch node
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Transmission

Transmission (Color)

The transmission of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Transmission Weight (Scalar)

This is the distance at which the medium absorption color reaches Transmission Color.
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Transmittance

Transmittance (Color)

The transmittance of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.

Transmittance Distance (Scalar)

This is the distance at which the medium absorption color reaches Transmittance Color.

Transmittance requires Volumetrics to be enabled; otherwise, there will be no color.
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Transparency

Transparency (Scalar)

Defines how transparent a surface is, often paired with

Refraction Index (Scalar)

This value is for the Index of Refraction of your material. Often used - 1.33 for water, 1.5 for glass, 2.4 for diamond.
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Transparency 2

Transparency Weight (Scalar)

This is the distance at which the medium absorption color reaches Transmission Color.

Transparency Color (Color)

The transmission of a material is its effectiveness in transmitting light - how transparent it is - and what color light it 
transmits through the material it is paired with.
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UV Projection

UV Texture Maps

The U and V refer to Texture Map coordinates and are really not very different from the XYZ coordinates you are familiar 
with. In fact, UV Mapping is the process of setting up a relationship between the two dimensions of an image, U and V, 
with the three dimensions of an object surface, XYZ.

Once this relationship is set up, changing any parameter (i.e., U, V, X, Y, or Z) will also relatively change the appearance 
of the Texture Mapping. With UV Mapping, the object provides additional information for Texture Mapping, which can 
be different for any given point on the surface. The texture is more or less stuck to points on the surface using a 
relationship that you define.

UVs and Projection

UVs have to come from somewhere. For existing polygonal models, the choices are limited to setting the UV coordinates 
for each point in the object manually, or applying some projection, which automatically generates the 2D Texture 
coordinates from the given 3D point positions. In LightWave, you can create UVs by using projections, which also 
happen to be the same as the standard projections for Texture Mapping (i.e., Planar, Cylindrical, and Spherical).Usually, 
the projection for the UV Map is not suitable for the whole model. The projected UV Map must be tweaked - eyes and 
nostrils moved over the right parts of a face, or texture features matched to geometry features.

For illustration purposes, let’s say you had your texture image printed on a piece of very flexible rubber and wanted to 
fit it on a toy car made of wood. You could conform the rubber material to contours of the car by tacking it down with 
thumbtacks. That is more or less what UV Mapping does. However, it is slightly reversed: what you do is tack the UV 
points down onto the image. Alternatively, imagine that your image is printed onto flat paper and you use an advanced 
form of Origami to fold it into shape.

Keep in mind that standard Projection Mapping is more accurate because it has some exact, continuous value 
over the entire surface. UV Mapping, on the other hand, is technically accurate only at small sample points. 
The surface for the large areas in between the sample points is interpolated. Adjusting the sample points so 
that the interpolated areas look right is difficult and the reason why UVs are more difficult to use.





LightWave 2020  –  LightWave 2020

Appendices –  3458



LightWave 2020  –  LightWave 2020

Appendices –  3459

Default UV Map

Default UV Map

You can now create a default UV map in Modeler. It is represented in the interface with a bullet by the name. The major 
benefit will be that a specific UV map will not have to be defined, leading to much faster UV workflow. The default UV 
map will also be used in Layout for the Surface Input node's U, V and dU, dV outputs.
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OpenVDB nodes

Click here to expand Table of Contents...
Common
Solid Volumes from Meshes and other Scene Items

Mesh To Volume
Shape To Volume
Fog To LevelSet
From Particles

Gaseous Volumes from Scene items
Gas Solver
To Fog Volume

Tools
Advect
Advect Points
Analysis
CSG
Combine
Filter
Level Set Morph
Noise
OpenVDB Info
Partio Node
Attributes list
Resample
Saver
Scatter
Solver
Vector Merge and Split
Velocity
Visualize

Common

 OpenVDB nodes may have the following common settings:

Voxel Size - Size of the voxel grid in meters (LightWave supports uniform grids); the size of the voxel "blocks" 
that will make up your object
Inner Bandwidth - Inner Bandwidth for level set in voxels
Outer Bandwidth - Outer Bandwidth for level set in voxels. For fog volumes, this defines the "softness" until 
maximum density is reached.
Fill Interior - Toggle for whether the volume will be solid when cut into or just a shell - like polygons are. Turning 
on Fill Interior with a Fog Volume will soften the outside of the fog
Coordinate System - How the voxel will be transformed. There are three choices

Local - No transform
World - Transform into world space


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Parent - Use the parent item's space

Grid Name - the base name of savedgrid.vdb files. Files will be appended with the frame number and written 
with temperature, density, and velocity grids

Solid Volumes from Meshes and other Scene Items

Creating a volume this way requires a target mesh, primitive shape or Particle emitter that needs to be in the scene. It 
can be out of camera view, hidden from render and hidden in OpenGL and the Object Replacement will still work. To 
create a volume from this item requires adding a null and using the Object Replacement entry OpenVDB Evaluator. 
Clicking Properties for it will bring up a Node Editor window.

Mesh To Volume

Creating volumes from meshes relies on polygons being tris or quads. NGons are not supported
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In the OpenVDB nodes group, Mesh To Volume will be the node to convert your mesh objects into volumes. There are 
two choices for conversion, Fog Volume will convert a mesh into a volumetric fog, much like the image at the top of this 
page, but you need to use an OpenVDB primitive. The second option is Level Set, which creates a volumetric mesh 
object. The Voxel Size setting will determine the resolution of your volumetric object. For the Logo Rezzing Up
example, a Scalar Constant node was used with an envelope that went from the default 1 down to 0.0025 to create the 
increasing resolution of the volume.

Particle Radius is where you set the size of individual particles if you will be outputting a particle system from this 
node.

The new Attributes tab, added in 2020, is where you can transfer details like vertex maps or surfacing information from 
the original mesh to your OpenVDB object.

Surfaces will all be added. You cannot just choose one.

Shape To Volume
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Will create a volume from LightWave primitive objects.

Fog To LevelSet

Converts a Fog grid to a Level Set mesh object. A fog grid can be imported using the OpenVDB Info node. Double-
clicking the node brings up its window with Iso setting and Normalize toggle.

From Particles

New to 2020. There is now a Particle System output to send particles directly to the Editor Input. You can choose to 
represent particles as individual spheres or a trail (of connected spheres). When you select Trail, a Trail Resolution
setting becomes available. Higher values mean more trail particles and might be needed for high-velocity trails.

The Morphology tab includes elements that are found in the Filter node that can be applied directly, without needing a 
discrete Filter node.
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This node will create a volumetric object from a stream of particles created using the FX Emitter or the Scatter or Solver 
nodes here. You have the option to either create sphere shapes or a trail per particle derived from their position, radius, 
and velocity. Each trail is generated as CSG unions of sphere instances with a decreasing radius.

When you have a particle emitter being meshed, you cannot bring up the particle properties, as upon meshing 
(the OpenVDB Evaluator being an object replacement procedure), the PFX Emitter server pane will close. The 
only way to adjust particle properties, in this case, is by using the modal FX Browser panel.

The same is true for other server pane items - changing the subdivision level, for example - but in that case, the 
only workaround is to disable the VDB object in the Scene Editor by unchecking the render flag.



FX Emitter particles must have a Size, and that size must be output with the Output Size toggle. You don't 
need to Show Size; it just helps visually.


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Particle System - A dropdown for choosing the specific particle system you want to use. Using the Input ghosts 
this control
There are two tabs next:
Surface - Details how the particles look:

Particle Count - A readout of attached particle system particle count
Space - Choose whether your particles are situated in Local, Parent or World Space
Particle Type - Choice between Sphere and Trail. Sphere will create distinct bubbles whereas Trail will 
attempt to use particle velocity to create a trail of diminishing size. Each trail is generated as CSG unions 
of sphere instances with a decreasing radius
Trail Resolution - Only available when the Trail Particle Type is chosen. The default of 1.0 trails off 
"normally". Less than 1.0 means fewer trail particles and separation might be noticeable. More than 1.0 
means more trail particles are created. Higher trail speeds might need more particles to stay stream-like 
so separation doesn't show
Voxel Size - Size of the Voxel for the particles. Voxels sizes in a network should be the same, especially 
combining or collisions between VDB grids
Iso Surface - Iso sizes in a network can be different but the editor input node will create the final meshing

Morphology - Operators so additional nodes are not needed
Dilation - Dilate the grid along its normals making it bigger
Closing - Dilate the grid to close holes then erode closing openings
Smoothing - Gaussian smoothing

The direction of a trail is inverse to the direction of the Velocity vector, with a length of |V|. The radius at the 
head of the trail is given by the radius of the particle and the radius at the tail of the trail is Rmin voxel units 
which has a default value of 1.5 corresponding to the Nyquist frequency.


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Gaseous Volumes from Scene items

Gas Solver

Gas solver.  Use Stam's stable fluids method to advect density and temperatures. Both the density and the temperature 
affect the fluid’s velocity. Heavy smoke tends to fall downwards due to gravity while hot gases tend to rise due to 
buoyancy. We use a simple model to account for these effects by defining external forces that  are directly proportional 
to the density and the temperature.

buoyancy = (-densityscale * density * Vec3f(0, 1, 0)) + (temperaturescale * temperature 
* Vec3f(0, 1, 0));

External forces can be added on the Force Grid input. This input accounts for external forces like gravity, wind, 
turbulence and merely is added onto the end of the momentum equation.

Temperature Tab
Ambient Temperature - Ambient air temperature
Clamp Temperature - Clamps the temperature to the minimum value set below (otherwise the gas cools to the 
point where it falls like dry ice)
Min - The minimum temperature (in Celsius) for the gas to fall to
Normalize Temperature Grid - Outputs the temperature grid as a scale between 0 and 1, rather than, say, 60 
and 900
Fuel Temperature - Fuel temperature as it is emitted
Gas Density - Density of emitted smoke from the fuel grid

http://physbam.stanford.edu/~fedkiw/papers/stanford2001-01.pdf
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Fuel Velocity - Velocity of emitted smoke and heat from the fuel grid
Density Scale - Scale of the downward pull on dense smoke
Buoyancy Scale - Scale of the temperature gradient pulling smoke upward
Cooling Scale - Scales the cooling rate
Dissipation - The amount of density that falls off over each iteration so that the gas thins over time

Advection Tab
Spacial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spacial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Max Divergence Steps - Maximum number of iterations of the pressure solver
Advection Sub Steps - Substeps per integration step. The only reason to increase it above its default value of 
one is to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Curl Scale - Curl strength of the vorticity confinement

Domain Tab
Boundary - One of three choices:

Free Slip - Velocity is negated at the boundary axis
No Slip - Velocity is set to 0 at the boundary
Outflow - The grid is clipped at the boundary

The Min and Max domain fields are for setting the minimum and maximum extents (corners) of the simulation's 
domain.

Cache Tab
Cache Grids - Toggle for enabling the caching of grids to Cache Path folder. Once cached they can be loaded 
without simulation
Cache Name - Base name of saved grid . vdb files. Files will be appended with the frame number. Files will be 
written with temperature, density, and velocity grids
Grid Path - Path to save folder
Clear Cache - Clear all files in the cache folder
Behavior - A dropdown with three choices:

Manual - Cache control is completely up to the user
Warn - A message will warn "The cache is invalid, should it be cleared?"
Automatic - The cache is cleared automatically, when necessary

To Fog Volume

Converts an SDF grid (signed) to a fog volume (unsigned) with a filled interior. There are no options.



LightWave 2020  –  LightWave 2020

Appendices –  3468

•

•

•

•

•

•
•

•

•

Tools

You can manipulate OpenVDB volumes with the following included tools.

Advect

Advect a Signed SDF grid with a velocity grid. Requires a Velocity Grid vector to give movement and direction.

Spatial - Set the spatial finite difference scheme. In other words, how accurately the gradients of the signed 
distance field are computed depends on your pick of interpolator. The choices further through the list are more 
accurate but take more time
Spatial Tracker - Set the spatial finite difference scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Temporal - Set the temporal integration scheme. How accurately time is evolved within the renormalization 
stage. The choices further through the list are more accurate but take more time
Temporal Tracker - Set the temporal integration scheme. How accurately time is evolved within the timestep. 
The choices further through the list are more accurate but take more time
Integrator - Set the numerical advection scheme. The choices further through the list are more accurate but 
take more time
Limiter - Set the limiter scheme used to stabilize the second-order MacCormack and BFECC schemes
Normalizing Steps - A number of renormalization passes can be performed between each substep to convert it 
back into a proper signed distance field. Prevents jerky motion but soften and slows the velocities
SubFrame Steps - Substeps per integration step. The only reason to increase it above its default value of one is 
to reduce the memory footprint from dilations - likely at the cost of more smoothing!
Rebuild SDF - Toggle to rebuild and retrack the narrow band of the SDF
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Advect Points

This node will advect the points in a particle system along a velocity field. The first thing you need is a particle system to 
use. Node inputs are:

Particle System - Particle system to advect
Velocity Grid - This must be a vector-valued VDB primitive. You can use the Vector Merge node to turn a vel.
[xyz] triple into a single primitive
Closest Point Grid -  Used for projection and constrained advection

In the node's panel, the controls are as follows:

Type - Three types are proposed:
Advection - Move the point along the velocity field
Projection - Move the point to the nearest surface point
Constrained Advection - Move the along the velocity field, and then project using the closest point field. 
This forces the particles to remain on a surface

Integration - Later options in the list are slower but better at following the velocity field
Iterations - Number of times to try projecting to the nearest point on the surface. Projecting might not move 
exactly to the surface on the first try. More iterations are slower but give a more accurate projection
Steps - How many times to repeat the advection step This will produce a more accurate motion, especially if 
large time steps or high velocities are present
Add Particles - At each frame add the input particles to the advection
Lifespan - How many frames the advected points will live for
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Analysis

This node presents various grid manipulations. Depending on the input grid type and the operation the output grid type 
will vary. Once an input is connected and the grid type is known the list of available operations will be collapsed to only 
show appropriate choices. Finally, if you change the operation the grid output will disconnect (ie scalar to vector).

Gradient - Vector that points perpendicular to the values basically un-normalized normals (Scalar - Vector)
Curvature - A measure of the surface curvature (Scalar - Scalar)
Laplacian - A smoothed version of the input (Scalar - Scalar)
Closest Point Transform - Direction to the closest point (Scalar - Vector)
Divergence - A measure of the change in quantities (Vector - Scalar)
Curl - A direction perpendicular to the input grid vectors (Vector - Vector)
Magnitude - The scale of the input vectors (Vector - Scalar)
Normalize - Normalized input vectors (Vector - Vector)

 There is also a Scale input for further adjustment.

CSG

Takes the Result from two SDF shapes and combines them in the fashion that should be familiar by now -

Union - Combines the two shapes, and is the default option
Intersection - Only leaves the parts of the two shapes that overlap
Subtraction - Removes Shape A from Shape B
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The velocity of the input grids will be reconstructed and output.

Combine

Combines grids using scalar operations.

Combination type - The different math operators that can be brought to bear:
Copy A - Use A , ignore  B
Copy B - Use B, ignore A
Invert - Use 1 minus A
Add - Add the values of A and B (Using Add for fog volumes, which have density values between 0 and 1, 
will push densities over 1 and cause a bright interface between the input volumes when rendered. To 
avoid this problem, try using the Blend 2 option)
Subtract - Subtract the values of B from the values of A
Multiply - Multiply the values of A and B
Divide - Divide the values of A by B
Maximum - Use the maximum of each corresponding value from A and B (Using this for fog volumes, 
which have density values between 0 and 1, can produce a dark interface between the inputs when 
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rendered, due to the binary nature of choosing a value from either from A or B. To avoid this problem use 
Blend 1 instead)
Minimum - Use the minimum of each corresponding value from A and B
Blend 1 - (1 - A) * B. This is similar to SDF Difference, except for fog volumes, and can also be viewed as a 
"soft cutout" operation It is typically used to clear out an area around characters in a dust simulation or 
some other environmental volume
Blend 2 - A + (1 - A) * B. This is similar to SDF Union, except for fog volumes, and can also be viewed as a 
"soft union" or "merge" operation. Consider using this over the Maximum or Add operations for fog 
volumes

A Multiplier - Multiply voxel values in the A VDB by a scalar before combining the A VDB with the B VDB
B Multiplier - Multiply voxel values in the B VDB by a scalar before combining the A VDB with the B VDB
Resample - Multiple options here. If the A and B VDBs have different transforms, one VDB should be resampled 
to match the other before the two are combined. Also, level set VDBs should have matching background values 
(i.e., matching narrow band widths):

Off - No resampling
B to Match A - Resample B so that the narrow band width is the same as A
A to Match B - Resample A so that the narrow band width is the same as B
Higher-res to Match Lower-res - Resample the higher resolution data so that the resolutions match
Lower-res to Match Higher-res - Resample the lower resolution data so that the resolutions match

Interpolation - When you choose a resampling option other than Off, the Interpolation choices become 
available. There are three to choose between:

Nearest - Nearest Neighbor interpolation is fast but can introduce noticeable sampling artifacts
Linear - Linear is the middle ground of speed and quality
Quadratic - Quadratic interpolation is slow but high-quality

Deactivate - Toggle to deactivate active output voxels whose values equal the output VDB's background value. 
When this option is checked, the field below becomes active:

Deactivate Tolerance - When deactivation of background voxels is enabled, voxel values are 
considered equal to the background if they differ by less than this tolerance

Prune - Reduce the memory footprint of output VDBs that have (sufficiently large) regions of voxels with the 
same value

Prune Tolerance - When pruning is enabled, voxel values are considered equal if they differ by 
less than the specified tolerance

Flood Fill - Reclassify inactive voxels of level set VDBs as either inside or outside. This option will test inactive 
voxels to determine if they are inside or outside of an SDF and hence whether they should have negative or 
positive sign

Pruning affects only the memory usage of a VDB. It does not remove voxels, apart from inactive voxels 
whose value is equal to the background


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Filter

  

This node adjusts the inner bandwidth of a volumetric signed distance field represented by a VDB volume
Filters the level set grid:

Filter Type:
Renormalize - Repair level sets represented by VDB volumes. Certain operations on a level set volume 
can cause the signed distances to its zero crossing to become invalid. This node iteratively adjusts voxel 
values to restore proper distance
Mean Value - This performs the equivalent of a simple box blur by taking the mean of the surrounding 
values
Median Value - This chooses the median of the surrounding values, good for homogenizing noisy data to 
avoid spikes
Mean Curvature - Finds the average curvature for a location and moves the surface along its normal to 
smooth out bumps
Laplacian Flow - Uses a local Laplacian value for movement along a normal
Dilate - Dilate the grid along its normals making it bigger
Erode - Erode the grid along its normals making it smaller
Close - Dilate the grid to close holes then erode closing openings
Open - Erode the grid then dilate to create openings
Track - the grid topology is updated by rebuilding the inner band so that it tracks the new iso interface
Gaussian - Gaussian smoothing
Resize - Change the width of the inner band of a VDB signed distance field

Accuracy - Increasingly complex algorithms for the accuracy of the integration
World - Performs the math for creating the levelset in World space, rather than Local
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Half Bandwidth - Level sets are normally symmetrical on the inner band. Half Bandwidth uses this fact to halve 
calculation times but at the cost of accuracy
Iterations - the maximum number of attempts to achieve a divergence-free pressure matrix
Voxel Offset - Offsets the iso surface from the actual value. For instance, using

Level Set Morph

You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

The above node tree will synchronize your surface morphing at the same time as the geometry

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out

Noise

Add the Bump output from an image or a 3D Texture to this node and pipe the output through.

OpenVDB Info
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The values for the Fuel channel of a VDB sequence
You can pipe a Level Set or Fog grid into this node and see the values contained within the file, but this node becomes 
more useful when you load a vdb file directly in the node. You can see info from whatever channels the vdb file contains.

Partio Node

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.


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Target - If you are using a volumetric object with the particle system, make sure it is targeted here
Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list

Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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Using the Partio node with a From Particles node

As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab
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You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Resample

Resample input grid to new voxelsize to output grid.

Interpolation - Different interpolators with increasing complexity
Rebuild SDF - Rebuilds and normalizes the narrow band of the level set
Prune - Removes values from the level set that are smaller than the Prune Tolerance set below

Saver

Pipe a grid into here and the frame or sequence is saved as VDB files upon clicking the Save button.

Save Type - a choice of Frame or Sequence. In both cases, a files or files will be saved using the File Name 
chosen appended with the frame number
Save Path - Choose a folder for the frame or sequence
File Name - The chosen prefix for the frame or sequence
Save - Immediately saves the frame or sequence. There is no visual confirmation apart from the playhead 
stepping through the scene in case of a sequence save

To load files saved this way, use the OpenVDB Info node to choose the VDB file and its channel saved.
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Scatter

Scatter creates particles on the input grid.  The particle system constructed belongs to the scatter target item. Particles 
can be scattered on or in both SDF and fog volumes.

Scatter Target - The input grid to scatter on
Scatter Mode - Dropdown to specify how the particles will be placed:

Point total - Absolute number of particles to be scattered
Point Density - Percentage of voxels in which to place a particle
Points Per Voxel - Number of particles to put in each voxel

Seed - Sets the random seed
Spread - Distance to randomly move from the voxel center

Depending on the scatter mode chosen:

Point Count - When Point Total is chosen (integer)
Density - When Point Density is picked (percentage)
Points Per Voxel - When Points per Voxel is chosen (scalar)

Multiply - Density multiplier
Animate - Reseed the random generator each frame
Fill Interior - Fill particles inside the sdf narrow band
Size Factor - The size of the particles created
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Creating bubbles inside a VDB toroid is simple with the Scatter node. The Filter node has been used here in Erode mode 
to ensure that the bubbles are created inside the toroid volume and not at the boundary.

Solver
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A particle solver that uses a particle system to initialize a temporal PIC/FLIP feedback loop. Particles from the particle 
system are input as they are born. Then are advected by the integrator using the gravity over the frame substeps. PIC 
(Particle In Cell) produces smoother motions, and FLIP (FLuid Implicit Particles) is splashier. The two methods can be 
combined.

The Navier-Stokes equations that the PIC/FLIP system uses do not dictate position but velocity. The vectors contained 
are not coordinates but velocities. PIC / FLIP is an advection equation, which is how the particles in these objects move 
within velocity fields.

Particles In Cells (PIC) works by evaluating particles as groups of particles in cells (like voxels)

FLIP stands for FLuid-Implicit Particles and uses a grid rather than particles. Grid-based methods were great for large 
ocean effects, but not fine detail close up visual effects work. Things can look globby and unrealistic at a small scale 
(thin fluids).

Inputs
Collision Grid - SDF grid to be used for collisions
Particle System input - Use a separate particle system

Outputs
Grid - Outputs an SDF grid
Particle System Out - Particle system output
Start Only - Only uses the first frame of the particle system
Voxel Size - Size of the gid voxels
Integrator - In short, the upper choices from this dropdown menu are faster but the lower choices are better 
quality
Subframe Steps - More steps per frame is more accurate but takes longer
PIC↔FLIP - Ratio of PIC velocities to FLIP velocities
Blobby - Check to treat the particles as spheres
Gravity - Downward pull in meters per second squared
Stickiness - Amount of velocity absorbed by contact with collision object
The next three checkmarks are to help visualize the grid:

Show Particles
Show Grid velocity
Show Collider grid

Vector Merge and Split

The Solver is time-based so scrubbing the scene will break it, particularly going backward. Create previews to 
see a smooth animation if your scene is too heavy.


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New to LightWave 2020 is a pair of nodes to split level sets into three separate dimensions for further manipulation. The 
Vector Split node takes an incoming OpenVDB grid and splits it into X, Y and Z channels. There is no options panel.

The Vector Merge node will create a vector-valued VDB volume using the values of corresponding voxels from up to 
three scalar VDBs as the vector components. The scalar VDBs must have the same voxel size and transform; if they do 
not, use the Resample node to resample two of the VDBs to match the third.

This node offers the following types of operation:

Tuple - No transformation
Gradient - Inverse-transpose transformation, ignoring translation
Unit Normal - Inverse-transpose transformation, ignoring translation but with renormalization
Displacement - Transformation, ignoring translation
Position - Transformation with translation
Copy Inactive Values - If enabled, merge the values of both active and inactive voxels. If disabled, merge the 
values of active voxels only, treating inactive voxels as active background voxels wherever corresponding input 
voxels have different active states

Velocity

This node will construct a velocity grid for motion blur use.

Reference Grid - Use to populate the velocity grid on the active values
Velocity - Vector of velocity evaluated during grid building
Rebuild Velocity - Rebuild Velocity at each evaluation rather than creating a static field

You can use an envelope or a texture map to adjust the velocity grid over time for more control

Visualize

Additional Destination node to help visualize VDB networks. You can choose any combination of the three choices - 
Values, Voxels, and Extent. When this node uses a Velocity Grid output as its input, the Vector Options dropdown menu 
becomes available.

Show Values - Shows the scalar voxel values multiplied by color
Show Voxels - Show the voxel cubes
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Show Extent - Puts a box surrounding the voxel object showing the extents
Vector Options - A dropdown menu with three options. This menu is ghosted when the Visualize node is not 
hooked to a Velocity Grid

Velocity - Shows velocity unclamped transformed
Normal - Shows normals scaled to .4 of box size to prevent overlap. Inverse transformed
Color - Shows the color with no transform
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Level Set Morph simple

You can morph between polygonal objects. It's not easy because you have to have the same point and poly count, and 
those points and polygons need to be in the same order; it's a tough job. Now, we have given LightWave the power to do 
the same using OpenVDB, the results can be very impressive.

In a scene, have two polygonal objects and a null. The point and polygon counts don't have to match, or even be close. 
In the example above, we are going from the Utah teapot with 1,506 polygons, to the Stanford bunny object with 
roughly 70,000. Use the Object Replacement > OpenVDB Evaluator entry to convert the two objects to OpenVDB (make 
sure that their Voxel Size fields match) Level Sets. Pipe the Grid outputs from these nodes into the new Level Set Morph 
node and from that into the destination Grid node.

Morphing between objects involves the nodes we've already outlined. Morphing from one surface into another requires 
the two surfaces to be changed as well. To do so, in the Surface Editor, pick your morphing null and edit its surface. 
Double click on the surface name to open the node editor and add:

Material Tools > Material Mixer
The surface for one object
The surface for the other object
Info > Time

You will need to freeze subpatched objects as they are not seen by OpenVDB
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The above node tree will synchronize your surface morphing at the same time as the geometry

The first four controls (Spatial, Spatial Normalize, Temporal, and Temporal Normalize) are graded in terms of rapidity 
and quality. Change up from the first only if it is posing problems with how the Morph is playing out.

Normalizing Steps - After morphing the signed distance field, it will often no longer contain valid distances.  A 
number of renormalization passes can be performed to convert it back into a proper signed distance field
Speed - A scalar to determine how fast your morph occurs
Invert Alpha Mask - If you have hooked up a grid as an alpha mask, this option allows you to reverse what is 
alpha'ed out
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Partio Node simple

Partio is an open-source C++ library, created by the Walt Disney Animations Studio, for reading, writing and 
manipulating a variety of standard particle formats (GEO, BGEO, PTC, PDB, PDA). LightWave cannot support the BGEO 
format right now, but Houdini can save in the older HClassic format that LightWave will understand. To save in HClassic 
format, just replace the file extension in Houdini.

The Partio node is simple in that it has one output and no inputs. Double-clicking on the node shows more depth:

Load Path - Where your particles are located.

Target - If you are using a volumetric object with the particle system, make sure it is targeted here
Start Frame - The frame on which to start the simulation in LightWave
Missing Frames - I have Hold (keep the previous frame's contents?) and Blank (leave a gap?)
Size - The particle size. If using a grid, it should be 1.5 times the voxel size or risk being missed

Attributes list

Using the Houdini "vocabulary" here. If you have particles from a different source, the names may be different. The 
fields are fairly self-explanatory with name, type, and depth. A Float 3 is three scalars, a color for instance. A Float 1 is a 
simple scalar.

position - The particle position
Cd - The diffuse color of the particle
v - Particle velocity. Can be used as a color or for post blurring, for example
pscale - The size of the particle

The Partio node has a single output - Particle System. To see these outputs, add an Additional > ParticleInfo node.

You should place Houdini files in your content directory's GridCache folder to ensure they can be seen 
by Package Scene.


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Once you have exported a stream of HClassic files, you can import them into LightWave using the Partio node. To do so, 
add a null to an empty scene. Make the null an OpenVDB Evaluator using the Object Replacement dropdown menu. Hit 
the P button to edit the Evaluator's nodes. Add the Partio node, but you won't see anything until you have chosen from 
the following

From Particles - Size in the Partio node should be about 1.5 times the Voxel Size in the From Particles node, 
sometimes a little bigger. This makes sure the particle spans the voxel cube; smaller and you might not see the 
particle rasterized.

Using the Partio node with a From Particles node

•
•
•

Because the outputs are dynamically created, if you are not seeing the outputs you expect, make sure that:

The ParticleInfo node is addressing the right object (double click the node to check the target)
The frame you are on actually has particles. It's not before or after the particles appear
You try stepping the frame forward and back to refresh the node, or moving the ParticleInfo node itself


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• As Particles - You can go straight from the Partio node to the OpenVDB destination node, turn on particles in the 
destination node and then just get particles that can be used for other purposes - such as with old-fashioned 
HyperVoxels.

Don't forget to turn on 'Use Legacy Volumetrics' In the Render Properties > Volumetrics tab

You can also use LightWave's own Volumetric objects. Add another null called "vol". Set the vol null Primitive Type to 
Volumetric. Use an OpenVDB Evaluator Object Replacement in the Partio's Object Properties window. In the Node 
Editor, add a Partio node and bring in your Houdini HClassic files. Set the Partio node Target to the vol null.



LightWave 2020  –  LightWave 2020

Appendices –  3491

Hook the Partio node directly to the Destination OpenVDB node. This will output a particle system. Add a new null 
labeled "vol" and make it a Volumetric object. Set the source item here to vol.
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Common Renderer
Global Illumination tab
Noise Filter Options
Photoshop PSD Export
Reconstruction Filters
Render Tile Size
VPR Draft Mode Limitations
Grid-Based Cache
NRC Monitoring
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Global Illumination tab

Global Illumination

Enable GI - On by default, there are two choices currently: Brute Force and Irradiance Cache. You can use any 
combination of the two engines you like but using Brute Force as the Primary and Irradiance Cache as the secondary 
makes the most sense. Be aware that the interactive version of VPR will not do any preprocessing, so a pure Irradiance 
Cache render, without existing cache, will probably end up blotchy.

Brute Force

Intensity - A multiplier applied to overall GI brightness. Useful especially for interior scenes. GI is a type of 
illumination and like other lights, its intensity can be modified. However, only an intensity of 100 % is close to 
physically accurate.
Rays - It is the number of brute force rays to use per pixel sample when not using interpolated or in regions of 
interpolated GI when interpolated samples could not be generated.
Caustics - Generally, a caustic occurs in the real world when light reflects off a curved surface or refracts through 
a transparent surface so that it is focused on a small area. Light through a wine glass is a good example. With a 
more complex surface, the caustic can create a random pattern like those seen on the floor and sides of a 
swimming pool. Switching Caustics on here will generate accurate caustics rather than the approximations seen 
in previous versions.

In 2015 and earlier versions of LightWave, the Indirect Bounces setting on the Global Illumination tab 
controlled how many bounces were rendered. That setting is now on the Render tab and named Diffuse 
Bounces. It performs the same function.


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Caustics can add a significant amount of time to your render, so it's all about balancing your time 
budget with your quality requirements. Our first shot is purely brute force, with no secondary GI, and it 
took 1918.9 seconds to render:

The second test used just primary brute force again but lowered the quantity or rays from 128 to 64 to 
try and improve render time. The following render took 722.6 seconds to complete:

The caustics aren't quite as good as the first render, but the time taken was significantly less. We should 
try further:


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Affected by Volumetrics - Allows volumetrics to be included in the global illumination calculation. This can slow 
rendering but is more accurate if there are volumetrics in the scene.

Irradiance Cache

Irradiance Cache GI presents more options than Brute Force. It is also, by its nature, not something that will work 
perfectly out of the blocks without preparation. The "Cache" in the title is the giveaway. VPR and F9/10 will still work, 
but without a cache, VPR risks being "blotchy."

Rays - the number of evenly-distributed Global Illumination rays sent out for evaluation. As you might expect, 
the higher the density, the more accurate, but the longer the rendering will take.
Interpolation Accuracy - Increasing accuracy will mean better contact shadows, but requires more rays thus 
slowing down the render

The overall quality is fine in this Irradiance Cache render at the default 512 rays, and the render time is 
great at just 125.5 seconds, but the caustics are without detail. Try again.

Now we have a happy compromise. Brute Force primary rays at 64, and default Irradiance Cache 512 
ray secondary GI with Caustics on gives a result that fits our time budget at 505.1 seconds, and the 
quality is pretty similar to our first image but at a quarter the cost in render time.
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Minimum Pixel Spacing (MinPS) -  Controls how tightly GI samples are packed near corners and measured in 
pixels. Larger values reduce the number of GI samples near corners which makes the GI less accurate but also 
can decrease render times.
Maximum Pixel Spacing (MaxPS) - Controls the maximum distance in pixels between interpolated Global 
Illumination samples. Larger values (100 is typical) reduce noise in large flat areas. Lower values make shadows 
more accurate but need more rays to reduce noise.
Distance Tolerance (DT) - is set in millimeters and controls the density of samples on flat surfaces. It is the 
maximum variation allowed in the sample direction in order to blend. Smaller distances will cause more 
samples to be taken for a surface but will help with small details like louvers, etc.

Angular Tolerance (AT) - is set in degrees and controls the density of samples on curved surfaces such as a 
sphere or a cylinder. It is the maximum variation allowed in the sample direction in order to blend. Smaller 
tolerances will cause more samples to be used on curved surfaces, but will help with details.
Screen Clamping - When Screen Clamping is checked, the MinPS and MaxPS fields are used. If Screen Clamping 
is unchecked, the Minimum Size field will be consulted for samples

Left: Distance Tolerance is too large for this scene. Note the leak of light to the step below. Right: 
Reducing the Distance Tolerance size has cured the light leak


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Use Specular - Uses specular effects from the scene to inform the radiosity solution
Use Glossy - Uses Glossy Reflection samples for the radiosity solution
Use SSS - Uses Subsurface Scattering samples for radiosity
Resolution Multiplier - Create a radiosity solution that is smaller, or bigger, than your render resolution

Interpolated Cache

Use Cache - When checked, a cache can be created and used for rendering. When unchecked the following 
settings are all ghosted and unavailable
Cache Type - Two choices:

Frame - is used for scenes where you have moving geometry or lights
Scene - is used if the camera in your scene is the only thing moving (flythroughs, etc)

Cache File - The name of your Irradiance Cache file. Clicking on the paper icon at the end of the filed will open a 
requester to set the name and path
Clear Cache - Click here to remove an existing cache so that a new one can be baked
Scene Baking Frame Step - How often to bake a cache for your scene. The default of 1 might take a long time 
where every 10 frames, or even more, might be suitable for your scene

Bake Grid - If you don't know where your camera will be going in your scene yet, or you want a belt and braces 
approach that ensures that every eventuality will be covered, you can bake a grid cache. The grid cache sets a 
grid at the spacing set for the bounding box of your whole scene.

Ray Recursion is the upper limit on the number of Diffuse Bounces you are allowed. For example, if you have a 
Ray Recursion Limit set to 1 and Diffuse Bounces set to 8, only one Global Illumination bounce will be 
calculated. However, if you have Ray Recursion Limit set to 8 and Diffuse Bounces set to 4, you will still get four 
bounces of Global Illumination.


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The first image shows our test scene with a chair separated from the room we are trying to bake, the 
second shows the chair in the room. In this simplified diagram, every vertex in the blue bounding box 
represents where the 360° camera is taking samples (Grid Spacing), at the resolution chosen (Grid 
Resolution)


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When you check this option, two further suboptions become available:
Grid Resolution - By default, this is set to 1024. The resolution of the cache. A cache is not an image, nor 
a set of images, but the resolution here is similar to the resolution of an image. The higher the resolution 
the longer each grid will take to bake but the more detail it will contain
Grid Spacing - This is how frequently you will be taking snapshots for this cache, at the resolution 
specified above

Caching saves Global Illumination data for subsequent render passes and frames, which can significantly reduce 
rendering time. The Global Illumination cache gets loaded before baking begins if it exists. This will allow you to 
continue baking an existing Global Illumination cache. You could, for example, extend an animation by setting your 
start and stop frames beyond those you have already baked and clicking Bake Global Illumination Scene. You could add 
just a single frame to the cache by selecting a frame and clicking Bake Global Illumination Frame.

Debug Display Options

The Show Nodes toggle shows the octree nodes that are used for storing the radiosity solution.

The baking process shows this clearly - in the grid bake shown on the left there are large expanses of 
nothing. Notice also that there are 4,698 locations to bake, adding to the time needed for a render of 
the cache. In the image on the right, we have returned the chair to within the room we are trying to 
bake. Already we can see that there are only 132 locations to bake and there will also be very little 
checkerboard because there are only a few openings (the windows).

1.

2.

3.

If your grid is taking longer to bake than you expect, check several things:

That the resolution and spacing of the grid is appropriate to the scene (no point baking extreme detail 
when it won't be seen)
The grid encompasses the bounding box for the scene. As the example in the wiki shows, don't have 
elements outside the area you are concentrating on
That you are not baking the grid to a slow network location


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Noise Filter Options

Noise Filter Options

This system, added in LightWave 2018, allows you to control a bilateral filtering of your render to give a smoother effect 
without needing endless anti-aliasing. Meant to remove fine grain that would take too long for the renderer to deal 
with, it won't work effectively on high contrast grain.If you open the window for this image filter before performing a 
render you will get a message:

The controls are:

Filter Size - Small filter windows should be used; for example 1, 2, or 3 will be enough in most cases
Tolerance - By default 0.1 and should be raised slowly as necessary. If the tolerance goes too high you'll get 
unwanted blurring across edges. A tolerance of 1 is equivalent to Photoshop's Gaussian filter.

The following two options are used to mask filtering by limiting it to pixels of a similar depth and/or Normal 
angles.
Use Depth Tolerance - This compares pixels that are within the given tolerance for difference in depth in the 
scene
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Use Poly Normal Tolerance - This compares the cosines of the angles between scene object normals
In both cases Pixel values under these tolerances get blurred, those exceeding the tolerances don't

Buffer name - The name of the buffer you are editing
Scale - The scale of the rendered image preview below
Process and Send to Image Viewer - This will send a processed render to the Image Viewer with a name that 
reflects the settings used in the Noise Reduction Filter.

Blend - A slider to blend between the unfiltered and filtered render

Below these controls is an image window in which a preview of your render appears so that the image quality can be 
fine-tuned. The view can be dragged around while holding a mouse button down. The slider above the window shows 
the filtering interactively. To the left of the vertical line is the filtered version, to the right is unfiltered.

The Image Viewer window titlebar indicates that we used a size 3 filter, at a Tolerance of 0.1; with Depth Tolerance of 0.05 
and Poly Normal Tolerance at 0.02

Using the Noise Filter

To enable the Noise Filter, you need to turn it on in several places. First, visit the Render Properties panel (Ctrl P), and 
go to the Render tab. Towards the bottom of the panel, you will see the option Enable Noise Filtering.

Enabling the Noise Filter here is the start of operations, but needs to be backed up with Buffers to be filtered. Visit the 
Buffers tab and check Noise Filtering for the buffers you want to be filtered.
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Note that some buffers might be better unflitered - things like Object ID, Material ID, Depth and other 
"programmatic" buffers are usually best left unfiltered.


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Photoshop PSD Export

Click here to expand Table of Contents...

Basic Tab
Additional Shading Tab
Material Tab
Motion Tab
Geometry Tab

The Photoshop PSD Export image filter is an image saver masquerading as an image filter. Being a filter allows it to have 
access to all the different internal render buffers. When you render a frame, a sequentially numbered PSD file is saved 
with each of the selected buffers placed into their own layers.

This filter is still included, but preferred workflow now is to save the buffers needed as individual files. Buffers to be 
output can be chosen from the list of buffers shown here.

Basic Tab
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Final Render - Represents the final output from the LightWave render.

Pre-effect Render - Represents the render before effects, such as lens flare, are applied.
Specular Color - Represents the specular color options of a surface.
Reflection - Represents the reflection channel for a surface.
Diffuse Shading - A single channel buffer, indicates the amount of light reflected toward the camera from a 
surface, including the effects of shadows cast onto the surfaces.
Shading - A single channel buffer, represents the lighting effects for shadows, as well as specular and diffuse.
Specular - A single channel buffer, indicates the value of the specular attribute of a surface.
Background - Represents the channel buffer when options in the Backdrop panel are activated, such as 
Gradient Backdrop or Image World.

Examples of various filters (Render from the Night.lws scene, included with the LightWave content.):

Final Render is several filters in one, all of which will be activated when you look at the PSD file. The following 
additional filters will be available in the PSD file: Effect (-), Effect (+), Surface, Diffuse Lighting, and Refraction.


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Final Render, Pre-effect Render
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Specular Color, Reflection

Diffuse Shading, Shading

Additional Shading Tab

Diffuse Color - A three channel buffer, providing color options, and accounts for the part of the render for diffuse 
lighting, surfacing, and shadowing.
Shadow - A single channel buffer, indicates the location and intensity of shadows, but not shadow color. The 
brighter areas indicate more intense shadows.
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• Specular Color - A single channel buffer, indicates the intensity of specular highlights on a surface due to all 
lights, though this does not include color information.
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Diffuse Color
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Shadow, Specular Shading

Material Tab

Raw Color - A three channel buffer, represents the value of the Color attribute of a surface
Mirror - A single channel buffer, directly indicates the value of the Reflection value of a surface.
Luminosity - A single channel buffer, indicates the intensity of luminosity on a surface.
Transparency - A single channel buffer, indicates the value of the transparency attribute of a surface
Diffuse - A single channel buffer, indicates the value of the diffuse attribute of a surface.
Special - A single channel buffer, indicates the special buffer values specified for a surface in the Surface Editor. 
Special uses only the first special buffer value.
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Raw Color, Mirror  

 

Transparency, Diffuse

Motion Tab

Motion X - A single channel buffer, indicates the direction of the geometry along the horizontal axis in relation to 
the camera. Negative values indicate movement towards the left, while positive values indicate movement 
towards the right. If the geometry is represented with a gradient, meaning parts are moving in different 
directions; a mid-range gray value will be used for the background.
Motion Y -A single channel buffer, indicates the direction of the geometry along the vertical axis in relation to the 
camera. A positive value indicates a downward movement, while a negative value indicates an upward 
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movement. If the geometry is represented with a gradient, meaning parts are moving in different directions; a 
mid-range gray value will be used for the background.

Geometry Tab

Depth - A single channel buffer, indicates the relative distance of items from the camera. The further away an 
item is the brighter it is represented.
Surface ID - A single channel buffer, indicates the internal surface identifier in Layout for each surface element in 
the final render, giving the ability to single out specific surfaces in the rendered image.
Object ID - A single channel buffer, indicates the object identifier for each surface element in the final render. 
The more items in a scene, the larger the values.
Geometry - A single channel buffer, indicates the relation of the angle of the polygon’s surface normal and the 
direction of the camera. The brighter the surface, the more it faces the camera directly.
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Depth, Geometry

The Max field determines the maximum value allowed in a buffer. So the acceptable buffer values are always zero to the 
Max. All values in the buffer are divided by Max to normalize them to the range zero to one.

The Sliding min/max range option will dynamically compute the minimum and maximum values of each buffer. The 
values are computed for every frame so the output buffers will have the widest possible range of values. This is great for 
still images, but animations should not use this setting, due to the lack of “temporal coherence” (i.e., the images may 
“pop” from frame to frame).

The 16-bit component output option will save out 16 bits per channel/buffer. Normally, only eight bits are used.
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Reconstruction Filters

Reconstruction Filters

The LightWave 3D renderer includes a full implementation of reconstruction filters. These filters determine how the 
rendering data is combined into a final image at a sub-pixel level in order to produce a final image. Reconstruction 
filters have been a subject of research over many years and the names of these filters are often derived from the 
research that led to their development. Reconstruction filters are not set on the Camera Properties panel, but rather per 
buffer in the Buffer tab of the Render Properties panel.

LightWave filters are outlined below:

Box

This is the most common form of filtering, and the method that most traditional applications use to reconstruct an 
image from raw rendering samples. These samples are simply places in a pixel “box” and averaged. Although this 
technique is fast, it can exhibit significant artifacts on motion and when there is fine image detail. From a signal 
processing point of view, this is a very poor technique for reconstructing an image from the raw data that comprises it. 
This mode is very close to the traditional LightWave modes.

Circle

Based on Box, it uses a 6x6 matrix based on the Filter Radius size. Anything within the filter radius is given full 
importance. Anything outside is cut off.

Different buffers can have different filtering applied but beware of mixing different filters on buffers for the 
same render since it will be difficult and perhaps impossible to reconstruct a final image.


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Triangle

Based on a cone with filtering taking place on pixels in a 6x6 matrix.

Gaussian

Gaussian filter based image construction takes the samples that compose the image and builds the final pixel data by 
weighting their contributions based on a Gaussian kernel of approximately one pixel in size. This technique typically 
performs quite well, although images tend to have a “soft” look. In practice this mode can be very valuable for video 
output where it can help hide some of the artifacts introduced by fielded or reduce bandwidth content.

Mitchell

Mitchell filtering is a technique that is now very popular and was suggested as an alternative to Lanczos filtering (see 
below). It does not suffer many of the ringing artifacts of Lanczos filtering and generally is a very good starting point for 
most situations.
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LanczosSinc

Lanczos filtering is arguably the technique that yields the closest to the perfect results for image reconstruction. This 
technique is based on a windowed sinc function (a sinc function being the optimal infinite image reconstruction filter). 
Unfortunately in practice Lanczos image reconstruction tends to produce overly emphasized edges and “ringing” in 
high contrast areas of the image.

Usage Tip

Box, Circle, Triangle and Gaussian may provide better results for moving images, whereas Mitchell and 
LanczosSinc may be more suited to stills due to their tendency to sharpen the image.


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Render Tile Size

Render Tile Size

(Default 32)

This dropdown giving a choice from 8 pixels square to 1024 will require your judgment to get the most rapid render. 
There is no easy way to judge whether large tiles will make more sense than smaller ones because the setting you 
choose will be completely scene-dependent. Test renders and limited region renders will allow you to tune to get the 
best performance.

Tile Colors

Render tiles come in three colors. Green, Blue, and Gold. There will be a tile for each core of the processor rendering. 
The three colors appear at different stages of rendering and the first to appear; once any GI work has been done, are 
green. Tiles that are green represent the first sampling for a section of the render. Once the first pass has been made, 
the tiles turn blue to show the adaptive sampling passes taking place. This is the usually the longest stage. Towards the 
end of the render, some cores may have finished any available tiles and would otherwise sit idle. LightWave will start to 
split tiles to keep all cores engaged until the end of the render. These split tiles will be gold.

If you choose a small size your render will be slowed slightly because each tile needs to have an unseen border 
rendered for matching to other tiles. The smaller the tile, the more time is spent on these unseen borders


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This animation shows the different tiles used for rendering. The system used consisted of a Dual E5-2698 v4 with 40 cores 
and 80 threads resulting in a lot of tiles for the render.

Polygon Intersection Mode

(Default Watertight)

There are three intersection modes with increasing precision:

Fastest - This is the speediest of the three, but can sometimes return dots where edges between polygons don't 
line up precisely
Watertight - Should work in all cases, but still uses single precision math that might fail in extreme situations
Double Precision - Bulletproof but not as fast
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VPR Draft Mode Limitations

VPR Draft Mode Limitations

VPR’s Draft Mode is designed to show you renders as quickly as possible, however, it doesn’t support everything of 
which VPR is capable. Here’s a list of VPR Draft mode limitations:

Motion Blur is disabled
Depth of Field is disabled
The Adaptive Threshold is set to 0.1
Minimum Samples is set to 1 and Maximum Samples is 9
Oversampling is set to 0.5 and uses Filter Radius
Light, Reflection, Refraction and Scattering samples are limited to 4.
Ray Recursion Limit and Reflection Bounces are set to 4 but the Reflection Recursion Limit is set to 2
Diffuse Bounces is set to 1

As you can see, to get a true view of your render, better to get out of Draft mode as you are nearing project completion, 
especially if you are going to require an F10 render sequence and want no surprises because your rendered images 
don’t look the same as your VPR previews.
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Grid-Based Cache

Bake Grid - If you don't know where your camera will be going in your scene yet, or you want a belt and braces 
approach that ensures that every eventuality will be covered, you can bake a grid cache. The grid cache sets a 
grid at the spacing set for the bounding box of your whole scene.

The first image shows our test scene with a chair separated from the room we are trying to bake, the 
second shows the chair in the room. In this simplified diagram, every vertex in the blue bounding box 
represents where the 360° camera is taking samples (Grid Spacing), at the resolution chosen (Grid 
Resolution)


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When you check this option, two further suboptions become available:
Grid Resolution - By default, this is set to 1024. The resolution of the cache. A cache is not an image, nor 
a set of images, but the resolution here is similar to the resolution of an image. The higher the resolution 
the longer each grid will take to bake but the more detail it will contain
Grid Spacing - This is how frequently you will be taking snapshots for this cache, at the resolution 
specified above

The baking process shows this clearly - in the grid bake shown on the left there are large expanses of 
nothing. Notice also that there are 4,698 locations to bake, adding to the time needed for a render of 
the cache. In the image on the right, we have returned the chair to within the room we are trying to 
bake. Already we can see that there are only 132 locations to bake and there will also be very little 
checkerboard because there are only a few openings (the windows).

1.

2.

3.

If your grid is taking longer to bake than you expect, check several things:

That the resolution and spacing of the grid is appropriate to the scene (no point baking extreme detail 
when it won't be seen)
The grid encompasses the bounding box for the scene. As the example in the wiki shows, don't have 
elements outside the area you are concentrating on
That you are not baking the grid to a slow network location


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NRC Monitoring

Items on this tab are as follows:

NRC Key - Unique identifier for the NRC Controller generated on the first run
NRC Identifier - Human-readable name for the controller (optional). If none is set here or in the mobile app, the 
NRC key value will be used instead
Enable Monitoring - This needs to be checked for monitoring to work at all, and should be checked before you 
start rendering. Once checked, there are two further options:

Direct Access - The default access method for monitoring; this requires that you open an IP address and 
specific port in your Windows services.msc tool. This method allows viewing of rendered images

Server Port - The default port number is 4431

Hosted - A more limited way of monitoring. Image viewing is not available with this method. Hosted links 
to an NT-hosted NoSQL server that keeps the log results of NRC. If you choose Hosted, further options 
appear:

Manually - Only when you request an update
Automatically - You can specify an interval between 5 and 60 seconds (default 10 seconds)

Getting started with the app

Android

The Google Play store has the application under the name NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

iOS

The App Store is where to go to get the iOS version of NRC Monitor. It is free and will only work with LightWave's 
distributed rendering method NRC.

Starting the app for Android or iOS for the first time presents a screen urging the user to create a server to monitor:
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As the message says, hitting the + icon at the bottom of the screen will open a new window where you can add an NRC 
Key - all that's necessary for the monitor to function. Adding an Identifier is optional, and in any case, your device will 
refer to the specific controller by its NRC key. If you enter an Identifier here, it will propagate to the Controller on your 
Windows or Mac desktop machine where you are running NRC; the same is true in the other direction.
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To add a controller, you need an NRC key first, which can be found in the NRC Controller preferences window > 
Monitoring tab. Copy this carefully onto the app and then proceed with your choice of Direct, or Hosted modes

Direct

You will need to enter an IP address along with the port number to be used. Until you have something that the NRC 
Monitor is happy with, you will see the following icon on the controller card:



LightWave 2020  –  LightWave 2020

Appendices –  3527

Once the connection is made, the bar will be removed:

Hosted

With Hosted mode, the NRC Monitor links to an NT-hosted NoSQL server that keeps the log results of NRC. The same 
iconography shows whether the connection has succeeded or not:

If your controller resolutely refuses to connect and you can't get rid of the bar even though you're sure you've 
done everything right, shut down the app and the NRC Controller and restart both. That usually unblocks 
them.


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Here there have been no tasks assigned to the renderfarm yet.

Using the App

Once you have your controller added, with no bar, it's time to start your scenes working. Both Direct and Hosted work 
the same way to begin with. Both have the same cards showing an overview of how many tasks have been assigned. 
You can tap on this card to see an overview of individual tasks:
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When a task is started, as shown left above, it will have no renders to show hence the line through the eye icon. Once 
renders are available the eye will be unbarred and can be clicked on to show previews of rendered images, right. Each 
buffer is treated as a separate task inside the scene.

With Hosted mode, the eyeball will always be barred because images cannot be previewed. In Direct mode, when the 
eyeball becomes unbarred you can click on the card to see thumbnails of all images rendered so far, and clicking on a 
thumbnail will display a full-scale image.

The three-dot menu on the right of each card will show the log for the task
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NRC Log
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Sliders

Sliders

(default keyboard shortcut Ctrl D)

Sliders (Modify > Tools > Sliders) are slider gadgets that are displayed over viewports. An individual slider is tied to a 
specific animation channel. A slider will indicate the current value of a channel and also let you interactively adjust that 
channel value. Sliders are useful for all kinds of animations, especially character animations. A good example can be an 
animated hand, with multiple bone movements for multiple fingers.

To use sliders in a scene:

Add the Sliders custom object (Object Properties Panel) to any object.
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To display and interact with the sliders, choose Modify > Tools > Sliders. The sliders for the last current object (with the 
Sliders custom object) will be editable when the Sliders tool is active. Keep this in mind if you have more than one 
object with the Sliders custom object.

To configure your sliders:

Open the Sliders Custom Object settings dialog from the Object Properties Panel.

The left window (Channels List) will list all of the channels in the scene. To attach a slider to a channel, simply select the 
channel in the left window and double click or click the Add Channel button. Selected channels in the right window can 
be removed with the Remove Channel button.

The Range Min and Range Max settings define the interactive range of the slider. The underlying channel can go beyond 
these values, but the slider’s range of control and feedback will be limited to this range. If the underlying channel goes 
outside the range, the slider value will turn red.

Remember, as with all Layout tools, you’ll need to select another tool (Move, Rotate, etc.) to deactivate the 
Slider tool.


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Clicking on the slider handle will immediately change the channel to the slider’s corresponding value.

The description Label will default to the channel name, but you may edit that if you desire. You can also set the color 
used for the slider with the Color preset pop-up menu or specific RGB values.Working with OpenGL Sliders:

There are three controls along the top. Drag the far-left one to move the slider group. The Envelope (E) button will 
display the Graph Editor with the associated channels in the curve bin. The right/left arrowhead (<>) button can be 
dragged to scale the size of the slider group. The arrowhead button on the right will minimise/maximise the slider 
display.

In the individual slider entries, the handle can be grabbed to slide to any value in the range set up and the arrows at the 
right end are to jump from keyframe to keyframe.

To simplify using sliders, use the Add Slider Bank generic plugin command (Not assigned to the interface by 
default). It will add a null object, apply the sliders custom object to it, and open the sliders interface, all in one 
step.


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Light Conversion
Loading a scene from a previous version of LightWave will automatically convert scene lights to the correct values, but if 
you need to manually convert a 100 % light from the old percentage scale to Lux you can do so according to the 
following rules:

Area * 3.14
Distant * 3.14
Dome * 1.57 (converted to Distant light with the appropriate angle)
Linear * 3.14
NGon * 3.14
Photometric no changes, but see note
Point * 3.14
Spherical * 6.28
Spotlight * 3.14
3rd party lights * 3.14

Photometric has no changes because Photometric lights are based on the IES data they contain that should 
now be accurate, rather than needing tweaking



Pi (either half, full, or double) is approximately the same light output as previous LightWave versions' 100%
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Scene Conversion

Automatic Scene Conversion

When you load a scene from a previous version of LightWave into 2019, two things happen. The first thing visible to the 
user is that you are asked whether you want to create a safe copy of the original scene:

Answering Yes to this question will open a requester to choose a new location for the 2019 version of the scene, copy 
the old content there and then open from there, preserving the original scene where it was. Answering No will go ahead 
and load the scene with the following conversions:

Surfaces

Legacy Surfaces have the following changes made when loading into LightWave 2019:

If the surface loads in with the Standard material, then Glossy Reflections on the Photoreal Integrator will be 
turned off so that the surface's Specular only produces a specular hit and doesn't include the "blurred 
reflections" that Glossy Reflections adds.
Mipmapping on any Image Textures applied to the T channels of the Standard material will be turned off.

Lights

Light intensity adjustments are made based on the light type. Conversions from the old percentage scale to Lux are 
created according to the following rules:

Area * 3.14
Distant * 3.14
Dome * 1.57
Linear * 3.14
NGon * 3.14
Photometric no changes
Point * 3.14
Spherical * 6.28
Spotlight * 3.14
3rd party lights * 3.14

Dome Conversion

Because Dome lights were replaced by Distant lights in LightWave 2018, dome light conversion adds a multiplier to the 
angle of the old dome light to account for the general shift from radius to diameter for lights. The number will be 
different to the value you had in 2015, but the appearance will be the same.

Pi (either half, full, or double) is approximately the same light output as previous LightWave versions' 100%
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Photometric Conversion

Photometric lights are left untouched and since they needed extreme settings to be correct in previous versions they 
will probably need to be set to 100 % in LightWave 2019.

Light Falloff

To replicate light falloff from previous versions (where falloff distance could be set according to the user's whim, rather 
than physically accurately), a Light Falloff node is added to the light's Node Editor and the appropriate connection is 
made. The legacy light's "Range/Nominal Distance" value (and optional envelope) will be copied to the same setting on 
the added Light Falloff node.

Global Illumination

Settings are transferred from the original scene as best as they can be. Bear in mind that the Backdrop and Final Gather 
versions of Radiosity in previous versions no longer exist.
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Common I/O
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Unity 3D Mode switch

Unity 3D Mode switch

Both LightWave and Unity use "left-handed" coordinate systems but FBX is right-handed, which means 
LightWave has to convert to the right-handed coordinate system, and Unity has to convert from the FBX right-
handed coordinate system back to its left-handed system. The way to convert from left to right-handed 
coordinate systems is to invert one axis and change the sign of the rotations on the other axes. That means you 
have three choices: X, Y or Z. The typical choice is to do it along the Z axis, which LightWave does. Unity uses 
the X axis, which results in an apparent 180 degree rotation of the scene.

Another oddity on FBX import is the wrong rotation of Lights and Cameras, caused by Unity ignoring any pre-
rotation setting stored in the FBX file, so these need to be compensated as well, again only for Unity.

Using this switch means that when you go into Unity and look down the Z axis the imported FBX looks exactly 
the same as it does inside LightWave.


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Common Modeler
Fine Adjustments - Rotation
Fine Adjustments - Stretch
Preferences reset
OBJ Options
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Fine Adjustments - Rotation

Using the RMB (and Ctrl) for controlling motion will result in much finer rotation increments.
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Fine Adjustments - Stretch

Using the RMB (and Ctrl) for controlling motion will result in much finer stretch increments.
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Preferences reset

Preferences

The Edit menu contains three entries designed to ease preferences management:

Revert to Startup Preferences - This entry will revert to the menu, shortcut and plugin options you had set 
when you started this session of Layout or Modeler
Import Preferences File... - Opens a requester to look for a valid preferences file. The keyboard shortcuts and 
menu files that accompany it will also be loaded
Export Preferences File... - Exports a set of three config files: the main preferences and accompanying 
keyboard shortcuts and menu configs
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8.
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10.

11.
12.
13.
14.

OBJ Options

The OBJ tab contains options for importing and exporting OBJ file objects.

OBJ One Layer - imports the object as a single layer
OBJ One VMap - imports the object with a single vertex map
OBJ Pivot at Center - creates the pivot of the object at the center of the object
OBJ Write Normals - writes the normals associated with the object when saved
OBJ Merge Points - merges points sharing the same space
OBJ Reverse Ka & Kd - Reverses Ambient Occlusion and Diffuse channels
OBJ Double Sided - Creates double-sided geometry
OBJ Parts - Keeps LightWave Part Polygon tags
OBJ Foreground Layers - Only saves layers marked as foreground to OBJ
OBJ Continuous UV - UVs have shared points rather than duplicated

OBJ Smoothing Groups - Supports the new Smoothing Groups system
OBJ Remove Hidden - Polygons that are hidden will not be exported (Hiding layers does not have any effect)
OBJ Import Scale - sets the scale of an object when it is imported
OBJ Export Scale - sets the scale of the object when it is exported
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Modeler can create vertex normal maps by exporting an object in OBJ format with smoothing groups 
unchecked here.


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Menu Navigation

Menu Navigation

LightWave's internal menus can be filtered, navigated rapidly and scrolled up and down. Filtering works as soon as you 
start typing and is based on the localized name. To remove filtering without clicking away from the menu, you can use 
Backspace.

This scene has almost 2,000 objects, but typing narrows that down
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The Additional menu always has a large number of entries. Scrolling through them is easier than having to go to the 
base of the menu to initiate a scroll

Keyboard Navigation/Selection

The keyboard shortcuts for navigation and selection are as follows:

Home - Goes to the top
End - Goes to the bottom
Page Up - Goes one page up (towards the top of the menu)
Page Down - Goes down one page (towards the bottom of the menu)
Up/Down Arrow keys - Change the selection (highlighted entry)
Right Arrow key - Opens the submenu if the current entry has one
Left Arrow key - Closes the active submenu
Enter/Return key - Accepts the highlighted entry

If you have deep hierarchies then sometimes there isn't the room onscreen to fit the item names. Hitting Shift-
Left or Shift-Right will navigate inside such hierarchies





LightWave 2020  –  LightWave 2020

Appendices –  3548

Regular expressions can also be used to filter menus. Start typing and hit TAB to switch into and out of regexp 
mode. (Go here for a tutorial on how to get started with regex)

As an example, to find all the numbered spoons in the Ratatouille kitchen scene with 2,000 objects, open the 
objects list, type . and hit tab (and you'll see (.*) instead of the magnifying glass indicating you are in regexp 
mode). Now you are in Regep mode, you can type spoons\d to find just the objects containing the word 
"spoons" followed by a number.



https://en.wikipedia.org/wiki/Regular_expression
https://regex101.com/
https://en.wikipedia.org/wiki/Regular_expression
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Flat Menu

You can now call up a flattened version of every entry that exists in the main menu with the keyboard shortcut CTRL 
Space. Doing so presents a list of all available commands in Layout or Modeler (with their associated keyboard 
shortcuts). As with other LightWave menus, you can type to narrow down your selection and the cursor keys and Enter 
can be used to choose the command you require.
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Upgrading From a Prior Version

Upgrading From a Prior Version

Those upgrading from an older version of LightWave 3D may have a USB hardware key (or parallel key on Windows 
systems), also known as a "dongle". LightWave no longer requires a hardware key, but you may still find one useful at 
times (as, for example, if you freelance at a firm with strict network policies).

Otherwise, the same installation instructions apply for an upgrade as for new users. The installation program will not 
delete any existing objects, scenes, or images on your system unless an existing item has the same name and is in the 
same directory as an item that LightWave 2019 installs. For this reason, you should install LightWave 2019 in a new 
directory.

NewTek strongly recommends that you backup your system before you install LightWave 3D.
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User-created Tutorials
If you have a technique you'd like to describe for the benefit of other LightWave users, get in touch and we can host it 
for you.

Exporting skinned characters from 3ds Max to LightWave — by Tony Prohl
Fundamentals of Subpatch Modeling — by Richard Culver
Environment Light tutorial — by Andrew 'Tobian' Comb
Move, Rotate and Scale Parts in LightWave 2019 — by Joe Lertola
How to do edge renders in LightWave 3D, a brief tutorial — by Nick Stevens
IK Booster Manual — by Ryan Roye
Typography with OpenVDB — by Mark Warner
Managed Floor Destruction — by Monroe Poteet
Using the Ray Type Switch node to control exactly how and what is reflected, refracted, or used in radiosity — by 
Robbie Mueller

___

The links below may take you to external sites or to user-submitted content. NewTek makes no claim for the 
suitability of these tutorials for the LightWave product, and you consume this content at your own risk.  We 
provide access to it solely as a convenience to our customers.



mailto://docs@lightwave3d.com
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Exporting skinned characters from 3ds Max to LightWave
Tony Prohl has created this guide to successfully importing 3ds Max-created assets.
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Fundamentals of Subpatch Modeling
Richard Culver has agreed to allow us to use his excellent tutorial for subpatch modeling for the official LightWave 
documentation wiki. It is in eight parts.

Subpatch Modeling - One
Subpatch Modeling - Two
Subpatch Modeling - Three
Subpatch Modeling - Four
Subpatch Modeling - Five
Subpatch Modeling - Six
Subpatch Modeling - Seven
Subpatch Modeling - Eight
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Subpatch Modeling - One

Click here to expand Table of Contents...

Basic Definition and Terms
Subpatch and Catmull Clark
Subdivision Math

Subpatch
Catmull Clark
Summary

More Terms
Rules

Hard Rules
Soft Rules

Basic Theory and Concepts
Overview
Giving yourself an editable edge
Triangles
Keep a simple low poly count
Balancing extremes
Stepping down
Separate Parts
To Boolean or Not to Boolean?
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NOTE: This tutorial will start out very simple and basic so nothing is missed and progress to more advanced techniques. 
But this is going to be fairly thorough, so no matter where you are as a modeler there will be things to learn so by all means 
start from the top.

Basic Definition and Terms

Subpatch Modeling (often referred to - technically speaking - as subdivision surfaces) is a process where you create a 
base shape from a polygon mesh (Base Mesh) then switch to a mode - TAB key - that subdivides these polygons into a 
rounded smooth organic shape (Subpatch). You can edit the shape in subpatch mode or you can switch back and forth 
using the TAB key. Some modelers prefer to do most of the editing in polygon mode whereas others prefer the organic 
feel of subpatch mode. More on this later. If you are new to subpatch modeling or to subdivision surfaces in general or 
even new to 3D you might want to take a look at this article for more information on the many uses for SDS before 
continuing with this tutorial.

Subpatch and Catmull Clark

As of LightWave 9.0, Modeler has two modes of subdivision surfaces. Subpatch mode, the mode we have had since 
Modeler got subdivision surfaces and Catmull Clark, (new to 9.0) named after the two men who invented it. In Subpatch 
mode you are restricted to using polygons of three or four sides.

There are two differences in Catmull Clark (or CC) and Subpatch. One is that CC can use polygons with more than 4 sides 
called Ngons. The other is in the math that CC uses to subdivide the surface in Layout and in the display of Modeler.

This is important to know. In Modeler, you set the subdivision level for both CC and Subpatch by bringing up the 
General Options panel. The Shortcut is "o" on the keyboard.

http://www.lightwiki.com/Uses_For_Subdivision_Surfaces
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The more geometry you have in your object, the slower it is going to get in Open GL (OGL) when spinning it in 
perspective view. It is a good idea to get to know the math of how LightWave subdivides the base mesh both for your 
Modeler display and for rendering in Layout. This affects how your model will look in Modeler and how it will display 
and render in Layout. They are basically the same except that Layout then displays and renders in triangles which 
doubles the poly count from what you are "seeing" in Modeler, say in shaded solid view.

In Layout you set the level in the Geometry Tab of the Object Properties Panel - press "p" with the object selected - one 
for display and one for render.

Subdivision Math

Here is the math in very simple practical terms:

In layout:

(Sample is 1 square polygon)

Subpatch

Level 1

This subdivides each polygon with one polygon. That is, it is a 1x1 subdivision = 1 polygon.
Then each polygon is converted into tris making 2 polygons. (The one polygon cut at a diagonal)

So level 1 = 2 polygons.
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Level 2

This is 2x2 subdivision = 4 polygons
That's basically a row of 2 polygons down the X and a row of 2 polys up the Y.

Now these polys are divided diagonally to make tris = 8 polygons.

So level 2 = 8 polygons.

Level 3

This is 3x3 subdivision = 9 polys made into tris (doubled) = 18 polys.

Level 4

This is 4x4 = 16 polygons, tris = 32 and so on.

Catmull Clark

Level 1

Level one takes the original polygon (1) and doubles this number to come up with the number for an equation.
So it is so it is 1 polygon - our sample times itself so that we get 2. This number is then inserted into the equation 
(a)x(a) to get 2x2 = 4 polys divided into tris to make 8 total polys

Level 2

Takes the number created by level 1 (2) and doubles it and uses this number (4) in the equation. So it is 4x4 = 16 
doubled by making it into tris = 32
Numbers sounding familiar? Just like binary code for computer data and computation - well, no need to go into 
that.

Level 3

This takes the number from level 2 (4) and doubles that ans uses it in the equation. So it is 8x8 to get 64 
subdivided into tris to get 128.

Level 4

This is 16x16 = 256 and made into tris = 512 polys

Summary

Level 4 Subpatch - 32 polys
Level 4 CC - 512 polys
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So as you can see there is quite a difference. If you are going to use CC, know that you should set it to a low display level 
in Modeler and in Layout otherwise it will bog down and be too slow to work. You can also use this math to predict how 
many polygons LightWave will render. With larger scenes this will be crucial to know as it will make a big difference on 
ram usage.

More Terms

Let's go over some more terms.

Quadrangle - A quadrangle is a polygon that has four sides. This is often referred to as a Quad. These two 
subpatched primitive shapes consist of all quads.

 
Triangle - Here we mean a polygon that has three sides. This is often referred to as a Tri.

Ngon - An Ngon is a polygon with more than 4 sides or points.
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Grid Mesh - A grid mesh is basically just that, a simple cross hatch of polygons. 

 
I use this term to indicate areas of the model that act as a connecting web between areas of particular detail.

Edge Loop - Areas of detail and contour are defined by Edge Loops. These are a series of quads that form a 
complete or partial loop and thus change direction from the grid mesh.
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Poly Flow - Poly Flow is a term that is often used to indicate the overall design and structure of a model using 
grid mesh and edge loops. The poly flow for a head, as an example, could be plotted out in predictable areas 
where detail will be added such as the eyes and mouth. 

 

Points - You should already know what a point is. But in subpatch we look at a point as a vertex. That is to say, 
connecting points where more than one edge merge and this is indicated by how many polygons share that 
point. This is a very important concept for subpatch modeling. I have also seen this referred to as a Star or a 



LightWave 2020  –  LightWave 2020

Appendices –  3561

Pole. Regardless of what you call it, the main thing is - how many polygons does that point connect to?

Rules

Hard Rules

Let's take a look at the basic rules that apply to subpatch modeling - technically speaking. That is, the rules that you can 
not bend.

Subpatch - You must have polygons with at least 3 but no more than 4 points.

If not, when you hit TAB, you will get an error message:

And the polygons that are illegal will not subdivide.
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Catmull Clark - You can have polys with more than 4 points called Ngons but the minimum is still a polygon with 3 
points.

If not, when you hit TAB, you will get also an error message:

And the polygons that are illegal - in this case a 2 point poly - will not subdivide.

Soft Rules

From these guidelines or restrictions we arrive at a set of soft rules - if you will - that come from application and 
observation. Some of them based on artifacts that you may encounter while trying to render your image, others based 
on experience in getting predictable shapes with economic use of polygons. We will cover the soft rules in this tutorial. 
And I should note that even though you can have Ngons in a Catmull Clark subdivision, most of the rules that come from 
working with a maximum of 4 points still apply and it should be assumed unless specifically noted that we are in 
standard subpatch mode throughout this tutorial and not Catmull Clark.
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Basic Theory and Concepts

Overview

Generally speaking creating a subpatch model is a process of connecting areas of detail defined by edge loops to 
greater areas of the model that form the general shape or form of the object and giving yourself ideal points to edit the 
shape smoothly and predictably. The more complex the object, the more complicated this process becomes.

Here is a simple illustration.

Giving yourself an editable edge

In this illustration you see that an edge loop is defining the shape that protrudes from a flat surface.

Notice that where the edge loop connects to the outer mesh there are 5 poly points and where it connects to the inner 
mesh there are 3 poly points.

In between these two areas is an edge loop that is made up of 4 poly points. This is indicated as an "Editable Edge".

Both the 3 poly point and the 5 poly point are difficult to edit predictably and will often cause unwanted bumps in your 
model. Points with 6 or more polys connected will give you a pinching effect and in general be difficult to get placed 
properly.

An ideal editable edge, or point for that matter, is one that is connected to 4 polygons. No more and no less. This will 
give you smooth predictable results.

Triangles

Triangles also come into the avoid category. They are sometimes unavoidable. They should be placed in an area that is 
nearly flat or that will not be visible such as behind an ear. They can also cause smoothing errors in a render.

Keep a simple low poly count

An ideal object has only the polygons needed to create the shape and no more.
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Balancing extremes

 

These two heads illustrate a low poly example and a high poly example.
The advantage of the high poly example is that there are more options to edit the shape. This particular example was 
taken from a base head then molded into this character (more on this method later). The disadvantage of course is the 
mesh is too dense and can create a slow down of layout during animation and takes up more ram.

The advantage of the low poly head is that is is faster to animate and takes up less ram. The disadvantage is that 
changing the characteristics of it as well as morphing it will not be as easy or smooth.

You have to balance these extremes because in order to have the ideal editable mesh and avoid 5 and 6 poly points as 
well as triangles, it takes more geometry. 5 poly points of course are unavoidable. But as you begin cutting back on this 
you have to add more geometry.

Stepping down

Stepping down is the process of taking your high detail areas and reducing the polys so that the over all mesh area is 
less dense. And again in doing so you create more 5 poly points and, depending on your method, perhaps triangles.
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The above pictures illustrate the basic concept and sequence of stepping a mesh down so that it goes from high density 
to low density. An area of high detail to one of low detail. Stepping down is one way to balance these extremes and have 
a model that has enough detail where needed and is not too dense to be practical. Notice how it creates points and 
edges that will be difficult to edit. These should be placed in an area where they will not be defining contour or detail, 
but rather, on flat or slightly curved areas of the model.
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Here is one practical example. The detail of a hand stepped down to the lesser detail of an arm starting at the knuckles 
where bumps are expected.

Separate Parts

This simple concept should not be overlooked. A subpatch model does not always have to be one part. A great example 
is creating an eye socket as part of the head and inserting an eyeball. This is not only good for animating the eyes it also 
makes good practical sense in creating the object. Not all parts have to be connected. An arm can disappear into a shirt. 
A handle can rest against a mug cylinder, a side view mirror against a car body, separate pieces of a chair or other 
furniture, as just a few examples. By separating things into parts you can eliminate the need to graduate from high 
detail to low detail. Deciding what can be connected and separate is a vital step in planning how to model an object.

To Boolean or Not to Boolean?

Modeling has gone though many advancements in technology over the years. One of the very early advancements was 
the ability to use shapes to cut out other shapes. Many modelers still use this technique. When spline patching, then 
smooth subdivision (Metaform) and eventually subpatch modeling came along, modelers turned away from Boolean 
operations in favor of newer more efficient ways of modeling. Furthermore, Booleans can be sloppy. Poor planning and 
misuse has lead to many modelers to have the opinion that Booleans "make hash" of your mesh, are difficult as well as 
time consuming to clean up and in general are not reliable. For this reason Booleans have become rather taboo in 
subpatch modeling. To be clear, a Boolean won't work if you have subpatches turned on. However, used properly and 
with good planning, Booleans are a very valuable tool for preparing a polygon base mesh for subpatch - especially in 
creating inorganic objects. There are certain things you will need to know to make Booleans and stencils work, and I will 
go into these techniques as we get into creating some shapes.
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Subpatch Modeling - Two

Click here to expand Table of Contents...

Subpatch Characteristics
Movement
Sliding Scale

Poly Flow
Two kinds of movement
Strong and Weak Joints

Poly Flow Examples
The Letter A
The Letter B
A Custom Font
Combined Polyflow
Creating hard edges in a loop

The goal of a modeler or any artist is to be able to create anything he can see or imagine. In part one, we went over 
some of the basic terms and theory concepts. Now we are going to learn how Subdivision Surfaces work from a very 
practical level. There are certain things I think are important to know about how SDS acts on a polygon mesh that will 
help us to predictably create any shape we want.

Subpatch Characteristics

Subpatch characteristics are pretty intuitive to understand at first glance. You take a square polygon, hit TAB and it 
becomes a near circle. Pull the control points around and you can turn it into an egg shape etc. Basically it is 
approximating your base shape with curves.

  

Movement

But as soon as we get past the simplicity of a square, cube or a ball we have to understand more than this. One very 
important characteristic of SDS is movement. Movement of vertices and edges from their original location to that of the 
subdivision surface. The most common understanding and use of this is to edit either the original vertex or the new one 
on the subdivision surface. In fact, it is often that the cages are turned off and the subdivision surface alone is edited. 
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This gives you a better visual feedback on the shape. You can access this display option in the display options panel, "d" 
on the keyboard.

 

Now let's look into this a little further. In this first example we are going to explore the movement of vertices and edges 
on a flat rectangle that is subpatched. This is very simple but the purpose is to introduce a concept we will build on and 
use in other ways.

 
OK, we start with one four-sided rectangle polygon.
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And when we subpatch it, notice that the vertex moves just about exactly 1/6th of the total distance from point to point 
on the X and on the Y. This does not mean much at this point. It is just giving us a formula to compare. The curve is just 
one continuous ellipse. It has no beginning or end.

And so we now start to add geometry. We split it once down the middle.

And when we subpatch and we get a new distance and the vertex moves 1/6th of this distance. So here is the first point 
we notice that the curve has a start point. It is now two U shapes that start from the middle. But more importantly we 
make note of the fact that the curve is being plotted from this new point and that the vertex moves the same 
percentage of distance from point to point. And that it is always calculating from all points it is connected to. In this 
case we are only in two dimensions so it is calculating a curve on the X and Y.

OK, So now we start to add more geometry.
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We start out with the rectangle again. This time we have added edges at each end.

And when we subpatch it the vertices, now also represented by edges, move toward each other or actually toward the 
center 1/6th of the total distance to the next point. In the first example where we split the polygon, notice it did not 
move since it was in the middle. But now that we put edges on the sides they do move toward the middle. The further 
they are from the nearest vertex the more they will move. And the reverse is true.

Our curve is tighter now and note that it starts from the position of the inner edges we have added. This is important. 
The curve will always start from where the vertex moves to.

So now we will split the polygon down the middle.
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And notice that the outside edges do not move as far because we have shortened the distance to the nearest vertex. It is 
still moving 1/6th the distance but the distance is now shorter resulting in a tighter curve even though we have not 
adjusted the outer edge at all. Remember that the curve always starts from where the vertex moves to.

So up to this point we are talking about the distance between two points on a line.

Sliding Scale

But when we put a line in the middle as an extra control point, if it is at the direct center of that line, it has no 
movement. As you travel to the edge the gap gets wider. So it is not a constant percentage. It is on a sliding scale. 
Approximately 16.9% (1/6th) at the edge to 0% at the center point of the two edge points on that line.
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Knowing this one bit of information will save you lots of head scratching and frustration as you move a line in on 
another line to get a tighter edge or give something any kind of sharper detail. You will wind up with edges so close 
together you can't edit them easily.

The solution is to add a line behind it and move it in so that it closes up the gap and tightens the curve.
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So creating predictable shapes in subpatch is really a matter of restricting and controlling movement of vertices on the 
subdivision surface.

Poly Flow

The way we control or restrict the movement of vertices on the subdivision surface to get the shapes we want is through 
poly flow. There are two basic types of poly flow - hard and soft. As mentioned before, Grid Mesh and Edge Loops.
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A grid is very good at holding a shape whereas edge loops give in and create curves.

Two kinds of movement

And with this then we can observe that there are two kinds of vertex movement along the subdivision surface.

  

1. Along a vector.

  

2. Along a line.

It is restricting vertex movement to the line that creates and angular shape or a sharp edge.
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And allowing movement along the vector that creates a curve.

Strong and Weak Joints

And so we can further extrapolate that there are two kinds of joints:

  

Strong and Weak
As mentioned in part one, these weak joints (3 and 5 poly points) are difficult to edit with predictable result. And now 
you can get an idea of why, since they move on the vector abnormally and allow for a curvature or bump that is an 

anomaly to the surface we are trying to create.  
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Poly Flow Examples

The Letter A

 

Using edge loops for the inside hole and legs allows for very clean geometry. All that is needed is to put some edges 
close to the corners and then edges on the outside of these to keep them from moving as much and you have a nice 
tight curve.

The outside corners can use simple cross hatch grid lines for a tight curved edge. Notice that there is little difference 
between the base mesh and the subpatch version. This is a clean, economical, controlled mesh.

And it extrudes beautifully.
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Now there is a very good reason not to use the cross hatch pattern on the inside tight corners. Also as a general rule, 
never connect two lines to one point on an edge unless it is an outside sharp corner like the top and bottoms of the 
letter A example.

This configuration leaves a 5-point poly right on the corner when you extrude and it will never look quite right not to 
mention be hard to edit.
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Inside tight corners and all curve edges should be an edge loop.

So in review we have used these two configurations:
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The Letter B

We will use them again in the letter B:
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With the addition of the wide sweeping edge loops that make up the curves of the B.

The center of the B poses a poly flow problem that we can get away with since it only has to be flat. If we needed to 
curve this, the weak joints would pose a problem we would have to solve to get a smooth arch.

http://www.lightwiki.com/Image:LetterB3.gif
http://www.lightwiki.com/Image:LetterB3.gif
http://www.lightwiki.com/Image:LetterB3.gif
http://www.lightwiki.com/Image:LetterB3.gif
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To solve it we have to add more geometry to smooth out the flow (with strong 4 poly joints) and we can have a much 
smoother arch on the surface:

And again this illustrates that the more complex the object, the more challenging it is to keep a clean poly flow. It also 
illustrates that you should model for what the job requires. You can get away with a lot on a flat surface and it will save 
time and polygons. But if it is to be curved you need to add more geometry to redirect the flow so as to eliminate as 
many weak joints as you can or place them where they are not a problem.

A Custom Font

Some samples from a font I created for a logo. You can see the various configurations that are all combinations of the 
edge loop and the cross hatch to create a transition of flowing curves into sharp points which are just various uses of 
the cross hatch pattern. Again here the logo only needs to be flat so I can get away with murder on the flat face and 
concentrate on my edges, but still doing my best to follow a logical flow and sticking to quads as much as possible.
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Closeups:
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The Letters A and B and this logo example were created on a 2D plane and then extruded with the Extrude Tool. So you 
have two basic configurations.

The Cross Hatch:
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The Edge Loop
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Working with these two configurations you can pretty much do anything.

Combined Polyflow

The other most common use of hard and soft poly flow is the placement of edge loops within the mesh. The mesh 
defines the shape and the edge loops create detail.

You would most often see this used to create eye sockets in a character head or the area around the mouth but basically 
any smooth shape or contour is delineated by the use of edge loops.
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Creating hard edges in a loop

A series of concentric lines in an edge loop give you the ability to both a) hold the curve shape with the edge loop and b) 
allow for tight edges using lines with strong 4 poly joints, which are in essence grid lines. So both strong and soft poly 
flow working together to define the shape.

As I pointed out in the beginning, in general, subpatch modeling is a matter of laying out grid mesh and edge loops in 
such a way as to create the shapes we want. Working with objects that have a more intricate contour is more complex in 
a sense and pose different challenges in "connecting the dots", but the basics we have covered so far apply. From here 
it is just a matter of exploring their usage.
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Subpatch Modeling - Three

Click here to expand Table of Contents...

Creating Primitive Shapes
Tools
Flat Box, Rectangle, Cube
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Rounded Edge Cube

Ball
Disc
More Primitives

Creating Primitive Shapes

In the visual arts, it is generally understood that all forms start with a primitive shape. It is no wonder then as to why in 
Modeler and in other 3D modeling applications, the creation of primitive shapes are a built-in function. Click on a tool, 
pull out a box or a ball. However, while this is great for polygonal modeling it does us no good for subpatch modeling, 
for as you have seen, hitting TAB on a box will give you nothing but putty and the ball tool puts a series of triangles at 
the poles. Something we don't want either.

Sure we could add segments to a box and it will hold its shape or just like with the triangles at the tip of the ball. But to 
truly master this art of subpatching we are going to have to do better than this. We need to know how to make 
subpatch-friendly primitive shapes. We can then use this understanding to construct more complex forms.

I will start with an overview of the tools you might want to use if you are going to follow along. I am not going to impose 
a workflow on you but give you what tips I can that I think are applicable as we go. Not going to bog you down with a 
step-by-step either but rather give you the basic sequence the object should be constructed. You can otherwise go at 
your own pace and sequence if you choose.

Tools

These are the following tools you should get to know for this segment of the tutorial. Note that you may also have your 
own preferences and/or plug-ins.

Basic Primitives:

Use cursor keys to add/reduce sides and/or segments while using the primitive creation tools.

Go to:

Box Tool (Shift-X)

Disc Tool

Ball Tool (Shift-O)

You may use the numeric requester if you prefer in some cases.

Add Geometry

Add Edges Tool
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Bandsaw Pro Tool

Knife Tool (Shift-K remember that this tool also has a numeric requester for precise placement)

Rounder

Bevel Tool. (B on the keyboard Ctrl key to constrain to one action - inset or shift - based on mouse movement)

Extend Geometry

Extend Tool (Shift-E)

Merge Geometry

Merge Polygons (Shift-Z on the keyboard)

These are the minimum tools you will need to know for this segment. Consult the LightWave manual if you need 
assistance. Also if you have the online help files installed, you can press F1 in Modeler and it will bring up a reference 
manual for LightWave with a search function.

Note: A general understanding of the basic functions of Modeler as well as some basic tools such as Move, Stretch, etc. are 
assumed.

Flat Box, Rectangle, Cube

Flat Box

Simply create a box:

This tutorial was written before several current Modelertoolswere written. Look into tools like Edit Edges, that 
will make adjusting for harder edges far more simple.


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Slice cross hatch edges.

Hit TAB for subpatch.

It will have a fairly tight corner.

Use Band Saw Pro with two segments, one at 2% and the other at 98%. Do it once, the tool will remember it 
and do it the other way for perfect symmetry.


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Uses: Basically a starting point for anything flat and square or square-like or even with sharp corners.

Other Uses: You can use this for a wall or floor or any flat geometry you may want to use as a base for displacement but 
that needs to remain square or rectangle.

Extrude and add a slice down the middle of the edge for a flat rectangle shape. If you need tighter edges simply add 
more segments to the edge or face.

Uses: For a tabletop, desktop, etc. Basically the starting point for anything square or rectangle and thin. Could be the 
base for a more complex object.

Other Uses: Use as a base object for something such as a stone wall that could be created using displacement.

Cube

Pull out a box. (Tip: Ctrl key to lock to perfect cube)

As you can see this makes a perfect "imperfect" object with slightly rounded corners. This is much faster to 
create, fewer polygons and overall more useful than creating something like this using polygon modeling.


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Add your edges (Band Saw Pro three times)

Subpatched makes a nice tight box.

Simple and low on polys.

Uses: Use to make a tutorial on how to make a perfectly imperfect cube with subpatches. Seriously though, different 
than the flat rectangle. This is the basic configuration for a portion of an object that needs to retain some kind of boxy 
shape with hard edges.

Rounded Edge Cube

Apply Rounder with these settings to a box.
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Subpatch.

Uses: Any boxy shape or portion of an object that also needs rounded edges.

Ball

Create an 8X8 ball.

Tip: Fix Poles Detail/Polygon/More

This tool creates a ring around the tip where the triangles are. But whatever you want to do to get the end result.
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Merge pairs of polys to get this pattern at the ends.

Subpatch

Stretch Tool to flatten slightly and make perfectly round.
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Uses: Great for eyeballs. Any round shape that needs to be animated with squash and stretch. An egg, the crown of the 
human head.Basically any object that starts with or uses a sphere-like shape.

You will get some slight bumpy parts at the poles of the sphere but there simply is no way to make a 
perfectsubpatchedball. There is always going to be a compromise someplace. This is the best one I have found. It has to 
be a matter of using common sense in the animation or still work place this where it will be least noticeable on a shot by 
shot basis.

Disc

8-sided Disc

Bevel
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Add Edges Tool (center polys) and Bandsaw Pro to add this geometry.

Subpatch

Uses: Starting point for anything with a tubular shape or any part of an object that has this shape.

More Primitives

If you want you can use what you have learned here to create more primitive shapes such as these:

Tip: More primitive shapes under Create/Primitives/More.
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So, from this you can see that the geometry does not need to be complex to create these forms. On this note, it is always 
a good idea to start simple and build into complexity as you go.

We have now explored the basic shapes we will need to create more complex forms, and that's just what we are going 
to start learning how to do next.
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Subpatch Modeling - Four

Click here to expand Table of Contents...

Combining Form
Method One: Altering An Existing Shape

Box Modeling
Old School
Point to Point
Spline Modeling
Plotting out Polyfowby Hand

Method Two: Joining Shapes
Summary

A Circle In A Square
Other Shapes In The Square

Box In Square
Triangle In Square

Creating Multi-sided Polygons
More Complex Poly Flow
Combining Solids

Ball and Cube

Combining Form

The first step in combining form is in the creation of the original form or forms. Here is a rough outline of some of thethe 
methodsof creating your original starting shape.

Create a primitive.
Draw out a multi-sided flat polygon.
Create a spline patch.

There are two general ways to combine form:

Start with a basic shape and alter it to create a more complex shape.

Start with two or more shapes and join them.

Or of course a combination of the two.

Method One: Altering An Existing Shape

Box Modeling

Box Modeling is basically the process of taking a single box and altering it into an organic shape such as a head.
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The most common practice of Box Modeling is to work primarily in Subpatch Mode and use tools such as Multishift that 
keep the object in quads and with the aid of SpinQuads to redirectflow. For people with a sculptingbackground this has 
the appearance of sculpting more than other methods of subpatchmodeling. In theendhowever you still have to wind 
up with a certain type of poly flow. So understanding what that should be is essential to using this technique 
successfully. We are not going to go into this technique but it is one of the ways it can be done.
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Old School

Point to Point

Some prefer what is called a Point to Point method where you start out with one small detail and work your way out 
literally a few points at a time poly-by-poly creating and joining your mesh into its final form. This is a valid method. 
Generally it is not a good idea to start out small and work big. But this still is a good method to use in some cases. This 
concept of adding geometry from existing geometry uses tools such as ExtenderPlus and Multishift which are real 
time savers.
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Spline Modeling

This is sort of a carry over from when there was no other way to get curved shapes in LightWave other than to create 
spline patched models. For somethingsthis is still a good technique to have and use.

Plotting out Polyfowby Hand

I have seen a method evolve which uses the concept of drawing poly flow onto existing geometry by hand sometimes 
completing all of the poly flow before even starting on defining the form. Many people including myself have seemed to 
simultaneously and separately develop this working method.

Here is an example of poly flow plotted out for a head on a flat polygon then shaped into the form of a head for editing.
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And another approach from the side view using a sketch as a reference.

This method works from the concept of working with original shapes that are close to the form you are going to create.
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Method Two: Joining Shapes

It is sometimes easier to create shapes separately and thenjointhem. This allows us to concentrate on the poly flow of a 
ball, forinstance,and then joining that with a cube, thus allowing precision work on each shape and concentrating on 
creating a smooth joint between the two. As an example, I almost always create an earina separate layer then join it to 
the head.

Summary

In both cases of altering existing shapes and joiningshapeswe have this basic 4-step process.

Creating the poly flow of an overall shape.

Creating a poly flow for the detail

Creating the poly flow that joins the two and

Tweaking the shape as necessary to smooth it out or further refine the form and detail. Or simplyadding-onfrom 
that new geometry.

Let's get started with some basic shapes to get the hang of it.

A Circle In A Square

The following technique is a hybrid of the two methods of combining form.

Additional tools you will need to be familiar with:

Drill (Shift R) Template inBackground layer.

Merge Points (M) Leave at default settings.

Split Polygons (Ctrl L) Select Polygon to split, select two points that define the new edge. Run tool.

Again if you need more help with these tools consult the manual and as before, you may have other methods.

Start with a subpatch square.

An 8-sided disc. (single poly)
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Drill tool -stencil.

Merge Points (always do this after a Boolean operation).

Add edges will fail.
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This poly needs to be split into two.

Using bevel and add edges make this geometry.

Subpatch.
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Notice that thecentercircle (tan color) is the only one that is perfect. The outer circle is being pulled at the corners by 
the edges connected to the weak joints.

I think of this as the Buffer Edge.

And in between the inner circle which is made up of the 3 poly points and the outer Buffer Edge is our Editable Edge - 
the perfect circle.

This is the edge I would then build from if I wanted to have a perfectly round hole or protruding geometry.
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Use ExtenderPlus (E) tool to build on to the above circle square object. Hit E to create new geometry; use the Move tool (T) 
to move geometry; hit E again to make new geometry, move it and so on.

Other Shapes In The Square

Box In Square

The challenge here is simply keeping the box square. However using what we have learned this is easy.

Triangle In Square

If you are having trouble remembering the steps refer to the first example.

Also, notice that I am fanning out my lines keeping the geometry as even as possible. This is a good habit to get into 
especially when you get into shapes that have a curved surface.
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Creating Multi-sided Polygons

We will now explore the creation of more complex original shapes forsubpatching.

Additional Tools Needed:

Pen Tool (Create Tab/Polygons/Pen) Text Tool (Shift W) DragNet Tool (;)

Create an S with a simple font.

Use it in a background layer as a reference and draw out a simple S with the Pen tool. Make sure and create the same 
number of points on each side of the S so you can join them later.

Use Catmull Clark subdivision surfaces - if you have LightWave 9 or higher - to make sure that your curves match the S. 
Use the TAB key to toggle it on and off to adjust the points where needed to make it conform.
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Bevel tool.

Fix the ends of the letter so that they will be sharp and not curved. You can use the Add Edges tool and the Merge Polys
tool. (Shift Z)

Fill in the quads in the center. (Add Edges tool)

Subpatch and make final adjustments with the DragNet tool.
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From here you can extrude the shape with the Extrude tool and use BandSawPro to tighten the edge if you like.

More Complex Poly Flow

S In Square

For this exercise we will make another S shape, but leave it at this point:

With the DragNet tool (and many other modify tools) you can right click to adjust a small blue circle that will 
give you the range of influence. This is a great feature and a perfect way to drag lines that are close together 
without having to do each one by hand.

Once you have the shape lined up with the reference, you are done.


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Just make sure it is at a point that it is done in the sense that it complies to the curves we want. We won't be tweaking 
and editing it later.

This example takes a little bit more thought as now we have a more complex curve and many more polygons. But rather 
than give you a step-by-step explanation, simply look at the progress of this as a reference to do it yourself.

In Review:

Use only quads.
Keep the 5 Poly Points away from the Editable Edge
Be sure to create a Buffer Edge around the S's Editable Edge so that it holds its shape.

To do this I use primarily the Add Edges tool and Merge Polys and I am using many of the techniques we have covered 
in previous sections.

Nice clean lines and a smooth but crisp transition from one shape to the next. Very simple and easy to achieve in 
subpatch with these techniques.

Let's look at some solid shapes.
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Combining Solids

Ball and Cube

OK, we are going do a simple joining of two shapes with a Boolean function, then subpatch them.

Additional tool needed: Boolean (Shift B)

Start with a subpatch cube and half of an 8x8 subpatch ball in the background layer.

Line it up so the ball is just below the top of the cube.

'

Run Boolean/Union.
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Merge Points.

Split Poly.

Run BandsawPro twice and it will stop at Ngons at the top of the cube.

Now we can add edges to the perfectly centered new lines.
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Add Edges tool to create Buffer Edge.

BandsawPro tool to create additional edge on ball.

Subpatch.
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Looks nice.

Now let's work on a curved surface.



LightWave 2020  –  LightWave 2020

Appendices –  3615

•
•

•

Subpatch Modeling - Five

Click here to expand Table of Contents...

Working On A Curved Surface
Other Shapes

A triangle

Working On A Curved Surface

Additional tools needed:

Weld

Multishift

Flatten

Now let's do a simple example on a curved surface. The goal here is to have a perfectly round raised area of detail on 
the curved surface of a cylinder.

We will start with a cylinder and a disc. For this example the disc is intentionally just smaller to show the challenge of 
connecting a shape with points that do not line up with the edges of the disc side. And the idea here is to conform to the 
curve of the disc with our new geometry.

Line the disc up so the center edges overlap perfectly. Make sure and select the polys on one half of the cylinder.

 

After we stencil:
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Always check merge points.

And then check for duplicate points in wireframe mode and then weld them.

Next we will create the first edge loop with Multishift. Use these settings to keep the geometry conforming along the 
curved surface.
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With the Add Edges tool create a buffer edge along the outside.

As well as these these edges.

 

Then merge polys to get this.
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And Add Edges. Note we are conforming to the curved surface with this connection.

And now we are going to merge these polys.

As well as these.
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BandsawPro to add an edge that will help restrict movement.

Add Edges to spit Ngon (bring all the way around to other side).

Don't forget to delete the unneeded points from the edges after you merge polys.

 


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Subpatch.

And now we have bumps on outside we can easily smooth out carefully with the drag tool.

 

Using the ExtenderPlus tool we can raise the circle slightly to give it relief.
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And more bumps on the circle.

Note that we can smooth these out easily because we have mostly 4 poly points to work with.

Alternate edits:

Now back to the original geometry and using the DragNet tool.
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We can do this.

 

Or using the MultiShift or ExtenderPlus tool.

Then we can do this.
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Or this.

Flatten tool.

 

And extend further.
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For he last example, we could have simply used the Boolean union function on two cylinders and then edited the 
outside geometry.

This shows that we can easily create a very predictable perfect circle on a curved surface.

We can do the same with other shapes as well.

Other Shapes

Such as this square in a tube, created with many of the techniques we have learned so far.

   

Now a problem occurs with this one.
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This is because we need more geometry to hold the shape. We are getting too much bumping with this little geometry 
because the 5 poly points are creating too much draw on the surrounding points. Remember about motion and weak 
joints. This is harsh on the curved surface.

 

So by simply starting with a cylinder with 16 sides and creating similar geometry...

 

we have pretty much eliminated the bumps.

 

And we have much better results overall on the smoothness of the shape.
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An alternate edit.

 

So to get a smooth surface on a curve and also have 5 poly points - unavoidable to create any kind of complex detail - 
we simply need more geometry.

A triangle

The geometry on this takes a little special treatment.

Take a look at this sequence.
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NOTE: Remember the letters A and B? In order to have tighter inside edges on the square and triangle we would simply 
have add more segments to the corners which in turn would mean more geometry all around.

And an alternate edit.

 

As before you will likely find some places that need smoothing. Carefully drag with the Drag tool on the 4 point polys to 
smooth out.
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So you get the idea. Controlling your mesh with all of the things we have learned so far.
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Subpatch Modeling - Six

Making a Hammer

Now we are going to put some of this information to practical use and create a hammer head. The handle is in Part 
eight.

Additional tools needed:

Taper
Triple Command (Shift T)
Symmetry Mode (Shift Y)

Here is a reference photo in case you want to use it for this portion of the tutorial.

First we will trace out a starting polygon.

Bevel.
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Fix ends with Add Edges and Merge Polys.

Create this geometry with BandsawPro, Knife and Add Edges.
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Extrude.

Bandsaw Pro



LightWave 2020  –  LightWave 2020

Appendices –  3632

Center 1D on the X.

Make sure center points are at 0 on the X.

Turn on Symmetry Mode.
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Use the Dragnet tool.

And taper the top points.
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Note: Alternatively, you could select these points and use the taper tool down the Y. Because the curve goes down the Y 
the taper tool will taper off its influence automatically. Whatever your preference. Sometimes I like to work by hand for 
a custom shape. But here a taper command works pretty well too.

Select these polys.
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Taper Tool.

Subpatching to check progress.
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Turn off subpatching. Select these polys.

Taper Tool.

Create a cutting tool.
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Center 1D on X.

In Symmetry mode shape it like this. (look ahead to further steps if you need to see where we are going with this).
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Triple Cutting tool.
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Very important to keep your cutting tools simple for Boolean. But non-planar polys can create problems, so triple your 
cutting tool.

Boolean subtract.

Merge Points.
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Now we are going to split the object. Create center edge.

Select these polys and delete.
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Now we will clean up the triple polys on our object. Merge Polys.

And delete points.

Preparing for a clean poly flow we will create this edge.
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Merge these polys

Delete point.
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Now will prepare the edge loops on the inner notch.

First connect these segments.

And then create these edge loops that connect to the poly flow we have already.
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Now the outer edge loop for the notch. Create this edge.

And start creating edge loop around outside of notch.
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Drag this point to prepare to turn corner with edge loop.

Finish edge loop.
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Make connecting edge to split Ngon. And another edge to create quad from triangle as well as terminate - step down 
out detail so we don't have to create more geometry.

Our progress so far after we mirror on the X and turn on subpatches.



LightWave 2020  –  LightWave 2020

Appendices –  3647

Now we want to tweak the slot. Use the dragnet tool.

And make slot rounder at the end and pull the middle into the body of the object to make it more cavernous. (We need 
to be able to fit the head of a large nail in here.)

Our progress so far.
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And the other side.
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Simple geometry and simple poly flow. So far we have a fairly complex merging of various contours curves and straight 
edges.
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Subpatch Modeling - Seven

Click here to expand Table of Contents...

Creating the Ball of the Hammer

Creating the Ball of the Hammer

We'll prepare to add the ball of the hammer.

Additional tools.

Bandglue

Untangle 

Select these polys.

= for Hide unselected.
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Use BandGlue to merge this loop.

Unhide "\" gives us this.

Now we want to merge these groups of polys.
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And delete the points.

To give us these four polys.
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Use ExtenderPlus and add two segments. Also use the stretch tool to scale each segment.

Delete half of the object.

Now let's fix the edge so it has a loop. Draw this line to the point.
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Weld the two points.

Merge these polys.
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Then draw the edge loop with the Add Edges tool.

Use the Drag (Ctrl-t) tool to fan out these edges.

Now mirror and select these polys.
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Flatten them on the Z.

Add one more segment with ExtenderPlus.
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Merge polys.

Untangle tool.

Now with a perfect circle you can extend it like so with ExtenderPlus.

Note: Alternate method for pre-9.2 is to put a 16-sided disc in a background layer and use BG Conform.


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And terminate the end in quads.

I did a little tweaking to some of the edges. Loosen them up a bit.
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And tweaked this curve. (All using the DragNet tool)

Here is the final result.
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Subpatch Modeling - Eight

Click here to expand Table of Contents...

Creating the Handle
Connecting to the Head
Detailing the Top
Conclusion

Creating the Handle

We will now make a simple handle with a finger grip.

Draw out a polygon and split down the middle.

Create this geometry.

And then step down as well as add another edge to where the grip starts. This will make the subpatching tighter.
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Note: We are going to live with the bumps this will create as a result of this step down on what will be a curved surface. I 
figured I could live with it on the handle and that it would look natural as if formed. Alternatively we could just bring the 
edges all the way across.

Now Extrude tool (shift e).

And Taper.
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Now select these points.

Size them as the arrows show and select the points below,
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Size them in so the angle matches all the way around.

Now size these in a little too.

Now select these points and size them in slightly.
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And do the same on the other side.
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Now grab this row of points and size them so that they match the angle.
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Select and Multishift to create an edge loop along the bottom of the handle.
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Subpatched.

Now BandsawPro.
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Switch to point select mode and find this loop selected. Now size them out (on the Z only).

This will keep the ends rounded.
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Connecting to the Head

First size the handle as needed.

We need it to line up like this.

And move it on the Y to line up just below the bottom polys of the head like this.
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Boolean Union.

Merge points.
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And weld all four intersections.

Sometimes you need to switch to wireframe mode to select points.
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Add Edges tool to connect all four corners.

Then create an edge loop.
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Use BandawPro to split the edgeloop.

Switch to point select and add one more segment with ExtenderPlus. Size and move to create an impression.
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The result so far.

Detailing the Top

Hammers traditionally have a hole in the top where the handle pokes through slightly. Old wood hammers often use a 
wedge here to keep it tight. You could also just buy a new handle and replace a broken one if need be. We won't create 
the wedge but we want to show the handle coming though. If could either be an indent and the handle would be 
beneath the surface or in this case coming out the top slightly.

We will stencil an oval shape.
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But we want these points to line up. So select them and use the rotate tool with Mouse as Action Center (Shift F5) to 
put them near where we want them. Put the mouse near the lower point and rotate in a side view.

Should line up like this.
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Select polys and stencil.

And as before weld all four intersections.
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Then create this geometry.

Multishift for an edge loop on the inside.

And Add Edges for one on the outside.
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Subpatch and select the polys that include the perfect oval - the Editable Edge.

Use ExtenderPlus along with Size and Move or just use Multishift to raise it above the surface.
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The result so far.

One last detail. Select these points and Taper to bring closer to the handle.
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And the result.
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Conclusion

What we have learned so far.

Subpatching is a process of connecting areas of detail (usually edgeloops) to greater areas of the model (usually 
a grid mesh) with the use of poly flow.

Poly flow can be hard (cross hatch) or soft (edge loop) and therefore can flow smoothly from hard edges to 
curves.

There is movement of vertices in subpatch and that movement is controlled with poly flow - hard or soft.

We can use the creation of primitive shapes as starting points or as a general reference for the construction of 
similar shapes.

Complex shapes are created essentially by designing the poly flow that allows a smooth transition from one 
form to the next.

There are many ways to combine form but essentially break down to the creation of the original shape and:

Modifying or adding to that shape.
Connecting it to another original or modified shape.

- or any combination of the two.

Original shapes can be primitives or shapes such as multi-sided polygons we create by hand.

Many tools such as Boolean can be used to join shapes or as precise starting points (stencil) for poly flow of 
detail on an original shape.

It is possible to create any form with a simply-plotted poly flow and this often means doing so by hand to get 
exactly what we want.
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Environment Light tutorial
Andrew presents a solid grounding in how to use environment lights in LightWave 2019

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=72AAwSFx4nA

https://www.youtube.com/watch?v=72AAwSFx4nA
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Move, Rotate and Scale Parts in LightWave 2019

LW2018_parts_tutorial_content_03.zip

Click here to expand Table of Contents...
Move, Scale and Rotate Parts

Move Parts
Scale Parts
Rotate Parts

Using a Procedural Texture to Move, Scale and Rotate Parts
Documenting Node
Moving and Rotating Parts to Align With Points on an Object

Moving Parts to Points
Rotating Parts to Align with Point Normals

Controlling Parts Animations
Controlling the Animation of Parts using Reference Nulls
Using two Nulls to Animate Parts over Time
Using Multiple Nodal Displacements
Using Procedural Textures to Control Animations over Time

Conclusion



https://docs.lightwave3d.com/download/attachments/8201937/LW2018_parts_tutorial_content_03.zip?api=v2&modificationDate=1519685562000&version=1
https://docs.lightwave3d.com/download/attachments/8201937/LW2018_parts_tutorial_content_03.zip?api=v2&modificationDate=1519685562000&version=1
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The ability to natively move parts around with nodal displacement was added in LightWave 2018. Additionally, the 
modifier stack brings a lot of flexibility to nodal animation. You can have multiple instances of nodal displacement, 
which makes organizing, simplifying and reusing nodal displacement easier than it ever was.

Newtek introduced the Mesh Part node - a part is a polygon or group of polygons that share common points. A cube is a 
part that consists of 6 polygons and 8 points. The Mesh Part node allows you to set up nodal displacement networks 
that can move, rotate and scale all the connected points within a part as a single unit. In this tutorial I am showing some 
node setups that I have used to control parts.

Move, Scale and Rotate Parts

Animated gif showing parts being moved, scaled and rotated

Move Parts

The Mesh Part node provides information about the part that each point in connected to. This allows each point in a 
part to be transformed in the same way as all the others. In this node setup the part positioned is scaled so that all the 
parts move away from a common center.
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Node setup showing how to move parts away from the object center using the position of a null to control the animation

Scale Parts

In this example the part center is subtracted from the current position of the point that is being evaluated. This, in 
effect, moves the part to 0,0,0 for scaling purposes.
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Node setup showing how scale each part

Rotate Parts

A node new to Lightwave 2018 was the Deform: Rotation node. I am not sure I understand exactly how this node works. 
Perhaps there is a way to use it to accomplish a rotation in one step but I wasn't able to get that to happen. With some 
trial and error I did manage to put together this node network that will rotate a part around its center.

Node setup showing how rotate each part
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The same node network as the one above but the rotation network is in a reusable compound node

Using a Procedural Texture to Move, Scale and Rotate Parts

In these examples, a procedural texture is used to animate the parts. To keep the example simple I used the Ripples 
texture which is animated automatically. Other procedural textures can be animatied by linking them to a texture 
reference null.
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Node setup showing how move parts based on a procedural texture

Node setup showing how scale parts based on a procedural texture
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1.

2.

3.

4.

5.

Node setup showing how rotate parts based on a procedural texture

Documenting Node

This node network uses an unconnected node as a label to explain the setup's purpose. Also a complicated looking 
portion has been sequestered into a compound node

Say you have a project where you need to create a certain displacement effect. You have an idea for how to set up 
nodes to do this. You start with a few nodes and experiment by adding nodes and connecting them in different ways. 
You might add connections that make perfect sense to you in your gestalt of creation. Finally you get it to working the 
way you want and you move on to the next project. But the next time you look at it months or years later it is an opaque 
tangled mess. I’ve had the experience of looking at node networks I set up in the past and have no memory of how they 
work. For me, once a network gets to a certain level of complexity it becomes very hard to understand. Sometimes I 
have found it easier to re-create something from scratch rather than trying to figure how a messy network works. That is 
why I think it’s very important to document your node networks:

Give node’s descriptive names. You can do this by selecting the node and pressing the N key. Then you can 
change the name of the node. I like to leave the original name of the node in place so that you know what type of 
node it is and add a simple description after that.
Use disconnected nodes as labels to describe the overall purpose of the network and also label individual 
sections. You can also use the note field at the bottom of the node window, but I find this less useful as you don't 
see the note until you select a node.
Encapsulate different parts of your node network in compound nodes if possible. This simplifies the look of the 
network.
Keep node networks as simple as possible. The simpler they are the easier they are to understand and reuse. 
That’s why Lightwave 2018’s displacement stack is such an improvement. A stack of simple nodal displacements 
can add up to a complex animation.
Once you have a useful setup working save it as a separate scene. I have saved a library of scenes that contain 
possibly useful nodal displacements.
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Moving and Rotating Parts to Align With Points on an Object

Moving Parts to Points

One important thing to note is that when you plug a node network into the Displacement node the results of your nodal 
calculation get added to the position of the points in the object. So, to erase the initial position of the parts, you should 
subtract the part’s positon from zero as show in this example. This allows the rest of the node network to explicitly set 
the position of each part.

This node setup moves parts to points on a reference object

Rotating Parts to Align with Point Normals

Unlike Lightwave’s instancing, which has aligning to object normal built in, we have to do some trigonometry if we want 
parts to line up with an object’s normals. I put together an ArcTan2 function as a compound node which calculates an 
angle given an x and y coordinate on a Cartesian plane. This function is a nodal implementation of the ArcTan2 
description in Wikipedia. The node setup is probably very inefficient because it calculates six possible answers then 
uses the logic node to erase the five incorrect ones. Note that in this example the parts are moved to the points by the 
node network above. The rotation happens in a completely independent Nodal Displacement.

https://en.wikipedia.org/wiki/Atan2
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This node setup rotates parts to align with point normal. Note that the compound node ARCTAN2 is used twice. This 
function does not exist in Lightwave nodes (there is a third party Math nodes collection with ArcTan2 and many others 
here). So if all the wiring in that node were out in the open, so to speak, then the node network would look very complex 
and much harder to understand

Controlling Parts Animations

Controlling the Animation of Parts using Reference Nulls

I find using the animation of nulls to control nodal displacement networks to be very useful. This example has a simple 
animation setup. The move control can be animated between zero and one on the Y axis. This value is used to scale the 
effect of moving parts. If Y is zero then it wipes out the nodal calculation leaving the parts in their base positon.

http://www.neko.ne.jp/~asagi/P2P/Plugins/lay.html
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Using one reference null to control animation

Using two Nulls to Animate Parts over Time

Animating from one state to another is fine but sometimes you need a more complex animation. Very complex 
animations can be created by getting parts to be displaced at different times. A setup using two control nulls can 
achieve this. In this example a building assembles itself as parts fly in and scale as they move into place. The Y positions 
of two control nulls are used to control the animation. Parts above the top null are invisible because they are moved 
away from their real position and scaled to zero size. Parts below the bottom control null are in their base position. 
Parts in between are in a blended state.
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Using Multiple Nodal Displacements

In Lightwave 2018 you can have multiple instances of Nodal Displacements. This let you keep your networks organized 
and understandable. You can easily make copies of your networks to make changes, layer different animations and 
effects and to experiment with alternate versions. By referencing control nulls the various nodal animations can be 
synchronized.

Effects like this are easily achieved with a mix of Part Move node setups
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This animation is accomplished by layering five different Nodal Displacements

Using Procedural Textures to Control Animations over Time

You can use procedural textures as a basis for animating parts at different times. This node setup moves parts away 
from the object center. The parts that get moved are determined by the alpha value of a procedural texture. In this 
example the Time node is used as input for the animation. The time controls the position of a gradient’s alpha value 
keys. Over time the gradient output will transition from all value one to all value zero.
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Conclusion

I have had fun exploring the new possibilities for using deformations in Lightwave 2019. You can download all the 
content for the examples from this link:

LW2018_parts_tutorial_content_03.zip

-Joe Lertola

https://docs.lightwave3d.com/download/attachments/8201937/LW2018_parts_tutorial_content_03.zip?api=v2&modificationDate=1519685562000&version=1
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How to do edge renders in LightWave 3D, a brief tutorial
This is a short blog post, which will describe how I go about edge renders in LightWave 3D. It’s really easy and I find it a 
great technique for renders that are not photorealistic.

I am using Lightwave version 11.6. I’m not sure how this works in other versions but it’s probably almost identical.

What do I mean by edge renders?

This is an effect that runs a line along various edges and boundaries. It can be used to emphasise fine detail, or to give a 
diagram effect. It works with transparency, and animates nicely.

Here’s an example.
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Hale Telescope Edge Render

Note how features of the telescope are highlighted with fine white lines.

Ready to start?

A simple example.

For your first try it’s probably easiest to start with a model which is all in one layer. Here’s my starting point, a normal 
render.
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Vostok Sample

Now select the object in question, and click Properties, then the Edges tab.
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Vostok screen shot, click to enlarge

And here’s the Edges panel from Lightwave 2019.
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Lightwave 2019 edges panel

You will see the options to turn on edges in various places. I normally find that choosing the first 3 or 4 works well. If you 
have VPR enabled, as in this case, you can see exactly what the effect is. I rarely turn on 'Other Edges' as it shows every 
polygon.

Here’s the resulting render:
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Vostok edge render 1

Now this is quite a bold effect, but you can tone it down, selecting a less obvious colour, such as grey, or by setting the 
line thickness smaller. You are allowed fractional pixel widths. Here’s the same object, with 0.5 pixel edges in grey.
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Vostok subtle edges

I hope you will agree that this is much more subtle, and I find it very useful to help bring out all the fine details I have 
modelled that may not be apparent in a more conventional render.

Alternatively, you may find it useful to let the edges dominate completely, giving an effect like a diagram. For this I find 
it useful to use one surface for the whole object, and set it to a flat colour, with 0% diffuse, and 100% luminous. This 
also lets you turn off all lights, and get very fast renders!
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Vostok, simple edges

If you use this technique with the ortho camera, (perspective free) you can produce impressive technical diagrams.

Also because it renders fast, it’s really good for animations, even ultra high definition renders. Here’s a link to a 4k / UHD 
render I did of the Aries from 2001, on my Vimeo channel:

Objects with multiple layers

Multiple layers are no problem at all.  As each is effectively a separate object, you can use different edge settings for 
each layer, but I generally use the same for all layers. And if you are going to do this, it’s a lot quicker to select all the 

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://vimeo.com/285323573

https://vimeo.com/285323573
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layers at the same time, (using the scene editor), then you can see them all come to life at the same time, using the VPR 
preview.

Finishing up…

 I hope you find this tutorial useful,  plese let me know in the comments if anything is not clear. I’d also love to see what 
you produce, so if you are on twitter I’m @runnymonkey, mention me in your post so I'll be notified there’s something 
to see.

www.nick-stevens.com

Note

At the time of writing this tutorial, Nick didn't have access to LightWave 2019's more advanced edge rendering 
possibilities, like Mesh Element Switch or the Global Edge Multiplier and Edge Vertical Points that could make 
his edge work even more exciting.



https://www.nick-stevens.com
https://docs.lightwave3d.com/display/LW2018/Mesh+Element+Switch
https://docs.lightwave3d.com/display/LW2018/Render+Properties+-+Render#RenderProperties-Render-GEM
https://docs.lightwave3d.com/display/LW2018/Render+Properties+-+Render#RenderProperties-Render-GEM
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IK Booster Manual
  ^

Click here to expand Table of Contents...
Introduction
IKBooster Command List
Hotkey List

CTRL-B:
CTRL (while moving things):
CTRL (while selecting things):
Shift+LMB
Alt+LMB-drag on DopeTrack
Shift-D
F1-F3:

Adding IKBooster to Your Object
Adding IKBooster to Lights and Cameras

Interface Overview and General Tips
UI Overview
Moving Things Around
General Notes and Tips:

Keyframe Mode Setting
The BoosterTrack

Known Issues/Limitations:

IKB Menu
Bone Dynamics
Global fxIK
IK Bind
Auto Bind
Auto Apply
Commands →
Reset Rotation
re-BakeSpot-all
re-BindMotion-all
Get/Set/Clear RIG as Comments
Motions →
Motion Copy
Motion Rollback
Motion Save/Load
Options...

Menu: Right Clicked Item
Fix (rotation modes only)
IKStop
FK Control
Handle
Mode →


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Rotate
Move
Quaternion
User Axis

Motion Tools →
IMPORTANT NOTE ABOUT MIRRORING:
Pose Copy from ...
Motion Copy from ...
Pose Save, Pose Load, Motion Save, Motion Load

Options →
Set Goal ... (only appears on fixed rotation items)
Set IKTarget ...
Setting Copy from...
Dynamics Edit
Controller Edit

Menu: Right Clicked Channel
(lock)/unlock
Set/unset limit
Edit limit
Reset limit
Reset value
Add Link
Graph Edit

Boosterlink
Follower-Mode
Animation Cycling
"Link" Right Click Menu

Menu: Timeline (single key)
Copy Key From Current
Make Key
Delete Key
Save/Load Pose/Motion (appears in various menus)

Menu: Timeline (multiple keys)
Bake Keys
Delete Keys
Copy Keys
Apply Keys
Record Motion
Set BakeSpot
Dynamics Effect
Bind Motion
Save Motion
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Introduction

This free reference guide was created by Ryan Roye. It contains information on what IKBooster's tools do and basic 
instructions on how to use them.

IKBooster Command List

Here is a complete list of IKBooster's menu commands. Click one or do a search to jump to its description (rmb = right 
mouse button).

RMB-Item RMB-Channels RMB Dopetrack (Single) RMB Dopetrack (Multi)

(fix)
(ikstop)
(Fk control)
(Handle)
Mode→

Rotate
Move
Quaternion
User Axis

Motion tools→
Pose Copy 
from...
Motion Copy 
from...

Options→
Set Goal ...
Set iktarget ...
Setting copy 
from ...
Dynamics edit
Controller edit

Keyframe Mode 
Setting→

All Item
Parent
Child
Parent+Child
Current

(lock)/unlock
set/unset limit
edit limit
reset limit
reset value
add link
graph edit

Copy Key from Current
Make Key
Delete Key
Save Pose/Motion
Load Pose
Load Motion

Bake Keys
Delete Keys
Copy Keys
Apply Keys
Record Motion
Set BakeSpot
Dynamics Effect
Bind Motion
Save Motion

IKB Menu →

Δ Back to top Δ
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Hotkey List

Some hotkeys are exclusive to IKBooster mode and as of this writing most cannot be changed. Also, some hotkeys 
replace Lightwave's default functionality (IE: global channel toggling).

CTRL-B:

Activate IKBooster

CTRL (while moving things):

Disables "fixed" items while ctrl key held

CTRL (while selecting things):

IKBooster multiselect. This works for fixing items, 
baking, and some dynamics functions. This does 
NOT work on anything else as of this writing.

Shift+LMB

Select the topmost IKBooster parent object (if 
not locked)

Alt+LMB-drag on DopeTrack

Places a BakeSpot range

Shift-D

Deletes keyframes without a dialogue, and relative to the 
keyframe mode setting. Note that motion modifiers, even if 
disabled, will prevent this command from operating on items 
that contain them.

F1-F3:

IKBooster Global Axis toggling. This replaces Lightwave's UI 
channel button functionality as well as the hotkeys associated 
with them. The channel buttons like shown below, when clicked 
in IKBooster mode, will get greyed out to indicate that all 
manipulations done in the 3d viewport will exclude those 
channels. XYZ in this case stands for XYZ and HPB.

Δ Back to top Δ

Adding IKBooster to Your Object

To apply IKBooster to an object...
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•

Adding IKBooster to Lights and Cameras

Make the light or camera a child object of a null that has IKBooster applied.

Δ Back to top Δ

Interface Overview and General Tips

IKBooster's interface and controls are specifically designed to make animation efficient by reducing the number of 
clicks, dialogues, and anything else that would add time to the process of animating. This also makes IKBooster 
somewhat difficult to learn through usage alone.

•

•

After applying IKBooster, its functions will be accessible to the object and all of its child items. Only one 
instance of IKBooster is needed to control a hierarchy with it.
NEVER add multiple instances of IKBooster to a hierarchy. It will break things. This includes making an 
IKBooster object the child of another object with IKBooster applied. Remove IKBooster from the object 
before re-parenting it.


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UI Overview

Moving Things Around

IKBooster's primary benefit is that it lets you click-drag any item in the 3d window to move things and it greatly 
simplifies the process of rigging and animation. This movement is almost always relative to the user's 3d 
window view regardless of move/rotate mode. This eliminates the problem of changing control schemes as the 
user moves the viewport around, or when manipulating an object that is a child of a parent object that has been 
moved, rotated or scaled.

General Notes and Tips:

IMPORTANT: Make absolutely certain you uncheck "FSPE" (Full Scene Parameter Evaluation) when using 
IKBooster with things like full character rigs, as it will severely hinder performance while manipulating things. 
FSPE can be found in the Preferences window (general tab).
IMPORTANT: For character rigs, avoid scaling the character object signifcantly up or down in layout or else it can 
adversely affect click-dragging controls on that character. If you need big differences in scale (IE: say you want a 
character who is half or less of the height of a template rig you're using), re-size the model in modeler and utilize 
skelegons to adjust the whole rig armature if scaling in layout yields problems.
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Some commands such as Set Goal, Add Link, and Motion Copy, derive their targets from whatever was 
previously selected.
If the dope track is open, enabling channel mode can significantly boost Layout playback when displaying many 
keyframes. Especially helpful for motion capture editing.
Load from scene works best when the background and other misc elements are loaded to the IKBooster 
character, not the other way around. Once the background is loaded into a scene that already has an IKBooster 
rig present, all other load from scene operations should work seamlessly.
It is recommended that character animation be performed when the frames per second is set to 20 or lower 
especially when using IKBooster. This reduces computational burden and increases productivity. When done, 
crank up the FPS and add additional motion detail as needed.
IKBooster tracks the keyframe selections in the dope track and can use them to perform operations on them. 
Sometimes these "selected" keyframes become invisible, so a rule of thumb is to left-click an empty space on 
the dope track before doing a right click operation to avoid unexpected UI behavior.

Δ Back to top Δ

Keyframe Mode Setting

The Keyframe Mode Setting is the SINGLE MOST IMPORTANT thing to understand when using IKBooster. Many 
commands operate relative to what is set in this little dropdown menu. The options listed refer to which way IKBooster 
will crawl up or down the bone chain when performing various actions such as Copy Key from Current or Delete Keys. 
Notice in the above image how the delete command got applied to ALL child items relative to the selected one.
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Δ Back to top Δ

The BoosterTrack

This inconspicuous grey bar, the BoosterTrack allows you to click-drag on it to shift 
keyframes around relative to the keyframe mode setting. Clicking anywhere (without 
dragging) leaves a marker like shown in the image which allows the user to isolate their 
shifting to either the LEFT or RIGHT of the marker's displayed keyframe. It is uber useful for 
re-positioning animations so that they occur exactly when you want them to (IE: You could 
create an animation of landing gears deploying, then just use the boostertrack to shift the 
keyframes where they need to go).

Known Issues/Limitations:

In versions of Lightwave after 9.6, the boostertrack is misaligned and does not match 
the dope track, which forces the user to rely on the number displayed when placing 
markers.
The boostertrack will not operate on items that contain a motion modifier or other 
constraint on them, even if they are disabled.

Δ Back to top Δ
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IKB Menu

Bone Dynamics

This enables or disables bone dynamics for the currently selected object hierarchy.

Global fxIK

Enables or disables all fixed items across the entire character. In almost all cases, use the CTRL-LMB functionality 
instead of this toggle option.

IK Bind

Do not confuse this with the "Bind" function, as this does something different. IK Bind prevents fixed points from 
moving beyond where they were fixed when the user manipulates a bone chain. Consider this an occasional use option; 
it is recommended that it be left DISABLED for most situations as IKBind can make controls feel "stiff".

Auto Bind

Whenever the 3D window is clicked, or manipulations are done in the viewport, having this option will automatically re-
bind and re-position things that are controlled via BakeSpots. IMPORTANT: If autobind does not update in real time, 
press D for display options and make sure "Dynamic Update" is set to "Interactive", not off or delayed.

Auto Apply

This performs the Apply Keys command (using "Soft Apply") on the selected item across the current timeline range 
whenever the 3d window is clicked. The keyframe range that this affects can be changed by adjusting the timeline 
range, or by selecting keys in the dope track.

NOTE: The first five options shown in the IKB Menu are PER OBJECT toggle settings that apply to the currently 
selected hierarchy.



NOTE: When bakespots are in the timeline, Auto Apply performs a "Flat Apply" for the range of that bakespot if 
your playhead rests within it, and the auto apply range before and after that bakespot will use a "Linear" 
apply. This is what makes editing animations that utilize bakespots a much simpler process. It should be noted 
that if the playhead rests between 2 bakespots, the Auto Apply function will operate only between them to 
prevent undesired wrecking of bakespot-driven motions.





LightWave 2020  –  LightWave 2020

Appendices –  3719

Commands →

Reset Rotation

Resets the rotation relative to the keyframe mode setting. Useful for easily getting a character back to a default T-Pose.

re-BakeSpot-all

Bakes the keyframes of all bakespots across all items in the currently selected hierarchy. Because bakespot baking does 
not factor in the orientation of the bone at the start of a bakespot after the first-placed one, using this option is not 
recommended in cases where a chain of fixed points need to be baked.

re-BindMotion-all

Performs the Bind operation all Bakespots present in the character's entire hierarchy.

Get/Set/Clear RIG as Comments

These commands are highly unstable and will often crash Lightwave especially in versions after 9.6. Just avoid using 
them. For those curious, these commands were supposed to be a way to copy and paste IKBooster settings of an entire 
IKB hierarchy.

Motions →

Motion Copy

This functionality is similar to graph editor's "Leave Footprint", only it works across the entire character and is much 
easier to take advantage of. It copies all of the motion data contained within the IKBooster object across the entire 
timeline. In this case, the keyframe mode setting is ignored.

Motion Rollback

Similar to the graph editor's "Backtrack Footprint", only it applies to the entire character. It replaces all of the 
animation contained within the object and all of its children back to that which is stored when the motion copy was 
performed. Performing this command multiple times allows you to toggle back and fourth between the stored and 
replaced motions. If you wish to discard the old motion, simply run motion copy a second time.

Motion Save/Load

Click here to scroll down for details; this command is the same as those identically named in other menus.
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Options...

FxIk size

Determines how far the bone chain needs to move until Lightwave calculates IKBooster's part-time IK relative to fixed
items. Setting this to a higher value will improve performance. You should increase the value as high as you can tolerate 
to optimize performance while editing. It is very important to understand that this setting also affects baking 
operations.

Group

This is a global dynamics setting that applies to all IKBooster objects in the entire scene. Group (also found in other 
Lightwave dynamics tools) is used to differentiate between objects to isolate dynamics calculations between specific 
objects.

Gravity

This number is factored in when doing IKBooster bone dynamics calculations. Note that you can also use a "gravity" 
dynamics object instead of this for greater flexibility, or to isolate the effect.

Controller Size

Adjusts the size of IKBooster's display that shows you the clickable areas of your rig. It is recommended that this be set 
to zero as the density of the display can often hinder visibility.

Size Mode

Identical to Controller Edit's size mode. Changes the size of the display that shows the currently selected item.

Ghost Mode/Size

Provides an "onion-skinning" display guide which can be shown on either the currently selected, or all bone in the 
hierarchy. Ghost size referrs to the number of frames it will look ahead of and behind the playhead's current position. 
Ghost mode does not operate well when motion modifiers or IK is applied.
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Menu: Right Clicked Item 

Fix (rotation modes only)

The fix command will hold the rotation-mode item in place as the character is moved. If a 
consecutive chain of fixed items are present, manipulating the top-most point will also 
hold the item's orientation. It is important to note that FxIK size in the IKB menu options 
will affect how fixing works.
This video demonstrates usage of this feature.

IKStop

When IKStop is applied, this prevents the user's direct movements and manipulations 
done to any child bones below it from influencing anything past it. Most often, IKStop is 
used on the upper legs, upper arms, knuckles, and other "top-point" areas to isolate areas 
of control.

NOTES: IKBooster is a PART-TIME animation system, therefore fixing items will 
not prevent things from wiggling around *INBETWEEN* keyframes. The bake 
command will plant fixed items solidly in place. As noted above, holding the 
CTRL key while moving things will temporarily disable the fix property on the 
whole character.   



NOTES: When moving things around, items above the IKStop point will still 
receive keyframes if you are in All, Parent, or Child+Parent keyframe modes.


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FK Control

This rotation option can greatly simplify the process of rotating a single item in ways that 
would be challenging to do with standard Lightwave handles, as it operates relative to the 
viewport orientation. FK Control and Quaternion mode have high synergy. Example uses for 
FK control include orienting gimbal bones on motion capture rigs (motion capture rigs often 
have "diagonal" rest rotations), animating simple boneless objects, getting specific 
rotations from gimbal-locked bones, and so on.

Handle

Assigning Handle to an item makes it operate on only 2 channels when click-dragged, with 
the 3rd channel being controlled by the "line". The line may be right-clicked to define the 
handle channel. Click-dragging above the line causes the handle symbol to change from a 
square to a circle, and allows for additive rotations across all bones in the chain (Handle is 
affected by IKStop, fixed points, etc).

Mode →

The modes listed here operate RELATIVE to the user's viewport...

Known Issues: Handle additive rotations will not operate in a usable fashion on 
bone chains that have had rest rotation applied to them.


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Rotate

The default mode that IKBooster child items will be set to; allows click-drag rotations of any 
number of items and applies IKBooster's part-time IK functionality while doing so. If no 
IKstop is applied, this mode can also be used to MOVE an object in addition to its child 
items.

Move

Moves items. This is advantageous over Lightwave's normal move mode in that the object 
hierarchy, viewport orientation, and other things that would normally affect controls 
adversely are not an issue with IKB move mode. Up is always up, down is always down... it 
just works! Move mode is often used on IK goals to greatly increase productivity and ease 
the animation process.

Quaternion

Identical to rotate with the addition of "quaternion" functionality. To put it simply, it 
rotates things linearly and is best used on items where rotational problems like gimbal lock 
are expected. In IKBooster character rigging, this is most often used on the arms and legs to 
give stability and flexibility to controls.

User Axis

Similar to FK control, only this lets you take a "snapshot" of your viewport orientation and 
restrict the rotation to that angle.

Right click an object that has this mode applied, and "Set User Axis" will appear in the 
Options category of the object-RMB menu. The "Get View Axis" button within the user axis 
dialogue, when clicked, is what takes the snapshot and changes the control accordingly. 
NOTE: This is essentially a motion modifier that uses the HEADING channel to operate, and 
will require baking to change or do anything else to the object.

NOTE ON LAYOUT SCALING: When using Quaternion bones in character rigs, know 
that if the rig is scaled significantly more or less than the model's original size in 
Layout that it will adversely affect quaternion controls. If you need drastic 
changes in a character template's size, scale them in modeler and adjust the rig 
rather than scaling them in Layout.


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Motion Tools →

IMPORTANT NOTE ABOUT MIRRORING:

Mirroring functions for Pose/Motion copying work relative to the topmost item in the IKB 
hierarchy, not relative to the chain of items. IE: Torso twisting that is isolated to the 
character's bones will affect the results you get.

Pose Copy from ...

Operates on ROTATIONS only. This takes the previously selected item and copies a single 
keyframe to the other side of the object.

Motion Copy from ...

Identical to Pose copy, only this does multiple keyframes.

Pose Save, Pose Load, Motion Save, Motion Load

Click here to scroll down for details; this command is the same as those identically named 
in other menus.

NOTE: "Lock&Limit" seen in the "Keys" dropdown menu of the pose/motion copy 
dialogues will factor in limited and channel-limited items when performing the 
copy. Do not confuse the meaning of the word "lock"; it refers to CHANNELS in this 
case, not whether the item itself is locked. This is useful if your character uses 
deformer bones and you don't want operations being applied to them. Both 
"Overwrite" and "Lock&Limit" will overwrite keyframes.


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Options →

Set Goal ... (only appears on fixed rotation items)

When a goal is set, whenever any part of an IKBooster bone hierarchy is moved, any "goal-
enabled" items will "snap" into position of their goal target, except for when the goal itself 
is moved. Think of this as an easily appliable and removable "pose-to-pose" style of IK 
designed to help the animator make characters or things interact witheachother. "Reset 
Goal" takes the place of "set goal", which removes the goal property.

Set IKTarget ...

This lets you control the rotation a single item by click-dragging on another. This does not 
constrain either object in any

way,
and can be used to cluster frequent-use controls together for easier access. This option 
only affects rotation-mode items, and Quaternion is recommended for use with IKTarget. 
IKTarget cannot be assigned across two IKBooster

hierarchies

Setting Copy from...

Copies the movement mode, limits, controller position, etc from the previously selected 
item to the currently selected.

Dynamics Edit

Allows for quick editing of the dynamics properties for IKBooster objects and their child 
items. All editing happens relative to the keyframe mode, right click for the menu after 
enabling Dynamics Edit. Note that IKBooster's dynamics use the exact same properties and 
settings found in Lightwave's other dynamics systems (IE: Clothfx).

Controller Edit

This editing mode allows you to re-position where items need to be clicked in order to 
manipulate them (it does NOT change their functionality). Click-dragging anything while in 
this mode will move the controllers accordingly. Use this when item overlapping is an issue, 
or when things are too tightly clustered to easily pick out one or the other. Float Mode
"sticks" the controller to a static position in the viewport, which can be useful for things like 
torso controls that would otherwise be hidden when doing upper body shots, or when you 
don't want to concern yourself with click accuracy or rotations. Size Mode refers to a global 
setting that affects IKBooster's display (it is not item-specific, and is identical to the size 
mode option found in the IKB Menu).

Δ Back to top Δ
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Menu: Right Clicked Channel 

(lock)/unlock

Locks or unlocks the channel. Locked items are denoted by 
parentheses.

Set/unset limit

Enables/disables limits for the item. While rotation limiting is the 
same as going into motion options, this is not true for MOVE mode 
items as IKBooster handles XYZ limiting separarately from the rest 
of Lightwave. Unconfirmed whether this is a bug or a functionality 
limitation.

Edit limit

Allows you to specify the minimum/maximum values for the item. 
Most often, limiting done through IKBooster is reserved for when 
boosterlink is involved.

Reset limit

Sets the limit's minimum and maximum to 
the item's current position or orientation.

Reset value

Zeroes out the channel.

Add Link

Adds a "link" to the previously selected item. 
See "Boosterlink" below for more details.

Graph Edit

Opens up graph editor and automatically 
highlights the channel.

Δ Back to top Δ
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Boosterlink

Think of boosterlink as being similar to follower and cyclist, with its core advantage being 
that assigning channels is a much faster process as it doesn't involve dropdown menus or 
even a window dialogue. Boosterlink can be described as having two functionalities.

Follower-Mode

Select the DRIVING item, then select the DRIVEN, right click a channel (like displayed in the 
image to the right) and this will cause the driven object to "follow" the driver. There are no 
settings for boosterlink items applied in this fashion.

Animation Cycling

Boosterlink also contains functionalities very similar to the "Cyclist" motion modifier, 
allowing you to define a controller for an object's keyframed animation. See the image 
below for details. The advantage of this method is that boosterlink items can be animated 
without moving around the timeline in addition to easier setup. The disadvantage is that 
keyframes 0 - 100 get tied up and therefore makes boosterlink controls less re-usable. Use 
the animation cycling feature for when you do not intend to remove a boosterlink 
constraint.

"Link" Right Click Menu

Right clicking the word "link" will display some options related to boosterlink:

Remove

removes the link

Change Shift

Offsets the animation by a specified number of frames in comparison to the driving item.

Change Ch

Allows you to change the driving channel. You will need to switch between rotate/move 
mode temporarily to assign a boosterlink between move and rotate channels.

Copy/Paste

You can copy the boosterlink settings of one link to another which can save the need for 
extra clicks.

Edit Graph

Opens graph editor and highlights the linked channel.
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Δ Back to top Δ



LightWave 2020  –  LightWave 2020

Appendices –  3729

Menu: Timeline (single key) 

 

Copy Key From Current

Insanely useful. Copies ALL of the keyframes (XYZ/HPB/Scale) located at the playhead and 
pastes them where you right-clicked relative to your keyframe mode setting.

Make Key

Same as Copy Key From Current except that it only copies the channels in which the items 
are set to (IE: Move mode items will only get XYZ, and rotate will only get HPB). Use this 
instead of copy key when preparing motions to be saved.

Delete Key

Deletes relative to the keyframe mode setting. The hotkey for this is Shift-D (replaces LW's 
normal delete dialogue).

Save/Load Pose/Motion (appears in various menus)

NOTE: Almost all timeline-based menus are performed based on the keyframe 
mode setting!


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When saving poses or motions, know that IKBooster will save *all* keyframes (XYZ/HPB/
Scale) present relative to the keyframe mode setting. In almost all cases, the topmost object 
in the hierarchy should be selected when saving. Also, the same object or item that was 
selected while saving, must be the same object selected when loading. If saving animations 
associated with a specific limb of a character, it is recommended to have good file naming 
conventions. With non-destructive rig editing practices, IKBooster motions (which are .TXT 
files), may be used on any character that shares a rig template. Also, IKBind ranges will get 
saved into the motion file and will automatically "apply" the bind when loaded.

Δ Back to top Δ

Known issues with motion saving:

Motion save will insert blank keyframe space for any frames past frame zero, 
making it problematic to save any motion that does not start at frame 0. If the 
motion is intended to be re-used, always use the boostertrack to move the motion 
so that it starts at 0.

Also, when specifying the desired keyframe range, there is an error that causes the 
resulting saved motion to be short by 1 keyframe. IE: If you save frames 0-20, it will 
only actually save frames 0-19... unless this is fixed in a later version of Lightwave, 
always add 1 keyframe to the range you want to save.

If using a bind-null setup for relative motion loading, note that the order in which 
the bind null hierarchy appears in the CLASSIC SCENE EDITOR must be consistent 
across all characters the saved motion is compatible with. Move it up or down in the 
list should its order somehow change (usually when deleting/adding new meshes/
nulls to the character). For more info on relative motion loading, see the 
Comprehensive Guide to IKBooster at the bottom of this page.

If you need to add OBJECTS to your character's hierarchy, add a bone first and 
make the object a child of that bone. This is neccecary because of the way 
IKBooster stores and reads motion files. If you want your motions to always work on 
all characters, adhere to this rule.

TIP: Want to use a pose on multiple different characters that use a same rig 
template? Use save motion instead of save pose (saving only 1 keyframe). Save 
pose does not work across multiple characters because there is no way to make it 
not save certain keyframes; save motion does not have this limitation.


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Menu: Timeline (multiple keys) 
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Bake Keys

Meant to be used in conjunction with the "Fix" property. This will hold fixed items in place by 
baking their keyframes (preventing interpolation wiggling). Remember this works with 
IKBooster multi-select. See the fix video for details on how Bake and Fix are used together. 
IMPORTANT: The "FxIk size" in IKB Options affects baking! A higher value will result in 
wobbling but will bake instantly, a low value, such as 1mm, will have no wobbling, but can be 
slow when performing the operation on many keyframes.

Delete Keys

Clears multiple keys relative to the keyframe mode setting. Quite useful. Know that motion 
modifiers or constraints will prevent this command from operating on items that contain 
them.

Copy Keys

Copies keys relative to the keyframe mode setting. Pre and Post Mix frames found within the 
dialogue of this command allows you to fade the animation in or out for a specified number of 
keyframes.

Apply Keys

This takes the user's last action and gradually applies them over a specified range of 
keyframes. This is most often used for adjusting/altering heavily keyframed animations or 
simply to make editing motions easier and more efficient. See also "Auto Apply".

Record Motion

This takes a specified range of keyframes and, when the selected object is moved via a click-
drag operation, keyframes will fill and advance in the timeline relative to the Record Interval 
setting. Recording stops when the user lets go of the button or reaches the end of the 
keyframe range. Record Interval within the dialogue of this command determines how far you 
need to move an object in order for a keyframe to be generated. This command is best 
reserved for 2-dimensional operations due to its limitations.

Set BakeSpot

•

•
•

NOTE: 

A keyframe must be present at the position of the playhead for both the previous 
and current action when performing an apply keys operation (otherwise it has 
nothing to reference from).
Only 1 action (the user's last action) is factored into apply keys.
Fractional keyframes get ignored. Integer only!


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BakeSpots are used in conjunction with the Bind and Bake commands and specify a keyframe 
range in which they should take effect when used, or when AutoBind is enabled. Right clicking 
below a bakespot will bring up additional options. As a general note, in most cases it is 
recommended that baking be performed with IKBooster multi-select instead of bakespots. It 
should be noted that the keyframe range of BakeSpots will not be adjusted with changes to 
frames per second (including bakespot ranges contained within saved motions), so it is best 
practice to save motions at a frames per second value you intend to use most often. 
Bakespots can be utilized with varying FPS values, but it requires switching to the same FPS 
that the bakespot was saved in, performing the bind operation, then switching back to the 
new FPS.

Dynamics Effect

Think of this option as a quick and dirty way to quickly get a "wobble" movement out of 
things like antennae or other semi-rigid chains of bones, or to add detail to currently existing 
animation (it factors in current keyframes when performing the calculation). Usually when 
performing this action you will have the lowest end of the bone chain selected... it can take 
some experimentation to get a good feel for what settings are required for the results needed. 
For added stability, set all bones that are to be used with this command to Quaternion. This 
will also factor in any dynamics edit mode changes that have been performed. IKB Multi-
select will work on multiple items granted that all of selected items reside in the same 
IKBooster hierarchy. While this doesn't factor in gravity, collision objects will affect the 
IKBooster-selected items during the dynamics effect calculation (only the selection, not the 
whole bone chain).

Bind Motion

This is IKBooster's most powerful feature; most commonly used with BakeSpots but this 
command allows binding without placing one. It transfers the absolute position of the 
selected item to the topmost object in the hierarchy which is useful for getting complex 
"relative" movements. It is difficult to describe all the scenarios where this can be used... it 
can make your characters climb stairs, roll boxes around with 100% accuracy, automatically 
factor in distance relative to a character's leg length, allow you to abandon entirely the need 
for retargeting and other nifty things.

Save Motion

Same as that which is found in other right click menus.

Δ Back to top Δ
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Typography with OpenVDB

Animation using LW’s native splines, particles and LW 2019’s openVDB system. Older versions could instead us HVs to 
sculpt the particles. Extremely flexible if you can master particles and Wind FX! Secondary animation using deformer on 
top of the openVDB meshing will further help creativity :D

Free plugins: OD Import Vector File: if you have OD Tools you will have a link with each update email. It can also be 
found on the Lightwave 3d Support Group on FB and through OD Root: http://www.odroot.com/

ef Toggle Line/curves: https://www.lightwave3d.com/assets/pl...

Weight Outwards: https://www.lightwave3d.com/assets/pl...

Intro music: https://www.bensound.com

Website: http://www.markwarner.tv

Instagram: https://www.instagram.com/markwarnertv/

Twitter: https://twitter.com/markWarnerTV

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=c55sJ7b79Uc

https://www.youtube.com/redirect?q=http%3A%2F%2Fwww.odroot.com%2F&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=https%3A%2F%2Fwww.lightwave3d.com%2Fassets%2Fplugins%2Fentry%2Fef-toggle-linescurves%2F&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=https%3A%2F%2Fwww.lightwave3d.com%2Fassets%2Fplugins%2Fentry%2Fweight-outward%2F&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=https%3A%2F%2Fwww.bensound.com&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=http%3A%2F%2Fwww.markwarner.tv&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=https%3A%2F%2Fwww.instagram.com%2Fmarkwarnertv%2F&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/redirect?q=https%3A%2F%2Ftwitter.com%2FmarkWarnerTV&redir_token=ig0NsnqYeTOF6sgRpjUSUqw4Z5t8MTU1MTQ0MDEwMEAxNTUxMzUzNzAw&v=c55sJ7b79Uc&event=video_description
https://www.youtube.com/watch?v=c55sJ7b79Uc
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Managed Floor Destruction

Introduction

A simple yet effective animation technique using Bullet demonstrated ably by Monroe Poteet.

For this sort of "managed destruction", I'd Fracture the floor object with a centered Sphere in the backtground layer to 
make the fractures more dense toward the middle of the floor, set the Glue Strength to 100% on the Parts Body floor, 
and use a moving Bullet Collision object which "unglues" the Parts of the floor over time using a Gradient on Distance to 
Object. Sample scene attached.

Modeling

In Modeler, create a Floor object and a surrounding Foundation with a ledge to support the edges of the floor as it falls 
apart:

1. Create unfractured floor

Sorry, the video is not supported in this export.
But you can reach it using the following URL:

Movie URL not available.
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2. Create foundationwith ledge using Boolean subtract, Knife, Extend

 

3. Create spherical object for background Fracture polygons
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4. Set up Fracture using background polys
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5. Fracture results

  

6. Create Bullet Collision object (will be hidden)

  

7. Rename all layers for clarity using F7

Save the object and send it to Layout.
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Layout

In Layout, the Floor_Unfractured layer isn't a Bullet object, but is just there to dissolve to 100% when the 
Floor_Fractured Parts Body starts falling apart. Here's the other Bullet setup:

  

1. Set the Foundation to Static Body
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2. Completely hide the Background Fracture Poly object

  

3. Set up the Floor_Fractured layer as a Parts Body with a Gradient=>Distance to Object on Glue Strength
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4. Parts Body Activation is Start Sleep (until touched by Collision Body)

  

5. Bullet_Collision layer is Bullet Collision object, moved up so it doesn't touch the Fractured Floor initially

  

6. Bullet_Collision also set completely hidden

The background fracture polygon layer and the Bullet_Collision layer are completely hidden by using the Object 
Properties=>Render tab and setting Unseen by Camera, etc. and clearing all the Shadow options.
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With Dynamics Disabled, create a motion path for the Collision object to unglue the floor:

  

7. Dynamics Disabled, move Collision object

Turning on Dynamics, use Front View to determine when the Floor_Fractured body starts falling apart, and Dissolve the 
Floor_Unfractured object (not a Bullet participant) to show the fractured floor using an Envelope:
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8. Dissolve the Floor_Unfractured object (not a Bullet participant)

9. Add some texturing, setup the backdrop:

Enable VPR so the hidden objects and dissolve shows, fine-tune the Parts Body parameters and the Collision object 
motion:
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Have fun!
mTp

See also Example - Choreograph your destruction
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1.

Using the Ray Type Switch node to control exactly how and what is reflected, refracted, 
or used in radiosity

In the past, something similar to this here could be done with additional copies of ‘unseen’ geometry, separate 
materials and lots of additional object render settings... It worked but was messy compared to the simplicity of the 
solution presented here, where there is just one material. 

This is one of those things you should use by default from now on, whenever luminous textured geometry is involved. 

A simple scene: a facade textured with an 8-bit photo. ground and objects are 64 grey, everything is 50% 
specular, 30% rough. the left sphere is 5% rough glass. all Principled BSDF material. we will only use radiosity to 
light the scene with the luminous facade and a very dark backdrop for a little ambient.
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2.

1. a simple scene

Simple nodes for the facade. Material luminosity is 90% - this will be our ‘Default Material’. This is not how you 
would properly texture an entire facade but only the luminous parts like windows, interiors, neon signs, etc. It’s 
just simpler for this tutorial.



LightWave 2020  –  LightWave 2020

Appendices –  3747

3.

2. simple nodes for the facade

‘Default’ Material rendered. looks nice overall, but because the photo is an 8bit image, it only looks good on the 
facade itself and lacks intensity and saturation in reflections, refractions, and radiosity. Let’s try a second 
material version to compensate for this. This would all be different with precisely made and edited HDRI 
textures, which in most cases we do not have.
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4.

3. ‘Default’ Material rendered

We now send the image through the ‘Color Tool’ node first, to boost saturation 150%, contrast 10%. Material 
luminosity is increased to 300%. this will become our ‘Switch Material’. These values depend on your own image 
and taste, of course.
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4. This second 'Switch' material could also consist of an HDR image, even one 'handmade' in Photoshop, but for 
simplicity, let's do it all with one common type of image here.
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5.

4. ‘Switch’ Material rendered. looks good in reflections, refractions, and radiosity... but not on the facade itself. Time 
to combine both things into one with ‘Ray Type Switch’.

Both material versions, our ‘Default’ and our ‘Switch’ are plugged into the ‘Ray Type Switch’ node, as shown in 
the image below. Every material input could have its own completely different material - you could have an 
object with an 'Apples' material, reflect as 'Oranges' material, refract as 'Chocolate' material, and emit light as 
'Banana' material, different materials for different ray trace aspects. We will only use two here.
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5. The 'Ray Type Switch' setup. >>> according to the manual, the pink ‘Ray Type’ connection from the 'Input' node is 
needed, but it seems to work without, but better safe than sorry. <<<
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6. ‘Default’ + ‘Switch’ Material rendered. Looking very very niiiice. I like! 

6. ‘Default’ + ‘Switch’ Material rendered. hint: center door looks slightly more saturated because it illuminates itself 
with its 'Switch' material version.

6b. Original render for comparison.
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2010 - LightWave 10

2011 - LightWave10.1

2012 - LightWave 11
2012 - LightWave 11 SP1 (11.0.1)
2012 - LightWave 11 SP2 (11.0.2)
2012 - LightWave 11 SP3 (11.0.3)
2013 - LightWave 11.5
2013 - LightWave 11.6
2014 - LightWave 11.6.3

2014 - LightWave 2015
2014 - LightWave 2015.1
2015 - LightWave 2015.2


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2015 - LightWave 2015.3

2018 - LightWave 2018.0
2018 - LightWave 2018.0.1
2018 - LightWave 2018.0.2
2018 - LightWave 2018.0.3
2018 - LightWave 2018.0.4
2018 - LightWave 2018.0.5
2018 - LightWave 2018.0.6
2018 - LightWave 2018.0.7

2019 - LightWave 2019.0
2019 - LightWave 2019.0.1
2019 - LightWave 2019.0.2
2019 - LightWave 2019.0.3
2019 - LightWave 2019.1
New features
2019 - LightWave 2019.1.1
2019 - LightWave 2019.1.2
2019 - LightWave 2019.1.3
2019 - LightWave 2019.1.4
2019 - LightWave 2019.1.5

2020 - LightWave 2020
2020 - LightWave 2020.0.1
2020 - LightWave 2020.0.2

About this history

This page is a compilation and an archival record of how NewTek, Inc's., LightWave 3D computer graphics software has 
evolved and changed interface styles, box packaging, and logo design over the course of time, now in its 27th year and 
13th version.

1988 - Precursor to LightWave 3D
Before LightWave came Videoscape 3D and Aegis Modeler 3D on the Commodore Amiga. Videoscape was written by 
Allen Hastings and Modeler 3D by Stuart Ferguson, giving a historical basis behind the split personality of LightWave 3D. 
Have a look at the sticker on the Videoscape 3D box to see how things have evolved since this program was state of the 
art... 
Of course, the Videoscape solution wasn't the only one available to NewTek when they wanted to add a 3D graphics 
application to the Amiga Video Toaster back in 1989 - it was almost equipped with Dr. Eric "Juggler" Graham's Sculpt 
3D...

screens courtesy: Ernie Wright (Videoscape #3 and Modeler 3D) and Hector Moratilla (Videoscape #1 & #2)
Videoscape box courtesy: Franck Lafage

The LightWave History page has to be rebuilt including full-size images. Doing so will take a little time and if 
users wish to contribute screenshots they will be credited. Images marked with zzz or lores need replacing


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Videoscape Amiga

 

 Videoscape Amiga
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Modeler Amiga

Modeler Boxshot

Videoscape Boxshot

1990 - LightWave 3D 1.0
1990 saw the first actual release of LightWave on the Commodore Amiga-based Video Toaster. NewTek had been 
promising its arrival for about two years at this point, but the problem lay with the chipset for the Video Toaster itself, 
not LightWave. At this point in time, there were 3D programs available, but they tended to cost tens of thousands of 
dollars, while the whole Toaster retailed for less than $5,000. The only real competition for 3D on the Amiga at that time 
came in the form of Imagine.

screens courtesy: Ernie Wright
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Modeler and Layout 1.0 Amiga

 Video Toaster Logo

1992 - LightWave 3D 2.0
The Video Toaster got an upgrade in 1992 and so did LightWave. Later that year NewTek released the "LightWave 2.5 
Pro" slice upgrade. This was the first version to have built in lens flares and some other "special" goodies for the 
Lightwaving Toaster users.

1993 - LightWave 3D 3.0/3.1
LightWave was still locked to the Video Toaster with the VT4000 that came out this year, however a small company 
called Industrial Might and Logic catered to a growing number of people that wanted access to LightWave but didn't or 
couldn't use the Video Toaster (because they had Amiga 3000s or lived in countries that used a television system other 
than NTSC). IML (natch) created their own dongle (named "LightRAVE" often referred to simply as "RAVE") that 
emulated the presence of the Video Toaster card so that LightWave could be run on machines without the desktop 
video card.

screens courtesy: Bernhard Bazant
box shot courtesy: Norm Pickthall
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Modeler Amiga,  Layout Amiga

 

Layout LightWave 3D 4000 Amiga
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VT4000 Boxshot (lores!)

1994 - LightWave 3D 3.5

The first official stand-alone version for the Amiga (no Video Toaster required)

box courtesy: Gökhan SÖNMEZ
screens courtesy: Bernhard Bazant

 

Packshot with Box detail
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Layout and Modeler 3.5

1995 - LightWave 3D 4.0
This was the first version ported to Windows Intel PCs and DEC Alphas.

PC screens courtesy: Anthony Rosbottom
Amiga screens courtesy: Bernhard Bazant
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Modeler 4.0 Amiga version, Layout 4.0 Amiga version

 

Modeler 4.0 Windows version , Layout 4.0 Windows version
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LightWave 4.0 Boxshot and Logo Windows (lores!)

1995 - LightWave 3D 5.0
This was when NewTek really started to branch out. LightWave was available for Intel and now also for SGI, DEC Alpha, 
Macintosh, and in its last version for Amiga

PC screens courtesy: Norm Pickthall
Amiga screens courtesy: Bernhard Bazant
box courtesy: Norm Pickthall

     

Modeler 5.0 Amiga version , Layout 5.0 Amiga version
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Modeler, Layout 5.0 Windows version

 

Boxshot and logo (lores!)

1997 - LightWave 3D for the VTNT
In 1997, NewTek brought out a version of the Video Toaster for the PC platform on a PCI card. It had to come with 
LightWave as had previous Amiga incarnations, so here is the Video Toaster bundled version.

screens courtesy: unknown

      

Windows Video Toaster version of Modeler and Layout
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Windows Video Toaster Boxshot (lores!)

1997 - LightWave 3D 5.5

screens courtesy: unknown

  

Modeler,  Layout 5.5 Windows version

1998 - LightWave 3D 5.6

screens courtesy: Deuce Bennett
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Modeler, Layout 5.6 Windows version

1997 - Inspire 3D 1.0
Also, in 97, NewTek released a cut-down version of LightWave called Inspire 3D for the PC. It offered the same ease-of-
use as LightWave but was much simpler in terms of its abilities. Still, it brought many people into 3D who could then 
move up to Inspire's bigger and more powerful brother once they had a handle on what was needed.

Screens courtesy: Ben Vost
Box courtesy: Franck Lafage
Logo courtesy: NewTek Europe

      

Inspire 3D Modeler and Layout, Windows version
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Boxshot and Logo

1999 - LightWave 3D 6.0
The redesign version! LightWave got a major redesign and a new element - the Hub - was introduced to synchronize files 
between Layout and Modeler automatically. There were numerous other changes, such as a new, user-editable menu 
system, the ability to have multiple layers in a single object along with the ability to keep them in sub-patch mode, 
rather than having to freeze when you saved out of Modeler. 
First commercial application to introduce HDRI, and the first incarnation of a new render engine at 192-bit. A first 
implementation of Monte Carlo and Interpolated radiosity for LightWave3D. 
Modeler introduced many new tools like skelegons, and upgraded many modifiers to interactive tools.

screens courtesy: Czech LightWave Users Homepage

     

Modeler, Layout 6.0 Windows version
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Boxshot

2000 - LightWave 3D 6.5

Because of the major redesign, more than a few people complained about the stability of LightWave in its new 
incarnation, but NewTek was on the case. A year after the release of 6.0, they brought out 6.5. It fixed most of the 
people's primary concerns, but also added cloth dynamics and Motion Designer 2 - in a free upgrade!

screens courtesy: Dean Scott

      

Modeler, Layout 6.5 Windows version
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Boxshot and Logo

2001 - LightWave 3D 7.0
LightWave 7.0 added new radiosity methods and integrated new character animation tools: motion mixer for non-linear 
animation, new bone setup for faster preview, new subdivision options to speed up animation workflow. The SasLite 
hair and fur solution was added, along with many other additions.

screens courtesy: Dean Scott

      

Modeler, Layout 7.0 Windows version

     

Boxshot and Logo (lores!)

2002 - LightWave 3D 7.5

Another free upgrade to LightWave including such features as improved radiosity and caustics, better OpenGL 
performance, BVH motion capture support, Powergons (polygons with scripts attached), Bandglue, and the well-named 
Magic Bevel among other things. 7.5 was eventually followed by 7.5b (06-Mar-03), which was not very successful and 
had a number of problems, and so was replaced almost immediately by 7.5c (16-May-03). This remained the cutting 
edge of LightWave for a time, but once LightWave 8 was released, a last update to 7.5 (7.5d on the 27-Aug-04) was 
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released to counter problems with Apple's OpenGL implementation in OSX 10.3. 
The 7.5b, c, and d revisions were the first visible fruits of the new development team's labors.

screens courtesy: Ben Vost
box courtesy: Darkside Animation
logo courtesy: NewTek Europe
Update PDF 

  

Modeler, Layout 7.5 Windows version   

 

Boxshot and Logo (lores!)

2004 - LightWave 3D 8.0
A long hiatus caused by the split between the original programmers and NewTek management meant that LightWave 8 
had to be created by software archaeology - digging through the code in an attempt to understand it. This work paid off 
and resulted in the first new version in two years officially released on 30-Jun-04. For some people, LightWave 3D 8 was 
only a commercial plugins collection, but it was the real starting point of LightWave3D Reborn. The new team starts to 
integrate many of their external plugins and add powerful features like Bone Tools (a complete bone edit system), a 
new Scene Editor with Dopesheet (to edit keys in the timeline more comfortably) and the DopeTrack (for editing keys 
inline with the timeline), new rigid and soft dynamics, soft and hard links to animate the new dynamics, new OpenGL 
acceleration and preview, and many other small but important improvements.

Screens courtesy: Ben Vost
Box and logo courtesy: NewTek Europe

https://docs.lightwave3d.com/download/attachments/8200558/LW75Update.pdf?api=v2&modificationDate=1538578203000&version=1
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Modeler, Layout 8.0 Windows version

 

Modeler, Layout 8.0 OS X version
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Boxshot 

Logo

2004 - LightWave 3D 8.0.1

The first patch to LightWave 3D [8] released Sep-01-04.

2005 - LightWave 3D 8.2

Second free upgrade released Jan-18-05 
This update included a method of making distortion-free UV maps for subdivision surfaces and was a world-first. Apart 
from bug fixes it also introduced PLD anti-aliasing, improvements to VIPER and IK Booster. Also included was a Linux 
version of Screamernet supplied as an RPM. This has not been updated since.

2005 - LightWave 3D 8.2.1

Patch for 8.2 released Mar-02-05

2005 - LightWave 3D 8.3

This was the fourth free update made available to registered users of LightWave 3D 8 on May-09-05. It offered 
improvements to HyperVoxels, Photoshop export and lots of other things...

Screens courtesy: Ben Vost



LightWave 2020  –  LightWave 2020

Appendices –  3772

 

Modeler, Layout 8.3 Windows version

 

Modeler, Layout 8.3 OS X version

2005 - LightWave 3D 8.5

Fifth free upgrade released Oct-10-05 
This new update adds GLSL compatibility to LightWave's Layout section and Multishift to its modeling tools along with 
plenty of bug fixes and implementations of feature requests. 
On the 20-Oct-05, NewTek also released a 64-bit version for Windows XP Professional xp64 edition. This allows people 
with 64-bit Windows-based machines the chance to access more than 2GB ram. As of writing, this version does not exist 
for the Mac since OSX is not a completely 64-bit OS at time of writing.

2006 - LightWave 3D 9.0
Released Jul-13-06
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box and logo courtesy: NewTek

 

Boxshot  and Logo

This is the second evolution (6.0 was the first overhaul) of LightWave and the feature list is very exciting!

2007 - LightWave 3D 9.2

Released Apr-25-07

Improvements across the renderer and shading pipeline
Three radiosity modes: Backdrop, MonteCarlo, Final Gather
Interpolated radiosity switch for fast radiosity solutions for any of the three modes
Photoreal motion blur and adjustable shutter efficiency to eliminate strobing
Photoreal depth of field
Physically correct materials
Much-improved Modeler OpenGL
Layout previewing of motion blur/depth of field

2007 - LightWave 3D 9.3

Released Aug-17-07

Point/Edge Rendering in new cameras
Single-sided area lights
OpenEXR image loader/saver
Volume stacking (means an end to using reversed geometry to indicate changes of IoR)
New subsurface scattering nodes Fast Skin and Sigma 2
Macintosh Universal version for improved Intel-based Mac rendering (roughly 3x faster on average)
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2007 - LightWave 9.3.1

Released Nov-20-07

A maintenance update that provides improved reliability and speed enhancements to the additions made in 
LightWave v9.3.

(note: the Windows installer contains both the 32-bit and 64-bit versions)

2008 - LightWave 9.5

Released Aug-12-08

Enhanced radiosity with disk-based cache and unique animated radiosity caching mode.
FiberFX hair and fur rendering system supports combing, dynamics, raytraced fibers, radiosity-shaded fibers and 
modeled fiber creation.
Much improved IK/Rigging features, Same As Item controller, improved IK stability, Pole Vector, Align to XY Plane 
IK goal.
Joint bone types, easier to rig, allow correct twist along their lengths and allow for stretchy limbs.
HDR antialiasing options in the image viewer.
Lights are now an API allowing for third party lights to be coded with the SDK. New light types included are 
Dome, IES/Photometric, and Spherical/Ball lights. Area lights quality improved.
Collada, FBX added and OBJ I/O support improved.
Interpolated Soft Reflections/Refractions for Node-based surfacing.
Composition Overlays for composing shots.
EXIF metadata support for images loaded and rendered.

This version was not available for Macintosh OS X, just Windows 32- and 64-bit.

2009 - LightWave 9.6

Released Jan-19-09
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Layout 9.6 Windows version

FiberFX Cloning - Provides the ability to place multiple instances of hair on the same object
Layout Snapping - Allows the quick connection of one item to another, saving time and additional steps
Ray Cutoff - Enables artists to decide at what point to stop further ray bounces when rendering a scene with 
many reflections, refractions, and transparency, saving significant project time
New and Improved Buffers for Export - Enables multi-pass pipeline users to output more buffers (layers) in high 
dynamic range, rather than be limited to 8-bpc (bits per channel), for greater flexibility
Multi-Threaded Pixel Filters - Provides faster rendering for projects that integrate pixel filters
Depth Buffer Normalizing - Allows 3D scene elements exported into film or video footage to automatically blend 
properly, even if moving relative to one another
Open to Other Render Engines - Other rendering engines conforming to the LightWave v9.6 SDK can be used 
directly from within the LightWave interface
Three New Nodes

Car Paint: Greatly eases the creation of a complex polished surface
Flake: A procedural texture based upon the flakes often seen in car paint
Curve: Allows the creation of complex gradients

Drag and Drop - Allows an icon of an object or scene to be directly dropped into the Modeler or Layout window 
to load

2011 - LightWave 9.6.1

Released Jun-8-2011 
The last release of LightWave 9 was actually publicly made available in June 2011 (although it had been available to 
open beta testers for a year before), long after the release of LightWave 10. It added a couple of bug fixes, but more 
importantly a 64-bit version for Mac owners.

2010 - LightWave CORE
Announced Feb-04-09, canceled Jun-23-11 
CORE was announced to have a lot of innovative features:

Complete rewrite, will not have all of LW9.6's features, will introduce new features replacing sets of LW9.6 
features
Internal application structure and SDK expose all features openly allowing easy future development
Linux support. Equal support for Linux, Mac, and Windows
Qt cross-platform GUI. Skinnable dynamically via CSS and viewport color configurations
Complete loss of LW9 and earlier plug-in and scripting backward compatibility
With Qt, have cross-platform plugins using the same source code. Easier Windows / Linux / Mac / 64-bit / 32-bit 
support, requiring only a recompile for that OS.
Internal architecture's full exposure allows all subsystems to interact with each other, e.g. hair influenced by 
water simulation
Partial LWS file compatibility specifically if the LWS uses plug-ins from LW9 and older
SDK now a more vital component to LightWave as it's used by NewTek for actually building LightWave CORE. The 
previous SDK enabled 3rd party support only.
Native Python scripting. LScript no longer supported. SWIG - allows many more language to be used to program 
to CORE SDK (Tcl, Perl, Guile, PHP, Java, Ruby, C#, LISP, OCaml, LUA, Modula-3, Javascript, R, Octave).
New Collada-based file format superseding LWS and LWO
Unified modeler and layout, if the user desires. Dockable UI, tear-off menus.
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Instancing
History / modifier stack
GPU awareness for on-GPU acceleration of subdivision calculation allowing radically larger numbers of OpenGL 
preview polygons faster
Brush editing
Lattice deformation
"Construction" viewport plane

Even with these features, what was lost was a sense of LightWave about the program and with a change of management 
of the development team it was decided that was needed was the use of CORE as a testbed behind closed doors to bring 
these new technologies to LightWave as it was already known. This led to the release of LightWave 10.

2010 - LightWave 10
Released Dec-30-2010

 

 
Layout 10 OS X

LightWave 10 is the first new ordinal release of LightWave since 2006. It added three major new functionalities - 
Colorspace management, VPR and the Virtual Studio.
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Color space management - Because LightWave operates in a linear fashion with regard to color whereas normal 
everyday colors displayed on a monitor are subject to the sRGB colorspace, meaning they have a Gamma of 2.2 
applied, it always meant that lights had to be forced in the past, or colors tuned to match expectations. 
LightWave 10's colorspace management meant that it was simple to make LightWave behave in a color-
managed way.

VPR or Viewport Preview Renderer - In many LightWave users' opinions, Worley Labs FPrime was their main 
reason to use LightWave, but there were more and more things that FPrime couldn't show, particularly with 
nodes needing pre-processing, or the new radiosity schemes introduced in LightWave 9.3. LightWave 10 has 
introduced VPR that converts the OpenGL view normally found in a viewport to a realtime renderer.

Virtual Studio - A system for realtime animation in the viewport using external controllers, eg. PlayStation Move 
cameras or the Microsoft Kinect, to move LightWave characters.

2011 - LightWave10.1

Released Jul-29-2011

Layout 10.1 OS X

2012 - LightWave 11
Released Feb-20-2012
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Layout 11.0.3 Windows

LightWave 11 adds a lot to LightWave, making it one of the most complete new ordinal versions ever. Here are some 
highlights:

Instancing - Although instancing has been available to LightWave for a long time through commercial and free 
plugins, this is the first time that LightWave has the ability to generate billions of polys at render time itself. 
Instances can be seen in OpenGL and VPR.
Flocking - Using the simple rules that govern flocking in nature, LightWave now creates huge flocks of 
"animals" (in conjunction with instancing).
Unified Sampling - Previously in LightWave you have needed to tweak anything that uses sampling in all the 
places that do so. This also slowed down the render dramatically and now it has all been unified you get the 
concomitant speed-up in rendering as well as simpler use.
Bullet Dynamics - World-class realtime hard-body dynamics are now in LightWave and are very easy to use - you 
only need tell LightWave that an object is dynamic for it to be.
Fracture - An integral part of the dynamics system now is the ability to break stuff apart and you can now do so 
in Modeler and Layout.
Virtual Studio Tools - Control Layout through 3D Connexion devices or even PlayStation Move controllers.
Interchange Tools - Add seamless workflow between LightWave and ZBrush through GoZ or Unity.
Shadow Catcher Node - A simple way to add an object to catch the shadows and reflections of your LightWave 
objects in a composite with real world elements.
Python - The powerful scripting language has been added alongside LScript, but can directly access the SDK.

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=lcKCe0_-9oM

https://www.youtube.com/watch?v=lcKCe0_-9oM
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Launch video

2012 - LightWave 11 SP1 (11.0.1)

Released Apr-16-12 
A bug fix release with over 130 issues corrected or improved. The Unity workflow also got a significant boost with a new 
Applink package.

2012 - LightWave 11 SP2 (11.0.2)

Released Jul-09-12 
A second bugfix release. It adds no new features, but merely corrects problems in previous releases. 78 fixes have been 
tracked.

2012 - LightWave 11 SP3 (11.0.3)

Released Aug-01-12 
A third service pack release. The sole feature in here is a new licensing system that allows for a software license rather 
than using the hardware dongle that LightWave has been tied to since it was first split from the Video Toaster.

 
Modeler 11.0.3 OS X

2013 - LightWave 11.5

Released Jan-31-2013 
A massive free update that includes the following and more:

Flocking - Nodal flocking - Predator/Prey behavior - Attract/Avoid meshes
Bullet Dynamics - Deforming bodies and Forces
Interchange After Effects interchange
FiberFX - New UI - Bundles and Braids
Genoma - Full rigging system



LightWave 2020  –  LightWave 2020

Appendices –  3780

•

•

•

Modeler - Line Pen - Heat Shrink - Axis Translate/Rotate/Scale - Transform - Chamfer - Place Mesh - Slice - 
Thicken - Straighten - Edit Edges - ABF Unwrap UVs - Select by Normal - Pick Surface - New Paste Behaviour
Workflow Enhancements - Node Editor Probe - Curved node Connectors - Dome Light with Image - MDD Multi-
Loader - DoF, Motion Blur and Refraction in VPR - Advanced Camera support in VPR - Rolling Shutter - Motion 
Path Frame display - Nodal Metalink - Fit Selected and Fit All
Python - New Plugin architectures - Single Shot format

2013 - LightWave 11.6

Pre-Released July-23-2013 
At SIGGRAPH in Anaheim, CA this year the LightWave Group pre-released LightWave 11.6 along with a plugin called 
NevronMotion for retargeting motion capture files and ChronoSculpt, a separate program for adjusting MDD, Geometry 
Cache or Alembic files. More details will follow on here once all three are fully released. 
Released 31-Oct-2013 LightWave 11.6, ChronoSculpt and NevronMotion are released.

 

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

https://www.youtube.com/watch?v=ODcc9VqQi1A

https://www.lightwave3d.com/chronosculpt/
https://www.lightwave3d.com/nevronmotion/
https://web.archive.org/web/20131219005024/http://lightwiki.com/wiki/File:Layout%E2%84%A2_NewTek_LightWave%E2%84%A2_11.6_%28Win64%29.png
https://web.archive.org/web/20131219005024/http://lightwiki.com/wiki/File:Layout%E2%84%A2_NewTek_LightWave%E2%84%A2_11.6_%28Win64%29.png
https://web.archive.org/web/20131219005024/http://lightwiki.com/wiki/File:Layout%E2%84%A2_NewTek_LightWave%E2%84%A2_11.6_%28Win64%29.png
https://www.youtube.com/watch?v=ODcc9VqQi1A
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Layout 11.6 showing Spline Control, Modeler 11.6 showing Mesh Repair

Features new to 11.6 include:

3D Display - Displays VPR or OpenGL in stereoscopic 3D on a suitably-equipped TV or monitor
3D Printing - New tools and loaders/savers to help with 3D printing. LightWave can now load and save STL, PLY 
and VRML format models, and there is a tool that checks the mesh is good to print (no single point or two points 
polys, etc.)
Alembic - Support for the open scene format
Assignments - A set of scripts to help with hierarchical operations in Layout (parenting, targeting, etc.)
CgFX shaders - Game engine shaders for display in OpenGL
Color Picker - Because Ken Nign now works for the LightWave Group he has brought his excellent Jovian color 
picker plugin into LightWave as its main picker
Compound Nodes - Node container to simplify networks
DPX (Digital Picture Exchange) Image Loader/Saver - Image loader/saver for a digital intermediate format 
used a lot in production
Genoma Spline Control - New subrig parts to add Spline Control features to rigging
Input Node - New permanent node (like the Surface node) that contains many things that might be needed. A 
necessary addition needed for Compound nodes to work
Light Falloff clamping - Now lights can have their falloff clamped to prevent overly bright areas inside the falloff 
zone
LUT Expansion - support for more color lookup tables (LUT)
Matching Perspective to Camera or Light - you can now size up a viewpoint in the Perspective viewpoint and 
copy it to the camera, or add a new camera. The same applies to matching the Light View with an existing or new 
light
Python Reduced Instruction Set module (PRIS) - PRIS is designed to make coding scripts for LightWave more 
like LScript, rather than C
Raycast Node - A node to allow you to sit something on a horizontal surface automatically, rather than needing 
to do it manually. Particularly useful if the surface is irregular and animation needs to take place on it
Spline Control - A new system using nulls, bones or other items to create a spline that can be animated itself, 
but also serve as a path to animate other things along 

2014 - LightWave 11.6.3

Released May-01-2014 
Bug fix release (licensing problems resolved)
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2014 - LightWave 2015

2015.3 Layout showing dynamics and bones

Released Nov-24-2014 
LightWave dropped the version number in favor of annual numbering. This new version features:

VPR in multiple viewports;
Background Importance Sampling for quicker noise-free radiosity renders;
Bullet Constraints;
Better I/O with FBX, Alembic and point cache file improvements;
Genoma 2 is an advanced rigging tool that is considerably more powerful than the original Genoma built into 
11.5;
Clip mapping is, at last, a surface property;
Perspective Matching for still background images to better put 3D into them;
Quicktime is supported in 64-bit versions of Windows
any font supported by your OS can be used in Modeler
dozens of workflow improvements

2014 - LightWave 2015.1

Released Dec-22-2014 
Update 1 brings stability and bug fixes
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2015 - LightWave 2015.2

Released Feb-23-2015 
Update 2 brings stability, bug fixes and also these additions:

OSX Support Full-screen mode for Layout and Modeler
Re-purposed "Enter License" tool
Small update to Transform Gizmo's rotate handle colors to match the color of the axis around which the rotation 
takes place.
Support import of Mixamo rigs (https://www.mixamo.com/)
Added 'Invert Color' option to the Image Node.
Add User Preference For Double-Click deselecting in Modeler
Made the NEW COMMAND "Drop/Restore selection" the default over Drop Selection in the menus and key 
configurations. 

2015 - LightWave 2015.3

Released Aug-15-2015

Several consolidations of functionality
Improvements to stability

2018 - LightWave 2018.0
Released January-01-2018

https://www.mixamo.com/
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Layout OpenGL and VPR side-by-side

Modeler showing Layout View

Physically Based Rendering System
Render and Light Buffers
New Volumetric Engine
OpenVDB Support
New Lighting Architecture
Virtual Reality Camera
Layout Modifier Stack
New Cel Shader
Layout Parametric Shapes
Noise Reduction Filter
UDIM Support
Preset Shelf Improvements
New Network Rendering System
Online wiki-based Documentation

2018 - LightWave 2018.0.1

Released January-12-2018

71 bugfixes and feature requests implemented

https://docs.lightwave3d.com/download/attachments/8200558/LightWave_2018.0.1-changelog.txt?api=v2&modificationDate=1520291219000&version=1
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2018 - LightWave 2018.0.2

Released March-01-2018

Over 200 bugfixes and feature requests implemented

2018 - LightWave 2018.0.3

Released March-29-2018

63 bugfixes and feature requests implemented

2018 - LightWave 2018.0.4

Released May-01-2018

29 bugfixes and feature requests implemented

2018 - LightWave 2018.0.5

Released July-02-2018

21 bugfixes and feature requests implemented

2018 - LightWave 2018.0.6

Released Aug-03-2018

Six bugfixes and feature requests implemented

2018 - LightWave 2018.0.7

Released Oct-31-2018

5 bugfixes and feature requests implemented

https://docs.lightwave3d.com/download/attachments/8200558/LightWave_2018.0.2-changelog.txt?api=v2&modificationDate=1520291195000&version=1
https://docs.lightwave3d.com/download/attachments/8200558/lightwave_2018-0-3_change-log_20180329.txt?api=v2&modificationDate=1522363787000&version=1
https://docs.lightwave3d.com/download/attachments/1859661/lightwave_2018-0-4_change-log_20180501.txt?api=v2&modificationDate=1525204924000&version=1
http://static.lightwave3d.com/downloads/installers/lightwave_2018/lightwave_2018-0-5_change-log_20180702.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2018/lightwave_2018-0-6_change-log_20180803.txt
https://docs.lightwave3d.com/download/attachments/8200558/lightwave_2018-0-7_change-log_20181031.txt?api=v2&modificationDate=1541016690000&version=1
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2019 - LightWave 2019.0

HiDPI interface

Smoothing Groups

Released Jan-22-2019
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Unreal Bridge - Dynamic interchange between LightWave and the Unreal Engine
MetaMorphic - Animated sculpting plugin for Layout
OpenVDB Conversion - Live editing of VDB <> mesh conversion
Undo - Improved system-wide undo support
Image Caching - Massively reduces memory use for images in-scene at render time
Material Components - Pull apart materials to create your own look
Edge and Patina Shaders - Creative shaders for more realism
Smoothing Groups - Industry-standard smoothing is added to LightWave
UV Tools - Updated UV tools
SunSky - new backdrop shader and light type for simulating realistic and fantastic skies
HiDPI Support - Adaptive UI layout for new monitor resolutions
Menu Improvements - Searching, mousewheel and keyboard navigation dramatically increase workflow speed
Updated documentation - Responsive wiki should now display correctly on all supports

2019 - LightWave 2019.0.1

Released January-31-2019

20 bugfixes and feature requests implemented

2019 - LightWave 2019.0.2

Released February-28-2019

54 bugfixes and feature requests implemented

2019 - LightWave 2019.0.3

Released March-13-2019

23 bugfixes and feature requests implemented

2019 - LightWave 2019.1

Released July-15-2019

New features

Cel Shading now responds to scene light color
FBX Improvements 
Hide all OpenGL non-renderable elements and gizmos 
Workflow improvements to the Layers panel in Modeler
New Navigation options
Node Editor - RGBA/XYZ splitter node/improvements
NRC Improvements
OpenVDB Improvements
Physical Sky Enhancements

http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-0-1_change-log_20190130.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-0-2_change-log_20190228.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-0-3_change-log_20190313.txt
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Add Progress indicator to VPR
LightWave Python Updates
Workflow Improvements: 'Reset Configs'
Workflow Improvements: Separate Menu and Key Config Files
Workflow Improvements: Tree Pane
Unreal Bridge Improvements 
Vertex Maps panel improvements

An incredible 282 bugfixes and feature requests implemented

2019 - LightWave 2019.1.1

Released August-05-2019

12 bugfixes and feature requests implemented

2019 - LightWave 2019.1.2

Released August-07-2019

3 bugfixes and feature requests implemented

2019 - LightWave 2019.1.3

Released September-12-2019

8 bugfixes and feature requests implemented

2019 - LightWave 2019.1.4

Released September-25-2019

7 bugfixes and feature requests implemented

2019 - LightWave 2019.1.5

Released January-15-2020

3 bugfixes and feature requests implemented

2020 - LightWave 2020

Sorry, the widget is not supported in this export.
But you can reach it using the following URL:

http://youtube.com/watch?v=lkyyiozAmbE

https://docs.lightwave3d.com/pages/viewpage.action?pageId=8195140
https://docs.lightwave3d.com/display/LW2019/Workflow+improvements%3A+Separate+Menu+and+Key+Configs
https://docs.lightwave3d.com/display/LW2019/Workflow+Improvements%3A+Tree+Pane
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1_change-log_20190711.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1_change-log_20190711.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1-1_change-log_20190805.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1-2_change-log_20190807.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1-3_change-log_20190912.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1-4_change-log_20190925.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2019/lightwave_2019-1-5_change-log_20200115.txt
http://youtube.com/watch?v=lkyyiozAmbE
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OpenVDB Advect Blur

Local Action Centers with Symmetry

Random walk multi-spectrum subsurface scattering

Released April-23-2020

Environment Lights - New streamlined workflow for setting scenes up
New GI - Brute Force has been revamped, Irradiance Cache has been added, and a new Grid Bake solution has 
been implemented
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FBX interchange - Updates to LightWave FBX imports and exports for improved interchange
OpenVDB - New tools for creating exciting new VDB-based animations
OpenGL - New shaders mean that LightWave's OpenGL is an ever closer match to a rendered image
Local AC - Modeler gains a Local action center
Motion System Order - You can now set an arbitrary rotation order
Simple Tone Mapping - Tone mapping for F9 and VPR renders gives control over the look of your render without 
needing to use a compositing package
Improved SSS - Random walk multi-spectrum subsurface scattering has been added to the Principled BDSF 
material
Better Hair and Fur - Two new materials have been added for hair and fur
Scene Editor - New tools make the Scene Editor even more useful
Node Editor - The middle mouse button can now be used to scroll around the Node Editor
Instancing - More control is now given for the placement of individual instances
Mobile NRC Monitoring - Android and iPhone applications for keeping track of your renders when you're out of 
the office

2020 - LightWave 2020.0.1

Released May-26-2020

More than 570 bugfixes and feature requests implemented

2020 - LightWave 2020.0.2

Released July-15-2020

More than 59 bugfixes and feature requests implemented

About this history
Copyright 2002, Dean A. Scott, chrusion | FX, all rights reserved. Updated wiki version and editing by Ben Vost, NewTek 
2005-2020

http://static.lightwave3d.com/downloads/installers/lightwave_2020/lightwave_2020-0-1_change-log_20200522.txt
http://static.lightwave3d.com/downloads/installers/lightwave_2020/lightwave_2020-0-2_change-log_20200715.txt
mailto:dascott@chrusion.com?subject=LW%20History
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Release History
New to 2019.1
New to 2019
New to 2018
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New to 2019.1

Click here to expand Table of Contents...
Cel Shading Improvements
FBX Improvements
Hide all OpenGL non-renderable elements and gizmos
Workflow improvements to the Layers panel in Modeler
New Navigation options
Node Editor - RGBA/XYZ splitter node/improvements
NRC Improvements
OpenVDB Improvements
Physical Sky Enhancements
Add Progress indicator to VPR
LightWave Python Updates
Workflow Improvements: 'Reset Configs'
Workflow Improvements: Separate Menu and Key Configs
Workflow Improvements: Tree Pane
Unreal Bridge Improvements
Vertex Maps panel improvements

A lot has changed in LightWave. Here is a curated list in alphabetical order with links to pages that describe the features:



Pages describing features new to LightWave 2019.1 have the label New and the badge above

https://docs.lightwave3d.com/label/new+2019_1
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Cel Shading Improvements

Surfaces will now react correctly to light color.

FBX Improvements

Transfer only animations, Drag-and-drop within the interface, Support principled material (not just standard) on import
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Hide all OpenGL non-renderable elements and gizmos

Simple toggle to clear all non-renderable items from the viewport for better scene visibility

Workflow improvements to the Layers panel in Modeler

Freezing, Swapping and Moving all come to the 2019.1 Layers panel
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New Navigation options

Layout and Modeler have new navigation tools

Node Editor - RGBA/XYZ splitter node/improvements

Individual RGB channels added as outputs on Image nodes
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NRC Improvements

You can now attach render nodes to your farm from other machines in your network, and LightWave Scene files can 
now be dragged-and-dropped into the NRC window

OpenVDB Improvements

Add particle system output to mesh to volume node based on the mesh vertices and add collision velocity to solvers
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Physical Sky Enhancements

An update has been made to the Physical Sky background shader

Add Progress indicator to VPR

See how fast your renders are going

LightWave Python Updates



LightWave 2020  –  LightWave 2020

Appendices –  3798

Python updated and new PCore console added

Workflow Improvements: 'Reset Configs'

Refresh the configs without losing your custom menus and keyboard shortcuts

Workflow Improvements: Separate Menu and Key Configs

New config files for menu and keyboard shortcut customizations

Workflow Improvements: Tree Pane

Several improvements made to the Tree Pane element of the LightWave UI

https://docs.lightwave3d.com/pages/viewpage.action?pageId=8195140
https://docs.lightwave3d.com/display/LW2019/Workflow+improvements%3A+Separate+Menu+and+Key+Configs
https://docs.lightwave3d.com/display/LW2019/Workflow+Improvements%3A+Tree+Pane
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Unreal Bridge Improvements

Images courtesy Ryan Roye

Improved interchange performance.

Vertex Maps panel improvements

Delete multiple maps at once, filter maps and select by map
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Cel Shading Improvements

Surfaces will now react correctly to light color.
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FBX Improvements

The FBX interchange facility has been greatly improved for 2019.1. 

Transfer only animations

The Interchange panel now has two options for the Transfer Mode. You can either Append Assets or Replace 
Animation. Append Assets was the default functionality from before, but Replace Animation is new, and can be used to 
transfer animation over items that are already animated. In this way, it can serve as an undo or an easy way to copy 
animations to multiple items.

Drag-and-drop within the interface

You can now drag and drop complete scenes or individual elements from one side or the other.
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Support for PBSDF Material on Import

You now have the option to import materials as Principled BSDF using the FBX Interchange. To do so, click the gear icon 
at the top right of the interface, deselect the Use Standard Material option, and close the Options window. The 
surfaces will now be created in a similar manner to the Surface Editor's Convert > Layered to Principled option. 
Images linked to a surface will be recreated using the Layered nodes.
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Hide all OpenGL non-renderable elements and gizmos

 This addition to the third viewport menu removes all non-renderable elements (grid, motion paths, camera, 
light, bone and null icons, etc.) from an OpenGL viewport. It's a simple toggle with no options.
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Workflow improvements to the Modeler Layers panel

The Layers panel has received various updates in 2019.1, including making the List or Hierarchy choice more 
permanent between sessions, and making the rename window resizable.

Freezing layers

Right-clicking on a layer will turn its icon cyan and will lock it as selected whatever other layers you click for foreground 
or background. If you move the layer the frozen checkmark will follow. To unfreeze a layer, right click it again.

Moving and Exchanging Layers

In List mode, if you select a layer and move it up or down there are two kinds of lines that indicate where you are. A line 
will show where the layer you have chosen will be inserted. If you have box around the layer it will be exchanged with 



LightWave 2020  –  LightWave 2020

Appendices –  3805

the layer you have selected. The names of the layers will follow the layers. In Hierarchy mode, the line has no effect 
while the box will parent a layer.

Layout Visibility

Click where the cursor is to highlight layers to send to Layout
Clicking in the empty square above the Eyeball column in the Layers panel will highlight all layers that will get sent to 
Layout (Reminder: Unchecking a layer in this column will not send it to Layout, useful for layers that are only intended 
as work layers rather than final geometry).

These actions for Layers have no undos.
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New Navigation options

Layout and Modeler now have additional navigation controls. The Navigation Options window that was 
mainly used for 3D mice and other presentation tools has received an upgrade.

To engage the new options, make sure the Layout or Modeler windows are the active window and press the X key. When 
you press this key the first time, mouse input is captured and a notification appears at the top center of the viewport in 
which Navigation is engaged. In Layout, the information appears in each viewport. Some combinations will only work in 
particular viewports (for instance, orbiting the view won't work in an orthogonal viewport).

In this new navigation mode, the traditional game keys of W, A, S and D move in the X and Z directions with Shift
speeding movement and Ctrl slowing it down. E and Q move in the Y axis, while mouse movement controls rotation 
around Y and X axes. The vertical scroll wheel controls the field of view, while in Layout, the horizontal scroll wheel 
controls the scene playhead.

If you wish to change keyboard assignments, set the device to keyboard and click Device Settings... at the top of the 
window. You can similarly change mouse movement and button assignment.

Pressing X a second time (or Esc) returns to standard LightWave navigation methods.

There are several Subjects above the individual settings and Styles below the settings pane:
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View - Acts like using the Viewport navigation controls. If the view is a camera or light you will be controlling the 
camera or light in the scene.

Grab - This attempts to emulate grabbing the world as you see it.
Orbit - This is similar to grab but rotates about a point of interest in front of the viewer.
Helicopter - This attempts to emulate flying a helicopter
Walk - The is similar to Helicopter but with limits on the pitch and bank. It attempts to emulate walking.

Current Item - Moves and rotates the currently-selected object.

Grab - This emulates grabbing the item relative to what the viewer sees.
Helicopter - This emulates flying the item from the point of view of the item (as if the user were inside the item 
flying it like a helicopter).

Timeline - A mode that uses the Twist on a Space Explorer, horizontal mouse movement or equivalent to act like 
a jog/shuttle dial on a video control surface. Holding the Alt key while rotating the device’s puck will result in 
faster scanning through the timeline.

The difference is more noticeable when the scene length is longer - a 120-frame scene is only barely noted, 
whereas the difference between normal scanning and Alt-scanning a 1200-frame scene is pronounced.



Note a change in the Navigation Options panel compared to previous: the Name/Enable/Reverse/Sensitivity/
Scale settings columns are now per-device instead of global. Also the System Panel button is now the Device 
Settings button, and one of the Enable Navigation buttons is now named Enable Device.


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Node Editor - RGBA/XYZ splitter node/improvements

2019.1 has slightly changed Image and Images Sampler nodes. Not only can you take the Color output, but 
now the individual Red, Green, and Blue channels are all available, in addition to the Alpha and Luma, as Scalar 
outputs.
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NRC Improvements

NRC has received some updates for the 2019.1 release. Node Pick-up allows you to enter an IP address (v4 or 
v6) to access a machine anywhere on the Internet and was added to allow people within a corporate intranet to access 
a different segment where their render machines may be sitting. It is not designed to create a global render network, 
although you can try.

Node Pick-up

To use the Node Pick-up function, you need to visit the NRC preferences in the NRC Controller's View menu. Go to the 
Nodes tab that is new to 2019.1, and turn off Use Bonjour services to discover nodes. Once done, you can check 
Enable Node Pick-up, which will add a new button and a new field to the NRC interface.
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Bonjour on, Bonjour off
Discover Nodes uses a "well-known" port (which is the default value in prefs).  If you change the port number in 
Preferences, you have to be sure to match it on each build slave, or you won't see anything. The Pick-Up node field can 
take an ip address, a range (IPv4 only) or a URL and you can add subnets with a dash (e.g. 10.38.1.110-115)
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Drag and Drop Scene files

Scene files can now be dropped on the lower window in the NRC. They still need to be dragged from there to the upper 
window to assign them to nodes, but if you check Automatically assign newly added Scenes in the NRC Preferences 
then scenes will be assigned to nodes without further manipulation.
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OpenVDB Particle system Improvement

The ability to emit particles from the vertices of polygons converted to VDB objects was added in 2019.1. These particles 
can either be static or move with the addition of a Solver node. Also, a Collision Velocity setting has been added to 
particles to simulate real-world situations better. The Solver node now has settings divided over three tabs, and new 
elements are detailed below:

Simulation

CFL Factor - The Courant–Friedrichs–Lewy condition is necessary for convergence when solving OpenVDB 
calculations. In short, it determines how far your particles can move in a single step. At its default of 100 %, 
movement will tend to be more sluggish than a simulation with a CFL Factor of 10 %.

Surface

There are four fields here, only one of which is available while the Blobby toggle is checked.

Blobby - Check to treat the particles as spheres
Halfwidth - This is the field that is available whether or not Blobby is checked. The name is a contraction of "Half 
Bandwidth," and the value uses the symmetricality of the VDB inner band of particles to reduce calculation time. 
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The default value of 3 should be good for most purposes, but you may want to raise the value if you intend to 
pad active areas for scattering. Lowering the value will speed things up, but you risk errors and holes in the data
Close - Dilate the grid to close holes then erode closing openings
Dilate - Dilate the grid along its normals making it bigger
Gaussian - Gaussian smoothing

Visualize

Aids for visualization of a VDB object. There are five categories

Show Particles - Shows the particles making up the VDB
Show Grid Velocity - Lines showing movement, strength, and direction. RGB colors map to XYZ directions

Show Staggered - Staggered shows the native side-centered velocity components. Otherwise, the 
velocity components will be collapsed into a cell-centered display

Show Collider Grid - Shows the collision voxels
Show Grid Voxels - A visual display of the voxel cubes that make up the grid
Show Pressure - Pressure levels produced by the Solver simulation are shown in color with this option checked. 
Red for low-pressure areas moving to white the higher the pressure

Gradient - Shows the gradient of the pressure using a vector field indication

Add a Saver node to save off a cache of vdb files and use an OpenVDB Info node to play back the cache without 
calculation.


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Physical Sky Enhancements

Layout's Physical Sky background shader has received an update to add a softened horizon line, and a 
"ground" that can be colored to suit your needs. There are no new controls, but rather than the hard line going to black 
of previous versions of LightWave 2019:

There is now a softer line that should provide a more realistic impression of a physical sky.
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If you now add a Textured Environment, and made sure it is above Physical Sky in the Environment list, you can have 
something like this:

Note that Physical Sky is a background shader, so there will be no "perspective" whether you use an image or 
a texture.


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Add progress indicator to VPR

The notification area under the Objects, Bones, Lights, and Cameras button now show how fast VPR is 
rendering. If you have multiple VPR viewports, you will get progress bars for each one:

With one, then two VPR viewports above, but also more:
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This meter is switched off by default, so don't be surprised if you don't see these bars right off. Visit Options (O)
, and at the bottom of the first tab you'll see a new option, Viewport Monitor.


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LightWave Python Updates

The Python installed with LightWave 2019.1 is now v2.7.16 and the PCore Console has been upgraded to Mark 
II. New features include:

Save and copy buttons no longer needed
Log output is now text; not multiple, separate list entries
The window is split in two, with log output and command input sections. The division between the two can be 
moved as needed and can be maximized in one direction or the other
The command input area is deigned to emulate the python CLI, including syntax highlighting, and command 
recall that is retained between sessions up to the maximum prompt recalls
Recall search using Shift-Space
Command matching
Fully customizable
Primary and secondary prompts, even Bash-style
The Prompt area has two modes:

Command Prompt: default, immediately evaluates each command when entered
Editor mode: enter as many commands as you wish; evaluates on return to Command mode

Custom key bindings can be set, retrieved and inline documentation is provided
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Workflow Improvements: 'Reset Configs'

In combination with Workflow improvements: Separate Menu and Key Configs, the Reset Configs plugin will 
allow you clear out LightWave configuration files without losing menu customizations or user-created keyboard 
shortcuts. There's no visual feedback for this config destruction, and because LightWave usually writes to its config files 
only when you quit the only way to tell is by closing LightWave and restarting it.

The Reset Configs command can be found by hitting Ctrl-Space to get the list of all commands but it can be added as a 
menu item, if you so desire. This command works by deleting the LW2019.1-64.CFG file when in Layout, and the 
LWM2019.1-64.CFG file when in Modeler in Windows, and the Layout 2019.1 and Modeler 2019.1 files in their MacOS 
version. Because keyboard shortcuts and menu customizations are now stored in their own config files these will not be 
lost when resetting.
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Workflow improvements: Separate Menu and Key Configs

LightWave now further splits its config files to better preserve hotkey and menu customization. There are 
Menus and Keys config files for both Layout and Modeler, preserving the text-based nature of the original config files 
meaning they can be edited by hand. Now, when you are asked to clear your configs, only the LW2019.1.cfg, 
LWM2019.1.cfg, Extension Cache-64, and LWHUB2019.1.cfg now need to be deleted and rebuilt.
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LightWave 2019 configs on the left and 2019.1 on the right
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Workflow Improvements: Tree Pane

There have been some modifications made to LightWave's Tree Pane control. A Tree Pane looks like the list of names in 
the Scene Editor above, Modifiers or even the details of the Keyboard Shortcuts editor. New tools include:

Column resizing

In the image above, you see we have an item with a long name. Previously, the standard Scene Editor had columns 
whose widths could only be changed by resizing the complete window, not always very convenient. Now, when the 
horizontal slider is at the right extent, a gray vertical line will appear at the edge of the Item column that can be dragged 
left and right to increase or decrease the amount of column visible.

Drag and Drop Improvement

With long file names, it can be a problem if you need to parent in the Scene Editor. Now, the list flips to a view of the 
start of the column as you are adjusting.
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Drag and drop over

The Keyboard Shortcut editor used to require that a name should be dragged above the target entry to assign it. Now, 
dragging over the entry suffices.

2019.0.3

2019.1
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Unreal Bridge Improvements

Images courtesy Ryan Roye

Added support for the new individual Red, Green and Blue Image channels.

Batch sending of meshes for potentially higher performance in scenes with many smaller objects.
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Vertex maps panel improvements

Modeler 2019.1 has several new features in the Vertex Maps panel. First, there is now a filter field at the top of 
the pane to allow name filtering and even Regex use for tracking down a specific vertex map.

The second new option is added right click functionality. Whether you are in Point, Edge or Polygon mode, right-clicking 
on a vertex map in the panel presents a new option - Select by Map . Choosing this will select all the points, edges or 
polygons that are in the map, whatever their value.

The third new option is the ability to delete multiple VMaps at a time. Much like LightWave working exclusively with 
points or edges or polygons in Modeler, or Objects or Lights or Camera in Layout, you cannot delete multiple VMaps of 
different types at the same time, but deleting multiple UV maps, or Vertex Color maps or Weight maps is now possible.



LightWave 2020  –  LightWave 2020

Appendices –  3826

•
•
•
•
•

•

•
•
•

•

Transition Glossary

For people coming from previous versions of LightWave some of the terminology used can seem strange. All that is 
occurring is that LightWave is aligning with industry-standard vocabulary.

Emission - Luminosity
Transmission - Transparency
Specularity - is actually Specular Reflection. It replaces the previous Reflection model
Sheen - A glancing like shiny fabric
Scattering - is the color of the surface when light shines on it. Scattering light can penetrate inside a volume, 
losing strength as it goes in
Absorption - is when light shines through a surface and some is absorbed and doesn't come out again, you only 
see the color that's NOT absorbed, the color complementary to the one you chose
Deformed Coordinates - World Coordinates
Object UV - A UV map that has been automatically created, for Primitive Shapes for example
Default UV - A UV map denoted by a bullet point in the name that is designated as a default in the case of several 
UV maps. It can be used with the Object UV input
Level Set - Volumetric version of a mesh object
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New to 2019

Click here to expand Table of Contents...
Layout

Empty Volumes
Interchange Bridge
Limited Bones
Metamorphic 2019
OpenVDB Evaluator
Physical Sky and SunLight (Hosek-Wilkie)
Undo System
Unreal Bridge
Rotofix

Surfacing
Edge Shader and Patina Node
Material Tools
Procedural Node

Renderer
Despike
Image Caching
Optix Denoising
Rho
Shading Models

Modeler
Genoma 2 Rig
Smoothing Groups
UV Mapping Tools

Documentation
Responsive Layout

General
HiDPI Display Support
Menu Improvements
Node Editor Improvements


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A lot has changed in LightWave. Here is a curated list in alphabetical order with links to pages that describe the features:

Layout

Empty Volumes

Create procedural shapes that can be booleaned live in Layout
Use Empty Volumes for creating procedural volumetric shapes or converting meshes to volumes and vice versa.

Interchange Bridge

The new Interchange bridge brings far more control over FBX assets including takes and animation from multiple FBX 
files.

Limited Bones

Realtime-optimized bone system version for better interchange with Game engines.
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Metamorphic 2019

Animated sculpting, weight mapping and vertex painting in Layout.

OpenVDB Evaluator
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Converting meshes to volumes and vice versa, plus all the other advantages of a VDB workflow open amazing new 
modeling and animation possibilities
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Physical Sky and SunLight (Hosek-Wilkie)

A backdrop shader for creating amazing skies with a new Light Type, simulating a physical sun.

Undo System

Stepping back changes for more than just transformations in LightWave is now possible. Revert changes made in 
Dopetrack, the Scene Editors, the Graph Editor, and server panes throughout LightWave.

Unreal Bridge

Realtime content created by Tony Prohl for the VR/AR Industry
Smooth real-time conversion to the Unreal games engine for presentations or game design is now possible.
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Rotofix

RotoFix is a Layout generic LScript, added to 2019.0.2, that adjusts the rotation keyframes of a selected item, in order to 
correct for rotation value wrap-around (e.g. heading jumping from 179 degrees to -179 degrees, instead of going from 
179 degrees to 181 degrees). This is important for correct interpolation (e.g. 179 degrees to -179 degrees is a change of 
358 degrees, while 179 degrees to 181 degrees is a change of only 2 degrees, even though the initial and final orientation 
of the item is the same in both cases).

It does this by minimizing the change in rotation values between keyframes while keeping the resulting orientation of 
the item unaffected.

Surfacing

Edge Shader and Patina Node

Shade edges to give an impression of additional rounding geometry without needing to model it, and create shading 
based on wear and dirt with the Patina node.

Material Tools

Nodes for splitting and combining custom materials to create the surface you want.

Procedural Node

Node to allow access to all of LightWave's considerable non-nodal procedural texture collection.

Renderer

Despike

New Despike algorithm to soften images to help cure hotspots.



LightWave 2020  –  LightWave 2020

Appendices –  3834

Image Caching

Massively reduces memory use for images in-scene at render time.

Optix Denoising

The effect is subtle and best seen full size, limitations of the AnimGIF format notwithstanding
Leverages NVidia graphics card to remove noise from still renders using artificial intelligence.

Rho

New Rho buffer to extract lighting and shading information from the direct and indirect buffers.

Shading Models

The ability to pull materials apart and build them to your tastes is new to LightWave 2019. There is access to Fresnel 
Functions, Material Components, Material Integrators, and Material Tools has been updated with new nodes.
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Modeler

Genoma 2 Rig

New Genoma 2 rig from Studio IKIF+ in Japan.
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Smoothing Groups

Industry standard Smoothing Groups have been added for more control over the look of geometry.
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UV Mapping Tools
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Select UV Overlap, Select UV Island and Rotate UV are just some of the tools
New tools and workflows to make Modeler more capable of managing UV maps.

Documentation

Responsive Layout

The LightWave documentation now fits on any device you care to use it on.

General

HiDPI Display Support

LightWave now works correctly on screens with resolutions larger than HD (1920x1080) by scaling interface elements for 
a more readable display.
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Menu Improvements

Use mouse wheel, keyboard, regexp and filtering in LightWave menus.

Node Editor Improvements

With ,(comma) you can show all nodes connected upstream, and with .(period) you can show all nodes connected 
downstream to help unravel complex node networks
New snapping grid and keyboard shortcuts added.
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Metamorphic 2019

Click here to expand Table of Contents...
Introduction
Features:
Panel
Brush Mode

Brush Mode Tools

Brush Parameters
Undo and Redo
Animation

Introduction

Metamorphic is a multipurpose mesh sculpting and vertex map manipulation plug-in for LightWave 3D 2019 that works 
in LightWave’s Layout taking full advantage of the new capabilities of the modifier stack.



The Windows version of Metamorphic has the keyboard modifiers/shortcuts and graphics tablet support listed 
in the documentation. While Metamorphic is open, keyboard events will be captured and checked against the 
listed shortcuts. This means that typing in other applications might be affected.

Keyboard shortcuts and graphics tablet support have not been implemented in MacOS

Object Properties blinking when you add Metamorphic is expected. Normally, adding a plugin drops it at the 
end of the list of modifiers, but Metamorphic has to be placed just before Subdivision so the Object Properties 
panel needs to be refreshed.


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Features:

Freeform animated sculpting
Built-in undo/redo system
Fully-multithreaded sculpting using all available CPU cores
Pen pressure support for brush size, strength and hardness (Windows only)
nodal brush texture support
Three modes of animation
Non-linear interpolation of sculpt animation keyframes
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Supports converting sculpt animation keyframes to Endomorphs
Predictive corrective morph sculpting that works after deformers with built-in driver/driven controller
Full Motion Blur support

Panel

The Metamorphic panel is organized into several different sections. At the top we have buttons to open this page in the 
Wiki and a General Options for Metamorphic:

View Vertex Selection - Shows the selection of vertices on the object
View Weight Value - Shows the numeric weight value of vertices when in the Weight Brush Mode
Hide Sel. While Sculpting - Hides the vertex selection while the LMB is held down for all Metamorphic modes 
and tools

Use Selection as Mask - When checked, this will restrict all Metamorphic operations to the selected area
Select/Weight Operations - This dropdown menu offers five global options for selection or weight maps:

Clear - Clears selection or weight map immediately (shortcut /)
Grow - The default option, increases selection or weight map area (shortcut })
Shrink - Reduces the quantity of selected vertices (shortcut {)
Connected - Selects any polygons connected with the initial selection. Selections are uniformly green 
and there is no Undo for this action. If you want to increase the strength of selection in areas, clicking Add 
to Selection is necessary (shortcut ])
Invert - Single click operation inverts the selected vertices (shortcut ")

Brush Mode

The middle section of the Metamorphic window is devoted to the Brush mode tools and parameters. There are seven 
choices here, six of which surround Layout's OpenGL window with a green line showing that Metamophic is active. The 
first of the seven, None (default keyboard shortcut - Space), removes the green outline. Here are the other six in order:

Brush Mode Tools

Brush Parameters

These are global options for controlling the brush for performing the operations contained within the six categories.

Symmetry on X - performs operations symmetrically across the X axis
Symmetry on Y - performs operations symmetrically across the Y axis
Global Brush - This selects all vertices for operations but respects Use Selection as Mask if enabled and there is a 
selection already extant. The direction of the effect is on each vertex normal. This setting is mainly useful for 
textures that you want to have a global effect or selection.
Stroke Steps - Sets the distance between segments for strokes. Think of it as "How many steps will I need to 
take to get to the next segment". A lower number will result in a smoother sculpt. A higher number can result in 
separation into islands of sculpting
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Stroke Coarseness - Changes the resolution of path interpolation. The value is based on a log(n) expression, so 
not much difference will be spotted in the middle of the range of values. It's at the extremes that changes will be 
fully evident.
The following three are toggles related to using a stylus and tablet. They only work on Windows for now:

Pen Pressure Radius - The default of 50 % can be changed by typing a new number, using the slider at 
the end of the field or by right-clicking in a Layout viewport and moving the mouse left or right
Pen Pressure Hardness - The default of 50 % can be changed by typing a new number, using the slider at 
the end of the field or by right-clicking in a Layout viewport and moving the mouse up or down. The 
hardness determines the width of the boundary region between 0 % and the full brush strength
Pen Pressure Strength -  Determines how fast clicking the LMB will result in a 100 % change to the 
vertices painted over.  The number is not clamped to 100 % and can be modified with CTRL-RMB left and 
right

Clamp Strength - This toggle will clamp the selection strength to 100 %
Negative Strength - Inverses the effect of painting with the LMB (Keyboard Modifier - Ctrl )
Use Brush Nodes - Uses a nodal network to control the shape of the brush

Edit Brush Nodes - Only available when Use Brush Nodes is checked. Opens the Node Editor for editing 
the brush shape (Metamorphic Brush Nodes)
World Coords - Only available when Use Brush Nodes is checked. Uses world coordinates for the brush
Resolution - Only available when Use Brush Nodes is checked. Three choices for the nodal brush: Low, 
Medium and High. Obviously, the higher the detail, the slower the brush

Undo and Redo

There are unlimited undo and redo steps for Metamorphic in a separate undo system to the main LightWave one.

Undo - Undos previous Metamorphic operation (Keyboard Shortcut - Ctrl Z )
Redo - Redo previous Metamorphic operation (Keyboard Shortcut - Z)
Purge Undos - Clears memory of Metamorphic Undo steps
Purge Redos - Clears memory of Metamorphic Redo steps

Animation

Metamorphic has its own parallel keyframing system for operations so that they can be animated over time. Each sculpt 
key is a morph map and contains the relative offsets of each vertex.

Clear All Keys - Completely destroys all Sculpt Keys for an object. There is a warning beforehand, but no Undo
Create Key - While Sculpt keys are created automatically, new keys can also be created at the playhead position
Rename Key - Keys are automatically given names by Metamorphic, but these names can be overwritten with 
something more personalized
Create Key At... - Creates a sculptkey at the frame of your choice
Delete Key - Deletes an individual Metamorphic key. There is a warning before deletion but no Undo
Current Key - A dropdown list of the keys created in Metamorphic. You can click on an entry in this list to jump 
to the keyframe in the scene
Animation Mode - A choice of three options:

Keyframes - The default mode of Single envelope/Multiple sculpts
Mixer - Non-linear morph mixer mode
Solo - Single sculpt edit mode

Sculpts To Morphs - Converts sculpts into morph maps. Keys can be cleared now, but the object should be 
saved otherwise the morphs will be lost
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Edit Graph - Opens the Graph Editor with the Sculpt channel active
Driver Options - Opens a new window to choose a scene item to "drive" morph events, to control them

Driver - Scene item to use to drive Metamorphic
Clear Driver - Removes the driver
Get Layout Selected - Uses the currently-selected Layout item
+/- - Swaps the Minimum and Maximum Limits
Driver Channel - Choose the animation channel to use for driving Metamorphic operations
Clamp - Clamps within the set Minimum and Maximum Limits
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New to 2018

Click here to expand Table of Contents...

Layout
Primitives

Primitive Shapes
Volumetric Primitive
OpenVDB

Lights
Falloff
Visible to Camera
Lux
Environment Light
Portal Light
Primitive Light
Light Rationalization
Light Groups

Volumetrics
Surfacing

New Surface Editor paradigm
New Cel shading tools

FiberFX
Motion Modifiers
Interface

OpenGL Improvements
Additional Viewports
Modifier Stack
New Menu Layout and Interface elements

Renderer
Radiosity
Tile Rendering
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Buffers/AOVs
Noise Removal Workflow
Noise Reduction Filter
VPR
Render Presets
Network rendering

Modeler
Default UV Map
UDIM UV mapping
Live Tools
Symmetry fixes
Fine Manipulation
Layout View

Documentation
General

Feedback  
New Panel Hierarchies

A lot has changed in LightWave. Here is a potted list with links to pages that describe the features:

Layout

The LightWave scene format LWS has been incremented to take account of LightWave's new features. Previous versions 
of LightWave will not be able to load LightWave 2018 scenes, you will need to export in a previous version LWS format.

Primitives

LightWave 2018 now comes with a set of primitive objects in addition to the mesh objects it has always supported. Right 
now, you can create Primitive Shapes, Volumetric Primitives and OpenVDB objects.

Primitive Shapes

Pages describing features new to LightWave 2018 have the label New

https://docs.lightwave3d.com/display/LW2018/Primitive+Type
https://docs.lightwave3d.com/display/LW2018/Primitive+Type+-+Shape
https://docs.lightwave3d.com/label/new
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Primitive shapes (Sphere, Cube, Cylinder, Torus, Cone and Plane for now) can now be made by simply adding a null and 
selecting shape in Object Properties. Parametric shapes can be textured like geometry and have a UV map for texturing 
built-in. They can also be displaced and, because they aren't based on geometry, can have very fine levels of detail.

Standard Primitive torus with Crumple displacement at default settings
Volumetric Primitive
HyperVoxels is being reborn as a modern volumetric object with complete integration to the renderer. Where 
HyperVoxels of old had problems with transparency and shading, 2018's Volumetric Primitives take advantage of all the 
new renderer goodness.

OpenVDB

https://docs.lightwave3d.com/display/LW2018/Primitive+Type
https://docs.lightwave3d.com/display/LW2018/Primitive+Type+-+Volumetric
https://docs.lightwave3d.com/display/LW2018/Primitive+Type+-+OpenVDB
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Items and sequences compiled into OpenVDB containers in other software can be brought into Layout as objects.

Lights

Lights have been completely overhauled in 2018 and now have a physical size (and presence in the render if desired).

Falloff
Falloff is now enabled by default. The Node Editor can be used to create custom falloffs.

Visible to Camera
Most lights can optionally be visible to the rendering camera (Area, Linear, NGon, Spherical and Spot when larger than 
0).

Lux
Rather than the abstract percent measurement that LightWave lights used before, they are now measured in Lux (Lux is 
equal to one lumen per square meter), making it easier to generate accurate real-world lighting. It means that the larger 
the light, the more brightness it needs unless normalized, and that IES lights should now be exactly the right brightness 
without further tweaking.

Environment Light
An Environment light is non-localized, non-directional diffused lighting from a backdrop. You can use its intensity to 
control the brightness of the illumination from your backdrop image or gradient.

Portal Light
Area and NGon lights can be Portals. Portals provide no illumination per se, but concentrate light through openings. 
You would use them for a doorway or window to bring outside lighting through these openings for the interior.

Primitive Light
A new light that uses a primitive object as the basis for its shape. Object geometry or the new Primitives can be used.

Light Rationalization

https://docs.lightwave3d.com/display/LW2018/Lights
https://docs.lightwave3d.com/display/LW2018/Environment+Light
https://docs.lightwave3d.com/display/LW2018/Primitive+Light
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The Dome light has been removed and the Distant light improved to allow for an angle setting to provide the same 
effect. Shadow maps are no more and Spotlights can have soft shadows. Most lights can use images. For the Spotlight, 
the image will be projected. For other lights, the light color will be tinted by the image.

Light Groups
Light Groups are a way of adding more granular control for one or more lights that you want to have separate access to 
when compositing. The lights in a group have their own buffers where lights not in a group contribute to the standard 
buffer output.

Volumetrics

With the Volumetric Primitives and OpenVDB already mentioned in Primitive types, there are new options for lights to 
affect volumetrics, a volumetric scattering effect (for so-called "God rays") and new fog settings.

Surfacing

New Surface Editor paradigm
The Surface Editor has been overhauled to offer ease of use for simple material texturing without needing to enter the 
node editor, a VPR-based Surface Preview mode that surpasses the previous sample in Surface Editor and new 
materials.

Because the concentration on nodal surfacing has intensified, often places where once were T buttons have been 
replaced by a node editor. There is still a layer-based component to the Surface Editor for the standard material, but all 
others have node-only inputs.

The Principled BSDF material has replaced Standard as the default material used.

https://docs.lightwave3d.com/display/LW2018/Light+Groups
https://docs.lightwave3d.com/display/LW2018/Surface+Editor#SurfaceEditor-SurfaceEditorPanel
https://docs.lightwave3d.com/display/LW2018/Surface+Preview
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New Surface Presets have replaced the longstanding originals.
In addition, the Surface Editor has a new RMB menu when clicking on a surface name.



LightWave 2020  –  LightWave 2020

Appendices –  3851

Example from Tony Prohl, model from iflyspaceships.com. Image A, standard layered surface from 2015; B, Converted 
to PBSDF; C, Final image with tweaks to lighting and materials.
New Cel shading tools
Cel shading has received a massive update in LightWave 2018. There are now two cel integrators in the Surface Editor 
Shading Models. With them, creating consistent shading is made simple with diffuse and specular gradients.

 

The default Cel and the additional Sublimation CelShader integrators
Secondly, Layout's OpenGL has been improved to give a better idea of how cel shading will look without even needing 
to render or go into VPR.

http://iflyspaceships.com
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The OpenGL view on the right has no edges, but the shading is exactly right
In addition, the New Surface Shaded switch in Object Properties allows full material selection for edges using the Mesh 
Element Switch to create more cel shading possibilities, and the new Global Edge Multiplier and Edge Vertical Points
settings make rendering cel-shaded edges for different resolution outputs simple.

FiberFX

FiberFX has been recreated as a primitive object. There is no longer a volumetric version.

Motion Modifiers

New nodal motion modifiers can link mesh pivot points to meshes and vertices and Bullet objects including parts.

Interface

OpenGL Improvements

https://docs.lightwave3d.com/display/LW2018/Mesh+Element+Switch
https://docs.lightwave3d.com/display/LW2018/Mesh+Element+Switch
https://docs.lightwave3d.com/display/LW2018/Render+Properties+-+Render#RenderProperties-Render-GEM
https://docs.lightwave3d.com/display/LW2018/FiberFX
https://docs.lightwave3d.com/display/LW2018/Item+Info#ItemInfo-Mesh
https://docs.lightwave3d.com/display/LW2018/Item+Info#ItemInfo-DynamicsPartInfo
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With the  PBRGLSL Shading Method, display in OpenGL matches VPR as closely as possible. The screenshot above 
shows the Principled BSDF material in OpenGL and VPR side by side. Apart from the shadows evident in VPR, the 
shading matches closely.

Additional Viewports

In Layout you can now add additional floating viewports that can be of any type and can be moved onto a different 
monitor in a multi-monitor setup.

Modifier Stack
In the past, sometimes there was a juggling act necessary to determine whether subpatch division was going to take 
place before bone deformation, or dynamics, or many other things. Now there is complete freedom with a modifier 
stack that can be re-ordered as you need. In addition, you can control the modifier stack for multiple objects at once.

https://docs.lightwave3d.com/display/LW2018/Additional+Viewports
https://docs.lightwave3d.com/display/LW2018/Modifier+Stack
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The Modifier Stack can be reordered as needed. Individual entries can be double-clicked to show an interface, and 
holding Alt allows the selection of similar items in multiple objects as shown in the second screenshot animation
New Menu Layout and Interface elements
Layout and Modeler's main menus have been rebuilt for better efficiency and new interface elements like clipboard 
functions have been added to speed workflow.
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Renderer

Radiosity

Deliberately simple scene to test radiosity rendering. Note the lack of patchiness for a render that took less than 270 
seconds.
LightWave's interpolated radiosity rendering has improvements to sampling.

Tile Rendering

Rather than the lines of previous versions, LightWave's render engine now uses user-sizable tiles.

Buffers/AOVs

AOVs are Arbitrary Output Variables, and LightWave now supports rendering of outputs like Direct_Diffuse, Depth and 
Alpha among many others, directly in VPR and final render.

Noise Removal Workflow

Noise is an inevitable and unwanted result of rendering 3D images. Unless your scene is extremely simple it is likely that 
you will have some. LightWave's buffer view enables you to track down exactly where this noise is coming from before 
you launch your scene render.

Noise Reduction Filter

This system, added in LightWave 2018, allows you to control a bilateral filtering of your render to give a smoother effect 
without needing endless anti-aliasing. Meant to remove fine grain that would take too long for the renderer to deal 
with, it won't work effectively on high contrast grain.

https://docs.lightwave3d.com/display/LW2018/Render+Tile+Size
https://docs.lightwave3d.com/display/LW2018/Removing+Noise+workflow
https://docs.lightwave3d.com/display/LW2018/Filter+List#FilterList-NoiseReductionFilter
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VPR

VPR can not only show the final render as before but now can show specific buffers like Alpha, Depth, Motion and more. 
It also now acts as a replacement for the old Surface Editor preview using either preset objects or scene objects.

Sometimes you really need to check that one detail that will make or break your render and you don't have the time to 
wait for the whole thing to finish. Now you can direct where VPR concentrates its firepower with cursor-targeted 
refinement.

Render Presets

You can now create presets for rendering settings using the F8 presets window.

Network rendering

LightWave is now easily installed and controlled as a renderslave or host with a graphical user interface making 
controlling a renderfarm simple.

Modeler

The LightWave object format LWO has been incremented to allow for larger quantities of nodes and surfaces. The LWO3 
format won't open in previous versions of LightWave, you will need to either export an LWO2 format object or use the 
LWO3 loader plugin for previous LightWave versions here.

Default UV Map

You can now create a default UV map in Modeler. It is represented in the interface with a bullet by the name. The major 
benefit will be that a specific UV map will not have to be defined, leading to much faster UV workflow. The default UV 
map will also be used in Layout for the Surface Input node's U, V and dU, dV outputs.

UDIM UV mapping

The UDIM method of assigning images as textures and organizing UV maps was created by WETA for the Lord of the 
Rings films and has now been implemented for LightWave.

https://docs.lightwave3d.com/display/LW2018/VPR
https://docs.lightwave3d.com/display/LW2018/VPR
https://docs.lightwave3d.com/display/LW2018/Distributed+Rendering+-+An+Introduction
https://www.lightwave3d.com/assets/plugins/entry/lwo3-loader/
https://docs.lightwave3d.com/display/LW2018/UDIM+Workflow
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Live Tools

New "Live" tools update the viewport as you change settings in the numeric panel.

Lattice
Spline Bridge
Array
Smooth
Toroid

Symmetry fixes

More tools now respect the Symmetry state in Modeler - Edit Edges, Lattice, Knife, and BandGlue.

Fine Manipulation

You can now Rotate, Stretch and Scale with more precision using the Right Mouse Button (RMB). In addition, using 
CTRL will constrain rotations to 15° increments.

Layout View

Layout View has been added to the View modes present in Modeler. It is an immobile view that exactly replicates the 
view in Layout. If you change the viewport in Layout, Modeler's will follow suit.

Documentation

LightWave's documentation is now in the form of the online wiki you are reading. It will always be up-to-date and 
improvements and changes can be easily made. It is accessed from Layout and Modeler by hitting F1.

General

Feedback  

Reporting Feature Requests or bugs that need fixing has never been easier. From within LightWave you can send both 
straight to NewTek.

https://docs.lightwave3d.com/display/LW2018/Lattice
https://docs.lightwave3d.com/display/LW2018/Spline+Bridge
https://docs.lightwave3d.com/display/LW2018/Array
https://docs.lightwave3d.com/display/LW2018/Transform+-+More#Transform-More-LiveSmooth
https://docs.lightwave3d.com/display/LW2018/Toroid
https://docs.lightwave3d.com/display/LW2018/Edit+Edges
https://docs.lightwave3d.com/display/LW2018/Lattice
https://docs.lightwave3d.com/display/LW2018/Knife+Tool
https://docs.lightwave3d.com/display/LW2018/Reduce+-+More#Reduce-More-BandGlue
https://docs.lightwave3d.com/display/LW2018/Manipulating
https://docs.lightwave3d.com/display/LW2018/Working+with+Modeler+Viewports#WorkingwithModelerViewports-LayoutView
https://docs.lightwave3d.com
https://docs.lightwave3d.com/display/LW2018/Feedback
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New Panel Hierarchies

New panels (like the Surface Editor, Render Properties, Scene Editor, Scene/Dope Editor and others) have 
collapsible hierarchies. Holding down the Ctrl key when clicking the expander arrow will open or close all 
children, holding down Shift will affect all siblings and holding down the Alt key when clicking a closed 
hierarchy will open that group and shut others. Holding Alt when there are several hierarchies open will 
maintain the one clicked on and close the others. All of the modifiers can be combined, they are not mutually 
exclusive.


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